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Presentazione

Questo Manuale Operativo (Riferimento) è una guida completa a tutte le funzioni di Sibelius. Per 
le spiegazioni delle funzioni più elementari e per familiarizzare con il programma, si consiglia di 
consultare la Guida all’uso (Handbook) oppure, in caso di aggiornamento da una versione prece-
dente, il libretto di Upgrade a Sibelius 5.

Il Manuale è disponibile sia “on-screen” sia in forma cartacea, acquistabile dal distributore di Sibe-
lius del proprio Paese (www.sibelius.com/buy). I due formati del Manuale sono identici.

Capitoli e argomenti
Il Manuale di Sibelius è suddiviso in sette capitoli contenenti argomenti più ridotti. L’elenco di tutti 
gli argomenti si trova nell’Indice. Tuttavia, l’Indice analitico può essere più utile per individu-
are rapidamente le informazioni relative a funzioni specifiche del programma. Il Glossario,
infine, spiega i termini tecnici e musicali.

Guida “on-screen”
Per aprire la Guida “on-screen” cliccare sul pulsante nella barra degli strumenti indicato a 
destra, oppure selezionare Aiuto > Riferimento Sibelius (comando rapido F1 o X?).

Si aprirà l’applicazione che il computer utilizza per visualizzare i file in formato PDF – normal-
mente, Adobe Reader in Windows e Anteprima su Mac – e apparirà il Manuale “on-screen”. Per 
consultare il Manuale “on-screen”, si possono utilizzare i segnalibri e le funzioni Modifica > Trova
di Adobe Reader e Anteprima.

I segnalibri sono simili a indici aperti accanto al documento in lettura e consentono di spostarsi 
rapidamente su ciascun capitolo, argomento o sotto titolo del Manuale. 
Per vedere i segnalibri:

* In Adobe Reader, selezionare Vista > Pannelli di navigazione > Segnalibri; a sinistra dello 
schermo appare un pannello simile a quello sottostante.

* In Anteprima (su Mac) selezionare Vista > Cassetto; sul lato destro della finestra sporge un 
pannello simile a quello indicato nella figura seguente.
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Per la ricerca nel Manuale “on-screen” utilizzare la funzione Modifica > Trova di Adobe Reader o 
Composizione > Cerca di Anteprima, oppure:

* In Adobe Reader, scrivere nella casella Trova sulla barra degli strumenti, illustrata in basso a sin-
istra e utilizzare i pulsanti Trova successivo e Trova precedente per spostarsi avanti e indietro.

* In Anteprima (su Mac) scrivere nella casella Cerca del Cassetto, illustrato in basso a destra e clic-
care nell’elenco dei risultati per scorrerlo avanti e indietro.

Dal Manuale “on-screen” non è possibile stampare o estrapolare testi o immagini con la funzione 
“copia e incolla”.

Riferimenti incrociati
b 2.28 Tratti d’unione significa “vedere l’argomento Tratti d’unione nel capitolo 2 del Man-
uale”.

v Iniziare un nuovo spartito significa “selezionare Aiuto > Video Tutorial e guardare il video 
Iniziare un nuovo spartito”.

Per i dettagli su altri segni e terminologia utilizzati, consultare la Guida all’uso (Handbook).
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Inserire

1.1 Inserimento note

b Flexi-time™, Inserire una tablatura per chitarra, Alterazioni, Articolazioni, 
Tratti d’unione, Ornamenti, Teste nota, Gambi e linee aggiuntive, Tremolo, Terzine 
e altri tuplet, Voci, Spaziatura note.

v Inserimento note: procedure.

Per creare e modificare note, accordi e pause sono presenti cinque metodi:

* Inserimento con il mouse – vedere in seguito
* Inserimento alfabetico e step-time – vedere in seguito
* Inserimento Flexi-time – b Flexi-time™

* Importando i file da altri programmi musicali (ad esempio, file MIDI, Finale, SCORE, ecc.) – 
b Aprire i file MIDI, Aprire i file MusicXML, Aprire i file Finale 98-2003, Aprire i 
file SCORE, Aprire i file Acorn Sibelius, File in tablatura ASCII

* Sottoponendo a scansione musica stampata – b Scansione.

La maggior parte di questi metodi è descritta brevemente nella Guida. Questo capitolo è un rias-
sunto dettagliato degli inserimenti con il mouse, step-time e alfabetico.

Inserimento alfabetico e step-time
Inserimento alfabetico (tastiera del computer) e step-time (tastiera MIDI) sono forse i metodi più 
semplici per scrivere la musica in Sibelius, perché lungo il percorso si possono creare altri oggetti 
(come tempi in chiave, cambi di tonalità, testo).

Per iniziare un inserimento alfabetico o step-time:

* Selezionare una pausa (si può selezionare anche qualcos’altro, come un oggetto di testo o una 
linea, che consentirà d’iniziare a scrivere le note da quel punto).

* Selezionare Note > Inserisci Note (comando rapido N). Appare il cursore (una linea verticale 
colorata in base alla voce che si sta inserendo).

* Scegliere un valore nota dal Keypad (a meno che non sia già selezionato il valore nota desider-
ato).

* Se si desidera, scegliere altri segni dal Keypad:
% Alterazioni dal primo/quinto layout (non necessario per l’inserimento step-time).
% Articolazioni dal primo/quarto layout.
% Punti e legature ritmici dal primo/secondo layout (i doppi punti sono nel secondo layout).
% Ornamenti e acciaccature dal secondo layout.
% Tremolo e tratti d’unione dal terzo layout.

* Tutti questi pulsanti restano selezionati per le note successive fino a quando si selezionano di 
nuovo (tranne le alterazioni sui layout del primo e quinto Keypad). Ciò significa, ad esempio, 
che è possibile inserire più note con la stessa articolazione.
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* È possibile scegliere i pulsanti da più di un layout per volta – saranno applicati alla nota/accordo 
inserito; scorrere i vari layout dei Keypad con il tasto + (premendo F8 in Windows e – su Mac si 
torna al primo layout).

* Inserire quindi la nota:
% Digitando A–G o R (si ripete la nota o l’accordo precedente, con tutte le alterazioni eseguite 

nel Keypad); oppure:
% Suonando la nota o l’accordo sulla tastiera MIDI.

* Per inserire una pausa del valore nota selezionato premere 0 sul layout F8 del Keypad (per 
creare altre pause dello stesso valore nota, continuare a premere 0).

* Per inserire una misura intera di pausa, premere 0 sul layout F9 del Keypad.
* Tornare al primo passo per inserire la nota o l’accordo successivo.

Una volta inserita la nota, prima di creare quella successiva è possibile eseguire alcune operazioni:

* Per correggere un errore, si può regolare l’altezza di una nota inserita premendo i tasti 3 o 2
(tenere premuto Ctrl o X per cambiare l’altezza di un’ottava).

* Per costruire un accordo con l’inserimento alfabetico inserire una nota dell’accordo, quindi 
aggiungere altre teste nota con uno dei metodi seguenti:
% Tenere premuto Maius e digitare il nome letterale della nota che si vuole aggiungere sopra; 

per aggiungere un G#, ad esempio, digitare anzitutto 8 sul primo layout del Keypad per selez-
ionare il diesis, quindi digitare Maius-G per aggiungere la nota; oppure:

% Digitare un numero da 1 a 9 (sulla tastiera principale del computer, non sul pad numerico) 
per aggiungere una nota all’intervallo specificato sopra quella corrente; per aggiungere una 
nota una sesta sopra, ad esempio, digitare 6; Con la combinazione Maius-1–9 si aggiungono 
note sotto quella corrente; con Maius-4, ad esempio, si aggiunge una nota una quarta sotto 
quella corrente, utile poiché funziona anche sui passaggi selezionati (ad esempio, per creare 
ottave); oppure:

% Selezionare l’opzione desiderata dal sottomenu Note > Aggiungi Altezza alle Note >
Aggiungi Intervallo, (sebbene sia molto più comodo usare i comandi rapidi descritti in pre-
cedenza).

* Per aggiungere una legatura, premere Invio sul pad numerico dopo aver inserito la nota.
* Per creare una duina (tuplet), digitare Ctrl+2–9 o X2–9 (oppure selezionare Crea > Gruppo 

Irregolare) dopo aver inserito la prima nota della duina.
* Per rinominare una nota enarmonicamente (da una tastiera MIDI, ad esempio) selezionare 

Note > Rinomina Alterazioni (comando rapido Invio, tastiera principale) dopo averla inserita.

Tasti utili
Quando si creano le note sono disponibili altri tasti utili:

* Se si commette un errore, premere Canc o Ritorno unitario; si cancella la nota selezionando 
quella precedente.
(Ciò che avviene cancellando una nota è leggermente diverso in base al contesto in cui è inserita 
la musica: cancellando una nota la si converte in una pausa della stessa durata; se si cancella una 
pausa o una misura di pausa il cursore si sposta oltre lasciandola intatta; cancellando tutte le 
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note di una duina si seleziona la parentesi quadra/numero – cancellando quest’ultimo lo si sosti-
tuisce con una pausa che dura per l’intera duina).

* Per spostarsi tra note e pause si possono usare anche i tasti freccia 0/1.
* Si possono spostare le note selezionate in un’altra voce digitando Alt+1/2/3/4 o z1/2/3/4; ad 

esempio, si può selezionare la nota di un accordo nella voce 1 e digitare Alt+2 o z2 per 
spostarla nella voce 2 (aggiungendola alle altre note eventualmente presenti in quella voce).

* Per inserire un tempo in chiave mentre si creano le note, digitare T, selezionarlo dalla finestra di 
dialogo e premere Invio o cliccare su OK per crearlo all’inizio della misura successiva.

* Per inserire un cambio tonalità, digitare K, selezionare il key signature desiderato dalla finestra 
di dialogo e premere Invio o cliccare su OK per crearlo nello spartito dopo la nota corrente.

* Per inserire un testo, Ctrl+E o XE (per una scritta Expression) e digitare la scritta desiderata; 
premere Esc per tornare alla creazione delle note. La scritta appare alla posizione di default 
sopra o sotto il rigo, alla stessa posizione orizzontale della nota selezionata prima di crearla.

* Durante l’inserimento della nota si può anche aggiungere un qualsiasi altro oggetto dal menu 
Crea. Simboli e diagrami degli accordi, appaiono tutti nelle rispettive posizioni di default sopra 
o sotto il rigo, alla stessa posizione orizzontale della nota selezionata.
Per le linee (in particolare legature e forcine) è pratico inserire quelle che durano per due note 
senza fermare temporaneamente l’inserimento della nota; questo perché l’estremità destra della 
linea deve collegarsi a una nota che normalmente non è ancora stata inserita. In generale, 
quindi, è più semplice tornare indietro e inserire le linee dopo aver inserito una frase musicale.

* Premendo Esc termina l’inserimento delle note (il cursore scompare).

Inserimento con il mouse
L’inserimento con il mouse, in pratica è simile a quello step-time e alfabetico, ma prima d’iniziare 
non deve essere selezionato nulla (premere Esc per deselezionare):

* Selezionare Note > Inserisci Note (comando rapido N); il puntatore del mouse cambia colore 
(di solito diventa blu scuro, a indicare la voce 1).

* Scegliere un valore nota dal primo layout del Keypad; è possibile anche selezionare alterazioni, 
articolazioni, ecc. da altri layout del Keypad (vedere in precedenza). Per inserire una pausa, 
selezionare il pulsante pausa dal primo layout.

* Muovendo il puntatore del mouse sullo spartito appare una nota sfumata grigia che indica dove 
sarà creata la nota quando si clicca. Non appena si sposta il puntatore in verticale sopra il rigo, 
sono disegnate le sopralinee aggiuntive necessarie; muovendolo orizzontalmente nella misura, 
la nota sfumata scatta ai vari movimenti della misura (questa funzionalità è configurabile – ved-
ere il paragrafo Opzioni d’inserimento nota che segue). Inoltre, la nota sfumata mostra 
anche il tipo di testa nota che si sta creando.

* Per inserire la nota cliccare semplicemente sul punto in cui si desidera crearla.
* Nello spartito, a destra della nota appena creata, appare un cursore (una linea verticale) – se si 

desidera, è possibile iniziare a creare note con l’inserimento step-time o alfabetico, ma per con-
tinuare ad aggiungere note con il mouse, è sufficiente cliccare ancora sullo spartito per creare 
altre note, cambiando il valore nota e altre proprietà della nota nel Keypad, se necessario. Per 
costruire un accordo, cliccare sopra o sotto la nota appena creata. Creando una nota da qualche 
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altra parte nella misura e tornando indietro cliccando sopra o sotto una nota esistente per cos-
truire un accordo, Sibelius cancella qualsiasi cosa sia presente prima e crea una nuova nota in 
quella posizione.

* Inserendo una nota lunga all’inizio di una misura e inserendo più avanti nella misura un’ altra 
nota (prima che finisca la lunga nota all’inizio della misura stessa), di default Sibelius sostituisce 
la prima nota con pause; altrimenti, se si preferisce, è possibile creare la nuova nota nella voce 2 
– Attivare l’opzione Usa voce 2 quando le ritmiche sono in disaccordo nella pagina Mouse
del menu File > Preferenze (menu Sibelius in Mac)

* Per inserire una pausa cliccare sul pulsante pausa (o digitare 0) sul primo layout del Keypad e 
cliccare sullo spartito.

* Non è obbligatorio inserire le note da sinistra a destra con il mouse – ci si può spostare nello 
spartito e cliccare per inserire le note ovunque.

Reinserire le altezze
Spesso è molto utile poter cambiare le altezze di una sequenza di note/accordi senza modificare il 
ritmo. L’applicazione tipica è la scrittura musicale per più strumenti che hanno lo stesso ritmo ma 
altezze diverse – basta copiare la parte musicale di uno strumento e poi reinserire le altezze. 
L’altezza di singole note si modifica con il mouse, i tasti 3/2, le lettere A-G o suonando una nota 
sulla tastiera MIDI, ma per reinserire un intero passaggio:

* Selezionare una nota dalla quale si desidera iniziare a reinserire le altezze (sia con il mouse sia 
con i tasti freccia).

* Selezionare Note > Cambia altezze di nota (comando rapido Ctrl+Maius+I o xXI).
* Appare un cursore punteggiato (invece della normale linea continua); esso indica che Sibelius 

sostituirà le note esistenti ma non i loro ritmi.
* Digitare A–G o suonare la nuova nota (o accordo) sulla tastiera MIDI.
* Sibelius modifica l’altezza della prima nota e seleziona quella successiva (ignorando pause e 

ornamenti che eventualmente la precedono) in modo che si possa subito cambiarne l’altezza.
* Per cambiare lo spelling enarmonico di una nota dopo averne modificato l’altezza, selezionare 

Note > Alterazione enarmonica (comando rapido Invio sulla tastiera principale del com-
puter).

* Quando si reinseriscono le altezze dalla tastiera del computer, alterazioni e articolazioni devono 
essere digitati dopo il nome della nota, non prima (a differenza di quando s’inseriscono o modif-
icano le singole note).

* Se non si desidera cambiare una nota particolare premere 0 sul pad numerico per passare a 
quella successiva.

* Per trasformare una nota esistente in una pausa premere 1 per selezionarla senza cambiarne 
l’altezza, quindi premere 0 sul primo layout del Keypad (comando rapido F8).

* Per trasformare una pausa esistente in una nota usare 0/1 per spostarsi sopra la pausa, quindi 
inserire la nota all’altezza desiderata.

* Al termine, selezionare di nuovo Note > Cambia altezze di nota, oppure premere Esc per tornare 
a modificare la propria musica; altrimenti, digitare N per iniziare a inserire altre note.
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Mentre si reinseriscono le altezze è possibile anche costruire accordi dalle note esistenti, allo stesso 
modo con cui s’inseriscono le note: selezionare una nota e digitare Maius-A–G, 1–9 o Maius-1–9
sulla tastiera principale del computer – vedere Inserimento alfabetico e step-time.

Editing di valori nota, alterazioni, articolazioni, ecc.
* Selezionare una nota, accordo o pausa (con il mouse o i tasti freccia).
* Per cambiare il valore nota, selezionarne uno nuovo dal primo o secondo layout del Keypad.

Se il nuovo valore nota è superiore a quello vecchio, le note che seguono sono sostituite dalle 
opportune pause; se invece il nuovo valore nota è inferiore a quello vecchio si creano le pause 
necessarie a completare il valore nota originale.

* Per modificare altre proprietà della nota, come alterazioni o articolazioni, scegliere il rispettivo 
pulsante Keypad che modifica immediatamente la nota (ad esempio, cliccare su # o digitare 8
per aggiungere un diesis alla nota).

Note > Alterazione enarmonica (comando rapido Invio sulla tastiera principale) rinomina 
un’alterazione – normalmente serve solo dopo un inserimento step-time/Flexi-time o durante 
l’editing di un file MIDI importato.

Opzioni d’inserimento nota
La pagina Inserimento Nota della finestra di dialogo File > Preferenze (menu Sibelius in Mac) 
presenta varie opzioni d’inserimento nota:

* Accordi Step-time: riguarda l’inserimento step-time (specialmente con una chitarra MIDI) e 
stabilisce con quanta velocità si deve pennare perché Sibelius interpreti le note suonate come un 
accordo o una serie di note singole. Di default, il cursore è più spostato verso l’opzione Massima, 
ideale per l’inserimento delle note con una tastiera MIDI (ove, in generale, gli accordi sono più 
compatti); usando una chitarra MIDI spostare il cursore più verso l’opzione Minima per trovare 
la posizione ideale in base al proprio stile di pennata.

reference.book  Page 13  Wednesday, April 16, 2008  4:28 PM



1. Inserire

14

* Righi Traspositori: quando si usa il MIDI per suonare musica trasportata è utile impostare 
questa opzione in Inserisci suono scritto, per evitare di dover eseguire il trasporto a vista; di 
default è Inserisci suono reale – vedere Transporto degli strumenti a pagina 132.

* Righi di Percussioni: è possibile inserire le note su pentagrammi di batteria con la tastiera MIDI 
usando sia i tasti che generano il suono corretto sia le altezze stabilite nella definizione stru-
mento per il rigo scelto – b Percussioni.

* Durante la modifica: attivandola Sibelius suona le note durante l’editing (ad esempio, inser-
endo, selezionando o modificando le note). Ripristina voce originale dopo selezioni di 
un’unica battuta: se questa opzione non è attiva, Sibelius memorizza solo tempo in chiave, 
tonalità o chiave originali alla fine di una selezione se quest’ultima dura più di una misura.

* Per i dettagli sulle opzioni di diteggiatura per le tablature di chitarra, b Inserire una tabla-
tura per chitarra.

* Ometti Note Errate: queste opzioni evitano che Sibelius scriva note molto brevi, molto acute o 
gravi oppure molto deboli quando le si inserisce da una tastiera o chitarra MIDI:
% Altezze di nota che suonano tra x e y: di default questa opzione non è attiva (poiché non 

sarebbe adatta ad alcuni dispositivi MIDI, come le tastiere); tuttavia, inserendo le note con 
una chitarra MIDI è meglio attivarla e regolare le note più gravi e acute che effettivamente 
devono essere scritte sul rigo. Le note fuori da questo intervallo sono ignorate.

% Note con velocities più alte di x: per evitare che note molto deboli siano scritte accidental-
mente, regolare la velocity minima. Suonare le note sulla chitarra il più piano possibile; 
quando la velocity di una nota è alta abbastanza da superare la soglia, s’illumina il piccolo 
indicatore nero nella finestra di dialogo. Impostare questo numero in modo che sia scritta sul 
rigo la nota più debole suonata.

% Note più lunghe di x ticks: per evitare che note molto brevi siano scritte accidentalmente 
regolare la durata minima. 256 tick = 1 nota da un quarto (semiminima); il valore di default 
pari a 10 tick, quindi, è un pò più breve di una nota da 1/64. Se si prevede di non dover mai 
scrivere una nota così breve, impostare un valore superiore.

Nascondere le note
Si possono nascondere note che tuttavia sono riprodotte (un ornamento, ad esempio). Selezionare 
la nota(e) da nascondere e scegliere Modifica > Mostra o Nascondi > Nascondi (comando rapido 
Ctrl+Maius+H o xXH). È nascosta anche qualsiasi alterazione, articolazione, gambo o tratto 
d’unione associato alla nota. Per maggiori informazioni sulle note nascoste, b Nascondere 
oggetti.

Trasformazione in pause
Per trasformare una nota, accordo, passaggio in pause premere Canc, oppure selezionare il pul-
sante pausa (comando rapido 0) sul primo layout del Keypad.

La sottile differenza tra Canc e 0 è che trasformando un passaggio in pause, Canc unisce le pause 
(cioè le raggruppa in pause più lunghe o in misure di pausa), mentre 0 trasforma semplicemente 
ogni nota in una singola pausa (cosa meno utile). Per maggiori informazioni sulle misure di pausa, 
b Misure e misure di pausa.
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Se alla fine si hanno una o più misure contenenti solamente pause di varie durate, si può trasfor-
marle in una misura di pausa selezionando la misura o il passaggio (in modo da racchiuderlo in un 
box di colore blu chiaro) e premendo Canc.

Spostare le pause
Le pause si possono spostare in alto/basso con il mouse o i tasti freccia (proprio come le note).

Per la musica ad una voce, non serve regolare la posizione verticale delle pause, poiché quella uti-
lizzata da Sibelius è standard. Tuttavia, avendo più voci è meglio regolare opportunamente la 
posizione verticale, in modo da far spazio a un’altra voce(i). Sibelius colloca automaticamente le 
pause leggermente in alto o in basso quando ci sono più voci, ma si è liberi di regolarle a piacere.

Nascondere le pause
Premendo Canc quando è selezionata una pausa la si nasconde; lo spazio che occupava rimane e la 
musica negli altri righi del sistema si distribuisce come se la pausa ci fosse ancora. Se è attiva l’opz-
ione Vista > Nascondi Oggetti (comando rapido Ctrl+Alt+H o zXH), la pausa è in grigio 
chiaro.

In realtà si può cancellare completamente una pausa, selezionando una pausa nascosta e pre-
mendo nuovamente Canc, ma di solito non c’è motivo per farlo.

È meglio non nascondere le pause senza una buona ragione, poiché la durata della misura appare 
sbagliata, generando confusione nei più distratti. Tuttavia, due buone ragioni per nascondere una 
pausa sono:

* Far scomparire una voce prima della fine di una misura o farla apparire dopo l’inizio. Per esem-
pio, nascondendo le pause nella voce 2, la musica diventa a una voce (con i gambi rivolti sia in 
alto sia in basso) – b Voci.

* Sostituirla con un simbolo o una linea che rappresenta un effetto non indicabile con le note. Per 
esempio, in uno spartito moderno si potrebbero scrivere effetti sonori nascondendo una pausa 
della durata desiderata e inserendo al suo posto una linea a serpentina.
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1.2 Tastierino numerico

b Inserimento note, Voci, Proprietà.

Il tastierino numerico rispecchia sullo schermo la disposizione dei tasti sul pad numerico del com-
puter. Esso mostra e permette di modificare le caratteristiche di nota(e), accordo(i) o pausa(e), 
oppure della nota che si sta per creare quando si utilizza l’inserimento alfabetico o step-time.

Per mostrare o nascondere il tastierino numerico: Finestre > Tastierino numerico (comando 
rapido Ctrl+Alt+K o zXK).

Layout del tastierino numerico
Il tastierino numerico ha cinque layout (vedere in seguito) che si possono selezionare come segue:

* Cliccando sulle pagine in cima al tastierino numerico; oppure:

* Cliccando  sul tastierino numerico per scorrere in ordine i layout (comando rapido +) e clic-
cando  per tornare al primo layout del tastierino numerico (comando rapido F8 e Maius-+ in 
Windows o – su Mac); oppure:

* Premendo i tasti da F8 a F12 per visualizzare i cinque layout del tastierino numerico.

Si usa prevalentemente il primo layout del tastierino numerico (contenente i valori nota e le alter-
azioni più comuni); la figura seguente mostra tutti i cinque layout:

* I primi due layout del tastierino numerico servono per inserire e modificare le note; legature di 
valore (non di portamento) si creano con il tasto Invio del layout F8; le acciaccature si creano 
con il tasto Invio del layout F9. Si noti che il punto del tasto “*” (/ su Mac) è l’articolazione “stac-
cato”, mentre il punto del tasto “.” (decimale) è un punto ritmico.

* Valori nota molto corti e molto lunghi, doppi e tripli punti ritmici si creano con il layout F9 – 
b Inserimento note

* Il terzo layout del tastierino numerico (comando rapido F10) serve per l’editing dei tratti 
d’unione (b Tratti d’unione) e la creazione di tremolo e segni buzz (b Tremolo).

* Il quarto layout del tastierino numerico (comando rapido F11) serve per aggiungere le artico-
lazioni; si notino i tre quadratini vuoti in cima al layout ai quali è possibile assegnare le proprie 
articolazioni dei gambi – b Articolazioni

Note comuni (F8) Altre note (F9) Tratti unione/tremolo 
(F10)

Articolazioni (F11) Alterazioni (F12)
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* Il quinto layout del tastierino numerico (comando rapido F12) serve per aggiungere varie alter-
azioni – b Alterazioni.

Il tasto 0 si usa appositamente per “non oggetti” – sia pause che per rimuovere tutte le articolazi-
oni/alterazioni.

Visualizzare e modificare le caratteristiche della nota
Quando si seleziona una nota, il tastierino numerico ne mostra le caratteristiche; per esempio, 
selezionando nello spartito una nota da 1/4 (semiminima) s’illumina il pulsante nota da 1/4 nel 
primo layout del tastierino numerico. Analogamente, selezionando una pausa di 1/4 col punto, nel 
tastierino numerico s’illuminano i pulsanti di 1/4 nota, pausa e punto ritmico.

Per attivare o disattivare una caratteristica particolare del tastierino numerico sull’oggetto selezi-
onato:

* Cliccare sull’icona con il mouse, oppure:
* Premere il tasto corrispondente sul pad numerico del tastierino numerico.

Per esempio, se nel primo layout del tastierino numerico, si vuole cambiare la nota selezionata in 
una nota da 1/2 (minima) digitare 5 sul pad numerico del tastierino numerico; per aggiungere una 
legatura di valore premere Invio sul pad numerico e così via. Analogamente, per togliere una leg-
atura selezionare la nota dalla quale inizia la legatura e premere Invio. Allo stesso modo è possibile 
aggiungere e rimuovere le caratteristiche da qualsiasi layout del tastierino numerico – quindi per 
inserire una fermata (pausa) alla nota da 1/2 (minima) premere F11 (per selezionare il quarto lay-
out del tastierino numerico) e 1 sul pad numerico del tastierino numerico per aggiungere la fer-
mata.

Se una nota ha caratteristiche non presenti nel layout del tastierino numerico selezionato, s’illumi-
nano in blu le pagine dei rispettivi layout del tastierino numerico. Per esempio, se nel primo layout 
del tastierino numerico si seleziona una nota da 1/4 che ha un quarto di bemolle ed una fermata 
(pausa), s’illuminano anche le pagine del quarto e quinto layout del tastierino numerico.

Voci
La fila di pulsanti in cima al tastierino numerico serve per specificare le voci delle note, oltre a 
scritte e linee assegnate al rigo – b Voci.

Comandi rapidi extra per le funzioni del tastierino numerico
Sebbene ci sia una relazione semplice e ovvia tra gli oggetti sul tastierino numerico dello schermo 
e il pad numerico sulla tastiera del computer, si possono anche assegnare comandi rapidi aggiun-
tivi ad oggetti specifici del tastierino numerico. Per assegnare un comando rapido specifico alla 
fermata (pausa) sul quarto layout del tastierino numerico, ad esempio (in modo da non premere 
F11 per selezionare il rispettivo layout seguito dal tasto 1 sul pad numerico per inserire la fermata) 
e digitare un solo comando rapido indipendentemente dal layout corrente del tastierino numerico, 
si può fare così:

* Selezionare File > Preferenze (menu Sibelius in Mac) e andare nella pagina Menu e Scorcia-
toie.

* Una volta scelta la funzione alla quale assegnare un nuovo comando rapido, selezionare Tast-
ierino numerico (F11 articolazioni) dall’elenco Menu o Categoria.
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* Nell’elenco Caratteristica, selezionare Fermata (pausa) e cliccare su Aggiungi per aggiungere 
il proprio comando rapido.

Per altri dettagli sull’assegnazione di comandi rapidi personalizzati, b Menu e comandi 
rapidi.

Accedere alle funzioni del pad numerico di un notebook (portatile)
La maggior parte dei notebook (computer portatili) non hanno un pad numerico separato. Alle 
funzioni del tastierino numerico si può accedere da vari notebook tenendo premuto il tasto Fn
insieme ad altri tasti della tastiera. Si tenga presente, però, che Sibelius ha anche altri comandi 
rapidi interni diversi da quelli di Windows e Mac.

Windows: usare l’opzione Notebook (laptop) feature set. Invece di usare i numeri sul pad 
numerico, si possono utilizzare i numeri standard sulla tastiera principale (che corrispondono a 
quelli del pad numerico). Quando si usa questa funzione, premere i tasti da Maius-1 a Maius-9
per inserire gli intervalli sopra una nota – b Menu e comandi rapidi.

Mac: per avere le corrispondenti pressioni dei tasti sul pad numerico, tenere premuto il 
tasto z insieme a quelli indicati nel diagramma a sinistra. Non tutti i pulsanti del tast-
ierino numerico hanno comandi rapidi alternativi; per quelli si deve usare il tasto Fn
(se presente) oppure cliccare nel tastierino numerico sullo schermo con il mouse.

Uso del tastierino numerico in Mac OS X
Di default, Mac OS X assegna i tasti F9, F10 e F11 alla funzione Exposé e il tasto F12 alla funzione 
Dashboard; in Sibelius, quindi, si possono avere risultati imprevedibili quando si usano questi 
comandi rapidi per cambiare i vari layout del tastierino numerico.

Per riassegnare i comandi rapidi Exposé e Dashboard ad altri tasti funzione (per esempio, F2, F3, 
F4 e F5) usare la finestrella Dashboard e Exposé che si trova in Preferenze di Sistema .
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1.3 Flexi-time™

b Inserimento note.

v Inserimento note.

Flexi-time è una funzione particolare di Sibelius per inserire le note via MIDI in tempo reale.

Inserimento in tempo reale
In altri programmi, con l’inserimento in tempo reale il programma elabora nello stesso momento 
altezza e ritmo della musica suonata su una tastiera MIDI, trasformandoli in notazione.

Il problema maggiore è il ritmo: quasi mai si suona il ritmo esattamente come è scritto, a causa di 
un involontario “rubato” (variazione di velocità) dell’esecutore; l’inserimento in tempo reale, 
quindi, spesso genera una serie di note legate a note “extra” da 1/64, ed altre cose senza senso.

Un rimedio standard è la quantizzazione, grazie alla quale il programma arrotonda tutti i valori 
nota al sedicesimo (semicroma) più vicino (o a qualsiasi altro valore specificato). Il problema è che 
ciò migliora la situazione solo con musica relativamente semplice – inoltre, accelerando o ral-
lentando l’esecuzione, il computer perde il tempo generando in ogni caso confusione.

Grazie alla funzione Flexi-time, invece, Sibelius rileva se l’esecutore sta eseguendo un “rubato”, lo 
compensa quantizzandolo automaticamente – non c’è bisogno di specificare un valore di quantiz-
zazione – e usa un algoritmo che varia la quantizzazione in base al contesto della musica. 
Per esempio, suonando note corte Sibelius quantizza a un valore più breve di quando si suonano 
note lunghe.

Inoltre, grazie all’utilissima funzione Live Playback, Sibelius separa la notazione stampata dalle 
sfumature dell’esecuzione registrata. La riproduzione della musica inserita in Flexi-time, quindi, 
può corrispondere esattamente a ciò che è stato suonato– fino alle più piccole variazioni in durata 
e dinamica di ogni nota – e la notazione rimane chiara e ordinata.

Registrare in Flexi-time
* Sebbene sia possibile modificare il tempo in chiave dopo aver inserito la musica, si 

raccomanda d’inserire prima il tempo in chiave corretto, in modo che il click del met-
ronomo indichi correttamente i movimenti della misura.

* Cliccare su una misura, nota o pausa dalla quale iniziare a registrare, oppure:
% Per registrare su due righi adiacenti (nel caso di un piano, ad esempio) selezionarli entrambi 

con un clic, quindi con Maius-clic del mouse.
% Se si registra dall’inizio di una partitura per uno strumento, non serve selezionare nulla 

prima (poiché è ovvio il punto dal quale s’inizia a registrare).
* Cliccare sul pulsante rosso Record nella finestra Playback, oppure selezionare Note > Flexi-time

(comando rapido Ctrl+Maius+F o xXF).
* Sibelius avvia il count-in del metronomo; di default è una misura intera di click (aspettare 

questa misura prima d’iniziare a suonare!).
* Per regolare la velocità della registrazione trascinare il cursore tempo; l’indicatore tempo sulla 

barra degli strumenti cambia trascinando il cursore; per registrare più lentamente, avviare la 
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registrazione, regolare il cursore tempo nel punto desiderato, quindi premere la barra spaziatrice 
per fermare e avviare di nuovo la registrazione – Sibelius ricorderà il tempo impostato.

* Iniziare a suonare sulla tastiera seguendo il click del metronomo (almeno approssimativa-
mente); mentre si suona, la musica appare scritta in notazione sullo schermo.
Accelerando o rallentando, il metronomo aumenta o diminuisce seguendo l’esecuzione (sempre 
che non si cambi il tempo troppo bruscamente).

* Al termine della registrazione premere la barra spaziatrice per fermarla.

Aggiungendo altra musica con Flexi-time su un rigo o righi diversi, Sibelius riproduce la musica 
esistente mentre si registra (“overdubbing”).

Per inserire un’altra melodia sullo stesso rigo, si può registrare su una delle altre voci – vedere 
Voci in seguito.

Impostazioni di click
Le impostazioni del click che si sente durante la registrazione in Flexi-time si controllano selezio-
nando Finestra > Mixer (comando rapido Ctrl+Alt+M o M su Mac) oppure si può accedere ad 
alcune di esse con il pulsante Click nella finestra di dialogo Note > Opzioni Flexi-time (comando 
rapido Ctrl+Maius+O o xXO).

Di default, il click segna il primo movimento della misura con un suono forte legnoso ed i movi-
menti successivi sempre con un suono legnoso, ma più debole. Nei tempi composti (come 6/8), 
suddivide anche il movimento in note da 1/8 (crome). Per tempi irregolari (come 7/8) la funzional-
ità di default è accentare l’inizio di ogni gruppo di movimenti.

Per maggiori informazioni su queste impostazioni, b Mixer.

Consigli
* Ascoltare i movimenti del countdown di Sibelius ed iniziare a tempo! Se si parte troppo presto (o 

a un tempo diverso dal countdown) Sibelius non riesce a rilevarlo.
* Se risulta difficile registrare su due righi, registrarli uno alla volta.
* Suonare in legato (in modo regolare ed omogeneo).
* Per scrivere gli “staccati” assicurarsi che sia attiva l’opzione Staccato nel menu Note > Opzioni 

Flexi-Time. Se questa opzione non è attiva, suonando in “staccato” Sibelius scrive note di breve 
durata seguite da pause.

* Quando si suona un accordo non è facile eseguirne simultaneamente le note. Separando molto le 
note dell’accordo, Sibelius scrive fedelmente ciò che si è suonato invece che, ad esempio, inserire 
una linea a serpentina verticale.

* Sibelius rileva molto rapidamente i cambi di tempo – più velocemente di una persona! Tuttavia, 
in presenza di cambi tempo repentini e improvvisi non sempre Sibelius riesce ad interpretare le 
reali intenzioni dell’esecutore; durante una registrazione, quindi, è bene evitarli.
Se Sibelius va fuori tempo rispetto alle note suonate, fermarlo e tornare al punto in cui è uscito. 
Se l’errore è grossolano, Sibelius può rientrare a tempo abbastanza bene; tuttavia, correggere un 
ritmo può essere ben più impegnativo che suonarlo di nuovo con più precisione!
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* Se la funzione Flexi-time genera una notazione complicata che si preferisce semplificare, pro-
vare con i plug-in presenti nella cartella Plug-in > Semplifica; in particolare, è utile il plug-in 
Renotate Performance – b Plug-in.

Inserimento note per due strumenti
È possibile inserire le note in due righi di strumenti diversi – Flauto e Fagotto, ad esempio – sem-
pre che siano adiacenti (e che non ci siano righi in mezzo semplicemente nascosti dal sistema in 
questione). Come per il piano, cliccare nel rigo superiore, quindi Maius-clic in quello inferiore per 
selezionarli entrambi e iniziare a registrare come al solito.

Registrare altri dati MIDI
Quando si registra in Flexi-time, Sibelius registra i dati controller MIDI insieme alle note. Per 
esempio, se durante l’inserimento via Flexi-time si usa il pedale sustain, Sibelius rileva i rispettivi 
messaggi MIDI nascondendoli automaticamente nella partitura. Altri dati controller MIDI che 
possono essere registrati sono: pitch bend, modulation, volume, ecc..

Se inserendo le note in Flexi-time si preferisce non registrare i messaggi MIDI, disattivare le rispet-
tive opzioni nella pagina Notazione della finestra di dialogo Note > Opzioni Flexi-time – vedere 
il capitolo Opzioni Flexi-time che segue.

Live Playback
Di default, Sibelius riproduce la musica inserita in Flexi-time usando la funzione Live Playback, 
che conserva le sfumature della registrazione (in particolare, dinamica e metrica precise di ogni 
nota). Si può anche editare l’esecuzione nei minimi dettagli. Per ascoltare invece la musica esatta-
mente come è stata scritta disattivare l’opzione Play > Live Playback (comando rapido Maius-L).

Per maggiori informazioni, b Live Playback.

Opzioni Flexi-time
Per modificare le varie opzioni Flexi-time disponibili, selezionare Note > Opzioni Flexi-time 
(comando rapido Ctrl+Maius+O o xXO):

La pagina Flexi-time presenta le seguenti opzioni:

* Flessibilità del tempo: controlla come Sibelius segue la velocità dell’esecuzione. Se si è abituati 
a suonare a metronomo, impostarla in Nessuna (non rubato); Sibelius manterrà un tempo 
fisso. Più alta s’imposta la flessibilità, più Sibelius tende a seguire il tempo dell’esecuzione.  
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Se Sibelius cambia il tempo in modo strano e fatica a seguire l’esecuzione, ridurre la flessibilità o 
impostarla in Nessuna (non rubato).

* Introduzione ... battute: stabilisce le misure d’introduzione riprodotte prima che inizi la regis-
trazione.

* Registra fino a ... battute: se nella partitura non rimangono molte misure nelle quali regis-
trare, quando inzia la registrazione questa opzione aggiunge automaticamente le misure man-
canti.

* Il pulsante Impostazioni Click apre una finestra di dialogo che stabilisce la funzionalità del click 
metronomico in registrazione – b Mixer.

* Opzioni Voci:
% Registra in una voce: permette di specificare una singola voce da usare per la registrazione 

in Flexi-time.
% Registra in voci multiple: è un’alternativa alla specifica di una singola voce: attivandola, 

Sibelius divide automaticamente la musica in due voci (se necessario); vedere Voci.
* Sostituisci e Overdub: controlla l’azione di Sibelius se si registra su un passaggio che già con-

tiene altra musica: in Sostituisci, Sibelius cancella la musica esistente prima di scrivere quella 
nuova eseguita; in Overdub, Sibelius aggiunge la nuova musica che si registra a quella esistente, 
formando accordi.

* Time Stamp MIDI interni: in un computer a doppio processore o con processore hyper-thread-
ing, può accadere che il ritmo della musica scritta perda la precisione man mano che la regis-
trazione procede; se nasce il problema attivare questa opzione (solo in Windows). 

La pagina Notazione presenta le seguenti opzioni:

* Opzioni Valori delle note :
% Regola ritmo: Sibelius ottimizza la notazione delle note suonate. Lasciarla attiva!
% Durata minima: stabilisce il valore nota più breve che Sibelius scrive. Non è un valore di 

quantizzazione – Sibelius quantizza con un algoritmo complesso che varia in base alle situ-
azioni, quindi questo valore non è forzato rigidamente ma agisce da guida. Per esempio, 
impostando una nota da 1/4 (semiminima) ma poi suonando note da 1/16 (semicrome) Sibe-
lius deve scrivere note più corte di 1/4, altrimenti si crea confusione.

% Trascrivi: sono opzioni di notazione per staccato e tenuto; se si è abituati a suonare le artico-
lazioni esattamente come si vuole vederle scritte, attivare queste opzioni. Se in seguito a un 
inserimento delle note in Flexi-time nella partitura si notano molte articolazioni staccato o 
tenuto imprecise, disattivarle, oppure regolare le soglie Se più breve di/più lungo di che rap-
presentano la percentuale del valore nota scritto oltre la quale sono scritte le articolazioni.

% Rimuovi pause tra le note su righi di batteria/percussioni: attiva di default, questa opzi-
one “raggruppa” le note più brevi per rimuovere pause superflue nelle parti di batteria.

* Righi di Tastiera: quando s’inseriscono le note su due righi, il punto di separazione determina 
quali note vanno in ciascun rigo (le note sul punto di separazione o sopra di esso sono collocate 
sul rigo superiore e quelle sotto vanno su quello inferiore). Selezionando Automatico, Sibelius 
“immagina” dove si trovino in ogni momento le mani dell’esecutore sulla tastiera e assegna 
opportunamente le note ai righi. Altrimenti, si può specificare un punto di separazione fisso 
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(Fisso). Si noti che in Sibelius, il DO centrale si chiama C4 (può essere diverso da quello impie-
gato da altri programmi musicali).

* Gruppi irregolari: per ogni duina elencata, si può impostare il modo in cui Sibelius la rileva: 
Nessuno/Semplice/Moderato/Complesso. Per esempio, un terzina “semplice” è formata da 
tre note uguali. Per duine di note da 1/4 (semiminima) seguite da una nota da 1/8 (croma), sceg-
liere Moderato, e per duine con pause o ritmi puntati usare l’opzione Complesso.

* Opzioni Messaggi MIDI:
% Mantieni messaggi program/bank: aggiunge alla partitura i messaggi MIDI program 

change e bank change utilizzando il formato di testo dei messaggi MIDI di Sibelius; questi 
messaggi sono nascosti automaticamente.

% Mantieni messaggi controller: anche questa opzione aggiunge tutti i messaggi controller 
(pitch bend, sustain pedal, channel volume, ecc.) e li nasconde nella partitura.

% Mantieni altri messaggi: aggiunge altri messaggi MIDI alla partitura.

Le opzioni Flexi-time consigliate sono quelle di default: Regola ritmo: on, Valore minimo nota : 
nota da 1/16 (semicroma), Flessibilità del tempo: Basso, Staccato e Tenuto: on, con soglie ris-
pettivamente di 35% e 110%. Per le duine impostare 3 a Semplice o Moderato (o anche 6) e le 
altre in Nessuno (a meno che non si suonino septuplet).

Registrare note trasportate
Nella pagina Inserimento nota del menu File > Preferenze (menu Sibelius in Mac) attivare l’opz-
ione Inserisci suono scritto se si sta registrando/suonando le note scritte da una partitura 
trasportata partitura (altrimenti, Sibelius presume che le note abbiano l’altezza suonata).

Spelling delle alterazioni
Analogamente all’inserimento in step-time, Sibelius “immagina” come “nominare” le note alterate 
(ad esempio, F# o Gb), ma si può modificare lo spelling di qualsiasi nota o selezione di note in un 
secondo momento premendo Invio (sulla tastiera del computer) o utilizzando uno dei plug-in 
delle alterazioni (b Plug-in).

Voci
Di default, quando si registra, Sibelius (se necessario) divide le note in due voci (per esempio, 
quando si suona musica polifonica, come una fuga). Nella maggior parte dei casi ciò è auspicabile, 
ma se s’inseriscono le note in un singolo rigo o per uno strumento monofonico è meglio “obbli-
gare” Sibelius a scrivere la musica in una sola voce (o in una voce specifica). Questa opzione si defi-
nisce nella finestra di dialogo Note > Opzioni Flexi-time (vedere in precedenza).

Sebbene in genere Sibelius distribuisca razionalmente la musica suonata in voci separate, può 
essere necessario tornare indietro e modificare alcuni passaggi per rendere la notazione più fedele 
alle proprie intenzioni. Per esempio, si potrebbe escludere la nota più bassa negli accordi della voce 
1 (b Filtri e Trova) e poi spostare tutte queste note nella voce 2, digitando Alt+2 o z2 – ; per 
ulteriori dettagli vedere Dividere le voci in b Voci .
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1.4 Scansione

Introduzione
PhotoScore Lite di Neuratron è un programma di scansione musicale progettato per funzionare in 
Sibelius – è l’equivalente musicale di un programma testuale OCR (rilevatore ottico di caratteri).

È un programma complesso con molte funzioni avanzate. Per la scansione di partiture relativa-
mente difficili (orchestrali/bandistiche) con molte pagine, si consiglia d’iniziare con musica più 
semplice fino a quando s’impara ad usare bene PhotoScore Lite e poi familiarizzare con la sezione 
FUNZIONI AVANZATE.

PhotoScore Ultimate
Una versione avanzata di PhotoScore Lite (PhotoScore Ultimate) con funzioni e migliorie extra si 
può acquistare separatamente. PhotoScore Ultimate legge molti più segni musicali (comprese 
duine, legature di portamento e testi) e partiture costituite da più di 12 righi.

Per i dettagli su PhotoScore Ultimate, selezionare Aiuto > PhotoScore Ultimate, oppure rivolg-
ersi al proprio rivenditore di Sibelius.

Scansione
Per un computer, sottoporre a scansione un testo è un’operazione difficile da eseguire e ha rag-
giunto un buon grado di precisione solamente negli ultimi anni. La scansione musicale è ancora 
più complicata a causa dei molti simboli e della “grammatica” musicale bidimensionale.

La difficoltà nel sottoporre a scansione musica o testo sta nel fatto che durante la scansione di una 
pagina musicale, il computer non la “comprende”. Il massimo che può fare un computer quando 
esegue una scansione è presentare una pagina con una griglia costituita da milioni di punti bianchi 
e neri, che possono essere musica, testo, un’immagine o qualsiasi altra cosa.

Il processo vero e proprio di lettura o interpretazione di musica, testo o immagini da questa griglia 
di punti è estremamente complesso e difficile da capire (gran parte del cervello umano, contenente 
milioni di “connessioni” è dedicato esclusivamente al “riconoscimento del percorso”!).

Installare e disinstallare PhotoScore Lite
Per installare e disinstallare PhotoScore Lite consultare la Guida (Handbook).

Originali supportati
PhotoScore Lite è progettato per leggere originali che:

* Sono stampati piuttosto che scritti a mano e usano note dallo stile “inciso” invece che “corsivo” 
(come quello di un libro non originale, ad esempio).

* Sono adatti allo scanner utilizzato (cioè la musica non è più grande della dimensione Lettera/A4, 
sebbene il foglio possa essere un pò più largo).

* Hanno un rigo dalle dimensioni di almeno 0,12 pollici/3mm.
* Non hanno più di 12 righi per pagina e 2 voci per rigo (sono omessi righi o voci aggiuntive).
* Sono abbastanza chiari – le linee del rigo devono essere continue e senza interruzioni o macchie, 

le teste delle note da 1/2 (minime) e intere (semibrevi) e i bemolle devono avere la circonferenza 
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continua e non spezzata o sbavata, tra i tratti d’unione sulle note da 1/16 (semiminime) e tra le 
note più brevi ci deve essere un vuoto significativo; inoltre, gli oggetti che devono essere separati 
(teste nota e alterazioni che le precedono) non devono sovrapporsi o essere un’unica macchia 
indistinta.

La musica che non soddisfa tali requisiti può essere leggibile, ma perde in termini di precisione.

La scansione di fotocopie non è consigliabile (a meno che la copia sia di ottima qualità) poiché la 
fotocopiatura tende a degradare molto la qualità dell’originale. Se l’originale è troppo grande per lo 
scanner, può capitare di eseguire la scansione da una fotocopia ridotta dell’originale; in tal caso, è 
probabile che ci sia una perdita di precisione della scansione.

Musica protetta da copyright
Attenzione a sottoporre a scansione musica scritta da terzi, poiché si violano i diritti d’autore. Ciò è 
illegale ed è proibito dal contratto per la licenza d’uso di Sibelius.

La maggior parte degli spartiti musicali ha il nome dell’autore. Nel caso si sottoponga a scansione 
un brano musicale del quale non si conosce l’autore contattare l’editore, il compositore o l’arrangia-
tore.

PER INIZIARE
Come Sibelius, PhotoScore Lite funziona allo stesso modo, sia in Windows che su Mac. Si può avvi-
are PhotoScore Lite selezionando File > Scansione nei menu di Sibelius, cliccando sull’icona Scan
nella barra degli strumenti di Sibelius, oppure dal menu Start (Windows) o con un doppio-clic del 
mouse sulla rispettiva icona (Mac). Non è necessario che Sibelius sia in esecuzione quando si usa 
PhotoScore Lite.

Le quattro fasi operative
PhotoScore Lite segue quattro fasi operative:

1. Scansione delle pagine

2. Lettura delle pagine

3. Editing della musica risultante

4. Invio della musica a Sibelius.

* Per sottoporre a scansione la pagina, PhotoScore Lite scatta una “foto” dell’originale.
* La lettura è la fase più delicata – PhotoScore Lite “legge” le pagine scansionate per riconoscere le 

note e gli altri segni musicali.
* Durante l’editing si correggono gli errori introdotti da PhotoScore Lite. In PhotoScore Lite l’edit-

ing funziona quasi come in Sibelius.
In PhotoScore Lite si può inserire o correggere quasi ogni tipo di segno, ma per ora è essenziale 
correggere solamente gli errori ritmici – le altre correzioni si possono fare una volta trasferita la 
partitura in Sibelius, se necessario.

* L’invio della musica a Sibelius avviene cliccando su un pulsante; dopo qualche secondo la musica 
appare in uno spartito di Sibelius, come se fosse stata inserita dall’utente.
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A questo punto si può riprodurla, riarrangiarla, trasportarla, creare nuove parti o stamparla.

Avvio rapido
Prima di esaminare nei dettagli il funzionamento di PhotoScore Lite, vediamo di introdurre breve-
mente le quattro fasi operative.

Sebbene usando PhotoScore sia più utile avere uno scanner collegato al computer si può “leggere” 
la musica anche senza usare uno scanner; basta salvare ogni pagina di musica sul computer in un 
file grafico con estensione .bmp (bitmap) in Windows, oppure TIFF e PICT (file Picture ) su Mac. 
(PhotoScore Ultimate può aprire anche i file in formato PDF).

Il primo passo consiste nel sottoporre a scansione la musica o aprire una pagina già sottoposta a 
scansione, ossia digitalizzata:

* Per sottoporre a scansione una pagina selezionare File > Scansiona pagine (comando rapido 
Ctrl+W o XW); si carica l’interfaccia dello scanner. Sottoponendo a scansione una pagina la si 
aggiunge all’elenco delle pagine digitalizzate in PhotoScore.

* Per aprire un file grafico selezionare File > Apri; alla richiesta della risoluzione con la quale è 
stata sottoposta a scansione l’immagine scegliere l’impostazione adeguata e cliccare su OK. I file 
grafici si aggiungono quindi all’elenco delle pagine digitalizzate.

PhotoScore Lite visualizza l’immagine digitalizzata, con le linee blu che indicano i righi trovati e le 
linee rosse che indicano che i righi sono uniti in parentesi quadra. Cliccare su Read pages per 
trasformare l’immagine digitalizzata in un file musicale (se appare un’altra finestra di dialogo con 
altre opzioni cliccare semplicemente su Read). La lettura di una pagina può richiedere più o meno 
tempo, dipende dalla velocità del computer (una barra di avanzamento indica il tempo rima-
nente).

Quando PhotoScore Lite ha termi-
nato la lettura dell’immagine, si apre 
la finestra di editing principale (a 
sinistra). Da qui è possibile correg-
gere eventuali errori nella musica.

Una volta eseguite le correzioni 
neessarie selezionare File > Invia a 
Sibelius (comando rapido Ctrl+D o
XD) per inviare la musica a Sibelius.

Se Sibelius non è già in esecuzione, 
si avvia e appare la finestra di dial-
ogo Apri file PhotoScore nella 

quale è possibile scegliere le varie opzioni per gli strumenti che saranno usati nello spartito di 
Sibelius. Per ora non c’è da preoccuparsi, cliccare su OK. Poco dopo appare lo spartito di Sibelius, 
pronto per l’editing (come se fosse l’utente a inserire le note).

1. SCANSIONE
Selezionare File > Scansiona Pagine (comando rapido Ctrl+W o XW) nel menu per aprire una 
finestra di dialogo che varia in base allo scanner utilizzato.
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Prima della scansione misurare la dimensione (altezza) dei righi sulla pagina da sottoporre a scan-
sione e scegliere la risoluzione dalla tabella seguente; sottoporre a scansione in bianco e nero o gri-
gio (non a colori):

Precisione di lettura e velocità si riducono notevolmente sottoponendo a scansione con una 
risoluzione troppo bassa o alta; non sottoporre a scansione a 400 dpi (a meno che i pentagrammi 
siano davvero piccoli).

In generale, si può scegliere se sottoporre a scansione in bianco e nero o scala di grigi. La scansione 
in grigio è molto più precisa – se nella finestra di dialogo della scansione questa opzione non è dis-
ponibile, consultare il manuale operativo dello scanner.

Ora si può sottoporre a scansione la prima pagina – fare una prova iniziando con una pagina o due 
di semplice musica per tastiera o simile:

* Collocate la pagina di musica (“originale”) sullo scanner, rivolta in basso e con la parte alta della 
pagina lontana da voi.
Appoggiate un lato dell’originale contro il bordo rialzato del vetro.
Si può anche sistemare la pagina sul proprio lato; PhotoScore Lite ruota automaticamente la pag-
ina di 90°, se necessario. Tuttavia, normalmente si allinea il bordo superiore della pagina al lato 
sinistro dello scanner (in modo che la pagina non esca capovolta). Non c’è da preoccuparsi 
comunque se viene digitalizzata al contrario, poiché è facile correggere in seguito.
Sottoponendo a scansione in grigio non è necessario che la pagina sia perfettamente diritta (a 
condizione che non sia ruotata di oltre 8°) – PhotoScore Lite equilibra automaticamente la pag-
ina (entro 0,1°) senza perdita di dettagli. Se sottoposta a scansione in bianco e nero è comunque 
ruotata, ma con una perdita di dettagli (quindi il risultato è meno preciso).

* Cliccare sul pulsante Scan.
* Poco dopo, lo scanner entra in funzione e trasferisce la pagina al computer. (Se ciò non avviene 

vedere PROBLEMI POSSIBILI).
* Eseguendo la scansione da un libro piuttosto voluminoso, premere lievemente in basso il coper-

chio dello scanner (o il libro, se è più comodo) durante la scansione, per mantenere piatta la pag-
ina sul vetro.

* Appare una finestra che consente di denominare la pagina (di default è Pagina 1). Si può dare 
un nome a piacere (sebbene, per evitare spiacevoli sorprese sia meglio numerarla) – ad esempio, 
Piano p1 – quindi premere Invio (sulla tastiera principale del computer).

* Le pagine successive digitalizzate saranno numerate automaticamente (per esempio, Piano p2 e 
così via) ma è possibile cambiare i nomi, se lo si desidera.

* Attendere alcuni secondi durante i quali PhotoScore Lite stabilizza l’immagine, scegliere la bril-
lantezza ottimale e individuare i righi.

* Apparirà quindi una scansione dell’intera pagina originale. Il colore opaco della carta indica che 
si visualizza un’immagine digitalizzata della pagina originale.

Dimensione rigo Risoluzione

0.25 pollici/6 mm o più 200 dpi

0.15-0.25 pollici/4–6 mm 300 dpi

0.12-0.15 pollici/3–4 mm 400 dpi
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Verificare che tutti i righi siano illuminati in blu – ciò indica che PhotoScore Lite ha rilevato 
dove si trovano. 
Se la pagina ha sistemi formati da due o più righi, verificare anche che i righi in ogni sistema 
siano uniti all’estremità sinistra da una linea verticale (o quasi verticale) rossa.
Se non tutti i righi sono blu, oppure non tutti i righi nei sistemi sono uniti da una linea rossa, si 
può dire manualmente a PhotoScore Lite dove si trovano (vedere FUNZIONI AVANZATE).
(Ignorare gli altri pulsanti in cima a questa finestra, poiché anch’essi sono descritti in FUNZI-
ONI AVANZATE).

* Collocare la seconda pagina di musica sullo scanner, selezionare File > Scansiona pagine e pro-
cedere come si è fatto per la prima pagina.

* Continuare così fino al termine della scansione di tutte le pagine desiderate.

Riassunto della scansione
Una volta digitalizzate alcune pagine si comprende subito la procedura che si può riassumere così:

* Collocare la pagina sullo scanner.
* Cliccare sul pulsante dello scanner o selezionare File > Scansiona Pagine.

* Scegliere la risoluzione e se la scansione deve essere in bianco e nero o in scala di grigi.
* Cliccare su Scansione.

* Inserire il nome della pagina (o lasciare quello di default).
* Verificare che righi e sistemi siano stati rilevati ed eseguire le regolazioni necessarie.
* Passare alla pagina successiva.

Catalogare le pagine scansionate
È importante capire che ogni volta che si digitalizza una pagina, PhotoScore Lite la aggiunge a un 
singolo elenco o “catalogo” di pagine digitalizzate da leggere in seguito. Non è necessario quindi 
salvare le pagine o il catalogo (sono salvati automaticamente sul disco rigido).

Ogni volta che lo si avvia, quindi, PhotoScore “ricorda” tutte le pagine scansionate in precedenza. 
(Si possono cancellare pagine che non serve conservare).

Maggiori dettagli sul catalogo sono descritti in seguito.

Consigli per la scansione
* Per leggere una pagina di musica più piccola delle dimensioni dello scanner, assicurarsi che sia 

digitalizzata solo la porzione desiderata.
La maggior parte degli scanner consente di sottoporre a scansione parte di una pagina, in genere 
cliccando sul pulsante Anteprima: si genera un’immagine in miniatura che può sembrare un pò 
“limitata.” Per regolare l’area desiderata trascinare con il mouse i bordi della miniatura.
Cliccare su Scansione per sottoporre a scansione l’area selezionata alla risoluzione più alta. 
Ogni volta che dopo questa operazione si clicca su Scansione, viene digitalizzata solo l’area 
selezionata fino a quando la si cambia.

* Assicurarsi che tutta la musica sulla pagina che si digitalizza sia posta sul vetro dello scanner.
Non importa se l’originale è più grande del formato Lettera/A4 se l’area occupata dalla musica 
rientra nel formato Lettera/A4.
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* Se si digitalizza una pagina più piccola del formato Lettera/A4, non importa dove si colloca 
l’originale sul vetro; è meglio però appoggiare il bordo del foglio a quello del vetro, in modo che 
sia diritto.

* Se si digitalizza un libro piccolo si potrebbe collocarlo con le due pagine (due facciate una 
accanto all’altra) sul vetro dello scanner, ma è meglio non farlo– PhotoScore Lite può leggere 
solo una pagina alla volta; sottoporre a scansione ogni pagina separatamente.

* Per semplicità, si consiglia di sottoporre a scansione tutte le pagine di un brano musicale prima 
di leggerle tutte. È possibile sottoporre a scansione una pagina, leggerla, digitalizzarne un’altra e 
così via (vedere FUNZIONI AVANZATE) ma si consiglia di non fare nulla del genere fino a 
quando non si conosce bene PhotoScore Lite.

2. LETTURA
Come accennato in precedenza, digitalizzando una pagina, il computer presenta una griglia con 
milioni di punti bianchi e neri, che potrebbero rappresentare qualsiasi cosa, da una testo a una 
fotografia.

“Leggere” la musica è il nodo cruciale, dal quale PhotoScore Lite rileva grazie alla scansione dove 
sono e cosa rappresentano le note e gli altri simboli musicali sulla pagina.

Avvio della lettura
Una volta digitalizzata ogni pagina della musica in questione, selezionare File > Leggi Pagine
(comando rapido Ctrl+R o XR).

PhotoScore Lite inizia a “ragionare” e visualizza una piccola barra di avanzamento, che mostra il 
nome della pagina corrente letta e l’avanzamento del processo di lettura. Questa finestra può essere 
ridotta o nascosta (in modo da poter continuare con un altro lavoro).

Cosa legge PhotoScore Lite
PhotoScore Lite legge i seguenti simboli musicali:

* Note e accordi (inclusa la direzione di gambi, tratti d’unione e bandierine) e pause.
* Bemolle, diesis e bequadri.
* Chiavi di violino e basso, tonalità e tempi in chiave.
* Righi a 5 linee (normali e ridotti), stanghette standard, tablature di chitarra a 6 linee.
* Formato pagina (inclusa la dimensione di pagina, rigo, margini e fine dei sistemi).

PhotoScore Ultimate (disponibile a parte) legge anche i testi, una più ampia gamma di chiavi e 
alterazioni ed è più preciso.

Consigli sulla lettura
* In generale non è necessario interrompere la lettura, ma normalmente (se necessario) è possibile 

farlo premendo Esc o X, oppure cliccando su Annulla nella finestra di progresso. PhotoScore 
Lite visualizza la parte di pagina già letta. Prima di sottoporre nuovamente a scansione o rileg-
gere la pagina si deve cancellarla selezionando Modifica > Elimina pagina .
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* Se durante la lettura di una pagina il computer genera un messaggio d’avviso, oppure impiega 
troppo tempo a leggere una determinata pagina, vedere PROBLEMI POSSIBILI.

* Volendo, si può fare in modo che PhotoScore Lite legga solamente una scansione o una serie di 
scansioni invece dell’intera partitura; vedere FUNZIONI AVANZATE.

3. EDITING
Quando PhotoScore Lite ha terminato la lettura della musica, la sua interpretazione della prima 
pagina appare nella finestra Output; qui si possono correggere gli errori eventualmente commessi 
da PhotoScore Lite.

La parte alta della finestra (con lo sfondo colorato opaco) mostra la pagina originale. La finestra 
Full detail view nell’angolo in alto a destra visualizza un’area ingrandita della pagina originale (in 
base a dove si punta il mouse).

La zona grande in basso nella finestra (con lo sfondo grigo chiaro) mostra l’interpretazione di Pho-
toScore Lite della prima scansione – cioè, quello che PhotoScore Lite ritiene sia scritto sulla prima 
pagina dell’originale. È in questa zona della finestra quindi che ci possono essere gli errori com-
messi da PhotoScore Lite.

In alto a sinistra nella finestra, PhotoScore Lite indica, ad esempio, Page 1 di 2; cliccando sulle 
frecce ci si può spostare tra tutte le pagine lette (la partitura d’uscita). Conviene correggere comple-
tamente la prima pagina, poi passare alla seconda e così via, fino a quando è stata sistemata l’intera 
partitura d’uscita.

In basso a destra nella finestra c’è il tastierino numerico con funzioni simili a quello di Sibelius; 
esso può essere riposizionato cliccando sulla barra del titolo e trascinandolo con il mouse.

In cima alla finestra c’è il menu Create, simile anch’esso al menu Crea di Sibelius (sebbene siano 
state omesse funzioni non adatte a PhotoScore Lite).
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Cosa correggere
Il livello di correzione minimo raccomandato prima d’inviare la partitura d’uscita a Sibelius è 
sistemare le tonalità e i tempi in chiave (key signature e time signature). Altri errori (come l’altezza 
delle note) possono essere corretti in Sibelius; tuttavia, è molto più semplice correggere tonalità e 
tempi in chiave in PhotoScore Lite, quindi è meglio farlo qui.

In particolare, se la partitura che si sta digitalizzando è trasportata, bisogna correggere le tonalità 
degli strumenti trasportati – per cancellare una singola tonalità, selezionarla e premere Ctrl+Canc
o X-Canc. Aggiungere poi la giusta tonalità al solo rigo: selezionare Crea > Tonalità (comando 
rapido K) e Ctrl+clic o X-clic sul rigo nel quale si vuole inserire la tonalità.

Per correggere errori ritmici, aggiungere il giusto tempo in chiave (se non già presente): selezion-
are Crea > Tempo in Chiave (comando rapido T) e cliccare in uno dei righi per aggiungere il 
tempo in chiave. Una volta che PhotoScore Lite conosce il tempo in chiave, tutte le imprecisioni rit-
miche sono indicate da piccole annotazioni rosse sopra la stanghetta della misura, che indicano il 
numero di movimenti extra o mancanti. Man mano che si correggono gli errori queste annotazioni 
scompaiono – e quando la partitura non ha più annotazioni rosse può essere inviata a Sibelius.

Quando si conosce bene PhotoScore Lite è possibile correggere la musica in PhotoScore Lite prima 
d’inviarla a Sibelius. Il vantaggio è la possibilità d’individuare gli errori guardando l’originale digi-
talizzato sullo schermo invece di vederlo scritto su carta.

Verifica degli errori
Verificare gli errori confrontando la parte bassa della finestra con la scansione originale in alto.  
Le parti in alto e in basso si muovono per mostrare la zona della pagina alla quale punta il mouse.

Evitare di confrontare la pagina d’uscita con la musica originale cartacea – è quasi sempre più 
comodo e veloce fare il confronto con la scansione sullo schermo.

In alto a destra nella finestra Output c’è la finestra dettagliata che mostra da vicino la parte 
dell’originale sulla quale si trova il puntatore del mouse. Con un Ctrl+clic o X-clic su questa 
finestra, s’ingrandisce o riduce l’immagine. Questa finestra può essere riposizionata cliccando e 
trascinando con il mouse la sua barra del titolo.

Riproduzione MIDI
Un altro modo per verificare gli errori è riprodurre la partitura d’uscita. Per farlo, il computer deve 
essere collegato a un dispositivo MIDI (se ci sono più dispositivi collegati sarà usato quello di 
default).

Per riprodurre l’intera pagina dall’inizio, assicurarsi che non sia selezionato nulla, cliccando in una 
zona della pagina priva di notazione musicale, quindi selezionare Play > Play/Stop (comando 
rapido P), oppure cliccare sul pulsante Play nella barra degli strumenti. Fare lo stesso per fermare 
la musica. Per riprodurre da un punto particolare della pagina, selezionare un oggetto in ognuno 
dei righi dai quali riprodurre; la riproduzione inizia dalla misura con la prima selezione.

Di default, tutti i righi riproducono un suono di piano che però si può cambiare: clic-destro (Win-
dows) o Control-clic (Mac) sui nomi all’inizio del primo sistema (per esempio Staff 1) e selezion-
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are Rename; si apre una finestra di dialogo simile a quella Crea > Strumenti di Sibelius, dalla 
quale scegliere il nome corretto (quindi il suono) usato da quel rigo.

Durante la riproduzione le misure riprodotte sono evidenziare in grigio. 

4. INVIO A SIBELIUS
Una volta corrette, le pagine della partitura possono essere inviate a 
Sibelius. Selezionare File > Invia a Sibelius (comando rapido Ctrl+D o
XD), oppure cliccare sulla piccola icona  accanto al pulsante Salva 
in cima alla finestra Output.

Se Sibelius non è già in esecuzione, si avvia ed appare la finestra di dia-
logo Apri file PhotoScore:

* Questa è una partitura traspositore: attivare questa opzione se la 
partitura contiene strumenti trasportati; quando si clicca su OK il 
programma chiede di scegliere gli strumenti corretti.

* Usa strumenti di default: apre il file senza tentare di capire quali 
sono gli strumenti impiegati nella partitura.

* Scegli strumento: consente all’utente di scegliere uno strumento per ogni rigo della partitura 
da una finestra di dialogo simile a quella Strumenti; nella musica digitalizzata scegliere il rigo 
che si vuole sostituire con uno strumento di Sibelius e cliccare su Aggiungi (come sempre). 
Aggiungendo uno strumento che normalmente utilizza due righi (come un piano) esso “userà” 
due righi dell’elenco situato all’estrema sinistra nella finestra di dialogo.

* Applicazione sceglie strumento: attivando questa opzione, Sibelius tenta di capire quali sono 
gli strumenti presenti nella partitura; per farlo, verifica i nomi dei righi configurati in Photo-
Score – se il nome di un rigo non corrisponde a uno strumento riconosciuto da Sibelius, il file si 
apre con il suono del piano (default).

* Usa dimensioni pagina scannerizzata: questa opzione indica a Sibelius di formattare la parti-
tura con la dimensione della pagina suggerita da PhotoScore. Di default, è usata la dimensione 
pagina del foglio manuscript utilizzato per l’import, ma se si desidera è possibile attivare questa 
opzione.

* Le opzioni Dimensioni carta, House style e di orientamento (Verticale o Orizzontale) 
determinano il formato documento della partitura risultante.

Una volta aperta la musica in Sibelius, si può fare ciò che si vuole (come se fosse stata inserita 
dall’utente) – tuttavia, per ulteriori chiarimenti vedere Strumenti multi-rigo.

Correggere gli errori ritmici
Inviando una partitura con misure “imprecise” da PhotoScore Lite a Sibelius, quest’ultimo allunga 
le misure troppo corte e accorcia quelle troppo lunghe.

Per farlo, Sibelius confronta la durata delle misure con il tempo in chiave principale. Se una misura 
è troppo corta, Sibelius inserisce semplicemente delle pause alla fine; se invece una misura è 
troppo lunga, l’accorcia togliendo una o più note/pause alla fine della misura.

Sebbene Sibelius regoli la durate delle misure in questo modo, si consiglia di correggere i ritmi sba-
gliati in PhotoScore Lite prima di sistemarli in Sibelius, poiché si risparmia molto lavoro.
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Formato
Sibelius utilizza le opzioni Adatta in un’accollatura e Adatta in una Pagina per assicurare che il 
formato della musica sia uguale all’originale. Tuttavia, se osservando il risultato finale le note 
appaiono troppo vicine o distanti tra loro, cambiare la dimensione del rigo nella finestra di dialogo 
Layout > Configurazione Documento (comando rapido Ctrl+D o XD). Altrimenti, se non è 
necessario che il formato della musica corrisponda all’originale, selezionare l’intero spartito 
(Ctrl+A o XA) e sbloccare il formato (Ctrl+Maius+ o xXU).

Strumenti Multi-rigo
Per gli strumenti che di default utilizzano due righi (come il piano) può essere impossibile impie-
gare i tratti d’unione dei righi incrociati sulla musica digitalizzata, poiché PhotoScore Lite tratta 
tutti i righi come strumenti separati; ciò significa che, di default, gli strumenti multi-rigo come le 
tastiere sono inviati a Sibelius su due righi dai nomi separati e senza parentesi graffa. 

Quando s’invia un file PhotoScore a Sibelius, si può usare la finestra di dialogo Apri file Photo-
Score per dire a Sibelius che, ad esempio, i righi 1 e 2 in realtà sono quelli per la mano destra e sin-
istra di un piano – scegliere gli strumenti, oppure cliccare su Applicazione sceglie strumento.

Nel caso di strumenti multi-rigo (come i Flauti 1+2), per averli scritti su due righi uniti da due sot-
toparentesi graffe con un singolo nome, si può importare ogni rigo come flauto e poi cambiare il 
nome ed aggungere una graffa in Sibelius, oppure importare entrambi i righi come piano e poi 
cambiare il nome e il suono (b Mixer).

Se l’originale contiene strumenti che hanno un numero diverso di righi su più sistemi, ad esempio 
gli archi (talvolta indicati divisi) vedere FUNZIONI AVANZATE.

Chiudere la partitura d’uscita
Una volta terminata e inviata a Sibelius la scansione di una partitura (e soddisfatti del risultato) 
chiudere la partitura in PhotoScore Lite prima di sottoporne a scansione una nuova. Per farlo, 
selezionare File > Chiudi; se la partitura ha modifiche non salvate, appare un messaggio che chiede 
di salvare.

Cancellare scansioni indesiderate
PhotoScore Lite salva auomaticamente ogni pagina che si sottopone a scnasione come immagine 
digitalizzata. Ciò occupa molto spazio sul disco rigido, quindi è bene eliminare periodicamente le 
scansioni già lette. Non cancellare però le scansioni prima di sottoporre a scansione il brano musi-
cale successivo.

Per cancellare scansioni indesiderate:

* Selezionare Vista > Pagine scansionate (comando rapido Ctrl+E o XE)
* Appare un catalogo con tutte le pagine scansionate (che ha molte applicazioni – vedere FUNZI-

ONI AVANZATE). Esso informa se ogni scansione è stata letta o meno.
* Cliccare sul pulsante Select Read in basso per selezionare tutte le scansioni lette e cliccare su 

Remove.

Dopo un messaggio d’avviso tutte queste scansioni sono cancellate.
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Salvare i file MIDI
Oltre a poter inviare la partitura d’uscita a Sibelius, si può anche salvare la partitura in un formato 
MIDI standard.

I file MIDI sono stati sviluppati per memorizzare dati di riproduzione musicale (in alternativa alla 
notazione musicale scritta) e hanno alcune limitazioni quando si tratta di memorizzare la musica 
digitalizzata. Tuttavia, essi sono molto utili, poiché virtualmente ogni dispositivo o software di 
editing musicale può leggere questi tipi di file.

Quando si salvano i file MIDI:

* Non è possibile memorizzare legature di portamento, direzione di gambi e tratti d’unione nota, 
fine rigo e posizionamento pagina, dimensione rigo e separazione di più voci per rigo. Se un file 
finisce in un pacchetto di notazione separata il risultato finale dipende da come un programma 
interpreta la musica. 

* Anche le funzioni musicali come cambi di chiave, pause, segni d’articolazione, note col punto, 
duine, simboli dinamici e legature di valore non possono essere memorizzate in un file MIDI. 
Tuttavia, se ci sono, PhotoScore Lite li emula in riproduzione; se il file MIDI è riprodotto da un 
programma di editing/riproduzione MIDI le funzioni si possono sentire, ma non necessaria-
mente sono presenti se caricate e visualizzate in un programma di notazione musicale. 

* Sebbene funzioni come tempi in chiave, tonalità e testo (come parole e titolo, ma non i simboli 
dinamici, poiché questi sono usati per emulare variazioni nel volume di riproduzione) siano sal-
vati nel file MIDI, non necessariamente tutti i software musicali li usano o visualizzano. 
Può darsi che nel software musicale ci sia un’opzione che consenta di usarle o ignorarle. 

* Gli strumenti assegnati a ciascun rigo sono memorizzati in base allo standard General MIDI. 
PhotoScore Lite riconosce intelligentemente gli strumenti MIDI usati dai nomi a sinistra di ogni 
rigo nella partitura d’uscita di PhotoScore Lite. Naturalmente, essi si possono cambiare con un 
altro programma musicale. 

* A causa dei limiti del file MIDI, possono essere salvati solo i primi 15 strumenti della partitura. 
* Il tempo è sempre impostato a 100 movimenti al minuto (BPM). Questo valore può essere cam-

biato con un altro programma musicale.

PROBLEMI POSSIBILI

Scansione molto lenta
Se non parte la scansione (cioè dopo aver cliccato sul pulsante Scan o Preview lo scanner resta 
inattivo, senza alcuna spia accesa o lampeggiante), molto probabilmente si è interrotta la comuni-
cazione tra il computer e lo scanner.

Verificare che lo scanner sia acceso e il cavo di connessione tra scanner e computer sia ben colleg-
gato a entrambe le estremità; altrimenti, provare a reinstallare il driver TWAIN dello scanner.

Alcuni scanner devono essere accesi prima del computer, altrimenti non sono riconosciuti.
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Non sono rilevati tutti i righi/sistemi
Se dopo la scansione di una pagina non tutti i righi sono evidenziati in blu, o i righi non sono cor-
rettamente uniti in sistemi da una spessa linea verticale rossa, i motivi possono essere vari:

* L’originale ha 13 o più righi su una pagina (solo PhotoScore Ultimate può sottoporre a scansione 
partiture con più di 12 righi).

* L’originale non era piatto sul vetro dello scanner: chiudere sempre il coperchio (a meno che si 
scansioni un libro voluminoso). Può aiutare una leggera pressione sul coperchio dello scanner.

* La pagina è stata scansionata a una risoluzione troppo bassa (i righi sono più piccoli del pre-
visto): verificare la dimensione del rigo, cambiare le impostazioni dello scanner e risottoporre a 
scansione.

* Si tenta di sottoporre a scansione una pagina doppia; PhotoScore Lite non può leggere entrambe 
le pagine in una volta (da uno spartito in miniatura, ad esempio). Risottoporre a scansione le 
pagine separatamente. Assicurarsi che la musica sulla pagina a fronte sia completamente fuori 
dal vetro o non digitalizzata – se interferisce con la scansione, PhotoScore Lite non leggerà cor-
rettamente la musica.

* I righi sull’originale non sono abbastanza nitidi per essere rilevati: in tal caso, si può dire a Pho-
toScore Lite dove si trovano sulla pagina i righi mancanti – vedere FUNZIONI AVANZATE.

La lettura è molto lunga
* Se la pagina è stata digitalizzata senza essere collocata piatta sul vetro o con il coperchio dello 

scanner aperto, si ha un bordo nero attorno alla pagina che può estendersi e coprire parte della 
musica. PhotoScore Lite può quindi impiegare moltissimo tempo a leggere la pagina. Se ciò avvi-
ene, interrompere la lettura (vedere in seguito) e risottoporre a scansione la pagina.

* Se dopo la scansione non sono stati rilevati tutti i righi (cioè alcuni non sono stati evidenziati in 
blu) la lettura si rallenta; vedere Non sono rilevati tutti i righi/sistemi.

Musica letta con poca precisione
Se la musica è stata letta con molte imprecisioni:

* L’originale non ha una buona qualità (è una fotocopia o una vecchia edizione musicale).
* L’originale è scritto a mano (o usa un font musicale che sembra scritto a mano): PhotoScore Lite 

non è in grado di leggere musica scritta a mano.
* La musica utilizza più di due voci.
* La musica è stata digitalizzata in bianco e nero e/o non era sufficientemente chiara: si racco-

manda di sottoporre a scansione in scala di grigi.
* La musica non era abbastanza chiara quando è stata digitalizzata e nelle preferenze non era 

selezionata l’opzione Make scans level (vedere FUNZIONI AVANZATE).
* I simboli musicali usati nell’originale non sono di forma o dimensione standard.

FUNZIONI AVANZATE
PhotoScore Lite ha molte funzioni e opzioni avanzate.
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Prima di eseguire una scansione complessa (partiture orchestrali/bandistiche o con molte pagine) 
si raccomanda di studiare bene questo capitolo.

Scegliere un buon scanner
Se c’è più di uno scanner collegato al computer è possibile scegliere tra più driver selezionando 
File > Seleziona Scanner.

Regolare i righi/sistemi rilevati
Quando si sottopone a scansione una pagina, PhotoScore Lite evidenzia in blu i righi rilevati e li 
unisce in sistemi con linee verticali rosse.

Tuttavia, se l’originale è di scarsa qualità, PhotoScore Lite potrebbe non rilevare alcuni righi/
sistemi, quindi bisogna dire a PhotoScore Lite dove si trovano.

Il metodo più semplice è selezionare il rigo in blu più vicino cliccandoci sopra e copiarlo con un 
Alt+clic o z-clic sulla linea centrale del rigo mancante (la posizione orizzontale non è impor-
tante).

Per creare da zero un rigo blu cliccarci sopra e trascinarlo fuori con il pulsante sinistro del mouse.

Una volta creato il rigo, assicurarsi che sia unito a un rigo dello stesso sistema (vedere in seguito).

PhotoScore Lite colloca automaticamente il rigo al suo posto, regolandone posizione e dimensione, 
se sotto trova un rigo adeguato. Se non si trova correttamente posizione/dimensione del rigo, 
ingrandire l’immagine a piena grandezza (cliccando sul pulsante 100 in alto) e regolare il rigo con 
le “maniglie” blu.

* Con il pulsante sinistro del mouse si può trascinare qualsiasi rigo blu in alto e in basso. In questo 
modo il rigo si colloca automaticamente al suo posto.

* Si possono trascinare le estremità dei righi blu ed è possibile collocarli in un angolo. 
* Si può anche modificare la dimensione di qualsiasi rigo blu – tirare in alto o in basso le “man-

iglie” al centro del rigo. PhotoScore Lite può leggere pagine che hanno righi di varie dimensioni, 
ed ogni rigo blu può avere una dimensione diversa. La maniglia circolare in alto consente di 
modificare la curvatura del rigo. Ciò è utile quando si sottopongono a scansione le pagine da 
libri voluminosi, nei quali è inevitabile una certa curvatura della pagina ai bordi.

* Se un qualsiasi rigo digitalizzato rimane privo del rigo blu in alto, il rigo digitalizzato e tutta la 
musica presente in esso sono ignorati quando la pagina è letta. Ciò può rallentare la lettura, ma 
non ci sono altre conseguenze.

* Per unire tra loro due righi adiacenti nello stesso sistema cliccare su un rigo in modo che si col-
ori di rosso, quindi Alt+clic r z-clic sull’altro rigo. Essi saranno uniti vicino all’estremità sinistra 
da una linea spessa verticale (o quasi verticale) rossa.

* Per separare due righi uniti in due sistemi separati seguire la stessa procedura d’unione.
* PhotoScore Lite prevede automaticamente se i righi debbano essere uniti o meno quando se ne 

creano di nuovi o si spostano quelli esistenti.
* Se nasce confusione con i righi blu e si vuole ricominciare, Ctrl+doppio-clic o X-doppio-clic del 

mouse sulla scansione: PhotoScore Lite reimposta i righi blu alle rispettive posizioni originali.
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* Una volta terminato l’editing di righi/sistemi controllare attentamente che i righi siano tutti uniti 
correttamente nei sistemi, poiché una volta letta la pagina ciò non si può cambiare.

Opzioni della finestra Scan
Nella finestra Scan sono disponibili altri pulsanti e funzioni:

* Il pulsante Read this page legge la scansione; cliccando sulla freccia del pulsante si apre un 
menu che consente di scegliere, una volta letta, dove inserire la pagina nella partitura d’uscita.

* Scale apre una finestra di dialogo che permette d’ingrandire e ridurre la scansione. Il pulsante a 
destra di quello Scale adatta l’immagine alla finestra principale; 50 ingrandisce del 50%; 100
del 100%.

* Upside down ruota l’immagine di 180° (nel caso la pagina sia stata digitalizzata al contrario).
* Re-scan risottopone a scansione la pagina.
* On side ruota l’immagine di 90° (nel caso la pagina sia stata digitalizzata di lato).

Elenco delle immagini scansionate
Selezionando Vista > Pagine scansionate (comando rapido Ctrl+E o XE) appare un catalogo di 
pagine scansionate, simile a questo:

* La seconda colonna (Status) indica se la scansione è stata letta o meno.
* La colonna Read next indica le scansioni che saranno lette quando si clicca in seguito su Read 

pages – si può selezionare o deselezionare questa opzione per ogni pagina digitalizzata. Per 
farlo, selezionare la scansione e cliccare il pulsante Read next o Don’t read a destra. Ciò con-
sente di compilare una scelta arbitraria di scansioni in una partitura invece di usare tutte quelle 
non lette.

* I quattro pulsanti in basso selezionano rispettivamente tutte le scansioni, solo le scansioni lette, 
solamente quelle che non sono state lette e nessuna scansione. 

* Cliccando su Remove a destra si cancellano le scansioni selezionate; 
* Cliccando su Display, o con un doppio-clic del mouse su uno dei nomi delle scansioni è visual-

izzata la scansione (come se fosse stata appena eseguita).
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* I pulsanti freccia gialli a sinistra servono per spostare la scansione selezionata in alto e in basso 
nell’elenco (e cambiare quindi l’ordine con il quale sono lette le scansioni).

Righi omessi
In partiture per molti strumenti (in particolare quelle orchestrali) i righi non usati sono spesso 
omessi.

Sostituendo i nomi di default degli strumenti all’inizio (ad esempio, “Staff 1”) con nomi adeguati, 
nei sistemi successivi, PhotoScore Lite colloca gli strumenti sui righi in ordine dall’alto in basso. 
Quindi, se la pagina originale omette uno strumento da un sistema, nella finestra Output alcuni 
dei righi avranno i nomi sbagliati. In questa situazione, per correggere un nome, clic-destro o
Control-clic del mouse sul nome dello strumento esistente nel rigo in questione e selezionare il 
giusto strumento dall’elenco degli strumenti correnti.

Su un qualsiasi sistema con righi omessi, probabilmente bisognerà correggere molti nomi degli 
strumenti in questo modo; farlo con ordine e cautela per evitare confusione.

Strumenti multi-rigo
Per strumenti multi-rigo (come le tastiere e le sezioni di legni e archi), PhotoScore Lite tratta ogni 
rigo come uno strumento dal nome distinto.

Se il numero di righi per uno strumento multi-rigo varia molto nell’originale (ove, ad esempio, gli 
archi sono divisi) per evitare confusione tra i righi è meglio dare nomi leggermente diversi, per 
esempio, Viola a e Viola b. I nomi si possono nuovamente cambiare una volta che la partitura è 
stata inviata a Sibelius.

Se i righi dello strumento sono omessi, seguire le instruzioni descritte in Righi omessi.

N.B. Se il numero dei righi per lo strumento aumenta nel corso della partitura (per esempio, da 1 a 
2) e il secondo rigo prima non c’era, trattarlo seguendo le istruzioni descritte in Strumenti/righi 
introdotti dopo l’inizio.

Strumenti/righi introdotti dopo l’inizio
Alcune partiture hanno strumenti o righi che non appaiono nel primo sistema.

Quando ciò avviene, nel sistema dove è stato introdotto il primo strumento/rigo bisogna eseguire 
le seguenti operazioni:

* Innanzitutto correggere il nome di ciascuno degli altri righi:
Clic-destro (Windows) o Control-clic (Mac) del mouse su ogni nome e scegliere quello giusto 
dall’elenco degli strumenti correnti.

* Comunicare a PhotoScore Lite il nome del nuovo strumento/rigo introdotto.
* Collocare il puntatore su un nome qualsiasi (potrebbe essere, ad esempio, Staff 5, oppure il nome 

di uno strumento omesso); clic-destro(Windows) o Control-clic (Mac) del mouse, cliccare su 
New e cliccare su un nome nell’elenco degli strumenti visualizzati (è simile a quello della 
finestra Strumenti di Sibelius). Per un nome non standard modificare il nome in basso.

Eseguire con cura questa operazione – altrimenti si crea molta confusione.
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Righi piccoli
Nella finestra Output, i righi piccoli sono visualizzati a piena grandezza per renderli leggibili, ma 
sono indicati dal simbolo seguente inserito alla fine del rigo:

Altre preferenze
La finestra di dialogo File > Preferenze presenta altre opzioni:

Nella pagina Scanning:

% Automatic scanning e Scan more quickly ci sono solo in PhotoScore Ultimate
% PhotoScore: attivandola, PhotoScore usa solamente la propria interfaccia di scansione.
% TWAIN (scanner default): se attiva, quando si seleziona File > Scan pages è usata l’interfac-

cia TWAIN standard (che funziona con tutti i programmi di scansione).
% Select TWAIN scanner consente di scegliere lo scanner che PhotoScore dovrà usare.
% Make scans level: attivandola, PhotoScore Lite rileva quanto è ruotata la scansione e la ruota 

a sua volta in modo che i righi siano orizzontali; si consiglia di lasciarla attiva.
% Read pages after scanning/opening c’è soltanto in PhotoScore Ultimate.

* Nella pagina Reading la maggior parte delle opzioni sono disabilitate (poiché sono disponibili 
solo in PhotoScore Ultimate):
% Ties, Slurs and Hairpins: è parzialmente abilitata, perché PhotoScore Lite può leggere solo le 

legature di valore.
% Read one voice per staff only: si può attivarla per migliorare la precisione se la musica che 

si digitalizza contiene sempre una voce per rigo.
% Display these options before reading: attivandola (default) si possono aggiornare alcune 

preferenze di precisione e velocità prima che inizi la lettura. Per iniziare la lettura cliccare sul 
pulsante OK in basso a destra nella finestra di dialogo che appare.

* Nella pagina Editing:
% Automatic page margins: crea gli opportuni margini su ogni pagina.
% Attach scanned staff panel to current staff: nella finestra Output, colloca la scansione 

originale appena sopra il rigo evidenziato (invece che in cima alla finestra). Ciò consente di 
muovere meno gli occhi quando si confronta la partitura d’uscita con l’originale (anche se 
questo potrebbe indurre più facilmente in errore l’occhio durante il confronto).

% Drag paper by: consente di scegliere se la carta si trascina con un click & drag del mouse, 
oppure tenendo premuto Maius e trascinando il mouse (come per le opzioni presenti nella 
pagina Mouse della finestra di dialogo File > Preferenze di Sibelius ).

* Nella pagina General:
% Computer audio properties: apre la finestra di dialogo con le proprietà del dispositivo 

audio e sonoro del sistema operativo, consentendo di scegliere i dispositivi per la riproduzi-
one e registrazione audio e quello preferito per la riproduzione MIDI.

% Skin design: permette di modificare l’aspetto di PhotoScore per farlo corrispondere a quello 
di Sibelius o del suo programma gemello G7.
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% Display splash screen at start-up: permette di disattivare lo splash screen di PhotoScore 
Lite quando si avvia il programma.

% Auto-save to backup file every n minutes: esegue automaticamente un salvataggio peri-
odico della partitura all’intervallo di tempo specificato.

Modificando queste opzioni, esse restano memorizzate come nuove impostazioni di default ogni 
volta che si usa PhotoScore (fino a quando le si cambia nuovamente).
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1.5 Inserire una tablatura per chitarra

b Diagrammi accordo, Notazione e tablatura per chitarra, Tablatura per liuto.

Questo capitolo spiega come inserire una tablatura usando la tastiera del computer, una chitarra 
MIDI o convertendo la notazione esistente in tablatura. Si può inserire la tablatura in altri modi:

* Importando un file MIDI, b Aprire i file MIDI;
* Importando un file di tablatura in formato ASCII, b File in tablatura ASCII;
* Sottoponendo a scansione musica stampata, b Scansione.

Sibelius scrive automaticamente la musica in notazione tradizionale o tablatura in ogni tonalità. 
Non deve “fare” nulla per eseguire tale conversione – tratta la tablatura semplicemente come un 
modo diverso di visualizzare la musica. In Sibelius, quindi, con la tablatura è possibile fare pres-
soché qualsiasi cosa che si fa con la notazione musicale tradizionale – si può riprodurla, traspor-
tarla, copiarla (su altri righi di tablatura o notazione musicale) e così via.

Si può anche inserire la musica in tablatura per trasformarla poi in notazione tradizionale (e vice-
versa), cambiare la tablatura standard per chitarra in un’accordatura diversa oppure scriverla per 
basso, mandolino, banjo, dobro, sitar o basso theorbo.

Creare uno strumento con tablatura
La chitarra e altri strumenti a tasti si trovano nella finestra di dialogo Crea > Strumenti (comando 
rapido I) con un rigo di tablatura che si crea automaticamente. Nella finestra di dialogo sono 
denominati, ad esempio Chitarra [tablatura].

Altrimenti, si può trasformare un rigo di notazione in uno di tablatura con un cambio strumento: 
selezionare Crea > Altro > Cambio Strumento, scegliere lo strumento con tablatura che si vuole 
usare e cliccare all’inizio dello spartito.

Trasformare la notazione in tablatura o la tablatura in notazione
Spesso serve avere due righi – uno di notazione e l’altro di tablatura che mostrano la stessa musica 
(oppure può essere necessario trasformare la notazione in tablatura o viceversa); per farlo, basta 
semplicemente copiare la musica da un tipo di rigo all’altro.

* Creare due chitarre, una in notazione e l’altra in tablatura o usare l’opzione Guitar + Tab.

* Inserire tutta la musica nel rigo di notazione (ad esempio).
* Selezionare tutta la musica come se fosse un passaggio con un triplo-clic nel rigo di notazione.
* Copiarla nel rigo di tablatura con Alt+clic o z-clic del mouse sulla prima misura. Essa si tras-

forma magicamente in tablatura:

* Si può quindi modificare il rigo di tablatura, ad esempio, spostando le note su corde diverse.
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Si può eseguire la stessa procedura al contrario – inserendo la tablatura per poi copiarla sul rigo di 
notazione. Poi, se non servono entrambi i righi (ma basta solo eseguire la conversione notazione - 
tablatura) si può cancellare il rigo originale.

In un rigo di notazione, la chitarra è scritta un’ottava più alta di come suona in realtà; quindi, copi-
ando la musica da un altro rigo (di uno strumento non trasportato come un piano, ad esempio), 
sul rigo di chitarra essa apparirà un’ottava più in alto, ma sarà riprodotta alla stessa altezza.

Inserire la tablatura
Inserire la tablatura dalla tastiera del computer è molto semplice e le operazioni principali si pos-
sono riassumere in pochi punti:

* Selezionare la misura dalla quale iniziare l’inserimento delle note e scegliere Note > Inserisci 
Note (comando rapido N).

* Appare il cursore (una piccola linea verticale) che indica la corda sulla quale ci si trova.
* Scegliere la durata della nota da inserire usando la finestra tastierino numerico, oppure dig-

itando il tasto corrispondente sul pad numerico della tastiera del computer.
* Usare i tasti 3 e 2 per spostarsi in alto e in basso sulle corde e i tasti 0 e 1 per muoversi avanti e 

indietro nella misura.
* Per inserire una nota, digitare il numero del tasto usando i tasti numerici sulla tastiera princi-

pale del computer (non il pad numerico).
* Per creare quarti di tono in una tablatura, creare la nota come al solito poi (con la nota selezion-

ata) digitare =; sul rigo di tablatura il quarto di tono è indicato dal numero tasto seguito da .5. 
Per creare quarti di tono su un rigo di notazione usare le alterazioni dal quinto layout del tast-
ierino numerico.

Spostandosi nella misura si può cambiare il valore nota di default con i tasti 0 e 1 nella pagina 
Mouse della finestra di dialogo File > Preferenze (menu Sibelius in Mac); cambiare l’opzione 
Posizioni ritmiche approssimate a al valore nota desiderato. Disattivare l’opzione Snap 
nell’inserimento di intavolature per chitarra se si vuole che i tasti 0 e 1 consentano di 
spostarsi alla stessa distanza del valore nota corrente selezionato sul tastierino numerico, a meno 
che non vi sia una nota tra la posizione corrente del cursore e quella successiva (in tal caso sarà 
selezionata quella nota).

Note non suonabili
Quando si copia musica tra i righi – per esempio da una tablatura per chitarra a 6 corde ad una per 
basso a 4 corde oppure da un rigo di notazione a uno di tablatura per chitarra – alcune note 
potrebbero non essere suonabili. In questo caso sul rigo di tablatura appare un punto interrogativo 
(?), a indicare che quella corda deve essere corretta dall’utente.

Opzioni di diteggiatura della tablatura per chitarra
Quando crea una tablatura – copiando da un rigo di notazione a uno di tablatura, da uno di tabla-
tura a un altro con accordatura diversa, inserendo le nota da una tastiera o chitarra MIDI, oppure 
importando un file MIDI – Sibelius cerca di generare la diteggiatura più comoda da suonare.

Nella sezione Diteggiatura intavolatura chitarra della pagina Inserimento nota in 
File > Preferenze (menu Sibelius in Mac) si può specificare l’intervallo di tasti preferito che Sibel-
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ius utilizzerà per le diteggiature. È possibile specificare i tasti più bassi e alti che Sibelius tenterà di 
usare, se tenterà di usare o meno corde libere (ove possibile) e il numero di tasti che si può coprire 
quando si suonano gli accordi.

Queste condizioni non sempre sono soddisfatte; si tratta solo di semplici indicazioni. Per esempio, 
se si disattiva l’opzione Usa preferibilmente corde aperte ma Sibelius ha bisogno di creare una 
nota che può essere suonata solamente con una corda libera, nella diteggiatura Sibelius indica 
quella nota come corda libera, invece di non indicarla affatto.

Sibelius non riscrive tutta la tablatura esistente nello spartito se si cambia qualcosa in questa 
finestra di dialogo. Per applicare nuove impostazioni alla tablatura esistente usare l’opzione Note >
Ripristina diteggiatura chitarra (vedere in seguito).

Ripristinare la diteggiatura della tablatura
Si può ripristinare la diteggiatura in un rigo di tablatura agli intervalli desiderati in ogni momento. 
Selezionare il passaggio in cui ripristinare la diteggiatura e selezionare Note > Ripristina diteg-
giatura chitarra.

Per esempio, se si pensa che un passaggio particolare sia più comodo da suonare intorno al quinto 
tasto invece che vicino al capotasto, impostare nuove preferenze nella pagina Note Input della 
finestra di dialogo File > Preferenze (menu Sibelius in Mac), quindi applicare quelle preferenze al 
passaggio in questione selezionando Note > Ripristina diteggiatura chitarra.

Quando Sibelius ripristina automaticamente la diteggiatura della tablatura?
In generale, la diteggiatura è mantenuta se si copia all’interno dello stesso rigo o in un altro rigo 
con la stessa accordatura. Copiando musica su un rigo di notazione o tablatura con un’accordatura 
diversa, Sibelius ricalcola la diteggiatura basandosi sulle impostazioni presenti nella pagina Note 
Input della finestra di dialogo File > Preferenze (menu Sibelius in Mac).

Tuttavia, nel caso specifico di spartiti costituiti da un solo rigo di notazione e tablatura (cioè 
diverse rappresentazioni della stessa musica) è utile mantenere le informazioni di diteggiatura 
quando si copia tra questi righi, poiché si potrebbe copiare più volte da un rigo all’altro. In tal caso, 
attivare l’opzione Ricorda diteggiatura nel copiare in un rigo di notazione standard nella pag-
ina Inserimento nota della finestra di dialogo File > Preferenze (menu Sibelius in Mac).

Uso di una chitarra MIDI
Sibelius consente d’inserire le note da una chitarra MIDI che supporta più canali MIDI – 
b Dispositivi d’ingresso MIDI.
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1.6 Selezioni e passaggi

b Filtri e Trova.

v Selezione e copia.

Quando sono selezionati in uno spartito, gli oggetti si colorano ad indicare che è possibile fare 
qualcosa usando il mouse e la tastiera del computer. In Sibelius, la maggior parte delle operazioni 
riguarda le selezioni.

Ci sono tre tipi principali di selezione:

* Selezione singola: è selezionato solo un oggetto.
* Selezione multipla: sono selezionati più oggetti distinti.
* Selezione di un passaggio: è selezionata una frase musicale continua, contornata da un box di 

colore blu chiaro (“passaggio sul rigo”) o un box doppio color porpora (“passaggio di sistema”).

Su tutti i tre tipi di selezione si fanno più o meno le stesse cose; la differenza principale è in come si 
selezionano gli oggetti la prima volta.

Inoltre, si può selezionare un rettangolo di musica per esportarlo come grafica – b Esportare 
file grafici.

Selezione dei colori
Quando un oggetto è selezionato, cambia colore:

* Note e testi con linee allegate al rigo sono colorati in base alla voce(i) alla quale appartengono (la 
voce 1 è blu scuro, la voce 2 è verde, la voce 3 è arancio e la voce 4 è rosa). Se un oggetto appar-
tiene in più di una voce (o in tutte le voci) assume il colore blu chiaro.

* Vari altri oggetti del rigo (simboli, chiavi, cambi strumento, ecc.), riguardano tutte le voci, 
quindi anch’essi sono di colore blu chiaro.

* Gli oggetti di sistema (per esempio, scritte di sistema, linee e simboli, tempi in chiave, tonalità, 
ecc.), quando sono selezionati diventano color porpora.

Selezioni singole
Per eseguire una selezione singola, cliccare su un oggetto – tutto qui.

* Si può selezionare un oggetto anche senza usare il mouse – con niente selezionato, premere Tab
per selezionare il primo oggetto sul rigo in alto nella pagina.

* Per selezionare l’oggetto successivo sul rigo si possono usare i tasti freccia o il tasto Tab (per 
selezionare l’oggetto precedente, premere Maius-Tab).

* Per selezionare una particolare testa nota in un accordo, premere Alt+3/2 o z3/2 per selezi-
onare la testa nota successiva sopra o sotto quella corrente selezionata.

* Se non ci sono accordi, un Alt+3/2 o z3/2 seleziona la nota alla posizione ritmica più vicina 
sul rigo sopra o sotto.

* Si può anche spostarsi tra varie parti delle linee premendo Alt+0/1 o z0/1 – b Linee e 
b Legature di portamento.
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* Un altro metodo per eseguire una selezione singola è usare la funzione Modifica > Trova
(comando rapido Ctrl+F o XF) – b Filtri e Trova.

Se non si riesce a selezionare un oggetto con il mouse (perchè c’è un altro oggetto molto vicino che 
rimane selezionato al suo posto) premere Tab (o Maius-Tab) per spostare la selezione all’oggetto 
che si vuole selezionare, oppure ingrandire molto l’immagine e provare a selezionarlo di nuovo; se 
anche questo tentativo fallisce, spostare temporanemante l’altro oggetto da un’altra parte.

Selezioni multiple
* Cliccare su un oggetto e Ctrl+clic o X-clic su uno o più degli altri oggetti per aggiungerli alla 

selezione; nuovo Ctrl+clic o X-clic su un oggetto per rimuoverlo dalla selezione.
* Altrimenti, Maius-clic o X-clic in una zona vuota e trascinare il box grigio chiaro attorno agli 

oggetti da selezionare (si chiama anche selezione “marquee” o “lasso”). Trascinando nell’intero 
rigo si seleziona invece un passaggio; si possono poi aggiungere/rimuovere oggetti dalla selezi-
one con un Ctrl+clic o X-clic. Se si usa spesso questa funzione, modificando l’impostazione 
Drag Paper nella finestra di dialogo File > Preferenze > Generali (menu Sibelius in Mac OS X) 
si può selezionare un passaggio cliccando e trascinando il mouse (senza premere Maius o X).

* Con le selezioni multiple di testo si può estendere una singola selezione con il comando 
Modifica > Seleziona > Seleziona Altro (digitare Ctrl+Maius+A o xXA) che seleziona tutti 
gli oggetti testuali simili (cioè con lo stesso stile) nello stesso rigo in quel sistema. È un modo 
rapido per selezionare, ad esempio, un’intera fila di simboli, accordi, parole, diteggiature o segni 
d’espressione.

* Se è selezionata la singola nota di un accordo, il comando Modifica > Seleziona > Seleziona 
Altro seleziona tutte le note dell’accordo; analogamente, se c’è una singola nota, pausa o un 
intero accordo selezionato, il comando Modifica > Seleziona > Seleziona Altro seleziona 
l’intera misura.

* Per eseguire una selezione multipla si possono anche usare i filtri – b Filtri e Trova.

Le selezioni multiple sono utili soprattutto per oggetti diversi da note, accordi e pause – per cancel-
lare più articolazioni o frammenti di testo, ad esempio.

Passaggi selezionati
Un “passaggio” è una frase musicale continua – di qualsiasi durata (da un paio di note all’intero 
spartito) e costituita da un qualsiasi numero di righi, da uno ad un’orchestra completa. Si può 
immaginarlo come un “rettangolo” di musica – sebbene questo rettangolo si possa estendere tra 
sistemi e pagine e in un passaggio si possano includere anche righi non adiacenti.

Al contrario di selezioni multiple, i passaggi selezionati si usano principalmente per eseguire oper-
azioni su più note, accordi e pause.

Ci sono due tipi di passaggi: normalmente, i passaggi sono circondati da un singolo box blu chiaro 
e possono contenere qualsiasi combinazione di righi dello spartito; i passaggi di sistema, al con-
trario, sono circondati da un doppio box color porpora e contengono tutti i righi dello spartito.

Per selezionare un passaggio con il mouse:
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* Cliccare sulla nota/accordo/pausa ad un angolo (l’angolo in alto a sinistra, ad esempio) del “ret-
tangolo” che si vuole selezionare; se si seleziona l’inizio della misura è più rapido cliccare in una 
zona vuota della misura.

* Maius-clic sulla nota/accordo/pausa all’angolo opposto (l’angolo in basso a destra, ad esempio) 
del “rettangolo”; se si seleziona la fine della misura cliccare in una zona vuota della stessa.

* Tutti gli oggetti selezionati si colorano ed appare un box blu chiaro intorno alla selezione. La 
selezione appare anche sul Navigatore (utile per visualizzare passaggi distribuiti su più pagine).

* Per aggiungere altri righi alla selezione tenere premuto Ctrl o X e cliccare su altri righi; con 
questa operazione si possono aggiungere alla selezione righi non adiacenti.

* Si possono anche escludere dalla selezione determinati righi con un Ctrl-clic o X-clic a turno sui 
righi che si desidera rimuovere dalla selezione.

Si può selezionare un passaggio anche con la finestra Modifica > Seleziona > Seleziona battute 
(comando rapido Ctrl+Alt+A o zXA); è utile quando si sa ciò che si vuole selezionare (le prime 
16 misure di una partitura, ad esempio) o si vuole selezionare dalla posizione corrente alla fine 
dello spartito. L’opzione Selezione di accollatura trasforma la selezione del passaggio in un pas-
saggio di sistema.

Per selezionare un passaggio di sistema, si fa lo stesso, ma con un Ctrl-clic o X-clic su una zona 
vuota della misura e tenendo premuto Ctrl o X mentre si clicca su altre note/accordi/pause in altri 
righi per estendere il passaggio.

Naturalmente, si può selezionare un passaggio usando solo la tastiera del computer:

* Con una nota selezionata, premere Maius-0/1 per estendere la selezione in orizzontale di una 
nota alla volta o Ctrl+Maius+0/1 o xX0/1 per estenderla di una misura per volta; è simile 
alla funzionalità dei programmi di testo (come per i vari altri impieghi dei tasti freccia).

* Per selezionare più righi, premere Maius-3/2 per includere un altro rigo nel passaggio.
* Per trasformare la selezione corrente in un passaggio di sistema selezionare Modifica >

Seleziona > Seleziona Passaggio di Sistema (comando rapido Maius+Alt+A o xzA).

Per selezionare un passaggio trascinando il mouse: tenere premuto Maius o X e trascinare un ret-
tangolo iniziando da sopra il rigo in alto all’inizio del passaggio desiderato e finendo sotto l’ultimo 
rigo alla fine; ciò è pratico solo per brevi passaggi.

Situazioni veloci
Ci sono vari modi per selezionare rapidamente alcuni tipi di passaggi:

* Cliccando nella zona vuota di una misura la si seleziona su quel rigo (per copiarla, ad esempio).
* Un doppio-clic del mouse nella zona vuota di una misura seleziona quel rigo per la durata del 

sistema (per copiare quelle misure, ad esempio).
* Un triplo-clic del mouse nella zona vuota di una misura seleziona quel rigo in tutto lo spartito 

(per eliminare un intero strumento, ad esempio).
* Dopo un singolo, doppio o triplo clic, eseguendo Maius-clic del mouse su un altro rigo si 

aggiungono tutti i righi in mezzo alla selezione, oppure (come prima) si possono aggiungere o 
rimuovere singoli righi con un Ctrl-clic o X-clic.
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* Tenendo premuto Ctrl o X durante un singolo, doppio o triplo clic iniziale, si seleziona un pas-
saggio di sistema (che è racchiuso in un doppio box color porpora).

* Si può anche selezionare l’intero spartito selezionando Modifica > Seleziona > Seleziona Tutto
(comando rapido Ctrl+A o XA). Ciò è molto utile per trasportare l’intero spartito, alterare il for-
mato dell’intero spartito o selezionare particolari tipi di oggetti lungo lo spartito (vedere in 
seguito).
(In altre parole, Modifica > Seleziona > Seleziona Tutto è come un Ctrl+triplo-clic o X+triplo-
clic del mouse).

Cosa si può fare con selezioni multiple e passaggi selezionati?
Virtualmente, ad una selezione multipla o un passaggio selezionato si può fare tutto ciò che si fa su 
una nota singola (e altro ancora); per esempio:

* Copiarla da qualche altra parte con un Alt-clic o z-clic del mouse (molto comodo per arran-
giare l’orchestrazione); la copia sostituisce le note, a meno che non si selezioni un passaggio di 
misure con Ctrl o X (in tal caso, la copia le inserisce).

* Cancellarla – basta premere Canc; se il passaggio è stato selezionato con un Ctrl o X (quindi 
aveva un doppio box che lo circondava) sono cancellate anche le misure stesse.

* Ripeterla con la lettera R – vedere Ripetizione delle selezioni in seguito.
* Trasportarla, usando la finestra di dialogo Transpose (b Trasporto intonazione) per 

trasportarla di un intervallo specifico o diatonicamente con i tasti 3 /2; con un Ctrl+3/2 o
X3/2 il trasporto è di un’ottava.

* Costruire accordi aggiungendo note sopra o sotto – digitare 1–9 per aggiungere un intervallo 
sopra, oppure Maius-1–9 per aggiungere un intervallo sotto (ma non quest’ultimo se si usa il set 
di funzioni Notebook (laptop) – b Menu e comandi rapidi).

* Riprodurla selezionando Play > Sposta linea Playback alla selezione o premendo Y, poi clic-
care sul pulsante Play nella finestra Playback o premere la barra spaziatrice.

* Arrangiare la musica per una serie di strumenti diversi “distribuendo” il passaggio su numero di 
righi più vasto o “riducendolo” a un numero inferiore – b Arrange™

* Utilizzare un plug-in per verificare, modificare o aggiungere qualcosa alla selezione – b Plug-
in

* Aggiungere articolazioni a tutte le note/accordi usando il primo o quarto layout del tastierino 
numerico.

* Reimpostare la spaziatura nota ai valori di default selezionando Layout > Ripristina Spaziatura 
Nota(comando rapido Ctrl+Maius+N o xXN).

Copia multipla
Con la copia multipla si copia una selezione singola, multipla o un passaggio più volte in orizzon-
tale (nello stesso rigo), in verticale (su più di un rigo) o in entrambe le direzioni in una volta.

Copia multipla di un singolo oggetto
Si può copiare un singolo oggetto (nota o testo) in verticale su un numero qualsiasi di righi. È utile 
per copiare più segni dinamici (mf, ad esempio) su più righi in una sola volta:
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* Selezionare un singolo oggetto e scegliere Modifica > Copia (comando rapido Ctrl+C o XC) per 
copiarlo nel clipboard.

* Selezionare un passaggio in uno o più righi e scegliere Modifica > Incolla (comando rapido 
Ctrl+V o XV) per copiare l’oggetto solo all’inizio del passaggio (una copia su ogni rigo).

Copia multipla di una selezione multipla
Per estendere l’operazione precedente, si possono selezionare più oggetti e copiarli in verticale su 
un numero qualsiasi di righi; ciò è molto utile per copiare una serie di segni dinamici:

* Eseguire una selezione multipla – Ctrl+clic o X-clic del mouse sugli oggetti da copiare, oppure 
selezionarli con un filtro (Modifica > Filtro > Dinamiche, ad esempio) e scegliere Modifica >
Copia (comando rapido Ctrl+C o XC) per copiarli sugli Appunti.

* Selezionare un passaggio in uno o più righi e scegliere Modifica > Incolla (comando rapido 
Ctrl+V o XV) per copiare la selezione solo all’inizio del passaggio (una copia per ogni rigo) 
mantenendo nelle copie le rispettive distanze tra gli oggetti originali; se nel passaggio di destina-
zione ci sono righi nascosti, la copia multipla è eseguita anche nei righi nascosti.

Copia multipla di un passaggio
* Selezionare un passaggio in uno o più righi e scegliere Modifica > Copia (comando rapido 

Ctrl+C o XC) per copiarlo sugli Appunti.
* Selezionare un altro passaggio e scegliere Modifica > Incolla (comando rapido Ctrl+V o XV) 

per completare il nuovo passaggio con copie multiple del passaggio originale; il nuovo passaggio 
è inserito con i seguenti criteri:
% Orizzontalmente: se il passaggio di destinazione è più lungo dell’originale, nel nuovo passag-

gio è incollato un numero intero di copie (le misure in più alla fine restano intatte). Se il pas-
saggio di destinazione è più breve dell’originale è eseguita solo una copia.

% Verticalmente: se il passaggio di destinazione contiene più righi dell’originale, dal rigo in alto 
scendendo in basso è eseguito un numero intero di copie (i righi più in basso restano intatti). 
Se il passaggio di destinazione ha meno righi dell’originale è eseguita solo una copia.

Attenzione, poiché la copia multipla sostituisce i contenuti originali del passaggio di destinazione e 
li copia su tutti i righi nascosti eventualmente presenti nel passaggio di destinazione!

Ripetizione delle selezioni
Per eseguire copie multiple di una selezione si può usare anche il comando Modifica > Ripeti
(comando rapido R):

* Selezionare una nota, accordo, passaggio, selezione multipla, linea, oggetto di testo, simbolo, 
diagramma accordo, grafica importata, cambio strumento, chiave, tonalità o stanghetta e pre-
mere il tasto R.

* L’oggetto(i) selezionato è ripetuto una volta a destra; per ripeterlo più volte, continuare a pre-
mere il tasto R.
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1.7 Dispositivi d’ingresso MIDI

b Inserimento note, Flexi-time™.

Con una tastiera MIDI o un altro dispositivo d’ingresso collegato al computer, si può usare l’inseri-
mento step-time e Flexi-time. Per informazioni su come configurare il computer per l’ingresso 
MIDI, b Setup MIDI in Windows e Setup MIDI in Mac nella Guida.

Scelta dei dispositivi d’ingresso
La pagina Dispositivi ingresso nella finestra di dialogo File > Preferenze (menu Sibelius in Mac) 
presenta le opzioni per l’ingresso MIDI:

La tabella in alto elenca tutti i dispositivi MIDI d’ingresso presenti. Le opzioni sono:

* Usa: Attivando il box di spunta in questa colonna, Sibelius accetta l’ingresso dei dati da quel dis-
positivo; disattivandolo, Sibelius ignora qualsiasi ingresso dati da quel dispositivo.  
Di default, il box di spunta Usa è attivo per tutti i dispositivi.

* Nome dispositivo: questa colonna indica il nome del dispositivo. Se la porta MIDI è rappresen-
tata da una scheda audio o interfaccia MIDI esterna, normalmente c’è il nome della porta stessa 
(per esempio, MIDISport USB 2x2 A o SB Live! MIDI Out) invece del nome di ogni dispositivo 
collegato alla porta o interfaccia MIDI. Se il dispositivo MIDI si collega direttamente al computer 
(via USB, ad esempio), probabilmente apparirà il nome vero e proprio del dispositivo MIDI (per 
esempio, M-Audio Oxygen 8).

* Tipo: indica il tipo di dispositivo. Cliccandoci sopra si apre un menu a tendina che consente di 
scegliere Keyboard (default) o Guitar. Scegliendo Guitar si abilitano i controlli MIDI Guitar 
Channels situati sotto la tabella – vedere Chitarre MIDI in seguito.
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* Mappa ingresso: consente di specificare esattamente il tipo di tastiera presente su un partico-
lare dispositivo; è utile poiché molte tastiere hanno manopole, cursori e pulsanti che possono 
essere utilizzati in Sibelius – vedere Mappature d’ingresso in seguito.

Suonare le note sulla tastiera (o un altro dispositivo d’ingresso MIDI) mentre la finestra di dialogo 
è aperta. Se tutto funziona bene il piccolo indicatore nero Test s’illumina in verde mentre si suona; 
se non s’illumina verificare le connessioni MIDI e assicurarsi di avere selezionato il dispositivo 
MIDI corretto (se presente più di uno).

Attivare il box di spunta MIDI Thru se (e solo se) la tastiera non ha suoni interni – questa opzione 
fa in modo che Sibelius riproduca le note suonate sulla tastiera dalla scheda audio o altro disposi-
tivo di riproduzione.

Problemi con l’ingresso MIDI
Se un ingresso MIDI non funziona verificare che l’uscita MIDI OUT della tastiera sia collegata 
all’ingresso MIDI IN sul computer e (se la tastiera ha suoni interni) l’ingresso MIDI IN della tasti-
era sia collegato all’uscita MIDI OUT sul computer – mai MIDI OUT a MIDI OUT e MIDI IN a 
MIDI IN. Se il computer ha due connettori MIDI IN provare a collegare la tastiera all’altro ingresso 
MIDI IN.

Mappature d’ingresso
Se la tastiera MIDI ha molti pulsanti, manopole e fader in più rispetto a una standard, essi si pos-
sono usare in Sibelius (per controllare i fader nel Mixer, la riproduzione e così via).

Scegliere l’oggetto adeguato elencato in Input Map nel box in alto della pagina Dispositivi ingresso 
della finestra di dialogo File > Preferenze (menu Sibelius in Mac). Di default, provare MIDI key-
board che funziona con molte tastiere MIDI; altrimenti, se nell’elenco è presente la tastiera speci-
fica utilizzata, scegliere la mappatura d’ingresso per quella tastiera.

Altre mappature d’ingresso sono disponibili all’Help Center on-line che si può visitare selezio-
nando Aiuto > Centro aiuto.

Chitarre MIDI
Usando una chitarra MIDI, Sibelius consente di assegnare ogni canale MIDI a una corda, in modo 
che le diteggiature appaiano automaticamente sulla corda corretta di un rigo di tablatura.  
Si possono anche configurare vari filtri per eliminare il “rumore” scambiato per note.

In una chitarra con pick-up esafonico (come il Roland GK-2A o GK-3) e un’interfaccia per chitarra 
MIDI (Axon AX100, Roland GR-33 o GI-20, ecc.), Sibelius può scrivere le note suonate su una 
corda nella giusta corda sulla tablatura, sia usando l’inserimento Flexi-time che step-time.

Per dire a Sibelius che si sta usando una chitarra MIDI, impostare come Tipo una Chitarra per il 
rispettivo oggetto nell’elenco dei dispositivi d’ingresso. Attivare quindi Input device is a guitar 
that ouputs one MIDI channel per string (a meno che la chitarra MIDI invii in uscita qualsiasi 
cosa si suoni su un singolo canale; in tal caso non attivare questa opzione). Nota: con questa opzi-
one attiva, le opzioni Diteggiatura Tab Chitarra di dialogo File > Preferenze (menu Sibelius in 
Mac) non hanno effetto durante l’inserimento delle note (sebbene siano comunque usate quando, 
ad esempio, si copia la musica da un rigo all’altro). 
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A questo punto:

* Impostare il valore Numero di corde appropriato.
* Se necessario, impostare il valore Canale MIDI della corda con la più alta intonazione. Sibe-

lius presume che le corde della chitarra MIDI siano numerate in sequenza; se non lo sono con-
sultare il manuale operativo dell’interfaccia per la chitarra MIDI e impostarne adeguatamente le 
opzioni.

Si possono anche impostare alcune delle opzioni Omit Wrong Notes, descritte in dettaglio nel 
paragrafo Opzioni d’inserimento nota a pagina 13. Uno dei problemi più comuni durante 
l’inserimento di note e accordi con una chitarra MIDI è che il software riconosce fedelmente ogni 
nota rilevata dal pick-up: anche se il chitarrista suona in modo molto pulito, spesso note molto 
deboli o brevi non suonate intenzionalmente appaiono ugualmente nella partitura; analogamente, 
talvolta i pick-up MIDI rilevano armoniche basse o alte che sono poi scritte nella notazione come 
note molto gravi o acute. Sibelius permette di adattare la sensibilità della sua notazione allo stile 
del chitarrista. (Queste opzioni, inoltre, possono essere utili anche per dispositivi d’ingresso diversi 
da una chitarra MIDI).

Per maggiori dettagli sull’inserimento MIDI (da tastiera o chitarra), vedere la Guida o i capitoli 
b Inserimento note e b Flexi-time™.

Consigli per un buon inserimento via chitarra MIDI
Sibelius trascrive qualsiasi cosa si suona, esattamente come è suonata. Tuttavia, alcuni fattori pos-
sono contribuire a una trascrizione imprecisa. Anche se Sibelius stesso può ignorare note a bassa 
velocity (vedere Opzioni d’inserimento nota a pagina 13) è bene assicurarsi che quando si usa 
una chitarra MIDI la sensibilità del convertitore MIDI sia piuttosto bassa; pennate accidentali sulle 
corde, note fantasma e altre anomalie, infatti, emergono di più quando la sensibilità è alta.

Ronzii delle corde su tasti alti o un cattivo setup della chitarra confondono il convertitore MIDI che 
può generare note poco fedeli; se si riscontrano tali imprecisioni è bene fare revisionare lo stru-
mento da un esperto.

Nell’interfaccia della chitarra MIDI sperimentare varie modalità di pennata. Roland e Axon hanno 
le opzioni interne per l’inserimento con il plettro (pick-style) e con le dita (finger-style). Provare le 
varie impostazioni, poiché per alcuni chitarristi l’inserimento con le dita è più preciso di quello con 
il plettro (e viceversa).

Sibelius non scrive informazioni di pitch bend, slide o bending delle corde durante l’inserimento 
delle note. Si possono creare nello spartito in seguito, ma quando s’inseriscono le note è impor-
tante suonare in modo molto pulito (evitando vibrati, slide o bending) per avere una notazione 
precisa.

Un’ultima osservazione: le corde lisce offrono una notazione molto più chiara in Sibelius.
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2.1 Acciaccature

b Ornamenti, b Lavorare con le parti.

La acciaccature sono piccole note usate in generale per un paio di motivi. In parti strumentali, i 
passaggi acciaccati aiutano l’esecutore a sapere dove si trova e non devono essere suonati. I pas-
saggi acciaccati possono anche indicare musica facoltativa (per esempio, un solo di armonica 
potrebbe diventare una parte di clarinetto con l’indicazione: “suonare se non c’è l’armonica”).

Non si confondano le acciaccature con gli ornamenti (b Ornamenti): le prime infatti occupano 
spazio ritmico nella misura e suonano come note normali. Poiché un’acciaccatura può contenere 
ornamenti o teste nota speciali, qualsiasi nota – sia essa normale, con una testa nota speciale o per-
fino un ornamento – può avere la dimensione di un’acciaccatura (anche pause, misure di pausa e 
altri oggetti come testi, linee e simboli).

L’altro motivo per usare note piccole è la scrittura di accompagnamenti facoltativi per tastiere 
(musica corale e strumentale) e nella parte di solo in un accompagnamento di tastiera; in questi 
casi, però, è meglio non usare le acciaccature, ma rimpicciolire i rispettivi righi (operazione che 
rimpicciolisce anche tutte le note e gli altri oggetti) – b Righi.

La dimensione delle acciaccature è proporzionale a quella del rigo – normalmente, le note d’acci-
accatura si trovano su un rigo di dimensioni normali, ma collocandole su un rigo piccolo esse 
diventano ancor più piccole; le note d’acciaccatura si possono scrivere anche su un rigo piccolo per 
ottenere note davvero molto piccole.

Comando Incolla come guida
Creare un passaggio d’acciaccature con il comando Modifica > Incolla come guida richiede poco 
tempo (per ‘Cue’ si intende la battuta d’entrata o, più semplicemente, ‘guida’):

* Assicurarsi di vedere tutta la partitura non solo una delle parti dinamiche. Sebbene per una 
parte dinamica si possa usare il comando Modifica > Incolla come guida, è meglio usarlo 
sull’intera partitura, in modo da vedere il rigo dal quale si preleva il materiale per incollare le 
acciaccature in più strumenti contemporaneamente.

* Copiare la musica da usare come acciaccature sugli Appunti, selezionandola e scegliendo 
Modifica > Copia (comando rapido Ctrl+C o XC).

* Selezionare la misura di pausa o la pausa nel rigo o nei righi sui quali si vuole inserire l’acciacca-
tura e selezionare Modifica > Incolla come guida (comando rapido Ctrl+Maius+Alt+V o
xzXV). Selezionando più di un rigo, Sibelius incolla l’acciaccatura su tutti i righi selezionati 
con una copia multipla (b Selezioni e passaggi).

Ecco fatto! Quando s’incolla un passaggio d’acciaccature, Sibelius fa una serie di altre cose:

* La musica copiata è incollata nella prima voce inutilizzata, con tutte le note e gli altri segni 
ridotti alla dimensione dell’acciaccatura.
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* L’acciaccatura è nascosta nella partitura completa, ma appare nelle parti (sebbene, volendo, si 
può dire a Sibelius di mostrare l’acciaccatura anche nella partitura completa – vedere Prefer-
enze del comando Incolla come guida).

* Sibelius tiene conto di tutti i trasporti più insoliti (per esempio, trasporta l’acciaccatura di un 
clarinetto in LA su un ottone in un rigo di FA) e, se necessario, aggiunge la chiave opportuna o 
una linea d’ottava per assicurare che l’acciaccatura sia facilmente leggibile, in base alle proprie 
preferenze – vedere Preferenze del comando Incolla come guida.

* Il nome dello strumento acciaccato è scritto sopra l’acciaccatura con lo stile di testo Instrument 
name (cues), che si può modificare se si desidera cambiarne l’aspetto o la posizione di default – 
b Modifica stili di testo.

* Se il tipo di rigo (il numero di linee, ad esempio) dello strumento acciaccato e il rigo di destina-
zione non corrispondono, a inizio e fine acciaccatura sono creati gli opportuni cambi strumento.

* Segni particolari (parole, segni dinamici, legature di portamento e forcine) sono inclusi o esclusi 
automaticamente in base alle preferenze definite – vedere Preferenze del comando Incolla 
come guida.

* Le note d’acciaccatura non sono riprodotte (Sibelius disattiva automaticamente i box di spunta 
Suona al passaggio nel pannello Playback della finestra Proprietà – vedere Quando ripro-
durre le note a pagina 271).

* In una voce inutilizzata (sia nell’intera partitura che nelle parti) sono aggiunte le opportune mis-
ure di pausa, in modo che appaiano corrette (sebbene, volendo, si può dire a Sibelius di non 
aggiungere misure di pausa nelle parti – vedere Preferenze del comando Incolla come 
guida).

Una delle poche cose che Sibelius non fa è decidere lo strumento da usare per l’acciaccatura, 
sebbene possa suggerire dove sarebbe meglio inserire le acciaccature – vedere in seguito.

Plug in Trova posizioni note guida
Quando si preparano le parti per un’esecuzione, una delle operazioni più lunghe e noiose è stabilire 
dove le acciaccature siano più utili per gli esecutori; esse, infatti, si potrebbero aggiungere dopo un 
certo numero di misure di pausa o dopo un certo tempo. Il plug-in Plug-in > Altro > Trova posiz-
ioni note guida esegue questa operazione – vedere Trova posizioni note guida a pagina 412.

Verificare il plug-in delle acciaccature
Le modifiche eseguite sulla musica nella partitura dopo l’inserimento delle acciaccature nelle parti, 
in teoria possono introdurre errori, poiché Sibelius non aggiorna automaticamente i passaggi 
d’acciaccatura se i righi sorgente dai quali è prelevato il materiale sono in seguito modificati. Tutta-
via, Sibelius ha un utile plug-in che verifica le acciaccature confrontandole con la musica dalla 
quale sono prelevate e avvisa se trova delle incongruenze; selezionare il passaggio in questione e 
scegliere Plug-in  > Verifica di lettura > Controlla battuta d’entrata – vedere Controlla bat-
tuta d’entrata a pagina 417.

Preferenze del comando Incolla come guida
Nella pagina Incolla come guida della finestra File > Preferenze (menu Sibelius in Mac) ci sono 
varie opzioni che determinano esattamente cosa avviene eseguendo il comando Modifica > Incolla 
come guida.

reference.book  Page 56  Wednesday, April 16, 2008  4:28 PM



2.1 Acciaccature

57

N
otazio

n
i

Le opzioni Regola chiave o trasposizione offrono tre alternative su come Sibelius risolve le dif-
ferenze tra i righi di sorgente e destinazione:

* Cambia chiave (se necessario): aggiunge una chiave all’inizio dell’acciaccatura incollata, se le 
chiavi usate dai righi di sorgente e destinazione non corrispondono. Incollando, ad esempio, un 
rigo di Cello su uno di Flauto, Sibelius crea una chiave di basso all’inizio dell’acciaccatura e 
rimette la chiave di violino alla fine. Si noti che questi cambi di chiave sono visibili solo nella 
parte.

* Aggiungi linea ottava (se necessario): aggiunge una linea d’ottava (fino a due ottave in alto o 
in basso, cioè 8va, 15ma, 8vb o 15mb) sopra l’acciaccatura incollata nel caso che Sibelius debba 
trasportare l’acciaccatura di una o più ottave perché s’inserisca adeguatamente nel rigo.

* Niente: incolla semplicemente l’acciaccatura nella chiave del rigo di destinazione senza traspor-
tare la musica in ottave.

Le opzioni Copia nella battuta d’entrata consentono 
di scegliere se Sibelius deve includere o meno Lega-
ture di portamento, Articolazioni, Dinamiche, 
Versi e Testo Technique nell’acciaccatura incollata.

Di solito, i passaggi d’acciaccatura nelle parti mostrano 
misure di pausa oltre alle note acciaccate, come indi-
cazione visiva supplementare per l’esecutore che le note 
hanno solo uno scopo informativo e non devono essere 
suonate. Tuttavia, in alcuni stili musicali (compreso il 
jazz) le acciaccature sono scritte come note più piccole 
senza l’aggiunta delle misure di pausa. Mostra bat-
tute in pause in ingresso (nelle parti) consente di 
scegliere quale convenzione seguire: se attiva (default), 
oltre alle note d’acciaccatura sono indicate le misure di 
pausa della misura originale; se disattiva, appaiono 
solo le note d’acciaccatura.

Anche qui, in alcuni stili musicali (di solito il jazz) talvolta si vede la scritta “Play” dopo l’acciacca-
tura, per ricordare all’esecutore che in quel punto deve ricominciare a suonare. L’opzione Scrivi 
‘Play’ dopo battuta d’entrata (non attiva di default) esegue questa operazione. È molto più utile 
se si disattiva l’opzione Mostra battute in pause in ingresso (nelle parti).

In generale, nella maggior parte degli stili musicali le acciaccature appaiono solo nelle parti, quindi 
l’opzione Nascondi battute d’entrata nella partitura completa è attiva di default. Tuttavia, le 
partiture di alcune musiche particolari (come quelle dei recital teatrali) di solito visualizzano le 
acciaccature in tutta la partitura; in questi casi è meglio quindi disattivare questa opzione .

Attenzione! Cambiando le opzioni qui, non s’influenzano le acciaccature già incollate; sono influ-
enzate solamente le acciaccature create in seguito con il comando Mofica > Incolla come guida.
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Creare acciaccature, pause e altri oggetti
Per fare in modo che una nota, pausa, linea, simbolo od oggetto di testo del rigo assuma le 
dimensioni di un’acciaccatura, selezionarlo e cliccare sul pulsante Dim. Guida indicato a 
destra (comando rapido Invio) nel secondo layout del tastierino numerico (comando 
rapido Invio). Creando note con mouse e tastiera o in step-time, le note continuano ad 
essere d’acciaccatura fino a quando non si disattiva nuovamente il pulsante.

Per far diventare un passaggio delle dimensioni dell’acciaccatura, selezionarlo e scegliere lo stesso 
pulsante nel secondo layout del tastierino numerico. Per far tornare acciaccature e pause dalle 
dimensioni d’acciaccatura a quelle normali, riselezionare il pulsante Dim. Guida.

Non è possibile portare scritte, simboli o linee di sistema alla dimensione d’acciaccatura, poiché 
essi non sono mai inclusi nei passaggi d’acciaccatura (ci sono già in tutte le parti).

Il pannello Generale della finestra Proprietà ha anche il box di spunta Dim. Guida, che ha la stessa 
funzione del pulsante omonimo.

Opzioni Regole tipografia
La pagina Note e Tremolo della finestra di dialogo House Style > Regole tipografia (comando 
rapido Ctrl+Maius+E o xXE) consente di modificare la dimensione di acciaccature e ornamenti 
rispetto alle note normali. Gli ornamenti, normalmente sono un po’ più piccoli delle acciaccature 
(il 60% della piena grandezza invece del 75%).

Note grandi
Nel caso (piuttosto raro) che servano note extra-large sui righi normali (notazione usata talvolta da 
Stockhausen per segnalare note forti) e non servono anche note dalla dimensione acciaccatura, 
impostare il valore del parametro Dimensione note guida nella pagina Note e Tremolo della 
finestra di dialogo House Style > Regole tipografia a 130% (ad esempio) e inserire le note grandi 
come se fossero acciaccature.
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2.2 Alterazioni

b Inserimento note.

Creare un’alterazione su una nota
Quando si crea una nota con il mouse o la tastiera del computer, è possibile aggiungervi subito 
un’alterazione scegliendola dal primo o quinto layout del tastierino numerico (comandi rapidi F8/
F12) prima d’inserire la nota nella partitura; dal tastierino numerico si possono anche aggiungere 
contemporaneamente articolazioni, punti ritmici, tremolo e tratti d’unione non standard.

Con l’inserimento da una tastiera MIDI le alterazioni si creano automaticamente.

Aggiungere le alterazioni alle note esistenti
Selezionare la nota (o le note) e scegliere un’alterazione dal primo o quinto layout del tastierino 
numerico.

Per aggiungere subito le alterazioni a tutte le note di un accordo, fare doppio clic con il mouse su 
una delle note presenti nell’accordo e scegliere l’alterazione desiderata.

Rimuovere alterazioni particolari
* Selezionare la nota (o le note) e scegliere di nuovo l’alterazione dal tastierino numerico 

per disattivarla.
* In alternativa, un metodo più lento e delicato consiste nel selezionare le alterazioni con il mouse, 

facendo attenzione a non selezionare anche le note e premere il tasto Canc.

Rimuovere una serie di alterazioni
Selezionare le note, quindi dal quinto layout del tastierino numerico (comando 
rapido F12) selezionare il tasto 0 sul pad numerico o il pulsante corrispondente 
indicato a destra.

Nascondere le alterazioni
In alcuni casi (passaggi con tratti d’unione incrociati, ad esempio – b Tratti d’unione) è prefer-
ibile nascondere un’alterazione, invece di eliminarla (la nota deve suonare alterata, ma l’alterazi-
one non deve apparire scritta sulla pagina).

Per farlo, selezionare l’alterazione (non la testa della nota) e scegliere Modifica > Mostra o 
Nascondi  > Nascondi (comando rapido Ctrl+Maius+H o xXH). Per ulteriori dettagli, 
b Nascondere oggetti.

Alterazioni in parentesi
Talvolta le alterazioni sono scritte in parentesi (tonde) per indicare che sono d’avvertimento o edi-
toriali. Per aggiungere la parentesi a un’alterazione su una nota selezionata (o gruppo di note) 
selezionare il pulsante parentesi dal quinto layout del tastierino numerico (comando rapido F12). 

In Sibelius, il plug-in Aggiungi alterazioni precauzionali controlla la partitura e, ove necessario, 
aggiunge le alterazioni d’avvertimento – b Plug-in.
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Le alterazioni editoriali, talvolta sono scritte in parentesi quadra. Per scriverle digitare le parentesi 
come scritta Technique. (Utenti esperti: se si utilizzano spesso le alterazioni in parentesi quadra è 
possibile creare facilmente nuovi simboli per le alterazioni in parentesi comuni, oppure modificare 
le alterazioni in parentesi già disponibili come simboli).

Alterazioni piccole
Le alterazioni si rimpiccioliscono automaticamente accanto ad acciaccature e ornamenti. Tuttavia, 
se si desidera un’alterazione più piccola su una nota di dimensioni normali, creare l’alterazione 
dalla finestra di dialogo Crea > Simbolo e scegliere Dim. Nota guida o Dim. nota d’abbelli-
mento, prima di cliccare su OK. Attenzione: i simboli delle alterazioni non sono riprodotti o 
trasportati automaticamente!

Doppie alterazioni e quarti di tono
Si trovano sul quinto layout del tastierino numerico, come le normali 
alterazioni.

I quarti di tono sono trasportati automaticamente – trasportare men-
talmente in alto di una 7a maggiore un MI di un quarto di tono 
bemolle: la risposta al quesito è in fondo al capitolo*. (Provare in 
seguito a scrivere la scala MI minore melodica di un quarto di tono 
bemolle!); Sibelius, oltre a farlo, rinomina i quarti di tono (vedere in 
seguito).

In Sibelius, il plug-in Riproduzione quarti di tono riproduce i quarti 
di tono – vedere Riproduzione di alterazioni microtonali.

Altri microtoni
Con i simboli è possibile avere (e scrivere) altri microtoni, che tuttavia non sono riprodotti o 
trasportati automaticamente. Si può modificare l’aspetto dei simboli – ad esempio, se si desidera 
che i bemolle di un quarto di tono siano riempiti in nero, sostituire il bemolle inverso vuoto della 
quarta colonna nella finestra di dialogo House Style > Modifica Simboli con un carattere di 
bemolle inverso pieno – Cambiare i simboli esistenti in b Modifica simboli.

“Spelling” delle alterazioni
Con l’inserimento MIDI (Flexi-time, step-time o da un file MIDI), Sibelius “immagina” come scri-
vere le note nere diesis o bemolle basandosi su tonalità e contesto della musica.

Per “rinominare” le note enarmonicamente (ad esempio da FA# a SOLb) selezionare la nota (o le 
note) e scegliere Note > Alterazione enarmonica (comando rapido Invio sulla tastiera principale).

Questa funzione rinomina una doppia alterazione (ad esempio, SIbb) naturale (LA), ma non vice 
versa (poiché in generale è meglio eliminare doppie alterazioni invece che introdurle). Essa rinom-
ina anche i quarti di tono; molti quarti di tono si possono scrivere in tre modi (un DO di un quarto 
di tono diesis è come un RE tre quarti di tono bemolle o un SI tre quarti di tono diesis).

Sibelius ha anche due plug-in che rinominano le alterazioni: Riscrivi bemolle come diesis e 
Riscrivi diesis come bemolle – b Plug-in.

Doppie alterazioni
Le doppie alterazioni si usano 
in tonalità anomale (es. SOL# 
minore) per evitare l’uso di 
troppi bequadri. Ad esempio, 
la sesta nota di REb minore è 
SIbb (cioè LA).

I simboli §b e b# si usano occa-
sionalmente al posto di b e # 
per cancellare un doppio-
bemolle o doppio-diesis collo-
cato prima nella misura.
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Semplificare le alterazioni
Trasportando la musica o inserendo una nuova tonalità nella musica esistente, si può finire con 
l’avere un gran numero di alterazioni. Il plug-in Plug-in > Alterazioni > Semplifica alterazioni
risolve questo problema – b Plug-in.

Nel caso la partitura contenga doppie alterazioni da eliminare, selezionare l’intera partitura 
(Modifica > Seleziona > Seleziona tutto, comando rapido Ctrl+A o XA) e dalla finestra di dial-
ogo Note > Trasponi (comando rapido Maius-T) trasportarla in alto di Major/Perfect Unisono
con l’opzione Doppio diesis/bemolle disattivata; tutte le doppie alterazioni saranno sostituite da 
equivalenti più semplici.

Aggiungere le alterazioni alle note
Sibelius ha due plug-in che consentono di aggiungere rapidamente le alterazioni a tutte le note di 
una selezione. Per aggiungere le alterazioni ad ogni nota che non “soddisfa” la tonalità corrente, 
selezionare Plug-in > Alterazioni > Aggiungi alterazioni a tutte le note diesis e bemolle. 
Questo plug-in, ad esempio, aggiunge un’alterazione ad ogni SIb in DO maggiore e ad ogni DO nat-
urale in MI maggiore. È possibile anche aggiungere letteralmente un’alterazione ad ogni nota in 
una selezione, scegliendo Plug-in > Alterazioni > Aggiungi alterazioni a tutte le note.

Unisoni alterati
Gli “unisoni alterati” sono due note di un accordo che si trovano nella stessa posizione, ma con 
alterazioni diverse (ad esempio, SOLb e SOL#).

Alcuni compositori (Messiaen, ad esempio) scrivono due teste nota affiancate, 
precedute da due alterazioni, invece che un intervallo di seconda (figura a sinis-
tra). Scrivere questa notazione al solito modo, creando cioè un accordo con due 

teste nota alla stessa posizione e aggiungendo le normali alterazioni.

Altri compositori scrivono la seconda testa nota su un gambo diagonale chiamato “stelo” (figura a 
destra). Per scriverlo, aggiungere la testa nota con lo stelo, utilizzando uno dei simboli stelo della 
finestra di dialogo Crea > Simbolo (comando rapido Z); lo svantaggio di questa notazione, tuttavia, 
è che la testa nota supplementare aggiunta non sarà riprodotta o trasportata (poiché è un simbolo).

Digitare le alterazioni nel testo
Talvolta occorre aggiungere le alterazioni a oggetti di testo della partitura – ad esempio, per inser-
ire nel titolo la tonalità del brano.

Per inserire le alterazioni nel testo, premere Ctrl o X e il tasto del pad numerico che corrisponde 
all’alterazione sul primo layout del tastierino numerico (comando rapido F8); ad esempio, Ctrl+8
o X8 inserisce un diesis, Ctrl+9 o X9 un segno bemolle. Si osservi che, affinché ciò funzioni, deve 
essere attiva l’opzione Num Lock. Altrimenti, cliccare con il pulsante destro del mouse (Windows) 
o fare Control-clic con il mouse (Mac) e selezionare l’alterazione desiderata dal menu contestuale.

Spostare le alterazioni
Le alterazioni sono posizionate automaticamente. Ad esempio, aggiungendo un’alterazione ad un 
accordo che ne ha già alcune, se necessario le alterazioni cambiano posizione, onde evitare 
sovrapposizioni. 
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Nei rari casi in cui occorra spostare un’alterazione, trascinarla orizzontalmente con il mouse, 
oppure spostarla leggermente (nudge) premendo Maius+Alt+0/1 o xz0/1. Per spostarla in 
incrementi maggiori, premere Ctrl+Maius+Alt+0/1 o xzX0/1.

Se occorrono alterazioni sopra il rigo (una ficta, ad esempio) si può usare un simbolo della finestra 
di dialogo Crea > Simbolo oppure, per riprodurre la ficta, utilizzare il plug-in Aggiungi ficta 
sopra la nota – b Plug-in.

Riproduzione di alterazioni microtonali
Molti dispositivi di riproduzione hanno una funzione pitch-bend, che consente di alterare la nota 
in base a 32 divisioni uguali da un semitono ciascuna (half-step). Sibelius ha il plug-in Plug-in >
Riproduzione > Riproduzione quarti di tono.

Per alterare l’intonazione di una nota, aggiungere anzitutto l’alterazione di un quarto di tono, ripe-
terla quanto necessario, quindi selezionare il passaggio da reintonare (assicurarsi d’includere la 
nota successiva intonata normalmente, in modo che il pitch-bend MIDI torni a zero). Selezionare 
Plug-in > Riproduzione > Riproduzione quarti di tono e cliccare due volte su OK.

A questo punto, alle note da reintonare è associato un comando pitch-bend MIDI invisibile (questi 
comandi invisibili appaiono in grigio attivando l’opzione Vista > Oggetti Nascosti) che aumenta 
l’altezza di un quarto di tono: ~B0,80. ~B0,64 fa tornare il rigo all’intonazione normale. Si può 
modificare questo comando di pitch-bend (per applicargli valori diversi dal quarto di tono) con un 
doppio-clic del mouse su di esso e modificandolo come segue:

Ogni incremento equivale a circa 3 cent (1 cent = 1/100 di semitono). Quindi, per avere (ad esem-
pio) una nota calante di 15 cent, si può modificare il comando pitch-bend in modo che sia 5 in 
meno (15/3) di 64, cioè ~B0,59. (Abbassando di questo valore la terza di una triade maggiore, si 
crea un accordo più armonioso). Se non si usano i quarti di tono in questo modo e non si desidera 
avere l’alterazione di un quarto di tono, a questo punto si può cancellarlo e il messaggio di pitch-
bend MIDI rimane.

Si noti che a causa della natura dei canali MIDI è possibile avere un solo comando di pitch-bend 
alla volta per strumento, quindi note diverse in un accordo non possono essere intonate di quantità 
diverse. Se in un accordo si tenta di assegnare pitch-bend diversi a due note diverse, il plug-in 
segna l’accordo con una X per avvisare che non si può ottenere il pitch-bend desiderato.

Per ulteriori dettagli sul plug-in, vedere Riproduzione dei quarti di tono a pagina 414. Per 
maggiori informazioni sui messaggi di pitch-bend MIDI, vedere Pitch Bend a pagina 325.

Opzioni Regole tipografia
Nel caso (ancor più raro) che nella partitura si debba modificare la spaziatura tra le alterazioni o lo 
spazio attorno ad esse, sono disponibili “insolite” opzioni particolarmente interessanti nelle pagine 
“Accidentals and Dots” e “Clefs and Key Signatures” della finestra di dialogo House Style >
Regole tipografia (comando rapido Ctrl+Maius+E o xXE).
(*Risposta al quesito di trasporto: RE un quarto di tono diesis. Al lettore il compito di trovare la scala!)

* ~B0,64 = intonazione normale.
* ~B0,80 = un quarto di tono diesis.

* ~B0,96 = un semitono diesis (half-step).
* ~B0,48 = un quarto di tono bemolle, ecc.
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2.3 Articolazioni

b Inserimento note.

v Aggiunta dei segni.

Le articolazioni sono simboli sopra o sotto una nota, accordo o pausa che indicano una tecnica 
esecutiva (staccato, accento, archetto in giù, ecc.). La articolazioni si creano e cancellano in modo 
molto simile alle alterazioni.

Creare la articolazioni per una nota
Quando si crea una nota è possibile creare subito la relativa arti-
colazione scegliendone una o più dal primo o quarto layout del 
tastierino numerico, prima d’inserire la nota nella partitura; 
allo stesso tempo, dal tastierino numerico è possibile aggiun-
gere alterazioni, legature di valore, punti ritmici, teste nota spe-
ciali, tremolo e tratti d’unione non-standard.

Aggiungere le articolazioni a note esistenti
Per aggiungere le articolazioni a una o più note selezionate, 
scegliere quelle desiderate dal primo o quarto layout del tast-
ierino numerico.

Quando s’aggiungono le articolazioni a un accordo, non 
importa quale sia la testa nota selezionata, poiché le articolazi-
oni si applicano a tutte le note dell’accordo.

Rimuovere alterazioni particolari
* Selezionare le note e scegliere le articolazioni dal tastierino numerico per disattivarle.
* Altrimenti, un metodo più lento ma delicato consiste nel selezionare le articolazioni con il 

mouse, facendo attenzione a non selezionare le rispettive note e premere Canc.
* Per rimuovere tutte le articolazioni in una volta, selezionare le note, scegliere il 

quarto layout del tastierino numerico (comando rapido F11) e premere 0,
oppure cliccare sul pulsante corrispondente indicato a destra.

Spostare le articolazioni
La articolazioni sono collocate automaticamente. Per esempio, aggiungendo un’articolazione ad 
una nota che ne ha già, esse si spostano mantenendo il giusto ordine per far spazio a quella nuova.

Può capitare di dover spostare un’articolazione. Talvolta, ad esempio, un’articolazione è collocata 
all’estremità “sbagliata” se tutte le articolazioni vicine si trovano lì; quindi se ci sono sei note in 
staccato, cinque delle quali hanno il segno di staccato sopra la nota, si può spostare lo staccato che 
rimane sopra la nota per seguire le stesso schema (altrimenti finirebbe sotto la nota).

Per spostare un’articolazione, selezionarla, quindi:

* Selezionare Modifica > Inverti (comando rapido X) per spostarla all’altra estremità della nota, 
oppure: 

Segni d’articolazione inusuali
I segni di articolazione seguenti potreb-
bero essere poco familiari:

Staccatissimo (molto breve)

Marcato

Pausa media

Pause breve

Archetto in su (strumenti a corda)

Archetto in giù

Armonico, charleston aperto

Charleston chiuso (percussioni), 
muto o stoppato di mano (ottoni), 
pizzicato mano sinistra (archi), 
trillo (musica Barocca)
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* Usare i tasti freccia (o trascinare con il mouse) per spostare l’articolazione in verticale. (Come 
sempre, mediante Ctrl+3/2 o X3/2 si sposta l’articolazione in incrementi più grandi).

Quando s’invertono o spostano le articolazioni, l’operazione è applicata a tutte le articolazioni 
assegnate alle note e non può essere applicata a una sola articolazione; per farlo, cancellare l’artico-
lazione che si vuole usare e crearne una nuova come simbolo. Attenzione: le articolazioni create 
come simboli non hanno effetto in riproduzione.

Per riposizionare le articolazioni nella partitura, vedere Opzioni Regole tipografia.

Copia delle articolazioni
Quando si copia una nota o accordo con la combinazione Alt+clic o z-clic del mouse oppure con il 
comando Modifica > Ripeti (comando rapido R) anche le articolazioni sono copiate, in modo da 
risparmiare tempo. Per copiare gli schemi di articolazioni da un passaggio a un altro senza influ-
enzare le note, si può usare il plug-in Plug-in > Note e Pause > Copia articolazioni e legature – 
per maggiori informazioni vedere b Plug-in.

Articolazioni sulle pause
I tre tipi di arresto (pausa) sono le sole articolazioni che si possono aggiungere a una pausa (le altre 
non hanno molto senso su una pausa!). 

Nel raro caso in cui si desideri aggiungere qualche altra articolazione a una pausa, usare un sim-
bolo. (Ad esempio, nelle partiture di Stockhausen e altri compositori contemporanei, talvolta si 
sono visti accenti sulle pause; sembra indichino l’immissione di un respiro dovuto ad una sincope 
inaspettata).

Quando si aggiunge un arresto a una misura di pausa essa si applica a tutti i righi, quindi è copiata 
su tutti i righi (e in tutte le parti strumentali).

Articolazioni personalizzate
Per cambiare l’aspetto delle articolazioni, modificarle nella finestra di dialogo House Style >
Modifica Simboli – b Modifica simboli.

Nel quarto layout del tastierino numerico ci sono tre spazi liberi ai quali assegnare altre articolazi-
oni (se lo si desidera) che corrispondono ai tre spazi nelle file Articolazioni della finestra di dial-
ogo House Style > Modifica Simboli:

Lo spazio vuoto utilizzato determina l’ordine in cui è inserita la nuova articolazione quando è com-
binata con altre articolazioni; l’articolazione 1 va più vicino alla testa nota, mentre la 3 si colloca 
più lontana dalla testa nota. Come si può osservare dalla figura precedente, si deve definire un sim-
bolo “sopra” e “sotto” per ogni articolazione (sebbene nella maggior parte dei casi, in realtà, si 
tratta dello stesso simbolo invece di versioni invertite).

Articolazione personalizzata 1
Articolazione personalizzata 2

Articolazione personalizzata 3
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Una volta definite le tre articolazioni personalizzate, attenzione perché i pulsanti sul quarto layout 
del tastierino numerico non si aggiornano per indicare i nuovi simboli; inoltre, le articolazioni 
personalizzate sono disponibili solamente nella partitura in cui sono state ridefinite; per renderle 
disponibili in altre partiture esportare in House Style (b House Style™).

Comandi rapidi dalla tastiera del computer
Sebbene sia possibile accedere a tutte le articolazioni grazie ai comandi rapidi standard per il tast-
ierino numerico, è possibile anche assegnare comandi rapidi extra a singole articolazioni – 
b Tastierino numerico.

Arresti (pause) sulle stanghette
Può capitare di inserire un arresto (pausa) sopra o sotto una stanghetta; per farlo, crearlo nella 
finestra di dialogo Crea > Simbolo (comando rapido Z), impostandolo per assegnarlo al sistema. 
Si crea un simbolo di sistema che appare in tutte le parti.

Articolazioni sopra il rigo
Nella musica per alcuni strumenti – ad esempio, percussioni e canto – è meglio avere tutte le arti-
colazioni sempre sopra il rigo. Sibelius lo fa automaticamente per alcuni strumenti, sebbene si pos-
sano comunque invertire le articolazioni con il comando Modifica > Inverti (comando rapido X).

Per forzare le articolazioni ad apparire sopra il rigo di un altro strumento attivare l’opzione Always 
position articulations above the staff nella pagina General della finestra di dialogo Staff Type
(si apre dalla finestra Modifica strumenti – b Modifica strumenti).

Opzioni Regole tipografia
La pagina Articolazioni della finestra di dialogo House Style > Regole tipografia (comando 
rapido Ctrl+Maius+E o xXE) presenta varie opzioni interessanti:
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Sempre sopra: normalmente, le articolazioni vanno sotto la maggior parte delle note con i gambi 
rivolti in alto. Questa opzione è utile per musicisti jazz e turnisti, i quali in generale preferiscono 
avere le articolazioni scritte in alto perché sono più visibili.

Consenti nel rigo: la maggior parte delle case editirici stampa staccati e tenuti nel rigo, alcuni 
scrivono gli armonici, pochi gli accenti. Si sconsiglia di mettere altre articolazioni nel rigo, poiché 
non riuscirebbero a stare tra le due linee del rigo e sarebbero quindi illeggibili.

Le opzioni Posizione delle articolazioni se vicine al gambo sono:

* Centra staccati sul gambo: questa opzione di posizione (default) colloca automaticamente 
tutte le articolazioni che sono alla fine del gambo nota: le centra sul gambo se l’articolazione più 
vicina è uno staccato, staccatissimo o un “cuneo” (wedge). Se le articolazioni sono all’estremità 
della testa nota sono posizionate normalmente.

* Centra a metà gli staccati sul gambo: è identica all’opzione Center staccatos on stem, ma 
se l’articolazione più vicina è uno staccato, staccatissimo o un “cuneo” centra le articolazioni a 
metà strada tra il gambo e il centro della testa nota.

* Centra tutto sul gambo: quando l’articolazione è alla fine del gambo centra le articolazioni sul 
gambo invece che sulla testa nota.

* Centra tutto sulla testa di nota: centra le articolazioni alla fine del gambo sulla testa nota, ad 
un lato del gambo.

Le opzioni Posizione verticale sono:

* spazi dalla testa di nota: quando le articolazioni vanno all’estremità della testa nota di una 
nota/accordo, questa è la distanza dell’articolazione più vicina. Se l’articolazione è collocata 
forzatamente fuori dal rigo, sarà ancora più lontana di così.

* spazi dal gambo: è la distanza corrispondente quando le articolazioni vanno all’estremità del 
gambo.

* spazi tra le articolazioni: determina la distanza tra le articolazioni se ce n’è più di una attaccata 
ad una nota.

Regolando l’opzione Arresti su battute in pausa si può anche controllare la distanza sopra il rigo 
degli arresti o delle misure di pausa.
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2.4 Chiavi

v Aggiungere i segni.

Le chiavi all’inizio di ogni sistema sono scritte automaticamente da Sibelius, che inserisce quelle 
standard quando si creano gli strumenti. Si deve pensare alle chiavi solo se si devono cambiare.

Modificare la chiave
*Per cambiare chiave a metà della misura, inserire la musica 
nella misura in cui si vuole il cambio chiave, in modo da 
crearlo tra le note giuste.
*Selezionare la nota o la pausa prima del punto in cui inserire 
la chiave, scegliere Crea > Chiave (comando rapido Q per 
“qlef ”) e cliccare sulla chiave desiderata nell’elenco dis-
ponibile (le chiavi più comuni sono in alto).
*Quando è attiva l’opzione Note > Partitura traspositore si 
può dire a Sibelius di usare una chiave diversa; ciò è utile per 
il trasporto di alcuni strumenti (ottoni bassi e strumenti a 
fiato, ad esempio); per farlo, attivare l’opzione Chiave Tras-
posta e scegliere la chiave da usare.
*L’opzione Disegna su righi successivi, come indica il 
nome, scrive la nuova chiave in tutti i sistemi successivi; dis-

attivarla è utile per particolari tipi di musica (lead sheet), ma normalmente si lascia attiva.
* Cliccando su OK si crea la chiave nella partitura. Tutta la musica dopo la chiave si sposta in alto 

o in basso in modo che suoni come prima.

Si può inserire un cambio di chiave anche con il mouse: assicurarsi che nella partitura non sia 
selezionato nulla (premere Esc), scegliere la chiave desiderata dalla finestra di dialogo Crea > Chi-
ave, quindi puntare il mouse dove si vuole inserire la chiave e cliccare. Per cambiare la chiave di un 
intero strumento, ad esempio, collocare la chiave scelta sopra quella esistente all’inizio della partit-
ura.

È possibile copiare i cambi di chiave (con la combinazione Alt+clic o z-clic), sebbene non si pos-
sano copiare le chiavi a piena grandezza all’inizio dei righi.

Spostare le chiavi
Trascinando una chiave, si noterà che Sibelius sposta automaticamente la musica in alto o in basso 
quando la chiave ci passa sopra, in modo che le note suonino uguali.

Provare questa funzionalità – creare un cambio di chiave da qualche parte, quindi trascinarla a 
sinistra e destra lungo il rigo (oppure in alto e in basso su altri righi) ed osservare come la musica 
si sposti immediatamente. Quando non c’è niente di meglio da fare, si possono passare ore di 
innocuo (sebbene limitato) divertimento.
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Cancellare le chiavi
I cambi di chiave si possono rimuovere premendo Canc. Se la chiave da eliminare cambia all’inizio 
di un sistema, cancellare il cambio chiave che appare alla fine del sistema precedente. (Questo per-
ché – pensandoci bene – la piccola chiave alla fine del sistema precedente è il punto di cambio vero 
e proprio; la grande chiave nel sistema successivo, in realtà, non è altro che un’indicazione standard 
della chiave corrente).

Per gli strumenti percussivi non intonati si può usare la “chiave vuota” (quella costituita da un po’ 
di rigo vuoto). Sebbene così il rigo inizi con uno spazio vuoto invece che con una chiave, si colloca 
la chiave vuota proprio come una qualsiasi altra chiave invece di cancellare la chiave che già pre-
sente.

Una volta inserito da qualche parte un cambio di chiave vuota, non si può selezionarlo e cancel-
larlo – non c’è niente da selezionare; collocare invece una chiave diversa in cima e premere Canc.

Nascondere le chiavi 
all’inizio di un sistema
Per far apparire una chiave sul 
primo sistema ma non in 
quelli successivi – se, ad esem-
pio, si sta lavorando su un lead 
sheet – disattivare l’opzione 
Disegna su sistemi succes-
sivi quando si crea la chiave; 
non cancellare la chiave 
all’inizio di ogni sistema!

Se non si desidera vedere in 
assoluto le chiavi su un deter-
minato rigo, selezionare tutte 
le misure in quel rigo e disatti-
vare il box di spunta Clefs nel 
pannello Bars della finestra 
Properties (b Proprietà).

Nascondere cambi di 
chiave d’avvertimento
Se una partitura ha più movi-
menti o brani, si può cambiare 

la chiave all’inizio di una sezione senza che appaia una chiave d’avvertimento alla fine della sezione 
precedente. Per farlo, selezionare la chiave d’avvertimento e scegliere Modifica > Mostra o 
nascondi > Nascondi (comando rapido Ctrl+Maius+H o xXH).

Per maggiori informazioni su come nascondere gli oggetti vedere b Nascondere oggetti.

Chiavi d’ottava
Alcuni scrivono la musica per il Piccolo (ad esempio) nella normale chiave di violino con un “8” 
sopra (in particolare nelle partiture d’avanguardia) – si tratta di una questione di gusto personale. 

Chiavi disponibili
Le seguenti chiavi sono disponibili dal riquadro Chiavi (ognuna mostra un Do):

Chiave
di violino

Chiave
di contralto,
per viola

Chiave di tenore,
per fagotto,
trombone e
violoncello

Chiave 
di basso

Chiave di
percussioni
non intonate

Chiave di
percussioni
non intonate

Chiave
intavolatura
standard

Chiave
di violino
francese,
rara
pre-1800

Chiave di 
basso un’ottava
sotto per parti 
di contrabbasso

Chiave
di basso,
due ottave
sotto

Chiave
di baritono,
rara,
pre-1800

Chiave di
percussioni
non intonate

Chiave
intavolatura
chitarra 
basso

Chiave 
intavolatura
più grande

Chiave
di soprano,
pre-1800

Chiave di
mezzo-
soprano,
rara
pre-1800

Chiave di
tenore un’ottava
sotto per parti
alte di
contrabbasso

Chiave di
baritono,
rara
pre-1800

Chiave di
basso un’ottava
sopra per la mano
sinistra della
celesta e flauto 
basso

Chiave 
di violino 
due ottave 
sopra, per 
glockenspiel

Chiave
di violino
due ottave
sopra, per
ottavino

Chiave
di violino
un’ottava
sotto, per 
tenore e chitarra

Chiave di violino
opzionale
un’ottava sotto 
per voce maschile
o femminile

Doppia chiave di 
violino:antica 
versione della 
chiave di violino 
un’ottava sotto
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Un vero Piccolo che esegue la musica in “chiave di violino 8” non suona all’ottava più alta di un Pic-
colo che esegue la stessa musica in normale chiave di violino – suonano esattamente le stesse note. 
In altre parole, il numero “8” è solo un avvertimento o un modo per ricordare al lettore che si tratta 
di uno strumento trasportato.

In Sibelius, quindi, chiavi con o senza “8” (o “15”) sopra sono esattamente equivalenti. Il fatto che 
un Piccolo suoni un’ottava più in alto rispetto al flauto che suona le stesse note è una caratteristica 
dello strumento, non della chiave (dopotutto, entrambi seguono la musica scritta in chiave di vio-
lino). In Sibelius, ciò è indicato dal fatto che un Piccolo ha un cambio di trasporto di default, cioè è 
trasportato in alto di un’ottava sia in una partitura non-transportata sia in una trasportata. Si pos-
sono creare strumenti trasportati come questo con l’opzione House Style > Modifica strumenti 
e ensemble (b Modifica strumenti). 

Uno “strumento” di voce tenore in Sibelius è analogo – ha un cambio di trasporto che lo trasporta 
in basso di un’ottava sia in una partitura non-trasportata sia in una trasportata. Anche qui la “chi-
ave di violino 8” per un tenore è solo un avvertimento per il lettore – è un’alternativa alla normale 
chiave di violino, ma non ha un effetto diretto sull’altezza delle note.

Opzioni Regole tipografia
La pagina Chiavi e Alterazioni in Chiave nella finestra di dialogo House Style > Regole 
tipografia (comando rapido Ctrl+Maius+E o xXE) consente di modificare a piacere lo spazio 
vuoto prima della chiave iniziale (Spazio prima della chiave iniziale) e la larghezza della chiave 
iniziale (Larghezza chiave iniziale).

L’opzione Dimensione note guida nella pagina Note e Tremolo della finestra di dialogo deter-
mina anche la dimensione dei cambi di chiave (rispetto alle chiavi in piena grandezza).
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2.5 Colori

b Evidenzia.

v Colori e import delle grafiche.

Sibelius consente di colorare la maggior parte degli oggetti nella partitura. Ciò è molto utile per 
scrivere partiture che catturino meglio l’attenzione (per esempio, si potrebbero colorare tutte le 
indicazioni di tempo o i segni di prova in uno specifico colore, in modo che risaltino alla vista del 
direttore d’orchestra o degli esecutori). La colorazione di determinati oggetti è utile anche a scopo 
educativo: si potrebbero usare vari colori per diversificare le diverse diteggiature o diagrammi 
accordo oppure colorare diversamente ogni nota sul rigo di notazione tradizionale, per aiutare gli 
studenti a imparare a leggere la musica.

Come colorare un oggetto
Cambiare il colore di un oggetto è semplice:

*  Selezionare l’oggetto (o gli oggetti) da colorare.
* Selezionare Modifica > Colore (comando rapido Ctrl+J o XJ).
* Si apre una finestra di dialogo con i colori standard: scegliere il colore desiderato e cliccare OK.

Per colorare un altro oggetto con l’ultimo colore utilizzato, selezionare l’oggetto e scegliere 
Modifica > Riapplica Colore (comando rapido Ctrl+Maius+J o xXJ).

È possibile colorare un oggetto singolarmente o una serie di oggetti selezionati. Per cambiare il col-
ore di tutte le note in una misura, ad esempio, selezionare la misura in modo che si circondi di un 
box blu chiaro e scegliere Modifica > Colore. Si possono anche usare i filtri (b Filtri e Trova) 
per selezionare, ad esempio, tutte le parole di un brano e colorarle.

Reimpostare il colore di un oggetto
Per reimpostare in nero il colore di un oggetto, selezionarlo e scegliere Layout > Ripristina 
aspetto (comando rapido Ctrl+Maius+D o xXD).

Visualizzare le note a colori
La visione delle note alle quali sono stati cambiati i colori dipende dall’opzione scelta nel sot-
tomenu Vista > Colori note. Se è attiva l’opzione Pitch Spectrum o Colori voce, tutte le note 
sono colorate in base all’opzione selezionata, non secondo i colori individuali scelti. I colori scelti 
dall’utente sono visibili solamente se sono attive le opzioni Nulla o Note fuori Range; vedere 
b Menu Vista.

Stampa a colori
Volendo è possibile stampare la partitura a colori – basta assicurarsi che sia attiva l’opzione 
Stampa a colori nella finestra di dialogo File > Stampa. Con una stampante in bianco e nero gli 
oggetti colorati sono stampati in scala di grigi. Se questa opzione non è attiva, tutti gli oggetti colo-
rati sono stampati in nero – b Stampa.
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Quali oggetti si possono colorare?
Tranne alcune eccezioni, si può cambiare il colore di qualsiasi cosa che si può selezionare, incluse 
note, linee, testi, diagrammi accordo, simboli e altro ancora.

Quando si colorano le note, assumono lo stesso colore della testa nota anche le seguenti parti che le 
costituiscono: alterazioni, articolazioni, punti ritmici, parentesi e legature di valore.

Le parti che invece ignorano il colore scelto per la testa nota e sono sempre scritte in nero: tratti 
d’unione, linee aggiuntive, gambi, slash d’acciaccatura, tremolo e bandierine/uncini.

Quali oggetti non si possono colorare?
* Singole teste note negli accordi (colorando una testa nota dell’accordo, tutte le altre teste note 

assumono lo stesso colore).
* Nomi strumento a sinistra del sistema.
* Numeri misura (sebbene , volendo, sia possibile colorare cambi dei numeri misura).
* Chiavi iniziali all’inizio dei sistemi (sebbene, volendo, sia possibile colorare cambi di chiave).
* Tempi in chiave iniziali a inizio sistemi (sebbene si possano colorare cambi di tempo in chiave).
* Nomi nota che indichino l’accordatura dei righi di tablatura all’inizio dei sistemi.
* Stanghette normali, sebbene sia possibile colorare stanghette speciali (di ripetizione, doppie e 

finali).
* Linee del rigo.

Salvare i colori nel raccoglitore di Windows
Per avere una serie di colori da usare in seguito, salvarli nella sezione Colori personalizzati del rac-
coglitore dei colori. Non è un’operazione semplice come potrebbe sembrare, poiché il nuovo colore 
è sempre salvato come primo colore personalizzato e sostituisce il nuovo colore nella parte destra 
della finestra di dialogo (a meno che non sia stato prima selezionato un colore personalizzato).

Per scorrere la partitura alla ricerca dei vari colori già usati e aggiungerli all’elenco dei colori per-
sonalizzati:

* Selezionare l’oggetto che usa il colore da salvare.
* Selezionare Modifica > Colore (comando rapido Ctrl+J).
* Premere Alt+C per selezionare il primo colore personalizzato.
* Con i tasti freccia evidenziare la posizione del colore personalizzato in cui salvare il colore 

dell’oggetto.
* Cliccare su Aggiungi ai colori personalizzati.

Salvare i colori nel raccoglitore di Mac
Per aggiungere un colore personalizzato in Mac:

* Selezionare l’oggetto che usa il colore da salvare.
* Selezionare Modifica > Colore (comando rapido XJ).
* Cliccare e tenere premuto il pulsante sinistro del mouse nel box in cima alla finestra di dialogo 

che visualizza il colore dell’oggetto.
* Trascinare il mouse in basso in uno dei box colore personalizzato alla base della finestra.
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2.6 Diagrammi accordo

b Simboli accordo.

I diagrammi accordo (conosciuti anche come box accordo, griglie tasto, guitar frame e così via) 
indicano come suonare un particolare accordo su una chitarra o un altro strumento a tasti, most-
rando le dita da premere su ogni tasto e corda. In generale, sono corredati da simboli testuali 
dell’accordo che Sibelius è in grado di scrivere.

Creare i diagrammi accordo
Per creare un diagramma accordo sopra la nota selezionata, scegliere Crea > Diagramma accordo 
(comando rapido Maius-K) per aprire questa finestra di dialogo:

* Le opzioni Scegliete un diagrama accordo nella parte sinistra della finestra sono:
% Accordo: tonalità dell’accordo da usare.
% L’elenco a metà determina il tipo d’accordo (maggiore, minore, aumentato, diminuito, ecc.).
% Basso: è la nota di basso dell’accordo. Di default è la stessa nota Chord, ma si può cambiare 

se, ad esempio, si sta scrivendo un accordo di SOL con basso di SI.
% Il rettangolo bianco grande mostra gli accordi disponibili, basati sulle impostazioni definite 

nella finestra di dialogo.
% Vis. testo diteggiatura: visualizza sotto ogni corda nel diagramma dell’accordo le diteggia-

ture necessarie a suonarlo. L’opzione non è disponibile se non è stata specificata una diteggia-
tura. Per maggiori informazioni vedere Aggiungere un testo di diteggiatura.

% Mostra simb. accordo: aggiunge un simbolo testuale per l’accordo sopra il diagramma.
% Cliccando Modifica o Nuovo si può modificare il diagramma dell’accordo selezionato o 

crearne uno nuovo non in elenco. Per i dettagli vedere Modificare e salvare i diagrammi 
accordo.

* Le opzioni Elenco accordi nella parte destra della finestra di dialogo specificano i diagrammi 
accordi che appaiono nella parte sinistra della finestra stessa:
% Strumento: impostare questa opzione all’accordatura della chitarra per la quale si scrivono i 

diagrammi degli accordi.
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% Accordi usati nella partitura: visualizza tutti i diagrammi degli accordi già usati nella parti-
tura corrispondenti alle opzioni correnti scelte nella finestra di dialogo.

% Accordi comuni (accordatura standard): mostra i diagrammi accordi da una selezione 
interna di accordature standard per chitarra a 6 corde, scelti per la loro facilità d’esecuzione; 
in generale, sono fornite tre diteggiature diverse per ogni tipo d’accordo: una al capotasto (o 
vicino ad esso), una intorno al quinto tasto e una attorno al nono tasto.

% Tutti gli acc.: attivandola Sibelius calcola automaticamente tutte le diteggiature possibili 
dell’accordo. Si noti che le posizioni generate dipendono dall’opzione Dist. massima n tasti. 
Se si usa un’accordatura speciale, attivando questa opzione si ottiene un’ampia selezione di 
posizioni suonabili di un particolare accordo, che si possono aggiungere alla libreria.

% Dist. massima n tasti: determina la distanza massima tra i tasti più basso e più alto per la 
diteggiatura dei diagrammi accordi generati automaticamente. Per i dettagli vedere Stretch 
massimo.

% Le opzioni Accordi in libreria stabiliscono se Sibelius visualizza gli accordi prelevandoli da 
una libreria di diagrammi accordi personalizzata. Per i dettagli vedere Librerie di dia-
grammi accordo.

Per elencare tutti gli accordi insieme nella parte sinistra della finestra di dialogo attivare più box di 
spunta alla volta.

Selezionando uno dei diagrammi accordo a sinistra e cliccando su OK, il diagramma si crea sopra 
la nota selezionata. Se prima di aprire la finestra di dialogo non è stata selezionata una nota, il pun-
tatore del mouse cambia colore ad indicare che è “pronto” con un diagramma accordo – a questo 
punto cliccare nel punto in cui si desidera inserirlo nella pagina.

Stretch massimo
Per le posizioni degli accordi generate automaticamente, si può specificare la distanza massima 
alla quale allargare le dita impostando l’opzione Dist. massima n tasti al numero tasti desiderato.

Copiare, modificare e cancellare i diagrammi accordo
Ovviamente, i diagrammi accordo si possono copiare, spostare e cancellare con i soliti metodi. Una 
volta creato nella partitura, il diagramma accordo si può modificare con un doppio-clic del mouse.

Si possono anche scorrere le varie diteggiature di un accordo selezionato senza tornare alla finestra 
di dialogo: basta cliccare una volta sul diagramma per selezionarlo e scegliere più volte Modifica >
Cambia diagramma accordo (comando rapido Ctrl+Maius+K o xXK) per scorrere le varie 
diteggiature, disponibili in base alla selezione specificata dalle ultime opzioni Elenco accordi
scelte nella finestra di dialogo Crea > Diagramma accordo.
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Modificare e salvare i diagrammi accordo
Per modificare un diagramma accordo visualizzato nella finestra di 
dialogo Diagramma Accordo, selezionarlo con il mouse e cliccare 
sul pulsante Modifica. Per creare da zero un nuovo diagramma 
accordo cliccare sul pulsante Nuovo. In entrambi i casi, si apre la 
finestra di dialogo indicata a sinistra.

* Per inserire un pallino su una corda basta cliccare dove si vuole farlo 
apparire.
* Per specificare la corda libera o da non suonare cliccare sopra la 
linea superiore della cornice per selezionare i simboli O e X.
* Per disegnare un barré, cliccare e trascinare il mouse attraverso le 
corde sulle quali inserire il barré.
* Per inserire il numero del tasto in alto a destra del diagramma clic-

care sulle frecce a destra nella finestra di dialogo.
* Per inserire un simbolo accordo diverso da quello di default, attivare l’opzione Usa simbolo 

accordo custom e digitare il simbolo accordo desiderato; per i dettagli vedere Simboli 
accordo.

* Per specificare la diteggiatura di un diagramma accordo inserirla nel box Diteggiatura Testo; 
per i dettagli vedere Aggiungere un testo di diteggiatura.

Quando il diagramma accordo è corretto, cliccare su OK per tornare alla finestra Diagramma 
Accordo.

Per usare il nuovo diagramma accordo o quello modificato in partiture future, bisogna salvarlo in 
una libreria, operazione che avviene automaticamente cliccando su OK (sempre che sia selezionata 
un’adeguata libreria nel menu a tendina accanto al box di spunta Agg. a libreria).

Aggiungere un testo di diteggiatura
Per aggiungere un testo di diteggiatura a un diagramma accordo usare la finestra di dialogo Modi-
fica Diagramma Accordo: digitare il testo desiderato nel box Diteggiatura Testo, secondo i cri-
teri seguenti:

* Ogni corda può visualizzare un singolo carattere come proprio testo di diteggiatura.
* Si può digitare qualsiasi carattere alfanumerico, cioè numeri (da 0 a 9) e lettere (dalla A alla Z) 

sia in maiuscolo che minuscolo.
* Digitare un trattino (-) per ogni corda priva della diteggiatura.

Digitando il carattere, la finestra d’anteprima (preview) mostra come apparirà la diteggiatura nella 
partitura (sebbene i caratteri nella finestra d’anteprima siano più grandi rispetto alla dimensione 
del diagramma accordo visualizzato nella partitura). Nel caso dell’esempio indicato in precedenza, 
quindi, occorrerà digitare -1342-.
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Aspetto del testo di diteggiatura
L’aspetto del testo di diteggiatura di un diagramma accordo si definisce nella pagina Chitarra della 
finestra di dialogo House Style > Regole tipografia:

* Posiziona testo diteggiatura: determina se il testo di diteggiatura deve essere scritto sotto il 
diagramma (Sotto il diagramma, di default) o sopra il diagramma (sopra il diagramma). 
Quando il testo di diteggiatura è scritto sopra il diagramma appare allineato ai simboli O e X. Il 
testo di diteggiatura ha la precedenza sui simboli O e X; se il testo di diteggiatura e un simbolo O 
o X devono apparire entrambi sopra la stessa corda, sarà visualizzato il testo di diteggiatura.

* Testo diteggiatura n spazi dal diagramma: determina la distanza dalla base o dalla cima del 
diagramma accordo alla quale è scritto il testo di diteggiatura (di default è 0,5 spazi). Se si stabi-
lisce che il testo di diteggiatura deve essere scritto sopra il diagramma, questo parametro cambia 
anche la distanza dei simboli O e X dalla cornice, in modo che il testo di diteggiatura si allinei ai 
simboli.

Per cambiare il font, lo stile (per esempio, grassetto, corsivo) e la dimensione del carattere usato 
per le diteggiature selezionare House Style > Modifica stili di testo e modificare l’opzione per lo 
stile di testo Diteggiatura diagramma accordo.

Librerie di diagrammi accordo
Le librerie facilitano il lavoro con i diagrammi accordo. Se per i propri accordi, ad esempio, si usa 
sempre una serie specifica di diteggiature (voci jazz o diteggiature molto semplici per gli studenti), 
si può costruire una libreria che contiene solo quei tipi d’accordo. In questo modo si trovano subito 
i diagrammi desiderati e, una volta completata la libreria, si può usarla in ogni partitura. Si può 
anche darla a un amico o aggiungere librerie create da altri.
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Per creare una libreria selezionare Nuova Libreria Diagramma Accordi... dal menu a tendina 
nella finestra Crea > Diagramma accordo. Sibelius chiede di digitare un nome – assegnarne uno 
facilmente memorizzabile (Jazz chords o Easy voicings, ad esempio) – e cliccare su OK.

Per aggiungere un accordo alla libreria, selezionarlo nel rettangolo bianco a sinistra nella finestra 
di dialogo e cliccare su Agg. a Libreria. (Se accanto all’opzione Accordi in libreria a destra non è 
selezionata una libreria, Sibelius chiede di sceglierla o di crearne una).

Per utilizzare un accordo della libreria attivare l’opzione Accordi in libreria e scegliere la libreria 
adeguata dal menu a tendina; gli accordi appaiono nell’elenco a sinistra.

Per rimuovere un accordo dalla libreria, assicurarsi che sia attiva l’opzione Accordi in libreria (è 
meglio disattivare le altre tre opzioni, così sono visualizzati solo gli accordi della libreria), quindi 
scegliere l’accordo da rimuovere e cliccare su Elimina dalla libreria.

Per condividere la propria libreria dei diagrammi accordo con qualcuno (o installare una libreria 
ricevuta da un altro utente), le librerie sono salvate nella cartella Chord Shapes (Figure Accordo) 
all’interno della cartella dati di Sibelius (vedere File modificabili dall’utente in b Lavorare 
con i file). I file della libreria accordi hanno estensione “.scl”.

Simboli accordo
Nella maggior parte dei casi, non serve cambiare il simbolo dell’accordo (che Sibelius fornisce di 
default) sopra il diagramma, ma per una convenzione diversa dei nomi esistono due soluzioni pos-
sibili:

* Se si vuole cambiare il simbolo accordo per ogni tipo di diagramma accordo nella partitura 
(maggiore, minore, sus4, ecc.) in modo che ogni nuovo diagramma accordo creato impieghi 
quello stabilito dall’utente, si può definire il simbolo accordo come parte dello stile house della 
partitura sulla quale si sta lavorando.

* D’altro canto, per cambiare solamente il simbolo accordo sopra un singolo diagramma accordo 
(in casi particolari, ad esempio per creare un accordo molto insolito come un DOb maggiore), si 
può creare un simbolo accordo personalizzato per quel singolo diagramma accordo.

Per modificare il simbolo accordo su ogni tipo di diagramma accordo:

* Selezionare la pagina Chitarra nella finestra di dialogo House Style > Regole tipografia
(comando rapido Ctrl+Maius+E o xXE).

* Cliccare su Modifica Simboli Accordo.

* Nella finestra di dialogo che appare, scegliere il tipo di accordo (Chord) e modificare oppor-
tunamente l’opzione Simbolo Accordo.

* Al termine, cliccare su OK.

Questa operazione cambia anche i simboli accordo in tutti i diagrammi accordo già creati (ma non 
influenza i simboli testuali dell’accordo che non fanno parte dei diagrammi accordo). Per trasferire 
le impostazioni di questo simbolo dell’accordo a un’altra partitura, esportare lo stile house da 
questa partitura e importarlo in un’altra (volendo, si può scegliere d’importare solo l’elemento di 
stile house Simboli accordo in diagrammi accordo) – b House Style™.

Altrimenti, per cambiare il simbolo accordo di un singolo diagramma accordo:
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* Nella finestra Crea > Diagramma accordo selezionare il diagramma accordo del quale si desid-
era cambiare il simbolo accordo e cliccare su Modifica (o su Nuovo per creare un nuovo dia-
gramma accordo basato su quello selezionato).

* Attivare l’opzione Usa simbolo accordo custom, digitare il nome desiderato e cliccare su OK.

Attenzione! I simboli degli accordi sopra i diagrammi accordo sono scritti con lo stile di testo Sim-
boli Accordo, perciò quando si crea un diagramma accordo i caratteri b e # nelle finestre di dial-
ogo per la definizione dei simboli accordo personalizzati sono trasformati nei simboli musicali 
appropriati b e # – b Simboli accordo.

Sia che si modifichi i simboli accordo globalmente in stile house o individualmente su singoli dia-
grammi accordo, i simboli accordo personalizzati non sono mai salvati in una libreria dei dia-
grammi accordo (perché potrebbe essere necessario usare la stessa libreria in più progetti che 
richiedono diverse convenzioni per i nomi degli accordi). In particolare, per simboli accordo indi-
viduali personalizzati, il metodo per riutilizzarli consiste nel creare il diagramma accordo nella 
partitura, quindi crearlo di nuovo, attivare l’opzione Chords used in this score nella finestra di 
dialogo Crea > Diagramma accordo e scegliere l’accordo dalla parte sinistra della finestra di dial-
ogo.

Riproduzione dei diagrammi accordo
I diagrammi accordo in sé non sono riproducibili, ma una volta inseriti nella partitura si può usare 
il plug-in Plug-in > Tool di composizione > Realizza una semplice armonia che genera un sem-
plice accompagnamento leggendo gli accordi – b Plug-in.

Diagrammi accordi non riconosciuti
Quando si aprono partiture create in versioni precedenti di Sibelius che contengono diagrammi 
accordi, può apparire un messaggio che informa che alcuni diagrammi accordi nella partitura non 
possono essere riconosciuti: significa che il diagramma accordo in questione non è uno di quelli 
standard riconosciuti da Sibelius. I diagrammi accordi non riconosciuti appaiono in rosso nella 
partitura, per essere facilmente riconoscibili.

Con un doppio-clic del mouse sul diagramma accordo si può modificarlo in modo da farlo corri-
spondere a uno di default, oppure decidere di lasciarlo così com’è. Il motivo principale per cui si 
modifica un diagramma accordo non riconosciuto è che Sibelius lo riconosca per poterlo traspor-
tare, se si trasporta l’intera partitura. In entrambi i casi, per far tornare nero il diagramma accordo, 
selezionarlo e scegliere Layout > Ripristina aspetto (comando rapido Ctrl+Maius+D o xXD).

Opzioni Regole tipografia
Oltre alle opzioni di testo per la diteggiatura e di simbolo accordo descritte in precedenza, la pag-
ina Guitar della finestra di dialogo House Style > Regole tipografia presenta numerose opzioni 
auto-esplicative per controllare lo stile dei diagrammi accordo.
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2.7 Foglio manoscritto

Ogni volta che s’inizia una nuova partitura si può scegliere di scriverla su un tipo particolare di 
foglio manoscritto; si tratta semplicemente di una partitura vuota, configurata con una serie di 
utili layout da usare come modello (template). Le opzioni disponibili in un foglio manoscritto pre-
set sono costituite da varie combinazioni di strumenti ed altre impostazioni (meno ovvie) che pos-
sono migliorare l’aspetto e il modo in cui è riprodotta la partitura.

Non necessariamente si devono usare gli strumenti esattamente come sono forniti – si è liberi di 
eliminare strumenti o aggiungerne di nuovi.

È meglio usare un foglio manoscritto contenente strumenti invece d’iniziare con una pagina vuota, 
anche se la strumentazione non è esattamente la stessa, poiché varie altre opzioni sono già ade-
guatamente impostate per un particolare tipo di musica.

Tipi di foglio manoscritto
Sibelius ha più di 60 fogli manoscritti predefiniti che comprendono:

* Blank: vuoto (senza strumenti preset).
* Piano.
* Bands: ampia gamma di fogli manoscritti per bande da concerto, strumenti a fiato, marching 

band, bande scolastiche, d’ottoni, percussive, militari e altre ensemble.
* Orchestra: orchestre d’archi e da film, Romantica, Moderna. Il foglio manoscritto Orchestra, 

film è stato realizzato da Alf Clausen e Kyle Clausen, i compositori dei Simpsons.
* Choir: vari fogli manoscritti Choir, alcuni (reduction) nei quali i cantanti sono ridotti a due 

righi (“partitura chiusa”), altri con accompagnamento d’organo o piano.
* Voice + keyboard.
* Jazz: serie di template che impiegano stili house “scritti a mano”, inclusi Lead sheet, Big band, e 

Jazz quartet – b House Style™

* Guitar: vari fogli manoscritti di notazione e tablatura per chitarra, incluso Lute tablature.

* Gruppi d’ottoni e fiati di varie dimensioni.
* Quartetto d’archi e orchestra d’archi (utilizzabile anche per un quintetto d’archi).
* Varie altre ensemble come campane a mano, gruppi di percussioni, band salsa e pop.

Con le opzioni nella finestra di dialogo File > Nuovo (comando rapido Ctrl+N o XN) è possibile 
scegliere uno di questi fogli manoscritti, aggiungere/rimuovere strumenti, modificare lo stile 
house, inserire tempi in chiave e tonalità, indicazioni tempo e perfino creare una pagina di titolo.

Per creare da zero un esercizio, in generale è meglio iniziare scegliendo un template dal menu 
File > Creatore questionario – b Creatore Quaderni di Lavoro, non con il comando 
File > Nuovo.

Creare un foglio manoscritto personalizzato
Se capita spesso di dover scrivere musica per un guppo insolito di strumenti e/o opzioni, si può 
creare un proprio foglio manoscritto, senza perdere tempo ad iniziare nuove partiture. Come in un 
foglio manoscritto reale è possibile scegliere diverse dimensioni del foglio, forme/dimensioni del 
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rigo e avere un foglio manoscritto pre-stampato con strumenti particolari.  
Tuttavia, si possono anche includere impostazioni più elaborate, come quelle nel menu House 
Style. Si può quindi ottenere un buon setup senza dover configurare ogni volta tutte le opzioni.

* Creare una partitura con tutte le impostazioni da includere nel foglio manoscritto – per esempio, 
forma/dimensione pagina, dimensione rigo, strumenti, opzioni Regole tipografia, stili di testo, 
font musicali, teste nota.

* Salvarla alla destinazione desiderata, con un nome qualsiasi da dare al foglio manoscritto (per 
esempio, Choir, Big paper, Sketches).

* Selezionare File > Esporta > Foglio manoscritto.

* A questo punto, volendo, si può cancellare il file originale salvato – rimane comunque come 
foglio manoscritto.

* Quando in seguito s’inizia una nuova partitura, il nuovo foglio manoscritto appare nell’elenco 
Manuscript Paper.

Per creare un nuovo foglio manoscritto che corrisponda ad una partitura esistente (se, ad esempio, 
sono stati configurati stili di testo speciali, ecc.), esportare lo stile house da quella partitura, creare 
una nuova partitura, importare lo stile house esportato, quindi esportare come foglio manoscritto; 
per i dettagli su import/export di uno stile house, vedere b House Style™.

Nel caso si debba rinominare o cancellare un foglio manoscritto, i rispettivi file sono nella cartella 
Manuscript paper all’interno della cartella dati d’applicazione di Sibelius (vedere File modifica-
bili dall’utente in b Lavorare con i file).
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2.8 Gambi e linee aggiuntive

Invertire la direzione del gambo
La regola per le direzioni del gambo (vedere box) è quasi sempre 
molto rigida; l’unica direzione del gambo che si può sempre 
invertire è quella delle note sulla linea centrale del rigo.

Per invertire un gambo nota, selezionarlo e scegliere Modifica >
Inverti (comando rapido X). S’invertono anche le legature, se nec-
essario (sebbene si possano invertire anche in modo indipendente).

Non si confonda l’inversione dei gambi con la normale scrittura 
della musica a due voci; scrivendo in due voci, Sibelius inverte 
automaticamente i gambi (b Voci).

Per invertire i gambi di tutte le note unite da un tratto d’unione, 
basta invertire il gambo di una delle note. Attenzione! Selezionare 
una nota la cui direzione del gambo non è stata alterata dalla pre-
senza del tratto d’unione.

Per invertire i gambi di un gruppo unito da un tratto d’unione in 
una situazione a più voci selezionare il primo gambo del gruppo 
unito dal tratto d’unione.

Gambi sulla linea centrale
In genere, i gambi sulla linea centrale del rigo sono rivolti in basso (vedere il box Direzioni del 
gambo); le eccezioni sono la musica vocale e corale (dove i gambi sulla linea centrale spesso sono 
rivolti in alto) e percussiva, scritta su righi ad 1 linea (nella quale i gambi puntano sempre in alto).

Sibelius esegue automaticamente questa operazione per gli opportuni strumenti. Per cambiare 
questa funzionalità modificare lo strumento – b Modifica strumenti.

Forzare la direzione del gambo
In rari casi (nella musica per cornamusa, ad esempio) può essere utile specificare che i gambi sar-
anno rivolti sempre in alto o in basso, indipendentemente dall’altezza delle note. Per farlo si può 
modificare uno strumento – b Modifica strumenti.

Regolare la lunghezza dei gambi
In genere, la lunghezza dei gambi non si cambia mai (in questo senso le regole sono piuttosto 
rigide e seguite alla lettera da Sibelius). Ci sono casi, però, nei quali un gambo deve essere allun-
gato: per evitare, ad esempio, una collisione tra un tratto d’unione e un ornamento, per fare spazio 
(nella musica d’avanguardia) a un simbolo speciale da scrivere sul gambo; inoltre, può essere nec-
essario accorciarlo, per evitare collisioni in situazioni difficili (soprattutto usando più voci).

Per regolare la lunghezza di un gambo trascinarne l’estremità, oppure cliccarci sopra e regolarla 
con i tasti freccia. Un Ctrl+3/2 o X3/2 regola in step di 0.25 spazi; è utile ingrandire il gambo 
per vedere meglio cosa si sta facendo.

Direzioni del gambo
Tra musicisti è opinione comune 
(errata) che le note sulla linea 
centrale del rigo possano avere il 
gambo rivolto in entrambe le 
direzioni; invece è sempre rivolto 
in basso (tranne alcuni casi parti-
colari). Nella musica vocale, i 
gambi sulle linee centrali spesso 
sono rivolti in alto (per evitare 
collisioni con le parole); sui righi 
a 1 linea i gambi sono sempre 
rivolti in alto.

Per le note in un accordo (o unite 
tra loro) la direzione del gambo 
dipende dall’altezza media.

In più voci, tutte le note hanno i 
gambi in alto nelle voci 1e 3 e in 
basso nelle voci 2 e 4, indipende-
mente dall’altezza.
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È possibile spostare i singoli gambi verso la testa nota (per avere una nota senza gambo) anche se è 
meglio usare le opportune note senza gambo – b Teste nota.

Si può anche spostare un gambo oltre la testa nota per farlo finire sul lato opposto della nota – 
sebbene non sia molto utile.

Note senza gambo
Per creare note senza gambo usare la testa nota 8 – selezionare la nota(e) o il passaggio al quale 
togliere il gambo(i) e premere Maius+Alt+8 o xz8 (sulla tastiera del computer).

Simboli per il gambo
Nella musica contemporanea, a volte ai gambi sono aggiunti simboli che 
indicano particolari tecniche esecutive; b Simboli. Tuttavia, Sibelius 
colloca e riproduce automaticamente tremolo e rullate; b Tremolo.

Nascondere le linee aggiuntive
Sibelius inserisce automaticamente linee aggiuntive quando si creano 
note sopra o sotto il rigo. Per nascondere le linee aggiuntive, si possono 
seguire due approcci: per nascondere tutte le linee aggiuntive di uno 
strumento particolare disattivare l’opzione Tagli addizionali nel tipo di 
rigo strumento (b Modifica strumenti); per nascondere le linee 

aggiuntive in un particolare passaggio di note usare un tipo di testa nota con l’opzione Tagli 
addizionali non attiva (b Modifica teste nota).

Opzioni Regole tipografia
Nella pagina Note e Tremolo della finestra di dialogo House Style > Regole tipografia
(comando rapido Ctrl+Maius+E o xXE) ci sono alcune opzioni intressanti:

* Tagli addizionali x spessore spazi: consente di modificare lo spessore delle linee aggiuntive; il 
valore di default è 0.16 spazi. Normalmente, le linee aggiuntive sono più sottili di quelle del rigo.

* I tagli addizionali si estendono al di là delle teste di nota di x% della loro ampiezza: 
permette di modificare la lunghezza delle linee aggiuntive; di default è 28%.

Nella pagina Tratti e Gambi della finestra di dialogo House Style > Regole tipografia (comando 
rapido Ctrl+Maius+E o xXE) ci sono opzioni ancor più interessanti:

* Gambi x spessore in spazi: consente di modificare lo spessore dei gambi; di default è 0.1 spazi.
* Lunghezza minima x spazi: permette di specificare una lunghezza minima per tutti i gambi, 

consentendo all’utente di sostituire (ad esempio) i gambi corti sulle note acute/gravi in 2 voci. 
Di default è 2.75.

* Nuova regola lunghezza gambo: allunga di 0,25 spazi rispetto all’opzione “off ” i gambi delle 
note sulla linea centrale o a un lato del rigo (cosa che molti trascrittori o editori preferiscono). 
Di default questa opzione è attiva.

Linee aggiuntive
Le linee aggiuntive per le 
note sopra o sotto il rigo non 
devono mai toccarsi, nem-
meno se i valori nota sono 
molto brevi.

Per evitare che si tocchino 
selezionare il passaggio 
interessato e aumentare un 
po’ la spaziatura tra le note.
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2.9 Legature di portamento

b Linee.

v Aggiungere i segni.

Legature di portamento e segni di frase
Sibelius tratta allo stesso modo le legature di portamento e i segni di frase; questi ultimi sono come 
grandi legature di portamento, quindi si usa il termine “legatura” per indicare entrambi. Questa 
terminologia è anche uno standard riconosciuto nella scrittura musicale.

Legature di portamento magnetiche™
In Sibelius, le legature scattano sulle note; modificando l’altezza delle 
note o aggiungendo articolazioni, la legatura si sposta: è cioè “mag-
netica”. (Altri oggetti magnetici sono i gruppi irregolari - tuplet).

Per creare una legatura di portamento magnetica:

* Selezionare una nota (o ornamento) e premere S; è scritta una legatura alla nota successiva; o
* Selezionare il passaggio di note (su un singolo rigo) da legare e premere S; appare una legatura di 

portamento su tutte le note selezionate.

Si può quindi estendere la legatura alla nota successiva premendo la barra spaziatrice (come 
quando si creano le parole), oppure contrarla con Maius-barra spaziatrice.

Questi tasti spostano l’estremità destra (poiché è quella 
selezionata). Si osservi la piccola “maniglia” quadrata – 
le legature hanno maniglie quando sono selezionate; se 
un’estremità della legatura è selezionata, solo lì appare la 
maniglia; l’uso di barra spaziatrice e Maius-barra spa-
ziatrice funziona anche con le altre linee.

È possibile selezionare e spostare l’estremità sinistra allo 
stesso modo sia con le frecce che con il mouse, oppure 
premendo barra spaziatrice/Maius-barra spazia-
trice. Per selezionare un’estremità della linea premere 
Alt+0/1 o z0/1; si selezionano quattro punti: 
l’estremità sinistra, entrambe le estremità (per regolare 
la posizione verticale della legatura) il centro della leg-
atura (per regolarne la curvatura) e l’estremità destra 
della legatura.

Infine, per cambiare forma alla legatura e renderla 
asimmetrica trascinarla al centro con il mouse.

Le legature magnetiche seguono alcune complesse regole di posizionamento, ma è Sibelius a farlo. 
Basta sapere alcuni particolari su come sono posizionate: premendo S la legatura inizia a un capo 
della testa nota nella prima nota in musica ad una voce (o a un capo del gambo in due o più voci). 

Posizione delle legature
In generale le legature vanno ai capi di 
note e accordi in una voce e a un capo del 
gambo in due o più voci.

Tuttavia, nella musica a una voce, se i 
gambi delle note legate hanno diverse 
direzioni o la legatura è lunga (quattro o 
più misure) essa va sopra le note.

Quando una legatura inizia su una nota 
legata, deve iniziare sulla prima delle note 
legate tra loro; analogamente, se una leg-
atura termina su una nota legata, deve 
andare alla fine delle note legate.

Per rendere le legature più visibili evitare 
che le estremità e i punti più alti e basso 
dell’arco tocchino una linea del rigo.
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Con Maius-S si colloca la legatura all’estremità opposta. Modifica > Inverti (comando rapido X) 
inverte una legatura all’altro capo della nota; talvolta bisogna farlo se la legatura unisce note nelle 
quali i gambi vanno in direzioni diverse (vedere il box di testo a pag. 135).

Le legature magnetiche non s’attaccano a note attraverso il rigo. Per sua natura, la legatura va dove 
sarebbero le note sul rigo originale, ma si può trascinare l’estremità della legatura alla posizione 
vera e propria della nota.

Legature non magnetiche
Sebbene questo tipo di legatura non sia consigliabile (tranne in circostanze particolari) è possibile 
avere legature non-magnetiche meno “intelligenti”, creando una legatura con niente selezionato con 
il mouse dalla finestra Crea > Linea. Le legature non-magnetiche non scattano sulle note e non evi-
tano nemmeno tratti d’unione e articolazioni, ma possono essere utili in alcune situazioni.

Le legature non-magnetiche selezionate appaiono in rosso (per consigliare l’uso di una legatura 
magnetica).

Il comando Layout > Ripristina posizione (comando rapido Ctrl+Maius+P o xXP) per reim-
postare la posizione di una legatura, trasforma inoltre una legatura non magnetica in una magnet-
ica.

Legature su due o più sistemi
Se è divisa su due sistemi, si usa scrivere ogni metà della legatura con un arco separato, invece di 
tagliarla in due semi-archi. Ciò consente ad una legatura divisa su due sistemi di unirsi alle note al 
termine del primo sistema o all’inizio del secondo.

Si può fare in due modi:

* Regolando la posizione verticale delle due estremità della mezza legatura: cliccare all’estremità 
della mezza legatura da regolare: appare una maniglia quadrata; trascinare le mezza legatura alla 
posizione desiderata. Per reimpostare le due metà della legatura alle rispettive posizioni di 
default selezionare Layout > Ripristina aspetto (comando rapido Ctrl+Maius+D o xXD). 
Oppure:

* Attivando l’opzione Clip a fine accollature nella pagina Legature della finestra di dialogo 
House Style > Regole tipografia (comando rapido Ctrl+Maius+E o xXE): si ottiene una leg-
atura non standard divisa a metà.

Copiare le legature
Quando in Sibelius si copia un passaggio contenente legature, insieme alle note sono copiate anche 
le legature; per copiarle in uno schema ritmico particolare o in altre frasi simili nella partitura si 
può usare il plug-in Copia Articolazioni e Legature – b Plug-in.

Legature multi-arco
Talvolta, nella musica per tastiera bisogna scrivere una legatura a forma 
di S, con più archi che scorrono sopra e sotto le note.

Per scriverla, inserire una legatura normale, cliccare a un’estremità e 
scegliere Crea > Altro > Arco legatura extra: s’aggiunge un arco extra 
alla legatura. Per cambiarne la forma, trascinare una metà della legatura 
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o il centro della legatura per deformarla asimmetricamente. È possibile aggiungere altri archi alla 
legatura nello stesso modo per allungarla a piacere.

Il comportamento di legature multi-arco non è prevedibile; vale la pena conoscerle meglio:

* Con l’estremità di una legatura rivolta in basso selezionata, scegliendo Crea > Altro > Arco leg-
atura extra s’aggiunge un altro arco di legatura rivolto in basso a quella estremità. Ripetendo 
l’operazione s’aggiungono più legature rivolte in basso.

* Con l’estremità di una legatura rivolta in alto selezionata, scegliendo Crea > Altro > Arco leg-
atura extra s’aggiunge un arco di legatura rivolto nella direzione opposta. Ripetendo questa 
operazione s’aggiunge un nuovo arco in ogni direzione.

* Invertendo in un punto qualsiasi la legatura, la direzione degli archi di legatura successivi (tutti 
in basso, tutti in alto o alternati in alto e in basso) dipende dalla direzione dell’arco di legatura 
originale e da quella dell’estremità dell’arco di legatura selezionato. Se la legatura originale è 
rivolta in basso, i nuovi archi di legatura saranno tutti rivolti nella stessa direzione dell’arco di 
legatura selezionato; se la legatura originale è rivolta in alto, le direzioni dei nuovi archi di leg-
atura si alterneranno iniziando dalla direzione opposta a quella dell’arco di legatura selezionato.

Legature tratteggiate e puntate
Le legature tratteggiate o puntate si creano scegliendole dalla finestra di 
dialogo Crea > Linea (comando rapido L). Creandole senza una nota 
selezionata non sono magnetiche; per renderle magnetiche usare il 
comando Layout > Ripristina posizione.

Si può modificare l’aspetto delle legature tratteggiate modificando la 
lunghezza dei trattini e lo spazio che li separa – b Modifica linee.

Legature sulle parole
Per stampare una sottile legatura dopo una parola (per esempio, alla fine di una serie di parole in 
un inno) non usare una legatura vera e propria – utilizzare invece il carattere “elisione”. 
Per i dettagli b Parole.

Per aggiungere legature a righi vocali (in modo da evidenziare meglio le parole) usare il plug-in 
Plug-in > Testo > Aggiungi legature alle parole (b Plug-in).

Opzioni Regole tipografia
La pagina Legature della finestra di dialogo House Style > Regole tipografia (comando rapido
Ctrl+Maius+E o xXE) ha varie opzioni interessanti riguardo alle legature:

* Distanza minima x spazi da linea rigo: evita che le estremità delle legature tocchino le linee 
del rigo.

* Evitare articolaziono: specifica la distanza tra le estremità delle legature e le articolazioni sulla 
stessa nota.

L’opzione Forma permette di cambiare l’aspetto delle legature:

* Margine: consente di stabilire il grado di “spallatura” delle legature. Quando c’è più di una spalla 
le legature sono più piatte al centro e hanno “angoli” più pronunciati alle estremità; con meno 
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spalla sono più arrotondate al centro e se ne controlla meglio la forma trascinandole con il 
mouse; i valori ideali sono compresi tra circa 60% e 90%.

* Clip a fine accollature: genera una legatura “troncata” dall’aspetto non-standard.

Infine, altre opzioni controllano come le legature magnetiche scattano alle note.
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2.10 Legature di valore

Le legature di valore indicano due note alla stessa altezza unite tra loro per formare una nota dalla 
durata superiore. Le note a fine o metà legatura di valore non devono essere risuonate. Le legature 
di valore sono molto diverse da quelle di portamento; queste ultime, infatti, si usano per indicare 
strutture di frase e, nel caso di strumenti a corda o a fiato, gruppi di note da suonare con un singolo 
movimento dell’archetto o un respiro continuo – b Legature di portamento.

Legature di valore e portamento
Non usare mai una legatura di portamento al posto di una di valore – quelle di portamento hanno 
lo stesso aspetto, ma in riproduzione o trasportando la musica non si comportano come le legature 
di valore; analogamente, non usare mai una legatura di valore al posto di una di portamento, 
poiché è possibile che le note non si leghino a niente (cioè, né ad un’altra nota né a una pausa) e in 
riproduzione si avranno note suonate all’infinito.

Creare le legature di valore
Le legature di valore s’inseriscono dal primo layout del tastierino numerico; selezionare una nota e 
scegliere la legatura di valore dal tastierino numerico (comando rapido Invio). Per aggiungere una 
legatura a tutte le note di un accordo doppio-click sull’accordo (o scegliere Modifica > Seleziona >
Seleziona altro, comando rapido Ctrl+Maius+A o xXA) prima di selezionare la legatura di 
valore dal tastierino numerico.

Dimensione e posizione della legatura di valore si possono modificare in molti modi:

* Per invertire la curva in alto piuttosto che in basso (o viceversa), selezionarla e scegliere 
Modifica > Inverti (comando rapido X); per resettarla alla sua posizione originale selezionare 
Layout > Resetta posizione (comando rapido Ctrl+Maius+P o xXP).

* Selezionare un’estremità (usare Alt+0/1 o z0/1 per selezionarla con la tastiera) e trascinarla, 
oppure premere Maius+Alt+0/1 o xz0/1; tenere premuto Ctrl o X per step più grandi. 
Sibelius garantisce che la legatura di valore rimanga sempre orizzontale e simmetrica.

* È possibile regolare la posizione delle estremità della legatura di valore e le rispettive “spalle” sin-
golarmente grazie al pannello Notes della finestra Properties (b Proprietà). 
Per regolarle in tutta la partitura vedere Opzioni Regole tipografia.

* Si può anche selezionare e trascinare la legatura al centro (o spostarla con i tasti 3/2) per ren-
derla più o meno arcuata.

* Per resettare la forma di una legatura dopo averne regolato la curvatura selezionare Layout >
Ripristina aspetto (comando rapido Ctrl+Maius+D o xXD).

Legature di valore sui break
Se una legatura attraversa un break di pagina o sistema non è possibile spostarne le estremità o 
invertire ogni metà in modo indipendente; in alcuni casi, ciò può creare dei problemi quando la 
legatura tocca i gambi nota. Se ciò avviene, attivare l’opzione Clip a fine accollature nella pagina 
Legature 1 della finestra di dialogo House Style > Regole tipografia.
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Legature di valore “Laissez vibrer”
Nella musica di piano e percussioni si può creare un effetto laissez vibrer legando una nota/accordo 
a una pausa come al solito (premendo Invio sul pad numerico) per indicare che la nota/accordo 
deve essere mantenuta fino al decadimento naturale del suono. Anche la riproduzione implementa 
questa opzione (inviando un messaggio MIDI Note On, ma non uno Note Off); il modo in cui 
suona la nota (in particolare se è risuonata in seguito) dipende dal tipo di dispositivo MIDI di 
riproduzione; se in riproduzione l’effetto non piace usare i simboli laissez vibrer nella fila Notes
della finestra di dialogo Crea > Simbolo (comando rapido Z).

Legature di valore nella musica arpeggiata
Nella musica per tastiere e arpa capita spesso di vedere figure come 
quella indicata a destra. Per scriverla, inserire le note come sempre 
aggiungendo una legatura di valore a ognuna; poi si può estendere ogni 
legatura alla nota di destinazione, se necessario.

Attenzione! Sibelius non “sa” che queste legature devono essere attaccate alle rispettive destinazi-
oni, quindi non ne regola automaticamente le lunghezze se cambia il loro layout o la spaziatura. 
Regolare quindi la lunghezza delle legature quando il layout della partitura è definitivo.

Note legate in misure di 2° finale (2° volta)
Quando le note sono legate in un 2° finale (misura 2° volta) le legature 
si devono scrivere all’inizio del 2° finale. Per farlo, usare i simboli lais-
sez vibrer descritti in precedenza o una legatura non magnetica 
(b Legature di portamento) - sebbene nessuno di questi metodi 
sarà riprodotto correttamente.

Opzioni Regole tipografia
La pagine Legature 1 e Legature 2 della finestra di dialogo House 
Style > Regole tipografia (comando rapido Ctrl+Maius+E o xXE) 
hanno un’incredibile serie di opzioni per le legature di valore. Molte 
non sono disponibili se l’opzione Regola posizionamento legatura 
di valore nella pagina Legature 1 non è impostata in Legature 
Optical. A meno che ci sia una buona ragione per non farlo è meglio 
usare quindi l’opzione Legature Optical.

Le altre opzioni nella pagina Legature 1 sono:

* Forma: queste opzioni determinano la “spalla” di default che Sibelius assegna alle legature. Essa 
si può paragonare alla pendenza della curvatura: una spalla più ampia tende ad appiattire la leg-
atura. Sibelius può aumentare automaticamente la spalla delle legature più lunghe, per evitare 
che assumano una curvatura troppo accentuata.

* Normalmente, le legature che attraversano un break di pagina o sistema sono scritte come due 
legature complete (una a ogni lato del break). Se però si preferisce che Sibelius scriva le legature 
sui break come due metà della stessa legatura attivare l’opzione Clip a fine accollature.

* Legature al di sopra/al di sotto sul lato della testa di nota definisce se le legature (quando 
sono scritte incurvate lontano dal gambo invece che verso il gambo) debbano andare o meno tra 
le teste nota, sopra o sotto di esse. Di default, Sibelius scrive le legature su singole note sopra o 

  
 


 

Posizionare le legature
La legatura di valore 
assomiglia a quella di porta-
mento ma le regole di posizion-
amento non sono uguali.

Quella di valore è più piatta e 
le estremità sono sempre vicine 
alla testa nota alla quale si lega 
(mai a fine gambo nota).

Per essere più visibili, le 
estremità e il punto più alto e 
basso dell’arco non devono toc-
care una linea del rigo.

Se ci sono entrambe le legature 
quella di valore deve sempre 
essere più vicina alle note.
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sotto (opzione Use on single notes attiva) e lega gli accordi tra le teste nota (opzione Usa su 
accordi non attiva). Le altre opzioni di questa sezione consentono di specificare la distanza della 
legatura dalla testa nota quando non è scritta tra le note, con impostazioni separate per sopra e 
sotto.

Le opzioni nella pagina Legature 2 sono:

* Legature di valore al di sopra/al di sotto rispetto al gambo: determina se le legature deb-
bano essere posizionate o meno in modo speciale quando la loro curvatura è forzata verso il 
gambo (scrittura diffusa nella musica a più voci). Alcuni editori preferiscono che la legatura più 
interna (cioè quella più vicina alle estremità dei gambi) sia collocata più in alto del normale (in 
modo che possa essere anche un pò più lunga). In Sibelius, le impostazioni di default manten-
gono le legature il più simmetriche possibili, quindi gli accordi non sono trattati in modo parti-
colare (opzione Usa su accordi non attiva) ma spostano le legature sulle singole note (opzione 
Usa su singole note attiva), usando le altre opzioni che permettono di specificare la distanza 
orizzontale e verticale alla quale la legatura più interna può essere spostata.

* Legature di valore tra le note: sono opzioni che si usano quando le legature non sono posiz-
ionate sopra o sotto se si trovano dalla parte della testa nota, oppure quando sono spostate in 
seguito alle impostazioni Legature di valore al di sopra/al di sotto rispetto al gambo. Si 
può stabilire come Sibelius decide la direzione della curvatura nelle legature di accordi e specifi-
care come si vuole che Sibelius collochi le estremità sinistra e destra delle legature. Come accen-
nato in precedenza, in Sibelius le impostazioni di default mantengono le legature simmetriche; 
le opzioni Allinea estremità sinistra della legature tra gli accordi e Allinea estremità 
destra della legature tra gli accordi sono quindi attive di default cosa che, in combinazione 
con le opzioni Legature di valore negli spazi (vedere in seguito), ottimizza l’aspetto delle lega-
ture anche nel caso di accordi complessi formati da intervalli di 2° o altri cluster.
Inizio legatura dopo punti ritmici: come indica il nome, questa opzione fa iniziare la legatura 
dopo il punto ritmico ed è attiva di default (sebbene le legature di note forzate sul lato del gambo 
non iniziano dopo i punti ritmici: piuttosto, di solito, vanno sopra il punto ritmico, quindi pos-
sono iniziare a sinistra del punto). Le altre opzioni peremttono di controllare con precisione le 
distanze che Sibelius utilizza quando colloca le legature tra note e accordi.

* Legature di valore negli spazi: determina se Sibelius debba preferire o meno una legatura per 
spazio (Preferisci una legatura per spazio). Ciò è utile, poiché evita che le legature appaiano 
“ammucchiate” in presenza d’accordi costituiti da più di due note con intervalli di 2° o altri clus-
ter di note. Con questa opzione attiva Sibelius garantisce che solo una legatura si trovi in un sin-
golo spazio sul rigo, distribuendo le altre legature in base ai limiti stabiliti dalle due opzioni 
Massimo. Si consiglia di lasciare solo un massimo di 1 legatura posizionabile oltre l’estremità 
della testa nota di un accordo (ma si può consentire il posizionamento di più legature sul lato del 
gambo; in Sibelius il valore di default è 2).

Avendo le idee chiare su come collocare le legature si raccomanda di sperimentare queste 
impostazioni per trovare la combinazione che soddisfi al meglio le proprie esigenze. Una volta 
configurate correttamente le opzioni desiderate, raramente si devono modificare manualmente le 
legature (nel caso sia necessario farlo usare il pannello Note della finestra Proprietà).
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2.11 Linee

b Legature di portamento, Filtri e Trova, Modifica linee.

v Aggiungere i segni.

La finestra di dialogo Crea > Linea (comando rapido L) presenta linee musicali speciali (trilli, lega-
ture, forcine, glissandi, e così via) da inserire nella partitura. È possibile anche modificare linee 
esistenti e disegnarne di nuove – b Modifica linee.

Creare le linee
Tutte le linee si creano allo stesso modo:

* È possibile crearle automaticamente alla posizione della nota/pausa selezionata, oppure si pos-
sono inserire con il mouse:
% Per avere la linea posizionata automaticamente, selezionare la nota/pausa dove si vuole far 

iniziare la linea, oppure un passaggio di note al quale applicarla.
% Per inserire la linea con il mouse assicurarsi che non sia selezionato niente – premere Esc.

* Selezionare Crea > Linea (comando rapido L). La finestra è divisa in due metà: staff lines (a sinis-
tra) che si applica solamente a un rigo singolo e system lines (a destra) che si applica a tutti i righi 
ed appare in tutte le parti.

* Selezionare la linea da creare e cliccare OK; la linea appare automaticamente sull’oggetto/passag-
gio selezionato nella partitura, oppure il puntatore del mouse cambia colore ad indicare che è 
“pronto” con un oggetto – per creare la linea cliccare nella partitura.

* Per estendere la linea verso destra di una nota alla volta, premere la barra spaziatrice; per con-
trarla di nuovo verso sinistra, premere Maius-barra spaziatrice. Si può anche trascinare 
un’estremità della linea con il mouse; le linee di sistema non si possono estendere e contrarre con 
la tastiera.

* Quando l’estremità di una linea è selezionata (appare un piccolo box blu) è possibile eseguire 
piccole regolazioni sulla sua posizione con i tasti freccia (premere Ctrl o X per step più grandi).

Legature di portamento
Le legature di portamento sono un tipo di linea speciale – b Legature di portamento.

Forcine
Le forcine si creano selezionando la nota sotto la quale si desidera far iniziare la 
forcina e digitando H per un crescendo o Maius-H per un diminuendo. Come per 
le legature di portamento e altre linee, si può spostare l’estremità di una forcina a 

destra/sinistra tra le note con la barra spaziatrice o premendo Maius-barra spaziatrice.

Allungando la forcina se ne aumenta leggermente l’apertura; nella pagina Lines della finestra 
House Style > Regole tipografia (comando rapido Ctrl+Maius+E o xXE) si può definire l’aper-
tura esatta della forcina nei vari casi. Se per una forcina particolare non si vuole un’apertura stan-
dard si può cambiarla con le opzioni del pannello Linee nella finestra Proprietà (b Proprietà). 
La finestra di dialogo contiene anche le forcine tratteggiate, puntate e “da/al silenzio”, mentre la 
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finestra di dialogo Crea > Simbolo ha i simboli “esponenziali” da aggiungere alla fine dei cre-
scendo (se necessario).

Si può regolare la riproduzione di una singola forcina nel pannello Playback della finestra Proper-
ties – b Riproduzione.

Ritardando e accelerando.
Nella finestrella Linee di sistema della finestra di dialogo 
Crea > Linea ci sono vari tipi d’indicazioni rit. e accel.. Per inser-
irli nella partitura, cliccarci sopra e trascinarli con il mouse.

Poiché sono linee di sistema, rit. e accel. si ripetono nella partit-
ura come gli altri oggetti di sistema (le scritte Tempo, ad esem-
pio) e sono incluse in tutte le parti.

Nella musica per tastiera e vocale, normalmente rit. e accel. sono 
scritti in corsivo. Nella musica corale sono scritti sul rigo di ogni 
cantante invece che solo in alto. Per segnarlo, creare una linea 
rit./accel. in corsivo sul rigo in alto e usare la scritta Expression 
per scrivere le indicazioni sugli altri righi.

Nella musica per sola tastiera, in genere le indicazioni rit./accel.
sono tra i righi. Per segnarlo, creare una linea rit./accel. sopra il rigo in alto e trascinarla in basso 
tra i righi.

Per regolare la riproduzione delle linee rit./accel., b Riproduzione.

Trilli
Per creare un trillo, selezionarlo dalla finestra di dialogo Crea > Linea, quindi cliccare e trascinare 
il mouse nella partitura per estendere la linea di trillo verso destra dal simbolo tr. Per avere un 
trillo senza una linea a serpentina cliccare e trascinare il più possibile verso sinistra la maniglia del 
trillo nella partitura.

Per regolare la riproduzione dei trilli, b Riproduzione.

Pedali
Oltre alla linea di pedale standard, la finestra di 
dialogo Crea > Linea ha varie altre linee che con-
sentono di scrivere le “tacche” di ri-pedalatura. Si 
possono anche creare segni senza linee, ove il 
pedale in alto è indicato da un asterisco dalla 
finestra di dialogo.

La pedalatura è riprodotta (sempre che sia scritta usando le linee, non simboli o scritte). Perché sia 
applicata a entrambi i righi di piano, assicurarsi che i righi usino lo stesso canale MIDI nella 
finestra Finestra > Mixer (comando rapido Ctrl+Alt+M o M su Mac) – b Mixer.

1°, 2° e 3° finale (misure 1°/2°/3° volta)
Il 1°, 2° e 3° finale (misure 1°/2°/3° volta) nella finestrella Linee di sistema della finestra di dial-
ogo Crea > Linea appaiono in cima al sistema e si applicano a tutti gli strumenti.

Posizione di forcine, trilli e 
pedali
Le forcine vanno sotto il rigo, con gli 
altri segni dinamici (a meno che 
siano in Voce 1 o 3 in partiture a più 
voci oppure sotto ci siano le parole). 
Si collocano tra i righi di strumenti a 
tastiera quando valgono per 
entrambe le mani. In genere, le 
forcine non sono in diagonale.

I trilli vanno sopra il rigo, tranne 
alcuni casi (se sono in Voce 2 o 4).

I pedali vanno sempre sotto il rigo di 
piano inferiore.
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In grandi partiture (per chiarezza) a metà sistema appaiono uno o più duplicati (per esempio, 
sopra gli archi nelle partiture orchestrali) così come per i segni di prova e le scritte Tempo. È possi-
bile regolare le posizioni in cui appaiono i duplicati, oppure cancellarli singolarmente – 
b Layout e formattazione.

Inoltre, è inclusa una linea di finale ‘1.2.’ (sebbene, in riproduzione, si ripeta solo una volta, non 
due). È possibile creare linee di n finali arbitrarie semplicemente creando una nuova linea basata 
su una esistente e cambiando la scritta all’inizio della linea – b Modifica linee.

Linee d’ottava (8/15)
Queste linee si usano soprattutto per evitare molte linee aggiuntive su un rigo. Sono diffuse nella 
musica per tastiera, ma si usano raramente per altri strumenti. 8va e 15va (rispettivamente per 
una e due ottave in alto) e 8vb e 15vb (rispettivamente per una e due ottave in basso) si trovano 
nella finestrella Linee rigo della finestra di dialogo Crea > Linea.

Per non usare la terminologia Italiana, si può modificare la linea in 8 invece che 8va o modificare 
la linea 8vb in 8va o 8va bassa – b Modifica linee.

Glissato e portamento
In genere, una linea gliss. è retta e comprende la scritta gliss. angolata 
in lunghezza (sebbene Sibelius ometta automaticamente la scritta se 
la linea non è abbastanza lunga); talvolta, la linea è a serpentina. Il 
Portamento (port.) è simile, ma di solito è indicato solo da una linea 
retta.

Per cambiare lo spessore delle serpentine usate dalla linea gliss., 
modificare la linea (b Modifica linee) e scegliere un altro tipo di 
linea dal menu a tendina Stile.

In alcune partiture può servire una linea gliss. senza scritta, anche 
quando la linea è abbastanza lunga per includerla; in una partitura, 
ad esempio, ci potrebbero essere molti glissando ma potrebbe essere 
necessario indicare esplicitamente con una scritta solo alcuni tra i 
primi. Per farlo, modificare la linea port., togliere la scritta e usare 
quella come linea gliss. senza scritta – b Modifica linee.

Per regolare la riproduzione delle linee, b Riproduzione.

Alcuni driver di stampanti hanno un bug che stampa con un angolo sbagliato le scritte angolate o 
le linee a serpentina; se ciò avviene vedere b Stampa.

Linee d’arpeggio
Nella musica per tastiera, arpa e chitarra spesso si vede una linea verticale a serpentina; essa indica 
che le note di un accordo devono essere “distribuite” dal basso in alto (o nel senso indicato dalla 
direzione della freccia sulla linea). Nella finestra di dialogo Crea > Linea ci sono molte linee 
d’arpeggio. Volendo, si può cambiare lo spessore delle serpentine usate da queste linee – 
b Modifica linee. Alcuni driver di stampanti hanno un bug che stampa le linee a serpentina nel 
posto sbagliato; se ciò avviene vedere b Stampa.

Posizione delle linee 
d’ottava
Le linee 8va e 15va sono sempre 
collocate sopra un rigo di chiave 
di violino; le linee 8vb e 15vb 
sono collocate sempre sotto un 
rigo di chiave di basso.

La scritta 8va è centrata sulla 
testa nota e l’estremità della 
parentesi di 8va si estende un pò 
oltre l’ultima nota.

Le alterazioni prima della linea 
d’ottava devono essere ripetute 
se la nota si ripete dopo l’inizio 
della linea d’ottava. 
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Parentesi per la musica di tastiera e doppi-stop
Le parentesi per indicare dove le note distribuite su due righi devono essere suonate da una mano 
nella musica per tastiera e dove le note devono essere stoppate due volte sugli archi si trovano nella 
finestrella Linee rigo della finestra Crea > Linea. Quando si creano queste linee, cliccare e tras-
cinare per crearle della lunghezza desiderata; assicurarsi di trascinare verso l’alto, in modo che le 
parentesi siano dirette nella stessa direzione (come indicato nella finestra di dialogo).

Rettangolo
Un rettangolo, utile alla notazione “in cornice” (impiegata dai compositori classici moderni come 
Lutoslawski), si trova nella finestrella Staff Line della finestra di dialogo Crea > Linea. (Per i pro-
fani, un rettangolo o “cornice” attorno ad un gruppo di note, di solito indica che esse si devono rip-
etere in continuazione ad un ritmo libero).

Per inserire un rettangolo, innanzitutto assicurarsi che nella partitura non sia selezionato niente 
(premere Esc), poi selezionare il rettangolo dalla finestra di dialogo Crea > Linea, cliccare nella 
partitura dove deve andare un angolo del rettangolo e trascinare verso l’angolo opposto. Diseg-
nando il rettangolo attorno ad alcune note, esso si espande e contrae per racchiuderle se la spazia-
tura nota cambia.

Linee di tratti d’unione
Nella finestrella Staff lines della finestra di dialogo Crea > Linea c’è un tratto d’unione da diseg-
nare sulle note per creare effetti speciali (come accelerando “a ventaglio”, b Tratti d’unione).

Linee tratteggiate
Servono ad indicare l’estensione di un segno come un cresc.. Usare queste linee invece di digitare 
una fila di trattini, poiché le linee s’allungano o accorciano automaticamente se cambia la spazia-
tura della partitura, mentre una fila di trattini mantiene una lunghezza fissa.

Linee di chitarra
Le linee per tutte le tecniche di chitarra più diffuse (sia sui righi di notazione che di tablatura) sono 
alla base della finestrella Staff lines nella finestra Crea > Linea, oltre ad una serie completa di 
linee indicatrici corda (un numero cerchiato seguito da una linea orizzontale con un uncino 
all’estremità destra), posizionabili sia sopra che sotto il rigo. b Notazione e tablatura per 
chitarra.

Comando Reset Position
Layout > Ripristina posizione (comando rapido Ctrl+Maius+P o xXP) allinea le estremità delle 
linee alle note, spostandole alle posizioni verticali di default. b Layout e formattazione.

Riformattare le linee
Come probabilmente si sarà capito, le linee si comportano in maniera molto “intelligente” se cam-
bia la spaziatura nota o si riformatta la musica. In pratica, le estremità di una linea sono attaccate 
ad una nota o posizione ritmica in modo indipendente; modificando la spaziatura delle note, 
quindi, tutte le linee nelle vicinanze s’allungano o accorciano opportunamente (collocare una 
forcina sotto alcune note e provare a trascinare una di esse a sinistra e destra per vedere cosa suc-
cede). Inoltre, Sibelius divide automaticamente le linee attraverso due o più sistemi, o riunisce i 
frammenti se la musica è riformattata più drasticamente (per i dettagli vedere in seguito).
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Un vantaggio del comportamento “intelligente” delle linee è che si evita di perdere di tempo a ordi-
narle nelle parti strumentali – Sibelius lo ha già fatto!

Linee su due o più sistemi
Per inserire una linea che divide due o più sistemi usare il mouse, come per una legatura:

non inserire due linee separate! Piuttosto, inserirne una come al solito (selezionando la nota e dig-
itando S al punto 1), poi premere la barra spaziatrice fino ad estendere la legatura al punto 2. 
Anche creando linee con il mouse non c’è bisogno di trascinare in orizzontale lungo il rigo superi-
ore – andare dritti al punto 2 senza passare per GO; Sibelius si occuperà del resto.

Sibelius, infatti, esegue molte operazioni utili in questi casi – se s’inserisce un segno 8va attraverso 
più di un sistema, Sibelius scrive un (8) d’avvertimento all’inizio del secondo sistema; si può modi-
ficare la scritta d’avvertimento cambiando la linea (b Modifica linee). Analogamente, una 
forcina di crescendo su due sistemi avrà un’estremità aperta sul lato sinistro del secondo sistema.

Con le linee orizzontali (come “8va”), Sibelius consente di spostare la seconda metà della linea in 
alto e in basso, indipendentemente dalla metà superiore (utile per evitare una nota acuta). Selezi-
onare la porzione di linea da regolare e spostarla in alto e in basso; ciò non vale per le forcine: se 
una forcina và oltre un sistema, non è possibile regolare la sua posizione verticale in modo 
indipendente dai sistemi successivi (poiché la forcina sarà scritta in diagonale).

Se una linea và oltre più di due sistemi, si può regolare solo la posizione verticale della porzione 
presente nel sistema originale e di tutti i sistemi successivi insieme (in altre parole, non si può 
regolare ogni sistema successivo in modo indipendente).

Per regolare la posizione orizzontale delle estremità nelle porzioni divise di linee su più di un 
sistema, vedere la pagina Linee della finestra di dialogo House Style > Regole tipografia
(comando rapido Ctrl+Maius+E o xXE):

* L’opzione RH end controlla la spaziatura tra l’estremità destra della linea e la fine del sistema.
* Il box di spunta LH end controlla se la continuazione di una linea di sistema inizia allineata 

all’inizio della tonalità. Di default non è attivo (la linea di sistema si allinea con la fine della 
tonalità).

Nascondere le linee
Per nascondere una linea (operazione necessaria in genere per aggiungere forcine nascoste che 
avviano la riproduzione), selezionarla e scegliere Modifica > Mostra o nascondi > Nascondi
(comando rapido Ctrl+Maius+H o xXH). Per maggiori informazioni sull’occultamento di 
oggetti, b Nascondere oggetti.
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2.12 Misure e misure di pausa

b Inserimento note, Pause multiple. Per copiare o cancellare più misure simultanemente, 
b Selezioni e passaggi.

v Layout e House Style.

Aggiungere le misure alla fine della partitura
Per aggiungere una misura alla fine della partitura: Crea > Battuta > Alla Fine (oppure Ctrl+B o
XB).

Per aggiungere più misure, tenere premuto Ctrl+B o XB; poco dopo il comando si “auto-ripete”.

Aggiungere le misure in mezzo alla partitura
Selezionare Crea > Battuta > Singola (comando rapido Ctrl+Maius+B o xXB) e cliccare nella 
partitura alla posizione in cui si vuole creare la misura.

Usando il comando Crea > Battuta > Singola con una nota, pausa o altro oggetto selezionato, si 
aggiunge una misura dopo quella contenente l’oggetto selezionato.

Altrimenti, selezionare una posizione nella partitura in cui aggiungere più misure, scegliere Crea >
Misura > Altro (comando rapido Alt+B o zB), digitare il valore Numero battute desiderato e 
cliccare su OK; Sibelius crea le misure. Se quando si è selezionato Crea > Battuta > Altro non era 
selezionato nulla, il puntatore del mouse cambia colore ad indicare che è “pronto“ con le nuove 
misure e si può cliccare nella partitura per inserirle.

Modificare la durata delle misure
Per cambiare la durata delle misure perché si sta modificando il tempo in chiave, vedere b Tempi 
in chiave.

Per modificare la durata di una singola misura (cioè inserire/cancellare note) mantenendo la 
musica:

* Creare una misura irregolare della durata desiderata (vedere in seguito), appena prima o dopo la 
misura in questione.

* Copiare la musica da conservare come un passaggio (b Selezioni e passaggi)
* Cancellare la misura originale.

Cancellare una misura intera
Per cancellare una misura selezionarla e scegliere Modifica > Elimina misure (comando rapido 
Ctrl+Canc o X-Canc); si cancella il contenuto della misura e la misura stessa. È possibile cancel-
lare più misure in una volta selezionandole come passaggio di sistema – b Selezioni e pas-
saggi.

Cancellare una misura in un rigo
* Cliccare in una zona vuota della misura (si circonda di un box blu chiaro).
* Premere Canc per trasformarla in una misura di pausa. Questa operazione cancella anche altri 

oggetti nella misura assegnati a quel rigo (un testo, ad esempio).
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Si può cancellare il contenuto di più misure in una volta (o una misura in più righi) selezionando le 
misure e premendo Canc – b Selezioni e passaggi.

Creare una misura di pausa in una voce
* Selezionare una nota o pausa nella misura.
* Premere N per far apparire il cursore d’inserimento.
* Andare nel secondo layout del tastierino numerico (comando rapido F9).
* Scegliere la voce nella quale inserire la misura di pausa usando i pulsanti alla base del tastierino 

numerico (comando rapido Alt+1-4 o z1-4).
* Selezionare il pulsante misura di pausa (comando rapido 0).

Questo metodo si può usare sia per creare una misura di pausa in una voce che prima non esisteva 
sia per trasformare di nuovo le note in una misura di pausa in una sola voce. Tuttavia, ciò cancella 
solamente note o pause e lascia intatti gli altri oggetti; per cancellare anche una scritta, linee e altri 
oggetti selezionare la misura e premere Canc.

Si noti che una misura di pausa non è una pausa di un intero (semibreve). Le misure di pausa sono 
centrate, mentre le pause di un intero si trovano a sinistra nella misura, alla stessa posizione in cui 
andrebbe la nota da un intero (come indica la figura seguente):

Cancellare il simbolo di una misura di pausa
Selezionare il simbolo della misura di pausa e premere Canc. Se la musica era a due voci, torna a 
essere a una voce. Se la musica era a una voce, la misura si svuota. Le misure vuote sono utili per 
inserirci qualcos’altro, come un simbolo strano o particolare.

Per avere misure vuote in tutta la partitura (come in un certo tipo di musica contemporanea) ved-
ere Misure di ripetizione e note intere doppie (breve)/misure di pausa vuote.

Creare misure irregolari
Una misura irregolare non ha la durata specificata dal tempo in chiave precedente. Le misure 
d’attacco (upbeat bars) ne sono un esempio; per creare una misura irregolare:

* Selezionare Crea > Battuta > Altro (comando rapido Alt+B o zB).
* Nella finestra di dialogo che appare cliccare su Irregolare.

* Dal menu a tendina, scegliere uno o più valori nota da aggiungere alla durata desiderata, oppure 
digitarli sul pad numerico (con il tasto Num Lock attivo).

* Si può anche specificare un Numero battute per avere più misure irregolari della stessa durata.
* Cliccare su OK.

* Cliccare nella partitura dove si desidera creare la misura(e).





Pausa da un intero

    
     

Misura di pausa
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Misure d’attacco (upbeat)
Spesso le partiture iniziano con una misura più corta, denominata misura d’attacco (upbeat bar) o 
anacrusis. È più facile crearle insieme al tempo in chiave (b Tempi in chiave). Sibelius mostra 
automaticamente come pause il numero di movimenti nella misura d’attacco e divide le pause cre-
ate in base all’opzione Gruppi di tratti e pause del tempo in chiave. Per aggiungere una misura 
d’attacco dopo aver creato il tempo in chiave:

* Accertarsi anzitutto che non vi sia nulla di selezionato (premendo Esc).
* Selezionare Crea > Battuta > Altro.

* Creare una misura della durata adeguata e cliccare all’inizio della partitura per collocarla davanti 
alla prima misura completa.

* Selezionare il tempo in chiave nella prima misura completa e premere Canc, rispondendo No
quando Sibelius chiede se si desidera riscrivere le misure successive.

* Creare di nuovo il tempo in chiave all’inizio della nuova misura d’attacco, assicurandosi di 
deselezionare l’opzione Riscrivi battute fino alla prossima indicazione di tempo (b Tempi 
in chiave).

* Infine, usare l’opzione Crea > Altro > Cambio numero misura per creare un cambio di numero 
misura a 0 all’inizio della misura d’attacco (b Numeri misura).

Modificare la larghezza di una misura di pausa
Spostare semplicemente la stanghetta alla fine della misura.

Misure di ripetizione e note intere doppie (breve)/misure di pausa vuote
Per cambiare un simbolo di misura di pausa in una misura di ripetizione, una misura di pausa di 
nota intera doppia (breve) o una misura di pausa vuota (mancante): selezionare il simbolo della 
misura di pausa e scegliere l’aspetto desiderato dal pannello Battute della finestra Proprietà, 
oppure i tasti di comando Maius-+/– per scegliere tra i vari simboli. È possibile cambiare le mis-
ure di pausa in basso su tutti i righi in una volta selezionando prima la misura con un Ctrl+clic o
X-clic del mouse.

Per avere misure di pause vuote in tutta la partitura, disattivare l’opzione Visualizza battute in 
pausa nella pagina Battute in pausa della finestra di dialogo House Style > Regole tipografia 
(comando rapido Ctrl+Maius+E o xXE).

Per riprodurre le misure di ripetizione, b Ripetizioni.

Spostare un simbolo di misura di pausa
(indispensabile quando si usano due o più voci!).

Selezionare il simbolo della misura di pausa e premere il tasto 3 o 2. Sibelius non permette di 
spostare una misura di pausa a sinistra o destra perché - in realtà - non serve a molto.

Premendo Ctrl+3/2 o X3/2 la misura di pausa si sposta di una volta e mezzo (la giusta distanza 
per i righi leggermente più larghi della tablatura per chitarra).

Misure divise
Talvolta è utile dividere una misura in due metà, la prima alla fine di un sistema e la seconda 
all’inizio di quello successivo. Per farlo, Plug-in > Altro > Dividi misura – b Plug-in.
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2.13 Notazione e tablatura per chitarra

b Inserire una tablatura per chitarra, Diagrammi accordo, Tablatura per liuto, File 
in tablatura ASCII.

La musica per chitarra ha molti segni peculiari– bending, pre-bending, slide, hammer-on e pull-
off e così via – tutti facilmente producibili in Sibelius; i più comuni sono elencati in seguito:

È possibile crearli sia sui righi di notazione che di tablatura e cambiano aspetto automaticamente 
quando sono copiati tra un tipo di rigo e l’altro (con alcune eccezioni descritte in seguito).

Alcuni segni di tablatura indicano note nascoste sul rigo di tablatura, che può essere visualizzato e 
modificato attivando l’opzione Vista > Oggetti nascosti (comando rapido Ctrl+Alt+H o zXH).

Bending
I bending si eseguono premendo una corda e tirandola in alto o in basso dopo 
averla suonata; normalmente sono di un semitono o di un tono, ma volendo è pos-
sibile anche eseguire bending di intervalli microtonali.

Sui righi di notazione, un bending è scritto con una linea angolata tra due note (un 
po’ come una legatura obliqua); sui righi di tablatura è indicato da una freccia 
rivolta in alto (se la seconda nota è più acuta della prima) o in basso (se la seconda 
nota è più grave della prima); inoltre, per i bending up la seconda nota non è seg-

nata sul rigo di tablatura; l’intervallo del bending è indicato invece sopra la freccia curva, in semi-
toni. Il bending di un tono solitamente è indicato dalla scritta “full” invece che dal numero “1” 
(sebbene, in Sibelius, questa funzionalità si possa cambiare nella pagina Chitarra della finestra di 
dialogo House Style > Regole tipografia, disattivando l’opzione Usa ‘full’ su bending intavola-
tura).

Per creare un bending selezionare la prima nota e premere J (assomiglia leggermente a un bending 
su un rigo di tablatura); la linea di bending si colloca automaticamente tra la prima nota e quella 
successiva (oppure scatta alla nota successiva quando la si crea). Si può inserire un bending anche 
con il mouse: innanzitutto assicurarsi che nella partitura non sia selezionato nulla, scegliere Crea >
Linea (comando rapido L) e selezionare la linea di bending (che appare come su un rigo di notazi-
one) dal pannello Linee rigo; il puntatore mouse cambia colore e si può cliccare nella partitura per 
inserire la linea.

Le linee di bending sono come le legature di portamento: digitare la barra spaziatrice per estendere 
il bending alla nota successiva o Maius-barra spaziatrice per contrarlo; sui righi di notazione, 
selezionare Modifica > Inverti (comando rapido X) per spostare il bending all’altro lato della nota; 
si può anche regolare la posizione di entrambe le estremità della linea di bending con il mouse o i 
tasti freccia. Come le legature di portamento, i bending sono magnetici e si posizionano automati-
camente.

Intervalli di bending
Per modificare l’intervallo di bending su un rigo di notazione cambiare l’altezza della seconda 
nota; su un rigo di tablatura, assicurarsi che l’opzione Vista > Oggetti nascosti (comando rapido 
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Ctrl+Alt+H o zXH) sia attiva, selezionare la seconda nota nascosta e modificarne l’altezza (suo-
nando una nota sulla tastiera MIDI o digitando il numero del tasto sulla tastiera del computer).

Per inserire un bending lieve o microtonale, creare un bending su una nota e premere Maius-barra 
spaziatrice per accorciare l’estremità destra, in modo che si attacchi alla stessa nota dell’estremità 
sinistra.  
Su un rigo di notazione, un bending lieve è scritto con una linea curva; su un rigo di tablatura 
come bending di un quarto di tono.

Per cambiare font o dimensione dei numeri sopra i bending su un rigo di tablatura, modificare lo 
stile di testo Tasto diagramma accordo – b Modifica stili di testo.

Se in un rigo di tablatura si preferisce scrivere i bending senza la freccia, disattivare l’opzione Usa 
frecce su bending intavolatura nella pagina Chitarra della finestra House Style > Regole 
tipografia.

Bending & release
Un bending & release è un bending up seguito da un bending down alla nota orig-
inale. Per segnarlo, creare un bending up seguito da un bending release.

Su un rigo di tablatura, in generale, la nota finale è in parentesi (perché non è 
pennata); per aggiungere la parentesi, selezionare la nota e scegliere il pulsante 
parentesi tonda ( , comando rapido 1) nel secondo layout del tastierino numer-

ico (F9).

Bending di ornamenti e pre-bending
Entrambi questi tipi di bending si scrivono allo stesso modo: innanzitutto, dal 
secondo layout del tastierino numerico (F9), creare l’ornamento ( , comando 
rapido * in Windows, = su Mac) o la nota pre-bending ( , comando rapido –
in Windows, * su Mac); premere J per creare un bending e creare la seconda 
nota.

Su un rigo di tablatura, il pre-bending è indicato da una freccia verticale.

Pre-bending e release
Un pre-bending e release si crea in modo simile ai bending d’ornamenti e pre-bend-
ing; creare una nota pre-bending seguita da un ornamento, creare un bending, poi 
creare una nota normale e creare un altro bending tra l’ornamento e la nota normale. 
Ricordarsi di aggiungere la parentesi alla nota finale sul rigo di tablatura (vedere 
Bending & release).

Bending all’unisono
Un bending all’unisono si ha pennando le due note contemporaneamente e tirando 
quella più grave all’altezza della nota più acuta. Su un rigo di notazione è scritto 
come un pre-bending (vedere sopra), con due teste nota per la nota superiore. Su un 
rigo di tablatura, si deve inserire un testo per indicare la nota più acuta delle due; 
selezionare Crea > Testo > Testo speciale > Numeri tablatura e digitare il numero.
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Slide
Uno slide si ottiene pennando la prima nota e facendo scivolare lo stesso dito in 
alto o in basso alla seconda nota e diventa pennato se è uno slide shift o non pen-
nato se è uno slide legato.

Sia nei righi di notazione che di tablatura, gli slide shift sono indicati da una 
linea retta (figura a sinistra). Gli slide legato sono scritti con una linea e una leg-
atura. Se la seconda nota dello slide è più acuta la linea punta in alto; se la sec-
onda nota è più grave, la linea punta in basso. Sui righi di tablatura, la linea ha 

un’angolazione fissa, ma su quelli di notazione è angolata in base alla posizione delle note alle quali 
è attaccata.

Per creare uno slide, inserire la prima nota dello slide e cliccare sul pulsante slide ( , comando 
rapido) nel secondo layout del tastierino numerico (F9), quindi inserire la seconda nota. Si può 
inserire lo slide anche dopo aver creato entrambe le note – selezionare la prima delle due note e 
cliccare sul pulsante slide. Per uno slide legato aggiungere una legatura come al solito 
(b Legature di portamento).

Gli slide sono magnetici e si posizionano automaticamente. Si può regolarne la posizione selezio-
nando una delle estremità e muovendo le maniglie con il mouse o i tasti freccia.

Quando in un accordo ci sono più note in slide, si presume che scivolino tutte nella stessa direzi-
one. Se così non fosse, usare le linee rette nella finestra di dialogo Crea > Linea (comando rapido L) 
per creare gli slide che vanno nella direzione opposta.

Vibrato (whammy) con pressione e rilascio della leva
L’altezza della nota o accordo scende del numero di toni specificato, poi torna 
a quella originale.

Su un rigo di notazione, pressione e rilascio della leva sono scritti con due 
linee di bending (vedere Bending) e la linea “w/bar” della finestra di dialogo 
Crea > Linea (comando rapido L).

Su un rigo di tablatura, cancellare la nota centrale e aggiungere la parentesi 
all’ultima nota. Usare due linee rette distinte della finestra di dialogo Crea > Linea per la V (poiché 
i bending appaiono come frecce). Digitare il numero sotto il rigo di tablatura al punto V con il 
comando Crea > Testo > Testo speciale > Numeri tablatura.

Leva di vibrato scoop
Il vibrato “scoop” si suona premendo la leva appena prima di pennare la nota 
e poi rilasciandola rapidamente.

Per scriverlo, usare il simbolo dalla fila Chitarra nella finestra di dialogo 
Crea > Simbolo (comando rapido Z). Su un rigo di notazione, si dovrà 
aggiungere anche la linea “w/bar” dalla finestra di dialogo Crea > Linea
(comando rapido L); per estendere la linea verso destra, premere la barra spaziatrice.
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Leva di vibrato dip
Un vibrato dip si suona pennando la nota, facendola calare del numero di step 
specificato e rilasciandola per riportarla all’altezza originale.

Per segnarlo, usare il simbolo V dalla fila Chitarra nella finestra Crea > Sim-
bolo, digitare i numeri sopra con il comando Crea > Testo > Altro testo rigo >
Testo piccolo e, su un rigo di notazione, inserire una linea “w/bar” dalla 
finestra Crea > Linea.

Altre tecniche
Altri segni per chitarra si possono creare facilmente come segue:

* Hammer-on and pull-off: usare una legatura – b Legature di portamento.

* Tapping: usare una legatura con l’articolazione + sulla prima nota se necessario 
(b Articolazioni); per il tapping con la mano sinistra, usare il simbolo  nella fila Tech-
niques della finestra di dialogo Crea > Simbolo (b Simboli).

* Vibrato e vibrato ampio: le linee adatte si trovano accanto al pulsante dell’elenco nella finestra di 
dialogo Crea > Linea – b Linee.

* Trillo: usare una linea trillo – b Linee.
* Arpeggiato: usare una linea arpeggio – b Linee.
* Pennata di tremolo: usare un tremolo – b Tremolo.

* Shake: usare un simbolo shake – b Simboli.

* Armonici: sui righi di notazione usare una testa nota a rombo (b Teste nota) e sui righi di 
tablatura scrivere “Harm.”, “H.H.” (per un armonico arpeggiato), o “P.H.” (per un armonico 
tirato) sopra la nota in testo Small.

* Slap: scrivere “T” sopra la nota in testo Small.
* Pop: scrivere “P” sopra la nota in testo Small.
* Testa nota X: selezionare una nota e scegliere la testa nota X dal pannello Notes della finestra 

Proprietà.
* Pick scrape: usare una linea di glissato angolata a serpentina (finestra Crea > Linea) e scrivere 

“P.S.” sopra il rigo della tablatura in testo Small; su un rigo di notazione usare una testa nota a 
croce.

* Corde stoppate: usare le teste nota a croce – b Teste nota.
* Rake: su un rigo di notazione, creare ornamenti con teste nota a croce; su un rigo di tablatura, 

copiare la musica da un rigo di notazione (in tal caso, le teste nota sono copiate automaticamente 
come croci) o cambiare le teste nota una volta create le note, poi aggiungere un’adeguata linea 
“Rake” dalla finestra di dialogo Crea > Linea.

* Diteggiatura: usare il comando Crea > Testo > Altro testo rigo > Diteggiatura chitarra (p i m 
a) e scrivere la diteggiatura sopra ogni nota o accordo.

La finestra Crea > Linea (comando rapido L) ha le linee che servono per la maggior parte delle tec-
niche di chitarra più comuni: “w/bar,” “P.M.” (per il palm muting) e così via. Per creare altre linee 
per la tecnica chitarristica, vedere b Modifica linee.

¬
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Accordatura sui righi di tablatura
Quando si usano accordature particolari è utile visualizzare la nota di ogni corda 
direttamente sul rigo di tablatura (a sinistra c’è l’accordatura aperta in DO).

Per le accordature non-standard Sibelius mostra queste note di default; per evi-
tarlo, selezionare una misura nel rigo, scegliere House Style > Modifica stru-

menti e ensemble, cliccare su Modifica Strumento, su Sì, quindi su Modifica Tipo Rigo; 
infine disattivare l’opzione Tonalità/Accordatura nella pagina Generale (b Modifica stru-
menti).

Personalizzare tablature, accordature e strumenti a tasti
Sibelius ha più di 30 accordature per chitarra interne (senza contare una mezza dozzina di accor-
dature per banjo, 11 per dobro, due per sitar e varie accordature per liuto!), ma oltre a questa rac-
colta completa se ne possono creare di personalizzate.

Cambiare l’accordatura di uno strumento
Per cambiare l’accordatura in un rigo della partitura, è sufficiente cambiare quella di un altro stru-
mento. Con nulla selezionato nella partitura, scegliere Crea > Altro > Cambio strumento, selezi-
onare lo strumento con l’accordatura desiderata, cliccare su OK, quindi nella partitura a sinistra 
della stanghetta iniziale all’inizio della partitura.

Se l’accordatura che si sta cercando è disponibile in uno strumento interno, si può facilmente mod-
ificarne una di quelle esistenti (o crearla da zero) con l’opzione House Style > Modifica stru-
menti e ensemble – b Modifica strumenti.

Note sulla tablatura con sfondo bianco
Vari editori hanno opinioni diverse sul fatto che i numeri sui righi della tablatura debbano essere 
collocati direttamente sulle linee del rigo o avere un piccolo sfondo bianco (in modo che le linee 
del rigo non attraversino il numero). Naturalmente, Sibelius consente all’utente di definire questa 
funzionalità permettendo di modificare le impostazioni per i singoli strumenti nella finestra di 
dialogo House Style > Modifica strumenti e ensemble. Selezionare lo strumento nella finestra 
e cliccare su Modifica Strumento; se lo strumento esiste già nella partitura, Sibelius chiede se si è 
sicuri di voler continuare: cliccare su Sì, quindi cliccare nella finestra di dialogo Modifica Stru-
mento cliccare su Modifica Tipo Rigo.  
L’opzione è Bianco esterno intorno alle note nella pagina Tab.

In Sibelius le impostazioni di default sono:

* Per i righi di tablatura che visualizzano i ritmi con i gambi scritti nel rigo, l’opzione Bianco 
esterno intorno alle note è attiva; ciò rende più chiara e ben definita la visione dei gambi.

* Per i righi di tablatura che indicano i ritmi con i gambi scritti interamente fuori dal rigo e per i 
righi di tablatura che non mostrano i ritmi, l’opzione Bianco esterno intorno alle note non è 
attiva.

La tablatura può essere divertente
Certamente!


C
G
C
G
C
E
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In Sibelius, la tablatura per chitarra è trattata come un tipo di rigo speciale (invece che come un 
rigo di percussioni) e proprio come Sibelius può cambiare il numero di linee del rigo a metà parti-
tura, l’utente può passare dalla notazione alla tablatura a metà partitura (e perfino a metà rigo) – o 
cambiare l’intonazione della corda a metà partitura.

Per provare: dalla finestra Crea > Altro > Cambio strumento scegliere uno strumento con tabla-
tura per chitarra e cliccare a metà di un rigo di notazione contenente musica. Da lì in poi, la notazi-
one si trasforma in tablatura e il punto di svolta è in pratica un “oggetto” (un po’ come una chiave) 
che, una volta selezionato, appare come un rettangolo color porpora. Trascinare questo rettangolo 
a sinistra e destra o in alto e in basso da rigo a rigo: Sibelius converte immediatamente tutta la 
notazione successiva in tablatura. Straordinario!

Opzioni Regole tipografia
La pagina Chitarra della finestra House Style > Regole tipografia (comando rapido 
Ctrl+Maius+E o xXE) riguarda soprattutto l’aspetto “esoterico” dei diagrammi accordo, ma ci 
sono anche alcune opzioni specifiche per la tablatura:

* Usa ‘full’ su bending intavolatura: se attiva, i bending di chitarra di un tono sono indicati 
dalla scritta “full”; disattivandola i bending di un tono sono indicati dal numero “1”.

* Usa frecce su bending intavolatura: disattivarla se si preferisce che le linee di bending sui 
righi di tablatura siano scritti senza le frecce.

* Disegna abbellimenti con stile lettere intavolatura: consente di regolare la dimensione 
degli ornamenti sui righi della tablatura indipendentemente dalla dimensione delle acciaccature 
sui righi di notazione; attivando questa opzione, gli ornamenti sui righi di tablatura assumono la 
dimensione dello stile di testo Lettere Intavolatura. Di default questa opzione non è attiva.

Si può anche modificare lo stile di testo usato per i numeri della tablatura cliccando sul pulsante 
Modifica Stile Testo.
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2.14 Ornamenti

b Acciaccature.

Gli ornamenti sono più piccoli delle note normali e sono scritti tra esse; a differenza delle acciacca-
ture, gli ornamenti non influiscono sulla durata totale della misura, poiché l’esecutore li inserisce 
tra le note principali. Gli ornamenti con una linea diagonale sul gambo sono acciaccature e quelli 
senza sono appoggiature (questa è la terminologia usata da Sibelius).

Creare gli ornamenti...
Gli ornamenti sono sempre attaccati alla nota successiva in 
una misura (quindi non è possibile creare automatica-
mente ornamenti alla fine della misura – vedere in 
seguito). Gli ornamenti si creano in due modi:

Il metodo più rapido è inserire gli ornamenti durante 
l’inserimento alfabetico o step-time delle note; il metodo 
più lento consiste nell’inserire prima le note normali e poi 
aggiungere gli ornamenti.

...il metodo più rapido
Per aggiungere gli ornamenti mentre s’inseriscono le note:

* Iniziare a creare le note (b Inserimento note)
* Per creare un ornamento, passare al secondo layout del 
tastierino numerico (comando rapido F9) e attivare il ris-
pettivo pulsante del tastierino numerico:

* Creare poi le note come al solito, scegliendo i valori nota dal primo layout del tastierino numer-
ico (comando rapido F8).

* Per interrompere la creazione degli ornamenti disattivare il pulsante d’ornamento nel secondo 
layout del tastierino numerico.

...il metodo più lento
Per aggiungere gli ornamenti a un passaggio di musica esistente:

* Con nulla di selezionato (premere Esc), selezionare il valore nota e il tipo d’ornamento rispetti-
vamente dal primo e secondo layout del tastierino numerico.

* Il puntatore del mouse cambia colore per indicare su quale voce si sta per creare l’ornamento; 
cliccare nel punto in cui deve essere inserito l’ornamento.

* Se non è stato specificato un valore nota prima di crearlo, l’ornamento appare come una nota da 
1/8 (croma); si può modificare il valore nota in seguito, come per le note normali.

Ornamenti
In generale, gli ornamenti sono scritti con i 
gambi rivolti in alto, indipendentemente 
dalla loro altezza; sono scritti con i gambi 
rivolti in basso solo per evitare collisioni 
con altri oggetti (ad esempio, nella seconda 
di due voci e nella musica per bagpipe).

Le acciaccature (con una linea sul gambo) 
si usano solo per singoli ornamenti. Orna-
menti singoli, in particolare le acciaccature, 
sono quasi sempre scritti in note da 1/8 
(croma) indipendentemente dalla loro 
durata reale. Coppie di ornamenti sono 
scritte in note da 1/16 (semicrome) e le note 
da 1/32 (biscrome) si usano per gruppi di 
circa quattro o più ornamenti.

In generale, gli ornamenti sono legati alla 
nota principale successiva. La legatura nor-
malmente va sopra se la nota principale è 
più acuta dell’ornamento (o se l’ornamento 
o nota principale ha linee aggiuntive sopra 
il rigo), altrimenti la legatura và sotto.

Acciaccatura Appoggiatura
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* Digitare A–G o usare la tastiera MIDI per avere più ornamenti dopo il primo.
* Digitare 1–9 (o Maius-1–9 per le note più gravi) per avere accordi d’ornamento (oppure 

suonare gli accordi sulla tastiera MIDI). 

Modificare gli ornamenti
La maggior parte delle operazioni di modifica sugli ornamenti sono uguali a quelle per le note nor-
mali, compresi trascinamento, copia, cancellazione, aggiunta/rimozione di alterazioni e articolazi-
oni, tratti d’unione e modifica dei valori o teste nota.

Ornamenti alla fine delle misure
Poiché gli ornamenti s’attaccano alla nota o pausa che li segue, quando si crea un ornamento alla 
fine della misura (ad esempio, dopo un trillo o altro ornamento) esso non può attaccarsi a nulla. 
Per creare un ornamento alla fine di una misura, quindi, inserire una nota nella misura successiva 
e creare l’ornamento(i) prima di questa nota, quindi spostare la sua posizione prima della stang-
hetta usando il parametro X nel pannello Generale della finestra Proprietà (b Proprietà). Se 
necessario, la nota principale dopo l’ornamento può essere cancellata. (Per spostare l’ornamento, 
quindi, usare solo la finestra Proprietà – non il mouse o i tasti freccia – altrimenti l’ornamento 
potrebbe attaccarsi a una nota diversa!).

Spaziatura degli ornamenti
Nella finestra di dialogo House Style > Regole spaziatura note, il parametro Spazio intorno 
agli abbellimenti definisce lo spazio che separa ogni ornamento, mentre il parametro Spazio 
extra dopo ultimo abbellimento stabilisce la distanza tra l’ultimo ornamento e la nota normale 
successiva.

Opzioni Regole tipografia
La pagina Note e Tremolo della finestra di dialogo House Style > Regole tipografia (comando 
rapido Ctrl+Maius+E o xXE) permette di modificare la dimensione di ornamenti e acciaccature 
rispetto alle note normali. Normalmente, gli ornamenti sono un po’ più piccoli delle acciaccature 
(il 60% della piena grandezza invece del 75%).
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2.15 Parentesi quadre e graffe

Le parentesi quadre e graffe si usano nella parte sinistra dei sistemi per raggruppare strumenti 
simili. Sibelius sceglie di default dove inserirle, ma è possibile cambiare questa funzionalità.

Spostare le parentesi quadre e graffe
Si può definire quali righi di uno spartito sono racchiusi in 
parentesi quadra o graffa:

* È meglio trovare un punto nella partitura in cui non ci siano 
righi nascosti, in modo da vedere subito tutte le parentesi qua-
dre e graffe. Cliccare all’estremità di una parentesi, sottoparen-
tesi quadra o graffa esistente in modo che si colori in porpora.
* Trascinarla in alto o in basso per estenderla o contrarla.
* Per rimuovere una parentesi quadra, sottoparentesi o graffa 
selezionata, cliccare su Canc.

Aggiungere una parentesi, sottoparentesi 
quadra o graffa
* Dal menu Crea > Altro > Parentesi quadra o graffa, cliccare 
su Quadra, Sotto-quadra o Graffa.

* Cliccare a sinistra del rigo per inserirvi la parentesi, sot-
toparentesi quadra o graffa.
* Cliccare e trascinare la sua parte alta o bassa per estenderla 
ad altri righi.

Nascondere una parentesi quadra o graffa
Sibelius nasconde automaticamente parentesi quadre e graffe 

se non è presente una stanghetta al lato sinistro del sistema. Per esempio, nascondendo un rigo di 
una parte di piano (in modo che sia visibile solo un rigo) Sibelius nasconde la parentesi quadra; 
analogamente, nascondendo tutti (tranne uno) i gruppi in parentesi quadra dei righi in uno o più 
sistemi, Sibelius nasconde la parentesi quadra.

Per nascondere una parentesi quadra o graffa in un’altra situazione (in una partitura “cut-away”, ad 
esempio) selezionare la misura dopo la parentesi quadra da nascondere, aprire il pannello Bars
della finestra Properties e disattivare l’opzione Brackets. Per maggiori informazioni sulle proprietà 
degli oggetti vedere b Proprietà.

Collocare le parentesi quadre a metà sistema
Talvolta, nella musica per tastiera (quella per organo in particolare) è necessario visualizzare una 
parentesi quadra a metà di un sistema. Ciò può essere utile anche in partiture “cut-away” (vedere 
Righi con spazi vuoti on page 118), dove a metà di una pagina è introdotto uno strumento in 
parentesi quadra.

Per far apparire una parentesi quadra a metà di un sistema:

Parentesi quadre e graffe
In generale, strumenti della stessa 
famiglia (es. legni, ottoni, percussioni) 
sono uniti in parentesi. Strumenti per-
cussivi e solisti normalmente non sono 
raccolti in parentesi.

Gli strumenti su due o più righi (come 
gli archi) sono uniti da una sottoparen-
tesi quadra (più sottile, a sinistra di 
quella normale). Esse, talvolta, si usano 
per raggruppare strumenti simili 
(Flauto e Piccolo, Violino I e II). Nelle 
vecchie partiture orchestrali talvolta 
sono usate parentesi a spirale al posto 
delle sottoparentesi quadre (in partico-
lare per i gruppi di ottoni).

I righi di tastiera sono uniti da una 
parentesi quadra, ma il rigo del pedale 
d’organo non è unito a quelli manuali.

In generale, piccoli gruppi di strumenti 
non sono messi tra parentesi.

Gli strumenti in parentesi quadra, sub-
parentesi o graffa di solito hanno anche 
i righi uniti da stanghette.
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* Selezionare la stanghetta iniziale della misura dopo la quale si vuole inserire la parentesi quadra.
* Aprire il pannello Misure della finestra Proprietà e aumentare con cautela il valore Spazio 

prima della misura con le frecce (a 0,03 o 0,06, ad esempio), fino a quando appare la parentesi 
quadra.  
In pratica, si crea un sistema diviso (come una coda) ma con un piccolo vuoto.

* Poi, nello stesso pannello Proprietà disattivare l’opzione Stanghetta iniziale e Chiavi.

Probabilmente si dovrà spostare la prima nota della misura successiva alla parentesi quadra a sin-
istra, per colmare il vuoto lasciato dalle chiavi: spostarla il più a sinistra possibile, poi con la nota 
ancora selezionata diminuire il valore X nel pannello Generale della finestra Proprietà fino a 
quando è correttamente posizionata (come per qualsiasi nota/pausa all’inizio della misura nella 
parte sinistra). Trascinare poi la seconda nota verso sinistra fino a quando lo spazio vuoto tra le 
prime due note è normale.

Si noti, tuttavia, che usando questo metodo le parentesi quadre e graffe sono ripetute in tutti gli 
altri righi che appaiono a questo punto (potrebbe essere poco desiderabile in una partitura “cut-
away”). Si può modificare ciò definendo un nuovo strumento con l’opzione Parentesi disattivata 
(pagina Generale della finestra di dialogo Modifica Tipo Rigo, accessibile dal menu Modifica 
Strumento); applicare poi una modifica strumento agli altri righi che appaiono a questo punto. 
Per ulteriori dettagli, vedere b Modifica strumenti.

Stile di parentesi quadre e graffe
Nella pagina Brackets della finestra di dialogo House Style > Regole tipografia (comando 
rapido Ctrl+Maius+E o xXE) ci sono varie opzioni “rassicuranti” che consentono di regolare 
spessore e posizione di parentesi quadre, sottoparentesi e graffe. Queste opzioni sono auto-esplica-
tive, tranne quella Disegna come graffa che per le sottoparentesi quadre è in vecchio stile per cui 
(ad esempio) i righi Violino I e II sono uniti da una graffa invece che da una sottoparentesi quadra.

Usando il font Helsinki di Sibelius, si noterà che la sua graffa è leggermente più spessa e curvilinea 
del font Opus. 

Per creare una parentesi quadra senza uncini (usati talvolta da compositori come Penderecki) 
modificare una parentesi quadra adatta nella finestra di dialogo House Style > Modifica linee; 
impostare l’opzione Cap to None. Si deve crearla manualmente nello spartito – non appare auto-
maticamente all’inizio di ogni sistema.

Le graffe sono scritte scalando un simbolo { presente nella fila General della finestra di dialogo 
Crea > Simbolo. Per cambiare lo stile della graffa sostituire un carattere graffa con un diverso font 
di musica o testo (b Simboli). Alcune stampanti non stampano il simbolo di graffa allungato; se 
è possibile stampare le graffe solo con l’opzione Parentesi attiva (finestra di dialogo File > Stampa)
significa che la stampante ha questo limite e non si può cambiare lo stile delle graffe in Sibelius.
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2.16 Pause multiple

b Misure e misure di pausa, Numeri misura, Lavorare con le parti, Layout auto-
matico.

La “pausa multipla” è un’abbreviazione che indica una serie di misure di pausa consecutive, con il 
numero di misure scritto sopra. Di solito, esse si trovano solo in parti strumentali; talvolta, però, 
appaiono anche in partiture complete (la Tapiola di Sibelius, misure 28–29, ad esempio).

Usare le pause multiple
In Sibelius, le pause multiple sono un’opzione visiva – le misure vuote si possono vedere come mis-
ure di pausa individuali o riunite in pause multiple.

Per vedere le misure di pausa come pause multiple selezionare Layout > Auto Layout e attivare 
l’opzione Usa simboli di battute d’aspetto. Sibelius lo fa automaticamente nelle parti. C’è anche 
un comando rapido speciale per attivare e disattivare l’opzione Usa simboli di battute 
d’aspetto: Ctrl+Maius+M o xXM. 

Sibelius divide automaticamente le pause multiple in corrispondenza di tempi in chiave, segni di 
prova, cambi tonalità, cambi di chiave, indicazioni tempo, e così via. Per dividere manualmente 
una pausa multipla, vedere Dividere una pausa multipla.

Creare una pausa multipla
La pausa multipla si crea come una serie di singole misure di pausa: selezionare Crea > Misura >
Altro, digitare il Numero battute desiderato, cliccare OK e cliccare dove si vuole collocare la 
pausa multipla. Altrimenti, copiare una pausa multipla esistente selezionandola come passaggio di 
sistema con un Ctrl+click o X-click e poi premendo Alt+click o z-click.

Inserimento note in una pausa multipla
Le pause multiple funzionano come le normali misure di pausa – è possibile inserire le note o copi-
are la musica in esse; inserendo le note in una pausa multipla, Sibelius estrae le misure da essa per 
inserirvi le note, riducendo opportunamente la durata della pausa multipla.

Cambiare la durata di una pausa multipla
Per regolare il numero di misure in una pausa multipla disattivare l’opzione Usa simboli di bat-
tute d’aspetto in Layout > Auto Layout (per avere una serie di misure di pausa separate), 
aggiungere o eliminare le misure e attivare di nuovo l’opzione Usa simboli di battute d’aspetto 
in Layout > Auto Layout.

Dividere una pausa multipla
Sibelius può dividere automaticamente le pause multiple – vedere Layout automatico di 
pause multiple.

Per dividere una pausa multipla:

* Disattivare l’opzione Usa simboli di battute d’aspetto in Layout > Auto Layout.
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* Selezionare una stanghetta e scegliere Layout > Interruzioni > Dividi battuta d’aspetto; se è 
attiva l’opzione Vista > Marchi Layout, sopra la stanghetta appare un piccolo simbolo di pausa 
multipla tagliato in due.

* Attivare ancora l’opzione Usa simboli di battute d’aspetto; la pausa multipla si divide alla 
stanghetta selezionata.

Se dopo aver disattivato l’opzione Usa simboli di battute d’aspetto in Layout > Auto Layout si 
seleziona un passaggio e si sceglie Layout > Interruzioni > Dividi battuta d’aspetto, il passaggio 
si divide a entrambe le estremità diventando una pausa multipla separata (quando si attiva di 
nuovo l’opzione Usa simboli di battute d’aspetto). Se nel passaggio ci sono note, testo o altri 
oggetti, essi dividono comunque la pausa multipla.

Evitare che una pausa multipla si divida in parti
Le pause multiple nelle parti sono divise automaticamente da oggetti di sistema. per non vedere 
l’oggetto nella parte, si può evitare che la pausa multipla si divida, selezionando nella parte e sceg-
liendo Modifica > Mostra o nascondi > Nascondi (comando rapido Ctrl+Maius+H o xXH) – 
b Lavorare con le parti.

Stabilire perché si divide una pausa multipla
Talvolta capita che in una parte una pausa multipla si divida inaspettatamente; ciò avviene, in 
genere, perché un oggetto di testo del sistema si è attaccato in un punto sbagliato; per rimediare, 
selezionare l’oggetto in questione, premere W per passare alla partitura intera, tagliare l’oggetto e 
collocarlo nel clipboard con un Ctrl+X o XX; incollarlo poi alla misura giusta con un Ctrl+V o
XV.

Se non si capisce perché una pausa multipla è divisa, selezionare le misure in questione e usare il 
plug-in Plug-in > Verifica di lettura > Cosa è dove. Verificare l’esito per gli elementi di testo del 
sistema (normalmente il problema è lì); una volta scoperto cosa provoca la divisione, correggere il 
problema seguendo le indicazioni descritte in precedenza.

Nascondere una pausa multipla
Per nascondere una pausa multipla, selezionarla e premere Canc. Il simbolo di pausa multipla 
scompare ma le rispettive misure restano intatte (in realtà, questa operazione cancella la prima 
misura di pausa “all’interno” della pausa multipla).

Cancellare una pausa multipla
Per cancellare interamente una pausa multipla, Ctrl-click o X-click del mouse su di essa per farla 
diventare un passaggio di sistema (circondato da un doppio-box color porpora) e premere Canc.

Layout automatico di pause multiple
Per informazioni su come dividere automaticamente le pause multiple, b Layout automatico.

Visualizzare i numeri misura sulle pause multiple
Sibelius può indicare i numeri misura delle misure contenute in una pausa multipla come inter-
vallo di numeri misura, sopra o sotto la pausa multipla – vedere Aspetto e frequenza in 
b Numeri misura.
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Opzioni Regole tipografia
La pagina Battute in Pausa della finestra di dialogo House Style > Regole tipografia (comando 
rapido Ctrl+Maius+E o xXE) presenta varie opzioni auto-esplicative.

L’opzione più evidente consente di scegliere se segnare le pause multiple in misure-H, misure-H 
strette (per lasciare spazio ad entrambi i lati in caso di aggiunte dell’ultimo minuto), nel “vecchio 
stile ” di buffi piccoli rettangoli, o completamente vuote (per eventuali annotazioni in parti jazz).

Le parti spesso hanno un numero sopra tutte le misure di pausa, sia che durino una singola misura 
o più misure. Per scrivere 1 sopra ogni singola misura di pausa attivare l’opzione Show ‘1’ above 
bar rests nella pagina Bar Rests della finestra di dialogo House Style > Regole tipografia. 
Questa opzione c’è anche nella finestra di dialogo Multiple Part Appearance – b Lavorare con 
le parti.

Un’altra opzione utile nella pagina Battute in Pausa è Disegna H-bar con simbolo: essa utilizza 
un simbolo allungato invece di un rettangolo, per scrivere la barretta grossa di una misura-H. Di 
default questa opzione non è attiva, ma è meglio attivarla quando si usano i font Reprise o 
Inkpen2, poiché così le pause multiple hanno lo stile manoscritto. Attenzione però, perché i bug 
nei driver di alcune stampanti stampano male le misure-H; possono perfino provocare un crash 
nel computer se si stampa con questa opzione attiva! Prima di usarla, quindi, verificare bene se 
l’opzione funziona correttamente con la propria stampante.

Sibelius consente di stabilire l’offset della pausa multipla di misura-H. Per cambiare questo valore, 
modificare il parametro Distanza dalla battuta d’aspetto alla stanghetta. Di default è 1
spazio; inserendo valori superiori aumenta lo spazio vuoto a entrambi i lati della pausa multipla 
rispetto alle stanghette ad entrambi i lati.

Le pause multiple si possono scalare in modo da essere proporzionalmente più larghe man mano 
la loro durata aumenta. Sibelius permette di stabilire lo spazio extra da aggiungere ad una pausa 
multipla che copre 10 misure. Per cambiare questo valore, modificare il parametro Spazio extra 
per battute d’aspetto da 10 misure. Di default è 12, quindi Sibelius aggiunge 12 per una pausa 
multipla di 10 misure e, in proporzione, di più man mano la pausa multipla si allunga. La scala 
impiegata è logaritmica, quindi le pause multiple non diventano improvvisamente più larghe 
quando le misure di pausa aumentano. Per disattivare completamente questa funzionalità inserire 
il numero 0.

È possibile modificare anche gli stili di testo usati per inserire i numeri e le scritte sopra le pause 
multiple, rispettivamente con le opzioni Pause multiple (numeri) e Pause multiple (tacet) per 
cambiare, ad esempio, le rispettive posizioni verticali – b Modifica stili di testo.

Collocare i numeri per le pause multiple sotto la misura-H
Normalmente, i numeri di pausa multipla sono scritti sopra la misura-H, ma per collocarli sotto
basta cambiare lo stile di testo Posizione verticale relativa al rigo della voce Pause multiple 
(numeri) in House Style > Posizioni di Default a -6, ad esempio.

  
Misura H Misura H stretta


Stile antico

  
Vuoto
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2.17 Percussioni

b Teste nota, Tremolo.

Questo capitolo è dedicato esclusivamente alla scrittura per strumenti percussivi non intonati. La 
scrittura per gli strumenti percussivi intonati è praticamente uguale a quella di altri strumenti 
intonati, quindi non richiede particolari nozioni.

Le percussioni non intonate si possono scrivere in vari modi (dipende dalla natura della musica e 
dall’ensemble per la quale sono scritte). Per esempio, nella musica rock, jazz e commerciale, per 
scrivere diversi strumenti non intonati sullo stesso rigo si usano altezze e teste nota diverse; si 
tratta, in genere, della notazione per batteria (drum set o drum kit).

Nella musica per orchestra, bande, ensemble di percussioni ci sono altre possibilità:

* Ogni strumento (o set di strumenti) può avere un rigo diverso (per esempio, piatti, cassa, tri-
angolo); oppure:

* Si usa solo un rigo, con una scritta che indica dove l’esecutore cambia da uno strumento all’altro; 
oppure:

* Ogni esecutore ha il proprio rigo o serie di righi; ciò è utile per creare parti separate suonate da 
vari esecutori.

Sibelius ha tutti i più comuni strumenti percussivi intonati e non intonati, facili da scrivere nella 
partitura con i criteri descritti in precedenza.

Strumenti percussivi non intonati
Ogni strumento percussivo interno non intonato di Sibelius ha la propria drum map, cioè un 
elenco di corrispondenze tra ogni percussione utilizzata (per esempio, cassa, campanaccio, ecc.), la 
posizione sul rigo e il tipo di testa nota (normale, a croce o rombo) con la quale è scritta.

Per gran parte degli strumenti percussivi non intonati, questa drum map è molto semplice. Gli 
strumenti percussivi che usano righi ad 1 sola linea, ad esempio, in genere producono il suono 
desiderato scrivendo una testa nota normale, a croce o rombo sul rigo stesso.

Alcuni strumenti percussivi, invece, sono più complessi e usano più linee sul rigo e molte teste 
nota. Per esempio, un kit di batteria, rullante, cassa e piatti utilizzano righi a 5 linee; inoltre, 
diverse teste nota a posizioni diverse sul rigo producono suoni diversi.

Poiché in Sibelius ci sono dozzine di strumenti percussivi non intonati è praticamente impossibile 
descrivere nei dettagli le drum map specifiche usate da ogni strumento. Per vedere quindi la drum 
map di un particolare strumento:

* Selezionare una nota o misura nello strumento in questione (se lo si sta già usando nella partit-
ura).

* Selezionare House Style > Modifica strumenti e ensemble.

* Se è stata selezionata una nota o misura, anche lo strumento sarà selezionato (altrimenti selezi-
onarlo dall’elenco Struments nella Famiglia).
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* Cliccare Modifica Strumento; se un messaggio avvisa che la modifica dello strumento com-
porta un cambiamento nella partitura, cliccare Si.

* A questo punto, cliccare Modifica Tipo Rigo e selezionare la pagina Percussioni.
* La zona in alto nella finestra di dialogo mostra le teste nota mappate; per vedere quale suono è 

prodotto da una specifica testa nota, selezionarla e guardare il campo valore Sound. Qui si può 
vedere anche quale tasto della tastiera MIDI suonare per inserire questa nota – vedere Inseri-
mento nota per una percussione non intonata.

Per maggiori informazioni su questa finestra di dialogo, la modifica di strumenti percussivi esist-
enti e la definizione dei propri, b Modifica strumenti.

La notazione per batteria, tuttavia, è piuttosto standard quindi si può vederla in dettaglio.

Notazione di batteria
Per creare un rigo di batteria in Sibelius, selezionare Crea > Strumenti e righi (comando rapido I) 
e scegliere Drum Set o Drum Kit (sono identici, a parte il nome).

Gli strumenti Drum Set e Drum Kit usano un sistema di notazione basato sulle indicazioni della 
Percussive Arts Society (tratte dal libro “Guide To Standardized Drumset Notation” di Norman 
Weinberg ) come segue:

Inserimento nota per una percussione non intonata
Per l’inserimento nei righi di percussioni, si può usare un metodo qualsiasi di Sibelius, ma se lo 
strumento percussivo usa tipi di teste nota diversi è più facile e rapido usare l’inserimento step-
time o Flexi-time invece di quello con il mouse o alfabetico.

Si consideri il semplice esempio che segue: cassa e rullante con il charleston aperto e chiuso di un 
normale kit di batteria:

Le note da 1/4 (semibrevi) sono nella voce 2 ed usano la testa nota di default, le note da 1/8 
(crome) e 1/16 (semicrome) sono nella voce 1 e utilizzano teste nota a croce. (Non usando la testa 
nota a croce, le note non avranno il suono del charleston).

Scrivendo questa musica con l’inserimento alfabetico o il mouse, bisognerà cambiare le note della 
voce 1 in modo che usino la testa nota a croce dopo averle inserite:


Pedale

charleston


Timpano

1


Timpano
acustico


Tom a terra

basso


Tom a terra

alto


Tom
basso


Tamburello


Rullante
acustico


Rullante
elettrico


Legno
basso




Bordo

        bacchetta

 
Legno
alto


Tom


Cowbell


Tom
alto


Piatto
Ride 1


Cha

chiuso


Cha

aperto


Piatto
Crash 1


Triangolo
aperto


Tom 
medio
basso

medio
alto
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* Selezionare le misure nelle quali cambiare le teste nota (b Selezioni e passaggi)
* Eseguire un fitraggio per una voce specifica, per esempio, Modifica > Filtro > Voce 1 (ciò che 

serve nell’esempio precedente) oppure per l’altezza specifica da cambiare, con l’opzione 
Modifica > Filtro > Filtro avanzato. Il filtro d’altezza tratta le chiavi percussive come chiave di 
violino, quindi:
% Nei righi a 1 linea l’altezza della linea nel singolo rigo è SI4 (poiché essa corrisponde a quella 

centrale di un rigo a 5 linee).
% Nei righi a 2 linee, le altezze sono (dal basso in alto) SOL4 e RE5.
% Nei righi a 3 linee, le altezze sono MI4, SI4 e FA5.
% Nei righi a 4 linee, le altezze sono FA4, LA4, DO5 e MI5.
% Nei righi percussivi a 5 linee, la linea centrale è SI4.
Per ulteriori dettagli sulle funzioni di filtro in Sibelius, b Filtri e Trova.

* Cambiare la testa nota premendo Maius+Alt+n o xzn, dove n è un numero digitato sulla tast-
iera del computer (non sul pad numerico); nell’esempio precedente premere Maius+Alt+1 o 
xz1. Altrimenti, si può scegliere la testa nota dal menu nel pannello Notes della finestra Prop-
erties (b Teste nota).

Inserendo la musica da una tastiera MIDI in step-time o Flexi-time, Sibelius mappa automatica-
mente l’altezza delle note suonate sulla tastiera MIDI all’altezza appropriata scegliendo anche la 
giusta testa nota (e articolazione, se specificata). Suonando una nota alla cui altezza c’è più di una 
testa nota mappata nel tipo di rigo, Sibelius sceglie la prima testa nota elencata nel drum map.

Si può decidere se usare le mappature d’altezza stabilite dallo strumento o le altezze usate dal dis-
positivo MIDI collegato (cioè la tastiera MIDI o un modulo sonoro). Ciò dipende dall’opzione 
Righi Percussioni nella pagina Inserimento note del menu File > Preferenze (menu Sibelius in 
Mac).

Di default, Sibelius è impostato in The instrument, quindi si aspetta che vengano suonate le note 
all’altezza impostata nella definizione dello strumento; una volta scelta questa impostazione, un 
rigo a l linea è trattato come la linea centrale di un rigo a 5 linee (cioè l’altezza SI4), un rigo a 2 
linee come la 2° e 4° linea (cioè le altezze SOL4 e RE5), un rigo a 3 linee come la 1°, 3° e 5° linea 
(cioè le altezze MI4, SI4 e FA5) e un rigo a 4 linee come gli spazi (FA4, LA4, DO5 e MI5). Di con-
seguenza, una nota sulla linea di un rigo a 1 linea s’inserisce suonando il SI sopra il DO centrale.

Se invece si preferisce che il suono desiderato corrisponda al tasto suonato sulla tastiera MIDI, 
impostare l’opzione Righi Percussioni nella drum map del dispositivo MIDI. Mentre lo s’inserisce 
si sente il suono corretto e Sibelius trasferisce l’altezza suonata sul rigo di batteria.
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Righi diversi per strumenti diversi
Nelle partiture orchestrali è prassi comune usare un rigo ad 1 linea per ogni strumento percussivo 
non intonato utilizzato, come indica la figura seguente:

Nella finestra di dialogo Crea > Strumenti e righi c’è un’ampia gamma di singoli strumenti per-
cussivi; per scrivere cassa, piatti e triangolo nella partitura, ad esempio:

* Nella finestra di dialogo Crea > Strumenti e righi selezionare la famiglia Percussioni/Batteria
e aggiungere gli strumenti Piatti, Triangolo e Basso.

* Cliccare Crea per inserire gli strumenti nella partitura.

Tutti questi strumenti sono riprodotti automaticamente con il giusto suono; si noti come nei righi 
ad 1 linea i gambi siano rivolti in alto.

Creare una drum map personalizzata
Per scrivere più strumenti percussivi sullo stesso rigo che utilizzino suoni, teste nota o posizioni 
nel rigo non definite negli strumenti interni di Sibelius, bisogna creare uno strumento personaliz-
zato che abbia una propria mappatura.

Per esempio, se si deve scrivere:

* Scegliere House Style > Modifica strumenti e ensemble.

* Dall’ensemble Strumenti Comuni selezionare la famiglia Percussioni e Batterie e selezionare 
Set di batteria dall’elenco Strumenti nella Famiglia; non ha molta importanza lo strumento 
che si sceglie (poiché sarà subito modificato) ma si seleziona questo perché ha il numero giusto 
di linee sul rigo e non troppe teste nota esistenti nella sua drum map.

* Cliccare Nuovo Strumento e rispondere Si quando Sibelius chiede se si vuole creare un nuovo 
strumento basato su questo.

* Cambiare Nome Riquadro in qualcosa come Cassa, Piatti, Triangolo, in modo da trovarlo 
nuovamente in seguito.

* Cambiare Nome partitura lunga in qualcosa come Cassa\n\Piattil\n\Triangolo (\n\ dice a 
Sibelius di collocare la parola successiva su una nuova linea).

* Cliccare Modifica Tipo Rigo e andare nella pagina Percussione della finestra che si apre.
* Nel nostro esempio, bisogna solo mappare le tre altezze sul rigo a determinati suoni: useremo la 

linea in alto per il triangolo, quella centrale per i piatti e la linea in basso per la cassa; selezionare 
le altre altezze che non servono e cliccare Cancella per rimuoverle.

* Per ciascuna delle altezze rimanenti selezionare la testa nota e scegliere il suono corretto dal 
menu a tendina Suono.
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* Si può anche cambiare l’opzione Notehead per un determinato strumento e perfino specificare 
un suono diverso quando a una testa nota è associata una particolare articolazione, ma non è 
strettamente necessario.

* Una volta configurati i suoni cliccare OK per confermare le modifiche apportate al tipo di rigo.
* Cliccare OK per confermare le modifiche apportate al nuovo strumento.
* Assicurarsi che i nuovi strumenti Cassa, Piatti, Triangolo siano nell’ensemble Strumenti 

comuni: spostarla dall’elenco Strumenti non in ensemble all’elenco Strumenti nella 
Famiglia cliccando Aggiungi alla Famiglia e cliccare Chiudi per chiudere la finestra di dialogo 
Modifica Strumenti.

* A questo punto, scegliere Crea > Strumenti e righi, selezionare il nuovo strumento dall’elenco e 
cliccare Aggiungi alla partitura per crearlo, quindi cliccare OK.

* Inserire la musica nel rigo usando le tre altezze definite nel tipo di rigo; si possono usare le voci, 
se si desidera – b Voci.

Rigo singolo per ogni musicista
Se la partitura richiede più di un percussionista (o il percussionista cambia strumento) è utile scri-
vere tutte le percussioni su un singolo rigo, con una scritta che indica dove deve avvenire il cambio 
strumento; in Sibelius, ciò si ottiene con i cambi strumento – b Strumenti.

Ci sono molti strumenti percussivi predefiniti configurati con i suoni adeguati; per esempio, lo 
strumento Piatti [1 linea] genera un suono di piatti; ovviamente è possibile creare nuovi stru-
menti percussivi, se necessario.

Simboli percussivi
Sibelius ha molti simboli utili che rappresentano graficamente gli strumenti, i tipi di battente e 
altre tecniche esecutive per un’ampia gamma di strumenti percussivi intonati e non intonati. Per 
inserire uno di questi simboli nella partitura selezionare Crea > Simbolo (comando rapido Z) e 
cliccare su quello desiderato scegliendo da batterie, meccaniche e altri strumenti, battenti e tec-
niche –b Simboli.

Rimuovere i bordi dai simboli di battente percussivo
Sibelius consente di rimuovere i bordi attorno ai simboli di battente percussivo:

* Selezionare House Style > Modifica simboli.

* Cliccare sul simbolo del box vuoto all’estrema destra della prima fila di battenti.
* Cliccare Modifica, inserire 0 nel campo Numero e cliccare OK.

Rullate (Z sul gambo)
Sono usate per indicare più colpi di rullata nella scrittura per batteria, ma Sibelius consente anche 
d’aggiungere un simbolo di tremolo a qualsiasi nota o accordo. Selezionare il terzo layout del tast-
ierino numerico (comando rapido F10) e premere 6. Per maggiori informazioni vedere 
b Tremolo.
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2.18 Righi

b Notazione e tablatura per chitarra, Strumenti, Percussioni, Lavorare con le 
parti, Evidenzia righi Selezionati, Modifica strumenti.

Per spostare o allineare i righi, b Spaziatura rigo.

v Layout e Stile House.

Creare i righi
Per creare un rigo di un nuovo strumento selezionare Crea > Strumenti e righi (comando rapido 
I) – b Strumenti.

Strumenti con più righi
Molti strumenti hanno più di un rigo:

* Strumenti a tastiera – mani sinistra e destra.
* Strumenti a fiato – quando ci sono molti musicisti.
* Percussioni – per esempio, la celesta o scritture complesse per marimba.
* Cantanti – talvolta quando sono divisi.
* Archi – spesso quando sono divisi.

Per aggiungere un altro rigo ad uno strumento: 

* Per aggiungere un rigo in tutta la partitura assicurarsi che non sia selezionato niente; se invece si 
vuol far apparire il nuovo rigo solo da una certa posizione nella partitura selezionare la misura 
alla quale si desidera che inizi.

* Selezionare Crea > Strumenti e righi (comando rapido I).
* Dall’elenco Righi nella partitura selezionare il rigo accanto al quale aggiungere un nuovo rigo.
* Cliccare Sopra o Sotto.

* Cliccare OK.

È possibile aggiungere altri righi allo stesso modo; un singolo strumento può avere un numero 
qualsiasi di righi (5 o 47391082), sebbene raramente ne servono più di due o tre. Se lungo la parti-
tura il numero di righi usati per uno strumento cambia, può essere necessario regolare alcune 
impostazioni di riproduzione – b Riproduzione.

Tutti i righi di uno strumento ne condividono il nome, centrato in verticale sui righi stessi.

Ossia
Un “ossia” è una piccola misura o simile di musica sopra un rigo di normali dimensioni che indica 
un modo alternativo di suonare qualcosa. In Sibelius, gli ossia sono molto facili da creare:

* Selezionare il passaggio sopra il quale creare un ossia; cliccare su una misura, ad esempio (è pos-
sibile selezionare anche solo alcune note, non per forza un numero intero di misure).

* Dal menu Crea > Altro > Rigo Ossia, scegliere Ossia Sopra o Ossia Sotto.
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* Appare automaticamente la misura(e) “ossia”, già piccola; si può quindi copiare la musica 
dall’originale (con un Alt+clic o z-clic) e correggere a piacere l’ossia.

Un ossia, in realtà, crea un piccolo rigo sopra/sotto quello selezionato, con cambi strumento prima 
e dopo l’ossia per nascondere le linee del rigo ad entrambi i lati dell’ossia stesso. Trascinare questi 
cambi strumento per regolare la larghezza dell’ossia.

Creando un ossia in questo modo, si crea sempre un rigo extra. Creando due ossia nello stesso 
sistema con il metodo descritto in precedenza, diventa difficile allinearli (perché Sibelius deve 
creare un secondo rigo extra sopra quello selezionato); bisogna invece creare il secondo ossia con 
un cambio strumento (allo strumento al quale appartiene l’ossia) per poi tornare a No strumento 
(nascosto) alla fine (b Strumenti).

Ordinare i sistemi sul lato sinistro
I sistemi sono ordinati automaticamente in modo da indicare tutti i nomi degli strumenti 
(all’inizio e in corrispondenza di nuove sezioni, ad esempio). Si può anche ordinare automatica-
mente il primo rigo di parti – b Lavorare con le parti.

Per ordinare manualmente un sistema trascinare la stanghetta iniziale (a sinistra della chiave) o 
l’estremità sinistra del rigo verso destra.

L’ordine è impostato solo per quella particolare stanghetta, quindi per mantenere lo stesso formato 
si raccomanda d’inserire un break di sistema o pagina alla fine del sistema precedente (se ce n’è 
uno); non facendolo, se la stanghetta finisce a metà di un sistema Sibelius inserisce uno spazio 
vuoto per creare un sistema diviso, come una coda – è ingegnoso, ma può essere rischioso!

Per resettare l’ordinamento di un rigo trascinato selezionare la stanghetta iniziale o l’estremità sin-
istra del rigo e scegliere Layout > Ripristina posizione (comando rapido Ctrl+Maius+P o xXP).

Ordinare i sistemi sul lato destro
Talvolta è utile interrompere un sistema vicino al margine destro (in esempi musicali, esercizi o 
fogli d’esame, ad esempio). Per farlo:

* Innanzitutto è meglio forzare un break di sistema dopo la misura che sarà alla fine del sistema 
accorciato (selezionando la stanghetta e premendo Invio sulla tastiera del computer).

* Cliccare appena a destra della stanghetta sul lato destro del sistema (bisogna cliccare a destra 
della linea centrale del rigo): appare una piccola maniglia blu.

* Trascinare la maniglia verso sinistra o usare i comandi rapidi 0/1 (premendo Ctrl o X per step 
più grandi) per aumentare l’ordinamento sul lato destro del sistema.

Per resettare un sistema alla sua larghezza di default selezionare la maniglia e scegliere Layout >
Ripristina posizione (comando rapido Ctrl+Maius+P o xXP).

Nascondere i righi
In Sibelius, ci sono due modi per nascondere i righi, ciascuno con scopi diversi:

* Per nascondere temporaneamente righi con musica (per esempio, quando si modificano parti-
ture per grandi ensemble e si deve lavorare su righi particolari senza essere distratti da tutti gli 
altri), oppure si sta preparando una versione speciale della partitura con righi nascosti che però 
sono riprodotti, usare l’opzione Vista > Evidenza su righi – b Evidenzia righi Selezionati.
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* Se invece si desidera nascondere righi privi di musica (per risparmiare spazio sulla pagina e 
facilitare la lettura della partitura) usare il comando Layout > Nascondi righi vuoti.

Intelligentemente, Sibelius mostra i righi nascosti nella partitura disegnando una linea tratteggiata 
blu nella pagina (se è attiva l’opzione Vista > Segni di layout – b Break - Interruzioni).

Salvare gli alberi – nascondere i righi vuoti
Se un rigo ha solo misure di pausa, lo si può nascondere da quel particolare sistema, come si fa in 
lunghe partiture:

* Doppio-clic del mouse sul rigo per selezionarlo tutto (o selezionare più righi come passaggio).
* Selezionare Layout > Nascondi righi vuoti(comando rapido Ctrl+Maius+Alt+H o xzXH).

Si può farlo anche su più righi (o un passaggio costituito dal numero di misure desiderate) o per-
fino sull’intera partitura. I righi sono nascosti solo sui sistemi privi di musica, oppure dove tutta la 
musica è nascosta (nei passaggi guida, ad esempio).

Per nascondere i righi vuoti in tutta la partitura selezionare Modifica > Seleziona > Seleziona 
tutto (comando rapido Ctrl+A o XA) e scegliere Layout > Nascondi righi vuoti – tutti i righi 
inutilizzati nella partitura scompaiono e l’intera partitura si riformatta immediatamente con il 
numero minore di pagine possibile (salvando quindi alberi preziosi).

Con il comando Layout > Nascondi righi vuoti, includendo anche i righi per tastiera si potrebbe 
finire con l’avere una sola mano nascosta (piuttosto insolito da vedere!). Verificare quindi la parte 
di tastiera ed eventualmente mostrare di nuovo il rigo nascosto, oppure (se, ad esempio, si stanno 
nascondendo i righi in tutta la partitura e non si vuole perdere tempo a verificare i righi di tastiera 
in seguito), quando si nascondono i righi escludere quelli di tastiera.

Naturalmente, non è possibile nascondere l’unico rigo in un sistema (perché ci deve essere almeno 
un rigo che indichi la presenza di un sistema). Per cancellare tutte le misure da un singolo rigo, si 
devono invece selezionare le misure come un passaggio di sistema e premere Canc.

Mostrare i righi nascosti
Per mostrare di nuovo i righi nascosti con il comando Layout > Nascondi righi vuoti:

* Cliccare su un misura dove si vogliono mostrare i righi.
* Selezionare Layout > Mostra righi vuoti(comando rapido Ctrl+Maius+Alt+S o xzXS).
* Nella finestra di dialogo che si apre cliccare OK per mostrare tutti i righi nascosti, oppure selezi-

onare i righi particolari da mostrare.

Questa operazione mostra i righi nascosti con il comando Layout > Nascondi righi vuoti (perché 
non contengono musica) ma non visualizza:

* I righi nascosti con un cambio strumento No strumento (nascosto) – farli riapparire usando 
un altro cambio strumento, per avere di nuovo lo strumento originale.

* Righi nascosti con l’opzione Focus on Staves – per farli riapparire disattivare l’opzione Vista >
Evidenza su righi.
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Cancellare permanentemente i righi
Per liberarsi definitivamente di un rigo (e di tutta la musica in esso contenuta) scegliere Crea >
Strumenti e righi (comando rapido I), selezionare il rigo (o righi) da cancellare dall’elenco Righi 
nella partitura, cliccare Cancella dalla partitura e cliccare OK; altrimenti, triplo-clic del mouse 
su un rigo (per selezionarlo in tutta la partitura) e premere Canc.

Dimensione del rigo
La dimensione del rigo determina quella di qualsiasi cosa nella partitura. Raddoppiando la dimen-
sione del rigo, raddoppia anche quella di tutti i testi, linee, ecc.. Se la partitura è troppo confusa o 
dispersiva modificare la dimensione del rigo; b Impostazioni documento.

Righi piccoli
Per rimpicciolire un rigo rispetto agli altri scegliere Crea > Strumenti e righi, selezionare il rigo in 
questione nell’elenco Righi nella partitura, attivare il box di spunta Rigo piccolo e cliccare OK.

Di default, i righi piccoli sono il 75% della dimensione normale; questo valore si regola nella pag-
ina Righi della finestra House Style > Regole tipografia (comando rapido Ctrl+Maius+E o
xXE).

Righi con spazi vuoti
Penderecki, Stockhausen ed altri compositori contemporanei preferiscono non avere le linee del 
rigo nelle misure dove uno strumento non suona. Ciò genera partiture con l’aspetto di un libro 
incompleto (“cut-away”), con passaggi musicali scarabocchiati qua e là sulla pagina (anche 
domande e risposte nella musica corale spesso sono scritte così).

In Sibelius ciò si ottiene facilmente con i cambi strumento:

* Innanzitutto, se non è già attiva, è meglio attivare l’opzione Vista > Oggetti nascosti (comando 
rapido Maius+Alt+H o xzH); i cambi strumento appaiono così come rettangoli grigi (se 
questa opzione non è attiva non appare niente!).

* Selezionare il passaggio musicale dal quale devono sparire le linee del rigo: per farle sparire 
all’inizio di una misura, ad esempio, selezionare quella misura; per farle scomparire dopo una 
nota particolare, selezionare quella nota. Estendere la selezione alla posizione in cui far riappar-
ire le linee del rigo con uno Maius-1 (premendo Ctrl o X per estenderla di misure intere).

* Selezionare Crea > Altro > Cambio strumento. Nella finestra di dialogo che si apre impostare 
Scegli da in Tutti gli strumenti, Famiglia in Altri e selezionare No strumento (nascosto)
dall’elenco degli strumenti.

* Cliccare OK: Sibelius crea due cambi strumento: all’inizio della selezione un cambio strumento a 
No strumento (nascosto), per nascondere le linee del rigo; alla fine della selezione crea un 
altro cambio strumento per tornare allo strumento originale.

* Nel caso Sibelius non collochi un cambio strumento nel punto esatto desiderato, selezionare il 
rettangolo grigio di cambio strumento e spostarlo a sinistra o destra con i tasti 0/1 (premendo 
Ctrl o X per step più grandi), oppure trascinarlo con il mouse.

Confrontare due righi
Per confrontare due righi nello stesso file e verificare le differenze usare il plug-in Plug-in >
Analisi > Confronta righi – b Plug-in.
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2.19 Ritmo libero

La musica a ritmo libero non ha tempo in chiave (nel recitativo, in certa musica d’avanguardia o 
canto libero) oppure è ignorato qualcosa (in una cadenza). Talvolta più strumenti suonano ritmi 
liberi a velocità diverse, quindi le note non sono allineate (come nella musica aleatoria).

Ritmo libero normale
Per il ritmo libero di un solo strumento o più in cui allineare i ritmi, creare misure irregolari dalle 
durate adeguate (selezionare Crea > Battuta > Altro, comando rapido Alt+B o zB) nelle quali col-
locare la musica.

In base al tipo di musica, si può inserirla in una misura lunga o in una serie di misure più corte con 
stanghette invisibili. Il secondo metodo ha il vantaggio che la musica può essere divisa a qualsiasi 
stanghetta invisibile (cosa necessaria, ad esempio, per una cadenza lunga che altrimenti non rius-
cirebbe a stare in un sistema). Lo svantaggio è che le misure extra falsano la numerazione delle 
misure, sebbene ciò si possa correggere inserendo un cambio misura appropriato alla fine 
(b Numeri misura).

Ritmi liberi indipendenti
Tavolta gli strumenti suonano ritmi completamente indipendenti nello stesso momento, in questo 
modo:

Scriverli come descritto in precedenza, ma scegliere uno dei righi come ritmo “fondamentale” e 
inserire prima la musica in quel rigo. Aggiungere poi gli altri ritmi, cambiandone però la velocità 
apparente, usando duine con un rapporto adeguato – cioè scegliere Niente e disattivare l’opzione 
Parentesi quadra nella finestra Crea > Gruppo irregolare (o modificarla retroattivamente dal 
pannello Note della finestra Proprietà). Per esempio, nella figura sopra, le prime tre note sul rigo 
inferiore sono in una terzina nascosta, in modo da collimare con le prime due del rigo superiore.

Sibelius, inoltre, riproduce i ritmi correttamente, come se leggesse la notazione spaziale.

Musica con più tempi in chiave simultanea
...o stanghette in punti diversi su righi diversi: b Tempi in chiave.

Canto libero
Per scrivere un canto libero, usare misure irregolari (selezionare Crea > Misura > Altro, comando 
rapido Alt+B o zB) di durate appropriate e note senza gambo – b Choir nella sezione Come 
fare della Guida.

Recitativo
Usare misure irregolari (selezionare Crea > Misura > Altro, comando rapido Alt+B o zB) di durate 
appropriate. Per un aiuto sull’inserimento di parole nel recitativo vedere b Parole.

reference.book  Page 119  Wednesday, April 16, 2008  4:28 PM



2. Notazioni

120

Cadenze
In Sibelius vi è un paio di metodi per creare le cadenze. È utile calcolare la durata della cadenza (in 
termini di valori nota) prima d’iniziare a inserirla:

* Creare una misura irregolare (o una serie di esse) con il comando Crea > Misura > Altro
(comando rapido Alt+B o zB). Si ricordi che ogni misura creata non può durare più di un 
sistema, quindi potrebbe essere necessario creare misure multiple con stanghette invisibili tra 
esse. La durata della misura si può specificare con la complessità desiderata e poi si può inserire 
la musica come al solito. Evitare, se possibile, di cancellare (nascondere) le pause indesiderate, 
poiché esse hanno effetto sulla spaziatura delle note anche se sono nascoste. 

* Per avere contemporaneamente misure di musica regolari (misurate) e ritmo libero, vedere 
Ritmi liberi indipendenti.
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2.20 Simboli

b Font musicali, Modifica simboli.

v Aggiungere i segni.

 
Tutti i simboli musicali standard di Sibelius sono disponibili non solo nel tastierino numerico nei 
menu, ma anche nella grande finestra di dialogo Crea > Simbolo, la quale ha anche molti simboli 
extra. 
I simboli (come testi e linee) si possono assegnare a un singolo rigo o al sistema.

La differenza tra i simboli e altri oggetti è che i primi possono essere collocati ovunque si desideri. 
Ciò consente d’ignorare tutte le regole di posizionamento di Sibelius e inserire un simbolo (un die-
sis, ad esempio) esattamente dove si vuole, anche nei punti più impensati.

Lo svantaggio è che i simboli non sono “intelligenti” come altri oggetti. Per esempio, inserendo un 
diesis accanto a una nota esso non si sposta in verticale se la nota è trascinata in alto o in basso, né 
la nota suona diesis e nemmeno diventa naturale (o altro) se la musica è trasportata. La morale è: 
non usare un simbolo dove un normale oggetto può andare ugualmente bene.

I simboli tuttavia sono “intelligenti” in altri sensi – s’attaccano a righi e posizioni ritmiche, così da 
stare al posto giusto nelle parti (b Attaccature).

Creare un simbolo
* Selezionare la nota accanto alla quale aggiungere un simbolo e scegliere Crea > Simbolo

(comando rapido Z per “zimbolo”).
* Selezionare un simbolo dalla finestra di dialogo e, se necessario, regolarne la dimensione con le 

quattro opzioni “size”. I simboli si ritirano automaticamente se assegnati a un rigo piccolo (in 
genere, quindi, per inserire un simbolo su un rigo piccolo si lascia l’opzione Normale).

* Scegliere se assegnare il simbolo a Rigo o Sistema. Un simbolo di sistema serve solo se si vuole 
vederlo in tutte le parti, per esempio una fermata (pausa) su una stanghetta, una coda o un sim-
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bolo Segno, oppure quando si usano simboli che controllano il comportamento di strutture rip-
etute (Segno e Coda, ad esempio).

* Cliccare su OK: il simbolo si crea nella partitura accanto alla nota selezionata (un doppio-clic sul 
simbolo nella finestra di dialogo equivale a cliccare su OK).

Altrimenti, i simboli si possono inserire con il mouse. Per farlo:

* Assicurarsi che non ci sia niente selezionato (premere Esc) e scegliere Crea > Simbolo.

* Selezionare un simbolo e cliccare su OK.
* Il puntatore del mouse cambia colore: cliccare nella partitura per posizionare il simbolo.

I simboli si possono copiare e cancellare come gli altri oggetti.

Spostare i simboli
Spesso è utile spostare leggermente i simboli con i tasti freccia; tenendo premuto Ctrl o X si 
spostano in step più grandi (esattamente di uno spazio). Il comando Layout > Ripristina posiz-
ione (comando rapido Ctrl+Maius+P o xXP) riporta un simbolo alla propria posizione di 
default. 

Modificare i simboli
Per i dettagli su modifica di simboli e creazione di nuovi simboli, b Modifica simboli.

Riproduzione dei simboli
Sebbene la maggior parte dei simboli non siano riprodotti, è riprodotto un handful (come scoop e 
fall) se il dispositivo di riproduzione lo supporta; per impostare la riproduzione di altri simboli 
usare la finestra di dialogo Play > Dizionario – b Dizionario di riproduzione.

Simboli scrivibili
La finestra di dialogo Crea > Simbolo è organizzata in categorie. Alcuni dei simboli più insoliti 
sono i seguenti:

Categoria Simboli Significato

Ripetizioni Ripete gli ultimi gruppi d’ottavi (crome); in genere sono nella musica manoscritta; ripete 
l’ultima misura; ripete le ultime due misure. Ci sono anche vari simboli di stanghetta, utili 
per partiture nelle quali alcuni righi hanno stanghette indipendenti. Sono presenti due tipi di 
simboli Coda e Segno; una coppia ha l’aspetto usato comunemente in Giappone.

Generici Parentesi (tonde) da collocare attorno ai simboli (es. alterazioni, 8va, trilli); parentesi per 
tastiera; finali di ripetizione in parentesi/alettati.

Ornamenti Include mordenti, cambi, e così via, che però non sono riprodotti automaticamente; per 
creare trilli riprodotti, b 2.11 Linee; per riprodurre mordenti e cambi, b 5.11 Plug-in; 
altri simboli d’ornamento sono nelle file More ornaments più in basso nella finestra di dial-
ogo (vedere in seguito).

Tastiera Simboli Pedale da usare per modificare l’aspetto delle linee per i pedali (b 2.11 Linee); 
simboli tallone e alluce per i pedali d’organo (piedi sinistro e destro).

Percussioni Queste file comprendono la maggior parte dei simboli forniti dal noto font Ghent™. La prima 
fila ha simboli per vari strumenti percussivi.

…battenti Comprende bacchette per vari strumenti (nella figura a sinistra sono indicati i battenti mor-
bidi, medi e duri).
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Chitarra Comprende diagrammi per vari numeri di corde; leva vibrato scoop; leva vibrato dip.

Articolazioni Le prime due file sono ordinate in base alla vicinanza alla testa nota (il punto di staccato, ad 
esempio, è più vicino alla testa nota di un simbolo d’archetto giù); i simboli sulla prima fila 
vanno sopra la nota, quelli sulla seconda fila vanno sotto. La terza fila ha altre articolazioni:

Staccati multipli da usare su note ripetute scritte come tremolo di una nota; pizzicato per 
strumenti a corda, usato principalmente da Bartók (e talvolta scritto capovolto).

Virgola e segno di spunta; indica un respiro (in genere nella musica corale); la virgola indica 
anche un breve silenzio per strumenti come il piano, che non può “respirare”; cesure in due 
spessori diversi.

Segni di accento e atonia (sopra e sotto) usati da Schoenberg; staccato “a tacca”, usato talvolta 
nella musica antica.

Alterazioni I primi nove simboli in entrambe le file (in parentesi e non) sono ordinati dal più calante al 
più crescente, compresi i microtoni; si ricorda che questi simboli non sono né trasportati né 
riprodotti automaticamente; se possibile, quindi, usare una normale alterazione.

Simboli alternativi per i microtoni sono disponibili nella fila More accidentals più in basso 
nella finestra di dialogo.

Note Sibelius non usa questi simboli per scrivere note normali; sono stati previste nel caso si 
vogliano scrivere note in posti insoliti; Sibelius scrive le note usando una testa nota (dalla fila 
Noteheads), con code (dalla fila Notes) per le note corte.

Ai fanatici delle code farà piacere osservare da vicino come sono state realizzate le code per le 
note da 1/16 (semicrome) e più brevi; infatti, la coda più vicina alla testa nota ha una cur-
vatura un pò più accentuata. I non fanatici non sapranno nemmeno di cosa si sta parlando!

Slash d’ornamento per il gambo dell’acciaccatura; simbolo di legatura laissez vibrer (in certi 
casi, preferibile da usare al posto della legatura vera e propria); si può usare anche per lega-
ture che entrano sul 2° finale (misure 2° volta) e Code; tratto di tremolo; punto ritmico.

Simbolo Cluster; ordinandone molti uno sopra l’altro in verticale si può realizzare un accordo 
cluster di qualsiasi dimensione.

Teste nota Per cambiare le teste nota non usare i simboli – b 2.26 Teste nota. Ci sono anche simboli 
“stelo” per unisoni alterati – b 2.2 Alterazioni. Teste nota poco comuni per la musica 
d’avanguardia e classica moderna sono nella fila Round noteheads più in basso nella 
finestra di dialogo.

Pause Tutte le pause standard, incluse quelle multiple vecchio stile; ci sono anche elementi costitu-
tivi delle misure-H – b 2.16 Pause multiple

Categoria Simboli Significato

1 ½  semitoni bemolle

1 ¼  semitoni bemolle, o occasionalmente 1 ½  semitoni bemolle

½     semitono bemolle

¼     semitono bemolle o  ½ semitono bemolle

¼     semitono diesis o  ½ semitono bemolle

½     semitono diesis

1 ¼  semitoni diesis, o occasionalmente 1 ½  semitoni diesis

1 ½  semitoni diesis
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Conduzione Hauptstimme: posto sopra la melodia di uno strumento indica che si tratta di quello più 
importante in quel passaggio; nebenstimme: denota il secondo strumento predominante; il 
frammento ad angolo più a destra indica dove termina un passaggio. Usati soprattutto da 
Schoenberg, Berg e Webern.

Inserirli all’estremità destra di un rigo (nella musica corale, ad esempio) per indicare che si 
divide sul sistema successivo; possono sconfinare nel margine destro della pagina. È possibile 
usare le frecce anche individualmente, puntandole al contrario per indicare che due righi 
stanno per riunirsi nuovamente.

Battito, battito mano sinistra, battito mano destra, battito singolo. Il simbolo più a sinistra è 
l’unico standard; gli altri si usano raramente (es. Lutoslawski) ma i significati variano. I segni 
di battito appaiono in tutta la partitura per dire al direttore come battere il tempo in casi par-
ticolari; a volte appaiono anche in parti così l’esecutore sà quando deve aspettare un battito.

Battito doppio e triplo (per un singolo battito usare una delle frecce sopra o una semplice 
linea verticale); appaiono sopra sequenze musicali per indicare al direttore come raggrup-
parle; sono disegni schematici di forma stabilita dalla bacchetta del direttore (usati nel Le 
Marteau sans maître di Boulez). Il set inferiore è per battiti composti; altri simboli di conduz-
ione sono nella fila More conductor più in basso nella finestra di dialogo.

Chiavi Contiene tutte le chiavi standard – b 2.4 Chiavi. 8 e 15 sono simboli distinti (a destra della 
seconda fila) che si possono alterare per cambiare in una volta tutte le opportune chiavi. 
Chiavi meno comuni (di violino e basso capovolte e girate, ad esempio) si trovano nella fila 
Altre chiavi più in basso nella finestra di dialogo.

Ottave Usati per le linee in 8va ecc.. – b 2.11 Linee

Segni layout Usati da Sibelius per mostrare break di pagina/sistema, ecc. – si usano raramente.

Tecniche Questa fila ha una miriade di simboli strani e inusuali:

Elevazioni (doit) e cadute per la notazione jazz; muto, per gli strumenti a corda.

Diteggiatura per gli strumenti a fiato: buco aperto, mezzo chiuso e chiuso.

Attaccati al gambo di una nota o accordo. Significano: sussurrato o sprechstimme; frusciato (o 
un’azione simile su strumenti percussivi); sul ponticello (suonato al ponte); “ronzio” d’arpa 
(quando il pedale cambia mentre la rispettiva corda vibra ancora) usato anche da Penderecki 
scrivere un tremolo d’archi non misurabile suonato il più velocemente possibile. Un segno “z” 
del gambo per le rullate leggermente diverso è sul terzo layout del tastierino numerico.

Curve “Esponenziali” di crescendo adatte a forcine lunghe e corte di crescendo.

Fisarmonica 25 diagrammi di alti e 21 di bassi accoppiati per la musica di fisarmonica, oltre a diagrammi 
vuoti e blob da sovrapporre per avere altre combinazioni.

Campane Qui ci sono tutti i simboli usati comunemente per le campane a mano.

Altri 
ornamenti

In queste quattro file ci sono più di 50 simboli aggiuntivi d’ornamento, inclusi pincé, shake, 
port de voix, cadenza, cadenza coupée, ecc..

Cluster Simboli cluster di nota bianca e nera per intervalli compresi tra una seconda e un’ottava.

Gambi speciali Serie di simboli gambo alternativi da usare con note senza gambo per indicare diverse tec-
niche d’esecuzione.

Prolatio Simboli di tempus perfectus, tempus imperfectus, prolatio perfectus (prolatio maggiore), prola-
tio imperfectus (prolatio minore), ecc.; usati nelle edizioni di musica medievale.

Miscellanea Simboli linee aggiuntive di varie larghezze (normale, nota intera, acciaccatura); allinearle al 
meglio con le normali linee del rigo.

Nomi nota Teste nota speciali con il nome della nota al loro interno. Per usarle, b 5.11 Plug-in.

Categoria Simboli Significato
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2.21 Stanghette

Sibelius ha un’ampia gamma di stanghette adatte a vari tipi di musica; esse si possono collocare 
alla fine o a metà di una misura:

Stanghette alla fine delle misure
Nella partitura non è necessario inserire stanghette alla fine delle misure; basta aggiungere le mis-
ure e le stanghette appaiono dopo ogni misura.

Le stanghette si possono spostare trascinandole a sinistra e destra con il mouse o i tasti 0/1 (pre-
mendo Ctrl o X per incrementi più grandi). Ciò modifica lo spazio vuoto dopo l’ultima nota/
pausa.

Non si può cancellare una stanghetta per unire due misure: si deve invece raddoppiare la durata del 
tempo in chiave (o creare una misura irregolare) per far stare la musica in una misura. Analoga-
mente, per dividere una misura in due, ridurre il tempo in chiave invece di inserire una nuova 
stanghetta.

Altre stanghette
Sono le stanghette doppie, tratteggiate, di ripetizione, classiche, ecc... 
Per crearne una, selezionare la nota oltre la quale si vuole inserire la 
stanghetta e scegliere il tipo di stanghetta dal menu Crea > Stang-
hetta, oppure inserire la stanghetta con il mouse premendo Esc per 
deselezionare tutto prima di creare la stanghetta desiderata.

Quando s’inserisce una stanghetta in mezzo alla misura, inserire 
anzitutto la musica nella prima misura, poi aggiungere la stanghetta 
tra due note o pause specifiche. (Se prima s’inserisce la stanghetta, 
non sarebbe chiaro dove essa debba essere collocata nella misura). La 

stanghetta potrebbe anche attaccarsi alla misura troppo vicina alla nota successiva; se ciò avviene, 
selezionare la stanghetta e modificare il parametro X nel pannello Generale della finestra Propri-
età per cambiarne l’offset.

Se una stanghetta si trova a metà di una misura di pausa, per una notazione più chiara è meglio 
dividere la misura di pausa in pause distinte a entrambi i lati della stanghetta.

Di solito, si separa una misura tra i sistemi a stanghetta doppia o stanghette di ripetizione (es. alla 
fine della linea di un inno); per farlo in Sibelius, creare due misure più corte (irregolari) e usare un 
break di sistema per separarle tra i due sistemi – b Misure e misure di pausa e Break - 
Interruzioni.













          
 

Normale


Doppia


Inizio 
ripetizione
(alettata)


Fine 
ripetizione
(alettata)


Tratteggiata


   Invisibile


Tra i
righi


Spessa


Corta


Finale

Stanghette doppie 
Le stanghette doppie si usano per 
indicare nuove sezioni. 

In generale, una stanghetta dop-
pia appare ad un cambio di 
tonalità (ma non a un cambio 
del tempo in chiave), oppure in 
corrispondenza dei segni di 
prova (a meno sia all’inizio di 
una nuova sezione).
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Si può copiare, trascinare e cancellare le stanghette; cancellando una di queste altre stanghette alla 
fine di una misura (anche una stanghetta invisibile) essa diventa una stanghetta normale.

Doppia stanghetta finale
Quando s’inizia una nuova partitura, appare una doppia stanghetta finale alla fine; se non la si 
desidera è possibile cancellarla.

In una partitura si può benissimo inserire più di una doppia stanghetta finale (se la partitura, ad 
esempio, è costituita da più di un movimento, brano o pezzo).

Stanghette di ripetizione
Le stanghette d’inizio e fine ripetizione si creano come le altre stanghette speciali. Per creare il 1° e 
2° finale (misure della prima e seconda volta) vedere b Linee.

Per creare stanghette di ripetizione con le alette (diffuse nel jazz e sui manoscritti) attivare l’opzi-
one Alette su stanghette di ripetizione (pagina Stanghette della finestra House Style >
Regole tipografia).

Per creare una stanghetta di ripetizione doppia (che si colloca tra due sezioni ripetute)

inserire una stanghetta Fine ripetizione alla fine della prima misura e una Inizio ripetizione 
all’inizio della seconda; le stanghette di ripetizione si possono trascinare allontanandole o avvici-
nandole.

Stanghette introduttive
Sibelius ha stanghette ideali per le edizioni di musica classica. Nella musica vocale antica c’è una 
convenzione per i tempi in chiave (un metodo usato dagli editori per aiutare gli esecutori moderni 
a capire le divisioni metriche della musica) che aggiunge le stanghette tra i righi (un metodo tal-
volta denominato mensurstriche).

Per usarle nella partitura, impostare Tipo stanghetta di default in Tra i righi nella pagina 
Stanghette della finestra House Style > Regole tipografia (comando rapido Ctrl+Maius+E o
xXE).

Alcuni editori adottano la convenzione per cui la musica deve comportarsi come se le stanghette ci 
fossero, con le note legate sopra le stanghette (figura a sinistra); altri privilegiano la convenzione 
opposta, con la musica scritta come se non ci fossero per niente le stanghette (figura a destra):

Sibelius lega automaticamente le note tra le stanghette, quindi la musica (di default) appare come 
l’esempio precedente a sinistra. Se si preferisce l’altra convenzione, usare misure irregolari ove 

          









    
legatura sulla stanghetta

           Nota da 1/4 puntata

     

 
1 misura

      
1 misura

        
1 misura
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opportuno per creare una singola misura che dura il doppio (b Misure e misure di pausa), 
quindi inserire manualmente la stanghetta alla giusta posizione.

È possibile anche creare stanghette Tick e Short, utili per la notazione di canzoni regolari:

Queste stanghette sono più utili in passaggi musicali di un singolo strumento (o voce), ma volendo 
si può usarle anche nella musica per più strumenti.

Unioni delle stanghette
Sibelius unisce automaticamente i righi in gruppi di strumenti 
simili con le stanghette (vedere il box a fianco). Tuttavia, ci sono 
anche altre possibilità:

*È preferibile trovare un punto nella partitura in cui non ci sono 
righi nascosti, in modo da verficare subito tutte le unioni.
* Cliccare con cautela in cima o alla base di una normale stang-
hetta nella partitura (non si possono usare stanghette speciali 
per cambiare le unioni di una stanghetta); appare una “maniglia” 
quadrata color porpora.
* Trascinarla in alto o in basso nel sistema per allungare o accor-
ciare la stanghetta. Ciò influenza simultaneamente ogni sistema 
della partitura.
*Allungando o accorciando le stanghette in basso nel sistema è 
possibile riorganizzare a piacere il modo in cui i righi sono uniti 
dalle stanghette.

Stanghette invisibili
È possibile nascondere una stanghetta alla fine di una misura 
sostituendola con una stanghetta “invisibile” scelta dal menu 

Crea > Stanghetta. Se è attiva l’opzione Vista > Oggetti Nascosti (comando rapido Ctrl+Alt+H
o zXH), la stanghetta invisibile appare in grigio chiaro, ma scompare disattivando questa opzi-
one.

L’impiego principale di una stanghetta invisibile è segnare una divisione tra due sistemi (vedere 
Misure separate). Poiché le misure a entrambi i lati sono comunque separate, ci sono tre inevi-
tabili conseguenze: alcuni ritmi non possono attraversare la stanghetta invisibile (si devono usare 
note legate); la numerazione delle misure sembra fuori di una misura (ma si può correggere cam-
biando il numero misura – b Numeri misura); inoltre, le misure di pausa appaiono come due 
misure di pausa, una ad ogni lato. Usare quindi con cautela le stanghette invisibili.

Per nascondere tutte le stanghette della partitura, cambiare l’opzione Tipo stanghetta di Default
in Invisibile nella pagina Stanghette della finestra di dialogo House Style > Regole tipografia 
(comando rapido Ctrl+Maius+E o xXE).

Unioni delle stanghette
Normalmente, i righi sono uniti da 
stanghette, per unire tra loro gruppi 
di strumenti simili. Spesso (ma non 
sempre) questi gruppi riflettono il 
modo in cui i righi sono ragguppati 
in parentesi quadre (b 2.15 Paren-
tesi quadre e graffe).

Nelle partiture orchestrali, i righi di 
legni, ottoni, percussioni e sezioni 
d’archi in generale sono uniti da 
stanghette ma restano separati da 
sezioni adiacenti.

I righi vocali non sono mai uniti tra 
loro e nemmeno ad altri strumenti. I 
righi per lo stesso strumento a tasti-
era sono uniti ma restano separati 
dagli strumenti adiacenti.

Quando una partitura ha pochi 
strumenti (un quintetto di fiati, ad 
esempio) è usata una stanghetta 
continua.
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Per nascondere tutte le stanghette di un rigo (ad esempio) o tutti i righi di una famiglia strumen-
tale, vedere Nascondere solo le stanghette di alcuni righi.

Nascondere solo le stanghette di alcuni righi
Per nascondere tutte le stanghette di una famiglia strumentale (dove tutti i righi sono uniti da una 
stanghetta continua) cliccare in cima o alla base della stanghetta in modo che appaia la “maniglia” 
e premere Canc. Per inserire di nuovo le stanghette cliccare in cima o alla base della stanghetta su 
un rigo adiacente e trascinarlo attraverso i righi senza stanghette.

Per nascondere tutte le stanghette di un rigo particolare, definire un nuovo strumento senza stang-
hette (b Modifica strumenti):

* Selezionare una misura nel rigo in cui si desidera nascondere le stanghette.
* Selezionare House Style > Modifica Strumenti e Ensemble.

* Nella finestra di dialogo si vedrà lo strumento in questione selezionato; cliccare su Nuovo stru-
mento e su Sì quando Sibelius chiede se si è sicuri di voler continuare.

* Nella finestra di dialogo Nuovo Strumento che appare, cambiare la scritta Nome riquadro in 
un nome facile da ricordare e cliccare su Modifica Tipo Rigo.

* Nell pagina Generale disattivare l’opzione Stanghette e cliccare su OK.

* Cliccare su OK nella finestra di dialogo Nuovo Strumento e assicurarsi che il nuovo strumento 
sia nell’ensemble adeguata (in modo da poterlo trovare rapidamente).

* Se non si vogliono avere le stanghette in un rigo particolare nell’intera partitura, assicurarsi che 
non sia selezionato nulla, quindi selezionare Crea > Altro > Cambio Strumento, scegliere il 
nuovo strumento, cliccare su OK e cliccare all’inizio del rigo sulla prima pagina a sinistra della 
stanghetta iniziale.

* Se non si vogliono vedere le stanghette in un passaggio particolare, selezionare la misura alla 
quale si desidera inserire la variazione, selezionare Crea > Altro > Cambio strumento, scegliere 
il nuovo strumento e cliccare su OK.

Stanghette iniziali su sistemi a rigo singolo
In un lead sheet, è abitudine che le stanghette iniziali siano scritte all’inizio di ogni sistema, anche 
se, normalmente, le stanghette iniziali appaiono solo quando ci sono due o più righi nel sistema. 
Per fare in modo che una stanghetta iniziale appaia in sistemi ad un solo rigo, attivare l’opzione 
Stanghetta all’inizio dei singoli righi nella pagina Stanghette della finestra di dialogo House 
Style > Regole tipografia.

Misure separate
Talvolta è utile separare una misura in due metà, la prima alla fine di un sistema e la seconda 
all’inizio del sistema successivo. Per farlo usare il plug-in Plug-in > Altro > Dividi misura – 
b Plug-in.

Poiché le misure separate sono comunque due misure separate da una stanghetta invisibile, esse 
hanno gli stessi tre svantaggi delle stanghette invisibili (vedere in precedenza).
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Opzioni Regole tipografia
Le opzioni nella pagina Stanghette della finestra di dialogo House Style > Regole tipografia
(comando rapido Ctrl+Maius+E o xXE) consentono di cambiare l’aspetto della stanghetta di 
default nella partitura; ciò è utile in partiture nelle quali la maggior parte delle stanghette (o tutte) 
debbano essere invisibili, tratteggiate, tra i righi, ecc..

Si può anche scegliere di usare o meno le stanghette di ripetizione con le alette, regolare lo spessore 
delle stanghette e la separazione di quelle doppie (nel caso sia indispensabile farlo).
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2.22 Strumenti

b Righi, Nomi strumento, Modifica strumenti.

v Layout e House Style.

Strumenti o righi?
Nell’interpretazione tecnica del termine, in Sibelius uno “strumento” è costituito da uno o più righi 
con un singolo nome a sinistra. Un piano con due righi è uno strumento perché il suo nome appare 
solo una volta, tra i righi. Il Violino 1 è uno strumento, sebbene di solito ci siano molti violini; 
anche se la musica per il Violino 1 è distribuita su due righi, il nome Violino 1 appare solo una 
volta tra essi; Sibelius, quindi, vede solo uno strumento. I cantanti stessi sono considerati stru-
menti. Se c’è un singolo rigo di percussioni, esso è considerato come un solo strumento, sebbene 
possa essere usato nello stesso momento per rullante, piatti, tom, ecc..

Creare gli strumenti
Si può creare uno strumento che non esiste già nella partitura in qualsiasi momento selezionando 
Crea > Strumenti e righi (comando rapido I).

Questa è la stessa finestra di dialogo che si apre cliccando Cambia strumenti nella finestra File >
Nuovo quando si crea una nuova partitura.

La finestra di dialogo è divisa in due metà: quella a sinistra serve per scegliere nuovi strumenti da 
aggiungere alla partitura, mentre la metà a destra mostra i righi già presenti nella partitura e con-
sente di cancellarli, riordinarli ed aggiungere righi extra agli strumenti esistenti.

Per aggiungere un nuovo strumento:

* Impostare l’opzione Scegli da il più vicino possibile al tipo di ensemble per la quale si sta scriv-
endo la musica: ensemble diverse, infatti, sono costituite anche da strumenti diversi (spesso in 
ordine leggermente diverso):
% Tutti gli strumenti: elenca tutti i circa 400 strumenti conosciuti da Sibelius.
% Strumenti Comuni: omette quelli meno comuni come i flageolet e le viole da gamba.
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% Strumenti Bandistici: comprende tutti gli strumenti presenti nelle bande paesane, militari, 
di ottoni o fiati.

% Strumenti Jazz: elenca tutti gli strumenti presenti in genere nelle band e big band di jazz.
% Strumenti Orchestrali: ha tutti i legni, ottoni, percussioni e archi che si trovano normal-

mente in un’orchestra.
% Strumenti Rock e pop: ha chitarre, tastiere, voci, e così via.

* Scegliere la famiglia strumentale dall’elenco Famiglia (per esempio, legni, ottoni, archi, ecc.).
* Dall’elenco Strumento selezionare lo strumento da aggiungere; cliccare Aggiungi per inserirlo 

nell’elenco Righi nella partitura, dove apparirà con un segno + prima del nome (ad indicare 
che è nuovo); è elencato alla posizione nella quale apparirà nella partitura quando si clicca OK. 
Si possono aggiungere rapidamente più strumenti adiacenti trascinando in basso con il mouse 
l’elenco Strumenti prima di cliccare Agg.

* Se si cambia idea, selezionare un rigo nell’elenco Righi nella partitura e cliccare Cancella dalla 
partitura per rimuoverlo.

* Si può anche selezionare un rigo e usare i pulsanti Su e Giù per spostarlo in verticale. Tutti i 
righi di un singolo strumento (per esempio, i due righi di un piano o un arpa, oppure tutti i righi 
del Violino I) si muovono sempre insieme.

* Per rimpicciolire uno o più righi (di uno strumento solista, ad esempio), selezionarli nell’elenco 
Righi nella partitura e attivare il box di spunta Rigo piccolo.

* Cliccando OK, Sibelius esegue tutte le variazioni necessarie, aggiungendo, rimuovendo, e/o rior-
dinando i righi nella partitura.

Questa finestra si può usare anche per aggiungere righi extra a strumenti esistenti nella partitura – 
vedere Strumenti con più righi in b Righi. Aggiungendo un nuovo strumento alla partitura, 
Sibelius crea automaticamente anche una parte dinamica per esso – b Lavorare con le parti.

Cancellare gli strumenti
Per cancellare gli strumenti scegliere Crea > Strumenti e 
righi, selezionare il rigo (o i righi) da cancellare 
dall’elenco Righi nella partitura e cliccare Cancella 
dalla partitura; altrimenti, selezionarli come passaggio 
con un triplo-clic nella partitura e premere Canc.

In ogni caso, un messaggio avvisa che tale operazione 
cancella anche tutta la musica in essi; per continuare clic-
care Si e OK per chiudere la finestra di dialogo.

Separatori di sistema
I separatori di sistema sono doppie linee grosse scritte tra 
i sistemi (in genere a sinistra) per rendere più chiaro il 
formato. I separatori destri di sistema (scritti al margine 
destro) servono raramente, ma grazie alla completezza di 
Sibelius, sono comunque disponibili.

Ordine standard degli strumenti
Vari stili di musica hanno ordini verticali 
diversi nei quali appaiono gli strumenti. Nella 
musica orchestrale i legni sono sempre in alto, 
seguiti da ottoni, percussioni, canto, stru-
menti a tasti e archi; anche in ogni sezione 
l’ordine è standard (come indica la finestra di 
dialgo Strumenti di Sibelius).

Ci sono però alcune eccezioni:

* La musica di un solista predominante è 
scritta sul rigo in alto.

* Percussioni: l’ordine degli strumenti di una 
sezione percussiva può variare da una partit-
ura all’altra.

* Musica per due orchestre, cori, ecc..
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I separatori di sistema si attivano o disattivano con l’opzione Disegna separatore sinistro/destro 
nella pagina Strumenti della finestra di dialogo House Style > Regole tipografia. Si può anche 
stabilire il numero di righi minimo che un sistema deve avere perché appaiano i separatori e la dis-
tanza dei separatori dal margine.

Poiché questa opzione è copiata nelle parti, si può usarla anche per controllare automaticamente 
quali parti hanno i separatori; per esempio, se si vuole vederli solamente in parti di percussioni 
complesse, contenenti (ad esempio) 3 o più righi, impostare a 3 il numero minimo di righi nella 
partitura: tutte le parti avranno la stessa impostazione.

Estensione dello strumento
Sibelius può scrivere le note sfumate in rosso se sono troppo acute o gravi per l’estensione di uno 
strumento (attivare l’opzione Vista > Colori note > Note fuori Range – b Menu Vista); ogni 
strumento ha due estensioni: “professionale” e “comoda” (entrambe regolabili).

L’estensione professionale, generalmente definisce le note più acute e gravi suonabili su un partico-
lare strumento; le note fuori da questa sono di colore rosso brillante. L’estensione comoda definisce 
le note più acute e gravi che un musicista non-professionista suona abitualmente; le note fuori da 
questa estensione ma entro quella professionale sono colorate in rosso scuro.

Naturalmente, la maggior parte degli strumenti non ha un’estensione ben definita (si pensi ai can-
tanti, ad esempio). Gli adattamenti opzionali comunemente adottati sugli strumenti, come la corda 
di DO basso sul contrabbasso, il SI basso sul flauto e il DO alto sul pianoforte (al posto del LA) ten-
dono ad essere inclusi nell’estensione professionale, ma non in quella comoda.

Per regolare l’estensione degli strumenti nella partitura vedere b Modifica strumenti.

Transporto degli strumenti
Sibelius tiene conto di tutte le problematiche legate al trasporto degli strumenti:

* Si può inserire la musica con le note trasportate o alla loro altezza reale (da concerto). Per pas-
sare subito da una rappresentazione all’altra, selezionare Note > Partitura traspositore 
(comando rapido Ctrl+Maius+T o xXT) o cliccare sul rispettivo pulsante nella toolbar.

* Quando si copia la musica tra strumenti trasportati, Sibelius trasporta automaticamente e cor-
rettamente la musica per farla suonare sempre allo stesso modo; ciò evita pesanti mal di testa 
quando si copia la musica da un Clarinetto in LA a un Corno in FA!

* Osservando la parte di uno strumento trasportato da una partitura all’altezza suonata non serve 
nemmeno pensare al trasporto della parte – lo fa Sibelius automaticamente.

* Si può inserire la musica da una tastiera MIDI, suonandola così com’è o come è scritta – per 
esempio, si possono suonare parti trasportate in Sibelius per costruire una partitura combinata 
con musica suonata alla giusta altezza; attivare l’opzione Inserisci suono scritto nella pagina 
Inserimento nota della finestra di dialogo File > Preferenze (Menu Sibelius in Mac).
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Alterazioni e tonalità per gli strumenti trasportati
Di default, Sibelius scrive gli strumenti trasportati usando correttamente le opportune alterazioni 
della tonalità remota. Avendo, ad esempio, un LA bemolle scritto per un sax alto in FA e passando 
alla partitura trasportata, Sibelius lo scrive correttamente come FA naturale in RE maggiore. 

In tonalità che cambiano segno se trasportate possono nascere problemi di spelling enarmonico. 
Per esempio, una partitura in FA# maggiore con una parte di clarinetto in SIb una volta trasportate 
andrebbe a finire in LAb maggiore; in condizioni normali, Sibelius dovrebbe solo alzare le note di 
una 2° maggiore per il clarinetto in SIb, ma qui il grado di trasporto diventa una 3° diminuita (cioè 
i FA# diventano LAb invece di SOL#).

Sibelius ha un’opzione che tiene conto automaticamente di questo: attivare l’opzione Regola tras-
crizione note nella trasposizione di strumenti nella pagina Chiavi e Alterazioni in Chiave
della finestra di dialogo House Style > Regole tipografia.

In genere, questa opzione è attiva, ma se la partitura ha spelling di lettere particolari che di solito 
non si scrivono, disattivando questa opzione si può rimediare a problemi derivanti dal trasporto. 
Per esempio, in un clarinetto in SIb, un LAbb in tonalità di FA# maggiore non è trasportabile agev-
olmente in alto di una 3° diminuita! (Diventerebbe un DO triplo-bemolle, usato talmente di rado 
che non esiste nemmeno uno standard riconosciuto su come debba essere scritto).

Nel caso in cui la parte di uno strumento trasportato possa essere scritta usando diesis o bemolle, 
Sibelius consente di utilizzare la tonalità risultante dal trasporto di quella da concerto, oppure 
semplificare la tonalità usando quella enarmonica equivalente.

Per esempio, si consideri un brano in SI maggiore con una parte di Clarinetto in SIb. Può darsi che 
il compositore preferisca scrivere tale parte in DO# maggiore usando sette diesis, oppure semplifi-
care la tonalità a REb maggiore (che ha solo cinque bemolle). Di default, quando ciò avviene, Sibe-
lius semplifica le tonalità remote. Tuttavia, per usare la forma non semplificata, disattivare 
l’opzione Trascrivi alterazioni in chiave nella partitura trasposta nella pagina Chiavi e Alter-
azioni in Chiave della finestra di dialogo House Style > Regole tipografia.

Esecutori multipli e archi divisi...
Spesso gli strumenti a fiato sono suonati da due o più esecutori numerati, per esempio, Trombe 1, 
2 e 3; anche gli archi sono spesso divisi su due righi (“divisi”) o, talvolta, su più righi numerati da 
string desks. I righi corali molte volte si dividono in due righi (semicoro o Dec e Can). Ci sono due 
modi per gestire queste situazioni, dipende dai casi:

...caso semplice
Se la partitura è omogenea riguardo agli esecutori che leggono determinati righi, non c’è problema. 
Per esempio, se tutte le tre trombe in una partitura sono scritte sempre sullo stesso rigo, basta 
creare un singolo strumento Tromba e rinominarlo (ad esempio) “Tromba 1.2.3” all’inizio.

Analogamente, se le trombe 1+2 sono sempre insieme su un rigo e la tromba 3 ha sempre il prop-
rio rigo separato, creare due strumenti con i nomi separati (chiamandoli “Tromba 1.2” e “Tromba 
3”), altrimenti creare un singolo strumento (“Trombe”) e aggiungergli un secondo rigo.
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...caso più complesso
Le complicazioni emergono se l’esecutore salta da rigo a rigo a metà della partitura, perché in tal 
caso bisogna cambiare i nomi al lato sinistro a metà partitura.

Per esempio, le tre trombe potrebbero suonare all’unisono su un singolo rigo “Trombe 1.2.3” in 
alcuni punti, poi dividersi su due righi (“Trombe 1.2” e “Trombe 3”) da qualche altra parte e, in 
passaggi complessi, potrebbero perfino dividersi su tre righi separati.

Poiché il nome al lato sinistro deve cambiare a metà partitura, si dovrà creare uno strumento 
Tromba distinto per ogni nome diverso che si vuole usare – in una partitura complessa per tre 
trombe, quindi, si dovranno creare cinque strumenti denominati Trombe 1.2.3, Trombe 1.2, 
Tromba 1, Tromba 2 e Tromba 3. A questo punto, scrivere la musica sul rigo appropriato e nascon-
dere i righi di scorta quando non sono usati (b Righi).

Indicare dove i righi si dividono o uniscono, oppure dove gli esecutori cambiano, usando lo stile di 
testo Technique, per scrivere (ad esempio) “1.2” o “a 2” o “div.” o “unis.”.

Dove il numero di righi cambia è meglio inserire un break di sistema, altrimenti appariranno righi 
parzialmente usati (e ciò è abbastanza insolito).

Per realizzare parti separate per i singoli esecutori vedere b Estrarre le parti.

Strumenti doppi
Gli strumenti doppi sono due o più strumenti suonati dalla stessa persona. Quasi sempre si dovrà 
usare il comando Crea > Altro > Cambio Strumento ogni volta che l’esecutore cambia strumento 
(vedere in seguito).

Un’eccezione possibile è una percussione senza intonazione (un triangolo, un rullante o una cassa, 
ad esempio) sullo stesso rigo; ciò è descritto nei dettagli in b Percussioni.

Cambi di strumento
Sibelius consente di cambiare facilmente gli strumenti in un punto qualsiasi della partitura con il 
comando Crea > Altro > Cambio strumento. Innanzitutto bisogna considerare se il cambio di 
strumento debba restare fino alla fine della partitura (o fino ad un cambio di strumento esistente 
presente più avanti nella partitura), oppure essere solo temporaneo per un passaggio specifico.

* Per un cambio di strumento temporaneo selezionare il passaggio nel quale avere il cambio di 
strumento; Sibelius torna automaticamente allo strumento originale alla fine della selezione.

* Per un cambio di strumento permanente selezionare una singola nota oltre la quale avere il cam-
bio di strumento, oppure non eseguire alcuna selezione (in tal caso, si può cliccare con il mouse 
per inserire subito il cambio di strumento).

* Una volta selezionato dove si vuole il cambio di strumento (ed eventualmente dove si vuole che 
termini) scegliere Crea > Altro > Cambio strumento. Si apre la finestra di dialogo seguente:
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* Scegliere dall’elenco lo strumento al quale si vuole cambiare. Le due opzioni extra che si possono 
impostare sono:
% Se Aggiungi chiave (se necessario) è attiva, Sibelius crea un cambio di chiave nel punto in 

cui c’è il cambio di strumento (se la chiave del nuovo strumento è diversa da quella dello stru-
mento originale).

% Se Segnala ultima nota dello strumento precedente è attiva, Sibelius crea un messaggio 
d’avviso (“Su [strumento]”) all’inizio delle pause che precedono il cambio.

* Cliccare OK; se non c’era una selezione prima dell’apertura della finestra, il puntatore del mouse 
ora è blu e si può cliccare nella partitura per inserire il proprio cambio di strumento, altrimenti 
Sibelius crea automaticamente il cambio (o cambi) di strumento alla selezione.

Quando si crea un cambio di strumento, Sibelius esegue sempre le seguenti operazioni:

* Cambia opportunamente il suono del rigo riprodotto.
* Cambia il nome dello strumento nei sistemi successivi (che, volendo, si può modificare).
* Scrive il nome del nuovo strumento sopra la cima del rigo dove inizia a suonare (volendo si può 

modificarlo).
* Se serve, cambia il trasporto del rigo (es. passando da un clarinetto in SIb ad uno in LA), indi-

cando il relativo cambio di tonalità (se è attiva l’opzione Note > Partitura traspositore).
* Se serve, cambia il tipo di rigo (numero di linee del rigo, notazione normale o tablatura, ecc.).

La figura seguente mostra come appaiono i cambi strumento nello spartito, passando da un Clari-
netto in SIb a un Sax Alto (in MIb); a sinistra è attiva l’opzione Vista > Oggetti nascosti (per ved-
ere il punto esatto di cambio strumento, grazie al rettangolo grigio) e non attiva l’opzione Note >
Partitura traspositore (la musica suona all’altezza reale); a destra è attiva l’opzione Note > Parti-
tura traspositore.
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Si noti che attivando o disattivando l’opzione Note > Partitura traspositore il cambio di stru-
mento occupa più o meno spazio; se la spaziatura non piace selezionare le misure influenzate e 
scegliere Layout > Ripristina spaziatura nota (comando rapido Ctrl+Maius+N o xXN).

Modificare i cambi di strumento
Si può spostare il cambio di strumento lungo il rigo trascinando con il mouse il rettangolo grigio o 
la tonalità a sinistra o destra, oppure usando i tasti 0/1. Si noti che se il cambio di chiave è stato 
creato insieme al cambio di strumento, il primo non si sposta muovendo il cambio di strumento – 
essi sono oggetti distinti. (Ciò significa, inoltre, che cancellando il cambio di strumento la chiave 
rimane, e viceversa).

Il segno testuale sopra il cambio di strumento si può spostare indipendentemente dal cambio di 
strumento vero e proprio, selezionandolo e muovendolo con il mouse o i tasti freccia. Si può mod-
ificare il testo con un doppio-clcik del mouse su di esso (come per qualsiasi altro oggetto di testo); 
si può anche nascondere il testo selezionandolo e scegliendo Modifica > Mostra o nascondi >
Nascondi (comando rapido Ctrl+Maius+H o xXH).

È possibile copiare, incollare e cancellare i cambi di strumento come qualsiasi altro oggetto di Sibe-
lius.

Cambi di strumento e parti dinamiche
Di default, i cambi di strumento creati in tutta la partitura appaiono nelle parti dinamiche, ma si 
possono cancellare nelle parti (se si desidera) senza influenzare l’intera partitura. Al contrario, i 
cambi di strumento creati in parti dinamiche non appaiono nell’intera partitura. Ciò consente di 
creare più parti dinamiche per vari strumenti o diversi trasporti – vedere Parti in trasporti 
diversi a pagina 484.
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2.23 Tablatura per liuto

b Notazione e tablatura per chitarra.

Sibelius ha un’ampia gamma di stili per la tablatura di liuto, con molte accordature diverse.  
Di default, tutta la tablatura per liuto è in stile Francese/Inglese, ma selezionando gli strumenti 
adeguati sono disponibili anche gli stili Italiano e Spagnolo.

Creare una tablatura per liuto
La tablatura per liuto s’insericsce come qualsisasi altro tipo di tablatura (b Inserire una tabla-
tura per chitarra) con una lieve complicazione: per scrivere le lettere nella tablatura si devono 
usare i numeri sulla tastiera del computer; per esempio, 0 = a, 2 = c, 5 = f, e così via.

Quando s’inizia una nuova partitura è più semplice usare il foglio manoscritto Lute tablature – 
b Foglio manoscritto.

Vari stili di tablatura per liuto
Le convenzioni di notazione dei tre stili supportati per la tablatura di liuto sono:

* Francese/Inglese: la corda più grave del liuto è la linea in basso sul rigo di tablatura e le lettere tra 
gli spazi rappresentano le note.

* Spagnola: la corda più grave del liuto è la linea in basso sul rigo di tablatura e i numeri sulle 
corde (come nella tablatura moderna per chitarra) rappresentano le note.

* Italiana: identica allo stile Spagnolo, con la differenza che la corda più bassa del liuto è la linea in 
alto sul rigo, non quella in basso.

La tablatura per liuto Tedesca (che utilizza le lettere per indicare le note ma è totalmente priva 
delle linee del rigo) non è supportata da Sibelius.

Per creare una delle tablature di liuto, basta scegliere quella desiderata dalla finestra di dialogo 
Crea > Strumenti e righi– b Strumenti.

Ritmi
Quando si scrivono i ritmi sui righi di tablatura per liuto, i valori nota da 1/8 (crome) e più brevi 
spesso sono lasciati privi di tratti d’unione. Sibelius unisce automaticamente tra loro queste note, 
ma è possibile dividerle nuovamente selezionando il passaggio nel quale separarle (con un triplo-
click del mouse sul rigo di liuto per selezionarlo in tutta la partitura, ad esempio), premendo F10
per scegliere il terzo layout del tastierino numerico e premendo 7 sul pad numerico.

Non si può scrivere una coda inversa, cioè una nota da 1/2 (minima) – poiché apparirebbe come 
un gambo senza coda (come una nota da 1/4).

Per togliere il gambo e un tratto d’unione/bandierina da una nota o passaggio selezionato (perché è 
un valore nota ripetuto) scegliere il numero di testa nota 8 dal pannello Notes della finestra Prop-
erties; selezionare il numero di testa nota 0 per riportare al proprio posto tratto d’unione/bandie-
rina.
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Diapason
I diapason sono corde extra non scritte sul rigo vero e proprio; nello stile di tablatura Italiana sono 
scritti sopra il rigo, tra la linea in cima al rigo e la base dei gambi che indicano il ritmo della 
musica; per scrivere queste lettere utilizzare il testo Technique (comando rapido Ctrl+T o XT).

Nello stile di tablatura Francese, i diapason sono scritti direttamente sotto il rigo; per scriverli nella 
partitura usare le etichette di testo per le Percussioni (selezionare Crea > Testo > Altro testo rigo >
Bacchette percussive).
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2.24 Tempi in chiave

Creare i tempi in chiave
* Selezionare una nota, pausa, linea o altro oggetto nella partitura.
* Scegliere Crea > Indicazione tempo (comando rapido T) e cliccare sul tempo in chiave desider-

ato; cliccare Altro e usare i menu a tendina per creare tempi in chiave più complessi.
* Cliccare OK o premere Invio; il tempo in chiave si crea all’inizio della misura successiva.

Per creare un tempo in chiave a inizio partitura è più comodo sceglierlo nella finestra di dialogo 
File > Nuovo quando si crea la partitura per la prima volta. Per crearlo o cambiarlo in seguito assi-
curarsi che non ci sia niente selezionato (premere Esc), scegliere Crea > Indicazione tempo, 
selezionare il tempo in chiave desiderato e cliccare OK. Il puntatore del mouse si colora ad indicare 
che “contiene” un oggetto – cliccare a inizio partitura per inserire il tempo in chiave iniziale.

Misure d’entrata (upbeat)
Se la partitura inizia con una misura d’entrata (upbeat) è più facile specificarlo nello stesso 
momento in cui si crea il tempo in chiave iniziale. Nella finestra di dialogo Crea > Indicazione 
tempo, cliccare Inizio con misura di durata e scegliere la durata della misura dall’elenco, oppure 
digitarla sul pad numerico (con il tasto Num Lock attivo). Per avere una misura d’entrata (upbeat) 
dalla durata particolare scegliere più di un valore nota, per esempio una nota da 1/2 (minima) più 
una da 1/8 (croma).

Si noterà che le misure d’entrata (upbeat) indicano correttamente il numero di movimenti in ogni 
misura sotto forma di pause, divise secondo le impostazioni Gruppi di tratti e pause definite 
durante la creazione del tempo in chiave.

Dimenticate di creare una misura d’entrata adesso; si può crearla come misura irregolare in seguito 
– b Misure e misure di pausa.

Quando la musica inizia con una misura d’entrata è normale assegnare il numero 1 non il 2 alla 
prima misura completa. Sibelius lo fa automaticamente, dando il numero 0 alla misura d’entrata.

Re-misurare la musica
Inserendo un tempo in chiave nella musica esistente, Sibelius divide quest’ultima in misure di 
nuova durata con legature di valore tra le stanghette, ove necessario (a meno che si disattivi l’opzi-
one Riscrivi battute fino alla prossima indicazione di tempo in Crea > Indicazione tempo).

Sibelius re-misura la musica solo fino al cambio tempo successivo nella partitura (se ce n’è uno). 
Tuttavia, se s’inizia selezionando un passaggio prima di creare un tempo in chiave, Sibelius rein-
serisce il tempo in chiave originale alla fine della selezione e riscrive la musica solo fino a quel 
punto; ciò è molto utile per cambiare la disposizione di alcune misure a metà partitura.

Se in una partitura sono state copiate misure che non soddisfano il tempo in chiave prevalente e si 
desidera re-misurarle opportunamente, selezionare il tempo in chiave e cancellarlo. Quando Sibel-
ius chiede se devono essere riscritte le misure successive, cliccare No poi reinserire lo stesso tempo 
in chiave, assicurandosi che l’opzione Riscrivi battute fino alla prossima indicazione di tempo
sia attiva.
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Tempi in chiave d’avvertimento
L’opzione Attiva avviso consente di visualizzare un tempo in chiave d’avvertimento alla fine del 
sistema precedente se il tempo in chiave è stato inserito (o successivamente va’ a finire) alla fine di 
un sistema. Normalmente, si disattiva questo box quando s’inserisce un tempo in chiave all’inizio 
di un nuovo pezzo, brano o movimento all’interno di una partitura più grande (lo stesso criterio 
vale per chiavi e tonalità d’avvertimento).

Tempi in chiave complessi
Per creare un tempo in chiave diverso da quelli più comuni presenti nella finestra di dialogo Crea >
Indicazione tempo, cliccare Altro e scegliere i numeri desiderati dagli elenchi disponibili.

Per fare in modo che i gruppi mostrino la sommatoria del tempo in chiave (3+2+2/8, ad esempio) 
digitare 3+2+2 nel box per il valore in alto del tempo in chiave invece di prelevare un numero 
dall’elenco. In Mac, si deve usare il tasto + del pad numerico (non della tastiera principale).

Altrimenti, per scrivere il tempo in chiave come 7/8 ma avere 2+2+3 (o qualsiasi altro testo) scritto 
sopra il tempo in chiave nello stesso font, aggiungere il tempo extra usando lo stile di testo Indi-
cazioni di tempo (un solo rigo) – vedere Tempi in chiave multipli.

Gruppi di tratti d’unione e pause
Sibelius raggruppa automaticamente i movimenti in base ad ogni tempo in chiave creato.

Tuttavia, è possibile modificare a piacere queste impostazioni cliccando Gruppi di tratti e pause 
nella finestra di dialogo Crea > Indicazione tempo, oppure si possono modificare i gruppi di tratti 
d’unione nella musica esistente con la finestra di dialogo Note > Ripristina gruppi tratti 
d’unione.

Per ulteriori dettagli, b Tratti d’unione.

Misure irregolari e ritmo libero
Per creare una misura irregolare (cioè con una durata diversa da quella specificata dal tempo in 
chiave prevalente), b Misure e misure di pausa.

Per altri casi di musica con tempo libero, b Ritmo libero.

Tempi in chiave multipli
Talvolta le partiture hanno due tempi in chiave simultanei con la stessa durata della misura (per 
esempio, 2/4 e 6/8). Per inserire questo tipo di situazioni:

* Creare un tempo in chiave di 2/4 e inserire la musica in 2/4, come al solito.
* Inserire la musica in 6/8 come terzine di ottavi (crome) ma, almeno per il primo tuplet, usare la 

finestra di dialogo Crea > Gruppo irregolare, attivando l’opzione Niente e disattivando quella 
Bracket in modo che le note non appaiano come terzine vere e proprie.

* Copiando la prima misura in 6/8 si ha subito il ritmo terzinato per le misure successive.
* Una volta inserita tutta la musica cancellare il tempo in chiave di 2/4 e trascinare la prima nota 

verso destra fino a quando c’è spazio sufficiente per un tempo in chiave sostitutivo.
* Digitare 2/4 e 6/8 usando un testo – iniziare con niente selezionato e usare il comando Crea >

Testo > Altro testo rigo > Tempi in chiave (solo un rigo).
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* Cliccare dove si vuole collocare il tempo in chiave da digitare come testo, premendo Invio (sulla 
tastiera principale del computer) dopo il numero.

Se servono due o più tempi in chiave con durate diverse della misura (per esempio, 4/4 e 5/4):

* Calcolare il multiplo comune più basso tra i due tempi in chiave – in questo caso 20/4 – e creare 
quello come tempo in chiave.

* Una volta inserita tutta la musica cancellare il tempo in chiave di 20/4 e trascinare la prima nota 
verso destra fino a quando c’è spazio sufficiente per il tempo in chiave sostitutivo.

* Digitare 4/4 e 5/4 usando il testo – si deve creare un nuovo stile di testo (vedere sopra).
* Aggiungere le stanghette extra usando la linea verticale nella finestra di dialogo Crea > Linea.

Il vantaggio di questo metodo è che i sistemi terminano a stanghette coincidenti. Se tempi in chi-
ave simultanei hanno sempre le stanghette in posti diversi adottare la stessa procedura, ma rimuo-
vere le stanghette da un rigo (vedere Nascondere solo le stanghette di alcuni righi in 
b Stanghette), poi usare la linea verticale nella finestrella Staff lines della finestra di dialogo 
Crea > Linea per scrivere le opportune stanghette alle posizioni desiderate.

Tempi in chiave alternati
Per scrivere la musica alternando i tempi in chiave (2/4 e 3/4, ad esempio) segnalati da un tempo 
in chiave composto in 2/4 3/4:

* Inserire un tempo in chiave di 2/4 e copiarlo nelle misure alternative.
* Fare la stessa cosa per il tempo in chiave di 3/4 nelle misure rimanenti.
* Inserire la musica.
* Cancellare tutti i tempi in chiave tranne quello iniziale di 2/4 (rispondendo No quando Sibelius 

chiede se si vuole riscrivere la musica).
* Infine, scrivere un tempo in chiave di 3/4 subito dopo quello di 2/4 usando il testo, come 

descritto in Tempi in chiave multipli.

Modificare i tempi in chiave
I tempi in chiave si possono copiare e cancellare come tutti gli altri oggetti. È possibile anche tras-
cinare i tempi in chiave a sinistra e destra per spostarli – perfino alle posizioni più insolite. Si rac-
comanda di non trascinare i tempi in chiave fuori dalla misura alla quale appartengono.

Tempi in chiave grandi, ecc.
I tempi in chiave grandi tra i righi sono utilizzati spesso nelle partiture moderne, ove la metrica 
cambia di frequente. Nella pagina Indicazioni Tempo della finestra House Style > Regole 
tipografia (comando rapido Ctrl+Maius+E o xXE) cliccare Tempi in chiave (grandi) o Tempi 
in chiave (enormi). In realtà, sono stili di testo utilizzabili dai tempi in chiave e influenzano tutti i 
tempi in chiave lungo tutta la partitura.

Per modificare dimensione, font e posizione dei tempi in chiave grandi cliccare Modifica Stile 
Testo; b Modifica stili di testo. Ciò consente di stabilire anche quali righi con tempi in chiave 
grandi vanno sopra.

L’altra opzione House Style > Regole tipografia consente di regolare lo spazio vuoto di default 
prima dei tempi in chiave.
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2.25 Terzine e altri tuplet

b Filtri e Trova, Nascondere oggetti.

I “tuplet” sono simili a terzine ma suonati ad una certa frazione della velocità normale.

In altre parole, i “tuplet” sono “gruppi irregolari” di note. L’opinione comune si divide sul fatto che 
“tuplet” faccia rima con “duplet” o “couplet”.

Creare rapidamente i tuplet
* Inserire o selezionare (solo) la prima nota del tuplet, che 

deve durare l’unità del tuplet (vedere box).
Per esempio, per una terzina della durata totale di 1/2, la 
prima nota da inserire deve essere da 1/4.

* Premere Ctrl+3 o X3 per una terzina – forse è proprio 
ciò che serve – o Ctrl+2–9 o X2–9 per qualsiasi altra 
cosa, da un tuplet a un nonuplet.

* Appare il tuplet con il giusto numero di pause. Inserire 
la altre note come al solito.

Il tuplet ha le ultime opzioni di formato e parentesi defi-
nite nella finestra di dialogo Crea > Gruppo irregolare 
(vedere Creare lentamente i tuplet).

Creare lentamente i tuplet
* Inserire o selezionare (solo) la prima nota del tuplet, che 

deve durare l’unità del tuplet.
* Selezionare Crea > Gruppo irregolare.

* Digitare un numero di ratio qualsiasi della complessità desiderata (per esempio, 13 o 99:64).
* Cliccare Numero per scrivere un solo singolo numero (o il primo numero del ratio), Rapporto

per scrivere un ratio (es. 5:3), Rapporto+nota per scrivere, es. 5:3x, e Niente per non scrivere 
alcun numero.

* Di default, Sibelius crea i tuplet con l’opzione Parentesi 
quadra autom. attiva; la parentesi della terzina quindi 
scompare se c’è un tratto d’unione che unisce esattamente 
le stesse note racchiuse in parentesi e se il tuplet è 
all’estremità del tratto d’unione delle note. Per specificare 
esplicitamente se mettere o meno il tuplet in parentesi 
scegliere una delle altre opzioni.

* Attivare Durata piena per estendere la parentesi alla nota/
pausa successiva (vedere il box alla pagina seguente).

* Cliccare OK: appare il tuplet e si possono inserire le altre 
note come al solito.

Tuplet a un solo numero
Il caso più semplice è la terzina; 3 su 
q q q significa 3 note da 1/4 ristrette nel 
tempo di due note da 1/4; in tal caso, la 
nota da 1/4 è l’“unità” del tuplet.

Dove si usano numeri diversi da 3, la 
tendenza è schiacciarli nelle 2 unità suc-
cessive più basse – 5 significa 5 nel 
tempo di 4, 15 significa 15 nel tempo di 
8, e così via. Le eccezioni a questa regola 
sono 2 e 4, che di solito significa 2 nel 
tempo di 3 e 4 nel tempo di 6.

Se le terzine sono molto usate, spesso il 
numero 3 è scritto sopra alcune delle 
prime e poi scompare. Se tutta la partit-
ura fosse scritta così sarebbe meglio 
usare un tempo in chiave diverso!
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Modificare i tuplet
Per modificare i tuplet esistenti ci sono vari plug-in – per i dettagli vedere a pagina 428.

Copiare i tuplet
Selezionare un numero o parentesi di tuplet e copiarlo su un’altra nota per trasformarla in tuplet.

Si possono anche copiare passaggi con tuplet; l’unica cosa che non si può copiare è parte di un 
tuplet (solo la prima nota, ad esempio, poiché si avrebbe un frammento di ritmo frazionale che ha 
poco senso). Se un messaggio imprevisto avvisa che si sta copiando parte di un tuplet, assicurarsi 
di aver selezionato numero o parentesi del tuplet, oltre che le note in esso contenute.

Cancellare i tuplet
Per cancellare un tuplet selezionare il numero o la parentesi e premere Canc. Ciò cancella non solo 
numero e parentesi ma anche le note; senza il tuplet, infatti, le note non si sommeranno più.

Impostare l’unità di durata
Talvolta la prima nota del tuplet non equivale all’unità di durata: 
una terzina che dura tre note da 1/4, potrebbe iniziare con una 
nota da 1/8, ad esempio. In tal caso, inserire la prima nota con 
l’unità di durata desiderata (qui, una nota da 1/4) così Sibelius sa 
quanto dura il ritmo, inserire il tuplet e poi cambiare il valore 
della prima nota.

Le unità di tuplet non possono essere puntate; scrivendo un 
tuplet su una nota puntata il punto è ignorato.

Tuplet speciali
Ci sono casi in cui si deve scrivere un tuplet a cifra singola, che 
indichi qualcosa di diverso dal solito; in 6/8, ad esempio, si 
potrebbe vedere questo:

In realtà, si tratta di un tuplet con ratio 7:6. Per scriverlo, usare la 
finestra di dialogo Crea > Gruppo irregolare, digitare 7:6 (per 
dire a Sibelius cos’è realmente il tuplet) e impostare l’opzione For-
mato in Numero (che dice a Sibelius di scrivere solo 7 nella 
partitura). 

Elliott Carter e alcuni altri compositori, scrivono 7 intendendo 7:8 e 15 per indicare 15:16, poiché 
in questo modo i valori nota sono molto più fedeli a come suonano nella notazione standard; per 
scriverlo, si deve scegliere un ratio di 7:8 (ad esempio) e impostare l’opzione Formato in Numero.

Spostare i tuplet
I tuplet sono “magnetici” (cioè si posizionano automaticamente) come le legature (b Linee). 
Sibelius decide se il tuplet deve andare sopra o sotto le note e a quale angolatura. Numero e paren-
tesi del tuplet di spostano automaticamente, per evitare collisioni con le note alle estremità e con le 

Parentesi del tuplet
Spesso la parentesi è scritta sopra le 
note del tuplet. Il numero è scritto 
sopra o sotto la parentesi, ma per 
risparmiare spazio si usa metterlo 
in uno spazio vuoto al centro.

Nelle vecchie partiture si trova 
spesso una legatura al posto della 
parentesi (anche se le note non 
devono essere suonate in legato); 
oggi la legatura si usa solo per indi-
care il portamento.

Alcuni compositori, come Britten e 
Holloway, indicano la terzina scriv-
endo solo la parentesi.

Nelle partiture moderne, spesso le 
parentesi del tuplet si estendono fino 
all’inizio della nota/pausa dopo il 
tuplet. Ciò è più chiaro quando si 
scrivono, ad esempio, terzine di note 
da 1/4 e sestine di note da 1/8 simul-
taneamente, perché significa che le 
parentesi finiscono tutte nello stesso 
posto.
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articolazioni sulle note del tuplet stesso. Si provi a trascinare la prima nota di un tuplet in alto e in 
basso per vedere cosa succede! Trasportando la musica, numero e parentesi del tuplet si spostano 
automaticamente, in modo da non toccare le altre note.

Se non piace come Sibelius lo colloca di default, il tuplet si può invertire all’altro lato delle note 
selezionando il numero (o parentesi) e scegliendo Modifica > Inverti (comando rapido X).

Si può anche spostare in alto e in basso l’intero tuplet trascinando il numero (o il centro della 
parentesi, se non c’è il numero) oppure usando i tasti freccia. Non provare a trascinare un tuplet 
all’altro lato delle note – usare invece il comando Modifica > Inverti (comando rapido X).

Per regolare l’angolo e il numero della parentesi spostare una capo della parentesi.

Per riportare un tuplet alla posizione di default, selezionarlo e scegliere Layout > Ripristina posiz-
ione (comando rapido Ctrl+Maius+P o xXP).

Tuplet annidati
I tuplet “annidati” (cioè tuplet in altri tuplet) sono molto amati 
dai compositori contemporanei come Brian Ferneyhough, ma 
sono piuttosto difficili da leggere a vista. Sibelius scrive auto-

maticamente quasi tutti i tuplet annidati più complessi, riproducendoli correttamente.

I tuplet annidati s’inseriscono come quelli normali, ma prima si deve inserire quello più esterno 
(cioè il più ampio) e poi continuare con gli altri.

Tuplet nascosti
I tuplet “nascosti” si scrivono nascondendo la parentesi e il numero 
(b Nascondere oggetti), oppure disattivando parentesi e numero 
dalla finestra di dialogo Crea > Gruppo irregolare quando li si crea.

La spaziatura diventa proporzionalmente diversa da quella in altri righi 
della partitura che non hanno nient’altro ad indicare che c’era un 
tuplet. È utile per veloci appunti di note e altri esempi di “ritmo libero” 
dove sarebbe lungo e noioso scrivere un ritmo esatto nella partitura. Si 
può usare questa opzione anche per scrivere tempi in chiave misti, 
come un 4/4 e un 6/8. b Ritmo libero, Tempi in chiave.

Cambiare l’aspetto di tuplet già presenti nella partitura
Se una volta creata una serie di tuplet si preferisce cambiare il modo in cui sono stampati è possi-
bile farlo usando i filtri e la finestra Proprietà.

Per nascondere parentesi e numeri di tuplet già presenti nella partitura, ad esempio:

* Selezionare Modifica > Filtro > Gruppi irregolari.

* A questo punto, tutte le parentesi e i numeri dei tuplet nella partitura sono selezionati. Ora:
% Per nascondere tutte le parentesi e i numeri dei tuplet selezionare Modifica > Mostra o 

nascondi > Nascondi (comando rapido Ctrl+Maius+H o xXH), oppure scegliere 
Nascondi dal menu del pannello Generale nella finestra Proprietà.

% Per cambiare aspetto al tuplet usare le opzioni nel pannello Note nella finestra Proprietà.

Ratio dei tuplet
Nella notazione moderna si 
può scrivere 5:4 (“5 nel tempo 
di 4”). Ciò si può usare per 
rendere più espliciti i singoli 
tuplet – scrivendo 3:2 per una 
terzina – o specificare ritmi 
più insoliti come 5:3. Il sec-
ondo numero deve essere più 
della metà e meno del doppio 
del primo.
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I filtri sono un metodo estremamente efficace per cambiare molti oggetti della partitura con una 
singola operazione – b Filtri e Trova.

Parentesi orizzontali del tuplet
Per avere le parentesi del tuplet sempre orizzontali scegliere House Style > Modifica linee, selezi-
onare la linea per la parentesi del tuplet nell’elenco Linee rigo, cliccare Modifica e, nella finestra di 
dialogo Modifica Linea, attivare l’opzione Orizzontale (b Modifica linee). Attenzione! For-
zando le parentesi del tuplet ad essere orizzontali si disabilitano alcune proprietà “magnetiche”.

Tuplet sopra le stanghette
Sebbene Sibelius non possa scrivere automaticamente i tuplets sopra le stanghette, l’effetto si può 
ottenere abbastanza facilmente come segue:

* Creare una misura irregolare dalla durata doppia del tempo in chiave prevalente: selezionare 
Crea > Misura > Altro (comando rapido Alt+B o zB).

* Scrivere la musica nelle due misure con il tuplet che attraversa la stanghetta.
* Aggiungere la stanghetta adeguata – nell’esempio precedente scegliere Crea > Stanghetta >

Normale e cliccare alla posizione più opportuna.
* Se si usano i numeri misura creare anche un cambio di numero misura nella misura che segue, 

per compensare la perdita di quella “vera”; scegliere Crea > Altro > Cambio numero misura.

Motivi dei tuplet e opzioni Engraving Rules
Il motivo di numeri e parentesi dei tuplet si può cambiare dalle finestre di dialogo House Style >
Modifica stili di testo (comando rapido Ctrl+Maius+Alt+T o xzXT) e House Style > Modi-
fica linee. Per il font dei numeri sui tuplet, in genere si usa il font Serif medio in corsivo. 
b Modifica stili di testo, Linee.

Molte opzioni per l’aspetto e la posizione dei tuplet sono nella pagina Gruppi irregolari della 
finestra di dialogo House Style > Regole tipografia (comando rapido Ctrl+Maius+E o xXE):

* Ruota singole unità: stabilisce se i numeri a una sola cifra del tuplet (le terzine, ad esempio) 
sono scritti con la stessa angolazione della parentesi; le cifre singole è meglio scriverle dritte; di 
default, quindi, questa opzione non è attiva. I testi di tuplet a più cifre (es. 12 o 3:2) sono scritti 
alla stessa angolatura della parentesi (per allinearsi ad essa) e non sono influenzati da questa 
opzione.

* Posizione rispetto alle note: consente di scegliere la posizione di default dei tuplet con e senza 
parentesi.

* Distanza verticale dalle note: controlla la distanza di default tra i tuplet e le note.
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2.26 Teste nota

b Tratti d’unione, Percussioni, Gambi e linee aggiuntive, Modifica teste nota.

Sibelius ha molte forme di teste nota speciali (a rombo, a croce e slash) ed è possibile creare teste 
nota personalizzate; si può anche controllare se una particolare forma di testa nota debba o meno 
essere riprodotta, trasportata, avere gambi o linee aggiuntive, ecc. (b Modifica teste nota).

Le teste nota sono distinte dai valori nota – una testa nota a croce può essere applicata indifferente-
mente ad una nota da 1/8 (croma), 1/2 (minima), oppure a una nota doppia da 4/4 (breve), cambi-
ando quindi leggermente il suo aspetto.

Scegliere una testa nota
Per cambiare il tipo di testa nota nella musica esistente, selezionare una nota o passaggio e usare il 
menu a tendina nel pannello Note della finestra Proprietà. Si può scegliere la testa nota anche 
tenendo premuto Maius+Alt o xz e digitando i numeri nella fila in alto sulla tastiera del com-
puter (non il pad numerico); per i numeri della testa nota vedere in seguito. Se la testa nota desid-
erata ha un numero superiore a 9 (il tipo di testa nota 13, ad esempio), digitare velocemente 
entrambe le cifre una dopo l’altra. Se non si è certi di ciò che si sta cercando, premere Maius-+/–
per scorrere avanti e indietro le teste nota disponibili.

Si può anche scegliere il tipo di testa nota mentre si creano le note: basta selezionarlo dalla finestra 
Properties o digitare il comando rapido prima d’inserire l’altezza della nota. Il tipo di testa nota 
scelto sarà usato da tutte le note successive inserite, fino a quando lo si cambia di nuovo.

Poiché le teste nota sono personalizzabili, i comandi rapidi elencati in questo capitolo (e in tutto il 
Manuale Operativo) potrebbero non essere giusti se si sono cambiati i tipi di testa nota esistenti.

Teste nota comuni
Le teste nota a croce (comando rapido Maius+Alt+1 o xz1) indicano note dall’altezza incerta 
(in genere, per percussioni non intonate). Una nota a croce da 1/2 (minima) si può scrivere come 
una normale nota da 1/2 con una croce che l’attraversa in notazione d’avanguardia o come un 
rombo in notazione di batteria (comando rapido Maius+Alt+5 o xz5).

Le teste nota a rombo (comando rapido Maius+Alt+2 o xz2) indicano note diteggiate ma non 
suonate, come l’armonico di un arco (vedere Armonici in b Riproduzione) o (nella musica 
d’avanguardia) i tasti del piano premuti silenziosamente. Per gli armonici di chitarra, le note da 1/
4 e più brevi sono scritte con un rombo nero pieno (comando rapido Maius+Alt+6 o xz6).

Gli slash indicano le parti ritmiche di accordi per jazz, rock e musica commerciale e ce ne sono di 
due tipi: uno con gambo (comando rapido Maius+Alt+4 o xz4) e uno senza (comando rapido 
Maius+Alt+3 o xz3). Queste teste nota non sono né riprodotte né trasportate. In genere sono 
scritte sempre sulla linea centrale del rigo.
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Le note senza testa (comando rapido Maius+Alt+7 o xz7) indicano i ritmi nella musica con-
temporanea, sia perché una nota o accordo precedente si ripete sia perché (come la testa nota a 
croce) l’altezza è indefinita o improvvisata (note intere senza testa si vedono raramente).

Le note senza gambo (comando rapido Maius+Alt+8 o xz8) sono utili nella musica priva di 
ritmo, come il canto libero.

Le note silenti (comando rapido Maius+Alt+9 o xz9) hanno l’aspetto di normali teste nota, ma 
non sono riprodotte (ciò può essere utile in determinate situazioni).

Le teste nota “cue-size” (comando rapido Maius+Alt+10 r xz10) servono per mischiare teste 
nota normali e “cue-size” nello stesso accordo (per acciaccature normali vedere in seguito).  
Attenzione! L’uso di questo tipo di testa nota non rimpicciolisce anche gli oggetti associati alla nota 
(le alterazioni, ad esempio).


0 - normale

   
1 - croce

    2 - rombo

   
3 - movimento senza gambo


4 - movimento 5 - croce o rombo

   
6 - rombo nero e bianco

   
7 - senza testa


8 - senza gambo    9 - silenti   

10 - piccole    11 - barrate   


12 - barrate al contrario

   
13 - frecce in basso

   
14 - frecce in alto    15 - triangolo inverso

   


16–23 - note stilizzate

               

             23 è  19 (uso dei gambi in basso)  


24 - croce con piccolo cerchio    25 - notazione bacchetta 26 - croce grande

  
27 - slash grande senza gambo   


28 - slash grande con gambo    29 - croce (grassetto)    30 - spillo     
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Le teste nota attraversate da uno slash (comandi rapidi Maius+Alt+11/12 o xz11/12) si usano 
nella notazione di batteria, per indicare, ad esempio, colpi sul bordo del rullante (rim-shots).

Le teste nota con freccia in basso (comando rapido Maius+Alt+13 o xz13) e freccia in alto 
(comando rapido Maius+Alt+14 o xz14), adatte soltanto a note con i gambi rivolti rispettiva-
mente in alto e in basso, si usano per evidenziare note indefinite molto gravi o acute. Queste teste 
nota sono scritte senza linee aggiuntive.

Le teste nota 16–23 si usano per la musica con note “modellate”, conosciuta anche con il nome di 
musica per “arpa consacrata”, riportata in un libro americano di brani musicali scritto da B.F. 
White e E.J. King nel 1844. La tecnica si chiama “fasola” (cioè, fa – so – la, una sorta di acronimo) e 
utilizza teste nota dalla forma diversa per i vari gradi della scala. Per creare automaticamente 
questo tipo di notazione usare il plug-in Plug-in > Note e Pause > Applica note stilizzate – 
b Plug-in.

La testa nota 24 è una a croce alternativa con una testa nota più piccola da 1/2 (minima), usata tal-
volta al posto della testa nota 1. La testa nota 29 è un’altra testa nota a croce alternativa, con la 
croce più spessa.

La testa nota 25 si usa per la notazione di bacchetta Kodály.

La testa nota 26 si usa per le marching band e di solito indica a tutte le percussioni di suonare 
all’unisono.

Le teste nota 27 e 28 sono teste nota slash alternative, usate talvolta al posto delle teste nota 3 e 4. 
A differenza delle teste nota 3 e 4, di default queste teste nota sono impostate per essere riprodotte 
e trasportate, poiché talvolta anch’esse sono utilizzate per le percussioni. Per evitare che siano 
riprodotte o trasportate, b Modifica teste nota.

La testa nota 30 si usa qualche volta nella notazione percussiva per indicare un “ping” (un colpo 
particolare sul bordo del rullante).

Diverse dimensioni di teste nota
Se nello stesso accordo servono teste note normali e piccole, si deve crearle con il tipo di testa nota 
10. Per far diventare una singola nota o un intero accordo “cue-size”, usare invece il pulsante “cue” 
(comando rapido Invio) sul secondo layout del tastierino numerico (comando rapido F9), in 
modo che anche il gambo e tutti gli accenti e le articolazioni diventino piccoli – b Ornamenti.

Se nella partitura si preferisce avere una testa leggermente più grande usare il foglio manoscritto 
Vuoto (notes grandi) – b Foglio manoscritto – oppure importare lo stile house Standard 
(note grandi) in una partitura esistente – b House Style™.

Note in parentesi
Le parentesi (tonde) a qualsiasi testa nota (compresi gli ornamenti) s’aggiungono con il pul-
sante sul secondo layout del tastierino numerico (comando rapido F9) indicato a sinistra. 

Le parentesi si regolano automaticamente per includere alterazioni, ecc..
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2.27 Tonalità

b Trasporto intonazione.

Le tonalità visualizzate all’inizio di ogni sistema sono automatiche; sono regolate per soddisfare la 
chiave corrente, trasportate per gli strumenti trasportati e omesse per gli strumenti che in genere 
non le usano (la maggior parte delle percussioni, ad esempio).

Le uniche tonalità che si devono specificare sono quella iniziale ed ogni cambio di tonalità even-
tualmente presente lungo la partitura.

Creare le tonalità
Selezionare Crea > Alterazioni in chiave (comando rapido 
K) e cliccare sulla tonalità desiderata. Passare da maggiore a 
minore con i pulsanti circolari a sinistra. (La distinzione tra 
tonalità maggiori e minori è molto importante, quindi Sibe-
lius sa come indicare al meglio le alterazioni inserite via 
MIDI – per esempio, in LA minore preferisce scrivere RE#
invece di MIb e in DO maggiore preferisce MIb a RE#).

Selezionando, ad esempio, una nota o pausa e poi creando 
una tonalità, Sibelius la colloca automaticamente dopo 
l’oggetto selezionato. 

Creando un cambio di tonalità a metà di un brano, Sibelius 
precede automaticamente il cambio con una doppia stanghetta (che volendo si può cancellare).

Per cambiare la tonalità in un certo numero di misure e poi tornare a quella originale selezionare le 
misure nelle quali deve avere effetto la nuova tonalità prima di crearla; Sibelius crea la nuova tonal-
ità all’inizio della selezione e inserisce di nuovo quella originale alla fine.

Per trasportare la musica (oltre che cambiare la tonalità) usare invece il comando Note > Trasponi 
– b Trasporto intonazione.

Per creare una tonalità all’inizio della partitura, assicurarsi che non sia selezionato niente; selezion-
are Crea > Tonalità, scegliere la tonalità e cliccare all’inizio della partitura. Si può usare questo 
metodo anche per creare un cambio di tonalità con il mouse ovunque nella partitura.

Se la partitura è una trasportata, scegliere una tonalità all’altezza reale – che sarà trasportata auto-
maticamente per gli strumenti trasportati.

Spostare e cancellare i cambi di tonalità
I cambi di tonalità si possono spostare con il mouse o i tasti freccia.

Per cancellare la tonalità all’inzio della partitura, selezionarla nella finestra di dialogo File > Nuovo
quando si crea la partitura, oppure creare una tonalità Open key/Atonal, C major, o A minor e 
collocarla sopra una esistente.
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Per cancellare una tonalità in un punto qualsiasi (cioè un cambio di tonalità), selezionarlo e pre-
mere Canc. Per cancellare un cambio di tonalità che si trova all’inizio di un sistema, cancellare il 
cambio di tonalità d’avvertimento all’inizio del sistema precedente.

Tonalità d’avvertimento
Se una nuova sezione, brano o movimento della partitura inizia in una nuova tonalità, spesso si 
omette la tonalità d’avvertimento (che altrimenti apparirebbe alla fine del sistema precedente).  
È più facile farlo quando si crea la tonalità all’inizio del nuovo movimento: attivare l’opzione 
Nascondi nella finestra di dialogo Crea > Alterazioni in chiave.

Per nascondere la tonalità d’avvertimento dopo averla creata, selezionarla e scegliere Modifica >
Mostra o nascondi > Nascondi (comando rapido Ctrl+Maius+H o xXH). In ogni caso, assi-
curarsi che il sistema precedente termini con un break di sistema o pagina, altrimenti rifor-
mattando la partitura il cambio di tonalità nascosto potrebbe andare a finire a metà sistema e non 
sarà chiaro quando avviene. Per maggiori informazioni sull’occultamento di oggetti, 
b Nascondere oggetti.

Tonalità aperta/Atonale
Alcune partiture trasportate che apparentemente sono in DO maggiore non hanno tonalità, nem-
meno negli strumenti trasportati; il compositore ha omesso tutte le tonalità perché cambiano 
troppo spesso, la musica è in una scala/modo diverso da maggiore o minore (le due sole scale alle 
quali le tonalità sono destinate), oppure la musica è priva di un centro tonale ben definito.

Per usare questa notazione: Open key/Atonal in alto a destra nella finestra Crea > Alterazioni in 
chiave.

Si può tornare alla musica in tonalità più avanti nella partitura creando una normale tonalità (DO 
maggiore, ad esempio). Un classico caso è l’opera Rite of Spring di Stravinsky, in gran parte atonale 
ma con alcune parti in tonalità – la maggior parte degli strumenti trasportati non ha tonalità, ma in 
alcuni talvolta c’è.

Se la partitura utilizza una tonalità Open key/Atonal, bisognerà indicare opportunamente le 
alterazioni; su come indicare le alterazioni gli approcci sono vari:

* Al primo caso di nota diesis o bemolle in una misura, ma non a ripetizioni di quella nota nella 
stessa misura: è ciò che fa Sibelius di default.

* Ad ogni nota diesis o bemolle, ovunque essa appaia: per farlo, usare il plug-in Plug-in >
Alterazioni > Aggiungi Alterazioni a tutte le note diesis e bemolle.

* Su ogni nota, incluse quelle naturali: usare il plug-in Plug-in > Alterazioni > Aggiungi alterazi-
oni a tutte le note.

Per maggiori informazioni, b Plug-in.

Strumenti senza tonalità
I righi di percussioni non intonate non hanno mai tonalità, Timpani e Corno in genere non 
l’hanno, mentre Tromba e Arpa talvolta non l’hanno. Sebbene per tutte queste eccezioni comuni 
Sibelius abbia strumenti alternativi nella finestra Crea > Strumenti e righi, se si vuole specificare 
che qualche altro strumento non ha una tonalità:
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* Selezionare una misura nello strumento in questione e scegliere House Style > Modifica stru-
menti e ensemble.

* Cliccare Modifica Strumento, cliccare Si quando Sibelius chiede se si vuole continuare e poi 
cliccare Modifica Tipo Rigo nella finestra di dialogo che appare.

* Nella pagina Generale della finestra Modifica Tipo Rigo disattivare Tonalità/Accordatura.

* Cliccare OK, di nuovo OK ed infine Chiudi.

Per maggiori informazioni sulla modifica degli strumenti, b Modifica strumenti.

Tonalità enarmoniche
Talvolta, per semplificare la lettura di strumenti trasportati, una partitura presenta sia diesis che 
bemolle. Per esempio, se una partitura è in SI maggiore (reale) con 5 diesis, le trombe in SIb spesso 
non saranno scritte in DO# maggiore (7 diesis) ma nella tonalità equivalente enarmonica REb (5 
bemolle) più facile da leggere; Sibelius lo fa automaticamente quando nella pagina Chiavi e Alter-
azioni in Chiave della finestra di dialogo House Style > Regole tipografia è attiva l’opzione 
Trascrivi alterazioni in chiave nella partitura trasposta.

Per gli strumenti non trasportati (un’arpa, ad esempio) si può impiegare un altro trucco utile; in 
una partitura in SI maggiore, ad esempio, è meglio avere l’arpa scritta in DOb maggiore. Per farlo:

* Creare una tonalità in DOb maggiore per tutti i righi d’arpa usando l’opzione Un solo rigo (ved-
ere in seguito).

* Selezionare i righi d’arpa e scegliere Plug-in > Alterazioni > Semplifica alterazioni, che riscrive 
i righi d’arpa in DOb maggiore, ma lascia intatti tutti gli altri righi.

Tonalità multiple
In alcune partiture di musica contemporenea, per strumenti diversi si usano tonalità diverse (da 
non confondere con il caso più diffuso di strumenti trasportati che hanno diverse tonalità). Per 
creare una tonalità che si applica solo ad un rigo, quando la si crea attivare l’opzione Un solo rigo
nella finestra di dialogo Crea > Alterazioni in chiave. Questa opzione è utile anche per scrivere 
tonalità con molte alterazioni (per esempio, FA# maggiore), ove molti strumenti nella partitura 
potrebbero beneficiare del fatto di essere scritti nella tonalità enarmonica equivalente che utilizza i 
bemolle (per esempio, SOLb maggiore).

La spaziatura nota in altri righi del sistema può essere influenzata dall’inserimento di una tonalità 
su un solo rigo; per rimediare, selezionare la misura e scegliere Layout > Ripristina spaziatura 
nota (comando rapido Ctrl+Maius+N o xXN).

Opzioni Engraving Rules
La pagina Chiavi e Alterazioni in Chiave della finestra di dialogo House Style > Regole 
tipografia (comando rapido Ctrl+Maius+E o xXE) ha le solite “strane” opzioni; quella principale 
(e più interessante) è Bequadri precauzionali, che aggiunge bequadri d’avvertimento ai cambi di 
tonalità per cancellare diesis/bemolle presenti nella tonalità precedente.

Disattivando questa opzione, i bequadri d’avvertimento appaiono solo passando all’opzione C 
major, A minor o Open key/Atonal, poiché in questi casi (pensandoci bene) senza bequadri 
d’avvertimento sarebbe un pò difficile accorgersi del cambio di chiave.
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2.28 Tratti d’unione

I tratti d’unione sono linee grosse usate per unire note di breve durata in gruppi. Sibelius le unisce 
automaticamente in gruppi, sebbene talvolta sia meglio regolarle manualmente.

È possibile regolare i tratti d’unione in molte misure simultaneamente, o cambiarli nota per nota, 
comprese notazioni speciali (come i tratti d’unione incrociati sul rigo).

Gruppi dei tratti d’unione
Sibelius sceglie di default un raggruppamento ideale dei tratti d’unione per ogni tempo in chiave 
creato nella partitura, ma in base al contesto musicale è possibile formare gruppi diversi. I gruppi 
di tratti d’unione si possono cambiare sia per i nuovi tempi in chiave creati sia per passaggi musi-
cali esistenti.

* Per cambiare gruppi di tratti d’unione per un nuovo tempo in chiave selezionare Crea > Indi-
cazione tempo (comando rapido T), scegliere il tempo in chiave da creare e cliccare su Gruppi 
di tratti e pause.

* Per cambiare gruppi di tratti d’unione per un passaggio musicale esistente, vedere Reim-
postare i gruppi dei tratti d’unione in seguito.

In ogni caso, si apre una finestra di dialogo con le seguenti opzioni:

È possibile modificare i gruppi dei tratti d’unione per valori nota diversi in modo indipendente.  
I gruppi di tratti d’unione sono rappresentati dal numero di note in ogni gruppo, separato da vir-
gole, e devono andare a sommarsi al numero indicato accanto al box nella colonna Totale in Bat-
tute.
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Per esempio, nel tempo in chiave di 4/4 si potrebbe impostare l’opzione Raggruppa crome come, 
nel modo seguente:

Modificando i gruppi di tratti d’unione per un valore nota, i valori nota più brevi spesso ereditano 
gli stessi gruppi di tratti d’unione (tranne in 4/4 ove le note da 1/8 sono unite in due gruppi da 
quattro; si tratta di un caso particolare – vedere in seguito). Gruppi di tratti d’unione delle note da 
1/8 di (ad esempio) 5,2,1 generano gruppi di tratti d’unione di note da 1/16 di 10,4,2.

Volendo, si può evitare ciò impostando le altre opzioni nella finestra di dialogo, cioè Raggruppa 
semicrome diversamente e Raggruppa semibiscrome diversamente. Anche in questo caso, 
bisogna assicurarsi che i gruppi dei tratti d’unione si sommino nel numero Totale in Battute. 
Nell’esempio di 4/4, ecco alcune possibili combinazioni:

Per ogni tempo in chiave con un denominatore superiore a 8 (9/16, 15/32, ecc.) il valore nota più 
lungo che si può regolare è quello indicato dal denominatore (per esempio, in 9/16 non si possono 
regolare gruppi di tratti d’unione con note da 1/8 (croma) – di default, essi saranno sempre uniti in 
coppie; analogamente, in 15/32 non è possibile regolare gruppi con note da 1/16 (semicroma); 
questi seguiranno sempre i gruppi dei tratti d’unione di note da 1/8.

Tratti d’unione primari e secondari
I tratti d’unione primari sono quelli più lontani dalle teste delle note; i tratti d’unione secondari 
sono tutti gli altri, ad esempio:

Le note unite in tratti d’unione secondari (che chiameremo “sottogruppi”) devono sempre indicare 
il ritmo il più chiaramente possibile; ciò si ottiene dividendo i sottogruppi in base all’unità più pic-
cola del movimento. Nei tempi in chiave semplici, in generale, i sottogruppi si hanno ogni due note 
da 1/8 (crome) e nei tempi in chiave composti spesso i sottogruppi si hanno ogni tre note da 1/8. 
Sibelius gestisce questa complessa procedura, ma consente all’utente di definire i sottogruppi nelle 
finestre Gruppi di tratti e pause e Ripristina Gruppi Tratti, se necessario.

  
4,4

    
2,2,2,2

          
5,2,1

         














Gruppo di ottavi in:

                       

     

4,4 2,2,2,2 5,2,1

Gruppo di sedicesimi differenziati:
8,8 5,3,1,4,3 4,6,3,3

tratti d’unione primari

tratti d’unione secondari

         

reference.book  Page 153  Wednesday, April 16, 2008  4:28 PM



2. Notazioni

154

Per definire i sottogruppi, attivare l’opzione Suddividi i tratti di unione secondari per le note da 
1/16 (semicrome) e/o 1/32 (biscrome) e scrivere i sottogruppi separati da virgole, assicurandosi 
che si sommino al numero Totale in Battute. Per esempio, in 6/8 è possibile suddividere i gruppi 
dei tratti d’unione delle note da 1/16 in questo modo:

Sibelius permette solo ai tratti d’unioni primari di essere un tratto d’unione da 1/8 (croma), cioè un 
singolo tratto d’unione. In alcune situazioni i tratti d’unione primari devono essere di note da 1/16 
(semicroma); in tal caso, aggiungere il tratto d’unione extra usando la linea disponibile nella 
finestra di dialogo Crea > Linea (b Linee).

Reimpostare i gruppi dei tratti d’unione
Per raggruppare le note in tratti d’unione, selezionare le note come passaggio e scegliere Note >
Ripristina gruppi tratti; si apre una finestra di dialogo. Per reimpostare i gruppi dei tratti 
d’unione ai valori di default di Sibelius per il tempo in chiave prevalente, cliccare su OK senza 
eseguire alcuna modifica. Per raggruppare le note in base alle proprie esigenze, modificare le 
impostazioni nella finestra di dialogo (per i dettagli vedere Gruppi dei tratti d’unione) e clic-
care su OK.

Le impostazioni definite nella finestra di dialogo Note > Ripristina gruppi tratti non persistono 
nella partitura una volta applicate; se si modificano i valori nota delle note nelle misure reim-
postate, i gruppi dei tratti d’unione si reimpostano ai gruppi specificati nel tempo in chiave preva-
lente. Se necessario, si può creare un nuovo tempo in chiave con i gruppi dei tratti d’unione 
desiderati, cliccare su Sì quando Sibelius chiede se si desidera riscrivere le misure successive e poi 
cancellarlo al termine d’inserimento e modifica (stavolta rispondere No alla richiesta di riscrivere 
le misure successive).

Riutilizzare i gruppi dei tratti d’unione
Configurando i gruppi dei tratti d’unione per un tempo in chiave (7/8, ad esempio) quando lo si 
crea, questi gruppi rimangono per tutte le misure successive, fino a un cambio del tempo in chiave; 
non necessariamente, però, altri tempi in chiave di 7/8 da qualche altra parte nella partitura avr-
anno gli stessi gruppi dei tratti d’unione – la configurazione di gruppi dei tratti d’unione influenza 
solo quel particolare tempo in chiave. Tuttavia, se si desidera che altri tempi in chiave di 7/8 (da 
qualche altra parte nella stessa partitura) utilizzino gli stessi gruppi dei tratti d’unione, basta copi-
are il tempo in chiave. Per fare in modo che alcune misure in 7/8 usino un certo raggruppamento 
dei tratti d’unione (per esempio, 2+2+3) e altri ne usino un altro (per esempio, 3+2+2), creare due 
tempi in chiave di 7/8 con raggruppamenti diversi, quindi copiarli nelle rispettive misure o pas-
saggi, inserire la musica e poi cancellare tutti i tempi in chiave superflui (scegliendo No quando 
Sibelius chiede se si vuole riscrivere la musica).






Gruppo di ottavi in:
3,3     


Suddivisione dei tratti d’unione secondari:
2,2,2,2,2,2           
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Modifica dei tratti d’unione
Per regolare i tratti d’unione in singole posizioni (invece che definirli per tutta la partitura o in un 
passaggio) si possono usare i pulsanti sul terzo layout del tastierino numerico (comando rapido 
F10). Selezionare la nota(e) o ornamento(i) da correggere e scegliere il pulsante adatto:.

Tratti d’unione attraverso le pause
Sibelius colloca automaticamente i tratti d’unione attraverso le pause, sia in un gruppo che a ogni 
estremità, se necessario. Quando si crea un tempo in chiave (o si reimpostano i tratti d’unione di 
un passaggio esistente) usare le opzioni seguenti della finestra di dialogo Gruppi di tratti e 
pause:

* Tratti d’unione da/a pausa: consente a un gruppo di tratti d’unione di iniziare e/o finire con 
una pausa.

* Tratti d’unione sopra le pause: le pause non interrompono un gruppo di tratti d’unione se 
cadono all’interno del gruppo definito.

Ecco alcuni esempi pratici di queste opzioni:

Se le pause in mezzo a un gruppo unito si sovrappongono al tratto d’unione, si può spostare la 
pausa (selezionandola e premendo 3/2) o regolare l’altezza del tratto d’unione – vedere Ango-
lazione dei tratti d’unione. Se una pausa all’inizio o alla fine di un gruppo si sovrappone al 
tratto d’unione, nascondere la pausa (selezionandola e premendo Ctrl+Maius+H o xXH) e inser-
ire un simbolo di pausa adeguato, da collocare poi opportunamente (b Simboli).

Nelle partiture moderne, le pause nei tratti d’unione talvolta hanno dei “prolungamenti”: sono pic-
coli gambi che si estendono dal tratto d’unione alla pausa (o che s’interrompono vicino alla pausa). 
Sibelius attualmente non supporta questi prolungamenti, ma se servono si può ottenere qualcosa 
di molto simile definendo un nuovo tipo di testa nota silente nel quale si sostituiscono i simboli 
della testa nota con simboli di pausa e si usa questo tipo di testa nota al posto delle pause – 
b Modifica teste nota.

Interrompe il tratto d’unione dalla nota precedente.

Unisce il tratto d’unione alle note precedenti e successive.

Chiude il tratto d’unione corrente (cioè interrompe il tratto d’unione con la nota succes-
siva).

Separa la nota(e) da quelle a entrambi i lati.

Unisce la nota(e) a quella precedente con un singolo tratto d’unione (primario).

Tratto d’unione da/a pause

         
Tratto d’unione su pause
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Tratti d’unione attraverso stanghette, break di sistema e pagina
Per fare in modo che un tratto d’unione s’unisca alla nota prima della stanghetta precedente, selez-
ionare la nota all’inizio della misura, scegliere il terzo layout del tastierino numerico (comando 
rapido F10) e premere 8 sul pad numerico.

Se un tratto d’unione sopra una stanghetta s’interrompe in corrispondenza di un break di sistema o 
pagina, Sibelius consente al tratto d’unione di proseguire attraverso il break, come indica l’esempio 
seguente tratto dalla parte di clarinetto basso del Petrouchka di Stravinsky:

Per far continuare un tratto d’unione attraverso una stanghetta (e un break di sistema o pagina) 
usare il layout F10 del tastierino numerico per impostare l’ultima nota alla fine del sistema o pag-
ina a Start of beam (comando rapido 7 sul pad numerico) o Middle of beam (comando rapido 8
sul pad numerico) e la prima nota della misura sul sistema successivo in Middle of beam 
(comando rapido 8 sul pad numerico) o End of beam (comando rapido 9 sul pad numerico).

Per regolare l’angolazione del tratto d’unione spostare la maniglia sul gambo della nota più a destra 
nel gruppo del tratto d’unione prima del break e la maniglia sul gambo della nota all’estremità 
destra del tratto d’unione dopo il break. Se non si usano le posizioni Optical dei tratti d’unione 
(vedere Opzioni Regole tipografia), regolando la lunghezza del gambo di note all’inizio del 
tratto d’unione, s’influenza anche l’inclinazione del tratto d’unione. Se un tratto d’unione incrociato 
sul rigo è unito solo a una nota dopo il break, il tratto d’unione è orizzontale.

Unire le duine
Se una duina si trova in un gruppo, di solito interrompe il tratto d’unione a entrambi i lati, per 
mantenere il ritmo il più chiaro possibile. L’opzione Separa gruppi irregolari da note adiacenti
nella finestra Gruppi di tratti e pause (attiva di default) controlla questa funzionalità. Si consid-
eri il caso seguente:

Il gruppo di note a sinistra (default di Sibelius) è molto più chiaro del gruppo a destra, che non ha 
attiva l’opzione Separa gruppi irregolari da note adiacenti.

Unire gli ottavi (crome) in 4
Di default, Sibelius unisce quattro note da 1/8 (crome) in semplici tempi in chiave binari (es. 2/4, 
4/4, 2/2). Quattro note consecutive da 1/8 che cadono nelle divisioni del movimento sono unite tra 
loro, ma Sibelius spezza automaticamente i tratti d’unione se il ritmo nel gruppo cambia:

        
p ma marc., accompagnando
         

  


  


  


   


  

         3 3

                    3
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Per cambiare questa funzionalità occorre definire nuovi gruppi di tratti d‘unione (impostando, ad 
esempio, l’opzione Raggruppa crome come a 2,2,2,2, ecc.) quando si crea il tempo in chiave o si 
seleziona Note > Ripristina gruppi tratti per reimpostare i tratti d’unione di un passaggio esist-
ente. Inoltre, Sibelius non applica questa regola se è attiva l’opzione Tratti d’unione sopra le 
pause.

Angolazione dei tratti d’unione
Talvolta si deve regolare angolazione o posizione di un tratto d’unione per evitare che urti un orna-
mento o un altro oggetto, oppure perché essendo un editore musicale si ha una propria idea sulla 
posizione dei tratti d’unione. Per regolare più tratti d’unione è meglio sistemare le opzioni Regole 
tipografia (vedere Opzioni Regole tipografia) per controllarne in massa le angolazioni.

Per spostare un tratto d’unione, ingrandirlo (per vedere bene ciò che si sta facendo) e trascinarlo in 
alto o in basso con il mouse. Trascinando l’estremità sinistra si modifica l’altezza di entrambe le 
estremità del tratto d’unione e trascinando l’estremità destra se ne modifica l’angolazione. Invece 
di trascinare con il mouse si possono premere i tasti 3 o 2. Con la combinazione Ctrl+3/2 o X3/
2 si sposta il tratto d’unione di 0,25 spazi. Per regolare velocemente l’angolazione, selezionare il 
tratto d’unione e trascinarlo in alto o in basso (è come trascinare l’estremità sinistra del tratto 
d’unione).

Per far tornare un tratto d’unione alla sua posizione originale, selezionare Note > Ripristina 
posizioni gambi e tratti; si può farlo anche su un passaggio selezionato o una selezione multipla.

Regolare l’angolazione di un tratto d’unione equivale esattamente a regolare le lunghezze dei 
gambi ai quali è attaccato il tratto d’unione stesso.

Tratti d’unione orizzontali
In certa musica (percussiva, ad esempio) i tratti d’unione sono sempre orizzontali, mai angolati. Di 
default, sui righi di percussioni Sibelius genera sempre tratti d’unione orizzontali, ma se si desidera 
utilizzare questa convenzione anche su altri strumenti, modificare il rispettivo strumento in 
House Style > Modifica strumenti e ensemble. Nella finestra di dialogo Modifica Strumento, 
cliccare su Modifica Tipo Rigo e attivare l’opzione Tratti d’unione sempre orizzontali nella pag-
ina Note e Pause – b Modifica strumenti.

Invertire i tratti d’unione
Per spostare un tratto d’unione da sopra a sotto un gruppo di note – cioè invertire la direzione dei 
gambi di tutte le note nel tratto d’unione – selezionare una delle note e invertirla scegliendo 
Modifica > Inverti (comando rapido X); se non è chiaro come, vedere b Gambi e linee 
aggiuntive. Per tornare alla direzione originale del gambo, invertire di nuovo la stessa nota 
oppure selezionare il gruppo di note e scegliere Note > Ripristina posizioni gambi e tratti.

Se su una nota del tratto d’unione il comando Modifica > Inverti non funziona, selezionare tutte le 
note nel tratto d’unione e scegliere Note > Ripristina posizioni gambi e tratti, quindi invertire 
solo la prima nota.

Invertire i tratti d’unione parziali
Talvolta, un tratto d’unione parziale (detto anche “bandierina”) in un gruppo di note unite tra loro 
è rivolto a sinistra, mentre lo si vorrebbe rivolto a destra (o viceversa). Per invertirlo, selezionare la 
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nota e, nel pannello Notes della finestra di dialogo Finestra > Proprietà, attivare l’opzione Inverti 
tratto d’unione frazionale.

Tratti d’unione tra i righi
La musica per strumenti a tastiera spesso presenta note unite distribuite sulle due mani, così:

Per ottenere questo risultato:

* Inserire tutta la musica nel rigo che utilizza la maggior parte delle note distribuite sulle due mani 
– in questo caso il rigo superiore:

* Selezionare le note che dovranno passare al rigo inferiore (preferibilmente come selezione mul-
tipla) – in questo caso, il SI e i SOL sulle linee aggiuntive.

* Trasferirle al rigo inferiore selezionando Note > Note che incrociano righi > Sposta giù di un 
rigo (comando rapido Ctrl+Maius+2 o xX2).
Ovviamente, il comando Note > Note che incrociano righi > Sposta su di un rigo (comando 
rapido Ctrl+Maius+3 o xX3) trasferisce le note al rigo superiore.

* È possibile collocare i tratti d’unione sopra entrambi i righi (come il primo gruppo nella prima 
figura in alto) o tra i righi (come nell’ultimo gruppo) semplicemente invertendo adeguatamente 
le direzioni dei gambi (selezionando Modifica > Inverti- comando rapido X).
Non farlo trascinando con il mouse i gambi all’altro lato delle note – ciò non produrrà l’effetto 
previsto!

* Nella prima figura in alto, le ultime tre note gravi della mano sinistra sono state anche invertite 
per evitare collisioni con le note tra i due righi della mano destra.

Si noti inoltre che:

* Le note non devono avere per forza dei tratti d’unione per essere trasferite ad un rigo adiacente – 
il SI nell’esempio è una nota da 1/4 (semiminima); si possono trasferire anche pause.

* Le note possono passare solo ad un altro rigo dello stesso strumento.
* Si possono distribuire le note su tre righi inserendole nel rigo centrale, quindi trasferendole ai 

righi superiore e inferiore. (Non è necessario che le note rimangano sul rigo centrale!)
* Il passaggio delle note ad un altro rigo non influenza in alcun modo le voci in quel rigo. Un rigo 

può avere anche quattro voci più altre note trasferite ad esso da righi adiacenti!
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* Per molti aspetti, le note sono trattate come sul rigo originale – per esempio, trasportando un 
passaggio nel rigo originale sono trasportate anche tutte le note trasferite da quel rigo.

* In alcuni casi, trasferendo le note ad un altro rigo si potrebbero incontrare troppe alterazioni. 
Per risolvere questo problema selezionare le alterazioni e nasconderle – b Alterazioni.

Tratti d’unione tra note sullo stesso rigo
Nelle vecchie partiture (in particolare nella musica per violino) se un gruppo di 
note è molto grave e poi molto acuto (o viceversa), talvolta il tratto d’unione si 
trova a metà strada tra le note, con alcuni gambi diretti in alto e altri in basso, 

come indicato nella figura a sinistra.

Per ottenere questo in Sibelius:

* Creare le note, selezionarle e cliccare sul pulsante d’inizio tratto d’unione ( ) nel terzo layout del 
tastierino numerico (F10) per toglierle dal tratto d’unione.

* Nascondere le bandierine delle note, selezionandole e scegliendo Modifica > Mostra o 
Nascondi > Nascondi.

* Creare una linea d’unione fittizia nella finestra di dialogo Crea > Linea (comando rapido L) e 
regolare adeguatamente la lunghezza dei gambi rivolti in alto e in basso.

Attenzione! La linea d’unione fittizia può essere sostituita se si riformatta la partitura, quindi biso-
gna crearla solo una volta terminata la formattazione della partitura.

Dividere gli accordi tra i righi
Nelle musica per tastiera in generale si separano le note di alcuni accordi tra i due righi:

Per farlo, scrivere ogni nota dell’accordo diviso sul rigo nel quale 
appare usando una voce adatta; per esempio, nel caso della figura 
accanto, inserire le note acute degli accordi divisi nella voce 2 sul 
rigo superiore e le note gravi nella voce 1 sul rigo inferiore. Usare 
poi il comando Modifica > Inverti (comando rapido X) per riv-
olgere verso il basso i gambi delle note sul rigo inferiore. Infine, 

trascinare in basso l’estremità di ogni gambo nota della mano destra, in modo che corrisponda a 
quello della nota suonata con la mano sinistra.

Nel caso di accordi con note più brevi di 1/4 (semiminima), nascondere le bandierine o i tratti 
d’unione selezionandoli e premendo Ctrl+Maius+H o xXH, quindi estendere i rispettivi gambi 
invertendoli (se necessario) con il comando Modifica > Inverti, per adattarli al resto dell’accordo.

Tratti d’unione a ventaglio
Talvolta, nella musica contemporanea, da un singolo tratto d’unione “emer-
gono” tratti d’unione supplementari che indicano un accelerando. Usando le 
duine “a nido” (b Terzine e altri tuplet) è possibile creare tratti d’unione a 
ventaglio che sono scritti e riprodotti correttamente. Per scrivere la figura rit-

mica indicata a sinistra, ad esempio:

* Creare la prima nota scrivendone una da 1/8 (croma).
* Premere Ctrl+3 o X3 per creare una terzina.
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* Inserire la seconda nota della terzina e premere Ctrl+3 o X3 per creare un’altra terzina, che si 
“annida” automaticamente nella prima.

* Inserire la seconda nota della terzina “annidata” e premere di nuovo Ctrl+3 o X3 per creare 
un’altra terzina “annidata”. Non preoccuparsi se i numeri di terzine e parentesi quadre creano un 
po’ di confusione.

* Una volta inserite tutte le note, selezionare la misura e aprire il pannello Notes della finestra di 
dialogo Properties.

* Impostare il box per la mano sinistra (left-hand) alla base del pannello in None e quello per la 
mano destra (right-hand) in No bracket.

* Ogni nota avrà ora una bandierina, quindi selezionare ciascuna di esse e scegliere Modifica >
Mostra o Nascondi > Nascondi (comando rapido Ctrl+Maius+H o xXH) per nasconderle – 
vedere Nascondere tratti d’unione, bandierine e code.

* A questo punto scrivere i tratti d’unione supplementari usando la linea d’unione nella finestra di 
dialogo Crea > Linea (comando rapido L). Si consiglia d’ingrandire l’immagine, per vedere bene 
ciò che si sta facendo.

Con questa procedura di base è possibile anche creare ritenuti a ventaglio e figure con più o meno 
note di così.

Nascondere tratti d’unione, bandierine e code
Per nascondere un tratto d’unione, selezionarlo (non selezionare la nota) e scegliere Modifica >
Mostra o Nascondi > Nascondi (comando rapido Ctrl+Maius+H o xXH). Come per gli altri 
oggetti, i tratti d’unione nascosti appaiono in grigio chiaro se è attiva l’opzione Vista > Oggetti 
nascosti (comando rapido Ctrl+Alt+H o zXH), e invisibili se tale opzione non è attiva.

Allo stesso modo si possono anche nascondere bandierine e code, per esempio su singole note da 
1/8 (crome): selezionare la bandierina o coda e scegliere Modifica > Mostra o Nascondi >
Nascondi. Se ci sono note con bandierine unite da tratti d’unione (1/8 col punto (croma) seguito 
da una nota da 1/16 (semicroma), ad esempio), si può nascondere la bandierina indipendente-
mente dal tratto d’unione principale.

Per esempio, nascondendo il tratto d’unione su una coppia di note da 1/8 (crome) esse non si tras-
formano in note da 1/4 (semiminime) – assumono solo l’aspetto di note da 1/4!

Opzioni Regole tipografia
La pagina Tratti e Gambi della finestra di dialogo House Style > Regole tipografia consente di 
controllare le posizioni dei tratti d’unione e il loro aspetto, come segue:

Posizioni dei tratti d’unione
La maggior parte delle opzioni Beam Positions sono applicate solo se è attiva l’opzione Posizioni 
Optical per i tratti d’unione. Disattivando l’opzione i tratti d’unione appaiono come nelle ver-
sioni di Sibelius 3 e precedenti (quindi non in posizioni particolarmente felici!).

Se l’intervallo tra la prima e l’ultima nota di un tratto d’unione non supera l’ottava, si può specifi-
care un’angolazione “ideale” per ogni intervallo con l’opzione Inclinazione di default per inter-
vallo.  
Per alcuni tratti d’unione tale angolazione deve essere regolata, perché essi non possono apparire 
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in determinate posizioni (tra due linee del rigo, ad esempio). Inoltre, quando due note sono molto 
vicine tra loro e generano un tratto d’unione ripido, l’angolazione può dover essere ridotta del 
valore specificato dal parametro Massimo gradiente tratto: Fino a un 8va, 1 in n.

Massimo gradiente tratto: 1 in n: controlla l’angolazione di intervalli superiori all’ottava.  
Il tratto d’unione segue l’angolazione tra la prima e l’ultima testa nota (sempre che non sia più rip-
ida di questo valore).

Se le note a metà di un tratto d’unione curvano verso il tratto d’unione (producendo una forma 
concava) è normale che il tratto d’unione sia orizzontale. Ciò si può controllare con l’opzione Oriz-
zontale se note al centro interferiscono di n spazi (che specifica la distanza alla quale una 
nota si deve prolungare lungo una linea immaginaria tra la prima e l’ultima nota per far diventare 
orizzontale il tratto d’unione).

Evita collisioni: evita alcuni casi di “cunei” in gruppi di note da 1/8 (crome). Si tratta di triangoli 
bianchi nei quali i tre lati sono rappresentati da un tratto d’unione, un gambo e una linea del rigo e 
che sono considerati fastidiosi da alcuni editori (ad altri invece non interessano): per evitare questi 
“cunei”, i gambi devono essere allungati (per alcuni musicisti sono peggiori da leggere dei cunei” 
stessi). Questa opzione quindi è del tutto soggettiva.

Le lunghezze dei gambi specificate dal parametro Lunghezza di default gambo in genere sono 
inferiori a quelle delle note normali (e sono ulteriormente accorciate per note molto acute o gravi). 
Tuttavia, ciò è smentito dal fatto che i gambi sono allungati nuovamente (se necessario) per 
spostare il tratto d’unione nella posizione ideale. Si può controllare le lunghezze dei gambi con il 
parametro Lunghezza minima n spazi alla base della pagina (il quale influenza sia le note unite 
dai tratti d’unione sia quelle singole).

Di default, i tratti d’unione attraverso il rigo sono sempre orizzontali (se è attiva l’opzione Posiz-
ioni Optical per i tratti d’unione) e sono collocati tra due righi; per angolarli bisogna trascinarli 
di volta in volta con il mouse.

Aspetto del tratto d’unione
Le opzioni in Aspetto tratto sono auto-esplicative; esse controllano spessore e separazione delle 
linee del tratto d’unione e stabiliscono se i gruppi di note in un tratto d’unione possono iniziare con 
una pausa.

L’opzione Tratti d’unione francesi è forse quella più interessante: i gambi delle 
note nel gruppo unito dai tratti d’unione toccano solo il tratto d’unione più 
interno, come indica la figura a destra. Questa convenzione è particolarmente dif-
fusa nella musica pubblicata in Francia (da qui il nome).

Per usare i tratti d’unione francesi nella partitura, attivare l’opzione Tratti d’unione francesi nella 
pagina Tratti e Gambi della finestra di dialogo House Style > Regole tipografia (comando 
rapido Ctrl+Maius+E o xXE).

   

reference.book  Page 161  Wednesday, April 16, 2008  4:28 PM



2. Notazioni

162

2.29 Tremolo

b Percussioni.

Il termine “tremolo” indica note ripetute suonate velocemente. Il tremolo a una nota riguarda una 
singola nota ripetuta; un tremolo a due note rappresenta due note alternate; una rullata (buzz roll) 
è un particolare tipo di tremolo usato per le percussioni non intonate.

Tremolo a una nota
Il tremolo a una nota è scritto con dei tratti sul gambo della nota o 
accordo, per esempio:

Per scriverlo, scegliere il numero di tratti da applicare alla nota dal 
terzo layout del tastierino numerico (prima o dopo aver creato la 
nota).

Per aggiungere un tremolo a una nota o accordo dopo averli creati 
selezionare la nota/accordo e scegliere il numero di tratti dal terzo 
layout del tastierino numerico (digitare 1/2/3/4/5 per 1/2/3/4/5 
tratti).

Per rimuovere il tremolo selezionare lo stesso pulsante del tastierino 
numerico.

Nel tremolo a una nota il numero di divisioni per nota talvolta è 
indicato da più staccati sopra la nota, oltre che dai tratti sul gambo. 

Gli staccati multipli si aggiungono con i simboli – b Simboli.

Tremolo a due note
Il tremolo a due note si scrive con tratti simili a quello d’unione tra due note o accordi:

Sulla prima nota/accordo scegliere il numero di tratti dal terzo layout del tastierino numer-
ico (digitare 1/2/3/4/5 per 1/2/3/4/5 tratti) e cliccare sul pulsante per il tremolo a due note 
indicato a sinistra (comando rapido Invio); si può farlo prima o dopo aver creato la seconda 

nota.

Ogni nota è scritta come se durasse per tutto il tremolo (sem-
bra cioè che la durata delle note sia doppia). Sibelius raddop-
pia automaticamente i valori nota; per scrivere un tremolo a 

Tremolo a una nota
Scrivere un tratto di tremolo su 
una nota da 1/4 o più significa 
che deve essere suonata come 
due note da 1/8. Scrivere due 
tratti significa che bisogna 
suonarla come quattro note da 
1/16, e così via. Si usano anche 
tre e quattro tratti ad indicare 
che la nota si deve ripetere il più 
velocemente possibile (tremolo 
“non misurato”) per indicare 
una rullata, ad esempio.

Su una nota da 1/8 o più corta, 
un tratto di tremolo indica che 
deve essere divisa in due, due 
tratti che deve essere divisa in 
quattro, e così via.

Tremolo a due note
Sono tratti d’unione tra due note o 
accordi: indicano che devono essere 
suonate ripetutamente alternan-
dosi; tratti multipli hanno lo stesso 
significato del tremolo a una nota.
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due note che dura una nota da 1/2, quindi, scrivere due note da 1/4 e usare il terzo layout del tast-
ierino numerico per aggiungere il tremolo:

Il tremolo si disattiva selezionando di nuovo gli stessi pulsanti del tastierino numerico.

Il tremolo a due note si può scrivere tra i righi (attraverso una o più note sull’altro rigo – b Tratti 
d’unione) e attraverso le stanghette.

Per regolare l’angolazione di un tremolo a due note trascinare i gambi delle note a lato. Se il trem-
olo a due note è scritto tra due note intere (semibrevi) trascinare la linea del tremolo stessa (è come 
trascinare il gambo della prima nota – sempre che ci sia!).

La pagina Notes and Tremolos della finestra di dialogo House Style > Regole tipografia
(comando rapido Ctrl+Maius+E o xXE) ha tre opzioni che definiscono l’aspetto del tremolo a 
due note (nel caso si desideri cambiarlo):

Rullate (Z sul gambo)
Le rullate sono scritte con un simbolo Z sul gambo di una nota o accordo, ad indicare un 
colpo multiplo, come si usa in genere nella musica percussiva (vedere a destra). 
Per aggiungere una rullata ad una nota o accordo dopo averli creati selezionare la nota o 
accordo e cliccare sul pulsante 6 nel terzo layout del tastierino numericotastierino numer-
ico (comando rapido F10). 
Sibelius riproduce le rullate come una serie di tremolo veloce. b Percussioni.

Anomalie nella scrittura del tremolo
Nel tremolo a due note, l’insolita convenzione di scrivere ogni nota con la durata totale del tremolo 
provoca alcune anomalie.

Nel XIX secolo si usava una strana convenzione per cui i valori nota erano raddoppiati solo se il 
tremolo durava una nota da 1/4 (semiminima) o più; si potevano trovare quindi coppie di ottavi 
(crome) in tremolo e note da 1/2 (minime), ma mai note da 1/4 (semiminime).

Inoltre, un’altra abitudine che sopravvive ancora oggi è la seguente: per scrivere un tremolo di due 
note che dura due misure da 4/4 si scrivono due note intere (semibrevi) con un tremolo attraverso 
la stanghetta invece di raddoppiare i valori nota a due doppie note intere (brevi). La maggior parte 
delle persone non fà caso a questa bizzarra eccezione.

Prima Dopo

Tra i gambi Tremolo esterno che
tocca i gambi

Tocca i gambi
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2.30 Voci

Cosa sono le voci?
La musica in genere ha una singola “voce” (o “layer”) di note, accordi e pause su ogni rigo. I gambi 
sono rivolti in alto o in basso secondo l’altezza delle note:

Quando la musica è a due voci, invece, il rigo ha due scritture musicali indipendenti che possono 
avere ritmi diversi. Le due voci si distinguono scrivendo i gambi rivolti in alto nella Voce 1 e in 
basso nella Voce 2:

Inoltre, ci sono anche due set diversi di pause, quelle superiori appartenenti alla Voce 1 e quelle 
inferiori per la Voce 2. Tuttavia, per semplicità, si scrive solo una pausa quando ce ne sono due 
uguali in entrambe le voci.

Nella musica per chitarra e organo (e talvolta da qualche altra parte) ci può essere anche una terza 
voce (con i gambi rivolti in alto) e perfino una quarta (con i gambi rivolti in basso).

Uso delle voci
Sibelius consente di avere fino a quattro voci indipendenti per rigo colorate così: Voce 1 in blu 
scuro, Voce 2 in verde, Voce 3 in arancio e Voce 4 in rosa.

Le note, ovviamente, possono essere solo in una singola voce, mentre testi e linee assegnati al rigo 
si possono trovare su una singola voce, una combinazione di voci o tutte le voci: ciò non influenza 
l’aspetto visivo della partitura, ma può essere utile in riproduzione (per applicare una forcina a 
tutte le voci del rigo, ad esempio).

Per cambiare voce usare il mouse (cliccare sui pulsanti voce nel tastierino numerico), il submenu 
Modifica > Voce o i comandi rapidi Alt+1/2/3/4 o z1/2/3/4 (il comando rapido per “tutte le 
voci” è Alt+5 o z5).

Per impostare la voce di una nota (selezionata o che si sta per creare), cliccare il rispettivo pulsante 
voce nel tastierino numerico (o usare il rispettivo comando rapido dalla tastiera del computer).

Per applicare un testo o linea a tutte le voci, premere Alt+5 o z5 (o cliccare sul pulsante All nel 
tastierino numerico). Se però si deve applicare un testo o una linea ad una combinazione di voci, 
bisogna cliccare con il mouse sui pulsanti nel tastierino numerico invece di usare i comandi rapidi; 
se un testo o una linea è nella Voce 1 e si clicca sul pulsante Voce 2 sul tastierino numerico, 
quell’oggetto apparterrà sia alla Voce 1 che alla Voce 2 (e nella partitura si colorerà in blu chiaro).

Non è possibile creare automaticamente testi o linee in una combinazione di voci: inizialmente 
sono sempre creati in una singola voce; si possono poi modificare le voci in seguito.

Solo una voce

Voce 1

Voce 2
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Altri oggetti come chiavi, tonalità, testi di sistema (per esempio, segni di tempo) e linee di sistema 
(per esempio, rit./accel., 1° e 2° finale) si applicano sempre a tutte le voci, quindi appaiono sempre 
in blu chiaro (oggetti del rigo) o porpora (oggetti di sistema) una volta selezionati. Non ha impor-
tanza quale voce si sceglie per creare questi oggetti.

Visualizzare il colore degli oggetti
Spesso è utile vedere sempre a quale voce appartengono le note, non solo quando sono selezionate. 
Per vederlo, attivare l’opzione Vista > Colori note > Colori voce.

Iniziare una nuova voce di note
Per iniziare una nuova voce con la tastiera o l’inserimento step-time:

* Selezionare una nota, pausa o altro oggetto (testo o linea) alla posizione in cui si desidera inziare 
con una nuova voce.

* Premere N (comando rapido per Note > Inserisci Note) seguito da Alt+2 o z2 per la Voce 2; il 
cursore diventa verde.

* Inserire la nota come al solito; appare nella Voce 2; il resto della misura è completato dalle 
opportune pause.

* Ora si può continuare ad aggiungere le note nella Voce 2 come al solito.

Per iniziare una nuova voce con il mouse:

* Con niente selezionato nella partitura scegliere il pulsante voce, il valore nota e tutte le altre pro-
prietà della nota dal tastierino numerico.

* Cliccare nella partitura alla posizione in cui iniziare la nuova voce; Sibelius inserisce la nota e 
completa il resto della misura con le pause nella nuova voce.

* Continuare ad inserire le note nella nuova voce come al solito.

Per iniziare la registrazione Flexi-time in una nuova voce scegliere la voce nella finestra Note >
Opzioni Flexi-time (comando rapido Ctrl+Maius+O o xXO). Se nella partitura la voce c’è già 
selezionare una pausa in quella voce ed avviare Flexi-time come sempre – b Flexi-time™.

Misure parzialmente in due voci
Se non si vogliono due voci alla fine della misura cancellare (Canc) le pause indesiderate alla fine, 
per nasconderle.

Per far iniziare la Voce 2 parzialmente in una misura che già contiene note di un’altra voce inserire 
con il mouse la nota della Voce 2 alla posizione in cui si vuole farla iniziare. Altrimenti, inserire le 
pause nella Voce 2 dall’inizio della misura seguite dalle note e poi cancellare (Canc) le pause.

In ogni caso, dove sono state cancellate le pause le note nella Voce 1 torneranno ad avere i gambi 
rivolti sia in alto che in basso.

Cancellare la Voce 2
È possibile rimuovere parti delle misure nella Voce 2 cancellando le pause (come descritto in pre-
cedenza). Tuttavia, per cancellare un’intera misura della Voce 2 basta inserire una misura di pausa 
nella Voce 2 dal secondo layout del tastierino numerico e poi cancellarla (Canc).

Per rimuovere un passaggio in una determinata voce usare i filtri – b Filtri e Trova.
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Unire le voci
Per unire tutte le note di un passaggio in più voci in una singola voce selezionare il passaggio e 
scegliere la voce desiderata dal tastierino numerico o usare l’opzione Modifica > Voce (comando 
rapido Alt+1/2/3/4 o z1/2/3/4):

Non è possibile unire voci con tuplet – Sibelius ometterà una delle voci con tuplet.

Unire i righi usando le voci
Per ridurre la musica da due (o più) righi, ognuno dei quali usa una singola voce a un singolo rigo 
a più voci usare la funzione Arrange (b Arrange™), a meno che si voglia avere un controllo 
totale sulla riduzione risultante; in tal caso, procedere così:

Supponiamo di ridurre due righi di violino a un solo rigo di violino; ecco come fare:

* Crere il nuovo rigo di violino (destinazione).
* Selezionare il rigo originale (sorgente) come selezione di passaggio da far diventare Voce 1 

(gambi in alto) sul rigo di destinazione (circondato da un singolo box blu chiaro).
* Alt+clic o z-clic sulla musica nel rigo di destinazione.
* Selezionare l’altro rigo di destinazione come selezione di passaggio (quello da far diventare Voce 

2 con i gambi in basso).
* Scegliere Modifica > Filtro > Voce 1 (comando rapido Ctrl+Maius+Alt+1 o xzX1); la selezi-

one del passaggio è convertita in una selezione multipla (il box blu chiaro scompare e solo le 
teste nota si colorano in blu).

* Scegliere Modifica > Voce > 2 (comando rapido Alt+2 o z2); tutte le note selezionate nel rigo 
sorgente passano nella Voce 2.

* Infine, Alt+clic o z-clic sulla musica nel rigo di destinazione.

Il passo importante nella procedura precedente è l’operazione di filtro (b Filtri e Trova) che 
converte la selezione di passaggio in una selezione multipla. Copiando le note di una selezione di 
passaggio della Voce 2 su un altro rigo, si sostituisce la musica esistente sul rigo di destinazione – 
perché le selezioni di passaggi sostituiscono sempre la musica esistente, mentre le selezioni multi-
ple aggiungono materiale alla musica esistente. Per maggiori infromazioni su questo tipo di oper-
azione, b Selezioni e passaggi.

Dividere le voci
Talvolta è utile dividere un passaggio scritto in una singola voce su due o più voci (per esempio, se 
è stata suonata musica polifonica in una singola voce in Flexi-time o è stato importato un file 
MIDI.

Prima Dopo
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iPer dividere la musica della Figura 1 in due voci e ottenere la Figura 3:

* Selezionare la musica da dividere come passaggio.
* Selezionare Modifica > Filtro > Nota inziale o Note singole (comando rapido Ctrl+Alt+B o

zXB) e scegliere Voce 2 sul tastierino numerico o Modifica > Voce > 2 (comando rapido Alt+2
o z2); la musica diventa come quella indicata in Figura 2.

* Infine, cambiare i valori nota per risolvere note legate superflue (o usare il plug-in Combina 
note e pause legate – b Plug-in); si otterrà la Figura 3.

Non è possibile dividere voci con tuplet – Sibelius ometterà una delle voci con tuplet.

Voci 3 e 4
Aggiungere le Voci 3 e 4 come la Voce 2. Per avere tre voci si possono usare le Voci 1+2+3 o 1+2+4 
dipende dalla direzione dei gambi che si vuole dare alle voci; nelle Voci 1 e 3 i gambi sono rivolti in 
alto, quelli delle Voci 2 e 4 puntano in basso.

Non ci sono regole particolari su come collocare tre o più voci; tuttavia, potrebbe essere necessario 
spostare le note in orizzontale per evitare collisioni. Vedere Voci incrociate.

Scambiare le voci
Se s’inizia a inserire musica nella voce sbagliata, invece di scartarla e ripartire da capo si può selez-
ionare la musica come un passaggio scambiare le voci.

Le varie opzioni sono in Modifica > Voce. In genere si scambiano le Voci 1 e 2, per le quali si può 
usare il comando rapido Maius-V.

Copiare le voci
Per copiare una singola voce da un rigo che contiene note in più di una voce selezionare il passag-
gio da copiare e usare, ad esempio, Modifica > Filtro > Voce 2 (comando rapido 
Ctrl+Maius+Alt+2 o xzX2) per filtrare solo le note nella Voce 2. A questo punto, si può 
eseguire un Alt+clic o z-clic su di esse in un altro rigo, come al solito.

Sibelius copia note e pause nella stessa voce di quella dalla quale provengono; per copiare da una 
voce all’altra...

Copia da una voce a un’altra
Per farlo, si scambiano le voci; per copiare alcune note della Voce 1 nella Voce 2:

* Scambiare le Voci 1 e 2 nell’originale che si sta copiando, in modo che le note copiate vadano a 
finire nella Voce 2. Per farlo, selezionare la musica come passaggio e scegliere Modifica > Voce >
Scambia 1 e 2 (comando rapido Maius-V).

Figura 1 Figura 2

Figura 3
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* Selezionare le note della Voce 2 da copiare selezionando un passaggio e filtrandolo per avere la 
Voce 2, come descritto in Copiare le voci.

* Copiare le note, che finiranno nella Voce 2 come quelle della voce dalla quale provengono.
* Scambiare nuovamente le Voci 1 e 2 nel passaggio originale.

Pause
Quando in voci multiple ci sono pause, Sibelius le scrive automaticamente sopra e sotto le rispet-
tive normali posizioni, in modo che sia chiaro a quali voci appartengono. Le pause si possono tras-
cinare ancora in alto o in basso, oppure spostare con i tasti freccia se danno fastidio ad altre voci.

Un particolare: quando si cancellano le pause (nella Voce 2, ad esempio) esse si nascondono ma 
non sono rimosse completamente; la spaziatura nota, quindi, può essere più ampia del normale se 
le pause nascoste sono inferiori ad altri valori nota simultanei. Questo raramente è un problema, 
ma se si è preoccupati, attivare l’opzione Vista > Oggetti nascosti e cancellare (Canc) le pause 
nascoste (visualizzate in grigio).

Nascondere le voci
In alcuni casi, può essere utile nascondere le note in una o più voci (per esempio, se si vuole che la 
partitura mostri solo un brano scritto che però sia riprodotto con armonie nascoste). Per farlo, 
inserire le armonie in una voce diversa da quella della melodia e poi usare i filtri (b Filtri e 
Trova) per selezionare tutte le note nella voce(i) extra e poi scegliere Modifica > Mostra o 
nascondi > Nascondi (comando rapido Ctrl+Maius+H o xXH) per nasconderle.

Voci incrociate
Sebbene in genere le note nella Voce 1 siano più acute di quelle in Voce 2, non sempre è così; le voci 
si possono incrociare – se contengono accordi possono perfino interagire tra loro. Sibelius cerca di 
collocare automaticamente le due voci in modo da evitare collisioni. Tuttavia, con tre o più voci, le 
collisioni sono probabili poiché non c’è una regola su dove collocare la terza o quarta voce.

In questi casi è bene regolare la posizione orizzontale di note, pause e accordi:

* Selezionare la nota, accordo o pausa da spostare.
* Aprire la pagina Generale della finestra Proprietà.
* Digitare la distanza (in spazi) alla quale spostare la nota nel box X – numeri positivi per 

spostarla a destra e negativi per spostarla a sinistra.
* Per spostare solo i punti ritmici attaccati alla nota, selezionarli e trascinarli a sinistra o destra 

con il mouse.

Opzioni Engraving Rules
Le regole per posizionare le note in voci multiple sono molto complesse e non sempre facili da 
interpretare. Sibelius, tuttavia, ha tre regole alternative di posizionamento nota disponibili nella 
pagina Note e Tremolo della finestra di dialogo House Style > Regole tipografia (comando 
rapido Ctrl+Maius+E o xXE). La regola di default Version 2 è quella raccomandata, ma si può 
usarne anche una di quelle “vecchio stile” scegliendole dalla finestra di dialogo.
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3.1 Lavorare con i testi

b Stili di testo comuni, Modifica stili di testo, Filtri e Trova.

v Testi.

Questo capitolo descrive nei dettagli i vari metodi di creazione e modifica dei testi in Sibelius. Per 
una semplice introduzione, vedere la Guida.

Creare rapidamente un testo
Ci sono vari metodi rapidi per creare un testo:

* Innanzitutto è meglio selezionare una nota vicina al punto in cui deve apparire il testo, quindi 
digitare i comandi rapidi Ctrl+E o XE, Ctrl+T o XT e Ctrl+L o XL per avere i tre stili di testo 
più comuni, vale a dire: Espressione, Tecnica e Linea di parole1.

* Altri stili di testo con comandi rapidi sono: Linea di parole 2 (Ctrl+Alt+L o zXL); Simbolo 
accordo (Ctrl+K o XK per “akkordo”) e Tempo (Ctrl+Alt+T o zXT).

* Se c’è una nota o oltro oggetto selezionato, Sibelius crea automaticamente il testo in quel punto 
della partitura; se non è selezionato niente, il puntatore del mouse cambia colore, ad indicare che 
“contiene” un oggetto; cliccare nella partitura per inserire il testo.

* Per scritte standard come cresc. usare i menu con le scritte utili – vedere Menu scritte.
* Se si usa molte volte lo stesso testo, copiarlo con un Alt+clic o z-clic o eseguire copie multiple 

tenendo premuto Maius per inserire il testo copiato alla posizione verticale di default (per inser-
ire gli stessi segni dinamici su ogni strumento, ad esempio) – b Selezioni e passaggi.

* Si può copiare un testo nel clipboard e poi incollarlo da qualche altra parte nella stessa partitura 
o in un’altra (o a/da un altro programma – vedere Copiare linee di testo e testi tra pro-
grammi diversi.

* Si può anche copiare il cursore stesso, per iniziare un nuovo frammento di testo. Trovare sullo 
schermo un testo nello stile desiderato, doppio-clic su di esso per far apparire il cursore e 
Alt+clic o z-clic da qualche altra parte per iniziare un nuovo testo nello stesso stile.

Menu scritte
Per risparmiare tempo, Sibelius ha menu interni di scritte, da digitare quando si crea il testo. Ogni 
stile di testo ha il proprio menu scritte. Per esempio, Expression genera un menu di segni dinamici 
(ecc.) e Chord symbols offre varie opzioni per realizzare qualsiasi simbolo d’accordo.

Per avere il menu scritte, clic-destro (Windows) o Control-clic (Mac) del mouse mentre si crea o 
modifica un testo. Alcune scritte e caratteri del menu hanno comandi rapidi; vedere b Menu e 
comandi rapidi o i menu stessi per un elenco completo.

È possibile modificare i menu scritte (oppure creare menu personalizzati) assegnando i propri 
comandi rapidi alle scritte – vedere Creare e modificare i menu scritte.
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Modificare il testo
I tasti di modifica testo sono come quelli di altri programmi, con alcuni tasti extra; i principali 
sono:

* Per modificare un oggetto di testo esistente, doppio-clic del mouse su di esso o premere Invio 
(sulla tastiera principale del computer).

* Per interrompere la modifica del testo premere Esc.
* Per selezionare tutto il testo nell’oggetto di testo corrente premere Ctrl+A o XA.
* Per una nuova linea durante la modifica premere Invio (sulla tastiera del computer).
* Per fare il testo in grassetto/normale cliccare B (comando rapido Ctrl+B o XB) nel pannello 

Testo della finestra Proprietà. Questo (e corsivo/sottolineato) influenza il testo che si sta per dig-
itare, una porzione di testo selezionata o l’intero oggetto(i) di testo (se selezionato).

* Per fare il testo in corsivo/normale cliccare I (comando rapido Ctrl+I o XI) nel pannello Testo
della finestra Proprietà.

* Per resettare uno stile di testo al suo valore di default mentre lo si modifica: Ctrl+Alt+Spazio o
^z-Spazio.

* Per fare il testo sottolineato/normale cliccare U (comando rapido Ctrl+U o XU) nel pannello 
Testo della finestra Proprietà; in musica il testo sottolineato si usa molto raramente.

* Per cambiare font o dimensione del testo cambiare il valore nel pannello Testo della finestra 
Proprietà (sebbene, in genere, si modifica lo stile di testo).

* Per altri comandi e ulteriori dettagli vedere b Menu e comandi rapidi.

Per modificare font/grassetto/corsivo/sottolineato/dimensione solo di una porzione di testo è meg-
lio usare le opzioni nel pannello Testo della finestra Proprietà. Tuttavia, per regolazioni più estese, 
ci sono metodi molto più efficaci:

* Per cambiare il font utilizzato per tutto il testo nella partitura (per esempio, cambiare il font di 
titolo, nomi strumento, parole, istruzioni tecniche ecc. con una sola operazione) selezionare 
House Style > Modifica tutti i font, e scegliere un nuovo Font di testo principale.

* Per cambiare tutto il testo della partitura in un particolare stile di testo, bisogna modificare 
invece lo stile di testo stesso (b Modifica stili di testo), perché questa operazione cambia 
automaticamente tutto il testo e anche il nuovo testo che si crea in seguito con quello stile. 
Per cambiare il font delle parole, ad esempio, modificare lo stile di testo piuttosto che cambiare 
manualmente tutte le parole.

* Per modificare gran parte del testo, ma non tutto (per un ritornello in corsivo, ad esempio) 
definire un nuovo stile di testo basato su quello esistente più simile ed usare quello (vedere 
Cambiare lo stile del testo esistente se nella partitura è gia stato inserito del testo).

Selezionare una linea di testo
Per selezionare tutto il testo su un rigo in uno stile particolare, selezionare un singolo oggetto di testo 
e scegliere Modifica > Seleziona > Seleziona altro (Ctrl+Maius+A o xXA). Ciò consente di:

* Spostare tutti gli oggetti insieme con il mouse o i tasti freccia.
* Copiare il testo nel clipboard per incollarlo da qualche altra parte nella partitura o in un altro 

programma (vedere in seguito).
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* Allinearli se vanno fuori allineamento (parole e simboli accordi, ad esempio): usare i comandi 
Layout > Allinea in una fila (Ctrl+Maius+R o xXR) o Layout > Ripristina posizione
(Ctrl+Maius+P o xXP) – b Layout e formattazione.

Copiare linee di testo e testi tra programmi diversi
In Sibelius gli oggetti di testo si possono copiare in molti modi:

* Nella stessa partitura o in partiture diverse, con un Alt+clic o z-clic (tenendo prenuto Maius
per collocare il testo alla posizione verticale di default dello stile di testo) o con i comandi 
Modifica > Copia e Modifica > Incolla – il secondo è molto utile con le parole (b Parole).

* In un altro programma (Microsoft Word, ad esempio): selezionare il testo da copiare, usare 
Modifica > Copia (Ctrl+C o XC) per copiarlo nel clipboard, passare all’altro programma e usare 
il comando Modifica > Incolla (in genere, Ctrl+V o XV) per incollare il testo.

Copiando simultaneamente più oggetti di testo in un altro programma, essi sono incollati uno 
dopo l’altro, con uno spazio tra ciascuno di essi; per le parole, sillabe separate della stessa parola 
sono incollate con dei trattini che le separa – b Parole. Copiando in un altro programma, i font 
ecc. sono ignorati; i segni dinamici e le note dei segni di metronomo, quindi (che usano il font di 
testo musicale definito nella finestra di dialogo House Style > Modifica tutti i font), non appar-
iranno come previsto in un documento di Word (ad esempio), a meno che si corregga il font in 
seguito.

Per copiare il testo da altri programmi in Sibelius:

* Selezionare il testo e copiarlo nel clipboard con un Modifica > Copia (in genere, Ctrl+C o XC).
* Passare a Sibelius e creare un cursore di testo adatto (per esempio, selezionare una nota e pre-

mere Ctrl+T o XT per il testo Technique).
* Selezionare Modifica > Incolla (Ctrl+V or XV) per incollare il testo.

Incollare le parole da altri programmi in Sibelius è leggermente diverso – b Parole.

Cambiare lo stile del testo esistente
Per cambiare lo stile di testo di un oggetto di testo esistente selezionare il testo e aprire il pannello 
Testo della finestra di dialogo Proprietà; qui si può cambiare lo stile di testo da un menu a tendina 
con le seguenti limitazioni:

* Non si può cambiare un testo del rigo in testo di sistema, e viceversa; inoltre:
* Non è possibile cambiare le parole in uno stile di testo non di parole, e viceversa.

Nascondere il testo
Per nascondere il testo (in genere, segni dinamici e altri segni di riproduzione) selezionare il testo 
da nascondere e scegliere Modifica > Mostra o nascondi > Nascondi (comando rapido 
Ctrl+Maius+H o xXH). Per ulteriori dettagli, b Nascondere oggetti.

Qualsiasi testo che segue un carattere tilde (~) è nascosto automaticamente da Sibelius e non è 
stampato. Normalmente si usa solo per scrivere messaggi MIDI (b Messaggi MIDI).

Comando Reset Position
Layout > Ripristina posizione (Ctrl+Maius+P o xXP) restta il testo alla sua posizione di default. 
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Resettare la forma
Per riportare un oggetto di testo al proprio font o dimensione di default definiti in House Style >
Modifica stili di testo (perché, ad esempio, il font è stato cambiato o parte del testo è stata tras-
formata in corsivo), selezionarlo e scegliere Layout > Ripristina aspetto (Ctrl+Maius+D o
xXD).

Testo a sinistra del sistema
Se si colloca il testo a sinistra di un sistema, probabilmente è per specificare quali musicisti suo-
nano uno strumento; in tal caso, vedere b Strumenti.

Tuttavia, se c’è una ragione particolare per scrivere il testo a sinistra del sistema, si può farlo ma 
bisogna inserire un break di sistema alla fine del sistema precedente, per fare in modo che il testo 
rimanga dov’è se si riformatta la musica. b Break - Interruzioni.

Testo tra i righi
Quando si crea un testo tra i righi con il mouse (come le dinamiche per la tastiera), Sibelius imma-
gina il rigo nel quale inserirlo in base alla posizione verticale di default dello stile di testo 
(b Posizioni di default). Ciò in genere produce un buon risultato – per esempio, creando le 
parole tra i righi, Sibelius decide di inserirle nel rigo superiore, perché le parole normalmente 
appartengono a quel rigo. Tuttavia, collocando il testo tra due righi, assicurarsi d’inserirlo sul rigo 
corretto (b Attaccature) altrimenti il testo sarà mal interpretato se si sposta il rigo o si crea una 
parte.

Evitare di collocare la porzione di un testo tra due strumenti separati ma applicandolo a entrambi 
(in ogni caso non è una buona notazione); altrimenti, avendo parti separate per gli strumenti, solo 
uno di essi prenderà il testo. È bene scrivere una porzione di testo tra le due mani di uno stru-
mento a tastiera, perché entrambe le mani andranno a finire nella stessa parte.

Porzioni di testo multiple
Spesso servono porzioni di testo l’una accanto all’altra su note diverse (diteggiature o sillabe di 
parole lunghe come cres – cen – do). In tutti i casi come questo, si devono usare porzioni di testo 
separate: non digitare il tutto come un frammento di testo con uno spazio in mezzo. Il motivo è che 
se si riformatta la musica bisognerà avvicinare o allontanare i frammenti separati.

Per digitare una parola lunga in sillabe separate su più misure usare un linea tratteggiata dalla 
finestra di dialogo Crea > Linea (comando rapido L) al posto dei trattini, in modo che quando 
cambia la spaziatura tra le sillabe appaiono più o meno tratti della linea. (In effetti è questo il modo 
in cui funzionano i trattini nelle parole).

Creare oggetti speciali con il testo
Una funzione oscura (ma talvolta utile) di Sibelius è avere caratteri speciali di oggetti, come segni 
di prova, tempi in chiave e numeri misura che si creano con gli stili Crea > Testo > Testo speciale.

Questo concetto, altrimenti incomprensibile, è ben illustrato dall’esempio seguente:

Supponiamo che si desideri iniziare la partitura con un segno denominato START. Sibelius non 
permette d’inserirlo come un normale segno di prova, perché non fa parte di una sequenza alfabet-
ica o numerica. Una soluzione complicata sarebbe creare uno stile di testo completamente nuovo 
per una grande box di testo e usarlo per digitare la parola START.
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È sufficiente invece usare il comando Crea > Testo > Testo speciale > Segni di prova; esso crea 
una porzione di testo che non è un segno di prova vero e proprio, ma utilizza lo stesso stile di testo 
dei segni si prova e quindi assomiglia ad un segno di prova (e per molti versi si comporta così). 
Digitando START con lo stile Segni di prova, il testo appare grande e in grassetto in un box, è 
duplicato più in basso nella partitura (sopra gli archi, ad esempio) ed appare anche automatica-
mente in tutte le parti. Bello vero?

Per creare oggetti speciali in questo modo si possono usare vari stili di testo:

* Tempi in chiave: per creare bizzarri tempi in chiave Ferneyhoughesque come un 5/6 (si crea il 
tempo in chiave su ogni rigo).

* Segni di prova: per scrivere segni di prova speciali non in sequenza (sebbene ci sia un’opzione 
automatica per ristabilire la sequenza del segno di prova).

Da qui in poi le opzioni diventano meno significative:

* Numeri pagina: per scrivere i numeri di pagina in un’edizione di musica antica.
* Lettere/Numeri tablatura: poco utili, poiché non è chiaro perché se ne dovrebbero usare di 

speciali.
* Gruppi irregolari: per formati insoliti come “3 in 2.”

Creare e modificare i menu scritte
* Selezionare la pagina Menu contestuali della finestra di dialogo File > Preferenze (menu Sibe-

lius in Mac; comando rapido Ctrl+, o X,).
* Cliccare su un menu scritta esistente da modificare, oppure inserire il nome di un nuovo menu 

scritta nel campo Nome menu e cliccare Nuovo sotto l’elenco dei menu scritta.
* Per cambiare il nome di un menu scritta nuovo o esistente inserire il nuovo nome nel campo 

Nome menu e cliccare Applica.

* Per aggiungere una nuova scritta a un menu cliccare sul pulsante Nuovo sotto l’elenco Parole, 
digitarlo nel box Testo e cliccare Applica.

* Per cambiare una scritta nel menu, selezionarla nell’elenco, modificarla nel box Testo e cliccare 
Applica.

* Per cambiare l’ordine delle scritte nel menu usare i pulsanti Sposta su e Sposta giù.

* Durante la creazione o modifica di una scritta si può assegnare un comando rapido: cliccare nel 
box Scorciatoia e digitarlo. Si può assegnare un comando rapido a piacere, ma attenzione a non 
usare una combinazione di tasti già utilizzata dal sistema operativo (non usare, ad esempio, 
Ctrl+F4 in Windows o zXM su Mac).

* Cliccare Usa caratteri di testo musicali nel caso (improbabile) che si digitino i caratteri musi-
cali dal font di testo musicale (definito nella finestra di dialogo House Style > Modifica tutti i 
font – b Font musicali); è per scritte come mf. Quando si modifica un menu scritta i carat-
teri appaiono in un font di testo normale, quindi potrebbero essere diversi da come saranno 
quando li si crea dal menu scritta (nei menu scritta Simboli accordo o Basso figurato, ad 
esempio).

* Per cancellare una scritta dal’elenco, selezionarla e cliccare Cancella sotto l’elenco di scritte.
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* Per eliminare un intero menu scritta, selezionarlo e cliccare Cancella sotto l’elenco dei menu 
scritta.

* Al termine cliccare OK.

Se è stato creato un nuovo menu scritta e si vuole assegnarlo a uno stile di testo andare nella pagina 
General della finestra di dialogo dello stile di testo Modifica stile di testo (b Modifica stili di 
testo) e impostare l’opzione Menu contestuale al menu creato.

Per configurare comandi rapidi personalizzati diversi da quelli per i menu scritta, b Menu e 
comandi rapidi.

Caratteri speciali
Oltre alle scritte, molti dei menu scritta hanno anche caratteri speciali, come f , e, ^, e %.

La maggior parte di essi è del font di testo musicale (Opus Text), indipendentemente dal font che si 
usa per i caratteri standard. Si può cambiare il font usato – b Font musicali. I caratteri per i 
simboli accordo in genere sono quelli del font Opus Chords; si può cambiarlo modificando lo stile 
di testo Simbolo accordo. I caratteri del basso figurato sono del font Opus Figured Bass.

Quando si creano scritte in lingua straniera possono servire lettere accentate, alcune delle quali 
sono disponibili nei menu scritta (vedere b Menu e comandi rapidi per un elenco completo di 
comandi rapidi per le lettere accentate). Sibelius usa il set carattere standard Unicode™, quindi i 
caratteri speciali come le lettere accentate sono trasferiti automaticamente tra Mac e Windows.

Su Mac è possibile usare anche la tavolozza Caratteri per inserire visivamente i caratteri speciali: 

* Per attivare la tavolozza Caratteri, doppio-clic su Internazionale in Preferenze di Sistema.
* Cliccare sulla pagina Menu Tastiera e attivare Gamma Carat-

teri nell’elenco dei metodi d’inserzione disponibili. 
* Selezionare Mostra Gamma Caratteri dall’elenco dei dispositivi 

d’ingresso nella barra dei menu (come indicato a destra); appare 
la finestra Gamma Caratteri. 

* Scegliere il carattere da inserire e cliccare Inserisci. Il carattere 
s’aggiunge all’oggetto di testo corrente che si sta modificando in 
Sibelius.
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3.2 Stili di testo comuni

b Lavorare con i testi, Parole, Simboli accordo, Basso figurato e numeri Romani, 
Numeri misura, Numeri pagina, Segni di prova.

Sibelius ha molti stili di testo da usare nelle partiture. Questo capitolo descrive nei dettagli molti di 
questi stili, mentre alcuni sono descritti a parte in altri capitoli – vedere sopra.

Cos’è uno stile di testo?
Nelle partiture si usano molti tipi di testo diversi: parole (sotto il rigo); segni d’espressione (in cor-
sivo e in genere sotto il rigo, tranne quando ci sono le parole e allora sono sopra); titoli (grandi, in 
grassetto e centrati in cima alla pagina), e così via.

Ogni tipo di testo può usare vari font, formattazione (grassetto, corsivo e, raramente, sottolineato), 
giustificazione (allineamento a sinistra, centrato o a destra) e posizionamento (il testo può appar-
ire sopra/sotto un rigo o tutti i righi, oppure in cima o in fondo alla pagina). Tutte queste 
impostazioni insieme costituiscono uno stile di testo.

Poiché Sibelius ha stili di testo per ciascuno di questi tipi di testo da scrivere nella partitura, non è 
necessario che sia l’utente a impostarne uno: basta scegliere lo stile di testo adeguato e Sibelius pro-
durrà il testo ideale collocandolo al posto giusto sulla pagina.

L’altro vantaggio degli stili di testo è che per cambiare qualcosa nell’aspetto del testo sulla partitura 
– ingrandire tutte le parole o fare in modo che le indicazioni di tempo siano in un altro font, ad 
esempio – basta semplicemente cambiare stile di testo; Sibelius aggiornerà automaticamente tutte 
le scritte nella partitura che adottano quello stile di testo.

Per sapere come modificare gli stili di testo esistenti in Sibelius e crearne di nuovi, b Modifica 
stili di testo.

Tre tipi di testo
In Sibelius ci sono tre tipi di testo:

* Testo del rigo: si applica a un singolo rigo (in genere sono le istruzioni per uno strumento).
* Testo di sistema: si applica a tutti i righi della partitura (sebbene possa essere visualizzato anche 

solo sopra uno o due di essi) e appare in tutte le parti (se ce ne sono) – di solito sono istruzioni di 
tempo o di prova.

* Testo per pagina vuota: si può creare solamente su una pagina vuota (in genere istruzioni di 
direzione o altre indicazioni importanti).
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Stili di testo principali
La tabella seguente elenca i più importanti stili di testo e il loro impiego:

Nome Usato per …

Te
sti

 d
el 

rig
o

Expression …scrivere segni dinamici e d’espressione, (ad esempio, mp, cresc. e legato). 
Comando rapido : Ctrl+E o XE

Technique …scrivere tecniche d’esecuzione (ad esempio, “mute,” “pizz.”, ecc.). 
Comando rapido : Ctrl+T o XT

Lyrics line 1, Lyrics line 2 etc. …scrivere le parole nella musica vocale – b 3.3 Parole 
Comando rapido : Ctrl+L o XL (Line 1), Ctrl+Alt+L o zXL (Line 2)

Chord symbol …scrivere i simboli degli accordi (ad esempio, Cm7) – b 3.4 Simboli accordo 
Comando rapido: Ctrl+K o XK

Plain text …scrivere blocchi di parole, note editoriali, ecc..

Roman numerals …scrivere simboli accordo con inversioni in numeri Romani – b 3.5 Basso figurato 
e numeri Romani

Figured bass …illustrare gli strumenti continui nella musica Barocca – b 3.5 Basso figurato e 
numeri Romani

Fingering …scrivere le diteggiature (ad esempio, nella musica per tastiera, ottoni o archi).

Guitar fingering (p i m a) ...scrivere le diteggiature nella musica per chitarra.

Boxed text …scrivere particolari tecniche esecutive (ad esempio, per le percussioni).

Small text …scrivere determinate tecniche d’esecuzione.

Nashville chord numbers …scrivere, ad esempio, 6/3 – b 3.4 Simboli accordo

Footnote …scrivere note editoriali alla base di una singola pagina (non è come Footer).

Te
sti

 d
i s

ist
em

a

Title …scrivere il titolo del brano o movimento

Subtitle …scrivere i sottotitoli (ad esempio, per un movimento particolare).

Composer …scrivere il nome del compositore (in genere tutto in maiuscolo) o arrangiatore/orches-
tratore (in minuscolo).

Lyricist …scrivere il nome del paroliere, poeta o altra fonte di testo.

Dedication …scrivere una dedica (ad esempio, Al coro di S. Giovanni).

Tempo …scrivere i segni tempo (ad esempio, Andante). 
Comando rapido: Ctrl+Alt+T o zXT

Metronome mark …scrivere i segni di metronomo e le modulazioni metriche.

Copyright …scrivere nella partitura le proprie linee di copyright.

Header etc. …scrivere un’intestazione su ogni pagina.

Footer etc.. …scrivere un piè di pagina su ogni pagina (non è come Footnote).

Rit./Accel. …scrivere indicazioni tempo particolari.

Te
sti

 p
ag

in
a 

vu
ot

a Composer (on blank page) …scrivere il nome del compositore su una pagina di titolo a inizio partitura.

Dedication (on blank page) …scrivere una dedica su una pagina di titolo a inizio partitura.

Plain text (on blank page) …scrivere strumentazione, istruzioni di direzione, ecc. su pagine vuote.

Subtitle (on blank page) …scrivere un sottotitolo su una pagina vuota.

Title (on blank page) …scrivere il titolo del lavoro su una pagina di titolo a inizio partitura.
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Expression
Questo stile di testo serve per scrivere i segni dinamici e altre indi-
cazioni simili per i musicisti (per esempio, legato, vivace, marcato); 
le scritte sono in corsivo.

I segni dinamici come mf o sfz sono caratteri speciali in grassetto 
che usano un particolare font di “testo musicale” (b Font musi-
cali), di solito Opus Text. È possibile creare questi caratteri dal 
menu scritta (clic-destro o Control-clic), oppure tenendo premuto 
Ctrl o X e digitando le lettere, per esempio Ctrl+MF o XMF per 
avere un mf. L’eccezione è la lettera z, per la quale si deve digitare 
Ctrl+Maius+Z o xXZ (perché Ctrl+Z o XZ è il comando rapido 
per la funzione Modifica > Undo).

Tutti i segni d’espressione più comuni si possono creare rapida-
mente dal menu scritta, evitando di digitarli in lettere.

Sebbene quasi tutti i segni dinamici che si creano nella partitura 
siano riprodotti automaticamente, le scritte cresc. e dim. non lo 
sono (perché non è chiaro quanto forte/piano devono essere ripro-
dotti) – per riprodurli, creare le opportune forcine e nasconderle 
(b Linee). Un paio d’effetti speciali, per esempio fp, non sono 

riprodotti molto fedelmente, ma se la buona riproduzione di questo particolare segno è impor-
tante, si può ottenere l’effetto desiderato con i messaggi MIDI.

I segni dinamici si applicano solo a un rigo (tranne nella musica per tastiera – b Riproduzione), 
ma si possono aggiungere rapidamente a più righi in un paio di modi:

* Copiare il segno dinamico con Modifica > Copia (comando rapido Ctrl+C o XC), selezionare i 
righi sui quali copiarlo e premere Ctrl+V o XV per incollarlo su tutti i righi selezionati. Questa 
operazione si chiama “copia multipla” – b Selezioni e passaggi

* Selezionare il segno dinamico e premere Alt+clic o z-clic per copiarlo su altri righi; tenendo 
premuto Maius durante un Alt+clic o z-clic si colloca ogni segno dinamico alla rispettiva 
posizione verticale di default; per allinearli in un secondo momento, selezionare la misura nella 
quale si trovano, scegliere Modifica > Filtro > Dinamiche (comando rapido Maius+Alt+D o
xzD) e usare il comando Layout > Allinea in una colonna (comando rapido Ctrl+Maius+C
o xXC).

Technique
Questo stile serve per scrivere istruzioni tecniche che in genere non sono scritte in corsivo (per 
esempio, mute, pizz., a2, solo, tremolo). È possibile anche scrivere simboli musicali (come le alter-
azioni) in stile Technique usando il menu scritta (utile per la musica d’arpa, ad esempio).

Metronome mark
I segni di metronomo sono q = 72 e spesso si integrano con un segno di tempo (vedere Tempo). 
Per scrivere un segno di metronomo:

Posizione dei testi 
Expression eTechnique
Il testo Expression è sotto il rigo al 
quale si applica e sopra in righi 
con parole. Il testo Technique è 
sopra il rigo. Nella musica in due 
voci, gli stili Expression e Tech-
nique vanno sopra il rigo per la 
Voce 1 e sotto per la Voce 2.  
Se il testo Expression o Technique 
si applica a entrambe le mani di 
uno strumento a tastiera, deve 
andare tra i righi.

Il lato sinistro del testo Expression 
in genere è appena a sinistra della 
nota alla quale si applica.

Per scrivere una f su un rigo (da 
evitare) per chiarezza la cross-bar 
deve essere collocata sopra una 
linea del rigo. Analogamente, p 
su un rigo deve essere centrato su 
uno spazio.
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*  Selezionare un oggetto nella partitura (es. nota o pausa) ove inserire il segno di metronomo (in 
genere, la prima nota di una misura) e scegliere Crea > Testo > Segno di metronomo; appare 
un cursore lampeggiante (se nella partitura non è selezionato niente, selezionare Crea > Testo >
Segno di metronomo e cliccare nella partitura per inserire il testo).

* Scrivere le note in segni di metronomo con un clic-destro (Windows) o Control-clic (Mac) per 
avere il menu scritta (altrimenti usare il tasto Ctrl o X insieme al pad numerico).

* Digitare = 60 o un altro valore; premere la barra spaziatrice a un’estremità del segno =.

Quando si digita un segno di metronomo dopo uno di tempo (per esempio, Allegro q = 60) è 
meglio non inserirlo usando due frammenti separati di testo (testo tempo più testo del segno di 
metronomo) poiché i due oggetti di testo separati potrebbero toccarsi se le note in una misura si 
avvicinano tra loro. Scrivere invece tutto il testo in stile di testo Tempo e quando si arriva al segno 
di metronomo disattivare l’opzione Bold e preferibilmente scegliere una dimensione del carattere 
più piccola nel pannello Text della finestra Properties.

Sibelius ha un plug-in che consente d’inserire i segni di metronomo alla partitura battendo il 
tempo desiderato con il mouse – vedere Imposta indicazione di metronomo in b Plug-in.

Modulazioni metriche
Le modulazioni metriche (conosciute anche come segni “allo stesso tempo”) si usano per illustrare 
la relazione tra i valori delle note in tempi diversi, per esempio:

Le modulazioni metriche sono molto usate anche per indicare un andamento “swing”:

Per creare una modulazione metrica selezionare Crea > Testo > Altro testo di sistema > Modulazi-
one metrica. Il menu scritta per questo stile di testo ha tutte le modulazioni metriche più comuni e i 
segni “swing” entrambi con e senza parentesi; questo stile di testo usa il font Opus Metronome.

Tempo
La scritta Tempo di solito appare all’inizio della partitura (per esem-
pio, Allegro non troppo) e spesso è associata a un segno di met-
ronomo (vedere sopra). È più rapido crearli dalla finestra di dialogo 
File > Nuovo quando si configura la partitura per la prima volta 
(sebbene sia possibile inserirli facilmente in seguito).

Sibelius riconosce un’ampia gamma di segni Tempo e li riproduce 
anche se non si crea un segno di metronomo – b Dizionario di 
riproduzione. Come sempre, un clic-destro (Windows) o Control-
clic (Mac) del mouse mentre si crea la scritta Tempo apre un menu di 
scritte utili. Non digitare come testo le scritte rit. e accel., ma usare le 

linee rit./accel. (b Linee) poiché esse sono riprodotte. Attenzione, i segni A tempo e Tempo I
non sono riprodotti, quindi per tornare al tempo originale creare un segno di metronomo (che 
volendo si può nascondere).

Tipografia di un testo di 
tempo o metronomo
Cambi tempo improvvisi iniz-
iano con la maiuscola: Molto 
vivace, Tempo I, Più mosso. 
Cambi tempo graduali iniziano 
la minuscola: poco rit., accel..

Se una scritta Tempo o un segno 
di metronomo è sopra un tempo 
in chiave, il lato sinistro di 
entrambi è allineato.
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In partiture più lunghe, i testi in stile Tempo e Metronome appaiono automaticamente non solo in 
alto, ma anche duplicati in basso (normalmente sopra la tastiera o gli archi). Le due copie si riflet-
tono l’una con l’altra ogni volta che se ne modifica una – per esempio, modificando una porzione 
di testo Tempo entrambi i testi cambiano simultaneamente.

Tuttavia, ogni scritta può essere trascinata in alto e in basso o cancellata in modo indipendente. 
Ciò è utile per evitare collisioni con una nota acuta sopra il rigo superiore che non c’è più in basso 
nella partitura. Per trascinare o cancellare entrambe le scritte insieme, farlo su quella in alto. Per 
eliminare una delle scritte più in basso, selezionarla e premere Canc; per riportarle, selezionare 
quella in alto e scegliere Layout > Ripristina aspetto (comando rapido Ctrl+Maius+D o xXD).

Si può definire quante copie di testo fare apparire e sopra quali righi – b Modifica stili di testo e 
House Style™. Altri oggetti di sistema si comportano in modo simile (i segni di prova, ad esempio).

Parole e simboli accordo
Questi sono stili di testo un pò particolari b Parole e Simboli accordo.

Titolo, Sottotitolo, Compositore, Parolieri, Dedi-
che
La maggior parte di queste scritte si crea rapidamente dalla 
finestra di dialogo File > Nuovo quando si configura la partitura 
per la prima volta (sebbene sia possibile inserirle in seguito). 
Di default, questi stili di testo sono allineati a sinistra, al centro o a 
destra sulla pagina; essi si possono trascinare solo in alto e in basso 
(non a sinistra o destra).

I titoli si possono inserire in ogni sistema nella partitura, non solo 
all’inizio – potrebbe servire un nuovo titolo all’inizio di una nuova 
sezione, brano o movimento, ad esempio – sebbene per farlo sia 
meglio inserire un break di sistema o pagina alla fine del sistema 
precedente (per mantenere separate le sezioni).

Talvolta (in un lavoro di copia da un libro, per esempio) è comodo 
collocare questi stili di testo a una posizione fissa sulla pagina invece di fare riferimento al rigo 
superiore. Per farlo, impostare ad un valore fisso per ogni stile di testo il parametro mm from top 
margin nella pagina Vertical Posn della finestra di dialogo House Style > Modifica stili di testo 
(comando rapido Ctrl+Maius+Alt+T o xzXT).

Diteggiatura
(In Crea > Testo > Altro testo di rigo). Questo stile è per le diteggiature di tastiera, ottoni e archi. 
Premere Invio (sulla tastiera principale) dopo ogni numero. Premendo la barra spaziatrice si 
avanza alla nota successiva.

Sibelius può inserire automaticamente la diteggiatura d’ottoni e archi e riposizionare le diteggiau-
ture per evitare note – b Plug-in.

Testo piccolo e in box
Questi stili sono per altre istruzioni di tipo tecnico; il testo nel box è utile per istruzioni importanti 
(come i cambi di strumento, ad esempio).

Regole di diteggiatura
Nella musica per tastiera, la diteg-
giatura è sopra le note per la 
mano destra e sotto per la mano 
sinistra. Terzine e altri tuplet 
devono spostarsi all’altro lato delle 
note per evitare collisioni (se nec-
essario).

Le diteggiature sono centrate in 
orizzontale sulle note. Diteggia-
ture successive non hanno bisogno 
di essere allineate in fila – vanno 
in alto e in basso seguendo 
l’altezza delle note per essere 
abbastanza vicino ad esse.
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Copyright
Normalmente, la linea di copyright è scritta sulla prima pagina di una partitura. Questo stile di 
testo è centrato in fondo alla pagina e appare in tutte le parti (selezionare Crea > Testo > Altro 
testo di sistema > Copyright). Il simbolo © è disponibile nel menu scritta.

Questo testo è da creare sulla prima misura della partitura – infatti, sebbene appaia in fondo alla 
pagina, in realtà è assegnato alla prima misura in modo da rimanere sempre sulla prima pagina 
anche se si riformatta la partitura.

Piè di pagina (Footnote)
Questo stile colloca il testo in fondo alla pagina. Per creare una appunto a piè di pagina, selezionare 
una nota nel rigo e misura alla quale si desidera faccia riferimento il piè di pagina e scegliere Crea >
Testo > Altro testo di rigo > Piè di pagina. Il cursore appare comunque in fondo alla pagina.

Si può segnalare l’appunto a piè di pagina con un asterisco o un numero usando (ad esempio) lo 
stile di testo Technique sopra il rigo. Il piè di pagina inserito resta sempre nella stessa pagina della 
misura alla quale fa riferimento e appare solo nella parte del rigo in questione.

Intestazione e Intestazione (dopo la prima pagina)
Le intestazioni sono scritte in cima a ogni pagina – il nome del brano o dello strumento in una parte, 
ad esempio.

Intestazione (in Altro Testo Accollatura) scrive lo stesso testo su ogni pagina; cambiando 
l’intestazione su una pagina, essa cambia automaticamente su tutte le altre pagine. Intestazioni e 
piè di pagina appaiono sulle pagine ove li si inserisce e su tutte quelle successive, ma non nelle 
pagine precedenti. Normamente, quindi, si colloca l’intestazione/piè di pagina sulla prima pagina, 
in modo che appaia lungo tutta la partitura. Intestazione (dopo prima pagina) funziona allo 
stesso modo, ma è sempre nascosto sulla prima pagina, per evitare che tocchi il titolo; le intestazi-
oni sono testi di sistema quindi appaiono in tutte le parti.

Piè di pagina
I piè di pagina sono testi in fondo a ogni pagina. Crea > Testo > Altro testo di sistema > Piè di 
pagina (bordo esterno) è a destra delle pagine sul lato destro e a sinistra di quelle sul lato sinis-
tro; Piè di pagina (bordo interno) è sul margine interno.

Come per le intestazioni, normalmente il piè di pagina si crea sulla prima o al massimo la seconda 
pagina; esso appare automaticamente in tutte le pagine successive (ma non in quelle precedenti). 
Cambiando il piè di pagina su una pagina, esso cambia automaticamente su tutte le altre pagine. 
I piè di pagina sono testi di sistema quindi appaiono in tutte le parti.

Testo normale
Per creare un testo normale nella partitura (per scrivere varie istruzioni d’esecuzione o blocchi di 
parole, ad esempio) selezionare Crea > Testo > Altro testo di rigo > Testo normale.
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3.3 Parole

b Lavorare con i testi, Modifica stili di testo.

v Testi.

Le parole sono vocaboli scritti sotto le note eseguite da un cantante; si creano in tre modi:

* Scrivendole direttamente;
* Copiando le parole in Sibelius sillaba per sillaba da un programma di scrittura o simile;
* Inserendo automaticamente le parole nella partitura da un file di testo; Sibelius provvede poi a 

collocare le sillabe sotto le note.

Le parole in un “blocco” per strofe extra alla fine di un brano o un inno si creano in modo diverso 
(perché non si allineano con le note ) – vedere Blocchi di parole.

Digitare le parole
Per scrivere direttamente le parole in Sibelius:

* Inserire le note sulle quali scrivere le parole.
* Selezionare la nota dalla quale si desidera far iniziare le parole e scegliere Crea > Testo > Parole >

Linea di parole 1 (comando rapido Ctrl+L o XL).
* Iniziare a scrivere le parole.
* Premere “–” (trattino) alla fine di ogni sillaba della parola.
* Premere la barra spaziatrice alla fine di ogni parola.
* Se una sillaba dura due o più note, premere la barra spaziatrice o “–” una volta per ogni nota.
* Se dopo la parola c’è una virgola, un punto o altra punteggiatura, scriverla prima di premere la 

barra spaziatrice.

Se serve più di una parola per nota o un’elisione vedere Più parole per nota ed elisioni.

Modificare le parole
Le parole si modificano come qualsiasi altro testo; è possibile cambiarle, spostarle copiarle e can-
cellarle.

Per modificare una parola doppio-clic su di essa (o selezionarla) e premere Invio (sulla tastiera 
principale); per muoversi tra parole e sillabe usare i tasti freccia o il tasto Backspace.

Cancellando una sillaba si cancella tutta la linea di parola o i trattini alla sua destra (associati alla 
sillaba). Per spostare la sillaba a sinistra o destra di una nota, selezionarla (diventa blu scuro, ma 
non il cursore che appare) e premere la barra spaziatrice o Maius-space. Analogamente, per 
estendere o contrarre una linea di parola o una fila di trattini selezionare l’estremità destra e pre-
mere la barra spaziatrice o Maius-barra spaziatrice.
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Strofe, ritornelli e traduzioni
Nella musica vocale spesso ci sono due o più linee di parole sotto la 
stessa musica. In genere, ciò è indicato dal numero della strofa che 
precede la prima parola o sillaba di ogni strofa (per esempio, “1. 
Il”.

In questo esempio, digitare “1. Il” come singolo oggetto di testo 
usando uno spazio non interrotto (vedere Più parole per nota 
ed elisioni).

Per inserire una seconda linea di parole selezionare Crea > Testo >
Parole > Linea di parole 2 (comando rapido Ctrl+Alt+L o zXL) 
e crearla come le altre parole; esse appariranno automaticamente 
sotto le parole della linea 1.

Per traduzioni che richiedono una seconda linea di parole usare 
l’opzione Linea di parole 2 e cambiare in corsivo lo stile di testo 

(b Modifica stili di testo), oppure si può passare temporaneamente in corsivo premendo 
Ctrl+I o XI mentre s’inseriscono le parole. Per i ritornelli nella linea 1 si può usare invece il 
comando Crea > Testo > Parole > Parole (chorus) che è impostato per usare gli stili in corsivo.

Sibelius ha stili di testo predefiniti per cinque strofe di testo. Le parole per le linee 3, 4 e 5 si otten-
gono dal submenu Crea > Testo > Parole. Per creare altre strofe di parole usare l’opzione House 
Style > Modifica stili di testo (comando rapido Ctrl+Maius+Alt+T o xzXT) – b Modifica 
stili di testo.

Per aggiungere rapidamente i numeri di strofa alla partitura dopo aver inserito le parole usare il 
plug-in Plug-in > Testo > Aggiungi numeri Strofa– b Plug-in.

Copiare le parole in Sibelius
È possibile copiare e incollare parole tra altri programmi (come uno di testo) e Sibelius, da una 
parte della partitura a un’altra in Sibelius, o da una partitura all’altra.

Il testo che si copia può essere normale, privo di trattini o avere già i trattini tra le sillabe; per 
esempio:

Ma-ry had a lit-tle lamb,  
its fleece was white as snow.

Se il testo non ha già i trattini, Sibelius lo scompone automaticamente in sillabe.

Si può dire a Sibelius la lingua in cui sono le parole di solito e configurare un paio di altre opzioni 
nella pagina Others del menu File > Preferenze (menu Sibelius in Mac). Opzioni simili ci sono 
anche nella finestra di dialogo Crea > Testi > Parole > Da file di testo (vedere Creare le parole 
da un file di testo).

Per copiare testi di parole in Sibelius:

*  Selezionare il testo da copiare:
%  Se si copia all’interno di Sibelius selezionare le parole da copiare: usare una selezione “lasso” 

(b Selezioni e passaggi) o selezionare una singola sillaba e scegliere Modifica >

Alcune regole di scritttura 
per le parole
In genere le parole sono sotto il rigo; 
si scrivono sopra solo se due righi 
condividono le stesse parole (es. in 
un inno) o se un rigo ha due voci 
con parole diverse.

Le sillabe cantate su note diverse 
sono separate da uno o più trattini. 
Se l’ultima sillaba di una parola 
continua per più note è scritta una 
“linea di parola” dopo la sillaba 
finale insieme alle note cantate su 
quella sillaba. La punteggiatura 
oltre la sillaba finale viene prima 
della linea di parola.
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Seleziona > Seleziona altro (o premere Ctrl+Maius+A o xXA) per selezionare una linea di 
parole, quindi scegliere Modifica > Copia (comando rapido Ctrl+C o XC).

% Se si copia da un altro programma, selezionare il testo da copiare e dai menu del programma 
scegliere Modifica > Copia (comando rapido, in genere, Ctrl+C o XC) per copiarlo nel clip-
board.

* Selezionare la nota dalla quale iniziare a incollare le parole e scegliere Crea > Testo > Parole >
Linea di parole 1 (comando rapido Ctrl+L o XL); appare un cursore lampeggiante.

* Per incollare una sillaba premere Ctrl+V o XV; questa operazione incolla il testo fino allo spazio 
o trattino successivo (cioè vale una nota).

* Si può quindi modificare il testo incollato come se fosse stato digitato, oppure premere la barra 
spaziatrice o “–” (trattino) per estendere la parola o sillaba a più di una nota.

* Per inserire la parola o sillaba successiva premere di nuovo Ctrl+V o XV.
* Se si sbaglia, scegliere Modifica > Undo (comando rapido Ctrl+Z o XZ): l’ultima parola o sill-

aba incollata è tolta dalla partitura e collocata di nuovo nel clipboard, per poterla incollare 
ancora.

Se il testo copiato ha trattini o spazi extra tra parole o sillabe, oppure ha sillabe che durano più di 
una nota, ciò è ignorato quando s’incolla. È utile se, ad esempio, si stanno copiando le parole da un 
rigo ad un altro in Sibelius e i ritmi sono diversi.

Consiglio: Incollando le parole così, si può premere la barra spaziatrice ad ogni sillaba, anche nel 
mezzo di una parola – Sibelius inserisce comunque un trattino ove necessario.

Copiare una linea intera di parole
Ecco un metodo veloce per copiare un’intera linea di parole da qualche altra parte nella partitura 
dove il ritmo delle parole è lo stesso:

* Selezionare la fila di parole originale (selezionando una parola o sillaba) e scegliere Modifica >
Seleziona > Seleziona altro (comando rapido Ctrl+Maius+A o xXA).

* Selezionare Modifica > Copia (comando rapido Ctrl+C o XC).
* Selezionare la prima nota nel passaggio di destinazione dove incollare le parole.
* Selezionare Modifica > Incolla (comando rapido Ctrl+V o XV), senza scegliere prima Crea >

Testo > Parole > Linea di parole 1, per incollare subito tutte le parole.

Se le parole di destinazione si toccano, in seguito selezionarle come passaggio e scegliere Layout >
Resetta spaziatura nota (comando rapido Ctrl+Maius+N o xXN).

Copiare le parole da una linea (o strofa) a un’altra
È abbastanza comune che i brani abbiano parole identiche in frasi simili di strofe diverse, quindi è 
comodo copiare le parole già scritte da una strofa a un’altra. Supponiamo di copiare le parole 
usando lo stile di testo da Linea di parole 1 a Linea di parole 3:

* Eseguire una selezione di passaggio attorno alla musica contenente le parole da copiare.
* Selezionare Modifica > Filtro > Filtro avanzato (comando rapido Ctrl+Maius+Alt+F o

xzXF).
* Nella finestra di dialogo che appare disattivare tutte le opzioni Find tranne quellaText.
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* Dall’elenco degli stili di testo a destra cliccare None e poi scegliere Lyrics line 1.

* Cliccare Select.

* Copiare le parole nel clipboard con un Modifica > Copia (comando rapido Ctrl+C o XC).
* Selezionare la nota dalla quale si vogliono fare iniziare le parole copiate e scegliere Modifica >

Incolla (comando rapido Ctrl+V o XV).
* Dal pannello Text della finestra Properties cambiare lo stile di testo delle parole copiate da Linea 

di parole 1 a LLinea di parole 3.

* Selezionare Layout > Ripristina posizione (Ctrl+Maius+P o xXP).

Copiare le parole da Sibelius
Può essere utile copiare e incollare le parole da Sibelius in un programma diverso (uno di testo, ad 
esempio) oppure in un blocco di parole alla fine della partitura in Sibelius (vedere Blocchi di 
parole). Per farlo:

* Selezionare le parole da copiare (per esempio, selezionando un passaggio o l’intera partitura e 
poi scegliendo Modifica > Filtro > Parole) e selezionare Modifica > Copia (comando rapido 
Ctrl+C o XC) per copiarle nel clipboard.

* A questo punto, incollare le parole alla posizione desiderata:
% Per incollare le parole in Sibelius creare un carattere di testo adatto; per un blocco di parole, 

ad esempio, selezionare Crea > Testo > Altro testo di rigo > Testo normale e cliccare nella 
partitura, quindi scegliere Modifica > Incolla (comando rapido Ctrl+V o XV) per incollare 
le parole.

% Per incollare le parole in un altro programma, passare a quel programma e selezionare 
Modifica > Incolla (comando rapido, in genere, Ctrl+V o XV).

Il testo incollato avrà dei trattini tra le sillabe (che si dovranno togliere).

Per salvare rapidamente tutte le parole dalla partitura usare il plug-in Plug-in > Testo > Esporta 
Parole – b Plug-in.

Creare le parole da un file di testo
Sibelius può leggere le parole da un file di testo e inserirle auto-
maticamente nella partitura, collocando i trattini tra le parole e 
mappandole sulle note di un rigo, inclusi i melismi (cioè una sin-
gola sillaba o parola cantata su più di una nota e indicata da una 
legatura sopre le note.

Innanzitutto, scorrere la partitura e verificare di avere creato le 
legature in tutti i punti nei quali si prevede che Sibelius produca i 
melismi.

Poi bisogna assicurarsi che le parole siano in un file dallo stile di 
testo normale. Usando Microsoft Word, selezionare File > Salva 
come e impostare il tipo di documento in Plain text (o Text 
only su Mac); usando un’altra applicazione, la procedura è prob-
abilmente simile, ma non identica.
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Una volta pronti, selezionare le misure nel rigo (o righi) alle quali aggiungere le parole e scegliere 
Crea > Testo > Parole > Da file di testo. Appare la finestra di dialogo indicata a destra.

* Scegliere il file di testo contenente le parole cliccando Sfoglia.

* Impostate la lingua dei versi: deve essere impostato nella lingua usata dalle parole (le opzioni 
sono: Inglese, Francese, Tedesco, Italiano, Spagnolo e Latino); Sibelius “immagina” automatica-
mente la lingua, ma se sbaglia correggere l’impostazione qui prima di continuare.

* Sillabazione intelligente di parole particolari: determina cosa fa Sibelius quando trova 
parole che possono essere sillabate dai trattini in vari modi (per esempio, “everything” può 
essere sillabata come “ev-er-y-thing” o “ev’-ry-thing”). Con questa opzione attiva, Sibelius esam-
ina sia la struttura della frase musicale alla quale sono assegnate le parole, sia la frase del testo 
stesso, per cercare di ottenere il risultato musicale ideale. Se questa opzione non è attiva, Sibelius 
chiede di scegliere la sillabazione specifica più appropriata per ogni parola ambigua.

* Stile testo versi: definisce lo stile di testo che Sibelius usa per le parole inserite nella partitura.
* Cancella prima versi esistenti: rimuove tutte le parole nel passaggio selezionato dello stile di 

testo scelto prima di aggiungere nuove parole; questa opzione è utile se usata in seguito, per 
esempio dopo aver corretto un errore nella musica o aggiunto una legatura per correggere un 
melisma.

* Trascrivi pseudo-dittonghi con un apostrofo: questa opzione dice a Sibelius d’indicare dove 
ha scelto di combinare due sillabe in una per le parole ambigue; per esempio, se divide “every-
thing” in tre sillabe piuttosto che in quattro, con questa opzione attiva scriverà “ev’-ry-thing”, 
mentre se non è attiva scriverà “eve-ry-thing.” In questa situazione, di solito si usa un apostrofo, 
quindi è meglio lasciare attiva questa opzione.

* Avvisa se i versi non si adattano alla musica: se attiva, Sibelius chiede se deve stabilire di 
avere troppe parole da fare corrispondere alle note disponibili (o viceversa) ed offre la possibilità 
di procedere, se si desidera.

Cliccando OK, Sibelius aggiunge le parole al passaggio selezionato nella partitura. Se non riesce a 
stabilire come scrivere al meglio le parole ambigue chiede un aiuto: si apre la finestra Scegli Silla-
bazione che mostra la parola in questione e permette di scegliere vari modi per sillabarla; fermare 
il puntatore del mouse sul box per vedere un tool tip che indica la parola nel contesto. Si può atti-
vare l’opzione Usa sillabazione per termini simili per chiedere a Sibelius di usare lo stesso crite-
rio di sillabazione per le parole con caratterisitche simili (lo stesso suffisso, ad esempio).

Se le parole cambiano diverse lingue, si può aggiungere un comando speciale al file di testo, il 
quale dice a Sibelius dove usare le regole di sillabazione di un’altra lingua: inserire il nome della 
lingua all’interno delle parentesi graffe (per esempio, {English} o {German}).

Per forzare una particolare sillabazione di una parola, aggiungere i trattini alla parola (o parole) in 
questione nel file di testo contenente le parole da aggiungere.

In alcune lingue, come lo Spagnolo e l’Italiano, si usa elidere la fine di una parola con l’inizio di 
quella successiva, trattando le due sillabe come una sola (per esempio, in Spagnolo la parola 
“donde irà” può essere cantata con tre sillabe invece che quattro, cioè “don-de_i-rà”). Sibelius 
esegue automaticamente questa operazione, se necessario.
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Dividere le parole in sillabe
Quando si divide una parola in sillabe è importante farlo in corrispondenza delle giuste lettere, alt-
rimenti la parola è difficile da leggere. Di norma (sebbene ci siano delle eccezioni) si fa così:

* Inserire prefissi e suffissi standard (es. un-, -ing, -ed, -ly) come sillabe separate.
* Se c’è una sola consonante prima di due sillabe (es. labor) dividere prima (la-bor).
* Se ci sono due consonanti tra due sillabe (es. better, Batman) dividere prima (bet-ter, Bat-man).

Poiché esistono delle eccezioni, nel dubbio assicurarsi che ogni sillaba si possa leggere e pronun-
ciare correttamente da sola; per esempio, “laughter” dovrà essere diviso in “laugh-ter” piuttosto 
che in “laug-hter” perché la sillaba “laug” non ha la giusta fonetica se pronunciata da sola.

Naturalmente, in caso di bisogno si può sempre consultare un dizionario!

Verificare la sillabazione delle parole
Poiché è facile sbagliare le sillabe di una parola digitandole, Sibelius ha un comodo plug-in che 
controlla la sillabazione delle parole nella partitura – vedere Controlla trattini d’unione 
delle parole a pagina 418.

Parole condivise
Se due righi hanno ritmi identici o quasi, si può scrivere una sola 
linea di parole tra essi che si applica a entrambi; dove i ritmi sono 
leggermente diversi, posizionare le sillabe in orizzontale tra le due 
note (come per le sillabe “–ry” e “on” nella figura a destra).

Parole su due voci
Nella musica corale in genere due linee vocali condividono lo stesso rigo (per esempio, soprano e 
contralto su un singolo rigo). Spesso per musica di questo tipo serve solamente un set di parole, 
poiché i ritmi delle due linee tendono ad essere simili; se i ritmi differiscono in passaggi estesi, 
risulta più chiaro scrivere ogni linea vocale su un rigo separato.

D’altro canto, se un rigo ha due cantati con ritmi molto diversi o parole solo in poche misure è 
meglio scrivere una linea extra di parole sopra per la Voce 1 e una linea separata di parole sotto per 
la Voce 2. La linea di parole extra può apparire anche solo per poche note ma non è presente 
nell’intero sistema, così è più chiaro se la linea di parole extra si ha solamente dove la musica si 
divide in due voci:

Aggiungendo le parole alla musica in due voci, prima d’iniziare si può scegliere la voce nella quale 
inserire le parole:

* Creare tutte le note (sia nella Voce 1 che in Voce 2).
* Per inserire le parole della Voce 1 sopra il rigo selezionare Crea > Testo > Altro testo di rigo >

Parole sopra il rigo.

* Per inserire le parole nella Voce 2 selezionare la prima nota in Voce 2 sulla quale inserire le 
parole e scegliere Crea > Testo > Parole > Linea di parole 1 (comando rapido Ctrl+L o XL).
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Più parole per nota ed elisioni
Nel fraseggio cantato (come un recitativo) spesso ci sono molte parole 
cantate su una nota lunga, ma digitando uno spazio o un trattino dopo 
la prima sillaba il cursore si sposta subito sopra la nota successiva.

Usare quindi i comandi speciali Ctrl+spazio o z-spazio e Ctrl+”–”
(trattino) o z–, che introducono spazi e trattini non interrotti (cioè 
che non si spostano sulla nota successiva). Talvolta, questi comandi 
sono utili quando si creano altri tipi di testo, come i simboli accordo.

Analogamente, in Italiano e alcune altre lingue spesso due sillabe elisi-
ate sono scritte sulla stessa nota con un carattere d’elisione che le sep-
ara (per esempio, Ky – ri – e_e – lei – son). Per farlo, digitare “_”
(underscore) mentre si creano le parole per avere un carattere d’eli-
sione.

Il carattere d’elisione si può usare come legatura in blocchi di parole (per esempio, alla fine di una 
linea o un inno).

Legature e tratti d’unione
Quando si cantano più note sulla stessa sillaba è possibile unirle con una legatura, per chiarire 
dove le sillabe iniziano e finiscono. Per farlo automaticamente, usare il plug-in Plug-in > Testo >
Aggiungi legature alle parole. Legature superflue possono confondere la musica, quindi si con-
siglia di usare le legature solo se la formazione della parola è complessa o potenzialmente confusa. 
I segni di frase non dovrebbero essere usati nella musica vocale.

Nelle partiture antiche le note cantate su sillabe separate non erano mai unite tra loro, per chiarire 
meglio le sillabe che andavano su ogni nota. Questa convenzione non si usa più molto (perché 
rende difficile la lettura ritmica) ma se fosse necessaria in una partitura particolare usare il plug-in 
Plug-in > Testo > Unione di parole tradizionale che lo fa automaticamente.

Per maggiori informazioni su questi plug-in, b Plug-in.

Punteggiatura sospesa
Digitando la parola “Oh,” Sibelius centra le lettere vere e proprie sotto la nota ignorando lo spazio 
in larghezza occupato dalla virgola (che rimane “sospesa” a destra). Analogamente, se una strofa 
inizia con “1. The” la parola “The” è centrata e il numero “1.” rimane sospeso a sinistra. Sono 
esempi di un particolare tipografico chiamato punteggiatura sospesa.

Per evitare che Sibelius consenta la punteggiatura sospesa, disattivare l’opzione Punteggiatura 
sospesa nella pagina Testo della finestra di dialogo House Style > Regole tipografia (comando 
rapido Ctrl+Maius+E o xXE).

Posizione orizzontale
Sibelius controlla la posizione orizzontale delle parole seguendo complesse regole. Mentre si digita 
ogni sillaba, Sibelius ne regola la posizione precisa in base alla larghezza e a quante note dura:

* Le parole sono centrate se una parola o sillaba è seguita da un’altra parola o sillaba sulla nota 
successiva.

Punteggiatura
Se le parole sono quelle di una 
poesia inserire le maiuscole 
(all’inzio delle linee) e la pun-
teggiatura (alla fine delle 
linee e ovunque) come nel 
testo originale. La punteggia-
tura alla fine delle parole và 
prima della linea di parola.

Se si ripete parte di una frase 
che non è ripetuta nel testo 
originale inserire una virgola 
prima della ripetizione (es. 
“My sister, my sister, my sister 
is a thistle-sifter”).
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* Le parole non sono centrate se una parola o sillaba è seguita da:
% Una nuova parola, due o più note dopo; la parola è allineata a sinistra della nota alla quale è 

associata, con una linea di parola trascinata.
% Una nuova sillaba, due o più note dopo; di default, la sillaba è allineata a sinistra della nota 

alla quale è associata, seguita da uno o più trattini; la sillaba, però, sarà centrata se è attiva 
l’opzione Centra tutte le sillabe seguite dai trattini nella pagina Testo della finestra di 
dialogo House Style > Regole tipografia.

Una volta digitate le parole, le singole sillabe si possono trascinare a piacere a sinistra e destra, 
come un altro testo (se bisogna regolarne la posizione).

Le sillabe associate alle note sono scritte sotto, quindi regolando la spaziatura nota anche le sillabe 
si spostano. Inoltre, spostando due sillabe unite da trattini appaiono sempre più trattini man mano 
le sillabe si spostano (e i trattini si scostano in modo da rimanere centrati con precisione tra le sill-
abe).

Per regolare la spaziatura delle parole selezionare la misura o passaggio in questione e premere 
Maius+Alt+0/1 o xz0/1 per aumentare o diminuire la spaziatura (Ctrl+Maius+Alt+0/1 o
xzX0/1 per step più grandi) – b Spaziatura note.

Per resettare la spaziatura al valore di default selezionare il rispettivo passaggio e scegliere 
Layout > Ripristina spaziatura note(comando rapido Ctrl+Maius+N o xXN).

L’azione di questa funzione dipende dall’opzione Consenti spazio per i versi nella finestra di dia-
logo House Style > Regola di spaziatura note che deve essere attiva in Layout > Ripristina spa-
ziatura note, per evitare collisioni tra le parole. Disattivando questa opzione Sibelius ignora 
completamente le parole quando si rispazia la musica, quindi si raccomanda di lasciarla attiva.

Sillabe particolarmente lunghe centrate sulla prima nota di una misura possono sporgere sulla 
stanghetta precedente e, in passaggi con poco spazio, provocare una collisione con la parola alla 
fine della misura precedente; per disabilitare questa funzionalità disattivare l’opzione Consenti la 
prima sillaba al di sopra della stanghetta nella finestra di dialogo House Style > Regola di 
spaziatura note.

Talvolta lasciare spazio per parole larghe può rendere poco omogenea la spaziatura nota; è uno 
degli spauracchi per chi scrive musica e migliorarlo richiede una sorta di compromesso tra come 
spaziare al meglio parole e note; per esempi e consigli al riguardo, b Spaziatura note.

Trattini della parola
Dove le sillabe sono divise sulle note, normalmente c’è un trattino che le divide; dove le sillabe sono 
cantate su molte note, appare più di un trattino (in base alla distanza tra le sillabe stesse).

I singoli trattini per le sillabe su note adiacenti sono centrati con precisione tra le sillabe. Più trat-
tini sono gestiti dalle opzioni nella pagina Text della finestra di dialogo House Style > Regola 
tipografia – vedere Opzioni Engraving Rules.

Nella lingua Inglese, spesso è accettabile il fatto che il trattino scompaia tra le sillabe in situazioni 
di spazio limitato (per esempio, dove parole come “little” si trovano su note corte adiacenti). In 
altre lingue, però, l’assenza del trattino può cambiare completamente il significato del testo. Sibel-
ius cerca sempre di lasciare lo spazio sufficiente per il singolo trattino tra due sillabe, ma in caso di 
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spazi limitati non sempre ciò è possibile. Per fare in modo che Sibelius non assicuri che il trattino 
appaia sempre disattivare l’opzione Consenti spazio extra per i trattini nella finestra di dialogo 
House Style > Regola di spaziatura note.

Dove le parole si dividono nei break di sistema i pareri sono discordi sul fatto che un trattino debba 
apparire sia all’inizio del secondo sistema che alla fine del primo. Sibelius soddisfa entrambe le esi-
genze: per far apparire i trattini all’inizio dei sistemi attivare la rispettiva opzione nella finestra di 
dialogo House Style > Regole tipografia. Sibelius, tuttavia, non può garantire che un trattino 
appaia all’inizio del secondo sistema, anche se è attiva l’opzione Trattini consentiti ad inizio 
accollature. Se un trattino non appare dove serve aumentare un pò lo spazio che precede la prima 
nota nel sistema dopo il break; il trattino apparirà.

Se un trattino non è correttamente centrato tra due sillabe, selezionarlo e scegliere 
Layout > Ripristina posizione (comando rapido Ctrl+Maius+P o xXP); i trattini si possono 
anche spostare un pò – cliccare sul trattino (più a destra) e trascinarlo a sinistra o destra.

Poszione verticale
Sibelius colloca le parole ad una posizione verticale standard sotto il rigo. Tuttavia, è possibile 
spostare le sillabe in alto e in basso singolarmente, come un qualsiasi altro testo.

Per spostare una linea di parole cliccare su una delle parole e selezionare Modifica > Seleziona >
Seleziona altro (comando rapido Ctrl+Maius+A o xXA) per selezionare l’intera linea, poi 
spostare le parole con i tasti freccia (Ctrl+3/2 o X3/2 per step più grandi). Altrimenti, una volta 
selezionata una linea di parole così, si può allinearle in una fila con il comando Layout > Allinea in 
una fila (comando rapido Ctrl+Maius+R o xXR), riportarle alla posizione verticale di default 
con il comando Layout > Ripristina posizione (Ctrl+Maius+P o xXP) o cancellarle premendo
Canc.

Per allineare rapidamente tutte le parole nella partitura usare il plug-in Plug-in > Testo > Allinea 
parole – b Plug-in.

Per cambiare la posizione verticale di default delle parole, b Posizioni di default.

Stile di testo
Si può modificare l’aspetto delle parole in vari modi:

* L’opzione House Style > Modifica stili di testo (comando rapido Ctrl+Maius+Alt+T o
xzXT) cambia lo stile di testo complessivo delle parole (per fare in modo, ad esempio, che 
tutte le parole nella partitura siano in un font particolare o tutte in corsivo) – b Modifica stili 
di testo.

* Ogni modifica eseguita sull’aspetto delle parole con la finestra Proprietà (b Proprietà) mentre 
si modificano le parole, si applica a tutto il testo successivo creato; per esempio, se si passa ad un 
font in corsivo e poi si preme la barra spaziatrice per spostarsi alla parola che segue, quella 
parola e tutte quelle successive saranno in corsivo fino a quando si disattiva la rispettiva opzione 
o s’interrompe l’inserimento delle parole.

Per far tornare l’aspetto delle parole alle impostazioni di default (definite in House Style > Modi-
fica stili di testo), selezionarle e scegliere Layout > Ripristina aspetto (Ctrl+Maius+D o
xXD). Una volta cambiato font o dimensione della parola – sia modificando lo stile di testo con 
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l’opzione House Style > Modifica tutti i font o importando uno stile house (b House 
Style™) – scegliere Layout > Ripristina spaziatura note (comando rapido Ctrl+Maius+N o 
xXN), poiché probabilmente le parole avranno bisogno di più o meno spazio in orizzontale ris-
petto a prima.

Blocchi di parole
Strofe extra di un brano o inno si possono scrivere come blocchi di parole alla fine della partitura. 
Non sono come le parole normali, perché non s’allineano con le note.

Per scrivere un blocco di parole usare il comando Crea > Testo > Altro testo di sistema > Sezioni 
di testi. Digitare le parole e premere Invio (sulla tastiera principale) alla fine di ogni linea, oppure 
copiare le parole prelevandole da qualche altra parte nella partitura, se possibile (vedere Copiare 
le parole da Sibelius); conviene scrivere ogni strofa come oggetto di testo separato, in modo da 
poter spostare poi tutte le strofe separatamente.

Direzioni dei gambi
Le note sulla linea centrale del rigo in genere hanno i gambi rivolti in basso; tuttavia, quando ci 
sono le parole il gambo spesso è rivolto in alto (per non toccare le parole). Di default, Sibelius usa 
questa convenzione; se si preferisce che non l’adotti vedere Gambi sulla linea centrale a 
pagina 80.

Opzioni Engraving Rules
Nella pagina Text della finestra di dialogo House Style > Regole tipografia (comando rapido 
Ctrl+Maius+E o xXE) si può definire la posizione delle linee di parola, la spaziatura dei trattini e 
alcune altre opzioni:

* Usa trattini testo (non simboli): Sibelius scrive i trattini delle parole con il font usato per 
creare le parole, invece di usare un simbolo speciale dalla finestra di dialogo Crea > Simboli. 
Di default questa opzione è attiva.

* Un trattino al massimo: fa apparire solo un trattino della parola, anche se le sillabe sono molto 
distanziate. Di default questa opzione non è attiva.

* Trattini consentiti ad inizio accollature: controlla se un trattino di parola può apparire 
all’inizio di un sistema se c’è una sillaba sulla prima nota. Di default questa opzione non è attiva.

* Punteggiatura sospesa: controlla se Sibelius tiene conto della punteggiatura sospesa quando si 
posizionano le parole (vedere Punteggiatura sospesa).

* Centra tutte le sillabe seguite dai trattini: centra le sillabe melismatiche (cioè quelle tenute 
sopra più di una nota) seguite da trattini, invece di allinearle a sinistra secondo la funzionalità di 
default. Di default questa opzione non è attiva.

* Centra tutte le sillabe che contengono caratteri asiatici: di default è attiva. Le regole di 
allineamento delle parole negli alfabeti Occidentali non sono adatte alle lingue Asiatiche, ove la 
maggior parte delle parole è costituita da singoli caratteri.

* Disegna legature di portamento sotto caratteri asiatici: scrive piccole legature sotto tutti 
gli elementi della parola che contengono più di un carattere Asiatico, tra il primo e l’ultimo car-
attere Asiatico nella sillaba, chiarendo così che devono essere tutti cantate con la stessa nota. Di 
default questa opzione non è attiva.
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3.4 Simboli accordo

b Diagrammi accordo, Lavorare con i testi.

I simboli accordo sono oggetti di testo scritti sotto o (più spesso) sopra il rigo che indicano l’armo-
nia a quel punto nella musica.

Sono diffuse varie convenzioni di simbolo accordo che dipendono principalmente dallo stile musi-
cale. Per esempio, la convenzione di Nashville nomina gli accordi in base al loro numero rispetto 
alla tonica della tonalità prevalente, mentre la maggior parte di altre convenzioni usa il nome della 
nota come base per il simbolo accordo.

Fortunatamente, tutti questi tipi di simboli si creano più o meno allo stesso modo.

Per inserire un simbolo accordo insieme a un diagramma accordo per chitarra, b Diagrammi 
accordo.

Creare automaticamente i simboli accordo 
Per aggiungere automaticamente i simboli accordo alla musica o trasformarli in musica scritta usare 
i plug-in Aggiungi simboli accordo o Realizza simboli e diagrammi accordo– b Plug-in.

Scrivere i simboli accordo
Per scrivere direttamente i simboli accordo in Sibelius:

* Anzitutto inserire le note, quindi selezionare la prima sopra la quale far apparire il simbolo 
accordo.

* Selezionare Crea > Testo > Chord Symbol (Simbolo accordo, comando rapido Ctrl+K o XK).
* Il simbolo accordo si può inserire come un normale testo o con un clic-destro (Windows) o Con-

trol-clic (Mac) per scegliere da un menu scritta di simboli accordi standard, come B¨ e m7.
* Premere la barra spaziatrice per passare alla nota o movimento successivo.

Per scrivere uno spazio all’interno di un simbolo accordo premere Ctrl+barra spaziatrice o z-barra 
spaziatrice (poiché premendo solo la barra spaziatrice si passa alla nota o movimento successivo).

Il menu scritta elenca i comandi rapidi per tutti i simboli accordo disponibili. Per aggiungere un 
segno bemolle, ad esempio, digitare una b minuscola; per inserire un segno diesis digitare #; per 
aggiungere numeri in alto digitare 1–9 e così via. Altri utili tasti di comando rapido sono:

Altri simboli nel menu accordo comprendono N.C. per “no accordo,” ' per specificare l’aggiunta 
di un’alterazione; per indicare l’omissione di una determinata nota e così via.

Le diciture si possono modificare nel menu scritta Chords (standard) se si usano spesso – 
b Lavorare con i testi.

Simbolo diminuito ( ) Ctrl+O o zB

Simbolo semidiminuito (5° bemolle) ( ) Ctrl+Maius+O o xXO

Simbolo aumentato (&) Maius-7 (&)

Simbolo Maggiore (^) per le 7° maggiori, ad esempio Maius-6 (^)

% per accordi con la 6° e la 9° Maius-5 (%)
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Simboli accordo standard
Sibelius ha sei menu scritta per i simboli accordo che consentono di scrivere facilmente i simboli 
accordo in vari formati. Per esempio:


Triadi maggiori

Accordi (standard)
menu scritta; alterazione tonica
allineata in basso

A 
Accordi (superscrivi
alterazioni tonica) 
menu scritta

Ab 
Accordi (standard,
maj/min) menu scritta;
suffisso “maj” per gli accordi
maggiori

Abmaj 
Accordi (standard,
ma/mi) menu scritta;
suffisso “ma” per gli accordi
maggiori

Abma


Accordi di 7° maggiore

Accordi (standard)
menu scritta; suffisso “ma7”
per gli accordi di 7° maggiore

E ma7

 
Accordi (standard)
menu scritta;     Shift - 6  per   �^

E

 
Accordi (standard)
menu scritta;   Shift +Alt+6 
o xz6 per 

E ^

 
Accordi (Brandt-
Roemer) menu scritta;
suffisso “MA7”

E <7




Triadi maggiori con aggiunta di 6° e 9°

Accordi (standard)
menu scritta;  %    per      %

D%


 

Accordi (standard)
menu scritta

D6 9


 

Triadi maggiori solo con 9° aggiunta

Accordi (standard)
menu scritta;   Ctrl+Shift+A 
o xXA per“add”

C'9


 

Accordi (standard)
menu scritta

C2





Accordi di 7° e 9° dominante

Accordi (superscrivi
alterazioni tonica)  
menu scritta

Ab7 
Accordi (standard)
menu scritta

F9 
Triadi minori

Accordi (standard)
menu scritta; alterazione
tonica allineata alla base

F m

 
Accordi (superscrivi
alterazioni tonica) 
menu scritta; suffisso “min” per
gli accordi minori

F#min




Triadi minori con 7° maggiore

Accordi (standard)
menu scritta

Cm(,7)

 
Accordi (standard)
menu scritta

Fm#7 
Accordi di 7° diminuiti

Accordi (standard)
menu scritta  Ctrl     +O 
o XO per º; Ctrl+Alt+O
o zXO per

Dº

 
Accordi (standard)
menu scritta

D dim7
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Per cambiare il menu scritta che appare con un clic-destro (Windows) o Control-clic (Mac) men-
tre s’inseriscono i simboli accordo:

* Selezionare House Style > Modifica stili di testo (Ctrl+Maius+Alt+T o xzXT).
* Cliccare su Chord Symbol (Ctrl+K), quindi su Modifica.

* Alla base della pagina Generale cambiare l’opzione Menu contestuale, come segue:
% Per le alterazioni toniche allineate alla linea di base (es. C©) usare Accordi (standard).

% Per alterazioni toniche esponenziali (es. C#) scegliere Chords (superscript root acciden-
tals).

% Per alterazioni sovrapposte che usano + e – invece di b e #¨, usare Chords (standard, +/– 
alterations).


Triadi aumentate

Accordi (standard)
menu scritta

C+

 
Accordi (standard)
menu scritta

Daug

 
Triadi sospese

Accordi(standard)
menu scritta

Asus4 
Accordi (standard)
menu scritta

Gsus2




Accordi con 5° e 9° alterate

Accordi (standard)
menu scritta

C7[âÁ]


 

Accordi (standard,
alterazioni +/-)
menu scritta

C7[ Á]


 

Accordi (standard)
menu scritta

D7[áÁ]


 

Accordi (standard,
alterazioni +/-)
menu scritta

D7[ Á]





Accordi con 11° e 13° alterata

Accordi (standard)
menu scritta

C9(#11)


 

Accordi (standard,
alterazioni +/-)
menu scritta

Cm9(&11)


 

Accordi (standard)
menu scritta

C7[ ]
 

Accordi (standard,
alterazioni +/-)
menu scritta

C7[ ]



Accordi composti

Accordi (standard)
menu scritta

C/E

 
Accordi (standard)
menu scritta

E7/C


 

E7

Accordi (standard)
menu scritta, poi usare
Plug-in > Simboli accordo   >
Simboli accordo frazionali

C




Accordi (standard)
menu scritta    Ctrl+Shift+M
o  xX M  per   ;


Note omesse

C;3
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% Per i simboli accordo che seguono in gran parte le indicazioni fornite dal libro di Brandt e 
Roemer “Standardized Chord Symbol Notation”, selezionare Chords (Brandt-Roemer).

% Per indicare minore e maggiore con maj e min o ma e mi, usare Chords (standard, maj/
min) o Chords (standard, ma/mi).

* Cliccare su OK e Chiudi per confermare le proprie scelte.

Font del simbolo accordo
Sibelius ha non meno di sei diversi font per i simboli accordo:

* Opus Chords è il font standard per il simbolo accordo.
* Opus PlainChords utilizza alterazioni e numeri non esponenziali.
* Opus Chords Sans è un font Sans Serif, ed è quello di default negli stili house che usano Arial 

come font di testo principale.
* Opus Chords Sans Condensed è un font ristretto, utile in partiture con molti accordi complessi, 

poiché occupa meno spazio in orizzontale.
* Inkpen2 Chords corrisponde all’aspetto del font musicale Inkpen2 ed è quello di default negli 

stili house Inkpen2.
* Reprise Chords corrisponde all’aspetto del font musicale Reprise ed è quello di default negli stili 

house Reprise.

Tuttavia, si può usare un qualsiasi font per il simbolo accordo in ogni partitura. Per farlo:

* Selezionare House Style > Modifica stili di testo (Ctrl+Maius+Alt+T o xzXT).
* Doppio-clic sullo stile di testo Simboli accordo per modificarlo.
* Nella pagina Generale cambiare a qualsiasi font che si desidera usare.
* Cliccare su OK.

Non cambiare però il font a quello di un testo standard (a meno che non si usino solo semplici sim-
boli accordo), poiché facendolo si perdono i caratteri di simbolo accordo.

Numeri Nashville
I numeri Nashville sono convenzioni ancora più semplici dei simboli accordo standard. Gli accordi 
sono indicati da numeri che rappresentano il grado della scala nella tonalità corrente; in tonalità di 
DO maggiore un accordo di FA maggiore è indicato dal numero 4. Se un accordo è invertito o ha 


Opus Chords

B¨7[ìðîëÍ]




 
Opus PlainChords

B¨7[ìðîëÍ]




 
Opus Chords Sans

B¨7[ìðîëÍ]





Opus Chords Sans Condensed


B¨7[ìðîëÍ]






 



Inkpen2 Chords

B¨7[ìðîëÍ]


  


Reprise Chords

B¨7[ìðîëÍ]
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una nota diversa al basso, la nota di basso è scritta a destra di uno slash (sempre con un numero); 
in DO maggiore un accordo di SOL maggiore con la terza al basso è scritto 5/3.

In generale, gli accordi Nashville sono indicati da numeri arabi, ma in alcuni casi si usano anche 
quelli Romani (IV al posto di 4, ad esempio).

Per scrivere i simboli accordo Nashville in Sibelius selezionare Crea > Testo > Altro Testo Rigo >
Nashville chords numbers. Per inserire i simboli delle alterazioni usare il menu scritta: clic-
destro (Windows) o Control-clic (Mac).

Riprodurre i simboli accordo
I simboli accordo non sono riprodotti automaticamente, ma Sibelius ha un plug-in che genera 
semplici accompagnamenti dai simboli e diagrammi accordo nella partitura; per maggiori dettagli 
vedere Realizza simboli e diagramma accordo a pagina 395.

Trasporto dei simboli accordo
I simboli accordo sono trasportati automaticamente quando si trasporta la musica, oppure una 
partitura passa dall’altezza da concerto a una trasportata (non sono trasportati se si cambia solo 
l’altezza della nota sotto il simbolo accordo).

Nelle parti i simboli accordo sono sempre all’altezza giusta. Tuttavia, modificando un simbolo 
accordo che è stato trasportato, Sibelius avvisa che è diverso nella partitura. Se si continua, Sibelius 
indica l’accordo all’altezza da concerto che dovrà essere opportunamente modificato 
(b Lavorare con le parti).

Allineare una fila di simboli accordo
Se in un rigo sono stati inseriti dei simboli accordi e si è dovuto spostarne qualcuno per evitare col-
lisioni con le note è utile poterli riallineare.

Per farlo, selezionare un simbolo accordo e scegliere Modifica > Seleziona > Seleziona altro
(Ctrl+Maius+A o xXA); si selezionano tutti i simboli accordi su quel rigo. Ora si può:

* Allinearli in fila selezionando Layout > Allinea in una riga (Ctrl+Maius+R o xXR), dopod-
iché si possono spostare tutti in alto o in basso con i tasti freccia; oppure:

* Selezionare Layout > Ripristina posizione (Ctrl+Maius+P o xXP) per far scattare i simboli 
accordo alle rispettive posizioni verticali di default.

Gli stessi trucchi funzionano per altri stili di testo, come parole e basso figurato.

Frequenza dei simboli accordo
Di default, premendo la barra spaziatrice mentre si creano i simboli accordo ci si sposta al movi-
mento o nota successivo (quello che arriva prima). Si può quindi scrivere più di un simbolo 
accordo su una nota più lunga di un singolo movimento. Non sempre però ciò è auspicabile, quindi 
se si preferisce che la barra spaziatrice porti sempre alla nota successiva, cambiare la rispettiva 
opzione nella finestra House Style > Posizioni di default – b Posizioni di default.

Stile dei simboli accordo
Posizione verticale di default e dimensione dei simboli accordo si possono cambiare, come in altri 
stili di testo – b Modifica stili di testo e Posizioni di default.
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3.5 Basso figurato e numeri Romani

b Lavorare con i testi.

Il basso figurato è molto diffuso nella musica Barocca. Le figure sono aggiunte alla linea di basso 
solo ove servono specifiche inversioni e alterazioni cromatiche; se non ci sono figure, si presume 
che l’esecutore debba suonare le note della triade formata da nota di basso, terza e quinta sopra (in 
base alla tonalità).

In generale, i numeri Romani si usano per l’analisi armonica. Sibelius consente di creare i nomi 
degli accordi usando la convenzione alfabetica o numerica per indicare le inversioni. Per esempio, 
Sibelius può visualizzare la seconda inversione di un accordo tonico come Ic o I6$.

Creare il basso figurato
Sibelius ha un set completo di simboli per il basso figurato nel font Opus Figured Bass, che 
assomiglia al font Times.

Per scrivere un basso figurato:

* Inserire le note sul rigo di basso o continuo.
* Selezionare la prima nota e scegliere Crea > Testo > Altro testo di rigo > Basso figurato.
* Per inserire numeri senza alterazioni digitare i numeri dalla tastiera nel solito modo.
* Per inserire numeri seguiti da un bequadro usare le lettere minuscole sulla fila da W a O, ove 

ogni lettera corrisponde al numero sopra di essa sulla tastiera (es. W è w ). Per inserire il 
bequadro a sinistra del numero (es.  W) tenere premuto Maius mentre si preme il relativo tasto.

* Per inserire numeri seguiti da un diesis, usare le lettere da S a K, ove ogni lettera corrisponde al 
numero sopra di essa (es. S è s ). Per inserire il diesis a sinistra del numero (es.  S) tenere pre-
muto Maius mentre si preme il relativo tasto.

* Per inserire numeri seguiti da un bemolle usare le lettere da X a M, ove ogni lettera corrisponde 
al numero sopra di essa (es. X è x ). Per inserire il bemolle a sinistra del numero (es.  X) tenere 
premuto Maius mentre si preme il relativo tasto.

* Premere Invio (sulla tastiera principale) per una nuova linea in una colonna di figure.
* Premere Ctrl o X insieme ai tasti numerici sulla tastiera principale per aggiungere numeri con 

slash; l’unica eccezione a questa regola è &, il cui comando rapido è Maius-7.
* Per spostarsi al movimento o nota successivi premere la barra spaziatrice.


8


7


6

e

7 3

  
8 7 w


6

4


7


7


6

e


5 7


8

t


7 r

3


8 7


6


8 7 8


7 8

§


7
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Altri caratteri speciali sono:

* Vari altri caratteri sono nel menu scritta (clic-destro in Windows o Control-clic su Mac), il quale 
elenca anche altri comandi rapidi.

* Premendo la barra spaziatrice si passa al movimento o nota successivi (quello che arriva prima).

Il font Opus Figured Bass è stato progettato da Tage Mellgren (www.editionglobal.com).

Creare i numeri Romani
Per inserire i numeri Romani selezionare Crea > Testo > Altro testo di rigo > Numeri Romani.

Per inserire accordi contenenti solo caratteri alfabetici digitare le lettere dell’accordo come si fa 
normalmente.

Inserire accordi con i numeri è un po’ più complicato ma una volta che si sa come funziona, la pro-
cedura è semplice. Supponiamo d’inserire l’accordo VY6£, dove 6 è il numero esponenziale e 3 quello 
del basso:

* Prima inserire la tonica dell’accordo alfabeticamente, come al solito (per esempio, V).
* Se il numero esponenziale ha un’alterazione, premere X (diesis), Y (bemolle) o Z (bequadro) 

come necessario, altrimenti procedere.
* Se il numero in basso ha un’alterazione premere Maius-X (diesis), Maius-Y (bemolle) o Maius-

Z (bequadro) come necessario, altrimenti procedere.
* Se sono state inserite le alterazioni per i numeri esponenziali o il basso, portare avanti il cursore 

premendo Maius-.
* Se l’accordo ha un numero esponenziale, inserirlo digitando il numero (es. 6).
* Se l’accordo ha un numero di basso, inserirlo digitando il numero mentre si tiene premuto il 

tasto Maius (es. Maius-3).
* Per inserire numeri esponenziali con uno slash, digitare le lettere da M a U, ove M è il numero 1, 

N il numero 2, ecc. Per inserire un numero di basso, tenere premuto il tasto Maius mentre si 
digita la rispettiva lettera.

* Per passare al movimento o nota successivi premere la barra spaziatrice.

q Q Q Maius-Q p P

P Maius-P a A A Maius-A

l L   L Maius-L z Z

Z Maius-Z = = , ,

< Maius-,  ; ;  : Maius-;

> Maius-.





        


I




V7




vi


ii


I6


IV6




V6%


I
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Simboli funzione
I simboli funzione si usano per indicare la struttura armonica della musica: T significa tonica, D
dominante e così via:

Per creare i simboli funzione usare il comando Crea > Testo > Altro testo di rigo > Simboli funzi-
one:

* Premere la barra spaziatrice per avanzare alla nota o movimento successivi.
* Se il simbolo funzione richiede le parentesi, [ e ] scrivono le quadre, mentre { e } le tonde.
* Se il simbolo funzione contiene un numero esponenziale sotto il simbolo principale, prima digi-

tare: (q = 3, w = 5, e = 5>, r = 7), quindi il simbolo principale.
* I simboli principali sono tutti sui tasti previsti; per esempio, d, D, t, T, s, S, g, G. I caratteri della 

linea di base ed esponenziali  sono su a e A.  è su f;  è su F;  è su /.
* Se un simbolo funzione ha due file di numeri che seguono il simbolo principale, prima digitare il 

numero superiore (super-esponenziale), poi il numero inferiore (esponenziale). Se il numero(i) 
che segue il simbolo principale è seguito da “<” o “>”, digitare tutti i numeri prima del carattere 
“<” o “>”.

* Per i numeri esponenziali premere 1–9 sulla tastiera del computer. L’esponente “v” si scrive dig-
itando v. I caratteri “<” e “>” adatti a numeri esponenziali successivi si scrivono digitando “,”
(virgola) e “.” (punto).

* Per i numeri super-esponenziali digitare da Maius-1 a Maius-9 sulla tastiera del computer. 
Il numero super-esponenziale “v” è su V. I caratteri “<” e “>”, adatti a numeri super-esponenziali 
successivi, si scrivono digitando < e >.
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3.6 Numeri misura

Le partiture possono avere numeri misura che appaiono automaticamente (in generale sopra la 
prima misura di ogni sistema). Si può regolarne a piacere frequenza d’apparizione e aspetto.

Per vedere i numeri misura su tutte le misure solo sullo schermo (in modo da orientarsi meglio in 
lunghe partiture) attivare l’opzione Vista > Nomi rigo e numeri misura; essa è utile anche per 
indicare il nome di ogni rigo sul lato sinistro dello schermo – b Menu Vista.

Le opzioni necessarie a regolare i numeri misura stampati nella partitura sono nella pagina 
Numeri Battuta della finestra House Style > Regole tipografia (Ctrl+Maius+E o xXE).

Aspetto e frequenza
Le opzioni nel gruppo Aspetto sono:

* Frequenza: consentono di scegliere se visualizzare i numeri misura Ogni n battute, Ogni 
sistema (default) o Senza numeri battuta. Scegliendo Ogni n battute i numeri misura 
appaiono all’intervallo n definito; valori tipici nelle edizioni musicali sono 1, 5 e 10. Scrivere i 
numeri misura su ogni misura è una convenzione usata spesso negli esempi musicali, musica 
per campane a mano, musica per bambini e parti per musicisti turnisti.

* Mostra sulla prima misura delle sezioni: di default non è attiva e determina se il numero mis-
ura appare sulla prima misura della partitura e su eventuali misure successive dopo la fine di 
una sezione (Fine sezione), sempre che la misura sia all’inizio di un sistema. Attivare questa 
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opzione se s’impostano i numeri misura ad apparire su ogni misura; altrimenti, non appare il 
numero misura sulla prima misura della partitura.

* Nascondi su segni per la concertazione: attivandola, Sibelius nasconde automaticamente i 
numeri misura che si trovano sulle stesse stanghette dei segni di prova, per garantire che non si 
tocchino.

* Conta ripetizioni: di default non è attiva e determina se Sibelius deve tener conto delle ripetiz-
ioni quando numera le misure – vedere Numeri misura in strutture di ripetizione.

* Mostra intervallo battute d’aspetto (es. 5–8): consente di usare una 
convenzione sempre più diffusa nella musica commerciale, per film e TV, 
ove il numero di misure racchiuse in una pausa multipla appare sopra o 
sotto la pausa multipla, come indica la figura a destra. Se gli altri numeri 
misura nella partitura non sono centrati, ma si desidera scrivere l’intervallo del numero misura 
al centro della pausa multipla, attivare l’opzione Centra range su battute d’aspetto.

Opzioni Mostra su Righi
Le opzioni Mostra su Righi permettono di scegliere su quali righi Sibelius scriverà i numeri mis-
ura. Il funzionamento è simile a quello della finestra di dialogo House Style > Posizioni oggetti 
di sistema per altri oggetti di sistema, come segni di prova e scritte Tempo (b Posizioni di 
default), ma è specifico per i numeri misura.

In generale, i numeri misura sono sopra il rigo della partitura e sopra una o più altre famiglie stru-
mentali nella musica orchestrale e bandistica (a volte sono sotto il rigo più in basso della partit-
ura). Scegliere il pulsante di opzione Righi selezionati e selezionare il rigo (o righi) sul quale 
visualizzare i numeri misura:

* Per selezionare più di un rigo nell’elenco, tenere premuto Ctrl o X e cliccare: è possibile selezion-
are fino a cinque righi, inclusi quello in alto e in basso.

* Per collocare i numeri misura sotto il rigo in basso vedere Collocare i numeri misura sotto 
il rigo in basso.

* Per collocare i numeri misura tra i righi di uno strumento a tastiera (a volta si sceglie di farlo) 
selezionare il rigo in alto nell’elenco Righi selezionati e posizionare i numeri misura sotto il rigo 
in alto – vedere Opzioni di posizione verticale.

È assai raro vedere i numeri misura apparire su tutti i righi di una partitura, ma per farlo scegliere 
il pulsante di opzione Tutti righi. Se serve solo per vedere sempre su quale misura si sta lavorando 
c’è un metodo più facile: attivare l’opzione Vista > Nomi rigo e numeri misura (b Menu 
Vista).

Opzioni Stile di testo
Per cambiare font o dimensione usati dai numeri misura nella partitura o nelle parti dinamiche 
cliccare su Modifica stile di testo. Appare una versione speciale della finestra di dialogo Modi-
fica stile di testo che ha solo le opzioni adatte ai numeri misura visualizzati – b Modifica stili 
di testo.
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Opzioni di posizione orizzontale
Attivando l’opzione Centra sulla battuta si disabilitano tutte le altre opzioni Posizione orizzon-
tale; ciò vale anche per tutti i cambi di numero misura che si creano (vedere in seguito). 
Se i numeri misura non sono centrati, Sibelius consente di scegliere le posizioni dei numeri misura 
a inizio sistema separatamente dagli altri numeri misura.

Primo numero di battuta del sistema: di default è Allinea a sinistra. Scegliendo Dopo la chi-
ave, Sibelius colloca il numero misura a destra della chiave, mentre selezionando Come altri 
numeri di battuta, Sibelius segue l’opzione Come altri numeri battuta.

Come altri numeri battuta: di default è Centrato, quindi i numeri misura sono centrati sopra le 
stanghette. Scegliendo Sinistra il lato sinistro del numero misura s’allinea alla stanghetta e selezio-
nando Destra il lato destro del numero misura s’allinea con la stanghetta alla fine della misura.

Opzioni di posizione verticale
Le opzioni Mostra su righi determinano su quali righi appaiono i numeri misura (vedere Opzi-
oni Mostra su Righi) e le opzioni Posizione verticale stabiliscono il posizionamento dei 
numeri misura rispetto ai righi scelti.

Le opzioni Sopra inizio rigo, Sopra centro rigo, Sotto centro rigo, Sotto fine rigo sono iden-
tiche a quelle della finestra di dialogo House Style > Posizioni di default (b Posizioni di 
default) e determinano se il valore Relative al rigo n spazi è misurato dalla linea centrale, in 
alto o in basso del rigo.

Collocare i numeri misura sotto il rigo in basso
In alcuni tipi di musica (come le colonne sonore dei film) i numeri misura appaiono sotto il rigo e 
spesso sono centrati su ogni misura. Per farlo:

* Scegliere House Style > Regole tipografia e selezionare la pagina Numeri Battuta.
* In Aspetto selezionare Ogni n battute e impostare n a 1.

* In Mostra su Righi scegliere Righi selezionati e selezionare solo Sotto fine rigo (Ctrl+clic o
X-clic per deselezionare tutti gli altri righi).

* In Posizione orizzontale attivare l’opzione Centra sulla battuta.

* In Posizione verticale selezionare Sotto fine rigo e impostare il valore Partiture di Relative 
al rigo n spazi a (per esempio) 3 spazi.

* Cliccare su OK.

Per avere un aspetto simile anche nelle parti dinamiche, visualizzarne una e ripetere la procedura 
precedente sulla parte. Quindi, ancora con la parte visualizzata, selezionare House Style >
Esporta House Style ed esportare lo stile house di quella parte. Usare la finestra di dialogo 
Aspetto Parte Multipla per importare questo stile house nelle altre parti – per maggiori dettagli 
vedere Esportare stili house dalle parti a pagina 484.

Numeri misura in strutture di ripetizione
Quando in una partitura ci sono ripetizioni, in generale le misure sono numerate come se fossero 
suonate solo una volta; in altre parole, il fatto che alcune misure siano ripetute non si riflette nel 
modo in cui sono numerate.
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Tuttavia, non è raro che nelle partiture i numeri misura siano indicati secondo l’ordine vero e prop-
rio di riproduzione e in Sibelius è facile farlo: attivare l’opzione Conta ripetizioni nella pagina 
Numeri Battuta della finestra di dialogo House Style > Regole tipografia e scegliere il formato 
desiderato dal menu a tendina:

* 10: i numeri misura sono scritti solo una volta, ma tutti quelli dopo le sezioni ripetute tengono 
conto delle misure ripetute.

* 10 (20): i numeri misura delle misure ripetute sono scritti in parentesi (opzione di default).
* 10/20: i numeri delle misure ripetute sono scritti dopo uno slash.
* 10–20: i numeri delle misure ripetute sono scritti dopo un trattino.

L’effetto di ogni opzione è il seguente:

Se per i segni di prova si usa il formato Numero Battuta (pagina Richiami per la concertazione
della finestra House Style > Regole tipografia) si noti che Conta ripetizioni cambia anche la 
visualizzazione dei segni di prova.

Selezionare i numeri misura
I numeri misura si selezionano come un qualsiasi altro oggetto, ma mentre è possibile spostare e 
nascondere quelli selezionati (vedere in seguito) essi non si possono copiare né cancellare. (si pos-
sono però copiare e cancellare i cambi di numero misura – vedere Cambi di numero misura).

Per selezionare subito un gruppo di numeri misura si può:

* Selezionare un singolo numero misura e scegliere Modifica > Seleziona > Seleziona altro per 
selezionare tutti i numeri misura in quel sistema; oppure:

* Selezionare un passaggio musicale e scegliere Modifica > Filtro > Numeri misura per selezion-
are solamente i numeri misura in quelle misure; oppure:

* Eseguire una selezione multipla (marquee) con la combinazione Maius-trascinamento o X-
trascinamento del mouse.

Un intervallo di numeri misura selezionato si può spostare o nascondere (vedere in seguito).

Spostare i numeri misura
I numeri misura si possono spostare in orizzontale o verticale – basta selezionare uno o più 
numeri misura e trascinarli con il mouse o spostarli con i tasti freccia (premendo Ctrl o X per 
incrementi più grandi). Per reimpostare i numeri misura alle posizioni di defualt originali, selezi-
onarli e scegliere Layout > Riprisitina posizione (comando rapido Ctrl+Maius+P o xXP).

Se i numeri misura appaiono anche sopra o sotto altri righi nella partitura, trascinando un numero 
misura cambia anche la posizione di quel numero misura sopra o sotto gli altri righi nei quali 
appare.

To Coda Ø 1.2.  3. D.C. al Coda Ø CODA
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Nascondere i numeri misura
Per nascondere i numeri misura, selezionarli e scegliere Modifica > Mostra o nascondi >
Nascondi (comando rapido Ctrl+Maius+H o xXH).

Per maggiori informazioni sull’occultamento di oggetti, b Nascondere oggetti.

Cambi di numero misura
Per far ripartire i numeri misura da un numero particolare (per esempio, all’inzio di una nuova 
sezione, brano o movimento) o passare a un formato diverso del numero misura (per numerare 
misure aggiunte “1a, 1b, 1c,” , ad esempio) si può creare un cambio di numero misura:

* Per far ripartire i numeri da una misura particolare, selezionarla o assicurarsi di non avere selez-
ionato nulla e scegliere Crea > Altro > Cambio numero misura; oppure:

* Per modificare i numeri misura di un intervallo di misure selezionare le misure alle quali cambi-
are la numerazione e scegliere Crea > Altro > Cambio numero misura. (Ciò è particolarmente 
utile per cambiare il formato del numero misura; Sibelius reimposta opportunamente la 
sequenza al formato originale alla fine del passaggio selezionato).

In ogni caso, apparirà questa finestra di dialogo:

Le opzioni dei pulsanti di opzione sono:

* Nuovo numero battuta: consente di specificare un particolare nuovo numero misura dal 
quale ripartire; impostarlo a 1 per ricominciare la numerazione all’inizio di un nuovo movi-
mento.

* Segui numeri battuta precedente: è più utile se usata insieme all’opzione Cambia formato; 
consente di proseguire una sequenza esistente con un nuovo formato. Per esempio, se il numero 
della misura che precede quella del cambio numerazione è 2 e si sceglie Segui numeri battuta 
precedente impostando Cambia formato a 1a, 1b, 1c..., il cambio di numero misura che 
appare sarà “2a.”.

* Nessun numero battuta (e nessun contatore): permette di specificare se Sibelius debba sal-
tare completamente la misura alla quale è attaccato questo cambio di numero misura; è utile se, 
ad esempio, bisogna dividere una misura su un break di sistema a causa di due misure irregolari 
e si vuole essere sicuri che la seconda misura irregolare non falsi i numeri misura. Questa opzi-
one genera un cambio di numero misura visibile solamente quando è attiva l’opzione Vista >
Oggetti nascosti e visualizza un numero misura racchiuso in parentesi quadra.
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La differenza tra Segui numeri battuta precedente e Nuovo numero battuta è che un cambio 
di numero misura in Segui numeri battuta precedente si aggiorna trascinandolo con il mouse; 
nell’esempio precedente, trascinando il numero misura “2a” a destra esso cambierà in “3a”, “4a”, 
“5a”, ecc., mentre un cambio di numero misura ad un Nuovo numero battuta specifico sarà 
sempre lo stesso. Come per Segui numeri battuta precedente, i cambi di numero misura in 
Nessun numero battuta (e nessun contatore) s’aggiornano dinamicamente spostandoli nella 
partitura.

Cambiando il formato del numero misura, normalmente si usa l’opzione Segui numeri battuta 
precedente e si seleziona il passaggio di misure da rinumerare, in modo che Sibelius possa reim-
postare automaticamente la numerazione al termine del passaggio.

Il box di spunta Agg. testo consente di specificare una scritta da inserire prima o dopo i numeri 
misura; si può dire a Sibelius d’aggiungere la scritta “nuovo” dopo il numero misura (per una 
numerazione 1 new, 2 new, 3 new, ecc.), oppure aggiungere la scritta “orig ” prima del numero 
misura (per una numerazione orig 1, orig 2, orig 3, ecc.).

Cambia formato: permette di specificare un nuovo formato di numeri misura:

* 1, 2, 3...: formato di numero misura standard che usa solo i numeri.
* 1a, 1b, 1c... e 1A, 1B, 1C...: questo formato si usa spesso nella musica per le produzioni tea-

trale, ove variazioni dell’ultimo minuto (misure extra nell’overture per dare più tempo agli attori 
di trovare i segni, ad esempio) non devono interferire con la numerazione misure del resto dello 
spettacolo. In generale, quindi, le misure inserite sono numerate dopo quella originale che seg-
uono; inserendo quattro misure dopo la vecchia misura 2, le nuove misure saranno numerate 2a, 
2b, 2c, 2d, e la misura successiva avrà ancora il numero 3. Talvolta, questo formato si usa anche 
per numerare le misure dei 2° finali (misure 2a volta).

* a, b, c... e A, B, C...: questo formato è molto usato per i passaggi introduttivi (per esempio, le 
prime otto misure di una canzone prima che il cantante inizi sono numerate a–h e la nona mis-
ura ha il numero 1.

Si noti che impostando il formato del numero misura a qualsiasi cosa diversa da 1, 2, 3..., Sibelius 
mostra sempre i numeri su ogni misura, ignorando qualsiasi impostazione generale eventual-
mente definita nelle opzioni Frequenza della pagina Numeri Battuta (finestra di dialogo House 
Style > Regole tipografia).

È possibile copiare e cancellare i cambi di numero misura (a differenza dei normali numeri mis-
ura) e si può anche spostare un cambio di numero misura in orizzontale e verticale fino a tre spazi 
dalla stanghetta alla quale appartiene – spostandolo di più scatterà alla misura più vicina.

Comando Go to Bar
Per saltare subito a una misura selezionare Modifica > Vai a misura (Ctrl+Alt+G o zXG), inser-
ire il numero misura e cliccare su OK; ci sono due cose da sapere su questo comando:

* I numeri misura si possono inserire in uno qualsiasi dei formati supportati; se Sibelius non trova 
un numero misura che corrisponda esattamente, ne suggerisce uno simile disponibile.

* Se nella partitura appare più volte lo stesso numero misura (perché, ad esempio, ci sono più 
movimenti nello stesso file) Sibelius cerca più avanti dall’inizio della partitura o della selezione 
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corrente; per andare al numero misura corrispondente successivo selezionare di nuovo 
Modifica > Vai a misura e cliccare su OK senza cambiare il numero misura che si sta cercando.

Numero sulla prima misura
Inserendo una sezione da una lunga partitura può essere utile inziare con un numero misura 
diverso da 1; per farlo, inserire una cambio di numero misura all’inizio (vedere in precedenza).

Misure d’attacco (upbeat)
Se la musica inizia con una misura d’attacco (upbeat) è più logico assegnare alla prima misura 
completa il numero 1 invece del numero 2 (come accadrebbe). Sibelius assegna automaticamente il 
numero 0 alle misure d’attacco.

Numeri misura nelle parti
Per i numeri misura nella partitura e nelle parti si possono usare stili di test diversi, poiché Sibelius 
ha stili di testo peculiari per la partitura (Numeri battuta) e le parti (Numeri battuta (parti)). 

Per cambiare simultaneamente l’aspetto dei numeri misura in tutte le parti (invece di modificare 
singolarmente ogni parte) usare la pagina House Style nella finestra di dialogo Multiple Part 
Appearance (b Finestra Aspetto parte multipla).
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3.7 Numeri pagina

Sibelius numera automaticamente le pagine nella partitura seguendo (di default) convenzioni uni-
versali (per libri di testo e musicali) secondo cui le pagine a destra hanno sempre il numero dis-
pari, quelle a sinistra hanno sempre il numero pari e la prima pagina non è numerata.

Nelle pagine a doppia facciata, normalmente i numeri pagina sono collocati sul bordo esterno della 
pagina (cioè il bordo più lontano dalla rilegatura) mentre in quelle a una sola facciata in genere 
sono collocati sul lato destro (o talvolta al centro, sebbene nei circoli tipografici ciò sia considerato 
poco elegante!): I numeri pagina appaiono quindi più vicino al pollice quando si scorre una partit-
ura e ciò ne migliora la visibilità. Indifferentemente dalla rilegatura, in genere i numeri pagina 
sono in cima alla pagina.

Poiché Sibelius segue queste convenzioni, raramente bisogna intervenire sui numeri pagina nella 
partitura, ma lavorando in layout complessi con pagine vuote a inizio partitura o più brani nello 
stesso file, può essere necessario modificare la numerazione pagina: per farlo si utilizza l’opzione 
Crea > Altro > Cambo numero pagina.

Cambio di numero pagina
Con un cambio di numero paigna, si può passare ad uno dei vari formati di numero, ripartire da 
qualsiasi punto con la numerazione pagina e nascondere i numeri pagina che seguono. Innanzi-
tutto selezionare qualcosa (una misura, ad esempio) nella pagina alla quale applicare un cambio di 
numero e scegliere Crea > Altro > Cambio numero pagina; si apre questa finestra di dialogo:

* New page number: consente di specificare il primo numero pagina nella sequenza; disatti-
vando questo box, il cambio di numero pagina che si crea segue la sequenza esistente.

* Si può scegliere una tra le quattro opzioni Formato:
% 1, 2, 3... : formato di default dei numeri Arabi.
% a, b, c... e A, B, C...: schemi alfabetici minuscoli e maiuscoli, utili per la pagina di copertina.
% i, ii, iii... e I, II, III...: numeri romani minuscoli e maiuscoli, utili anch’essi per la pagina di 

copertina.
* Infine si può scegliere quali saranno i numeri pagina visibili influenzati dal cambio di numerazi-

one:
% Mostra numeri pagina: mostra tutti i numeri pagina (fino al cambio di numero pagina suc-

cessivo).
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% Nascondi primo numero pagina: nasconde il primo numero pagina del cambio numerazi-
one e mostra tutti quelli successivi (fino al cambio di numero pagina successivo).

% Nascondi numeri pagina: nasconde tutti i numeri pagina (fino al cambio di numero pagina 
successivo).

Cliccando OK, Sibelius crea i rispettivi cambi di numero pagina; si noti che Sibelius crea anche un 
break di pagina alla fine della pagina stessa, perché gli è stato detto d’inserire un cambio di numero 
pagina ad una posizione specifica, quindi il programma deve correggere il layout della partitura 
per garantire che il cambio di numero pagina resti sulla giusta pagina.

Per cambiare il numero pagina su una pagina vuota (creata con un break di pagina speciale – 
b Break - Interruzioni), assicurarsi che non ci sia niente selezionato prima di scegliere Crea >
Altro > Cambio numero pagina; poi, una volta cliccato OK nella finestra di dialogo, cliccare sulla 
pagina vuota nella quale deve avvenire il cambio di numero pagina.

Selezionare i numeri pagina
Sebbene non si possano selezionare i numeri pagina automatici che Sibelius crea di default è possi-
bile selezionare i numeri pagina generati dai cambi di numero pagina.

Per selezionare tutti i cambi pagina della partitura, si può selezionare, ad esempio, l’intera partitura 
con il comando Modifica > Seleziona > Seleziona tutto (comando rapido Ctrl+A o XA) e poi 
scegliere Modifica > Filtro > Cambi numero pagina; si può quindi nascondere o cancellare i 
cambi di pagina selezionati – vedere in seguito.

Nascondere i numeri pagina
Per nascondere i numeri pagina dopo aver creato un cambio di numero pagina non è necessario 
creare un nuovo cambio di numero pagina: basta selezionare uno dei numeri pagina influenzati 
dal cambio di numero pagina e scegliere Modifica > Mostra o nascondi > Nascondi (comando 
rapido Ctrl+Maius+H o xXH).

Per nascondere solo il primo numero di pagina in un cambio di numero pagina, assicurarsi di 
selezionare quel numero pagina; selezionandone un altro, infatti, saranno nascosti tutti i numeri 
pagina influenzati dal cambio di numero pagina.

Per altre informazioni sull’occultamento di oggetti, b Nascondere oggetti.

Cancellare i numeri pagina
Non è possibile cancellare numeri pagina automatici (sebbene sia possa nasconderli), ma si pos-
sono cancellare quelli generati dai cambi di numero pagina – selezionandoli (vedere sopra) e pre-
mendo Canc. Cancellando il break di pagina al quale è attaccato un cambio di numero pagina, si 
cancella anche il cambio di numero pagina, ma non è vero il contrario (cancellando il cambio di 
numero pagina, cioè, non si cancella il break di pagina).

Per non vedere i numeri pagina selezionare una misura sulla prima pagina della partitura, aprire la 
finestra Crea > Altro > Cambio numero pagina e attivare l’opzione Nascondi numeri pagina.

Numeri pagina nelle parti
In genere, le parti strumentali sono numerate da pagina 1, indipendentemente dalla partitura. 
Di default lo fa Sibelius, ma volendo si può fare in modo che le parti usino gli stessi numeri pagina 
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della partitura con le opzioni nella pagina Layout della finestra di dialogo Multiple Part Appear-
ance – b Finestra Aspetto parte multipla. Si può anche creare un cambio di numero pag-
ina in una parte (che influenzerà solo la parte nella quale è stato creato).

Mostrare il numero di pagina sulla pagina 1
Di default, Sibelius numera la partitura dalla pagina 1 e non mostra un numero pagina sulla prima 
pagina (anche se attivando l’opzione Vista > Oggetti nascosti si vedrà un “1” grigio nell’angolo in 
alto a destra della pagina). Per rendere visibile il numero sulla prima pagina, usare l’opzione Crea >
Altro > Cambio numero pagina (per creare un cambio di numero pagina a 1 sulla prima pagina 
della partitura) e scegliere Mostra numeri pagina.

Numero sulla prima pagina
Ecco alcuni consigli su come deve essere il numero sulla prima pagina nei vari casi:

* Se la partitura inizia con una pagina sinistra creare una cambio di numero pagina alla pagina 2 
sulla prima pagina (o lasciarla a 1 se il file di Sibelius ha la pagina del titolo).

* Se la partitura non ha copertina (sulla pagina frontale c’è musica) la pagina frontale è pagina 1.
* Se la pagina frontale è una copertina ma la carta è la stessa del resto della partitura, la copertina 

è pagina 1; quindi se la musica inizia sulla prima pagina sinistra, creare un cambio di numero 
pagina a pagina 2 (a meno che la partitura abbia una pagina di titolo).

* Se la partitura ha una copertina separata in cartoncino, normalmente la pagina 1 è la prima pag-
ina destra sotto la copertina.

Si ricordi che in genere la pagina 1 non ha stampato un numero.

Posizionare i numeri pagina rispetto al margine
Di default, i numeri pagina sono allineati con i margini sia sulle pagine sinistre che destre. 
Tuttavia, alcuni editori preferiscono allineare i numeri pagina delle pagine sinistre al lato sinistro 
del rigo; per usare questa convenzione:

* Selezionare House Style > Modifica stili di testo.

* Selezionare Numeri Pagina dall’elenco degli stili di testo e cliccare Modifica.

* Nella finestra di dialogo Stile Testo Accollatura che appare selezionare la pagina Pos Oriz-
zontale e attivare l’opzione (poco auto-esplicativa) A sinistra della pagina, allinea al margine 
del rigo 'No Nomi'. 

* Cliccare OK e Chiudi.

Numeri pagina in partiture a una sola facciata
Per stampare la partitura su una sola facciata invece che su due, bisogna cambiare posizione ai 
numeri pagina, in modo che appaiano sempre sul lato destro della pagina:

* Selezionare House Style > Modifica stili di testo.

* Dall’elenco degli stili di testo scegliere Numeri Pagina e cliccare Modifica.

* Nella finestra di dialogo Stile Testo Accollatura che appare selezionare la pagina Pos Orizzon-
tale e impostare l’opzione Allinea nella pagina a Destra.

* Cliccare OK e Chiudi.
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Numeri pagina nei testi
Talvolta i numeri pagina fanno parte di un’intestazione o piè di pagina. Per farlo, si può aggiungere 
il numero pagina corrente a un’intestazione o piè di pagina (o piuttosto a un altro testo) usando il 
jolly \$PageNum\. Per esempio:

* Innanzitutto si devono nascondere i numeri pagina automatici di Sibelius.; selezionare la prima 
misura della partitura e scegliere Crea > Altro > Cambio numero pagina.

* Cliccare il pulsante circolare Nascondi numeri pagina e cliccare OK. (se non è già attiva, atti-
vare l’opzione Vista > Oggetti nascosti; si noti che i numeri pagina sono ancora lì, ma ora sono 
tutti nascosti).

* A questo punto modificare l’intestazione di testo esistente o usare l’opzione Crea > Testo > Altro 
Testo di sistema > Intestazione (dopo prima pagina) per crearne una nuova.

* Aggiungere \$PageNum\ all’intestazione; quando la si modifica, ad esempio, l’intestazione 
potrebbe apparire così: \$Title\ – \$Composer\ – p.\$PageNum\; ciò produce qualcosa come 
“Sinfonia no. 40 – Mozart – p.15”. I risultati sono visibili solo al termine delle modifiche e Sibel-
ius sostituisce automaticamente i jolly.

Per maggiori informazioni sui jolly, b Jolly.

Comando Go to Page
Per saltare subito a una pagina qualsiasi selezionare Modifica > Vai a pagina (Ctrl+Maius+G o
xXG), digitare il numero pagina e cliccare OK. Si può scrivere un numero pagina in qualsiasi for-
mato riconosciuto da Sibelius.
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3.8 Segni di prova

I segni di prova (o richiami per la concertazione) sono grandi lettere o numeri che indicano posiz-
ioni importanti nella partitura. Lettere e numeri sono aggiunti automaticamente in sequenza da 
Sibelius – si deve solamente indicare dove metterli. I segni di prova si possono quindi creare e can-
cellare liberamente senza preoccuparsi di assegnargli nuove lettere o numeri.

Creare i segni di prova
* Selezionare Crea > Richiamo per la concertazione. Si apre questa finestra di dialogo:

* Consecutivo: il segno di prova creato continua nella sequenza già stabilita (o diventa il primo 
della sequenza) ed usa il formato definito nella finestra di dialogo House Style > Regole 
tipografia (vedere in seguito). In genere è ciò che serve, quindi questo è quello che si ottiene con 
il comando rapido Ctrl+R o XR (senza che Sibelius mostri la finestra di dialogo).
Per esempio, inserendo più segni di prova consecutivi in un rigo, essi appariranno con le lettere 
A B C D E. Cancellando B, i segni successivi cambiano automaticamente da C D E a B C D, per 
mantenere la sequenza. Analogamente, creando un nuovo segno di prova tra altri due sono rego-
lati i segni successivi.

* Inizia a: permette di creare un segno di prova fuori dalla sequenza e riavviare la sequenza da un 
punto particolare. Scrivere il segno desiderato nel box; Sibelius continuerà quindi la sequenza 
per i segni di prova Consecutivo – per esempio, se si chiede di partire con Y2, questo segno 
sarà seguito prima da Z2, poi da A3, B3, ecc..

* Nuovo prefisso/suffisso: consente d’inserire un testo fisso prima o dopo il segno di prova, per 
realizzare sequenze particolari dei segni di prova (A1, A2, A3, A4, o 1A, 2A, 3A, 4A, ecc.) diverse 
da quelle standard (volendo si può impostare un prefisso o suffisso per tutti i segni di prova – ved-
ere Opzioni Engraving Rules). Digitare il prefisso o suffisso desiderato nei box Prefisso o Suf-
fisso. L’opzione Sovrascrivi defaults permette di scegliere se il prefisso/suffisso specificato qui 
deve essere usato al posto del prefisso/suffisso di default definito nella finestra House Style >
Regole tipografia; per sostituire prefisso e suffisso di default attivare questa opzione.

* A questo punto cliccare su OK:
% Se non c’è una nota selezionata, il puntatore del mouse cambia colore e si può cliccare sopra 

una stanghetta per inserire il segno di prova.
% Se c’è una nota selezionata, il segno di prova si colloca automaticamente sopra la stanghetta 

all’inizio della misura successiva.
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Modificare i segni di prova
I segni di prova si trascinano, copiano e cancellano con le normali procedure. Quando sono trasci-
nati scattano orizzontalmente alle stanghette.

Come per le scritte tempo, le grandi partiture spesso hanno più di uno per ciascuno dei segni di 
prova – per esempio, uno sopra il sistema e un altro sopra gli archi nella musica orchestrale.

Spostando o cancellando il segno di prova in alto si spostano o cancellano anche tutti i duplicati 
più in basso nel sistema. Tuttavia, spostando o cancellando un duplicato del segno di prova invece 
di quello in alto, esso si comporta in modo indipendente. Ciò consente (ad esempio) di spostare o 
cancellare solo il segno di prova sopra gli archi se c’è una nota acuta che lo tocca.

È possibile cambiare i righi sopra i quali appaiono i segni di prova e altri oggetti di sistema – ved-
ere Posizioni degli oggetti di sistema a pagina 540.

Per spostare un segno di prova un po’ a sinistra o destra della stanghetta (in modo da evitare un 
ostacolo) selezionarlo e modificarne il valore X nel pannello Generale della finestra Proprietà.

Opzioni Engraving Rules
Il formato di tutti i segni di prova si sceglie nella pagina Richiami per la concertazione della 
finestra di dialogo House Style > Regole tipografia (comando rapido Ctrl+Maius+E o xXE). Le 
opzioni sono:

* A-Z, A1-Z1, A2... 
* A-Z, AA-ZZ, AAA... 
* 1, 2, 3... 
* Numero battuta 
* Nascondi tutto

Il formato cambia per tutti i segni di prova esistenti, quindi passando al terzo formato, la sequenza 
Y Z AA BB diventerà 25 26 27 28.

(Divertente: impostare i segni di prova al formato Numero battuta. Creare un segno di prova ed 
osservare cosa avviene trascinandolo da misura a misura!).

Le opzioni Prefisso e Suffisso permettono di specificare un testo da collocare prima e dopo la 
parte automatica di tutti i segni di prova. Ciò è utile se il font che si sta usando per i segni di prova 
ha caratteri speciali per disegnare box decorati attorno a lettere e numeri; il font Reprise Rehearsal 
di Sibelius è uno di questi (provare ad importare gli stili house Reprise, ad esempio).

Font, dimensione, box, ecc. si controllano cliccando sul pulsante Modifica Stile Testo. 
b Modifica stili di testo.

I segni di prova si rimpiccioliscono automaticamente nelle parti rispetto alla partitura. Si può con-
trollare la dimensione alla quale si riducono modificando lo stile di testo Richiami per la concer-
tazione. Selezionare House Style > Modifica stili di testo (Ctrl+Maius+Alt+T o xzXT), 
selezionare lo stile di testo Richiami per la concertazione e cliccare su Modifica. Regolare la 
dimensione Parti nella pagina Generale della finestra di dialogo Stile Testo in base alle esigenze. 
Per informazioni sull’uso delle parti, b Lavorare con le parti.
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3.9 Nomi strumento

b Strumenti, Modifica strumenti.

Ogni strumento ha due nomi – quello completo che in genere precede il primo sistema e il nome 
corto (abbreviazione) che di solito è prima dei sistemi successivi. Se si cambia un nome bisogna 
sistemare anche l’altro; i nomi cambiano in tutta la partitura, non solo nel sistema in cui si esegue 
la modifica.

Modificare i nomi strumento
Si può modificare il nome di qualsiasi strumento nella partitura – usare un’altra lingua, ad esem-
pio, o nominare un cantato Wozzeck al posto di Baritono. Cliccare sul nome a sinistra di uno dei 
sistemi e modificarlo come un qualsiasi altro testo.

La modifica del nome non cambia il tipo di strumento, quindi cambiando da “Violino” a “Flauto” 
lo strumento non diventa un flauto. Analogamente, cambiando da“Corno in FA” a “Corno in MIb” 
non cambia il trasporto e il Corno non diventa uno strumento in MIb. Per applicare questo tipo di 
modifica usare invece il comando Crea > Altro > Cambio strumento – b Strumenti.

È possibile modifcare il nome strumento all’inizio di un sistema che segue un cambio strumento 
come con un qualsiasi altro nome strumento.

Se nella partitura ci sono più strumenti identici e si vuole dare a tutti lo stesso nome, è più comodo 
usare il comando House Style > Modifica Strumenti e ensemble invece di modificare ogni 
nome singolarmente – b Modifica strumenti.

Nascondere i nomi strumento
Per non vedere i nomi strumento, disattivarli dalla finestra di dialogo House Style > Regole 
tipografia (vedere Formato e stile dei nomi).

Per rimuovere il nome di un singolo strumento selezionarlo e premere Canc – se in seguito si 
vuole rimettere il nome dello strumento, doppio-clic del mouse dove deve andare il nome e il cur-
sore riappare consentendo di digitare nuovamente il nome.

Spostare i nomi strumento
Si può spostare un nome strumento con il mouse; si spostano tutte le istanze del nome. Tuttavia, in 
genere, si regola la posizione dei nomi strumento modificandone l’allineamento – vedere For-
mato e stile dei nomi.

Formato e stile dei nomi
Per cambiare il formato dei nomi strumento scegliere House Style > Regole tipografia (comando 
rapido Ctrl+Maius+E o xXE) e selezionare la pagina Strumenti.

Le varie opzioni permettono di scegliere se usare il nome completo, abbreviato o nessun nome 
all’inizio della partitura, sui sistemi successivi e ad ogni nuova sezione (vedere in seguito).

Le impostazioni consigliate sono le seguenti:
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* In partiture con molti strumenti (es. orchestrali o bandistiche) specificare i nomi completi 
all’inizio (ed eventualmente a nuove sezioni) e nomi completi o abbreviati in seguito.

* In partiture per strumenti solisti e con pochi strumenti senza righi nascosti specificare i nomi 
completi all’inizio (ed eventualmente a nuove sezioni) e nessun nome in seguito.

* In parti, partiture per strumenti solisti ed esempi musicali, si può specificare di non inserire i 
nomi. Di default, nelle parti Sibelius non scrive i nomi accanto ai sistemi; scrive invece il nome 
strumento in cima alla pagina.

I nomi strumento sono controllati da uno stile di testo, quindi il loro font, dimensione, ecc. si può 
regolare come altri stili di testo scegliendo House Style > Modifica stili di testo (comando 
rapido Ctrl+Maius+Alt+T o xzXT). Selezionare Nomi strumento dall’elenco a sinistra e clic-
care Edit. L’allineamento orizzontale dei nomi strumento si regola nella pagina Pos Orizzontale 
(b Modifica stili di testo) e si può regolare la distanza dalla stanghetta iniziale alla quale 
appaiono modificando l’opzione Spazio tra nomi strumenti e stanghetta iniziale nella pagina 
Instruments della finestra di dialogo House Style > Regole tipografia.

Tradizionalmente i nomi strumento sono centrati in una colonna, ma così alcuni nomi possono 
trovarsi lontano dal rigo al quale si rifersicono se altri nomi nel sistema sono molto più larghi. Tal-
volta, quindi, i nomi strumento sono allineati a destra (o in rari casi, come nella musica bandis-
tica) a sinistra. I fogli manoscritti di Sibelius sono già configurati con nomi strumento adeguati, 
quindi usando il foglio manoscritto adatto per creare la propria partitura non c’è da preoccuparsi.

Alcuni formati più avanzati di nome strumento sono:

Si può scriverlo all’inizio della partitura con un doppio-clic del mouse sul 
nome per modificarlo. Si può modificare anche la forma abbreviata del 
nome su una pagina successiva.
Per scriverlo, doppio-clic del mouse sul nome strumento e premere Invio
(sulla tastiera del computer) tra ogni nome.

In questo esempio, creare un flauto singolo, aggiungere un rigo extra sotto 
(b Righi) e modificare il nome strumento: digitare “1 Invio Invio Fl. 
spazio spazio Invio Invio 2”. I numeri 1 e 2 sono posizionati correttamente 
in verticale ma si scostano leggermente se si cambia lo spazio tra i righi ris-
petto al valore di default.
Si ottiene creando il nome in un stile di testo giustificato a destra con la spa-
ziatura linea al 50%; digitare “1 Invio Clarinet spazio spazio spazio Invio
2.” Quando serve impostare lo stile di testo Instrument names a una spa-
ziatura linea del 50%; per altri nomi strumento che occupano più di una 
linea servirà un Invio extra tra le linee per spaziarle correttamente.
Qui “Violin I” è il nome sturmento e “divisi” è stato aggiunto digitando la 
scritta Expression al margine. Attenzione che questa scritta “divisi” è attac-
cata alla prima misura del rigo, quindi riformattando la partitura si 
potrebbe spostare; creare quindi un break di sistema alla fine del sistema 
precedente in modo che non si sposti.

reference.book  Page 215  Wednesday, April 16, 2008  4:28 PM



3. Testo

216

Nomi strumento in nuove sezioni
Le partiture costituite da più pezzi, brani o movimenti si dice abbiano più “sezioni”, ciascuna delle 
quali inizia spesso con un nuovo titolo; per le nuove sezioni di solito si scrivono i nomi strumento 
completi, anche se da qualche altra parte sono usati nomi abbreviati o nessun nome. Per farlo:

* Selezionare la misura finale della sezione precedente.
* Scegliere Finestra > Proprietà (comando rapido Ctrl+Alt+P o zXP), aprire il pannello Misure 

e attivare Fine sezione.

* Nella pagina Strumenti della finestra di dialogo House Style > Regole tipografia impostare il 
comportamento dei nomi Su nuove sezioni in Completo (o eventualmente Breve).

Per maggiori informazioni su partiture con più sezioni, b Dividere e unire le partiture.

Nomi strumento nelle parti dinamiche
Raramente i nomi strumento sono stampati sul lato sinistro di ogni rigo nelle parti strumentali; si 
tende invece a stamparli nell’angolo in alto a sinistra della prima pagina (quindi come parte di 
un’intestazione mobile). Nelle parti dinamiche, Sibelius gestisce tutto questo usando i jolly 
(b Jolly), in modo da non toccare l’intestazione. Tuttavia, se non si è abituati a lavorare con i jolly 
e si prova a modificare le intestazioni, è possibile che si vanifichi il lavoro di Sibelius e si generi 
confusione. I problemi più comuni sono tre:

Tutte le parti indicano lo stesso nome strumento nell’angolo in alto a sinistra della prima pagina

Ciò avviene se si modifica direttamente l’oggetto di testo esistente nell’angolo in alto a sinistra sulla 
prima pagina dell’intera partitura o di una delle parti (che è meglio evitare). Il jolly usato per il 
testo in cima alla prima pagina è \$PartName\ e prende il suo valore dal campo Part name nella 
finestra File > Info partitura. Per correggere l’errore, basta sistemare l’oggetto di testo:

* Se necessario passare alla partitura completa premendo W.

* Doppio-clic del mouse sull’oggetto di testo nell’angolo in alto a sinistra sulla prima pagina per 
modificarlo.

* Cancellare il testo esistente e sostituirlo con la stringa \$PartName\ e premere Esc per ter-
minare l’editing.

* Si noti che la scritta ora è “Full Score”.
* Se nella partitura appare il testo ma si desidera nasconderlo selezionare l’opzione Modifica >

Mostra o nascondi > Mostra nelle parti.

Per cambiare questo testo in una delle parti, il segreto è modificare il campo Part name in Score 
Info. Ci sono due modi per farlo:

In alcune partiture corali, a sinistra dei sistemi non sono usati i nomi stru-
mento. Essi sono invece scritti in maiuscolo in testo Technique sopra ogni 
rigo (sopra la chiave) all’inizio del brano e ovunque cambino i cantanti nel 
sistema. Questa convenzione è spesso usata nelle edizioni di musica classica 
e in partiture ove nella maggior parte dei sistemi ci sono gli stessi righi. I 
nomi strumento per i cantanti corali in genere sono scritti in maiuscolo.
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* Singolo clic del mouse sul nome della parte nella finestra Parts, digitare il nuovo nome e premere 
Invio; oppure

* Visualizzare la parte, selezionare File > Info partitura e modificare lì il campo Part name.

Nelle parti non appaiono i nomi strumento

Se nell’angolo in alto a sinistra sulla prima pagina della parte o nell’intestazione delle pagine suc-
cessive non c’è il nome strumento, provare ad eseguire una di queste operazioni:

* Innanzitutto, assicurarsi che sia attiva l’opzione Vista > Oggetti nascosti; osservare l’inizio della 
partitura. Il nome strumento deve apparire in grigio (nascosto) o in nero (visibile).

* Se il nome strumento c’è ma in grigio, selezionarlo e scegliere Modifica > Mostra o nascondi >
Mostra nelle parti; il nome sarà nascosto nella partitura ma visibile in tutte le parti.

* Se non c’è il nome strumento, significa che in qualche modo è stato cancellato il rispettivo 
oggetto di testo. Per inserirlo di nuovo:
% Assicurarsi che sia visibile la prima misura dell’intera partitura o parte.
% Selezionare la prima misura della partitura o parte, in modo che si circondi di un singolo box 

blu.
% Selezionare Crea > Testo > Testo speciale > Nome strumento in alto a sinistra.

% Appare un cursore lampeggiante: digitare \$PartName\ e premere Esc.

In parti a più righi manca il nome strumento a sinistra di ogni rigo

Di default, Sibelius non mostra i nomi strumento a sinistra di ogni rigo nelle parti dinamiche (per-
ché la maggior parte di esse ha un solo rigo). Tuttavia, nei casi in cui ci sono più righi nella stessa 
parte può essere utile vedere i nomi strumento all’inizio del primo sistema (ed eventualmente 
anche in quelli successivi). Per farlo:

* Visualizzare la parte nella quale far apparire i nomi strumento.
* Selezionare House Style > Regole tipografia e andare nella pagina Instruments.
* Impostare i nomi strumento ad apparire completi (Full) a inizio partitura (Start of score) e 

abbreviati (Short) successivamente (se si desidera), quindi cliccare OK.

Se ci sono molte parti nelle quali serve vedere i nomi strumento, invece di ripetere questa proce-
dura per ogni singola parte è più comodo esportare uno stile house da questa parte ed importarla 
nelle altre – vedere Esportare stili house dalle parti a pagina 484.

Per maggiori informazioni sull’uso delle parti dinamiche, b Lavorare con le parti.

Righi senza nome
Per creare righi senza nome selezionare l’ensemble All instruments dalla finestra di dialogo 
Crea > Strumenti e righi e scegliere la famiglia Others che ha i righi di violino (treble staff) e 
basso (bass staff); questi righi non rappresentano alcun strumento particolare.

Se invece si preferisce non vedere i nomi strumento di tutti gli strumenti nella partitura modificare 
le opzioni nella pagina Instruments della finestra di dialogo House Style > Regole tipografia
(vedere Formato e stile dei nomi).
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3.10 Modifica stili di testo

b Lavorare con i testi, Posizioni di default.

Questo capitolo spiega come modificare font, dimensione e allineamento degli stili di testo e altre 
funzioni.

È possibile ridefinire non solo i normali tipi di testo, ma anche segni di prova, numeri dei tuplet, 
numeri misura, numeri pagina e nomi strumento. Ogni modifica eseguita si riflette immediata-
mente in tutti i testi dello stile modificato ogni volta che appaiono nella partitura.

Per eseguire rapide modifiche ai font di tutti gli stili di testo nella partitura usare la finestra di dia-
logo House Style > Modifica tutti i font; se invece c’è bisogno di regolare singoli stili di testo 
usare la finestra di dialogo House Style > Modifica stili di testo.

Finestra Modifica tutti Font
Per cambiare tutti i font utilizzati nella partitura selezionare 
House Style > Modifica tutti font. Questa finestra di dial-
ogo cambia subito i font di molti stili di testo.

* Carattere Testo Principale: è la famiglia di font usata da 
stili di testo come Title, Composer, Tempo, Expression, 
Technique, Lyrics line 1 e così via. Modificando questa 
impostazione si può cambiare radicalmente l’aspetto della 
partitura.
* Carattere Musica Principale: è la famiglia di font usata 
per i simboli musicali nella partitura (note, pause, chiavi, 

tempi in chiave e così via. b Font musicali.
* Carattere Testo Musica: è il font usato dalle istruzioni di testo che impiegano simboli speciali, 

come quelli dinamici (es. mf). È bene che il font per i testi musicali sia della stessa famiglia del 
font musicale: se si sceglie Opus, Helsinki o un altro font musicale “scolpito” scegliere Opus Text, 
Helsinki Text o il font musicale specifico equivalente, se disponibile; se si sceglie Reprise, 
Inkpen2 o un altro font musicale “manoscritto” scegliere Reprise Text o Inkpen2 Text.

Cliccando su OK, Sibelius aggiorna istantaneamente l’aspetto della partitura; se il risultato non è 
soddisfacente, selezionare Modifica > Undo (comando rapido Ctrl+Z o XZ).

Dopo aver cambiato il font musicale, può darsi che selezionando l’intera partitura ed eseguendo il 
comando Layout > Ripristina spaziatura note (Ctrl+Maius+N o xXN) l’aspetto della partitura 
migliora se i nuovi font scelti sono molto più larghi o stretti di quelli usati prima.

Lo stesso è vero se la partitura contiene delle parole e si cambia il font di testo principale.

Finestra Modifica Stili Testo
Per cambiare o creare uno stile di testo selezionare House Style > Modifica stili di testo 
(comando rapido Ctrl+Maius+Alt+T o xzXT).
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Si supponga di modificare uno stile di rigo esistente, come Technique; nell’elenco, cliccare su 
Technique, quindi su Modifica.

Per creare invece un nuovo stile di testo basato su quello Technique, selezionarlo nell’elenco, clic-
care su Nuovo e scegliere uno stile di testo simile a quello che si desidera creare; nel caso di un 
nuovo stile di testo per le parole, ad esempio, basarlo su uno stile esistente Linea versi1. Sibelius 
chiede se deve veramente creare un nuovo stile di testo basato su questo esistente; cliccare su Sì.

Sia che si modifichi uno stile di testo esistente o se ne crei uno nuovo, si apre una finestra di dial-
ogo con una di pagine:

Si noti che il nome (nella barra del titolo) specifica il tipo di stile di testo in modifica: Stile testo 
rigo, Stile testo accollatura o Stile testo pagina vuoto. Non si può cambiare il fatto che lo stile 
di testo esistente sia di rigo, sistema o pagina vuota e nemmeno si deve farlo – si noti però che 
quando si crea un nuovo stile di testo basato su uno esistente, il nuovo stile sarà dello stesso tipo 
(rigo, sistema o pagina vuota) di quello esistente.

Una volta definite le impostazioni di stile, cliccare su OK ed esse appariranno subito nella partit-
ura, modificando tutti i testi presenti in quello stile.

Pagina Generale
Nome: è il nome dello stile e si può cambiare. Modificandolo, però, non si crea un nuovo stile; si 
rinomina solamente quello corrente. Si fa per assegnare un nuovo utilizzo a uno degli stili; ad 
esempio, se non si vuole mai usare Technique ma uno stile simile chiamato “Stage directions”, è 
sufficiente modificare il nome Technique per indicarne il nuovo uso. Altrimenti, si deve creare un 
nuovo stile basato su quello Technique, come descritto in precedenza. Stili speciali (come quelli 
per i numeri misura) operano sempre nei loro modi particolari anche cambiandone il nome.

Font: definisce il font. Cliccare su un font nell’elenco per cambiarlo. Si può anche rendere il font 
Grassetto, Corsivo o Sottolineato. Il sottolineato è molto raro in musica, quindi non usarlo (a 
meno che sia veramente necessario). Per consigli su font e stili da usare in musica vedere in 
seguito.
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Angolo consente di scrivere un testo angolato; anche questo è raro.

Dimensioni: dimensione del testo; Sibelius permette di stabilirla in modo indipendente nella par-
titura e nelle parti (b Lavorare con le parti). In musica, spesso il testo è proporzionale alla 
dimensione del rigo: se il rigo è grande sono grandi anche tutti i segni dinamici, le parole e così via. 
Il numero a sinistra è un valore relativo: è la dimensione del testo se quella del rigo è 0,28” (7 mm). 
In generale è più facile specificare le dimensioni dei testi in musica per un rigo dalle dimensioni 
standard come questo. Il numero a destra è un valore assoluto; indica cioè quanto s’allarga il testo 
nel rigo con la dimensione corrente; cambiando un numero l’altro cambia automaticamente. 

Assoluto: questa opzione crea stili di testo sempre alla stessa dimensione, indipendentemente da 
quella del rigo. Ciò è utile, ad esempio, per dare una dimensione fissa ai titoli nelle parti o per avere 
i segni di prova sempre alla stessa dimensione (che non siano buffi su righi piccoli).

Trasponi nomi di accordo/nota: si usa solo per i simboli accordo e dice a Sibelius di cambiarli 
quando la musica è trasportata.

Interpreta durante la riproduzione: specifica se in riproduzione gli oggetti di testo che usano lo 
stile di testo modificato devono essere interpretati o meno dal dizionario di riproduzione – 
b Dizionario di riproduzione.

Menu contestuale: permette di scegliere l’elenco di scritte utili che appare con un clic-destro 
(Windows) o Control-clic (Mac) quando s’inserisce lo stile di testo. b Lavorare con i testi.

Pagina Bordo
Circolare: scrive un cerchio attorno al testo. Le scritte cerchiate 
sono rare in musica; si usano solo per specificare le corde della chi-
tarra e, talvolta, numeri misura e segni di prova.

Quadrato: scrive un box attorno al testo. È più diffuso dei cerchi e si 
usa per i segni di prova; meno comunemente per numeri misura e 
importanti istruzioni per i musicisti.

Sibelius consente anche di scrivere un testo in cerchio e box – cosa 
che avviene comunque assai raramente.

Lo spessore della linea usata per il box e il cerchio è definita dal 
parametro Bordi testo nella pagina Testo della finestra House 
Style > Regole tipografia (Ctrl+Maius+E o xXE).

Cancella sfondo: questa opzione è per i testi sopra le linee del rigo o le stanghette. Si usa princi-
palmente per i numeri sulle tablature di chitarra, ma si può attivare (ad esempio) per i segni 
dinamici (nel caso si debbano collocare attraverso la stanghetta di una misura).

Posizione: specifica dove deve andare e quanto grande deve essere il cerchio o box e la dimensione 
dell’area cancellata dall’opzione Erase background. Sibelius inserisce valori di default adeguati.

Pagina Pos Orizzontale
Poiché il testo di rigo si può attaccare solo a posizioni ritmiche in una misura, le opzioni Allinea 
alla nota sono le uniche disponibili per il testo di rigo. Il testo di sistema può attaccarsi a posizioni 
ritmiche (es. Tempo) o alla pagina - es. Intestazione - (dopo prima pagina), perciò si può sceg-

Dimensioni carattere
Le dimensioni dei testi sono 
specificate in punti da 1/72 di 
pollice (circa 0,35 mm). Poiché 
la dimensione delle lettere varia 
(anche nelle maiuscole) il crite-
rio di misura usato per definire 
la dimensione è la distanza 
dalla cima della lettera più alta 
alla base di quella più bassa. 
Essa è circa una volta e mezza 
l’altezza delle maiuscole. 
Nei libri la dimensione del testo 
è di circa 10 punti.
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liere Allinea alla nota o Allinea alla pagina. Il testo di pagina vuota non si può mai attaccare a 
posizioni ritmiche in una misura (perché non ci sono misure su pagine vuote!) quindi si può sceg-
liere solo Allinea alla nota.

Per i testi che usano l’opzione Allinea alla nota, Sinistra / Centrato / Destra specificare come 
deve essere collocato il testo rispetto a dove è stato creato; queste opzioni influenzano anche 
l’allineamento di più linee di testo nello stesso oggetto di testo. L’allineamento a sinistra è quello 
più diffuso, ma alcuni tipi di testo si possono allineare in modo diverso – le diteggiature, ad esem-
pio, spesso sono centrate sopra le note.

Per impostare la distanza orizzontale del testo dal punto in cui è stato creato, b Posizioni di 
default.

Le opzioni Allinea alla pagina (solo per i testi di sistema e pagine vuote) allineano il testo a sinis-
tra/centro/destra della pagina – ad esempio, il titolo di un brano è quasi sempre centrato sulla pag-
ina. Tuttavia, si possono anche scegliere le opzioni Entro / Fuori margine usate per le stampe a 
doppia facciata e che si spiegano meglio con un esempio: nella stampa a una facciata, i numeri pag-
ina si collocano in generale a destra; nella stampa a facciata doppia, invece, nelle pagine destre i 
numeri pagina sono a destra e nelle pagine sinistre sono a sinistra – sul bordo esterno appunto.

In generale, quando si creano, i testi allineati alla pagina s’attaccano sempre alla prima misura di 
un sistema (es. il testo Titolo) o alla prima misura nella pagina se il testo è allineato in verticale 
sulla pagina (es. il testo Footer).

Se il testo è impostato all’opzione Allinea alla pagina ci sono altre opzioni:

* A sinistra della pagina, allinea al margine del rigo ‘No nomi’: riguarda i numeri pagina – 
b Numeri pagina.

* Approssima al margine: evita che il testo sia trascinato lontano dal margine al quale è 
allineato.

* Relativo solo ai margini della prima pagina: dice a Sibelius di allineare sempre il testo ai 
margini d’inizio della partitura, ignorando cambi di margine successivi (introdotti da speciali 
break di pagina – b Break - Interruzioni). È utile per intestazioni, piè di pagina e numeri 
pagina.

Pagina Pos Verticale
Per impostare la distanza verticale del testo dal punto in cui è stato creato, b Posizioni di default.

Spaziatura delle linee: stabilisce la distanza tra le linee del testo quando di preme Invio (sulla 
tastiera principale) alla fine di una linea. È espressa in percentuale di dimensione del punto. 120% è 
un valore normale per i libri, mentre 100% è più adatto al testo musicale. Per inciso, la spaziatura 
linea è nota nel gergo tipografico come leading (che fa rima con “heading”), dai tempi in cui 
bisognava scrivere strisce supplementari di interlinee per spaziare opportunamente le linee di testo.

Approssima a fine o inizio pagina: questa opzione è utile per collocare il testo che si trova in una 
posizione fissa sulla pagina, come numeri pagina, intestazioni, piè di pagina e note a piè di pagina. 
Attivandola si può quindi impostare il valore mm dal margine superiore/inferiore per lo stile di 
testo e inserire valori diversi per partitura e parti, se si desidera (1 pollice = 25,4 mm) – 
b Lavorare con le parti.

reference.book  Page 221  Wednesday, April 16, 2008  4:28 PM



3. Testo

222

Titoli, segni di prova, numeri misura, nome del compositore e così via di solito si posizionano ris-
petto al rigo in alto invece che al margine della pagina. Si può anche specificare di posizionare 
questo tipo di stile di testo solo rispetto ai margini della prima pagina (Relativo solo ai margini 
della prima pagina) ignorando di nuovo tutti i cambi margine dovuti a speciali break di pagina.

Posizioni oggetti di sistemi multipli: disponibile solo per i testi di sistema, questa opzione con-
sente di scrivere il testo sopra più di un rigo. Ad esempio, i titoli vanno solo sopra il rigo in alto 
(cliccare quindi solo su Rigo iniziale), mentre in partiture orchestrali i segni di prova in genere 
vanno sia sopra il rigo in alto sia sopra gli archi (quindi cliccare su Rigo iniziale e 2a posizione). 
Nella finestra di dialogo House Style > Posizioni oggetti di sistema si stabiliscono i righi alle 
posizioni 2a, 3a e 4a – b House Style™.

Rigo finale: questa opzione si usa talvolta per scrivere i segni di prova sotto il rigo in basso. 
Per farlo, si deve attivare anche l’opzione Sotto rigo finale nella finestra di dialogo House Style >
Posizioni oggetti di sistema.

Pagina Ripeti
È disponibile solo per i testi di sistema ed è utile solamente per intestazioni, piè di pagina, linee di 
copyright e simili. Il testo inserito appare su più pagine.

Tra gli editori è abbastanza diffusa l’abitudine di avere intestazioni o piè di pagina diversi sulle 
pagine sinistra e destra – ad esempio, il nome di un’antologia o album in cima ad ogni pagina sin-
istra e il nome del pezzo o brano corrente in cima ad ogni pagina destra.

Cancellare gli stili di testo
Il pulsante Cancella nella finestra di dialogo House Style > Modifica stili di testo cancella lo 
stile di testo selezionato; gli stili di testo predefiniti non si possono cancellare.

Font adeguati
In musica è comune usare solo una famiglia di font per tutti i testi, con l’eventuale eccezione di 
titoli e nomi strumento. Una famiglia di font è costituita da varianti di un font principale – nor-
malmente versioni in grassetto, corsivo e grassetto corsivo, sebbene alcune famiglie di font hanno 
anche font heavier (linee più spesse) e lighter (linee più sottili) e/o condensed (schiacciati). In ogni 
partitura è meglio usare solo due o al massimo tre famiglie di font.

Di default, tutti gli stili di testo usano la famiglia del font Times New Roman (a meno che non si 
utilizzi un foglio manoscritto o uno stile house “handwritten” basato sui font Reprise o Inkpen 2) 
perché Times va bene ed è già installato sul computer. Sostituendo una famiglia si raccomanda di 
usare i font Serif con la possibile eccezione di uno o due stili di testo specificati in seguito. I font 
Serif (come quello usato in questo paragrafo) hanno tratti incrociati puntati chiamati serifs in cima 
alle lettere (a differenza dei font sans serif). I font Serif sono usati nella maggior parte di libri e 
giornali per la maggior parte dei testi, mentre i font Sans Serif si usano principalmente per i titoli.

Si raccomanda di mantenere all’incirca la dimensione di tutti gli stili di testo simile a quella dei 
default di Sibelius (a meno che sia diversamente specificato in seguito), sebbene cambiando font 
possa essere necessario modificarne leggermente la dimensione, perché alcuni font sembrano più 
grandi o piccoli di altri che hanno la stessa dimensione.
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Se quando si crea una nuova partitura s’intende cambiare il font di testo principale è meglio iniz-
iare con uno stile house Georgia o Arial che Times, poiché sia Georgia sia Arial sono più simili in 
dimensione alla maggior parte degli altri font rispetto a Times. Ciò dovrebbe garantire che il font 
di testo principale non sia troppo grande rispetto al resto della partitura.

Di seguito sono riportati alcuni consigli per scegliere con criterio gli stili di testo principali:

* Expression: usa un font corsivo non-grassetto (tranne per i segni dinamici, come mf, che 
dovrebbero usare uno speciale font di testo musicale come Opus Text).

* Technique: usa un font normale non-grassetto.
* Lyrics line 1: Times New Roman e Times hanno il pregio di essere insolitamente stretti, quindi 

usandoli per le parole si ha un disturbo minore sulla spaziatura nota. Altro font classico per le 
parole è Plantin, usato dall’Oxford University Press. Scrivendo una seconda linea di parole per 
una traduzione o un coro è normale usare il corsivo. Per la seconda, terza strofa, ecc. usare il 
non-corsivo.

* Simbolo accordo: di default usa i font speciali Opus Chords (o Reprise Chords o Inkpen2 
Chords, dipende dallo stile house). Si può sostituire un altro font medio (eventualmente uno 
Sans Serif) ma attenzione, poiché alcuni simboli accordo usano caratteri speciali che non ci sono 
nei normali font di testo.

* Titolo, Sottotitolo, Composer, Autore, Dedica: per il titolo principale e sottotitolo si può 
impostare font e dimensione a piacere. Per compositore, paroliere e dedica, in generale si usa 
stesso font e dimensione Technique, ma con la dedica normalmente in corsivo.

* Tempo e Metronome mark: le dimensioni di questi stili cambiano molto da una partitura 
all’altra. Il font di Tempo è quasi sempre in grassetto e più grande del segno Metronomo, che in 
generale è in un font non in grassetto.

* Strumenti: potrebbe andar bene un font Sans Serif, ma procedere con cautela.
* Numeri misura: generalmente in corsivo. Si può aggiungere un box per evidenziare meglio i 

numeri, ma in tal caso usare un font non-corsivo (il corsivo potrebbe toccare il box).
* Page numbers: usare un font non-grassetto e non-corsivo. Per i consigli di posizionamento ved-

ere b Numeri pagina.
* Segni di prova: per chiarezza è meglio usare font in grassetto, ma non corsivo (potrebbero toc-

care il box). Spesso è bene usare lo stesso font del titolo principale, anche se si tratta di un font 
insolito. Si può omettere il box, ma non è consigliabile (poiché i segni di prova senza un box 
sono poco visibili).

* Tempi in chiave: di default i tempi in chiave usano i font Opus, Helsinki, Reprise o Inkpen2. 
Si può sostituire un altro font musicale standard o un font di testo in grassetto. In tal caso, può 
essere necessario regolare la spaziatura linea nella pagina Pos verticale.

* Tuplets: un font Serif in corsivo è normale, sebbene talvolta nelle partiture moderne con molti 
tuplet si possano vedere font non-corsivi e/o Sans Serif.

* Altri stili di testo: preferibilmente che corrispondano a stili di testo simili a quelli descritti in 
precedenza; per esempio, si può rendere Boxed text e Footnote identico o simile a Technique.

* Stili di simboli (es. Simboli comuni, Percussioni): questi stili specificano il font usato per i 
simboli musicali, quindi non sono come gli altri testi. Per i consigli al riguardo, b Font musi-
cali e non cambiarli (a meno che si sappia ciò che si sta facendo).
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3.11 Jolly

Un jolly è un codice in un oggetto di testo che inserisce scritte speciali provenienti da qualche altra 
parte. Sibelius ha vari jolly utili che permettono, ad esempio, d’inserire titolo e numero pagina di 
un pezzo in un’intestazione che sarà aggiornata automaticamente se si cambia il titolo (e quindi 
può essere usata nei proprio foglio manoscritto).

Come appaiono i jolly
In Sibelius i jolly iniziano con \$ e finiscono con \ (per esempio, \$Title\). Quando si modifica un 
oggetto di testo contenente un jolly si vede il codice vero e proprio (come indicato in basso a sinis-
tra). Al termine della modifica di testo si vedrà invece il testo al quale il jolly si riferisce (come indi-
cato in basso a destra).

Jolly disponibili
I jolly che seguono generano il testo digitato nella finestra di dialogo File > Info partitura
(b Lavorare con i file) e alcuni di essi sono anche impostati nell’ultima pagina della finestra di 
dialogo File > Nuovo quando si crea una nuova partitura:

Volendo, tutti questi jolly possono essere impostati a valori diversi nella partitura completa e in 
ogni parte dinamica. Sibelius sfrutta questo a proprio vantaggio, garantendo che ciascuna delle 
parti dinamiche sia nominata correttamente – vedere Nome parte e cambi strumento.

Sono disponibili anche i seguenti jolly aggiuntivi:

* \$Title\
* \$Subtitle\
* \$Composer\
* \$Arranger\
* \$Artist\
* \$Copyright\
* \$PartName\
* \$InstrumentChanges\

* \$Lyricist\
* \$Copyist\
* \$Publisher\
* \$Dedication\
* \$OpusNumber\
* \$ComposerDates\
* \$YearOfComposition\
* \$MoreInfo\
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* \$DateShort\: data abbreviata corrente nel formato definito dalle impostazioni locali del prop-
rio sistema operativo (per esempio, dd:mm:yyyy).

* \$DateLong\: data completa corrente nel formato definito dalle impostazioni locali del proprio 
sistema operativo (per esempio, dd MMMM yyyy).

* \$Time\: tempo lineare corrente nel formato hh:mm:ss (24 ore).
* \$User\: username dell’utente registrato per quel computer.
* \$FilePath\: nome file e percorso della partitura corrente (non funziona fino a quando non è 

stata salvata una partitura).
* \$FileName\: nome della partitura corrente senza il suo percorso (non funziona fino a quando 

non è stata salvata una partitura).
* \$FileDate\: data e ora di salvataggio più recente della partitura, nel formato locale definito per 

il sistema (per esempio, dd MM yyyy hh:mm:ss).
* \$PageNum\: numero della pagina corrente.

Nome parte e cambi strumento
In una partitura completa \$PartName\ di default è “Full Score”, mentre \$InstrumentChanges\
fornisce un elenco di tutti gli strumenti usati nella partitura (lo strumento iniziale di ogni rigo e 
tutti i cambi strumento in ogni rigo) separati da ritorni di carrello.

In una parte dinamica, sia \$PartName\ che \$InstrumentChanges\ forniscono un elenco di 
tutti gli strumenti usati nella parte, separati da ritorni di carrello.

Ci sono altri due jolly equivalenti: \$HeaderPartName\ e \$HeaderInstrumentChanges\, i 
quali separano ogni nome strumento con una virgola invece che con un ritorno di carrello.

Ma perché ci sono così tanti jolly quasi identici?

* Sibelius usa \$PartName\ per il nome (o nomi) strumento che appaiono nell’angolo in alto a 
sinistra nella prima pagina di ogni parte dinamica e partitura completa sebbene (di default) 
questo testo sia nascosto.

* Sibelius usa \$HeaderPartName\ per il nome (o nomi) strumento che appare nell’intestazione 
mobile dalla pagina 2 in avanti di ogni parte dinamica e partitura completa sebbene anche qui 
(di default) il testo è nascosto nella partitura completa.

* È convenzione dare un nome come “Ance 1” a parti contenenti strumenti doppi che devono 
essere suonati da un singolo esecutore. Per farlo, impostare Part name in File > Info partitura
per la parte in questione a “Ance 1”; in questo modo s’aggiorna il testo nell’angolo in alto a sinis-
tra della prima pagina e nell’intestazione mobile. Talvolta è utile anche visualizzare l’elenco vero 
e proprio degli strumenti usati in una parte e qui è comodo il jolly \$InstrumentChanges\. 
Nelle figure seguenti, i frammenti a sinistra indicano cosa bisogna scrivere nell’oggetto di testo 
all’angolo in alto a sinistra della prima pagina; i frammenti a destra mostrano cosa si vedrà una 
volta terminata la modifica del testo. In entrambi i casi, si vede ciò che è stato inserito nella 
finestra File > Info partitura.

Nella coppia di frammenti in basso, si noti come il jolly \$PartName\ è in grassetto e anche la 
scritta “REEDS 1” corrispondente è in grassetto. Vedere in seguito come applicare altri tipi di for-
mattazione ai jolly.
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Uso dei jolly
I jolly si possono usare in tutti gli oggetti di testo e un numero qualsiasi di jolly all’interno della 
stessa stringa di testo. Per esempio, se è stato creato un oggetto di testo \$Title\ – Ultima ver-
sione di \$User\ on \$FileDate\, esso può essere interpretato così: “Firebird – Ultima versione 
di Igor Stravinsky del 16 Maggio 1910 ore 02:15:28.”

Si può anche cambiare la formattazione dei jolly; per esempio, se un oggetto di testo è \$Title\ – 
\$Composer\ e si vuole che il titolo della partitura sia in grassetto:

* Modificare il testo (premendo Invio, F2 o con un doppio-clic del mouse, ad esempio).
* Selezionare solo il jolly \$Title\ (per esempio, con uno Maius+0/1).
* Premere Ctrl+B o XB (o attivare B nel pannello Text in Properties) per averlo in grassetto.

Usare la stessa procedura per rendere un jolly in corsivo, cambiarne il font, allargarlo, e così via.

Altri consigli per un proficuo impiego dei jolly:

* I jolly sono insensibili al maiuscolo/minuscolo, quindi \$TITLE\, \$title\ e \$Title\ sono tutti 
equivalenti. Inoltre, il maiuscolo/minuscolo del jolly non ha alcun effetto sul testo sostituito.

* Tuttavia, i jolly non hanno mai spazi, perciò digitando \$Composer Dates\ invece di \$Com-
poserDates\ il jolly non funziona.

* Se si usa un jolly che non ha valore (per esempio, si digita \$Title\ ma non si scrive niente nel 
campo Title della finestra File > Info su partitura) una volta terminata la modifica dell’oggetto 
di testo esso può sparire completamente; è meglio quindi assicurarsi di avere dato un valore che 
il jolly può mostrare prima di usarlo. 

\$NomeParte\ Clarinetto in Bb
Sax contralto

\$InstrumentChanges\
\$PartName\
\$InstrumentChanges\
\$PartName\
\$NomeParte\
\$CambiStrumento\

ANCE 1
Clarinetto in Bb
Sax contralto
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* Non scrivere i jolly veri e propri in altre finestre di dialogo (non digitarli, ad esempio, in uno dei 
campi della finestra File > Info su partitura. Digitarli solo direttamente in oggetti di testo nella 
partitura. Non si può, ad esempio, usare un jolly per definire un altro jolly (del resto è anche un 
mistero il motivo per cui si dovrebbe farlo).

Aggiungere le modifiche formattate alla finestra Info su partitura
Sibelius consente d’inserire break di linea e cambi di font, carattere e stile in ogni punto di un testo 
grazie alla finestra di dialogo File > Info su partitura. La maggior parte dei cambi di formato 
riguarda semplicemente scritte tra gli slash – per esempio, \n\.

* \ffontname\ – cambio a un determinato nome font (es. \fArial\ per passare ad Arial).
* \sheight\ – imposta la dimensione del font a height x 1/32° spazi (es. \s64\ per impostare la 

dimensione del font a due spazi).
* ^ – usa Music text font (definito in House Style > Modifica tutti i font) per il carattere suc-

cessivo.

Per esempio, supponiamo che si lavori sull’arrangiamento di un brano scritto da un altro composi-
tore e si desideri includere entrambi i nomi nel campo Compositore della finestra di dialogo 
File > Info su partitura su linee separate. Si può inserire qualcosa del genere: J.S. Bach\n\arr. 
Aran Gerr che, se riferito al jolly \$Composer\ in un pezzo di testo nella partitura, sarà interpre-
tato così:

“J.S. Bach 
arr. Aran Gerr”

* \B\ – grassetto on
* \I\ – corsivo on
* \U\ – sottolineato on
* \n\ – nuova linea

* \b\ – grassetto off
* \i\ – corsivo off
* \u\ – sottolineato off
* \f\ – cambio al font stile testo di default
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3.12 Font equivalenti

Solo per utenti esperti

Se si apre una partitura per la quale un font non è installato nel computer, Sibelius lo sostituisce con 
un font simile. Ciò vale sia per i font di testo (ad esempio, se non è presente il font Helvetica sarà uti-
lizzato Arial) sia quelli musicali (se non è presente il font Petrucci sarà utilizzato Opus, ad esempio).

È possibile controllare i font sostituiti usando la pagina Font Equivalenti della finestra di dialogo 
File > Preferenze (menu Sibelius in Mac):

Si supponga di avere ricevuto da un utente un file con il font Didot, che non è installato nel com-
puter del destinatario. Si può indicare a Sibelius di sostituirlo con il font Palatino Linotype, dopod-
iché Palatino Linotype diventerà il font utilizzato al posto del font Didot mancante in tutte le 
partiture che lo contengono che si apriranno in futuro. 

Per inserire il nome di un font mancante e impostare i suoi equivalenti:

* Inserire il nome del font da sostituire nel campo Font a sinistra, oppure sceglierlo da un elenco 
di font cliccando sul pulsante Scegli. Una volta inserito il nome del font, cliccare sul pulsante 
Aggiungi Font: il font s’aggiunge all’elenco dei font a sinistra.

* Per impostare un font sostituto, selezionare il font mancante dall’elenco a sinistra e, nel campo 
denominato Se il Font non è disponibile, è possibile sostituirlo con uno di questi, inserire 
il nome del font sostituto oppure usare il pulsante Scegli per selezionarlo da un elenco di font 
installati nel computer. Una volta inserito il nome del font sostituto, cliccare sul pulsante Agg. 
Sostituto. Sibelius aggiunge il font all’elenco dei sostituti a destra.

* Per aggiungere altri sostituti per un font, ripetere più volte la stessa procedura.

Per regolare la precedenza dei font sostituti, usare i pulsanti Sposta in su e Sposta in giù a destra 
per scorrere in alto e in basso gli elementi nell’elenco dei font sostituti. Sibelius privilegia sempre il 
font in cima all’elenco rispetto a quelli più in basso (cioè se è installato il font più in alto userà 
quello) altrimenti verificherà se il font successivo è installato ed userà quello e così via.

Per rimuovere un font o sostituto da uno degli elenchi selezionare il font da rimuovere e cliccare 
sul rispettivo pulsante Rimuovi.

In Sibelius si possono usare anche font musicali di terzi. Per i dettagli su come informare Sibelius 
di tali font, vedere Usare font non forniti da Sibelius in b Font musicali.
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4.1 Riproduzione

b Linee, Percussioni, Mixer, Esecuzione, Ripetizioni, Live Playback, Dizionario di 
riproduzione, Sibelius Sounds Essentials, Messaggi MIDI.

v Riproduzione.

Per configurare Sibelius in modo che riproduca le partiture vedere Configurazione MIDI in 
Windows o Configurazione MIDI in Mac nella Guida e b Dispositivi di riproduzione e 
Sibelius Sounds Essentials.

Finestra Playback
In Sibelius i controlli di riproduzione sono nella finestra Finestra > Playback (Ctrl+Alt+Y o
zXY), che si può anche aprire e chiudere dalla toolbar. Per un’introduzione alla riproduzione della 
partitura consultare la Guida.

Filosofia di progetto
In Sibelius, la filosofia di progetto per le funzioni di riproduzione è che l’utente deve poter scrivere 
una partitura proprio come farebbe su un foglio di carta, usando la notazione normale e senza 
comandi speciali, e riprodurla bene senza ulteriori impostazioni.

Per farlo:

* Di default Sibelius sceglie il suono migliore disponibile per ogni strumento.
* Ogni volta che si riproduce una partitura, Sibelius legge più o meno tutto quello che c’è scritto 

nella partitura, in qualsiasi formato sia. Sibelius capisce anche segni come ff, “pizz.”, o accel., ed 
è possibile cambiare queste impostazioni e aggiungerne di proprie grazie al suo dizionario di 
riproduzione interno.

Cosa legge Sibelius?
Quasi tutta la notazione in una partitura è riprodotta correttamente. Sibelius legge:

* Note, accordi, pause, alterazioni, legature, acciaccature.
* Chiavi, tonalità, tempi in chiave.
* Strumenti – che determinano i suoni usati e si possono cambiare, se si desidera.
* Articolazioni standard (per esempio, accenti, staccato, marcato, ecc.).
* Tremolo e rullate (z sul gambo).
* Testi che specificano le dinamiche, come pp, sfz, loud.
* Segni Tempo (es. Allegro), segni di metronomo (es. q = 108), modulazioni metriche (es. q = e).
* Altri testi (es.”con sord”, pizz., legato) – per i dettagli completi sulla riproduzione dei testi 

b Dizionario di riproduzione.
* Ripetizioni, compresi 1° e 2° finale (misure 1° o 2° volta), stanghette di ripetizione, Coda, Segno 

– b Ripetizioni

* Linee come legature, trilli, ottava (8va), pedali, rit./accel., gliss., forcine.
* Tablature di chitarra e notazioni come bending e slide.
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* Teste nota speciali usate per le percussioni.
* Strumenti trasportati (che suonano sempre alla rispettiva altezza corretta).
* Messaggi MIDI di testo, inseriti per un controllo di riproduzione avanzato – b Messaggi 

MIDI.
* Oggetti nascosti (per esempio, segni di metronomo, note, dinamiche o righi interi – 

b Lavorare con i testi, Nascondere oggetti, Evidenzia righi Selezionati.

Regolare la riproduzione
Ci sono vari aspetti di riproduzione che si possono regolare come segue:

* Suoni: finestra Mixer (per definire il suono iniziale – b Mixer), testi come “pizz.” (per cambi-
are il suono a metà partitura – b Dizionario di riproduzione), testi come “~P35” 
(b Messaggi MIDI).

* Dinamiche: testi come mf (vedere sotto), forcine (vedere sotto), plug- in Cresc./Dim. Playback
(b Plug-in), volume complessivo (b Mixer), testi come “~C7,64” (b Messaggi MIDI).

* Tempo: testi (come Allegro, Più mosso, Presto), segni di metronomo e modulazioni met-
riche, linee rit./accel. e cursore tempo nella finestra Playback (vedere sotto).

* SoundStage™: bilanciamento (pan) e distanza (b Mixer).
* Esecuzione: Espressivo™, Rubato™, riverbero (b Esecuzione), andamento (feel) ritmico 

(b Esecuzione, Dizionario di riproduzione).

Dinamiche
Nel mondo reale, i vari strumenti gestiscono le dinamiche in modi diversi. Gli strumenti percussivi 
(piano, timpani, arpa, ecc.) possono cambiare la dinamica solo all’attacco della nota, mentre gli 
strumenti dal suono sostenuto (come la maggior parte dei legni, ottoni e strumenti ad arco) pos-
sono dosare la dinamica lungo la durata di una nota.

Sibelius riproduce le dinamiche con il massimo realismo consentito dal dispositivo di riproduzi-
one. Alcuni strumenti virtuali (Garritan Personal Orchestra) sono configurati appositamente per 
permettere un controllo indipendente del livello dinamico di uno strumento sostenuto e 
dell’attacco sulle note che suona. Altri dispositivi (compresa la maggior parte di moduli sonori 
MIDI e schede audio) non sono configurati così, quindi su tali dispostivi Sibelius può specificare 
solo la dinamica all’attacco della nota, ma non può variarla a metà nota.

Poiché gli oggetti del rigo si applicano solo a strumento e voce(i) al quale sono attaccati, in 
riproduzione si sente subito se i segni dinamici sono attaccati al rigo sbagliato, poiché gli stru-
menti non riprodurranno le giuste dinamiche (b Attaccature). Per strumenti con più righi 
(come quelli a tastiera) vedere Strumenti con più righi.

Per cambiare il rigo al quale è attaccato un segno dinamico spostare quest’ultimo sul rigo al quale 
lo si vuole attaccare (in modo che la freccia grigia d’aggancio scatti al nuovo rigo) e poi ricollocarlo 
alla giusta posizione. (L’attaccatura di un oggetto si può eseguire solo in una partitura completa: 
trascinando un oggetto in una parte dinamica esso non si riattacca).

Per cambiare la voce(i) alla quale applicare un segno dinamico, selezionarlo e cliccare sui pulsanti 
voce alla base del tastierino numerico (comando rapido Alt+1/2/3/4 o z1/2/3/4 per assegnarlo a 
un’altra voce; con un Alt+5 o z5 il segno dinamico si applica a tutte le voci). Per applicare un 
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segno dinamico ad altre combinazioni di voci cliccare sui pulsanti voce alla base della finestra tast-
ierino numerico (b Tastierino numerico).

Quando si riproduce un segno dinamico creato con il testo Expression (vedere Expression on 
page 179) esso è interpretato secondo la rispettiva definizione nel dizionario di riproduzione 
(b Dizionario di riproduzione) – per esempio, fff equivale alla dinamica più forte, ma non è 
tutto qui: l’effettiva dinamica di una nota dipende anche dal livello di Espressivo e dalle articolazi-
oni presenti (gli accenti, ad esempio).

Forcine
Inserendo una forcina, di default Sibelius ne calcola automaticamente la dinamica finale. Se c’è un 
segno dinamico vero e proprio (es. ff o mp) scritto all’estremità destra Sibelius lo usa; se non è 
specificata una dinamica, Sibelius aumenta o diminuisce la dinamica di un livello (per esempio, 
una forcina di crescendo che inizia con un mp prevalente passa a mf, mentre una forcina di dimin-
uendo che inizia con un ff prevalente passa a f ).

Per specificare con più precisione la fine della dinamica, sia con un segno dinamico esplicito che 
con una modifica in percentuale della dinamica iniziale, selezionare la forcina alla quale cambiare 
la fine della dinamica e aprire il pannello Playback della finestra Proprietà (comando rapido 
Ctrl+Alt+P o zXP). Modificare il menu a tendina da auto (default) a un nuovo valore percentu-
ale e scegliere se tale valore è una variazione (Change) dalla dinamica iniziale o una percentuale 
della velocity massima (Maximum). Se nella finestra Proprietà si specifica una particolare 
dinamica finale per una forcina, sarà sempre usata quella dinamica (anche inserendo, rimuovendo 
o cambiando un oggetto di testo Expression alla fine della forcina).

Come i testi Expression (vedere Dinamiche) tutte le linee del rigo, comprese le forcine, influen-
zano solo la riproduzione di strumento e voce(i) al quale sono attaccate.

Trilli
Di default, i trilli si alternano 12 volte al secondo all’intervallo di uno step diatonico – cioè mezzo 
step (semitono) o uno intero (tono), dipende dall’altezza della nota rispetto alla tonalità corrente.

Per cambiare la riproduzione di un singolo trillo, selezionarlo e modificare i controlli nel pannello 
Playback della finestra Proprietà:

* Per specificare intervalli di mezzo step (semitoni) disattivare Diatonica e impostare Semitoni
all’intervallo desiderato. (nelle percussioni, per trasformare un trillo in un tremolo a una nota 
selezionare il trillo e impostare Semitoni a 0).

* Per cambiare la velocità del trillo impostare Velocità al numero di note al secondo desiderato.
* Attivare Suona dritto se non si vuole che Sibelius applichi lievi variazioni al ritmo del trillo.  

È bene non attivare questa opzione, poiché con note “regolari” il trillo suona molto meccanico.
* Attivare Avvia su nota più alta per iniziare il trillo alla nota più acuta e non a quella più grave.

Si può scrivere una piccola alterazione come simbolo sopra il trillo per indicare l’intervallo, ma 
Sibelius non la legge direttamente.

Altri ornamenti non sono riprodotti automaticamente, ma Sibelius ha un plug-in che riproduce 
mordenti e variazioni – vedere Riproduzione ornamenti on page 414.
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Tempo
Per cambiare il tempo della partitura usare un pezzo di testo Tempo – come Allegro, Lento, 
Presto, e così via – o un segno di metronomo che sarà scritto nel testo della scritta Metronome. 
Per sapere come scrivere questi testi nella partitura sotto forma di testo vedere Tempo on page 
180 e Metronome mark on page 179. Per cambiare la rapidità con la quale Sibelius interpreta i 
segni di tempo (es. Allegro) vedere b Dizionario di riproduzione.

Si può anche regolare il tempo della partitura durante la riproduzione usando il cursore tempo 
nella finestra Playback; non usarlo però come metodo principale per cambiare il tempo, perché la 
posizione del cursore tempo non è ricordata da Sibelius ad aperture successive della partitura.

Rit. e accel.
Sibelius riproduce ritardando e accelerando usando linee speciali (b Linee).

Le linee Rit./accel. consentono di specificare l’entità di rit./accel. e dove essi terminano, vale a dire 
alla fine della linea. La linea può essere tratteggiata visibile o invisibile; essa indica semplicemente 
a Sibelius quanto dura il rit./accel. (visibile come una linea continua grigia se è attiva l’opzione 
Vista > Oggetti nascosti). Nel pannello Playback della finestra di dialogo Properties
(b Proprietà) si può anche specificare il tempo finale del rit./accel.:

* Final tempo: specificato in tempo assoluto (in bpm) o in percentuale del tempo iniziale (di 
default è il 75% per ogni linea rit. e il 133% per ogni linea accel.).

* Si può anche specificare come varia il tempo durante un accel. o rit.:
% Early: cambia il tempo più rapidamente all’inizio della linea.
% Late: cambia il tempo più rapidamente verso la fine della linea.
% Linear: cambia il tempo a velocità costante lungo la durata della linea.

Per tornare al tempo originale dopo un accel. o rit., si deve scrivere un testo Tempo (come A 
tempo) nel testo Tempo. Tuttavia, Sibelius non interpreta automaticamente un A tempo (perché 
spesso non è chiaro a quale tempo debba ritornare), quindi bisogna creare anche un segno di met-
ronomo nascosto (vedere Metronome mark on page 179).

Glissando e portamento
Le linee Gliss. e port. (b Linee) sono riprodotte in default per il tipo di glissando opportuno dello 
strumento al quale sono applicate (per esempio, in semitoni cromatici per strumenti a fiato, o uno 
slide continuo per gli archi). Per cambiare il modo in cui è riprodotta una linea, selezionarla e 
usare il pannello Playback della finestra Proprietà:

* Tipo Glissando: offre vari tipi di glissando. In genere, si può lasciare a Instrument default.
* Per il glissando Continuo (uno slide omogeneo), il modo in cui suona è specificato così:

% Early: il glissando è più veloce all’inizio della linea.
% Late: il glissando è più veloce verso la fine della linea.
% Lineare: il glissando suona a velocità costante dall’inizio alla fine della linea.

Armonici
Sibelius non riproduce automaticamente gli armonici; si deve usare il plug-in Riproduzione >
Riproduzione armonici (b Plug-in) o usando note nascoste e teste nota silenti.
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Gli armonici naturali (es. negli ottoni) in genere sono indicati da un simbolo “o” sopra la nota. 
Per riprodurre l’armonico, fare in modo che all’altezza stampata suoni una testa nota silente e 
aggiungere l’altezza suonata dell’armonico usando una nota nascosta in un’altra voce – per mag-
giori dettagli, b Nascondere oggetti e Teste nota

Gli armonici artificiali (es. in strumenti ad arco) sono indicati da una testa nota a rombo una 
quarta o quinta giusta sopra l’altezza scritta. Usare una testa nota silente per l’altezza scritta e una 
testa nota a rombo per l’armonico. È opportuno far diventare silente anche la testa nota a rombo – 
b Modifica teste nota. Come in precedenza, aggiungere l’altezza suonata dell’armonico 
usando una nota nascosta in un’altra voce.

Strumenti con più righi
Se uno strumento in genere usa due righi (come un piano o un’arpa) bisogna creare le dinamiche 
attaccate ad uno solo dei due righi e Sibelius le applicherà a entrambi i righi in riproduzione se le 
dinamiche sono tra i righi. Attenzione! Ciò è applicato anche a qualsiasi strumento con due righi 
che si crea (creando un flauto con due righi, ad esempio, le dinamiche scritte tra i due righi sono 
applicate a entrambi).

Nel raro caso in cui non si voglia applicare la dinamica a entrambi i righi di uno strumento a tasti-
era collocare il segno dinamico vicino a un rigo o fuori dai righi (cioè sopra l’estremità destra del 
rigo o sotto quella sinistra). Per non applicare le dinamiche da nessuna parte nei righi, disattivare 
l’opzione Influenza rigo adiacente nella finestra di dialogo Play > Esecuzione. In questa finestra 
si può anche regolare la soglia che stabilisce quanto deve essere lontano dal rigo un segno 
dinamico perché Sibelius lo applichi al rigo adiacente; per ulteriori dettagli, b Esecuzione.

Dove il numero di righi usati per uno strumento cambia (per esempio, dove uno strumento si 
divide in due righi per musicisti separati o riunioni future) può essere utile inserire una tecnica 
dinamica e/o di esecuzione (es. pizz., muto) all’inizio del sistema successivo, che corrisponda alla 
dinamica/tecnica prevalente presente appena prima del cambio dei righi. Questo perché gli effetti 
della riproduzione rimangono lungo ogni rigo – Sibelius non può sapere se un musicista passa da 
un rigo a un altro.

Modulazioni metriche
Sibelius riproduce le modulazioni metriche, sempre che siano state scritte usando uno stile di testo 
di sistema (per esempio, un segno Tempo o Metronome) – per i dettagli sulla loro creazione vedere 
Modulazioni metriche on page 180.

Sibelius riconosce formati complessi come q = q._x ecc.; è consentito un numero qualsiasi di note 
(con o senza punti) unite da legature di valore o segni “+”. L’unico limite è che Sibelius si basa sui 
termini della finestra di dialogo Play > Dizionario, usata per la riproduzione di segni metronomo 
regolari che riconoscono modulazioni metriche. Ciò significa che se serve una modulazione met-
rica con una combinazione di note con legature o segni “+” al lato sinistro del segno “=”, bisogna 
definire nuovi termini nel dizionario per ogni tipo di modulazione metrica da usare 
(b Dizionario di riproduzione).

Note silenti e linee/testi ignorati
In riproduzione si può ignorare qualsiasi oggetto (es. dinamiche, note) disattivando tutti i suoi box 
di spunta Play on pass nel pannello Playback della finestra Properties – b Ripetizioni. 
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Altrimenti, si può evitare la riproduzione di particolari teste nota usando il tipo di testa nota 
silente (comando rapido Maius+Alt+9 o xz9) – b Teste nota.

Si può anche specificare che tutte le scritte in un determinato stile di testo non abbiano effetto in 
riproduzione disattivando l’opzione Interpret during playback nella pagina General della 
finestra Edit Text Style – b Modifica stili di testo.

Comando Tutte Note Off
Il comando Play > Tutte Note Off (comando rapido Maius-O) disattiva tutte le note correnti in 
riproduzione. Ciò può essere necessario se:

* Il computer, la scheda audio o il dispositivo di riproduzione si blocca in seguito a un avanza-
mento o riavvolgimento rapido (può accadere se il dispositivo non è molto veloce o nel corso di 
un avanzamento/riavvolgimento rapido di musica complessa).

* Si ferma la riproduzione mentre è premuto il pedale del sustain.

Se si sente una nota sospesa mentre la partitura è in riproduzione, si può anche premere Maius-O
durante la riproduzione – Sibelius “resetta” tutte le note e riprende la riproduzione.

La causa più diffusa di note sospese sono le legature aperte (cioè una nota con una legatura alla 
quale non segue una nota alla stessa altezza). Sibelius ha un plug-in che verifica la partitura ed 
elimina tutte le legature aperte problematiche – vedere Rimuovi legature sospese on page 
407.

Altre opzioni di riproduzione
Sibelius ha anche altre opzioni di riproduzione alle quali si può accedere nei modi seguenti:

* Per nascondere la linea di riproduzione quando non si è in riproduzione disattivare l’opzione 
Vista > Linea di riproduzione.

* La pagina Posizione partitura nella finestra di dialogo File > Preferenze (menu Sibelius in 
Mac) presenta opzioni relative alla posizione della partitura durante la riproduzione. A meno 
che ci siano problemi di riproduzione non è necessario modificare queste opzioni; per maggiori 
dettagli, b Preferenze.

* Le note sono riprodotte quando ci si clicca sopra e le si trascina con il mouse. Se ciò da fastidio 
disattivare l’opzione Riproduci note in fase di modifica nella pagina Inserimento nota della 
finestra di dialogo File > Preferenze (menu Sibelius in Mac).
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4.2 Interpretazione della partitura

b Linee, Percussioni, Ripetizioni, Dizionario di riproduzione.

In Sibelius la filosofia di progetto per le funzioni di riproduzione permette di scrivere una partitura 
come su un foglio manoscritto (usando la normale notazione e nessun comando speciale) e ripro-
durla fedelmente senza ulteriori configurazioni.

Per farlo:

* Di default Sibelius sceglie il miglior suono disponibile per ogni strumento.
* Ogni volta che riproduce la partitura, Sibelius legge più o meno qualsiasi cosa scritta in essa, 

qualunque sia il formato in cui è stata scritta. Sibelius interpreta anche segni quali ff, pizz. o 
accel.. Grazie al dizionario di riproduzione interno di Sibelius è possibile cambiare queste 
impostazioni e aggiungerne di propriÈ.

Cosa legge Sibelius
È riprodotta subito correttamente quasi tutta la notazione in una partitura. Sibelius interpreta:

* Note, accordi, pause, alterazioni, legature, abbellimenti.
* Chiavi, tonalità, tempi in chiave.
* Strumenti – essi determinano i suoni utilizzati che volendo si possono cambiare.
* Articolazioni standard (es. accenti, staccati, marcati, ecc.).
* Tremolo e rullate (z sul gambo).
* Scritte che specificano le dinamiche (es. pp, sfz, forte).
* Segni Tempo (es. Allegro), segni di metronomo (es. q = 108), modulazioni metriche (es. q = e).
* Altre scritte (es. con sordina, pizzicato, legato) – per i dettagli completi sulla riproduzione delle 

scritte b Dizionario di riproduzione

* Ripetizioni, inclusi 1° e 2° finale (misure 1° o 2° volta), stanghette di ripetizione, coda, segni – 
b Ripetizioni

* Linee (es. legature), trilli, linee d’ottava (8va), pedalatura, rit./accel., glissato, forcine.
* Tablatura e notazioni per chitarra quali bending e slide.
* Teste nota speciali usate per le percussioni.
* Strumenti trasportati (che suonano sempre alla rispettiva altezza corretta).
* Messaggi MIDI di testo inseriti per un controllo di riproduzione avanzato – b Messaggi 

MIDI.
* Oggetti nascosti (es. segni di metronomo nascosti, note o dinamiche, righi interi) – 

b Lavorare con i testi, Nascondere oggetti, Evidenzia righi Selezionati.

Dinamiche
Nel mondo reale i vari tipi di strumenti suonano le dinamiche in modi diversi. Gli strumenti per-
cussivi (piano, timpani, arpa, ecc.) possono cambiare la dinamica solo all’inizio di una nota, men-
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tre quelli con sustain (la maggior parte di legni, ottoni e archi) possono cambiare la dinamica 
lungo la durata di una nota.

Sibelius riproduce le dinamiche tanto realisticamente quanto il dispositivo di riproduzione lo con-
sente. Alcuni strumenti virtuali (es. Garritan Personal Orchestra) sono configurati appositamente 
per consentire un controllo indipendente del livello dinamico di uno strumento con sustain e 
dell’attacco delle note che suona. Altri dispositivi, inclusi la maggior parte dei moduli sonori MIDI 
e delle schede audio non è configurata così; su questi dispositivi, quindi, Sibelius può solo specifi-
care la dinamica all’inizio della nota, ma non può cambiarla a metà nota.

Poiché gli oggetti del rigo si applicano solo a strumento e voce(i) al quale sono assegnati, in 
riproduzione si nota particolarmente se le dinamiche sono attaccate al rigo sbagliato, poiché gli 
strumenti suonano con le dinamiche sbagliate (b Attaccature). Per gli strumenti con più righi 
(es. quelli a tastiera) vedere Strumenti con più righi in seguito.

Per cambiare il rigo al quale è assegnata una dinamica spostare il segno dinamico sopra il rigo al 
quale si vuole attaccarlo, in modo che la freccia d’assegnazione grigia si collochi sul nuovo rigo, 
quindi ricollocarla alla giusta posizione. (L’assegnazione di un oggetto si può cambiare solo nella 
partitura completa; trascinando un oggetto in una parte dinamica esso non si riattacca).

Per cambiare la voce(i) alla quale è applicato un segno dinamico, selezionarlo e cliccare sui pul-
santi voce alla base del tastierino numerico (comando rapido Alt+1/2/3/4 o z1/2/3/4 per asseg-
narlo a un’altra voce; con un Alt+5 o z5 il segno dinamico è applicato a tutte le voci). Pe fare in 
modo che un segno dinamico sia applicato ad altre combinazioni di voci, cliccare sui pulsanti voce 
alla base della finestra tastierino numerico (b Tastierino numerico).

Quando si riproduce un segno dinamico creato con il testo Expression (vedere Expression on 
page 179) esso è interpretato in base alla rispettiva scritta del dizionario di riproduzione 
(b Dizionario di riproduzione) – es. fff equivale alla dinamica massima, ma non è tutto qui 
– la riproduzione reale della dinamica di una nota dipende anche dal livello di Espressivo e da tutte 
le articolazioni presenti (es. gli accenti).

Forcine
Inserendo una forcina, di default Sibelius individua automaticamente la fine della dinamica. Se c’è 
un segno dinamico (es. ff o mp) scritto all’estremità destra lo utilizza; se non è specificata una 
dinamica, Sibelius aumenta o diminuisce la dinamica di un livello (es. una forcina di crescendo 
che inizia a mp arriva a mf, una forcina di diminuendo che inizia a ff arriva a f ).

Per specificare con più precisione la fine di una dinamica (con un chiaro segno dinamico o un 
cambio in percentuale della dinamica iniziale) selezionare la forcina sulla quale cambiare la fine 
della dinamica e aprire il pannello Playback della finestra Proprietà (comando rapido 
Ctrl+Alt+P o zXP). Cambiare il menu a tendina da auto (default) a un nuovo valore percentuale 
e scegliere se è un Cambio dalla dinamica iniziale o una percentuale della velocity Massima. 
Specificando una dinamica finale particolare di una forcina nelle Proprietà, sarà sempre usata 
quella dinamica (anche aggiungendo, togliendo o cambiando un oggetto di testo Expression alla 
fine della forcina).

Come il testo Expression (vedere Dinamiche), tutte le line del rigo (incluse le forcine) influen-
zano solo la riproduzione di strumento e voce(i) al quale sono assegnate.
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Trilli
Di default, i trilli si alternano 12 volte al secondo con un intervallo di uno step diatonico – cioè 
mezzo step (semitono) o uno step intero (tono), dipende dall’altezza della nota rispetto alla tonal-
ità corrente.

Per cambiare la riproduzione di un singolo trillo, selezionarlo e poi modificare i controlli sul pan-
nello Playback della finestra Proprietà:

* Per specificare un intervallo in mezzi step (semitoni) disattivare Diatonica e impostare Semi-
toni all’intervallo esiderato. (Per fare in modo che un trillo esegua il tremolo a una nota nelle 
percussioni, selezionare il trillo e impostare Semitoni a 0).

* Per cambiare la velocità del trillo impostare Velocità al numero di note al secondo desiderate.
* Attivare Suona dritto per evitare che Sibelius applichi lievi variazioni al ritmo del trillo. Si con-

siglia di lasciarlo disattivato, poiché suonando le note “regolari” il trillo diventa molto mecca-
nico.

* Attivare Avvia su nota più alta per fare in modo che il trillo inizi dalla nota superiore invece 
che da quella inferiore.

Si può scrivere una piccola alterazione come simbolo sopra il trillo a indicare l’intervallo, ma Sibel-
ius non lo leggerà direttamente.

Altri ornamenti non sono riprodotti automaticamente, ma Sibelius ha un plug-in che riproduce 
mordenti e turn – vedere Riproduzione ornamenti on page 414.

Tempo
Per cambiare il tempo della partitura usare una scritta Tempo – es. Allegro, Slow, Presto, e così 
via – o un segno di metronomo, che come tale dovrà essere una scritta di Metronomo. Per sapere 
come digitare questi segni di testo nella partitura vedere Tempo on page 180 e Metronome 
mark on page 179. Per cambiare la velocità alla quale Sibelius immagina i segni di tempo (es. 
Allegro), b Dizionario di riproduzione.

Il tempo della partitura si può regolare anche durante la riproduzione con il cursore tempo nella 
finestra Playback; non bisogna usarlo però come metodo principale per impostare il tempo, 
poiché la posizione del cursore tempo non è memorizzata all’apertura successiva della partitura.

Modulazioni metriche
Sibelius riproduce le modulazioni metriche, sempre che siano digitate usando uno stile testo di 
sistema (es. un segno Tempo o Metronomo) – per i dettagli sulla loro creazione vedere Modulazi-
oni metriche on page 180.

Sibelius interpreta formati complessi come q = q._x ecc.; è consentito un numero qualsiasi di note 
(con o senza punti) unite da legature o segni +. L’unica limitazione è che per riconoscere le modu-
lazioni metriche Sibelius si basa sulle opzioni della finestra Play > Dizionario usata per la 
riproduzione dei normali segni di metronomo. Quindi, se serve una modulazione metrica con una 
combinazione di note con legature o segni + a sinistra del segno =, si devono definire nuove parole 
nel dizionario per ogni tipo di modulazione metrica da usare (b Dizionario di riproduzione).
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Rit. e accel.
Sibelius riproduce ritardando e accelerando usando linee speciali (b Linee).

Le linee Rit./accel. consentono di specificare la quantità di rit./accel. e dove finiscono rit./accel.
(cioè la fine della linea). La linea può essere visibile e tratteggiata o invisibile; essa indica semplice-
mente a Sibelius la durata di rit./accel. (visibile con una linea continua grigia se è attiva l’opzione 
Vista > Oggetti Nascosti). Si può anche specificare il tempo finale di rit./accel. dal pannello Play-
back della finestra Proprietà (b Proprietà):

* Final tempo: specifica un tempo assoluto (in bpm) o una percentuale rispetto al tempo iniziale 
(di default è 75% per qualsiasi linea rit. e 133% per ogni linea accel.).

* Si può anche specificare come cambia il tempo durante accel. o rit.:
% Early: il tempo cambia più rapidamente all’inizio della linea.
% Late: il tempo cambia più rapidamente verso la fine della linea.
% Lineare: il tempo cambia a una velocià costante lungo tutta la linea.

Per tornare al tempo originale dopo un accel. o rit., in quel punto bisogna scrivere un testo Tempo 
(es. A tempo). Tuttavia, Sibelius non interpreta automaticamente una scritta A tempo (perché 
spesso non è chiaro a quale tempo deve tornare) quindi si deve creare anche un segno di met-
ronomo nascosto (vedere Metronome mark on page 179).

Glissato e portamento
Le linee di riproduzione gliss. e port. (b Linee), di default si collocano al tipo di glissando più 
adatto per lo strumento al quale sono applicate (es. passando in step cromatici per i legni, ma con 
uno slide continuo per gli archi). Per cambiare il modo in cui è riprodotta una linea, selezionarla e 
usare il pannello Playback delle finestra Proprietà:

* Tipo Glissando offre vari tipi di glissando; normalmente si può lasciare l’opzione Strumento di 
default.

* Per un tipo di glissando Continuo (uno slide omogeneo) il modo in cui è riprodotto il glissando 
dipende dalle seguenti opzioni:
% Early: il glissando è riprodotto più velocemente all’inizio della linea.
% Late: il glissando è riprodotto più rapidamente verso la fine della linea.
% Lineare: il glissando è riprodotto a una velocità costante dall’inizio alla fine della linea.

Armonici
Sebbene Sibelius non riproduca automaticamente gli armonici, essi si possono riprodurre facil-
mente usando il plug-in Riproduzione > Riproduci armonici (b Plug-in) o usando note 
nascoste e teste nota silenti.

Gli armonici naturali (es. degli ottoni) normalmente hanno un simbolo “o” sopra la nota. Per 
riprodurre l’armonico, realizzare l’altezza stampata usando una testa nota silente e aggiungere 
l’altezza suonata dell’armonico usando una voce nascosta in un’altra voce – per maggiori dettagli, 
b Nascondere oggetti e Teste nota

Gli armonici artificiali (es. degli archi) sono indicati da una testa nota a rombo una quarta o quinta 
giusta sopra l’altezza scritta; usare una testa nota silente per l’altezza scritta e una testa nota a 
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rombo per l’armonico. È opportuno inoltre rendere silente anche la testa nota a rombo – 
b Modifica teste nota. Come in precedenza, aggiungere l’altezza suonata dell’armonico 
usando una nota nascosta in un’altra voce.

Strumenti con più righi
Se normalmente uno strumento utilizza due righi (es. un piano o un’arpa) basta assegnare le 
dinamiche a uno dei due righi: in riproduzione Sibelius le applicherà se si trovano tra i righi. 
Attenzione! Ciò vale anche per qualsiasi strumento a due righi che si crea (es. creando un flauto a 
due righi, le dinamiche presenti tra i due righi sono applicate a entrambi i righi).

Nel raro caso in cui non si voglia applicare una dinamica a entrambi i righi di uno strumento a 
tastiera, collocare il segno dinamico vicino a un rigo o all’esterno dei righi (cioè sopra l’estremità 
destra o sotto l’estremità sinistra del rigo). Per non applicare da nessuna parte le dinamiche a 
entrambi i righi disattivare l’opzione Influenza rigo adiacente nella finestra di dialogo Play >
Esecuzione. In questa finestra si può regolare la distanza alla quale un segno dinamico si deve tro-
vare dal rigo perché Sibelius lo applichi al rigo adiacente. Per ulteriori dettagli, b Esecuzione.

Ove il numero di righi usati per uno strumento cambia (per esempio quando uno strumento si 
divide su due righi per musicisti diversi o riunioni successive) bisogna collocare un segno 
dinamico nascosto e/o una tecnica esecutiva (es. pizz., muto) all’inizio del sistema successivo che 
corrisponda alla dinamica/tecnica prevalente appena prima che i righi cambino. Questo perché gli 
effetti di riproduzione sono attivi lungo ogni rigo – Sibelius non può sapere se un musicista si 
sposta da un rigo a un altro.

Note silenti e scritte ingnorate/linee
Si può fare in modo che durante la riproduzione un oggetto qualsiasi (es. dinamiche, note) sia 
ignorato disattivando i box di spunta Play on pass nel pannello Playback della finestra Proper-
ties – b Ripetizioni. 

Altrimenti, si può evitare la riproduzione di teste nota particolari usando un tipo di testa nota 
silente (comando rapido Maius+Alt+9 o xz9) – b Teste nota.

Si può anche specificare che tutte le scritte in un determinato stile di testo non devono avere effetto 
in riproduzione disattivando l’opzione Interpret during playback nella pagina Generale della 
finestra Edit Text Style – b Modifica stili di testo.
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4.3 Mixer

v Riproduzione.

Nella finestra Mixer di Sibelius si modificano i suoni da riprodurre (volume, pan e regolazione dei 
parametri in strumenti virtuali ed effetti) usati nella configurazione di riproduzione corrente.

Per mostrare o nascondere il Mixer selezionare Finestra > Mixer o usare il comando rapido 
Ctrl+Alt+M (Windows) o M (Mac), oppure cliccare sul pulsante della toolbar indicato a 
destra. La finestra Mixer è costituita da varie sezioni:

La larghezza del Mixer è fissa, ma si può cambiarne l’altezza trascinando il bordo inferiore (Win-
dows) o l’angolo inferiore destro (Mac); è possibile inoltre nascondere e mostrare individualmente 
ogni tipo di striscia con i pulsanti in alto.

Striscia pulsanti per nascondere e mostrare altre 
strisce Mixer e indicare le risorse della CPU.

Strisce rigo per regolare volume, solo/mute, pan, 
canale MIDI(ove serve) e il numero ID del suono 
iniziale in ogni rigo della partitura.

Striscia traccia clic per regolare il clic del met-
ronomo in riproduzione e nella registrazione in 
Flexi-time.

Strisce gruppo per regolare volume relativo e solo/
mute delle famiglie strumentali nella partitura.

Striscia strumento virtuale per regolare i 
parametri nella finestra di ogni strumento virtu-
ale, solo/mute di tutti i righi che suonano da esso e 
l’entità del segnale inviato ad ogni bus effetti.

Strisce bus effetti per regolare i parametri nelle 
finestre degli effetti e regolare i livello d’uscita e 
trim.

Striscia volume Master per regolare il volume 
complessivo di tutti gli strumenti virtuali /effetti e i 
parametri in ogni finestra d’effetto master.
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Striscia pulsanti
La striscia pulsanti in cima al Mixer consente di nascondere/mostrare gli altri tipi di strisce:

Di default, quando si apre il Mixer per la prima volta appaiono solo le strisce rigo e volume Master. 
Se la configurazione di riproduzione corrente non usa strumenti virtuali o effetti, i pulsanti per le 
strisce di strumenti virtuali e bus effetti sono disabilitati.

L’indicatore di risorse CPU mostra l’uso del processore da parte del sistema audio, cioè tutti gli 
strumenti virtuali ed effetti nella configurazione di riproduzione corrente (non l’uso complessivo 
del processore da parte di tutto il computer). Se in riproduzione l’indicatore diventa rosso, significa 
che il computer impiega più tempo a restituire l’audio richiesto rispetto a quello che impiega a 
riprodurlo; è probabile quindi che in riproduzione si sentano rumori o interruzioni.

Se ciò avviene si può sempre esportare un file audio della partitura che sarà riprodotto senza 
anomalie (b Esportare i file audio), ma per ridurre i rumori in riproduzione vedere Come 
ottenere il meglio da strumenti virtuali ed effetti on page 314.

Strisce rigo
Ogni rigo nella partitura ha la propria striscia rigo:

Per aprire e chiudere ogni striscia rigo cliccare sulla freccia al lato sinistro della striscia. I controlli 
in ogni striscia rigo funzionano così:

* Il campo nome del rigo mostra il nome del rigo come appare in Crea > Strumenti e righi e non 
si può modificare; per cambiare il nome strumento, b Nomi strumento.

* Per regolare il volume, trascinare il fader a sinistra (per ridurlo) o destra (per aumentarlo). 
Il fader ha una posizione “adesiva” al volume di default (100 su 127). In riproduzione, lo sfondo 
del fader s’illumina ad indicare il livello di riproduzione su quel rigo. Ciò consente di correggere 
l’equilibrio relativo tra i righi senza dover scrivere dinamiche più forti per gli strumenti forti e 
più deboli per quelli deboli. Di default, la maggior parte dei dispositivi riproduce tutti gli stru-

Strisce 
rigo

Strisce strumento 
virtuale

Striscia volume 
Master

Strisce 
gruppo

Strisce bus 
effetti

Indicatore 
risorse CPU

Striscia rigo chiusa

Striscia rigo aperta

Cliccare sulla freccia per 
aprire/chiudere la striscia

Nome rigo Fader volume e indicatore livello Pulsanti Solo/Mute

Numero ID suono ini-
ziale usato dal rigo Cursore PanCanale o slot 

MIDI
Mostra/nasconde 

finestra strumento
virtuale

Dispositivo che 
suona il rigo
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menti circa allo stesso volume, quindi (ad esempio) ad una sezione completa Violino I bisognerà 
dare un volume un pò più alto rispetto a quello del solo di un flauto.

* Per sentire solo un rigo cliccare sul pulsante Solo ( ). I pulsanti Mute di tutti i righi sono dis-
abilitati (appaiono così: ). È possibile mettere simultaneamente in Solo altri righi cliccando 
sui rispettivi pulsanti Solo; disattivando tutti i pulsanti Solo, i pulsanti Mute sono riabilitati. Ved-
ere Mute e Solo on page 247.

* Per silenziare un rigo cliccare sul pulsante Mute ( ). Cliccare una volta per silenziare a metà il 
rigo ( ) e due volte per silenziarlo completamente ( ). Un terzo clic del mouse lo toglie dal 
Muto. Vedere Mute e Solo on page 247.

* Per regolare il pan del rigo – cioè la sua posizione stereo da sinistra a destra – prima aprire la 
striscia cliccando sulla freccia di apertura poi trascinare a sinistra o destra il cursore pan. Il cur-
sore ha una posizione “adesiva” al centro. Il suono è migliore se non si posizionano i righi troppo 
a sinistra o destra nel campo stereo.

* Il menu device permette di cambiare il dispositivo usato per riprodurre il suono iniziale su un 
determinato rigo, ma si raccomanda di non cambiarlo qui: usare invece la pagina Preferred 
Sounds della finestra Play > Dispositivi d’ingresso e riproduzione per dire a Sibelius che si 
preferisce usare un altro dispositivo, poiché questa scelta sarà salvata nella configurazione di 
riproduzione e sarà applicata a tutte le partiture – vedere Pagina Suoni Preferiti on page 301.
Se si decide di cambiare il dispositivo usato per riprodurre un rigo, si noti che il menu presenta 
un elenco di tutti i dispositivi della configurazione di riproduzione e un’opzione extra (auto) in 
cima all’elenco; per dire a Sibelius di scegliere di nuovo automaticamente il dispositivo selezion-
are (auto).

* Il pulsante a destra del menu device ( ) è abilitato solo se il dispositivo corrente usato per quel 
rigo è uno strumento virtuale; cliccandoci sopra si apre la finestra dello strumento virtuale. Clic-
care di nuovo su questo pulsante per chiuderla. Se per la riproduzione si usa Sounds Essentials 
di Sibelius, cliccando su questo pulsante appare la finestra di Kontakt Player 2 – vedere 
Finestra Kontakt Player 2 on page 251.

* Il controllo di canale o slot MIDI consente solo di cambiare il canale MIDI usato da un rigo se il 
dispositivo corrente usato è un dispositivo MIDI. Se il rigo è riprodotto da Kontakt Player 2, la 
scritta indica che lo slot è usato per questo rigo, ma non si può modificarla. In genere non è nec-
essario cambiarla comunque (perché Sibelius valuta intelligentemente quale canale usare per 
ogni rigo).

* Il campo del numero ID mostra l’identificativo del suono usato dal rigo all’inizio della partitura. 
Se il rigo contiene oggetti che cambiano il suono di riproduzione dopo la prima misura – per 
esempio, cambi strumento, istruzioni di testo per tecniche esecutive, ecc. – questo campo non 
s’aggiorna. Il numero ID del suono iniziale si può cambiare qui scegliendolo dal menu a tendina, 
ma è meglio non farlo: modificare invece il sound ID dello strumento nella finestra House 
Style > Modifica strumenti e ensemble (b Modifica strumenti).

In riproduzione, si può solo regolare il volume (inclusi Solo e Mute) e il pan di ogni rigo; per poter 
cambiare una qualsiasi altra impostazione la partitura non deve essere in riproduzione.
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Striscia traccia clic
La striscia traccia clic è sempre alla base delle strisce rigo:

La striscia traccia clic è molto simile alle altre strisce rigo, 
tranne che invece di scegliere un sound ID iniziale, si può 
cliccare Settings per aprire la finestra di dialogo 
Impostazioni clic indicata a destra.

*Suddividi battiti: utile per alcuni tempi in chiave, come 6/
8, ove c’è un leggero clic su ogni nota da 1/8 (croma).
*Accenta battito di gruppi irregolari: accenta i movi-

menti nella misura in base ai gruppi di beat definiti per tempi in chiave irregolari, come 7/8 
(b Tempi in chiave).

* È possibile anche scegliere i suoni percussivi usati dalla traccia clic per il primo movimento della 
misura e quelli successivi.

Oltre ai pulsanti Solo e Mute sulla striscia traccia clic, si può anche mettere in Solo o silenziare il 
rigo della traccia clic cliccando sul pulsante clic in Riproduzione nella finestra Playback.

Strisce gruppo
Le strisce gruppo consentono di regolare volume e pan relativi di ogni famiglia strumentale usata 
nella partitura. È molto comodo, ad esempio, per aumentare il volume degli archi rispetto a quello 
dei legni, e così via. I controlli nelle strisce gruppo sono i seguenti:

* A sinistra della striscia c’è il campo nome del gruppo. Sibelius determina quali sono i righi 
inclusi in ogni gruppo; non si può cambiare il nome dei gruppi.

* Per regolare il volume di tutti i righi nel gruppo trascinare il fader a sinistra o destra (come per le 
Strisce rigo). Sibelius mantiene l’equilibrio relativo di tutti gli strumenti nel gruppo mentre si 
regola il volume.

* Per il Solo di tutti i righi in un gruppo cliccare sul pulsante Solo (come per le Strisce rigo).
* Per silenziare a metà o completamente tutti i righi in un gruppo cliccare sul pulsante Mute 

(come per le Strisce rigo).

Fader volume e indicatore livello Pulsanti Solo/Mute

Finestra di dialogo 
clic Settings

Cursore PanCanale 
MIDI

Mostra/nasconde finestra 
strumento virtuale

Dispositivo che suona 
questo rigo

Fader volume e indicatore livello Pulsanti Solo/MuteNome gruppo

reference.book  Page 245  Wednesday, April 16, 2008  4:28 PM



4. Riproduzione & video

246

Se mentre si lavora con la striscia gruppo ci sono strisce rigo visibili, si potrà osservare che le mod-
ifiche eseguite nella striscia gruppo si riflettono in ogni striscia rigo.

Strisce strumento virtuale
Ogni strumento virtuale nella configurazione di registrazione ha la propria striscia:

* Il campo con il nome dello strumento virtuale appare sul lato sinistro.

* Per aprire la finestra dello strumento virtuale (per regolarne i parametri) cliccare . Cliccare di 
nuovo per chiudere la finestra. Se nella finestra dello strumento virtuale si eseguono modifiche 
che si vuole siano ricordate da Sibelius in seguito salvare la configurazione di registrazione in 
Play > Dispositivi d’ingresso e riproduzione (vedere Modificare una configurazione di 
riproduzione on page 299).

* Il livello d’uscita di ogni strumento virtuale si regola trascinando il rispettivo fader di volume.
* Per il Solo e Mute di tutti i righi suonati da uno strumento virtuale cliccare sul pulsante Solo o 

Mute nella striscia dello strumento virtuale. I pulsanti Solo e Mute nelle strisce rigo interessate 
riflettono le variazioni eseguite nella striscia dello strumento virtuale.

* Le quattro manopole permettono di determinare la quantità di segnale inviata dallo strumento 
virtuale a ciascuno dei quattro bus effetti. Trascinare il mouse in circolo per aumentare la quan-
tità di segnale inviato al rispettivo bus. La manopola FX1 lo invia al Bus 1, FX2 al Bus 2, e così 
via. Ciò significa che si può inviare l’uscita di vari strumenti virtuali a diversi bus d’effetti. Per 
applicare lo stesso effetto a tutti gli strumenti virtuali usare invece gli effetti master in Insert 
(vedere Striscia volume Master sotto).

Strisce bus effetti
Sibelius ha quattro bus effetti, ciascuno dei quali può caricare fino a effetti che si definiscono nella 
pagina Effects della finestra Play > Dispositivi d’ingresso e riproduzione – vedere Pagina 
Effetti on page 303. Ogni bus ha la propria striscia:

Striscia strumento virtuale 
chiusa

Striscia strumento virtuale 
aperta

Cliccare sulla freccia per 
aprire o chiudere la striscia

Nome strumento virtuale Fader volume e indicatore livello
Mostra/nasconde finestra 

 strumento virtuale

Quantità di segnale inviata
ad ogni bus effetti

Pulsanti Solo/Mute

Guadagno bus d’uscita

Nomi effetto

Mostra/nasconde la finestra effetto

Cliccare sulla freccia per 
aprire o chiudere la striscia

Regolazione livello 
d’ingresso
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Quando è chiusa, la striscia mostra un campo nome del bus e un fader che regola il guadagno 
d’uscita del bus diretto al mix.

Se si apre la striscia cliccando sulla freccia appare un fader extra denominato TRIM. Esso regola i 
livelli d’ingresso che entrano nel bus effetti. In genere non è necessario regolarlo, poiché quasi tutti 
gli effetti hanno un controllo di guadagno nella propria finestra, ma è stato previsto per gli effetti 
che non l’hanno.

A sinistra della striscia aperta c’è il nome di tutti gli effetti nel bus. Per aprire una finestra effetto in 
modo da regolare i parametri cliccare . Cliccare di nuovo per chiudere la finestra. Se nella 
finestra dell’effetto si eseguono modifiche che si vuole restino usando Sibelius in seguito, salvare la 
configurazione di registrazione in Play > Dispositivi d’ingresso e riproduzione (vedere Modifi-
care una configurazione di riproduzione on page 299).

Striscia volume Master
Alla base della finestra Mixer c’è la striscia di volume Master che permette di regolare il volume di 
tutti gli strumenti virtuali ed effetti da un singolo fader ed eseguire modifiche sugli effetti Master 
in Insert, applicate anche sull’uscita di tutti gli strumenti virtuali ed effetti in uso:

Quando la striscia di volume Master è chiusa l’unico controllo è il fader di volume. In riproduzi-
one, lo sfondo del fader s’illumina indicando il livello d’uscita; questo fader influenza solo gli stru-
menti virtuali, quindi se uno o più righi nella partitura sono riprodotti dal sintetizzatore interno 
della scheda audio o da un dispositivo MIDI esterno, il fader non ha effetto sul loro volume.

Una volta aperta la striscia cliccando sulla freccia, si può vedere la finestra di ciascuno dei quattro 
effetti Master in Insert cliccando . Per informazioni sugli effetti Master in Insert vedere Pagina 
Effetti on page 303.

Mute e Solo
Per verificare singoli strumenti o gruppi di strumenti, qualsiasi rigo può essere riprodotto a pieno 
volume, a metà volume o silenziato completamente (silente). Cliccare sul pulsante Mute ( ) del 
rigo in questione per selezionare le tre diverse impostazioni Mute.

Un’applicazione utile di questa funzionalità è realizzare registrazioni di “musica meno uno”: collo-
cando uno strumento in secondo piano si aiutano i musicisti memorizzare la parte. Silenziare 
completamente uno strumento è utile per studiare la propria parte mentre Sibelius suona 
l’accompagnamento o per riprodurre musica scritta per cornamusa o fisarmonica.

Si può mettere in Solo un intero rigo (silenziando tutti gli altri) cliccando sul pulsante Solo ( ). 
È possibile aggiungere altri righi cliccando sui rispettivi pulsanti Solo.

Fader volume e indicatore livello

Nomi effetto

Mostra/nasconde finestra effetto

Cliccare sulla freccia per 
aprire o chiudere la 

striscia

reference.book  Page 247  Wednesday, April 16, 2008  4:28 PM



4. Riproduzione & video

248

Per riprodurre solo alcuni strumenti della partitura selezionare alternativamente gli strumenti 
necessari come passaggio prima di riprodurli (b Selezioni e passaggi). Riproducendo una 
selezione di righi nella partitura, il loro stato Mute è ignorato – se si sta lavorando su un quartetto 
d’archi e si silenzia il rigo di violino ma poi si seleziona, ad esempio, quel rigo di violino e un rigo 
di cello da riprodurre entrambi, essi suoneranno. Sibelius presume che quando si seleziona specifi-
camente un rigo da riprodurre, lo si vuole davvero sentire anche se è silenziato.

Campo sonoro
Appurato che l’essere umano ha solo due orecchie il cervello fatica a costruire un’immagine tridi-
mensionale da due sorgenti sonore. Quindi difficilmente è un limite il fatto che il dispositivo di 
riproduzione possa riprodurre solo in stereo finchè si riescono a ricreare i suoni che si sentirebbero 
se i musicisti suonassero dal vivo davanti a noi. L’impressione tridimensionale creata da un suono 
stereo ben preparato è talvolta chiamato un “campo sonoro” – e la funzione SoundStage di Sibelius 
la ricrea automaticamente.

Immaginando di ricreare il campo sonoro che si sentirebbe tra il pubblico in una sala da concerto, 
con un’orchestra che suona sul palco, entrano in gioco numerosi fattori:

* Ogni strumento si trova a una distanza leggermente diversa dall’ascoltatore e le varie parti 
hanno un numero diverso di esecutori; ciò influenza il volume relativo degli strumenti.

* Ogni strumento si trova a una posizione sinistra-destra leggermente diversa dall’ascoltatore.
* Le acustiche della sala generano riverbero, dal quale si può sentire non solo la dimensione ma 

anche la forma della sala stessa.
* Gli strumenti più vicini all’ascoltatore generano meno riverbero degli altri. Questo perché i loro 

suoni arrivano direttamente all’orecchio invece di rimbalzare sulle pareti (si può paragonare il 
suono “sordo” di qualcuno che parla ad un normale telefono con quello più vivo e aperto di un 
telefono a viva voce).

* Uno strumento lontano, come una tromba giù dal palco, suona molto riverberante perché nes-
suna parte del suo suono arriva direttamente alle orecchie dell’ascoltatore; lo strumento suona 
debole, quindi il suo volume è basso.

Non è necessario attivare o disattivare SoundStage – è sempre attivo. Ogni volta che si creano gli 
strumenti, Sibelius li colloca automaticamente in uno spazio a 3D, come se fossero sul palco di una 
sala da concerto – non solo in stereo (cioè con posizioni pan adeguate), ma anche con lievi rego-
lazioni di volume per simulare distanza o vicinanza degli strumenti.

Le impostazioni SoundStage di Sibelius sono layout standard per orchestra, band di ottoni, ensem-
ble di cori e archi – in realtà vanno bene anche per altre combinazioni.

Migliorare la riproduzione con molti strumenti
Con molti strumenti in riproduzione si può avere un “effetto organo”; ciò è dannoso, poiché è evi-
dente che il suono non è quello di una registrazione reale.

Le cause principali di questo problema sono quattro (e piuttosto facili da evitare):

* Pessimo bilanciamento. Regolando al massimo tutti i volumi di una partitura orchestrale, ad 
esempio, alcuni strumenti diventano troppo forti e altri sono coperti.
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* Espressione scarsa. Provare a impostare l’opzione Espressivo nella finestra di dialogo Play >
Esecuzione in Espressivo o Molto espressivo. Essa introduce una gradazione di volume che 
aiuta a distinguere le diverse linee musicali anche in una grande partitura. In generale, più stru-
menti suonano, più Espressivo si dovrebbe aggiungere (b Esecuzione).

* Effetto “Phasing”. Il suono noioso simile a una radio mal sintonizzata provocato da due strumenti 
identici che eseguono lo stesso suono all’unisono. Se due righi nella partitura si raddoppiano 
spesso l’un l’altro (es. Violini 1 e 2) usare i box di spunta Play on pass nella finestra Properties
(b Proprietà) per silenziare uno dei righi mentre sono doppiati. 
Ciò dovrebbe introdurre un miglioramento significativo.

* Posizioni pan non abbastanza distinte. Per l’orecchio non è facile separare i vari suoni degli stru-
menti; modificare opportunamente le posizioni panoramiche dei suoni nel campo stereo.

reference.book  Page 249  Wednesday, April 16, 2008  4:28 PM



4. Riproduzione & video

250

4.4 Sibelius Sounds Essentials

b Riproduzione, Mixer, Esecuzione, Esportare i file audio.

v Kontakt Player.

Sibelius Sounds Essentials è una libreria sonora di alta qualità costituita da un set completo di 128 
suoni General MIDI M-Audio Session, oltre a strumenti scelti con cura da Sibelius Sounds Rock 
and Pop Collection, la rinomata Garritan Personal Orchestra, Garritan Concert & Marching Band, 
Garritan Jazz and Big Band e Virtual Drumline di Tapspace. Il risultato è una raccolta versatile di 
suoni adatti a qualsiasi genere musicale.

Sibelius Sounds Essentials ha bisogno di Kontakt Player 2, uno strumento virtuale di Native 
Instruments incluso in Sibelius. Kontakt Player 2 è un sofisticato player di campioni che può essere 
usato con un’ampia gamma di librerie, comprese quelle Sibelius Sounds quelle prodotte da Garri-
tan, Tapspace e altri costruttori.

È possibile aggiungere altre liberie di suoni da usare con Kontakt Player 2 in Sibelius, comprese le 
versioni complete (dalle quali sono ricavati i suoni di Sibelius Sounds Essentials). Selezionare 
Help > Sibelius Sounds per collegarsi al sito web di Sibelius e avere ulteriori informazioni.

Requisiti del computer
Kontakt Player 2 ha bisogno degli stessi requisiti del computer per Sibelius 5 – per i dettagli vedere 
Installare Sibelius in Windows o Installare Sibelius in Mac nella Guida.

Le librerie di suoni occupano molto spazio su hard-disk, quindi assicurarsi di averne molto libero; 
inoltre, per caricare molti suoni contemporaneamente serve molta RAM. Vedere Come otte-
nere il meglio da strumenti virtuali ed effetti on page 314 per i consigli utili sia per Kon-
takt Player 2 che per altri strumenti virtuali.

Installare Sibelius Sounds Essentials
Per installare Sibelius Sounds Essentials e Kontakt Player 2 vedere Installare Sibelius in Win-
dows o Installare Sibelius in Mac nella Guida.

Configurare Sibelius Sounds Essentials
Per riprodurre le partiture con Sibelius Sounds Essentials:

* Selezionare Play > Dispositivi di Ingresso e Playback.

* Dal menu Configurazione alla base della finestra selezionare Sibelius Sounds Essentials.
* Attendere che Kontakt Player 2 si carichi. Nell’elenco Periferiche attive sul lato destro della 

pagina Periferiche attive apparirà KontaktPlayer2. Sound set sarà impostato in Sibelius 
Sounds Essentials.

* Cliccare Chiudi.

Avviando la riproduzione della partitura, Sibelius carica automaticamente i suoni necessari in 
Kontakt Player 2 (sullo schermo appare una serie di barre di progresso mentre si carica ogni 
suono); in genere bastano pochi secondi e poi inizia la riproduzione della partitura .
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Come funziona Kontakt Player 2
Per ottenere il meglio da Kontakt Player 2, bisogna sapere un pò come funziona. Kontakt Player 2 
riproduce fino a 16 suoni diversi simultaneamente e ogni suono è caricato in uno dei 16 slot dis-
ponibili (simili a canali MIDI).

Può riprodurre cioè senza alcun problema partiture costituite da fino a 16 strumenti diversi.

Tuttavia, un rigo della partitura potrebbe potenzialmente usare più di un suono a causa di cambi 
strumento (per esempio, se un rigo inzia con un clarinetto, ma in seguito diventa un sax) o modi-
fiche nella tecnica esecutiva (per esempio, se un rigo di violino inizia con l’archetto, ma in seguito 
esegue un pizzicato); ciò può aumentare il numero totale di suoni usati nella partitura portandolo 
a oltre 16 (dipende se Sibelius può riprodurre o meno i suoni usando lo stesso slot).

I suoni possono condividere uno slot se ad essi si accede con un selettore, in modo che Sibelius 
suoni una nota specifica per triggerare un cambio di suono (noto come keyswitch), imposti un 
controller MIDI a un valore specifico, oppure suoni una nota ad una certa velocity, e così via. Molti 
dei suoni in Sibelius Sounds Essentials funzionano così: per esempio, i violini della Garritan Per-
sonal Orchestra possono passare da archetto a pizzicato grazie ai keyswitch; allo stesso modo, le 
trombe della Garritan Jazz and Big Band possono avere il suono pieno o con la sordina.

Per passare ad un suono completamente diverso (da un clarinetto a un sax, ad esempio) in genere 
serve uno slot extra.

In pratica, ciò significa che se in totale la partitura ha più di 16 strumenti, Sibelius deve arrivare a 
un compromesso per riprodurla al meglio. Per i righi nella stessa famiglia strumentale (es. legni, 
ottoni e archi) raddoppia i righi nello stesso slot, in modo che tutti usino lo stesso suono – si 
potrebbe quindi finire con l’avere clarinetti, oboe e tube tutti con un suono di tuba (ad esempio).

Se la partitura richiede più di 16 strumenti diversi, si possono attivare ulteriori istanze (copie) di 
Kontakt Player 2, per evitare che Sibelius condivida i suoni:

* Selezionare Play > Dispositivi di Ingresso e Playback e andare alla pagina Periferiche attive.
* Nell’elenco Periferiche disponibili selezionare KontaktPlayer2 e cliccare Attiva.

* Attendere che si carichi Kontakt Player 2; quando appare nell’elenco Periferiche attive, assi-
curarsi che la colonna Sound set sia impostata su Sibelius Essentials.

* Cliccare Salva per salvare le modifiche alla propria configurazione e cliccare Close.

Sibelius usa automaticamente le istanze di Kontakt Player 2 messe a disposizione. Ogni istanza, 
però, appesantisce il processore, quindi se il computer è abbastanza veloce ed ha memoria suffi-
ciente è meglio usare più di un Kontakt Player 2.

Finestra Kontakt Player 2
In genere non c’è bisogno di regolare direttamente le impostazioni nella finestra Kontakt Player 2, 
perché Sibelius carica automaticamente i suoni necessari e il riverbero. Infatti, molte delle 
impostazioni nella finestra Kontakt Player 2 (per esempio, i controlli su strumenti individuali, 
come le singole manopole per brillantezza, attacco o riverbero) non si possono salvare; in generale, 
quindi, è meglio non regolarle direttamente nell’interfaccia grafica. Alcuni di questi parametri 
possono essere controllati dai messaggi controller MIDI (b Messaggi MIDI), quindi usare 
questi (ove possibile).
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Per dare un’occhiata alla finestra Kontakt Player 2 mentre si lavora su una partitura aprire la 
finestra Mixer (comando rapido Ctrl+Alt+M o M) e cliccare sul pulsante ; appare questa 
finestra:

Rack strumento
La grande area vicino alla parte alta a destra della finestra Kontakt Player 2 è il rack strumento, ove 
si possono regolare i controlli per ogni suono caricato.

Si notino i pulsanti nell’angolo in alto a destra del rack. I pulsanti numerici consentono di scegliere 
tra le quattro sezioni del rack. In teoria è possibile caricare fino a 64 strumenti nella stessa istanza 
di Kontakt Player 2, ma solo i primi 16 slot sono accessibili da un host come Sibelius, quindi non 
serve premere questi pulsanti.

Il pulsante Aux mostra o nasconde i fader Send ausiliari di ogni strumento – vedere Uscite.

Ogni strumento caricato ha il proprio set di controlli; per aprire o chiudere la metà inferiore del 
pannello cliccare sul pulsante a sinistra. Strumenti diversi hanno vari controlli. In generale, gli 
strumenti si controllano dalla finestra Mixer di Sibelius invece che dai controlli presenti nel rack 
strumento di Kontakt Player 2.

Pannello di controllo principale

Browser

Tastiera virtuale

Uscite

MasterKontrol

Rack strumento
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Pannello di controllo principale
Il pannello di controllo principale in cima alla finestra consente di nascondere e mostrare gli altri 
elementi della finestra Kontakt Player 2.

Browser, Outputs, Keyboard, MasterKontrol e Options sono descritti nei dettagli in seguito.

Cliccando Load/Save appare un menu che consente di caricare e salvare strumenti e multi (un 
“multi” è una combinazione di strumenti, effetti e altre impostazioni che si possono caricare o sal-
vare). Tuttavia, poiché Sibelius carica automaticamente i suoni necessari, non c’è bisogno di usare 
queste opzioni.

Le opzioni nel menu Purge servono per scaricare dalla RAM i campioni inutilizzati. Una volta 
riprodotta la partitura, si possono escludere i campioni non riprodotti (per ridurre la quantità di 
RAM utilizzata). Si noti, tuttavia, che se in seguito si cambiano le note nella partitura, i campioni 
necessari a suonarle potrebbero essere stati esclusi; in tal caso scegliere Reload All Samples dal 
menu Purge.

Il menu Vista permette di scegliere varie dimensioni per la finestra Kontakt Player 2: Normal 
Size, Bigger Size o Large Size. Normalmente si lascia in Normal Size.

Gli indicatori di prestazioni del sistema mostrano, dall’alto a sinistra in 
senso orario:

* Notes: quantità di polifonia usata. La cifra sinistra indica il numero 
corrente di note riprodotte; la cifra destra mostra la polifonia massima disponibile.

* CPU: mostra le risorse del processore consumate da Kontakt Player 2; più barre illuminate indi-
cano un consumo maggiore della CPU.

* Disk: indica gli accessi all’hard-disk di Kontakt Player 2; un flusso maggiore di dati dall’hard-
disk fa illuminare più barre.

* RAM: indica la memoria occupata dai campioni usati da Kontakt Player 2.

Il pulsante all’estrema destra del pannello di controllo attiva la veduta Instrument Focus, 
grazie alla quale la dimensione della finestra si riduce, in modo da concentrare l’attenzione 
sullo strumento corrente scelto e nascondere gli altri elementi. Cliccare di nuovo su questo 

pulsante per riportare la finestra alla sua dimensione normale.
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Browser
Nella zona sinistra della finestra c’è il Browser con tre pagine: Libraries, 
Engine e Auto.

La pagina Libraries consente di vedere i dettagli di tutte le librerie Kon-
takt Player 2 installate. Qui c’è almeno Sibelius Sounds Essentials.

Alcune librerie di suoni richiedono un’autorizzazione per potere essere 
usate più di 30 giorni. La stato d’autorizzazione di una libreria installata 
si vede nel suo titolo. Se a sinistra del nome appare una piccola icona 
gialla d’avviso  , significa che la libreria non è ancora stata autorizzata 
e dopo 30 giorni non funzionerà più se nel frattempo non la si autorizza.

Se c’è un piccola icona rossa d’avviso , il periodo di prova è scaduto e 
si deve autorizzare la libreria per poterla usare.

Per autorizzare una libreria cliccare sul pulsante Info, selezionare la pag-
ina Register nella finestra di dialogo e scegliere Launch Service Center
per avviare l’applicazione NI Service Center. Si possono quindi autoriz-
zare le librerie via Internet.

Sibelius Sounds Essentials non richiede autorizzazione perché può essere usata solo in Sibelius.

I pulsanti Instruments e Multis nel pannello di ogni libreria visual-
izzano un elenco di strumenti e multi in essa contenuti. Scegliere uno 
strumento dal menu per caricarlo – sebbene non sia necessario farlo, 
perché Sibelius carica già gli strumenti. Cliccare Info per visualizzare 
una finestra di dialogo con le informazioni sulla libreria.

La pagina Engine del Browser mostra informazioni in tempo reale sulle prestazioni del motore di 
campionamento, mentre la pagina Automation permette di assegnare vari tipi d’automazione 
MIDI ai vari controlli in Kontakt Player 2; non c’è bisogno di sapere niente su questa pagina, tranne 
che si deve lasciarla in Host Automation.

Uscite
Nel pannello Outputs di Kontakt Player 2 ci sono due tipi di fader:

Ogni fader blu rappresenta un’uscita stereo. Sibelius può indirizzare solo una singola uscita da ogni 
strumento virtuale, quindi si possono assegnare gli strumenti solo attraverso la prima uscita stereo 
st. 1. I fader arancio (da aux. 1 a aux. 4) controllano i ritorni dai quattro effetti in Send. 
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Di default, Sibelius carica gli effetti riverbero e chorus rispettivamente nelle prime e seconde uscite 
ausiliare Return.

Non si possono utilmente aggiungere o rimuovere canali, quindi è possibile ignorare i pulsanti 
Add Channel e Delete Channel. Il pulsante Hide Inserts nasconde gli effetti in Insert per ris-
parmiare spazio. Per modificare i parametri di un effetto, selezionarlo nell’elenco degli Insert sopra 
il rispettivo bus e cliccare Edit Effect.

Modificando le uscite, si può salvarle come default per il futuro cliccando Make Default.

Tastiera virtuale
Il pannello Keyboard visualizza sullo schermo una tastiera virtuale:

I tasti blu indicano le note che riproducono un suono; quelli rossi mostrano i tasti che triggerano i 
keyswitch. Si può cliccare con il mouse sui tasti per ascoltare il suono selezionato, ma non si pos-
sono inserire le note nella partitura cliccando sulla tastiera virtuale di Kontakt Player 2.

MasterKontrol
Il pannello MasterKontrol consente di regolare alcune impostazioni applicate a tutti gli stru-
menti:

Per cambiare l’intonazione regolare il controllo Master Tune dal suo valore di default di 440Hz.

Non c’è da preoccuparsi delle funzioni Extern Sync, tempo o Reference Tone, poiché in Sibelius 
non hanno un impiego pratico.

Opzioni
Il pulsante Options nel pannello di controllo principale visualizza una finestra di dialogo con sei 
pagine; nel complesso non c’è da preoccuparsi di queste opzioni, ma eccole descritte in breve:

* Pagina Interface :
% I controlli Small size, Mid size, Big size regolano le dimensioni in pixel.
% Capture keyboard from host: non deve essere attiva; se attiva, questa opzione cattura le 

pressioni sui tasti da Sibelius e le passa a Kontakt Player 2.
% Capture mouse from host: non deve essere attiva; se attiva, questa opzione cattura i movi-

menti della rotellina del mouse da Sibelius e li passa a Kontakt Player 2.
% Show mapping and keyswitches on keyboard: è attiva di default; disattivandola, i tasti 

sulla tastiera virtuale non si colorano in blu o rosso.
% Auto-refresh Browser: non è attiva di default; attivandola, Kontakt Player 2 rileva automati-

camente dal sistema operativo se è cambiata o è stata creata una cartella libreria. Si può tran-
quillamente lasciare disattivata questa opzione.

% Menu font size: consente di scegliere una dimensione del testo normale (Normal) e più 
grande (Larger).
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* Pagina Audio Engine :
% Si può scegliere se il volume di default dei nuovi strumenti sarà -6dB o 0dB. Si raccomanda 

di lasciarlo a -6dB.
% CPU overload protection: determina come Kontakt Player 2 gestisce un notevole consumo 

di CPU. Se il consumo di risorse della CPU resta alto, Kontakt Player 2 toglie alcune note di 
polifonia per ridurre il consumo del processore; lasciarlo in Relaxed.

% Multiprocessor support: lasciare attiva questa opzione se il computer ha più processori (o 
un processore dual-core o quad-core).

% Send MIDI to outside world: stabilisce se Kontakt Player 2 trasmette i dati MIDI generati 
all’applicazione host; si raccomanda di non cambiare questa impostazione.

% Offline interpolation quality: consente di regolare la qualità audio quando si esporta una 
traccia audio. High-Quality Interpolation (HQI) aiuta ad eliminare l’aliasing digitale nei suoni 
(che diventa particolarmente udibile quando si trasportano in alto i suoni con un contenuto 
significativo di alte frequenze). In generale, non serve regolare l’impostazione di default 
same as real-time (è stessa qualità che si sente durante la normale riproduzione).

* Pagina Handling:
% Attivare l’opzione Use computer keyboard for MIDI playback per consentire alla tastiera 

del computer di triggerare i suoni in Kontakt Player 2; normalmente si lascia disattivata.
% Solo Mode: consente di scegliere tra le opzioni Solo In-Place (solamente uno strumento in 

Solo e gli altri silenziati) e Solo Latch (più strumenti in Solo).
% Browser: double-click loads instrument: è attiva di default; con un doppio-clic del mouse 

su uno strumento nel Browser, esso è caricato.
% Browser: show files before folders: è attiva di default; permette di cambiare l’ordine di file 

e cartelle nel Browser.
% Default root key for new zones: specifica la root key (tonica) di default per gli strumenti 

dotati di questa informazione.
% MIDI channel assignment for loaded patches: permette di specificare se Kontakt Player 2 

deve caricare ogni nuovo suono nel primo canale libero (1st free) o fare in modo che accet-
tino il MIDI su tutti i canali (omni); non cambiare questa impostazione.

% Installation base path: è la cartella nella quale Kontakt Player 2 era installato in origine. 
Evitare di spostare questa cartella, ma se si fa è possibile specificarla di nuovo qui.

* Pagina Load/Import :
% Load instruments/banks/multis in “purged mode”: questa opzione ricarica i parametri 

dei campioni esclusi, ma senza il dato del campione vero e proprio; lasciarla disattivata.
% Force-load pre-2.0 patches in DFD mode: obbliga il motore a usare lo streaming Direct 

From Disk (DFD) anche per vecchie patch che in origine non lo usavano.
% Unwind automation IDs for additionally loaded patches: è un’opzione particolare per 

assegnare l’automazione allo stesso suono caricato in più slot; lasciarla disattivata.
% Library path: è la destinazione alla quale sono salvati gli strumenti e le combinazioni multi

regolate dall’utente.
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* La pagina Search/DB specifica le opzioni che riguardano le funzioni di ricerca di Kontakt Player 
2; non sono particolarmente importanti.

* La pagina DFD consente di specificare lo spazio di memoria da dedicare allo streaming Direct 
From Disk (DFD). Sebbene i campioni si prelevino dall’hard-disk è necessario memorizzare i 
loro attacchi in RAM in modo che siano subito disponibili in riproduzione. Se lo streaming DFD 
non funziona correttamente assegnare più RAM in Amount of memory for DFD.

Suoni interni
I suoni di Sibelius Sounds Essentials sono i seguenti:

Nome Tecniche / strumenti Intervallo

Garritan Personal Orchestra

Violins 1 KS Keyswitch: arco (C–1); pizzicato (F–1) G3 a A8

Violas KS Keyswitch: arco (C–1); pizzicato (F–1) C3 a A6

Cellos KS Keyswitch: arco (C–1); pizzicato (F–1) C2 a E6

Double Basses KS Keyswitch: arco (C–1); pizzicato (F–1) C0 a G4

Guarneri Solo Violin KS Keyswitch: arco (C–1); pizzicato (F–1) G3 a C8

Piccolo D5 a C8

Flute Solo B3 a D7

Oboe 1 Modern Solo Bb3 a A6

Bb Clarinet Solo C#3 a G#6

Bass Clarinet Solo Bb1 a F5

Bassoon 1 Solo Bb1 a E5

French Horn Solo 1 E1 a F5

Trumpet 1 Solo C3 a F6

Tenor Trombone Solo E1 a F5

Tuba 1 Solo Bb0 a B4

Basic Orchestral Percussion Bass drum hit (B1); Bass drum hit 2 (C2), Bass drum roll (C#2); Tim-
pani hit (D2–G3); Side drum hit, snares off, left (G#3); Side drum hit, 
snares off, right (A3); Side drum hit, snares off, roll (A#3); Side drum 
hit, snares on, left (B3); Side drum hit, snares on, right (C4); Side 
drum hit, snares on, roll (C#4)

Garritan Jazz and Big Band

Trumpet Keyswitch: aperto (C–1); harmon mute (F–1) E3 a Bb6

Alto Saxophone C#3 a F6

Tenor Saxophone G#2 a C6

Baritone Saxophone C2 a C6

Garritan Concert & Marching Band

Trumpet Ensemble E3 a Bb6

Mellophone Ensemble Bb1 a F5

Baritone Ensemble E2 a F5

Tuba Ensemble Bb1 a F4

Trombone Ensemble E1 a F5
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Tapspace Virtual Drumline 2

Marching Snares (Manual) All with snares on: sustained roll (E6); RH hits (G#5); LH hits (F#5); RH 
shots (G5); LH shots (F5); RH rims (Eb5); LH rims (Db5); ride cymbal 
(E3); bell of ride cymbal (D3); cymbal crash (C3)

Marching Snares (Auto RL) All with snares on, automatic RL switching: sustained roll (B5); rim 
shots (C5); main hits (B4); rims (A4); ride cymbal (E3); bell of ride 
cymbal (D3); cymbal crash (C3)

Marching Tenor Drums (Manual) Spock 1 RH Hits (E5); Spock 1 LH Hits (Eb5); Spock 2 RH Hits (D5); 
Spock 2 LH Hits (Db5); Drum 1 RH Hits (C5); Drum 1 LH Hits (B4); 
Drum 2 RH Hits (Bb4); Drum 2 LH Hits (A4); Drum 3 RH Hits (Ab4); 
Drum 3 LH Hits (G4); Drum 4 RH Hits (F#4); Drum 4 LH Hits (F4); 
Sustained buzz roll spock 1 (Bb3); Sustained buzz roll spock 2 (A3); 
Sustained buzz roll drum 1 (Ab3); Sustained buzz roll drum 2 (G3); 
Sustained buzz roll drum 3 (F#3); Sustained buzz roll drum 4 (F3); 
Spock 1 RH shot/rim (E3); Spock 1 LH shot/rim (Eb3); Spock 2 RH 
shot/rim (D3); Spock 2 LH shot/rim (Db3); Drum 1 RH shot/rim (C3); 
Drum 1 LH shot/rim (B2); Drum 2 LH shot/rim (Bb2); Drum 2 RH 
shot/rim (A2); Drum 3 RH shot/rim (Ab2); Drum 3 LH shot/rim (G2); 
Drum 4 RH shot/rim (F#2); Drum 4 LH shot/rim (F2)

Marching Tenor Drums (Auto RL) Automatic RL switching: Spock 2 shots/rims (Db6); Spock 2 hits (B5); 
Spock 1 shots/rims (Ab5); Spock 1 hits (G5); Drum 1 shots/rims (Gb5); 
Drum 1 hits (E5); Drum 2 shots/rims (Db5); Drum 2 hits (C5); Drum 3 
shots/rims (Bb4); Drum 3 hits (A4); Drum 4 shots/rims (F#4); Drum 4 
hits (F4); Roll Spock 2 sustained buzz (A3); Roll Spock 1 sustained 
buzz (F3); Roll Drum 1 sustained buzz (D3); Roll Drum 2 sustained 
buzz (B2); Roll Drum 3 sustained buzz (G2); Roll Drum 4 sustained 
buzz (E2)

Marching Bass Drums (Manual) Drum 1 RH hits (E5); Drum 1 LH hits (Eb5); Drum 2 RH hits (D5); 
Drum 2 LH hits (C#5); Drum 3 RH hits (C5); Drum 3 LH hits (B4); 
Drum 4 RH hits (Bb4); Drum 4 LH hits (A4); Drum 5 RH hits (Ab4); 
Drum 5 LH hits (A4); Drum 5 RH hits (Ab4); Drum 5 LH hits (G4); 
Drum 6 RH hits (F#4); Drum 6 LH hits (F4); Unison RH hits (E4); Uni-
son LH hits (Eb4); Unison RH rims (D4); Unison LH rims (C#4); Uni-
son sustained roll (Ab3)

Marching Bass Drums (Auto RL) Automatic RL switching: Unison sustained roll (B6); Drum 1 hits (G5); 
Drum 2 hits (E5); Unison rims (D5); Drum 3 hits (C5); Unison hits 
(B4); Drum 4 hits (A4); Drum 5 hits (F4); Drum 6 hits (D4)

Marching Cymbals Unison cymbal section: hi hat choke (Bb5); sizzle/suck A (C#5); sizzle 
(D5); vacuum suck (C5); crash choke fat (B4); flat crash (Bb4)

Unpitched Concert Percussion Brake drum RL (C7); wind chimes (B6); Finger cymbal (A6); Triangle 
roll (G6); Triangle hit sustain/muted (F6); Bell plate (E6); Suspended 
cymbal cresc. mp (D6); Suspended cymbal cresc. f (C6); Suspended 
cymbal crash (B5); Suspended cymbal crash choke (A5); Suspended 
cymbal w/stick tip (ride) (G5); Hand cymbals choke (F5); Hand cym-
bals crash (E5); Concert snare drum roll (D5); Concert snare drum hits 
RL (C5); Tambourine fist hits (B4); Tambourine roll shaken (A4); 
Tambourine thumb roll (G4); Tambourine finger hits RL (F4); Temple 
block high RL (E4); Temple block med-high RL (D4); Temple block 
med RL (C4); Temple block med-low RL (B3); Temple block low RL 
(A3); Concert tom high RL (G3); Concert tom med-high RL (F3); Con-
cert tom med-low RL (E3); Concert tom low RL (D3); Impact drum 
hits RL (C3); Tam-tam hit p (B2); Tam-tam hit f (A2); Concert bass 
drum roll (G2); Concert bass drum hit RL (F2)

Marimba C2 a C7

Nome Tecniche / strumenti Intervallo
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Vibraphone Sustain; Damped F3 a F6

Xylophone F3 a C7

Glockenspiel F3 a C6

Crotales (one octave) C4 a C5

Chimes C4 a G5

Timpani C2 a C4

Sibelius Sounds World Instruments (suoni Garritan)

Ewe Drum Ensemble I suoni sono solo su note bianche C2 a B4

Djembe Ensemble I suoni sono solo su note bianche C3 a C4

Da altri costruttori

Steinway piano (Peter Siedlaczek) A0 a C8

Recorder (Northstar) A0 a C8

Harp (Northstar) C–1 a G9

Handbells (Northstar) C–1 a G9

Female Choir “Ah” (Sonivox) C2 a G7

Male Choir “Ah” (Sonivox) F1 a F5

Choir “Ooh” (Sonivox) C–1 a G7

 Sibelius Sounds Rock and Pop Collection (suoni Sonivox & Native Instruments)

Drum Kit (Brushes) Loose kick (B1); Tight kick (C2); Snare swirl, long (C#2); Rim shot 
(D2); Claps (D#2); Snare swirl, short (E2); Low floor tom (F2), Hi-hat, 
closed (F#2); High floor tom (G2); Hi-hat, pedal (G#2); Low rack tom 
(A2); Hi-hat, open (A#2); Mid rack tom (B2); High mid-rack tom (C3); 
Low crash cymbal (C#3); High rack tom (D3); Low ride cymbal (D#3); 
Hi-hat foot pedal (E3); Ride bell (F3); Tambourine (F#3); Splash cym-
bal (G3); Cowbell (G#3); High crash cymbal (A3); Vibraslap (A#3); 
Gong, with sizzles (B3); High bongo (C4); Low bongo (C#4); Muffled 
slap (D4); Conga (D#4); Tumba (E4); Timbale, high (F4); Timbale, low 
(F#4); Agogo, high (G4); Agogo, low (G#4); Cabasa (A4); Maracas 
(A#4); Whistle, low (B4); Whistle, high (C5); Guiro, short (C#5); Guiro, 
low (D5); Clave (D#5); Woodblock, high (E5); Woodblock, low (F5); 
Cuica, low (F#5); Cuica, high (G5); Triangle, mute (G#5); Triangle, 
open (A5); Shaker (A#5)

Drum Kit (Dance) Metronome bell (A#1); Snare (B1); Tight kick (C2); Side stick (C#2); 
Rimshot (D2); Claps (D#2); Snare drum (E2); Low floor tom (F2); Hi-
hat, closed (F#2); High floor tom (G2); Hi-hat, pedal (G#2); Low rack 
tom (A2); Hi-hat, open (A#2); Mid rack tom (B2); High mid-rack tom 
(C3); Low crash cymbal (C#3); High rack tom (D3); Low ride cymbal 
(D#3); Chinese cymbal (E3); Ride bell (F3); Tambourine (F#3); Tam-
bourine, pop (G3); Dance cowbell (G#3); High crash cymbal (A3); 
Klick snare (A#3); Table ball (B3); High bongo (C4); Low bongo (C#4); 
Muffled slap (D4); Conga (D#4); Tumba (E4); High timbale (F4); Low 
timbale (F#4); Zap (G4); Zappy (G#4); Snare synth 2 (A4); Hi-hat 1 
(A#4); Hi-hat 2 (B4); Hi-hat 3 (C5); Short guiro (C#5); Future snare 
(D5); Clave (D#5); Dance cowbell 2 (E5); Al Snare (F5); Acid bass 
drum (F#5); Acid bass drum (G5); Dark bass drum (G#5); Techno bass 
drum (A5); Kring bass drum (A#5); Work bass drum (B5); Muffled 
bass drum (C6); 808 bass drum (C#6); Klick bass drum (D6); Lo-fi 
bass drum (D#6); Booch (E6); Real bass drum (F6); Sub-bomb (F#6)

Drum Kit (Modern Rock) General MIDI-compatible drum kit

Nome Tecniche / strumenti Intervallo
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World Percussion Tumba, open (C1); Tumba, mute slap (D1); Tumba tip, round-robin 
(E1), Tumba, muffled slap (F#1); Tumba, finger bend (G1); Tumba, 
mute tone (G#1); Tumba, bass tone (A#1); Conga, open (C2); Conga, 
mute slap RH (D2); Conga, tip (E2); Conga, muffled slap (F#2); Conga, 
finger bend (G2); Conga, mute tone round-robin (G#2); Conga, bass 
tone (A#2); Qunto, open RH (C3); Quinto, mute slap (D3); Quinto, tip 
(E3); Quinto, muffled slap (F#3); Quinto, finger bend (G3); Quinto, 
mute tone round-robin (G#3); Quinto, bass tone (A#3); Whistle, low 
long (B3); Whistle, high long (C4); Guiro, short (C#4); Guiro, long 
(D4); Cabasa (D#4); Crash cymbal (E4); Splash cymbal (F4); Triangle, 
mute (G#4); Triangle, open (A4); Shaker (A#4); Maraca (B4); Low 
bongo, open (C5); Low bongo, slap (D5); Low bongo, bass tone (E5); 
Low bongo, muffled slap (F#5); High bongo, open (C6); High bongo, 
slap (D6); High bongo, tip and heel (E6); High bongo, muffled slap 
(F#6); Clave (G6), Wood block, round-robin (G#6); Ride bell (A#6); 
Ride bell crash (B6); Mambo bell, open (C7); Salsa bell, open (D#7); 
Mambo bell, rim (E7); Cha-cha bell, rim (A7), Low timbale (C8), Low 
timbale, rim (C#8); Cascara (D8); Low timbale, open tone hand (D#8); 
Low timbale, muffled hit (E8); Low timbale, side stick (F8); High tim-
bale, open (F#8); High timbale, rim shot (G8); High timbale, open tone 
hand (A8); High timbale, muffled hit (A#8); High timbale, side stick 
(B8)

Fender Rhodes Mk.2 Tremolo E1 a E7

Hammond B3 Organ C2 a C7

Clavinet E7 E1 a E7

Electric Bass (Precision) Keyswitch: pick (C0); slap (D0); mute (E0) B0 a E5

Electric Guitar (Stratocaster) Keyswitch: pick (C1); mute (D1) C2 a F6

Acoustic Guitar (Nylon) C2 a E6

General MIDI (sounds from M-Audio Session)

Acoustic Grand Piano C–1 a G9

Bright Acoustic Piano C–1 a G9

Electric Grand Piano C–1 a G9

Honky-Tonk Piano C–1 a G9

Electric Piano 1 C–1 a G9

Electric Piano 2 C–1 a G9

Harpsichord C–1 a G9

Clavi C–1 a G9

Celesta C–1 a G9

Glockenspiel C–1 a G9

Music Box C–1 a G9

Vibraphone C–1 a G9

Marimba C–1 a G9

Xylophone C–1 a G9

Tubular Bells C–1 a G9

Dulcimer C–1 a G9

Drawbar Organ C–1 a G9

Percussive Organ C–1 a G9
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Rock Organ C–1 a G9

Church Organ C–1 a G9

Reed Organ C–1 a G9

Accordion C–1 a G9

Harmonica C–1 a G9

Tango Accordion C–1 a G9

Acoustic Guitar (Nylon) C–1 a G9

Acoustic Guitar (Steel) C–1 a G9

Electric Guitar (Jazz) C–1 a G9

Electric Guitar (Clean) C–1 a G9

Electric Guitar (Muted) C–1 a G9

Overdriven Guitar C–1 a G9

Distortion Guitar C–1 a G9

Guitar Harmonics C–1 a G9

Acoustic Bass C–1 a G9

Electric Bass C–1 a G9

Electric Bass (Finger) C–1 a G9

Electric Bass (Pick) C–1 a G9

Fretless Bass C–1 a G9

Slap Bass 1 C–1 a G9

Slap Bass 2 C–1 a G9

Synth Bass 1 C–1 a G9

Synth Bass 2 C–1 a G9

Violin C–1 a G9

Viola C–1 a G9

Cello C–1 a G9

Contrabass C–1 a G9

Tremolo Strings C–1 a G9

Pizzicato Strings C–1 a G9

Orchestral Harp C–1 a G9

Timpani C–1 a G9

String Ensemble 1 C–1 a G9

String Ensemble 2 C–1 a G9

Synth Strings 1 C–1 a G9

Synth Strings 2 C–1 a G9

Choir Aahs C–1 a G9

Voice Oohs C–1 a G9

Synth Voice C–1 a G9

Orchestra Hit C–1 a G9

Trumpet C–1 a G9

Trombone C–1 a G9

Nome Tecniche / strumenti Intervallo
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Tuba C–1 a G9

Muted Trumpet C–1 a G9

French Horn C–1 a G9

Brass Section C–1 a G9

Synth Brass 1 C–1 a G9

Synth Brass 2 C–1 a G9

Soprano Saxophone C–1 a G9

Alto Saxophone C–1 a G9

Tenor Saxophone C–1 a G9

Baritone Saxophone C–1 a G9

Oboe C–1 a G9

English Horn C–1 a G9

Bassoon C–1 a G9

Clarinet C–1 a G9

Piccolo C–1 a G9

Flute C–1 a G9

Recorder C–1 a G9

Pan Flute C–1 a G9

Blown Bottle C–1 a G9

Shakuhachi C–1 a G9

Whistle C–1 a G9

Ocarina C–1 a G9

Lead 1 (Square) C–1 a G9

Lead 2 (Sawtooth) C–1 a G9

Lead 3 (Calliope) C–1 a G9

Lead 4 (Chiff) C–1 a G9

Lead 5 (Charang) C–1 a G9

Lead 6 (Voice) C–1 a G9

Lead 7 (Fifths) C–1 a G9

Lead 8 (Bass + Lead) C–1 a G9

Pad 1 (New Age) C–1 a G9

Pad 2 (Warm) C–1 a G9

Pad 3 (Polysynth) C–1 a G9

Pad 4 (Choir) C–1 a G9

Pad 5 (Bowed) C–1 a G9

Pad 6 (Metallic) C–1 a G9

Pad 7 (Halo) C–1 a G9

Pad 8 (Sweep) C–1 a G9

FX 1 (Rain) C–1 a G9

FX 2 (Soundtrack) C–1 a G9

FX 3 (Crystal) C–1 a G9
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FX 4 (Atmosphere) C–1 a G9

FX 5 (Brightness) C–1 a G9

FX 6 (Goblins) C–1 a G9

FX 7 (Echoes) C–1 a G9

FX 8 (Sci-Fi) C–1 a G9

Sitar C–1 a G9

Banjo C–1 a G9

Shamisen C–1 a G9

Koto C–1 a G9

Kalimba C–1 a G9

Bagpipe C–1 a G9

Fiddle C–1 a G9

Shanai C–1 a G9

Tinkle Bell C–1 a G9

Agogo C–1 a G9

Steel Drums C–1 a G9

Woodblock C–1 a G9

Taiko Drum C–1 a G9

Melodic Tom C–1 a G9

Synth Drum C–1 a G9

Reverse Cymbal C–1 a G9

Guitar Fret Noise C–1 a G9

Breath Noise C–1 a G9

Seashore C–1 a G9

Bird Tweet C–1 a G9

Telephone Ring C–1 a G9

Helicopter C–1 a G9

Applause C–1 a G9

Gunshot C–1 a G9
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4.5 Esecuzione

b Riproduzione.

v Riproduzione.

Sibelius ha funzioni talmente avanzate per migliorare la riproduzione delle partiture che preferi-
amo pensare non a una semplice riproduzione ma ad una vera e propria esecuzione!

Le opzioni che controllano lo stile dell’esecuzione si trovano tutte nella finestra di dialogo Play >
Interpretazione e sono descritte in seguito; esse influenzano anche ciò che si ottiene esportando 
un file MIDI (b Esportare i file MIDI).

Espressivo™
La funzione Espressivo permette a Sibelius di riprodurre le partiture aggiungendo una sua espres-
sione, come fa un vero musicista. Sibelius segue segni dinamici e articolazioni scritti nella partit-
ura, ma aggiunge molti altri fraseggi e interpretazioni con e sopra di essi.

Riproducendo una partitura che utilizza molti strumenti – perfino un’intera orchestra – Espressivo 
introduce un’espressione indipendente per ogni singolo strumento.

Nella finestra di dialogo Play > Prestazioni, il menu a tendina Espressivo offre cinque gradi 
diversi d’espressione per i vari stili musicali:

* Meccanico: riproduce la partitura alla lettera, senza dinamiche o articolazioni (tranne ove 
espressamente indicato).

* Senza espressivo: aggiunge solo lievi variazioni di volume e leggeri accenti a inizio delle misure 
e gruppi di note, come farebbe un vero musicista anche quando cerca di suonare senza espres-
sione.

* Poco espressivo: introduce lievi dinamiche che seguono il profilo della musica; è adatto a uno 
stile veloce piuttosto meccanico (per la musica Barocca, ad esempio).

* Espressivo: è l’opzione di default che intoduce molte dinamiche.
* Molto espressivo: introduce molta espressione, che però può essere eccessiva per alcuni stili 

musicali; è ideale per gruppi di strumenti estesi, poiché aiuta a separare le varie linee musicali.

Rubato™
La funzione Rubato è la controparte ritmica dell’Espressivo. Sibelius può variare leggermente il 
tempo della partitura per introdurre una maggiore espressione, in modo molto simile a quello di 
un vero musicista.

Nella finestra di dialogo Play > Interpretazione è possibile scegliere sei gradi diversi di Rubato
(adatti ai vari stili musicali) dall’elenco del menu a tendina:

* Meccanico: è l’opzione di default che riproduce letteralmente la partitura senza gradazioni di 
tempo (tranne ove indicato da scritte Tempo, segni di metronomo, o linee rit./accel.).

* Senza Rubato: riproduce la partitura come farebbe un vero musicista, mantenendo il tempo 
assolutamente fedele; le fluttuazioni di tempo sono appena percettibili.
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* Poco Rubato: introduce poco Rubato, quindi il tempo della partitura varia poco nelle frasi 
musicali.

* Rubato: introduce moderate variazioni di tempo.
* Più Rubato: introduce un pò più di Rubato.
* Molto Rubato: introduce la massima quantità di Rubato e Sibelius esagera con il fraseggio rit-

mico (può essere eccessivo per un certo tipo di musica).

L’impostazione raccomandata è Rubato (quella media). Impostazioni più elevate possono intro-
durre un effetto troppo evidente che in riproduzione può creare “instabilità” in passaggi particolar-
mente complessi.

Il Rubato può essere leggero solo in musica ripetitiva o uniforme (poiché Sibelius lo basa sulle 
forme delle frasi). Inoltre, l’effetto ritmico introdotto dal Rubato si riduce in presenza di molti stru-
menti, mentre un pesante Rubato è meno adatto (e difficile da dirigere!) in grandi ensemble.

“Tocco” ritmico - Rhythmic feel™
Sibelius può riprodurre un’ampia gamma di “feel ritmici” adatti a vari stili musicali, dal jazz al 
valzer Viennese; alcuni di essi regolano il ritmo scritto, alcuni l’andamento del movimento nella 
misura, altri regolano entrambi.

Le opzioni “Tocco ritmico” nella finestra Play > Prestazioni sono:

* Straight: impostazione di default.
* Light / Regular / Heavy swing: convenzione jazz per la quale due ottavi scritti (crome) sono 

eseguiti all’incirca come una terzina formata da 1/4 più una nota da 1/8 (terzina di semiminima 
più croma).

* Triplet swing: swing di due note da 1/8 (crome) in una terzina esatta da 1/4 più una nota da 1/8 
(semiminima più croma)

* Shuffle: leggero swing di nota da 1/16 (semicroma).
* Swung sixteenths: come Regular swing ma lo swing è in sedicesimi (semicrome) invece che 

ottavi (crome).
* Dotted eighths (quavers): andamento swing molto marcato; non è chiaro il motivo per cui ci 

debba essere ma è stato previsto.
* Notes Inégales: terzina da 1/4 più 1/8 (semiminima più croma) simile a Triplet swing, per un 

effetto usato in certa musica antica (sebbene le convenzioni richieste per autentiche note inègales
siano molto più complesse di queste).

* Light / Viennese waltz: accorcia il primo movimento della misura (rispettivamente a un grado 
minore e superiore) introducendo il classico andamento ritmico del valzer.

* Samba: feel di nota da 1/16 (semiminima) che accenta il primo e quarto movimento.
* Rock / Pop: accenta il feel del primo e terzo movimento di una misura da 4/4, riducendo 

l’accento sul secondo e quarto movimento, e riducendolo ancor di più tra i movimenti (più nel 
Rock che nel Pop).

* Reggae: schema ritmico a note da 1/16 (semicrome) con forte enfasi sul 3° e 4° sedicesimo.
* Funk: simile a Pop, ma anticipa leggermente il secondo movimento (in 4/4).
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Si può attivare o disattivare il feel ritmico, oppure passare da uno all’altro nelle diverse parti della 
partitura inserendo scritte come “Swing” o “Straight” in testo Tempo (che si può nascondere, se 
necessario) – b Playback dictionary.

Si potrebbe pensare che serva un’opzione swing sia per note da 1/8 (crome) che da 1/16 (semi-
crome) allo stesso tempo; pensandoci bene, però, non possono avere un andamento swing simul-
taneamente – poiché avendo sedicesimi e ottavi, i sedicesimi dovrebbero essere extra-lunghi in 
una croma in battere e corti in una croma in levare. Quello che invece probabilmente serve è che 
nei punti in cui le note più veloci sono ottavi, la riproduzione deve essere in swing sugli ottavi, e 
dove le note più veloci sono sedicesimi, lo swing deve essere sui sedicesimi. Per farlo, collocare i 
segni di testo adeguati ove la musica cambia tra passaggi di ottavi e sedicesimi – b Playback 
dictionary.

Inoltre, l’opzione Solo cambi battiti nella finestra di dialogo Play > Prestazioni sarà ignorata, 
poiché ogni feel ritmico preset s’attiva o disattiva opportunamente. Questa opzione controlla se il 
feel ritmico cambia solo l’accento ritmico delle note che cadono sul movimento; per esempio, 
Viennese waltz attiva questa opzione, ma le opzioni swing la disattivano; non c’è ragione di cam-
biarla ma si è liberi di sperimentare nuove impostazioni.

Riverbero
Riverbero significa eco – o meglio l’eco diffuso che si sente in una sala piuttosto che quello ripetuto 
delle Alpi Svizzere. La maggior parte di schede audio e moduli sonori (oltre ad alcune tastiere 
MIDI) possono aggiungere il riverbero. L’aggiunta del riverbero rende le partiture più vitali, poiché 
l’udito è sensibile alle acustiche ambientali quasi quanto al suono riprodotto in sala.

La finestra di dialogo Play > Prestazioni di Sibelius offre sei gradi di riverbero da Asciutto a Cat-
tedrale; si può anche inserire una percentuale precisa nel box in basso.

La musica per piccole ensemble può beneficiare da una modesta quantità di riverbero, caratteris-
tica in una sala di medie dimensioni, mentre grandi lavori orchestrali assumono più profondità 
aggiungendo quantità maggiori di riverbero.

Dispositivi diversi reagiscono diversamente alle impostazioni di riverbero – 100% è un riverbero 
infinito su alcuni e non su altri; sperimentare un pò. Alcuni dispositivi MIDI hanno una serie di 
altri effetti (riverberi plate, hall, e così via; per i dettagli vedere il manuale del dispositivo MIDI).

Durata delle note
La durata delle note in riproduzione si può regolare con l’opzione Unslurred notes. Di default, 
Sibelius riproduce le note senza legatura di frase alla loro piena durata (legato). Allungando le 
durate delle note oltre il 100% in modo che si sovrappongano, su alcuni dispositivi MIDI si ottiene 
un legato molto pronunciato, ma su altri può provocare problemi quando si ripete un’altezza – la 
sovrapposizione accorcia molto la durata della seconda nota (o alcune note restano “sospese” con-
tinuando a suonare all’infinito).

La durata delle note legate in una frase si regola nella pagina Linee rigo della finestra Play > Diz-
ionario – b Dizionario di riproduzione.
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L’opzione Suona legature di valore tra le voci (attiva di default) dice a Sibelius di non risuonare 
la seconda nota di una coppia legata se quest’ultima è in una voce diversa da quella della prima 
nota (situazione frequente nella musica per strumenti a tastiera).

Dinamiche tra i righi di tastiera
Sibelius riproduce automaticamente le dinamiche tra i due righi degli strumenti a tastiera (o altri 
strumenti a più righi, come un flauto con due righi ) – per maggiori dettagli b Riproduzione.

La finestra di dialogo Play > Prestazioni consente di definire la distanza minima dal rigo alla quale 
si deve trovare un segno dinamico prima che si applichi al rigo adiacente (cioè il rigo sotto se il 
segno dinamico è attaccato al rigo superiore o il rigo sopra se è attaccato al rigo inferiore).

Per non applicare i segni dinamci a entrambi i righi di strumenti a tastiera disattivare l’opzione 
Influenza rigo adiacente.

Ripetizioni
L’opzione Riproduci ripetizioni determina se Sibelius riproduce i segni di ripetizione nella partit-
ura; di default è attiva e in genere è l’impostazione più utile. b Ripetizioni.

L’opzione Spazio dopo le stanghette finali stabilisce quanto resta in pausa Sibelius dopo ogni 
doppia stanghetta finale in una partitura con più brani, pezzi o movimenti.

Messaggi MIDI
Solo per utenti avanzati. 

La finestra di dialogo Preferenze > Playback permette di stabilire come Sibelius gestisce i mes-
saggi MIDI in una partitura:

* Invio Reset Controllers durante riproduzione: dice a Sibelius se resettare tutti i controller 
MIDI quando avvia la riproduzione; se si usa Proteus 2 disattivare questa opzione.

* Invia bank high (controller 0) e Invia bank low (controller 32): queste opzioni dicono a 
Sibelius se inviare i numeri del banco quando si trasmettono messaggi MIDI Program Change; 
usando Roland SC-88 o Korg 05RW disattivare questa opzione se la trasmissione dei messaggi di 
banco cambia la modalità operativa del dispositivo MIDI o seleziona un banco non General 
MIDI (GM). Queste impostazioni sono un controllo generale sulla trasmissione dei messaggi di 
banco da parte di Sibelius; si può sempre cambiarla rigo per rigo dalla finestra Window > Mixer
– b Mixer).

* Invia program changes: dice a Sibelius se inviare messaggi Program Change quando avvia la 
riproduzione. Disattivare questa opzione se bisogna specificare la patch usata da un particolare 
canale MIDI nella partitura (se per la riproduzione si usa un programma come Gigasampler, ad 
esempio).

* Converti Live Playback velocities in dinamiche su strumenti con sustain: le velocity Live 
Playback sono convertite in dinamiche invece che in attacco per gli strumenti con sustain che 
usano per il volume la rotellina di modulazione (per esempio, la Garritan Personal Orchestra).
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4.6 Ripetizioni

b Stanghette, Linee, Simboli, Lavorare con i testi, Riproduzione, Dizionario di 
riproduzione, Proprietà.

Come per altri tipi di riproduzione, Sibelius riconosce i segni di ripetizione nella partitura ripro-
ducendoli automaticamente; Sibelius riproduce anche strutture ripetitive complesse.

Vari tipi di oggetti possono influenzare la riproduzione delle ripetizioni: stanghette; linee come il 
1° e 2° finale; testi come D.C. al Coda o 1° volta mf; e simboli di Coda e Segno. Anche i file MIDI 
salvati da Sibelius contengono le ripetizioni, esattamente come sono riprodotte.

Riprodurre le ripetizioni
Le ripetizioni sono riprodotte solo se è attiva l’opzione Riproduci ripetizioni nella finestra di dial-
ogo Play > Prestazioni; essa è attiva di default, ma se non funziona la riproduzione delle ripetiz-
ioni, per prima cosa verificare questa opzione.

Stanghette di ripetizione
Per creare una stanghetta d’inizio e fine ripetizione selezionare la stanghetta dove inserire la ripe-
tizione e scegliere Crea > Stanghetta > Inizio ripetizione o Fine ripetizione; per i dettagli, 
b Stanghette.

Di default, le stanghette di ripetizione si ripetono solo una volta (cioè ogni passaggio con una 
stanghetta di ripetizione alla fine è riprodotto due volte). Per riprodurre una sezione più di due 
volte selezionare la stanghetta di fine ripetizione e attivare più box di spunta Suona al passaggio
nel pannello Playback della finestra Proprietà (vedere in seguito); attivando, ad esempio, i box di 
spunta 1, 2 e 3 la sezione è ripetuta tre volte (cioè riprodotta quattro volte in totale). Se però nella 
stessa misura c’è anche una linea di finale (vedere sotto) le sue proprietà di riproduzione hanno la 
precedenza (la stanghetta ripete la sezione tante volte quante quelle indicate dalla linea di finale).

Linee di 1° e 2° finale
Per informazioni sulla creazione di queste linee, b Linee.

Sibelius imposta automaticamente le proprietà di riproduzione di queste linee quando le si crea; 
legge i numeri sotto le parentesi quadre e imposta opportunamente i box di spunta Play on pass
(vedere Finestra Properietà). Per esempio, una linea di finale con la scritta 1.–3. imposta auto-
maticamente i box di spunta 1, 2 e 3; una linea con la scritta 1, 3, 5 imposta i box di spunta 1, 3 e 
5, ecc..

Linee di finale con parentesi aperte all’estremità destra impostano automaticamente l’opzione Last 
time ending; essa dice a Sibelius che ha finito di riprodurre tutte le linee di finale che la prece-
dono.

Coda
Le Code – musica alla fine di un brano dalla struttura ripetitiva – in genere sono separate dalla 
musica precedente con un vuoto. Per creare una coda:
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* Creare le misure ove inserire la musica della coda.
* Selezionare la stanghetta appena prima della coda.
* Selezionare Crea > Stanghetta > Doppia (perché di solito le code sono precedute da stanghette 

doppie che indicano la fine della sezione precedente).
* In genere, s’inserisce anche una indicazione che informa i musicisti su cosa fare quando arrivano 

alla doppia stanghetta per la prima volta – vedere Dal Segno (D.S.) e Da Capo (D.C.).
* Selezionare Layout > Interruzioni > Dividi accollatura. Questo comando crea un vuoto dopo la 

stanghetta selezionata. Si può trascinare la stanghetta all’inizio della seconda metà del sistema 
per aumentare o diminuire il vuoto (per rimuovere completamente il vuoto selezionare la stang-
hetta dopo il vuoto e scegliere Layout > Ripristina posizione). Per controllare se chiave, tonal-
ità, ecc. sono ripetute dopo il vuoto selezionare la stanghetta alla fine della prima misura dopo il 
vuoto e aprire il pannello Bars della finestra Properties (b Proprietà).

* Per scrivere la parola CODA sopra l’inizio della coda premere Esc per essere sicuri che non sia 
selezionato niente e scegliere Crea > Testo > Tempo (comando rapido Ctrl+Alt+T o zXT) e 
cliccare sopra l’inizio della coda; clic-destro (Windows) o Control-clic (Mac) per aprire il menu 
scritte che ha il simbolo della coda e digitare la parola CODA come al solito.

Dal Segno (D.S.) e Da Capo (D.C.)
Nella maggior parte della musica si vede sia la scritta D.S. al Fine (significa “tornare al segno $ e 
suonare di nuovo la musica fino alla misura con la parola Fine, poi fermarsi”) che la scritta D.S. al 
Coda (significa “tornare la segno $ e suonare di nuovo la musica fno alla misura con la parola 
Coda, poi saltare alla coda”).

Il segno Da Capo significa dall’inizio vero e proprio del brano; proprio come con la scritta D.S., 
nella maggior parte della musica si vedono le scritte D.C. al Fine o D.C. al Coda.

La scritta D.C. o D.S. si può vedere anche nell’ultima misura della partitura; significa rispettiva-
mente di ripetere la musica dall’inizio della partitura o dal segno $ e poi fermarsi.

In musica, queste istruzioni appaiono sempre alla fine della misura dalla quale bisogna tornare 
indietro (al segno $ o all’inizio del brano). Per inserire queste istruzioni:

* Selezionare la stanghetta dove il musicista deve tornare indietro nel brano.
* Selezionare Crea > Testo > Altro testo di sistema > Ripetizione (D.C./D.S./To Coda). 

Èimportante usare questo stile di testo e non la scritta Tempo perché s’attacca automaticamente 
alla fine della misura.

* Appare un cursore lampeggiante; clic-destro (Windows) o Control-clic (Mac) per aprire il menu 
scritte con il testo che serve – inserirlo nella partitura cliccandoci sopra nel menu. Digitando le 
parole usare il maiuscolo (cioè “Fine”, non “fine”, poiché il minuscolo non è riprodotto corretta-
mente).

Creare un segno
Se il musicista deve tornare a un segno si deve collocare il simbolo alla giusta posizione. Per farlo:

* Selezionare la nota all’inizio della misura alla quale il musicista deve tornare indietro.
* Selezionare Crea > Simbolo (comando rapido Z per “zimbolo”).
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* Il simbolo del segno ($) è in cima alla finestra di dialogo nella fila Ripetizioni; cliccarci sopra 
una volta per selezionarlo e assicurarsi che l’opzione Attach sia impostata in System.

* Cliccare OK e il segno è scritto nella partitura.

Fine e Al Coda
Altre scritte usate in strutture ripetitive sono Fine (indica dove il musicista deve smettere di 
suonare il brano se in precedenza era tornato indietro da un’istruzione D.S. o D.C.) e Coda (indica 
dove il musicista deve saltare più avanti alla coda se in precedenza arrivava da un’istruzione D.S. al 
Coda o D.C. al Coda).

Entrambe queste istruzioni sono scritte alla fine delle misure e sono inserite allo stesso modo di 
quelle D.S. e D.C. – vedere Dal Segno (D.S.) e Da Capo (D.C.).

Misure di ripetizione
Per creare una misura di ripetizione, b Misure e misure di pausa. Sibelius non le riproduce 
automaticamente, ma si può farlo in un altro modo; supponiamo di dover scrivere un pattern nella 
prima misura di un rigo per batteria e poi dire al batterista di ripeterlo per alcune misure:

* Inserire la prima misura del pattern come al solito.
* Selezionare la prima misura e premere R (comando rapido per Modifica > Ripeti) per ripeterla 

in quella successiva.
* Con la misura copiata selezionata premere Alt+2 o z2 per impostare tutta la musica in Voce 2; 

probabilmente ora si avranno molte pause nella Voce 1.
* Selezionare Modifica > Filtro > Voce 2 (Ctrl+Maius+Alt+2 o xzX2) per filtrare solo le note 

nella Voce 2.
* Scegliere Modifica > Mostra o nascondi > Nascondi (Ctrl+Maius+H o xXH) per nascondere 

le note in Voce 2.
* Selezionare una delle pause in Voce 1 e premere F9 per scegliere il secondo layout del tastierino 

numerico, quindi 0 sul tastierino numerico per trasformare la pause nella Voce 1 in una misura 
di pausa.

* Selezionare ancora l’intera misura copiata e premere più volte R per fare le copie necessarie.
* Infine, selezionare tutte le misure ripetute, aprire il pannello Misure della finestra Proprietà e 

scegliere il simbolo della misura di ripetizione dall’elenco a tendina per trasformare le normali 
pause della misura nella Voce 1 in simboli misura di ripetizione.

Si può anche numerare automaticamente le misure di ripetizione con il plug-in Plug-in > Testo >
Numera Battute.

Finestra Properietà
Nel pannello Playback della finestra Proprietà ci sono i controlli principali 
per regolare l’effetto in riproduzione di linee, testi e note.

* Suona al passaggio: questi box di spunta controllano se l’oggetto selezi-
onato è riprodotto in un determinato passaggio nella partitura, fino a un 
totale di otto volte. Per stanghette di ripetizione e linee di 1° e 2° finale, 

Sibelius imposta automaticamente queste proprietà (vedere Stanghette di ripetizione e 
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Linee di 1° e 2° finale); per i testi, impostarla da sè (vedere Quando riprodurre testi e 
linee).

* Fine ultima volta: si applica solo a linee di finale con le estremità destre aperte (cioè prive di 
uncino all’estremità destra) – vedere Linee di 1° e 2° finale.

* Salta alla fine della battuta: dice a Sibelius se eseguire un salto (per esempio, da un D.C. al 
Coda) al punto preciso nella misura alla quale è attaccato il testo o alla fine della misura 
(default). Disattivare questa opzione solo se un’istruzione di ripetizione deve essere eseguita a 
metà misura.

Quando riprodurre testi e linee
I box di spunta Suona al passaggio servono per dire a Sibelius quando devono essere riprodotte 
istruzioni di testo che influenzano la riproduzione (in genere Expression e Technique). Per esem-
pio, si può creare il testo Technique “Sax (solo 2° volta)” e attivare il box di spunta 2 in Suona al 
passaggio: Sibelius passa al suono di sax la seconda volta che riproduce quella misura; analoga-
mente, si può creare un testo Expression “1°, 3°, 5° volta: mf  ” (attivando i box di spunta Suona al 
passaggio 1, 3, e 5) e un altro oggetto “2°, 4° volta: pp ” (attivando i box di spunta 2 e 4) all’inizio 
della sezione ripetuta; Sibelius seguirà opportunamente le dinamiche indicate. Allo stesso modo, si 
può creare una line di rigo (una forcina o un glissando) e impostarlo per esserlo riprodotto solo in 
un singolo passaggio nella partitura.

Il testo di sistema, in genere negli stili di testo Tempo o Repeat (D.C./D.S./To Coda), non è influen-
zato dai box di spunta Suona al passaggio: Sibelius decide intelligentemente quando seguire 
queste istruzioni; analogamente, linee di sistema diverse dai finali di ripetizione (es. rit./accel.)
sono sempre riprodotte in ogni passaggio nella partitura.

Quando riprodurre le note
I box di spunta Suona al passaggio valgono anche per le note e ciò apre nuove interessanti possi-
bilità: per brani che hanno una diversa base ritmica nella linea vocale in strofe diverse, ad esempio, 
si possono creare note di passaggio che seguono il ritmo delle parole nella strofa 2, impostandole 
in modo che siano riprodotte solo nel secondo passaggio; nel jazz, si può creare un piccolo passag-
gio di solo negli ottoni da eseguire solo sulla ripetizione, e così via.

Si può anche silenziare completamente una nota disattivando tutti i box di spunta Suona al pas-
saggio! (Per silenziare solo una testa nota in un accordo usare invece una testa nota silente – 
b Teste nota.)

Saltare le misure
In alcuni casi, una misura non deve essere riprodotta; la partitura, ad esempio, potrebbe iniziare 
con un rigo introduttivo(come una “handbells used” chart), oppure ci potrebbe essere un box con 
alcune misure di frasi chitarristiche su una pagina della partitura da non riprodurre.

Ciò è facile da realizzare usando i testi di sistema sotto forma di una coppia di “marker” – un 
oggetto di testo che stabilisca il punto dal quale saltare e un altro che definisca il punto al quale sal-
tare:

* Decidere un nome per la coppia di marker: supponiamo di scegliere la parola “gatto”.
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* Alla fine della misura immediatamente precedente la misura(e) da non riprodurre creare un 
nuovo oggetto di testo Repeat (D.C./D.S./To Coda) formato dalle parole “vai a” e il nome del 
marker (in questo esempio, vai al gatto).

* All’inizio della misura alla quale deve saltare la riproduzione creare un nuovo oggetto di testo 
Tempo costituito dalla parola “marker” e il nome del marker (marker gatto).

Probabilmente non si vuole far apparire questa coppia di marker nella stampa della partitura; in tal 
caso, selezionarli e nasconderli (con il comando Modifica > Mostra o nascondi > Nascondi) 
oppure inserire un carattere tilde (~) che li nasconde all’inizio di ogni oggetto di testo.

Sibelius obbedisce sempre a una coppia di marker quando li incontra nel corso della riproduzione 
(come tutti gli oggetti di testo, cioè, essi ignorano i box di spunta Suona al passaggio).

Finali opzionali & Repeat to fade
Nei fogli musicali di alcuni brani pop, talvolta si vedono finali opzionali; uno è in genere Repeat 
to fade e l’altro Optional ending (i musicisti che non riescono a sfumare bene la musica usano il 
finale opzionale).

Sibelius li può riprodurre in vari modi; un modo di suonare con il finale opzionale è il seguente:

* Usare le linee di finale con le estremità destre chiuse sia per le misure Repeat to fade che 
Optional ending.

* Impostare la linea di finale Repeat to fade per essere riprodotta (ad esempio) due volte, usando 
i controlli nel pannello Playback della finestra Proprietà; assicurarsi che non sia attivo il box di 
spunta Fine ultima volta.

* Selezionare la linea Optional ending e attivare l’opzione Fine ultima volta nel pannello Play-
back della finestra Proprietà.

Riproducendo la partitura, Sibelius riproduce due volte il finale Repeat to fade, poi per finire 
riproduce le misure Optional ending.

Altrimenti, si può simulare uno sfumando così:

* Impostare la sezione finale in modo che si ripeta per un certo numero di volte, selezionando la 
stanghetta di fine ripetizione e attivando i box di spunta Suona al passaggio necessari nel pan-
nello Playback della finestra Proprietà.

* Creare una forcina diminuendo sopra la durata della sezione ripetuta e impostarla per essere 
riprodotta all’ultima ripetizione della sezione finale; nello stesso pannello impostare la sua vari-
azione dinamica a 100% of maximum.

* Nascondere la forcina selezionandola e scegliendo Modifica > Mostra o nascondi > Nascondi
(comando rapido Ctrl+Maius+H o xXH).

Problemi in strutture ripetute complesse
Nelle partiture con strutture di ripetizione complesse può essere utile attivare il timecode Sopra 
ogni battuta nella finestra Play > Video e Tempo > Timecode e durata. In sezioni ripetute, si 
vedranno più timecode ordinati in verticale (uno per ogni passaggio); osservando i timecode si 
può quindi sapere subito in quale ordine e quante volte Sibelius riprodurrà le misure nella partit-
ura. Per ulteriori dettagli, b Timecode e hit point.
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4.7 Live Playback

b Flexi-time™, Riproduzione, Esecuzione, Aprire i file MIDI.

v Riproduzione.

Un’esecuzione musicale reale non corrisponde mai esattamente alla notazione della partitura; ci 
sono molte sfumature di tempo, dinamica e una flessibilità ritmica tali da non essere facilmente 
riprodotte, nemmeno da funzioni intelligenti come Espressivo, Rubato e Rhythmic Feel 
(b Esecuzione).

Fornendo quindi a Sibelius un’esecuzione reale umana – da una registrazione in tempo reale con 
Flexi-time (b Flexi-time™) o importando un file MIDI (b Aprire i file MIDI) – si può evi-
tare di usare la funzione Live Playback.

Live Playback memorizza con assoluta precisione il modo in cui si suona ogni nota (anche le sin-
gole note negli accordi) fino alle più piccole variazioni di velocity (volume), durata (per quanto è 
stata suonata) e posizione d’inizio (quanto devia dal punto preciso in cui si trova il movimento).

Si può anche modificare l’esecuzione, oppure creare un’esecuzione Live Playback per la musica 
inserita in altri modi (per esempio, in step-time, con l’inserimento alfabetico o la scansione di un 
foglio musicale stampato) usando il pannello Playback della finestra Proprietà o la finestra di dia-
logo Play > Trasforma Live Playback.

Sentire Live Playback
La funzione Live Playback è attiva di default in tutte le nuove partiture. Per attivarla o dis-
attivarla selezionare Play > Live Playback (comando rapido Maius-L) o cliccare sul rispet-

tivo pulsante nella finestra Playback (a sinistra) che s’illumina quando la funzione Live Playback è 
attiva e diventa nero quando non lo è; salvando e riaprendo la partitura, Sibelius ricorda se è stata 
attivata o meno.

Live Playback è completamente distinta dall’interpretazione di Sibelius della partitura. Per esem-
pio, quando Play > Live Playback è attiva (e se i dati Live Playback sono memorizzati nella partit-
ura), Sibelius riproduce la partitura esattamente come è stata eseguita in origine. Gli oggetti 
inseriti nella partitura che di solito influenzano le dinamiche o il tempo – segni dinamici, forcine, 
altre indicazioni di testo (come i messaggi MIDI) e opzioni come Espressivo, Rubato e Rhythmic 
Feel – non sono riprodotte (a meno che si applichino a note prive dei dati Live Playback).

Per esempio, importando un file MIDI e poi inserendo un segno dinamico in uno dei righi usando 
un testo Expression (b Lavorare con i testi) esso non sarà riprodotto, a meno che si disattivi 
l’opzione Play > Live Playback (comando rapido Maius-L).

Al contrario, scrivendo una partitura in step-time o con l’inserimento alfabetico e poi riproducen-
dola, in riproduzione non si sentirà una differenza attivando o meno Live Playback, perché nella 
partitura non è memorizzato alcun dato Live Playback – vedere Creare dati Live Playback.

Le istruzioni Tempo – come scritte Tempo, segni di metronomo, linee rit./accel. – e le ripetizioni 
sono sempre osservate (con la funzione Live Playback attiva o meno).
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Visualizzare le velocity Live Playback
Per vedere le velocity Live Playback memorizzate nella partitura attivare l’opzione Vista > Velocity
Live Playback; essa è disponibile solo se Play > Live Playback è attiva; le note con i dati Live Play-
back (e con il box di spunta Live velocity attivo nella finestra Properties) visualizzano una col-
onna verticale sopra il rigo (un pò come quelle di un grafico a barre). L’altezza della colonna 
rappresenta la massima velocity possibile (127) e la parte colorata che emerge dalla base della col-
onna indica la velocity Live Playback della nota o accordo in questione. Sibelius può visualizzare le 
velocity Live Playback di singole note e accordi in un numero qualsiasi di voci, così:

Modificare i dati Live Playback
Ci sono tre metodi principali per modificare i dati Live Playback:

* Cambiando direttamente i valori memorizzati per ogni nota nel pannello Playback della 
finestra Proprietà.

* Trascinando le barre verticali che appaiono quando è attiva l’opzione Vista > Live Playback 
Velocities.

* Usando la finestra di dialogo Play > Trasforma Live Playback.

Finestra Proprietà
Per modificare i dati Live Playback di singole note, più selezioni o passaggi selezionati si può usare 
il pannello Playback della finestra Proprietà (comando rapido Ctrl+Alt+P o zXP); questi con-
trolli sono disponibili solo se è attiva l’opzione Play > Live Playback.

Voce 1 nota singola Voce 1 accordo

Voci 1 & 2 note singole Voci 1 & 2 accordi 

Voci 1–4

La velocity delle singole 
note è sempre indicata.

Quando non ci sono note selezionate o sono 
selezionate tutte appaiono le velocity superiore 
e inferiore (superiore in blu scuro e inferiore in 
blu chiaro). Selezionando una singola testa 
nota appare sempre la rispettiva velocity.

Se non è selezionata, la velocity 
della voce 1 è indicata in blu; la 
velocity della voce 2 è in verde.

Se non è selezionata, appare la 
velocity più alta in ogni voce.

Le voci 3 e 4 hanno una colonna 
separata e si comportano come 
le voci 1 e2.
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* Velocity live: è compresa nell’intervallo 0–127 (127 la velocity più forte, 0 quella più debole).
* Posizione iniziale: è espressa in tick; 256 tick = nota da 1/4 (semiminima). A un valore negativo 

la nota suona in anticipo rispetto alla sua notazione nella misura (es. a –64 suona 1/16 prima di 
come è scritta), mentre a un valore positivo suona in ritardo (es. a 128 suona 1/8 dopo di come è 
scritta); si può anche fare in modo che una nota suoni in una misura diversa da quella in cui è 
scritta, ma in genere si eseguono solamente piccole regolazioni che influenzano il “feel” ritmico 
(per “dilatare” o compattare i suoni, ad esempio).

* Durata live: è espressa in tick. Si può impostare una nota a una durata arbitraria e modificando 
l’impostazione qui non s’influenza il suo aspetto scritto (ci può essere scritta quindi una nota da 
1/2 che suona solo per 1/4, oppure una nota scritta in 1/4 che dura 1/2).

Per modificare i dati Live Playback di una singola nota basta selezionarla e regolare i valori nel 
pannello Playback. È possibile selezionare singole teste nota negli accordi e regolarne i dati 
indipendentemente.

Selezionando un passaggio o eseguendo una selezione multipla, le opzioni nel pannello Playback
normalmente visualizzano “--” ad indicare che sono memorizzati valori diversi per le varie note 
nella selezione (a meno che tutte abbiano dati identici; in tal caso ciò è indicato); quando si cambi-
ano i dati Live Playback per un passaggio selezionato o una selezione multipla, essi diventano ver-
amente identici in tutte le note selezionate.

È possibile ignorare uno o tutti i parametri Live Playback di singole note semplicemente disatti-
vando i rispettivi box di spunta nel pannello Playback della finestra Proprietà – vedere Live Play-
back on e off per le sezioni di una partitura.

Per applicare trasformazioni più elaborate ai dati in un passaggio selezionato (cioè modificarlo in 
altri modi rispetto alla semplice condizione on/off o alla sua impostazione ad un valore costante in 
tutto il passaggio) vedere Finestra Transform Live Playback.

Modificare le velocity Live Playback
Per modificare graficamente le velocity trascinare le barre verticali che appaiono quando è attiva 
l’opzione Vista > Live Playback Velocities. È bene ingrandire l’immagine prima di modificare le 
velocity, per vedere meglio ciò che si sta facendo.

* Per cambiare la velocity di una singola nota (o nota in un accordo), selezionarla quindi cliccare e 
trascinare in alto e in basso la barra verticale.

* Per dare la stessa velocity a tutte le note in un passaggio, selezionarlo e cliccare su una delle barre 
verticali: tutte le altre barre verticali saranno impostate allo stesso valore di velocity.

* Per dare velocity diverse a un intervallo di note, non eseguire la selezione di un passaggio, ma 
cliccare sulla barra verticale della prima nota sulla quale cambiare la velocity e – tenendo pre-
muto il pulsante sinistro del mouse – trascinarlo attraverso le barre verticali sulle note succes-
sive; non appena il puntatore del mouse si trova sopra le barre verticali, le velocity si regolano in 
base all’altezza alla quale il puntatore del mouse le attraversa. In questo modo si possono diseg-
nare curve espressive lungo un passaggio. Attenzione! Se il passaggio contiene accordi, tutte le 
note degli accordi saranno impostate alla stessa velocity.

* Per cambiare le velocity delle note solo nella Voce 2 (ad esempio) selezionare il passaggio, fil-
trare la Voce 2 (b Filtri e Trova) e poi usare uno dei metodi appena descritti.
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* Per cambiare la distanza dal rigo alla quale appaiono le barre verticali tenere premuto Ctrl o X e 
trascinare con il mouse una delle barre verticali; ciò cambia la posizione delle barre verticali di 
quel rigo in tutta la partitura ed esse si possono trascinare fino a 20 spazi sopra o sotto il rigo.

Come per ogni operazione in Sibelius, se una volta modificate le velocity si cambia idea, basta 
selezionare Modifica > Undo (comando rapido Ctrl+Z o XZ).

Finestra Transform Live Playback
La finestra di dialogo Play > Trasforma Live Playback (comando rapido Ctrl+Maius+Alt+L o
xzXL) consente di applicare complesse trasformazioni ai dati Live Playback nella partitura.

Per usare questa finestra, selezionare il passaggio da trasformare e scegliere Play > Trasforma Live 
Playback (se non si esegue una selezione, Sibelius chiede se l’operazione deve essere applicata 
all’intera partitura).

La finestra è costituita da due pagine: Velocities e Timings. Si può configurare una trasformazi-
one in una o entrambe le pagine; se si desidera, quindi, è possibile trasformare velocity e temporiz-
zazione simultaneamente. Le opzioni sono:

* Pagina Velocities:
% Invariato: attivare questa opzione se si vuole eseguire una trasformazione solo nella pagina 

Timings.
% Velocity costante (0-127): imposta tutte le note nella selezione alla stessa velocity.
% Più forte: aggiunge a tutte le note la velocity specificata, fino al valore massimo (127).
% Più piano: sottrae a tutte le note la velocity specificata, fino al valore minimo (0).
% Crescendo/Diminuendo: specifica la velocity desiderata per la prima e ultima nota nella 

selezione; Sibelius scalerà le velocity delle note intermedie, introducendo un crescendo o 
diminuendo.

% Scala range dinamico: comprime o espande le velocity delle note nella selezione in base 
all’intervallo di valori minimo e massimo specificato; ciò consente di restringere o ampliare 
l’intervallo dinamico.

* Pagina Timing:
% Invariato: selezionare questa opzione per eseguire una trasformazione solo nella pagina 

Velocities.
% Scala durata live: scala della percentuale specificata la durata di tutte le note nella selezione, 

consentendo di allungare o accorciare la loro durata reale.
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% Imposta durata live n% della durata trascritta: cambia la durata reale delle note selezion-
ate di una percentuale delle durate scritte (indipendentemente cioè dalle durate reali cor-
renti).

% Durata Live costante: imposta la durata reale di ogni nota al numero di tick specificato (256 
tick = nota da 1/4).

% Anticipa: riduce la posizione d’inizio delle note del numero di tick specificato; si può usare 
questa opzione per fare in modo che la musica sia “in anticipo sul movimento”.

% Ritarda: aumenta la posizione d’inizio delle note del numero di tick specificato; si può usare 
questa opzione per fare in modo che la musica sia “in ritardo sul movimento”.

% Scala posizioni iniziali relative alla trascrizione: consente di esagerare o ridurre l’effetto 
delle posizioni d’inizio nel passaggio selezionato. L’opzione Mantieni durata costante
(attiva di default), come suggerisce il nome consente di scegliere se mantenere le durate orig-
inali delle note. L’effetto musicale di riscalatura delle posizioni d’inizio delle note è far suonare 
la musica più o meno in anticipo o in ritardo sul movimento (cioè più “compatta” o 
“dilatata”).

Per applicare le trasformazioni scelte cliccare OK e premere P per ascoltare il risultato.

Creare dati Live Playback
Se la partitura non è stata creata usando l’inserimento Flexi-time o importando un file MIDI, non 
esistono dati Live Playback. Per creare dati Live Playback procedere come segue:

* Selezionare il passaggio musicale nel quale creare i dati Live Playback.
* Aprire il pannello Playback della finestra Proprietà.
* Attivare i box di spunta Velocity, Position e Duration. Sibelius crea automaticamente dati Live 

Playback ad opportuni valori di default (tutte le posizioni d’inizio a 0, le durate delle note al 
numero di tick equivalente alle durate scritte e le velocity a 80).

Si possono quindi modificare i dati Live Playback come al solito.

Live Playback on e off per le sezioni di una partitura
Ovviamente è possibile attivare e disattivare l’opzione Play > Live Playback per interpretare la par-
titura secondo Live Playback o Sibelius. Tuttavia, in alcune situazioni è utile disattivare i dati Live 
Playback in una parte della partitura. Per farlo:

* Selezionare il passaggio nel quale disattivare i dati Live Playback.
* Aprire il pannello Playback della finestra Properties.
* Disattivare uno o più box di spunta Velocity live, Durata live e Posizione iniziale.

Queste opzioni si possono disattivare in modo indipendente, con effetti diversi sulla riproduzione. 
Disattivando entrambi i box di spunta Durata live e Posizione iniziale sono riprodotte le opzioni 
intelligenti Rubato e Rhythmic Feel di Sibelius; disattivando il box di spunta Velocity live, Sibel-
ius usa l’Espressivo per la riproduzione e risponde ai testi Expression, ecc. È possibile quindi sceg-
liere e prelevare quali parti dell’esecuzione Live Playback conservare e quali lasciare 
all’interpretazione di Sibelius.

reference.book  Page 277  Wednesday, April 16, 2008  4:28 PM



4. Riproduzione & video

278

4.8 Dizionario di riproduzione

b Riproduzione, Messaggi MIDI, SoundWorld™.

v Riproduzione.

In riproduzione Sibelius legge e interpreta non solo i testi (come mf, pizz. e legato), ma anche 
molti altri segni nella partitura, compresi linee (es. linee d’ottava, legature, trilli, segni di pedale), 
articolazioni (es. staccato, tenuto, accenti) e simboli.

Sebbene normalmente non sia necessario, si può modificare con precisione l’effetto che questi 
segni hanno sulla riproduzione usando la finestra di dialogo Play > Dizionario di Sibelius e inser-
ire i propri segni nel dizionario. La finestra ha sei pagine, ciascuna delle quali riguarda un ele-
mento diverso che può influenzare la riproduzione:

* Testo rigo: per istruzioni di riproduzione che si applicano al singolo rigo (es. ff, legato).
* Testo accollatura: per istruzioni che si applicano a tutti gli strumenti (es. Presto, Swing, 

Adagio).
* Linee rigo: per linee che si applicano a un singolo rigo, per esempio trilli, linee d’ottava (8va), 

legature, forcine.
* Articolazioni: per esempio, staccato, tenuto; si noti che in questa pagina si gestiscono anche il 

tremolo a una nota e le rullate.
* Teste di nota: per effetti generati da teste nota (es. armonici, note fantasma).
* Simboli: per esempio, scoop, fall, mazze e battenti per le percussioni.

Ogni pagina è descritta nei dettagli in seguito.

Pagina Testo rigo

Le scritte sono elencate nella parte sinistra nella finestra di dialogo. Si può cambiare l’ordine delle 
scritte nell’elenco cliccando sui pulsanti Su e Giù; sebbene ciò non abbia effetto su come Sibelius le 
gestisce in riproduzione è utile poter aggiungere le scritte in ordine alfabetico.
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Per modificare una scritta cliccare Rinomina: appare una semplice finestra di dialogo nella quale 
cambiare la scritta. Per aggiungere una nuova scritta, selezionarne una che ha un effetto simile a 
quello che si vuole realizzare e cliccare Nuovo; appare un’altra finestra di dialogo nella quale è 
possibile specificare la nuova scritta. Per fare la copia di una scritta esistente cliccare Duplica. 
Per rimuovere completamente una scritta cliccare Elimina.

Ogni scritta, inoltre, può avere una combinazione delle seguenti impostazioni di configurazione:

* Maiuscole/minuscole: nella maggior parte dei casi è meglio che una scritta non sia sensibile al 
maiuscolo/minuscolo (cioè “swing,” “Swing” e “SWING” devono essere equivalenti); normal-
mente, quindi, questa opzione non è attiva.

* Solo parole intere: significa che la scritta non è un’abbreviazione. Tuttavia, molti termini musi-
cali si possono abbreviare, quindi in genere questa opzione non è attiva. Per esempio, Sibelius 
passa al suono d’arco pizzicato se incontra una scritta qualsiasi che inzia con le lettere “pizz”; le 
scritte “pizz,” “pizz.” (con un punto) e “pizzicato”, quindi, producono tutte lo stesso effetto (anche 
“pizza” funziona, ma difficilmente si vedrà in una partitura!). Se la scritta è un’abbreviazione, in 
questa finestra non mettere un punto alla fine della scritta; se invece la scritta non è un’abbrevi-
azione attivare questa opzione.

* Espressione Regolare: questa opzione consente sofisticate corrispondenze di pattern all’interno 
di stringhe di testo, ma non è per i deboli di cuore! In genere non serve mai attivare l’opzione 
Espressione Regolare – tuttavia, se siete curiosi, vedere Espressioni regolari.

Per determinare l’effetto in riproduzione di una determinata scritta, selezionarla e scegliere il tipo 
d’effetto (Effetto) dall’elenco a destra; il gruppo Valori Effetto sottostante s’aggiorna per mostrare 
ciò che si può cambiare per ogni tipo d’effetto:

* Control change: imposta un controller MIDI a un determinato valore:
% MIDI controller: specifica il numero di controller MIDI da cambiare (es. il controller 1 è la 

modulazione, il controller 64 è il pedale di sustain, il controller 91è il riverbero, ecc.).
% Valore Controller: specifica il valore al quale impostare il controller MIDI scelto; 0 è il min-

imo, 127 il massimo.
* Dinamica: consente di cambiare la dinamica prevalente; è l’effetto usato per scritte come mf, ff

e forte:
% Dinamica: specifica il volume al quale sarà riprodotta la musica che segue, in un intervallo 

tra 0 e 127. In base al dispositivo di riproduzione, essa può essere riprodotta usando la veloc-
ity nota, l’espressione MIDI (controller 11), la modulazione (controller 1) o qualcos’altro.

% Attacco: specifica l’incisività d’attacco delle note a questa dinamica, con un intervallo tra 0 e 
127 (in base al dispositivo di riproduzione, ciò può avere un effetto più o meno udibile).

% Sound ID change: consente di specificare un cambio di ID suono oltre alla variazione di 
dinamica; vedere Cambi ID suono.

* Cambio dinamica: consente di cambiare la dinamica di una nota o della musica che segue ris-
petto alla dinamica corrente (invece che impostarla a un livello assoluto, come fa l’opzione 
Dinamica):
% Dinamica n% di dinamica attuale: permette di specificare la variazione di dinamica in ter-

mini di percentuale della dinamica prevalente.
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% Attacco n% di attacco attuale: permette di specificare la variazione d’attacco in termini di 
percentuale dell’attacco prevalente.

% Sound ID: consente di specificare un cambio di ID suono oltre alla variazione di dinamica; 
vedere Cambi ID suono.

% Cambia per: è un elenco che offre due scelte: solo una nota (la dinamica influenza solo le 
note alle quali è attaccata l’istruzione di testo) o tutte le note seguenti (la variazione è 
“congelata” fino al successivo segno dinamico).

* Inviluppo dinamica: è per effetti in cui la dinamica aumenta e diminuisce nel tempo (per 
esempio, sfz o fp):
% Dinamica iniziale: specifica la dinamica all’inzio della nota.
% Decadimento: determina il tempo in cui la dinamica torna al suo livello originale o all’opzi-

one Fine dinamica, espressa come percentuale di durata della nota.
% Fine dinamica: è opzionale e specifica la dinamica alla fine della nota.

* Program change: consente di cambiare il numero di programma MIDI per modificare il suono 
usato da un rigo. In generale, non si usa questo metodo: si usano invece i cambi strumento 
(b Strumenti) o un cambio di ID suono (vedere in seguito). Nel caso si debba usare:
% Program: specifica il numero programma (in un intervallo tra 0 e 127).
% Invia bank change: consente di scegliere se i messaggi MIDI Bank Change debbano essere 

trasmessi oltre al cambio programma; attivandola, sono abilitati Bank High e Bank Low.
% Bank High e Bank Low: permette d’impostare i bit più (“high”) e meno (“low”) significativi 

necessari per il messaggio MIDI Bank Change.
* Cambio Sound ID: permette di aggiungere o rimuovere tecniche dal suono presente. È possibile 

scegliere uno o più elementi ID suono dal menu – vedere Cambi ID suono.

Pagina Testo Accollatura

La pagina Testo Accollatura ha controlli simili a quelli della pagina Testo rigo (vedere Pagina 
Testo rigo), ma i tipi d’effetto (Effetto) sono diversi:
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* Metronomo: specifica il significato dei caratteri a sinistra dell’uguale in un segno di met-
ronomo. Per esempio, nel segno di metronomo “q = 120”, il carattere di nota da 1/4 in realtà è la 
lettera “q” nei font musicali di Sibelius, quindi q = definisce l’effetto Metronomo impostato a 1 
battiti (quarti). Analogamente, in “e = 160” la nota da 1/8 è la lettera “e”, quindi e = significa 
0.5 battiti (quarti). Tuttavia, poiché tutte le durate standard delle note (comprese quelle pun-
tate) sono già definite, non ci sarà mai bisogno di configurare nuove scritte Metronomo (a 
meno che s’inventino nuove durate nota!).

* Ripeti: specifica il tipo d’effetto che ha una scritta sulla riproduzione di sezioni ripetute nella 
partitura. Per esempio, una scritta che deve avere l’effetto D.C. al Coda dice a Sibelius di saltare 
all’inizio della partitura e continuare a suonare fino a quando trova una scritta il cui effetto Rip-
eti è assegnato a Coda; Sibelius salta quindi alla posizione nella partitura dove trova una scritta 
Ripeti denominata Coda (cioè all’inizio della coda stessa). Le scritte Ripeti sono le uniche pre-
definite all’uso dell’opzione Espressione regolare – vedere Espressioni regolari. Come per le 
scritte Metronomo, non c’è bisogno di configurare alcuna scritta Ripeti, perché tutte quelle più 
comuni sono già configurate; per maggiori informazioni su come Sibelius riproduce le ripetiz-
ioni, b Ripetizioni.

* Feel ritmico: cambia l’andamento ritmico della partitura nel punto specifico al quale appare. 
Per esempio, la scritta “Swing” imposta l’andamento ritmico in Regular Swing; per maggiori 
informazioni sull’andamento ritmico, b Esecuzione.

* Rit./Accel.: permette di specificare un rit. o accel., sebbene sia meglio piuttosto usare le linee 
adatte a tale scopo (che consentono un controllo maggiore) – vedere Rit. e accel. on page 234. 
Tuttavia, se si decide di definire una scritta Rit./Accel. impostare Scala tempo su n%
dell’attuale a un valore adeguato e su n battiti (quarti) alla durata del tempo che segue il testo 
per il quale si vuole inserire il cambio tempo.

* Tempo: consente d’impostare un tempo specifico. Per esempio, un “Allegro” è Imposta tempo 
a 120 quarti/min, mentre un “Lento” è Imposta tempo a 60 quarti/min.

* Scala Tempo: scala il tempo corrente di una percentuale specificata. Per esempio, “Slower” 
scala del 90% il tempo orginale, mentre “Faster” imposta il tempo al 110% di quello originale.
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Pagina Linee rigo

La pagina Linee rigo consente di specificare un Cambio Sound ID per ogni tipo di linea esistente 
nella partitura. Per esempio, si può specificare un cambio ID suono di +legato per una legatura 
che selezionerà automaticamente un suono di violino omogeneo particolare dal dispositivo di 
riproduzione (se poi s’inserisce una legatura sul rigo di violino nella partitura), un diverso suono 
omogeneo di tromba se si scrive una legatura in un rigo di tromba, e così via – vedere Cambi ID 
suono.

Non facendolo, se Sibelius non trova un suono adatto per riprodurre il cambio ID suono specifi-
cato (o non è specificato un cambio ID suono) applica uno degli effetti di default specificati in Se 
non ci sono Sound ID adatti disponibili. Le opzioni sono:

* Regola durata delle note sotto la linea: utile per le legature di frase che allungano la durata 
delle note per suonarle in legato, tranne l’ultima nota sotto la legatura che è accorciata (perché 
sia separata da quella successiva). Per modificare queste opzioni:
% Per cambiare la durata delle note sotto la linea attivare Regola durate di n%; a quelle che 

durano più del 100% la durata aumenta (se durano meno del 100% la durata diminuisce).
% Per accorciare l’ultima nota sotto la linea attivare l’opzione Abbrevia ultima nota di n sec-

ondi.
* Trasponi su/giù 1/2 ottave: è usata dalle linee d’ottava (8va, 15mb, ecc.). Stabilire se le note sotto 

la linea devono essere trasportate in alto o in basso e di quanto (un’ottava o due).
* Estendi accordo su/giù per n millisecondi: è per le linee d’arpeggio (accordo esteso) o altre 

linee che si voglia agiscano come linee d’arpeggio.
* Riproduci crescendo o diminuendo: è per le forcine. Si può stabilire l’effetto di riproduzione 

preciso su una singola forcina selezionandola nella partitura e usando le opzioni nel pannello 
Playback della finestra Proprietà (vedere Forcine on page 233).

* Riproduci trillo: è per i trilli. È possibile specificare velocità di riproduzione e intervallo di un 
singolo trillo selezionandolo nella partitura e usando le opzioni nel pannello Playback della 
finestra Proprietà (vedere Trilli on page 233).

* Riproduci pedale di sustain: è per le linee di pedale.
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* Riproduci glissando/portamento: è per le linee gliss. e port.. È possibile specificare velocità di 
riproduzione e intervallo di una singola linea selezionandola nella partitura e usando le opzioni 
nel pannello Playback della finestra Proprietà (vedere Glissando e portamento on page 
234).

* Riproduci bending chitarra: è per le linee di bending (vedere Bending on page 97).
* Nessun effetto in riproduzione: Sibelius ignora la linea durante la riproduzione.

Ognuna di queste opzioni si può applicare a qualsiasi linea, quindi una legatura si può comportare 
come una linea d’ottava (o un bending di chitarra come una linea d’arpeggio), se si desidera.

Si noti, però, che le linee sulle quali si può regolare individualmente la riproduzione nel pannello 
Playback della finestra Proprietà – forcine, trilli, linee gliss. e port. – si possono regolare nella 
finestra Properties solo se si basano sul tipo di linea appropriato. In altre parole, sebbene si possa 
dire a Sibelius di riprodurre una linea Box come una forcina, ad esempio, ciò sarà sempre fatto con 
il metodo di default e non si potrà regolare l’effetto in riproduzione nella finestra Proprietà.

Pagina Articolazioni

La pagina Articolazioni consente di specificare un Cambio suono ID per ogni tipo d’articolazi-
one o tremolo. Per esempio, si possono specificare articolazioni d’archetto su e giù per avere cambi 
ID suono a +upbow e +downbow, che sceglieranno automaticamente speciali suoni d’archetto su 
e giù dal dispositivo di riproduzione (se disponibili) – vedere Cambi ID suono.

Non facendolo, se Sibelius non trova un suono adatto per riprodurre il cambio ID suono specifi-
cato (o non è specificato un cambio ID suono) applica uno degli effetti di default specificati in Se 
non ci sono Sound ID adatti disponibili. Le opzioni sono:

* Suona note ripetute: è per tremolo e rullate (z sui gambi). Si può stabilire se deve essere 
suonato misurato – in tal caso, impostare Suddividi n volte al valore adeguato – o Unmea-
sured (che significa suonare ripetutamente le note il più velocemente possibile).
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* Regola dinamica, attacco e/o durata: è per quasi tutte le altre articolazioni. Per esempio, di 
default lo staccato accorcia una nota del 50%, l’accento aumenta la dinamica del 50% e l’archetto 
in giù aumenta la dinamica del 10% (accorciando anche un pò la nota).
% Per cambiare la dinamica della nota sulla quale c’è l’articolazione attivare Regola dinamica a 

n% della dinamica attuale e impostare un valore adeguato.
% Per cambiare l’attacco della nota sulla quale c’è l’articolazione attivare Regola attacco a n%

dell’attacco attuale e impostare un valore adeguato.
% Per cambiare la durata della nota attivare Regola durata a n% della durata scritta. Non è 

da usare per le fermate (pause) – esse hanno le rispettive opzioni speciali.
* Estendi durata a n della durata scritta: è per le fermate. Di default, una fermata regolare è 1.5 

volte la durata scritta, una fermata lunga (quadra) è 1.75 volte la durata scritta ed una fermata
breve (triangolare) è 1.25 volte la durata scritta, ma volendo si possono modificare questi valori.

* Nessun effetto in riproduzione: Sibelius ignora l’articolazione durante la riproduzione.

Come per le linee del rigo, si può applicare una qualsiasi di queste opzioni ad ogni articolazione, 
quindi si può fare in modo che uno staccato si comporti come una fermata, se si desidera.

Pagina Teste di nota

La pagina Teste di nota permette di specificare un Cambio suono ID per ogni tipo di testa nota 
nella partitura. Per esempio, si può definire una testa nota a rombo per avere un cambio ID suono 
a +harmonic, che sceglierà automaticamente un armonico dal dispositivo di riproduzione (se ce 
ne è uno disponibile) – vedere Cambi ID suono.

Non facendolo, si può stabilire che ogni testa nota produca l’effetto di default in riproduzione. 
Nel caso delle teste nota, si può specificare solo che una testa nota regoli la dinamica corrente; ciò è 
utile per le note “fantasma” nella musica per chitarra (che normalmente sono scritte con una testa 
nota a croce e suonano molto più deboli delle note normali).
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Pagina Simboli

Nella pagina Simboli si specifica un Cambio Sound ID per ogni tipo di simbolo nella partitura . 
Per esempio, un simbolo fall può produrre un cambio ID suono +fall, che comanderà automatica-
mente (ad esempio) un suono fall di tromba nel dispositivo di riproduzione (se ce ne è uno dis-
ponibile) – vedere Cambi ID suono. Per i simboli non ci sono altri effetti di riproduzione.

Cambi ID suono
Per un’introduzione agli ID suono, b SoundWorld™.

I cambi ID suono consentono d’aggiungere o rimuovere una o 
più tecniche esecutive dal suono corrente su un rigo in un 
punto qualsiasi. Per esempio, si può definire la scritta “pizz” 
per avere un cambio ID suono a +pizzicato, mentre “arco” 
può essere -pizzicato. Si può anche definire qualcosa nel diz-
ionario per aggiungere un elemento e toglierne un altro simul-
taneamente (come -mute +sul ponticello).

Per definire un cambio ID suono è possibile digitare nel box 
gli elementi ID suono da aggiungere o rimuovere, oppure 
sceglierli dal rispettivo menu degli elementi ID suono.

Per aggiungere un elemento digitare “+” prima di esso, senza 
spazio; per rimuovere un elemento digitare “–” prima di esso 
senza spazio. Per rimuovere tutti gli elementi correnti digitare 
[reset] (comprese le parentesi quadre).

Si noti che definendo semplicemente un nuovo cambio ID suono in Play > Dizionario non ne è 
garantita la sua riproduzione – Sibelius può riprodurre gli effetti disponibili nei dispositivi della 
configurazione di riproduzione corrente – ma il vantaggio degli ID suono è che essi dipendono dal 
dispositivo, quindi il suono potrebbe essere disponibile su un altro computer o se in seguito si usa 
una configurazione di riproduzione diversa; a quel punto Sibelius li riprodurrà automaticamente.
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Quando hanno effetto gli elementi nel dizionario
Attenzione ad inserire le scritte dal dizionario di riproduzione nella partitura usando i testi, poiché 
Sibelius tratta in modo diverso le scritte delle pagine Testo rigo e Testo accollatura.

Le scritte inserite in un testo di sistema (per esempio, i segni di tempo o Rhythmic Feel) hanno 
effetto all’inizio della misura alla quale sono attaccati.

Le scritte inserite in un testo di rigo (per esempio, i segni dinamici e scritte come pizz.) hanno 
effetto sulla nota alla quale sono attaccate; analogamente, le linee di rigo influenzano la riproduzi-
one dal punto in cui sono attaccate al punto in cui terminano.

Espressioni regolari
Le espressioni regolari definiscono, con simboli dai significati particolari, pattern di corrispon-
denza in stringhe di testo; Sibelius usa le espressioni regolari per la corrispondenza dei termini 
usati per la riproduzione di strutture ripetitive, come D.C. al Fine e D.S. al Coda
(b Ripetizioni).

Usando le espressioni regolari nel dizionario di riproduzione, si deve farlo con molta cautela – 
infatti è facile crearne una che interrompe la riproduzione di qualsiasi altra scritta nella partitura 
(per esempio, l’espressione regolare a corrisponde a tutte le stringhe di testo che contengono una 
“a”, mentre i caratteri “^” “.”o “$” non corrispondono a niente).

* ^ indica che la corrispondenza deve essere all’inizio della stringa, per esempio ^All’inizio; ved-
ere in seguito.

* $ indica che la corrispondenza deve essere alla fine della stringa, per esempio Amen$; vedere in 
seguito.

* . indica una corrispondenza con qualsiasi carattere singolo, per esempio c.t (che corrisponderà a 
cat, cbt, cct, cdt e così via!); per la ricerca di un punto letterale usare il carattere “\”.

* * indica una corrispondenza con un numero qualsiasi di presenze del carattere precedente (o 
una scelta di caratteri in parentesi quadre [ ]). Ciò può includere anche nessuna presenza, quindi 
l’espressione regolare a* è soddisfatta dalla stringa b, oltre da a, aaaaa, e così via. Un’espressione 
regolare utile è .*, che significa “qualsiasi corrispondenza”; si può fare quindi ^inizio.*fine$, 
che corrisponde a qualsiasi cosa circondata da inizio e fine.

* + indica una corrispondenza con una o più presenze del carattere precedente, quindi l’espres-
sione regolare a+ è soddisfatta dalle stringhe a, aaaaa e baaa, ma non da una stringa b o vuota. 

* [ ] sono operatori di gruppo che significano “corrispondenza con tutti i caratteri nel gruppo”, 
quindi si possono trovare cifre [0-9]. I caratteri di punteggiatura perdono il loro speciale signifi-
cato se racchiusi in queste parentesi quadre, quindi si può scrivere (ad esempio) D[.$S]* al 
Coda.

* \xNN indica la corrispondenza con il carattere esadecimale NN.
* (x)|(y) sono operatori di scelta esclusivi, per i quali la stringa deve corrispondere a x o y. Si pos-

sono usare per corrispondenze con parole intere, per esempio (mela)|(banana).

Le espressioni regolari possono corrispondere a qualsiasi parte della stringa di testo, quindi 
l’espressione regolare a corrisponde (ad esempio) alle stringhe a long string e cat. Per esplicitare 
una corrsipondenza a da sola, bisogna aggiungere le ancore d’inizio e fine: ^a$.
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Molti caratteri di punteggiatura (. $ ^ [ ] ( ) * + \) assumono un significato particolare nelle 
espressioni regolari e per una corrispondenza letterale (cioè per corrispondere a una stringa di 
testo contenente uno di questi caratteri) devono essere preceduti dal carattere “\”.

Copiare gli elementi del dizionario di riproduzione in altre partiture
Una volta modificati gli elementi nel dizionario di riproduzione è possibile trasferire il dizionario 
aggiornato in altre partiture, esportando lo stile house dalla partitura nella quale è stato modificato 
il dizionario e importandolo nella nuova partitura (per ulteriori dettagli b House Style™) o 
salvare la partitura come foglio manoscritto – b Foglio manoscritto.
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4.9 Video

b Riproduzione, Timecode e hit point.

v Video.

Questo capitolo spiega come associare un video digitale alla partitura e disegnare le immagini 
usando Sibelius. 

Riuscire a comporre direttamente sincronizzati a un video è molto utile sia per la composizione 
che a scopi didattici. Molti programmi scolastici hanno dei moduli che invitano gli studenti a com-
porre musica da un video; Sibelius offre una piattaforma integrata sulla quale scrivere, realizzare e 
stampare il proprio lavoro. Il DVD-ROM di Sibelius contiene anche una serie di video per i quali 
comporre musica; altri si possono scaricare dal sito SibeliusEducation.com.

Aggiungere un video
Per aggiungere un video alla partitura:

* Selezionare Play > Video e Tempo > Aggiungi video. Si apre una finestra di dialogo che chiede 
d’individuare il file video d’aggiungere alla partitura. Una volta trovato il file cliccare Apri.

* A questo punto il video appare nella finestra Video di Sibelius, insieme al nome file del video 
nella barra del titolo della finestra. 

Rimuovere un video
Per rimuovere un video dalla partitura:

* Selezionare Play > Video e Tempo > Rimuovi Video.

* Sibelius avvisa che il video non è più associato alla partitura e consente di annullare l’operazione, 
se si desidera.

Sincronizzazione
Una volta aggiunto il video alla partitura, esso si mantiene in sincronia con la partitura durante la 
riproduzione; inoltre, il video s’aggiorna ogni volta che cambia la posizione della linea di riproduz-
ione. Si può quindi saltare facilmente ad una posizione particolare nel video usando il cursore 
timeline nella finestra Playback o i pulsanti Rewind e FF.

Se premuti una volta, Rewind e FF (comandi rapidi [ e ]) si muovono di 0.2 secondi esatti; tenen-
doli premuti si accelera. Con alcuni computer e formati video, può darsi che il riavvolgimento del 
video sia più lento dell’avanzamento veloce. Per una regolazione di precisione quando ci si muove 
nel video premere Maius-[ e Maius-] per spostarsi di un singolo fotogramma (frame) alla volta.

Esempi video
Sibelius ha molti brevi video per comporre musica; alcuni di essi sono nel DVD installativo: le 
stesse versioni a risoluzioni maggiori e altri video si possono scaricare dal sito www.sibeliusedu-
cation.com.

Alcuni degli esempi video hanno le rispettive partiture di Sibelius, altri hanno la colonna sonora o 
sono muti; in ogni caso si può comporre la propria colonna sonora. I video comprendono:
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* Chaplin: Charlie Chaplin prova a insegnare la sua famosa camminata.
* South: nel corso della sua leggendaria spedizione Antartica, la nave di Shackleton “Endurance” 

và alla deriva sulla banchisa polare (con partitura).
* Mr Bean (su SibeliusEducation.com): un estratto animato del noto comico, con la partitura 

originale di Howard Goodall.
* Marching Band: La banda Santa Clara Vanguard suona Sheherezade (con partitura; ascoltarlo 

con la colonna sonora del video invece che in MIDI).
* Shadowscan: un pronto soccorso.
* More is Less: montaggio di Londra.
* Blue Pullman: spezzone del famoso treno del 1960.
* Jazz Age: musicisti e ballerini intrattengono alcuni orsi polari.
* Holiday: spezzone di una vacanza d’epoca.
* Box Clever: intenso combattimento tra due pugili (con partitura).

Per trovare i video sul DVD di Sibelius, inserirlo nel drive DVD-ROM e:

* Windows: dalla finestra di dialogo che appare selezionare Browse this disc. I video sono nella 
cartella Videos.

* Mac: aprire la cartella Example scores & Documentation che contiene la cartella Videos con 
i video.

Copiare i video sull’hard-disk prima di usarli in Sibelius.

Per scaricare altri video dal sito SibeliusEducation.com, visitarlo o selezionare Help > SibeliusEd-
ucation.com in Sibelius.

Gli spezzoni tratti dai film Holiday, Blue Pullman, Jazz Age, More Is Less e Shadowscan sono tutti forniti per gentile concessione 
del British Film Institute. Tutti i diritti riservati.

Formati file
Sibelius riproduce qualsiasi formato di file video supportato dal sistema operativo. In Windows si 
tratta dei file .avi, .mpg, .wmv e .mov (se è installato QuickTime). Gli utenti Mac possono ripro-
durre i file .avi, .mpg e .mov. Sibelius, inoltre, ha bisogno dei rispettivi codec installati nel sistema 
per riprodurre i file video selezionati; alcuni file, quindi, potrebbero non essere riprodotti (pur 
avendo una di queste estensioni) e altri (con la stessa estensione) essere riprodotti senza problemi. 
Tuttavia, se ciò avviene si noterà che il video non è riprodotto nemmeno da altri player del com-
puter (a causa della mancanza dei codec necessari). Se Sibelius non riconosce il formato di un file, 
genera un messaggio d’avviso e il video non è associato alla partitura.

Salvare e aprire partiture con i file video
Quando si salva una partitura con video, Sibelius salva la destinazione file del video nella partitura. 
Per dare la partitura ad altri utenti di Sibelius, bisogna anche fornire loro il file video vero e prop-
rio, in modo che lo possano vedere (il video non è incluso nel file di Sibelius).

Quando si apre una partitura con video, per prima cosa Sibelius cerca il file video nella cartella 
dalla quale è stato aperto; se non lo trova, chiede se si desidera individuare manualmente il file. 
Cliccando Yes si apre finestra di dialogo nella quale si può impostare il nuovo percorso del file; 
cliccando No Sibelius non cercherà di riprodurre il video.
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Nascondere e mostrare la finestra Video
Aggiungendo un video alla partitura, Sibelius mostra automaticamente la finestra Video. 
Per nasconderla o mostrarla, selezionare Finestra > Video (comando rapido Ctrl+Alt+V o zXV). 
C’è un pulsante che apre o chiude la finestra Video anche nella toolbar. 

Nascondendo la finestra Video non si rimuove il video dalla partitura. In realtà, il video continua 
ad essere riprodotto insieme alla partitura pur rimanendo invisibile, quindi si può comunque 
ascoltare la colonna sonora del video; per rimuovere il video dalla partitura in modo permanente 
vedere Rimuovere un video.

Impostare il volume del video
Sibelius permette di regolare il volume della colonna sonora del video indipendentemente dalla 
partitura variando la posizione del cursore di volume alla base della finestra Video. Con il cursore 
all’estrema sinistra la colonna sonora del video è completamente muta. 

Impostare la dimensione della finestra Video
La finestra Video ha quattro preset di dimensione che consentono di scegliere le dimensione del 
video. Questi quattro pulsanti si trovano alla base della finestra Video (vedere sopra); le opzioni 
sono anche nel submenu Play > Video e Tempo. Il video può essere impostato al 50%, 100% o
200% della sua dimensione originale, oppure in modalità A tutto schermo (vedere sotto).

Modalità A tutto schermo - Full screen
L’uso della modalità a schermo pieno per i video può essere utile, ma bisogna fare attenzione 
poiché ciò che avviene esattamente  dipende quasi interamente dal codec usato dal video stesso e 
dal comportamento di hardware o software usati per riversare il video.

* In un sistema a doppio-schermo può essere impossibile scegliere lo schermo sul quale visualiz-
zare il video; in tal caso, non si riesce a vederlo su uno schermo e visualizzare la partitura 
sull’altro. Altri problemi possono essere che la linea di riproduzione di Sibelius non appare cor-
rettamente o la finestra Video è bloccata su uno schermo con il video vero e proprio che appare 
invece a schermo pieno sull’altro, ecc..

* In Windows, se si usa un codec QuickTime per riprodurre il video, esso apparirà a schermo 
pieno sullo schermo primario, indipendentemente da dove appare la finestra Video.

* In Windows, se si usa Windows Media per riprodurre il video, passando alla modalità a schermo 
pieno il video è riprodotto a schermo pieno sullo schermo in cui prima si trovava la finestra 

Hit point

Mezza grandezza
Cursore Volume

Piena grandezza Grandezza doppia

Schermo pieno
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Video. Cliccando sulla finestra Video o fermando la riproduzione in Sibelius, il video esce imme-
diatamente dalla modalità Full Screen: è una funzione del codec Windows Media.

Se c’è un solo schermo, la modalità a schermo pieno funziona quasi sempre senza problemi. 
Se ci fossero problemi, normalmente si può riportare la finestra alla sua dimensione precedente 
premendo Esc.

Windows Media e QuickTime (solo Windows)
Alcuni video si vedono meglio con Windows Media, altri con QuickTime. Sibelius consente di 
scegliere il player preferito dalla pagina Display della finestra File > Preferenze. 
Se QuickTime non è installato è impossibile scegliere questa opzione.

Se si associa un video non supportato dal player scelto, Sibelius tenta di usare l’altro player igno-
rando le impostazioni utente; ciò può accadere se, ad esempio, si cerca di riprodurre un file .mov 
QuickTime con Windows Media.

Sibelius visualizza il nome del player video che sta usando in parentesi nella barra del titolo della 
finestra Video dopo il nome del file video.

Traslucenza della finestra Video
Sibelius può rendere traslucida la finestra Video insieme ad altre finestre tool. Questa opzione è 
nella pagina Display della finestra File > Preferenze (menu Sibelius in Mac). A differenza delle 
altre finestre tool, tuttavia, si può disattivare la traslucenza della finestra Video in modo indipen-
dente. Talvolta ciò è necessario, poiché alcune configurazioni hardware e codec durante la 
riproduzione provocano lampeggi o immagini fantasma nella finestra Video traslucida.

Per maggiori informazioni sulle finestre traslucide, b Impostazioni visive.

Posizione d’inizio
Si può definire un punto di partenza del video diverso da quello d’inizio (per scavalcare uno spez-
zone che non è scritto nella partitura, ad esempio). Si può anche dire a Sibelius d’iniziare la 
riproduzione del video solo da un determinato punto nella partitura. Nella finestra Play > Video e 
Tempo > Timecode e Durata ci sono tre impostazioni che permettono di configurare l’esatta cor-
relazione tra partitura e video:
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* Timecode della prima battuta: indica a Sibelius la posizione temporale della prima misura.
* Inizia video: posizione temporale alla quale si desidera iniziare la riproduzione del video nella 

partitura; è espressa in tempo assoluto, quindi deve essere sempre superiore o uguale al valore 
Timecode della prima battuta. Per far partire la riproduzione del video all’inizio vero e prop-
rio della partitura, scegliere poi Inizio partitura.

* Inizia video da: si usa per far partire la riproduzione del video da un punto diverso del suo 
inizio vero e proprio. Per esempio, se un file video inizia con due secondi di vuoto si possono 
ignorare completamente questi primi due secondi e dire a Sibelius d’iniziare a riprodurre il video 
solo dopo quel punto; per farlo impostare Inizia video da a due secondi.

La finestra di dialogo riconosce vari formati. 1’00”, 00:01:00:00 e 1:00’ equivalgono a “un minuto.” 
Inoltre, Sibelius interpreta in secondi ogni singolo numero intero inserito in uno di questi campi, 
quindi il valore 18 sarà sempre interpretato 00:00:18:00. Inserendo valori in fotogrammi (frames), 
assicurarsi di usare lo stesso frame rate selezionato in Frames.

Per maggiori informazioni su timecode e hit point, b Timecode e hit point.

Aggiungere la musica ai file video
Sia Windows XP che Mac OS X hanno software economici o gratuiti che consentono di aggiugere 
la musica scritta in Sibelius al file del video. Innanzitutto si deve esportare la partitura come file 
audio in Sibelius – b Esportare i file audio. Poi si può importare il file che Sibelius crea, insi-
eme al file video (nel quale è scritta la musica) nell’editor video. 

Windows Movie Maker è disponibile gratuitamente come parte di Windows XP Service Pack 2 o 
superiori, mentre iMovie è gratuito su ogni computer Apple con il sistema operativo Mac OS X. Per 
maggiori informazioni visistare il sito www.apple.com/ilife/imovie.

Se si usa Windows e si desidera comporre musica propria da vedere, visitare il sito 
www.picasa.com e scaricare il software gratuito che permette di realizzare striscie audiovisive dai 
propri album di foto digitali.
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4.10 Timecode e hit point

b Riproduzione, Video.

v Video.

Un timecode è la posizione temporale di un punto in una partitura o video. In genere è misurato 
dall’inizio della partitura, oppure in film/TV dall’inizio della bobina o da qualche altro punto parti-
colare.

Quando si riproduce una partitura il valore timecode è visualizzato nella finestra Playback, insi-
eme a una lettura del tempo corrente in beat al minuto (bpm); b Riproduzione.

Sibelius può anche visualizzare automaticamente il timecode come testo sopra ogni stanghetta 
nella partitura, calcolando la posizione temporale delle stanghette basata su numero di misure, 
durate misura e segni di metronomo fino a quel punto. Il timecode è molto utile per lavorare 
sull’esatta temporizzazione di particolari passaggi musicali o per sincronizzare eventi musicali con 
gli hit point (o le scene in un film).

Sibelius non sincronizza la riproduzione né visualizza il flusso di dati SMPTE o MTC entranti. 
Questa funzionalità è offerta da sequencer professionali come Pro Tools, che può essere usato per 
riprodurre la musica così esportandola da Sibelius come file MIDI (b Esportare i file MIDI). 
Sibelius, tuttavia, sincronizza la riproduzione con file video digitali che si possono assegnare facil-
mente a qualsiasi partitura di Sibelius (b Video).

Lettura Timecode
Durante la riproduzione le letture timecode e tempo appaiono nella finestra Riproduzione (Play-
back):

La finestra Playback si apre e chiude con il comando Finestra > Riproduzione (comando rapido 
Ctrl+Alt+Y o zXY) o con il pulsante  nella toolbar. Il display timecode (in basso a sinistra) 
indica il tempo trascorso dall’inizio della partitura (invece del tempo trascorso dall’inizio della 
riproduzione) – in altre parole, mostra i valori del “tempo partitura” assoluti specificati nella 
finestra di dialogo Play > Video e Tempo > Timecode e durata (vedere sotto) invece del “tempo 
reale”.
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Finestra Timecode e Durata
La finestra di dialogo Play > Video e Tempo > Timecode e durata ha varie opzioni di tempo che 
sono salvate nella partitura.

Scrivere il timecode nella partitura
Per scrivere il timecode nella partitura attivare l’opzione Sopra ogni battuta o All’inizio di ogni 
sistema. Per cambiare rigo sopra il quale appare, scegliere dall’elenco Posizione. Il timecode 
appare automaticamente come testo sopra ogni stanghetta nella partitura; per spostarlo più in alto 
o in basso selezionare House Style > Posizioni di default e regolare adeguatamente la posizione 
verticale dello stile di testo Timecode (b Posizioni di default).

Unità
Il timecode può essere visualizzato in vari formati:

* Frames (es. 01:23:04:13): formato standard per film/TV.
* 0.1 secondi (e.g. 1:23’4.5’’); formato più leggibile ma non molto preciso.
* Secondi (e.g. 1:23’4): formato un pò impreciso ma utile per temporizzazioni approssimative.

Se la partitura include ripetizioni, le misure ripetute visualizzano due o più timecode sovrapposti, 
uno per ogni “passaggio” di musica – b Ripetizioni.

I timecode sono stampati quando si stampa la partitura, ma di default non appaiono nelle parti. 
Per attivare il timecode nelle parti usare la pagina House Style della finestra di dialogo Aspetto 
Parte Multipla (b Finestra Aspetto parte multipla). 

Poiché film e video possono avere diverse velocità, il timecode può essere calcolato sul numero di 
frame al secondo. 15, 24, 25, 29.97 (non-drop), 29.97 (drop) e 30 (non-drop) sono tutti usati 
in vari tipi di film o video; 100 (centisecondi) sebbene non sia una velocità film o video standard 
è prevista in caso di utilità.
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Punto d’inizio
Il parametro Timecode della prima battuta specifica il timecode d’inizio della partitura (nel for-
mato Ore:Minuti: Secondi:Frame).

È usato come offset per tutti i tempi visualizzati (cioè sia per la lettura del timecode durante la 
riproduzione nella finestra Playback, che per qualsiasi scritta timecode nella partitura). Se si usa 
un formato timecode basato sui frame, il valore frame del punto d’inizio è interpretato secondo i 
frame al secondo correnti impostati nella finestra di dialogo.

La modifica del parametro Timecode della prima battuta ha due applicazioni:

* Se la partitura è per un lavoro film/TV, spesso il tempo d’inizio serve per specificare la posizione 
di una particolare battuta d’entrata nel film.

* Se la partitura è parte di un lavoro più grande (il movimento di una sinfonia, ad esempio) il 
tempo d’inizio della partitura s’imposta al tempo di fine del movimento precedente (definito 
dalla durata dell’ultima pagina del movimento precedente). Tutti i timecode faranno riferimento 
quindi all’inizio della sinfonia invece che all’inizio di questo movimento.

Per i dettagli sulle opzioni Inizo video e Inizio video da, b Video.

Opzione Durata alla fine della partitura
Questa opzione calcola e scrive la durata della partitura arrotondata al secondo intero sull’ultima 
pagina della partitura (per esempio, 4’33’’).

Impostando un tempo d’inizio per la partitura, esso è aggiunto alla durata – separando il lavoro in 
due file e impostando il tempo d’inizio del secondo alla durata del primo, la durata del secondo file 
indica il tempo accumulato fino a quel punto. (Vedere Punto d’inizio).

Calcolo di timecode e durata
I valori timecode e durata della partitura tengono conto di ripetizioni (b Ripetizioni), segni 
tempo (es. Allegro), segni di metronomo (b Lavorare con i testi), fermate (pause) e linee rit./
accel. (b Linee) – i valori s’aggiornano immediatamente ogni volta che si creano o modificano. 
Provare per credere!

Tuttavia, i valori timecode non tengono conto delle regolazioni eseguite sulla velocità di riproduzi-
one con il cursore tempo.

Hit point
Gli hit point sono riferimenti di tempo nella partitura che evidenziano scene importanti in un film 
o video, per semplificare la scrittura musicale in corrispondenza di questi punti. Sibelius permette 
d’aggiungere hit point mobili con un nome che si spostano per indicare il punto corrispondente in 
un film o video se cambia la temporizzazione nella partitura.

Come inserire hit point nella partitura
Quando s’aggiunge un hit point alla partitura, esso è inserito alla posizione corrente della linea di 
riproduzione. Supponiamo di avere un video con una scena importante a 04’32”: con il cursore 
della timeline nella finestra Playback arrivare a quel punto del video e poi usare i pulsanti Rewind 
e FF per spostarsi con più precisione (0.2 secondi) in entrambe le direzioni, se necessario. 
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Quando il frame da segnare è visualizzato nella finestra Video, cliccare sul pulsante Add Hit Point

 nella finestra Video, oppure selezionare Crea > Altro > Hit Point; s’inserisce un hit point sopra 
quel punto nella partitura.

Gli hit points s’aggiungono alla partitura anche con il pulsante Nuovo nella finestra Play > Video 
e Tempo > Hit Points. Aggiungendoli in questo modo, essi sono sempre inseriti all’inizio vero e 
proprio della partitura, indipendentemente dalla posizione corrente della linea di riproduzione; 
volendo è possibile poi digitare la posizione timecode (vedere sopra).

È possibile spostare gli hit point in alto o in basso nella partitura cambiando il valore Vertical 
position dello stile di testo Hit points in House Style > Posizioni di default – b Posizioni di 
default.

Modificare posizione tempo e nome degli hit point
Si può modificare qualsiasi hit point nella partitura selezionando Play > Video e Tempo > Hit 
Points (Maius+Alt+P o xzP). Questa finestra elenca tutti gli hit point nella partitura: 

* La colonna Timecode indica la posizione tempo assoluta alla quale si trova ogni hit point. 
Il formato visualizzato dipende dall’impostazione timecode scelta in Play > Video e Tempo >
Timecode e durata; questo campo è modificabile con un doppio-clic del mouse sul valore 
tempo da cambiare.

* La colonna Misura.battito.100imi indica la posizione di un hit point nella partitura in misure, 
beat e centesimi di un beat (64.2.96 significa misura 64, beat 2.96). Se un hit point si trova esat-
tamente sul beat, il valore in centesimi è omesso. Non si può cambiare manualmente questo 
valore: s’aggiorna automaticamente se si riposiziona l’hit point cambiando il suo valore Time.

* La colonna Name indica il nome di ogni hit point nella partitura; si può modificare con un dop-
pio-clic sul nome corrente; premere Return dopo aver inserito un nuovo nome per inserirlo 
nella tabella.

Cancellare gli hit point
Per rimuovere un hit point dalla partitura usare la finestra Play > Video e Tempo > Hit Points. 
Selezionare l’hit point da cancellare e cliccare Cancella; per cancellarli tutti cliccare Cancella 
tutto.
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Adatta selezione a tempo
Per fare in modo che un particolare hit point arrivi ad un punto specifico nella partitura, bisogna 
regolare il tempo della partitura. Sibelius ha un plug-in che esegue i calcoli necessari – vedere 
Adatta selezione al tempo on page 400.

Spostare tutti gli hit points
Potrebbero esserci casi in cui gli hit point della partitura sono fuori sincronia con il video (se sono 
state modificate le impostazioni del punto d’inizio partitura o video). Per correggere questa anom-
alia, si possono spostare (offset) tutti gli hit point creati dello stesso valore tempo, cliccando Maius 
All in Play > Video e Tempo > Hit Points. Si può inserire un qualsiasi valore di offset positivo o 
negativo usando vari formati (1’00”, 00:01:00:00 e 1:00’ equivalgono tutti a “un minuto”). Inoltre, 
Sibelius interpreta in secondi ogni numero intero inserito in uno qualsiasi di questi campi, quindi 
-4 sarà sempre interpretato come -00:00:04:00. Inserendo valori che specificano i frame, assi-
curarsi di usare lo stesso frame rate selezionato nella sezione Frames della finestra Play > Video e 
Tempo > Timecode e durata (vedere sopra).

Visualizzare gli hit point su un rigo
Alcuni compositori preferiscono riferire la posizione di ogni hit point al beat più vicino nella 
musica, spesso scrivendo teste nota a croce su un rigo a una sola linea in alto o in basso nella parti-
tura. Sibelius ha un plug-in per questo – vedere Aggiungi rigo Hit Point on page 399.

Stili di testo
I valori timecode sono scritti nello stile di testo Timecode e gli hit point con lo stile di testo Hit 
points. La loro distanza sopra il rigo è determinata dal valore della rispettiva posizione verticale 
dello stile di testo definita in House Style > Posizioni di default (b Posizioni di default). 
Si può anche regolare la posizione verticale di durata della partitura che appare sotto la misura 
finale della partitura stessa modificando lo stile di testo Durata a fine partitura.
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4.11 Dispositivi di riproduzione

MIDI setup for Windows, MIDI setup for Mac in Handbook; b Mixer, Sibelius 
Sounds Essentials.

v Configurazione MIDI.

Se non si conosce la terminologia MIDI o strumenti virtuali ed effetti vedere b Nozioni MIDI e 
b Strumenti virtuali prima di leggere questo capitolo.

Questo capitolo introduce i concetti relativi alle configurazioni di riproduzione e spiega nei dettagli 
come realizzarle usando la finestra di dialogo Play > Dispositivi d’ingresso e riproduzione.

Dispositivi compatibili
Sibelius può ripordurre la musica attraverso vari dispositivi hardware e software:

* Hardware MIDI esterno (moduli sonori e tastiere con suoni interni).
* Hardware MIDI interno (schede audio con sintetizzatori interni).
* Strumenti virtuali VST o Audio Unit (compreso Kontakt Player 2 fornito con Sibelius).

È possibile usare questi dispositivi in qualsiasi combinazione configurandoli per la riproduzione.

Configurazioni di riproduzione
Una configurazione di riproduzione è una serie d’impostazioni che determina quali dispositivi sono 
disponibili per Sibelius e come si devono usare per la riproduzione. Si possono realizzare tutte le 
configurazioni di riproduzione desiderate, usando anche dispositivi diversi in ogni configurazione 
e passare in ogni momento da una all’altra.

Creare una nuova configurazione di riproduzione
Per creare una nuova configurazione selezionare Play > Dispositivi di Ingresso e Playback e 
sceglierne una esistente sulla quale basare quella nuova. Cliccare Nuovo alla base della finestra di 
dialogo; Sibelius chiede di scegliere un nome: digitarne uno e cliccare OK. In base ai dispositivi in 
uso, può darsi che Sibelius sia occupato per alcuni secondi dopo aver cliccato OK.

Cambiare la configurazione di riproduzione corrente
Per usare una diversa configurazione di riproduzione selezionare Play > Dispositivi di Ingresso e 
Playback e scegliere un elemento dall’elenco Configurazione alla base della finestra di dialogo. In 
base ai dispositivi in uso, può darsi che Sibelius sia occupato per alcuni secondi (specialmente se la 
nuova configurazione utilizza uno o più strumenti virtuali).

Rinominare e cancellare le configurazioni di riproduzione
Per rinominare una configurazione esistente selezionarla dall’elenco alla base della finestra di dial-
ogo e cliccare Rinomina. Analogamente, per cancellare una configurazione esistente, selezionarla 
dall’elenco, cliccare Cancella e rispondere Si al messaggio d’avviso.
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Modificare una configurazione di riproduzione
Per modificare una configurazione di riproduzione esistente usare le quattro pagine della finestra 
di dialogo Play > Dispositivi di Ingresso e Playback che sono descritte nei dettagli in seguito.

Si noti che quando nella finestra si esegue una qualsiasi modifica appare un asterisco accanto al 
nome della configurazione nel menu in basso; per salvare la configurazione cliccare Save.

Pagina Dispositivi Attivi
Nella pagina Dispositivi Attivi si possono scegliere i dispositivi disponibili nel sistema usati da 
questa configurazione:

* Il box Periferiche disponibili a sinistra elenca i dispositivi di riproduzione disponibili nel 
sistema. Ciascuno è elencato in base a nome (Dispositivo) e tipo (Tipo) che può essere MIDI, 
VST, AU o Kontakt. Solo Kontakt Player 2 e Kontakt 2 completo sono sempre riconosciuti come 
tipo Kontakt. Gli altri strumenti virtuali, in genere, sono VST; in Mac, alcuni strumenti virtuali 
sono Audio Unit; essi appaiono come tipo AU. I normali dispositivi MIDI (sintetizzatori interni 
delle schede audio o tastiere e moduli sonori esterni) sono di tipo MIDI.
Per attivare un dispositivo nella configurazione corrente, selezionarlo nell’elenco Periferiche 
disponibili e cliccare Attiva. Attivando un dispositivo MIDI, esso passa dall’elenco Periferiche 
disponibili a quello Periferiche attive a destra. Attivando però un dispositivo Kontakt, VST o 
AU, esso rimane nell’elenco Periferiche disponibili ed è copiato nell’elenco Periferiche attive: 
si può quindi attivare più di un’istanza di uno strumento virtuale, ma si può avere sempre solo 
una istanza di un dispositivo MIDI.

* Il box Periferiche attive a destra elenca i dispositivi di riproduzione attivati (che Sibelius può 
usare per la riproduzione). Oltre alle colonne Dispositivo e Tipo (in comune con l’elenco Per-
iferiche disponibili) c’è la colonna Sound set; cliccando in questa colonna si scelgono i vari 
sound set.
Si noti che la scelta dei sound set disponibili è diversa in base al tipo di dispositivo selezionato e 
Sibelius non ha sound set per ogni possibile dispositivo MIDI o strumento virtuale – vedere Set 
di Suoni - Sound set. Se non c’è un sound set disponibile per lo strumento virtuale che si sta 
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usando impostare Sound set in (nessuno) e poi usare la normale pagina Set di Suoni Manuali
per dire a Sibelius come eseguire la riproduzione con il rispettivo strumento virtuale.
Per disattivare un dispositivo, selezionarlo nell’elenco Periferiche attive e cliccare Disattiva per 
rimuoverlo dall’elenco.

Pagina Set di Suoni Manuali
Ci sono due casi nei quali si usa la pagina Set di Suoni Manuali della finestra Play > Dispositivi 
di Ingresso e Playback per configurare la riproduzione:

* Se si usa uno strumento virtuale per il quale non c’è un sound set disponibile; oppure
* Se si usa uno strumento virtuale diverso da Kontakt Player 2 o Kontakt 2 per il quale c’è un 

sound set adatto.

A differenza dei dispositivi MIDI, in genere non è possibile dire a uno strumento virtuale di ripro-
durre automaticamente un suono specifico. Sibelius lo può fare per Kontakt Player 2 perché ha un 
supporto interno speciale. Tuttavia, per altri strumenti virtuali si deve dire a Sibelius quali sono i 
suoni disponibili, creando in pratica un mini sound set per ogni strumento virtuale. 
La pagina Set di Suoni Manuali serve appunto a questo:

* Scegliere lo strumento virtuale dal menu Dispositivo in cima alla finestra di dialogo; qui non è 
possibile scegliere dispositivi Kontakt o MIDI, ma si possono scegliere quelli VST o AU.

* Cliccare Mostra per aprire l’interfaccia dello strumento virtuale in un’altra finestra. Ci sono 
moltissimi tipi d’interfaccia che si comportano anche in modo diverso, quindi è impossibile 
fornire un aiuto pratico per il loro uso (vedere la documentazione dello strumento virtuale). 
Lasciare aperta la finestra: servirà tra poco.

* Se nella pagina Periferiche attive è già stato scelto un sound set per questo dispositivo, esso 
sarà presente nel menu Sound set; altrimenti si può sceglierlo ora; se non è disponibile un 
sound set adatto selezionare (nessuno).

* Impostare No. canali al numero dei vari canali, slot o suoni che lo strumento virtuale può ripro-
durre simultaneamente. Alcuni strumenti virtuali simulano solamente un singolo strumento 
(un piano elettrico o sintetizzatore specifico, ad esempio); in tal caso, di solito riproducono solo 
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un suono alla volta, quindi No. canali deve essere impostato a 1. Altri strumenti virtuali (in 
particolare quelli con librerie di campioni) possono riprodurre una serie di suoni simultanea-
mente, quindi No. canali può essere impostato a 8 o 16. Si noti che la tabella a destra nella 
finestra di dialogo è aggiornata con l’appropriato numero di canali scelti qui.

* Tornare ora all’interfaccia dello strumento virtuale e caricare un suono (o selezionare un preset 
adeguato). Se lo strumento virtuale può riprodurre più suoni simultaneamente iniziare cari-
cando un suono nel primo canale o slot.

* A questo punto osservare le opzioni Impostazioni Suono nella pagina Set di Suoni Manuali; 
cliccare sulla prima riga nella tabella a destra o usare il controllo Channel accanto per scegliere 
il canale adeguato.

* Se per questo dispositivo è stato scelto un sound set, il menu Program sarà abilitato, mentre sarà 
disabilitato il menu Sound ID.
% Se è abilitato Program scegliere il nome del programma caricato nello strumento virtuale e 

cliccare Applica.
% Se è abilitato Sound ID selezionare il suono che più s’avvicina al suono caricato nello stru-

mento virtuale cliccando “...” per vedere un menu. Per esempio, se è stato caricato il suono di 
un ensemble di violini selezionare strings.violin.ensemble dal menu; se il suono è quello di 
un piano Steinway scegliere keyboard.piano.grand.steinway. È bene essere il più specifici 
possibile, poiché ciò aiuta Sibelius ad usare il suono più adeguato. Una volta scelta la corri-
spondenza migliore cliccare Applica.

* La prima riga della tabella a destra nella finestra di dialogo è aggiornata; se il dispositivo può 
gestire un altro suono contemporaneamente, ripetere le operazioni precedenti fino a quando 
sono stati caricati i suoni necessari e configurare le rispettive mappature nel sound set manuale.

Non dimenticare di cliccare Salva alla base della finestra di dialogo, altrimenti si perde tutto il 
lavoro eseguito!

Pagina Suoni Preferiti
Una volta scelti gli strumenti da usare per la riproduzione e configurati opportunamente i sound 
set manuali, si può dire a Sibelius quali dispostivi usare per i vari tipi di suono. Per esempio, se si 
preferiscono gli ottoni di un dispositivo e gli archi di un altro, si può dire a Sibelius di usare i ris-
pettivi dispositivi per questi tipi di suono, ove possibile.

La configurazione della pagina Suoni Preferiti è completamente opzionale (Sibelius è in grado di 
scegliere il suono migliore disponibile in ogni situazione); si può quindi ignorare completamente 
questa pagina della finestra di dialogo e lasciare a Sibelius il compito di scegliere i suoni da usare.

reference.book  Page 301  Wednesday, April 16, 2008  4:28 PM



4. Riproduzione & video

302

Se si desidera, però, è possibile impostare le proprie preferenze nella pagina Suoni Preferiti della 
finestra di dialogo Play > Dispositivi di Ingresso e Playback:

* Dalla struttura ad albero Sound ID (Specifiche suono) a sinistra selezionare il gruppi di suoni 
per i quali si vuole specificare un dispositivo preferito. Selezionando un ramo dell’albero si selez-
ionano anche tutti i sotto-rami in esso contenuti; scegliendo Strings, ad esempio, si seleziona 
anche Strings.Violin e tutto quello che c’è sotto, oltre che Strings.Violoncello e tutto il suo con-
tenuto.

* Una volta selezionato il ramo appropriato, si vedrà che For this sound ID mostra il nome com-
pleto del suono scelto; a questo punto, fare una scelta dall’elenco Prefer this device e cliccare 
Add per impostare la propria preferenza.

* Si noti che la preferenza configurata appare ora nell’elenco a destra nella finestra di dialogo. 
Per rimuovere una qualsiasi delle opzioni esistenti, selezionarla nell’elenco e cliccare Remove.

Si può essere specifici a piacere nel configurare le proprie preferenze: se in generale si preferisce 
che i suoni degli ottoni siano riprodotti da un dispositivo particolare selezionare Brass e config-
urare una preferenza; se invece si vuole usare sempre un particolare dispositivo che simula molto 
bene il suono di un organo Hammond B3, quando la partitura utilizza quello strumento selezion-
are keyboard.organ.drawbar.percussive.with rotary speaker e poi definire una preferenza solo 
per quel suono.

Come per le impostazioni in altre pagine di questa finestra di dialogo, non dimenticarsi di cliccare 
Save per salvare le proprie modifiche!
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Pagina Effetti
La pagina Effetti consente di caricare gli effetti nei vari bus disponibili:

Effetti Master Insert: sono effetti applicati all’intero segnale audio prima che esca dal dispositivo 
e subito dopo arrivi alle orecchie. Effetti come compressori e limiter possono essere aggiunti come 
effetti master in Insert, poiché in genere si applicano a tutto il suono generato da tutti gli strumenti 
virtuali utilizzati. Si può anche usare un riverbero come effetto master in Insert, sebbene così 
facendo non si possa cambiare singolarmente la quantità di riverbero degli strumenti virtuali. È 
possibile collegare fino a quattro effetti master Insert in serie: il segnale audio attraversa ogni 
effetto, uno dopo l’altro.

Sibelius ha anche quattro bus send d’effetti che servono per inviare parte del segnale audio a uno o 
più effetti. Questi bus sono post-fader, quindi la quantità di segnale inviato all’effetto dipende dal 
livello del fader di volume d’uscita dello strumento virtuale. Si può stabilire quanta parte del seg-
nale d’uscita di ogni strumento virtuale è inviata ad ognuno dei bus send usando i controlli nelle 
finestra Mixer (b Mixer). È possibile collegare in serie fino a due effetti in ogni bus send.

I bus send si possono usare per aggiungere effetti all’uscita dei singoli strumenti virtuali. 
Per esempio, si può aggiungere un pedale d’effetto a uno strumento virtuale di chitarra: caricare il 
pedale d’effetto in uno dei bus send e inviare parte dell’uscita proveniente dallo strumento virtuale 
a quel bus send.

Aggiungere un effetto alla propria configurazione di riproduzione è molto semplice: basta scegli-
erlo dal menu a tendina del rispettivo slot in qualsiasi bus si voglia che appaia; per visualizzare 
l’interfaccia grafica dell’effetto cliccare sul pulsante Mostra. Tutte le modifiche eseguite sull’inter-
faccia dell’effetto sono salvate quando si salva la propria configurazione.

Si noti che gli effetti influenzano solo il suono generato dagli strumenti virtuali, perché quello gen-
erato da dispositivi MIDI non fa parte dello stesso flusso audio (in caso di dispositivi MIDI esterni 
il suono non è mai nemmeno all’interno del computer!).
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Finestra Audio Engine Options
Per configurare l’interfaccia audio che Sibelius userà per la riproduzione cliccare Opzioni Motore 
Audio alla base della finestra Play > Dispositivi di Ingresso e Playback. 
Si apre questa finestra di dialogo:

* Selezionare il dispositivo da usare per la riproduzione dal menu a tendina Interfaccia. In Win-
dows, può apparire più volte lo stesso dispositivo con acronimi diversi in parentesi alla fine:
% Se c’è un dispositivo con l’acronimo (ASIO) alla fine del nome, usarlo. ASIO (“Audio Stream 

Input Output”) è un’interfaccia a bassa latenza, ideale quando si usano strumenti virtuali ed 
effetti in ingresso e per la riproduzione.

% I dispositivi con (DS) alla fine del nome utilizzano la tecnologia DirectSound di Microsoft. 
DirectSound non ha la bassa latenza ASIO, ma è l’opzione raccomandata se non è disponibile 
un dispositivo ASIO. In base all’hardware specifico, un dispositivo DirectSound può fornire o 
meno una bassa latenza sufficiente per l’inserimento in Flexi-time.

% I dispositivi con (MME) alla fine del nome utilizzano la tecnologia MultiMedia Extension di 
Microsoft (un predecessore di DirectSound e ASIO). Alcune schede audio economiche o un 
hardware sonoro interno (di computer portatili o fissi di largo consumo) supportano solo 
MME che in genere funziona bene in riproduzione, ma non fornisce assolutamente la bassa 
latenza necessaria all’inserimento in Flexi-time.

In Windows, Sibelius sceglie automaticamente un dispositivo ASIO (se disponibile); altrimenti 
ne sceglie uno DirectSound o Multimedia (come ultima possibilità).
In Mac, quasi tutti i dispositivi supportano lo standard interno Core Audio di Mac OS X, quindi 
normalmente si vede solo (CoreAudio) alla fine del nome di ogni dispositivo; Core Audio è sim-
ile ad ASIO, nel senso che offre bassa latenza.

* In Windows, usando un dispositivo ASIO il pulsante ASIO Setup è abilitato; cliccando su questo 
pulsante si apre il pannello di controllo ASIO del dispositivo, nel quale si possono impostare i 
parametri ideali specifici del dispositivo stesso.

* Uscite: consente di scegliere le uscite del dispositivo usate per la riproduzione. La maggior parte 
delle schede audio hanno una singola coppia d’uscita stereo, quindi in questo menu ci sarà sola-
mente l’opzione 1/2. In una scheda audio o altra interfaccia audio con più coppie d’uscita, ogni 
coppia sarà elencata qui.
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* Dimensioni Buffer: determina la dimensione del buffer offerto dall’interfaccia audio per il 
flusso dei dati; questo parametro influisce sulla latenza del dispositivo: più grande è il buffer, più 
alta è la latenza. Le dimensioni del buffer fornite dall’hardware possono variare, ma per la gran 
parte dei dispositivi ASIO e Core Audio, un buffer ragionevole è 1024 campioni (samples).

* Freq. di Campionamento: è la frequenza alla quale l’audio è riprodotto dall’interfaccia audio; 
normalmente s’imposta a 44100Hz.

* Latenza: è il tempo (in millisecondi) che serve al dispositivo audio per riprodurre una nota 
dopo che Sibelius gli ha detto di farlo. La latenza non si può modificare direttamente; essa è cal-
colata in base alla combinazione tra dimensione buffer e frequenza di campionamento.

* In Windows, cè anche un’opzione che consente di scegliere la cartella dalla quale Sibelius deve 
caricare strumenti virtuali ed effetti. Di default, si trova in C:\Program Files\Sibelius Soft-
ware\VSTPlugins. Se strumenti virtuali ed effetti si trovano in un’altra cartella del computer, si 
può cambiarla cliccando Sfoglia; si noti, però, che di default Kontakt Player 2 è installato nella 
cartella VSTPlugins di Sibelius, quindi bisogna copiare la sua DLL dalla cartella di default 
all’altra per poter usare Kontakt Player 2. (In Mac, tutti gli strumenti virtuali ed effetti sono in 
una singola destinazione specificata da Mac OS X, quindi non c’è mai bisogno di cambiarla).

* Cliccare Cerca ancora se sono stati aggiunti o rimossi strumenti virtuali o effetti dalla cartella 
che Sibelius sta usando. All’avvio successivo, Sibelius analizza di nuovo tutti gli strumenti virtu-
ali ed effetti nella cartella specificata; questa operazione può richiedere un pò di tempo!

L’opzione Usa strumenti virtuali ed effetti in cima alla finestra di dialogo consente di disattivare 
completamente il supporto di Sibelius per strumenti virtuali ed effetti. Disattivare questa opzione e 
riavviare Sibelius se si vuole che nella finestra Play > Dispositivi di Ingresso e playback appaiano 
solo i dispositivi MIDI.

Al termine delle modifiche nella finestra di dialogo Opzioni Motore Audio cliccare Chiudi.

Set di Suoni - Sound set
Un sound set è un file che elenca tutti i suoni disponibili in un particolare dispositivo MIDI o stru-
mento virtuale e dice a Sibelius qual’è la corrispondenza reale tra i suoni e gli strumenti, in modo 
che possa automaticamente usare quelli più adatti.

Di default, in Sibelius sono installati vari sound set; se un dispositivo non appare nella colonna 
Sound set dell’elenco Periferiche attive nella pagina Dispositivi Attivi della finestra di dialogo 
Play > Dispositivi Ingresso e Playback, il file del sound set può essere disponibile nell’Help Cen-
ter on-line di Sibelius – selezionare Aiuto > Centro aiuto.

Soundfont
I soundfont sono raccolte di suoni campionati (di solito in due formati: SF2 e DLS). Inizialmente 
servivano per cambiare i suoni disponibili sulle schede audio fornite dai vari costruttori; attual-
mente è possible usare i soundfont senza bisogno di una scheda audio specifica.

Molti soundfont si possono scaricare da Internet; quelli più diffusi sono i banchi General MIDI 
completi che in Sibelius non richiedono una configurazione particolare.

In Windows non c’è un supporto interno per i soundfont, ma il modo più semplice per usare i 
soundfont in Sibelius è utilizzare uno strumento virtuale che li possa caricare e riprodurre. 
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Per esempio, RGC Audio’s sfz (gratuito; scaricabile dal sito http://www.rgcaudio.com/sfz.htm) 
può caricare soundfont SF2 e DLS.

Mac OS X ha un supporto interno per i soundfont. Per usare un soundfont in Mac OS X:

* Copiare il file .sf2 o .dls nella cartella Library/Audio/Sound/Banks dell’hard-disk.
* Scegliere una configurazione di riproduzione che includa il dispositivo DLSMusicDevice

nell’elenco Periferiche attive della finestra Play > Dispositivi di Ingresso e Playback (es. la 
configurazione Default standard di Sibelius).

* Aprire l’interfaccia grafica del dispositivo DLSMusicDevice (dal Mixer, ad esempio) e scegliere il 
soundfont desiderato dal menu Sound Bank.

È possibile usare solo un singolo banco soundfont per ogni istanza di DLSMusicDevice, ma si 
possono attivare più istanze del dispositivo DLSMusicDevice nella finestra di dialogo Play > Dis-
positivi di Ingresso e Playback e impostare ciascuna di esse all’uso di un soundfont diverso.
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4.12 Nozioni MIDI

Questo capitolo presume che si sappia poco del MIDI. Si consiglia di leggerlo se si conosce poco o 
niente del MIDI; evitare di leggere questo capitolo se invece lo si conosce abbastanza bene.

Per informazioni su collegamento e configurazione dei dispositivi MIDI sul computer, 
b Dispositivi di riproduzione, MIDI setup for Windows e MIDI setup for Mac nella 
Guida.

Domanda principale – cosa è il MIDI?
MIDI significa Musical Instrument Digital Interface. È uno standard, non un oggetto* – lo stan-
dard universale per la connessione di strumenti elettronici. Tastiere MIDI, sintetizzatori, moduli 
sonori, campionatori e altri gadget elettronici musicali si possono collegare tra loro con cavi MIDI 
e collegare a loro volta al computer. Inoltre, anche schede audio, sintetizzatori software e strumenti 
virtuali sono compatibili con lo standard MIDI e, poiché sono già nel computer, non serve colle-
gare alcun cavo per riprodurre la musica.

Il MIDI serve per semplificare la vita (allo stesso modo in cui collegare una stampante al computer 
oggi è abbastanza facile). Ricordate i vecchi tempi quando non era possibile usare una stampante 
senza una conoscenza del computer e nel manuale c’era lo schema elettrico nel caso fosse necessa-
rio saldare componenti elettronici extra? Ah, che tempi!

Purtroppo, nel campo del MIDI quei giorni sono ancora attuali. Alle persone che lavorano con i 
dispositivi MIDI si richiede ancora la conoscenza di nozioni come canali MIDI, numeri pro-
gramma, banchi e altro ancora – conoscenze che nella maggior parte dei casi possono e devono 
essere sconosciute a tutti (tranne che agli esperti).
(*Questo concetto all’apparenza ovvio và approfondito, poiché in molte occasioni ci chiedono: “Quanto è grande un MIDI?”).

Numeri programma e General MIDI
I suoni disponibili nei dispositivi MIDI sono identificati da numeri, in genere da 0 a 127. Il piano 
ha il numero 0 e il flauto il numero 73; sarebbe meglio chiamarli numeri strumento o numeri 
suono, ma nella pratica (per ragioni storiche misteriose) sono chiamati numeri programma. 
(Talvolta sono denominati “program change”, “numeri patch” o “numeri voce”).

Fino a poco tempo fa i numeri programma non erano standardizzati. Sebbene nella maggior parte 
dei dispositivi il programma 0 era un piano, il programma 73 poteva essere qualsiasi cosa! Prima 
della standardizzazione, si doveva dire ai computer i numeri programma da assegnare ad ogni 
strumento in ogni partitura (piuttosto noioso). Inoltre, riproducendo la stessa partitura su altri 
dispositivi MIDI si potevano avere suoni diversi – non molto pratico.

Fortunatamente è stato realizzato un elenco standard di 128 suoni denominato General MIDI 
(GM). Questi suoni iniziano con il piano (numero programma 0) attraversando la maggior parte 
degli strumenti esistenti, fino ad arrivare all’ultimo suono del colpo di pistola (numero programma 
127). Virtualmente, tutte le schede audio e molti dei nuovi dispositivi MIDI seguono questo stan-
dard (anche con suoni extra). I dispositivi MIDI professionali tendono ad essere meno General 
MIDI compatibili.
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Recentemente, i costruttori MIDI si sono incontrati e hanno ratificato alcune integrazioni allo 
standard General MIDI, realizzando lo standard General MIDI 2 (GM2). GM2 aggiunge 128 suoni 
extra al set standard (oltre ad altre cose) ma il suo impiego non è ancora molto diffuso. 
In genere un dispositivo MIDI GM o GM2 compatibile ha il rispettivo logo sul pannello frontale.

In Sibelius i numeri programma funzionano così: ogni volta che si crea un rigo di flauto Sibelius lo 
imposta al numero programma 73 (il numero programma General MIDI per un suono di flauto). 
Riproducendo la partitura con un dispositivo General MIDI esso genera il giusto suono: tutto qui.

Inoltre, collegando un dispositivo diverso e dicendo a Sibelius che tipo di dispositivo è, Sibelius 
cambia il numero programma per scegliere dal dispositivo il miglior suono di flauto possibile. 
Sibelius può essere usato con qualsiasi dispositivo MIDI.

Conteggio da 0
Un’inutile complicazione del MIDI è che alcuni manuali elencano i numeri programma da 0 a 127 
e altri da 1 a 128. (Questo perché a causa di misteriose ragioni tecniche, i programmatori di com-
puter contano da 0, quindi progettando il funzionamento interno dei dispositivi MIDI tendono a 
dimenticarsi che le persone normali contano da 1).

La spiacevole conseguenza è che talvolta configurando i dispositivi MIDI si ha il suono sbagliato e 
bisogna aggiungere o sottrarre 1 da un numero programma per correggere l’anomalia. Sibelius 
esegue quasi sempre automaticamente questa regolazione, quindi non c’è da preoccuparsi.

Banchi: varianti dei suoni
Alcuni dispositivi MIDI possono riprodurre centinaia di suoni diversi, sebbene i numeri pro-
gramma arrivino solo fino a 127. Questa limitazione si supera organizzando i suoni extra in gruppi 
o banchi di numeri programma; per accedere ad essi, oltre al numero programma si specifica 
anche il numero del banco.

Un numero banco è costituito da 2 valori, sebbene spesso i dispositivi MIDI ne specificano solo 
uno (essendo implicito che l’altro valore è 0).

Canali
Chi ha sufficienti conoscenze tecniche sul MIDI può evitare di leggere questo paragrafo.

Spesso i canali sono la prima cosa che si sente del MIDI, ma con Sibelius essi sono piuttosto irrile-
vanti. La maggior parte dei dispositivi MIDI può riprodurre solo fino a 16 suoni diversi contempo-
raneamente (cioè solo 16 timbri diversi), sebbene il numero massimo di note simultanee possa 
essere 32 o più. Si può immaginare che il dispositivo MIDI contenga 16 righi denominati canali e 
possa riprodurre un solo timbro alla volta. Sibelius, o qualsiasi cosa ad esso collegata, genera 
diversi timbri in base al canale sul quale è riprodotta un nota o accordo. Anche altre cose, come il 
controllo del volume complessivo (indicato da un fader nella finestra Mixer di Sibelius), la posiz-
ione pan (stereo) e i pedali del piano si applicano al canale, non alle singole note.

Altri termini MIDI
Altri termini MIDI non descritti qui ma nel Glossario sono: aftertouch, control change, NoteOn, 
NoteOff, pan, pitch bend, track, velocity, volume.
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File MIDI
I file MIDI sono file musicali in un formato standard – talvolta denominato Standard MIDI File
(SMF). Quasi tutti i programmi musicali e alcune tastiere possono salvare (export) e aprire 
(import) file MIDI; attualmente, si possono acquistare file MIDI su floppy disk in un negozio di 
strumenti musicali. Internet è pieno di file MIDI; attenzione, però, poiché molti violano i diritti 
d’autore e quindi sono illegali.

L’uso dei file MIDI è un metodo comodo per trasferire la musica tra Sibelius e tutti gli altri pro-
grammi musicali. Tuttavia, i file MIDI sono destinati a riprodurre la musica piuttosto che scriverla 
e stamparla; essi non includono quindi molte informazioni sulla notazione musicale (come lega-
ture, articolazioni e layout di pagina); anche la differenza tra FA# e SOLb è ignorata.

Queste limitazioni dimostrano che i file MIDI non sono il metodo ideale per trasferire la notazione 
musicale da un programma di computer a un altro (sebbene siano l’unico standard universale).

Fortunatamente, però, Sibelius trasforma opportunamente in pochi secondi i file MIDI in notazi-
one musicale (o viceversa); b Aprire i file MIDI e Esportare i file MIDI. Tuttavia, non ci si 
aspettino miracoli! Convertire una partitura in dati MIDI e poi di nuovo in partitura è un pò come 
convertire un complesso documento di testo in formato ASCII (testo normale) e convertirlo di 
nuovo – l’informazione di base è mantenuta ma il layout e altri particolari si perdono.

Sesi vuole convertire la musica in Sibelius da programmi come Finale, Allegro, PrintMusic o 
SCORE, Sibelius può trasferire molte più informazioni di quanto si potrebbe fare con i file MIDI. 
Per farlo, b Aprire i file MusicXML, Aprire i file Finale 98-2003 e Aprire i file SCORE.
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4.13 Strumenti virtuali

Negli ultimi due decenni la musica è stata rivoluzionata dall’avanzare della tecnologia dei com-
puter e attualmente è molto diffusa la presenza di strumenti virtuali – software che simulano gli 
strumenti reali – i quali hanno rapidamente sostituito i dispositivi hardware dedicati (come sin-
tetizzatori MIDI e moduli sonori).

Grazie alla potenza sempre maggiore dei computer, negli studi di registrazione gli strumenti virtu-
ali si sono diffusi perché consentono di avere una vasta gamma di suoni generata da un solo hard-
ware. In quasi tutti i dispositivi hardware, la scelta dei suoni si limita a quelli interni previsti dal 
costruttore; lavorando invece in ambiente software, la tavolozza sonora è limitata solo dalla quan-
tità di strumenti virtuali a disposizione (ma si può sempre installarne di nuovi!).

Ci sono migliaia di strumenti virtuali di vario tipo da usare con Sibelius, ma questo scenario può 
essere nebuloso e intimidatorio per un principiante.

Cos’è uno strumento virtuale?
Uno strumento virtuale è un software che simula la prestazione di uno strumento reale, sia 
elettronico (come un sintetizzatore analogico o digitale) che acustico.

In generale, gli strumenti virtuali eseguono questa simulazione per uno o due scopi: la riproduzi-
one di suoni campionati o la sintesi sonora. Un “campione” è semplicemente la registrazione digi-
tale di un suono (di solito una singola nota) ed è il modo più semplice per riprodurre il suono di 
uno strumento acustico (perché la registrazione originale è quella di uno strumento acustico). Con 
la “sintesi” il suono è generato da calcoli matematici invece che da una registrazione e si basa su un 
modello che descrive il suono reale (es. sintesi additiva) o un modello che descrive il meccanismo 
di generazione del suono (es. sintesi modellata).

Strumenti virtuali basati sul campione
Un buon esempio di strumento virtuale basato sul campione è Kontakt Player 2, incluso in Sibelius 
5: esso può caricare raccolte di campioni (“librerie”) e riprodurre la musica grazie a questi campi-
oni, caricando fino a 16 “programmi” o suoni diversi simultaneamente.

Alle origini del MIDI, un singolo “programma” era un singolo suono – es. un suono di violino con 
archetto era un programma e un suono di violino pizzicato un altro; negli strumenti virtuali basati 
sul campione, invece, un singolo programma può contenere molti suoni simili – continuando 
l’esempio del violino, non solo archetto e pizzicato ma anche altre tecniche esecutive (denominate 
genericamente “articolazioni” nel mondo degli strumenti virtuali) come legato, staccato, spiccato, 
col legno, tremolo, e così via – tutte caricate nello stesso canale e organizzate in layer (cioè parti 
dello stesso programma che restano nascoste fino a quando non sono utilizzate).

Si passa da un layer all’altro usando una serie di tecniche particolari, come suonare una nota molto 
acuta o (più spesso) molto grave sulla tastiera MIDI (tecnica conosciuta come “keyswitch,” perché 
il suono cambia premendo un tasto specifico) o regolando un controller continuo MIDI (es. 
usando la Mod Wheel sulla tastiera MIDI). Gli strumenti vituali più sofisticati basati sul campione 
possono assegnare qualsiasi suono a qualsiasi combinazione di keyswitch, controller MIDI e per-
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fino controller a fiato MIDI particolari (breath controller) che fanno sembrare chi li usa come se 
stesse suonando un’armonica invisibile.

Fortunatamente, il motore di riproduzione di Sibelius è abbastanza potente da sapere come inser-
ire le note keyswitch, modificare i controller MIDI, e così via per molti degli strumenti virtuali 
basati sul campione più diffusi, in modo da selezionare in ogni momento il suono più opportuno; 
non c’è quindi da preoccuparsi di questo.

Altri strumenti virtuali basati sul campione sono: Vienna Symphonic Library, Garritan Personal 
Orchestra, EastWest Quantum Leap Symphonic Orchestra, Sonivox Symphonic Orchestra, Miro-
slav Philharmonik – che sono solo alcuni di quelli dedicati alla riproduzione di un’orchestra tradiz-
ionale! Inoltre, ci sono gli strumenti virtuali destinati ad ogni gruppo di strumenti e stile musicale, 
dalle bande, batterie e percussioni (es. Virtual Drum Line di Tapspace) a bellissimi pianoforti (es. 
Synthogy Ivory) a strumenti etnici e rari (es. EastWest Quantum Leap Ra) a grandi cori (es. East-
West Symphonic Choirs) a big band di jazz e swing tradizionale (es. Garritan Jazz & Big Band, 
Sonivox Broadway Big Band) al beat anni ‘60 (es. EastWest Fab Four), e così via. Con Sibelius si 
possono usare praticamente tutti questi strumenti virtuali, quindi le possibilità sono quasi infinite!

Per funzionare al meglio gli strumenti virtuali basati sul campione hanno bisogno di molto spazio 
su hard-disk e molta memoria RAM. Alcuni campioni sono talmente grandi che su un singolo 
computer si riescono a usare solo pochi suoni contemporaneamente (e possono passare anche fino 
a 10 minuti per caricarli tutti da hard-disk prima che si possa suonare qualcosa!): è importante 
quindi ottenere un buon equilibrio tra qualità sonora e pragmatismo. Per alcuni consigli al 
riguardo vedere Come ottenere il meglio da strumenti virtuali ed effetti.

Strumenti virtuali basati sulla sintesi
Sebbene gli strumenti virtuali basati sulla sintesi per lungo tempo siano stati fantastici nel ripro-
durre i sintetizzatori analogici e digitali degli anni ‘70 e ‘80 – in alcuni casi migliorando le prestazi-
oni delle versioni hardware originali – ed abbiano anche riprodotto fedelmente altri suoni famosi 
(come l’organo Hammond), solo recentemente i grandi progressi nelle tecniche dei modelli fisici 
hanno iniziato a dare i loro frutti nel produrre interpretazioni veramente convincenti degli stru-
menti acustici.

Gli strumenti virtuali basati sulla sintesi sono comodi perché non hanno bisogno di enormi liberie 
di campioni per generare un bel suono: invece di registrare musicisti che suonano ogni nota con 
l’articolazione desiderata, questi strumenti virtuali costruiscono un complesso modello matemat-
ico di generazione del suono e il risultato è una fedele simulazione del suono vero e proprio. 
Gli strumenti modellati possono rispondere in tempo reale al modo in cui sono suonati dall’esecu-
tore tanto bene quasi quanto gli strumenti che simulano; questo approccio può tener conto anche 
di fattori particolari, come una piacevole riverberazione e combinazioni di armonici non possibili 
con la semplice riproduzione dei campioni. Regolando leggermente il modello per valorizzare (ad 
esempio) le differenze costruttive di strumenti simili realizzati da diversi costruttori (come le dif-
ferenze tra un piano Steinway e un Bechstein) è possibile avere un’ampia gamma di suoni senza 
dover registrare ogni nota da ogni strumento. Alcuni degli strumenti virtuali più evoluti che utiliz-
zano questo approccio sono Pianoteq (simula una serie di pianoforti), Lounge Lizard (simula i 
piani elettrici Wurlitzer e Rhodes) e String Studio (simula una serie di strumenti a corda, come 
chitarra, clavicembalo e arpa).
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Sta emergendo anche un interessante tipo di strumento virtuale ibrido, che combina campioni e 
sintesi per offrire strumenti virtuali che riproducono il carattere reale dei suoni campionati senza 
bisogno di enormi librerie di campioni; un valido esempio di uno strumento virtuale che utilizza 
questo tipo di approccio è Synful Orchestra.

Gli strumenti virtuali basati sulla sintesi, in particolare quelli che impiegano modelli fisici, ten-
dono a consumare più risorse della CPU rispetto agli strumenti virtuali basati sul campione, ma 
hanno bisogno di molto meno spazio su hard-disk e un pò meno RAM.

Tecnologie per gli strumenti virtuali
Ci sono molte tecnologie dai nomi strani (usate sia dagli strumenti virtuali basati sul campione che 
per la sintesi); alcune sono specifiche per i PC Windows, altre per i Mac; altre ancora consentono ai 
rispettivi strumenti virtuali di funzionare solo con determinati pacchetti software.

Sibelius attualmente supporta gli strumenti virtuali con gli standard VST e Audio Units. VST sig-
nifica “Virtual Studio Technology” ed è una tecnologia inventata da Steinberg. Gli strumenti virtu-
ali VST (VSTi) si possono usare sia in Windows che su Mac. Lo standard Audio Units (AU) è stato 
inventato da Apple e gli strumenti virtuali Audio Unit si possono usare solo su Mac.

Esistono diversi altri formati di strumenti virtuali, inclusi RTAS (Real Time Audio Suite) e TDM
(Time Division Multiplexing) entrambi usati da Pro Tools (Digidesign), DXi (DirectX Instrument) 
e MAS (MOTU Audio System). Al momento Sibelius non ne supporta nessuno. Tuttavia, la mag-
gior parte degli strumenti virtuali sono disponibili sia nei formati VST che Audio Unit.

Sebbene ci siano differenze significative tra le tecnologie VST e AU (e tra gli altri formati), per le 
esigenze dell’utente non c’è una differenza pratica sostanziale.

Strumenti virtuali come “plug-in
In genere si sente dire che gli strumenti virtuali adottano lo standard VST, in particolare denomi-
nato “VST plug-ins.” Il termine “plug-in” indica un software che opera all’interno di un altro ambi-
ente software (un “programma in un programma” se si prefersice). Per semplicità, tuttavia, in 
questo Manuale Operativo il termine “plug-in” è riferito ai plug-in che si possono usare nel menu 
Plug-ins di Sibelius (b Plug-in), non agli strumenti virtuali.

Oltre ad essere usati in un’applicazione “host” (come Sibelius o Pro Tools), molti strumenti virtuali 
funzionano anche in “stand-alone”; essi, cioè, possono funzionare da soli, senza bisogno di 
un’applicazione host (ideale per esibizioni dal vivo).

Effetti
Sibelius, oltre agli strumenti virtuali, può usare anche degli effetti, i quali sono programmi che 
processano un segnale audio per modificare una o più caratteristiche di un suono. Come gli stru-
menti virtuali, talvolta gli effetti simulano i dispositivi hardware reali, come amplificatori per chi-
tarra o compressori valvolari; altre volte simulano fenomeni sonori naturali, come il riverbero.

Alcuni degli effetti più comuni sono:

* Filtri: attenuano (riducono) alcune frequenze presenti nel segnale audio, lasciandone passare 
altre. In verità, la maggior parte degli effetti (compresi molti di quelli elencati in seguito) sono in 
un certo senso dei filtri, ma quando si parla di “filtri” si tende a pensare a un wah-wah (il quale 
genera il suo suono caratteristico variando le frequenze che possono passare attraverso il filtro) 
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ed effetti di equalizzazione (o EQ), che attenuano alcuni intervalli di frequenza e ne enfatizzano 
altri. Con un EQ è possibile compensare le imperfezioni in un segnale audio o la risposta in fre-
quenza sbilanciata in un dispositivo di riproduzione audio.

* Compressori: comprimono l’intervallo dinamico di un segnale audio alzando il volume dei suoni 
più deboli e abbassando quello dei suoni più forti. L’obiettivo è ottenere un suono più uniforme e 
consistente. La compressione è utile specialmente per batterie, bassi elettrici e altri strumenti 
rock, sebbene la maggior parte dei dischi – rock, pop, jazz o musica classica – utilizzino questo 
effetto. Si possono anche usare i limiter, i quali sono semplicemente dei compressori che fornis-
cono una quantità maggiore di compressione ed evitano distorsione (o “clipping”) ad alti volumi.

* Distorsori: questi effetti alterano la struttura originale delle forme d’onde che costituiscono il 
segnale audio; sebbene, in genere, la distorsione sia sgradevole, è proprio quella che da alle chi-
tarre elettriche il loro caratteristico suono aggressivo. Gli effetti che generano le distorsioni più 
estreme simulano il suono potente e ricco d’armoniche di amplificatori, cabinet e pedali fuzz; 
sono utili anche distorsioni più morbide, come quelle che simulano il suono prodotto dagli 
amplificatori valvolari vintage o dal nastro analogico.

* Delay: questi effetti prelevano il segnale audio all’ingresso e lo riproducono di nuovo dopo un 
certo periodo di tempo (in genere piuttosto breve). Il suono ritardato può essere riprodotto più 
volte, oppure di nuovo nel delay, per creare un eco ripetuto in decadimento; non si confonda il 
delay con il riverbero (vedere in seguito).

* Modulazione: questi effetti moltiplicano il segnale audio entrante, copiandolo o aggiungendo 
altre forme d’onda. Gli effetti di modulazione più comuni sono chorus, flanging e phasing. 
Il chorus miscela il segnale audio entrante con una o più delle sue copie ritardate e spostate in 
altezza, simulando il suono di più strumenti o voci (quando in realtà ce n’è uno solo). Il flanging
genera un suono “ventoso” miscelando il segnale audio con una sua copia leggermente ritardata 
e variando continuamente il ritardo. Secondo la leggenda si chiama così perché fu scoperto per 
caso durante una delle sessioni di registrazione dei Beatles quando su un macchina a nastro 
usata per il delay qualcuno toccò accidentalmente il bordo di una bobina del nastro (chiamata 
appunto “flange”) cambiando leggermente l’altezza del suono. Il phasing è simile, ma il segnale 
audio d’ingresso passa simultaneamente attraverso un filtro invece che dopo un delay variabile. 
Il filtro risponde in modo diverso alle varie frequenze e genera quindi lievi ritardi di durata vari-
abile alle diverse frequenze; ne risulta una suono “a vortice” meno intenso di quello generato dal 
flanging.

* Riverberi: questi effetti simulano il modo in cui i suoni sono riflessi dalle superfici di una sala. 
Il suono arriva alle orecchie da molte direzioni: alcune (es. il percorso diretto dall’esecutore alle 
orecchie) sono più dirette di altre (es. il suono riflesso dalle pareti prima di arrivare alle orec-
chie). I suoni che percorrono una distanza maggiore per arrivare all’ascoltatore sono più atten-
uati di quelli diretti, ma le differenze di tempi e volume sono talmente piccole che l’orecchio non 
percepisce ogni suono riflesso come copia dell’originale, ma l’effetto di tutte le riflessioni come 
un singolo suono. Le simulazioni di riverbero più realistiche sono prodotte dalla convoluzione, 
che utilizza una “risposta impulsiva” registrata, cioè la registrazione della riverberazine di un 
ambiente, come una sala da concerto (dovuta a un suono ideale, o “impulso”) e la combina con 
l’ingresso audio, generando un segnale d’uscita che simula la riproduzione del suono d’ingresso 
in una sala o ambiente specifico; il riverbero a convoluzione è molto più complesso di altri river-
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beri digitali i quali, in genere, utilizzano più circuiti “feedback” di ritardo per generare una lunga 
serie di copie in decadimento del segnale originale.

Se cominciate a non capire, non preoccupatevi: iniziate con poco, sperimentando con il riverbero 
(è forse l’effetto che introduce la differenza più grande nei suoni generati dagli strumenti virtuali). 
Kontakt Player 2 ha il proprio riverbero, oppure si può aggiungerne uno separato; una volta che si 
conosce il riverbero, si può provare ad occuparsi della compressione che equilibra l’intervallo 
dinamico. Si può anche provare un limiter impostato a -3dB o -6dB, il quale assicura che il mix 
complessivo non distorca (siete già esperti!).

Per provare gli effetti, da Internet se ne possono scaricare molti gratuitamente, compresa la serie 
Kjaerhus Classic (www.kjaerhusaudio.com; solo Windows) o gli effetti gratuiti Audio Unit 
Smartelectronix (mda.smartelectronix.com/effects.htm; solo Mac).

Attenzione! Entrando nel mondo degli effetti, presto inizierete a parlare di “calore” e “sensibilità al 
tocco” del suono, direte cose strane come “cavalcare il guadagno”, vi entusiasmerete per gli “echi 
inversi”... a questo punto non ci sarà davvero più speranza per voi!

Come ottenere il meglio da strumenti virtuali ed effetti
Lo svantaggio degli strumenti virtuali è che consumano le risorse del computer, più degli elementi 
essenziali che servono al sistema operativo e (ancor più importante) a Sibelius. Più strumenti vir-
tuali basati sul campione s’installano, più spazio serve su hard-disk (e più strumenti virtuali basati 
sul campione si vogliono usare simultanemente, più serve un processore veloce e una maggiore 
quantità di RAM). Con strumenti virtuali basati sulla sintesi serve meno spazio su hard-disk e 
RAM, ma un processore molto veloce.

Avere spazio sufficiente su hard-disk è un problema facile da risolvere: gli hard-disk non costano 
molto, sono capienti e facili da installare (se c’è una porta USB 2.0 o Firewire non c’è nemmeno 
bisogno di aprire il computer). Si consiglia d’installare i campioni su un hard-disk diverso da 
quello sul quale si trovano il sistema operativo e le altre applicazioni, poiché ciò aumenta le 
prestazioni di disk-streaming (cioè il flusso dei dati dall’hard-disk).

I requisiti di RAM sono tecnicamente più complessi – quindi se il parlare di “32-bit questo” e “64-
bit quello” vi spaventa e confonde potete pure saltare un paio di paragrafi: la raccomandazione più 
importante per quanto riguarda la RAM è averne il più possibile, almeno 2GB o più.

La maggior parte dei computer Windows venduti nell’ultimo decennio usano microprocessori a 
32-bit, che possono indirizzare un massimo di 4GB di RAM (non “vedono” niente più di quello 
nemmeno installandolo); Windows stesso, inoltre, non è in grado di usare molta memoria oltre i 
2GB, quindi questo valore è quello massimo consigliato. Tolta la memoria necessaria al sistema 
operativo e Sibelius, rimane circa 1GB di RAM nella quale caricare i campioni. La situazione è sim-
ile in Mac: sebbene teoricamente Mac OS X possa indirizzare facilmente più di 2GB di RAM, per 
ora solo Mac Pro desktop accetta più di 2GB di RAM (in realtà è un computer a 64-bit e questo 
complica ulteriormente le cose).

In teoria, icomputer con processori a 64-bit possono indirizzare fino a 16 exabyte di memoria (più 
di 16 milioni di GB!), sebbene in pratica il massimo che un computer disponibile oggi accetta è 16 
GB. Tuttavia, per trarre vantaggio dalla potenza extra di un processore a 64-bit, serve anche un 
sistema operativo che lavori bene a 64-bit; inoltre, tutte le applicazioni, compresi gli stessi stru-
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menti virtuali, devono essere aggiornati per godere di capacità superiori. Al momento, quindi, i 
benefici sono molto teorici e potrebbero essere necessari ancora alcuni anni prima che questi tipi 
di sistemi siano d’uso comune.

A causa di queste complicazioni, negli studi che utilizzano molto gli strumenti virtuali spesso ci 
sono più computer collegati tra loro (ciascuno che gestisce strumenti virtuali diversi), controllati 
da un altro computer; non tutti, però, se lo possono permettere economicamente.

Se leggendo i paragrafi precedenti vi stavate addormentando è il momento di riprendersi, perché 
ora le cose tornano ad essere interessanti.

Per i comuni mortali ciò che si è detto finora è semplicemente che ci sono dei limiti al numero di 
strumenti virtuali o suoni utilizzabili simultaneamente su un computer, perché per ripordurli 
serve un’enorme potenza di calcolo.

Supponendo di avere un computer recente con 2GB di RAM si può affermare con una stima 
approssimativa che è possibile suonare contemporaneamente in tempo reale da 32 a 40 suoni 
(sebbene ciò dipenda molto dal tipo di suoni utilizzati).

In Sibelius, tuttavia, ci sono un paio di trucchi a questo proposito. Innanzitutto, si può passare 
molto facilmente a vari set di strumenti virtuali, in modo da usare una combinazione “leggera” per 
l’inserimento, la modifica e l’ascolto, per poi passare a una combinazione più complessa e dispend-
iosa quando si vuole ascoltare un’esecuzione particolare. In secondo luogo, anche se il computer 
fatica a eseguire la riproduzione in tempo reale, si può usare la funzione File > Esporta > Audio di 
Sibelius per esportare un file audio della partitura e Sibelius riprodurrà internamente la partitura 
(più lentamente rispetto al tempo reale) consentendo al computer di non bloccarsi – 
b Esportare i file audio.

Oltre ai problemi di spazio su hard-disk, RAM e velocità del processore, quando si considera l’uso 
intensivo di strumenti virtuali è necessario avere una scheda o interfaccia audio di alta qualità; ciò 
è particolarmente vero sui PC Windows (l’hardware audio interno dei computer Mac attuali è ade-
guato per la riproduzione), specialmente se si vogliono usare gli strumenti virtuali per generare il 
suono durante l’inserimento delle note oltre che in riproduzione.

Inserendo le note con una tastiera controller MIDI (specialmente in Flexi-time) l’ascolto deve 
essere quasi immediato (altrimenti si suona fuori tempo per compensare il ritardo con il quale si 
sente ciò che si sta suonando). Il ritardo tra il dire al computer di suonare una nota e quello che si 
sente veramente si chiama “latenza”; una latenza superiore a circa 20 millisecondi è troppo alta e 
porta inevitabilmente a commettere errori nell’inserimento della musica.

Per limitare la latenza bisogna ridurre il tempo necessario a inviare i messaggi di nota MIDI nel 
computer e ottenere l’audio in uscita; un’interfaccia o scheda audio di alta qualità può ridurre la 
latenza a 5ms o meno. Le schede audio destinate ai giochi non sono particolarmente adatte ad 
applicazioni audio in tempo reale e all’uso con strumenti virtuali; servono invece schede audio 
destinate appositamente ad applicazioni audio. In Windows, per le schede audio è essenziale il sup-
porto ASIO (ASIO è un’altra tecnologia Steinberg che consente di avere una riproduzione a bassa 
latenza). Le schede audio ASIO sono costruite da M-Audio, Digidesign, Presonus, RME, Echo Dig-
ital e altri costruttori; una scheda di medio livello come la Audiophile 2496 M-Audio costa meno di 
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200 euro, può coesistere (in genere) con qualsiasi hardware audio e le sue prestazioni sono netta-
mente migliori di una scheda audio d’alto livello per i giochi che costa il doppio!

Ulteriori informazioni
Ci sono centinaia di siti Internet e altre risorse disponibili che consentono di conoscere meglio il 
mondo degli strumenti ed effetti virtuali; alcuni sono:

* Rivista Virtual Instruments (www.virtualinstrumentsmag.com).
* Rivista Sound on Sound (www.soundonsound.com).
* KVR Audio, un’ottima sorgente di strumenti ed effetti virtuali gratuiti e informazioni aggiornate 

sui prodotti in commercio (www.kvraudio.com).
* Northern Sound Source, uno dei più grandi forum di tecnologia musicale e composizione in 

Internet (www.northernsounds.com).
* BigBlueLounge.com, un’altra delle più grandi risorse di musica, produzione audio e comunità di 

Internet (www.bigbluelounge.com).
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4.14 Lavorare con gli strumenti virtuali

Questo capitolo descrive alcuni esempi d’uso degli strumenti virtuali in Sibelius.

Per un’introduzione al mondo degli strumenti virtuali si consiglia di vedere b Strumenti virtu-
ali. Se non si conosce ancora bene la finestra di dialogo Play > Dispositivi di Ingresso e Play-
back, b Dispositivi di riproduzione.

Questo capitolo descrive due tipi di strumenti virtuali:

* Quelli che possono riprodurre suoni diversi simultaneamente (denominati strumenti virtuali 
multi-canale); includono Kontakt, Steinberg Halion, MOTU MachFive, EastWest Play, ecc..

* Quelli che possono riprodurre solo un suono alla volta (denominati strumenti virtuali a singolo 
canale); includono Vienna Symphonic Library Vienna Instruments, TruePianos, Pianoteq, Gar-
ritan Steinway, B4, Lounge Lizard, ecc..

Kontakt Player 2 fa parte del primo gruppo ma funziona in modo speciale, poiché Sibelius può 
caricare automaticamente i suoni in questo strumento virtuale; per tutti gli altri strumenti virtuali 
(sia multi-canale che a singolo canale) i suoni si devono caricare a mano.

Sibelius Sounds Essentials
Sibelius Sounds Essentials è la libreria di suoni fornita con Sibelius che usa Kontakt Player 2 – 
b Sibelius Sounds Essentials.

Altre librerie Kontakt Player 2
Sono disponibili sempre più librerie di campioni che impiegano Kontakt Player 2 da usare in Sibe-
lius. Il vantaggio delle librerie basate su Kontakt Player 2 è che se è disponibile un sound set adatto 
Sibelius può caricare i suoni necessari a riprodurre automaticamente la partitura.

Le librerie di Kontakt Player 2 più famose includono Garritan Personal Orchestra, Garritan Jazz 
and Big Band, Garritan Concert and Marching Band e Tapspace Virtual Drumline, oltre che altre 
librerie Sibelius Sounds, Sibelius Sounds Rock and Pop Collection, Sibelius Sounds World Music e 
Sibelius Sounds Choral.

Il modo più semplice per iniziare con una di queste librerie è scegliere una delle configurazioni di 
riproduzione esistenti (es. Sibelius Essentials (16 sounds)), cliccare Nuovo, digitare un nuovo 
nome (es. GPO), impostare la colonna Sound set alla libreria che si sta usando e cliccare Chiudi.

Per maggiori informazioni:

* Librerie Garritan: vedere Garritan Wiki sul sito http://www.garritan.info/.
* Virtual Drumline: visitare il sito http://www.tapspace.com/support/.
* Sibelius Sounds: consultare la Guida Utente stampata a parte fornita con il prodotto.

Combinare diverse librerie Kontakt Player 2
Può essere utile combinare i suoni da più librerie Kontakt Player 2 nella stessa configurazione di 
riproduzione. Garritan Personal Orchestra, ad esempio, non ha suoni vocali quindi per una partit-
ura d’orchestra e coro si usano i suoni di Sibelius Sounds Choral insieme a quelli orchestrali.
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Per farlo, basta creare una nuova configurazione di riproduzione con almeno due istanze di Kon-
takt Player 2: selezionare il sound set Sibelius Choral per un’istanza e il sound set Garritan Per-
sonal Orchestra per le altre istanze. Sibelius sceglie automaticamente di riprodurre i righi vocali 
usando Sibelius Sounds Choral e il resto dei righi usando Garritan Personal Orchestra.

Altrimenti, si possono combinare due librerie i cui suoni si sovrappongono un pò. Per esempio, 
Garritan Jazz and Big Band non ha tanti suoni di tastiera e chitarra quanti quelli di Sibelius Sounds 
Rock and Pop Collection, quindi si può pensare ad una combinazione tra i suoni di chitarra 
elettrica della libreria Rock and Pop Collection e i suoni della libreria Jazz and Big Band.

Per farlo, creare una configurazione di riproduzione con almeno un’istanza di Kontakt Player 2 
impostata a Garritan JABB e almeno un’istanza impostata a Sibelius Rock and Pop. A questo 
punto è utile rinominare i dispositivi nell’elenco Periferiche attive, cliccando lentamente due 
volte su ogni nome e digitando i nomi desiderati.

Ora, per dire a Sibelius di usare le chitarre della libreria Rock and Pop, selezionare la pagina Suoni 
preferiti della finestra di dialogo Play > Dispositivi di Ingresso e Playback e, usando l’elenco 
gerarchico dei sound ID nella parte sinistra della finestra, selezionare Chitarra > Elettrica. Sul lato 
destro scegliere Kontakt Player 2 che è impostato per la riproduzione usando la libreria Sibelius 
Sounds Rock and Pop Collection, cliccare Agg. e infine cliccare Chiudi.

Usare Kontakt Player 2 come altri strumenti virtuali
Di default, Sibelius carica sempre automaticamente i suoni in Kontakt Player 2. Per fare in modo 
che Sibelius gestisca Kontakt Player 2 (e tutto il campionatore Kontakt) come altri strumenti virtu-
ali attivare l’opzione Usa Sound Set manuale nella pagina Playback della finestra di dialogo 
File > Preferenze (menu Sibelius in Mac).

Attivando questa opzione si può scegliere Kontakt Player 2 e attivare l’opzione Usa Sound Set 
manuale nella pagina Consenti sound set manuali della finestra di dialogo Play > Dispositivi 
di Ingresso e Playback, per eseguire una qualsiasi delle procedure descritte in seguito.

Usare uno strumento virtuale multi-canale con un sound set
Perché Sibelius sfrutti al meglio le funzioni avanzate delle librerie campione attuali, inclusi i key-
switch per scegliere tecniche di riproduzione e automazione dei controller per manipolare la qual-
ità del suono (es. le dinamiche) si raccomanda di avere un sound set per la libreria. Supponiamo 
che si usino i suoni della EastWest Quantum Leap Symphonic Orchestra (EWQLSO). Non importa 
se li si usa all’interno del player originale Kompakt a otto canali o nel nuovo player EastWest Play 
(o addirittura in un altro campionatore, come Kontakt).

A questo punto, i suoni si devono caricare manualmente. Per iniziare, creare una nuova config-
urazione di riproduzione e aggiungere una o più istanze del campionatore desiderato all’elenco 
Periferiche attive. Scegliere il sound set adatto (es. EWQLSO Silver) dal menu nella colonna 
Sound set. Selezionare quindi la pagina Set di Suoni Manuali della finestra di dialogo Play >
Dispositivi di Ingresso e Playback (qui si dice a Sibelius quale suono è caricato in ogni slot o 
canale del campionatore). Cliccare Mostra per aprire l’interfaccia grafica del campionatore e pro-
cedere caricando la patch desiderata in ogni canale. Nella pagina Set di Suoni Manuali attivare 
l’opzione Usa Sound Set manuale e assicurarsi che il campo No. canale sia impostato al valore 
opportuno. 
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A questo punto, per ogni canale scegliere il programma (Program) adatto nell’elenco che appare e 
cliccare Applica dopo ogni scelta. Una volta terminato il caricamento dei suoni nel campionatore e 
scelto lo stesso programma per ogni canale nella pagina Set di Suoni Manuali cliccare Chiudi.

Sibelius assegna ora automaticamente la riproduzione di ogni rigo nella partitura al rispettivo pro-
gramma caricato nel campionatore utilizzando adeguatamente i keyswitch e le altre informazioni 
sui controller definite nel sound set.

Per assegnare manualmente un rigo specifico a un determinato canale si usa il Mixer: prima di 
tutto espandere la strip del rigo, poi selezionare il dispositivo dal menu dispositivo (in modo che il 
nome non appaia in parentesi), quindi scegliere il suono desiderato dal menu suono. Si possono 
anche usare le frecce a destra del numero canale per cambiare direttamente il canale.

Usare uno strumento virtuale multi-canale senza un sound set
È possibile anche usare una libreria campione come EWQLSO senza un sound set (sebbene ciò 
impedisca a Sibelius di gestire automaticamente note keyswitch e altri dati d’automazione). 
Conoscendo le potenzialità della libreria di campioni e riuscendo a eseguire comodamente la pro-
grammazione extra a mano (es. aggiungere i messaggi ~Nx,y MIDI per le note keyswitch e il plug-
in Plug-in > Riproduzione > Aggiungi messaggi MIDI Control Change per i dati d’automazione) 
questo metodo può essere più o meno produttivo.

La procedura di configurazione è uguale a quella descritta in Usare uno strumento virtuale 
multi-canale con un sound set, fino al punto in cui appare l’interfaccia grafica del campi-
onatore e si caricano i programmi in ogni canale. Nella pagina Set di Suoni Manuali della finestra 
di dialogo Play > Dispositivi di Ingresso e Playback attivare l’opzione Usa Sound Set manuale: 
si noti che il menu Program è disabilitato (poiché non si ha un sound set).

Per fare in modo che Sibelius tenti di assegnare automaticamente ogni rigo al rispettivo canale, si 
deve scegliere il sound ID più adatto per ogni canale. Per esempio, avendo il suono di una sezione 
di violini caricato nel primo canale scegliere il sound ID strings.violin.ensemble; avendo invece 
un suono di oboe caricato nel secondo canale selezionare wind.oboes.oboe, e così via. Dopo aver 
scelto ogni sound ID cliccare Applica; al termine cliccare Chiudi.

Se invece si preferisce assegnare ogni rigo a mano, assicurarsi che sia attiva l’opzione Usa Sound 
Set manuale e che sia stato scelto il giusto numero di canali, quindi cliccare Salva e Chiudi. A 
questo punto, avviando la riproduzione molto probabilmente non si sentirà nulla, poiché Sibelius 
non sa qual’è il suono fornito da un determinato canale. Nel Mixer bisogna quindi scegliere esplici-
tamente il dispositivo da usare per ogni rigo (in modo che il nome del dispositivo non appaia in 
parentesi) e poi impostare il canale usando le frecce a destra del numero canale.

Usando una libreria di campioni senza sound set lo svantaggio maggiore è l’impossibilità di ripro-
durre percussioni non intonate (a meno che il programma di percussioni non intonate sia mappato 
allo stesso modo delle percussioni General MIDI). Per riprodurre altre percussioni non intonate, si 
deve creare un file sound set (almeno per quei programmi).

Usare uno strumento virtuale multi-canale con più programmi per canale
Alcuni campionatori permettono di configurare i banchi che consentono di accedere a più pro-
grammi sullo stesso canale (selezionabili con messaggi MIDI Program Change). È possibile, ad 
esempio, configurare diverse tecniche d’esecuzione per lo stesso strumento (per esempio, in un 

reference.book  Page 319  Wednesday, April 16, 2008  4:28 PM



4. Riproduzione & video

320

banco suoni di violino possono essere caricati programmi di archetto legato, staccato, tremolo e 
pizzicato, accessibili con i messaggi Program Change da 1 a 4).

Come in precedenza, si deve caricare a mano ogni banco direttamente nell’interfaccia grafica del 
campionatore.

Perché Sibelius assegni automaticamente la riproduzione ci sono due modi: avendo un file sound 
set, Sibelius non solo può assegnare automaticamente ogni rigo al giusto canale, ma anche sceg-
liere le varie tecniche esecutive; se non si ha un sound set è possibile scegliere il sound ID più 
adatto per il suono di base su ogni canale e poi usare espliciti messaggi MIDI nella partitura per 
cambiare le tecniche esecutive (es. ~P2 per l’archetto staccato).

(Un’osservazione sulla creazione di un sound set per un arrangiamento dei banchi: prima di iniz-
iare si deve decidere quale banco sarà caricato in un determinato canale del campionatore, in 
modo da realizzare la mascherina canale adeguata ad ogni programma. Nel nostro esempio, sup-
poniamo che il banco di violino sia caricato nel canale 3: significa che ogni programma di violino 
accessibile all’interno del banco deve anche avere un set di mascherina canale che consenta l’uso di 
questi programmi solo sul canale 3).

Per assegnare la riproduzione a mano assicurarsi che sia attiva l’opzione Use manual sound set e 
sia stato scelto il numero di canale più opportuno. Se i banchi richiedono la trasmissione di un 
messaggio Program Change specifico a inizio riproduzione (per garantire che sia selezionaro il 
programma di default) attivare l’opzione Send program change e impostare opportunamente il 
valore Program change.

A questo punto, si deve usare il Mixer per scegliere esplicitamente il dispositivo più adatto per ogni 
rigo (in modo che il suo nome non appaia in parentesi) e impostare il canale usando le frecce a 
destra del numero canale. Per passare ad altri programmi all’nterno dello stesso banco si devono 
inserire espliciti messaggi MIDI nella partitura.

Usare strumenti virtuali a singolo canale
Gli strumenti virtuali a singolo canale possono fornire un solo suono strumentale alla volta, ma 
per il resto funzionano in modo identico agli strumenti virtuali multi-canale.

Usando Vienna Symphonic Library, ad esempio, per costruire un ensemble si deve caricare un 
player di campione Vienna Instrument per ogni suono strumentale da utilizzare. Supponiamo di 
dover realizzare una configurazione di riproduzione che suoni un quartetto d’archi. Nella pagina 
Dispositivi Attivi della finestra di dialogo Play > Dispositivi di Ingresso e Playback, quindi, atti-
vare quattro istanze di VSL. Esse appariranno nell’elenco a destra come VSL, VSL (2), VSL (3) e 
VSL (4), perciò è meglio rinominarle (es. Violino 1, Violino 2, Viola, Cello). Impostare il sound 
set per ogni istanza di VSL al sound set più opportuno (es. VSL Special Edition).

Andare ora nella pagina Set di Suoni Manuali. Cliccare Mostra per aprire l’interfaccia grafica 
della Vienna Instrument e caricare il programma adeguato, quindi attivare l’opzione Usa Sound 
Set manuale, scegliere la rispettiva opzione dal menu Program e cliccare Applica. Ripetere 
questa procedura per le altre tre istanze di VSL, quindi cliccare Chiudi per completare la config-
urazione. Riproducendo la partitura Sibelius assegnerà automaticamente ogni rigo a un’istanza di 
VSL.
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Un altro esempio: si ha uno strumento virtuale con un bellissimo suono di piano (es. TruePianos) 
e lo si vuole usare insieme (ad esempio) a Kontakt Player 2. Per farlo creare una nuova configurazi-
one di riproduzione con una o più istanze di Kontakt Player 2 (ciascuna con il rispettivo sound set 
più opportuno) e attivare TruePianos. Nell’elenco Periferiche attive a destra impostare Sound set
su (nessuno), quindi selezionare la pagina Set di Suoni Manuali. Attivare l’opzione Usa Sound 
Set manuale e impostare un Sound ID adeguato (es. keyboard.piano.grand) quindi cliccare 
Applica. Andare nella pagina Suoni Preferiti, selezionare Tastiere > Piano > Grand dall’elenco 
gerarchico a sinistra, scegliere TruePianos dal menu prefer this device e cliccare Add per confer-
mare la propria scelta; infine cliccare Chiudi per completare la configurazione.

Riproducendo la partitura Sibelius userà TruePianos per tutti i pianoforti e Kontakt Player 2 per gli 
altri strumenti.

Usare i Soundfont con gli strumenti virtuali
I Soundfont sono raccolte di suoni campionati, di solito nei formati SF2 o DLS. Inizialmente desti-
nati a offrire un modo per cambiare i suoni sulle schede audio di alcuni costruttori, ora è possibile 
usare i Soundfont senza bisogno di avere una scheda audio specifica.

Molti Soundfont si possono scaricare da Internet; quelli più utili sono i banchi General MIDI com-
pleti (che in Sibelius non richiedono una configurazione speciale).

In Windows non c’è un supporto interno per i Soundfont, ma il modo più facile per usarli in Sibel-
ius è utilizzare uno strumento virtuale multi-canale che li possa caricare e riprodurre. Per esempio, 
sfz di RGC Audio (freeware, si può scaricare dal sito http://www.rgcaudio.com/sfz.htm) può 
caricare i Soundfont SF2 e DLS.

Mac OS X ha un supporto interno per i Soundfont; per usare un Soundfont in Mac OS X:

* Copiare il file .sf2 o .dls nella cartella /Library/Audio/Sound/Banks su hard-disk.
* Scegliere una configurazione di riproduzione con il DLSMusicDevice interno nell’elenco Active 

devices della finestra Play > Dispositivi di Ingresso e Playback (es. la configurazione standard 
Default di Sibelius).

* Aprire l’interfaccia grafica di DLSMusicDevice (es. dal Mixer) e scegliere il Soundfont desider-
ato dal menu Sound Bank.

Si può usare solamente un singolo banco di Soundfont in ogni istanza di DLSMusicDevice, ma è 
possibile attivare più istanze DLSMusicDevice nella finestra di dialogo Play > Dispositivi di 
Ingresso e Playback e poi impostarne ciascuna all’utilizzo di un Soundfont diverso.
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4.15 Messaggi MIDI

Solo per utenti esperti

b Dizionario di riproduzione 

Il MIDI è uno standard definito da una serie di costruttori diversi universalmente implementato e 
supportato; sembra troppo bello per essere vero, ed è così infatti, perché per capire esattamente 
come funziona il MIDI bisognerebbe sapere parlare Marziano!

I dispositivi MIDI (es. la scheda audio del computer o la tastiera MIDI) trasmettono e ricevono 
messaggi MIDI che sono costituiti da un byte di stato e uno o due byte dati. I byte MIDI possono 
avere un valore decimale 0-127; per essere indipendenti dal dispositivo, questi numeri (inclusi i 
cambi programma) partono sempre da 0, anche se il manuale del dispositivo MIDI inizia da 1.

I messaggi MIDI sono classificati come messaggi di canale, che influenzano un singolo canale (in 
Sibelius, ciò si riferisce al rigo al quale è attaccato il canale) o messaggi di sistema, che influenzano 
tutti i canali (in Sibelius, tutti i righi).

I messaggi di canale hanno la maggior parte dei dati musicali (es. quali note suonare, la loro 
durata, il suono da usare) mentre i messaggi di sistema sono usati per funzioni più tecniche (come 
la sincronizzazione con altri dispositivi MIDI).

Sibelius supporta tutti i messaggi MIDI (compresi Control Change, Pitch Bend, SYSEX, e così via).

Creare i messaggi MIDI in Sibelius
Sibelius legge quasi tutti i segni nella partitura e li trasforma automaticamente negli opportuni 
messaggi MIDI per la riproduzione (b Riproduzione) quindi, in genere, i messaggi MIDI 
s’inseriscono manualmente in Sibelius solo in casi molto particolari. Essi includono il cambio 
suono di un rigo a metà partitura (per esempio, quando un clarinettista doppia un sax nello stesso 
pezzo), oppure l’uso di un suono diverso per avere timbri diversi sullo stesso strumento (es. muto o 
non muto). Il metodo più sicuro per farlo è definire un termine nuovo nel dizionario di riproduzi-
one (b Dizionario di riproduzione).

Tuttavia, si può anche dire a Sibelius di trasmettere in ogni momento il messaggio MIDI desiderato 
digitandolo come testo con i semplici comandi di messaggio MIDI descritti in seguito.

Questi messaggi MIDI possono essere allegati al testo ordinario e sono nascosti, quindi per scriv-
ere 2° volta molto vibrato ~C1,90 (in una sezione ripetuta di musica, ad esempio), Sibelius 
resetta il controller 1 (modulazione) a zero per silenziare il rigo al punto esatto in cui sul tabulato 
appare la scritta 2° volta molto vibrato. Il messaggio ~C1,90 è nascosto automaticamente (e 
scompare completamente se non è attiva l’opzione Vista > Oggetti nascosti (è bene quindi atti-
varla prima di lavorare con i messaggi MIDI).

Per silenziare molti righi, naturalmente si può copiare la scritta 2° volta molto vibrato ~C1,90
con un Alt+clic o z-clic del mouse (per evitare di doverla riscrivere), oppure si può aggiungerla al 
menu scritte che si apre con un clic-destro (Windows) o Control-clic (Mac) e allo stesso tempo 
assegnargli un tasto di comando rapido– b Lavorare con i testi.
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Quando s’importa un file MIDI è possibile scegliere di avere tutti i messaggi MIDI presenti nel file 
scritti nella partitura; in tal caso, ogni Control Change ecc. appare come se fosse stato digitato.

È meglio usare il dizionario o i messaggi MIDI?
Molte situazioni si gestiscono meglio con la finestra di dialogo Play > Dizionario. Solo le regolazi-
oni più “esoteriche” richiedono i messaggi MIDI (di solito per sfruttare funzioni particolari di dis-
positivi specifici); sicuramente, se di desidera che la partitura sia riprodotta in modo accettabile da 
altri dispositivi, ove possibile è meglio evitare l’uso dei messaggi MIDI.

Sintassi
I messaggi MIDI si possono digitare nella partitura usando qualsiasi stile di testo del rigo (di solito 
Technique o Expression) e possono essere scritti da soli o inseriti alla fine di una qualsiasi altra 
scritta (es. “mute”).

I messaggi hanno la forma seguente: carattere ~ seguito da una singola lettera di comando e 
seguita a sua volta da uno o più numeri, in genere separati da virgole.

Per esempio: ~C64,127 

(il carattere ~ si chiama informalmente “linea curva” o “tilde,” ma il termine tecnico è twiddle).

Sebbene il sistema decimale (es. 0-127) sia il metodo più leggibile per specificare i valori, alcuni 
manuali dei dispositivi MIDI indicano in altri modi i valori dei messaggi MIDI, che si possono 
comunque inserire direttamente in Sibelius. I valori si specificano usando sette bit decimali pre-
ceduti dalla lettera b (es.b0111101) o esadecimali fino e 7F preceduti dalla lettera h (es. h5C). A 
A meno che non siate un computer, però, non c’è bisogno di pensarci troppo! 

Si noti che:

* I messaggi MIDI sono sensibili al maiuscolo/minuscolo (le lettere devono essere digitate maius-
cole o minuscole, come indicato) – ~C0,0 funziona, mentre ~c0,0 non funziona.

* Le cifre esadecimali (es. 5C) sono insensibili al maiuscolo/minuscolo, ma la lettera h che pre-
cede la cifra deve sempre essere scritta in minuscolo.

* Si possono scrivere più messaggi nello stesso frammento di testo, separati da uno spazio o Invio
(sulla tastiera principale) e con un solo “tilde” all’inizio (per esempio: ~P43 A65 C64,127).

* Se si desidera è possibile inserire spazi o Invii attorno a virgole e numeri.

È meglio disattivare l’opzione Transpose chord/note names in House Style > Modifica stili di 
testo per lo stile di testo scelto, in modo da evitare che la lettera maiuscola all’inizio dei messaggi 
MIDI (es. ~C) sia trasportata come se fosse un simbolo accordo – b Modifica stili di testo.

Messaggi di canale
I messaggi di canale si dividono in due tipi: messaggi di voce canale (con i dati musicali) e messaggi 
di modalità canale (definiscono come il dispositivo MIDI risponde ai dati musicali).

Vediamo ciascuno di questi messaggi canale:

Program e Bank Change
Un Program Change controlla il suono usato per suonare le note successive su un canale partico-
lare. Sibelius trasmette automaticamente il giusto Program Change per ogni rigo, come definito 
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nella finestra Finestra > Mixer quando inizia la riproduzione. Tuttavia, per cambiare a metà parti-
tura il suono utilizzato da un rigo, si può usare un messaggio Program Change.

Sibelius consente inoltre di cambiare Banco e Programma nello stesso messaggio MIDI; se il dis-
positivo di riproduzione supporta solo i suoni General MIDI, non c’è mai bisogno di usare insieme 
i messaggi Bank Change e Program Change; se però ha una vasta gamma di suoni (come General 
MIDI 2 o Roland JV-1080) si può prelevare un suono da un banco diverso.

Ci sono tre tipi di messaggi Program Change:

* Solo Program Change: ~P programma (es. ~P76).
* Program e Bank Change, trasmissione numero banco: ~P banco,programma (es. ~P24,76).
* Program e Bank Change, specificando MSB e LSB per il numero banco: ~P MSB,LSB,pro-

gramma (es. ~P64,2,36).

(Per una spiegazione di MSB e LSB, vedere Numeri Banco).

In tutti i casi, il valore programma presume che il dispositivo MIDI conti i numeri programma da 0 
invece che da 1 (b Nozioni MIDI). Se il dispositivo MIDI conta da 1, usare ~p al posto di ~P.

Con un messaggio in forma ~P banco,programma, è trasmesso solo LSB se il banco è inferiore a 
128; se il banco è superiore a 128, MSB e LSB sono trasmessi secondo la formula banco = (MSB x 
128) + LSB.

Con un messaggio in forma ~P MSB,LSB,programma, se si specifica un valore di –1 per MSB o 
LSB, quel byte non è trasmesso; ciò permette di specificare la trasmissione del solo MSB o LSB (per 
non trasmetterne nessuno usare un semplice Program Change).

Per sapere se il dispositivo MIDI conta da 0 o 1 e i valori MSB e LSB vedere il suo manuale. MSB e 
LSB possono anche essere elencati in Coarse e Fine o CC (Control Change) 0 e 32 rispettivamente.

Ciò è un pò difficile da capire quindi vediamo di spiegarlo con un paio di esempi:

Supponiamo di voler cambiare il suono di uno o due righi a metà partitura in quello del latrato di 
un cane usando il modulo sonoro Roland SC-88; il manuale SC-88 indica “Dog, PC = 124, CC00 = 
001.” I dispositivi Roland contano i numeri programma da 1, poiché i loro manuali indicano il 
primo suono GM (Acoustic Grand Piano) con il numero programma 1. SC-88 è peculiare poiché 
usa il dato LSB per cose particolari; lo usa infatti per stabilire se è utilizzata la modalità di compat-
ibilità Roland SC-55 (è quasi uguale a quella di SC-88 ma ha meno suoni disponibili). Per questo 
motivo LSB normalmente è a 0 e MSB determina il banco da usare.

Per cambiare il suono a metà partitura nel latrato del cane inserire ~p1,0,124, ~p128,124 o 
~P1,0,123 – ciascuno di questi messaggi fa esattamente la stessa cosa. Si può anche definire un 
termine nel dizionario di riproduzione che faccia la stessa cosa: aggiungere dog e specificare 
Value a 123 e Unit a128.

Diversamente, i dispositivi che usano lo standad XG di Yamaha mantengono MSB costante (a 0) e 
cambiano LSB secondo il tipo di variante del suono di base del banco 0 (es. LSB 1 = panned, 3 = 
stereo, ecc.); i numeri programma iniziano da 1. Per accedere al suono “PianoStr” (banco 40), una 
variante del suono di base del piano (banco 0 programma 1) usare ~p0,40,1.
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Numeri Banco
I numeri Banco sono calcolati da altri due numeri: il byte più significativo (MSB) e quello meno 
significativo LSB, chiamato talvolta Coarse e Fine o CC (Controller Change) 0 e 32, rispettiva-
mente. La formula per calcolare i numeri banco è (MSB x 128) + LSB. Questi valori sono forniti dal 
manuale del dispositivo MIDI. 
Per esempio, la documentazione MIDI del dispositivo potrebbe essere così:

Per calcolare il numero banco del Banco 2 nell’esempio sopra, quindi, la formula è (64 x 128) + 2, = 
numero banco 8194; è il numero da usare in un messaggio MIDI: ~P MSB,LSB,programma (vedere 
in precedenza).

Alcuni manuali indicano i numeri banco come valori singoli invece che MSB e LSB separati; in tal 
caso, non c’è bisogno della calcolatrice!

Control Change
I messaggi Control Change servono a controllare un’ampia gamma di funzioni in un dispositivo 
MIDI. Sebbene la funzione di ogni Control Change sia chiaramente definita, non tutti i dispositivi 
MIDI supportano ogni Control Change. Essi si dividono in gruppi:

* Control Change 0–31: dati provenienti da selettori, Mod Wheel, fader e pedali sul dispositivo 
MIDI (inclusi modulazione, volume, espressione, ecc.).

* Control Change 32–63: Trasmettono opzionalmente il dato LSB per i Control Change 0-31 ris-
pettivamente.

* Control Change 64–67: funzioni di selezione (cioè “on” o “off ”) come portamento, pedale sus-
tain, pedale damper (soft), ecc..

* Control Change 91–95: profondità o livello d’effetti come riverbero, chorus, ecc..
* Control Change 96–101: usati insieme ai Control Change 6 e 38 (Data Entry), possono essere 

usati per modificare i suoni.
* Control Change 121–127: messaggi di modalità canale (vedere Modalità canale).

La sintassi per i messaggi Control Change è: ~Cbyte1,byte2, dove byte1 è il numero di Control 
Change (da 0 a 127) e byte2 è il valore del controllo (da 0 a 127). 

Per i dettagli completi sui messaggi Control Change supportati dal dispositivo MIDI, vedere il 
manuale del costruttore.

I messaggi Control Change usati più comunemente sono:

Pitch Bend
In genere consente di cambiare l’altezza di una nota alzandola o abbassandola fino a uno step 
intero (tono), sebbene ci siano un paio di modi per aumentare questo intervallo – vedere sotto.

La sintassi di Pitch Bend è: ~B0,bending di (es. ~B0,96).

Numero banco MSB LSB

Banco 0 64 0

Banco 1 64 1

Banco 2 64 2
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Bending di è un numero tra 0 e 127 ove ogni unità rappresenta 1/32 di mezzo step (semitono). 
~B0,64 genera una nota alla sua altezza scritta; valori inferiori a 64 fanno calare la nota e valori 
superiori a 64 la fanno crescere. Per far suonare una nota mezzo step (semitono) più acuta di come 
è scritta: ~B0,96; per farla suonare mezzo step (semitono) più grave: ~B0,32.

Questo Control Change si può usare (ad esempio) per riprodurre una nota diesis o bemolle senza 
aggiungere un’alterazione; per riprodurre un ficta – alterazioni editoriali sopra il rigo – si può 
inserire l’alterazione dalla finestra di dialogo Crea > Simbolo e poi usare un messaggio MIDI 
~B0,96 (ad esempio) per far suonare la nota un semitono diesis. Non dimenticarsi di usare 
~B0,64 per far tornare il canale alla sua intonazione originale sulla nota successiva! 
In realtà, questo è ciò che fa il plug-in Add Ficta Above Note – b Plug-in.

Si può anche usare il messaggio Pitch Bend di Control Change per creare un effetto di portamento
o glissando inserendo una serie di messaggi MIDI uno dopo l’altro. Il pitch bend non dura solo su 
una nota – rimane sempre, quindi in genere s’inserisce un pitch bend nella direzione opposta sulla 
nota successiva per tornare all’altezza normale.

Per un controllo di precisione sul pitch bend, si può cambiare il byte iniziale (anch’esso nell’inter-
vallo 0–127) per applicare leggere deviazioni (1/128 x 32 semitoni); per esempio, ~B127,64 fa 
crescere leggermente la nota scritta.

Per creare un effetto di pitch bend su un intervallo più ampio di uno step intero (tono), si può 
usare il Control Change portamento (vedere Control Change) per eseguire un pitch bend, 
oppure usare il metodo seguente:

* Innanzitutto, definire l’intervallo sul quale agisce il pitch bend: inserire i messaggi MIDI 
~C101,0 C100,0 C6,half-steps nella partitura, ove half-steps è l’intervallo totale di pitch bend in 
semitoni da 0 a 12. Per impostare un pitch bend dall’intervallo massimo di un’ottava, ad esempio, 
inserire il messaggio ~C6,12 (è meglio inserire questi messaggi a inizio partitura).

* Per aggiungere un pitch bend alla partitura inserire un comando ~B0,bending di come al solito, 
dividendo però il parametro bending di nel numero di semitoni definiti con il comando ~C6; 
per esempio, se è stato inserito ~C6,12, ogni semitono aggiunge o sottrae il valore 5.3 (64 diviso 
per 12) a bending di; per un bending crescente di quattro semitoni, quindi, bisognerà inserire 
~B0,85.

Questo metodo funziona se il dispositivo MIDI supporta lo standard “Registered Parameter Mes-
sages” (RPM) comune ma non universale; per usare altri RPM nella stessa partitura, ricordarsi di 
“chiudere” i parametri scrivendo ~C101,127 ~C100,127 dopo il messaggio ~C6,half-steps.

Aftertouch
L’Aftertouch è la pressione applicata quando, ad esempio, si preme un tasto sulla tastiera MIDI. 
Questa informazione può essere utilizzata per controllare alcuni aspetti del suono usato per la 
riproduzione (es. il vibrato in un suono di violino). L’effetto preciso di questo controller dipende 
dal dispositivo MIDI impiegato.

L’Aftertouch può essere applicato a una nota particolare (Aftertouch polifonico) o a tutte le note su 
un canale (Aftertouch di canale); nei dispositivi MIDI, l’Aftertouch polifonico non è implementato 
così diffusamente come l’Aftertouch di canale.
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La sintassi è la seguente:

* Aftertouch di canale: ~A pressione (es. ~A64).
* Aftertouch polifonico: ~a altezza,pressione (es. ~a60,64).

Modulation
Il messaggio Control Change 1 controlla l’oscillazione del vibrato generata da una Mod Wheel. 
Per avere molta oscillazione: ~C1,127; per non avere oscillazione: ~C1,0.

Breath
Il messaggio Control Change 2 è riconosciuto solo da alcuni dispositivi MIDI (come i sintetizzatori 
a fiato) e corrisponde alla “pressione del fiato” impiegata per suonare una nota.

Portamento
Il portamento è una “scivolata” omogenea da una nota a un’altra (simile al glissando suonato da un 
trombone). In realtà, questo effetto è controllato da due Control Change: ~C5,0–127 controlla la 
durata del portamento (0 il più veloce, 127 il più lento) e ~C84,0–127 determina la distanza del 
portamento (a valori sotto 60 inizia sotto la nota, a valori oltre 60 inizia sopra la nota; l’intervallo 
preciso dipende dal dispositivo MIDI).

Prima quindi si deve “configurare” l’effetto di portamento con un messaggio ~C5, poi attaccare il 
messaggio ~C84 alla nota sulla quale deve avvenire il portamento.

Questo Control Change non è supportato da tutti i dispositivi MIDI.

Volume
Il messaggio Control Change 7 determina il volume di una certa nota (per esempio, ~C7,127 è il 
volume più forte e ~C7,0 quello più debole).

Nel MIDI, volume non significa velocity. La velocity è definita quando si suona la nota (parte del 
messaggio NoteOn – vedere in seguito) ed è analoga, ad esempio, alla forza con la quale si colpisce 
una nota sul piano; i dispositivi MIDI più sofisticati suonano la stessa altezza con un timbro 
diverso in base alla velocity della nota. Il volume, invece, è come la manopola del volume generale 
su un amplificatore. Una tromba che suona una nota in fortissimo (cioè a velcity elevata) ma a 
basso volume suona comunque come una tromba che suona in fortissimo, ma con il volume 
abbassato.

I fader nella finestra di dialogo Finestra > Mixer cambiano il controller di volume che specifica il 
volume dei righi nella partitura. Si deve inserire manualmente questo messaggio MIDI nella parti-
tura solo per avere una variazione di dinamica nel corso della durata di una nota – il plug-in 
Cresc./Dim. Playback inserisce questi messaggi (b Plug-in).

Pan
Il messaggio Control Change 10 determina la posizione nel campo sonoro stereo di un particolare 
canale; per esempio, ~C10,0 è tutto a sinistra, ~C10,64 è al centro e ~C10,127 è tutto a destra.

Non è necessario usare questo messaggio MIDI, a meno che si debba modificare il pan di uno stru-
mento durante la riproduzione – la posizione pan iniziale è definita nella finestra di dialogo 
Finestra > Mixer.
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Expression
Il messaggio Control Change 11 preleva una frazione di volume del canale specificato dal control-
ler 7, quindi ~C11,127 usa il 100% del volume canale, ~C11,64 il 50%, e così via. Da un punto di 
vista funzionale, ~C7 agisce in modo simile a una manopola di volume e ~C11 è un modo per 
regolare temporaneamente il volume “principale”.

Sustain pedal
Sibelius genera automaticamente i messaggi MIDI per il pedale sustain se si usano le linee Ped. 
della finestra di dialogo Crea > Linea (b Linee). Tuttavia, per applicare il sustain alla riproduzi-
one della partitura senza usare queste linee, inserire il messaggio ~C64,127. Per disattivare di 
nuovo il pedale: ~C64,0. Su alcuni dispositivi MIDI valori tra 0 e 127 generano un mezzo pedale.

Soft pedal
Il messaggio Control Change 67 simula l’uso del pedale a una corda (sinistra) di un piano: per atti-
vare il soft pedal usare ~C67,127; per disattivarlo usare ~C67,0; questo Control Change non fun-
ziona su tutti i dispositivi MIDI.

Modalità canale
Probabilmente non si useranno mai i Control Change 121–127 in Sibelius, ma se si usassero:

* ~C121: resetta tutti i controller.
* ~C122: Local Control on/off.
* ~C124–127: modalità Omni on/off, modalità Mono/Poly.

NoteOn/NoteOff
Questi messaggi controllano quale nota è suonata, quanto è forte e quanto dura. In Sibelius non è 
mai necessario usare questi messaggi perché si possono riprodurre le note semplicemente inseren-
dole (ed eventualmente nascondendole).

Tuttavia, per ragioni di completezza, essi si possono inserire nella forma ~Nnota,velocity per 
NoteOn e ~Onota,velocity per NoteOff; si deve inserire un messaggio NoteOff, altrimenti la nota 
suona all’infinito!

Nota è il numero di tasto MIDI (es. 60 è il DO centrale) e velocity è un valore tra 0 e 127 (127 è il 
più forte). Molti dispositivi MIDI ignorano la velocity NoteOff, ma alcuni la interpretano come la 
“rudezza” con la quale la nota è stata rilasciata; nel dubbio usare il valore 64, ad esempio.

Messaggi di sistema
Non hanno bisogno di un canale, quindi il rigo al quale sono attaccati determina solamente il dis-
positivo MIDI al quale sono trasmessi.

I messaggi di sistema si dividono in tre tipi: system common, system real-time e System Exclusive. In 
genere solo gli ultimi due sono utili in Sibelius – il primo tipo riguarda principalmente la sin-
cronizzazione MIDI con componenti MIDI basati sul clock. In Sibelius, al momento non è quindi 
possibile entrare nei messaggi system common .

I messaggi System Exclusive si usano per trasmettere dati specifici per il particolare dispositivo 
MIDI che si sta utilizzando e possono variare da un dispositivo all’altro.
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Per inserire messaggi di sistema nella partitura: 

* System Exclusive: ~X byte es. ~Xh40, h00, hf7. Normalmente per chiudere un messaggio Sys-
tem Exclusive si scrive hf7 (a meno che lo si continui con un comando D contenente più dati).

* Dati di continuazione System Exclusive (senza alcun byte “comando”): ~D byte es. ~Dh40, h00, 
h7f.

* System real-time: ~S byte. Questi messaggi sono utili per sincronizzare la riproduzione di Sibel-
ius con altri sequencer o campionatori. I tre comandi più utili sono: ~ShFA (start sequencer), 
~ShFB (continua/pausa sequencer) e ~ShFC (stop sequencer).

Nascondere i messaggi MIDI
Qualsiasi testo che inizia con un “tilde” (~) è automaticamente nascosto da Sibelius, quindi non c’è 
da preoccuparsi di nascondere i singoli messaggi MIDI. Solo il carattere ~ e i messaggi dopo di 
esso sono nascosti, quindi si possono comunque leggere le istruzioni precedenti destinate ai player 
(come “mute” che è fatto per essere visibile). Quando si modifica il testo, il messaggio ~ riappare.

Se è attiva l’opzione Vista > Oggetti nascosti (comando rapido Ctrl+Alt+H o zXH) i messaggi 
MIDI sono visualizzati in grigio.

Ulteriori informazioni
Se questo capitolo non ha esaurito il desiderio di conoscenza riguardo a stringhe di lettere e 
numeri è possibile trovare più informazioni sui messaggi MIDI sul sito http://www.harmony-
central.com/MIDI/.
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4.16 SoundWorld™

Solo per utenti esperti.

SoundWorld è un nuovo standard sviluppato da Sibelius Software per nominare e classificare i 
timbri dei suoni. Esso sostituisce i confusi mosaici di numeri patch e nomi (spesso criptici) usati 
da tastiere MIDI, moduli sonori e librerie sonore per indicare i suoni. È possibile invece scegliere i 
suoni desiderati usando semplici nomi standardizzati. Poiché i nomi sono indipendenti da un par-
ticolare dispositivo di riproduzione, Sibelius può suonare una partitura che in origine è stata creata 
per dispositivi diversi da quelli presenti nel sistema. Inoltre, se un suono non è disponibile nella 
configurazione di registrazione corrente, Sibelius trova intelligentemente il suono alternativo 
migliore; può anche riprodurre tecniche strumentali (es. legature e accenti) usando suoni speciali, 
se disponibili, invece di approssimarle cambiando durata o volume delle note.

Questo capitolo spiega quindi come funziona SoundWorld; non è indispensabile capirlo per usare 
Sibelius, ma può essere ugualmente un argomento interessante.

Sound ID, SoundWorld e sound set
SoundWorld identifica ogni suono usando un nome strutturato denominato sound ID; per esem-
pio, woodwind.flutes.flute, woodwind.flutes.piccolo.flutter-tongue o strings.violin.ensem-
ble.pizzicato. Si noti che, in generale, ogni sound ID inizia con un nome di famiglia strumentale, 
quindi il nome strumento seguito talvolta da tecniche esecutive specifiche per tale strumento.

Un SoundWorld è una raccolta di sound ID organizzata in una struttura ad albero. Il SoundWorld 
specifico usato da Sibelius si chiama Sibelius Standard SoundWorld (S3W); è un elenco abbastanza 
completo di suoni disponibili sulle principali librerie sonore e dispositivi MIDI. 
Man mano che sono disponibili ulteriori suoni, vengono aggiunti a S3W nuovi sound ID.

Per riprodurre un particolare sound ID, Sibelius deve sapere quali sono i suoni disponibili sui vari 
dispositivi di riproduzione. Per saperlo, Sibelius ha per ogni dispositivo un sound set, un file XML 
con tutti i sound ID che un dispositivo può riprodurre e i messaggi MIDI (es. Program Change, 
Controller Change e keyswitch) necessari a riprodurli. Un sound set elenca anche altre funzioni del 
dispositivo: la quantità di suoni che può riprodurre simultaneamente e se essi si trovano su canali 
speciali (per esempio, le percussioni solo sul canale 10 nei dispositivi General MIDI).

Dove appaiono in Sibelius i sound ID?
In Sibelius i sound ID appaiono ovunque si specificano i suoni. Ad esempio:

* Ogni strumento ha un sound ID preferito (che si può cambiare nella finestra House Style >
Modifica strumenti e ensemble).

* Il Mixer mostra il sound ID di ogni rigo nella partitura.
* Ogni testa nota su un rigo percussivo ha sound ID preferito (che si può cambiare modificando lo 

strumento).
* I sound ID descrivono tutte le tecniche d’esecuzione e le articolazioni degli strumenti (che si pos-

sono cambiare in Play > Dizionario).
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Come sceglie Sibelius il sound ID da usare?
Per riprodurre un rigo, Sibelius parte con il suo sound ID iniziale (indicato nel Mixer): per esem-
pio, di default un solo di violino inizia con il sound ID strings.violin. I segni nella partitura, come 
articolazioni, legature, istruzioni di testo per tecniche d’esecuzioni specifiche come pizz., ecc., 
modificano tutte il sound ID, aggiungendo o sottraendo elementi da esso. Queste modifiche sono 
specificate nel dizionario di riproduzione. Nell’esempio che segue, le modifiche al sound ID si tro-
vano sopra il rigo e il sound ID risultante appare sotto il rigo:

Sibelius ha ora i sound ID che generano la riproduzione ideale. Tuttavia, capita spesso che un 
sound ID non sia disponibile per la riproduzione, perché il suono non è presente in alcun disposi-
tivo di riproduzione o non vi sono sufficienti slot o canali disponibili a riprodurre ogni sound ID 
richiesto; Sibelius deve quindi trovare il suono alternativo migliore in base alle limitazioni.

Per esempio, si supponga che Sibelius debba riprodurre il sound ID strings.violin.staccato.mute
(come indicato sopra) ma il suono non sia presente; per trovare il sound ID alternativo migliore, 
Sibelius usa una regola di sostituzione che dipende interamente dalla struttura ad albero dei sound 
ID in SoundWorld. Considera, ad esempio, che strings.violin.staccato.mute è un suono di vio-
lino staccato (figlio di strings.violin.staccato) che a sua volta è un suono di violino (figlio di 
strings.violin); la regola vale anche per l’ordine di priorità tra suoni simili (es. strings.violin e 
strings.viola).

Iniziando quindi da strings.violin.staccato.mute non disponibile, Sibelius cerca prima di trovare 
il relativo sound ID discendente disponibile, ossia il primo figlio (che potrebbe essere strings.vio-
lin.staccato.mute.stradivarius), quindi il primo figlio di tale sound ID; se trova un sound ID 
senza figlio, Sibelius prova invece con il primo simile e il relativo figlio. Se non ci sono sound ID 
discendenti dell’originale, prova con il genitore (in questo caso, strings.violin.staccato), seguito 
dal primo figlio del genitore e altri discendenti allo stesso modo; poi eventualmente il nonno 
strings.violin e così via, finché non trova il primo suono che può essere riprodotto. S3W è stato 
studiato in modo da ottenere l’approssimazione più fedele possibile al suono originale.

Struttura ad albero del sound ID
Perché il sound ID che si cerca è chiamato strings.violin.staccato.mute e non strings.vio-
lin.mute.staccato? Per una buona sostituzione, una convenzione seguita da S3W è che le diverse 
tecniche d’esecuzione seguono un ordine specifico discendente di priorità nel sound ID:
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* Qualità Macro (es. pizzicato, pizzicato.snap, pizzicato.secco, bisbigliando, col legno, rul-
lanti on, rullanti off, ecc.).

* Ensemble (la presenza dell’elemento ensemble indica che il suono fa parte di un’ensemble; la 
sua assenza significa che è un suono solista).

* Durata (es. staccato, staccato.wedge, staccato.detaché, spiccato, portato, legato).
* Attacco/dinamiche (es. accent, crescendo, diminuendo, fortepiano, sforzato, 

sforzato.sforzatissimo, non vibrato, vibrato, ecc.).
* Qualità Micro (es. sul tasto, sul ponte, sul tasto.flautando, mute, mute.harmon, 

mute.cup, mute.straight, aperto, ecc.).
* Ornamento (es. trillo, tremolo, mordente, turn, flutter-tongue, glissando, scoop, fall, ecc.).
* Musicisti (es. 2 musicisti è un suono ensemble formato da un numero specifico di musicisti).
* Velocità di ripetizione (es. lento, veloce)
* Modificatore di durata (es. lunga, corta)
* Variante n (es. strings.violins.violin.solo.1 e strings.violins.violin.solo.2, per suoni quasi 

identici che però hanno bisogno di un sound ID peculiare).

Gli elementi di durata (come uno staccato) sono quindi più importanti di quelli della qualità 
Micro (come mute) e sono elencati prima nel sound ID. Ciò significa che quando Sibelius deve 
trovare un sostituto per strings.violin.staccato.mute, troverà strings.violin.staccato prima di 
strings.violin.mute; se sono disponibili entrambi sceglierà il primo, poiché è un sostituto 
migliore.

Inoltre, le tecniche in ogni gruppo di elementi elencati sopra sono trattate secondo principi di 
mutua esclusività: se un rigo utilizza un strings.violin.pizzicato e arriva a un’istruzione di testo 
“col legno”, Sibelius sa che deve sostituire l’elemento pizzicato con uno col legno (invece di 
aggiungere col legno alla fine) producendo strings.violin.col legno (non strings.violin.pizzi-
cato.col legno).
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5.1 Arrange™

b Modificare gli stili Arrange.

v Arrange.

Arrange™ è una funzione destinata ad aiutare gli studenti nell’arrangiamento e orchestrazione e far 
risparmiare tempo ai professionisti che sanno già cosa fare.

Essa copia in modo intelligente la musica da un qualsiasi numero di righi in un altro numero di 
righi decidendo (se necessario) quali strumenti usare; si può impiegare per riduzioni di piano e 
per “distribuire” gli accordi su più righi. L’azione più importante di questa sofisticata funzione, tut-
tavia, è aiutare l’utente ad arrangiare e orchestrare un’ampia gamma di stili ed ensemble musicali, 
dalla musica corale, alla banda, alle partiture orchestrali.

Si può essere più o meno specifici su ciò che si desidera arrangiare. Per esempio, se già si 
conoscono gli strumenti da usare, si può utilizzare la funzione Arrange semplicemente come un 
metodo rapido per copiare la musica (distribuire intelligentemente gli accordi tra gli ottoni, ad 
esempio); anche studenti e altri soggetti possono usare i numerosi stili Arrange già pronti per sper-
imentare con arrangiamento e orchestrazione ad ogni livello.

Riassunto
Arrange, in realtà, è un tipo particolare di operazione copia e incolla:

* Copiare la musica da arrangiare sugli Appunti con Modifica > Copia (Ctrl+C o XC). È impor-
tante che il materiale sorgente usi un numero costante di voci (cioè tutto in una voce oppure 
tutto in due voci, ma non una e due voci alternate in misure diverse). Non copiare righi di per-
cussioni non intonate, poiché Arrange gestisce solo materiale intonato.

* Selezionare i righi nei quali incollare la musica risultante, nella stessa partitura o in un’altra. Non 
è necessario selezionare il giusto numero di misure nei righi di destinazione – basta selezionare 
una singola misura.
Per arrangiare un passaggio che inizia a metà misura creare le opportune pause in tutti i righi di 
destinazione, in modo da selezionare il punto preciso al quale incollare la musica arrangiata.
Selezionando un intervallo di righi adiacenti con Maius-clic, Arrange eseguirà l’arrangiamento 
anche nei righi nascosti che si potrebbero trovare nell’intervallo; se non è ciò che si desidera, 
selezionare uno ad uno i righi da arrangiare con Ctrl+clic o X-clic.

* Selezionare Note > Arrange (comando rapido Ctrl+Maius+V o xXV).
* Si apre la finestra di dialogo Stili di Arrangiamento; scegliere lo stile desiderato dall’elenco a 

tendina e cliccare su OK.

Appare una barra di avanzamento e in pochi secondi Sibelius completa l’arrangiamento, sceg-
liendo la musica più adatta ai vari strumenti e trasportandola in ottave, se ciò è necessario per sod-
disfare le varie estensioni musicali.

reference.book  Page 335  Wednesday, April 16, 2008  4:28 PM



5. Funzioni efficaci

336

Se non è già stato fatto, provare la funzione Arrange aprendo la partitura d’esempio Arrange nella 
cartella Other all’interno della cartella Scores e seguendo le istruzioni in cima alla partitura. 
Ciò consente di capire che cosa può fare la funzione Arrange.

Questo è solo un breve riassunto della funzione Arrange – proseguire nella lettura per capire le 
varie modalità d’uso di questa funzione prima di provarla nella pratica.

Usare Arrange in modo musicale
Come la composizione anche arrangiamento e orchestrazione sono capacità musicali avanzate che 
richiedono inevitabilmente un coinvolgimento umano. La funzione Arrange, quindi, non è desti-
nata a produrre da sola un risultato finito; ciò dipende dall’utente:

* Scegliere accuratamente il passaggio d’arrangiare – in generale è meglio una frase o meno (altri 
dettagli in seguito). Non si devono arrangiare subito tutti i righi – si può arrangiare la mano 
destra di un pezzo di piano per i legni e quella sinistra per gli archi, se si sa cosa si vuole.

* Si consideri l’adattamento della sorgente musicale prima dell’arrangiamento, per renderla più 
adatta agli strumenti utilizzati – la funzione Arrange non altera mai il materiale di base, quindi 
ciò che va bene per un piano potrebbe non andar bene per l’arrangiamento dei legni o di una 
sezione d’archi senza adattamento. Vedere Preparare la musica da arrangiare per indicazi-
oni su come migliorare il materiale di base e Dopo aver arrangiato la musica per alcuni 
consigli su cosa fare dopo l’arrangiamento.

* Scegliere attentamente lo stile Arrange e i righi da selezionare; gli stili Arrange utilizzati per 
ensemble diverse sono descritti in seguito; se l’arrangiamento non piace, selezionare Modifica >
Annulla e riprovare con uno stile Arrange diverso e/o altri righi selezionati.

* La variazione dello stile Arrange e dei righi selezionati spesso producono un arrangiamento 
interessante – non arrangiare sempre subito tutti gli strumenti!

* Si può anche modificare opportunamente il risultato della funzione Arrange, regolando le 
ottave, ad esempio, oppure applicando tecniche d’orchestrazione come un “incastro” musicale da 
uno strumento all’altro.

È importante capire che la funzione Arrange mantiene la stessa strumentazione e intonazione in 
tutto il passaggio che s’arrangia – ad esempio, se una linea di note inizia molto acuta e poi diventa 
molto grave o viceversa, Sibelius non la “incastra” da uno strumento all’altro, né modifica il pas-
saggio d’ottava a metà; la funzione Arrange, tuttavia, cambia la strumentazione tra ogni passaggio 
che s’arrangia se vede che la cosa funziona.

Per questo motivo, in generale non s’arrangia più di una frase musicale alla volta, altrimenti alcuni 
strumenti potrebbero essere obbligati a suonare intervalli di note difficoltosi o non suonabili. 
Arrangiando brevi passaggi si permette a Sibelius di cambiare strumentazione e intonazione, per 
lasciare la musica nell’estensione adatta ai vari strumenti (oltre che mantenere interessante l’arran-
giamento). Sibelius avvisa se il passaggio che s’arrangia tende a essere troppo lungo.

Come arrangia la funzione Arrange
Nello specifico (tranne gli stili speciali Espandi e Riduzione descritti in seguito) la funzione 
Arrange agisce in questo modo:
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* Sceglie gli strumenti opportuni da arrangiare dai righi di destinazione selezionati. In generale, 
sono usati molti o tutti i righi selezionati, a meno che lo stile Arrange sia destinato a strumenti 
specifici (es. gli stili Famiglia e Ensemble Misto descritti in seguito); in tal caso, tutti gli altri 
sono ignorati.

* Sibelius suddivide la musica tra gli strumenti (in generale, con una singola linea di note per rigo, 
se possibile).

* Parte della musica può essere trasportata di ottave per entrare nell’estensione di uno strumento o 
dare un certo “colore” ai suoni. (È possibile definire intervalli suonabili, i quali influiscono sul 
modo in cui Sibelius arrangia la musica – b Strumenti).

* Sibelius può inserire materiale diverso su tipi di strumento diversi (es. musica veloce sui legni o 
musica lenta sugli archi), dipende dallo Arrange che si sceglie. In particolare, ci sono gli stili 
Sezione e Misto per l’orchestrazione (vedere in seguito).

* Sibelius può orchestrare usando opportuni raddoppi di strumento (es. un piccolo all’ottava sopra 
il flauto); anche questo dipende dallo stile Arrange.

A parte suddividerla e trasportarla, la funzione Arrange non cambia la musica sorgente.

Stili Arrange
Il modo preciso con il quale Sibelius arrangia la musica è determinato dallo stile Arrange. Esso 
specifica quali strumenti usare, i raddoppi strumentali e il materiale assegnato ai vari strumenti.

È fornito un ampio elenco di oltre 130 stili Arrange e se ne possono creare anche di propri 
(b Modificare gli stili Arrange). In pratica, gli stili comprendono operazioni d’espansione e 
riduzione, oltre ad arrangiamento/orchestrazione per una vasta gamma d’ensemble, dai cori alle 
bande.

I nomi degli stili Arrange sono organizzati come segue:

* Innanzitutto, specificano il tipo d’ensemble o strumenti che arrangiano (es. Orchestra, Banda, 
1 Famiglia: Ottoni);

* In secondo luogo, indicano lo stile particolare d’arrangiamento (es. Impressionista o Film);
* Terzo, specificano determinati strumenti inclusi od omessi (es. Senza trombe o solo legni e 

archi);
* Quarto, lo stato di alcuni stili, cioè se usano un’orchestrazione Sezione o Mista (vedere sotto).

Ogni stile Arrange ha anche una descrizione più dettagliata nella parte destra della finestra di dial-
ogo Arrange quando si seleziona lo stile; essa fornisce utili informazioni e consigli su cosa fa lo stile 
e il modo migliore di usarlo.

Stili Block e Mixed
Gli stili Arrange per l’orchestrazione sono di due tipi: Sezione e Misto.

* Sezione colloca materiale musicale diverso su famiglie di strumenti diverse. Il materiale è sud-
diviso in base alla sua velocità – in un arrangiamento orchestrale, ad esempio, i legni potrebbero 
suonare la musica più veloce e gli ottoni quella più lenta. In generale, la melodia è più veloce 
dell’accompagnamento (ma non sempre è così).
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In molti casi ci sono due stili per le stesse famiglie (ad esempio, una con i legni per la musica più 
veloce e una alternativa sempre di legni per la musica più lenta).

* Gli stili Misto consentono agli strumenti in famiglie diverse di doppiarsi a vicenda, quindi stru-
menti dall’estensione simile (come violini e flauti) suonano lo stesso materiale.

Se non è specificato Sezione o Misto, lo stile Arrange genera un’orchestrazione di tipo Misto.

Espandi
Per “scomporre” gli accordi (cioè separare le note) in un numero superiore di righi:

* Selezionare il materiale da scomporre (può essere in uno o più righi) e copiarlo sugli Appunti 
scegliendo Modifica > Copia (comando rapido Ctrl+C o XC).

* Selezionare i righi sui quali distribuire il materiale (da qualche altra parte nella stessa partitura o 
in un’altra partitura). Selezionare Note > Arrange (comando rapido Ctrl+Maius+V o xXV).

* Selezionare lo stile Arrange Espandi e cliccare su OK; Sibelius scompone immediatamente la 
musica sui righi di destinazione.

Se ci sono meno righi di note, Sibelius colloca due note su un rigo in voci separate; se in seguito si 
vogliono unire queste due voci in accordi su una singola voce, selezionare il passaggio e scegliere 
(ad esempio) Modifica > Voce > 1 (comando rapido Alt+1 o z1).

Sibelius trasporta anche le note in ottave, se necessario, in modo da renderle suonabili sugli stru-
menti di destinazione.

Scomponendo un passaggio lungo, Sibelius può generare il messaggio d’avviso “Si consiglia di 
arrangiare poche misure alla volta”: ignorarlo e cliccare su Sì.

Se si sta scomponendo la musica da un singolo rigo su un massimo di quattro righi e si desidera un 
controllo maggiore su come Sibelius distribuisce precisamente la musica in ogni rigo di destinazi-
one (in particolare se non si vuole che la musica sia trasportata in ottave) usare il plug-in Plug-in >
Tool di composizione > Scomponi – vedere Explode a pagina 399.

Riduzione
Per ridurre la musica da più righi a un numero di righi inferiore (“implosione”):

* Selezionare il materiale da ridurre e copiarlo sugli Appunti con Modifica > Copia (Ctrl+C o
XC).
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* Selezionare i righi sui quali inserire il materiale ridotto (da qualche altra parte nella stessa parti-
tura o in un’altra partitura) e scegliere Note > Arrange (Ctrl+Maius+V o xXV).

* Scegliere uno degli stili Arrange Riduzione e cliccare su OK.

Ci sono vari stili Riduzione destinati ad impieghi leggermente diversi; leggere la descrizione di 
ogni stile per sapere qual è quello più adatto al risultato desiderato.

Per una riduzione di tastiera lo stile ideale dipende dalla complessità del materiale sorgente. Nella 
maggior parte dei casi può andar bene lo stile Riduzione per tastiera: fino a 2 voci per rigo, ma 
se la riduzione risultante è troppo complessa provare con lo stile 1 voce per rigo; è bene anche 
considerare se vale la pena omettere eventuali righi nel passaggio sorgente che sarebbero troppo 
difficili da suonare su una tastiera.

Riducendo un passaggio lungo, Sibelius può generare il messaggio d’avviso “Si consiglia di arran-
giare poche misure alla volta”: ignorarlo e cliccare su Sì.

Dopo aver usato uno degli stili Riduzione, ci si può trovare con una serie di segni dinamici dupli-
cati uno sopra l’altro nella musica risultante (perché erano su righi sorgente separati); selezionare 
la musica come passaggio e scegliere Modifica > Filtro > Dinamiche (comando rapido 
Maius+Alt+D o xzD), quindi premere Canc per rimuoverli. (In rari casi, dopo una riduzione 
potrebbero apparire anche legature superflue; in tal caso, usare i filtri per rimuoverle).

Se la musica da ridurre contiene terzine o altri gruppi irregolari (oppure si vuole avere un controllo 
maggiore su come Sibelius riduce la musica) usare il plug-in Plug-in > Tool di composizione  >
Riduci – vedere Reduce a pagina 402.

Arrangiare famiglie di strumenti
Gli stili 1 Famiglia e 2 Famiglie arrangiano solo gli strumenti specificati nel nome dello stile – è 
possibile, ad esempio, scegliere tutti i righi in una partitura orchestrale o bandistica e poi usare lo 
stile Arrange 1 Famiglia: Legni; la musica sarà arrangiata solo per i legni. Tuttavia, selezionando 
tutti i righi dei legni tranne i flauti, ad esempio, i flauti non saranno usati.

Questi stili sono adatti anche per arrangiare musica di ensemble più piccole (es. quartetti di fiati, 
quintetti d’ottoni, orchestre d’archi).

Gli stili 2 Famiglie sono presenti in entrambe le configurazioni Sezione e Misto, per offrire 
diversi colori e sfumature timbriche.

Arrangiare l’orchestra
Gli stili Orchestra sono raggruppati in base allo stile musicale; ci sono vari stili musicali, da 
Barocco a Moderna, da Impressionista a Film.

La maggior parte degli stili Orchestra generano “tutti” se si selezionano tutti i righi, sebbene si 
possa selezionare un numero qualsiasi di righi di destinazione; quindi, selezionando solamente i 
righi flauto, clarinetto e viola come passaggio di destinazione, ad esempio, solo quegli strumenti 
saranno usati dalla funzione Arrange. Per evitare di avere un’orchestrazione “tutti”, si raccomanda 
di variare i righi che si selezionano e gli stili Arrange che si usano!

Per l’orchestra si possono usare anche altri stili, come Famiglia e Ensemble Mista, poiché utiliz-
zano gruppi più ridotti di strumenti per generare particolari effetti di colore. Usando questi stili 
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non è necessario selezionare particolari righi – si possono selezionare tutti e lo stile userà solo gli 
strumenti ai quali è destinato. Leggere attentamente la descrizione di ogni stile Arrange per sapere 
quali strumenti usa.

Provare anche alcuni degli stili più “esotici” – si possono ottenere risultati molto interessanti con 
gli strumenti più insoliti.

Nessuno degli stili comprende percussioni non intonate, sebbene alcuni stili utilizzino strumenti 
percussivi intonati per aggiungere colore (es. i timpani negli stili Romantic e le percussioni con le 
mazze negli stili Modern); naturalmente, si possono omettere percussioni intonate non selezio-
nando alcun rigo di destinazione con percussioni intonate.

Arrangiare una banda
Gli stili Banda sono ugualmente adatti a bande di fiati, bande da concerto, bande sinfoniche, 
bande scolastiche, marching band e bande militari. Leggere le descrizioni: alcuni stili generano 
“tutti” e alcuni usano combinazioni con meno strumenti; molti degli stili includono percussioni 
con le mazze, ma gli strumenti percussivi non intonati non ci sono.

Gli stili Brass Band, come indica il nome, servono per arrangiare le band d’ottoni standard.

Leggere Arrangiare l’orchestra per consigli generali sugli strumenti e gli stili Arrange (inclusi 
gli stili Famiglia e Ensemble misto), così da ottenere l’arrangiamento più interessante possibile.

Arrangiare ensemble miste
Gli stili Ensemble misto sono previsti principalmente per orchestrazioni già pronte da usare con 
orchestra, banda ad altre grandi ensemble; usano pochi strumenti. Come per gli stili Famiglia, 
usarli come variante, per evitare di arrangiare sempre tutti gli strumenti!

Arrangiare i cori
Gli stili Coro offrono vari effetti corali standard, come i soprani doppiati dai tenori in ottava o la 
melodia di una delle voci principali con altre che provvedono all’accompagnamento, e così via. 
Gli stili possono essere usati per arrangiare qualsiasi combinazione di voci, quindi è possibile 
creare arrangiamenti per cori SSAA o TBB con la stessa facilità di quelli SATB.

Per realizzare una riduzione per piano da musica corale basta usare lo stile Arrange Riduzione per 
tastiera appropriato.

Arrangiare le ensemble jazz
Ci sono vari stili Jazz per una grande varietà di ensemble, inclusi i quintetti (utilizzabili anche per 
arrangiare quartetto e trio), big band e jazz band tradizionali; gli stili Famiglia sono adatti anche 
per big band e jazz band. Anche qui è bene variare stile e righi selezionati, per ottenere un arran-
giamento interessante.

Arrangiare ensemble rock e pop
Gli stili Rock e Pop includono combinazioni chitarra/basso/tastiere (sebbene non arrangino le 
batterie); provare gli stili che includono l’orchestra!
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Arrangiare strumenti solisti
Gli stili Solo con accompagnamento assegnano la melodia a uno strumento solista e la musica 
rimanente ad altri strumenti. Per usare gli stili, si devono selezionare gli strumenti d’accompagna-
mento specificati dallo stile stesso (chitarra, arpa, tastiera o archi) selezionando anche il rigo dello 
strumento solista. Si può selezionare più di un rigo di strumento solista (es. Flauto e Clarinetto); in 
tal caso, essi finiranno col raddoppiarsi a vicenda.

I normali stili Solo sono un metodo rapido per assegnare la melodia al singolo strumento specifi-
cato. La musica d’accompagnamento non è usata (e può essere arrangiata separatamente per altri 
strumenti usando altri stili Arrange).

Tutti questi stili presumono che la musica più veloce nel materiale sorgente sia la melodia (in gen-
erale è così, ma non sempre); se non lo è usare i filtri (ad esempio, per selezionare dalla sorgente 
musicale la linea di note più in alto). b Filtri e Trova. 

Arrangiare altre ensemble
Se l’ensemble da arrangiare non è in elenco (es. un sestetto di celli) scegliere lo stile Arrangia-
mento standard che offre buoni risultati per qualsiasi combinazione di strumenti.

Preparare la musica da arrangiare
Vale la pena impiegare un po’ di tempo a ottimizzare la musica prima di usare la funzione Arrange, 
in modo da migliorare il risultato dell’arrangiamento.

Sibelius non cambia la sorgente musicale (a parte il trasporto in ottave per adattarla agli strumenti 
di destinazione), quindi occorre eseguire tutte le regolazioni necessarie per adattarla agli stru-
menti sui quali si desidera arrangiarla. Sebbene si possa farlo dopo l’arrangiamento è meglio farlo 
prima, per non dovere eseguire le stesse modifiche su più strumenti; alcune cose da ricordare:

* Fare in modo che la sorgente musicale abbia un numero costante di voci su ogni rigo. Essa può 
cambiare il numero di voci tra diversi passaggi che si stanno arrangiando separatamente. 
Per esempio, in questo caso:

ove la Voce 2 è usata solo occasionalmente dalla mano destra separare le note in basso degli 
accordi in Voce 1 nella Voce 2. Per farlo, selezionare il passaggio influenzato (qui nel rigo superi-
ore), scegliere Modifica > Filtro > Nota iniziale e poi scambiare la musica nella Voce 2 selezio-
nando Modifica > Voce > 2 (comando rapido z2 o Alt+2); rimane questo:

Ciò garantisce che Sibelius inserirà la nuova linea di note della Voce 2 nello stesso strumento(i). 
Non facendolo, Sibelius prima visualizza un avviso e poi inserisce le due note originariamente in 
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Voce 2 in uno strumento separato con le pause a un lato; questo perché Sibelius vede la Voce 2 
distribuita in tutto il passaggio, quindi inserisce pause dove non ci sono note in Voce 2, per 
creare una “linea di note” continua.

* Gli stili Arrange come Orchestra: Barocco sono previsti per la musica di quel periodo – non si 
può far suonare Barocca la musica jazz semplicemente orchestrandola in strumenti Barocchi!

* È meglio suddividere la musica esistente su voci diverse, in modo d’adattarla meglio agli stru-
menti per i quali la si sta arrangiando. Per esempio, una figura di basso “oom-pah-pah” funziona 
meglio se “oom” dura per l’intera misura in Voce 2 (ad esempio) mentre gli accordi “pah-pah” 
sono in Voce 1:

* La funzione Arrange copia dinamiche e altri oggetti del rigo (simboli, linee, e così via) – ma non 
copia oggetti di sistema (come tonalità e tempi in chiave); se la musica che si sta arrangiando 
cambia tempo in chiave, si devono creare cambi di tempo in chiave nel punto di destinazione 
(preferibilmente prima che dopo l’arrangiamento).

* Cancellare gli oggetti inutili; per esempio, arrangiando musica di piano per strumenti a fiato 
cancellare tutte le linee pedale prima d’iniziare – ma non cancellare oggetti come segni dinamici, 
legature e trilli, i quali devono essere copiati nei righi di destinazione.

* Cancellare tutte le linee d’ottava (8va) nella partitura ed esplicitarle (in altre parole, trasportare la 
musica del numero d’ottave appropriato) prima di arrangiare; questo perché le linee d’ottava 
sono usate raramente dalla maggior parte degli strumenti non a tastiera e Sibelius ignora le linee 
d’ottava quando cerca di stabilire quali sono gli strumenti migliori per gli intervalli delle note.

* Se si ama l’avventura provare a usare l’opzione Modifica > Filtro > Filtro avanzato per selezion-
are (ad esempio) solo il primo movimento di ogni misura della sorgente musicale prima di 
arrangiare. Copiando solo parte della musica nel passaggio sorgente, si possono creare rapida-
mente semplici strutture d’accompagnamento.

Dopo aver arrangiato la musica
* La funzione Arrange cerca di mantenere la musica all’interno dell’estensione di ogni strumento, 

ma in alcuni casi ciò non è possibile: se quindi si finisce con l’avere alcune note fuori dall’esten-
sione dello strumento, le si possono “incastrare” in un altro strumento dall’estensione adeguata 
oppure cambiare l’ottava delle note fuori estensione.

* Se si ottengono molte note fuori estensione è probabile che si stia cercando d’arrangiare troppa 
musica alla volta. Provare ad arrangiare una frase musicale per volta, in modo da ridurre la 
“pulizia” da eseguire dopo l’arrangiamento. 
 

Voce singola Due voci

Prima dell’arrangiamento

Archi

Dopo l’arrangiamento
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* Se un rigo particolare ha bisogno di due voci, dopo l’arrangiamento si vedrà che Sibelius ha 
scritto la musica in due voci lungo tutto il passaggio di destinazione (anche se le voci sono quasi 
sempre all’unisono). La Voce 2 può essere interamente o parzialmente sopra la Voce 1, quindi 
può essere necessario scambiare le voci con il comando Modifica > Voce > Scambia 1 e 2
(comando rapido Maius-V). Se le voci sono all’unisono od omofone, è possibile visualizzarle più 
chiaramente unendo gran parte o tutta la musica di quel rigo in una singola voce; selezionare la 
musica come passaggio e scegliere Modifica > Voce > 1 (comando rapido Alt+1 o z1).

* Se arrangiando la musica alcuni strumenti finiscono per suonare materiale non adeguato (note 
gravi e veloci su un Corno, ad esempio) eseguire una funzione Annulla e arrangiare di nuovo, 
omettendo dalla selezione quegli strumenti (in modo che non siano usati) oppure arrangiare 
con uno stile diverso. Per esempio, con gli stili di 2 famiglie di strumenti in blocchi, ci sono ver-
sioni alternative previste (ad esempio) per gli ottoni che suonano le note più veloci o più lente.
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5.2 Modificare gli stili Arrange

b Arrange™.

Solo per utenti esperti.

Sibelius ha oltre 130 stili Arrange predefiniti; questo capitolo spiega come definire i propri.

Per creare stili Arrange efficaci, prima bisogna capire come lavora la funzione Arrange di Sibelius.

Come funziona
L’algoritmo Arrange di Sibelius è complesso, ma in pratica suddivide la musica selezionata in 
“linee di note” monofoniche, ciascuna costituita da singole note e pause; esse sono poi distribuite 
tra i righi di destinazione scelti, eventualmente trasportate in ottave, raddoppiando altri righi (in 
unisono o in ottave), oppure usando più voci, se necessario.

Sibelius determina le linee di note come segue:

* Ogni voce su ogni rigo contenente una o più note (o pause o misure di pausa) è trattata come 
una o più linea di note.

* Se i numeri di note nella voce non è costante (per esempio, se un passaggio in terze è seguito da 
un passaggio di note singole), Sibelius colloca le note più acute degli accordi in più linee rispetto 
alle note più gravi.

* Ogni linea di note include anche tutti gli oggetti attaccati al rispettivo rigo o voce, quindi tutte le 
note mantengono articolazioni, legature, tipi di teste nota, ecc., oltre a oggetti come testi e linee.

Queste linee di note sono poi organizzate in modo da riempire i righi di destinazione secondo lo 
stile Arrange selezionato; lo stile Arrange specifica “gruppi di strumenti” nei quali sarà arrangiata 
musica simile.

Si applicano i seguenti principi generali:

* Sibelius cerca d’inserire tutta la sorgente musicale nei righi selezionati; ciò può portare a molti 
raddoppi (se ci sono troppo poche linee di note per il numero di righi selezionato) o a molti righi 
con più voci (se ci sono troppe linee di note per il numero di righi selezionato).

* Sibelius assegna una linea di note solo a ogni gruppo, a meno che ci siano meno linee di gruppi – 
per esempio, in un caso estremo, se la sorgente musicale è costituita da una singola linea mono-
fonica che in seguito è arrangiata per un’orchestra completa, Sibelius non compone la musica per 
accompagnare la singola linea, ma semplicemente la duplica in tutti i righi.

* Sibelius regola l’altezza di ogni linea di note in modo da adattarla all’estensione dello strumento 
di destinazione. Opzionalmente, l’utente può anche specificare a Sibelius di “allungare” la sor-
gente musicale lungo un determinato intervallo di altezze – vedere in seguito.

Quando si arrangia, Sibelius ordina le linee di note in quattro modi principali determinati dallo 
stile Arrange:
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* Dalla più veloce alla più lenta: le linee di note con i valori nota più brevi della media sono asseg-
nate al primo gruppo di strumenti elencato (l’ultimo gruppo elencato ha le linee di note dai val-
ori nota medi più lunghi).

* Dalla più acuta alla più grave: le linee di note con l’altezza media più elevata sono assegnate al 
primo gruppo di strumenti elencato, ecc.

* Ricche (suonano la maggior parte della note): le linee di note più ricche di note sono assegnate al 
primo gruppo elencato e quelle con il minor numero di note all’ultimo gruppo elencato.

* Ricche (suonano la maggior parte del tempo): le linee di note che suonano più a lungo in proporz-
ione alla durata totale del materiale sorgente sono assegnate al primo gruppo di strumenti elen-
cato, ecc.

Modificare gli stili di arrangiamento
* Selezionare Note > Modifica stili Arrange:

% Per modificare uno stile esistente, selezionarlo dall’elenco a tendina e cliccare su Modifica.

% Per creare un nuovo stile selezionare quello più adatto sul quale basare il nuovo stile e cliccare 
su Nuovo.

* Si apre questa finestra di dialogo:

In cima alla finestra di dialogo si può modificare il nome (Nome) dello stile e inserirne una 
descrizione (Descrizione) se lo si desidera; la metà inferiore della finestra di dialogo elenca i 
gruppi di strumenti nei quali Sibelius arrangia la musica.

* Per rimuovere un gruppo di strumenti esistente selezionarne il nome e cliccare su Cancella; 
l’ordine dei gruppi si cambia selezionando un gruppo e cliccando sui pulsanti Sposta in alto o 
Sposta in basso.
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* Per aggiungere un nuovo gruppo di strumenti cliccare su Nuovo e scegliere gli strumenti da 
inserire nel gruppo:

Gli approcci possono essere vari: si potrebbero collocare gli strumenti melodici (es. legni e fiati 
acuti) in un gruppo e strumenti di supporto (es. ottoni, corni e archi gravi) in un altro.
Si può anche specificare che uno strumento deve raddoppiare quello elencato sopra ad un inter-
vallo specifico (es. per raddoppiare il flauto di un’ottava da un piccolo, oppure per suonare in 
terze particolari strumenti).
Per fare in modo che due strumenti raddoppino un singolo strumento (un piccolo e un clari-
netto che raddoppiano i flauti, ad esempio) gli strumenti devono essere elencati nel campo 
Gruppo di strumenti come segue:

In altre parole, si possono avere più strumenti che doppiano lo stesso strumento; lo strumento 
doppiato quando s’attiva l’opzione Raddoppia lo strumento elencato sopra questo sarà il 
primo strumento sopra quello selezionato che non è impostato per doppiare un altro strumento.
Anche se non si specificano gli strumenti che si doppiano a vicenda, essi potrebbero finire col 
doppiarsi comunque (arrangiando linee di note su un numero più grande di righi).

* Una volta terminata l’aggiunta di strumenti al gruppo cliccare su OK.

* Dare un nome al gruppo (es. Vln1+Fl) con un doppio-clic del mouse sullo spazio vuoto nella 
colonna Nome.

* Per specificare un’estensione all’interno della quale Sibelius arrangi la musica per un gruppo 
impostare l’opzione Fill range in Yes e poi scegliere i valori Min Pitch e Max Pitch appropriati. 
Sibelius trasporterà la musica in ottave per farla entrare nell’intervallo stabilito e in modo che i 
vari strumenti nel gruppo coprano collettivamente l’intero intervallo.
Fill range: questa opzione è utile se, ad esempio, il materiale sorgente è un pezzo di piano che 
per necessità utilizza un ristretto intervallo d’accordi (in genere, meno di una quinta in ogni 
mano) e si vuole fare in modo che la musica sia suonata da una sezione d’archi in tutta la sua 
estensione; oppure per garantire che il materiale vada a finire in un intervallo particolare (per 
esempio, i legni acuti, anche se gli strumenti potrebbero suonarlo ad altre altezze). 

Flauto non raddopiarlo

Piccolo raddoppiarlo di un’ottava in alto

Clarinetto raddoppiarlo all’unisono
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* Min Linee: determina il numero minimo di linee di note assegnabili al gruppo selezionato. 
È raccomandato valore di default 0; significa che il gruppo non deve sempre suonare.

* Max Linee: determina il numero massimo di linee di note assegnabili al gruppo selezionato. 
Il valore di default (vuoto) consente di assegnare un numero di linee qualsiasi al gruppo.
Questo valore si cambia solo per avere effetti particolari (per esempio, impostando Max Lines a 
1 tutti gli strumenti nel gruppo sono obbligati a doppiare lo stesso materiale.

* Max Linee per Rigo e Max Voci per Rigo: controllano la distribuzione delle linee di note tra gli 
strumenti all’interno del gruppo; i valori di default (rispettivamente 2 e 2) sono adatti alla mag-
gior parte degli stili musicali.
In generale, Sibelius usa più voci sullo stesso rigo se deve farlo, per esempio se sono più le linee 
di note assegnate a un particolare gruppo che i righi all’interno del gruppo.
Se Max Linee per Rigo è a un valore superiore di Max Voci, Sibelius unisce queste linee di note 
in accordi nella stessa voce (ovviamente, non ha molto senso impostare Max Linee per Rigo ad 
un numero inferiore di Max Voci); per avere solo singole note su ogni rigo, impostare entrambe 
queste opzioni a 1.
Alcune utili impostazioni di queste opzioni sono:

* A tutti gli strumenti in un gruppo è assegnata musica simile. Il modo in cui le linee di note sono 
assegnate ai gruppi è definito dall’opzione Quali linee vanno nel primo gruppo; per esempio, 
se è Altissimo, la linea più acuta va nel primo gruppo elencato, la seconda più acuta nel gruppo 
successivo elencato, e così via. Per cambiare l’ordine dei gruppi di strumenti cliccare sui pulsanti 
Sposta in alto o Sposta in basso (vedere sopra per i dettagli).

* Una volta definito lo stile Arrange cliccare su OK.

Gli stili Arrange sono salvati automaticamente nella cartella Arrange Styles all’interno della car-
tella dati dell’applicazione, quindi è possibile condividere gli stili con altri utenti semplicemente 
inviandogli i file .sar di quella cartella – File modificabili dall’utente in b Lavorare con i 
file.

Se si creano stili che saranno usati da altri utenti, includere tutti gli strumenti adeguati possibili in 
ogni stile (è stato fatto per gli stili predefiniti). Per esempio, uno stile Arrange d’ottoni dovrà com-
prendere preferibilmente strumenti rari come la tromba piccola e i corni con crooks, nel caso qual-
cuno voglia arrangiare la musica per questi strumenti.

Linee che vanno nel primo gruppo
Gli stili Arrange forniti sono adatti alla maggior parte degli arrangiamenti, ma per definire i propri 
è importante capire come la distribuzione delle linee di note influenza l’arrangiamento risultante.

Tastiera Max Lines per Staff = 4, Max Voices = 2

Legni singoli Max Lines per Staff = 1, Max Voices = 1

Legni doppi Max Lines per Staff = 2, Max Voices = 2

Ottoni Max Lines per Staff = 2, Max Voices = 2

Archi Max Lines per Staff = 2, Max Voices = 2

Canto Max Lines per Staff = 1, Max Voices = 1
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I quattro metodi di ordinamento delle linee di note – determinati dall’opzione Quali linee vanno 
nel primo gruppo – danno luogo a distribuzioni molto diverse della musica. In generale:

* Se ordinati per altezza (Altissimo), i gruppi devono essere sistemati in modo che gli strumenti 
in ogni gruppo siano in grado di suonare nel giusto registro; per esempio, in un primo gruppo 
gli strumenti acuti (come i violini e i flauti), in un secondo gruppo quelli medi (es. viole, clari-
netti, corni) e in un terzo gruppo gli strumenti gravi (es. celli, contrabbassi, tromboni). L’ordina-
mento per altezza consente d’impostare più facilmente i raddoppi in un’orchestrazione “mista” 
(es. violini doppiati da flauti e clarinetti, viole doppiate dagli oboe, celli doppiati dai contrab-
bassi, ecc.). In genere, questo tipo di stile Arrange dovrà contenere tre o quattro gruppi (gli stili 
Mixed sono definiti così).

* Se ordinati per velocità (cioè Velocissimo o Occupato) ogni gruppo deve contenere una 
gamma di strumenti in grado di suonare l’intero intervallo di note, come quelli delle famiglie 
strumentali standard (legni, ottoni e archi). Ciò consente un’orchestrazione in “blocco”, nella 
quale ogni famiglia suona un tipo di materiale particolare (es. i legni suonano la musica più 
veloce e gli ottoni quella più lenta). In genere, questo tipo di stile Arrange dovrà contenere due o 
tre gruppi. Gli stili Sezione sono definiti così, ordinati in Velocissimo (impostazione racco-
mandata per l’orchestrazione in blocco).

* Se ci sono dei dubbi sul metodo d’ordinamento da usare, Velocissimo (cioè l’orchestrazione 
mista) generalmente offre i risultati di default migliori.
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5.3 Impostazioni visive

b Menu Vista.

È bene impiegare un po’ di tempo a impostare le opzioni visive di Sibelius in base alle proprie pref-
erenze, in modo che funzioni il più velocemente e regolarmente possibile sul computer.

Risoluzione dello schermo
Sibelius ha bisogno di una risoluzione minima dello schermo di 1024 x 768 pixel ma, se possibile, 
si raccomanda una risoluzione superiore; per cambiare la risoluzione dello schermo:

* In Windows:
% Ridurre tutti i programmi aperti, clic-destro del mouse sul desktop e selezionare Proprietà

dal menu contestuale.
% Cliccare sulla pagina Impostazioni.
% Trascinare il cursore Risoluzione dello schermo a destra per aumentare la risoluzione dello 

schermo e cliccare su Applica per provare le modifiche; se il computer ha più di un paio 
d’anni, ridurre il valore Colori per avere risoluzioni visive maggiori – vedere Numero di 
colori.

* In Mac:
% Dal dock o dal menu mela lanciare Preferenze di Sistema e cliccare sull’icona Monitor.

% Scegliere una nuova risoluzione dello schermo dall’elenco disponibile; Mac s’imposta auto-
maticamente sulla nuova risoluzione.

In base alla scheda video del computer, soluzioni superiori potrebbero rallentare la scrittura delle 
immagini sullo schermo; in tal caso, provare a ridurre il numero di colori usato, per ridurre il car-
ico sulla scheda video.

Numero di colori
In Mac, Sibelius deve apparire bene a qualsiasi “profondità colore” (numero di colori), da 256 col-
ori fino a milioni di colori; cambiare il numero di colori usato dallo schermo solo se le immagini si 
rallentano a una certa profondità colore.

In Windows, tuttavia, si raccomanda d’impostare lo schermo a una profondità colore di almeno 
16-bit; questo perché alcuni pulsanti nel tastierino numerico potrebbero non apparire corretta-
mente sullo schermo usando 256 colori (o meno).

Per cambiare la profondità colore usata dallo schermo attenersi alla stessa procedura descritta in 
Risoluzione dello schermo.

Sfondi
In Sibelius, sia il foglio virtuale sia lo schermo impiegano sfondi di alta qualità, per facilitarne la 
visione; è possibile cambiare facilmente gli sfondi scegliendoli da un’ampia gamma di fogli, legni, 
marmi, e così via nella pagina Textures della finestra File > Preferenze (menu Sibelius in Mac).
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Scegliendo dal menu Modifica texture per è possibile impostare gli sfondi di partitura (Parti-
ture), parti (Parti) e modificare idee (Idee) in modo indipendente.

Alcuni sfondi sono divertenti – provare 
Pelle tigrata per la scrivania, o Carta, caffè
per la carta se si è rimasti alzati tutta notte a 
scrivere musica! Il più utile è forse lo sfondo 
Carta, grafico, ideale per allineare visiva-
mente gli oggetti nella partitura – se si visu-
alizza al 100% le linee griglia sono 
distanziate di 1 spazio.

Se le immagini sullo schermo sono disegnate troppo lentamente attivare l’opzione Disegno tex-
ture alternativo in questa finestra di dialogo, quindi uscire e riavviare Sibelius; ciò può velociz-
zare Sibelius su alcuni computer, ma rallentarlo su quelli con poca memoria (questa opzione non è 
disponibile in Mac quando è attiva l’opzione smoothing).

Se le immagini sullo schermo sono ancora lente, probabilmente disattivando gli sfondi (impo-
stando le opzioni in Usa colore non texture) la tracciatura sullo schermo si velocizza.

È possibile anche aggiungere propri sfondi a Sibelius – basta creare una cartella Textures nell’area 
dei dati d’applicazione del computer (File modificabili dall’utente in b Lavorare con i 
file) e rilasciare alcuni file Windows bitmap (BMP) adatti in essa. All’avvio successivo di Sibelius i 
nuovi sfondi saranno disponibili nella pagina Textures della finestra File > Preferenze.

Smoothing - Scorrevolezza
In Windows, si può stabilire come e in che misura Sibelius facilita la visione della partitura sullo 
schermo (smoothing) selezionando File > Preferenze e  Visualizza. 

Si può scegliere un preset di scorrevolezza dal menu Impostazioni (di default Sibelius usa l’opzione 
Fluido e veloce), o cambiare le impostazioni singolarmente, cioè decidere se facilitare la visione 
di Legature di portamento/valore, Tratti d’unione, Linee irregolari (es. forcine) e Linee rette
(es. le linee del rigo). La scorrevolezza di simboli e testi può essere disattivata, impostata al valore 
di default di sistema o attivata. Il default di sistema si può cambiare cliccando sul pulsante Effetti
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nella pagina Aspetto delle proprietà Schermo del sistema. (Scegliere Start > Pannello di con-
trollo e doppio-clic su Schermo). 

L’opzione Posizionamento testo preciso garantisce che tutti i testi disegnati sullo schermo sar-
anno accuratamente posizionati; ciò a spese delle prestazioni di sistema, quindi può darsi che Sibe-
lius sia molto più veloce non attivando questa opzione.

In Mac, Sibelius usa la visione Quartz interna di Mac OS X, sempre molto omogenea. Non sono 
necessarie opzioni la visione Quartz, quindi le opzioni Smoothing non appaiono in Mac.

Consigli rapidi
Ecco alcuni metodi con i quali migliorare le prestazioni di Sibelius sul computer:

* Se il trascinamento del foglio è lento, provare con l’opzione Disegno texture alternativo o dis-
attivare gli sfondi di foglio e schermo (vedere Sfondi). Si può anche provare a cambiare il livello 
smoothing/profondità colore e attivare l’opzione Finestre Traslucide.

* In Windows, usando le versioni Adobe Type 1 (PostScript) dei font Opus, Reprise, Inkpen2 e 
Helsinki può darsi che si rallentino i tempi di scrittura sullo schermo – ove possibile, quindi 
usare i font TrueType (sono installati di default, quindi a meno che non siano stati cambiati i 
font usati da Sibelius, non occorre preoccuparsene).

* Se la selezione di oggetti è lenta, chiudere tutti i “pannelli” aperti non usati della finestra Propri-
età oppure nasconderli completamente selezionando Finestra > Proprietà (comando rapido 
Ctrl+Alt+P o zXP). Anche disattivando i righelli nel sottomenu Vista > Righelli la velocità 
aumenta (b Menu Vista in Manuale Operativo

Finestre trasparenti
Per rendere trasparenti le finestre Navigator, Tastierino numerico, Mixer, Video e Proprietà (per 
vedere la musica attraverso di esse) attivare l’opzione Finestre Tools Traslucide nella pagina 
Visualizza della finestra File > Preferenze (menu Sibelius in Mac). Se in riproduzione sono pre-
senti lampeggi o altri problemi, attivare l’opzione Ad eccezione della finestra video che toglie la 
trasparenza alla finestra Video (i problemi si dovrebbero risolvere); b Video.

Sibelius consente anche d’impostare il grado di trasparenza delle finestre con il cursore Tras-
parenza. A 0% le finestre sono completamente opache, mentre al 100% sono pressoché invisi-
bili. 

In genere la trasparenza velocizza la tracciatura sullo schermo, quindi si raccomanda di attivare 
questa opzione.

Monitor multipli
Sibelius può utilizzare più monitor; ciò è molto utile poiché si può avere (ad esempio) una partit-
ura diversa aperta in ogni monitor o vedere due pagine della stessa partitura su due schermi.
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5.4 Filtri e Trova

b Selezioni e passaggi.

Una delle peculiarità di Sibelius è la capacità di trovare oggetti dalle caratteristiche particolari – 
per esempio, tutte le forcine, le note più acute in un passaggio d’accordi, tutte le scritte cresc. nello 
stile di testo Expression o tutti i DO centrali da 1/8 (croma) nella Voce 2 con un colpo d’archetto in 
giù e un marcato.

È possibile selezionare tutti gli oggetti che soddisfano le caratteristiche scelte usando le opzioni del 
sottomenu Modifica > Filtro, oppure trovare a turno l’oggetto corrispondente con le funzioni 
Modifica > Tova (Ctrl+F o XF) e Modifica > Trova successivo (Ctrl+G o XG). Una volta ese-
guita questa operazione, con la selezione si può fare ciò che si vuole – modificarla, copiarla, cancel-
larla o qualsiasi altra cosa.

Come usare i filtri
* Selezionare il passaggio musicale dal quale selezionare gli oggetti o l’intera partitura (Ctrl+A o

XA).
* Scegliere uno dei “filtri veloci” dal menu Modifica > Filtro o Filtro avanzato

(Ctrl+Maius+Alt+F o xzXF) per selezionare caratteristiche più complesse (i dettagli in 
seguito).

* Con la selezione si può fare ciò che si vuole – per esempio, cancellarla, copiarla, spostarla con i 
tasti freccia, aggiungere articolazioni, cambiare valore nota.

* Altrimenti, si può scegliere un’altra caratteristica dal menu Modifica > Filtro per restringere 
ulteriormente la selezione (vedere in seguito).

Filtri rapidi
Il menu Modifica > Filtro contiene una selezione di filtri standard per un rapido accesso:

* Numeri battuta: seleziona tutti i numeri misura e i cambi di numero misura.
* Simboli accordo: seleziona tutti i simboli accordo.
* Dinamiche: seleziona tutti i testi Expression e le forcine (Maius+Alt+D o xzD).
* Testo espressione: seleziona tutti i testi nello stile Expression.
* Simboli accordo: seleziona tutti i diagrammi accordo.
* Forchette: seleziona tutte le linee di forcina, ma non forcine tratteggiate, punteggiate, in paren-

tesi o forcine a/da silenzio.
* Parole: seleziona tutte le parole.
* Note e accordi: seleziona tutte le note e accordi (insieme a rispettive alterazioni, articolazioni, 

ecc.), ma non seleziona altri oggetti come i testi.
* Cambi numero pagina: seleziona tutti i cambi di numero pagina.
* Legature: seleziona le legature normali (magnetiche e non-magnetiche), ma non legature trat-

teggiate o punteggiate.
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* Gruppi irregolari: seleziona parentesi e numeri dei tuplet; utile per nascondere, mostrare o 
ripristinare la posizione delle parentesi dei tuplet in una sola operazione.

* Voce 1/2/3/4 (Ctrl+Maius+Alt+1/2/3/4 o xzX1/2/3/4): seleziona tutti gli oggetti in quella 
voce (es. note, pause, scritte, linee, ecc.), includendo oggetti che non sono esclusivamente in 
quella voce – per esempio, se si filtra la Voce 1, sono selezionati anche gli oggetti di testo che si 
applicano (ad esempio) a entrambe le Voci 1 e 2. Ciò è particolarmente utile per la copia di una 
singola voce in un altro rigo, poiché è bene che gli oggetti associati (come i segni dinamici) siano 
copiati con le note.

* Solo Voce 1/2/3/4: seleziona gli oggetti che sono solo in quella voce; non seleziona quindi 
oggetti presenti in più voci – per esempio, filtrando Solo Voce 2, gli oggetti di testo che si appli-
cano a entrambe le voci 1 e 2 non sono selezionati. Si usa principalmente per cancellare una voce 
particolare da un passaggio, poiché in generale non si cancella un qualsiasi oggetto che si applica 
anche alla voce rimanente su quel rigo.

* Nota Iniziale/2a/3a/Finale: seleziona solo la testa nota specificata dagli accordi in tutte le voci 
del rigo; scegliendo i filtri Nota Iniziale o Nota Finale sono selezionate anche le singole note. 
Ciò è utile per cancellare note da accordi ma lasciare intatta la melodia, ad esempio. 2a e 3a sig-
nificano la seconda o terza testa nota contando dall’alto in basso, non dal basso in alto.

* Nota Iniziale/2a/3a/finale o Note singole (Ctrl+Alt+1/2/3/B o zX1/2/3/B): se un passag-
gio contiene sia accordi sia note singole, questo filtro seleziona la testa nota specificata dagli 
accordi e le singole note in tutte le voci, quindi si finisce per avere una linea di musica continua. 
Utile per l’arrangiamento da una breve composizione di tastiera, ove si desidera copiare le linee 
di musica su altri righi.

* Player 1/2 (Per estrazione): questi filtri facilitano la separazione di un rigo per Flauto 1 e 2 (ad 
esempio) in singole parti per ogni musicista. Si possono usare per dividere due musicisti da un 
rigo su righi separati nella partitura, in situazioni complesse non gestite da altri filtri, come 
quando la musica alcune volte è in una voce e altre in due. Vedere Estrarre singoli musicisti
a pagina 492.

Usare i filtri per copiare e cancellare
L’uso principale dei filtri è la copia e la cancellazione della musica che si riflettono nella gamma di 
filtri rapidi interni di Sibelius. La differenza nell’uso dei filtri per copiare e cancellare, in un primo 
momento è meno ovvia di quanto sembri, quindi vediamo un esempio pratico.

C’è un passaggio per due flauti scritti in due voci sullo stesso rigo ma in realtà si vuole far suonare 
a un clarinetto la linea suonata dal Flauto 2. Per farlo subito, selezionare il passaggio nel rigo di 
flauto e scegliere Modifica > Filtro > Voce 2 (che seleziona tutte le note del Flauto 2, con i rispettivi 
segni dinamici, legature e così via). A questo punto, copiare la musica nel rigo di clarinetto con 
Alt+clic o z-clic e scambiare la nuova musica di clarinetto nella Voce 1 con Alt+1 o z1. 
Per cancellare poi la musica del Flauto 2 dal rigo di flauto selezionare di nuovo il passaggio e sceg-
liere Modifica > Filtro > Solo Voce 2. Questa operazione non seleziona tutte le note, ma solo le 
dinamiche ecc. che si applicano solo alla Voce 2, quindi cliccando Cancella non si perde alcun 
testo (ecc.), che sarà applicato anche alla Voce 1.

Quando si cancella una voce cliccare due volte su Cancella – il primo Cancella trasforma le note 
in pause e il secondo cancella queste pause.
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Finestra Filtro avanzato
Per applicare un filtro più complesso (es. uno che utilizza una combinazione di caratteristiche), 
usare la finestra Modifica > Filtro > Filtro avanzato (Ctrl+Maius+Alt+F o xzXF):

Questa finestra permette di selezionare o deselezionare tutti gli oggetti nel passaggio selezionato o 
nell’intera partitura. È divisa in due: a sinistra ci sono i valori generali da impostare per operazioni 
di filtro, come un Trova nell’intera partitura o in un passaggio selezionato, i tipi d’oggetto da inclu-
dere (Testo, Linee ecc.) e quali voci includere; a destra ci sono i valori dettagliati per ogni tipo 
d’oggetto generale – sono in quattro pagine, selezionabili nell’elenco Mostra.

I quattro box Voce indicano le voci filtrate nella partitura; di default sono filtrate tutte e quattro.

Se prima di scegliere Modifica > Filtro > Filtro avanzato si seleziona un passaggio o si esegue una 
selezione multipla, si può decidere se applicare il filtro alla selezione (Selezione) o all’intera parti-
tura (Partitura completa); non selezionando nulla prima del filtraggio, il filtro s’applica all’intera 
partitura.

Usando le quattro pagine di opzioni nell’elenco Mostra a sinistra è possibile definire le combinazi-
oni di filtro più complesse. Attivare il box Trova di una particolare pagina per aggiungerla al filtro; 
disattivarla di nuovo per rimuoverla. È ovvio che almeno uno dei box Trova deve essere attivato 
per eseguire un’operazione di filtro!

Le quattro pagine presentano le seguenti opzioni:

* Note e Accordi: sebbene qui le opzioni siano auto-esplicative, è opportuno esaminarle breve-
mente:
% Note/Accordi con n teste della nota: filtra gli accordi formati dal numero di note specifi-

cato.
% Note in accordo: filtra la testa nota specificata.

* Pitch (reale)/Ottava: filtra solo le note all’altezza specificata ed eventualmente nell’ottava spec-
ificata (DO4 è il DO centrale). Sibelius in pratica cerca l’altezza suonata, quindi non c’è da preoc-
cuparsi del trasporto degli strumenti; per non creare confusione, quando si lavora con partiture 
trasportate, prima di usare i filtri d’altezza disattivare l’opzione Note > Partitura traspositore
(si noti che le linee d’ottava sono ignorate da questo filtro quando si cerca l’altezza).
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% Valore della nota: seleziona solo note/pause della durata specificata; prelevare i valori nota 
dall’elenco o digitarli sul pad numerico (con il tasto Num Lock attivo). Le legature sono 
ignorate, quindi una nota da 1/2 legata a una da 1/8 è trattata come due note separate.

% Posizione nella misura: filtra note/pause con la posizione specificata dopo l’inizio della mis-
ura. Scegliendo quindi una nota da 1/4 sono filtrate solo note/pause che si trovano un quarto 
di nota nella misura (cioè iniziano sul secondo quarto). Scegliendo anche Più multipli, sarà 
filtrata ogni nota/pausa sul movimento da un quarto; per filtrare solo note/pause all’inizio 
delle misure lasciare vuoto il box Posizione nella misura.

% Articolazioni: filtra note/accordi in base alle rispettive articolazioni. Selezionando Alcune di 
queste una nota/accordo è filtrata se ha una delle articolazioni selezionate; selezionando 
Tutte, una nota/accordo è filtrata solo se ha tutte le articolazioni specificate.

* Pause e battute in pausa: si può scegliere se il filtro deve agire su pause normali, misure di 
pausa o entrambi inserendo la spunta nei rispettivi box; gli elenchi a tendina permettono di 
specificare la durata delle pause da filtrare.

* Testo: inserire una scritta particolare (es. “legato,” “mf ”) per filtrare tutti i testi corrispondenti 
nella selezione; questo campo è sensibile al maiuscolo/minuscolo (es. “Legato” e “legato” sono 
diversi). È possibile specificare uno o più stili di testo da filtrare – cliccare sullo stile di testo per 
aggiungerlo alla selezione e cliccare di nuovo per rimuoverlo dalla selezione. I pulsanti Nessuno 
e Tutti sono senz’altro auto-esplicativi!

* Linee: se questa pagina è presente nel filtro sarà selezionata la linea nei box a destra; si possono 
filtrare tutti i tipi di linea (opzione Tutte le linee attiva) o solo un tipo di linea per volta (non più 
tipi di linea). Per fare in modo che il filtro ignori completamente le linee, accertarsi che il box 
Linee sotto Trova non sia selezionato.

Cliccando Ripristina nella finestra di dialogo tutte le opzioni filtro tornano ai rispettivi valori di 
default e si può ricominciare. 

Una volta configurate le opzioni desiderate, verificare che siano selezionati gli opportuni box 
Trova, quindi cliccare Seleziona per selezionare tutti gli oggetti nella selezione o nell’intera partit-
ura che corrispondono alle caratteristiche di filtro, oppure cliccare su Deseleziona per rimuovere 
dalla selezione tutti gli oggetti che corrispondono alle caratteristiche di filtro.

Selezionare gli oggetti con caratteristiche x e y
Si supponga di selezionare tutte le note DO centrale da 1/2 in un passaggio per dargli un accento. 
Pensarvi come a una selezione di tutto ciò che è una nota da 1/2 e DO centrale.

Per farlo, si selezionano tutte le note da 1/2 e poi si filtrano tutti i DO centrali, in questo modo:

* Selezionare anzitutto un passaggio.
* Scegliere Modifica > Filtro > Filtro avanzato (comando rapido Ctrl+Maius+Alt+F o xzXF).
* Da Valore della nota scegliere una nota da 1/2.
* Dall’elenco Pitch (reale) scegliere C e dall’elenco Ottava selezionare 4.

* Cliccare su Seleziona: il filtro è applicato alla partitura e restano selezionate solo le note DO da 
1/2.

* Aggiungere gli accenti usando il primo layout del tastierino numerico.
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Selezionare gli oggetti con caratteristiche x o y
Si supponga (per assurdo) di selezionare tutte le note in un passaggio che siano da 1/2 o DO cen-
trali per accentarle. È un caso assai improbabile, quindi non c’è un modo diretto per farlo; tuttavia, 
il metodo indiretto è il seguente:

* Selezionare un passaggio, quindi usando la finestra di dialogo Modifica > Filtro > Filtro avan-
zato, selezionare tutte le note da 1/2.

* Collocare sopra di esse un accento usando il primo layout del tastierino numerico.
* Selezionare di nuovo il passaggio e usare la finestra di dialogo Modifica > Filtro > Filtro avan-

zato per selezionare tutti i DO centrali.
* Collocare un accento anche sopra di essi.

Trovare gli oggetti
La ricerca funziona in modo molto simile al filtro, tranne per il fatto che si seleziona la corrispon-
denza degli oggetti uno ad uno invece che tutti simultaneamente. La finestra di dialogo Modifica >
Trova è molto simile a quella Filtro avanzato; per trovare gli oggetti:

* Selezionare Modifica > Trova (comando rapido Ctrl+F o XF) e scegliere la combinazione di car-
ratteristiche da trovare nella partitura – per i dettagli su come usare questa finestra di dialogo 
vedere Finestra Filtro avanzato.

* Cliccare su Trova per trovare il primo oggetto nella partitura che corrisponda ai criteri scelti; se 
non si trovano oggetti corrispondenti, Sibelius genera un messaggio d’avviso.

Una volta configurata un’operazione Trova usare il comando Modifica > Trova successivo
(comando rapido Ctrl+G o XG) per trovare l’oggetto corrispondente successivo nella partitura.

 L’ordine di ricerca è il seguente:

* La ricerca parte all’inizio della partitura, con la prima misura del rigo in alto.
* Sibelius cerca alla fine di quel rigo (alla fine della partitura) poi si sposta in basso sul rigo succes-

sivo e cerca dall’inizio della partitura in quel rigo alla fine e così via.
* Quando raggiunge la fine della partitura (in altre parole, la fine del rigo in basso), Sibelius 

chiede se la ricerca è finita o deve continuarla dal rigo in alto all’inizio della partitura.

Trovare e sostituire testi
Per trovare e sostituire un testo particolare nella partitura usare il plug-in Plug-in > Testo > Trova e 
sostituisci testo – b Plug-in.

Trovare motivi (motif)
Per trovare un particolare motivo melodico o ritmico nella partitura usare il plug-in Plug-in >
Analisi > Trova motivo – b Plug-in.
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5.5 Evidenzia righi Selezionati

b Righi, Riproduzione, Panorama.

v Evidenzia righi Selezionati e Proprietà.

Lavorando su partiture per grandi ensemble come un’orchestra o una banda, spesso è utile vedere 
solo uno o pochi righi sui quali si lavora; per esempio, si potrebbero vedere solo i righi degli archi o 
dei corni. Ciò funziona particolarmente bene con la funzione Vista > Panorama.

Analogamente, talvolta è utile preparare partiture in cui i righi con la musica sono nascosti in 
riproduzione; per esempio, quando si prepara un semplice foglio per la stampa ma si vuole sentire 
un accompagnamento nascosto durante la riproduzione.

La funzione Vista > Evidenza righi Selezionati (Ctrl+Alt+F o zXF) di Sibelius consente di real-
izzare facilmente entrambi questi obiettivi.

Scegliere i righi sui quali lavorare
Usare la funzione Evidenza righi Selezionati è molto semplice:

* Selezionare il rigo (o i righi) da visualizzare (lasciare deselezionati tutti i righi da nascondere). 
Si deve selezionare solo una singola misura in ogni rigo da evidenziare: Maius-clic per selezion-
are righi adiacenti, oppure Ctrl+clic o X-clic per selezionare righi non adiacenti (b Selezioni 
e passaggi); per evidenziare un singolo rigo, basta avere solo una nota o un altro oggetto selez-
ionato.

* Cliccare sul pulsante nella barra degli strumenti (indicato a destra) o selezionare Vista >
Evidenzia righi Selezionati (comando rapido Ctrl+Alt+F o zXF).

* Immediatamente sono nascosti i righi da non evidenziare.
* Si può ora lavorare sui righi rimanenti come al solito, inserendo e modificando note, aggiun-

gendo testi e così via.
* Attivare l’opzione Vista > Panorama che dispone i righi come in un singolo sistema continuo su 

una pagina infinitamente larga ignorando il layout della partitura (b Panorama).

* Per uscire dalla modalità di evidenziazione, cliccare nuovamente sul pulsante nella barra degli 
strumenti, digitare il comando rapido o disattivare la funzione Vista > Evidenzia righi Selezi-
onati.

Se la selezione iniziale di righi includeva righi nascosti con il comando Layout > Nascondi righi 
vuoti (b Righi) questi righi appaiono quando s’attiva la funzione Vista > Evidenzia righi Selezi-
onati e scompaiono di nuovo quando la si disattiva (se sono ancora vuoti).

Sibelius ricorda l’ultima combinazione scelta di righi da evidenziare, quindi si può evidenziare di 
nuovo lo stesso rigo attivando la funzione Vista > Evidenzia righi Selezionati con nulla di selezi-
onato.
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Riproduzione
Avviando la riproduzione con la funzione Evidenzia righi Selezionati attiva, suonano tutti i righi 
nella partitura, non solo quelli evidenziati; ciò può essere molto utile, poiché permette di creare 
partiture nelle quali i righi non si vedono ma sono riprodotti – come una realizzazione nascosta o 
un foglio d’accompagnamento.

Per non sentire i righi nascosti durante la riproduzione, silenziarli (Mute) nella finestra Mixer
(b Mixer).

Poiché l’impostazione Vista > Evidenzia righi Selezionati è salvata nella partitura, si può usare 
con profitto questa funzione con Sibelius Scorch (b SibeliusMusic.com), realizzando versioni 
degli spartiti che sono riprodotte in un modo ma stampate in un altro.

Selezioni e passaggi
Quando la funzione Vista > Evidenzia righi Selezionati è attiva, tra i righi evidenziati appaiono 
delle linee blu tratteggiate, che indicano dove sono i righi presenti ma non mostrati. (Si noti che le 
stesse linee tratteggiate appaiono con la funzione Layout > Nascondi righi vuoti – per maggiori 
dettagli b Righi).

Attenzione! Eseguendo una selezione attraverso più righi con la funzione Vista > Evidenzia righi 
Selezionati attiva, saranno selezionati anche i righi nascosti tra quelli visibili. Ciò può provocare 
conseguenze impreviste: per esempio, quando si copia un passaggio così da qualche altra parte 
nella partitura, si vedrà che è stata copiata anche la musica sui righi nascosti.

Per questo motivo si raccomanda di:

* Lasciare attiva l’opzione Vista > Segni layout in modo da poter vedere dove sono nascosti i righi 
prima di eseguire una copia.

* Copiare preferibilmente solo passaggi su un singolo rigo, per evitare di copiare musica che non si 
può vedere.

* Disattivare l’opzione Vista > Evidenzia righi Selezionati se si desidera eseguire operazioni di 
copia complesse che riguardano più righi (a meno che non si possa vedere che nella selezione 
non siano inclusi righi nascosti).

Pause multiple
Attivare l’opzione Usa simboli di battute d’aspetto quando si evidenziano i righi equivale esat-
tamente ad attivare le pause multiple quando non si usa la funzione Evidenzia righi Selezionati. In 
altre parole, si vedrà una pausa multipla solo se si hanno almeno due misure di pausa consecutive 
in tutti i righi nella partitura (non solo nei righi che si evidenziano).

Confusioni possibili
Non si confonda la funzione Evidenzia righi Selezionati con il comando Layout > Nascondi righi 
vuoti (b Righi). Evidenzia righi Selezionati può nascondere i righi con musica, influenzare i 
righi su ogni pagina e di solito si usa temporaneamente (a meno che non si nasconda un accompa-
gnamento o una realizzazione a scopi di riproduzione). Il comando Layout > Nascondi righi 
vuoti funziona su sistemi individuali, solo su righi vuoti o nei quali tutti gli elementi sono nascosti 
e il suo scopo principale è risparmiare spazio nelle partiture complete.
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5.6 Nascondere oggetti

Può essere utile visualizzare alcuni oggetti nelle parti ma nasconderli nelle partiture. Spesso, ad 
esempio, i passaggi cue devono apparire nelle parti ma essere nascosti nella partitura completa. 

Oppure si può decidere di riprodurre musica non visibile, come una realizzazione di jazz o basso 
figurato.

Sibelius consente di nascondere qualsiasi oggetto e controllare se tale oggetto sarà visibile nella 
partitura, nelle parti o non visibile affatto.

Nascondere un oggetto
Per nascondere un oggetto, selezionarlo e scegliere una delle opzioni del menu Modifica > Mostra 
o Nascondi:

* Mostra o Nascondi (comando rapido Ctrl+Maius+H o xXH): nasconde o mostra un oggetto 
nella partitura o parte corrente.

* Mostra nella partitura: mostra un oggetto solo nella partitura (nascondendolo in tutte le 
parti).

* Mostra nelle parti: mostra un oggetto in tutte le parti (nascondendolo nella partitura).
* Mostra tutto: mostra un oggetto sia nella partitura completa che in tutte le parti.

L’opzione Mostra o Nascondi appare anche nella pagina Generale della finestra Proprietà: 
selezionare l’oggetto da nascondere o mostrare e scegliere l’opzione desiderata dal menu a tendina.

Nascondendo un oggetto o selezionandone uno nascosto, sullo schermo esso appare in colore sbia-
dito. Una volta deselezionato, l’oggetto scompare (sebbene si possa scegliere di vedere in grigio 
tutti gli oggetti nascosti) – Vedere gli oggetti nascosti.

Cosa può essere nascosto?
Nella partitura può essere nascosto qualsiasi oggetto, inclusi note, pause, testi, cambi di tempo e 
tonalità, linee e così via. Nascondendo una nota si nascondono anche alterazioni, tratti d’unione, 
gambi e articolazioni associati a essa. (Se necessario, tuttavia, è possibile nascondere indipendent-
emente alterazioni, flag e tratti d’unione – b Alterazioni e Tratti d’unione.)

Per i dettagli sull’occultamento di oggetti particolari vedere il rispettivo capitolo in questo Manuale 
Operativo (così come per l’occultamento delle linee, b Linee).

Alcune applicazioni degli oggetti nascosti:

* Note: creare passaggi cue nascosti e silenti nella partitura completa ma visibili nelle parti 
(b Ornamenti); avere soli e realizzazioni “improvvisati” riprodotti ma non visibili.

* Testi: nascondere segni di metronomo o dinamiche che però sono riprodotti; aggiungere indi-
cazioni per i musicisti invisibili nella partitura ma visibili nelle parti; aggiungere note per il 
direttore che appaiono nella partitura ma non nelle parti.

* Linee: aggiungere segni (es. forcine) o linee accel./rit. riprodotte ma nascoste.
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Vedere gli oggetti nascosti
Per poter vedere sullo schermo gli oggetti nascosti attivare l’opzione Vista > Oggetti Nascosti 
(comando rapido Ctrl+Alt+H o zXH); di default questa opzione non è attiva. Attivandola, gli 
oggetti nascosti appaiono in grigio chiaro nella partitura (ma non sono stampati – vedere 
Riproduzione e stampa di oggetti nascosti). Gli oggetti nascosti possono essere selezionati 
e modificati allo stesso modo di quelli normali.

Con l’opzione Vista > Oggetti Nascosti non attiva, gli oggetti nascosti nella partitura sono com-
pletamente invisibili e non si possono selezionare o modificare individualmente (sebbene 
appaiano eseguendo una selezione di passaggio o sistema – per esempio, digitando Ctrl+A o XA
per selezionare tutto – e ci si possa spostare tra oggetti nascosti e visibili con i tasti freccia e Tab).

Questa opzione controlla anche se i vari oggetti normalmente scritti sono visualizzati o meno. 
Per esempio:

* Le stanghette invisibili (b Stanghette) appaiono in grigio.
* I cambi di tonalità (b Tonalità) e strumento (b Strumenti) che non hanno alterazioni visi-

bili sono visualizzati in un rettangolo grigio.
* Pause e misure di pausa nascoste dal tipo di rigo dello strumento (es. per alcuni strumenti con 

tablatura per chitarra) appaiono in grigio.

Si noti, inoltre, che se è attiva l’opzione Vista > Oggetti Nascosti (Ctrl+Alt+H o zXH) cancel-
lando una pausa inizialmente nascosta essa appare grigio chiaro. Cancellandola di nuovo la pausa 
scompare completamente.

Oggetti nascosti nella parti
Quando un oggetto è nascosto nella partitura completa ma visibile in una parte (o viceversa) ed è 
attiva l’opzione Vista > Differenze nelle parti, la sua versione visibile appare in arancione (a indi-
care che non è identica nella partitura e nella parte); come sempre, la versione nascosta appare in 
grigio quando è attiva l’opzione Vista > Oggetti Nascosti, ma diventa arancione pallido se selezi-
onata.

Riproduzione e stampa di oggetti nascosti
Di default, gli oggetti nascosti non sono stampati ma sono riprodotti, indipendentemente dal fatto 
che sia attiva o meno l’opzione Vista > Oggetti Nascosti. Non è consigliabile nascondere determi-
nati oggetti in riproduzione (per esempio, un passaggio cue nascosto nella partitura completa ma 
visibile nella parti); in tal caso, è meglio usare teste note silenti o disattivare i box di spunta Suona 
al passaggio dell’oggetto nella finestra Proprietà – b Teste nota e Ripetizioni.

Per stampare gli oggetti nascosti (per una prova di lettura, ad esempio) attivare l’opzione Vista >
Oggetti Nascosti e poi stampare la partitura, assicurandosi di attivare anche l’opzione Stampa 
opzioni menu Vista nella finestra di dialogo File > Stampa (b Stampa).

reference.book  Page 360  Wednesday, April 16, 2008  4:28 PM



5.7 Evidenzia

361

Funzio
ni

5.7 Evidenzia

b Colori.

Sibelius consente di evidenziare la musica per ricordare sezioni sulle quali si sta lavorando o sem-
plicemente per richiamare l’attenzione su una particolare funzione della partitura; alcuni plug-in 
(es. Trova motivo) evidenziano automaticamente parti della musica – b Plug-in.

Creare un’evidenziazione
Per creare un’evidenziazione nella partitura:

* Selezionare Crea > Evidenzia, quindi cliccare e trascinare il mouse nel passaggio da evidenziare.
* Oppure selezionare un passaggio e scegliere Crea > Evidenzia per creare un’evidenziazione sulla 

durata del passaggio; si può evidenziare un passaggio solo in un rigo alla volta, quindi se si sceg-
lie un passaggio contenente più righi, l’evidenziazione appare solo sul rigo più in alto nella selez-
ione (sebbene sia possibile evidenziare individualmente gli altri righi).

Di default le evidenziazioni sono gialle, ma il colore si può cambiare dopo averle create, proprio 
come con tutti gli altri oggetti – b Colori.

Selezionare oggetti evidenziati
Note o altri oggetti evidenziati si spostano come una qualsiasi altra nota od oggetto; per selezion-
are l’evidenziazione, cliccare sul bordo in modo da poterla spostare, copiare e cancellare. 

Spostare l’evidenziatura
* Per spostare un’evidenziazione a sinistra o destra, cliccare sul bordo in alto o in basso dell’eviden-

ziazione e trascinarla con il mouse o usare i tasti 0/1 (premendo Ctrl o X per step più grandi).
* Per regolare la durata di un’evidenziazione selezionata, cliccare sulla linea sinistra o destra del box 

attorno ad essa e trascinare il mouse; premere spazio per estenderla di una nota (Maius-barra 
spaziatrice la ritrae di una nota) o usare i tasti 0/1 (premendo Ctrl o X per step più grandi).

Cancellare un’evidenziazione
Cliccare sul bordo dell’evidenziazione e premere Canc; per togliere tutte le evidenziazioni in una 
partitura usare il plug-in Plug-in > Altro > Rimuovi evidenziati (b Plug-in).

Visualizzare le evidenziazioni
Per specificare se visualizzare le evidenziazioni nella partitura selezionare Vista > Evidenziatore.

Stampare le evidenziazioni
Si può scegliere se stampare o meno le evidenziazioni.

* Per non stamparle, assicurarsi che l’opzione Stampa opzioni menu Vista nella finestra di dial-
ogo File > Stampa (comando rapido Ctrl+P o XP) non sia attiva quando si stampa la partitura.

* Per stamparle, attivare l’opzione Vista > Evidenzia (disattivando tutte le altre opzioni nel menu 
Vista che non si desidera stampare) e stampare la partitura, assicurandosi che l’opzione Stampa 
opzioni menu Vista nella finestra File > Stampa (Ctrl+P o XP) sia attiva.

Per maggiori informazioni sulla stampa, b Stampa.
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5.8 Idee

Scrivendo musica, spesso si realizzano frammenti di melodia, ritmo, accompagnamento o progres-
sioni d’accordi geniali. Arrangiatori e copisti usano e riutilizzano un gran numero di frammenti 
specifici di notazione (segni di testo, simboli o diagrammi accordo specifici e così via).

Questi frammenti si chiamano idee: pezzi di una durata qualsiasi, di ogni tipo e per qualsiasi 
numero di strumenti; si sfrutta un’intuizione per catturare un’idea da memorizzare per il futuro. 
Una volta catturata, la si può modificare, etichettare con parole chiave personalizzate (es. canone, 
lirica, riff) per trovarla di nuovo, oppure codificarla con un colore. La finestra Idee consente di 
archiviare e cercare tutte le idee disponibili per poi riprodurle. Usare un’idea è semplice come 
incollare dagli Appunti; Sibelius inoltre le trasporta nella giusta tonalità ed estensione.

È possibile importare ed esportare set di idee da condividere con altri utenti – anche tramite Inter-
net. Un insegnante può salvare un set di idee all’interno di una partitura per realizzare un esercizio 
scritto di composizione per i suoi studenti.

Inoltre, Sibelius ha più di 2000 idee interne per molti strumenti e stili musicali, quindi se non 
arriva l’ispirazione o si sta cercando uno stimolo per la propria creatività, in pochi secondi lo si può 
trovare.

Cosa c’è in un’idea?
Un idea è costituita praticamente da tutto ciò che si può scrivere in Sibelius. È possibile selezionare 
tutta la musica desiderata (da una singola nota su un rigo fino a centinaia di misure su un numero 
qualsiasi di righi) e catturarla in un’idea. Si possono anche selezionare altri tipi d’oggetti – linee, 
simboli, oggetti di testo, grafiche importate – e catturarli come idee, con o senza note.

Così come la musica, anche un’idea contiene etichette. Esse sono un modo per identificare le idee 
usando parole chiave che descrivono l’idea stessa, in modo da trovarla facilmente in seguito. Ciò è 
utile quando si hanno migliaia di idee da valutare! Oltre alle etichette che si specificano, Sibelius 
etichetta automaticamente ogni idea con altre informazioni che comprendono:

* Tonalità
* Tempo in chiave
* Tempo
* Durate dell’idea (in misure)
* Strumenti usati nell’idea
* Data di creazione
* Data di modifica

Le idee si possono cercare usando una delle etichette scelte dall’utente o quelle aggiunte automati-
camente da Sibelius; si può anche assegnare un colore specifico ad ogni idea.

Finestra Idee
Il metodo di lavoro principale con le idee consiste nell’usare la finestra Idee che si apre e chi-
ude selezionando Finestra > Idee (Ctrl+Alt+I o zXI) o cliccando sul pulsante nella barra 
degli strumenti indicato a destra.
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La finestra Idee ha due vedute, compatta e dettagliata. Di default si apre la veduta compatta:

Per cercare le idee, digitare una o più etichette nel box in cima alla finestra. Se non si sa cosa digi-
tare, cliccare sulla piccola freccia a destra; appare un elenco a tendina che elenca le etichette delle 
idee disponibili usate più di frequente. Cliccare su una delle etichette nell’elenco per aggiungerla al 
box. Una volta che nel box si ha una o più parole scorrere di nuovo il menu: Sibelius mostra le 
etichette che ricorrono più spesso nelle idee che utilizzano anche le etichette già scelte. 
Ogni volta che s’aggiunge una parola al box e si preme Invio, Sibelius aggiorna l’elenco di idee nella 
sezione principale della finestra.

I pulsanti Partitura e Libreria consentono di scegliere se le idee mostrate nella finestra proven-
gono dalla partitura corrente, dalla libreria (un deposito di idee disponibili per ogni partitura sulla 
quale si lavora, incluse le idee interne e altre idee che si collocano nella libreria) o entrambi (vedere 
Dove sono salvate le idee?). Si noti che se nella partitura sulla quale si lavora non ci sono 
idee, il pulsante Partitura non è abilitato e non è possibile disattivare il pulsante Libreria.

La sezione principale della finestra mostra le anteprime delle idee che corrispondono alle etichette 
correnti in ordine d’importanza decrescente o (se non si è digitato nulla nel box in cima alla 
finestra) tutte le idee disponibili (nella partitura e/o libreria), con quelle più recenti catturate o 
modificate in cima all’elenco.

Ogni idea elencata visualizza una piccola anteprima di musica o oggetti in essa contenuti; in gen-
erale, si vedono due o tre misure del rigo in alto. Le etichette importanti appaiono ai quattro angoli 
intorno alla notazione in anteprima: in alto a sinistra, c’è il nome dell’idea; in alto a destra appare la 
lettera L se l’idea si trova nella libreria invece che nella partitura corrente; in basso a sinistra c’è il 
tempo in chiave dell’idea e in basso a destra il tempo dell’idea. Fermando il mouse su un’idea 
appare una descrizione comandi che mostra altre etichette, compresa la strumentazione. Per non 
vedere la notazione in anteprima disattivare l’opzione Mostra anteprima notazione nella 
finestra Idee nella pagina Idee della finestra File > Preferenze (menu Sibelius in Mac); in tal 
caso, si vedrà solo il nome e il tempo dell’idea.

Digitare l’etichetta qui...
...o cliccare sulla freccia 
per vedere un elenco...

...poi scegliere se visualizzare le 
idee dalla partitura o libreria

corrente (o entrambi).
L’idea selezionata ha un contorno; 
usare i tasti 2/3 per spostare una 
selezione dopo aver cliccato su una.

Cattura idea

Copia
Modifica Elimina

Veduta dettagliata

Aggiungi alla libreria
Aggiungi alla partituraIncolla Modifica 

Info idea
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Ogni idea appare con uno sfondo colorato, che si può cambiare per catalogarla ulteriormente; di 
default, le nuove idee catturate dall’utente hanno lo sfondo bianco.

Con un clic-destro (Windows) o Control-clic (Mac) del mouse su un’idea nell’elenco appare un 
menu con una serie di utili opzioni. Esse sono come i pulsanti alla base della finestra:

* Copia: copia l’idea selezionata sugli Appunti, in modo da poterla incollare nella partitura; vedere 
Incollare un’idea.

* Incolla: incolla il contenuto corrente sugli Appunti nella partitura; se nella partitura c’è una 
selezione, il contenuto degli Appunti viene incollato direttamente in quella posizione; se non c’è 
una selezione il puntatore del mouse si colora in blu e si può cliccare per incollare in quella 
posizione.

* Modifica: modifca l’idea selezionata; vedere Modificare un’idea.
* Modifica info idea: consente di modificare etichette e colore di un’idea e vedere le etichette che 

Sibelius assegna automaticamente all’idea.
* Elimina: cancella l’idea selezionata dalla raccolta di idee salvata nella libreria o nella partitura.
* Aggiungi alla partitura: è abilitata solo se l’idea selezionata si trova nella libreria e permette di 

copiare l’idea dalla libreria alla raccolta di idee nella partitura corrente.
* Aggiungi alla libreria: è abilitata solo se l’idea selezionata si trova nella raccolta di idee nella 

partitura e consente di copiare l’idea dalla partitura corrente alla libreria.
* Vista Dettagliata: consente di passare alla veduta dettagliata della finestra:

La veduta dettagliata ha quasi la stessa funzionalità di quella compatta, ma (ovviamente) è più det-
tagliata. Invece di vedere una breve notazione in anteprima di ogni idea, si può vedere l’anteprima 
completa di un’idea nella finestrella alla base della finestra. L’elenco nella finestrella superiore della 
finestra mostra tutte le etichette che appartengono a ogni idea e può essere ordinato cliccando su 
una delle intestazioni colonna. Per cambiare la larghezza delle colonne (o l’ordine delle colonne) 
trascinarle con il mouse. È possibile inoltre cambiare l’altezza delle due finestrelle nella finestra 
trascinando in alto o in basso il divisore che le separa.

Si noti che l’altezza della finestra Idee si può cambiare solo nella veduta compatta, mentre in quella 
dettagliata la finestra si può ridimensionare in entrambe le direzioni.

Trascinare il divisore in alto e in basso 
per cambiare l’altezza dell’elenco e delle 
finestrelle d’anteprima

Cliccare su un nome colonna per 
ordinare l’elenco in base a quella col-
onna; trascinare le colonne a sinistra 
o destra per riordinarle

Torna alla veduta compatta
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La veduta dettagliata ha due pulsanti extra non presenti nella veduta compatta; essi servono per 
importare ed esportare le idee – vedere Dove sono salvate le idee?

Ascolto delle idee
Per sentire come suona un’idea, cliccarci sopra nella finestra Idee tenendo premuto il pulsante sin-
istro del mouse per ascoltarla; Sibelius riproduce l’idea in loop ripetendola fino a otto volte. 
Per fare in modo che Sibelius la riproduca solo una volta invece che in loop, disattivare l’opzione 
Ripeti automaticamente idee in fase di preascolto nella pagina Idee della finestra File > Pref-
erenze (menu Sibelius in Mac).

Catturare un’idea
Un’idea si crea selezionando della musica nella partitura e scegliendo Modifica > Cattura idea
(comando rapido Maius-I). Si può catturare un’idea da qualsiasi tipo di selezione, inclusi:

* Selezioni di passaggi formati da un numero qualsiasi di misure e righi; attenzione a selezionare 
un passaggio di sistema, poiché gli oggetti di sistema (tempi in chiave, stanghette di ripetizione, 
scritte Tempo, ecc.) sono esclusi dall’idea – le idee non possono contenere oggetti di sistema. 
Non è possibile nemmeno catturare un’idea da una selezione che comprende righi non contigui.

* Un singolo oggetto selezionato (es. una nota, un oggetto di testo, una linea, ecc.). Anche in 
questo caso, non è possibile catturare in un’idea un oggetto di sistema.

* Selezioni multiple di note (es. il primo e terzo movimento di una misura, selezionato con 
Ctrl+clic o X-clic del mouse oppure da un filtro). Quando sono catturate in idee, le selezioni 
multiple sono trasformate in selezioni di passaggio, perciò quando si modifica o incolla un’idea 
si vedrà che è integrata dalle opportune pause.

* Selezioni multiple di cose diverse dalle note (es. serie di oggetti di testo Expression e forcine, 
selezionati con Ctrl+clic o X-clic del mouse oppure da un filtro).

(Per maggiori informazioni sui vari tipi di selezioni, b Selezioni e passaggi.)

Alcune cose, ovviamente, non si possono catturare in idee. Per esempio, non è possibile catturare 
un’alterazione, tratto d’unione o articolazione senza catturare la nota (o note) alla quale è attaccata. 
Come regola generale, ciò che si può copiare e incollare si può catturare come idea.

Se la finestra Idee è aperta (e non è stata digitata alcuna etichetta nel box in cima alla finestra), 
l’idea appare in cima alla finestra. Sibelius sceglie automaticamente un nome per l’idea prendendo 
spunto dal titolo o nome file della partitura e aggiungendo un numero (per garantirne la peculiar-
ità); volendo, il nome si può cambiare in seguito.

Trovare un’idea
Per trovare un’idea, digitare una o più etichette nel box in cima alla finestra Idee e scegliere un’idea 
dall’elenco.

Digitando nel box, Sibelius scorre il menu sottostante visualizzando le etichette che soddisfano le 
corrispondenze digitate (per esempio, digitando “cl” si vedrà “clarinet”, “closed”, “classical” e non 
appena s’aggiunge una “a”, la parola “closed” scomparirà dall’elenco). Si può continuare a digitare, 
oppure usare i tasti freccia o il mouse per selezionare una delle etichette dall’elenco. 
Non appena è stata scelta un’etichetta o si è premuto spazio (ad indicare che si è concluso l’inseri-
mento di un’etichetta) l’elenco delle idee nella sezione principale della finestra è aggiornato.
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Si può quindi digitare un’altra etichetta; aggiungendo una seconda etichetta, solo le idee che corri-
spondono sia all’etichetta originale sia a quella nuova appaiono nell’elenco. Come prima, quando 
s’inizia a digitare nel box il menu scorre e indica le possibili etichette che corrispondono alle lettere 
digitate fino a quel momento.

Ogni volta che s’aggiunge un’altra etichetta, la scelta di idee nella sezione principale della finestra 
si riduce opportunamente, per visualizzare solo le idee che corrispondono a tutte le etichette digi-
tate nel box. È possibile poi selezionare l’idea desiderata cliccandoci sopra nell’elenco.

Le idee sono elencate nella sezione principale della finestra Idee in ordine di rilevanza decrescente. 
Se l’etichetta digitata è nel nome (Nome) dell’idea è considerata molto rilevante; se è nell’elenco 
generale delle etichette (Parole chiave) è considerata abbastanza rilevante; se è nelle etichette 
generate automaticamente da Sibelius è considerata poco rilevante.

Incollare un’idea
Prima di poter incollare un’idea bisogna copiarla sugli Appunti; per farlo, selezionarla nella 
finestra Idee e premere Ctrl+C o XC o cliccare sul pulsante Copia alla base della finestra, oppure 
clic-destro (Windows) o Control-clic (Mac) del mouse e scegliere Copia dal menu contestuale.

Incollare un’idea in una partitura è come qualsiasi altra operazione incolla: selezionare la posizione 
nella partitura alla quale incollare l’idea e scegliere Modifica > Incolla (Ctrl+V o XV). Altrimenti, 
assicurarsi che non vi sia nulla di selezionato, scegliere Modifica > Incolla e cliccare nella partitura 
dove si desidera inserire l’idea (si può anche cliccare sul pulsante Incolla alla base della finestra 
Idee).

Come per ogni altra operazione incolla, si può usare la copia multipla per incollare molte copie di 
un’idea (vedere Copia multipla di un passaggio a pagina 48), oppure selezionare Modifica >
Ripeti (comando rapido R) subito dopo l’incollaggio, per ripetere l’idea dopo se stessa.

A differenza dell’operazione incolla normale, tuttavia, quando s’incolla un’idea Sibelius esegue di 
default altre operazioni supplementari: trasporta l’idea per farla corrispondere alla tonalità preva-
lente della partitura nel punto in cui la s’incolla; inoltre, trasporta l’idea in ottave per garantire che 
la musica rimanga all’interno dell’estensione suonabile dello strumento nel quale viene incollata.

Quando Sibelius trasporta un’idea per farla corrispondere alla tonalità corrente, trasporta tutte le 
note in alto o in basso dello stesso intervallo, quindi se l’idea è in una tonalità maggiore e la 
s’incolla in una tonalità minore, l’idea incollata “suona” ancora in maggiore (sebbene, se necessa-
rio, si possa eseguire un trasporto modale con il plug-in Trasforma Scala – vedere Trasforma 
Scala a pagina 403). Se invece si preferisce che Sibelius non trasporti le idee, disattivare l’opzione 
Trasponi con le alterazioni in chiave attuali nella pagina Idee della finestra File > Preferenze
(menu Sibelius in Mac).

Analogamente, se non si vuole che Sibelius provi a fare in modo che l’idea rientri nell’estensione 
dello strumento nel quale la si sta incollando, disattivare l’opzione Trasponi di ottava per in base 
al range degli strumenti (sempre nella pagina Idee della finestra File > Preferenze).

Per rintracciare le posizioni in cui sono state usate le idee nella partitura (o se un insegnante vuole 
vedere dove gli studenti le hanno usate) attivare l’opzione Crea evidenziazione a colori (pagina 
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Idee della finestra File > Preferenze, menu Sibelius in Mac); si crea un’evidenziazione nello 
sfondo colore dell’idea ove è stata incollata.

Modificare un’idea
Si può modificare sia la musica sia le etichette di un’idea.

Per modificare le etichette di un’idea, selezionarla nella finestra 
Idee e cliccare sul pulsante Modifica Info Idea alla base della 
finestra o clic-destro del mouse e selezionare Modifica Info 
Idea dal menu contestuale; appare la finestra a destra.

Per modificare Nome e Parole chiave dell’idea digitare nei ris-
pettivi box. Per cambiare il colore di sfondo dell’idea cliccare su 
Imposta colore e scegliere il colore dal raccoglitore che appare.

In questa finestra è possibile anche vedere tutte le etichette auto-
matiche create da Sibelius (sebbene non si possano modificare); 
esse s’aggiornano automaticamente modificando la musica 
dell’idea.

Per modificare la musica in un’idea, selezionarla nella finestra 
Idee, poi cliccare sul pulsante Modifica Idea alla base della 
finestra oppure clic-destro del mouse e scegliere Modifica Idea dal menu contestuale.

Appare una nuova finestra (come se fosse stata aperta un’altra partitura). L’idea è visualizzata in 
Panorama (b Panorama) e si può modificarla, come qualsiasi altra partitura.

Una volta modificata l’idea, salvarla mediante File > Salva (Ctrl+S o XS) e chiudere la finestra con 
File > Chiudi (Ctrl+W o XW) per ritornare alla partitura originale.

Per ignorare tutte le modifiche non salvate nell’idea, selezionare File > Chiudi e cliccare su No
quando Sibelius chiede se si desidera salvare le modifiche eseguite.

Dove sono salvate le idee?
Un’idea può essere salvata nella partitura corrente o nella libreria. Se un’idea è salvata in una parti-
tura può apparire nella finestra Idee solo quando la partitura è aperta e il pulsante Partitura è 
attivo; se un’idea è salvata nella libreria può apparire nella finestra Idee quando è aperta una qual-
siasi partitura (sempre che sia attivo il pulsante Libreria).

Di default, quando si cattura un’idea essa è aggiunta alla partitura corrente, quindi è disponibile 
solo su quella partitura (a meno che non la si selezioni e si clicchi sul pulsante Aggiungi alla libre-
ria nella finestra Idee. Se invece si preferisce inviare direttamente tutte le idee nella libreria, atti-
vare l’opzione Aggiungi idee catturate alla libreria nella pagina Idee della finestra File >
Preferenze (menu Sibelius in Mac).

La libreria è un grande deposito di idee da usare in molte partiture diverse, invece che in una sola; 
qui sono salvate anche le idee interne; se non si vogliono vedere (ma nella libreria si vogliono ved-
ere solo le proprie idee) disattivare l’opzione Mostra idee integrate. Le idee interne sono salvate 
nella cartelle programma di Sibelius (Windows) o nel pacchetto appplicativo (Mac) ed è meglio 
non toccarle. Le proprie idee conservate nella libreria sono salvate in una cartella denominata Idee
nella cartella dati d’applicazione del proprio account, ma anche qui è meglio non interferire diret-
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tamente con questi file (vedere File modificabili dall’utente a pagina 562), perché Sibelius ha 
funzioni interne per importarli ed esportarli in modo da condividerli con altri utenti.

Condividere le idee
Ci sono due modi per condividere le proprie idee con altri: il primo è salvare le idee da condividere 
su una partitura specifica e poi distribuirla (è utile nella realizzazione di progetti per gli studenti – 
vedere Usare le idee per insegnare); il secondo è esportare una selezione di idee in un file 
.Idee che in seguito può essere importato nella libreria idee di un altro utente.

Per salvare le idee su una partitura, selezionare quelle da trasferire sulla partitura e cliccare sul pul-
sante Aggiungi alla partitura alla base della finestra Idee, oppure clic-destro del mouse e sceg-
liere Aggiungi alla partitura dal menu contestuale. Si possono selezionare simultaneamente più 
idee solo se si sta usando la veduta dettagliata della finestra Idee, quindi è quella la veduta più utile 
per questo tipo di operazione. Verificare che nella partitura vi siano le idee giuste disattivando il 
pulsante Libreria nella finestra Idee, in modo che appaiano solo le idee salvate nella partitura.

Per esportare una selezione di idee si deve usare la veduta dettagliata della finestra Idee. Selezion-
are come al solito le idee da esportare – Maius-clic per selezionare un intervallo contiguo di idee 
dall’elenco, oppure Ctrl+clic o X-clic per selezionare più idee tracciando una linea tratteggiata 
intorno all’elenco – e cliccare sul pulsante Esporta alla base della finestra oppure clic-destro (Win-
dows) o Control-clic (Mac) del mouse e selezionare Esporta dal menu contestuale. Sibelius chiede 
un nome file e una destinazione ove salvare le idee; cliccando su Salva viene salvato un file .idee 
sulla posizione selezionata; si può quindi inviare il file .idee a qualcuno (es. via e-mail) o al sito 
SibeliusEducation.com.

Importare le idee
Per importare le idee nella propria libreria (es. in seguito alla ricezione di un file .idee da un altro 
utente Sibelius) attivare la veduta dettagliata della finestra Idee e cliccare su Importa. Sibelius 
chiede di scegliere il file .idee da importare; cliccare su Apri: appare una finestra di dialogo ove 
specificare se le idee entranti devono essere aggiunte alla libreria o a una delle partiture correnti 
aperte.

Accesso limitato alla libreria
Se lavorando su una partitura specifica non si vogliono mai vedere le idee dalla libreria (es. si sta 
preparando una lezione per gli studenti, sulla quale ad essi è consentito lavorare solo con un set 
specifico di idee definite dall’insegnante e salvate nella partitura stessa) attivare l’opzione Mostra 
Idee solo da questa partitura nella pagina File della finestra File > Info partitura.

Con questa opzione attiva, il pulsante Libreria nella finestra Idee è disabilitato, quindi solo le idee 
salvate nella partitura saranno visibili quando si lavora su quella partitura.

Idee interne
Sibelius ha oltre 2000 idee interne per compositori di tutte le età; esse riguardano tutti gli stili 
musicali possibili ad un livello di base.

Ogni idea ha un nome peculiare; di solito si tratta del nome seguito dallo strumento (o strumenti) 
nell’idea e un numero. In generale, più alto è il numero più complessa è la musica nell’idea. 
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Le idee interne sono anche codificate da colori in base al genere (in parentesi seguendo il nome di 
ogni stile musicale nell’elenco che segue). 

Per trovare le idee in uno stile musicale specifico, prima digitare una delle seguenti etichette:

Si possono restringere le corrispondenze usando etichette come:

* Strumento: es. chitarra, batteria, piano.
* Tempo: es. presto, lento, moderato.
* Tipo idea: es. melodia, accompagnamento, ritmo.
* Complessità: es. elementare, media, complessa.
* Atmosfera: es. allegra, triste, riflessiva.
* Caratteristiche: es. eccitante, vitale, rilassato, maestoso, maggiore, minore, swing, drammatico, 

divertente.

Digitare una o più etichette prelevandole da una o più di queste categorie; si troveranno presto idee 
adatte ai propri scopi.

Altri consigli utili per l’uso delle idee interne nelle proprie partiture:

* Le idee hanno durate diverse (di solito da due a otto misure). Le idee più lunghe sono ideali per 
spiegare (ad esempio) punti particolari in una composizione, stile o tecniche esecutive; le idee 
più brevi servono per adattamenti, ripetizioni o altri impieghi nelle proprie composizioni.

* Quasi tutte le idee sono per singoli strumenti (come specificato nei nomi) e funzionano meglio 
se incollate su un particolare strumento o uno simile. Tuttavia, si può incollare un’idea su un rigo 
qualsiasi nella partitura; Sibelius lo trasporterà per adattarlo all’estensione del rispettivo stru-
mento, quindi sperimentare in tutta libertà.

* Tutte le idee in uno stile musicale sono destinate a lavorare insieme, sebbene non necessaria-
mente condividano le stesse strutture armoniche o sequenze d’accordi. Idee con lo stesso 
numero per strumenti diversi (es. Reggae Bass 1 e Reggae Keyboard 1) in generale si amalga-
mano meglio tra loro.

* Le idee interne suonano al meglio se riprodotte con Sibelius Sounds Essentials (b Sibelius 
Sounds Essentials) e l’opzione Play > Live Playback attiva (b Live Playback), ma natural-
mente si possono riprodurre con qualsiasi dispositivo.

* African (pesca)
* Chill Out (verde pastello)
* Classical (verde opaco)
* Concert Band (verde brillante)
* Country (giallo)
* Dance (grigio)
* Film (blu chiaro)
* Folk (oliva)
* Funk (grigio-rosa)
* Garage (blu indistinto)

* Groovy (rosa pastello)
* Hip Hop (blu pastello)
* Jazz (rosa medio)
* Latin (arancione)
* Marching Band (turchese)
* Modern Classical (verde scuro)
* Motown (beige)
* Pop (blu brillante)
* Reggae (viola)
* Rock (rosa brillante)
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Usare le idee per insegnare
Un insegnante probabilmente trova subito dozzine di modi per usare in modo creativo le idee di 
Sibelius per il suo programma didattico; tuttavia, ecco alcuni consigli pratici grazie ai quali anche 
gli studenti possono ottenere il massimo da queste funzioni:

* Ascolto idee di notazione: gli studenti non particolarmente abili nella lettura musicale si render-
anno conto che la possibilità di ascoltare le idee semplicemente cliccandoci sopra nella finestra 
Idee accenderà la loro creatività.

* Creare ostinati in forma ABA: mostrare agli studenti come creare uno strumento adeguato nella 
partitura con l’opzione Crea > Strumenti e righi (comando rapido I) e incollare un’idea sul rigo. 
Mostrare loro come ripetere velocemente un’idea dopo averla incollata con il comando 
Modifica > Ripeti (comando rapido R). Con queste semplici tecniche gli studenti impareranno 
presto a realizzare le proprie composizioni usando le idee interne di Sibelius.

* Verificare la loro creatività con evidenziature colorate: attivare l’opzione Crea evidenziazione a 
colori (pagina Idee della finestra File > Preferenze, menu Sibelius in Mac) aiuta gli studenti a 
vedere gli schemi realizzati usando le idee insieme; l’insegnante, a sua volta, può vedere dove gli 
studenti hanno usato le idee o creato musica propria in base alla presenza o assenza di queste 
evidenziazioni.

* Creare modelli della partitura: è possibile realizzare semplici progetti per gli studenti configu-
rando un modello di partitura (template) che include idee appositamente scelte. Per esempio, si 
possono creare righi vuoti per piccoli gruppi jazz (batteria, tastiera, basso e uno strumento 
solista come un sax). È possibile quindi prelevare le idee più opportune dalla libreria interna e 
aggiungerle alla partitura (selezionandole e scegliendo Aggiungi alla partitura nella finestra 
Idee) per dare agli studenti il materiale di base (es. alcune linee di basso, alcuni riff di tastiera e 
alcuni pattern di batteria) per realizzare un blues in 12-misure. Attivando l’opzione Mostra idee 
solo da questa partitura (pagina Idee della finestra File > Info partitura) gli studenti potranno 
scegliere solo una delle idee che l’insegnante ha selezionato per loro quando si lavora con questo 
file.

* Improvvisare una melodia: incoraggiare gli studenti più capaci a improvvisare una melodia per 
lo strumento dopo che hanno realizzato una buona base di basso, piano e batteria con le idee a 
disposizione.

Le funzioni delle idee di Sibelius offrono anche:

* Elementi per lo studio della musica.
* Utilizzo delle idee per chiamata e/o risposta.
* Esperimenti con il cambio dei suoni strumento.
* Ear training attraverso un riconoscimento in loop e dettato melodico.
* Possibilità per gli studenti di catturare le proprie idee da mettere a disposizione degli studenti 

più giovani.
* Aiuto agli studenti nella realizzazione di musica pop/dance.

Una serie di idee interne (in particolare quelle “Classical”) sono punti di partenza specifici per la 
composizione e riguardano molti argomenti di composizione per i livelli musicali GCSE e AS / A2.

Per altri suggerimenti visitare il sito www.sibeliuseducation.com.
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5.9 Menu e comandi rapidi

Quasi ogni funzione Sibelius può essere eseguita usando solamente la tastiera del computer. 
Una volta imparati i comandi rapidi per le funzioni usate più spesso, Sibelius sarà ancora più facile 
e veloce da usare.

Gran parte dei comandi rapidi sono nei menu di Sibelius e appaiono in questo Manuale opera-
tivo ogni volta che si nomina una funzione con un comando rapido; nelle prossime pagine c’è un 
elenco completo dei comandi rapidi; quelli essenziali sono elencati anche in fondo alla Guida.

È possibile personalizzare a piacere i comandi rapidi e si possono anche abilitare o disabilitare fun-
zioni particolari nei menu di Sibelius (utile nelle scuole) – vedere in seguito.

I dettagli sulle convenzioni usate in questo Manuale Operativo per nominare menu e comandi 
rapidi sono descritti all’inizio della Guida.

Schemi dei comandi rapidi
Ecco alcuni schemi dei comandi rapidi che consentono di ricordarli meglio:

* Le operazioni standard comuni a tutti i programmi (es. Nuovo, Copia, Stampa, Trova, Salva, 
Undo) usano comandi rapidi standard (in genere, Ctrl o X più la lettera iniziale dell’operazi-
one). 
Le eccezioni degne di nota sono Undo (Ctrl+Z o XZ) e Incolla (Ctrl+V o XV).

* La maggior parte dei comandi rapidi nel menu Crea (tranne i testi) sono una lettera singola, in 
genere quella inziale (es. L per Line, K per Key Signature - Alterazioni in chiave).

* I comandi rapidi nel menu Crea > Testo sono Ctrl o X, o Ctrl+Alt o zX, più la lettera iniziale 
(es. Ctrl+E o XE per Expression, Ctrl+T o XT per Technique, Ctrl+Alt+T o zXT per Tempo).

* La maggior parte dei comandi rapidi nei menu Note, Layout e House Style sono Ctrl+Maius
o xX più la lettera iniziale. Per le opzioni Layout > Ripristina... si usa la lettera iniziale dell’ele-
mento da resettare (es. Ctrl+Maius+P o xXP per Resetta posizione).

* I comandi rapidi delle finestre Tool sono Ctrl+Alt o zX più la lettera iniziale (o una lettera del 
nome) della finestra da mostrare o nascondere.

* Ctrl o X con i tasti freccia o Home/End/Page Up/Page Down significano “step grandi”; per 
esempio, con una nota selezionata Ctrl+3 o X3 la trasporta di un’ottava; con una misura selez-
ionata Ctrl+Maius+Alt+1 o xzX1 aumenta molto la spaziatura nota.

* Maius con le frecce o un clic del mouse significano “estendere la selezione”; per esempio, con 
una misura selezionata Maius-3 estende la selezione al rigo sopra.

Differenze Windows/Mac
Sibelius e i comandi rapidi sono praticamente identici in Windows e Mac. Il tasto Command (X) 
in Mac equivale al tasto Ctrl in Windows e il tasto Option (z) in Mac equivale al tasto Alt in Win-
dows. In pratica, quindi, quasi tutti i comandi rapidi sono intercambiabili sempre che, ad esempio, 
X sia opportunamente sostituito da Ctrl; le eccezioni sono poche e chiaramente evidenziate (ove 
necessario).
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Il mouse standard di Mac ha solo un pulsante, quindi gli utenti Mac devono usare Control-clic per 
accedere ai menu contestuali, mentre gli utenti Windows usano un clic-destro.

Funzioni Scuola
Sibelius ha un set di funzioni didattiche già pronte denominate Funzioni scuola che disabilitano 
tutte le funzioni avanzate del programma. Per usare questo set di funzioni selezionare la pagina 
Menu e scorciatoie della finestra File > Preferenze (menu Sibelius in Mac), scegliere Funzioni 
scuola dal menu a tendina e cliccare OK.

Le funzioni che restano abilitate sono quelle più usate dagli studenti (es. l’inserimento di note e 
altri oggetti comuni, la riproduzione di base, la stampa), mentre le funzioni più avanzate (o quelle 
con le quali non si vuole che giochino gli studenti!) sono disabilitate (per esempio, la maggior 
parte delle funzioni nei menu House Style e Layout, funzioni di riproduzione avanzate, plug-in e 
i link web del menu Aiuto).

Le funzioni abilitate sono utili con Sibelius Notes, un pacchetto completo di risorse didattiche per 
l’insegnamento in classe con Sibelius; per i dettagli vedere b SibeliusEducation.com.

Sibelius non inpedisce agli studenti di entrare nella finestra di dialogo Preferences per attivare le 
funzioni disabilitate, ma l’insegnante può punirli se tentano di farlo!

Si può anche usare Funzioni scuola come base per il proprio set di funzioni – vedere Abilitare e 
disabilitare le funzioni.

Funzioni computer portatile (solo Windows)
Sibelius ha un set di funzioni appositamente studiate per gli utenti di computer portatili Windows 
senza pad numerico. Per usare questo set scegliere File > Preferenze e selezionare la pagina Menu 
e scorciatoie. Scegliere Funzioni computer portatile dal menu a tendina e cliccare OK. 
Per maggiori informazioni vedere Accedere alle funzioni del pad numerico di un note-
book (portatile) on page 18.

Personalizzare i comandi rapidi
È possibile personalizzare a piacere i comandi rapidi esistenti in Sibelius. Per esempio, se si usano 
spesso le terzine e premere Ctrl+3 o X3 risulta noioso, si può assegnare come comando rapido un 
singolo tasto (preferibilmente non usato, come U).
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Per iniziare selezionare la pagina Menu e scorciatoie della finestra File > Preferenze (menu 
Sibelius in Mac); appare questa finestra di dialogo:

Prima di poter definire un nuovo comando rapido si deve creare un nuovo set funzioni, cioè un set 
specifico di comandi rapidi e funzioni abilitate (vedere Abilitare e disabilitare le funzioni). 
Di default, Sibelius usa il set Menu standard e scorciatoie da tastiera (sebbene ci siano altri set 
– vedere sopra), ma si possono avere tanti set quanti si desidera; per crearne uno:

* Scorrere l’elenco in cima alla finestra e cliccare Aggiungi set funzioni per creare un nuovo set.
* Nella finestra Nuovo Set Funzioni digitare un nome adeguato. L’opzione Usa come base il set 

di default (attiva di default) è raccomandata: essa mantiene tutti i comandi rapidi standard di 
Sibelius e consente di aggiungerne altri – disattivandola si dovrà definire da zero ogni singolo 
comando rapido.

* Cliccare OK: il nuovo set di funzioni si seleziona nella finestra Menu e scorciatoie.

* Per cancellare o rinominare un set funzioni selezionare Modifica set funzioni dall’elenco. Si 
può anche duplicare un set funzioni esistente; ciò è utile per basare un nuovo set sul quello Fun-
zioni scuola fornito da Sibelius.

A questo punto si possono definire i propri comandi rapidi:

* Tutte le funzioni personalizzabili con i comandi rapidi sono organizzate in base ai rispettivi 
Menu o Categoria; selezionare l’opzione adeguata nell’elenco (per esempio, Tuplets).

* L’elenco Caratteristica mostra le funzioni disponibili nel menu o categoria scelti; selezionare 
Triplet.

* Nel box Scorciatoie da tastiera a destra sono visualizzati tutti i comandi rapidi correnti per 
quella funzione; è indicato il comando rapido standard per la creazione di una terzina.

* Si può selezionare il comando rapido esistente e cliccare Cancella per rimuoverlo ma raramente 
è necessario, poiché si possono definire più comandi rapidi per la stessa funzione; il primo 
comando rapido elencato è quello che appare nei menu Sibelius (se quella funzione ha un ele-
mento nel menu). Aggiungiamo quindi un altro comando rapido: cliccare Aggiungi.
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* Si apre la finestra Aggiungi scorciatoia da tastiera; digitare il proprio comando rapido (in 
questo caso solo U) e cliccare OK. Si può digitare un solo tasto o una combinazione di tasti 
(come Ctrl+Alt+U o zXU), ma singoli comandi rapidi sono più pratici.

* Se il comando rapido scelto è già usato da un’altra funzione, Sibelius chiede se deve sostituirlo.
* Terminata la personalizzazione dei comandi rapidi cliccare OK per chiudere la finesra di dialogo 

Menu e scorciatoie.

Alcune cose da ricordare quando si personalizzano i comandi rapidi:

* Teoricamente è possibile riassegnare i tasti sul tastierino numerico (utile per simulare altri pro-
grammi musicali) ma il tastierino numerico sullo schermo non si riarrangia magicamente da 
solo: quindi se 3 sul tastierino numerico diventa il comando rapido per la terzina, non si ha la 
terzina disegnata lì.

* In Mac, non è possibile assegnare una serie di combinazioni, poiché esse sono occupate dal 
sistema operativo, comprese: xX0–9, F1–F12, zXT, XM e XH.

* In Windows, i tasti principali che non possono essere assegnati sono: Alt+F, Alt+E, Alt+V, 
Alt+N, Alt+C, Alt+P, Alt+L, Alt+S, Alt+U, Alt+W, Alt+H – essi sono i comandi rapidi per 
ogni menu di Sibelius. Non tentare di riassegnare altri comandi rapidi standard di Windows 
come Ctrl+F4, Alt+F4, Ctrl+Esc, Ctrl+Tab, Alt+Tab, e così via.

Per personalizzare i comandi rapidi degli oggetti nei menu scritte, b Lavorare con i testi.

Trovare comandi rapidi inutilizzati
È possibile che ci siano vari comandi rapidi non usati dai set standard di Sibelius. In generale, si 
tratta della maggior parte delle combinazioni di singole lettere; Ctrl o X più lettere e Ctrl+Maius o
xX più lettere (e un numero inferiore di Ctrl+Maius+Alt o xzX più lettere) sono già usati di 
default, ma senza toccare questi si può usare:

* Ctrl+Maius o xX, oppure Ctrl+Maius+Alt o xzX, più i numeri sulla tastiera principale.
* Ctrl o X, Ctrl+Maius o xX, oppure Ctrl+Maius+Alt o xzX più gran parte dei tasti funzione.
* Comandi rapidi singoli che usano tasti di punteggiatura (es. , . / # ; ecc.).

Un elenco di tutti i comandi rapidi di default usati in Sibelius si può scaricare da Internet; selezion-
are Aiuto > Centro assistenza per visitare il centro d’assistenza on-line.

Abilitare e disabilitare le funzioni
Oltre che consentire la personalizzazione dei comandi rapidi, la pagina Menu e scorciatoie della 
finestra Preferenze permette di disabilitare selettivamente singole funzioni; ciò può essere utile a 
scopo didattico, per impedire agli studenti di usare particolari funzioni del programma.

Per farlo, creare un set di funzioni (basato sul set Funzioni scuola, ad esempio – non è possibile 
disabilitare le funzioni nel set di default) –vedere Personalizzare i comandi rapidi. Scegliere 
poi la funzione da disabilitare dall’elenco Caratteristica e disattivare l’opzione Abilita caratteris-
tica. Le funzioni disabilitate non scompaiono dai menu di Sibelius, ma sono sfumate in grigio e 
non possono essere usate dai rispettivi comandi rapidi.
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Condividere i set di funzioni
I set di funzioni sono salvati nella cartella Menu e scorciatoie all’interno della cartella applica-
tion data del sistema (vedere File modificabili dall’utente on page 562) con estensione file 
.sfs. È possibile trasferire i set di funzioni da un computer a un altro semplicemente copiando 
questo file e poi scegliendo il set di funzioni copiato dalla pagina Menu e scorciatoie della 
finestra di dialogo File > Preferenze del secondo computer (menu Sibelius in Mac).

I file dei set di funzioni dipendono dalla piattaforma operativa; un set di funzioni creato in Win-
dows non funziona su Mac, e viceversa (perché i tasti sulle tastiere Windows e Mac sono diversi).

Ri-memorizzare i comandi rapidi di default
Per riportare i comandi rapidi alle rispettive impostazioni di default selezionare di nuovo il set di 
funzioni Menu standard e scorciatoie da tastiera nella pagina Menu e scorciatoie della 
finestra di dialogo File > Preferenze (menu Sibelius in Mac) e cliccare OK.

Funzione Comando rapido Windows Comando rapido Mac

File

Nuovo Ctrl+N XN

Apri Ctrl+O XO

Chiudi Ctrl+F4 / Ctrl+W XW

Chiudi Tutti Ctrl+Alt+W zXW

Salva Ctrl+S XS

Salva con nome Ctrl+Maius+S xXS

Creazione note

Inserimento Note N N

y / x / e / q / h / w 1/2/3/4/5/6 (pad numerico) 1/2/3/4/5/6 (pad numerico)z

§ / # / b (on/off) 7/8/9 (pad numerico) 7/8/9 (pad numerico)

> .  – (on/off) / * - = / *

Punto ritmico . (punto) . (punto)

Creazione nota A/B/C/D/E/F/G o suonare nota/
accordo sulla tastiera MIDI

A/B/C/D/E/F/G o suonare nota/
accordo sulla tastiera MIDI

Crezione pausa 0 (pad numerico) 0 (pad numerico)

Aggiunta intervallo sopra 1/2/3/4/5/6/7/8/9 
(tastiera principale)

1/2/3/4/5/6/7/8/9 
(tastiera principale)

Aggiunta intervallo sotto Maius+1/2/3/4/5/6/7/8/9 
(tastiera principale)

x1/2/3/4/5/6/7/8/9 
(tastiera principale)

Aggiunta altezza sopra Maius+A-G xA-G

Legatura di valore (on/off) Invio (pad numerico) Invio (pad numerico)

Inizio nuova voce N Alt+2/3/4 N z2/3/4

Flexi-time™

Flexi-time Ctrl+Maius+F xXF

Fine Flexi-time Spazio Spazio

Opzioni Flexi-time Ctrl+Maius+O xXO

Modifica note
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Re-inserimento altezze Ctrl+Maius+I xXI

Modifica altezza A/B/C/D/E/F/G o suonare nota/
accordo sulla tastiera MIDI

A/B/C/D/E/F/G o suonare nota/
accordo sulla tastiera MIDI

Modifica valore nota: y / x / e / q / h / w;  
inizio/fine re-inserimento altezze

1/2/3/4/5/6 (pad numerico) 1/2/3/4/5/6 (pad numerico)

Modifica alterazione: § / # / b (on/off) 7/8/9 (pad numerico) 7/8/9 (pad numerico)

Modifica articolazione(i): > .  – (on/off) / * - = / *

Trasforma in pausa(e) Canc / Backspace Canc / Backspace

Trasforma in pausa(e) singola 0 sul primo layout del T. num. 0 sul primo layout del T. num.

Rinomina alterazione Invio (tastiera principale) Invio (tastiera principale)

Cross note/chord/rest to staff above/below Ctrl+Maius+3/2 xX3/2

Testa nota standard Maius+Alt+0 (tastiera principale) xz0 (tastiera principale)

Cambio testa nota Maius+Alt+0/1/2/3… (o due 
cifre)

xz 0/1/2/3… (o due cifre)  

Tipo di testa nota/misura di pausa successiva Maius+= x=

Tipo di testa nota/misura di pausa precedente Maius+– x–

Scambia Voci 1 e 2 Maius+V xV

Transpose Maius+T xT

Arrange Ctrl+Maius+V xXV

Creazione oggetti

Crea (menu) Maius+F10 / clic-destro  
(con niente selezionato)

Control-clic  
(con niente selezionato)

Misura alla fine Ctrl+B XB

Singola misura (a metà partitura) Ctrl+Maius+B xXB

Altro misura (multipla/irregolare) Alt+B zB

Chiave Q Q

Diagramma accordo Maius-K xK

Strumenti I I

Tonalità K K

Linea L L

Legatura/legatura capovolta S/Maius+S (spazio per estenderla) S/xS (spazio per estenderla)

Forcina di crescendo/diminuendo H/Maius+H (spazio per 
estenderla)

H/xH (spazio per estenderla)

Segno di prova Ctrl+R XR

Simbolo Z Z

Tempo in chiave T T

Terzina Ctrl+3 (tastiera principale) X3 (tastiera principale)

Tuplet Ctrl+2–9 (tastiera principale) X2–9 (tastiera principale)

Creazione testi

Simbolo accordo Ctrl+K XK

Expression Ctrl+E XE

Funzione Comando rapido Windows Comando rapido Mac
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Lyrics line 1 Ctrl+L XL

Lyrics line 2 Ctrl+Alt+L zXL

Technique Ctrl+T XT

Tempo Ctrl+Alt+T zXT

Modifica testi

Inizio modifica Invio (tastiera principale) / F2 / 
doppio-clic

Invio (tastiera principale) / 
doppio-clic

Fine modifica Esc Esc 

Muovi a sinistra/destra di un carattere 0/1 0/1

Muovi a sinistra/destra di una scritta Ctrl+0/1 z0/1

Muovi a inizio/fine linea Home/End nessuno

Muovi a inizio/fine testo Ctrl+Home/End X0/1

Seleziona scritta doppio-clic del mouse doppio-clic del mouse

Seleziona carattere succ./prec. Maius+0/1 x0/1

Seleziona a fine/inizio scritta Ctrl+Maius+0/1 xz0/1

Seleziona a fine/inizio testo Ctrl+Maius+Home/End xX0/1

Select All testo Ctrl+A XA

Cancella carattere prec./succ. Backspace / Canc Backspace

Cancella scritta prec./succ. Ctrl+Backspace/Canc z-Backspace/Canc

Sostituisci testo selezionato digitare il nuovo testo digitare il nuovo testo

Nuova linea Invio / Enter Invio / Enter

Grassetto/corsivo/sottolineato on/off Ctrl+B/I/U XB/I/U

Font di default Ctrl+Alt+Spazio ^z-Spazio

Avanza alla nota/movimento successivo (parole/
simboli accordo/basso figurato/diteggiatura)

spazio spazio

Trattini alla nota successiva (parole) – (trattino) – (trattino)

Elisione (parole) _ (underscore) _ (underscore)

Spazio non d’interruzione/trattino non d’interruz-
ione (parole/simboli accordo)

Ctrl+spazio/trattino z-spazio/trattino

Menu scritte Maius+F10 / clic-destro Control-clic

f / m / n �p / r / s / z (testo Expression) Ctrl+F/M/N/P/R/S, Ctrl+Maius+Z XF/M/N/P/R/S, xXZ

cresc. / dim. (testo Expression) Ctrl+Maius+C/D xXC/D

y / x / e / q / h / w / § / # / b Ctrl+1/2/3… (pad numerico) X1/2/3… (pad numerico)

à / è / ì / ò / ù Ctrl+Maius+Alt+A/E/I/O/U z` seguito dalla lettera (es. z`A)

á / é / í / ó / ú Ctrl+Maius+A/E/I/O/U zE seguito dalla lettera

ä / ë / ï / ö / ü Alt+numero da Mappa Caratteri zU seguito dalla lettera

â / ê / î / ô / û Alt+numero da Mappa Caratteri zI seguito dalla lettera

ç / Ç Alt+numero da Mappa Caratteri zC / xzC

Altri caratteri speciali Alt+numero da Mappa Caratteri usare l’utility Keyboard Viewer

“ / ” (virgolette rapide) Alt+2 / Maius+Alt+2 z] / xz]
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‘ / ’ (virgolette singole rapide) Alt+’ / Maius+Alt+’ z[ / xz[

… (ellissi) Alt+0133 (pad numerico) z;

© Ctrl+Maius+C xXC

| (Paroliere/Titolo/Copyright) Ctrl+Maius+P xXP

$ (Tempo) Ctrl+Maius+4 ($) xX4 ($)

Ø (Tempo) Ctrl+0 (zero) X0 (zero)

< / > (in modulazioni metriche) Ctrl+[ / ] X[ / ]

Diagrammi pedale arpa (testo Technique) Ctrl+Alt+7/8/9/+ (pad numerico) zX7/8/9/+ (pad numerico)

% (simboli accordo) Maius+5 (%) x5 (%)

º / Ø / ^ (simboli accordo) Ctrl+O / Ctrl+Maius+O / 
Maius+6

XO / xXO / x6

' / ; (simboli accordo) Ctrl+Maius+A / Ctrl+Alt+O xXA / zXO

[ ] (alterazioni sovrapposte in simboli accordo) [ ] [ ]

Tablature chitarra

Cambio tasto 0/1/2/3… (o due cifre sulla tastiera 
principale)  

0/1/2/3…  
(o due cifre sulla tastiera principale)  

Muovi a sinistra/destra attraverso la misura 0/1 0/1

Muovi in alto/basso di una corda 3/2 3/2

Muovi sulla corda in cima/fondo Ctrl+3/2 X3/2

Bending J (spazio per aumentarlo) J (spazio per aumentarlo)

Pre-bending / slide / testa nota in parentesi –  / . (punto) / 1 
sul secondo layout del T. num.

* /. (punto) / 1 
sul secondo layout del T. num.

Diesis 1/4 di tono(indicato da 0.5) = (tastiera principale) = (tastiera principale)

Riproduzione & video

Play o Stop Spazio Spazio

Replay Ctrl+Spazio z-Spazio

Play From Selection P P

REW/FF (in step di 0.2 secondi) [ / ] [ / ]

Muovi indietro/avanti di un singolo frame Maius-[ / ] x[ / ]

Stop Esc Esc / X. 

All Notes Off Maius+O xO

Move Playback Line to Start Ctrl+[ X[

Move Playback Line to End Ctrl+] X]

Move Playback Line to Selection Y Y

Vai a linea di riproduzione Maius+Y xY

Live Playback Maius+L xL

Transform Live Playback Ctrl+Maius+Alt+L xzXL

Mixer (mostra/nascondi) Ctrl+Alt+M M

Hit Point Maius+Alt+P xzP
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Modifica oggetti

Undo Ctrl+Z XZ

Redo Ctrl+Y XY

Undo History Ctrl+Maius+Z xXZ

Redo History Ctrl+Maius+Y xXY

Taglia Ctrl+X XX

Copia Ctrl+C XC

Copia dove si clicca Alt+clic z-clic

Copia dove si clicca collocando la copia alla posiz-
ione verticale di default

Maius+Alt+clic xz-clic

Cattura Idea Maius-I xI

Incolla Ctrl+V XV

Paste as Cue Ctrl+Maius+Alt+V xzXV

Ripeti (nota/accordo/passaggio/testo/linea/ecc.) R R

Cancella Backspace / Canc Backspace (0) / Canc

Cancella Misure Ctrl+Backspace X0 (Backspace)

Capovolgi (gambo, legatura, tuplet, ecc.) X X

Voce 1/2/3/4/Tutte le Voci Alt+1/2/3/4/5 (tastiera princi-
pale)

z1/2/3/4/5 (tastiera principale)

Nascondi/Mostra Ctrl+Maius+H xXH

Colore Ctrl+J XJ

Ri-applica Colore Ctrl+Maius+J xXJ

Navigazione

Seleziona primo oggetto sulla pagina (con niente 
selezionato)

Tab Tab

Seleziona oggetto succ./prec. Tab/Maius+Tab Tab/x-Tab

Seleziona nota/accordo/pausa prec./succ. 0/1 0/1

Seleziona inizio misura prec./succ. Ctrl+0/1 X0/1

Seleziona fine/metà linea o intera linea Alt+0/1 z0/1

Seleziona nota/pausa sopra/sotto (in un accordo o 
rigo adiacente)

Alt+3/2 z3/2

Sposta la partitura trascinare Navigatore/foglio trascinare Navigatore/foglio

Vai in su/giù di una schermata Page Up/Down 8/9 o Page Up/Down

Vai a sinistra/destra di una schermata o pagina Home/End 4/7 (x4) o Home/End

Vai un pò in alto/basso Alt+Page Up/Down z8/9 o zPage Up/Down

Vai un pò a sinistra/destra Alt+Home/End z4/7 o zHome/End

Vai a pagina in cima/in fondo Ctrl+Page Up/Down X8/9 o X-Page Up/Down

Vai a prima/ultima pagina Ctrl+Home/End X4/7 (xX4) o X-Home/End

Vai a inizio selezione Maius+Home x4 o xHome

Vai a fine selezione Maius+End x7 o xEnd

Funzione Comando rapido Windows Comando rapido Mac

reference.book  Page 379  Wednesday, April 16, 2008  4:28 PM



5. Funzioni efficaci

380

Vai a Misura Ctrl+Alt+G xzG

Vai a Pagina Ctrl+Maius+G xXG

Zoom in/out Ctrl+=/– o +/– su pad numerico (o 
clic/clic-destro tool zoom)

X=/– o +/– su pad numerico (o clic/
z-clic tool zoom) 

Zoom al 100% Ctrl+1 X1

Zoom adattato a pagina Ctrl+0 X0

Spostamento oggetti

Sposta oggetto(i) (in step più grandi; default: 1 
spazio)

3/2/0/1 (Ctrl+3/2/0/1) 3/2/0/1 (X3/2/0/1)

Sposta oggetti scatta a posizioni ideali durante il 
movimento

Maius-trascinamento x-trascinamento

Sposta rigo/righi in alto/basso  
(in step più grandi; default: 1 spazio)

Alt+3/2 (Ctrl+Alt+3/2)  
o trascinamento

z3/2 (zX3/2) 
o trascinamento

Sposta rigo/righi in alto/basso in modo indipen-
dente (in step più grandi; dafault: 1 spazio)

Maius+Alt+3/2 
(Ctrl+Maius+Alt+3/2)  
o Maius+trascinamento

xz3/2 (xzX3/2)  
o x-trascinamento

Sposta nota/pausa/alterazione/punto ritmico/fine 
legatura (in step più grandi; default: 1 spazio)

Maius+Alt+0/1 
(Ctrl+Maius+Alt+0/1)

xz0/1 (xzX0/1)

Sposta linea (un’estremità) o parola alla nota 
succ./prec.

spazio/Maius+spazio spazio/x-spazio

Selezioni & passaggi multipli

Seleziona misura Clic sul rigo (evitando note, ecc.) clic sul rigo (evitando note, ecc.)

Seleziona misura in tutti i righi Ctrl+clic sul rigo X-clic sul rigo

Seleziona tutte le misure su un rigo (1 sistema) Doppio-clic sul rigo Doppio-clic sul rigo

Seleziona tutte le misure in tutti i righi (1 sistema) Ctrl+doppio-clic sul rigo X-doppio-clic sul rigo

Seleziona tutte le misure rigo in tutta la partitura Triplo-clic sul rigo Triplo-clic sul rigo

Edit > Select > Select Bars Ctrl+Alt+A zXA

Seleziona Passaggio di Sistema Maius+Alt+A xzA

Estendi il passaggio a un oggetto Maius+clic x-clic

Estendi il passaggio di una nota/pausa Maius+0/1 x0/1

Estendi il passaggio di una misura Ctrl+Maius+0/1 xX0/1

Estendi il passaggio di un rigo Maius+3/2 x3/2

Seleziona Tutto partitura Ctrl+A XA

Seleziona tutte teste nota accordo (Select More) Ctrl+Maius+A o doppio-clic xXA o doppio-clic

Seleziona tutto il testo su rigo nello stesso stile 
(Select More)

Ctrl+Maius+A xXA

Selezione multipla oggetti (marquee) Maius+trascinare sul foglio X-trascinare sul foglio

Aggiungi/rimuovi oggetti a/da selezione Ctrl+clic X-clic

Seleziona grafiche Alt+G zG

Nessuna selezione 
 

Esc Esc / X.
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Filtri e Trova

Filtri avanzati Ctrl+Maius+Alt+F xzXF

Filtro Dinamiche Maius+Alt+D xzD

Filtro Voce 1/2/3/4 Ctrl+Maius+Alt+1/2/3/4 xzX1/2/3/4

Filtro Nota Alto/2°/3°/Basso o Note singole Ctrl+Alt+1/2/3/B zX1/2/3/B

Trova Ctrl+F XF

Trova Successivo Ctrl+G XG

Layout

Strumenti I I

Focus on Staves Ctrl+Alt+F zXF

Setup documento Ctrl+D XD

Nascondi righi vuoti Ctrl+Maius+Alt+H xzXH

Mostra righi vuoti Ctrl+Maius+Alt+S xzXS

Break di sistema on/off Maius+Invio (tastiera principale) x-Invio (tastiera principale)

Break di pagina on/off Ctrl+Invio (tastiera principale) X-Invio (tastiera principale)

Break speciale di pagina Ctrl+Maius+Invio (tastiera princi-
pale)

xX-Invio (tastiera principale)

Blocca Formato Ctrl+Maius+L xXL

Sblocca Formato Ctrl+Maius+U xXU

Esegui nel Sistema Maius+Alt+M xzM

Esegui nella Pagina Ctrl+Maius+Alt+M xzXM

Allinea in Fila/Colonna Ctrl+Maius+R/C xXR/C

Resetta Spaziatura nota Ctrl+Maius+N xXN

Resetta Posizione Ctrl+Maius+P xXP

Resetta Design Ctrl+Maius+D xXD

Resetta alla Posizione Partitura Ctrl+Maius+Alt+P xzXP

Resetta al Design Partitura Ctrl+Maius+Alt+D xzXD

Restringi/espandi spaziatura nota 
(in step più grandi)

Maius+Alt+0/1 

(Ctrl+Maius+Alt+0/1)
xz0/1 (xzX0/1)

Uso pause multiple (in Auto Layout) on/off Ctrl+Maius+M xXM

House Style™

Engraving Rules Ctrl+Maius+E xXE

Edit Text Styles Ctrl+Maius+Alt+T xzXT

Menu Vedute & Finestre

Panorama Maius-P xP

Oggetti nascosti (mostra/nascondi) Ctrl+Alt+H zXH

Righelli oggetti (mostra/nascondi) Maius+Alt+R xzR

Righelli rigo (mostra/nascondi) Ctrl+Maius+Alt+R xzXR

Partitura di trasporto Ctrl+Maius+T xXT
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Navigatore (mostra/nascondi) Ctrl+Alt+N zXN

T. num. (mostra/nascondi) Ctrl+Alt+K zXK

Riproduzione (mostra/nascondi) Ctrl+Alt+Y zXY

Mixer (mostra/nascondi) Ctrl+Alt+M M

Idee (mostra/nascondi) Ctrl+Alt+I zXI

Parti (mostra/nascondi) Ctrl+Alt+R zXR

Video (mostra/nascondi) Ctrl+Alt+V zXV

Proprietà (mostra/nascondi) Ctrl+Alt+P zXP

Nascondi/Mostra Finestre Tool Ctrl+Alt+X zXX

Passa da partitura completa a parte W W

Parte successiva Ctrl+Alt+Tab zX~

Parte precedente Ctrl+Maius+Alt+Tab xzX~

Schermo pieno (solo Windows) Ctrl+U nessuno

Menu e finestre di dialogo

Entra nel menu Alt+lettera sottolineata nessuno

Scegli dal menu lettera sottolineata nessuno

Scegli dalla finestra Alt+lettera sottolineata nessuno

Sposta a box prec./succ. nella finestra Tab/Maius-Tab Tab/x-Tab

Seleziona elementi consecutivi dall’elenco Maius+clic o trascinamento trascinamento

Seleziona elementi separati dall’elenco Ctrl+clic X-clic

OK (o pulsante di default) Return/Enter Return/Enter

Cancel Esc Esc / X.

Layout T. num. F8–F12 F8–F12

Layout successivo T. num. + (pad numerico) + (pad numerico)

Torna al primo layout T. num. F8 / Maius-+ — (pad numerico) / F8

Modifica menu contesutale Maius+F10 / clic-destro su 
oggetto(i) selezionato

Control-clic su oggetto(i) selezionato

Cambio finestra Ctrl+Tab X~

Nascondi applicazione nessuno XH 

Riduci finestra nessuno XM 

Miscellanea

Manuale operativo di Sibelius F1 X?

Stampa Ctrl+P XP

Preferenze Ctrl+, X,

Chiusura/Uscita Alt+F4 / Ctrl+Q XQ
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5.10 Panorama

b Evidenzia righi Selezionati, Menu Vista.

Panorama è un modo alternativo di vedere la partitura; invece di essere distribuita in pagine sullo 
schermo (esattamente come sarà stampata) la partitura si può vedere come un singolo sistema 
musicale distribuito su un foglio infinitamente largo. In altri programmi, questo tipo di veduta è 
talvolta chiamata veduta a scorrimento o galleria.

Con la veduta Panorama ci si può concentrare su inserimento e modifica della musica senza pen-
sare al layout di pagina; l’inserimento note in Panorama è anche molto comodo, specialmente se 
nella veduta normale c’è più di un sistema per pagina; Panorama, infatti, elimina il movimento 
verticale della musica da sistema a sistema e la partitura si sposta sempre solo in orizzontale. 
Ciò riduce il disorientamento che si ha lavorando velocemente nella veduta normale.

Attivare la veduta Panorama
Per attivare la veduta Panorama selezionare Vista > Panorama (Maius-P) o cliccare sul 
pulsante nella toolbar indicato a destra; quando si vede la partitura così, Sibelius esegue 
anche le seguenti operazioni:

* Disabilita il Navigatore (perché c’è solo una pagina).
* Attiva l’opzione Vista > Barre scorrimento.

* Attiva l’opzione Vista > Nomi rigo e Numeri battuta.

Per disattivare la veduta Panorama selezionare di nuovo Vista > Panorama.

Se in veduta Panorama si disattiva l’opzione Barre scorrimento o Nomi rigo e Numeri battuta, 
Sibelius cambia le impostazioni solo fino a quando si resta nella veduta Panorama, ma le ricorda la 
volta successiva che si usa la veduta Panorama.

Muoversi nella veduta Panorama
Il lavoro nella veduta Panorama è molto simile a quello nella veduta normale; si possono usare 
tutti gli stessi comandi rapidi di navigazione (es. Home, End, Page Up o 8, Page Down o 9, ecc.) 
e altre funzioni come lo zoom. Provare il livello di zoom Adatta altezza pagina, il quale è partico-
larmente utile poiché garantisce la piena visibilità di tutti i righi sullo schermo.

Si noti che non appena si trascina l’inzio della musica fuori dal bordo sinistro dello schermo, 
appare in blu chiaro un’utile indicazione di chiave e tonalità correnti di ogni rigo.

Inserimento e modifica nella veduta Panorama
Inserimento e modifica nella veduta Panorama sono quasi uguali a quelli della veduta normale; 
poche cose non sono possibili in Panorama (perché non essendoci pagine, non hanno senso):

* Non è possibile vedere o inserire testi allineati alla pagina, come Titolo, Intestazione (dopo 
prima pagina), ecc..

* Se è attiva l’opzione Vista > Marchi layout, Sibelius scrive i segni di layout sopra le stanghette e, 
sebbene si possano creare break di sistema o pagina, non se ne vedrà l’effetto in Panorama.
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* Le partiture non si possono stampare in Panorama (perché poche stampanti riescono a gestire 
fogli di carta dalla larghezza infinita!), quindi scegliendo File > Stampa Sibelius stampa la parti-
tura in veduta normale.

* Il comando Layout > Nascondi righi vuoti non può essere usato per nascondere i righi su 
sistemi specifici in Panorama, perché c’è solo un sistema; tutti i righi nascosti nella veduta nor-
male, quindi, appaiono nella veduta Panorama.

* Le opzioni Modifica > Vai a pagina e Crea > Altro > Cambio numero pagina sono disabilitate.
* Il comando Layout > Allinea righi è disabilitato.
* Selezionando File > Esporta > Grafiche è possibile esportare solo una selezione grafica (Graphic 

selection) non sistemi o pagine specifici – b Esportare file grafici.

Spaziatura nota in Panorama
In Panorama, Sibelius usa una spaziatura nota “non giustificata”; in altre parole, Sibelius non ha 
bisogno di espandere o compattare la spaziatura nota per fare in modo che la musica occupi la 
larghezza della pagina. Si noti, però, che qualsiasi regolazione manuale eseguita sulla spaziatura 
nota appare in Panorama, quindi se è stata allargata la spaziatura di una misura (per evitare colli-
sioni tra i simboli accordo, ad esempio) queste regolazioni appaiono nella veduta Panorama come 
in quella normale.

Attenzione! Regolando la spaziatura nota nella veduta Panorama, la spaziatura regolata può risul-
tare più stretta o larga quando si torna alla veduta normale, perché Sibelius deve poi giustificare la 
spaziatura per fare in modo che la musica stia nella larghezza della pagina.

Spaziatura rigo in Panorama
In Panorama, Sibelius utilizza lo spazio tra i sistemi definito nella pagina Righi della finestra 
House Style > Regole tipografia; poiché non c’è un’altezza di pagina fissa, Sibelius ignora il 
valore del parametro Giustifica righi se la pagina è al meno x% completa, con il risultato che 
i righi talvolta possono apparire più ravvicinati nella veduta Panorama che in quella normale.

Tuttavia, si può regolare la distanza tra i righi nella veduta Panorama senza che ciò influenzi la 
veduta normale, cosa utile da fare se note o altri oggetti sopra o sotto il rigo toccano altri oggetti: 
trascinarli o spostarli leggermente con i soliti metodi (b Spaziatura rigo).

Usare la veduta Panorama con Focus on Staves
Quando si usa la funzione Vista > Evidenza su righi per vedere solo un paio di righi della partit-
ura, il layout nella veduta normale può essere un pò falsato a causa della mancanza degli altri righi; 
provare ad attivare anche l’opzione Vista > Panorama; ciò rende la funzione Focus on Staves molto 
più efficace. b Evidenzia righi Selezionati.

Aprire le partiture nella veduta Panorama
Quando si salva una partitura Sibelius ricorda se la veduta Panorama era attiva o meno e, riapren-
dolo in seguito, Sibelius l’attiva di nuovo, se necessario. Nella pagina File della finestra File > Pref-
erenze (menu Sibelius in Mac) è possibile dire a Sibelius di usare sempre la veduta Panorama o 
normale – b Preferenze.
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5.11 Plug-in

Sibelius supporta i plug-in (funzioni extra create usando un linguaggio di programmazione 
interno denominato ManuScript). Il menu Plug-in offre una serie di plug-in molto utili, organiz-
zati in categorie all’interno di altri sottomenu; è possibile anche assegnare tasti di comando rapido 
ai plug-in usati più spesso – b Menu e comandi rapidi.

Si può fermare un plug-in mentre è in funzione cliccando sul pulsante Stop plug-in nell’angolo in 
alto a sinistra dello schermo. Si può anche annullare l’azione eseguita nella partitura da un qual-
siasi plug-in scegliendo come al solito Modifica > Undo (Ctrl+Z o XZ) dopo averlo avviato.

Plug-in aggiuntivi
Per Sibelius sono sviluppati continuamente nuovi plug-in; alcuni extra e gratuiti appaiono periodi-
camente sul sito Internet di Sibelius – per vedere quelli disponibili visitare il sito www.sibel-
ius.com/download/plugins.

Se si realizza un plug-in che si ritiene possa essere utile ad altri utenti Sibelius, inviare i dettagli 
tramite posta elettronica all’indirizzo sibhelpUK@sibelius.com. Verrà valutato se se includerlo 
nel sito o in future versioni di Sibelius; i plug-in di qualità ottengono ottimi compensi in denaro!

In alternativa, segnalare se si ha un’idea originale per un plug-in ma non si è in grado di realizzarla.

Installare nuovi plug-in
Per installare un nuovo plug-in copiare il rispettivo file (estensione .plg) nella cartella Plugins
all’interno della cartella dati dell’applicazione; il plug-in si carica automaticamente all’avvio suc-
cessivo di Sibelius. Per l’assistenza sull’installazione dei plug-in visitare il sito www.sibelius.com/
download/plugins.

Modificare i plug-in
Il comando Plug-in > Modifica Plug-in consente si scaricare, ricaricare, cancellare, modificare e 
creare nuovi plug-in.

Selezionare un plug-in dall’elenco e cliccare sul rispettivo pulsante:

* Libera; scarica un plug-in da Sibelius; non lo rimuove dal disco rigido ma consente di risparmi-
are memoria; i plug-in scaricati sono descritti così nell’elenco.

* Ricarica: ricarica di nuovo un plug-in dopo che è stato scaricato.
* Cancella: rimuove un plug-in dal disco rigido.
* Nuovo e Modifica servono per creare i propri plug-in.

Creare i propri plug-in
Questa operazione richiede la conoscenza del linguaggio ManuScript; è abbastanza semplice da 
imparare ma va oltre gli scopi di questo Manuale Operativo. La documentazione completa del 
linguaggio ManuScript è in un file Acrobat PDF nella cartella Extras all’interno della cartella di 
programma di Sibelius in Windows e sul DVD-ROM di installazione in Mac.
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Plug-in > Mostra finestra rintraccia plug-in: visualizza una finestra traccia, utile per la correzi-
one degli errori nei plug-in sviluppati dall’utente; per i dettagli vedere la documentazione Manu-
Script.

ALTERAZIONI

Aggiungi alterazioni a tutte le note
Inserisce le alterazioni prima di ogni nota anche se bequadri, diesis o bemolle sono già nella tonal-
ità, oppure anche se una nota è legata con quella precedente; questo tipo di notazione si usa tal-
volta in partiture atonali o altre partiture prive di tonalità.

Per usare il plug-in selezionare il passaggio nel quale inserire le alterazioni e scegliere Plug-in >
Aggiungi alterazioni a tutte le note. In seguito è opportuno eseguire il comando Layout >
Ripristina spaziatura note per far spazio a tutte le nuove alterazioni aggiunte.

Al momento, le alterazioni di 1/4 di tono non sono gestite da questo plug-in: esse sono indicate 
dalla lettera Q, che si può cercare usando l’opzione Modifica > Trova per garantire che tutte le note 
successive della misura nella stessa linea o spazio siano precedute dal simbolo adeguato.

Plug-in realizzato da Peter Hayter.

Aggiungi alterazioni a tutte le note con diesis e bemolle
Questo plug-in aggiunge le alterazioni a tutte le note diesis e bemolle, anche se si trovano prima 
nella stessa misura ma non se esistono già nella tonalità.

Plug-in realizzato da Stefan Behrisch (www.werklabor.de).

Aggiungi alterazioni precauzionali
Se una nota ha un’alterazione in una misura della partitura e poi torna all’altezza stabilita dalla 
tonalità nella misura successiva, è normale collocare un’alterazione d’avviso prima della rispettiva 
nota nella seconda misura. È ciò che fa questo plug-in, sia in un passaggio selezionato sia 
nell’intera partitura, con la possibilità di segnare ogni alterazione d’avviso aggiunta con la scritta 
[CA] o un’evidenziazione (in modo da verificare le variazioni).

Per applicare il plug-in all’intera partitura selezionare Modifica > Seleziona > Seleziona tutto
(Ctrl+A o XA) e scegliere Plug-in > Alterazioni > Aggiungi alterazioni precauzionali.

Si può definire il grado d’intervento del plug-in con l’opzione Numero massimo di note coin-
volte a 0 le alterazioni sono inserite solo nei casi più evidenti (cioè solo quando l’alterazione cam-
bia tra note consecutive); a un valore elevato (es. 99) le alterazioni sono inserite da inizio a fine 
misura (ci possono essere fino a 99 note diverse tra le due sulle quali cambia l’alterazione).

Attivando l’opzione Aggiungi precauzionali alle note dello stesso tono in diverse ottave il 
plug-in aggiunge alterazioni d’avviso alle note della stessa altezza, anche se l’alterazione è cambiata 
in un’ottava diversa; si può anche scegliere se questa opzione deve essere applicata quando l’alter-
azione cambia solo nella stessa misura (solo nella stessa battuta), quando le note sono in mis-
ure diverse (quando le note sono in battute diverse) o sempre (sempre).

Attivando l’opzione Metti parentesi attorno le alterazioni precauzionali, il plug-in inserisce 
parentesi tonde attorno ad ogni alterazione d’avviso che crea.
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Il plug-in ha un Aiuto interno che offre ulteriori informazioni sull’uso delle altre opzioni.

Il plug-in può rispaziare singole misure, in modo da aumentare lo spazio intorno alle note alterate; 
per evitare che il plug-in influenzi la spaziatura originale della partitura, attivare l’opzione Ripris-
tina spaziatura delle note nelle battute che cambiano.

Se la partitura è molto lunga, si può usare la funzione Modifica > Trova di Sibelius per trovare tutte 
le annotazioni [CA] che il plug-in ha aggiunto ad essa.

Plug-in realizzato da Behrisch (www.werklabor.de) e perfezionato da Michael Eastwood.

Aggiungi un simbolo di ficta sopra la nota
Nella musica antica, le alterazioni erano spesso implicite ma non scritte esplicitamente nei mano-
scritti originali a causa delle prove d’esecuzione giornaliere; le edizioni moderne spesso indicano 
questi cosiddetti ficta musicali collocando piccole alterazioni editoriali sopra le note in questione.

Questo plug-in inserisce i simboli d’alterazione sopra la nota, oltre ai messaggi MIDI di pitch bend 
necessari a rendere la nota diesis o bemolle.

Per usare il plug-in selezionare la nota(e) alla quale aggiungere il ficta e scegliere Plug-in >
Alterazioni > Aggiungi un simbolo di ficta sopra la nota. Si apre una finestra di dialogo: sceg-
liere se si vuole aggiungere diesis, bemolle o bequadri e poi cliccare OK.

Il plug-in nasconde l’alterazione regolare della nota e aggiunge un simbolo adeguato sopra.

Plug-in realizzato da Chris May.

Riscrivi bemolle come diesis/diesis come bemolle
Modifica lo spelling delle alterazioni nel passaggio selezionato. Selezionare un passaggio, scegliere 
Plug-in > Alterazioni > Riscrivi bemolle come diesis o Plug-in > Alterazioni > Riscrivi diesis 
come bemolle: sono rinominati tutti i bemolle/diesis nel passaggio selezionato; usando questo 
plug-in si perdono le teste nota speciali e i dati Live Playback.

Semplifica alterazioni
Questo plug-in rinomina tutte le alterazioni in una partitura o passaggio selezionato in base alle 
tonalità prevalenti; è molto utile per rimuovere alterazioni residue rimaste in seguito a particolari 
operazioni di modifica (es. il trasporto o l’aggiunta di una nuova tonalità a musica esistente).

Per usare il plug-in selezionare un passaggio (o l’intera partitura) e scegliere Plug-in >
Alterazioni > Semplifica alterazioni.

Plug-in realizzato da Peter Hayter. 

ANALISI

Aggiungi scala gradi Schenker
Questo plug-in analizza la partitura e aggiunge i gradi della scala Schenkerian sopra o sotto il rigo.

Per usare il plug-in selezionare un passaggio in una singola tonalità (cioè privo di cambi tonalità) o 
l’intera partitura (se ha una sola tonalità) e scegliere Plug-in > Analisi > Aggiungi scala gradi 
Schenker. Si apre una semplice finestra di dialogo:
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* Fila verticale: determina se i simboli ^ o v sono scritti sopra il grado della scala (opzione attiva) 
oppure a sinistra del grado della scala (opzione non attiva).

* Voce: consente di scegliere quale voce analizzare sul rigo.
* Stile di testo: determina l’aspetto (es. in box, corsivo, ecc.) dei gradi della scala e dove sono 

scritti: tutti gli stili di testo tranne Figured bass li collocano sopra il rigo; Figured bass li colloca 
sotto.

* Aggiungi a passaggio selezionato/intera partitura: permette di definire lo scopo dell’azione 
del plug-in; scegliere l’opzione per l’intera partitura solo se essa non presenta cambi di tonalità.

Cliccando OK i gradi della scala sono scritti nella partitura secondo le opzioni definite.

Plug-in realizzato da John Kennedy.

Confronta righi
Confronta le coppie di righi nello stesso file evidenziandone le differenze. Per usare questo plug-in 
selezionare un passaggio in una coppia qualsiasi di righi nella partitura (Ctrl+clic o X-clic per 
selezionare due righi non adiacenti) e scegliere Plug-in > Analisi > Confronta righi. 
Si apre una semplice finestra di dialogo:

* Note e pause: analizza le differenze di valore nota, altezza, voce, ecc..
* Linee: analizza le differenze in tipi di linea, lunghezza, ecc. Naturalmente, funziona solo per le 

linee del rigo (poiché le linee di sistema si applicano comunque a tutti i righi).
* Chiavi: analizza la presenza di chiavi diverse nei due righi.
* Testo: analizza le differenze negli oggetti di testo; non coglie le differenze in font o dimensione 

tra due righi, ma rileva le differenze nelle scritte vere e proprie; ciò rende questo plug-in molto 
utile per controllare (ad esempio) le parole su due righi vocali che condividono la stessa ritmica. 
Come per le linee, questo plug-in funziona solo su testi del rigo, non di sistema.

* Differenza colori in: permette di scegliere se le evidenziature debbano essere scritte nel rigo in 
alto (Rigo in alto), in basso (Rigo in basso) o in entrambi (attivando entrambe le opzioni).

* Passaggio selezionato/Tutto lo spartito: scegliere se confrontare i righi solo nel passaggio 
selezionato o dall’inizio alla fine della partitura.

Cliccando OK il plug-in analizza la partitura; alla fine del processo appare un messaggio in un box 
che indica le differenze trovate.

Per rimuovere le evidenziature create da questo plug-in in seguito, vedere Rimuovi evidenziati.

Plug-in realizzato da Neil Sands.

Trova motivo
Analizza la partitura per trovare motivi (motif) che corrispondono a intervalli o ritmi (o entrambi) 
di un passaggio selezionato e segna ogni corrispondenza con un’evidenziatura (b Evidenzia). 
Ciò è molto utile nell’analisi musicale, per trovare tutti gli eventi nel soggetto di una fuga o esam-
inare come è usato un particolare schema ritmico in un pezzo.

Per usare questo plug-in selezionare il motivo per il quale trovare la corrispondenza e scegliere 
Plug-in > Analisi > Trova Motivo. Appare una finestra di dialogo che consente d’impostare alcune 
opzioni:
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* Confronta ritmi: attivarla per trovare corrispondenze ritmiche; si può definire la variazione 
consentita rispetto al motivo specificato (a 0% si accettano solo corrispondenze esatte).

* Confronta toni: attivarla per trovare corrispondenze d’intervallo. Anche qui si può definire la 
variazione consentita; a 0%, sono trovate le corrispondenze di trasporti esatti del motivo, mentre 
corrispondenze diatoniche o altri trasporti inesatti non sono trovati; per esempio, in una fuga il 
plug-in troverà le risposte vere e proprie, ma non quelle tonali.; per trovare trasporti inesatti 
aumentare oltre 0% la variazione consentita.

* Motivo originale nella voce x: permette di scegliere in quale voce il plug-in deve trovare il 
motivo originale; questa opzione determina solo dove è trovato il motivo d’esempio per il quale 
si cerca la corrispondenza – il plug-in cerca sempre le corrispondenze in tutte le voci nel resto 
della partitura.

Attivare sia Confronta ritmi che Confronta toni per trovare solo entrambe le corrispondenze.

Cliccare OK: appare una barra di progresso la quale indica il rigo che il plug-in sta analizzando. 
Dopo pochi secondi il plug-in visualizza le corrispondenze trovate, ciascuna delle quali è evidenzi-
ata in giallo.

Plug-in realizzato da James Larcombe e Byron Hawkins.

Trova estensione
Calcola l’estensione (cioè le note più gravi e più acute), l’altezza media e le altezze più frequenti 
(tutto espresso in altezza da concerto) di un passaggio selezionato; è utile, ad esempio, se si sta 
scrivendo musica vocale e si vuole sapere il tipo di sforzo richiesto ai cantanti.

Per avviare questo plug-in selezionare un passaggio (o triplo-clic del mouse su un rigo per calco-
larne l’estensione da inizio a fine partitura) e scegliere Plug-in > Analisi > Trova estensione.

PROCESSO DI MASSA

Calcola Statistiche
Crea un rapporto che elenca il numero di misure, righi, pagine e altri oggetti presenti nella partit-
ura corrente o in tutte le partiture di una determinata cartella; è utile per i copisti che possono cal-
colare le loro parcelle per i lavori di copiatura.

Per applicare il plug-in a una singola partitura selezionare Plug-in > Processo di massa > Calcola 
statistiche e poi cliccare Spartito corrente nella finestra di dialogo che si apre. Per calcolare le 
statistiche di un movimento (o di un pezzo a più movimenti nella stessa partitura) selezionare le 
misure in questione prima di avviare il plug-in e poi cliccare Spartito corrente.

Per applicare il plug-in ad una cartella selezionare Plug-in > Processo di massa > Calcola statis-
tiche poi cliccare Processa cartella. Scegliere la cartella per la quale calcolare le statistiche; clic-
cando OK Sibelius processa a turno ogni file (non sono modificate le partiture vere e proprie).

Una volta processati la partitura corrente o tutte le partiture nella cartella, Sibelius apre una 
finestra di dialogo che elenca gli oggetti di ogni tipo trovati; cliccare Scrivi file di testo per salvare 
i risultati in un file di testo nella cartella desiderata o nella stessa cartella della partitura corrente.

Plug-in realizzato da Bob Zawalich. 
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Converti cartella di file Sibelius 7 Acorn
Converte in massa tutti i file Acorn di Sibelius trovati in una cartella specificata, ri-salvandoli con 
gli stessi nomi file ma con estensione .sib – b Aprire i file Acorn Sibelius.

Converti cartella di file di Finale
Converte in massa tutti i file PrintMusic 1.0, Finale e Allegro 98/2000, Finale Guitar e Finale 2001/
2002/2003/2004 ETF in una cartella specificata, ri-salvandoli con gli stessi nomi file ma con esten-
sione .sib – b Aprire i file Finale 98-2003.

Converti cartella di file MIDI
Converte in massa tutti i file MIDI in una cartella specificata, ri-salvandoli con gli stessi nomi file 
ma con estensione .sib. Questi file devono essere file Standard MIDI (con estensione file .mid in 
Windows) non in altri formati sequencer – b Aprire i file MIDI.

Converti cartella di file MusicXML
Converte in massa tutti i file MusicXML in una cartella specificata, ri-salvandoli con gli stessi nomi 
file ma con estensione .sib – b Aprire i file MusicXML.

Converti cartella di file SCORE
Converte in massa tutti i file SCORE in una cartella specificata, ri-salvandoli con gli stessi nomi file 
ma con estensione .sib – b Aprire i file SCORE.

Converti cartelle di spartiti in grafica
Converte in massa tutte le partiture di una cartella in file grafici di un formato specificato – 
b Esportare file grafici.

Per usare il plug-in selezionare Plug-in > Processo di massa > Converti cartella di partiture in 
grafica e scegliere la cartella da convertire. Un messaggio chiede di scegliere il formato grafico; si 
può anche decidere di usare o meno le impostazioni di default. In genere, si può lasciare attiva 
l’opzione Usa impostazioni predefinite e cliccare OK per salvare tutti i file; disattivando l’opzi-
one Usa impostazioni predefinite e un messaggio chiede di scegliere le impostazioni per ogni 
file nella cartella.

Converti cartelle di spartiti in MIDI
Converte in massa tutte le partiture di una cartella in file Standard MIDI, usando lo stesso nome 
file ma con estensione .mid – b Esportare i file MIDI.

Converti cartelle di spartiti in pagine web
Salva pagine web Scorch per tutti i file in una cartella creando anche una pagina d’indice con i link 
a tutte le singole partiture, pronte da essere inserite sul proprio sito web – b Esportare pagine 
web Scorch.

Per usare il plug-in selezionare Plug-in > Processo di massa > Converti cartella di partiture in 
pagine web. Appare una finestra di dialogo:

* Scegliere la cartella sorgente delle partiture cliccando sul pulsante Sfoglia a fianco a Converti 
tutti gli spartiti all’interno; per includere le partiture nelle sotto-cartelle assicurarsi che sia 
attiva anche l’opzione Converti anche spartiti in sottocartelle.
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* Scegliere la cartella di destinazione cliccando sul pulsante Sfoglia sotto Metti pagine web in, 
oppure attivare l’opzione Usa la stessa cartella per salvare le pagine web nella stessa cartella 
delle partiture originali.

* Disattivare l’opzione Crea pagina indice se non si vuole che il plug-in generi una pagina 
d’indice con i link a tutte le altre pagine web Scorch; lasciare attiva questa opzione.

* Scegliere il Modello delle pagine web dall’elenco: questi template sono nel plug-in e non si 
possono cambiare nemmeno cambiando i template nella cartella Manuscript paper di Sibelius.

* L’opzione Dimensioni dello spartito nella pagina web stabilisce la larghezza della finestra 
Scorch in ogni pagina web; il valore di default pari a 720 pixel è ideale per la maggior parte delle 
situazioni.

* Per consentire ad altre persone di stampare e salvare le proprie partiture dalla pagina web perso-
nale selezionare Permetti stampa e salvataggio.

Cliccare OK: Sibelius processa a turno ogni file; quando il plug-in ha finito, si avrà una cartella 
completa di file pronti per l’upload sul proprio sito web o Intranet!

Plug-in realizzato da Neil Sands. 

Importa House Style in una cartella di partiture
Applica un file House Style specificato a tutti i file in una cartella selezionata.

Per usare il plug-in selezionare Plug-in > Processo di massa > Importa House Style in una car-
tella di partiture. Un messaggio chiede di selezionare il file in stile house della libreria (.lib) da 
applicare, poi Sibelius chiede la cartella di file alla quale applicare lo stile house scelto.

La cartella House Styles all’interno della cartella programma di Sibelius fornisce una serie di stili 
house – b House Style™.

Plug-in realizzato da Michael Kilpatrick. 

Stampa copie multiple
Permette di stampare più copie di una selezione di partiture in una cartella (oltre a qualsiasi sotto-
cartella che contiene partiture, se si desidera). Per stampare copie multiple di parti è più facile 
usare le funzioni Copia e Stampa Parte(i) della finestra Parts (b Lavorare con le parti).

Per usare il plug-in chiudere tutte le partiture aperte e selezionare Plug-in > Processo di massa >
Stampa copie multiple. Appare un avviso per le partiture create in versioni precedenti di Sibel-
ius. Di default, se aperte in Sibelius 4 mostrano un messaggio d’avviso; si può decidere di non farlo 
più apparire, poi Sibelius chiede di scegliere una cartella e appare quindi la seguente finestra:
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* Scegliere la cartella dall’elenco Cartelle contenenti spartiti a sinistra.
* Eseguire una selezione dall’elenco Spartiti nella cartella selezionata, impostare il menu a ten-

dina Copie al numero delle copie di questo file che si desidera stampare e cliccare Aggiungi File. 
Cliccare Aggiungi Tutti per aggiungere all’elenco Coda di stampa tutte le partiture nella car-
tella scelta, con il numero di copie stabilito.

* Completare l’elenco Coda di stampa a destra aggiungendo altri file; quando si è pronti a stam-
pare cliccare Stampa.

Il plug-in stampa tutte le partiture nella coda per il numero di volte specificato con le opzioni di 
default (dal plug-in non è possibile definire opzioni come la stampa di un libretto, ecc.).

Il pulsante Leggi Copie apre tutti i file nella cartella scelta e controlla il testo ~copies=n attaccato 
a ognuna delle prime cinque misure nei primi cinque righi (ove n è il numero di copie che saranno 
stampate) e li aggiunge all’elenco Coda di stampa con il rispettivo numero di copie definito. Se un 
file ha più di un oggetto di testo nella forma ~copies=n, Sibelius presume che sia una partitura 
precedente l’estrazione della parte e non l’aggiunge alla coda di stampa.

Plug-in realizzato da Peter Hayter e Gunnar Hellquist.

SIMBOLI ACCORDO

Aggiungi accordo con capotasto
Aggiunge uno o più set di simboli accordo extra (in genere sopra quelli esistenti), corrispondenti 
agli accordi che un chitarrista deve suonare con il capotasto mobile a un tasto particolare. Ciò è 
utile per i musicisti che hanno difficoltà a suonare nella tonalità scritta; il chitarrista può mettere 
invece un capotasto mobile sulla chitarra e suonare gli accordi in posizioni più facili.

Per avviare il plug-in selezionare il rigo con i simboli accordo esistenti e scegliere Plug-in > Sim-
boli accordo > Aggiungi accordo con capotasto. Si apre una finestra di dialogo che consente di 
scegliere il tasto al quale è collocato il capotasto mobile e che mostra a quale tonalità corrisponde. 
Si può decidere se i nuovi simboli accordo debbano essere o meno in grassetto, corsivo o in paren-
tesi e scegliere un nuovo stile di testo, se si desidera (sebbene i simboli Chord di default in genere 
sono quelli ideali).

Il plug-in ha una propria finestra di dialogo Aiuto per ulteriori informazioni.

Plug-in realizzato da Bob Zawalich.

Aggiungi simboli accordo
Analizza l’armonia della musica e aggiunge automaticamente gli opportuni simboli accordo sopra 
i righi selezionati; si può scegliere di analizzare uno qualsiasi o tutti i righi nella partitura e dove 
saranno creati i simboli accordi.
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Per avviare il plug-in selezionare i righi con l’armonia (es. i due eighi di un piano) e scegliere Plug-
in > Simboli accordo > Aggiungi simboli accordo; appare la seguente finestra di dialogo:

In genere, si possono lasciare le impostazioni di default – cliccare OK per aggiungere i simboli 
accordo alla partitura.

Se si cambiano le impostazioni, il risultato delle modifiche dipende da molte opzioni:

* Aggiungi simbolo accordo: all’inizio di ogni battuta o ogni valore di nota dall’inizio della 
battuta (ove valore di nota si sceglie da un elenco a tendina): questa opzione determina con 
quale frequenza il plug-in aggiunge i simboli accordi alla partitura.

* Come trovare la fondamentale and Opzioni per l’analisi della fondamentale: queste opzi-
oni controllano come il plug-in determina la nota fondamentale (root note) dell’accordo; è il 
passo più importante per nominare l’accordo. Per esempio, DO6 e LAmi7 in pratica sono lo 
stesso accordo (infatti sono formati dalle stesse note) ma la nota fondamentale è diversa.
Selezionando l’opzione Prova sempre a trovare la fondamentale analizzando le note, il 
plug-in tenta d’immaginare con vari metodi la nota fondamentale (controllata dalle Opzioni 
per l’analisi della fondamentale). Sibelius non può immaginarla sempre correttamente: ogni 
nota di un accordo potrebbe essere la fondamentale e Sibelius non legge nella mente del com-
positore (per ora!).
Per evitare che il plug-in immagini le note fondamentali usare l’opzione Fondamentale come 
nota più bassa. Come suggerisce il nome, essa presume che tutti gli accordi siano in posizione 
fondamentale (nota pià grave fondamentale); altrimenti usare l’opzione Fondamentale come 
nota più bassa nei seguenti righi numero: che legge la nota fondamentale dell’accordo da un 
rigo particolare.

* Opzioni per l’analisi della fondamentale:
% Preferisci 7ths a 2nds: se c’è un intervallo di seconda tra le note in un accordo, il plug-in 

prova a collocarlo come ‘7° – Tonica’ invece che ‘Tonica - 2°' o qualsiasi altro intervallo. 
Questa opzione garantisce che, ad esempio, le note SIb - DO - MI - SOL dal basso in alto siano 
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riconosciute come DO7 invece che SIb% (b5) o MImi+(#11) (o qualcosa d’altro ugualmente 
improbabile!).

% Preferisci accordi contenenti triadi: quando è attivo questo box il plug-in sceglie (se possi-
bile) la nota fondamentale più grave che da all’accordo una triade maggiore o minore. Se la 
nota non è presente, il plug-in utilizza altri metodi per cercare di trovare la nota fondamen-
tale, a meno che sia selezionata l’opzione Usa nota più bassa se l’accordo non ha una tri-
ade; in tal caso, il plug-in usa la nota più grave dell’accordo come fondamentale.

* Opzioni di notazione: queste opzioni stabiliscono se Sibelius scrive un simbolo accordo ad 
ogni posizione specificata da Aggiungi simboli accordo (in cima) oppure omette quelli in 
eccesso:
% Inserisci simboli accordo ad ogni posizione specificata: scrive sempre un simbolo 

accordo, indipendentemente dal fatto che l’accordo corrente cambi o meno.
% Inserisci simboli accordo solo se la fondamentale è cambiata: attivandola il plug-in 

non crea un nuovo simbolo accordo se la nota fondamentale non è cambiata dall’ultimo sim-
bolo accordo; l’accordo vero e proprio potrebbe cambiare (es. da DO a DO7) ma il simbolo 
accordo è comunque omesso se è attiva questa opzione.

% Inserisci simboli accordo soltanto se il nome dell’accordo è cambiato: attivandola il 
plug-in omette un simbolo accordo solo se è identico all’ultimo simbolo accordo creato (es. il 
secondo di due accordi DO consecutivi non sarà creato, ma sarà scritto un DO7 dopo un 
accordo di DO).

% Metti simboli accordo al rigo numero: questa opzione determina il numero del rigo nella 
partitura dove sono creati i simboli accordo rispetto al rigo in alto selezionato; cioè, se si 
selezionano tre righi e si vogliono creare i simboli accordo sopra il secondo dei tre inserire il 
numero 2 qui. Come per tutti i numeri rigo in questa finestra del plug-in, la numerazione ini-
zia dal rigo in alto selezionato (numero 1) in basso e comprende tutti gli eventuali righi 
nascosti inclusi nella selezione; se il plug-in non aggiunge i simboli accordo alla partitura, 
può darsi che si sia scelto di crearli su un rigo nascosto.

* Altre opzioni di notazione:
% Usa segni di inversione ‘slash’: se attiva, il plug-in scrive in modo diverso da quello stan-

dard le inversioni dell’accordo, scrivendo il simbolo accordo seguito da uno “slash” (/) e il 
nome della nota più grave. Per esempio, un accordo di DO maggiore in prima inversione è 
scritto DO/MI.

% Scrivi accordo soltanto quando ha 3 note distinte: se attiva, solo gli accordi formati da 3 
o più note diverse sono scritti come simboli accordi. Ciò evita l’aggiunta di nomi accordi ridi-
coli con molte omissioni nei punti in cui suonano una o due note; tuttavia, con questa opzi-
one attiva non sono creati i “power chords” (es. DO5).

% Trascrivi omissioni di: queste opzioni controllano quali intervalli sono segnati come omis-
sioni se mancano da un accordo in cui normalmente dovrebbero esserci; per esempio, se è 
attiva l’opzione 5ths, l’accordo DO-MI-SIb genera il simbolo accordo DO7 (; 5).

% Per le opzioni 7ths/9ths/11ths/13ths un intervallo è previsto se il nome dell’accordo con-
tiene un’estensione dal numero più alto; per esempio, di default si presume che un accordo 
DO13 contenga anche la 7°, la 9° e l’11°. Nella pratica musicale, raramente un accordo del 
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genere è suonato completo, quindi è utile disattivare le opzioni d’omissione per alcune di 
queste estensioni più grandi – di default sono già disattivate.

Simboli accordo come frazione
Converte i simboli accordo con le note al basso in formato “slash” (es. Fmaj7/G) in formato frazio-
nale, ove il nome dell’accordo, una linea e la nota di basso sono ordinati in verticale come in una 

frazione, ( ). Per usare questo plug-in selezionare la musica contenente gli accordi con il for-
mato da cambiare e scegliere Plug-in > Simboli Accordo > Simboli accordo come frazione. Si 
può decidere se il plug-in deve separare ogni elemento individualmente creando tre oggetti di testo 
separati per ogni accordo (Usa carattere lineette in basso separato), oppure deve creare solo 
due oggetti con quello superiore sottolineato (Usa sottolineatura del font). Per regolare lo 
spazio vuoto tra gli accordi cliccare sul pulsante Opzioni tipografia mus.; per inziare la conver-
sione cliccare OK.

Plug-in realizzato da Bob Zawalich.

Realizza simboli e diagramma accordo
Crea semplici accompagnamenti di chitarra o piano in vari stili, basati sui simboli accordo e/o dia-
grammi accordo presenti nella partitura.

Selezionare Plug-in > Simboli accordo > Realizza simboli accordo e diagrammi. Se non c’è un 
passaggio selezionato, un messaggio chiede se l’operazione deve essere applicata all’intera partit-
ura; appare quindi la seguente finestra di dialogo:

* Si può scegliere fra tre diversi strumenti da aggiungere: Piano aggiunge due righi alla partitura e 
distribuisce gli accordi sui due righi; Piano (left-hand only) scrive un accompagnamento su un 
singolo rigo, ideale da usare se la melodia che si sta realizzando è nel rigo per la mano destra; 
Chitarra (notazione) aggiunge un singolo rigo di notazione alla partitura, mentre Chitarra 
(tab) aggiunge un rigo di tablatura con l’accordatura standard per chitarra a 6 corde (sebbene in 
seguito si possa cambiare). Per altri strumenti selezionare una di queste opzioni e poi copiare la 
musica nello strumento desiderato dopo aver avviato il plug-in.

* Il menu Stile accordo permette di controllare come sono realizzati gli accordi: Accordo ogni 
simbolo accordo crea un nuovo accordo ogni volta che l’accordo cambia; Accordo ogni bat-
tuta crea un nuovo accordo in ogni movimento (indipendentemente da quanto spesso cambia 
l’accordo); Accordi seguono ritmo dello spartito consente di realizzare gli accordi nello 
stesso ritmo di quello presente sui righi esistenti nella partitura; 8th note Alberti crea uno 
schema stile Alberti usando note da 1/8 (crome); 16th note Alberti crea lo stesso tipo di 

Fmaj7_____G
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schema usando note da 1/16 (semicrome); 8th note arpeggios crea uno schema d’arpeggio 
ascendente in note da 1/8 e 16th note arpeggios crea arpeggi ascendenti di note da 1/16.
I risultati di ciascuna delle sei opzioni in un rigo di notazione per chitarra sono i seguenti:

* Opzioni per ‘Accordi seguono ritmo dello spartito’: consente di scegliere il rigo (e la voce su 
quel rigo) da usare come base del ritmo per lo stile accordo Accordi seguono ritmo dello 
spartito.

* Se si sceglie uno degli stili accordo Alberti o arpeggio, può darsi che non si voglia l’accordo finale 
arpeggiato; per farlo, assicurarsi che sia attiva l’opzione Non arpeggiare accordo finale.

* Segnala sigle accordi sconosciute: apre un box di messaggio se il plug-in trova un simbolo 
accordo che non sa come interpretare.

Cliccare OK: per alcuni secondi appare una barra di progresso mentre gli accordi sono scritti nella 
partitura. Il plug-in crea un nuovo strumento nel quale scrive la sua interpretazione e può darsi 
che la sovrapponga ai propri simboli o diagrammi accordi. Per spostare più lontano i righi, triplo-
clic del mouse su una misura nel rigo di melodia, in modo che sia circondato da un box blu chiaro 
da inzio a fine partitura, poi trascinarlo verso il basso; s’aumenta così la distanza tra i due righi in 
tutta la partitura con una sola operazione.

Questo plug-in si può usare più di una volta nella stessa aprtitura per realizzare diversi layer 
d’accompagnamento – per esempio, si può aggiungere un piano che suona accordi pieni e una chi-
tarra che suona in stile finger-picking. Per farlo, avviare di nuovo il plug-in: si crea un nuovo stru-
mento ad ogni lancio del plug-in. Se i risultati non piacciono, si può sempre cancellare i nuovi righi 
aggiunti usando la finestra di dialogo Crea > Strumenti e righi.

Plug-in realizzato da Bob Zawalich. 
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TOOL DI COMPOSIZIONE

Matrice a 12 toni
Genera una matrice a 12 toni da una fila di tono specificata (fila nota) che può essere inserita man-
ualmente nel plug-in o prelevata da una selezione eseguita nella partitura corrente. Selezionare 
Plug-in > Tool di composizione > Matrice a 12 toni; appare la seguente finestra di dialogo:

Per inserire la fila manualmente digitare le classi d’altezza usando i numeri da 0 a 11 (separati da 
spazi) nel campo valore in alto e cliccare Fila digitata (i numeri da 0 a 11 rappresentano rispetti-
vamente le note da DO a SI); per leggere la fila dalla partitura cliccare Spartito. 

Se è attiva l’opzione Adatta matrice così che P0/I0 siano prima fila e colonna il plug-in 
trasporta la fila, in modo che la prima nota della fila sia l’altezza di classe 0. Ciò non ha effetto 
quando si legge la fila da una partitura.

La tabella sarà completata per mostrare tutte le possibili varianti della fila; la prima fila letta da 
sinistra a destra indica la prima fila del tono, mentre letta da destra a sinistra mostra l’inversione. 
La prima colonna letta dall’alto in basso mostra l’inversione della fila; letta dal basso in alto mostra 
l’inversione retrograda. Le colonne e file successive mostrano la stessa informazione con tutte le 
possibili permutazioni a rotazione.

Il plug-in può anche scrivere tutte le file che ha generato in notazione musicale; per farlo cliccare 
sul pulsante File in notazione.

Plug-in realizzato da Bob Zawalich.
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Aggiungi pattern di batteria
Crea una riga di batteria nella partitura e scrive uno schema ritmico in uno dei 24 stili pre-definiti. 
Per usare il plug-in selezionare Plug-in > Tool di composizione > Aggiungi pattern di batteria 
(non è necessario creare prima un rigo di batteria); appare la seguente finestra di dialogo:

* Scegliere uno stile dall’elenco a tendina Stile. Gli stili disponibili nell’elenco – che includono 
blues, rock, pop, jazz, latino e country – sono adatti al tempo in chiave, quindi non si avrà mai 
uno schema ritmico di valzer in 4/4, o uno shuffle blues in 3/4! Gli schemi mostrano tutti un 
tempo ideale al quale suonano meglio, quindi è bene scegliere uno schema previsto per lo stesso 
tipo di tempo della partitura.

* Aggiungi indicazione di metronomo: crea un segno di metronomo all’inizio della partitura (o 
del passaggio selezionato se si sta lavorando su una parte della partitura), impostando il tempo 
di riproduzione al tempo ideale per lo schema ritmico scelto.

* Comincia con una battuta introduttiva: determina se lo schema deve iniziare con una mis-
ura d’introduzione che porta allo schema regolare.

* Batt. fill/break ogni n battute: consente di scegliere se lo schema deve includere una misura 
introduttiva o di break e quanto spesso deve essere eseguita.

* Concludi con battuta finale: specifica se il plug-in deve finire lo schema con una o due misure 
conclusive (che dipendono dallo schema).

Una volta configurate opportunamente le opzioni cliccare OK. Per alcuni secondi appare una barra 
di progresso mentre il plug-in crea lo schema ritmico, dopodichè è possibile riprodurlo. 
Se si decide di cambiare schema selezionare di nuovo Plug-in > Tool di composizione > Aggiungi 
pattern di batteria; lo schema ritmico esistente è cancellato e sostituito automaticamente da 
quello nuovo.

Attenzione! Se la partitura usa vari tempi in chiave, quando si seleziona Note > Aggiungi pattern 
di batteria appare un messaggio che chiede di selezionare un passaggio in un singolo tempo in 
chiave e poi riprovare. 

Plug-in realizzato da Gunnar Hellquist. 
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Aggiungi rigo Hit Point
Aggiunge un rigo di percussioni alla base della partitura con teste nota a croce alle posizioni 
rimtiche più vicine al punto in cui si trova ogni hit point. Per usare il plug-in selezionare Plug-in >
Tool di composizione > Aggiungi rigo Hit Point.

Ciò consente di vedere meglio la relazione tra hit point e musica. Sibelius aggiunge una nota 
all’interno di 1/16 (semicroma) del punto in cui si trova ogni hit point; se si cambia il tempo della 
partitura (oppure s’aggiungono o rimuovono gli hit point) si può avviare di nuovo il plug-in; esso 
sostituirà le note esistenti con quelle nuove.

Plug-in realizzato da Bob Zawalich.

Aggiungi armonia semplice
Aggiunge un’armonizzazione al passaggio melodico selezionato nella partitura corrente. 

* Scegliere lo stile d’accompagnamento da Stile accordo (può essere Block chords, arpeggi o 
basso Alberti).

* Il plug-in rileva automaticamente la tonalità del pezzo, ma non può trovare le relative minori, 
quindi se (ad esempio) la tonalità visualizzata è SOL maggiore invece di MI minore, si dovrà 
scegliere manualmente la tonalità corretta.

* Cambiare l’opzione Melodia è nella voce nel caso (improbabile) che la melodia da armonizzare 
non sia in Voce 1.

* Cambia accordo: permette d’impostare la velocità del ritmo armonico generato dal plug-in. 
L’opzione Ogni gruppo battiti in genere è quella ideale ma se i cambi armonici sono troppo fre-
quenti o rari, scegliendo le opzioni Ogni battuta o Ogni battito si possono avere risultati 
migliori.

* Scrivi armonie per: consente di scegliere lo strumento (piano o chitarra) che il plug-in usa per 
l’armonizzazione; naturalmente è possibile copiare o arrangiare l’armonia su altri strumenti in 
un secondo momento.

* Mantieni accompagnamento in estensione media: può essere utile se si chiede al plug-in di 
armonizzare una melodia distribuita su un intervallo particolare, oppure se si armonizza la 
melodia per uno strumento molto grave o acuto. Non attivando questa opzione, l’armonizzazi-
one generata dal plug-in è scritta in una tessitura simile a quella della melodia da armonizzare; 
se si sta armonizzando una melodia per il piccolo, ad esempio, è bene attivare questa opzione 
(per evitare che il cane del vicino di casa si precipiti ad abbaiare alla vostra porta!).

Plug-in realizzato da Bob Zawalich, Andrew Davis e Daniel Spreadbury.

Explode
“Scompone” (cioè distribuisce) la musica in un rigo su più righi. Per usare questo plug-in:

* Selezionare un passaggio da un singolo rigo, copiarlo nel clipboard (Ctrl+C o XC) poi selezion-
are i righi sui quali distribuire la musica e scegliere Plug-in > Tool di composizione > Explode. 
Sibelius scrive la musica sui righi di destinazione usando le impostazioni correnti di default;

* Oppure selezionare il passaggio sul singolo rigo da scomporre e scegliere Plug-in > Tool di 
composizione > Explode: appare una finestra di dialogo che chiede su quanti righi distribuire la 
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musica, seguita da un’altra finestra che chiede su quali righi distribuirla; ci sono opzioni per 
creare nuovi righi o usare quelli esistenti (vedere in seguito).

Si può anche avviare il plug-in senza alcuna selezione; in tal caso, si apre una finestra di dialogo 
che permette di definire come deve essere distribuita la musica:

* Se è attiva l’opzione Overwrite existing material il plug-in sostituisce la musica esistente nei 
righi di destinazione.

* Se è attiva l’opzione Put notes in all parts unless specified (by a1, 1, etc.) il plug-in presume 
che le singole note debbano andare in tutte le parti (e dove c’è più di una parte o voce colloca le 
note in tutte le parti, doppiando la nota specificata). Se questa opzione non è attiva le singole 
note vanno in una parte.
Quando un passaggio a singola nota è segnato con specifiche istruzioni in testo Technique (come 
1., 2., 3., 4., a1., a2., a3., a4.) il plug-in le interpreta, tenendoli in considerazione quando scom-
pone la musica e continua così fino a quando trova un’altra istruzione o accordo. Dopo un 
accordo (a meno che incontri un’altra istruzione) il plug-in torna alla sua impostazione di 
default per le singole note, specificata dall’opzione Put notes in all parts....

* Double part n if necessary: consente di scegliere quali note saranno doppiate se in un punto ci 
sono meno note.

* Extra notes go into part n: permette di specificare quali parti ricevono note extra se in un 
determinato punto c’è un numero di note superiore. Il plug-in distribuisce automaticamente le 
note dove c’è il doppio del numero di parti o più (es. in un accordo a otto note, quattro parti 
prendono due note ciascuna).

* Attivando l’opzione Copy text, lines and symbols from all voices il plug-in copia gli oggetti 
presenti in ogni voce del rigo sorgente nei righi di destinazione; disattivandola il plug-in 
aggiunge solo gli oggetti dalla voce contenente le note che copia (o gli oggetti in tutte le voci).

* Cue solos in other parts crea passaggi introduttivi e si può scegliere se il passaggio sarà nomi-
nato con i nomi strumento completi o abbreviati, oppure senza alcun nome strumento. 
Se è attiva l’opzione Only whole bars, il plug-in crea un passaggio introduttivo solo in una mis-
ura (che altrimenti rimane vuota). L’opzione Create bar rest in voice 2 aggiunge invece una 
misura di pausa completa che contiene solo i passaggi introduttivi; per creare una scritta “Play” 
alla fine del passaggio introduttivo attivare l’opzione Add ‘Play’ text.

Se serve scomporre la musica da più di un rigo su un numero superiore di righi (o scomporla in 
più di quattro parti) usare la funzione Arrange di Sibelius – vedere Espandi on page 338.

Plug-in realizzato da Dave Foster.

Adatta selezione al tempo
Cambia il tempo del passaggio selezionato per fare in modo che termini a un timecode specifico o 
duri per un tempo ben definito.

Per avviare il plug-in selezionare la musica alla quale cambiare la durata e scegliere Plug-in > Tool 
di composizione > Adatta selezione al tempo. Si apre una finestra di dialogo che consente di 
scegliere se specificare l’opzione Nuovo tempo finale o Nuova durata. Il plug-in inserisce un 
cambio tempo all’inizio della selezione per garantire che corrisponda al tempo di fine o durata 
specificati.

reference.book  Page 400  Wednesday, April 16, 2008  4:28 PM



5.11 Plug-in

401

Funzio
ni

Altrimenti si può scegliere un hit point esistente dall’elenco Tempo dell’hit point selezionato; il 
plug-in inserisce un cambio tempo per spostare l’hit point alla fine della selezione.

Il plug-in rimuove i segni di metronomo presenti nella selezione, ma per avere un cambio tempo 
graduale si possono creare le rispettive linee rit./accel. prima di avviare il plug-in (che le userà).

Plug-in realizzato da Bob Zawalich.

Inverti
Esegue un’inversione sul passaggio selezionato attorno a un’altezza specificata; questo plug-in sos-
tituisce la musica originale.

Per avviare il plug-in selezionare la musica da invertire e scegliere Plug-in > Tool di 
composizione > Inverti. Si apre una finestra di dialogo nella quale definire l’altezza attorno alla 
quale invertire il materiale e stabilire se invertirlo in modo cromatico (Cromaticamente) o dia-
tonico (Diatonicamente).

Plug-in realizzato da James Larcombe e Jürgen Zimmermann. 

Mappatura Pitch
Talvolta è necessario eseguire delle variazioni su un passaggio esistente (per trasportarlo al modo 
minore, ad esempio). Questo plug-in consente di specificare nuove altezze per ogni grado della 
scala cromatica e cambiare (“mappare”) opportunamente le altezze nel passaggio selezionato.

Per usare il plug-in selezionare il passaggio da mappare e scegliere Plug-in > Tool di 
composizione > Mappatura pitch. Selezionare le altezze desiderate dai menu a tendina nella 
finestra di dialogo del plug-in e cliccare OK.

Di default, il plug-in tratta allo stesso modo tutte le note della stessa altezza (quindi SOLb e FA#
sono uguali), ma per mappare in modo diverso le note enarmoniche equivalenti cliccare sul pul-
sante Altre scelte che consente di farlo.

Si può anche scegliere se Sibelius mapperà le note esistenti a note più acute o gravi cliccando 
Nuovo pitch più alto?. Appare un’altra finestra di dialogo che permette di scegliere se Sibelius 
mapperà o meno tutte le note più acute o gravi e, se non lo fa, quanto ampio deve essere l’intervallo 
tra le altezze vecchie e nuove prima che le note siano trasportate in alto o in basso.

Il plug-in analizza tutte le note nella selezione e calcola l’altezza di ogni nota rispetto al DO (quindi 
0 è DO, 1 è DO#/REb, e così via). Cambia poi l’altezza di ogni nota in base alle impostazioni nella 
finestra di dialogo del plug-in. Supponiamo che nella finestra di dialogo il RE sia mappato sul LA#: 
tutti i RE nella selezione saranno sostituiti da LA# nella stessa ottava dell’originale (ottave ascen-
denti da DO a SI).

Mappando quindi un SOL a RE, ad esempio, esso si mapperà al RE sotto la nota originale. Non 
sempre è ciò che si vuole e per questo motivo c’è l’opzione Sposta tutto. Attivandola se una nota è 
più acuta dell’altezza definita qui sarà mappata alla nuova altezza e poi trasportata un’ottava sopra.

Plug-in sviluppato da Bob Zawalich.

Crea basso cifrato
Legge i testi di basso figurato nella partitura e crea una semplice realizzazione.
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Per usare il plug-in selezionare Plug-in > Tool di composizione > Crea basso cifrato. Appare una 
serie di semplici finestre di dialogo:

* Innanzitutto, Sibelius chiede se si vuole che il plug-in trovi automaticamente il testo di basso fig-
urato o si preferisce specificare il rigo al quale è attaccato; fare una scelta e cliccare OK.

* Se si è scelto di specificare il rigo (o il plug-in trova i testi di basso figurato su più di un rigo nella 
partitura) appare una finestra di dialogo che mostra i nomi dei righi nella partitura. Digitare il 
numero che corrisponde al rigo sul quale attaccare il basso figurato che si vuole realizzare e clic-
care OK.

* Appare quindi la finestra di dialogo Rhythmic Basis and Texture con le seguenti opzioni:
% Scegliere l’opzione Armonizza ogni nota di basso individualmente (adatta a sezioni con 

parti di basso lente) o inserire un valore nota in Ignora note di basso più corte di; usando 
la seconda opzione, il plug-in presume che le note più brevi del valore stabilito prive di una 
specifica figura debbano usare l’armonia prevalente.

% Usa scrittura musicale leggera: il plug-in scrive accordi di due o tre note nella realizzazi-
one, mantenendo la struttura più semplice (in genere omettendo la quinta).

% Un singolo # indica sempre una terza maggiore: permette di scegliere se la figura #
indica una terza maggiore, indipendentemente da quanti semitoni (half-step) la terza 
dell’accordo deve essere aumentata per essere così, oppure se un # da solo significa semplice-
mente di aumentare la terza dell’accordo di un solo semitono (half-step).

% Mantieni ottava di basso originale: il plug-in mantiene la linea di basso sulla mano sinis-
tra della realizzazione nella stessa ottava delle note originali; disattivando questa opzione, il 
plug-in potrebbe trasportare le note di basso di un’ottava per portarle più vicine alle note della 
mano destra.

* Una volta definite queste opzioni cliccare OK: il plug-in crea la sua realizzazione, ma prima di 
farlo cancella qualsiasi realizzazione precedente.

Un aspetto della notazione di basso figurato non gestito automaticamente dal plug-in è la linea 
orizzontale scritta tra set di figure, la quale denota che la figura precedente prevarrà sopra tutte le 
note lungo la linea. Per ottenere ciò aggiungere un testo di basso figurato costituito da un trattino 
(–) sotto ogni nota alla quale applicare la figura precedente; si può nascondere questo testo (con il 
comando Modifica > Mostra o nascondi > Nascondi) e il plug-in lo riconoscerà comunque – è 
possibile poi aggiungere linee orizzontali vere e proprie con la finestra di dialogo Crea > Linea.

Plug-in realizzato da Eric Froggatt.

Reduce
Riduce la musica da un numero più grande di righi a un singolo rigo. Per usare questo plug-in:

* Selezionare un passaggio da più righi, copiarlo nel clipboard con Ctrl+C or XC, selezionare i 
righi su quali ridurlo e scegliere Plug-in > Tool di composizione > Reduce. Sibelius riduce la 
musica sui righi di destinazione usando le impostazioni correnti di default;

* Altrimenti selezionare il passaggio da più righi che si vogliono ridurre e scegliere Plug-in > Tool 
di composizione > Riduci; si apre una finestra di dialogo che chiede se si vuole ridurre su un 
rigo esistente (in tal caso quale) o creare un nuovo rigo.
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Si può avviare il plug-in anche senza alcuna selezione; appare una finestra di dialogo che consente 
di definire come la musica sarà ridotta:

* Scegliere l’opzione Use minimum number of voices o Separate all parts into separate 
voices; il default è organizzare le note nel numero minore possibile di voci.

* Attivare l’opzione Ignore cue passages per assicurarsi che il plug-in non tenti di ridurre i pas-
saggi introduttivi nei righi sorgente in quelli di destinazione.

* Ignore duplicate text, lines and symbols within: attivandola Sibelius ignora segni identici 
sui righi sorgente se si trovano alle stesse posizioni ritmiche (o molto vicine) su più righi. 
Impostare la distanza alla quale Sibelius ignorerà segni identici a quarter (crotchet), eighth 
(quaver) o 16th (semiquaver).

* Se è attiva l’opzione Overwrite existing material il plug-in sostituisce la musica esistente nel 
rigo di destinazione.

Per ridurre la musica su un numero inferiore di righi (ma su più di un singolo rigo) usare la funzi-
one Arrange di Sibelius – see Riduzione on page 338.

Plug-in realizzato da Dave Foster.

Retrocedi
Crea una versione al contrario del passaggio selezionato – in altre parole, inverte la musica. 
Per esempio, il plug-in riscrive il passaggio:

come:

Per usare questo plug-in selezionare il passaggio da invertire e scegliere Plug-in > Tool di 
composizione > Retrocedi. Appare una finestra che informa sulle limitazioni del plug-in. 
Cliccando OK si crea una nuova partitura con la musica risultante.

Plug-in realizzato da Bob Zawalich.

Visualizza Handbells richiesti
Questo plug-in interessa solo partiture con musica per un ensemble di campane a mano e 
aggiunge una misura all’inizio della partitura che mostra tutte le campane a mano necessarie ad 
eseguire il pezzo. Per usare il plug-in selezionare Plug-in > Tool di composizione > Visualizza 
Handbells richiesti. Una volta avviato il plug-in potrebbe essere necessario cancellare le pause o 
le chiavi nella misura creata dal plug-in.

Plug-in realizzato da Neil Sands.

Trasforma Scala
Cambia le altezze nella partitura corrente dalla scala corrente a una nuova scala, per modificare 
(ad esempio) il modo di una melodia da maggiore a minore oppure cambiare una melodia penta-
tonica in modo che usi una scala esatonale (a toni interi), e così via.
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Per usare il plug-in selezionare il passaggio da trasformare e scegliere Plug-in > Tool di 
composizione > Trasforma Scala. Appare una finestra di dialogo nella quale specificare la scala 
corrente della musica e la nuova scala nella quale trasformarla. L’opzione Snap non-scale tones 
to scale tones determina se il plug-in deve far scattare una nota non nella scala alla nota più vic-
ina che fa parte della scala; per esempio, la nota MIb non c’è nella scala di SOL maggiore, quindi si 
può decidere se il plug-in deve lasciarla invariata o farla scattare alla nota più vicina presente nella 
scala (a un RE, ad esempio); fare una scelta e cliccare OK.

Il plug-in ha molte altre opzioni che si possono vedere cliccando sul pulsante Mostra Opzioni
nella finestra di dialogo che appare:

* Altri tipi di scale si definiscono cliccando sul pulsante Add/Edit Scales.

* Per salvare e richiamare le trasformazioni che si usano più spesso cliccare Save/Restore Map.

* La direzione nella quale Sibelius trasporta le note quando si trasforma la scala si stabilisce clic-
cando su New Pitch Higher?

Ciascuna di queste finestre di dialogo presentano informazioni dettagliate sul loro uso; inoltre il 
plug-in ha anche un pulsante Help che visualizza ulteriori dettagli.

Plug-in realizzato da Bob Zawalich.

NOTE E PAUSE

Aggiungi teste di nota barrate per parti
Quando per il trasporto delle partiture si usano teste nota barrate (slash) nelle parti è convenzione 
collocare gli slash nel mezzo del rigo. Tuttavia, poiché in Sibelius le teste nota slash sono traspor-
tate quando è attiva l’opzione Note > Partitura traspositore, gli slash potrebbero andare a finire 
in posizioni sbagliate sul rigo nella partitura completa o sulla parte; questo plug-in risolve il prob-
lema creando nuovi slash in parti che sono nascoste nella partitura completa e nascondendo nelle 
parti gli slash trasportati dalla partitura.

Per usare il plug-in, innanzitutto assicurarsi che si veda la partitura completa (non una parte 
dinamica) e poi scegliere Plug-in > Note e Pause > Aggiungi teste nota barrate per parti. 
Il plug-in consente di stabilire quale voce Sibelius dovrà usare per inserire i nuovi slash.

Plug-in realizzato da Bob Zawalich.

Applica Shape Notes
Cambia le teste nota in base alla rispettiva altezza in modo che usino le convenzioni di forma a 4-
note o 7-note.

Per usare il plug-in selezionare Plug-in > Note e Pause > Applica Shape Notes; scegliere la con-
venzione di forma nota preferita e cliccare OK; se poi si vuole tornare alla notazione regolare con le 
normali teste nota avviare di nuovo il plug-in e selezionare Ripristina teste delle note normali.

Plug-in realizzato da Gunnar Hellquist. 
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Boomwhacker® Note Colors
Questo plug-in colora le note secondo lo schema colore Boomwhacker® (per i dettagli visitare il sito 
www.whackymusic.com). Per usare il plug-in selezionare Plug-in > Note e Pause > Boom-
whackers Note Colors. Sibelius cambia il colore di tutte le note nella partitura e fa presente che 
per stampare la partitura a colori si deve attivare l’opzione Stampa opzioni menu Vista nella 
finestra di dialogo File > Stampa.

Il plug-in funziona cambiando i colori usati dalla funzione Vista > Colori note > Pitch Spectrum 
e attivandola, in modo che non cambi la partitura vera e propria; quindi la prima volta che si vuole 
stampare una partitura con i colori nota Boomwhacker, dopo aver avviato Sibelius bisogna avviare 
il plug-in; non è necessario poi avviare di nuovo il plug-in durante quella sessione d’uso di Sibelius. 
Poiché il plug-in attiva l’opzione Vista > Colori note > Pitch Spectrum ogni partitura sulla quale si 
lavora utilizzerà i colori nota Boomwhacker – per evitarlo scegliere una delle altre opzioni dal 
submenu Vista > Colori note oppure avviare di nuovo il plug-in in modo da resettare i colori Pitch 
Spectrum ai rispettivi default.

Plug-in realizzato da Andrew Davis. 

Color Pitches
Questo plug-in colora le note in base alla loro altezza, una convenzione utilizzata talvolta nella 
didattica musicale. Per usare questo plug-in selezionare il passaggio nel quale cambiare il colore 
delle note (o non selezionare niente per applicare l’operazione all’intera partitura) e scegliere Plug-
in > Note e Pause > Color Pitches. Appare una finestra di dialogo nella quale si può scegliere un 
colore per ciascuna delle dodici note della scala cromatica; fatte le proprie scelte cliccare OK: i col-
ori sono applicati alle note nella selezione.

Attenzione! Tutte le note in qualsiasi accordo nella selezione sono colorate in base all’altezza della 
nota più acuta dell’accordo.

Plug-in realizzato da Andrew Davis.

Converti tempo semplice in tempo composto
Riscrive i passaggi in 4/4, 3/4 ecc., nei tempi in chiave composti di 12/8, 9/8 ecc., raddoppiando la 
durata delle note da 1/8 (crome) dispari in ogni misura. L’eccezione a questa regola è che le terzine 
di ottavi, le note da 1/4 e da 1/2 sono mantenute regolari.

Per usare questo plug-in selezionare il passaggio da convertire e scegliere Plug-in > Note e Pause >
Converti tempo semplice in tempo composto. Prima di avviare questo plug-in si può avviare 
il plug-in Straighten Written-Out Swing (vedere in seguito) il quale trasforma le note puntate 
swing in tempo composto.

Se nel passaggio selezionato non c’è un tempo in chiave, il plug-in presume che sia in 4/4.

La notazione convertita è aggiunta nella partitura alla fine della selezione. Dove non è stato con-
vertito un gruppo irregolare (tuplet) è aggiunto un testo d’avviso alla partitura che indica il 
numero della misura contenente il gruppo irregolare originale, in modo da poterlo correggere. 
Il plug-in copia solo note: articolazioni, linee, stanghette speciali, parole, ecc. non sono copiate, 
quindi dovranno essere copiate o ricreate dopo aver usato il plug-in.

Plug-in realizzato da Peter Hayter. 
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Copia articolazioni e legature
Questo plug-in consente di copiare articolazioni e legature da una frase musicale ad altre con lo 
stesso ritmo (o simile). 

Per copiare articolazioni e legature di una frase musicale nel clipboard:

* Selezionare come passaggio la frase con le articolazioni e legature da copiare.
* Scegliere Plug-in > Note e Pause > Copia articolazioni e legature.

* Dall’elenco Scegli una funzione selezionare Copia nella clipboard.

* Selezionare la voce nella quale ci sono le note con articolazioni e legature da copiare.
* Per copiare una o l’altra si possono scegliere le opzioni Copia articolazioni e Copia legature in 

modo indipendente.
* Cliccare OK.

A questo punto, il plug-in copia le articolazioni e le legature all’interno della frase selezionata nel 
proprio clipboard; dopo averlo fatto genera un messaggio che invita a scegliere Chiudi o OK nella 
finestra di dialogo principale (dipende se si desidera copiare articolazioni e legature sull’intera par-
titura o in un’altra frase simile).

Per copiare articolazioni e legature ad ogni ritmo corrispondente in tutta la partitura:

* Assicurarsi che l’elenco Scegli una funzione sia impostato in Incolla in tutto lo spartito.

* Per fare in modo che il plug-in rimuova qualsiasi articolazione esistente in tutte le note alle quali 
deve copiare le articolazioni scegliere Sostituisci articolazioni esistenti.

* Per fare in modo che il plug-in copi articolazioni e legature nei passaggi con i valori nota che 
sono il doppio o la metà di quelli nella selezione originale selezionare Also copy to augmenta-
tions and diminutions

* Cliccare OK.

Il plug-in copia articolazioni e legature dalla selezione originale a tutti i passaggi simili, da inizio a 
fine partitura.

Per copiare articolazioni e legature che corrispondano ai ritmi in un particolare passaggio:

* Cliccare sul pulsante Chiudi.
* Selezionare un passaggio con le note per le quali si desidera copiare articolazioni e legature. 

Si possono copiare articolazioni e legature su più frasi simultaneamente includendole tutte nel 
passaggio che si seleziona; non è necessario essere esatti per quanto riguarda inizio, fine e righi 
racchiusi nel passaggio, poiché articolazioni e legature saranno copiate sulle frasi all’interno di 
esso che corrispondono al ritmo originale.

* Selezionare Plug-in > Note e Pause > Copia articolazioni e legature.

* Dall’elenco Scegli una funzione selezionare Incolla nella selezione.

* Per fare in modo che il plug-in rimuova le articolazioni esistenti nelle note sulle quali deve copi-
are le articolazioni selezionare Sostituisci articolazioni esistenti.

* Se la selezione che si sta copiando ha valori nota più lunghi o corti dell’originale attivare l’opzione 
Also copy to augmentations and diminutions.

* Cliccare OK.
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Il plug-in copia articolazioni e legature dalla frase originale su tutte le frasi corrispondenti nelle 
selezioni successive.

Plug-in realizzato da Neil Sands.

Valori delle note dimezzate/doppie
Talvolta è utile dimezzare o raddoppiare tutti i valori nota nella partitura (es. trascrivendo musica 
antica nella quale i valori nota durano il doppio di come sono scritti nelle edizioni moderne).

Per avviare questi due plug-in selezionare un passaggio di musica e scegliere Valori delle note 
dimezzate o doppie dal submenu Plug-in > Note e Pause. Appare una finestra di dialogo che 
indica le limitazioni del plug-in.

Cliccando OK si crea una nuova partitura con il passaggio selezionato copiato in forma aumentata 
o diminuita. I plug-in copiano anche i tempi in chiave (raddoppiandoli o dimezzandoli oppor-
tunamente) e creano le legature adeguate.

Plug-in realizzato da Bob Zawalich.

Rendi i pitch costanti
Imposta tutte le note in una selezione alla stessa altezza, cambiando eventualmente il tipo di testa 
nota utilizzato e completando la misura con note in un’altra voce (es. per completare una misura 
con note slash mentre si visualizza un ritmo specifico sul quale il musicista possa improvvisare). 
Per esempio, questo plug-in può trasformare la misura a sinistra in quella a destra con pochi clic 
del mouse:

Per usare questo plug-in selezionare il passaggio di altezze da rendere costante e scegliere Plug-in >
Note e Pause > Rendi i pitch costanti. Appare una finestra di dialogo divisa a metà:

* La metà superiore modifica le note esistenti. Specificare la voce alla quale appartengono le note 
da trasportare e, per cambiare anche le teste nota, impostare il tipo di testa nota desiderato. 
L’opzione Sposta le pause insieme alle note sposta in verticale tutte le pause nel passaggio, in 
modo che corrispondano all’altezza delle note trasportate.

* La metà inferiore permette di aggiungere nuove note a un’altra voce nello stesso passaggio; ciò è 
particolarmente utile per creare la notazione slash. Scegliere la voce da usare per le nuove note 
(assicurandosi che sia diversa dalla voce con le note da trasportare), impostare altezza, tipo di 
testa nota e valore nota, quindi cliccare OK.

Plug-in perfezionato da Stefan Behrisch (www.werklabor.de). 

Rimuovi legature sospese
Talvolta, durante la riproduzione, una nota continua a suonare all’infinito se accidentalmente è 
stata usata una legatura di valore al posto di una legatura di portamento; questo plug-in verifica 
nella partitura le note con legature di valore “sospese” – cioè non legate ad una nota successiva.
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Per usare il plug-in selezionare il passaggio da correggere e scegliere Plug-in > Note e Pause >
Rimuovi legature sospese.

Dividi pause di quarti puntati
Nei tempi in chiave composti (come 6/8), Sibelius scrive (ad esempio) una pausa di un movimento 
come una nota da 1/4 puntata; si tratta della convenzione moderna. Per alcuni musicisti, però, è 
più facile leggere queste pause divise in due valori da 1/4 e 1/8; questo plug-in sostituisce automati-
camente queste pause così:

Per usare il plug-in selezionare il passaggio nel quale dividere le pause e scegliere Plug-in > Note e 
Pause > Dividi pause di quarti puntati. Ovviamente, se il passaggio contiene note esse non sono 
toccate.

Straighten Written-Out Swing

Converte il ritmo swing scritto  in note regolari da 1/8 (crome).

Per usare il plug-in selezionare il passaggio da convertire e scegliere Plug-in > Note e Pause >
Straighten Written-Out Swing. Si può scegliere se inserire la scritta Swing al passaggio 
riscritto.

Attenzione! il passaggio riscritto perderà le articolazioni; le parole non sono riscritte, quindi 
potrebbero andare a finire in una posizione sbagliata nella misura; anche altri oggetti che erano 
allineati al ritmo originale dovranno essere regolati manualmente.

Plug-in realizzato da Peter Hayter. 

ALTRO

Aggiungi pedali arpa
Aggiunge automaticamente adeguati diagrammi di pedale per l’arpa o testi d’istruzione di cambio 
pedale in parti di arpa e avvisa quando i cambi pedale sono troppo ravvicinati per essere comoda-
mente eseguiti o quando la musica non è suonabile.

Per usare il plug-in, prima selezionare il passaggio nel quale inserire la pedalatura (selezionare 
solo i righi d’arpa), poi scegliere Plug-in > Altro > Aggiungi pedali arpa; appare una finestra:

* Aggiungi a: consente di scegliere se processare l’intera partitura (Tutto lo spartito) o solo il 
passaggio selezionato (Passaggio selezionato).

* Quarti di nota (semiminime) richieste per cambiare tutti i pedali: permette di regolare il 
tempo previsto necessario a cambiare tutti i pedali; in musica veloce aumentare oppor-
tunamente questo valore.

* Si può decidere se la pedalatura inserita nella partitura sarà in diagrammi (Diagramma) o con 
la scritta in box (Testo boxed).

Default Dopo applicazione plug-in
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* Infine, scegliere se le pedalature inserite devono essere evidenziate (per trovarle facilmente in 
lunghe partiture se si desidera controllarle in seguito). Evidenzia altri cambi si riferisce ai 
cambi pedale da eseguire immediatamente, prima che serva una nota; il plug-in cerca di evitarli 
se non riesce a trovare un punto per il cambio anticipato.

Cliccando OK il plug-in inserisce la pedalatura. Attenzione! Usando i pedali d’arpa, non si possno 
impostare doppi diesis e doppi bemolle; se ce ne sono scritti nella musica, il plug-in avvisa della 
loro presenza quando ha finito di scrivere le altre modifiche.

Plug-in realizzato da Neil Sands.

Aggiungi nomi delle note alle teste delle note
Scrive il nome della nota all’interno della testa nota con il font Opus Note Names, così:

Per usare questo plug-in selezionare il passaggio nel quale scrivere i nomi delle note (o tutta la par-
titura) e scegliere Plug-in > Altro > Aggiungi nomi delle note alle teste delle note. Appare una 
finestra di dialogo nella quale si può decidere se i nomi delle note scritte dentro le teste nota deb-
bano includere le alterazioni; cliccare OK e la partitura è aggiornata.

Aggiungendo altre note o cambiando le altezze delle note già nella partitura, bisognerà avviare di 
nuovo il plug-in per aggiornare i nomi delle note dentro le teste nota.

Plug-in realizzato da Neil Sands

Groovy Music Mark-up
Aggiunge annotazioni (in forma di messaggi MIDI) alla partitura corrente, che agiscono da 
“marker” speciali quando s’importa un file MIDI generato dalla partitura in Groovy Jungle o 
Groovy City. Groovy Music è una serie di tre programmi per l’insegnamento facile e divertente 
della musica ai bambini – per maggiori dettagli: www.sibelius.com/products/groovy.

Selezionare un passaggio su un singolo rigo, oppure una o più note singole e scegliere Plug-in >
Altro > Groovy Music Markup. Un messaggio chiede di scegliere su quale prodotto Groovy Music 
esportare. Nella finestra che appare scegliere se un elemento Melody, Bass, Rhythm, Chord, 
Arpeggio ecc., quindi cliccare OK. Eseguire una nuova selezione e avviare di nuovo il plug-in per 
segnare un altro elemento e continuare così fino a quando è terminata la marcatura della partitura.

Quando la partitura è segnata tutta come si desidera selezionare File > Esporta > File MIDI ed 
esportare un file MIDI (b Esportare i file MIDI), poi caricare il file MIDI risultante in Groovy 
cliccando Open Song.

Per altre informazioni il plug-in ha un pulsante Help che offre maggiori dettagli.

Rendi layout uniforme
Obbliga la partitura ad avere un numero ben definito di misure per sistema e sistemi per pagina. 
Il default di 4 e 4 è adatto per voce o strumento solista con accompagnamento di tastiera. 
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La musica solista per tastiera in genere ha 4 misure per sistema e 6 sistemi per pagina; quella per 
uno strumento a rigo singolo di solito ha 4 misure per sistema e 10 sistemi per pagina.

La prima pagina di una partitura spesso ha meno sistemi delle pagine successive (per far spazio al 
titolo); questo plug-in consente di definire il numero di sistemi sulla prima pagina indipendente-
mente dal resto della partitura.

Sibelius può configurare automaticamente l’intera partitura con un numero uniforme di misure 
per sistema e riformattarla dinamicamente quando cambia (b Layout automatico).In genere, 
quindi, questo plug-in si usa unicamente per fare in modo che solo parte della partitura abbia un 
layout uniforme.

Selezionare il passaggio da uniformare e scegliere Plug-in > Altro > Rendi layout uniforme.

Attiva layout per pianoforte a quattro mani
Prende una partitura scritta per due pianoforti (o meglio per due strumenti a tastiera) e crea una 
nuova partitura in formato convenzionale a quattro mani, con la musica per il musicista più grave 
(secondo) sulle pagine sinistre e quella per il musicista più acuto (primo) sulle pagine destre.

Per usare il plug-in, innanzitutto preparare la partitura sorgente (che dovrà contenere solo due 
strumenti a tastiera). Poi usare il comando Crea > Pagina titolo per aggiungere una pagina di 
titolo alla partitura (se non c’è già) o comunque assicurarsi che la prima pagina di musica sia sinis-
tra (ciò aiuta il plug-in a generare i cambi pagina corretti nella partitura creata). Infine, selezionare 
l’intera partitura ed eseguire il comando Layout > Formato > Blocca formato poi scegliere Plug-
in > Altro > Layout per pianoforte a quattro mani.

Appare una finestra di dialogo, nella quale scegliere i nomi strumento da usare per ogni strumento 
nella nuova partitura creata. L’opzione Keep facing pages in sync dice al plug-in di assicurarsi 
che sulle pagine sinistre e destre di ogni sistema appaiano le stesse misure. Cliccare OK e osservare 
le barre di progresso sfrecciare sullo schermo; poco dopo è creata la nuova partitura.

Una volta avviato il plug-in probabilmente bisognerà fare un pò d’ordine: il plug-in crea utili 
oggetti di testo con la scritta “P4H” ad ogni punto ove serve ordine (si può trovare con la funzione 
Modifica > Trova per decidere cosa fare caso per caso).

Plug-in realizzato da Hans-Christoph Wirth.

Preferenze
Questo plug-in è destinato ad essere usato solo dagli sviluppatori dei plug-in. Per maggiori infor-
mazioni vedere la documentazione ManuScript separata.

Rimuovi evidenziati
Questo plug-in rimuove tutte le evidenziature dalla partitura; per usarlo selezionare Plug-in >
Altro > Rimuovi evidenziati.

Scale ed Arpeggi
Crea esercizi contenenti dozzine di scale e arpeggi con pochi clic del mouse. Per usare il plug-in 
selezionare Plug-in > Altro > Scale ed arpeggi. Si è guidati lungo una serie di finestre di dialogo 
secondo i seguenti criteri:
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* Se una partitura è già aperta un messaggio chiede prima se si vogliono aggiungere le scale alla 
partitura esistente o crearne una nuova: fare una scelta e cliccare Seguente.

* Se si sta realizzando una nuova partitura Sibelius chiede se si vogliono creare le scale per uno 
strumento a singolo rigo o per uno a tastiera. Si può anche chiedere al plug-in di generare un 
solo esempio per ogni tipo di scala e arpeggio che può creare; fare una scelta e cliccare Seg-
uente.

* Un messaggio chiede di scegliere tra diversi tipi di scale o arpeggi: scale maggiori, minori, 
modali, alterate, jazz e arpeggi; anche qui fare un scelta e cliccare Seguente.

* La finestra di dialogo successiva permette di specificare le opzioni per scale o arpeggi che si 
vogliono creare: tipo di scala, numero di ottave (e in quale ottava deve iniziare), direzione, valore 
nota da usare, chiave, e così via. L’opzione Includi indicazione di tonalità inserisce una nuova 
tonalità all’inizio di ogni scala.
Se si desidera creare scale per tastiera è possibile specificare se aggiungere un intervallo di una 
terza o un’ottava sopra le note nel rigo per la mano destra.
Per creare una serie di scale si può scegliere se ogni nuova scala deve essere nella tonalità della 
nuova nota di partenza o rimanere nella tonalità originale ma iniziare semplicemente da un 
altro grado della scala.
Una volta definite le opzioni desiderate:
% Se si stanno creando scale o arpeggi per uno strumento a singolo rigo cliccare Fine.
% Se si stanno creando scale per uno strumento a tastiera cliccare Seguente. È possibile poi 

eseguire alcune altre scelte se la scala deve essere creata in senso uguale o contrario, se il rigo 
per la mano sinistra deve iniziare nella stessa ottava o in una diversa dal rigo per la mano 
destra, e così via.

* Una volta cliccato Fine il plug-in crea in pochi secondi scale o arpeggi desiderati.

Plug-in realizzato da Gunnar Hellquist. 

Imposta indicazione di metronomo
Consente di creare segni di metronomo a velocità specifiche battendo il tempo con il mouse. Per 
usare il plug-in selezionare la misura nella quale creare il segno di metronomo (o non selezionare 
niente, per crearlo nella prima misura) e scegliere Plug-in > Altro > Imposta indicazione di met-
ronomo.

Nella finestra di dialogo che appare cliccare sul grande pulsante al tempo desiderato: dopo dodici 
click il plug-in mostra il tempo medio cliccato e consente di creare un segno di metronomo a quel 
tempo preciso o a quello più vicino che si trova su un metronomo tradizionale.

Plug-in realizzato da Neil Sands e Michael Eastwood. 

Dividi Battuta
Divide una misura in due misure irregolari dalla durata adeguata, inserisce un cambio di numero 
misura adatto e, se si sceglie d’inserire un break di sistema dove si divide la misura, inserisce anche 
una stanghetta invisibile tra le due metà della misura.

Selezionare la nota prima della quale dividere la misura e scegliere Plug-in > Altro > Dividi battuta.

Plug-in realizzato da Bob Zawalich.
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Trova posizioni note guida
Segna nella partitura posizioni adatte per i passaggi introduttivi, basate su un numero minimo di 
misure di pausa o una durata minima del silenzio in secondi.

Selezionare il passaggio nel quale il plug-in suggerisca posizioni adatte per i passaggi introduttivi 
(es. triplo-clic del mouse su un rigo) e avviare il plug-in; oppure, per processare l’intera partitura, 
selezionare Plug-in > Altro > Trova posizioni note guida; appare la seguente finestra:

Sebbene si possa chiedere al plug-in di suggerire le posizioni dopo un numero di misure di pausa e 
una quantità di tempo trascorso, in genere è più utile scegliere uno o l’altro.

Le tre opzioni Indica posizioni note guida in indicano i risultati del processo eseguito dal plug-
in:

* Spartito come testo: crea un oggetto di testo Technique (colorato in rosso) sopra la prima nota 
che segue ogni posizione suggerita per un passaggio introduttivo.

* File di testo: crea un file di testo denominato nome file cue locations.txt nella stessa cartella 
in cui si trova il file della partitura che elenca le posizioni introduttive suggerite.

* Plug-in Trace Window: scrive ogni posizione introduttiva suggerita nella finestra Plug-in 
Trace.

Con l’opzione Spartito come testo si possono usare i comandi Modifica > Trova e Modifica >
Trova successivo per trovare un testo che inizia con “Cue:” per spostarsi ad ogni posizione 
introduttiva suggerita.

Plug-in realizzato da Neil Sands.

RIPRODUZIONE

Aggiungi Control Change continui
Genera messaggi di controller MIDI nella partitura facilitando l’applicazione dei cambi di control-
ler continui necessari per regolare la riproduzione (es. per altri strumenti virtuali o dispositivi di 
riproduzione).
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Per usare il plug-in, prima creare nella partitura una o più linee alla posizione (o posizioni) ove 
applicare i dati d’automazione. Utilizzare la linea orizzontale nella finestrella Staff lines della 
finestra di dialogo Crea > Linea e assicurarsi che inizi e termini sulle note sopra le quali scrivere i 
dati dei controller MIDI; selezionare poi una linea o un passaggio contenente una o più di queste 
linee e scegliere Plug-in > Riproduzione > Aggiungi Control Change continui.

Il plug-in è corredato da una serie di preset di librerie campioni; selezionare un preset (se ce n’è 
uno adatto) e cliccare Carica Preset. Se non servono ulteriori modifiche cliccare OK: il plug-in 
scrive nella partitura gli opportuni messaggi dei controller MIDI.

Naturalmente è possibile regolare i preset esistenti e creare i propri. Impostare le opzioni desider-
ate nelle finestre di dialogo e cliccare Aggiungi Preset. Sibelius chiede di scegliere un nome per il 
preset; farlo e cliccare OK. Se in seguito si cambia questo preset cliccare Salva Preset per assi-
curarsi che siano salvate le proprie modifiche.

Il plug-in consente di scrivere i controller che descrivono varie forme d’onda e curve (sinusoidale, 
quadra, triangolare, a dente di sega, esponenziale, ecc.) che si possono scegliere dal menu a ten-
dina Tipo Segnale. In base all’opzione Tipo Segnale scelta, bisognerà specificare una serie di 
parametri per le opzioni presenti nella parte destra della finestra di dialogo. Per maggiori infor-
mazioni vedere la finestra di dialogo Help del plug-in.

Plug-in realizzato da David Budde.

Riproduzione Cresc./Dim.
Abilita la riproduzione di crescendo e diminuendo su singole note tenute per strumenti appropriati 
(in particolare fiati, archi e cantanti). Sibelius non riproduce automaticamente i segni di forcine 
sulle singole note (perché usa le velocity MIDI per ottenere gradazioni della dinamica su note con-
secutive). Questo plug-in inserisce una serie di messaggi MIDI di volume o espressione per variare 
le dinamiche di una singola nota.

Per avviare questo plug-in, prima creare le forcine ove si vuole avere un cambio di volume, poi 
selezionare una misura o un passaggio contenente la forcina(e). Il metodo migliore per processare 
solo una forcina è selezionarla.

Una volta eseguita la selezione scegliere Plug-in > Riproduzione > Riproduzione Cresc./Dim.. 
Appare una finestra di dialogo che consente di stabilire se processare ogni forcina nel passaggio 
selezionato o solamente la prima, oltre a specificare inizio e fine dinamica del cresc./dim..

Si può anche decidere se usare il controller MIDI 7 o 11 per generare il cambio della dinamica. 
Di default, il plug-in usa il controller 7 (volume) poiché è quello supportato da tutti i dispositivi 
MIDI, mentre il controller 11 (espressione) non è così diffuso; può darsi che dopo avere creato una 
serie di messaggi MIDI si debba inserirne un altro per resettare il volume o il livello d’espressione 
di un particolare rigo – Per maggiori informazioni b Messaggi MIDI.

Il plug-in ha bisogno di trovare una forcina nella partitura prima di avviarsi, quindi se non si vuole 
che appaia una forcina si può crearne temporaneamente una per poi cancellarla una volta avviato il 
plug-in (ciò non cancella i messaggi MIDI).

I messaggi MIDI creati dal plug-in sono nascosti automaticamente, quindi saranno visibili solo se 
è attiva l’opzione Vista > Oggetti nascosti (Ctrl+Alt+H o zXH).
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Riproduzione armonici
Questo plug-in abilita la riproduzione degli armonici (es. sui righi d’archi) utilizzando le funzioni 
Live Playback e dei messaggi MIDI di Sibelius. Per usare il plug-in selezionare il passaggio nel 
quale riprodurre gli armonici e scegliere Plug-in > Riproduzione > Riproduzione armonici. Si 
apre una finestra di dialogo nella quale scegliere il tipo di armonici che il plug-in deve processare; 
in genere, si tengono quelli di default e si clicca OK. Un avviso invita a salvare la partitura, dopod-
ichè il plug-in processa il passaggio selezionato.

Per sentire gli armonici assicurarsi che la funzione Play > Live Playback sia attiva quando si ripro-
duce la partitura. Attenzione! Trasportando la musica o cambiando in altro modo le altezze delle 
note con gli armonici dopo aver avviato questo plug-in, per avere una corretta riproduzione assi-
curarsi di cancellare i messaggi di testo MIDI sopra le note e avviare di nuovo il plug-in.

Plug-in realizzato da Michael Eastwood. 

Riproduzione ornamenti
Inserisce i messaggi MIDI necessari alla riproduzione di mordenti e ripetizioni. Per usare il plug-in 
selezionare la nota (o note) alla quale aggiungere un ornamento e scegliere Plug-in >
Riproduzione > Riproduzione ornamenti. Appare una finestra di dialogo con le seguenti opzi-
oni:

* Mordente o Ruota: consente di scegliere il tipo d’ornamento da aggiungere.
* Inferiore: genera un ornamento invertito.
* Cromatico: genera un ornamento cromatico; disattivando questa opzione l’ornamento generato 

è diatonico.
* A fine nota: questa opzione è destinata solo alle ripetizioni; Sibelius inserisce la ripetizione alla 

fine della nota selezionata (cioè appena prima di quella successiva).
* Aggiungi simbolo: questa opzione aggiunge il rispettivo simbolo d’ornamento sopra la nota (o 

note) selezionata(e).

Una volta scelte le opzioni desiderate cliccare OK: sono aggiunti alla partitura i rispettivi messaggi 
MIDI (per vederli attivare l’opzione Vista > Oggetti nascosti).

Riproduzione dei quarti di tono
Inserisce messaggi MIDI per la riproduzione delle note da un quarto di tono. Per usare questo 
plug-in selezionare un passaggio o l’intera partitura (Ctrl+A o XA) e scegliere Plug-in >
Riproduzione > Riprodzione dei quarti di tono.

Si apre una finestra di dialogo che permette di scegliere l’entità di pitch bend necessaria a produrre 
il quarto di tono; in genere si lascia al valore di default – quindi cliccare OK.

I messaggi MIDI creati da questo plug-in sono nascosti automaticamente quindi non si vedranno, 
a meno che sia attiva l’opzione Vista > Oggetti nascosti (Ctrl+Alt+H o zXH).

Questo plug-in ha un Help che descrive nei dettagli funzionamento e limitazioni.
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Strummer
Cambia le proprietà Live Playback delle note negli accordi per offrire una pennata più realistica. 
Il plug-in è destinato alla chitarra, ma può anche essere applicato ad altri strumenti (si può speri-
mentare usandolo su arpa, clavicembalo o parti di archi in pizzicato).

Per avviare il plug-in selezionare un passaggio e scegliere Plug-in > Riproduzione > Strummer. 
Si apre una finestra di dialogo con le opzioni per scegliere quali accordi pennare (accordi con quat-
tro o più note sono ideali), come alternare le pennate in giù e in su (nella terminologia chitarris-
tica, pennare in giù significa suonare l’accordo dalle note più gravi a quelle più acute), la durata 
dell’accordo (256 tick equivalgono a una nota da 1/4) e come scrivere lo schema di pennata; le opz-
ioni sono: nessuna notazione, una scritta d o u rispettivamente per pennata giù su, o l’uso di arti-
colazioni (in tal caso, sono usati rispettivamente i simboli d’archetto giù e su).

Le opzioni di nota da 1/2, 1/4 e 1/8 collocano le pennate in giù ogni movimento specificato, con le 
pennate in su sugli accordi in ognuno degli altri movimenti. Le opzioni Strictly alternating, all 
down e all up sono auto-esplicative. 

L’opzione "use pattern" è quella più flessibile e può essere usata per generare interessanti schemi di 
pennata stile flamenco. Inserire lo schema come un arco (con "d" per la prennata in giù e "u" per 
quella in su): questo schema è applicato in sequenza a tutti gli accordi selezionati, ripetendosi 
quanto necessario (quindi avendo inserito lo schema a tre lettere dud e selezionato accordi di 
ottavi, il risultato sarà uno schema dudduddu).

Plug-in realizzato da David Harvey.

VERIFICA DI LETTURA

Proof-read
Questo plug-in consente all’utente di avviare qualsiasi combinazione di altri sei plug-in di verifica 
lettura che si trovano nello stesso menu: 

* Controlla chiavi: scrive avvisi nella partitura ove un segno si ripete inutilmente (es. in una 
parte di Viola la chiave di contralto sarà ripetuta se è stato omesso un cambio a una chiave di 
violino).

* Controlla cues – vedere in seguito.
* Controlla Parallel 5ths/8ves – vedere in seguito.
* Controlla pedaling arpa: scrive avvisi nella partitura se alcune note nel passaggio selezionato 

sono insuonabili su un’arpa con la configurazione pedale specificata nella finestra di dialogo. Per 
risultati ottimali selezionare solo i righi d’arpa prima d’avviare questo particolare plug-in, e 
specificare un passaggio privo di cambi pedale. Il plug-in, eventualmente, può aggiungere un 
diagramma pedale d’arpa alla partitura corrispondente alla combinazione di pedalatura che si 
specifica nella rispettiva finestra di dialogo.

* Controlla stop multipli – vedere in seguito.
* Controlla pizzicati: scrive avvisi nella partitura ove un “arco” o “pizz.” è superfluo o mancante.
* Controlla stanghette di ripetizione scrive avvisi nella partitura ove un inizio o fine ripetiz-

ione sembra superfluo o mancante (cioè le stanghette di ripetizione non corrispondono).
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Se la partitura è molto lunga usare la funzione Modifica > Trova di Sibelius (b Filtri e Trova) 
per scorrere gli avvisi che il plug-in colloca nella partitura.

Volendo, si può avviare individualmente uno qualsiasi di questi plug-in selezionandoli dal sub-
menu Plug-in > Verifica di lettura.

Controlla collegamenti
Questo plug-in è molto utile per individuare situazioni in cui un segno d’espressione è stato erro-
neamente attaccato al rigo sotto o sopra quello previsto. Per usare il plug-in selezionare Plug-
in > Verifica di lettura > Controlla collegamenti. Il plug-in può verificare la partitura corrente o 
guardare nello stesso momento a un gruppo di file nella cartella specificata. Selezionare l’opzione 
più opportuna dalla prima finestra di dialogo visualizzata dal plug-in e cliccare Avanti; appare la 
finestra di dialogo seguente:

* Rimozione colori marker esistenti prima della colorazione: serve per quando prima è già 
stato avviato il plug-in e si vuole confermare che le modifiche eseguite per risolvere i problemi 
precedenti sono state corrette; questa opzione garantisce che tutti gli oggetti colorati correnti 
presenti nella partitura tornano ad essere di colore nero prima che il plug-in esegua la sua veri-
fica.

* Scrivi in file log: registra tutti i problemi potenziali in un file di testo denominato Sibelius 
Attachment Log.txt situato nella cartella Scores.

* Scrivi in finestra monitoring plug-in registra tutti i problemi potenziali nella finestra Plug-in
Trace di Sibelius.

* Usa questo colore per evidenziare collegamenti: consente di scegliere il colore che il plug-in 
userà per rendere i visivamente evidenti i problemi nella partitura.

* Le impostazioni Opzioni di posizione speciali permettono di stabilire dove di default gli stili 
di testo più comuni sono collocati nella partitura, in modo che il plug-in sia in grado di accertare 
efficacemente eventuali problemi.

Una volta impostate opportunamente tutte le opzioni cliccare sul pulsante OK: il plug-in analizza 
la partitura(e) evidenziando qualsiasi problema.

Plug-in realizzato da Bob Zawalich.
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Controlla battuta d’entrata
Verifica che i passaggi introduttivi nella partitura corrispondano alla note nei righi dai quali sono 
stati copiati. Ciò è utile se si è continuato ad eseguire modifiche nella partitura da quando sono 
stati aggiunti passaggi introduttivi alle parti ed ora si vuole verificare che quelle modifiche si riflet-
tano anche nei rispettivi passaggi introduttivi.

Selezionare il passaggio nel quale verificare i passaggi introduttivi (es. triplo-clic del mouse su un 
rigo) poi avviare il plug-in, oppure (per processare l’intera partitura) selezionare Plug-in > Verifica 
di lettura > Controlla battuta d’entrata; appare una finestra di dialogo:

Le tre opzioni Evidenzia battute d’entrata come in indicano i risultati dell’azione del plug-in:

* Spartito come testo: crea un oggetto di testo Technique (colorato in rosso) sopra la prima nota 
di ogni passaggio introduttivo sospetto.

* File di testo: crea un file di testo denominato nome file suspect cues.txt nella stessa cartella in 
cui si trova il file della partitura che elenca la posizione di ogni passaggio introduttivo sospetto.

* Finestra monitoring plug-in: scrive la posizione di ogni passaggio introduttivo sospetto nella 
finestra Plug-in Trace.

Con l’opzione Spartito come testo si possono usare i comandi Modifica > Trova e Modifica >
Trova successivo per trovare il testo che inizia con la scritta “Suspect cue:” per spostarsi a turno 
ad ogni passaggio introduttivo sospetto.

Plug-in realizzato da Neil Sands.

Controlla quinte/ottave parallele
Verifica gli intervalli di quinta e ottava tra le note in ogni voce su tutti i righi. Il plug-in verifica 
anche quinte e ottave “nascoste” (cioè quelle inverse).

Per verificare l’intera partitura selezionare Modifica > Seleziona > Seleziona tutto (Ctrl+A o
XA) e scegliere Plug-in > Verifica di lettura > Controlla quinte/ottave parallele; altrimenti 
selezionare solo il passaggio da verificare prima di avviare il plug-in. Nella finestra di dialogo sceg-
liere se verificare le quinte, le ottave o entrambe e cliccare OK; dopo alcuni secondi d’intensa attiv-
ità Sibelius mostra gli errori trovati, i quali sono segnati con una scritta nella partitura. (Il testo 
d’avviso inizia appena sopra la prima nota incriminata del parallelo 5°/8°).

reference.book  Page 417  Wednesday, April 16, 2008  4:28 PM



5. Funzioni efficaci

418

Se la partitura è molto lunga usare la funzione Modifica > Trova di Sibelius per trovare tutti gli 
appunti che il plug-in ha collocato nella partitura.

Controlla trattini d’unione delle parole
Verifica le parole nella partitura alla ricerca di trattini incorretti usando il sillabatore interno di Sibelius.

Per usare il plug-in selezionare un passaggio specifico nella partitura (se si desidera) e scegliere 
Plug-in > Verifica di lettura > Controlla trattini d’unione delle parole.

Si può decidere se verificare l’intera partitura o un passaggio selezionato e scegliere la lingua in cui 
sono scritte le parole (Inglese, Francese, Tedesco, Italiano, Spagnolo e Latino).

Scegliere se il plug-in deve colorare in rosso i trattini scorretti (Colora trattini d’unione scorretti 
di rosso) e anche correggere le parole nella partitura (Correggi parole in spartito); la seconda 
opzione sostituisce le parole sillabate in modo scorretto con la giusta sillabazione. Le opzioni 
Elenca correzioni in salvano un file di testo che elenca tutte le parole sillabate in modo scorretto 
nella stessa cartella della partitura o nella finestra Plug-in Trace.

Plug-in realizzato da Neil Sands.

Controlla stop multipli
Verifica la partitura e trova gli accordi che richiedono più stop insuonabili. Ogni accordo (in una 
singola voce o parte di un passaggio in contrappunto) può essere facile, difficile o inpossibile: gli 
accordi facili sono trascurati, quelli difficili o impossibili sono indicati come tali nella partitura.

Per usare il plug-in selezionare un passaggio specifico (se si desidera) e scegliere Plug-in > Verifica 
di lettura > Controlla stop multipli. Appare una finestra di dialogo nella quale stabilire se verifi-
care solo il passaggio selezionato o l’intera partitura e se verificare i righi che appartengono a stru-
menti a corda (scelta raccomandata) o tutti i righi; cliccare OK: appare una barra di progresso 
mentre il plug-in esamina a turno ogni rigo.

Ogni accordo difficile o impossibile è indicato da un testo Technique; le funzioni Modifica > Trova
e Modifica > Trova successivo di Sibelius trovano ogni accordo identificato dal plug-in (b Filtri 
e Trova).

Il plug-in valuta la possibile collocazione di ogni nota dell’accordo su ogni corda dello strumento, 
suonata da ciascun dito e determina la posizione più facile per l’accordo; è la definizione applicata 
all’accordo nella partitura. Si consideri lo stretch delle dita che i musicisti possono applicare sullo 
strumento; alcuni (con dita lunghe!) riescono a suonare accordi definiti impossibili dal plug-in. 
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Gli accordi con più di quattro note sono automaticamente ritenuti impossibili (perché tutti gli 
archi hanno solo quattro corde).

Poiché l’archetto è diritto e le tastiere degli archi sono curve, su uno strumento reale solo due note 
possono suonare contemporaneamente; il plug-in considera ciò, ma stabilisce che le due note più 
acute di ogni accordo devono essere su corde adiacenti, altrimenti non possono essere tenute 
entrambe; ogni accordo le cui due note più acute non sono su corde adiacenti è definito impossibile.

Gli accordi definiti difficili in genere comportano molto stretch (ma non impossibile) o una posiz-
ione innaturale della mano (la posizione ideale è con l’indice sulla corda più bassa, il medio su 
quella più bassa successiva, ecc.; bicordi su due corde sono quindi suonabili, mentre per suonare 
agevolmente accordi su tre e quattro corde, le dita devono essere sistemate nel giusto ordine).

Il plug-in agisce indipendentemente dal contesto musicale (es. un passaggio costituito da 24 
accordi in doppio stop “facili” in fila sono processati tranquillamente). Analogamente, il plug-in 
non tiene conto dei problemi di tempo.

Plug-in realizzato da Neil Sands. 

Cosa è dove
Questo plug-in crea un set di statistiche che mostrano gli oggetti esistenti in una selezione eseguita 
nella partitura corrente. Si può scegliere quali oggetti includere nelle statistiche e decidere se il 
plug-in deve colorare gli oggetti inclusi nella propria analisi. Se è attiva l’opzione Scrivi file Log 
l’analisi è salvata in un file di testo denominato dove.txt, che si trova nella stessa cartella della par-
titura in analisi; si può anche visualizzare l’uscita del plug-in nella finestra Plug-in Trace attivando 
l’opzione Write to plug-in trace window.

Usare l’opzione Remove existing marking color before coloring quando il plug-in è stato usato 
in precedenza e si vogliono annullare i colori che c’erano prima dell’analisi successiva.

Plug-in realizzato da Bob Zawalich.

SEMPLIFICA NOTAZIONE

Cambio punto di split
Cambia il punto di separazione delle note tra i righi per la mano destra e sinistra di un piano o 
altro strumento che usa due righi; è utile per ripulire la musica inserita in Flexi-time o via MIDI.

Per usare il plug-in selezionare il passaggio nel quale cambiare il punto di divisione e scegliere 
Plug-in > Semplifica notazione > Cambio punto di split. Nella finestra di dialogo che appare 
specificare il nuovo punto di divisione e se si vuole che le note sopra di esso siano scritte sul rigo per 
la mano sinistra o destra, quindi cliccare OK: il plug-in sposta opportunamente le note tra i righi.

Plug-in realizzato da Bob Zawalich.

Combina note legate e pause
Unisce le note legate e i gruppi di pause in valori nota più lunghi; è utile per ripulire partiture 
pesantemente modificate o quelle inserite via Flexi-time o con un import MIDI.
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Per usare il plug-in selezionare Plug-in > Semplifica notazione > Combina note legate e pause. 
Se non è selezionato niente, Sibelius chiede se l’operazione deve essere applicata all’intera partitura 
(altrimenti il plug-in agisce sul passaggio selezionato).

Si può decidere se combinare note legate o pause (o entrambe) e, poiché il plug-in può alterare 
notevolmente l’aspetto della partitura, è possibile anche creare un file di testo che elenca tutte le 
modifiche eseguite (si può anche creare un file che elenca tutte le modifiche che il plug-in può 
eseguire senza però eseguirle veramente).

Questo sofisticato plug-in è provvisto di una completa documentazione interna: cliccare Help
nella finestra di dialogo iniziale per avere maggiori informazioni sulle regole che usa per unire 
note legate e pause, oltre alle indicazioni sulle proprie limitazioni.

Plug-in realizzato da Bob Zawalich. 

Duplicati In righi
Agisce su una selezione contenente due righi, colorando tutte le note simili che ci sono nello stesso 
momento in entrambi i righi. Si può scegliere il colore usato per distinguere le note duplicate; il 
plug-in visualizza i duplicati trovati nella finestra Plug-in Trace e al termine del processo genera un 
messaggio che indica il numero di duplicati trovati.

Ciò è utile (ad esempio) per identificare facilmente nella partitura tutti gli strumenti che si dupli-
cano a vicenda in un determinato punto.

Plug-in realizzato da Bob Zawalich.

Sposta su altro rigo
Sposta una singola nota o accordo selezionati su una tastiera o altro strumento a doppio rigo, sul 
rigo superiore o inferiore; è utile per correggere errori nei punti di divisione basati sul criterio 
“nota per nota” – per cambiare il punto di divisione di un passaggio musicale più lungo vedere il 
plug-in Cambio punto di split. Per usare il plug-in selezionare le nota o accordo che si vuole 
spostare dal suo rigo corrente a quello superiore o inferiore e scegliere Plug-in > Semplifica 
notazione > Sposta su altro rigo.

Plug-in realizzato da Geoff Haynes.

Rimuovi note sovrapposte
Questo plug-in rimuove le note sovrapposte in un rigo ed è destinato a ripulire la musica inserita in 
Flexi-time (specialmente da una chitarra MIDI) o importando un file MIDI. Funziona eliminando 
le note che suonano già quando inizia il suono della nota successiva; inoltre verifica e rimuove leg-
ature di valore “sospese” (quelle che non si legano alla nota successiva).

Per usare il plug-in selezionare il rigo (o righi) al quale applicarlo (o non selezionare niente per 
applicarlo all’intera partitura) e scegliere Plug-in > Semplifica notazione > Rimuovi note 
sovrapposte. Un messaggio avvisa di salvare la partitura; cliccando OK il plug-in processa il pas-
saggio selezionato o l’intera partitura e al termine del processo indica le note sovrapposte rimosse.

Plug-in realizzato da Bob Zawalich. 
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Rimuovi pause
Rimuove le pause dal passaggio musicale selezionato; se si ottengono troppe pause dopo un inseri-
mento in Flexi-time o importando un file MIDI, questo plug-in “ripulisce” la musica.

Per esempio, il plug-in riscriverà la musica seguente:

così:

Per usare il plug-in selezionare il passaggio dal quale rimuovere le pause e scegliere Plug-in >
Semplifica notazione > Rimuovi pause. Si apre una finestra di dialogo che ricorda le limitazioni 
del plug-in; cliccando OK si crea una nuova partitura contenente la musica ripulita che poi si può 
ricopiare nell’originale.

Le limitazioni del plug-in sono:

* I tuplet sono omessi, ma il resto delle misure in cui appaiono è copiato correttamente.
* Gli abbellimenti non sono copiati
* I tratti d’unione personalizzati appaiono con i gruppi dei tratti d’unione di default.
* I gambi capovolti dall’utente non sono copiati.
* Teste nota speciali, segni d’articolazione e stanghette speciali non sono copiati.
* Può darsi che le misure irregolari (come quelle d’attacco) non si copino correttamente.

Plug-in perfezionato da Geoff Haynes

Rimuovi note all’unisono
Rimuove le note all’unisono, cioè due teste nota della stessa altezza, sullo stesso gambo (o della 
stessa altezza in voci diverse) che talvolta appaiono dopo aver importato una file MIDI o usato la 
funzione Arrange per realizzare riduzioni di musica esistente.

Per usare il plug-in selezionare Plug-in > Semplifica notazione > Rimuovi note all’unisono. Se 
non c’è una selezione Sibelius chiede se l’operazione deve essere eseguita sull’intera partitura; altri-
menti, è applicata solo al passaggio selezionato; si apre una finestra di dialogo con alcune opzioni:

* Scegliere se rimuovere gli unisoni Solo all’interno di ogni voce (non sono toccate due note 
della stessa altezza alla stessa posizione ritmica ma in voci separate) o All’interno e tra tutte le 
voci (se due note della stessa altezza in voci separate sono alla stessa posizione ritmica, una di 
esse sarà rimossa).

* Scegliere se creare o meno un file di testo che elenca tutte le modifiche eseguite dal plug-in, in 
modo da poterle verificare in seguito (si può anche chiedere al plug-in di creare un file delle 
modifiche che eseguirebbe senza cambiare veramente la partitura). Nel file si può decidere se 
usare nomi nota Americani o Inglesi.

Cliccare OK: il plug-in processa la partitura.

Plug-in realizzato da Bob Zawalich.
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Riscrivi esecuzione
Riscrive la notazione generata da un’esecuzione in Flexi-time o importata da un file MIDI renden-
dola più leggibile; questo plug-in esegue indirettamente la stessa funzione dei plug-in Rimuovi 
note sovrapposte e Rimuovi pause, quindi non sarà necessario avviare quei plug-in oltre a 
questo. Il plug-in è molto più utile con un paio di righi per tastiera, ma si può anche usarlo per 
qualche altro strumento se si desidera e può risolvere i seguenti problemi:

* Note scritte sul rigo sbagliato che quindi hanno troppe linee aggiuntive.
* Voci d’accordo insuonabili perché lo stretch della mano è eccessivo.
* Voci inconsistenti causate dall’opzione Usa voci multiple per l’inserimento Flexi-time.
* Note brevi scritte come accordi perché l’opzione Durata minima di Flexi-time è stata impostata 

a un valore troppo elevato.
* Le note sono scritte con valori più brevi di quelli ideali perché suonate troppo in staccato.

Il plug-in cerca di generare una notazione ritmicamente e visivamente più semplice dell’originale, 
scrivendo comunque ogni nota dell’esecuzione originale; per farlo riorganizza le voci e ri-quan-
tizza la musica riducendo le note ad una singola voce su ogni rigo; le voci più importanti sono sug-
gerite aggiungendo le note ove serve, senza usare legature di valore per indicarne la durata. 
La musica è ri-quantizzata con la stessa unità di valore Durata minima usata per l’inserimento 
originale Flexi-time o via import MIDI, ma questa unità è ridotta automaticamente ove necessario 
(per esempio, dove sono stati suonati sedicesimi ma l’unità Durata minima era in ottavi, oppure 
dove è stato suonato un accordo esteso, un’abbellimento o altro ornamento).

Per usare il plug-in selezionare un passaggio nel rigo (o righi) da riscrivere e scegliere Plug-in >
Semplifica notazione > Riscrivi esecuzione. Appare una finestra di dialogo che consente di sos-
tituire l’unità di quantizzazione scelta dal plug-in e specificare se sostituire o meno il passaggio 
selezionato (Overwrite selected passage). Se questa opzione è attiva la musica selezionata è sos-
tituita; se disattivata, Sibelius aggiunge un nuovo strumento e inserisce la musica riscritta su quel 
rigo (utile per confrontare il passaggio orginale con quello riscritto).

Plug-in realizzato da Geoff Haynes.

TESTO

Aggiunge parentesi quadre al font Reprise Script
In alcune partiture scritte a mano, i testi sono segnati in parentesi, per indicare se sono applicati 
sopra o sotto il rigo, così:

Il font Reprise Script di Sibelius ha caratteri speciali che generano questi tipi di parentesi e il 
metodo più semplice per ottenerle è selezionare passaggio contenente il testo al quale aggiungere 
le parentesi e scegliere Plug-in > Testo > Aggiunge parentesi quadre al font Reprise Script. Si 
apre una finestra di dialogo che permette di scegliere se aggiungere o togliere le parentesi: fare una 

 
{W`i`t`h` `A` `L`i`v`e`l`y` `S`w`i`n`g`}

                   
[O_p_e_n_ _F_o_r_ _S_o_l_o_s_]
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scelta e cliccare OK. Il plug-in determina se il testo è sopra o sotto il rigo e crea automaticamente il 
giusto tipo di parentesi.

Se in seguito si cambia il font del testo che ha le parentesi, si vedrà che queste ultime non appaiono 
più corrette: avviare di nuovo il plug-in e selezionare Rimuovi parentesi per correggere l’aspetto 
della partitura.

Plug-in realizzato da Dave Foster.

Aggiungi diteggiature fiati
Inserisce l’opportuna diteggiatura per una serie di ottoni (comprese le trombe in SIb, DO, RE e 
MIb), ottoni che usano le diteggiature in FA e SIb e gli euphonium a 3 e 4 valvole.

Per usare il plug-in selezionare il passaggio al quale aggiungere la diteggiatura (es. triplo-clic del 
mouse sul rigo dell’ottone in questione) e selezionare Plug-in > Testo > Aggiungi diteggiature 
fiati. Scegliere lo strumento dalla finestra di dialogo e cliccare OK per aggiungere la diteggiatura 
alla partitura nello stile di testo Fingering; se esso tocca note o altri segni usare il plug-in Riposiz-
iona Testo per regolarlo (vedere in seguito).

Aggiungi nomi delle note
Scrive LA, DO#, ecc. sopra ogni nota nella partitura.

Per avviare il plug-in selezionare un passaggio (o assicurarsi che non ci sia niente selezionato se si 
desidera aggiungere i nomi nota a tutti i righi da inizio a fine partitura) e scegliere Plug-in >
Testo > Aggiungi nomi delle note. Appare una finestra di dialogo che consente di specificare se i 
nomi nota saranno in maiuscolo o minuscolo, lo stile di testo usato, se usare l’altezza suonata o 
scritta (per gli strumenti trasportati), se includere il numero d’ottava oltre il nome della nota e se i 
nomi nota devono essere aggiunti al passaggio selezionato o all’intera partitura; si può anche 
decidere la lingua con la quale sono scritti i nomi nota.

Se il testo inserito tocca le note o altri segni selezionare un oggetto di testo e scegliere Modifica >
Seleziona > Seleziona altro (Ctrl+Maius+A o xXA), quindi spostare l’intera fila con i tasti 3/2.

Aggiungi legature alle parole
In genere, le parole cantate sopra più di una nota sono legate, così per il cantante è più facile vedere 
quando la parola cambia; questo plug-in aggiunge legature ai righi con le parole seguendo questa 
convenzione.

Per usare il plug-in selezionare il passaggio al quale applicarlo (esso esamina solamente i righi con 
le parole, quindi per usarlo sull’intera partitura non bisogna selezionare niente) poi scegliere Plug-
in > Testo > Aggiungi legature alle parole. Si apre una finestra di dialogo che permette di sceg-
liere se inserire legature normali, punteggiate o tratteggiate; inoltre, il plug-in evidenzia le legature 
esistenti se si trovano alla posizione sbagliata o i melismi di parole sospetti (es. senza trattini o 
linee di parola); cliccando OK le legature sono aggiunte alla partitura.

Plug-in realizzato da Michael Kilpatrick. 

Aggiungi diteggiatura per gli archi
Questo plug-in aggiunge la diteggiatura alla musica per violino, viola, cello e contrabbasso.
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Per usarlo selezionare il passaggio al quale aggiungere la diteggiatura (in genere con un triplo-clic 
del mouse sul rigo dello strumento in questione) e scegliere Plug-in > Testo > Aggiungi diteggia-
tura per gli archi. Scegliere lo strumento desiderato dalla finestra di dialogo; è possibile anche 
scegliere la posizione(i) di diteggiatura da usare; quella di default 1 and 3 aggiunge le diteggiature 
per la prima posizione poi torna indietro e cerca di riempire i vuoti con le diteggiature dalla terza 
posizione. Cliccare OK per inserire la diteggiatura nella partitura con lo stile di testo Fingering; se 
il testo tocca note o altri segni usare il plug-in Riposiziona Testo per regolarlo (vedere in seguito).

Aggiungi Tonica Sol-Fa
Aggiunge una notazione di solfeggio a un passaggio selezionato o all’intera partitura. Il solfeggio è 
sia una forma di notazione musicale usata nella musica vocale che un metodo d’insegnamento per 
il cantato a vista.

Inventato da John Curwen in Inghilterra nel 1840 e modificato da Kodály nel ventesimo secolo, il 
solfeggio si basa sul sistema do. Le note della scala maggiore sono cantate (in ordine ascendente) 
do, re, mi, fa, sol, la, si, ove do è la tonica e le altre note fanno riferimento alla tonica del momento 
(che può cambiare in seguito a una modulazione). Le tonalità minori sono trattate come modi 
delle rispettive relative maggiori (la scala minore naturale è solfeggiata la, si, do, re, ecc.). Nella 
notazione le note sono abbreviate con le lettere d, r, m, f, s, l, t. Diesis e bemolle sono indicati dal 
cambio di vocale, i diesis in “e”, i bemolle “a” (es. do diesis diventa “de”; mi bemolle diventa “ma”). 
I due punti (:) separano un movimento da quello successivo, singoli punti (.) sono usati quando un 
movimento è diviso a metà e le virgole dividono i mezzi movimenti in movimenti da un quarto. Le 
linee orizzontali indicano che le note devono essere tenute sul bordo del movimento (o sotto-mov-
imento); gli spazi vuoti indicano le pause.

L’esempio seguente (tratto dal bel libro The Standard Course of Lessons on the Tonic Sol-fa Method 
of Teaching to Sing di John Curwen) mostra come appare la notazione nella pratica comune:

Per usare questo plug-in selezionare un passaggio e scegliere Plug-in > Testo > Aggiungi Tonica 
Sol-Fa. Appare una finestra di dialogo nella quale specificare la tonalità del passaggio selezionato. 
È possibile anche specificare quale voce solfeggiare e varie opzioni sull’aspetto del solfeggio nella 
notazione. Una volta definite le opzioni cliccare OK: il solfeggio è aggiunto alla partitura.

Il plug-in non legge automaticamente i cambi di tonalità nella partitura, quindi bisogna applicarlo 
alle varie sezioni della partitura in tonalità diverse. Inoltre, di default, la notazione di solfeggio è 
inserita con lo stile di testo Linea Versi 1, quindi si devono inserire le parole vere e proprie usando 
lo stile di testo Linea Versi 2 o manualmente spostando le parole esistenti prima di avviare il plug-
in (per evitare che la notazione del solfeggio appaia sopra le parole).

Questo plug-in ha le seguenti limitazioni:

* La spaziatura delle stanghette può essere scorretta (si può correggere a mano in seguito).
* Le misure d’attacco (anacrusis) potrebbero non essere scritte correttamente.
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* Il plug-in usa una notazione di “nota ponte” non-standard per la modulazione; di solito si usano 
caratteri subscript e superscript, ma non potendoli creare il plug-in scrive [vecchia nota] nuova 
nota.

* Il plug-in usa anche segni tuplet non-standard (> al posto di una virgola invertita).
* Alcuni segni ritmici possono essere troppo vicini (anche questo si corregge a mano in seguito).

Aggiungi numeri verso
Aggiunge numeri strofa all’inizio delle strofe di parole, allineandoli in una colonna e usando l’ade-
guato stile di testo Linea Versi n.

Per usare il plug-in selezionare la misura contenente l’inizio delle strofe di parole e scegliere Plug-
in > Testo > Aggiungi numeri verso; non ci sono opzioni (il plug-in procede inserendo i numeri 
automaticamente).

Se in seguito si desidera selezionare la strofa di parole (compreso il numero strofa) selezionare il 
numero strofa e scegliere Modifica > Seleziona > Seleziona altro (Ctrl+Maius+A o xXA). Clic-
cando invece su una sillaba il numero strofa non sarà selezionato. Analogamente, il comando 
Modifica > Filtro > Parole non seleziona i numeri strofa.

Plug-in realizzato da Peter Hayter. 

Allinea parole
Regola la spaziatura verticale di più strofe di parole in modo che:

* Le parole della prima strofa siano allineate in verticale con la sillaba più in basso in quella strofa; 
* Le parole dell’ultima strofa siano allineate in verticale con la sillaba più in alto in quella strofa; e
* Ci sia lo stesso spazio tra ogni strofa di parole.

Questo plug-in è utile quando le parole sono state spostate in alto o in basso per evitare collisioni 
con le note; se è stato fatto male (o in seguito è stato riformattato il sistema) ci possono essere 
parole male allineate o strofe non spaziate in modo uniforme.

Per usare il plug-in selezionare la misura contenente l’inizio delle parole e scegliere Plug-in >
Testo > Allinea parole; non ci sono opzioni (il plug-in procede allineando automaticamente le 
parole).

Se c’è solo una strofa le parole sono allineate in una fila e collocate alla giusta posizione rispetto alla 
sillaba più bassa e alta presente nel passaggio selezionato. In generale, questo plug-in si applica ad 
una partitura secondo un criterio sistema-per-sistema, poiché di solito le parole sono collocate in 
modo indipendente su sistemi diversi.

Plug-in realizzato da Peter Hayter. 

Cambia dinamiche
Regola di uno step in più o in meno tutte le dinamiche in una selezione o nell’intera partitura – es. 
tutti i segni mp diventano p o tutti quelli mf diventano f – oppure si può definire una mappatura 
personalizzata di dinamiche esistenti a nuove dinamiche.

Per usare il plug-in selezionare il passaggio da processare (o non eseguire alcuna selezione per pro-
cessare l’intera partitura) e scegliere Plug-in > Testo > Cambia dinamiche. Appare una finestra di 
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dialogo nella quale scegliere il font di testo musicale per i segni dinamici (in genere Opus Text o 
Helsinki Text per partiture “incise” e Inkpen2 Text o Reprise Text per partiture “manoscritte”), se 
le dinamiche devono diventare uno step più forte, uno step più debole o se si utilizza una map-
patura personalizzata; cliccando OK, se si è scelto di configurare una mappatura personalizzata, 
bisogna poi specificare le nuove dinamiche alle quali mappare quelle esistenti.

Per ulteriori informazioni consultare la finestra Help del plug-in.

Plug-in realizzato da Michael Kilpatrick.

Salva parole
Esporta le parole dalla partitura in un normale file di testo; per usare il plug-in selezionare Plug-
in > Testo > Salva parole. Si apre una finestra di dialogo che consente di decidere se il plug-in deve 
usare l’opzione Linee separate (cioè aggiungere dei break di linea dopo la punteggiatura che è 
seguita da una lettera maiuscola o un numero) e se deve salvare il testo in formato Unicode (Salva 
come Unicode), da attivare se si usano parole che non utilizzano l’alfabeto Romano (come il 
Giapponese). Cliccando OK il file di testo si crea nella stessa cartella file di Sibelius.

Per copiare le parole da un passaggio o rigo particolare, selezionarlo prima di avviare il plug-in 
(altrimenti il plug-in salva le parole solo dal rigo più in alto nella partitura che contiene parole).

L’uso sistematico degli stili di testo nella partitura porta ai risultati migliori con questo plug-in, 
poiché esso consente di separare strofe diverse. Usare Lyrics line 1 per le parole della strofa 1, Lyr-
ics line 2 per quelle della strofa 2, ecc.; usare Lyrics (chorus) per i ritornelli; usare lo stile di testo 
Block lyrics per blocchi di parole alla fine della partitura, ecc..

Se la partitura presenta ripetizioni, misure di 1° e 2° finale, ecc., probabilmente il file di testo cre-
ato dovrà essere modificato. Il plug-in, inoltre, non è adatto a partiture contenenti più brani: a 
turno per ogni brano selezionare quindi solo quel brano come passaggio e avviare il plug-in.

Avviando il plug-in più di una volta sulla stessa partitura (es. per esportare le parole da righi o 
brani diversi), assicurarsi di rinominare il file di testo salvato, altrimenti esso sostituirà un qual-
siasi file creato durante l’uso precedente del plug-in.

Plug-in realizzato da Lydia Machell.

Trova e sostituisci testo
Cerca un testo specifico nella partitura e lo sostituisce con un altro. Per usare il plug-in selezionare 
Plug-in > Testo > Trova e sostituisci testo. Appare una finestra di dialogo: inserire il testo da tro-
vare e il testo da sostituire; specificare se il plug-in deve trovare il testo corrispondente solo come 
singolo oggetto di testo, trovare una parola intera all’interno di un oggetto di testo o una parte di 
parola qualsiasi in un oggetto di testo; cliccare OK; il plug-in trova e sostituisce il testo specificato 
da inizio a fine partitura.

Plug-in realizzato da Stefan Behrisch (www.werklabor.de). 

Numera battute
Aggiunge i numeri sopra le misure; è utile per numerare misure ripetute o misure di pausa. 
Per usare il plug-in selezionare il passaggio da numerare e scegliere Plug-in > Testo > Numera 
battute. Si apre una finestra di dialogo nella impostare varie opzioni auto-esplicative (stile di testo 
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da usare per i numeri, quanto spesso devono apparire, se la numerazione deve ricominciare in cor-
rispondenza di stanghette o segni di prova speciali, e così via).

Cliccando OK il plug-in numera tutte le misure nella selezione in base alle opzioni definite nella 
finestra di dialogo; i numeri sono centrati all’incirca su ogni misura, ma poiché (come tutti i testi) 
sono attaccati a posizioni ritmiche, può darsi che si debba regolarne la posizione (specialmente se 
si riformatta la musica).

Plug-in realizzato da Stefan Behrisch (www.werklabor.de). 

Numera battiti
Questo plug-in numera i movimenti in una misura di un passaggio selezionato; per esempio:

Per usare il plug-in selezionare il passaggio desiderato e scegliere Plug-in > Testo > Numera bat-
titi. La durata del movimento è ricavata dal tempo in chiave (es. il 6/8 ha movimenti di note da 1/4 
puntate). Il testo è aggiunto in stile Technique; se tocca le note o altri segni selezionare un oggetto 
di testo e scegliere Modifica > Seleziona > Seleziona altro (Ctrl+Maius+A o xXA), quindi 
spostare l’intera fila premendo i tasti 3/2.

Riposiziona testo
È un plug-in per scopi generici; regola la posizione dei testi di rigo (per evitare, ad esempio, che i 
segni dinamici tocchino le note sopra o sotto il rigo), oppure colloca con precisione il testo per la 
diteggiatura della tastiera. Per usare questo plug-in:

* Per riposizionare un singolo oggetto di testo (es. un segno dinamico) selezionarlo e scegliere 
Plug-in > Testo > Riposiziona testo. Il plug-in regola automaticamente la posizione dell’oggetto 
di testo selezionato spostandolo sopra o sotto la nota.

* Per riposizionare molti testi assicurarsi che non ci sia selezionato niente (per processare l’intera 
partitura) o filtrare il testo specifico da riposizionare (b Filtri e Trova), oppure selezionare un 
passaggio; scegliere poi Plug-in > Testo > Riposiziona testo.

Se si decide di riposizionare molti testi appare una finestra di dialogo che consente di scegliere se 
collocare il testo sempre sopra la nota, sempre sotto, sopra o sotto la nota (utile, ad esempio, per un 
testo Fingering), oppure se si desidera che il testo possa essere spostato solo in orizzontale.

Per processare il testo cliccare OK o Opzioni avanzate per dare al plug-in altre istruzioni: si può 
specificare di riposizionare un singolo stile di testo nel passaggio selezionato e regolare la dimen-
sione e l’offset verticale/orizzontale del testo (che influenza la distanza alla quale il plug-in sposta il 
testo per evitare collisioni con le note).

Il plug-in ha due utili finestre Help da consultare in caso di bisogno.

Plug-in realizzato da Marc Nijdam.

Virgolette intelligenti
Ricolloca virgolette e apostrofi degli oggetti di testo nella partitura corrente o in un set di file in 
una directory specifica, in modo che appaiano in una forma più ordinata. La prima finestra di dia-

reference.book  Page 427  Wednesday, April 16, 2008  4:28 PM



5. Funzioni efficaci

428

logo del plug-in permette di scegliere se l’operazione sarà applicata alla partitura corrente o a un 
set di file; cliccando Next appare la seguente finestra di dialogo:

Qui è possibile definire una serie di opzioni: quale stile di testo sarà “riordinato,” se il plug-in agisce 
solo in modalità di prova lettura - in tal caso sarà generato un registro (log) senza modifiche ese-
guite sulla partitura - impostare le opzioni di registro e scegliere quanti caratteri di virgolette o 
apostrofi trovati nella partitura saranno cambiati; attivando l’opzione Scrivi su file log un log di 
tutte le modifiche eseguite nella partitura sarà salvato in un file denominato Sibelius Quotes 
Log.txt, situato nella cartella Scores.

A differenza di molti programmi, questo plug-in risolve anche casi complessi come la parola ‘Twas 
e segni di virgolette “annidati”.

Plug-in realizzato da Bob Zawalich.

Beaming di parole tradizionale
Unisce in tratti d’unione le note in base alla radice delle parole (cioè i tratti d’unione s’interrom-
pono ad ogni nuova parola o sillaba). Per usare questo plug-in selezionare i righi sui quali deve 
agire (o non selezionare niente per processare l’intera partitura; il plug-in cambia solo note con le 
parole attaccate, quindi i righi non vocali non sono influenzati) e scegliere Plug-in > Testo >
Beaming di parole tradizionale.

Appare una finestra di dialogo nella quale scegliere se processare solo il passaggio selezionato o 
l’intera partitura e se interrompere o meno i tratti d’unione di note senza parole (in tal caso, si può 
evidenziare tali modifiche per verificarle); cliccare OK: il plug-in cambia i tratti d’unione nella par-
titura.

Plug-in realizzato da Michael Kilpatrick.

GRUPPI IRREGOLARI
Tutti i plug-in nel submenu Plug-in > Gruppi irregolari possono agire sulla musica usando un 
numero qualsiasi di voci. Usando i plug-in con una selezione di passaggio, essi influenzano solo le 
note in Voce 1. Per manipolare le note nelle Voci 2, 3 o 4 eseguire invece una selezione multipla 
(selezionando, ad esempio, la prima nota del tuplet in Voce 2 e premendo Ctrl+clic o X-clic 
sull’ultima nota del tuplet prima di avviare il plug-in.
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Plug-in Tuplet realizzati da Hans-Christoph Wirth.

Aggiungi note in gruppi irregolari
Aggiunge note al tuplet corrente lasciandolo alla stessa durata complessiva (aumentandone cioè il 
ratio). Per usare il plug-in selezionare tante note in un tuplet quante quelle da aggiungere (es. per 
trasformare un tuplet da sette note in uno a nove note selezionare due note nel tuplet da sette) e 
scegliere Plug-in > Gruppi irregolari > Aggiungi note in gruppi irregolare.

Cambia rapporto gruppo irregolare
Cambia il ratio del tuplet corrente lasciandolo alla stessa durata complessiva. Si può raddoppiare o 
dimezzare una parte del ratio (es. trasformare un tuplet 3:2 in 3:4, 6:4 o 6:8, e così via). Per usare il 
plug-in eseguire una selezione di passaggio che racchiuda tutte le note del tuplet o selezionare il 
numero del tuplet e scegliere Plug-in > Gruppi irregolari > Cambia rapporto gruppo irregolare. 
Appare una finestra di dialogo; scegliere il ratio desiderato e cliccare OK. La finestra ha anche un 
pulsante Opzioni: cliccandoci sopra si apre la finestra di dialogo Preferenze Gruppo irrego-
lare (vedere in seguito).

Allunga gruppo irregolare
Allunga un tuplet combinandolo con note ad entrambe le sue estremità. Per usare il plug-in selezi-
onare tutte le note del tuplet esistente e le note (prima o dopo il tuplet) da aggiungere ad esso e 
scegliere Plug-in > Gruppi irregolari > Allunga gruppo irregolare. Selezionando tutte le note di 
due o più tuplet adiacenti, esse saranno tutte unite in un singolo tuplet.

Inserisci in gruppo irregolare
Trasforma una selezione di note in un tuplet. Per usare il plug-in selezionare le note da trasformare 
in tuplet e scegliere Plug-in > Gruppi irregolari > Inserisci in gruppo irregolare. Si apre una 
finestra di dialogo che permette di scegliere il ratio del tuplet risultante e se ingrandire il tuplet con 
pause all’estremità destra o sinistra. La finestra ha anche un pulsante Opzioni: cliccandoci sopra 
appare la finestra di dialogo Preferenze Gruppo irregolare (vedere in seguito).

Rimuovi note dal gruppo irregolare
Rimuove le note dal tuplet corrente lasciandolo alla stessa durata complessiva (diminuendone cioè 
il ratio). Per usare il plug-in selezionare tante note nel tuplet quante quelle da rimuovere (es. per 
trasformare una quintina in una terzina selezionare due note nella quintina) e scegliere Plug-in >
Gruppi irregolari > Rimuovi note dal gruppo irregolare.

Accorcia gruppo irregolare
Accorcia un tuplet togliendo note da esso e riscrivendole fuori dalla parentesi del tuplet. Per usare 
il plug-in selezionare in un tuplet esistente tante note quante quelle che devono restare e scegliere 
Plug-in > Gruppi irregolari > Accorcia gruppo irregolare. Le note non selezionate nel tuplet sono 
scritte come note “normali” prima o dopo il tuplet accorciato; selezionando solo una o due note e 
avviando il plug-in è rimosso l’intero tuplet che sarà sostituito da note regolari.

Dividi o unisci gruppi irregolari
Divide un tuplet in due tuplet più brevi o unisce due o più tuplet adiacenti in uno più lungo.
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Per dividere un tuplet selezionare la nota che dovrà diventare la prima nota del secondo tuplet e 
scegliere Plug-in > Gruppi irregolari > Dividi o unisci gruppi irregolari.

Per unire tra loro due tuplet eseguire una selezione di passaggio contenente due o più tuplet adia-
centi e scegliere Plug-in > Gruppi irregolari > Dividi o unisci gruppi irregolari. Quando unisce i 
tuplet, il plug-in non altera la temporizzazione precisa di riproduzione delle note nel nuovo tuplet 
unito, quindi in alcuni casi il tuplet risultante può essere più piacevole a un matematico che a un 
musicista! 
Se il risultato non piace, eseguire un Modifica > Undo, selezionare entrambi i tuplet e provare ad 
applicare il plug-in Plug-in > Gruppi irregolari > Allunga gruppo irregolare (vedere sopra).

Preferenze Gruppo irregolare
Questa finestra specifica le preferenze utilizzate da tutti gli altri 
plug-in del submenu Plug-in > Gruppi irregolari. Per aprirla si 
può anche cliccare sul pulsante Options nelle finestre di dialogo 
visualizzate dai plug-in Inserisci in gruppo irregolare e Cambia 
rapporto gruppo irregolare.

Le opzioni sono abbastanza auto-esplicative. Le prime due influen-
zano i ratio dei tuplet creati dai plug-in, poiché ci sono sempre due 
metodi alternativi per definire il ratio dello stesso tuplet. 
Per esempio, cinque note nel tempo di tre saranno scritte 5:3 o 5:6 impostando Mantieni ratio 
gruppo irregolare nell’intervallo rispettivamente a 1:1 ... 2:1 o 1:2 ... 2:2. Per cambiare il ratio 
di un singolo tuplet usare il plug-in Plug-in > Gruppi irregolari > Cambia rapporto gruppo irre-
golare (vedere sopra).
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5.12 Preferenze

b Inserimento note, Lavorare con i testi, Video, Impostazioni visive, Lavorare con 
le parti, Menu e comandi rapidi, Menu Vista, Menu Finestra, Esportare file grafici.

Le preferenze sono opzioni che influenzano Sibelius nel suo insieme e restano impostate in modo 
permanente fino a quando le si cambia; non sono salvate nelle singole partiture. Si tratta di 
impostazioni visive, comandi rapidi e menu scritte che velocizzano l’inserimento testuale.

Se Sibelius è usato sullo stesso computer in tempi differenti da utenti diversi, Sibelius ricorda auto-
maticamente un set diverso di preferenze per le varie persone se esse si “loggano” al computer 
come utenti separati.

Nella finestra di dialogo File > Preferenze (menu Sibelius in Mac; comando rapido Ctrl+, o X,) ci 
sono le varie preferenze organizzate in 13 pagine.

Visualizza
La pagina Visualizza regola il modo in cui Sibelius rende omogenea la visione degli oggetti nella 
partitura, se e a quale livello le finestre tool (come Mixer, Navigator e Tastierino numerico) sono tras-
parenti e (in Windows) il player video preferito da Sibelius – b Impostazioni visive e Video.

File
La pagina File consente di stabilire come Sibelius apre, salva e stampa i file:

* Avvisa se la configurazione usata nella partitura è diversa dalla configurazione attiva: se 
attivata, un avviso informa se la partitura che si sta aprendo l’ultima volta è stata salvata con una 
configurazione di riproduzione diversa; non attivandola, Sibelius apre semplicemente la partit-
ura senza modificare in alcun modo i suoni.

* Apri a livello di zoom: consente di stabilire se Sibelius apre le partiture allo zoom specificato 
qui o a quello che si stava usando l’ultima volta che la partitura è stata salvata.
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* Apri partiture utilizzando: consente di scegliere se Sibelius aprirà le partiture nelle vedute 
Panorama (b Panorama), normale o l’ultima usata nella partitura (default).

* Stampa data e ora a piè di pagina: specifica i contenuti del piè di pagina opzionale: può conte-
nere una combinazione della data corrente o di quella alla quale è stato salvata l’ultima volta la 
partitura, nome file e nome dell’utente su ogni pagina; è possibile scegliere vari formati dati e ora 
e stabilire se Sibelius deve stampare solo il nome file o anche il percorso completo – b Stampa.

* Abilita salvataggio automatico: controlla la funzione auto-save di Sibelius – b Lavorare 
con i file.

* Per i dettagli sulle opzioni nel gruppo Idee, b Idee.

Font Equivalenti
Per i dettagli sulla pagina Font Equivalenti, b Font equivalenti.

Dispositivi ingresso
Per i dettagli sulla pagina Dispositivi ingresso, b Dispositivi d’ingresso MIDI.

Menu e scorciatoie
Per i dettagli sulla pagina Menu e scorciatoie, b Menu e comandi rapidi.

Mouse
La pagina Mouse stabilisce come si comporta Sibelius inserendo la musica con il mouse:

* Quando viene creato un oggetto: determina se l’oggetto appare vicino alla selezione corrente 
(Appare vicino alla selezione attuale, impostazione raccomandata) e se bisogna cliccare con 
il mouse per posizionarlo (Clicca sul pulsante del mouse per posizionarlo). Questa opzione 
è prevista per gli utenti di Sibelius 1.4 o precedenti ove gli oggetti erano sempre collocati con il 
mouse; tuttavia, questo manuale operativo presume sempre che questa opzione sia impostata al 
default (Appare vicino alla selezione attuale).

* Abilita copia con il mouse: (solo Windows), controlla se cliccare insieme i pulsanti centrale, 
sinistro e destro del mouse o scorrere la rotellina equivale a premere Alt+clic.

reference.book  Page 432  Wednesday, April 16, 2008  4:28 PM



5.12 Preferenze

433

Funzio
ni

* Per trascinare il foglio (invece di creare un riquadro di selezione): in default è Trascina, 
ma se si preferisce è possibile impostarla in Premete Maius e trascinate (o Premete Com-
mand e trascinate in Mac).

* Mostra Note Ombra: determina se le note ombreggiate sono visualizzate durante l’inserimento 
con il mouse – b Inserimento note

* Usa voce 2 quando le ritmiche sono in disaccordo: se attiva, inserendo una nota a metà 
strada tra la durata di una esistente Sibelius crea la nuova nota in Voce 2, non alterando la nota 
esistente; disattivandola, invece, Sibelius accorcia la prima nota.

* Posizioni di Snap: queste opzioni controllano come sono suddivise le misure per l’inserimento 
delle note con il mouse o la tablatura per chitarra:
% Posizioni Ritmiche approssimate a: in default è a note da 1/4; è l’unità di valore alla quale 

sono divise le misure.
% Snap nell'inserimento di intavolature per chitarra: se attiva, premendo 0/1 quando 

s’inserisce la tablatura per chitarra con la tastiera del computer in misure vuote, si avanza 
nella misura dell’unità specificata in Posizioni Ritmiche approssimate a:; se non è attiva 
premendo 0/1 ci si sposta nella misura del valore nota scelto sul tastierino numerico – ved-
ere Inserire una tablatura per chitarra on page 41

* Snap nell'inserimento delle note: se attiva è possibile creare note o pause a tutte le posizioni 
“snap” create dalle unità specificate in Posizioni Ritmiche approssimate a:; se non è attiva, note 
e pause si possono creare solo con il mouse all’inizio di note, pause o misure di pausa esistenti.

Font musicali
Per i dettagli sulla pagina Font musicali, b Font musicali.

Inserimento nota
Per i dettagli sulla pagina Inserimento nota, vedere Opzioni d’inserimento nota on page 13.

Incolla come guida
Per i dettagli sulla pagina Incolla come guida, vedere Preferenze del comando Incolla 
come guida on page 56.

Posizione partitura
La pagina Posizione partitura definisce come e quando Sibelius riposiziona la partitura:
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* Sibelius segue la partitura durante la riproduzione con una line verde che indica la posizione 
corrente. Se si preferisce che Sibelius non lo faccia (es. per consumare meno risorse di processo 
quando si usa Kontakt Player) disattivare l’opzione Segui linea di riproduzione.

* Nascondi finestre strumenti non necessarie: attiva di default; se attiva, in riproduzione sono 
nascoste tutte le finestre tranne quelle Playback, Video, Kontakt e Navigator.

* Usa zoom diverso:consente d’impostare uno zoom specifico per la riproduzione, indipendente 
da quello usato per l’editing. Impostare lo zoom desiderato direttamente nell’elenco in questa 
finestra di dialogo; altrimenti, cambiando lo zoom durante la riproduzione con questa opzione 
attiva, lo zoom al quale si arriva sarà ricordato da Sibelius alla riproduzione successiva.

* Sposta primi n battiti: permette di scegliere con quanto anticipo Sibelius riposiziona la partit-
ura quando il passaggio musicale successivo in riproduzione sta per uscire dalla visuale; è utile 
se si sta usando Sibelius per l’accompagnamento o per quando bisogna seguire da vicino una 
partitura nel corso della riproduzione, poiché si vede sempre un passaggio musicale prima che 
Sibelius lo riproduca.

* Segui selezione: se attiva, Sibelius garantisce che la selezione corrente sia sempre in vista. 
Se attiva, inoltre, è possibile attivare o disattivare le funzioni successive:
% Durante inserimento delle note, segui cursore: attivandola il cursore sarà sempre visibile 

prima che sia inserita una nota.
% Centra selezione: forza la selezione corrente ad essere sempre al centro dello schermo. 

Alcune persone preferiscono lavorare con questa opzione attiva, poiché offre la possibilità di 
concentrare il lavoro su un punto invece che da sinistra a destra. Questa opzione è particolar-
mente consigliata per utenti dalla vista debole.

% Consenti finestre strumenti: garantisce che Sibelius non tenta di posizionare la selezione 
corrente al di sotto di una delle finestre tool.

% Visualizza intera larghezza accollatura: garantisce che, ove possibile durante l’inserimento 
nota, Sibelius posiziona la veduta corrente in modo che si veda l’intera larghezza del sistema 
sul quale si sta lavorando; se il sistema è più largo dello schermo, Sibelius mantiene la posiz-
ione orizzontale della partitura.

% Visualizza intera altezza accollatura: garantisce che, ove possibile durante l’inserimento 
nota, Sibelius posiziona la veduta corrente in modo che si veda l’intera altezza del sistema sul 
quale si sta lavorando.

* Se si preferisce che Sibelius non riposizioni mai automaticamente la partitura disattivare l’opzi-
one Segui selezione; è possibile assegnare un comando rapido a questa opzione – b Menu e 
comandi rapidi.)

Textures
Per i dettagli sulla pagina Textures, b Impostazioni visive.

Menu contestuali
Per i dettagli sulla pagina Menu contestuali, vedere Creare e modificare i menu scritte in 
b Lavorare con i testi.
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Altro
La pagina Altro permette di modificare varie altre opzioni:

* Righelli: determina le unità di misurazione usate dai righelli sullo schermo – b Menu Vista

* Undo: permette di stabilire quante modifiche alla partitura Sibelius ricorderà– b Undo e 
Redo.

* Le opzioni in Quando Sibelius si avvia contollano se all’avvio Sibelius riproduce un breve 
brano musicale, se deve apparire automaticamente la finestra File > Avvio rapido, e se Sibelius 
verificherà gli aggiornamenti ogni 90 giorni – b Help nella Guida.

* Visualizza parti in nuove finestre: consente di scegliere se Sibelius apre le parti nella stessa 
finestra, oppure se crea una nuova finestra per ogni parte – b Lavorare con le parti

* Mostra tutti i messaggi: resetta tutti i messaggi d’avviso soppressi – vedere Messaggi di 
notifica.

* Incolla parti grafiche in altri programmi: permette di scegliere se Sibelius esporterà le 
grafiche nel clipboard in un solo colore (Monochrome) e offre un controllo sulla risoluzione 
dell’immagine che si può cambiare con l’opzione Dots per inch – b Esportare file grafici.

* Le opzioni nel gruppo Incolla versi dalla cartella Appunti determinano se Sibelius deve 
dividere automaticamente le parole in sillabe quando le si incolla nella partitura – b Parole.

Messaggi di notifica
Durante l’uso di Sibelius appare una serie di utili messaggi; se danno fastidio, possono essere sop-
pressi attivando Non visualizzare più questo immagine nel rispettivo box di messaggio.

Se improvvisamente si dimentica come funziona Sibelius e servono nuovamente tutti questi mes-
saggi cliccare Mostra tutti i messaggi: tutti i messaggi soppressi riappaiono in futuro.
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Per i dettagli sulle dimensioni standard del foglio e i onsigli su quale pagina e dimensioni del rigo 
usare per particolari tipi di musica, b Impostazioni documento.

Per produrre grandi quantità di partiture stampate ad alta qualità, b Pubblicazione.

Impostare la dimensione del foglio
Prima di stampare da Sibelius verificare che il driver della stampate sia impostato per usare la 
dimensione corretta del foglio. Su Mac, ogni programma del computer mantiene la propria dimen-
sione di default del foglio, quindi basta assicurarsi che nella finestra di dialogo File > Imposta pag-
ina sia impostata la dimensione corretta. In Windows, la dimensione del foglio si cambia nella 
finestra di dialogo File > Stampa di Sibelius, ma ciò influenza solo i documenti stampati da Sibel-
ius e solo fino a quando si esce dal programma. All’avvio successivo di Sibelius, la dimensione 
foglio si resetta di nuovo al default del driver stampante; assicurarsi quindi che le impostazioni di 
default della stampante siano corrette. Per farlo:

* In Windows XP: 
% Selezionare Start > Stampanti e Fax

% Selezionare la stampante di default e scegliere File > Preferenze di stampa.

% Nella finestra di dialogo del driver stampante cliccare sulla pagina Layout, quindi cliccare 
Avanzato (nell’angolo in basso a destra della finestra).

% Scegliere la dimensione di default corretta del foglio e cliccare due volte OK per confermare le 
modifiche.

* In Windows Vista:
% Selezionare Start > Pannello di Controllo e cliccare Stampanti.

% Clic-destro sull’icona stampante e scegliere Seleziona preferenze di stampa.

% Nella finestra di dialogo del driver stampante cliccare sulla pagina Layout, quindi cliccare 
Advanced (nell’angolo in basso a destra della finestra).

% Scegliere la dimensione di default corretta del foglio e cliccare due volte OK per confermare le 
modifiche.

Stampa
Selezionare File > Stampa (comando rapido Ctrl+P o XP). Appare una finestra di dialogo Print 
standard con alcune opzioni extra.

* In Windows, se c’è più di una stampante collegata al computer, si può scegliere quale usare 
dall’elenco a tendina in cima alla finestra; è possibile anche cambiare opzioni specifiche del 
driver cliccando Proprietà.

* Su Mac, scegliere la pagina di opzioni Sibelius per avere una finestra contenente le opzioni per 
libretti, etc.. Nella pagina Copie & Pagine si può anche decidere quali pagine stampare.

Impostare a piacere le opzioni di stampa e cliccare OK (Windows) o Stampa (Mac) per iniziarla.

Consiglio: in Windows è possibile stampare i file di Sibelius senza avviare il programma: clic-destro 
sull’icona del file e selezionare Stampa dal menu che appare.
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Le opzioni nella finestra di dialogo File > Stampa sono descritte in seguito. Tranne ove diversa-
mente indicato, le opzioni sono nella finestra di dialogo principale File > Stampa (in Windows) o 
nella pagina Sibelius della finestra di dialogo File > Stampa (su Mac):

Intervallo di stampa
Per non stampare l’intera partitura digitare un elenco di pagine da stampare (es. 1, 3, 8) e/o un 
intervallo di pagine (es. 5-9) che può essere al contrario per stampare all’indietro (es. 9-5).

I numeri pagina che si specificano qui non sono necessariamente quelli visualizzati nella partitura 
se la partitura usa cambi di numero pagina; si riferiscono piuttosto alle pagine fisiche nella partit-
ura: per stampare la seconda, terza e quarta pagina della partitura (anche se numerate ii, iii e iv) 
digitare 2-4 nel campo Pagine. b Numeri pagina.

Copie e Fasciola (Collate)
Di default, è stampata una copia, ma si può impostare una qualsiasi altra quantità nel box Copie
(pagina Copie & Pagine in Mac). Più copie sono eseguite a turno per ogni pagina, quindi sceg-
liendo due copie le pagine usciranno nell’ordine 1, 1, 2, 2, 3, 3, ecc..

Attivando l’opzione Fascicola ogni copia della partitura è opportunamente distribuita, quindi le 
pagine usciranno già nell’ordine 1, 2, 3, 4... 1, 2, 3, 4.... Si evita così di doverle ordinare manual-
mente; la stampa potrebbe durare più a lungo sulle stampanti laser.

Bordo
Stampa un sottile bordo attorno alla pagina; stampando su un foglio fuori dimensione, si facilita 
visione e taglio della pagina (senza usare i segni di taglio). È molto utile anche per la prova lettura 
delle partiture scalate (ad esempio) a 65% con le opzioni Border e Spreads attive (vedere sotto).

Segni di ritaglio
Sono piccole croci usate nell’editoria professionale per segnare gli angoli della pagina. I segni di 
taglio sono necessari perché i libri sono stampati su carta sovradimensionata che poi è tagliata alla 
dimensione richiesta.

Ha senso usare i segni di taglio se si stampa su carta più grande delle pagine della partitura.

Visualizza opzioni menu
Queste opzioni di stampa (come le evidenziature, gli oggetti nascosti e i colori nota) si attivano nel 
menu Vista – per maggiori dettagli b Menu Vista.

Stampa a colori
Se attiva, Sibelius stampa a colori qualsiasi oggetto colorato nella partitura (o in grigio se la stam-
pante è in bianco e nero); sono stampati anche i colori delle grafiche. Se non è attiva, gli oggetti col-
orati sono stampati in nero.

Data e ora a piè di pagina
Se attiva, Sibelius stampa piè di pagina con data e ora su ogni pagina della partitura; ciò è utile per 
rintracciare versioni diverse di una partitura. Per i dettagli su configurazione e personalizzazione 
di questo piè di pagina, b Preferenze.
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Adatta al foglio
Scala la partitura a una dimensione inferiore (se necessario) per far stare la musica nei margini di 
stampa del foglio ed evitare che i bordi della musica siano tagliati. È particolarmente utile per 
stampare partiture in dimensione Lettera su foglio A4 (e viceversa) e per ridurre le partiture Tab-
loid/A3 su foglio Lettera/A4. L’opzione Adatta al foglio, tuttavia, non espande la musica in modo 
che riempia il foglio se quest’ultimo è più grande della dimensione pagina.

Attenzione! Le dimensioni dei fogli USA (es. Lettera e Tabloid) non hanno esattamente la stessa 
forma degli altri, quindi i margini pagina potrebbero risultare diversi da quelli previsti. 
Con le dimensioni Europee dei fogli non ci sono questi problemi.

Questa opzione regola automaticamente il parametro Scala (vedere sotto); se è attiva l’opzione 
Adatta al foglio, quindi, non è possibile modificare manualmente il parametro Scala.

Scala
Normalmente la musica è stampata al 100%, ma volendo si può impostare un’altra scala. 
Per ridurre la musica in modo che stia su un foglio più piccolo attivare l’opzione Adatta al foglio
invece di cercare la scalatura ideale.

Sostituisci - opzioni
Queste opzioni risolvono vari problemi di stampa e/o ne possono migliorare velocità o qualità. 
Provare le varie combinazioni per vedere se si ottiene qualche miglioramento.

Le opzioni sono:

* Linee: alcuni driver di stampa non stampano le linee del rigo in modo uniforme (o non le stam-
pano completamente); altri driver scrivono le linee come stanghette e gambi dalle estremità 
arrotondate invece che piatte. Stampando molte pagine alla volta alcune stampanti PostScript 
possono generare errori del tipo “memoria insufficiente”. Attivando questa opzione si potrebbe 
risolvere questo problema e aumentare la velocità di stampa, ma le linee del rigo potrebbero 
essere stampate a spessori leggermente diversi.

* Parentesi quadre: alcuni driver stampano le parentesi nel posto sbagliato o usando il simbolo 
errato. 
Attivare questa opzione se ci sono questi problemi.

* Arpeggi, gliss., ecc.: alcuni driver di stampa per Windows hanno un bug che stampa i testi 
angolati e le linee a serpentina di glissando e arpeggi all’angolatura sbagliata o nella posizione 
errata; se ciò avviene attivare questa opzione.

* Simboli (solo Windows): questa opzione influenza il modo in cui i simboli font – usati per note, 
tempi in chiave, chiavi e altri simboli nella partitura – sono interpretati dalla stampante. 
I simboli font sono Opus, Reprise, Inkpen2, Opus Percussion, Opus Special, ecc., oltre a Symbol, 
Wingdings e altri font. Se questa opzione non è impostata correttamente per la stampante, i font 
dei simboli potrebbero non essere visualizzati o stampati; le quattro possibilità sono:
% Automatico: Sibelius rileva se i simboli font sono in formato TrueType o PostScript (Type 1) 

e li interpreta opportunamente; è l’impostazione raccomandata in Windows.
% PostScript: Sibelius presume che tutti i simboli font siano in formato PostScript (Type 1).
% TrueType: Sibelius presume che tutti i simboli font siano in formato TrueType.
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Stampa su due facciate
Per la stampa della musica su due facciate:

* In Formato, selezionare Normale e Dispari e stampare la partitura; sono stampate solo le 
pagine dispari (cioè quelle destre).

* Inserire i fogli nella stampante, possibilmente rivolti in alto (dipende da come la stampante li 
legge). Se la prima pagina della partitura ha il numero pari – cioè è una pagina sinistra – bisogna 
inserire un foglio extra bianco all’inizio, poiché sulla prima pagina frontale non deve esserci 
stampato niente.

* A questo punto selezionare Pari. Stampare di nuovo la partitura, per stampare le pagine con i 
numeri pari (sinistre) sul retro di quelle con i numeri dispari.

Se le pagine escono dalla stampante rivolte in basso invertire l’ordine dei fogli prima di stampare la 
seconda facciata, oppure stampare la seconda facciata con l’ordine inverso (inserendo un intervallo 
di stampa come 8–1); si deve provare, perché ciò varia da una stampante all’altra.

Le stampanti laser tendono a spiegazzare un pò la carta mentre stampano. Il foglio quindi può 
essere preso male dalla stampante quando lo si inserisce per stampare l’altra facciata. Questo prob-
lema si riduce lasciando ferma la carta per circa un’ora dopo aver stampato la prima facciata, 
oppure inserendo manualmente i fogli uno alla volta per la stampa della seconda facciata (piut-
tosto noioso!). Alcuni problemi d’alimentazione carta possono anche essere causati da residui 
statici dovuti alla carica della corona (nella maggior parte delle stampanti laser), che si possono 
alleviare “sfogliando” la carta prima di re-inserirla nella stampante.

Poster - Spreads
Stampa due pagine consecutive una accanto all’altra su ogni foglio con le 
pagine dispari sempre stampate sul lato destro; è un formato adatto alle 
dimostrazioni.

Con l’opzione Poster selezionata:

* Assicurarsi che il foglio sia grande almeno due volte le pagine in Sibel-
ius (es. Tabloid/A3 per le pagine Lettera/A4); oppure:

* Usare la stessa dimensione pagina della carta ma ridurre oppor-
tunamente il valore Scala (es. stampare pagine Lettera/A4 al 68% su 
carta Lettera/A4).

Stampare poi come al solito usando le altre opzioni (es. Border).

2-Up
Simile a Poster, tranne per la prima pagina specificata che è sempre stamapata a sinistra.

Libretto
Un “libretto ” è un piccolo libro costituito da pagine a doppia facciata graffettate nel mezzo. 
I libretti sono stampati a due pagine accostate su fogli di carta grandi il doppio delle pagine più 
grandi.

Le pagine devono essere numerate in modo insolito quando sono stampate (così tutto funziona 
quando si realizza il libretto). Per esempio, il foglio più lontano di un libretto a 16 pagine avrà le 

1

2 3

4 5

6

1 2

3 4

5 6

Spreads 2-Up

Differenza tra le opzioni 
Spreads e 2-up su un 
documento a sei pagine:
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pagine 16 e 1 a fronte (in quell’ordine) e le pagine 2 e 15 a retro. Fortunatamente, questa compli-
cata procedura di layout (tecnicamente denominata “imposizione”) è eseguita automaticamente da 
Sibelius.

Per stampare un libretto:

* Assicurarsi che la carta sia grande il doppio delle pagine musicali in Sibelius (es. carta A3 per 
pagine A4), oppure:

* Usare la stessa dimensione pagina della carta, ma ridurre opportunamente il valore Scale (es. su 
carta A4 stampare due pagine A4 al 70%).

Poi:

* Cliccare Libretto e Pagine esterne.

* Stampare come al solito; sarà stampata una facciata del foglio.
* Cliccare Pagine interne.

* Reinserire la carta nella stampante e stampare di nuovo per fare l’altra facciata.

Come per la normale stampa a doppia facciata, se le pagine escono dalla stampante rivolte in basso 
invertire l’ordine dei fogli prima di stampare la seconda facciata, oppure stampare la seconda facci-
ata con l’ordine inverso (inserendo un intervallo pagina come 8–1); si deve provare, perché ciò 
varia da una stampante all’altra.

Stampando libretti è possibile usare anche altre opzioni, es. Pagine, Segni di ritagli, Pari e dis-
pari, ecc.; l’opzione Fascicola è molto utile per avere un pacco di copie pronte per la rilegatura.

Sibelius presume che la prima pagina del libretto finito sia la numero 1 (anche se il numero sulla 
prima pagina della partitura non è 1); se quindi la partitura inizia sulla pagina 2, essa apparirà 
come pagina sinistra interna del libretto, non a fronte; ciò consente di lasciare vuota la pagina 
frontale per l’aggiunta di una speciale copertina realizzata con un altro programma.

Stampando le pagine esterne (Pagine esterne) Sibelius stampa prima la doppia pagina contenente 
la pagina 1, poi 3, 5, 7 ecc.; analogamente, stampando le pagine interne (Pagine interne) Sibelius 
inizia a stampare la doppia pagina contenente la pagina 2, poi 4, 6 ecc..

Per esempio, l’ordine di stampa per un libretto a 8 pagine sarà questo:

* Pagine esterne: 1 & 8 (insieme, pagina 1 a destra), 3 & 6
* Pagine interne: 2 & 7, 4 & 5.

Si noti inoltre che due numeri di pagina adiacenti su un foglio si sommano sempre al numero 
totale di pagine, arrotondato in eccesso a un multiplo di quattro più 1 (nel caso sopra, 9).

Per stampare una specifica pagina doppia da un libretto – es. pagine 8 & 1 da un libretto a 8 pagine 
– specificare una delle pagine (es. pagina 1); Sibelius stamperà quella successiva accanto.

Stampare più partiture o parti alla volta
È possibile stampare più file alla volta (es. un’intera cartella) con il plug-in Print Multiple Copies; 
b Plug-in. Per stampare più parti usare il comando File > Stampa tutte le parti (per stamparle 
tutte) o il pulsante Stampa Parte(i) nella finestra Parti per stampare le parti selezionate; 
b Lavorare con le parti.
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Scegliere carta di qualità
Acquistare carta di ottima qualità può migliorare notevolmente l’aspetto della stampa. Una buona 
carta è quella bianca brillante; è molto consistente (così la musica non penetra uscendo da dietro) 
e abbastanza rigida da non cadere dal leggio! Evitare carta comune o per fotocopiatrici – si racco-
manda una carta di circa 26 lb/risma o 100 gsm.

Problemi con i margini
Alcune stampanti potrebbero tagliare i bordi della musica (specialmente quello inferiore); questo 
perché la maggior parte delle stampanti ha bisogno di spazio per afferrare il foglio.

Una soluzione è spostare la musica lontano dal bordo, aumentando i margini della pagina musicale 
nella finestra di dialogo Layout > Imposta documento (comando rapido Ctrl+D o XD).

Se il layout della musica è soggetto a riformattazione ed è stata tagliata (ad esempio) solo la base 
della pagina, si può evitare la riformattazione della musica diminuendo il margine superiore di (ad 
esempio) 0.2 pollici (5mm) e aumentando quello inferiore di 0.2 pollici (5mm), in modo che la 
musica si sposti leggermente in alto sulla pagina; altrimenti usare l’opzione Lock Format prima di 
regolare i margini (b Layout e formattazione).

Problemi con la stampa a doppia facciata
Se la stampante non trascina bene la carta provare con una delle seguenti operazioni:

* Lasciare raffreddare un pò la carta dopo la stampa della prima facciata.
* Inserire manualmente la seconda facciata.
* Aprire la linguetta d’uscita carta (se c’è) sulla stampante, per lasciar scorrere meglio il foglio.

Se l’inchiostro sulla prima facciata tende a sbavare quando si stampa la seconda facciata:

* Lasciare raffreddare un pò la carta dopo la stampa della prima facciata.
* Se ci sono opzioni per far scorrere la carta più velocemente (es. una risoluzione di stampa inferi-

ore) provare ad attivarle per la stampa della seconda facciata.
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5.14 Proprietà

v Focus on Staves e Proprietà.

Solo per utenti esperti

Quasi ogni oggetto in una partitura ha proprietà che si possono modificare in vari modi nella 
finestra Finestra > Proprietà (comando rapido Ctrl+Alt+P o zXP).

Per esempio, font e dimensione di un oggetto di testo si possono cambiare nel pannello Testo della 
finestra Proprietà; l’offset orizzontale di una determinata nota si può modificare dal pannello Gen-
erale, e così via.

In generale, è più facile definire queste proprietà quando si crea l’oggetto, ma talvolta è utile ved-
erle o modificarle in un secondo momento; molte proprietà si possono anche vedere/modificare 
dai normali menu o modificarle con i comandi rapidi.

Vedere le proprietà
Di default, la finestra Proprietà non appare sullo schermo, perché non è necessario regolare spesso 
lì le impostazioni.

Per aprire (e poi chiudere) la finestra Proprietà selezionare Finestra > Proprietà (comando rapido 
Ctrl+Alt+P o zXP) o cliccare sul rispettivo pulsante nella toolbar; si può spostarla ovunque sullo 
schermo trascinando con il mouse la barra del titolo.

Il titolo della finestra Proprietà riflette la selezione corrente – con niente selezionato appare “Nes-
suna selezione”; con il segno di titolo o tempo selezionato del pezzo “Modifica Testo”; con una sin-
gola nota selezionata “Modifica Nota”; con un passaggio selezionato “Modifica Passaggio”; quando 
il cursore è visibile il titolo è “Crea Nota/Pausa”; infine, nel caso di una selezione multipla, invece di 
un elenco con tutti i tipi d’oggetto appare la scritta “Modifica Selezione Multipla”.

Se c’è una selezione multipla o un passaggio selezionato sono visualizzate solo le proprietà comuni 
a tutti gli oggetti selezionati. Per esempio, selezionando due note delle quali solo una è accentata, il 
pulsante d’accento sul tastierino numerico non s’illumina; cliccando sul pulsante d’accento 
entrambe le note prendono l’accento e solo allora il pulsante d’accento s’illumina.

Per aprire e chiudere ciascuno dei sei pannelli cliccare sulla rispettiva barra del titolo. Ogni pan-
nello si può aprire in modo indipendente, così da vederli insieme in qualsiasi combinazione. 
Aprendo più pannelli di quelli che possono stare in verticale sullo schermo, Sibelius chiude auto-
maticamente uno o più pannelli, in modo che la finestra Proprietà occupi sempre lo schermo.

Le opzioni in ogni pannello sono descritte nei dettagli in seguito.
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Pannello Generale
Il pannello Generale della finestra Proprietà permette di cambiare posiz-
ione, ecc. dell’oggetto(i) selezionato, nasconderlo (se si desidera) e mostrare 
una lettura del numero di rigo e misura.

Le opzioni in questo pannello sono le seguenti:

* La prima linea del pannello indica il nome del rigo al quale l’oggetto è 
attaccato (o mostra la scritta “Accollatura” per gli oggetti di sistema).

* Pagina x of y: indica su quale pagina(e) della partitura si trova la selezione.
* Battuta e Pos: indica misura e posizione ritmica all’interno della misura alla quale è attaccato 

l’oggetto. Il valore Pos è sempre in note da 1/4, indipendentemente dal tempo in chiave; per linee 
e tuplet, questo valore indica la posizione dell’estremità sinistra; se non è specificato un valore 
Pos, l’oggetto è attaccato all’inizio di una misura. Non è possibile modificare direttamente questi 
parametri – spostare l’oggetto con il mouse o i tasti freccia.

* Mostra e Nacondi etc.: determina se l’oggetto è nascosto o meno; b Nascondere oggetti.
* X: indica lo spostamento orizzontale dell’oggetto dalla posizione alla quale è attaccato (es. 

l’estremità di una forcina può essere attaccata a una nota anche se è un pò a destra o sinistra).
Si può modificare questo valore; ciò è molto utile per posizionare note, pause e accordi non 
allineati quando si usano due o più voci (o per distanziare segni di prova da una stanghetta).

* Y: ha significati diversi per i vari oggetti; per note e accordi determina la lunghezza del gambo, 
mentre per linee e testi è la distanza sopra la posizione verticale di default.

* Inverti: permette di cambiare le direzione del gambo delle note selezionate e capovolge alcuni 
oggetti sopra o sotto le note (come legature, parentesi dei tuplet, articolazioni e le curvature delle 
legature); per capovolgere un oggetto usare questa opzione o scegliere Modifica > Inverti
(comando rapido X) invece di trascinarlo con il mouse.

* Dim-guida: permette di impostare note selezionate, linee, simboli e oggetti di testo del rigo per 
essere “cue-sized”; equivale a usare il pulsante “cue-size” sul secondo layout (F9) del tastierino 
numerico; b Acciaccature.

Pannello Testo
Nel pannello Testo è possibile cambiare lo stile di testo dell’oggetto di testo 
selezionato e modificarne font, dimensione, grassetto, corsivo o sottolin-
eato; le opzioni sono:

* Il primo menu a tendina mostra lo stile di testo dell’oggetto di testo selez-
ionato; lo stile si cambia scegliendone un altro dal menu. È possibile sceg-
liere solo stili compatibili – non si può cambiare un oggetto testo di sistema (es . Tempo) in uno 
di rigo (es. Expression). Per maggiori dettagli b Lavorare con i testi.

* Il secondo menu a tendina mostra il font dell’oggetto di testo corrente; il font si cambia sceglien-
done un altro dal menu; per cambiare il font (o la dimensione) di tutti i testi nella partitura in 
quello stile, b Modifica stili di testo.

* Dimensioni: è la dimensione del font (in punti).
* I box B, I e U controllano rispettivamente se il testo selezionato è in grassetto, corsivo e/o sot-

tolineato; i comandi rapidi sono Ctrl+B/I/U o XB/I/U.
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Pannello Playback
Nel pannello Playback è possibile regolare la riproduzione di linee e cam-
biare le impostazioni di ripetizione della riproduzione; le opzioni sono:

* Suona al passaggio: i box di spunta 1–8 determinano quante volte 
l’oggetto di testo selezionato, linea o nota deve essere riprodotto in un 
passaggio – per maggiori dettagli, b Ripetizioni.

* Fine ultima volta: determina se una linea di finale è l’ultima o meno in 
una struttura ripetuta – per maggiori dettagli, b Ripetizioni.

* Salta alla fine della battuta: fa in modo che i salti di ripetizione abbi-
ano effetto a metà della misura – per maggiori dettagli, b Ripetizioni.

* Velocity live, posizione iniziale e Durata live: sono i tre parametri di 
una nota che si possono modificare in Live Playback – b Live Play-
back

* Gliss./Rit./Accel.: permette di cambiare l’effetto in riproduzione di 
questi tre tipi di linea – Per maggiori dettagli b Riproduzione.

* Forchetta dinamica: consente di definire la dinamica finale (o una variazione percentuale della 
dinamica) di una forcina selezionata; in Auto (default) è Sibelius a farlo. Vedere 
b Riproduzione.

* Trillo: permette di scegliere se la riproduzione deve essere diatonica (Diatonica) o meno; per 
stabilire l’intervallo manualmente disattivare l’opzione Diatonica, quindi scegliere l’intervallo in 
Semitoni, Velocità (note al secondo) e stabilire se la riproduzione deve iniziare sulla nota supe-
riore di un trillo selezionato (Avvia su nota più alta). Di default, Sibelius riproduce i trilli con 
leggere irregolarità ritmiche, per farli suonare più naturali – se questo effetto non piace attivare 
l’opzione Suona dritto; vedere b Riproduzione.

* Tremolo: consente di stabilire se Sibelius deve riprodurre o meno il tremolo a una nota o la rul-
lata (“z sul gambo”); disattivare questa opzione solo se il dispositivo di riproduzione riproduce il 
tremolo con campioni dedicati e non si vuole che Sibelius stesso suoni più note.

Pannello Linee
Il pannello Linee permette di modificare le proprietà della legatura selezio-
nata; le opzioni sono:

* Centro: controlla la curvatura della legatura selezionata.
* Fine: controlla l’offset orizzontale (X) e verticale (Y) dell’estremità destra 

della legatura selezionata; vedere b Legature di portamento.
* Aperture fine forchetta e Aperture continuazione: controllano i quat-

tro punti possibili di una forcina (qui indicati divisi su un break di 
sistema o pagina):

% Chiusa (a. nell’esempio sopra) è l’estremità chiusa della forcina; impostarlo a un valore supe-
riore a 0 per aprire la forcina a un’estremità.
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% Aperta (d. nell’esempio sopra) è l’estremità aperta della forcina.
% Piccola (c. nell’esempio sopra) è il segmento della forcina che usa l’opzione Apertura piccola 

continuazione (definita in House Style > Regole tipografia - Linee); ha effetto solo se la 
forcina è divisa su un break di sistema o pagina.

% Grande (b. nell’esempio sopra) è il segmento di forcina che usa l’opzione Apertura larga 
continuazione; ha effetto solo se la forcina è divisa su un break di sistema o pagina.

Pannello Misure
Per cambiare le proprietà di una misura, selezionarla in modo che si cir-
condi di un box blu chiaro (per alcune opzioni si colora la stanghetta alla 
fine della misura) e modificare le opzioni nel pannello Misure:

* Parentesi/Stanghetta iniziale/Chiavi/Indicazione di tonalità: deter-
minano se gli oggetti sono scritti all’inizio della misura (quando essa è 
all’inizio del sistema), oppure dopo il vuoto in un sistema “diviso”, come 
una coda o un rigo provvisorio (o incipit).

* Dividi multipausa: forza questa stanghetta a dividersi in una pausa mul-
tipla – per maggiori dettagli, b Pause multiple.

* Fine sezione: segna la stanghetta come fine di una sezione a beneficio dei formati nome stru-
mento scelti nella finestra di dialogo House Style > Regole tipografia (Ctrl+Maius+E o
xXE); nello stesso punto si dovrà creare anche un break di sistema o pagina.

* Il primo menu a tendina indica i break (se ci sono) sulla stanghetta – così si può aggiungere o 
rimuovere un break di sistema o pagina alla stanghetta selezionata. Ciò si può fare solo dal sub-
menu Layout > Interruzioni (o con i comandi rapidi). .

* Nel secondo menu a tendina è possibile cambiare il tipo di misura di pausa usata nella misura 
selezionata; per i dettagli b Misure e misure di pausa.

* Spazio prima della misura: modifica la tacca prima della misura selezionata quando essa è 
all’inizio di un sistema o il vuoto appena prima della misura in un sistema diviso (come una 
coda).

Pannello Note
Il pannello Note permette di cambiare la testa nota della nota(e) selezion-
ata, la posizione orizzontale delle alterazioni e la posizione e forma delle 
legature. Per regolare un’alterazione o legatura da questo pannello selezion-
are la rispettiva nota (non l’alterazione/legatura); le opzioni sono:

* Il menu a tendina in cima mostra la testa nota selezionata; per cambiarla, 
selezionarne un’altra dal menu. Per cambiare le teste nota con la tastiera 
tenere premuto Maius+Alt o xz e digitare il numero di testa nota sulla 
tastiera principale – b Teste nota.

* Alterazione: X: controlla l’offset orizzontale dell’alterazione attaccata alla 
nota selezionata. Valori positivi spostano l’alterazione a destra, valori negativi a sinistra. 
Le alterazioni si possono anche spostare selezionandole e premendo Alt+0/1 o z0/1. 
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* Bordo legatura: %: controlla la curvatura della legatura; valori più elevati generano legature più 
piatte, mentre valori inferiori generano una forma a boomerang. Cliccare Def (default) per far 
tornare la spalla della legatura alla sua forma originale definita nella pagina Legature 1 della 
finestra di dialogo House Style > Regole tipografia (utile se il boomerang non torna indietro!) 
– b Legature di valore.

* Centro Leg.: Y: controlla l’altezza della parte centrale della legatura; si può regolarla anche 
selezionando la legatura e premendo i tasti 3/2.

* Margini Leg.: Y: controlla la posizione verticale dell’estremità destra di una legatura attaccata 
alla nota selezionata. L e R controllano rispettivamente la posizione orizzontale delle estremità 
sinistra e destra della legatura; si può regolarla anche selezionando l’estremità della legatura e 
premendo Maius+Alt+0/1 o xz0/1.

* Gruppo irregolare: permette di cambiare l’aspetto del tuplet selezionato (visualizzando o meno 
la parentesi, ad esempio). Vedere b Terzine e altri tuplet.

* Inverti tratto d’unione frazionale: permette di capovolgere un tratto d’unione secondario 
frazionale. b Tratti d’unione.
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b SibeliusMusic.com, Creatore Quaderni di Lavoro.

v Pubblicazione in Internet.

SibeliusEducation.com è un sito web per la condivisione e il download di risorse per l’insegna-
mento e l’apprendimento e la comunicazione con altri insegnanti in tutto il mondo.

A chi serve?
È comodo per insegnanti e studenti i quali possono accedere via Internet ad esercizi e risorse. 
Per l’insegnante è un metodo facile di pianificazione delle lezioni (evita di stampare o fotocopiare 
decine d’esercizi e che gli studenti perdano il lavoro eseguito).

Poiché la musica è visualizzata usando Scorch, gli studenti possono riprodurre le musica per sen-
tire come suona – molto più interessante che usare un esercizio su un foglio di carta! 
Inoltre, se usano Sibelius (a scuola) o Sibelius Student (a casa) possono eseguire un download e 
completare il lavoro su computer.

Caratteristiche
Poiché SibeliusEducation.com è in costante sviluppo, periodicamente s’aggiungono nuove funzi-
oni; è possibile:

* Raccogliere esercizi e materiale didattico da usare per le lezioni.
* Gli studenti possono vedere, stampare e scaricare il lavoro che l’insegnante ha preparato per loro, 

completandolo su carta o, se usano Sibelius (a scuola) o Sibelius Student (a casa), eseguendo il 
lavoro su computer e poi caricandolo finito sul sito.

* Accedere a materiale didattico fornito da altri insegnanti e scuole.
* Discutere in chat con altri insegnanti in tutto il mondo per scambiarsi informazioni e idee.
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* Ottenere altre risorse e informazioni da Sibelius Software (per esempio esercizi extra e video sui 
quali comporre).

* Ottenere risorse per la gamma di prodotti Sibelius Educational Suite.

Dettagli completi sul sito web.

Servizi SibeliusEducation.com
Per iscriversi a SibeliusEducation.com selezionare Aiuto > SibeliusEducation.com, oppure visi-
tare il sito www.sibeliuseducation.com; creando un account si può beneficiare dei servizi 
aggiuntivi, come messaggi di posta sul forum e upload degli esercizi sul sito.

Pubblicare gli esercizi in SibeliusEducation.com
* Una volta creato il proprio esercizio salvarlo sul disco rigido.
* Per fare in modo che gli studenti riescano ad aprire il file con un versione precedente di Sibelius 

o Sibelius Student selezionare File > Esporta > Sibelius 2, 3, 4 o Student per salvare il file.
* Selezionare File > Pubblica su SibeliusEducation.com poi, quando si apre il browser web, 

iscriversi e andare nell’area My work del sito (bisogna iscriversi per poterlo fare).
* Seguire le istruzioni sullo schermo per caricare i propri file sul sito nell’area degli esercizi.

SibeliusMusic.com
SibeliusMusic.com ha decine di migliaia di partiture realizzate da compositori, arrangiatori, inseg-
nanti e studenti. Si può scaricare musica dal sito a scopi didattici da vedere e riprodurre gratuita-
mente; molta musica si può stampare, altra è in vendita. 
Per i dettagli b SibeliusMusic.com.
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b SibeliusEducation.com, Esportare pagine web Scorch.

v Pubblicazione in Internet.

Internet è il metodo ideale per raggiungere il pubblico di tutto il mondo con la propria musica. 
Sibelius è l’unico software di notazione musicale con il plug-in di browser web gratuito Scorch che 
consente a chiunque di vedere, riprodurre, trasportare e stampare le partiture in Internet.

Compositori, arrangiatori e chiunque altro può pubblicare materiale sul nostro sito SibeliusMu-
sic.com – da brani per piano a partiture orchestrali, dalla musica classica all’avanguardia e al rock/
pop. Pubblicare partiture è completamente gratuito; inoltre, si può anche guadagnare qualcosa – 
chi vende la propria musica (invece di fornirla gratuitamente) è pagato il 50% del prezzo!

Si può anche pubblicare la musica sul proprio sito web, oppure pubblicare materiale didattico sul 
nostro sito educativo.

Scorch
Sibelius Scorch è l’eccezionale plug-in browser web gratuito che consente a chiunque di vedere, 
riprodurre, cambiare tonalità e strumenti, perfino stampare partiture direttamente da Internet, sia 
che abbia o meno Sibelius.

Alle persone che visitano il vostro sito sarà chiesto di scaricare automaticamente Scorch; in pochi 
minuti esse potranno vedere e ascoltare musica dal vostro sito e centinaia di altri, compresi i siti 
dei maggiori editori come www.sheetmusicdirect.com (rock/pop) e www.boosey.com
(musica classica/didattica).

Per i dettagli sull’installazione di Scorch vedere Installare Sibelius nella sezione Iniziare qui 
della Guida. Scorch s’installa automaticamente solo su Internet Explorer per Windows – ma fun-
ziona anche con altri browser, inclusi Firefox e Opera, sia in Windows che su Mac.

Controlli di riproduzione e cursore tempo.
Cliccare Play per avviare la riproduzione o cliccare 
ovunque sulla partitura per iniziarla da quel punto.

Gira pagina Scelta del dispositivo
di riproduzione

Salva la partitura
su hard-disk*

Stampa 
partitura*

Cambio strumento
in alto*

Informazioni e 
aggiornamenti Scorch

Cambio tonalità*

* opzione non disponibile in tutte le partiture.

Toolbar di Scorch 
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Impostazioni consigliate
Per fare in modo che la vostra partitura appaia e suoni al meglio quando altre persone la vedono, 
prima di pubblicarla in Internet bisogna standardizzare alcuni elementi:

* Font – non tutti i font sono disponibili su tutti i computer
* Dimensione pagina – la stampa della partitura deve essere accettabile su vari tipi di carta.
* Riproduzione – deve tenere conto dei requisiti minimi di riproduzione di un computer medio.

Limitare i font usati per i testi nella partitura a quelli più comuni, come Times, Times New Roman, 
Arial e Helvetica (sebbene Scorch sostituirà i font con altri equivalenti più simili se la persona che 
vede la vostra pagina web non ha i font da voi usati); assicurarsi inoltre che gli unici font musicali 
usati siano quelli standard di Sibelius (Opus, Helsinki, Reprise e Inkpen2), poiché essi saranno dis-
ponibili su ogni computer con Scorch installato.

Preparando le partiture da pubblicare su SibeliusMusic.com (da dove possono essere stampate) 
usare il formato ritratto e preferibilmente una dimensione standard della pagina (es. Lettera, Tab-
loid, A4 o A3); Scorch scala la musica per farla stare nella dimensione pagina della stampante.

Si tenga presente, inoltre, che una partitura la quale suona bene con la propria scheda audio o i 
propri dispositivi MIDI potrebbe suonare non altrettanto bene su altri computer. È meglio quindi 
provare ad ascoltare le proprie partiture con suoni standard General MIDI, per avere un’idea di 
come suonano quando sono riprodotte in Scorch.

Pubblicazione su SibeliusMusic.com
Iniziare aprendo il file di Sibelius da pubblicare on-line e scegliendo File > Pubblica su Sibelius 
Music.com.

* Se di recente il file non è stato salvato, un messaggio d’avviso chiede di farlo; salvarlo e selezion-
are di nuovo Pubblica su SibeliusMusic.com.

* Si apre il vostro browser web che visualizza un pagina web nella quale specificare le informazi-
oni principali sulla partitura, come il titolo (è inserito automaticamente se prima è stato scritto 
nella finestra di dialogo File > Nuovo o File > Info su partitura).

* Trovare su hard-disk la partitura da pubblicare on-line – cliccare Sfoglia per trovarla.
* Una volta trovata la partitura cliccare Successivo; il computer si collega a Internet e carica la 

partitura su SibeliusMusic.com.
* Un messaggio chiede di fornire altre informazioni su di voi e la vostra partitura – seguire sem-

plicemente le istruzioni sullo schermo.

SibeliusMusic.com pubblica solo musica tutelata da copyright (cioè composizioni originali o 
arrangiamenti di musica esenti da copyright). Non è consentito pubblicare trascrizioni o arrangia-
menti di musica protetta da copyright, trascrizioni letterali o edizioni di musica esenti da copy-
right e partiture contenenti parole protette da copyright usate senza il permesso dell’autore. 
Per altri dettagli sulle limitazioni imposte dal copyright sulle partiture che si possono pubblicare 
vedere le informazioni fornite dal sito SibeliusMusic.com.

Se ci sono problemi o domande sulla pubblicazione della propria musica su SibeliusMusic.com si 
prega d’inviare una e-mail al seguente indirizzo: info@sibeliusmusic.com.
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Per i dettagli sul trasporto di strumenti e partiture, b Strumenti.

Per informazioni su semplificazione di tonalità e spelling enarmonici, b Tonalità.

Per trasportare la musica:

* Selezionare la musica da trasportare – in genere un passaggio o l’intera partitura (comando 
rapido Ctrl+A o XA).

* Scegliere Note > Trasponi (comando rapido Maius-T).
* Decidere se trasportare in tonalità (Chiave) o intervallo (Intervallo).
* Se si sceglie Chiave:

% Selezionare la tonalità alla quale trasportare la musica dal menu.
% Stabilire se Sibelius deve trasportare del più piccolo intervallo richiesto (Più vicina), oppure 

in alto (Su) o in basso (Giù).
* Se si sceglie Intervallo:

% Cliccare Su o Giù.
% Dal secondo box scegliere l’intervallo principale.
% Nel primo box Major/Perfect lascia inalterato l’intervallo principale, Augmented lo 

aumenta di mezzo step (un semitono), Minor/Diminished lo diminusice di un semitono.
% Diatonic: sposta le note all’interno della tonalità specificata da quella corrente in chiave; 

trasportando in alto di una seconda diatonica, quindi, la terza nota della tonalità diventa la 
quarta, la quinta bemolle diventa la sesta bemolle, ecc.

* Se si desidera, impostare anche le altre opzioni:
% Trasponi indicazioni di tonalità: (disponibile per il trasporto di un passaggio di sistema o 

dell’intera partitura) trasporta ogni cambio di tonalità all’interno del passaggio selezionato. 
Normalmente si lascia attiva; disattivandola, le note trasportate prendono le alterazioni che 
altrimenti sarebbero specificate nella tonalità in chiave.
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% Trasponi indicazioni di tonalità: se attiva, si può attivare anche l’opzione Cambia chiave 
all’inizio, che crea una nuova tonalità in chiave all’inizio del passaggio trasportato (se si 
desidera).

% Per evitare che Sibelius crei un di nuovo un cambio alla tonalità originale alla fine del passag-
gio trasportato attivare l’opzione Consenti cambio chiave permanente.

% Usa doppio diesis/bemolle: questa opzione fa in modo che Sibelius scriva tonalità remote 
usando doppi diesis e bemolle invece che bequadri; disattivarla per la musica atonale. 
Lasciarla attiva se si suona Rachmaninov o Alban Berg.

* Cliccando su OK Sibelius trasporta immediatamente la musica.

Spostamento senza alterazioni
Per spostare note senza alterarle selezionare la musica e premere una o più volte i tasti 3/2.

Trasportare di una o più ottave
Il metodo più rapido è selezionare la musica e premere Ctrl+3/2 o X3/2.

Trasportare più di due ottave
Per comodità, la finestra di dialogo Note > Trasponi (comando rapido Maius-T) elenca solo inter-
valli fino a due ottave. Per intervalli superiori, trasportare di altre ottave premendo Ctrl+3/2 o
X3/2 prima o dopo il trasporto dalla finestra di dialogo.

Trasportare di mezzo step (un semitono)
Sebbene la maggior parte dei trasporti sia elementare, questo caso particolare merita una breve 
spiegazione. Se, ad esempio, c’è una partitura in RE maggiore da trasportare in RE bemolle mag-
giore, non si deve trasportarla in basso di una seconda minore (perchè si avrebbe un DO# mag-
giore); abbassarla invece di un unisono aumentato.

Trasporti estremi
Per trasporti estremi il cui intervallo non è elencato, per esempio da SI a RE bemolle (in alto di una 
terza doppiamente aumentata), dividerlo in due trasporti meno ampi: prima alzare di una terza 
minore a RE, poi abbassare di un unisono aumentato a RE bemolle.

Simboli e diagrammi accordo
Si trasportano automaticamente.

Spostare altri oggetti
Durante il trasporto, Sibelius sposta altri oggetti per vedere se rimangono alle giuste posizioni. 
Legature di valore e portamento, ad esempio, si spostano automaticamente per seguire le note. 
Se la musica è trasportata talmente lontano per cui molte direzioni dei gambi nota cambiano, 
bisognerà capovolgere alcune legature con il comando Modifica > Inverti (comando rapido X), in 
modo da collocarle meglio sopra le note.
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Undo
Cliccare sul pulsante nella barra degli strumenti indicato a sinistra o selezionare 
Modifica > Undo (comando rapido Ctrl+Z o XZ) per annullare l’ultima operazione ese-
guita.

Il menu Modifica indica l’ultima operazione eseguita in Sibelius (in caso di memoria corta!).

La funzione Undo è multi-livello – praticamente si possono eseguire Undo illimitati. Con l’’opzione 
Modifica > Storia Undo (vedere sotto) si può tornare indietro a un punto particolare.

Redo
Redo annulla gli Undo (o meglio, Redo riesegue gli Undo). Per ripetere un’operazione che 
non si desiderava annullare cliccare sul pulsante nella barra degli strumenti indicato a 
sinistra o selezionare Modifica > Redo (comando rapido Ctrl+Y o XY).

 Anche in questo caso, il menu Modifica indica l’operazione Redo eseguita.

Undo storia
Modifica > Undo storia... (comando rapido Ctrl+Maius+Z o xXZ) elenca tutte le operazioni 
recenti eseguite e permette di tornare indietro nel tempo a una particolare operazione.

L’operazione più recente è quella più in cima all’elenco; cliccare su di essa per annullare uno step, 
cliccare sulla seconda operazione per l’Undo di due step e sull’operazione in fondo per tornare 
indietro il più possibile. Il livello retroattivo dell’opzione Undo storia è personalizzabile – vedere 
Livello Undo.

Redo storia
Modifica > Redo storia... (comando rapido Ctrl+Maius+Y o xXY) è come Undo storia, ma 
elenca tutte le operazioni che si possono eseguire di nuovo dopo aver applicato una serie di Undo.

L’operazione più recente non eseguita è in cima all’elenco, quindi (come per Undo storia) cliccare 
sull’operazione in alto per eseguire di nuovo uno step, cliccare sulla seconda operazione per il Redo 
di due step e sull’operazione in fondo per eseguire di nuovo tutte le operazioni annullate e tornare 
al punto di partenza.

Livello Undo
Per stabilire quanti Undo è possibile eseguire selezionare la pagina Altro della finestra File > Pref-
erenze (menu Sibelius in Mac) e trascinare il cursore. È possibile annullare fino a 20.000 operazi-
oni, quindi impostando un livello Undo abbastanza elevato si può tornare indietro fino a quando si 
è iniziato a scrivere la partitura corrente.

Impostandolo ancora più elevato si può annullare fino a prima dell’acquisto di Sibelius!
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5.19 Menu Vista

b Impostazioni visive, Menu Finestra.

v Trovare la propria strada.

Il menu Vista ha varie opzioni che controllano come partiture e interfaccia grafica di Sibelius 
appaiono sullo schermo.

È possibile stampare la partitura con le opzioni incluse nel menu Vista (per esempio, con gli 
oggetti nascosti in grigio, le evidenziature in giallo e i segni di layout in blu) – b Stampa.

Panorama
Visualizza la partitura in un singolo sistema continuo su una pagina infinitamente larga. 
b Panorama.

Evidenza su righi
Questa funzione visualizza solo i righi selezionati nascondendo tutti gli altri; è utile per l’inseri-
mento e la modifica della musica (specialmente insieme alla veduta Panorama) e per i righi 
nascosti con musica da riprodurre. b Evidenzia righi Selezionati.

Nomi rigo e Numeri battuta
Lavorando su partiture per grandi ensemble o ingrandendo l’immagine è molto utile sapere su 
quale rigo e misura si sta lavorando, senza dover cercare nome strumento e numero misura.

Questa opzione scrive i numeri misura in blu sopra ogni misura e il nome di ogni rigo sul lato sin-
istro dello schermo quando i nomi degli strumenti sono fuori dal lato sinistro dello schermo.

Marchi Layout
Questa opzione mostra i break di sistema e pagina con icone nella partitura, disegna altre icone 
che indicano dove è stato cambiato il layout e mostra dove sono i righi nascosti tracciando una 
linea tratteggiata blu nella pagina. b Break - Interruzioni.

Poiché quando si usa la funzione Vista > Evidenza su righi è utile vedere (ad esempio) dove sono 
nascosti i righi, Sibelius permette di disattivare l’opzione Vista > Marchi Layout quando si lavora 
sull’intera partitura e attivarla quando si usa la funzione Focus on Staves (e viceversa) – attivarla o 
disattivarla in base alle esigenze; Sibelius ricorderà la sua condizione.

Margini pagina
Questa opzione disegna un rettangolo tratteggiato che indica dove sono i margini definiti nella 
finestra Layout > Imposta documento. b Impostazioni documento.

Righelli
Le opzioni nel submenu Vista > Righelli attivano e disattivano tre tipi di righelli:

* Selezione righelli: visualizza un righello tra l’oggetto(i) selezionato e il rigo al quale è attaccato.
* Righelli oggetto (comando rapido Maius+Alt+R o xzR): visualizza un righello per tutti gli 

oggetti attaccati ai righi (es. testi, simboli, linee, ecc.) sia che siano selezionati o meno.
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* Righelli rigo (comando rapido Ctrl+Maius+Alt+R o xzXR): visualizza i righelli tra righi e 
bordi pagina, e tra righi adiacenti.

Impostare l’unità di misurazione usata per i righelli nella pagina Altro della finestra di dialogo 
File > Preferenze (menu Sibelius in Mac); si può scegliere tra pollici, punti (1 punto = 1/72 pol-
lice), millimetri e spazi.

I righelli d’oggetto e rigo possono rallentare notevolmente le immagini sullo schermo; disattivarli 
se Sibelius rallenta la sua azione.

Oltre ai righelli, scegliendo l’opzione di struttura grafica Sibelius può visualizzare la musica su un 
foglio grafico suddiviso in spazi; b Impostazioni visive.

Linee collegamento
Questa opzione traccia una freccia grigia tratteggiata che indica a quale rigo e posizione ritmica è 
attaccato l’oggetto selezionato; per comodità, non appaiono linee d’attaccatura per alcuni oggetti 
come note, pause e oggetti di sistema. b Attaccature.

Oggetti nascosti
Con questa opzione attiva, gli oggetti nascosti appaiono in grigio chiaro nella partitura e sono 
modificabili; se non è attiva, sono invisibili e non modificabili. È più comodo usare i tasti di 
comando rapido invece dei menu, quindi è bene memorizzare Ctrl+Alt+H o zXH.
b Nascondere oggetti.

Differenze nelle parti
Se attiva, Sibelius mostra gli oggetti la cui posizione o aspetto in una parte è diversa rispetto alla 
partitura colorandoli in arancio; usando questa opzione in una partitura, Sibelius colora tutti gli 
oggetti che hanno posizione o aspetto diverso in una o più parti. b Lavorare con le parti. 

Righelli di rigo– indicano la distanza 
tra i righi adiacenti e quella tra i righi 
e i bordi della pagina.

Righelli di selezione – indicano la dis-
tanza tra gli oggetti selezionati e il rigo 
al quale sono attaccati.
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Highlights
Se nella partitura sono state create evidenziature, usare questa opzione per stabilire se esse sono 
visualizzate sullo schermo. b Evidenzia.

Colori note
Il menu Vista > Colori note ha quattro opzioni che influenzano l’aspetto della partitura sullo 
schermo:

* Pitch Spectrum: colora ogni nota in base all’altezza alla quale suona rispetto al circolo delle 
quinte. Con questa opzione attiva, le note selezionate sono colorate in grigio per non essere con-
fuse con le teste nota colorate; i quarti di tono sono colorati come i mezzi step (semitoni) adia-
centi.

* Colori voce: colora tutte le note in una sfumatura più scura del rispettivo colore voce; le note in 
Voce 1 sono in blu scuro, in Voce 2 sono verdi, in Voce 3 sono arancio e le note in Voce 4 sono 
rosa (b Voci).

* Note fuori Range: impostazione di default; colora automaticamente in rosso le note troppo 
acute o gravi da suonare per uno strumento; le note scomode da suonare ma suonabili dai pro-
fessionisti sono in rosso scuro. Si possono quindi individuare facilmente le note difficili o impos-
sibili e correggerle prima delle prove (b Strumenti).

* Nulla: visualizza le note in nero; le note selezionate sono colorate in base alle rispettive voci (la 
Voce 1 è blu scuro, la Voce 2 è verde, ecc.).

L’opzione Pitch Spectrum è utile sia ai professionisti che ai principianti; lo schema dei colori è 
determinato dal circolo delle quinte, quindi:

* Le tonalità simili hanno colori simili; per esempio, un pezzo in DO maggiore con una sezione 
centrale in SOL maggiore usa uno schema colore coerente.

* Le note vicine non si confondono quando si vede una partitura non ingrandita; per esempio, le 
note DO e SOL hanno colori simili, ma sono distanti tra loro sul rigo, mentre le note DO e DO#
sono vicine sul rigo ma hanno colori molto diversi.

Lo scopo è avere una buona panoramica della partitura anche se non 
è ingrandita; per esempio, gli strumenti che suonano la stessa nota 
sono segnati con lo stesso colore, per vedere facilmente i raddoppi – 
specialmente su strumenti in chiavi diverse o trasportati. Al con-
trario, una scala cromatica è proprio “cromatica” (multi-colorata, dal 
Greco chroma - “colore”) poiché ogni nota non ha alcuna relazione 
armonica con le altre, quindi ha un colore completamente diverso.

Si consiglia di usare Sibelius con l’opzione Pitch Spectrum attiva per 
imparare i colori; una volta abituati ad essi sarà un metodo di lavoro molto comodo.

È interessante come alcuni compositori, come Messiaen e Skryabin, associano i suoni ai colori; 
questa “associazione di idee” è nota come sinestesia. L’opzione Pitch Spectrum può aiutare la com-
prensione di questo fenomeno! Per maggiori informazioni sulla sinestesia, visitare il sito:

http://web.mit.edu/synesthesia/www/synesthesia.html 
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Live Playback Velocities
Mostra colonne colorate sopra ogni nota o accordo nella partitura che contiene dati Live Playback, 
che rappresentano le rispettive velocity MIDI. b Live Playback.

Linea Playback
Quando non si riproduce niente disattivarla per nascondere la linea verde di riproduzione.

Schermo intero (solo Windows)
Selezionando questa opzione (comando rapido Ctrl+U) i menu e la barra delle funzioni (quella in 
basso che mostra i programmi in esecuzione) scompaiono per risparmiare spazio.

Si possono usare comunque i menu spostando il mouse in cima allo schermo: i menu riappaiono.

Barre scorrimento
Aggiunge barre di scorrimento verticali e orizzontali alla finestra di editing principale della partit-
ura; è meglio non usarle, poiché muoversi nella partitura con Navigator è più semplice e rapido.

Avendo un mouse con la rotellina, la si può usare per scorrere la partitura, con l’opzione Vista >
Barre scorrimento attiva o meno:

* Scorrere la rotellina in alto e in basso per spostarsi alla pagina precedente/successiva; tenere pre-
muto Alt o z per spostarsi di una schermata alla volta.

* Tenere premuto Maius e scorrere la rotellina per spostare la pagina a sinistra e destra; tenere 
premuto Alt o z per spostarsi di una schermata alla volta (o una pagina alla volta se la larghezza 
della pagina occupa tutto lo schermo). Con Mighty Mouse di Apple, scorrendo la rotellina in 
orizzontale la pagina si sposta a sinistra e destra senza dover tenere premuto Maius (solo Mac).

* Tenendo premuto Ctrl o X la rotellina serve anche per lo zoom.

In Windows, per variare la velocità di scorrimento usare Mouse nel Pannello di Controllo. 
Le opzioni precise disponibili dipendono dal driver mouse installato, ma molti driver hanno l’opz-
ione per lo scorrimento accelerato; aumentandola si può scorrere più velocemente la partitura con 
la rotellina del mouse.

Toolbar
Mostra/nasconde la toolbar; nascondendola si risparmia spazio sullo schermo (in ogni caso quasi 
tutti i pulsanti nella toolbar hanno semplici comandi rapidi).

Zoom
Le opzioni nel menu Vista > Zoom duplicano le azioni dei tool Zoom sulla toolbar; le funzioni 
zoom di Sibelius si possono usare in molti modi:

* Usare i comandi rapidi Ctrl++ o X+ (zoom in) e Ctrl+– o X– (zoom out); si possono usare i 
tasti + e – sul pad numerico o sulla tastiera principale.

* Avendo un mouse con la rotellina, tenere premuto Ctrl o X e scorrerla in alto e in basso per 
ingrandire e ridurre l’immagine.

* Cliccare sul pulsante zoom nella toolbar, quindi cliccare sulla partitura per ingrandire; clic-
destro (Windows) o z-clic (Mac) per ridurre di nuovo.
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* Cliccare sul pulsante zoom nella toolbar e trascinare il mouse sulla partitura per selezionare 
l’area da ingrandire.

* Con il comando rapido Ctrl+0 o X0 cambiare il livello zoom a Adatta pagina, e Ctrl+1 o X1
per impostare il livello zoom a 100%; si possono anche definire comandi rapidi personalizzati 
per altri livelli zoom – b Menu e comandi rapidi.

Il pulsante zoom attivo sulla toolbar rimane attivo dopo aver cliccato o trascinato il mouse nella 
partitura, quindi si può cliccare di nuovo; per fermare lo zoom, premere il tasto Esc o disattivare il 
pulsante zoom.

Uno zoom al 100% non visualizza la musica alla dimensione di stampa; la mostra a una dimen-
sione comoda per l’editing. L’opzione Dimensione Attuale (nell’elenco sulla toolbar) mostra la 
musica alla dimensione di stampa presunta (sebbene ciò dipenda dalla dimensione esatta del 
monitor).

Le opzioni come Adatta ampiezza pagina sono auto-esplicative. Tuttavia, è megli attenersi ai fat-
tori di zoom numerici, poiché essi sono stati scelti per visualizzare le note il più chiaramente possi-
bile, garantendo che tutte le linee del rigo siano ugualmente spaziate. Si può digitare il proprio 
fattore di zoom nella toolbar; in tal caso, Sibelius lo arrotonda per eccesso o difetto al fattore ideale 
di zoom.

Di default, in riproduzione Sibelius imposta il livello zoom a Adatta ampiezza pagina, ma 
volendo si può cambiarlo (o impedire a Sibelius di cambiare il livello zoom durante la riproduzi-
one) nella pagina Posizione partitura della finestra di dialogo File > Preferenze (menu Sibelius
in Mac), oppure cambiando semplicemente il livello zoom durante la riproduzione; 
b Riproduzione.

La pagina File della finestra File > Preferenze (menu Sibelius in Mac) ha un’opzione che stabilisce 
il fattore zoom di default da usare all’apertura delle partiture; b Preferenze.
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5.20 Menu Finestra

b Menu Vista.

Il menu Finestra presenta le seguenti opzioni:

Nuova finestra
Nuova finestra crea una nuova veduta della partitura corrente. Ciò consente di vedere diverse 
posizioni nella stessa partitura allo stesso momento, guardare la stessa partitura a fattori di zoom 
diversi o vedere più parti contemporaneamente; per esempio, si può impostare una veduta al 25% 
per una visione generale del layout pagina e un’altra al 200% per un lavoro più ravvicinato (ciò è 
particolarmente sel il computer ha due monitor).

Solo Windows: Il menu Finestra ha anche tutte le opzioni standard di Windows per vedere le par-
titure; per esempio, se c’è più di una partitura aperta (o una partitura e una parte) l’opzione Affi-
anca Orizzontalmente consente di vederle entrambe nello stesso momento.

Finestre tool

* Navigatore: mostra e nasconde la finestra Navigatore; si può usare il pulsante sulla toolbar 
(vedi sopra) o il comando rapido Ctrl+Alt+N or zXN; conoscendo i comandi rapidi per muo-
versi nella partitura (Page Up o 8, Page Down o 9, ecc.) si può anche fare a meno della finestra 
Navigatore; per spostare la finestra Navigator sullo schermo trascinare la sua barra del titolo (lo 
stesso vale per le altre finestre tool).

* Tastierino numerico (tastierino numerico): attiva e disattiva il tastierino numerico, ma è più 
comodo usare il comando rapido Ctrl+Alt+K o zXK.  
Si dovrebbe conoscere abbastanza bene Sibelius per sapere cosa sono tutti i pulsanti in tutti i lay-
out del tastierino numerico senza guardare; dopo aver usato Sibelius per un pò, provare a disatti-
vare il tastierino numerico per vedere cosa si ricorda (è bene conoscere a memoria almeno il 
primo layout del tastierino numerico).

* Riproduzione (Playback): apre e chiude la finestra Playback (oppure si può premere 
Ctrl+Alt+Y o zXY) – b Riproduzione.

* Mixer: apre e chiude la finestra Mixer (sebbene sia molto più facile premere Ctrl+Alt+M o M su 
Mac per attivare o disattivare il Mixer) – b Mixer.

* Mostra finestra idee: apre la finestra Idee; si può usare anche il comando rapido Ctrl+Alt+I o
zXI – b Idee.

Navigatore

T. num.

Playback

Mixer

Idee

Parti

Video

Proprietà

Nascondi  
finestre Tool 
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* Parti: apre e chiude la finestra Parti (sebbene si possa premere Ctrl+Alt+R o zXR) – 
b Lavorare con le parti.

* Video: apre e chiude la finestra Video (è più comodo usare il comando rapido Ctrl+Alt+V o
zXV) – b Video.

* Proprietà: apre e chiude la finestra Proprietà: si può anche premere Ctrl+Alt+P o zXP. 
Di default, le finestre Proprietà e tastierino numerico scompaiono durante la riproduzione (per 
mantenere libero lo schermo). b Proprietà.

* Nascondi finestra Tool: se si sta usando (ad esempio) Kontakt Player, regolando le impostazi-
oninel Mixer e montando il video, con molte finestre tool aperte lo schermo può diventare piut-
tosto confuso; Sibelius consente di nascondere simultaneamente tutte le finestre tool aperte e 
riaprire lo stesso set di finestre in seguito con il comando Finestra > Nascondi finestra Tool 
(comando rapido Ctrl+Alt+X or zXX). 

Passa a parte/Partitura completa
Lavorando sulle parti in una partitura queste opzioni consentono di passare dalla partitura com-
pleta a una parte; la parte visualizzata dipende dalla selezione eseguita nella partitura prima di 
usare l’opzione Passa a parte/Partitura completa. Sibelius cerca sempre di mostrare la parte più 
significativa della selezione, quindi se (ad esempio) si seleziona una nota nella parte del 2° Flauto, 
Sibelius visualizza la parte del 2° Flauto; se non è stata eseguita una selezione (o la selezione con-
tiene oggetti in più di una parte), Sibelius mostra invece la parte più recente visualizzata. Il menu 
indica Passa a Partitura Completa quando si sta guardando una parte e Switch to Part quando 
è aperta l’intera partitura; si può passare dalla partitura alle parti anche con il comando rapido W.

Prossima Parte
Mostra la parte successiva nella partitura corrente aperta; si può usare anche il comando rapido 
Ctrl+Alt+Tab o zX~. Se si sta vedendo l’ultima parte, Sibelius mostra l’intera partitura. 

Parte precedente
Mostra la parte precedente nella partitura corrente aperta; si può usare anche il comando rapido 
Ctrl+Maius+Alt+Tab o xzX~. Se si sta vedendo la prima parte, Sibelius mostra l’intera partit-
ura.

Per maggiori informazioni sull’uso delle parti, b Lavorare con le parti.

Contrai (solo Mac)
Riduce la partitura corrente aperta collocandola sul lato destro del dock (è come cliccare sull’icona 
gialla in alto a sinistra nella finestra della partitura) - comando rapido XM.

Ridimensiona (solo Mac)
Ingrandisce la finestra della partitura corrente aperta (è come cliccare sull’icona verde + in alto a 
sinistra nella finestra della partitura).
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5.21 Creatore Quaderni di Lavoro

v Worksheet Creator.

Gli insegnanti di musica devono sempre arricchire il proprio materiale didattico per svolgere il 
proprio curriculum didattico. Il Creatore di Quaderni di Lavoro (Worksheet Creator) consente di 
scegliere tra oltre 1700 questionari, esercizi, progetti, pezzi di repertorio, poster, materiali di riferi-
mento e altre risorse. Essi sono destinati specificamente ai curriculum delle scuole di Stati Uniti, 
Regno Unito, Australia, Nuova Zelanda e Canada e sono adatti agli studenti di ogni età; parte del 
materiale è utile anche per i livelli di college e università.

Si può realizzare sia un questionario per lo studente che un foglio con le risposte da completare con 
i segni di correzione; è possibile anche creare questionari con domande casuali ogni volta diverse, 
in modo da non esaurire mai il materiale didattico (e tutto in pochi secondi!).

In Worksheet Creator si possono aggiungere anche i propri questionari (in copie personali o di col-
leghi che usano Sibelius) – b Inserire questionari personalizzati.

Usare Worksheet Creator
Per iniziare selezionare File > Creatore fogli di lavoro; appare la seguente finestra di dialogo:

* Scegliere l’opzione Materiali di insegnamento e apprendimento o Modello (Template). Un 
template è un questionario privo di musica da usare come base per la creazione del proprio 
materiale (vedere in seguito).

* Questionari extra, materiale supplementare e molto altro ancora sono disponibili sul sito Sibel-
iusEducation.com che si può visitare cliccando sul pulsante Visita SibeliusEducation.com
nella finestra di dialogo – b SibeliusEducation.com
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* Scegliere la dimensione pagina del questionario da creare (A4 o Lettera).
* Le opzioni Aggiungi al Quaderno di Lavoro definiscono varie altre cose da stampare sul ques-

tionario per lo studente e il foglio con le risposte dell’insegnante; sul foglio dello studente:
% Data odierna: stampa la data in formato 18 Aprile, 2005; questa opzione è disponibile sia 

per il questionario dello studente che per il foglio con le risposte dell’insegnante.
% Spazi per nome studente e classe: stampa delle linee nell’angolo in alto a destra del ques-

tionario ove lo studente scrive il proprio nome e la classe.
* Sul foglio dell’insegnante (quaderno risposte):

% Come completare: stampa un pro-memoria che indica se un determinato lavoro deve essere 
completato su carta, al computer o suonandolo sullo strumento.

% Coinvolgimento Insegnante: stampa un pro-memoria che informa l’insegnante se egli deve 
essere coinvolto nel completamento del lavoro e se deve accedere a Sibelius.

% Dimensioni Gruppo: stampa un pro-memoria che informa se il lavoro è destinato ad essere 
svolto da un singolo, un gruppo ristretto o un gruppo più ampio.

% Livelli Curriculum: stampa i dettagli del curriculum specifico al quale un lavoro è destinato 
(ove questa informazione è disponbile).

Se si prevede di stampare tutto dalle sezioni Risorse, Riferimento, Reperorio selezionato o 
Poster, Schede e Giochi è meglio disattivare tutte queste opzioni.

Avendo scelto Materiali di insegnamento e apprendimento ed eseguite le proprie scelte clic-
care Successivo per restringere la ricerca del tipo di materiale desiderato:

Poiché in Worksheet Creator c’è moltissimo materiale, si può decidere di scegliere solo quello che 
corrisponde a determinati criteri; per esempio, se si vuole trovare materiale adatto a un gruppo di 
studenti invece che a un singolo studente selezionare Materiali per piccoli gruppi e Gruppi di 
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qualsiasi dimensione, quindi cliccare Successivo. Per trovare questionari da completare solo 
usando Sibelius scegliere Possono essere completati Al computer e cliccare Successivo. 

L’opzione Trova per nome file è utile se è già stato stampato un particolare questionario e si vuole 
usarlo ancora; ogni foglio con le risposte dell’insegnante ha il nome file (Nome file:) nell’angolo in 
basso a destra della prima pagina. Digitarlo lì e cliccare Successivo per andare direttamente a 
quell’elemento da stampare di nuovo.

Se è la prima volta dall’installazione di Sibelius che si usa questa funzione, può essere necessario 
un minuto o più a Sibelius per generare un elenco del materiale disponibile.

Appaiono quindi le categorie dalle quali scegliere il materiale desiderato:

Il materiale è suddiviso in 6 categorie principali:

* Elements of music: 14 argomenti fondamentali di teoria e pratica musicale, dalle note ai ritmi, 
dalla lettura a prima vista all’ear training.

* Writing and creating music: notazione, trasporto, arrangiamento, composizione 
e improvvisazione.

* Selected repertoire: oltre 400 pezzi per voce, piano e altri strumenti compresi brani in 14 
lingue diverse e 50 pezzi di Bach per tastiera (ideali per studio, arrangiamento, esecuzione e 
realizzazione dei propri questionari); ci sono anche 45 poesie per gli studenti da musicare.

* Reference: contiene un’enorme libreria d’informazioni musicali, oltre 80 scale e modi per le 
estensioni dei vari strumenti.

* Posters, Flashcards & Games: ha quasi 200 elementi per un aiuto nell’insegnamento dei conc-
etti musicali; gli argomenti vanno da note e tonalità a dozzine di figure degli strumenti.

* UK KS3 & GCSE Projects: ha progetti specifici per il Regno Unito che riguardano esecuzione, 
ascolto e composizione, con argomenti che vanno dalle percussioni Africane alle telenovele!

reference.book  Page 463  Wednesday, April 16, 2008  4:28 PM



5. Funzioni efficaci

464

Per maggiori dettagli sulle categorie, vedere la tabella Categorie che segue.

Tutte le categorie e sub-categorie sono numerate con un prefisso (es. 16 Sight Reading); ciò ne 
facilita l’individuazione nella vasta gamma del materiale fornito, oltre ad indicare il grado di diffi-
coltà del materiale in ogni categoria, dal più elementare al più avanzato.

I numeri alla fine di ogni nome della categoria, es. (8 of 27), indicano quanto materiale nella cat-
egoria corrisponde ai criteri di selezione specificati (indicati vicino alla base della finestra di dial-
ogo). Il numero zero, es. (0 of 27), indica che non ha senso scegliere quella categoria, poiché 
all’interno non c’è niente che corrisponda ai criteri specificati; se ci sono pochi elementi che corri-
spondono e serve una scelta più ampia cambiare i criteri di selezione del materiale cliccando sul 
pulsante Cambia tipo di materiale.

Scegliere la categoria da esplorare, quindi doppio-clic del mouse nell’elenco a sinistra nella finestra 
di dialogo o cliccare Successivo. Appare di nuovo la stessa pagina della finestra, che questa volta 
mostra le sub-categorie contenute nella categoria scelta oltre che il percorso seguito per arrivarci. 
Per tornare alla categoria “genitore” della sub-categoria in cui ci si trova cliccare Precedente.

Quando si arriva all’ultima sub-categoria di una determinata categoria, si può scegliere un ques-
tionario specifico o altro materiale da un elenco:

Scegliendo un elemento dall’elenco, una sua descrizione appare nella parte destra della finestra di 
dialogo. Il campo Descrizione mostra i dettagli su cosa gli studenti devono fare per completare il 
questionario o il lavoro.

Alla base di questa pagina ci sono tre opzioni, abilitate o disabilitate in base al materiale scelto:

* Numero di domande: consente di scegliere il numero di domande da inserire nel questionario 
stampato; questa opzione è disponibile solo se il questionario ha molte domande a disposizione 
da scegliere a caso. È possibile riutilizzare questi questionari, perché anche decidendo d’inserire 
(ad esempio) 10 domande, se in futuro si usa ancora quel questionario, Sibelius ne sceglierà a 
caso altre 10 (sebbene ci possa essere qualche sovrapposizione).
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* Includi riquadro con risposte possibili: è disponibile se si sceglie un questionario basato sulla 
“corrispondenza” di ogni domanda a una serie di possibili risposte.

* Crea anche quaderno risposte: crea un foglio di risposte per l’insegnante (con le risposte già 
inserite per risparmiare tempo durante la correzione) insieme al foglio dello studente; questa 
opzione non è disponibile per materiali come poster, repertorio, ecc.. Si noti che molti question-
ari non hanno singole risposte giuste o sbagliate; in tal caso, il foglio di risposte presenta un 
esempio di risposta possibile, con l’indicazione che le risposte possono variare.

Una volta eseguite le proprie scelte cliccare Successivo per vedere un’anteprima:

Il questionario per lo studente è quello a sinistra; se è disponibile un foglio di risposte e si è scelto 
di crearne uno, esso appare a destra.

Se il questionario non è proprio come si desidera cliccare Precedente una o più volte per tornare 
indietro e rivedere le proprie scelte, altrimenti cliccare Fine per creare il questionario.

Se si è deciso di creare sia il questionario per lo studente che un foglio di risposte, Sibelius crea due 
partiture, che si possono stampare, salvare per il futuro o modificare per realizzare un questionario 
personalizzato.

Rhythm levels (RL1-4) e scale levels (SL1-4)
I vari questionari sono classificati in base a un livello ritmico e di scala (dipende dalla complessità 
di ritmi e scale che contengono); riassumendo, i livelli ritmici sono:

* RL1: tempi in chiave di 2/4 e 3/4, note da 1/8 a 1/2 puntate, pause semplici.
* RL2: anche 4/4, nota intera, note da 1/16, altre pause.
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* RL3: anche 6/8, C (tempo comune), note puntate, ritmi semplici in 6/8, sincopi, Scotch snap, 
altre pause puntate.

* RL4: tutti gli altri tempi in chiave, terzine, ritmi complessi in 6/8.

I livelli scala sono:

* SL1: maggiore, minore naturale (eolia), pentatonica maggiore, pentatonica minore.
* SL2: anche cromatica, ionica esatonica (cioè solo le prime 6 note della scala maggiore).
* SL3: anche minore armonica, minore melodica, dorica, dorica esatonica.
* SL4: anche tutti gli altri modi/scale jazz, scala blues, scala esatonale.

Alcune terminologie delle scale servono solo a livello d’interesse pedagogico personale piuttosto 
che per insegnare i termini agli studenti; i dettagli completi di tutti i livelli sono sul sito www.sibe-
liuseducation.com (Aiuto > SibeliusEducation.com).

Template
Per creare un template vuoto sul quale basare il proprio materiale didattico andare nella prima 
pagina della finestra di dialogo File > Creatore quaderno di lavoro, selezionare l’opzione Tem-
plate e cliccare Successivo; appaiono i template disponibili con un’anteprima di ciascuno:

Scegliere il template da realizzare e cliccare Fine; si crea una partitura che si può modificare o nella 
quale scrivere musica per creare un questionario personalizzato. È possibile anche aggiungere i 
propri questionari a Worksheet Creator per altri impieghi futuri (specialmente per generare ris-
poste casuali) – b Inserire questionari personalizzati.
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Categorie

Categoria principale Contenuto Descrizione

01 Elements of Music 01 Notes & Rests 
02 Dynamics 
03 Timbre & Tone Color 
04 Meter & Tempo 
05 Rhythm 
06 Scales & Key Signatures 
07 Intervals, Chords, Progressions & 

Cadences 
08 Score Analysis, 
09 Conducting 
10 Dictation/Transcription, 
11 Sight Reading 
12 Ear Training 
13 Auditory Discrimination 
14 Aural Recall

Attività organizzate in sequenze d’apprendi-
mento dei concetti fondamentali della musica. 
Introduzione a linguaggio e terminologia 
musicali, sviluppo delle capacità musicali 
principali, introduzione agli aspetti di teoria e 
insegnamento dell’analisi di tonalità, forma e 
struttura, tessitura e stile musicale.

02 Writing and Creating 
Music

01 Notation  
02 Adapting, Transposing & Arranging 
03 Composing 
04 Improvising

Acquisizione delle nozioni elementari di scrit-
tura musicale e una vasta gamma di esplorazi-
one creativa, con un lavoro su suoni, ritmi, 
melodie, accompagnamenti, strutture, parole e 
orchestrazione.

03 Selected Repertoire 01 Bach Piano Repertoire  
02 Other Piano Repertoire 
03 Instrumental Repertoire 
04 Songs for Teaching 
05 Rounds and Canons Collection 
06 Poetry for Lyrics 
07 Texts for Incidental Music 
08 Rhythm Collection

Quasi 500 pezzi di musica e poesia, molti dei 
quali usati nei questionari e tutti disponibili 
per estensioni, altri lavori in classe e creazione 
di questionari personalizzati. Quasi 100 pezzi 
per tastiera inclusi 50 di Bach e frammenti da 
altri maestri; oltre 150 brani, inclusi quasi 50 
rondò e canoni, lavori in 13 lingue e 45 poesie.

04 Reference 01 Encyclopedia of Scales & Modes 
02 Chord Library 
03 Instrumental & Vocal Ranges 
04 US & British Music Terms Compared 
05 Keyboard Handouts

Utile libreria d’informazioni musicali, 80 scale 
e modi e quasi 150 accordi con i rispettivi sim-
boli da usare per ricerca, sperimentazione e 
inserimento in attività creative.

05 Posters, Flashcards & 
Games

01 Posters 
02 Flashcards 
03 Games

Quasi 200 poster, flashcard e giochi per l’inseg-
namento e il ripasso dei concetti musicali. Gli 
argomenti includono note, pause, scale, tonal-
ità, circolo delle quinte, simboli, terminologia, 
notazione stick, e quasi 100 figure di strumenti 
da usare per decorare la classe e preparare il 
materiale didattico.

06 UK KS3 & GCSE Projects 01 African Drumming KS3 
02 Blues (12-bar) KS3 
03 Composing to Create a Specific Mood 

KS3/GCSE 
04 Pop Songs (Reggae) KS3/GCSE 
05 Pop Songs (Dance Grooves) GCSE 
06 Serialism GCSE 
07 Blues (Arranging) GCSE

Sette progetti specifici per il Regno Unito su 
tre argomenti principali di studio – esecuzi-
one, composizione e ascolto – per gli standard 
Key Stage 3 e GCSE con osservazioni complete 
dell’insegnante e idee per eventuali sviluppi.

reference.book  Page 467  Wednesday, April 16, 2008  4:28 PM



5. Funzioni efficaci

468

5.22 Inserire questionari personalizzati

b Creatore Quaderni di Lavoro.

Inserire i propri questionari
Sibelius permette di creare materiale didattico personalizzato “intelligente” e inserirlo in Creatore 
Quaderni di lavoro (nel proprio Sibelius o in quello dei colleghi); si possono creare facilmente par-
titure con domande/risposte e file che generano domande casuali da usare più volte.

Dimensioni e margini pagina
Per realizzare materiale ordinato e leggibile è opportuno ricordare alcune cose quando si configura 
e formatta la partitura.

Si può basare il proprio questionario su un modello già pronto, se ce n’è uno adatto (b Creatore 
Quaderni di Lavoro); in tal caso, scegliere il formato del foglio A4 invece che Lettera (una volta 
inserito il questionario in Creatore Quaderni di lavoro si potrà trasformarlo nel formato Lettera). 
Altrimenti, se si crea un questionario partendo da zero, in Layout > Imposta documento:

* Usare A4 come formato pagina.
* Usare i margini superiore e inferiore di 24 mm e quelli sinistro e destro di 15 mm; questi margini 

compensano le differenze di formato tra A4 e Lettera.
* Usare 12 mm come margine del rigo superiore e 24 mm per il margine del rigo inferiore; questi 

margini lasciano spazio per il testo creato da Creatore Quaderni di lavoro in cima e in fondo alla 
pagina.

Foglio di risposte
Per generare un foglio di risposte dal proprio questionario occorre utilizzare voci adeguate nella 
partitura, in modo che Sibelius possa eliminare una o più voci per togliere le risposte dal foglio 
dello studente. Usare voci diverse per gli elementi che si desidera far apparire solo sul foglio dello 
studente, per gli elementi sul foglio di risposte e per quelli su entrambi i fogli; ad esempio, 
s’immagini un questionario nel quale lo studente deve scrivere il nome di un determinato inter-
vallo sotto il rigo e del quale si desideri stampare anche un foglio di risposte.

* Collocare ogni intervallo in Voce 1 (ad esempio); le note saranno scritte sia sul foglio dello stu-
dente sia su quello delle risposte dell’insegnante. In generale, è meglio usare le Voci 1 e 2 (quelle 
usate normalmente per scrivere musica) per tutto ciò che è destinato a entrambi i fogli.

* Creare la risposta, ad esempio, mediante il testo Lyrics line 1 in Voce 4; in seguito si specificherà 
che gli elementi nella Voce 4 debbano apparire solo sul foglio di risposte dell’insegnante.

* Si può anche inserire una linea sotto ogni intervallo, ove lo studente scriverà l’intervallo stesso. 
Creare le linee orizzontali in Voce 3 (ad esempio). Anche qui, si specificherà in seguito che 
questa voce deve apparire solo sul foglio dello studente.

Domande casuali e fisse
Sono presenti due tipi principali di questionari: quelli con domande casuali e quelli con domande 
fisse. 
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I questionari con domande fisse sono più facili da realizzare, poiché possono essere configurati 
esattamente nel modo in cui si desidera vederli quando escono da Creatore Quaderni di lavoro, ma 
per entrambi i tipi di questionario occorre utilizzare le voci con attenzione.

Se si prevede di realizzare un questionario con domande casuali, non si deve aggiungere alcun 
testo supplementare alla partitura e non è necessario impiegare tanto tempo a regolare il layout 
(perché fa già tutto Creatore Quaderni di lavoro); evitare quindi di mettere un titolo in cima alla 
pagina, numerare le domande o aggiungere un’indicazione per lo studente.

Per realizzare un questionario con domande fisse, occorrerà aggiungere vari altri frammenti di 
testo alla pagina che includano possibilmente:

* Un titolo – nell’esempio indicato può essere “Nominare gli intervalli” in testo Title.
* Un testo che fornisca istruzioni agli studenti – si può creare un testo Technique sopra la prima 

misura della partitura che dice: “Scrivere il nome degli intervalli nei rispettivi spazi”.
* Numerare le domande – ad esempio, inserendo un testo sopra ogni misura con il numero della 

domanda; si può farlo rapidamente con il plug-in Plug-in > Testo > Numera misure.

Creare questi oggetti di testo in Voce 1, in modo che appaiano sia nel foglio dello studente sia in 
quello di risposte dell’insegnante.

Per entrambi i questionari (fisso e casuale) può essere necessario eseguire alcune ulteriori rego-
lazioni di layout. Assicurarsi, ad esempio, che vi sia abbastanza spazio sopra il rigo in alto, in modo 
che Creatore Quaderni di lavoro possa aggiungere la data e lo spazio nel quale lo studente scrive il 
proprio nome e la classe; può essere utile anche lasciare spazi vuoti tra ogni domanda, selezio-
nando una misura e digitando (ad esempio) 4 nel campo Gap before bar nel pannello Bars della 
finestra Properties. Si può anche forzare un numero particolare di misure per sistema, usando i 
break di sistema automatici (Layout > Layout automatico).

Una volta inseriti i testi e regolato il layout, si può inserire il proprio questionario in Creatore 
Quaderni di lavoro.

Usare le idee nei questionari
La funzione Idee di Sibelius può essere uno strumento molto potente per la realizzazione di eser-
cizi e questionari per gli studenti – b Idee.

Le idee si possono prelevare dalla libreria interna di Sibelius (ne ha oltre 1500), oppure si può 
prendere una propria idea creata in qualsiasi partitura. Si può salvare un particolare set di idee in 
una partitura e impedire agli studenti di usare idee diverse da quelle salvate nella partitura (è utile 
per fare in modo che gli studenti realizzino una composizione usando solo idee appositamente 
scelte dall’insegnante). Per maggiori dettagli, Accesso limitato alla libreria a pagina 368.

Per informazioni più generali su come usare le idee a scopo didattico vedere Usare le idee per 
insegnare a pagina 370.
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Inserire un questionario in Creatore Quaderni di lavoro
Una volta creato un questionario, per inserirlo in Creatore Quaderni di lavoro selezionare File >
Aggiungi al Creatore Quaderni di lavoro:

* Innanzitutto, scegliere il tipo di materiale che si sta inserendo; per aggiungere un modello selez-
ionare Modello (Template) e cliccare su OK, altrimenti scegliere Materiali di insegnamento 
e apprendimento.

* Passare sulla parte destra della finestra di dialogo e scegliere l’opzione Domande Random o 
Domande Fisse; questa scelta influenza i campi disponibili nel resto della finestra.

* Nome (nel riquadro): è il nome che appare in Creatore Quaderni di lavoro; mantenerlo il più 
corto possibile.

* Titolo (in partitura): è la dicitura che Sibelius crea come titolo nella partitura se è stata scelta 
l’opzione Domande Random (scegliendo Domande Fisse, si deve scrivere il titolo nella partit-
ura prima di aggiungerlo).

* Descrizione (insegnante): è il testo che appare in Creatore Quaderni di lavoro per descrivere il 
questionario.

* Istruzioni (studente): è quello che Sibelius crea sopra la prima domanda nel questionario dello 
studente se si sceglie l’opzione Domande Random (scegliendo Domande Fisse si devono scri-
vere le istruzioni per lo studente nel questionario prima di aggiungerlo a Creatore Quaderni di 
lavoro).

* Livello Curriculum: deve contenere informazioni sul curriculum specifico al quale è destinato il 
questionario (se pertinente).

* Eseguire una selezione in Può essere completato per specificare il metodo (o i metodi) di 
svolgimento del questionario.

* Scegliere il livello di coinvolgimento dell’insegnante desiderato (Coinvolgimento Insegnante).
* Specificare la dimensione del gruppo al quale è destinato il questionario (Dimensione gruppo).
* L’opzione Misure per domanda è disponibile solo scegliendo Domande Random e dice a Sibe-

lius quante misure occupa ogni domanda: è molto importante impostarla correttamente.
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* L’opzione Domande per accollatura indica a Sibelius il layout ideale del questionario; se le 
domande sono lunghe 1, 2 o 4 misure, lasciare questa opzione su Default, altrimenti occorre 
impostarla per istruire Sibelius sul numero di domande consentite su un sistema, prima 
dell’inserimento di un break di sistema.

* Voci mostrate su quaderno studente: specifica quali voci Sibelius deve lasciare nel question-
ario dello studente (nell’esempio precedente bisognerà inserire 1 e 3).

* Quaderno risposte: determina se Sibelius deve offrire o meno la possibilità di realizzare un 
foglio di risposte per il proprio questionario; attivando la funzione, si dovrà anche specificare 
l’opzione Voci mostrate su quaderno studente (nell’esempio precedente occorrerà inserire 1
e 4).

* Infine, scegliere dove collocare il questionario in Creatore Quaderni di lavoro. Utilizzare i pul-
santi Scegli e Indietro per scorrere le categorie; una volta trovata la destinazione desiderata clic-
care su OK per inserire il proprio questionario.

Modificare i questionari
Per creare una nuova categoria o modificare un questionario inserito in precedenza, si utilizza la 
finestra di dialogo Modifica Fogli di Lavoro che si apre cliccando sul pulsante Modifica nella 
finestra Aggiungi al Creatore Quaderni di lavoro o selezionando File > Modifica fogli di 
lavoro:

Le opzioni a sinistra nella finestra riguardano categorie e sottocategorie, invece che i file dei ques-
tionari veri e propri:

* Selezionare Materiali di insegnamento e apprendimento o Modello in cima alla finestra per 
scegliere tra due tipi di contenuto.

* I pulsanti Scegli e Indietro consentono di scorrere l’elenco delle categorie a sinistra nella 
finestra (come nella finestra Aggiungi al Creatore Quaderni di lavoro).
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* I pulsanti Sposta in su e Sposta in giù consentono di spostare la sottocategoria selezionata in 
alto e in basso, seguendo l’ordine all’interno della categoria corrente.

* Il pulsante Aggiungi consente di inserire una nuova sottocategoria: cliccare sul pulsante per 
sceglierne il nome.

* Il pulsante Rinomina consente di rinomina la sottocategoria selezionata.
* Il pulsante Cancella consente di rimuovere permanentemente la sottocategoria selezionata e 

tutte le altre sottocategorie e questionari che essa contiene; utilizzare questa opzione con attenzi-
one!

* Il pulsante Importa consente di importare una categoria di materiale proveniente dall’esterno, 
ad esempio, scaricata dal sito SibeliusEducation.com (b SibeliusEducation.com).

* Il pulsante Esporta consente di esportare la categoria selezionata e le rispettive sottocategorie e 
questionari di una nuova cartella nella cartella Scores, da condividere con i colleghi, che potr-
anno importarla (con il pulsante Importa).

Le opzioni nella parte destra della finestra di dialogo riguardano i questionari e i modelli veri e 
propri (l’elenco ha elementi solo quando si trova una sottocategoria contenente i questionari).

* I pulsanti Sposta Su e Sposta Giù consentono di spostare la sottocategoria selezionata in alto e 
in basso seguendo l’ordine all’interno della categoria corrente.

* Il pulsante Modifica Dettagli consente di aprire la finestra di dialogo Modifica Dettagli 
Attività, nella quale si possono modificare le impostazioni definite quando è stato esportato il 
questionario; le opzioni in Modifica dettagli Fogli di lavoro sono le stesse di quelle presenti 
nella finestra Aggiungi al Creatore Quaderni di lavoro, tuttavia non è possibile cambiare da 
questionario a modello o viceversa – vedere Inserire un questionario in Creatore Quad-
erni di lavoro.

* Il pulsante Apri Partitura consente di aprire la partitura del questionario scelto, in modo che si 
possa modificare il materiale in esso contenuto o le risposte, ecc.. Una volta terminata la modi-
fica della partitura, salvarla e chiuderla – non è necessario inserirla ancora in Creatore Quaderni 
di lavoro.

* Il pulsante Rinomina consente di ridenominare il questionario selezionato, modificando il con-
tenuto del campo Nome (nel riquadro).

* Il pulsante Cancella consente di rimuovere permanentemente il questionario selezionato; uti-
lizzare questa opzione con attenzione!

Al termine delle modifiche cliccare sul pulsante Chiudi.
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Parti

6.1 Lavorare con le parti

v Parti dinamiche.

In genere, la musica per più strumenti è scritta sia in una partitura completa che su “parti” sepa-
rate, ciascuna con la musica di un solo strumento (o più). Le parti sono piuttosto diverse dalle par-
titure complete (hanno solo la notazione riferita allo strumento specifico); le parti per strumenti 
trasportati possono essere in tonalità diverse e la musica è distribuita in modo diverso (spesso su 
fogli di grandezza diversa). Fortunatamente, Sibelius si occupa di tutto ciò formattando, 
trasportando e distribuendo automaticamente le parti.

Cosa sono le parti dinamiche?
In programmi di notazione musicale bisogna “estrarre” le parti di ogni strumento in file separati; 
per modificare l’intera partitura (dopo una prima prova, ad esempio) si devono quindi eseguire le 
stesse modifiche nelle parti (oppure estrarle di nuovo, perdendo ore di lavoro!).

Sibelius utilizza un approccio rivoluzionario, per cui ogni modifica eseguita nella partitura è appli-
cata automaticamente alla parte, e viceversa: si tratta delle parti dinamiche™.

Le parti dinamiche si modificano come una partitura; è possibile spostare, inserire e cancellare 
note, aggiungere legature, segni d’espressione, ecc. (come si fa normalmente) ma ogni volta che si 
cambia qualcosa nella partitura le parti sono aggiornate automaticamente, e viceversa. 
Non è necessario estrarre le parti dinamiche (esse infatti sono conservate nello stesso file della par-
titura completa), quindi è anche più facile organizzarle.

Vedere le parti dinamiche
Una volta creato o aperto un file di Sibelius è visualizzata l’intera partitura. Per passare alle/dalle 
parti è più semplice usare l’elenco a tendina Partitura completa sulla toolbar; cliccandoci sopra 
appare un elenco che inizia con la partitura completa e continua con i nomi di tutte le parti. Clic-
cando sul nome della parte che si desidera vedere Sibelius la apre in una nuova finestra. 

Si può anche passare subito dalla partitura alla parte visualizzata più di recente cliccando sul pul-
sante Passa tra Partitura completa e Parte nella toolbar  (comando rapido W). Se prima di 
usare il pulsante Passa tra Partitura completa e Parte si seleziona una nota o un altro oggetto 
del rigo, Sibelius mostra la parte che lo contiene; se non è selezionato niente, Sibelius mostra la 
parte visualizzata più di recente; si può anche passare a una parte con un doppio-clic del mouse su 
di essa nella finestra Parts (vedere in seguito).

È possibile anche scorrere le parti con il comando Finestra > Prossima parte e Parte precedente 
(comandi rapidi Ctrl+Alt+Tab o zX~ e Maius+Ctrl+Alt+Tab o xzX~). Una volta arrivati 
all’ultima parte, avanzando alla successiva Sibelius mostra l’intera partitura.

Vedere più parti
Di default, Sibelius crea solo due finestre per ogni partitura: una per l’intera partitura e l’altra per le 
parti; selezionando le parti, Sibelius riutilizza sempre la finestra che mostra la parte visualizzata in 
precedenza. Se si preferisce che Sibelius crei una finestra separata per ogni parte (per vederle 
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sovrapposte su uno schermo grande) attivare l’opzione Visualizza parti in nuove finestre nella 
pagina Altro della finestra File > Preferenze (menu Sibelius in Mac) - comando rapido Ctrl+, o
X,.

Distinguere la partitura da una parte
Sibelius usa diverse strutture di foglio e desk per partiture e parti, in modo da renderle immediata-
mente distinguibili; di default, Sibelius mostra le parti su foglio color crema e la partitura su foglio 
bianco; per cambiare l’aspetto di queste strutture usare la pagina Textures della finestra File >
Preferenze (menu Sibelius in Mac) – b Impostazioni visive.

Finestra Parti
La finestra Parti permette di stampare, creare, modificare, cancellare ed estrarre parti. Non si usa 
spesso questa finestra (poiché, ad esempio, è possibile stampare le parti con il comando File >
Stampa o File > Stampa tutte le parti) quindi in genere la si lascia chiusa; per aprirla, tuttavia, 
selezionare Finestra > Parti (Ctrl+Alt+R o zXR) o cliccare sul rispettivo pulsante nella toolbar. 

Simile all’elenco a tendina sulla toolbar, questa finestra presenta un elenco di tutte le parti presenti 
nella partitura; per scegliere una parte dalla finestra Parti doppio-clic del mouse sul nome della 
parte da visualizzare.

È possibile applicare alcune modifiche a più parti nello stesso momento. Per selezionare una sin-
gola parte, cliccare sul suo nome; per selezionare più parti, Ctrl+clic o X-clic per aggiungere una 
parte alla selezione o Maius-clic per estendere la selezione.

Una volta selezionata una o più parti, si può cliccare su uno qualsiasi dei pulsanti situati alla base 
della finestra:

* Stampa Parte(i): stampa le parti correnti selezionate; la colonna Copie permette di specificare 
quante copie stampare di ogni parte – vedere Stampare più parti.

Numero di copie da 
stampare (cliccare 
per la modifica).

Nome della parte 
(cliccare per la 
modifica).

Stampa
Parte(i)

Aspetto di più parti

Nuovo

Righi nella parte

Elimina Estrai

Copia layout
della parte
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* Aspetto parte multipla: Sibelius chiede se modificare tutte le parti presenti nella partitura o 
solo quelle correnti selezionate, dopodichè consente di modificare l’aspetto di tutte le parti scelte 
con una singola operazione – b Finestra Aspetto parte multipla

* Copia layout della parte: copia il layout della parte corrente visualizzata sulla parte(i) selezio-
nata nella finestra Parts – vedere Copiare il layout della parte a pagina 483

* Nuova parte: consente di creare manualmente dalla partitura completa una nuova parte, conte-
nente un numero qualsiasi di righi.

* Righi nella parte: usare questa opzione per inserire o togliere righi da una parte (funziona solo 
con una singola selezione).

* Cancella parte/i: rimuove la parte(i) corrente selezionata.
* Estrai parti: estrae le parti in file separati di Sibelius – b Estrarre le parti.

Stampare più parti
Stampando una partitura orchestrale, di solito serve una copia per la parte del primo Flauto, ma 
molte più copie per la parte del primo Violino (da distribuire a tutti gli orchestrali). Sibelius con-
sente di definire il numero desiderato di copie da stampare per ogni parte. Selezionare la parte 
nella finestra Parts e cliccare una volta nella colonna Copie; appare un cursore: digitare il numero 
di copie (può essere un numero qualsiasi tra 0 e 99).

Poiché Sibelius consente di specificare un numero di copie per ogni parte, la stampa di un set com-
pleto di parti può essere eseguita davvero con due clic del mouse; si può stampare qualsiasi combi-
nazione di parti con una sola operazione di stampa.

Per stampare tutte le parti selezionare File > Stampa tutte le parti. Per stampare solo alcune parti 
selezionare la parte(i) nella finestra Parti e cliccare sul pulsante Stampa Parte(i) ( ). Altrimenti 
si può stampare una singola parte al solito modo con il comando File > Stampa; stampando più di 
una parte non è possibile regolare i valori d’intervallo pagina o numero copie nella finestra di dial-
ogo Stampa.

Le parti si possono stampare direttamente in file PDF comodi da spedire via e-mail. In Windows, 
per usare questa funzione si deve installare il driver di stampa PDF (vedere Creare file PDF a 
pagina 597). Su Mac cliccare Registra come PDF nella finestra di dialogo Stampa. Sia in Win-
dows che su Mac, Sibelius salva automaticamente ogni parte in un file PDF scegliendo un nome 
file adeguato.

Creare nuove parti
Sibelius crea automaticamente una parte per ogni strumento nella partitura; quando si apre una 
partitura creata in Sibelius 3 o precedenti, si ha la possibilità di scegliere se creare o meno un set di 
parti (b Aprire i file di versioni precedenti). 

Se per qualsiasi ragione si deve aggiungere manualmente un’altra parte nella partitura cliccare sul 
pulsante Nuova parte ( ) nella finestra Parti. Appare una finestra di dialogo in cui si può sceg-
liere quale dei righi disponibili nella partitura rendere visibile nella nuova parte; è identica alla 
finestra di dialogo Righi nella parte (vedere in seguito).
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Aggiungere o rimuovere righi dalle parti
Sibelius permette d’inserire un numero o combinazione di righi qualsiasi dalla partitura in una 
parte; per esempio, si può realizzare la partitura vocale di un’opera creando una parte con tutti i 
cantanti e un’accompagnamento di tastiera.

Per farlo, assicurarsi che la partitura completa contenga tutti gli strumenti che servono, inclusi i 
righi di tastiera. Tuttavia, in genere, le riduzioni dei righi di tastiera non sono stampate nella parti-
tura del direttore, quindi (così come per la parte della partitura vocale) si dovrà creare una parte 
per la partitura del direttore che contenga tutti gli strumenti tranne l’accompagnamento di tasti-
era; quando si stampano le partiture, stampare la parte “partitura del direttore” e la parte “partit-
ura vocale” invece della partitura completa.

Per cambiare i righi in una parte esistente selezionare la parte e cliccare sul pulsante Righi nella 

parte ( ) nella finestra Parti; appare la seguente finestra di dialogo:

L’elenco Righi disponibili a sinistra indica i righi disponibili nella partitura completa non conte-
nuti nelle parti; quando un rigo è stato aggiunto a una parte appare nell’elenco Righi nella parte a 
destra. Per aggiungere righi a una parte selezionare i rispettivi righi nell’elenco a sinistra e cliccare 
sul pulsante Aggiungi alla Parte. Analogamente, per rimuovere i righi da una parte, selezionarli 
nell’elenco a destra e cliccare sul pulsante Rimuovi dalla Parte (non si rimuove lo strumento dalla 
partitura).

Aggiungendo o rimuovendo un rigo (o più righi) da una parte, si resetta la spaziatura nota 
dell’intera parte, per garantire che sia uniforme dall’inizio alla fine della parte.

Cancellare le parti

Per cancellare una parte, selezionarla nella finestra Parti e cliccare sul pulsante Cancella ( ). 
Sibelius chiede una conferma prima di procedere; per cancellare più di una parte alla volta cliccare 
sul pulsante Cancella con una selezione multipla. Cancellando una parte non si elimina il rispet-
tivo strumento dalla partitura.

Tuttavia, non c’è problema ad avere parti elencate anche se non s’intende usarle, quindi non farsi 
alcun scrupolo di cancellare parti indesiderate.
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Aspetto di parti e partitura
Alcuni elementi sono sempre uguali nella partitura e in tutte le parti – non importa quindi se si sta 
vedendo la partitura o una parte; cambiando uno di questi elementi esso cambia ovunque:

* Stili di testo: è possibile impostare diverse dimensioni dei caratteri nella partitura completa e per 
tutte le parti in Modifica stili testo.

* Posizioni di default: analogamente, esse si possono impostare in modo diverso nella partitura 
completa e nelle parti con la finestra Posizioni di Default.

* Molti criteri in House Style > Regole tipografia (es. la posizione di alterazioni, punti ritmici, 
articolazioni, parentesi, chiavi, tonalità, gruppi irregolari; aspetto di stanghette, diagrammi 
accordo, forcine, segni di prova, legature di valore e portamento; posizioni dei tratti d’unione; 
dimensione delle note; bordi testuali e opzioni per le parole).

Tuttavia, gli elementi seguenti devono essere impostati per ogni parte in modo abbastanza 
indipendente da altre parti e dalla partitura, quindi modificandoli s’influenza solo la parte (o la 
partitura) che si sta vedendo:

* Dimensione pagina e rigo, ecc. (in Layout > Imposta documento).
* Layout, compresi i break e la funzione Layout > Auto Layout.
* Spaziatura nota (inclusa l’opzione House Style > Regola spaziatura note).
* Dimensione dei testi (vedere Stili di testo nelle parti on page 482).
* Alcuni criteri nella finestra House Style > Regole tipografia (es. formato dei numeri misura, 

pause multiple, nomi strumento, tempi in chiave; aspetto dei separatori di sistema; numero sulla 
prima pagina; spaziatura rigo e sistema).

* Aspetto di timecode e hit point (Play > Video e Tempo > Timecode e Durata e Hit Points).

È utile poter cambiare elementi in parti diverse in modo indipendente gli uni dagli altri. Tuttavia, 
spesso è utile anche eseguire le stesse modifiche in tutte le parti o in un gruppo di parti contempo-
raneamente piuttosto di doverlo fare a turno in ogni parte; la finestra di dialogo Aspetto parte 
multipla serve proprio a questo – b Finestra Aspetto parte multipla.

reference.book  Page 479  Wednesday, April 16, 2008  4:28 PM



6. Parti dinamiche

480
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La modifica di una parte è esattamente uguale a quella di una partitura; in pratica, quasi tutto ciò 
che si può fare in una partitura è possibile farlo in una parte; creando e cancellando oggetti in una 
parte avviene lo stesso nella partitura e viceversa.

Spostare gli oggetti nelle parti
Lo spostamento di oggetti (a parte la modifica d’altezza delle note) è però un’altra cosa. È possibile 
posizionare elementi in modo leggermente diverso nella partitura e nella parte (per motivi di lay-
out e per evitare collisioni che possono esserci in una, ma non nell’altra); i criteri sono:

* Spostando un oggetto nella partitura, esso si sposta anche nella rispettiva parte(i), come è logico 
che sia.

* Se però si sposta un oggetto in una parte, esso non si sposta nella partitura; lo stesso vale per la 
modifica della forma di un oggetto – trascinando con il mouse il centro di una legatura per 
modificarne la forma nella parte, essa non cambia nella partitura. Ciò consente di eseguire rego-
lazioni finali alle parti senza influenzare la partitura; l’oggetto si colora in arancione nella parte, 
per indicare che è diverso da come appare nella partitura (vedere Differenze nelle parti).

* Avendo spostato in questo modo un oggetto in una parte, spostandolo nella partitura non lo si 
sposterà ancora nella parte (perché questo metterebbe in disordine la parte proprio quando il 
suo aspetto è ideale) – a meno che non lo si sposti così lontano da farlo attaccare a una nota 
diversa (altrimenti partitura e parte non corrisponderebbero affatto) oppure non si ripristini 
l’oggetto in modo che si trovi nuovamente nella parte e nella partitura (vedere Ripristinare gli 
oggetti nelle parti).

* Non spostare troppo lontano un oggetto in una parte (es. a una nota diversa), perché non si 
sposterà nella partitura e quindi non corrisponderà alla partitura stessa; facendolo, la linea 
d’attaccamento grigia diventa rossa, per avvisare che l’oggetto è troppo lontano dalla sua posiz-
ione nella partitura.

In generale, quindi, il metodo di lavoro ideale consiste nell’inserire la musica nella partitura, invece 
che nelle parti; si modificherà poi posizione e forma degli elementi nelle parti nel corso delle rego-
lazioni finali.

Si noti, però, che nelle parti è possibile eseguire piuttosto liberamente modifiche di layout, come 
spostare righi, regolare break di sistema e pagina, cambiare la spaziatura nota – ciò non equivale a 
spostare gli oggetti, perché non importa se partitura e parte hanno layout leggermente diversi.

Differenze nelle parti
Modificando o spostando un oggetto in una parte, Sibelius mostra che si diversifica rispetto alla 
partitura colorandolo in arancione (per evitarlo, disattivare l’opzione Vista > Differenze nelle 
parti).

Per esempio:

* Gli oggetti del rigo (es. testi Expression, forcine, alterazioni, ecc.) appaiono in arancione se sono 
stati spostati nelle parti.

* Le note capovolte o fatte diventare “cue-sized” nelle parti appaiono in arancione.
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* Gli oggetti visibili nelle parti ma nascosti (o assenti) nella partitura (o viceversa) sono arancioni.

Attivando l’opzione Vista > Differenze nelle parti nella partitura completa, Sibelius colora tutti gli 
oggetti spostati o modificati in una o più parti. È facile quindi, ad esempio, vedere su quali oggetti 
si potrebbe usare il comando Layout > Ripristina su posizione partitura (vedere sotto).

Ripristinare gli oggetti nelle parti
Si può ripristinare la posizione di un oggetto in una parte alla sua posizione di default o alla stessa 
posizione che ha nella partitura.

* Per ripristinarlo alla posizione di default (cioè ai valori definiti in House Style > Posizioni di 
default) selezionare Layout > Ripristina posizione (comando rapido Ctrl+Maius+P o xXP).

* Per ristabilire di nuovo la posizione di un oggetto nella partitura selezionare Layout > Ripristina 
su posizione partitura (Ctrl+Maius+Alt+P o xzXP); se è attiva l’opzione Vista > Differenze 
nelle parti l’oggetto non si colora più in arancione.

Quando si modifica l’intera partitura, si può usare il comando Layout > Ripristina su posizione 
partitura per ripristinare un oggetto alla posizione nella partitura in tutte le parti nelle quali 
appare.

Si può anche ripristinare l’aspetto di un oggetto in una parte (come una legatura) alla sua forma di 
default, oppure a quella che ha nella partitura: 

* Per riportare uno o più oggetti alla forma di default selezionare Layout > Ripristina aspetto
(comando rapido Ctrl+Maius+D o xXD).

* Per ripristinare nuovamente la forma dello stesso oggetto nella partitura, selezionare Layout > 
Ripristina su aspetto della partitura (comando rapido Ctrl+Maius+Alt+D o xzXD); 
anche in questo caso, l’oggetto non sarà più arancione (a meno che non si sia cambiata anche la 
sua posizione).

Come per la rimemorizzazione della posizione nella partitura, selezionando Layout > Ripristina 
su aspetto della partitura mentre si modifica l’intera partitura si ripristina nuovamente la forma 
dell’oggetto selezionato all’aspetto della partitura in tutte le parti nelle quali appare.

Mostra e nascondi in parti e partitura
Tranne alcuni casi (come i cambi chiave e i passaggi introduttivi), di default ogni oggetto è visibile 
sia nella partitura sia nelle parti nelle quali è contenuto; per nascondere un oggetto nella partitura 
in modo che appaia solo in una parte, selezionarlo (nella partitura o nella parte) e scegliere 
Modifica > Mostra o Nascondi > Mostra nelle parti. Analogamente, per far apparire un oggetto 
solo nella partitura completa e non nelle parti, selezionare Modifica > Mostra o Nascondi >
Mostra nella partitura.

Vedendo l’intera partitura e selezionando Modifica > Mostra o Nascondi > Nascondi si nasconde 
l’oggetto nella partitura e in tutte le parti; quando si vede una parte, scegliendo Modifica > Mostra 
o Nascondi > Nascondi si nasconde l’oggetto solo in quella parte, lasciando inalterata la partitura; 
se necessario, è possibile nascondere/mostrare gli oggetti in singole parti nella pagina Generale
della finestra Proprietà.
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Modificare i nomi delle parti
I nomi delle parti si possono modificare direttamente nel campo Name della finestra Parts, 
oppure nella finestra di dialogo File > Info su partitura quando si vede una parte; per la modifica 
dalla finestra Parts, scegliere la parte da rinominare e cliccare una volta nella colonna Name. 

Appare un cursore che consente di digitare il nuovo nome per la parte; modificando il nome della 
parte se ne aggiorna anche il nome sulla prima pagina e quelle successive della parte. 

Per inserire dei break di linea al nome di una parte, in modo da elencare più strumenti su linee 
separate nell’intestazione pagina usare \n\. Si può anche dire a Sibelius di usare il font di testo 
musicale per i singoli caratteri facendo precedere il carattere al quale cambiare font dal segno ^
(es. scrivendo Clarinetto in SI^b apparirà “Clarinetto in SIb”) – per i dettagli su altri caratteri spe-
ciali che si possono digitare, Aggiungere le modifiche formattate alla finestra Info su 
partitura a pagina 227.

Per altre informazioni sui nomi delle parti, vedere Nome parte e cambi strumento a 
pagina 225; per informazioni più generali sui nomi degli strumenti, b Nomi strumento.

Stili di testo nelle parti
In Sibelius ogni stile di testo ha due dimensioni: una per la partitura e l’altra per tutte le parti. 
Per cambiare la dimensione del testo nelle parti in modo indipendente dalla partitura cliccare su 
Modifica stili testo nel menu House Style o nella pagina House Style della finestra Aspetto 
parte multipla. Appare la finestra di dialogo Modifica Stili di testo; selezionare il nome dello 
stile di testo da modificare e cliccare su Modifica. Si apre la seguente finestra di dialogo:

Per regolare la dimensione dello stile di testo nelle parti, inserire una nuova dimensione punto in 
valore (rel. al rigo da 7 mm) o (assoluto). Se non si desidera scalare il testo in base alla dimen-
sione del rigo attivare l’opzione Assoluto; per maggiori informazioni sulla modifica degli stili di 
testo, b Modifica stili di testo.

Per far apparire il testo in dimensioni diverse su partitura e parti (consigliabile, ad esempio, per il 
testo Title, il quale di solito è più grande nella partitura che nelle parti) non regolarne mai la 
dimensione con il pannello Testo della finestra Proprietà; qualsiasi modifica sulla dimensione di 
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un oggetto di testo in questo modo influenza sia la partitura sia la parte! Bisogna invece cambiare 
le dimensioni di default dello stile di testo nella finestra House Style > Modifica stili testo.

Se s’incontra un testo troppo grande sulla partitura o nella parte, probabilmente ne è stata modifi-
cata la dimensione con la finestra Proprietà; selezionarlo e scegliere Layout > Ripristina aspetto
(Ctrl+Maius+D o zXD), quindi andare nella finestra House Style > Modifica stili testo e 
definire dimensioni adeguate per la partitura e le parti.

Cambi di chiave nelle parti
Sibelius consente di creare cambi di chiave in parti che non appaiono nella partitura completa; tali 
chiavi sono colorate in arancione (se è attiva l’opzione Vista > Differenze nelle parti). Attenzione, 
però: se la chiave iniziale nella parte è diversa da quella iniziale dello strumento nell’intera partit-
ura, l’opzione Ometti cambi chiave nella pagina House Style della finestra Aspetto parte 
multipla (b Finestra Aspetto parte multipla) può impedire che appaiano i nuovi cambi 
chiave che si creano nella parte; in tal caso, Sibelius genera un messaggio d’avviso.

Attenzione, inoltre, che se nella partitura completa c’è un cambio chiave visibile nella parte, trasci-
nando con il mouse la chiave nella parte essa si sposta anche nella partitura; per spostare una chi-
ave nella parte senza spostarla nella partitura, creare una nuova chiave nella parte appena sopra 
quella esistente; questa nuova chiave è indipendente in quella parte specifica, quindi può essere 
spostata in modo indipendente da quella nella partitura completa.

Segni di Coda nelle parti
Sibelius consente di stabilire se una divisione nel sistema (che di solito appare prima di una coda) 
deve apparire anche nella parti. Una coda è segnata come tale da una stanghetta che ha l’opzione 
Dividi multipausa attiva e un valore Spazio prima della misura superiore a 0. (Scegliendo 
Layout > Interruzioni > Dividi accollatura, Sibelius lo fa automaticamente – b Ripetizioni). 
Per fare in modo che il sistema si divida automaticamente alla stessa posizione nelle parti, attivare 
l’opzione Mantieni margine prima delle code (con battute d'aspetto divise) nella pagina 
Layout della finestra Aspetto parte multipla; per evitare la divisione nelle parti, disattivarla – 
b Finestra Aspetto parte multipla.

Copiare il layout della parte
In alcuni tipi di musica – specialmente quella per film, TV e musical – il layout di tutte le parti 
strumentali è molto simile, con break di sistema e cambi pagina alla stessa posizione in tutte le 
parti. In Sibelius è facile copiare il layout da una parte a una o tutte le altre:

* Innanzitutto, regolare il layout di una delle parti, inclusi il posizionamento verticale degli oggetti 
di sistema (segni di prova, segni tempo e così via), fino a quando sono configurati come si desid-
era anche per le altre parti.

* Mentre si vede la parte dalla quale copiare il layout:
% Per copiare il layout su tutte le altre parti, cliccare sul pulsante Copia layout della parte

( ) con tutte (o nessuna) le parti selezionate nella finestra.
% Per copiare il layout su una o più parti, selezionare le parti da aggiornare e cliccare sul pul-

sante Copia layout della parte.
* Sibelius chiede se si desidera continuare: cliccare su Sì.
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Il layout della parte corrente è copiato immediatamente sulle parti selezionate; dimensione pagina 
e rigo, orientamento, margini pagina e rigo, break di sistema, pagina e break speciali di pagina, 
impostazioni Layout > Auto Layout e le posizioni degli oggetti di sistema sono tutti aggiornati in 
modo da corrispondere alla parte scelta.

Esportare stili house dalle parti
Una volta configurato l’aspetto di una parte nelle finestre di dialogo Aspetto parte multipla, 
Auto Layout e Regole tipografia è possibile esportarne lo stile house (per importarlo in altre 
parti nella stessa partitura o in parti di un’altra partitura in futuro).

Per esportare uno stile house da una parte, assicurarsi di vedere quella parte e selezionare House 
Style > Esporta House Style.

Per importare lo stile house in altre parti nella stessa partitura (o in un’altra) selezionare quelle 
parti nella finestra Parts, cliccare sul pulsante Aspetto parte multipla e cliccare su Importa 
House Style nella pagina House Style della finestra di dialogo. 

Quando si esporta uno stile house da una parte, esso comprende le impostazioni Auto Layout e 
Imposta documento che lo fanno apparire come una parte; lo stile house, quindi, si può impor-
tare solo in altre parti, non in un’intera partitura; analogamente, esportando uno stile house da 
un’intera partitura non si può importarlo nelle parti. Bisogna quindi esportare stili house diversi 
per intere partiture e per le parti.

Parti in trasporti diversi
Può essere necessario avere la stessa parte trasportata per più strumenti (es. nelle bande di fiati 
alcune parti di ottoni possono essere in SIb e MIb, dipende dagli strumenti disponibili); farlo in 
Sibelius è molto semplice:

* Creare anzitutto una nuova parte contenente lo strumento per il quale si deve realizzare una 
parte trasportata – vedere Creare nuove parti a pagina 477

* Cambiare il nome della parte, in modo da poterlo trattare a parte, per esempio 1st Horn (Eb) – 
vedere Modificare i nomi delle parti.

* Visualizzare ora la parte con un doppio-clic del mouse sul suo nome nella finestra Parts o sceg-
liendolo dal menu sulla barra degli strumenti.

* Per cambiare il trasporto della parte, assicurarsi che in essa non vi sia nulla di selezionato (pre-
mere Esc) e scegliere Crea > Altro > Cambio strumento. Scegliere la variante dello strumento 
con il trasporto desiderato e cliccare su OK, quindi cliccare all’inizio del primo rigo della parte 
per crearlo; questo cambio strumento esiste solo in questa parte (non influenza l’intera partitura 
e nessuna delle altre parti).

* Bisogna anche cambiare la tonalità usata dalla nuova parte trasportata. Anche qui assicurarsi 
che non sia selezionato nulla (premere Esc), scegliere Crea > Alterazioni in chiave (comando 
rapido K), selezionare la tonalità desiderata e cliccare su OK, quindi cliccare all’inizio della parte. 
Come per il cambio strumento, questa tonalità esiste solo in questa parte.

* Infine, per trasporti estremi, regolare la chiave; con nulla di selezionato, scegliere Crea > Chiave
(comando rapido Q), selezionare la chiave desiderata, cliccare su OK e cliccare all’inizio della 
parte; possono essere necessari altri cambi di chiave – vedere Cambi di chiave nelle parti.
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Sebbene non capiti spesso, è possibile anche creare cambi di strumento, chiave e tonalità a un 
punto qualsiasi in una parte dinamica senza influenzare l’intera partitura o una delle altre parti 
basate sullo stesso strumento nella partitura. Attenzione! Aggiungendo una tonalità a una parte, 
s’influenza solo la parte sulla quale si lavora (non la si crea nell’intera partitura); per avere un cam-
bio di tonalità nell’intera partitura e in tutte le parti, crearlo nell’intera partitura.
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6.3 Finestra Aspetto parte multipla

La finestra di dialogo Aspetto parte multipla serve per modificare l’aspetto di un numero qual-
siasi di parti con una sola operazione; innanzitutto selezionare la parte(i) da modificare nella 
finestra Parti , poi cliccare sul pulsante .

Modificando l’aspetto di più parti, ci possono essere casi in cui alcune impostazioni sono diverse 
nelle varie parti; in tal caso, esse appaiono vuote. Se in questa condizione non si eseguono modi-
fiche alle impostazioni i singoli valori di ciascuna delle parti nella selezione restano invariati.

La finestra di dialogo è costituita da tre pagine:

Pagina Impostazioni Documento
La pagina Impostazioni documento permette di definire dimensione pagina, orientamento e 
dimensione rigo delle parti: 

* Impostando la dimensione pagina a Come la partitura, dimensione pagina e orientamento 
delle parti saranno identiche alla partitura; per usare impostazioni diverse scegliere la dimen-
sione desiderata dall’elenco a tendina e cliccare su Verticale o Orizzontale.

* Impostando la dimensone del rigo a Come la partitura, tutti i righi nelle parti avranno la stessa 
dimensione di quelli nella partitura. In genere, però, le parti hanno righi più larghi, quindi per 
impostare un valore diverso scegliere mm o inches e inserire la dimensione del rigo desiderata.

* Cliccando sul pulsante Margini è possibile cambiare i margini di pagina e rigo delle parti in 
modo indipendente dalla partitura – vedere Margini pagina e Margini del rigo a pagina 517. 
Ciò è molto utile per aumentare il margine del rigo in alto sulla prima pagina, in modo da fare 
spazio al testo per il titolo, ecc..

* Su Mac, cliccare su Imposta Pagina (un pulsante extra non indicato qui) per configurare le 
impostazioni di default per la stampa delle parti (impostandole, ad esempio, ad una particolare 
dimensione del foglio per la stampa) – b Stampa.
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Pagina Layout
La pagina Layout ha varie opzioni; nel dubbio, lasciarle ai valori di default (che vanno bene in 
molte situazioni):

* Per cambiare le impostazioni di layout automatico cliccare sul pulsante Auto Layout; questa 
finestra consente di definire come Sibelius configura sistemi, pagine e pause multiple 
(b Layout automatico).

* Nelle parti i break di sistema, pagina e i break di pagina speciali aggiunti manualmente alla par-
titura possono essere eliminati, mantenuti o modificati (nel dubbio, non toccare queste opzioni):
% Per fare in modo che le pagine vuote all’inizio della partitura (quelle che precedono la prima 

prima misura di musica) appaiano nelle parti attivare l’opzione Mantieni titolo delle 
pagine.

% Per fare in modo che le altre pagine vuote (quelle che ci sono dopo la prima misura di 
musica) appaiano nelle parti esattamente come nella partitura attivare l’opzione Mantieni 
altre interruzioni di pagina speciali.

% Se si preferisce che siano cambiate in altri tipi di break attivare il box di spunta ma converti 
in e scegliere se devono essere modificate in interruzioni di pagina o interruzioni di acco-
llatura.

% Per fare in modo che i break di pagina appaiano nelle parti esattamente come nella partitura 
attivare l’opzione Mantieni interruzioni di pagina.

% Per cambiarli in break di sistema attivare l’opzione ma converti in interruzioni di accolla-
tura.

% Per fare in modo che i break di sistema nella partitura appaiano anche nelle parti attivare 
l’opzione Mantieni interruzioni di sistema.

% Altra formattazione (es. sistemi bloccati “misure mantenute insieme”) della partitura può 
apparire anche nelle parti attivando l’opzione Mantieni altre interruzioni.

% Mantieni margine prima delle code (con battute d’aspetto divise); per maggiori infor-
mazioni vedere Segni di Coda nelle parti a pagina 483.
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* In una parte è piuttosto diffusa la convenzione di ordinare a destra l’inizio del primo rigo. 
Sibelius consente di ordinare tutte le parti automaticamente impostando l’opzione Indentazi-
one prima accollatura di a 4 spazi (ad esempio); se impostata a zero, il rigo appare alla sua sol-
ita posizione.

* Per stabilire come giustificare i righi nelle parti, impostare l’opzione Giustifica righi se pagina 
è n% spazi (vedere Spaziatura di rigo e sistema on page 530).

* Regolando il valore Distanza tra sistemi si controlla la distanza standard tra i sistemi nella 
parte(i) selezionata; diminuendo il valore si risparmia spazio nelle parti. In pagine ove la musica 
è giustificata in verticale, la distanza tra i righi può essere superiore ai valori specificati.

* Per cambiare l’aspetto delle pause multiple nelle parti, scegliere lo stile adeguato dall’elenco 
 Aspetto. Per fare in modo che Sibelius scriva il numero 1 sopra singole misure di pausa attivare 
l’opzione Visualizza ‘1’ su battute in pausa (b Pause multiple).

* Di default, le parti hanno tutte le rispettive pagine numerate da 1; per avere un numero diverso 
sulla prima pagina, specificarlo modificando l’opzione Primo numero pagina. Se, più insolita-
mente, si vuole che le parti utilizzino gli stessi numeri pagina della partitura attivare l’opzione 
Mantieni cambi numero pagina da pagina titolo partitura, disponibile solo se è attiva l’opz-
ione Mantieni altri numero pagina da partitura (perché i numeri pagina sono attaccati ai 
break di pagina). 
Per maggiori informazioni sui numeri pagina, b Numeri pagina.

Pagina House Style
La pagina House Style presenta le seguenti opzioni:.

* Sibelius può aggiungere i nomi strumento a ciascuna delle parti. Di default, essi appaiono in alto 
a sinistra sulla prima pagina (Prima pagina) e in cima alle pagine successive (Pagine seg-
uenti); se non si vogliono i nomi strumento disattivare una o entrambe le opzioni.
Le intestazioni dei nomi strumento sono generate automaticamente dal nome di ogni parte con i 
testi jolly – b Jolly – ed esistono sempre in ogni parte; disattivando qui le intestazioni, Sibelius 
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nasconde i rispettivi oggetti di testo nelle parti (senza cancellarli) in modo da poterli attivare 
nuovamente in seguito.

* Di default, timecode e hit point non appaiono nelle parti. Per vedere il timecode scegliere Sopra 
ogni battuta o All’inizio di ogni accolatura in Visualizza timecode; per vedere gli hit point 
attivare l’opzione Mostra hit points (b Timecode e hit point).

* Normalmente i tempi in chiave appaiono incastrati (di default) tra le linee del rigo superiore e 
inferiore; per usare tempi in chiave grandi (Grande) o enormi (Grandissimo) nelle parti sceg-
liere la rispettiva opzione in Dimensione indicazione di tempo (vedere Tempi in chiave 
grandi, ecc. on page 141).

* Cliccando sul pulsante Modifica stile di testo si apre direttamente la finestra di dialogo Modi-
fica stili di testo (vedere Stili di testo nelle parti a pagina 482).

* Si può importare uno stile house in tutte le parti selezionate cliccando Importa House Style – 
vedere Esportare stili house dalle parti a pagina 484; durante l’import in una parte sono 
abilitate solo le opzioni Impostazioni documento e regole di tipografia e Regole di spazia-
mento delle note.

* Disattivando l’opzione Ometti cambi chiave tutti i cambi di chiave nella partitura appaiono 
nelle parti; per eliminare tutti i cambi di chiave in ogni strumento nelle parti attivare l’opzione 
Ometti cambi chiave e scegliere Sempre. Alcuni strumenti trasportati (come il clarinetto 
basso) potrebbero usare una chiave diversa nelle parti rispetto alla partitura, quindi i cambi di 
chiave necessari nella partitura potrebbero non avere alcun senso nella parte. Sibelius offre la 
possibilità di omettere tali cambi di chiave selezionando Ometti cambi chiave e cliccando Se 
Partitura e parti hanno chiavi diverse; aggiungendo manualmente i necessari cambi di chiave 
in una parte essi non appariranno nella partitura – vedere Cambi di chiave nelle parti a 
pagina 483.

* È nello stile di alcuni compositori nascondere frammenti di un rigo dove uno strumento non sta 
suonando (è noto come aspetto “cut-away” o “scrapbook” – vedere Righi con spazi vuoti on 
page 118). In genere, però, questa convenzione non si applica alle parti, quindi Sibelius consente 
di eliminare tutti i cambi strumento per nascondere (nessuna linea) gli strumenti nelle parti; per 
farlo attivare l’opzione Ometti cambi strumenti del tipo ‘Niente strumento (nascosto)’.

* Per impostare la frequenza con la quale appaiono i numeri misura nelle parti selezionare Ogni n
battute, Ogni sistema o Nessun numero battuta; si possono anche centrare i numeri con 
l’opzione Centrati sulla battuta. Per evitare che i numeri misura appaiano nelle stesse misure 
in cui ci sono segni di prova attivare l’opzione Ometti su richiami per la concertazione. Per 
fare in modo che l’aspetto dei numeri misura sia diverso nelle parti rispetto alla partitura sceg-
liere lo stile di testo desiderato dall’elenco a tendina Stile di testo dei numeri di battuta. A 
questo scopo è destinato lo stile di testo Numeri misura (parti), ma normalmente basta lascia-
rlo impostato a Numeri misura.
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6.4 Estrarre le parti

Estrarre le parti significa che qualsiasi parte dinamica scelta per l’estrazione sarà esportata in sin-
goli file e manterrà con precisione la rispettiva musica, formattazione e layout. Le parti dinamiche 
originali vere e proprie non sono alterate.

Perché estrarre le parti?
Raramente bisogna estrarre parti dalla partitura; tuttavia, in alcune situazioni può essere necessa-
rio farlo:

* Nel caso di parti con un numero variabile di righi nella partitura o righi con musica per più musi-
cisti: se una partitura ha un rigo per i “Corni 1+3” e righi separati per “Corno 1” e “Corno 3” 
(usati in punti diversi della partitura per maggior chiarezza) non si può creare automaticamente 
una parte per il “Corno 1” o il “Corno 3” (sebbene si possa creare una parte dinamica combinata 
di Corno 1 e Corno 3).
Se un solo rigo nella partitura contiene musica per due musicisti (es. “Flauti1.2.”) non è possibile 
creare automaticamente parti individuali da “Flauto 1” e “Flauto 2”; bisogna estrarre la parte 
“Flauti 1.2.” in due file distinti e poi modificarli rimuovendo il musicista superfluo – prima di 
continuare ed estrarre le parti vedere Più musicisti sullo stesso rigo.

* Per fare in modo che le parti si aprano in Sibelius Student o in versioni precedenti di Sibelius: 
occorre estrarre le parti dalla partitura, quindi esportarle come file nelle versioni 2, 3, 4 o Stu-
dent (in base alle esigenze).

* Per pubblicare le parti su SibeliusMusic.com: poiché Scorch al momento non può visualizzare le 
parti dinamiche, si deve estrarle dalla partitura e caricarle separatamente su SibeliusMusic.com.

Cercare di estrarre le parti sempre il più tardi possibile; se in futuro si deve revisionare una partit-
ura si manterranno così al minimo le modifiche corrispondenti sulle parti.

Se in futuro si eseguono poche revisioni della partitura è più comodo riestrarre alcune o tutte le 
parti invece di revisionarle.
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Finestra Estrarre le parti
Per estrarre le parti cliccare sul pulsante Estrarre le parti ( ) nella finestra Parti; si apre questa 
finestra di dialogo:

A sinistra si selezionano le parti da estrarre; si può selezionare una parte per estrarre solo quella, 
aggiungere singole parti alla selezione premendo Ctrl+clic o X-clic, aggiungere parti consecutive 
premendo Maius-clic oppure cliccare e trascinare in basso l’elenco per aggiungere parti consecu-
tive con il mouse.

Ignorando le rimanenti opzioni (descritte tra poco), cliccare su OK: in pochi secondi la parte o le 
parti vengono salvate e riaperte in Sibelius in uno o più file distinti.

Le altre opzioni nella finestra di dialogo sono:

* Salva nella cartella: Sibelius salva le parti estratte sulla destinazione specificata; inserire il per-
corso manualmente o cliccare su Sfoglia per individuare la directory.
Sibelius consente di creare utili nomi file per ciascuna delle parti salvate usando dei codici, elen-
cando quelli riconosciuti nella finestra di dialogo. Per esempio, se la partitura si chiamava Opus 
1 ed è stata estratta la parte del 2° oboe, inserendo il nome file %f - %p (part %n of %o).sib 
esso è interpretato: Opus 1°- 2° Oboe (parte 4 di 29).sib.
Di default, Sibelius nomina le parti in un formato adeguato, che include il nome file della partit-
ura, il nome della parte, data e ora di salvataggio delle parti.

* Disattivando l’opzione Visualizza parti ora, si può estrarre e salvare un set di parti senza che 
queste debbano apparire sullo schermo; lasciando attiva questa opzione, una volta estratte le 
parti occorre chiuderle tutte (ad esempio, con il comando File > Chiudi tutte).

Più musicisti sullo stesso rigo
Sebbene la parti dinamiche non siano sempre adatte alle situazioni nelle quali più musicisti condi-
vidono lo stesso rigo (es. Corno 1+2), possono essere utili mantenendo il rigo Corno 1+2 e due 
righi separati Corno 1 e Corno 2 nella partitura, in modo da poter facilmente eseguire le modifiche 
a tutti e tre i righi e vederli nello stesso momento. Per farlo:
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* Nella partitura completa, scrivere la musica su un rigo combinato Corno 1+2 (o alternarlo con 
righi separati).

* Finita la musica, aggiungere i righi separati Corno 1 e 2 e copiare/filtrare la musica su di essi dal 
rigo combinato Corno 1+2, come descritto in Estrarre singoli musicisti.

* Creare una “parte” dinamica (chiamata, ad esempio, “Partitura direttore”) costituita da tutti gli 
strumenti tranne i nuovi righi separati Corno 1 e 2 (vedere Aggiungere o rimuovere righi 
dalle parti a pagina 478): stamparla per il direttore. Per le parti dei Corni stampare i righi sep-
arati Corno 1 e 2 (invece del rigo combinato).

* Se in futuro bisognerà rivedere qualcosa sui Corni eseguire le stesse operazioni di revisione 
(nella partitura completa) sul rigo combinato Corno 1+2 e i righi separati Corno 1 e 2.

Estrarre singoli musicisti
Come descritto in b Strumenti, talvolta nella partitura ci sono più musicisti numerati per i 
quali si devono estrarre parti individuali – es. Trombe 1, 2 e 3. La procedura per eseguire questa 
operazione dipende dai casi:

* Se i musicisti saltano da rigo a rigo bisogna estrarre più di un rigo nella stessa parte. Per esem-
pio, se nella partitura ci sono gli strumenti “Trombe 1.2.3,” “Trombe 1.2” e “Tromba 3” e si vuole 
avere la parte della Tromba 3, estrarre le Trombe 1.2.3 e la Tromba 3 nella stessa parte, poi can-
cellare tutte le note suonate dalla Tromba 3. In quest’ultima fase possono essere d’aiuto i filtri 
(b Filtri e Trova). Come nella partitura, può essere necessario inserire dei break di sistema 
nel punto in cui un musicista salta da un rigo a un altro, in modo da nascondere i righi inutiliz-
zati a un lato del punto di cambio.

* Se ci sono solo due musicisti (es. Flauti 1 e 2) che talvolta o sempre condividono lo stesso rigo, si 
possono estrarre entrambi nella stessa parte e poi rimuovere con i filtri le note indesiderate (ved-
ere in seguito).

Il caso più diffuso è il secondo; due musicisti condividono lo stesso rigo, come indica l’esempio 
sotto per due flauti:

In questo esempio, talvolta la musica è in bicordi, qualche volta all’unisono (a 2) e altre volte in due 
voci.

Sibelius ha filtri interni che, con pochi clic del mouse, consentono di estrarre singoli musicisti. 
I filtri Modifica > Filtro > Player 1 (Per estrazione) e Player 2 (Per estrazione) sono destinati 
specificamente a tale scopo.

* Visualizzare il rigo o i righi Flauto 1 & 2 come una singola parte dinamica. A questo punto, 
eseguire tutte le modifiche necessarie per entrambi i musicisti, come la rimozione di collisioni 
tra gli oggetti o l’aggiunta di note introduttive.

* Estrarre la parte.
* Fare una copia della parte estratta con File > Salva come, chiamandola (es.) Flauto 2.
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* Per realizzare la parte Flauto 1 selezionare a turno come passaggio ogni sezione destinata a 
entrambi i flauti, scegliere Modifica > Filtro > Player 2 (Per estrazione) e premere Canc due 
volte per cancellare la musica del Flauto 2 – il primo Canc trasforma in pause le note indesider-
ate nelle voci extra e il secondo Canc cancella queste pause. Se la musica conteneva sezioni di 
accordi in una voce (come nell’esempio sopra) si dovrà filtrarla specificamente per le pause, 
poiché premendo semplicemente di nuovo Canc si cancelleranno anche alcune note del Flauto 1 
(che sono rimaste selezionate dopo aver premuto Canc la prima volta).

* Lasciare intatte tutte le sezioni di musica dove suona solo il Flauto 1, come indicato dal numero 
’1.’ (ad esempio) sopra il rigo. Tutte le sezioni ove un flauto suona e l’altro ha pause esplicite 
(usando due voci) possono essere gestite dal filtro Player 2 (Per estrazione).

* La parte del Flauto 1, tutti i segni dinamici, i testi e così via, rimarranno intatti. Modificare il 
nome dello strumento in “Flauto 1”:

* Per realizzare la parte del Flauto 2 aprire la copia della parte estratta e seguire la stessa proce-
dura, usando il filtro Modifica > Filtro > Player 1 (Per estrazione); una volta regolato il nome 
dello strumento, verificato le articolazioni e così via, si dovrebbe ottenere questo: 

Un caso che questi filtri non possono gestire automaticamente è un misto di bicordi e voci multiple 
che si trovano nella stessa misura, come indica l’esempio seguente:

In questo caso, il filtro Player 2 (Per estrazione), ad esempio, lascerà 
non selezionate le due note da 1/8 alla fine della misura. Sibelius presume 
sempre che se all’interno di una singola misura ci sono più voci ciascuna 
di esse costituisce un musicista; per avere risultati corretti, quindi, biso-

gna garantire che le voci siano usate coerentemente nella stessa misura; in questo caso particolare, 
selezionando la coppia di note più grave e scambiandola nella Voce 2 (comando rapido Alt+2 o
z2) si attua l’espediente.

Questi filtri Player possono farcela solo nel caso di due musicisti separati, non con tre (come le tre 
trombe indicate in precedenza).

Non usare i filtri Player per selezionare un musicista particolare e copiarlo – non si copierebbe la 
musica prevista; per altri dettagli sui filtri, b Filtri e Trova.
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7.1 Layout e formattazione

b Righi, Lavorare con le parti, Menu Vista, Scrittura musicale, Layout automatico, 
Break - Interruzioni, Impostazioni documento, Attaccature, Spaziatura note, Spa-
ziatura rigo.

v Layout e Stile House.

Il layout è l’aspetto della musica sulla pagina; la formattazione è il processo con il quale si realizza 
un buon layout. Sibelius conosce molte regole di scrittura musicale, quindi può formattare auto-
maticamente la musica per avere subito un ottimo layout. In altri programmi di notazione musi-
cale la formattazione è lasciata in gran parte all’utente, il quale può perdere ore di lavoro!

Sibelius consente anche di regolare manualmente il layout (in seguito sono descritti i vari metodi). 
La maggior parte delle opzioni sono nel menu Layout; per esempio, si possono inserire i propri 
cambi pagina nelle parti o forzare una partitura a stare in un certo numero di pagine.

Poiché Sibelius riformatta la partitura in una frazione di secondo, si può regolare rapidamente il 
layout in qualsiasi momento, anche quando la musica è finita, eliminando la necessità di pianifi-
care il layout in anticipo.

I tre elementi principali di formattazione sono la regolazione delle dimensioni di pagina e rigo, la 
spaziatura verticale e quella orizzontale. Ci sono anche opzioni per forzare un passaggio musicale a 
stare in un sistema o pagina e per bloccare la musica in modo che non si possa riformattare.

Dimensione pagina e rigo
I tool più diretti per modificare il rigo e le dimensioni di margine e/o pagina sono nella finestra di 
dialogo Layout > Imposta documento (comando rapido Ctrl+D o XD); modificarli è un modo 
per aumentare o ridurre il numero di pagine in una partitura o liberare spazio tra i righi.

Regolare la dimensione (la distanza tra le linee in alto e in basso di un rigo a 5 linee) è in genere il 
metodo più efficace. Lievi regolazioni spesso hanno un notevole effetto sulla quantità di musica 
che può stare sulla pagina, senza che ciò influenzi le leggibilità delle note; per esempio, in una par-
titura orchestrale si possono far stare due sistemi per pagina invece che uno solo, dimezzando così 
la lunghezza della partitura.

Analogamente, una lieve regolazione dei margini o della dimensione pagina può avere un grande 
effetto sul layout; ovviamente, per ragioni pratiche, ciò potrebbe non essere possibile.

Per le descrizioni dettagliate di queste opzioni, b Impostazioni documento.

Spaziatura verticale
In pratica, cambiare la spaziatura verticale significa spostare i righi; le opzioni sono:

* Spostare i righi in alto e in basso per cambiare il vuoto che li separa – b Spaziatura rigo

* Spostare i sistemi in alto e in basso trascinando il rigo in alto del sistema – b Spaziatura rigo

* Modificare le impostazioni House Style > Regole tipografia per la giustificazione di rigo e 
sistema – b Spaziatura rigo
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* Nascondere i righi vuoti – b Righi

* Creare un break di pagina; è un metodo semplice per ridurre il numero di righi su una pagina 
(specialmente nelle parti). I righi rimanenti sono spaziati proporzionalmente senza dover essere 
trascinati con il mouse – b Break - Interruzioni.

Spaziatura orizzontale
Cambiare la spaziatura orizzontale significa modificare la distanza tra note, pause e stanghette – 
b Spaziatura note.

Break di sistema e pagina
Per cambiare la formattazione di default di Sibelius, si possono inserire break di sistema e pagina 
manuali ad ogni stanghetta – b Break - Interruzioni.

Make Into System/Page
Si può forzare ogni passaggio a stare in un sistema o in una pagina; selezionare il passaggio e dal 
submenu Layout > Formato scegliere Adatta in un’Accollatura (comando rapido 
Maius+Alt+M o xzM) o Adatta in una Pagina (comando rapido Ctrl+Maius+Alt+M o
xzXM). Esso rimane bloccato come sistema o pagina, anche se si riformatta la partitura.

Per annullare questa operazione, sbloccare la formattazione (vedere in seguito).

Come con altre sostituzioni di formattazione è meglio non trasformare sempre i passaggi in 
sistemi/pagine. Facendolo spesso, infatti, si può creare una formattazione indesiderata da qualche 
altra parte, se non si sa cosa si sta facendo – è un’operazione destinata solo a casi particolari.

Mantieni insieme battute
Talvolta è bene assicurarsi che due o tre misure appaiano sempre nello stesso sistema; per farlo 
selezionare le misure da tenere insieme e scegliere Layout > Formato > Mantieni insieme bat-
tute.

Uniformare il layout
Per impostare un numero costante di misure per sistema e/o sistemi per pagina selezionare
Plug-in > Altro > Rendi layout uniforme; per i dettagli sull’uso di questo plug-in, b Plug-in.

Blocco formattazione
Se è stato inserito un passaggio di musica che richiede una formattazione molto speciale da non 
perdere, la si può bloccare; ciò impedisce alle misure di andare su altri sistemi (sebbene non impe-
disca modifiche di spaziatura all’interno di un sistema, es. spostando una nota a sinistra o destra). 
Per bloccare la formattazione selezionare il passaggio in questione e scegliere Layout > Formato >
Blocca formato (comando rapido Ctrl+Maius+L o xXL).

Bloccando la formattazione o usando l’opzione Layout > Formato > Adatta in una Accollatura/
Pagina, su ogni stanghetta appaiono dei piccoli simboli di layout, i quali impediscono lo sposta-
mento della misura; queste icone sono visibili attivando l’opzione Vista > Marchi Layout.
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Sblocco formattazione
Per annullare un’operazione Blocca Formato ri-selezionare le misure e scegliere Layout >
Formato > Sblocca formato (comando rapido Ctrl+Maius+U o xXU); le icone blu scompaiono 
e le misure sono di nuovo libere di spostarsi da sistema a sistema.

Sblocca Formato rimuove anche i break di pagina e di sistema, oltre ad annullare le operazioni 
Adatta in una Accollatura/Pagina, Mantieni insieme battute e gli effetti del plug-in Rendi 
layout uniforme.

Auto Layout
La finestra di dialogo Auto Layout permette di specificare varie posizioni ideali alle quali Sibelius 
inserisce i break di sistema e pagina (specialmente nelle parti) – b Layout automatico.

Ordinare i righi
Trascinare le estremità sinistra e destra dei sistemi per ordinarli – b Righi.

Ripristinare la posizione
Per spostare gli oggetti dalle rispettive posizioni di default eseguire una selezione e scegliere 
Layout > Ripristina posizione (comando rapido Ctrl+Maius+P o xXP).

Gli effetti specifici di questo comando su alcuni oggetti particolari sono:

* Testi e segni di prova: li allinea con le note e riallinea file di parole e simboli accordo.
* Simboli: li allinea con le note – es. per collocare un ornamento sopra una nota.
* Linee: fa scattare le estremità alle note e fa diventare magnetiche le legature non magnetiche. 

La finestra di dialogo House Style > Posizioni di default permette di definire la posizione 
esatta di default rispetto alla nota.

* Tuplet: fa diventare magnetici tutti i gruppi irregolari non magnetici (come quelli creati nelle 
versioni di Sibelius 1.4 o precedenti).

* Alterazioni: resetta la posizione orizzontale delle alterazioni.
* Angoli dei tratti d’unione e lunghezze dei gambi: li resetta ai valori di default (come fa il comando 

Note > Ripristina gambi e posizioni tratti).

Per spostare gli oggetti alle posizioni ideali si può anche usare il mouse: tenere premuto Maius e 
trascinare l’oggetto selezionato; testi, linee e simboli scattano alle rispettive posizioni verticali di 
default e il loro movimento è impedito in verticale (si possono spostare solo in orizzontale). Atten-
zione! L’operazione Maius-trascinamento funziona solo su singoli oggetti.

Quando si copiano gli oggetti si può anche tenere premuto Maius e Alt+clic o z-clic: gli oggetti 
copiati sono collocati automaticamente alle rispettive posizioni di default.

Ripristina su posizione partitura
Funziona come il comando Ripristina posizione, ma gli oggetti nella parte sono impostati per 
usare la stessa posizione alla quale appaiono nella partitura completa; usando questo comando in 
una partitura completa, Sibelius resetta la posizione dell’oggetto in tutte le parti nelle quali appare.

reference.book  Page 499  Wednesday, April 16, 2008  4:28 PM



7. Layout & tipografia

500

Ripristina aspetto
Cambiando l’aspetto (invece che la posizione) di un oggetto, se ne può resettare la forma al default 
con il comando Layout > Ripristina aspetto (comando rapido Ctrl+Maius+D o xXD).

Gli effetti specifici su particolari oggetti sono:

* Mostra tratti d’unione, bandierine o uncini nascosti.
* Mostra istanze selezionate dei testi di sistema (es. il testo Tempo o i segni di prova).
* Resetta il fattore della scala di grafiche importate.
* Resetta curvatura e simmetria di legature di portamento e valore.
* Resetta gli oggetti di testo alle rispettive formattazioni di default.

Ripristina su aspetto partitura
Funziona come Ripristina aspetto, ma gli oggetti nella parte tornano ad avere lo stesso aspetto 
che hanno nella partitura completa; applicando questo comando a un’intera partitura, Sibelius 
resetta la forma dell’oggetto in tutte le parti nelle quali appare.

Per maggiori informazioni sui comandi Ripristina su posizione partitura e Ripristina su 
aspetto partitura, b Layout automatico e Ripristinare gli oggetti nelle parti a 
pagina 481.

Allineamento degli oggetti
Per allineare più oggetti in una fila/colonna selezionare Layout > Allinea in una riga
(Ctrl+Maius+R o xXR) o Layout > Allinea in una colonna (Ctrl+Maius+C o xXC). Gli 
oggetti s’allineano alla media delle rispettive posizioni orizzontale/verticale.

Ciò è molto utile allineare parole, simboli accordo, diagrammi accordo, ecc. lungo un rigo. Inoltre, 
selezionando una serie di oggetti attaccati a righi diversi (es. con Ctrl+clic o X-clic), il comando 
Layout > Allinea in una riga li allinea alla stessa distanza sopra il rigo al quale sono attaccati.

Il comando Layout > Allinea in una riga funziona anche su stili di testo di sistema: si può usarlo 
per allineare i segni di tempo e metronomo, ad esempio. Tuttavia, non si può usare per allineare 
oggetti di sistema con oggetti del rigo e nemmeno per allineare tra loro stili di testo con posizioni 
verticali di default diverse (es. non si può allineare il testo Composer con quello Subtitle, ecc.).

Per allineare molte parole usare il plug-in Plug-in > Testo > Allinea parole – b Plug-in.

Consiglio: per selezionare tutti gli oggetti di testo simili in un rigo o sistema prima di allinearli (per 
esempio, tutte le parole o tutti i segni di prova) selezionare un oggetto e scegliere Modifica >
Seleziona > Seleziona altro (comando rapido Ctrl+Maius+A o xXA).

Righelli e fogli grafici
Sibelius visualizza dei righelli sullo schermo che aiutano ad allineare gli oggetti ed eseguire precise 
regolazioni sul layout della partitura – b Menu Vista.

Nella pagina Textures della finestra File > Preferenze (menu Sibelius in Mac) si può scegliere 
l’opzione Carta, grafico che disegna una griglia sulla partitura; se visualizzate al 100% le linee 
della griglia sono distanziate di 1 spazio.
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7.2 Scrittura musicale

b Layout e formattazione, House Style™, Spaziatura note, Spaziatura rigo.

Questo capitolo riassume i concetti principali di scrittura musicale, ovvero l’arte raffinata alla base 
della maggior parte di quello che fa Sibelius; sebbene sia solo una breve introduzione a questo 
vasto argomento, imparando un pò questa arte si migliorerà l’aspetto delle proprie partiture e si 
svilupperà un buon occhio nel saper riconoscere una buona scrittura musicale.

Premessa
Sibelius rappresenta l’ultimo stadio di una tradizione secolare. La notazione musicale risale al XII 
secolo mentre la stampa musicale è iniziata nel XV secolo; sono stati impiegati vari metodi per 
riprodurre (“incidere”) la musica:

* Copiatura a mano.
* Incisione meccanica: taglio o stampa della musica direttamente su matrici di stampa usando 

speciali attrezzi; questa tecnica (di qualità elevata ma estremamente laboriosa) è stata per secoli 
la tecnologia dominante.

* Caratteri tipografici mobili (largamente usati fino al XV secolo).
* Macchine da scrivere musicali, pennini stilografici e simboli trasferibili a secco su fogli traslu-

cidi (Letraset®) erano ancora in uso nel corso del XX secolo.

Le tecnologie di scrittura musicale sono cambiate nel corso dei secoli; un copista a mano che scrive 
la musica per pubblicazioni nel 1990 sarebbe facilmente riconoscibile da una scimmia che 
eseguiva lo stesso lavoro nel 1190!

Durante gli anni ‘90, tuttavia, il computer ha completamente rivoluzionato la scrittura musicale e 
in questa svolta Sibelius ha giocato un ruolo fondamentale. In una sola decade, le vecchie tecnolo-
gie sono state quasi totalmente abbandonate, tranne quella più antica di tutte: la scrittura a mano.

Grazie alla pubblicazione on-line in Internet anche la stampa non è più un obiettivo indispensabile 
della scrittura musicale, (b SibeliusMusic.com).

Cosa è la scrittura musicale?
La scrittura musicale è l’arte di riprodurre in modo chiaro la notazione musicale. Assomiglia un pò 
alla tipografia – così come la tipografia tratta la forma e il posizionamento delle lettere e il layout 
del testo sulla pagina, la scrittura musicale riguarda la forma e il posizionamento dei simboli musi-
cali e il layout della musica sulla pagina.

Scrittura e notazione musicale non sono la stessa cosa – chiunque sappia leggere la musica conosce 
la notazione musicale, ma pochi musicisti conoscono la scrittura musicale. Continuando con l’ana-
logia delle parole, la notazione musicale equivale allo spelling e alla grammatica – indica in modo 
generico come scrivere la musica, ma non indica con precisione come e dove scrivere i simboli; 
questi dettagli cruciali sono definiti dalla scrittura musicale.

Serve molta esperienza per riconoscere e valutare le sottigliezze della scrittura musicale. Un occhio 
allenato può dire facilmente di quale editore è una partitura o con quale programma di computer o 

reference.book  Page 501  Wednesday, April 16, 2008  4:28 PM



7. Layout & tipografia

502

altro metodo è stata realizzata – mentre alla maggior parte dei musicisti la scrittura di tutte le par-
titure sembra più o meno la stessa (una buona scrittura è spesso invisibile ad occhi poco allenati; la 
scrittura emerge solo quando è fatta veramente male!).

La scrittura musicale è un’arte molto raffinata, che riguarda particolari i quali possono sembrare 
pedanti (alcuni lo sono!). Fortunatamente, Sibelius gestisce automaticamente la maggior parte di 
questi particolari, quindi non è indispensabile conoscerli.

Regole di scrittura
Ci sono pochi libri che trattano la scrittura musicale – è una tradizione tramandata per secoli solo 
oralmente, da maestro ad apprendista e governata da centinaia di regole di scrittura, molte origina-
tesi nel XIX secolo quando le edizioni musicali raggiunsero un livello di qualità davvero molto ele-
vato.

Una serie di regole di scrittura, unite a cose come le forme dei simboli musicali, costituiscono uno 
stile house per le edizioni musicali. Sebbene denominate “regole ” di scrittura molte sono in realtà 
convenzioni, poiché poche sono universalmente usate e anche gli editori più rinomati praticano 
regole diverse. Tuttavia, scrittori ed editori sono molto legati alle particolari regole utilizzate, ed 
affermano aspramente che le loro sono le migliori o perfino le uniche “giuste”.

Sibelius applica automaticamente alla partitura centinaia di regole di scrittura, alcune delle quali 
non sono mai state formulate prima; di default usa le regole standard che gli utenti esperti possono 
regolare a piacere nella finestra di dialogo House Style > Regole tipografia. Sibelius riformatta in 
un decimo di secondo l’intera partitura utilizzando queste regole ogni volta che si cambia qualcosa 
– anche se si esegue una modifica drastica come una cambio delle dimensione pagina.

Nonostante ciò, Sibelius non è uno scrittore musicale perfetto.

Questo semplicemente perché le regole di scrittura sono imperfette: alcune sono troppo vaghe da 
calcolare e molte non prevedono tutti i casi, richiedendo talvolta una regolazione a occhio per 
apparire corrette. Talvolta le regole sono in conflitto tra loro e si rende necessario trasgredire ad 
una regola per obbedire ad una più importante. È meglio che siano scrittori umani a risolvere tali 
situazioni; Sibelius non può essere migliore delle regole di scrittura stesse. A questo proposito, si 
può utilizzare un sillogismo Aristotelico:

* Le regole di scrittura musicale sono imperfette (e talvolta si devono correggere a occhio).
* Sibelius utilizza le regole di scrittura musicale.
* La scrittura musicale di Sibelius è quindi imperfetta (e talvolta si deve sistemare a occhio).

Ci sono però alcune regole universali, delle quali una è assolutamente fondamentale:

Regola n° 1: chiarezza
La musica deve essere scritta nel modo più chiaro possibile. 

Nessun’altra regola di scrittura può sostituire questa; se qualcosa è poco chiaro non è corretto. 
Per questo motivo, le correzioni ai dettami delle regole di scrittura sono spesso fatte “a occhio”; 
nelle varie situazioni per cui non è state formulata una regola precisa l’alternativa è andare ancora 
“a occhio”.
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Diventando esperti di scrittura musicale, nella partitura si faranno poche regolazioni a occhio. 
Per ora è sufficiente contare su Sibelius per seguire le regole di scrittura.

Ma perché la chiarezza è la regola più importante? Lo scopo della scrittura musicale è fare in modo 
che si legga una partitura senza un ragionamento vero e proprio, come dover considerare cosa è un 
particolare ritmo o accordo, quale nota si applica ad una particolare parola, segno dinamico o arti-
colazione, e così via; una partitura scritta male (poco chiara) può confondere facilmente il lettore e 
indurlo in errore (specialmente nella lettura a prima vista) senza che nemmeno sappia il perché. 
Tutti abbiamo visto partiture così – perfino quelle stampate dalle case editrici.

Regola n° 2: evitare collisioni
Quando nella notazione musicale gli oggetti si sovrappongono diventano difficili da leggere e poco 
chiari. Per evitare di trasgredire alla Regola n° 1, quindi, si deve seguire questa seconda regola:

Evitare le collisioni tra oggetti diversi. 

Molte regole di scrittura sono metodi efficaci per evitare le collisioni e fortunatamente Sibelius ne 
ha molte. Per esempio, quando s’incrociano due voci, Sibelius ne colloca una a sinistra o destra per 
evitare che si tocchino; quando nelle parole si scrivono sillabe lunghe, Sibelius provvede ad inserire 
uno spazio extra tra esse aumentando il vuoto tra le note.

Sebbene Sibelius abbia queste regole, non può evitare sempre le collisioni, perché non ci sono 
regole rigide su come risolvere tutte le collisioni – in situazioni difficili la scrittura deve essere 
sistemata ad occhio per far stare un oggetto. Per esempio, se un segno dinamico tocca il gambo di 
una nota, si può spostare il segno dinamico a sinistra, a destra o addirittura nel rigo, dipende da 
quanto rimane chiaro l’aspetto della partitura; in una situazione molto difficile si può scegliere di 
lasciare il segno dinamico al suo posto e accorciare invece il gambo della nota.

Decisioni così delicate non possono essere formulate in regole, quindi la responsabilità di risolverle 
è dell’utente, non di Sibelius; anche non essendo uno scrittore musicale esperto si devono però 
rimuovere tutte le eventuali collisioni.

Alcune collisioni sono consentite (poiché sono quasi inevitabili e non impediscono la necessaria 
chiarezza). Quelle principali sono le legature (di valore e portamento) e le forcine tra una stang-
hetta che unisce due righi. Le legature possono andare anche nei righi, mentre i testi e la maggior 
parte di linee e simboli non possono farlo (tranne in situazioni molto critiche).

Unità
L’unità principale della scrittura musicale è lo spazio (cioè la distanza tra linee del rigo adiacenti). 
Essa è relativa piuttosto che assoluta, perché tutto nella musica è proporzionato alla dimensione 
del rigo; la dimensione assoluta di note, testi, ecc. è meno importante (anche per i testi Sibelius usa 
una dimensione punto relativa invece che assoluta). Quasi tutte le regole di scrittura utilizzano gli 
spazi come unità; pollici e millimetri diventano significativi quando si decidono le dimensioni 
pagina e margine.

Layout orizzontale: spaziatura note
Il layout orizzontale della musica in pratica si basa sulla spaziatura nota. Ci sono molti oggetti 
diversi dalle note, ma sono collocati prevalentemente rispetto alle note; per esempio, articolazioni, 
legature, parole e segni dinamici vanno sopra/sotto le note alle quali si applicano.
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Note e pause sono spaziate in base ai rispettivi valori nota; le spaziature usate da Sibelius sono nella 
finestra di dialogo House Style > Regola spaziatura note. Per esempio, dopo una nota da 1/4 ci 
sono 3.5 spazi, dopo una nota da 1/2 ci sono 5.94 spazi e dopo una nota intera ci sono 8.19 spazi. 
Vari editori usano spaziature leggermente diverse.

Un rapido calcolo mentale conferma che lo spazio dopo una nota o pausa non è proporzionale al 
suo valore nota: se così fosse, una nota intera sarebbe seguita da 4 x 3.5 = 14 spazi (cioè 4 spazi 
nota da 1/4) invece che da 8.19 spazi. Il motivo per cui la spaziatura nota non è proporzionale è che 
se lo fosse note molto brevi sarebbero talmente ravvicinate da risultare illeggibili e note molto 
lunghe consumerebbero troppo spazio.

Se più righi o voci simultanei hanno ritmi diversi nello stesso momento, quali delle rispettive note 
sono usate per stabilire la spaziatira nota? La risposta è che sono le note o pause più brevi in ogni 
punto a determinare la spaziatura: quindi se la mano destra di un piano sta suonando note da 1/4 
mentre la mano sinistra suona note intere, sono le note da 1/4 a determinare la spaziatura e le note 
intere sono solo posizionate allineate ad esse. Tuttavia, diventa molto più difficile mantenere la 
giusta spaziatura quando ci sono molti righi (es. in partiture orchestrali/bandistiche) e complicati 
ritmi incrociati (come i gruppi irregolari).

Poiché la spaziatura nota non è proporzionale, le misure non hanno la stessa larghezza – misure 
con note più brevi sono più larghe (anche se può sembrare paradossale):

Normalmente quindi non c’è un numero costante di misure per sistema; la musica jazz e commer-
ciale, ad esempio, spesso è scritta su quattro misure per sistema (ma è un’eccezione).

Una regolazione della spaziatura di base è la giustificazione: le note devono essere distribuite in 
modo che un numero intero di misure stia nella larghezza della pagina. Il metodo consiste nel far 
stare il numero massimo di misure possibile nella larghezza della pagina (con le spaziature note 
descritte sopra), poi lo spazio che avanza è aggiunto equamente a tutte le note che sono distribuite 
fino al margine destro; è la stessa giustificazione usata per le parole che riempiono una linea in un 
programma di scrittura.

Sono eseguite anche altre regolazioni: spazio extra serve per alterazioni, punti ritmici, linee 
aggiuntive, code sui gambi rivolti in alto (poiché sporgono), stanghette, abbellimenti, “note 
inverse” (teste nota sul lato sbagliato del gambo in accordi cluster), voci incrociate, parole e cambi 
di chiave, tonalità e tempo in chiave.

Anche qui, Sibelius automatizza tutte queste operazioni usando un complesso algoritmo per la 
regola di spaziatura denominato Optical – sebbene ciò non significhi che talvolta non si debba 
eseguire una regolazione a occhio. In particolare, si regola la spaziatura nota se diventa molto irre-
golare a causa di valori nota variabili o parole complicate; vedere b Spaziatura note.

reference.book  Page 504  Wednesday, April 16, 2008  4:28 PM



7.2 Scrittura musicale

505

Layo
ut

Layout verticale: spaziatura rigo
Il layout verticale è un pò meno preciso di quello orizzontale. Tuttavia, come il layout orizzontale si 
basa sulla posizione delle note (con altri oggetti posizionati rispetto ad esse) quello verticale 
riguarda la spaziatura del rigo; la posizione verticale di altri oggetti (note, pause, chiavi, tempi in 
chiave, nomi strumento, titoli, numeri misura e segni di prova) è determinata dai righi ai quali 
appartengono.

In generale, i righi devono essere alla stessa distanza tra loro con uno spazio vuoto leggermente 
superiore tra i sistemi e spesso uno spazio vuoto più ampio tra le famiglie strumentali in partiture 
più grandi (es. per orchestra o banda). Quando ciò avviene, Sibelius non inserisce automatica-
mente quest’ultimo spazio vuoto; può farlo l’utente selezionando il rigo in alto di una famiglia da 
inizio a fine partitura e spostandolo in basso.

Spesso le partiture sono giustificate in verticale per distribuire i righi in basso verso il margine 
inferiore (come avviene per la giustificazione orizzontale delle note). Sibelius lo fa automatica-
mente se la pagina è piena più della metà (come sempre è possibile regolare le rispettive opzioni 
nella finestra di dialogo Engraving Rules).

Talvolta, tuttavia, bisogna lasciare uno spazio extra tra i righi o riposizionare altri oggetti per evi-
tare collisioni (ad esempio, tra le note acute o gravi su un rigo e gli oggetti su un rigo adiacente). 
È la classica regolazione a occhio che si può fare da soli.

Un altro motivo per spostare i righi è allineare righi corrispondenti su pagine che sono l’una di 
fronte all’altra; è utile in partiture orchestrali/bandistiche per agevolare il direttore nella lettura 
della musica per un particolare strumento da una pagina all’altra. La finestra di dialogo Layout >
Align Staves di Sibelius lo fa in automatico (b Spaziatura rigo).

Altre informazioni
In particolare, per i vari metodi di miglioramento dell’aspetto della partitura in Sibelius vedere 
b Spaziatura note e Layout e formattazione .

Ci sono molte altre regole di scrittura (troppo numerose per essere descritte in questo capitolo); 
molte sono comunque riassunte in altri capitoli di questo Reference Guide, sia in box (in parti-
colare per le regole non automatiche) o nel paragrafo Opzioni Engraving Rules alla fine del 
capitolo; la maggior parte delle regole sono gestite automaticamente da Sibelius, quindi non è 
indispensabile conoscerle.

Per altre informazioni sulla scrittura musicale, un buon libro sulle nozioni principali al riguardo è 
l’economico ma leggibilissimo Essential Dictionary of Music Notation (Edizioni Alfred). Ci sono 
anche altri libri (costosi e non altrettanto leggibili) per gli scrittori musicali più esperti.

Per concludere, si consiglia di applicare le Regole 1 e 2 indicate in precedenza: evitare collisioni e 
soprattutto rendere il più chiaro possibile l’aspetto della partitura.
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7.3 Layout automatico

b Pause multiple, Lavorare con le parti, Layout e formattazione, Break - Interruzi-
oni.

v Parti dinamiche.

Sibelius crea automaticamente break di sistema e pagina in posizioni musicalmente adatte con la 
funzione Layout > Auto Layout che consente di risparmiare molto tempo quando si formattano le 
parti; se lo si desidera, queste opzioni si possono usare anche nelle partiture.

Configurare le parti
Nelle parti è utile inserire break di pagina in presenza di una o più misure di pausa sulla pagina 
destra, in modo che il musicista abbia il tempo di girare la pagina. La funzione Layout > Auto Lay-
out di Sibelius esegue questa operazione aggiornando il layout ogni volta che serve; inserendo 
misure, collocando note in misure vuote, ecc., il layout può cambiare, poiché Sibelius colloca un 
break di pagina in un punto diverso più adatto. È utile collocare break di sistema in punti partico-
lari della musica, come nei cambi di tempo, tonalità, segni di prova o pause multiple per fare in 
modo di vedere a prima vista questi oggetti.

Di default, il layout automatico non è attivo nelle partiture, ma Sibelius lo attiva nelle parti. Per 
cambiare il modo in cui Sibelius configura la pagina, selezionare Layout > Auto Layout, oppure 
modificare una o più parti simultaneamente cliccando sul pulsante Auto Layout nella pagina 
Layout della finestra Aspetto Parte Multipla (b Finestra Aspetto parte multipla). 
In ogni caso appare questa finestra di dialogo:

Break di sistema automatici
* L’opzione Usa automatche interruzioni di accollatura consente all’utente di scegliere se 

usare o meno break di sistema automatici. Sibelius può creare i break di sistema regolarmente 
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dopo un numero di misure specificato; altrimenti inserire break di sistema in punti nella parte 
ove una separazione del materiale su uno dei lati del break consente di visualizzare meglio un 
cambio nella musica.

* Se si desidera che Sibelius inserisca break di sistema a intervalli regolari selezionare Ogni n bat-
tute e inserire il numero di misure per sistema desiderato; per avere break di sistemi regolari 
solo per una sezione della musica e non per l’intera partitura usare invece il plug-in Rendi lay-
out uniforme (b Plug-in).

* Usando l’opzione Quando o prima di, Sibelius inserisce break di sistema dove ci sono oggetti 
specifici: 
% Richiami per la concertazione: se attiva, Sibelius sposta i segni di prova all’inizio di un 

sistema.
% Testo tempo: Sibelius sposta la scritta tempo all’inizio di un sistema.
% Stanghette doppie: in generale indica la fine di una sezione, quindi per evidenziare meglio 

la divisione musicale attivare questa opzione per inserire un break di sistema ove appare una 
stanghetta doppia.

% Cambi di tonalità: se attiva, Sibelius inserisce un break di sistema prima di un cambio tonal-
ità, in modo che la nuova tonalità sia visualizzata all’inizio di un sistema; ciò vale solamente 
per i cambi di tonalità o strumento alla fine di una misura, non a metà misura.

% Battute d’aspetto di n o più battute: attivare questa opzione per inserire break di sistema 
dopo pause multiple di una determinata durata.

% Sistema deve essere completo al n%: usare questa opzione per evitare che Sibelius spazi 
troppo la musica: qui si stabilisce un soglia minima alla quale interviene un break automat-
ico.

I break automatici di sistema sono indicati da un segno di break di sistema puntato, in questo 
modo:  Sono arancioni, perché appaiono nella parte, non nelle partitura (se è attiva l’opzione 
Vista > Differenze nelle parti).

Break di pagina automatici
* Usa automatiche interruzioni di pagina: consente di scegliere se Sibelius deve inserire break 

di pagina automatici nei punti adatti; se questa opzione non è attiva tutte le opzioni Page Break
sono disabilitate.

* All’ultima stanghetta: se attiva, Sibelius inserisce un break di pagina dopo una stanghetta 
finale. 
È utile lavorando su partiture costituite da più di un movimento, pezzo o brano.

* Battuta in pausa: se attiva, Sibelius inserisce un break di pagina dopo le pause (per facilitare i 
cambi di pagina) con le seguenti opzioni: 
% Scegliere se Sibelius deve provvedere a break di pagina automatici dopo ogni pagina (Dopo 

ogni pagina) o dopo le pagine destre (Dopo le pagine destre), cioè quelle dispari. Se i 
musicisti leggono fogli singoli scegliere Dopo ogni pagina; se leggono su due pagine selezi-
onare Dopo le pagine destre.

% Dopo n o più battute in pausa: determina il numero minimo delle misure di pausa prima 
di un break di pagina automatico (quindi il tempo necessario a girare pagina).
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% Preferire pause più lunghe prima di un’interr. di pagina: Sibelius interrompe la pagina 
dopo una pausa multipla più lunga invece che dopo una più corta (scelta consentita) in modo 
d’avere più tempo per girare la pagina (anche se ciò può significare avere meno musica sulla 
pagina).

* Pagina deve essere completa al n%: evita che Sibelius inserisca troppo presto cambi pagina 
automatici nella pagina (altrimenti non avrebbe abbastanza musica e apparirebbe poco rego-
lare).

* Inserisci avviso quando il cambio pagina è difficile: stampa un avviso sul margine dopo la 
misura finale della pagina se non vi è un posto ideale per un break di pagina automatico; l’avviso 
di default è “V.S.” (verso subito), ma si può usare anche una propria scritta o il simbolo Specta-
cles.
Per usare un simbolo diverso modificare il simbolo Spectacles nella fila Layout Marks della 
finestra di dialogo House Style > Modifica simboli – b Modifica simboli.

Per rimuovere un avviso dalla fine di una pagina particolare, inserirvi un break di pagina manuale 
(vedere in seguito) ad indicare che il break è intenzionale.

Attivando l’opzione Vista > Marchi Layout sullo schermo appare un simbolo alla fine delle pagine 
destre (o di tutte le pagine) che indica se Sibelius ha trovato un break di pagina buono ( ) o 
pessimo ( ); questo simbolo, tuttavia, non sarà stampato.

Eliminare break di pagina e di sistema automatici
Ci possono essere situazioni nelle quali è necessario eliminare un break di pagina o sistema auto-
matico; per farlo:

* Selezionare la stanghetta alla quale eliminare il break automatico.
* Nel sottomenu Layout > Interruzioni selezionare Interruzione di accollatura (comando 

rapido Invio sulla tastiera principale) o Interruzione di pagina (comando rapido Ctrl+Invio o
X-Return). Il simbolo di break automatico appare con una croce ad indicare che è stato elimi-
nato.

Poiché Sibelius obbedisce ai normali break di pagina, sistema e altra formattazione quando decide 
dove collocare un break automatico, si possono sostituire i break automatici selezionando le mis-
ure che si desidera siano presenti sulla pagina o sistema e usando il comando Layout > Formato >
Adatta in una Pagina o (più raramente) il comando Layout > Formato > Adatta in un’Accolla-
tura.

Se si seleziona la stanghetta sulla quale è presente un break di pagina o sistema automatico e si 
cambia tipo di break, quest’ultimo si pone in tre condizioni: auto, eliminato e manuale.

Pause multiple
La funzione Layout > Auto Layout presenta anche opzioni che determinano l’aspetto delle pause 
multiple nelle parti (o anche nella partitura, se lo si desidera):

* Usa simboli di battute d'aspetto: come accennato in precedenza, attivandola Sibelius scrive 
più misure consecutive di pausa come pause multiple. Nelle parti questa opzione è attiva di 
default; disattivandola, le altre impostazioni sull’aspetto delle pause multiple sono disabilitate. 
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* Svuotare sezioni tra stanghette finali: se un passaggio musicale tra l’inizio di una partitura e 
la stanghetta finale o tra stanghette finali successive è vuoto, Sibelius può evitare che le pause 
multiple si interrompano in corrispondenza di cambi del tempo in chiave, scritte Tempo e simili, 
visualizzando semplicemente una singola pausa multipla “silente”distribuita sulla larghezza del 
sistema. Si può usare questa opzione sia in partiture che nelle parti senza musica; è possibile 
anche impostare manualmente la scritta che appare sopra la pausa multipla. 

* Suddividi automaticamente battute d'aspetto: di default, Sibelius divide le pause multiple a 
posizioni nella partitura o nella parte ove è assolutamente necessario farlo (es. a cambi del 
tempo in chiave o in corrispondenza di stanghette doppie). Tuttavia, se il pezzo segue un fraseg-
gio regolare, può essere utile attivare questa impostazione e scegliere una delle seguenti due opz-
ioni:
% Suddividi in gruppi di n battute: se attiva, Sibelius divide le pause multiple in gruppi di n

misure. Per esempio, se una parte ha 14 misure di pausa e questa opzione è impostata a 
8, Sibelius scrive due pause multiple, la prima della durata di otto misure e la seconda di sei 
misure.

% Dividi quando il num. battute è multiplo di n: divide una pausa multipla in multipli di n
misure da una misura, tenendo conto di tutti i cambi numero misura. Per esempio, digitando 
8 qui e avendo una pausa multipla di 12 misure che inizia alla misura 3, la pausa multipla si 
divide in due pause multiple di 6 misure ciascuna, con la divisione tra le due alla misura 9; ciò 
significa che le pause multiple si divideranno sempre alla fine di frasi regolari da 8 misure 
(come nella musica jazz, pop e nei musical).

Per maggiori informazioni sulle pause multiple, b Pause multiple.
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7.4 Break - Interruzioni

b Numeri pagina, Layout e formattazione, Layout automatico, Impostazioni docu-
mento.

v Layout e Stile House.

I break (interruzioni) sono punti nella musica ai quali si forza la fine di un sistema o una pagina 
(per esempio, alla fine di una sezione). È come l’inizio di un nuovo paragrafo o pagina in un pro-
gramma di testo: in generale, esso distribuisce automaticamente parole e frasi nei paragrafi ed è 
sufficiente premere Invio per iniziare un nuovo paragrafo; più raramente, si deve premere 
Ctrl+Invio o X-Invio per inserire un break di pagina e iniziarne una nuova.

Sibelius esegue una procedura simile distribuendo automaticamente misure e sistemi sulle pagine; 
l’utente deve inserire un break solo quando ha bisogno che una determinata misura sia all’inizio di 
un nuovo sistema o pagina (tranne in casi particolari, le pagine di titolo o altre pagine prive di 
musica per favorire un cambio pagina in una parte strumentale, ad esempio). Per sottolineare 
l’analogia con un programma di testo, Sibelius usa per i break gli stessi comandi rapidi utilizzati 
dalla maggior parte dei programmi di testo.

Sibelius può anche inserire automaticamente break di sistema e pagina espliciti che consentono di 
far risparmiare molto tempo (specialmente per le parti) – b Layout automatico.

Per i consigli generali sul layout della partitura, b Layout e formattazione.

Inserire o togliere break di sistema o pagina manuali
Per inserire un break di sistema o pagina in un punto qualsiasi della partitura o parte:

* Selezionare la stanghetta alla quale inserire il break.
* Dal sottomenu Layout > Interruzioni selezionare Interruzione di accollatura (comando 

rapido Invio sulla tastiera principale) o Interruzione di pagina (comando rapido Ctrl+Invio o
X-Invio).

La musica si distribuisce in modo da terminare a un punto specifico – o meglio, Sibelius distri-
buisce i due sistemi che portano al break, dopodiché la misura che finisce con il break va sempre 
alla fine di un sistema o pagina.

Per rimuovere un break creato in precedenza, eseguire la stessa procedura oppure selezionare il 
simbolo di layout che appare sopra la stanghetta (vedere Visualizzare i break) e premere Canc.

Dove collocare i break di sistema?
Sebbene la funzione Auto Layout di Sibelius lo faccia automaticamente, può essere necessario 
forzare dei break di sistema:

* Alla fine di sezioni di musica (a una stanghetta di ripetizione, ad esempio).
* Alla fine di sezioni nelle parti (specialmente quando l’inizio della sezione successiva ha un nuovo 

titolo). Nelle parti, in generale, è meglio usare break di sistema invece che di pagina, per non 
avere spazi vuoti enormi nella parte.
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* Dove gli strumenti si dividono su due righi o riuniscono in uno, per non avere sequenze di mis-
ure di pausa non eseguite da tutti i musicisti.

Non inserire sempre break di sistema alla fine di sistemi normali, poiché ciò causa problemi di for-
mattazione se si cambia la musica (nel dubbio, non usare un break di sistema).

Dove collocare i break di pagina?
Sebbene la funzione Auto Layout di Sibelius lo faccia automaticamente, può essere necessario 
forzare dei break di pagina:

* In un punto ideale nelle parti sulle pagine destre, in modo che il musicista non debba girare pag-
ina mentre sta suonando.

* Alla fine di sezioni, specialmente quando all’inizio di quella successiva c’è un nuovo titolo.

Non inserire sempre break alla fine di ogni pagina, poiché è probabile che si danneggi la format-
tazione cambiando la musica. Se è indispensabile inserire un break, di solito si può usarne uno di 
sistema (perché un break di sistema sull’ultimo sistema di una pagina in pratica è come un break 
di pagina, ma ha meno impatto sul layout se si riformatta la partitura); nel dubbio, non usare un 
break di pagina.

Break di pagina speciali
A volte è necessario avere pagine senza musica in una partitura; per esempio, sulla copertina della 
partitura può esserci una o più pagine di titolo, una pagina per eseguire istruzioni tra i movimenti 
o una pagina vuota per facilitare un cambio pagina in seguito su una parte strumentale. Può essere 
necessario anche modificare i margini su pagine diverse della partitura (per far spazio a titoli e 
altri testi in cima alla prima pagina, ad esempio).

Sibelius facilita la creazione di tutti questi elementi grazie a un particolare break di pagina, 
denominato appunto break di pagina speciale; esso consente di creare una o più pagine vuote, oltre 
che modificare la pagina e i margini del rigo nelle pagine successive (non si deve creare una pagina 
vuota per cambiare i margini).

Per creare un break di pagina speciale:

* Selezionare la stanghetta alla quale inserire il break; per creare pagine vuote all’inizio della parti-
tura selezionare la stanghetta iniziale della prima misura (cioè quella a sinistra di tempo in chi-
ave e tonalità iniziali) o usare il comando Crea > Pagina Titolo – vedere in seguito.

* Scegliere Layout > Interruzioni > Interruzione pagina speciale (Ctrl+Maius+Invio o xX-
Return); appare una semplice finestra di dialogo:
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* Per creare una o più pagine vuote attivare il box di spunta Blank page(s) e scegliere uno dei tre 
tipi di pagina vuota disponibili:
% Numero di pagine vuote n: inserisce un numero fisso di pagine vuote.
% Musica riparte dalla successiva pagina di sinistra: inserisce una pagina vuota solo se la 

stanghetta alla quale il break di pagina speciale è attaccato si trova alla fine di una pagina sin-
istra (pari). Questa opzione è utile quando si preparano parti strumentali e si vuole essere 
sicuri che una certa coppia di pagine appaia insieme, senza che si debba voltare pagina. Non 
appena cambia il layout della partitura (per esempio, s’inseriscono o rimuovono misure 
prima di quella su cui è presente il break di pagina speciale) la pagina vuota appare e scom-
pare opportunamente.

% Musica riparte dalla successiva pagina di destra: inserisce una pagina vuota solo se il 
break di pagina speciale è alla fine di una pagina destra (dispari); come prima, anche questo è 
utile in alcune situazioni di preparazione delle parti strumentali.

* Per cambiare i margini delle pagine che seguono il break di pagina speciale attivare l’opzione 
Nuovi margini e cliccare su Margini; si apre un’altra finestra di dialogo – vedere Cambiare i 
margini di pagina e rigo con break di pagina speciali. Si noti che è possibile scegliere in 
modo indipendente le opzioni Pagine vuote e Nuovi margini, in modo da cambiare i margini 
di pagina e rigo senza inserire una pagina vuota, e viceversa.

* Cliccare su OK: si crea il break di pagina speciale; come per gli altri break, Sibelius mostra un 
simbolo blu chiaro sopra la stanghetta sulla quale è presente il break di pagina speciale.

Altrimenti, per creare semplicemente una singola pagina vuota selezionare la stanghetta oltre la 
quale inserire la pagina vuota (o scegliere la stanghetta iniziale all’inizio della misura 1 per creare 
una pagina di titolo che preceda la prima pagina di musica) e scegliere Interruzione Pagina Spe-
ciale dal menu nel pannello Misure della finestra Proprietà (b Proprietà).

Creare una pagina di titolo
Per creare una pagina di titolo quando si crea la partitura per la prima volta attivare l’opzione Crea 
pagina titolo nell’ultima pagina della finestra di dialogo File > Nuovo; per crearla in seguito 
selezionare Crea > Pagina titolo. Si può scegliere quante pagine vuote inserire all’inizio della parti-
tura, e Sibelius aggiungerà anche titolo e compositore sulla prima pagina vuota.

Creare testi e grafiche sulle pagine vuote
Difficilmente si creano pagine senza musica per lasciarle in bianco a lungo!

Non è possibile creare testi di rigo, parole o testi di sistema normali su una pagina vuota, perché 
tutti questi tipi di testo s’attaccano a misure o note (che non esistono su pagine vuote); è anche 
impossibile quindi copiare e incollare testi di rigo o sistema da una pagina con musica a una vuota.

È tuttavia possibile inserire testi su pagine vuote usando gli stili di testo del sottomenu Crea >
Testo > Pagina testo vuota – b Lavorare con i testi. Intestazioni e piè di pagina (es. testi 
Intestazione (dopo prima pagina) e numeri pagina) appaiono sulle pagine vuote come in quelle 
con musica.

È possibile anche inserire grafiche nelle pagine vuote con il comando Crea > Grafica. A differenza 
dei testi si possono copiare e incollare grafiche tra pagine di musica e pagine vuote. Per maggiori 
informazioni sull’importazione delle grafiche, b Importare le grafiche.

reference.book  Page 512  Wednesday, April 16, 2008  4:28 PM



7.4 Break - Interruzioni

513

Layo
ut

Modificare i break di pagina speciali
Per modificare un break di pagina speciale esistente (es. per cambiare il numero di pagine vuote o 
regolare i margini) selezionare la stanghetta sulla quale è presente il break o il segno di layout 
sopra la stanghetta e scegliere Layout > Interruzioni > Interruzione pagina speciale.

Si apre la finestra di dialogo Interruzione pagina speciale, la quale mostra le opzioni correnti di 
tale break di pagina speciale; eseguire le modifiche desiderate e cliccare su OK. Riducendo il 
numero di pagine vuote, Sibelius avvisa che tutti i testi e le grafiche su quelle pagine vuote saranno 
rimossi. Quando si cancellano pagine vuote, Sibelius inizia da destra (cioè elimina la pagina vuota 
più a destra).

Cancellare break di pagina speciali
Per eliminare un break di pagina speciale selezionare il segno di layout sopra la stanghetta sulla 
quale è presente il break e premere Canc; in alternativa, con il metodo usuale, si può sostituire il 
break di pagina speciale con un altro tipo di break (di sistema o pagina, ad esempio).

Quando si cancella un break di pagina speciale che genera una o più pagine vuote sono cancellati 
anche i testi o le grafiche presenti nelle pagine vuote.

Cambiare i margini di pagina e rigo con break di pagina speciali
È possibile cambiare i margini di pagina e rigo nelle pagine che seguono un break di pagina spe-
ciale: nella finestra Interruzione pagina speciale attivare Nuovi margini e cliccare sul pulsante 
Margini.

La finestra di dialogo che appare è basata su Layout > Imposta documento, ma con le opzioni di 
dimensione pagina e rigo disabilitate; vedere, b Impostazioni documento.

Break e parti dinamiche
I break che si creano nella partitura completa influenzano in modo diverso le parti dinamiche, 
dipende dalle opzioni scelte nella finestra Aspetto Parte Multipla (b Finestra Aspetto parte 
multipla). Di default, tuttavia:

* I break di pagina speciali nella partitura completa non appaiono nelle parti, perché in genere 
non si stampano per ogni parte le pagine di titolo e altri elementi di copertina.

* I break di pagina nell’intera partitura sono trasformati in break di sistema nelle parti, perché 
normalmente si usano per segnare l’inizio di una sezione o movimento nella partitura completa 
(che nelle parti di solito sono indicati con break di sistema, per risparmiare spazio).

* I break di sistema nella partitura completa non sono visualizzati nelle parti, perché in generale si 
usano per compattare la formattazione nell’intera partitura e sono irrilevanti per il layout delle 
parti.

Si può anche creare un break in una parte dinamica senza che influenzi l’intera partitura. 
Se, ad esempio, serve una pagina vuota per favorire un cambio pagina, crearla al solito modo nella 
parte in questione. I segni di layout sopra le stanghette ad indicare i break presenti possono appar-
ire in colori diversi nelle parti – vedere Visualizzare i break.

Rimuovere molti break
Per rimuovere i break di pagina e sistema nella partitura o in un passaggio di misure:
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* Selezionare le misure (o premere Ctrl+A o XA per selezionare l’intera partitura).
* Scegliere Layout > Formato > Sblocca formato (comando rapido Ctrl+Maius+U o xXU).

La musica si riformatta come in origine, con la formattazione rimossa dalle opzioni Layout > For-
mato. I break di pagina speciali, però, non sono rimossi dal comando Unlock Format.

Visualizzare i break
L’opzione Vista > Marchi Layout (attiva di default) mostra i break di sistema e pagina (oltre ad 
altra formattazione nella partitura) con i seguenti simboli:

È possibile eliminare i break automatici di sistema e pagina cliccando sul break (per eliminare un 
break di sistema, ad esempio, selezionare la stanghetta e premere Invio). Sibelius indica che un 
break è stato eliminato con una croce sul break stesso.

I segni di layout possono apparire in vari colori:

* I segni blu indicano i break nella partitura o visualizzati nelle parti.
* I segni arancione appaiono solo nelle parti e indicano i break presenti solo nelle parti (se è attiva 

l’opzione Vista > Differenze nelle parti) – b Lavorare con le parti. 
* I segni rossi dei break appaiono solo quando si usano break di pagina automatici e indicano un 

“pessimo” break di pagina automatico (cioè collocato in un punto non ideale – b Layout e 
formattazione.

Si noti che i segni di layout appaiono su entrambi i lati di un break: un break di sistema, ad esem-
pio, visualizza un simbolo sopra la stanghetta alla fine del sistema e sopra la stanghetta iniziale 
all’inizio del sistema successivo; un break di pagina speciale visualizza un simbolo sopra la stang-
hetta alla fine della pagina e sopra la stanghetta iniziale all’inizio della pagina successiva con 
musica; per cancellare il break selezionare un simbolo di layout qualsiasi e premere Canc.

Riunisci misure Break di sistema
manuale

Dividi pausa
multipla

Break di sistema
automatico

Break di sistema
automatico soppresso

Break di pagina
manuale automatico

Break di pagina Break di pagina
non adatto

Break di pagina
automatico soppresso

Break di pagina
speciale

Break di pagina
speciale soppresso

Sopra ogni stanghetta 
dopo trasformazione

in pagina

Fine sezione
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7.5 Impostazioni documento

b Stampa, Layout e formattazione, Break - Interruzioni.

v Layout e Stile House.

La finestra di dialogo Layout > Imposta documento (comando rapido Ctrl+D o XD) permette 
di definire dimensione pagina, dimensione rigo e margini della partitura. Sibelius riformatta la 
partitura immediatamente alle nuove impostazioni, quindi si possono provare varie dimensioni o 
forme del foglio o diverse dimensioni del rigo fino a trovare quelle migliori.

Poiché ciò influenza la quantità di musica per pagina e il numero di pagine nella partitura, si può 
usare la funzione Layout > Imposta documento per configurare la propria partitura a un numero 
qualsiasi di pagine desiderato; vedere b Layout e formattazione.

Cambiare le impostazioni pagina
Selezionare Layout > Imposta documento (comando rapido Ctrl+D o XD); si può quindi rego-
lare dimensione pagina, forma della pagina e dimensione del rigo, come descritto in seguito.

L’anteprima mostra l’aspetto della prima pagina in base alle impostazioni definite; cliccare sulle 
frecce per vedere le pagine successive.

Cliccando su OK la partitura si riformatta immediatamente in base alle nuove impostazioni; se il 
risultato non è soddisfacente, selezionare Modifica > Undo

Dimensioni del foglio
L’elenco Dim pagina presenta le dimensioni del foglio USA ed Europeo (sebbene si possano speci-
ficare altezza e larghezza desiderate):

Lettera 8.5 x 11” 216 x 279mm

Tabloid 11 x 17” 279 x 432mm (o “B”)

A5 5.9 x 8.3” 149 x 210mm (A4 piegato a metà)
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(I termini “Octavo” e “Quarto” si riferiscono ad altri tipi di foglio).

È possibile selezionare pollici, millimetri e punti con i rispettivi pulsanti: 1 pollice = 25,4 mm 
(esatti), 1 mm = 0,0397 pollici (quasi esatti) e 1 punto = 1/72 inch esatti = 0,353 mm (approssima-
tivi).

Alcune dimensioni consigliate per foglio e rigo sono:

* Tastiera, brani, strumenti solisti: Lettera/A4, righi da 0,25–0,3”/6–7 mm.
* Partiture per orchestra/banda: Lettera/Tabloid/A4/A3, righi da 0,1–0,2”/3–5 mm.
* Parti: Lettera/Concert/A4/B4, righi da 0,25–0,3”/6–7 mm.
* Musica corale: Lettera/A4 o inferiori, righi da 0,2”/5 mm.
* Libri per principianti: Lettera/A4, righi da 0,3–0,4”/8–10 mm.

Tutte queste dimensioni pagina sono in formato verticale (portrait); il formato orizzontale (land-
scape) è usato raramente (a parte la musica d’organo, le marching band e la musica per bande di 
ottoni); le edizioni musicali stesse spesso non corrispondono a una misura di foglio standard.

Dimensione del rigo
La dimensione del rigo è la distanza dal centro della linea in alto al centro della linea in basso del 
rigo; tutto in una partitura è scalato in base alla dimensione del rigo – note, chiavi, testi, ecc.

Si può digitare un valore per la dimensione del rigo o cliccare sulle piccole frecce per modificarlo 
in piccoli step; cliccare e tenere premuto le piccole frecce per vedere in anteprima i righi che si dila-
tano e restringono.

Sebbene le dimensioni del rigo varino notevolmente è bene tener conto del tipo di musica che si 
scrive. In generale, impostando una dimensione del rigo troppo piccola, i musicisti saranno a disa-
gio (senza nemmeno sapere bene il perché); per le dimensioni consigliate, vedere sopra.

B5 6.9 x 9.8” 177 x 250mm

A4 8.3 x 11.7” 210 x 297mm

B4 9.8 x 13.9” 250 x 354mm

A3 11.7 x 16.5” 297 x 420mm (grandezza doppia A4)

Band 5 x 7” 127 x 178mm (di solito con orientamento orizzontale)

Statement 5.5 x 8.5” 140 x 216mm

Hymn 5.75” x 8.25” 146 x 205mm

Octavo 6.75 x 10.5” 171 x 267mm

Executive 7.25 x 10.5” 184 x 266mm

Quarto 8.5 x 10.8” 215 x 275mm

Concert 9 x 12” 229 x 305mm

Folio 8.5 x 13” 216 x 330mm

Legal 8.5 x 14” 216 x 356mm

Part 9.5 x 12.5” 241 x 317mm

Part 10 x 13” 254 x 330mm
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Sibelius non cambia la dimensione del rigo senza il permesso dell’utente, quindi con molti stru-
menti su una pagina piccola i righi possono avvicinarsi molto tra loro (o perfino sovrapporsi!). Per 
evitarlo scegliere una dimensione più piccola del rigo (o una pagina più grande).

Margini pagina
Nella finestra di dialogo Layout > Imposta documento si possono anche impostare i margini 
pagina. La musica può essere scritta appena sopra i margini, ma non al di fuori di essi.

Per vedere i margini nella partitura (in linee tratteggiate blu) selezionare Vista > Margini pagina. 

La partitura può avere gli stessi margini (Uguali) sulle pagine sinistre e destre (opzione raccoman-
data per la stampa a singola facciata), margini speculari (Speculari), talvolta chiamati margini 
“interno” ed “esterno” o margini diversi (Diversi) sulle pagine sinistre e destre. 
I margini superiore e inferiore sono sempre identici sulle pagine sinistre e destre.

Nello specifico, con l’opzione Uguali selezionata i margini sono definiti così:

* Margine superiore: dove normalmente si colloca il numero pagina in alto (se è in cima alla pag-
ina).

* Margine inferiore: dove normalmente si colloca il numero pagina in basso (se è alla base della 
pagina).

* Margine sinistro: lato sinistro del nome strumento più a sinistra.
* Margine destro: estremità destra dei righi.

Margini del rigo
I margini del rigo controllano la distanza tra i righi superiore e inferiore su una pagina, i margini 
superiore e inferiore della pagina e la distanza tra il margine della pagina sinistra e il lato sinistro 
del sistema; ciò consente d’impostare la posizione di default dei righi sulla pagina.

È comune avere margini superiore e inferiore del rigo diversi sulla prima pagina di una partitura, 
per far stare elementi come il titolo e il nome del compositore in alto e i dettagli su copyright ed 
editore in basso; fortunatamente in Sibelius è un’operazione molto semplice:

Inserire i margini del rigo da usare sulla prima pagina di musica nella partitura nei box a sinistra, 
attivare il box di spunta Dopo prima pagina e digitare i valori da usare per le pagine successive 
nei box valore sotto quello di spunta.

Per il margine sinistro ci sono tre valori diversi, dipende se i righi hanno nomi strumento com-
pleti, parziali (per esempio, dopo la prima pagina) o nessun nome strumento. Le impostazioni per 
i nomi strumento sono nella pagina Strumenti della finestra di dialogo House Style > Regole 
tipografia – b Strumenti). 
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Questi valori s’aggiornano automaticamente cambiando la dimensione del rigo o la lunghezza del 
nome strumento (modificando un nome esistente, aggiungendo nuovi strumenti o creando un 
cambio strumento); non è possibile specificarli separatamente per le diverse pagine della partitura, 
perché s’aggiornano in base alla larghezza del nome strumento più lungo usato nell’intera partit-
ura.

Cambiare il setup del documento a metà partitura
Non si possono cambiare dimensione pagina, orientamento o dimensione del rigo a metà partit-
ura, ma è possibile cambiare i margini di pagina e rigo in ogni punto usando i break di pagina spe-
ciali – vedere Cambiare i margini di pagina e rigo con break di pagina speciali a 
pagina 513.
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7.6 Attaccature

In Sibelius, ogni oggetto in una partitura (note, linee, testi e così via) è attaccato sia in orizzontale 
sia in verticale alla musica, in modo da spostarsi correttamente quando cambia la formattazione 
della partitura.

Ciò rende la musica immune da tutte le modifiche di layout che ci possono essere in futuro, quindi 
non occorre muoversi qua e là per sistemare il tutto dopo una modifica sostanziale della partitura 
(l’aggiunta di un nuovo strumento, ad esempio).

Visualizzare le attaccature
Quando un oggetto è selezionato, una freccia grigia tratteggiata mostra a che cosa è attaccato. Essa 
indica il rigo al quale è attaccato l’oggetto e la posizione ritmica sul rigo. Per togliere la freccia gri-
gia disattivare l’opzione Vista > Linee collegamento; se invece si vogliono vedere tutte le attacca-
ture nella partitura premere Ctrl+A o XA per selezionare tutti gli oggetti nella partitura. 
Analogamente, per vedere tutti gli oggetti attaccati a un singolo rigo eseguire una triplo-clic del 
mouse sul rigo desiderato.

Sibelius può anche mostrare i righelli che indicano le distanze precise tra i righi e gli oggetti attac-
cati ad essi – b Menu Vista.

Visualizzare le attaccature nelle parti
La visualizzazione delle attaccature nelle parti è identica a quella in una partitura completa. Tutta-
via, le linee d’attaccatura possono essere colorate in rosso con intensità crescente man mano che 
l’oggetto si sposta lontano dalla posizione alla quale è attaccato (per avvisare che non dovrebbe 
essere spostato di tale entità) – b Lavorare con le parti.

Attaccamento orizzontale
Tutti gli oggetti sono attaccati orizzontalmente a posizioni ritmiche nella musica; spostando una 
nota a sinistra o a destra, tutte le note alla stessa posizione ritmica si spostano con essa.

Se un oggetto è attaccato a una nota la sua freccia d’attaccamento punterà alla nota (o alla posiz-
ione orizzontale della nota). Qualsiasi cosa collocata direttamente sopra o vicino a una nota 
rimane attaccata a quella nota; ad esempio, se una legatura inizia o finisce su una nota, l’intera leg-
atura si allunga o accorcia nel caso sia necessaria in futuro per seguire la nota.

Se un oggetto si trova a metà strada tra due note, si attacca ad una posizione ritmica intermedia; 
quindi, se un oggetto è a metà strada tra due note starà sempre a metà strada anche se la dimen-
sione dello spazio vuoto cambia. La figura sottostante mostra un classico caso ove le estremità 
delle forcine e la f sono collocate proporzionalmente tra le note anche quando la spaziatura cam-
bia:
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Poiché è Sibelius a farlo, si evita all’utente un gran lavoro di “pulitura” in caso di variazioni sostan-
ziali al layout (come la creazione di misure o l’aggiunta dei break di pagina o sistema).

Attaccamento verticale
La maggior parte degli oggetti si applica a un rigo particolare ed è posizionata in verticale rispetto 
ad esso; ad esempio, un trillo di tromba si applica solo al rigo di tromba e deve rimanere sopra il 
rigo di tromba se i righi si spostano. Gli oggetti che appartengono a un rigo particolare sono chia-
mati “oggetti del rigo”.

Spostando un rigo in basso e in alto tutti gli oggetti attaccati lo seguono. Ancor più importante è 
che tutti gli oggetti attaccati ai rispettivi righi appaiono nella rispettiva parte (o parti). 
È importante quindi che ogni oggetto del rigo sia attaccato al rigo corretto.

Per essere sicuri di questo tenere d’occhio la freccia d’attaccamento grigia – specialmente quando il 
testo si trova in una posizione ambigua tra due righi e potrebbe essere attaccato a uno dei due.

Attaccamento a un altro rigo
Se un oggetto tra due righi è attaccato al rigo sbagliato, trascinarlo con il mouse in modo che toc-
chi l’altro rigo e si riattacchi a quello – la freccia tratteggiata esegue uno scatto ad indicarlo. 
Spostare poi l’oggetto di nuovo sulla sua posizione originale.

Sibelius dispone del plug-in Controlla collegamenti che rileva in modo intelligente dove acci-
dentalmente l’oggetto potrebbe essere stato trascinato troppo lontano dal rigo previsto – b Plug-
in.

Un’avvertenza: non applicare due oggetti tra due strumenti separati con l’intenzione di applicarli a 
entrambi; si tratta di una convenzione usata talvolta nei manoscritti (mai nell’editoria musicale, 
perché è una notazione scorretta). Ogni oggetto del rigo s’attacca solo a un rigo, quindi non appar-
irà nelle parti contenenti il rigo dello strumento al quale l’oggetto non si è attaccato.

È tuttavia corretto scrivere un oggetto che si applica a entrambi i righi di uno strumento (come i 
segni dinamici tra i righi di tastiera, perché andranno a finire nella stessa parte).

Regolare le attaccature nelle parti
È impossibile cambiare l’attaccatura di un qualsiasi oggetto in una parte; trascinando un oggetto 
lontano dalla propria posizione di default in una parte, il suo punto d’attaccatura rimane fisso 
(cambiano solo i suoi offset orizzontale e verticale). Per cambiare l’attaccatura di un oggetto, 
spostarlo sulla sua nuova posizione nelle partitura completa; esso si sposterà anche nella parte.

Oggetti di sistema
Alcuni oggetti si applicano a tutti i righi in un sistema (non a un rigo in particolare) e sono chia-
mati “oggetti di sistema”; gli oggetti di sistema si colorano in porpora quando sono selezionati. 
Tipici esempi degli oggetti di sistema sono titoli, segni tempo, segni di prova e linee di 1° e 2° finale 
(misure 1a/2a volta). Sebbene questi oggetti appaiano in cima a un sistema (e qualche volta dupli-
cati anche più in basso) essi si riferiscono in realtà ad ogni rigo nel sistema; ad esempio, dovreb-
bero andare in ogni parte strumentale, non solo nello strumento in cima alla partitura.

Alcuni menu e finestre di dialogo distinguono gli oggetti di rigo e sistema; per esempio, nel menu 
Crea > Testo gli stili di testo che sono oggetti di sistema sono elencati sotto gli oggetti del rigo.
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Per definire sopra quali righi appaiono gli oggetti di sistema vedere Posizioni degli oggetti di 
sistema in b Posizioni di default.

Collocare gli oggetti in posti insoliti
Si può collocare una porzione di testo o un altro oggetto lontano dalla musica (ad esempio, in un 
margine). Si tenga sempre presente, però, che tutti gli oggetti sono attaccati alla musica, non fissati 
ad un punto particolare sulla pagina; gli oggetti di testo sul margine, ad esempio, sono attaccati 
generalmente alla misura più vicina nel rigo più vicino e restano ad una distanza fissa da quella 
misura.

Riformattando la musica, la misura si sposterà da qualche altra parte e l’oggetto potrebbe andare a 
finire in una posizione anche più insolita di quella prevista! Si può quindi bloccare la formattazi-
one del sistema o della pagina per impedirne la riformattazione. b Layout e formattazione.
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7.7 House Style™

b Foglio manoscritto, Modifica stili di testo, Timecode e hit point, Scrittura musi-
cale, Layout e formattazione, Posizioni di default, Pubblicazione.

v Layout e Stile House.

L’aspetto preciso di una partitura stampata è definito dal suo stile house; i vari editori hanno i pro-
pri stili house e Sibelius permette di modificare lo stile house in modo quasi illimitato.

Gli aspetti di uno stile house comprendono:

* Opzioni Regole tipografia – vedere in seguito.
* Stili di testo – b Modifica stili di testo

* Font e forme dei simboli – b Simboli, Font musicali, Modifica simboli

* Forme delle teste nota – b Teste nota, Modifica teste nota

* Definizioni strumento ed ensemble – b Modifica strumenti

* Forme delle linee – b Linee, Modifica linee

* Posizioni degli oggetti – b Posizioni di default

* Regole di spaziatura nota – b Spaziatura note

* Configurazione documento (es. dimensione pagina e rigo) – b Impostazioni documento

* Termini del dizionario di riproduzione – b Dizionario di riproduzione

* Impostazioni Multiple Part Appearance di default – b Lavorare con le parti

La maggior parte di queste opzioni può essere modificata dal menu House Style.

Stili house predefiniti
Quando si crea una nuova partitura o s’importa uno stile house (vedere in seguito), si può scegliere 
da un elenco di stili house già pronti (dipende dal tipo di musica e dall’aspetto complessivo che si 
desidera dare alla partitura).

Ogni nome di stile house indica il tipo di musica al quale è destinato (es. jazz), il font musicale 
usato (Opus, Helsinki, Reprise o Inkpen2) ed eventualmente il font di testo (Times, Georgia o 
Arial). Opus è un font musicale dall’aspetto standard, Helsinki è più tradizionale, Reprise e 
Inkpen2 sono manoscritti.

Times è un font di testo standard, Georgia è meno diffuso (e dall’aspetto più tradizionale) Serif e 
Arial (chiamato anche Helvetica) sono font sans serif moderni, dall’aspetto molto più contempora-
neo (e forse meno elegante). Gli stili house Reprise usano tutti il font Reprise sia per il testo sia per 
la musica; anche gli stili house Inkpen2 usano tutti il font Inkpen2 per il testo.

I tipi di musica sono:

* Standard – stile usato dal foglio manoscritto Blank; adatto per molti tipi di musica.
* Jazz – come Standard ma con stanghette di ripetizione alettate e tutte le articolazioni sopra il 

rigo, come si usa nella musica jazz.
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* Keyboard – per musica di tastiera solista; come Standard ma con i segni dinamici esattamente 
a metà tra le mani, senza nomi strumento né giustificazione del rigo.

* Larger notes – come Standard ma con una forma alternativa di testa nota che segue il design e 
i consigli della US Music Publishers Association.

* Lead sheet – come Jazz ma con stanghette iniziali scritte su sistemi a linea singola.
* Vocal – per musica vocale e corale; come Standard ma con i segni dinamici sopra il rigo, senza 

separatori di sistema e con i nomi strumenti centrati.

Si consiglia di prendere nota delle impostazioni Layout > Imposta documento (dimensione pag-
ina, dimensione rigo e margini) della partitura prima d’importarle in partiture esistenti; importare 
poi lo stile house incluse le Impostazioni documento e regole di tipografia; la partitura sarà 
così impostata per usare un foglio A4 e righi da 6 mm; dopo l’importazione, quindi, cambiare di 
nuovo le impostazioni Layout > Imposta documento ai valori che avevano in precedenza.

Stili house Reprise e Inkpen2
Gli stili house Reprise hanno molte impostazioni speciali; per esempio, i segni di prova sono racch-
iusi in box con un ombra sfumata, i titoli usano un font di timbro speciale chiamato Reprise Title
(nel quale tutti i caratteri sono maiuscoli, ma digitando minuscolo e maiuscolo si ottiene la stessa 
forma della lettera con imperfezioni diverse), mentre i nomi strumento nell’angolo in alto a sinis-
tra della prima pagina di parti dinamiche usano un altro font di timbro denominato Reprise 
Stamp. Si possono anche aggiungere parentesi tonde speciali a istruzioni testuali sopra o sotto il 
rigo – vedere Aggiunge parentesi quadre al font Reprise Script a pagina 422.

Gli stili house Inkpen2 non sono così particolari come Reprise, ma possono essere più piacevoli i 
caratteri leggermente più spessi di Inkpen2 rispetto a quelli Reprise (che sembrano scritti con un 
pennino più sottile). Anche altre linee (quelle di rigo, stanghette, legature e così via), in generale 
sono più spesse negli stili house Inkpen2 che in quelli Reprise.

Usando uno degli stili house manoscritti Reprise o Inkpen2, per avere un aspetto davvero auten-
tico della partitura, cambiare la struttura della carta in Carta, bianca increspata nella pagina 
Textures della finestra File > Preferenze (menu Sibelius in Mac).

Nella musica per tastiera provare a stampare con l’opzione Parentesi della finestra di dialogo File >
Stampa non attiva (comando rapido Ctrl+P o XP), per rendere manoscritto l’aspetto delle paren-
tesi, come sullo schermo (ciò non funziona su alcune stampanti).

Analogamente, per le parti attivare l’opzione Disegna H-bar con un simbolo nella pagina Bat-
tute in pausa della finestra House Style > Regole tipografia (Ctrl+Maius+E o xXE) per ren-
dere manoscritto l’aspetto delle pause multiple, sebbene alcune stampanti abbiano dei bug che ne 
impediscono una stampa corretta (e in casi estremi provocare perfino un blocco del computer!).

Regole di scrittura
Sibelius ha numerose regole di scrittura da personalizzare come parte del design del proprio stile 
house o per realizzare diversi stili house per vari tipi di musica; queste regole sono tutte definite 
nella finestra di dialogo House Style > Regole tipografia (Ctrl+Maius+E o xXE).

Le opzioni Regole tipografia includono posizioni preferite per le articolazioni, distanze tra le note e 
altri oggetti, giustificazione del rigo e così via.
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I dettagli delle opzioni sono sparsi tra i vari capitoli di questo Manuale Operativo; per esempio, 
le opzioni nella pagina Numeri misura sono descritte nei dettagli in b Numeri misura. Verifi-
care l’Indice a “Regole tipografia” per un elenco dei riferimenti pagina.

Impostare gli stili house per tutte le partiture
Le impostazioni dello stile house si applicano solo alla partitura sulla quale si sta lavorando, quindi 
per usare le stesse impostazioni su tutti i file, ci sono due possibilità:

* Configurare fogli manoscritti per gli strumenti che si usano più spesso contenenti lo stile house 
preferito (b Foglio manoscritto) oppure:

* Esportare gli stili house preferiti con il comando House Style > Esporta House Style (vedere 
sotto) e importarli in altri file; si può importare uno stile house su più file contemporaneamente 
(vedere Importare uno stile house).

Esportare uno stile house
È possibile esportare un file di stile house da una partitura o parte sul disco rigido per poi impor-
tarlo in altre partiture:

* Selezionare House Style > Esporta House Style.

* Inserire un nome per lo stile house e cliccare su OK.

Sibelius salva il nuovo stile house nella cartella dei dati d’applicazione dell’utente (vedere File 
modificabili dall’utente in b Lavorare con i file). A meno che non si desideri condividere 
lo stile house con qualcuno, non occorre preoccuparsi della destinazione del file, poiché Sibelius lo 
riconosce come stile house disponibile ogni volta che si avvia il programma.

Un editore può inviare i file di stile house sui quali si basa a tutti i suoi compositori, arrangiatori e 
copisti o importare lo stile house nelle partiture ricevute per verificarne l’aspetto.

Per maggiori dettagli sull’esportazione degli stili house dalle parti dinamiche, vedere Esportare 
stili house dalle parti a pagina 484.

Importare uno stile house
Per importare uno stile house nella partitura corrente:

* Se la partitura ha delle parti, assicurarsi di vedere l’intera partitura invece di una parte (per 
importare lo stile house nella partitura e in tutte le parti); si può anche importare uno stile house 
nelle parti – vedere a pagina 489.

* Selezionare House Style > Importa House Style.

* Scegliere lo stile house da importare dall’elenco.
* Disattivare tutte le opzioni da non importare, in modo che non sostituiscano le impostazioni 

esistenti; ciò consente (ad esempio) di trasferire solo gli stili di testo da una partitura a un’altra. 
Alcune opzioni servono ad altre, quindi non si possono disattivare in modo indipendente.

* Cliccare su OK.

* Il font di testo musicale (per i segni dinamici, di metronomo, ecc.) non s’aggiorna automatica-
mente; si deve selezionare House Style > Modifica tutti Font e scegliere quello corretto 
dall’elenco Carattere Musica Principale (Opus Text, Helsinki Text, Reprise Text o Inkpen2 
Text, dipende dal font musicale che si sceglie).
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Sibelius fornisce vari stili house predefiniti – vedere Stili house predefiniti; inoltre, ha un plug-
in che permette d’importare uno stile house particolare in una cartella piena di file – b Plug-in.

Se si usa spesso un particolare stile house, collocarlo nella cartella House Styles all’interno della 
cartella dei dati d’applicazione, per poterlo scegliere dalla finestra di dialogo File > Nuovo quando 
s’inizia una nuova partitura; per maggiori informazioni, vedere File modificabili dall’utente a 
pagina 562.

Importando una nuova regola di spaziatura nota in una partitura, le spaziature esistenti non sono 
toccate. La nuova regola è impiegata solo quando si creano altre note o si usa il comando Layout >
Ripristina spaziatura note (Ctrl+Maius+N o xXN); si possono quindi usare diverse spaziature 
per sezioni diverse di una partitura.

Quando s’importa uno stile house che modifica la posizione di default degli oggetti, la maggior 
parte di essi non sarà riposizionata, a meno che si selezionino gli oggetti (usando un filtro, ad 
esempio) e si scelga il comando Layout > Ripristina posizione (Ctrl+Maius+P o xXP).
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b Scrittura musicale, Layout e formattazione, Spaziatura rigo.

v Layout e Stile House.

Cambiare la spaziatura note in pratica significa regolare la distanza tra note, accordi, pause e 
stanghette; si può farlo in vari modi:

* Spostando singole note e pause a sinistra o destra con il mouse o premendo Maius+Alt+0/1 o
xz0/1 (premendo Ctrl o X per step grandi).

* Comprimendo o espandendo un passaggio musicale, selezionandolo e premendo alcune volte 
Maius+Alt+0/1 o xz0/1 (tenere premuto Ctrl o X per spostarlo in step più grandi).

* Usando il comando Layout > Formato > Adatta in un’Accollatura/Pagina per condensare o 
espandere il passaggio selezionato perché occupi un sistema o pagina – b Layout e format-
tazione

* Modificando la regola di spaziatura nota (vedere in seguito).
* Se alcune spaziature nota sono state perse e si vuole resettarle al valore di default selezionare un 

passaggio e scegliere Layout > Ripristina spaziatura note (Ctrl+Maius+N o xXN); ciò tiene 
conto anche dello spazio necessario per chiavi, alterazioni, parole, ecc..

Regola di spaziatura nota
Sibelius usa un sofisticato algoritmo di spaziatura nota denominato Optical™. E’ un pò più comp-
lesso di una semplice serie di spaziature per i vari valori nota; tuttavia, è possibile specificare le 
spaziature di base nella finestra di dialogo House Style > Regola spaziatura note: 

* Per ogni valore nota si specifica lo spazio non giustificato che segue. (“non giustificato” perché la 
giustificazione orizzontale aumenta lo spazio oltre le note/pause di una quantità che dipende dal 
contesto della musica).
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* Le distanze sono misurate dal lato sinistro di una nota a quello sinistro della nota successiva 
(inclusa cioè la larghezza della testa nota).

* Si può specificare il vuoto che precede la prima nota/pausa in una misura e la larghezza di una 
misura vuota.

* Consenti spazio extra per voci che collidono: è per il caso specifico in cui una nota in una 
voce opposta a un’intervallo di seconda deve essere spostata a destra; attivando questa opzione, 
Sibelius aggiunge uno spazio extra per consentire il collocamento della nota (altrimenti lo spazio 
sarebbe più stretto di quanto è in realtà).

* Le opzioni Abbellimenti controllano lo spazio di default attorno agli abbellimenti e lo spazio 
oltre l’ultimo abbellimento (prima della nota regolare successiva).

* Le impostazioni Spazio minimo definiscono il vuoto più piccolo che Sibelius lascia intorno a 
note, alterazioni, linee aggiuntive, code (bandierine su note senza tratti d’unione) ed a inizio e 
fine delle misure in casi di spazi estremamente limitati – questi valori, in genere, sono molto più 
piccoli di quelli di spaziatura “ideali” a sinistra nella finestra di dialogo. Sibelius include queste 
spaziature minime definite nei propri calcoli, con il risultato che le collisioni tra oggetti solidi 
sono molto rare, anche in situazioni di spazio molto ridotto. Solo se Sibelius non riesce a trovare 
la spaziatura minima totale tra tutti gli oggetti nel sistema è costretto a “schiacciarli” per avvici-
narli; a questo punto potrebbero verificarsi delle collisioni.

* Le opzioni Legature di valore controllano la lunghezza minima delle legature per evitare che si 
“schiaccino” o diventino invisibili quando c’è poco spazio; è possibile impostare lunghezze min-
ime diverse per le legature sopra o sotto le note e quelle tra le note.

* Le opzioni Parole/Versi deteminano se la larghezza delle parole è considerata quando si spazia 
la musica, insieme alle opzioni del vuoto di default tra le parole (per lasciare spazio extra ai trat-
tini delle parole) e se le sillabe lunghe all’inizio della misura possono sporgere sulla stanghetta 
della misura precedente – b Parole.

Per maggiori dettagli su come queste opzioni regolano la spaziatura, b Scrittura musicale.

La finestra di dialogo House Style > Regole tipografia (comando rapido Ctrl+Maius+E o xXE) 
ha le impostazioni per stabilire il vuoto tra gli oggetti diversi da note e pause. Inoltre, la pagina 
Note e Tremolo consente a Sibelius di ridurre leggermente la spaziatura nota per completare le 
misure in modo più ordinato su un rigo.

Attenzione! I valori inseriti nella finestra di dialogo Regole spaziatura note possono sembrare 
leggermente diversi quando si riapre la finestra; Sibelius misura le distanze in 1/32 di uno spazio, 
ma le divisioni decimali di uno spazio sono più facili da capire per i comuni mortali delle frazioni 
da 1/32! Qualsiasi valore digitato nella finestra, quindi, sarà arrotondato a 1/32 di spazio più 
vicino.

Note non allineate
Sibelius gestisce automaticamente l’allineamento delle note, anche in situazioni complesse a più 
voci; a volte, però, può essere necessario modificare la posizione orizzontale di una singola nota in 
una misura. Per farlo, selezionare la nota, aprire il pannello Generale della finestra Proprietà e 
cambiare il parametro X che ne regola l’offset orizzontale; valori negativi spostano la nota a sinis-
tra, valori positivi la spostano a destra; le unità sono spazi. b Proprietà.
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Ottimizzare la spaziatura nota
Come molte altre cose nella scrittura musicale, la spaziatura nota è un’arte esoterica per la quale 
non ci sono regole rigide e sicure (b Scrittura musicale).

Le note non sono e non devono essere spaziate in proporzione ai valori nota (b Scrittura musi-
cale), quindi è normale che le misure s’allarghino e si restringano quando la musica cambia; tutta-
via, se la variazione nei valori nota è molto grande e riguarda ritmi incrociati tra righi diversi, la 
spaziatura può diventare piuttosto irregolare (per esempio, le note nel box sottostante):

Serve quindi un compromesso tra l’uso di questa spaziatura irregolare di default e quello di una 
spaziatura proporzionata per far apparire la seconda metà della misura 1 come la prima metà 
(cosa che al confronto renderebbe la misura 2 troppo piccola).

Una buona strategia è fare in modo che la spaziatura nota sia regolare movimento per movimento 
o misura per misura; in tal caso, si può far diventare la prima misura abbastanza regolare e la sec-
onda regolare ma non troppo più stretta della prima, così:

In pratica, è stata leggermente accorciata rispetto alla prima la seconda metà della misura 1, per 
avere un passaggio più omogeneo alla spaziatura (comunque più stretta) della misura 2. C’è uno 
spazio extra per l’alterazione tra le note SOL e SIb da 1/16 nel rigo inferiore; questa notazione è 
abbastanza accettabile in situazioni di spazio limitato.

Ottimizzare la spaziatura delle parole
La musica con parole presenta problemi particolari di spaziatura nota (specialmente se i valori 
nota sono brevi e le parole sono lunghe). Spaziandola musica solo in base alla durata delle note si 
avrebbero risultati di questo tipo:

Spaziatura di default

Meglio : dopo una regolazione manuale

Spaziatura non regolare 
a causa del bemolle

Spaziatura solo in base alle note
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Fortunatamente, Sibelius inserisce uno spazio extra tra le note per le sillabe molto larghe, per evi-
tare collisioni; tuttavia, se alcune sillabe sono larghe e altre non lo sono, la spaziatura nota 
potrebbe diventare molto irregolare, così:

Si noti come le parole siano ben distanziate, ma le note non lo siano; la loro spaziatura varia in 
modo irregolare (in particolare per quelle nel box). Naturalmente, questo è un esempio abbastanza 
problematico: le parole “scratched” e “stretched” a nove lettere ciascuna, infatti, sono tra le sillabe 
più lunghe nella lingua inglese (un primato che condividono con la parola “squelched”); anche la 
parola “through” (che ricorre spesso) è quasi altrettanto problematica.

Per rendere accettabili sia la spaziatura nota che quella delle parole, bisogna scendere a un com-
promesso; come per l’ottimizzazione della spaziatura nota (vedere in precedenza) una buona 
strategia è regolarizzare la spaziatura delle parole movimento per movimento o misura per misura; 
quindi, se c’è un movimento (o misura) con una sillaba molto lunga regolare la spaziatura di tutte 
le note in quel movimento o misura in modo che corrispondano alle parole.

In situazioni di spazio molto limitato è utile spostare un pò in orizzontale alcune sillabe (in modo 
da beneficiare dello spazio libero attorno alle sillabe precedenti o successive); probabilmente il 
risultato migliore che si può ottenere nell’esempio precedente è questo:

Default di Sibelius: spaziatura più ampia in parole lunghe (per evitare collisioni)

Ottimale: spaziatura note e parole omogenea 
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7.9 Spaziatura rigo

b Righi, Menu Vista, Layout e formattazione, Scrittura musicale, Layout automat-
ico, Break - Interruzioni, Impostazioni documento.

 
Questo capitolo spiega come modificare la posizione verticale dei righi nella partitura; altri tool di 
layout e formattazione sono descritti nei dettagli in b Layout e formattazione, Layout 
automatico, Break - Interruzioni (es. break di sistema), Impostazioni documento (es. 
dimensione pagina e rigo), Spaziatura note.

Per modificare la spaziatura verticale di righi e sistemi:

* Modificare le impostazioni nella pagina Righi della finestra di dialogo House Style > Regole 
tipografia (comando rapido Ctrl+Maius+E o xXE) per cambiare la spaziatura di default di 
rigo e sistema e la giustificazione da inizio a fine partitura.

* Spostare i righi in verticale per regolare la spaziatura sopra e sotto di essi; se necessario, Sibelius 
“schiaccia” leggermente gli altri righi per creare lo spazio necessario a farlo.

* Spostare i righi in verticale senza influenzare la posizione di altri righi.
* Applicare la posizione dei righi su una determinata pagina ad altre pagine usando la finestra di 

dialogo Layout > Allinea righi.
* Resettare la spaziatura ai valori di default.

Tutte queste procedure sono descritte nei dettagli in seguito.

Spaziatura di rigo e sistema
Righi e sistemi sono spesso distribuiti (“giustificati”) per riempire una 
pagina fino in fondo; le regole si definiscono nella pagina Righi della 
finestra House Style > Regole tipografia (Ctrl+Maius+E o xXE):

* spazi tra i righi/accollature: questi valori regolano la distanza stan-
dard tra righi e sistemi; aumentare il valore staves se la partitura ha 
molte linee aggiuntive o più strofe di parole. Diminuendo il valore 
accollature si risparmia spazio nelle parti. Su pagine con musica gius-
tificata in verticale la distanza tra righi e sistemi è superiore ai valori 
specificati.
*giustifica righi se la pagina è al meno n% completa: controlla 

quanto Sibelius riesce a giustificare; a valori bassi Sibelius distribuisce solo pochi righi e sistemi 
per riempire una pagina (che può apparire buffa!). A valori superiori Sibelius è più incline a col-
locare righi e sistemi in alto invece che distribuirli ovunque; il valore di default è 65% (i righi 
sono giustificati se la pagina è almeno due terzi della musica). Impostarlo a 100% per disatti-
vare completamente la giustificazione.

* Spaziatura accollatura restringibile del n%: permette a Sibelius di “schiacciare” i sistemi più 
del normale per avere un sistema su una pagina (sempre che la spaziatura tra i sistemi non 
scenda sotto la percentuale specificata dal valore di spaziatura di default).

Vuoti tra i righi
Non è necessario che i vuoti 
tra i righi siano uguali in 
tutta la partitura – regolarli 
ove serve per lasciare spazio 
a note gravi/acute ecc..

In grandi partiture per molti 
strumenti di solito si lascia 
un vuoto extra a sinistra 
delle famiglie strumentali, 
come fiati, ottoni e archi.
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Spostare i righi
Per la maggior parte delle operazioni sul rigo, incluso lo spostamento, prima bisogna selezionare il 
rigo (o righi) sul quale lavorare:

* Cliccare su una zona vuota di una misura per selezionarla (un doppio-clic seleziona il rigo, ma la 
selezione di una misura è sufficiente per spostare righi, ecc.).

* Triplo-clic su una zona vuota di una misura per selezionare un rigo in tutta la partitura.
* Per lavorare su più righi selezionare un passaggio (utile per modificare i vuoti tra i righi di tasti-

era o in tutte le famiglie strumentali).

Per maggiori informazioni sulle selezioni, b Selezioni e passaggi.

I metodi principali per spostare i righi sono:

* Spostamento normale – selezionare un rigo (o righi) e trascinarlo con il mouse (comando rapido 
Alt+3/2 o z3/2, con Ctrl o X per step più grandi): cambia la distanza tra il rigo/righi selezi-
onato e il rigo sopra (o il margine superiore della pagina se è selezionato il rigo in alto) e rimane 
la spaziatura tra tutti gli altri righi; può darsi che Sibelius debba “schiacciare” altri righi per fare 
spazio se la pagina è piena.

* Spostamento indipendente – selezionare un rigo (o righi) e premere Maius-trascinamento 
(comando rapido Maius+Alt+3/2 o xz3/2, con Ctrl o X per step più grandi): sposta solo il 
rigo/righi selezionato lasciando tutti gli altri righi alla stessa posizione sulla pagina; sebbene si 
possano quasi spostare i righi uno sopra l’altro non è possibile spostare un rigo oltre un altro in 
nessuna direzione (cambiando quindi l’ordine dei righi nella partitura). Per farlo, 
b Strumenti).

Prima di spostare i righi può essere utile attivare l’opzione Vista > Righelli > Righelli rigo
(comando rapido Ctrl+Maius+Alt+R o xzXR) – b Menu Vista.

Quali siano righi e sistemi spostati con precisione dipende dall’estensione della selezione iniziale. 
Ciò significa che si può modificare la spaziatura tra i righi sullo stesso sistema, le stessa pagina o 
qualsiasi numero di pagine, semplicemente selezionando il passaggio per il quale modificare la 
spaziatura; si può anche selezionare un passaggio contenente più righi e spostarlo in alto e in basso 
in modo indipendente (per cambiare il vuoto sopra il rigo in alto selezionato e/o sotto il rigo in 
basso selezionato).

Esempi:

* Per inserire uno spazio extra tra le famiglie di legni e ottoni da inzio a fine partitura, triplo-clic 
del mouse sul rigo di ottoni più in alto e spostarlo in basso.

* Per cambiare la spaziatura tra il rigo inferiore su una pagina e il margine della pagina (per far 
spazio a un piè di pagina o una linea di copyright, ad esempio) cliccare sul rigo inferiore e 
spostarlo in modo indipendente.

* Per cambiare la distanza tra i righi di Contralto e Tenore su un singolo sistema di una partitura 
corale (per sistemare le parole in un passaggio di note gravi di Contralto) doppio-clic del mouse 
su una misura di Tenore e trascinarla in basso.
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Allineare i righi
Per applicare la spaziatura di rigo e sistema su una pagina della partitura ad altre pagine selezion-
are un passaggio che si estende nelle pagine da modificare e scegliere Layout > Allinea righi.

Tutte le modifiche eseguite da questa finestra di dialogo sono applicate a tutte le pagine sulle quali 
appare il passaggio selezionato, quindi si può selezionare da qualsiasi misura su ogni rigo della 
prima pagina da modificare a qualsiasi misura su ogni rigo dell’ultima pagina; le opzioni sono:

* Blocca il formato prima delle modifiche: blocca la formattazione di tutte le misure nelle 
pagine selezionate; le misure rimangono sulle stesse pagine dopo l’allineamento dei righi.

* Ripristina la posizione dei righi: queste opzioni ristabiliscono il vuoto di default sopra il rigo 
superiore o inferiore su una pagina alle posizioni del margine di rigo (definito nella finestra di 
dialogo Layout > Imposta documento).

* Allinea i righi nelle pagine selezionate: se attiva, si può scegliere una delle quattro opzioni 
disponibili:
% Con la prima pagina selezionata: allinea tutte le pagine successive con la prima pagina 

della selezione.
% Con l’ultima pagina selezionata: allinea tutte le pagine precedenti con l’ultima pagina della 

selezione.
% Pagine destre con pagine sinistre di fronte: allinea ogni pagina destra con la pagina sinis-

tra di fronte.
% Pagine sinistre con pagine destre di fronte: allinea ogni pagina sinistra con la pagina 

destra di fronte.

Per usare queste opzioni si deve selezionare più di una pagina.

L’allineamento dei righi in questa finestra è possibile solo se le pagine da allineare hanno lo stesso 
numero di sistemi e di righi su ogni sistema, altrimenti si allineano solo i righi superiore e inferi-
ore (se una o entrambe le pagine ha solo un sistema si allinea solo il rigo superiore).

Ristabilire la spaziatura rigo di default
Per ristabilire la spaziatura di default (cioè le impostazioni definite nella pagina Staves della 
finestra House Style > Regole tipografia) su un rigo (o righi) selezionare il passaggio desiderato 
e scegliere Layout > Ripristina spazio sopra il rigo o Layout > Ripristina spazio sotto il rigo.

Per resettare la spaziatura sopra o sotto i righi superiore o inferiore in una serie di pagine nello 
stesso momento è meglio usare la finestra di dialogo Layout > Allinea righi (vedere sopra).
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7.10 Font musicali

b Modifica stili di testo, House Style™, Modifica simboli.

Teste nota, chiavi, alterazioni e gran parte degli altri oggetti nelle partiture di Sibelius sono scritti 
in simboli (cioè un carattere o una combinazione di caratteri di un font musicale).

I font musicali si sono moltiplicati in modo piuttosto disordinato negli anni; vari font spesso sono 
costituiti da alcuni simboli musicali più o mneo casuali e spesso inadeguati. I gusti sono diversi sui 
font musicali; inoltre, ogni font ha vantaggi e svantaggi, quindi nessuno è “ideale”.

Per questo motivo è stata posta molta cura nell’inserire in Sibelius i font musicali di quasi tutti i 
simboli più usati o disponibili in altri font e soprattutto le forme dei simboli più adatte alla stampa 
di edizioni professionali.

Tuttavia, proprio perchè i gusti sui font musicali sono molto diversi, abbiamo cercato di evitare la 
confusione con altri font musicali, in modo che Sibelius sia compatibile con qualsiasi altro font 
musicale che l’utente preferisce usare – sono stati inseriti i font Petrucci™, Chaconne™, Sonata™, 
Susato™, Jazz™, Franck™, Maestro™, November™, Partita™, Swing™, Tamburo™, Piu™ e Ghent™. 
Si possono anche usare insieme tutti questi font nella stessa partitura.

Cambiare font musicale
Il modo più semplice per cambiare il font musicale usato dalla partitura è selezionare House 
Style > Modifica tutti Font, sceglierne uno nuovo dall’elenco Carattere Musica Principale e 
cliccare su OK.

I font che seguono appaiono come opzioni nella finestra di dialogo Edit All Fonts (se sono instal-
lati nel sistema operativo): Opus, Helsinki, Reprise, Inkpen2, Maestro, Petrucci, Sonata, Partita, 
Franck, Virtuoso, Chaconne, November, Jazz, Swing, LeeMusic, RussMusic e AshMusic.

Per inserire altri font musicali nell’elenco, vedere Usare font non forniti da Sibelius.

Molte partiture di Sibelius utilizzano il font Opus. Per passare all’aspetto manoscritto di Reprise o 
Inkpen2 è meglio importare gli stili house Reprise o Inkpen2, poiché ciò cambia anche l’aspetto di 
altri oggetti (rigo e stanghette, legature, forcine, e così via – b House Style™).

Si può usare anche il font musicale Helsinki di Sibelius dall’aspetto più tradizionale ed elegante. 
Come per i font Reprise e Inkpen2 bisogna importare uno stile house Helsinki per beneficiare dei 
particolari che lo stile house apporta ad altri aspetti visivi della partitura – b House Style™.

Cambiare il font di un subset di simboli
Per cambiare font musicale, non è necessario cambiare tutti i simboli di Sibelius; basta cambiare 
solo le chiavi o i simboli percussivi, oppure solamente un singolo simbolo.

In Sibelius ogni simbolo è scritto con il font specificato da un particolare stile di testo. Modificando 
le impostazioni dello stile di testo cambia simultaneamente l’aspetto d’interi set di simboli:

* Simboli comuni: sono quasi tutti i simboli comuni usati normalmente – note standard, alter-
azioni, chiavi, articolazioni, ecc..
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I simboli comuni si possono cambiare (Common symbols) in Reprise, Inkpen2, Helsinki, 
Petrucci, Susato o Sonata; Sonata ha chiavi in posizioni non-standard (ma si possono spostare).

* Teste di nota speciali, ecc.: sono simboli insoliti di teste nota e microtoni; è possibile sosti-
tuirli con i font Reprise Special, Inkpen2 Special, Helsinki Special, Tamburo o Piu.

* Strumenti percussivi: strane figure di mazze, spazzole, coins e qualsiasi cosa si possa colpire; è 
possibile sostituirle con il font Ghent.

* Simboli speciali: sono simboli che non si trovano in altri font, tranne Opus Special, Reprise 
Special, Helsinki Special e Inkpen2 Special, quindi non sono da sostituire con un altro font (a 
meno che se ne progetti uno proprio).

* Note flags: si può cambiare tra Opus, Helsinki, Reprise, Inkpen2 e Petrucci – Susato, Sonata, 
ecc. non sono adatti perchè hanno bandierine (flag) incompatibili.

Per cambiare il font in uno di questi set di simboli:

* Nella finestra di dialogo House Style > Modifica simboli cliccare su Font musicali.

* Cliccare sul set simbolo da modificare e cliccare su Modifica.

* Cambiare il font (ed eventualmente anche la dimensione), cliccare su OK e ancora su OK per 
chiudere la finestra di dialogo Modifica Simboli.

Se si vuole modificare la dimensione, quella standard per tutti i simboli è 19.8 punti (relativa) – 
aumentando o diminuendo questo valore il simbolo diventa più grande o più piccolo; si può usarlo 
(ad esempio) per ingrandire le note nei metodi per principianti o per scalare un simbolo (creando 
uno stile di testo per esso) – vedere Creare un nuovo stile di testo per il simbolo in 
b Modifica simboli.

Per i curiosi: la modifica del font musicale e della sua dimensione ha luogo nella finestra di dialogo 
House Style > Modifica stili testo. Questo perchè Sibelius, in pratica, tratta i set di simboli come 
stili di testo, sebbene font e dimensioni sono soltanto opzioni che si possono modificare utilmente 
(non è il caso di pensarci troppo!).

Per maggiori informazioni sulla personalizzazione dei simboli di Sibelius, b Modifica simboli.

Font di testo musicale
Vari simboli musicali (es. f, p e q) possono essere digitati come testi Expression e segni di met-
ronomo. Questi caratteri, denominati testo musicale, di default sono scritti nel font Opus Text, 
poiché sono i numeri 0–9 e il carattere : (due punti) usati nei gruppi irregolari (tuplet).

Il font usato per il testo musicale si cambia nella finestra di dialogo House Style > Modifica 
tutti Font. Si raccomanda di cambiarlo solo in font di testo corsivo o grassetto e cambiarlo in font 
di testo normale solo se non si usano i segni di metronomo (poiché i font di testo non hanno le fig-
ure delle note).

Tuttavia, per cambiare il font di testo musicale e usare ugualmente i segni di metronomo, si può 
cambiare di nuovo manualmente il font per i segni di metronomo a Opus Text, Helsinki Text, 
Reprise Text o Inkpen2 Text mentre li si inserisce.

Cambiando il font di testo musicale, un’opzione consente di scegliere se applicare o meno la modi-
fica al testo esistente nella partitura; ciò permette, ad esempio, di cambiare il font usato per i segni 
dinamici già nella partitura; non si può farlo modificando lo stile di testo Expression, poiché gli 
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stili di testo definiscono solo il font usato per i testi normali (es. cresc.), non per i caratteri di testo 
musicali come mf.

Usare font non forniti da Sibelius
Sibelius consente di usare qualsiasi font musicale compatibile per la notazione nella partitura. 
Poiché (per il computer) un font è semplicemente un font, perchè Sibelius possa usarli bisogna 
dirgli quali sono i font musicali validi presenti nel sistema operativo.

I font musicali supportati sono elencati nella finestra di dialogo House Style > Modifica tutti 
Font; quando s’informa Sibelius di un nuovo font musicale, esso appare in Carattere Musica 
Principale.

Selezionare la pagina Font musicali nella finestra di dialogo File > Preferenze (menu Sibelius in 
Mac); si apre la seguente finestra di dialogo:

L’elenco dei font a sinistra mostra quelli che Sibelius riconosce come font musicali; per aggiungere 
un nuovo font all’elenco:

* Digitare il nome del nuovo font musicale nel campo Font musicale a sinistra o cliccare sul pul-
sante Scegli per sceglierlo da un elenco di font installati sul computer. Una volta inserito il nome 
del font cliccare sul pulsante Aggiungi Font; il font è inserito nell’elenco.

* Con il nuovo font selezionato nell’elenco a sinistra inserire il nome del font da usare per ogni 
aspetto della notazione nei vari campi a destra o cliccare sul pulsante Scegli per selezionare il 
font da un elenco; una volta completati i campi cliccare sul puslante Imposta Sostituzioni.

Pochissimi font musicali disponibili hanno font separati adatti a tutti gli stili di testo per i simboli 
di Sibelius; di solito, quindi, basta sostituire il font scelto in Simboli comuni.

Installare i font musicali Type 1
I font musicali Opus, Helsinki, Reprise e Inkpen2 sono sia in formato TrueType che Adobe Type 1 
(PostScript) e i font TrueType sono installati di default; è possibile stampare su stampanti Post-
Script e creare file EPS usando uno di questi formati dei font.

Tuttavia, per esigenze editoriali, i font Adobe Type 1 sono preferiti ai font TrueType (sebbene di 
solito si deve installare un software per usarli). In Windows, le versioni Type 1 di Opus, Helsinki, 
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Reprise e Inkpen2 sono nella cartella PostScript Fonts (all’interno della cartella Extras nella car-
tella programma Sibelius). In Mac, i font Type 1 si trovano nella cartella Other Applications del 
DVD-ROM di Sibelius 5.

Realizzare i propri font musicali
Per la realizzazione di ogni tipo di font si consiglia il programma FontLab (www.fontlab.com); 
tuttavia la realizzazione di un font è un’arte complessa, quindi non è consigliata ai principianti.

Le famiglie dei font Opus, Helsinki, Reprise e Inkpen2 sono protette da copyright, quindi è vietato 
usare i rispettivi simboli per qualsiasi nuovo font realizzato dall’utente.
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7.11 Posizioni di default

Solo per utenti esperti

La finestra di dialogo House Style > Posizioni di Default consente di cambiare il modo in cui si 
posizionano testi, linee e vari altri oggetti quando li si crea, li si sposta e si ripristinano le rispettive 
posizioni; in Sibelius le impostazioni di default sono “intelligenti” quindi di solito non è necessario 
cambiarle, ma nel caso lo si debba fare questo capitolo spiega come.

La finestra di dialogo è la seguente:

Per cambiare la posizione di default di un oggetto scegliere la rispettiva categoria nell’angolo in 
alto a sinistra (Stili di testo, Linee o Altri oggetti) e poi selezionare lo stile di testo o l’oggetto 
desiderato dall’elenco; è possibile anche selezionare più stili od oggetti per modificare le rispettive 
proprietà comuni nello stesso momento.

Le opzioni non applicabili allo stile di testo od oggetto selezionato sono disabilitate (per gli stili di 
testo non si possono impostare le opzioni Creare Linee e viceversa). Analogamente, selezionando 
più linee (ad esempio) i valori che tutti gli oggetti selezionati hanno in comune sono indicati nella 
finestra di dialogo, mentre quelli non in comune appaiono vuoti.

Le opzioni nella finestra di dialogo sono:

Creare un Oggetto
Ci sono opzioni separate per creare gli oggetti con il mouse e la tastiera. Creando gli oggetti con il 
mouse, si può cliccare con precisione nel punto in cui si desidera collocarli; creandoli con la tasti-
era, non si può indicare con precisione dove crearli, quindi essi appaiono in una posizione “intelli-
gente” vicino al cursore (se s’inseriscono note) o all’oggetto selezionato.

Si può fare in modo che di default gli oggetti appaiano in posizioni diverse nelle parti rispetto alla 
partitura. In generale non è necessario, ma gli oggetti come i segni di prova di solito sono più visi-
bili se collocati vicino alla cima di un rigo nelle parti che nella partitura; Sibelius consente (ad 
esempio) di collocare i segni di prova a cinque spazi di distanza dai righi nella partitura e a solo 
due spazi dai righi nelle parti.
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Le opzioni Con tastiera (o Posizione Ripristino) controllano le regola per il posizionamento 
dell’oggetto quando lo si crea con la tastiera, oppure quando lo si seleziona e si sceglie il comando 
Layout > Ripristina posizione (comando rapido Ctrl+Maius+P o xXP):

* Posizione orizzontale relativa a nota: stabilisce la posizione orizzontale di default sia per la 
partitura che per le parti; inserire valori negativi per collocare gli oggetti a sinistra della nota alla 
quale sono attaccati (nel caso dei segni dinamici, ad esempio).

* Posizione verticale relativa a rigo: posiziona automaticamente l’oggetto in verticale, secondo 
l’opzione scelta alla base della finestra di dialogo nella sezione Posizione verticale (Sopra 
inizio rigo, Sotto fine rigo, Sopra centro del rigo e Sotto centro del rigo). 
Si possono inserire valori diversi per la partitura e le sue parti, se lo si desidera.

Le opzioni Con il mouse determinano se l’oggetto creato con il mouse si colloca alla sua posizione 
orizzontale e/o verticale di default (come stabilito dalle impostazioni Con tastiera descritte in 
precedenza) invece che alla posizione del mouse; ad esempio:

* Testi come simboli accordo, basso figurato, diteggiatura e parole sono più utili se creati alle ris-
pettive posizioni orizzontale e verticale di default;

* Testi di sistema (titolo, compositore, copyright, piè di pagina, e così via) è meglio siano creati alle 
rispettive posizioni verticali di default;

* Alcuni altri stili di testo (come quelli per i segni di tempo e metronomo) è meglio siano creati 
alla posizione in cui si clicca con il mouse – in tal caso disattivare entrambe le opzioni Con il 
mouse.

Spostare un oggetto
Sebbene tutti gli oggetti in una partitura possano essere trascinati con il mouse, si può avere un 
controllo più preciso spostandoli con i tasti freccia e i rispettivi tasti di modifica (es. 0/1 per pic-
coli incrementi e Ctrl+0/1 o X0/1 per incrementi più grandi). Le opzioni Spostare un oggetto
consentono il controllo di queste operazioni:

* Frecce spostano di ..... spazi: è la distanza alla quale si sposta un oggetto mosso con i tasti frec-
cia.

* Ctrl+frecce/Command-frecce spostano di: è la distanza alla quale si sposta un oggetto 
mosso con i tasti freccia insieme al tasto Ctrl o X.

* Soglia trascinamento mouse: stabilisce quanto lontano si deve trascinare un oggetto con il 
mouse prima che si sposti dalla sua posizione corrente; impostare un valore elevato per far 
diventare gli oggetti più “adesivi” ed evitare quindi di trascinarli accidentalmente.

È possibile regolare separatamente queste opzioni per stili di testo e linee, ma non per stili di testo 
o linee individuali; tutte le modifiche a queste impostazioni, quindi, influenzano tutti gli oggetti 
simili (es. cambiando la soglia di trascinamento per il testo Technique la si cambia anche per tutti 
gli altri stili di testo). Le opzioni Spostare un oggetto (a differenza delle altre in questa finestra) 
sono preferenze globali, perciò non associate a una partitura particolare – si applicano a ogni par-
titura sulla quale si lavora in Sibelius.
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Creare Linee
Posizione orizzontale dell’estremità per la mano destra: come suggerisce il nome, determina 
quanti spazi di default a destra della fine di una linea appare l’estremità destra.

Creare Testo
Sopra/Sotto inizio/centro/fine del rigo: stabilisce la posizione della base delle lettere maiuscole 
rispetto alla linea del rigo specificata; la distanza dalla linea del rigo è specificata in Con tastiera 
(o Posizione Ripristino) sulla parte superiore della finestra di dialogo.

Alcuni stili di testo (come le parole, il basso figurato e i simboli accordo) si creano saltando da nota 
a nota con la barra spaziatrice (spazio) - b Parole, Lavorare con i testi. 
Le opzioni Inserimento stile versi controllano questo comportamento:

* Spazio / Trattino passa a nota successiva: sposta il trattino alla nota successiva.
* Spazio sposta a beat successivo: è usata dai simboli accordo, in modo che si possano scrivere 

simboli accordo diversi su ogni movimento della misura, anche se la nota dura molti movimenti.

Se entrambe le due opzioni in basso sono attive, premendo spazio mentre si crea un testo ci si 
sposta alla nota o al movimento successivo (dipende da quello che viene prima).

Casi particolari
Usando la finestra House Style > Posizioni di Default è bene tener presente alcune cose:

* Le opzioni Creare un oggetto non hanno effetto su chiavi, tonalità, stanghette speciali, tempi 
in chiave o trasporto; per resettare la posizione di uno di questi oggetti, eseguire una selezione di 
sistema attorno ad esso e scegliere Layout > Ripristina spaziatura note (Ctrl+Maius+N o
xXN).

* Per gli oggetti di sistema (es. stili di testo come Title, Tempo, linee rit./accel., ecc.) la posizione 
verticale di default e le impostazioni Sopra/Sotto inizio/centro/fine del rigo sono retroattive 
– in altre parole, tutte le modifiche eseguite su queste impostazioni cambiano automaticamente 
tutti gli oggetti di testo di sistema nella partitura.

* Tuttavia, per gli oggetti del rigo (es. simboli accordo, testi Linea versi 1 o linee di parentesi) le 
modifiche influenzano solo i nuovi oggetti creati – per esempio, se nella partitura c’è un testo 
Expression e si cambia la posizione di default dello stile di testo Expression, il testo Expression 
esistente nella partitura non cambia automaticamente posizione. 
Per cambiare la posizione di alcuni (o tutti) gli oggetti esistenti oltre a quelli nuovi usare i filtri 
per selezionarli (b Filtri e Trova) e scegliere Layout > Ripristina posizione (comando rapido 
Ctrl+Maius+P o xXP).

* Le impostazioni per l’allineamento dei testi rispetto alla pagina nella finestra House Style >
Modifica stile di testo hanno la precedenza su quelle della finestra House Style > Posizioni di 
default.

* La creazione di legature con il mouse genera legature non-magnetiche se nessuna delle opzioni 
Crea alla posizione orizzontale/verticale di default è attiva; attivando una o entrambe le 
opzioni, il mouse crea legature magnetiche. Creare legature magnetiche con il mouse può essere 
scomodo – ad esempio, se si vuole inserire una legatura con l’arco rivolto in alto (comando 
rapido S) cercando di collocarla con il mouse sopra alcune note i cui gambi sono rivolti in alto, la 
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legatura apparirà sotto le teste nota; tuttavia, per chi è abituato a usare il mouse questa può 
essere una funzione utile!

* Per i segni di prova, le posizioni orizzontali sono determinate dalle impostazioni nella sezione 
Altri oggetti, mentre le posizioni verticali dipendono dalle impostazioni nella sezione Stili di 
testo.

* Le posizioni di alcuni altri oggetti con complesse regole di posizionamento (es. legature magnet-
iche e gruppi irregolari) si possono modificare solo nella finestra di dialogo House Style >
Regole tipografia non in quella House Style > Posizioni di default.

Posizioni degli oggetti di sistema
In grandi partiture, alcuni oggetti di sistema (come i segni di prova e le scritte Tempo) possono 
apparire simultaneamente in più posizioni lungo un sistema (in alto e sopra gli archi nella musica 
orchestrale, ad esempio); per modificare le posizioni alle quali vanno questi oggetti:

* Selezionare House Style > Posizione oggetti accollatura.

* Cliccare sui righi sopra i quali devono apparire gli oggetti di sistema – fino a un totale di cinque. 
Il rigo superiore è d’obbligo; gli oggetti di sistema possono andare anche sotto il rigo inferiore.

Non necessariamente tutti gli oggetti di sistema devono apparire a tutte queste posizioni. La pag-
ina Pos verticale della finestra House Style > Modifica stili di testo (comando rapido 
Ctrl+Maius+Alt+T o xzXT) permette di specificare a quale di queste posizioni appare real-
mente un determinato stile di testo; ciò consente (ad esempio) di avere i segni di prova in alto, 
sopra gli archi e sotto il rigo inferiore, ma la scritta Tempo solo in alto. b Modifica stili di 
testo.

È inoltre possibile eliminare le singole istanze degli oggetti di sistema; ad esempio, se una scritta 
Tempo appare tre volte lungo la partitura si possono cancellare (Canc) singolarmente le due 
istanze in basso – cancellando l’istanza in alto si cancellano tutte le altre; per riportare nella partit-
ura le istanze cancellate degli oggetti di sistema, selezionare l’istanza in alto e scegliere Layout >
Ripristina aspetto (Ctrl+Maius+D o xXD).
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7.12 Modifica strumenti

b Strumenti, Righi, Nomi strumento.

Sebbene Sibelius abbia un elenco completo di oltre 400 strumenti interni a volte è necessario modifi-
care un tipo di strumento usato nella partitura (per esempio, se serve una particolare combinazione di 
strumenti percussivi su un singolo rigo non offerta dagli strumenti interni di Sibelius) oppure, più 
raramente, per creare un tipo di strumento non elencato in Crea > Strumenti e righi.

In Sibelius si usa la finestra House Style > Modifica strumenti e ensemble; le modifiche agli 
strumenti esistenti o a quelli nuovi creati sono poi salvate nella partitura in cui si lavora e possono 
essere usate in altre partiture esportando uno stile house o salvandole in un foglio manoscritto.

Finestra Edit Instruments
La finestra House Style > Modifica strumenti e ensemble consente di creare, modificare e can-
cellare tipi di strumento oltre a organizzarli in ensemble (termine che indica semplicemente i 
gruppi di strumenti che appaiono nell’elenco Scegli da della finestra Crea > Strumenti e righi). 
Ogni ensemble contiene una o più famiglie (normalmente ordinate in base a famiglie strumentali, 
come Brass, Woodwind, Strings, ecc.) e in ogni famiglia ci sono uno o più strumenti.

Con una partitura aperta selezionare House Style > Modifica strumenti e ensemble; appare 
questa finestra:

Esaminandola da sinistra a destra si può osservare:

* L’elenco Ensembles a sinistra elenca tutte le ensemble disponibili nella partitura corrente; 
l’elenco Famiglie in ensemble a destra mostra le famiglie presenti nell’ensemble selezionata;

* Strumenti nella Famiglia: elenca gli strumenti disponibili nella famiglia selezionata;
* Strumenti non utilizzati: elenca tutti gli strumenti definiti nella partitura ma che in quel 

momento non si trovano in nessuna famiglia dell’ensemble selezionata; è utile, poiché significa 
poter configurare le proprie ensemble contenenti solo gli strumenti che si usano (l’ensemble All 
instruments deve sempre contenere tutti gli strumenti definiti nella partitura).
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Tutte le partiture di Sibelius contengono varie ensemble predefinite (per un elenco vedere Creare 
gli strumenti a pagina 130 ) che non è possibile rinominare o cancellare; tuttavia, si possono 
cambiare le famiglie e gli strumenti in esse contenute.

Creare e cancellare un’ensemble
Non è necessario creare un’ensemble per realizzare un nuovo strumento o modificarne uno esist-
ente, ma se c’è un set particolare di strumenti usato spesso (o si vogliono vedere gli strumenti ordi-
nati in verticale nella partitura) può essere comodo creare una propria ensemble contenente un 
numero qualsiasi di strumenti ordinati a piacere.

Per creare una nuova ensemble:

* Selezionare un’ensemble esistente nell’elenco Ensembles sulla quale basare la propria.
* Cliccare su Nuovo Ensemble; Sibelius chiede se si vuole creare una nuova ensemble basata su 

questa; cliccare su Sì.

* Si apre una finestra di dialogo nella quale dare un nome all’ensemble; digitare il nome e cliccare 
su OK.

Per cancellare un’ensemble creata, selezionarla nell’elenco Ensembles e cliccare Cancella Ensem-
ble; Sibelius chiede se si è sicuri: cliccando Sì l’ensemble sarà cancellata.

Creare e cancellare una famiglia
Per creare una nuova famiglia in un’ensemble:

* Scegliere l’ensemble nell’elenco Ensembles e cliccare Nuova famiglia.

* Appare una finestra di dialogo nella quale digitare il nome della nuova famiglia; farlo e cliccare 
su OK.

* Di default la nuova famiglia è vuota.
* La famiglia si sposta in alto e in basso nell’elenco delle famiglie esistenti con i pulsanti Su e Giù

situati sotto l’elenco Famiglie in ensemble. L’ordine delle famiglie è importante, perché deter-
mina l’ordine verticale di default quando si creano gli strumenti nella partitura; se la famiglia 
Brass è sopra quella Strings, ogni strumento inserito nella partitura dalla famiglia Brass sarà 
collocato sopra un qualsiasi strumento inserito dalla famiglia Strings.

Per rinominare una famiglia, selezionarla e cliccare su Rinomina Famiglia, digitare il nuovo 
nome nella finestra di dialogo che si apre e cliccare su OK; per cancellare una famiglia, selezionarla 
e cliccare su Cancella Famiglia: dopo un messaggio d’avviso la famiglia sarà cancellata.

Aggiungere e rimuovere strumenti esistenti
Per aggiungere strumenti (già definiti) ad una famiglia:

* Individuare lo strumento (o strumenti) da aggiungere nell’elenco Strumenti non utilizzati e 
selezionarli. Si noti che non è possibile aggiungere lo stesso strumento a più di una famiglia nella 
stessa ensemble, quindi se lo strumento è già in un’altra famiglia non apparirà nell’elenco Stru-
menti non utilizzati; tuttavia, si può creare un nuovo strumento basato su uno esistente se si 
vuole che strumenti simili appaiano in famiglie diverse.

* Cliccare su Aggiungi alla Famiglia per spostare lo strumento(i) selezionato dall’elenco Stru-
menti non utilizzati a quello Strumenti nella Famiglia.
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* Spostare lo strumento(i) in alto e in basso nell’elenco con i pulsanti Su e Giù situati sotto l’elenco 
Strumenti nella Famiglia. Come per l’ordine delle famiglie, qui l’ordine degli strumenti deter-
mina l’ordine verticale quando si creano gli strumenti nella partitura.

Per rimuovere uno strumento(i) da una famiglia, selezionarlo dall’elenco Strumenti nella 
Famiglia e cliccare su Rimuovi dalla Famiglia (oppure per rimuovere tutti gli strumenti da una 
famiglia cancellare la famiglia stessa).

Creare, modificare e cancellare strumenti
Si può cancellare completamente uno strumento solo se non è usato nella partitura e non è un tipo 
di strumento predefinito incluso in tutte le partiture – Sibelius abilita il pulsante Cancella stru-
mento solo se gli strumenti selezionati possono essere cancellati.

Si può modificare uno strumento esistente selezionandolo nell’elenco Strumenti nella Famiglia o 
Strumenti non utilizzati e cliccando su Modifica strumento; se lo strumento è usato nella par-
titura appare un messaggio il quale avvisa che la modifica dello strumento può cambiare l’aspetto 
della partitura: cliccare su Sì per continuare.

Per creare un tipo di strumento completamente nuovo selezionare lo strumento più simile a quello 
da creare e cliccare su Nuovo Strumento; un messaggio chiede se si desidera continuare: cliccare 
su Sì per procedere.

Sia che si modifichi uno strumento esistente o se ne crei uno nuovo appare la stessa finestra:

Le opzioni Nome permettono di definire le tre forme del nome strumento usato in Sibelius:

* Lingua: non si può cambiare a meno che si usi una versione circoscritta (non in lingua inglese) 
di Sibelius; nelle versioni circoscritte, si può scegliere se visualizzare i nomi strumento in inglese 
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nella partitura o nella lingua della propria copia di Sibelius, ma nelle versioni in inglese, l’opzi-
one Lingua è sempre English.

* Nome riquadro: nome che appare nelle finestre House Style > Modifica strumenti e ensem-
ble e Crea > Strumenti e righi; questi nomi possono essere più descrittivi di quelli che appaiono 
nella partitura stessa (potrebbero indicare un trasporto insolito o il fatto che lo strumento non 
visualizza una tonalità, ad esempio).

* Nome partitura lunga: nome di default che appare a sinistra del rigo (normalmente sul primo 
sistema e poi all’inizio di nuove sezioni) – b Nomi strumento.

* Nome partitura breve: nome di default che in genere appare a sinistra del rigo dopo il primo 
sistema.

Per usare i caratteri dei font di testo musicali sui nomi strumento nella partitura (ad esempio, per il 
simbolo bemolle in un nome come “Clarinetto in SIb”) digitare “^” prima dei caratteri che corri-
spondono al bemolle (lettera b) e al diesis (il simbolo #) – in realtà, si può usare uno dei codici di 
formattazione elencati in Aggiungere le modifiche formattate alla finestra Info su par-
titura a pagina 227.

Le opzioni Opzioni trascrizione determinano il comportamento del rigo (o righi) nella partitura:

* Scegliere il tipo di rigo (Tipo di rigo) adeguato:
% Gli strumenti intonati (Pitched) possono avere un rigo (es. flauto, clarinetto, violino) o due 

righi (es. piano, arpa, celesta, marimba); impostare il valore Numero di righi adatto.
% Gli strumenti Percussioni non intonate (es. batteria, legnetti) possono avere solo un rigo e 

non è possibile impostare per essi le opzioni Chiave parte, Estensione o Trasposizione.
% Gli strumenti Intavolatura (es. chitarra, liuto, dulcimer) possono avere solo un rigo e, come 

gli strumenti non intonati, non è possibile per essi impostare le opzioni Chiave parte, 
Estensione o Trasposizione.

* Per modificare le proprietà del rigo usato dallo strumento cliccare su Modifica Tipo Rigo – 
vedere Modifica Tipo Rigo.

* Chiave partitura primaria: determina la chiave normale da usare. Per uno strumento intonato 
a due righi (come il piano) è la chiave usata nel rigo superiore; cliccare su Scegli per scegliere la 
chiave – per maggiori informazioni vedere b Chiavi.

* Chiave parte: determina la chiave usata da uno strumento intonato a un solo rigo (se è uno stru-
mento trasportato) e se trasportandolo di un intervallo ampio è utile usare una chiave diversa 
all’altezza suonata che a quella trasportata (es. per gli ottoni gravi e i fiati). Per usare questa opzi-
one attivare Chiave parte e cliccare su Scegli per scegliere la chiave; la chiave che si usa qui sarà 
quella usata quando è attiva l’opzione Note > Partitura Traspositore; questa opzione non è dis-
ponibile per strumenti intonati a due righi o qualsiasi strumento non intonato o con tablatura.

* Chiave partitura secondaria: determina la chiave usata dal rigo inferiore di uno strumento 
intonato a due righi (es. la chiave di basso per la mano sinistra del piano); cliccare Scegli per 
scegliere la chiave.

* Parentesi con: determina come Sibelius mette in parentesi uno strumento quando lo si crea 
nella partitura; Sibelius segue le convenzioni standard per mettere in parentesi gli strumenti in 
base alla famiglia strumentale. L’elenco qui non riflette le famiglie in un’ensemble particolare 
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(perché possono essere diverse in ogni ensemble della partitura); è piuttosto un elenco delle 
famiglie strumentali standard (per esempio, se si vuole mettere in parentesi uno strumento con 
altri strumenti ad arco selezionare Archi).
Attenzione! L’opzione Parentesi con non determina l’ordine in cui sono creati gli strumenti 
nella partitura; esso è determinato dall’ordine degli strumenti all’interno delle famiglie e, a sua 
volta, dalle famiglie nell’ensemble; questa opzione dice solo a Sibelius che quando si crea uno 
strumento, creandolo accanto a uno strumento con le stesse impostazioni Parentesi con, i due 
strumenti uniti in parentesi. Altro dettaglio: gli strumenti intonati a due righi (es. il piano) 
hanno sempre una parentesi, quindi non sono messi in parentesi con altri strumenti.

Le opzioni Estensione sono usate da Sibelius per colorare le note in rosso quando è attiva l’opzione 
Vista > Colori note > Note fuori Range (vedere Colori note a pagina 456). Questa opzione si 
può impostare solo per gli strumenti intonati; per strumenti con tablatura, l’intervallo è indicato 
dalle altezze delle corde definite nel tipo di rigo dello strumento.

Le opzioni Trasposizione consentono di stabilire come sono trasportati gli strumenti:

* Gli strumenti che talvolta sono in una tonalità particolare (es. Clarinetto in LA/SIb) o famiglie di 
strumenti identici tranne nella dimensione e quindi generano altezze diverse (es. sax Tenore/
Contralto o il Corno con crooks) sono trasportati se è attiva l’opzione Note > Partitura traspos-
itore. Per questi tipi di strumenti impostare adeguatamente i menu a tendina Partitura tras-
posta; per un Clarinetto in LA, ad esempio, impostare A in ottava 3, perché un DO centrale 
scritto per un Clarinetto in LA suona come il LA sotto il DO centrale (DO centrale = C4).

* L’opzione Partitura non trasposta serve solo per strumenti come il piccolo, il contrabbasso e la 
voce di tenore che sono scritti appositamente un’ottava più acuta o grave di come suonano anche 
in partiture non trasportate; l’opzione permette di specificare a quale ottava suona un tipo di 
strumento così. Poiché tutti questi strumenti sono già predefiniti, in situazioni normali non c’è 
bisogno di usare questa opzione (e nemmeno di pensarci!).
Tuttavia, se si usa questa opzione e si vuole assegnare a quello strumento una chiave con un pic-
colo 8 o 15 sopra, si tenga presente che Sibelius ignora il piccolo 8 o 15 perché è opzionale e 
ricava l’informazione su quale ottava suona lo strumento da questa opzione, perché il trasporto 
d’ottava è una caratteristica dello strumento (es. il piccolo), non della chiave.

Le opzioni Riproduzione di Default indicano a Sibelius come riprodurre la musica scritta per lo 
strumento:

* Suono migliore: sound ID; descrive, il più fedelmente possibile, il suono che genera uno stru-
mento. Bisogna pensarlo come al suono reale generato dallo strumento vero e proprio, invece 
che come il suono specifico di un dispositivo di riproduzione; per maggiori informazioni sui 
sound ID, b SoundWorld™.

* Pan: posizione pan di default dello strumento quando lo si aggiunge alla partitura; -100 com-
pletamente a sinistra, 100 completamente a destra.

* Distanza: distanza dello strumento dall’ascoltatore; determina la quantità di riverbero relativa 
che lo strumento acquista di default.

* Volume: specifica il volume di default dello strumento quando lo si aggiunge alla partitura.
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* Tipo Glissando: determina se lo strumento suona i glissando con un pitch bend Continuo, 
usando note discrete (Note nere, Note bianche, Cromatico) o non lo esegue (None).

Al termine cliccare su OK per confermare le modifiche.

Se si stava creando un nuovo strumento, esso è inserito automaticamente nell’ensemble All instru-
ments nella stessa famiglia dello strumento sul quale si è basato quello nuovo.

Modifica Tipo Rigo
Cliccando su Modifica Tipo Rigo nella finestra di dialogo Nuovo/Modifica strumento si apre 
una finestra con due o tre pagine; esse sono:

* Generale: si applica a tutti i tipi di strumento; consente di stabilire il numero di linee rigo, ecc.
* Note e pause: si applica a tutti i tipi di strumento; permette di definire direzione e lunghezza 

dei gambi, ecc.
* Percussioni: disponibile solo per strumenti non percussivi: permette di specificare una map-

patura tra le teste nota sul rigo e i suoni degli strumenti percussivi.
* Tab: disponibile solo per strumenti con tablatura: specifica l’altezza di ogni corda, ecc.

Le opzioni in ogni pagina sono descritte in seguito.

Pagina Generale
* Numero di linee del rigo: consente di scegliere un 

numero qualsiasi di linee del rigo (o corde in una tabla-
tura).

* Spazio tra linee rigo (1/32 spazi): consente di modifi-
care la distanza tra le linee del rigo (quindi l’altezza del 
rigo). Si noti, però, che cambiando questo parametro gli 
altri oggetti non diventano più grandi o piccoli per corri-
spondere alla nuova altezza del rigo; non c’è ragione di 
cambiarlo quindi (a meno si voglia ottenere qualche 
strano effetto). Per metodi di modifica adeguati della 
dimensione del rigo, b Righi.)

* Stanghetta dimezzata (1/32 spazi): permette di modi-
ficare l’altezza delle stanghette in un determinato rigo. 
Si noti che le stanghette sono centrate in verticale a metà 
rigo, quindi impostando questo parametro a 32, ad esem-
pio (il default è 64), le stanghette toccheranno la seconda 
e quarta linea di un rigo a cinque linee.

* Parentesi quadra: controlla se le parentesi quadre e/o tonde sono scritte all’inizio del rigo.
* Stanghetta iniziale: determina se la stanghetta iniziale è scritta all’inizio di ogni sistema; non 

determina la presenza di una stanghetta iniziale su un sistema costituito da un solo rigo (ciò si 
controlla dalla pagina Stanghette della finestra House Style > Regole tipografia).

* Chiave iniziale: si riferisce alla chiave all’inizio di ogni sistema, non solo a quella iniziale situata 
all’inizio vero e proprio della partitura. I lead sheet e le parti di ottoni per le marching band 
spesso omettono le chiavi dalla maggior parte dei sistemi.

reference.book  Page 546  Wednesday, April 16, 2008  4:28 PM



7.12 Modifica strumenti

547

Layo
ut

* Stanghette: controlla se le stanghette sono scritte o meno sul rigo.
* Tonalità/Accordatura: determina se sul rigo appaiono tonalità e intonazioni delle corde di chi-

tarra; anche le tonalità spesso sono omesse in lead sheet e parti di ottoni per marching band.

Pagina Note e pause
* Ritmiche (gambi, punti, legature, pause, ecc.): cont-

rolla gambi, flag e punti ritmici; in genere non è attiva solo 
per i righi di tablatura ove non sono indicati i ritmi (di 
solito c’è un rigo d’accompagnamento che indica i ritmi).

* Battute in pausa: disattivarla per non vedere le misure di 
pausa in un determinato rigo; in genere non è attiva 
quando anche l’opzione Ritmiche non è attiva.

* Articolazioni sempre sopra il rigo: è utile per i righi 
vocali e percussivi a una sola linea (es. collocando le arti-
colazioni sopra il rigo si evitano collisioni con le parole).

* Tratti d’unione sempre orizzontali: forza tutti i tratti 
d’unione ad essere piatti; è molto utile nella musica per-
cussiva, ed è spesso usata anche in alcuni stili di tablatura 
che indicano i ritmi usando gambi e tratti d’unione fuori 
dal rigo.

* Tagli addizionali: determina se appaiono le linee aggiun-
tive quando le note vanno sopra o sotto il rigo; in genere non è attiva per i righi percussivi.

* Le opzioni Lunghezza del gambo permettono di scegliere se i gambi devono avere la lunghezza 
normale (quella di default per la maggior parte dei tipi di rigo) o estendersi fuori dal rigo (utile 
nei righi di tablatura ove sono indicati i ritmi).

* Estendi gambi al di fuori del rigo: attivandola, si può scegliere se i gambi devono essere scritti 
completamente fuori dal rigo (non estendendosi cioè al numero/lettera tasto o testa nota) 
quando è attiva l’opzione Disegna gambi oltre lo spazio extra; questo aspetto del rigo è dif-
fuso nella tablatura per liuto e in alcune tablature per chitarra ritmica.

* Consenti spazio per n tratti d’unione: determina quanto i gambi sporgono dal rigo; di 
default, c’è spazio sufficiente per tre tratti d’unione (cioè una nota da 1/32). L’opzione Spazio 
extra per consentire è utile soprattutto per stabilire la distanza tra la linea del rigo più esterna 
e il punto del gambo più interno sopra o sotto il rigo (se è attiva l’opzione Disegna gambi oltre 
lo spazio extra).

* Le opzioni Gambi su note in una voce singola determinano se in una singola voce i gambi 
delle note situate sulla linea centrale devono essere rivolti in basso (convenzione per la maggior 
parte dei tipi di rigo), in alto (convenzione per i righi percussivi ad una sola linea), se tutti i 
gambi in una singola voce devono essere rivolti in basso (convenzione per le tablature di banjo) 
o in alto (convenzione nella maggior parte della tablatura per chitarra e liuto e nella musica per 
cornamusa); ove si usano due o più voci queste impostazioni sono ignorate e i gambi sono rivolti 
in alto o in basso secondo la melodia della voce (come al solito).
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Pagina Percussione
* La rappresentazione grafica del rigo mostra la mappatura di batteria (vedere Strumenti per-

cussivi non intonati a pagina 110) – è possibile impostare diverse teste nota o la stessa testa 
nota con articolazioni diverse per generare suoni diversi sulla stessa linea o spazio.

* Per rimuovere una testa nota esistente, selezionarla (cliccan-
doci sopra) e cliccare su Cancella.

* Per cambiare una testa nota selezionare quella da cambiare e 
scegliere la forma desiderata dal menu a tendina Testa della 
nota.

* Per aggiungere un’articolazione alla testa nota usare il menu a 
tendina Articolazione.

* Per cambiare il sound ID usato dalla testa nota selezionata 
cliccare sul pulsante Scegli Suono (b SoundWorld™).

* Per inserire una nuova testa nota, selezionare testa nota e 
suono desiderati dagli elenchi Testa della nota, Articolazi-
one e Suono, quindi cliccare su Nuovo; il puntatore del 
mouse cambia colore: cliccare sul rigo per collocare la nuova 
testa nota.

* Se si crea la notazione per una batteria con l’inserimento Step-time o Flexi-time verificare che 
l’impostazione per ogni testa nota nei menu Input con pitch corrisponda al tasto che si preme 
sulla tastiera MIDI (per generare lo stesso suono); vedere Inserimento nota per una per-
cussione non intonata a pagina 111.

* Aggiungendo una nuova testa nota alla drum map, il valore Input con pitch s’imposta al default 
della nota come se fosse scritta su un rigo in chiave di violino; se sulla linea o nello spazio c’è già 
una testa nota Sibelius aggiunge un diesis alla nota.

Pagina Tab
* Per modificare l’intonazione di una corda cliccare sulla corda 

nella grande finestra in cima alla finestra di dialogo e scegliere 
la nuova altezza dal menu a tendina Pitch sottostante.

* Si può specificare se la nota deve essere scritta con un diesis o 
un bemolle (talvolta necessario in accordature insolite) selezi-
onando il rispettivo pulsante di opzione.

* Per cambiare il numero di corde cliccare sulla pagina Gen-
erale, cambiare le corde e tornare alla pagina Tab per rego-
larne le intonazioni.

* Le opzioni Note Intavolatura determinano se il rigo di tabla-
tura utilizza l’opzione Usa numeri (convenzione per le tabla-
ture di chitarra) o Usa lettere (convenzione usata nella gran 
parte degli stili di tablatura per liuto); selezionare o meno 
l’opzione Disegna note tra le linee del rigo (sulle linee è la 
convenzione in tablature per chitarra, tra le linee è la convenzione in tablature di liuto); si può 
decidere se numeri o lettere devono avere uno sfondo bianco (utile per tablature che mostrano il 
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ritmo) e se nelle note degli accordi i gambi devono essere scritti (di default, i gambi si estendono 
su tutte le note di un accordo, ma in alcune tablature ritmiche il gambo è scritto solo fino alla 
prima nota che tocca).
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7.13 Modifica linee

b Linee, Legature di portamento, House Style™.

Solo per utenti esperti

Sibelius permette di modificare le forma delle linee e creare le proprie; modificando una linea 
esistente, tutte le modifiche eseguite sulla forma della linea influenzeranno tutte le istanze di 
quella linea presenti nella partitura e tutte le istanze create in seguito.

Modificare una linea
Per modificare una linea selezionare House Style > Modifica linee. Una volta scelta una linea 
dall’elenco si può modificarla (Modifica), cancellarla (Cancella) se è una definita dall’utente o 
cliccare su Nuovo per creare una nuova linea basata su quella selezionata.

Quando si crea una nuova linea, basarla su una con caratteristiche di riproduzione e posiziona-
mento simili; per creare una linea da riprodurre come trillo, ad esempio, basarla su un trillo.

Cliccando su Modifica si apre una finestra di dialogo ove cambiare le caratteristiche di una linea:

Nel complesso, una linea è costituita da cinque elementi:

* Un inizio opzionale – un simbolo (es. “Ped”) od oggetto di testo (es. “1.2.”), più una testa di frec-
cia opzionale o un breve segmento angolato a destra chiamato “uncino,” come quello del 1° finale 
(misura 1a volta).

* La linea vera e propria – può essere continua, punteggiata, tratteggiata o a serpentina, di varie 
larghezze, orizzontale o diagonale.

* Un testo opzionale associato alla linea (per esempio, gliss.).
* Un simbolo continuativo opzionale – è quello che appare all’inizio del sistema quando una linea 

continua da un sistema precedente, come un (8) per una linea di 8va.
* Un elemento finale opzionale – come per l’elemento iniziale, può essere un simbolo, un uncino o 

la testa di una freccia.
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La modifica di questi elementi nella finestra di dialogo è auto-esplicativa, tuttavia di seguito se ne 
riporta una breve spiegazione:

* Le opzioni Linea contollano l’aspetto della linea vera e propria:
% Stile: specifica se la linea è continua, punteggiata, tratteggiata o a serpentina.
% Linea tratt.: lunghezza dei trattini nelle linee tratteggiate.
% Separazione: spazio vuoto tra trattini/punti nelle linee tratteggiate/puntate.
% Orizzontale: forza la linea ad essere orizzontale (es. un trillo).
% Visualizzazione sullo schermo più fluida: rende omogenea la linea non appena appare 

sullo schermo (dipende dalla impostazioni complessive dell’aspetto sullo schermo), ma non 
ne influenza la stampa (Sibelius stampa sempre bene!) – lasciare attiva questa opzione.

% Dopo simbolo d’inizio: colloca l’estremità sinistra della linea dopo l’elemento iniziale.
* Le opzioni Inizio definiscono se la linea inizia con un cap, simbolo od oggetto di testo:

% Niente/Testo/Simbolo: cliccando sul pulsante di opzione Testo si apre una finestra di dial-
ogo dalla quale scegliere il testo che deve apparire, lo stile di testo da usare e la posizione del 
testo rispetto alla linea.
Per collocare il testo in modo che la linea appaia a metà, cambiare il parametro x spazi in su; usando lo stile 
Small Text un valore di 0.5 spazi è ideale.

% spazi a destra/in su: si usa per regolare la posizione di simbolo, testo o uncino.
% Uncino: permette di scegliere un uncino (e definirne l’offset dalla linea) o una testa di freccia 

da un elenco definito.
* Le opzioni Prolungamento determinano cosa fa la linea se continua su un’interruzione di 

sistema o pagina:
% Simbolo: consente d’iniziare la continuazione con un simbolo.
% spazi a destra/in su: si usa per regolare la posizione del simbolo opzionale.
% Il pulsante Testo fa continuare il testo lungo la linea.

* Le opzioni Fine sono simili a quelle Inizio, ma non si può chiudere una linea con un testo.

L’anteprima mostra come la linea appare se divisa su due sistemi, in modo che si possa vedere l’ele-
mento di continuazione (oltre che la sua parte iniziale, centrale e finale).

Un esempio dell’impiego di questa finestra di dialogo è il cambio del simbolo all’inizio di una linea 
standard 8va (come indica la figura precedente) per inserire, ad esempio, solo il numero 8; cliccare 
su Seleziona nella sezione Inizio della finestra di dialogo Modifica Linea e scegliere un nuovo 
simbolo.  
Il simbolo di continuazione (Prolungamento) si cambia allo stesso modo.
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7.14 Modifica teste nota

b Teste nota, Gambi e linee aggiuntive.

Solo per utenti esperti

Per modificare la forma di una testa nota o definirne una nuova:

* Selezionare House Style > Modifica teste di nota.

* Nella finestra di dialogo che appare cliccare su Nuovo per creare un nuovo tipo di testa nota, 
oppure cliccare su uno dei tipi elencati e cliccare su Modifica per modificarlo. Si può anche clic-
care e cancellare (Cancella) i tipi di testa nota definiti.

La finestra di dialogo Testa della nota che appare consente di definire ogni aspetto della testa 
nota:

* Nome: nome del tipo di testa nota (anche se non è indispensabile conoscerlo!).
* Suona: determina se sulla linea o spazio è riprodotto il tipo di testa nota; alcune teste nota (es. 

gli slash) di default non sono riprodotte.
* Alterazioni: disattivarla per evitare che la testa nota abbia alterazioni (es. per gli slash).
* Traspone: determina se la testa nota si può trasportare (es. modificando l’opzione Note > Parti-

tura traspositore, se si trasporta la musica o nelle parti); di default alcune teste nota non si pos-
sono trasportare (es. gli slash).

* Tagli addizionali: determina se la testa nota deve sempre apparire con le linee aggiuntive.
* Gambo: determina se la testa nota deve apparire su un gambo.
* Per cambiare il simbolo usato per la testa nota selezionare uno dei valori nota, cliccare su Cam-

bia simbolo e selezionare il simbolo da usare dalla finestra di dialogo Simboli che appare 
(b Simboli); la testa nota da 1/4 è usata anche per i valori nota da 1/8 e più brevi.

Sotto i simboli di testa nota ci sono opzioni distinte per il posizionamento di gambi e teste nota 
quando i gambi sono rivolti in alto e in basso:

reference.book  Page 552  Wednesday, April 16, 2008  4:28 PM



7.14 Modifica teste nota

553

Layo
ut

* Accorcia il gambo di: consente di eseguire un’unione più ordinata tra il gambo e alcune teste 
nota, come quelle a croce (questa opzione è disponibile solo se è attiva l’opzione Gambo).

* Sposta testa della nota di x spazi a destra/sinistra: sposta la testa nota a sinistra o destra del 
gambo del numero di spazi specificato (sempre per avere un’unione più ordinata).

* Sposta testa della nota di x spazi in su/giù: sposta la testa nota in alto o in basso sul gambo 
del numero di spazi specificato.

Al termine cliccare su OK, quindi nuovamente su OK per chiudere la finestra di dialogo Modifica 
teste di nota.

Un particolare: le opzioni Tagli addizionali e Gambo hanno un effetto basato sul tipo di testa 
nota della nota in cima a un accordo; quindi se, ad esempio, si ha un accordo nel quale due note 
normalmente sarebbero scritte su linee aggiuntive ma s’imposta la testa nota più acuta ad usare un 
tipo di testa nota che non ha le linee aggiuntive, nessuna delle due note avrà linee aggiuntive. 
Al contrario, se nella stessa situazione s’imposta la più grave delle due note sulle linee aggiuntive a 
usare una testa nota che non ha linee aggiuntive, entrambe le note saranno stampate con le linee 
aggiuntive (perché la testa nota più acuta dell’accordo usa le linee aggiuntive).

Creando una nuova testa nota essa appare alla base della finestra House Style > Modifica teste di 
nota e nell’elenco delle teste nota nel pannello Note della finestra Proprietà e può essere inserita 
con un comando rapido numerico come le altre teste nota.
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7.15 Modifica simboli

b Simboli, Font musicali.

Solo per utenti esperti

I simboli che Sibelius usa per gli oggetti standard come teste nota, chiavi e articolazioni si trovano 
tutti nella finestra di dialogo Crea > Simbolo (comando rapido Z) e si possono modificare nella 
finestra di dialogo House Style > Modifica simboli.

Cambiare i simboli esistenti
I simboli per gli oggetti standard nella finestra di dialogo House Style > Modifica simboli hanno 
significati particolari; cambiando il simbolo diesis nel segno del dollaro, Sibelius lo tratta comu-
nque come un diesis (ad esempio, durante la riproduzione o il trasporto).

Lo considera ancora diesis anche se si cambia la forma del simbolo in bemolle (perché interpreta i 
simboli in base a dove si trovano nella griglia, non in base all’aspetto). Ciò non provoca difficoltà 
d’interpretazione a Sibelius, ma può causarle all’utente! Per evitare confusione, quindi, è meglio 
cambiare i simboli esistenti a forme simili al significato che avevano nella forma precedente.

Un’applicazione potrebbe essere il cambio dei simboli usati per le alterazioni microtonali. I primi 
nove simboli sulla fila Accidentals della finestra di dialogo Crea > Simbolo corrispondono a 
quelli presenti sul quinto layout del tastierino numerico (comando rapido F12); per un elenco dei 
vari simboli alternativi vedere la tabella dei simboli scrivibili al capitolo Simboli. Se nella finestra 
di dialogo House Style > Modifica simboli si cambia un simbolo usato sul tastierino numerico, 
quest’ultimo mostra ancora il simbolo originale ma inserisce quello nuovo.

Nuovi simboli
Per creare un nuovo simbolo che non abbia solo una forma diversa da uno esistente, ci sono molti 
comodi spazi nella tabella House Style > Modifica simboli nei quali inserire il nuovo simbolo. 
Usare uno spazio in una fila dal nome appropriato o in una fila User-defined in basso.

Se si usano tutti gli spazi nella fila User-defined cliccare su Nuovo nella finestra di dialogo 
House Style > Modifica simboli per creare un nuovo simbolo su una nuova fila.

Simboli composti
Alcuni simboli sono costituiti da uno o più simboli; ciò ha due vantaggi:

* Si può creare un nuovo simbolo anche se non è disponibile in un font musicale, unendo tra loro 
altri simboli; per esempio, il simbolo della chiave di tenore (chiave di violino con un 8 sotto) è 
formato dalla chiave di violino più il numero 8.

* Cambiando font, dimensione o forma di un simbolo (come una chiave di violino), cambiano 
anche tutti i simboli basati su di esso, per garantire un aspetto consistente ed evitare di dover 
cambiare nello stesso momento molti altri simboli.

Modificare e creare nuovi simboli
* Selezionare House Style > Modifica simboli.
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* Selezionare un simbolo da modificare e clic-
care su Modifica; per creare un nuovo sim-
bolo selezionare uno slot vuoto nella finestra 
e cliccare su Modifica o cliccare su Nuovo
per creare un nuovo simbolo in una nuova 
fila

* Per cambiare il carattere a un simbolo clic-
care su un nuovo simbolo nella tabella a sin-
istra nella finestra o digitare un numero 
carattere nel campo Numero. Usando un 
misto di font musicali si può anche scegliere 
il font da usare dall’elenco Font musicali
(descritto in seguito).

* Per far diventare vuoto il simbolo o trasformarlo in un insieme di simboli esistenti (senza avere 
anche un carattere scelto direttamente da un font musicale) impostare Numero a 0.

* Si può anche cambiare il nome del simbolo nel campo Nome; esso è utile per identificarlo 
quando fa parte di un simbolo composto.

* Per spostare un simbolo dalla sua posizione originale cliccare sui pulsanti freccia a destra.
* Per aggiungere un altro simbolo in modo da crearne uno composto, cliccare su Aggiungi, quindi 

cliccare su un altro simbolo e cliccare su Aggiungi simbolo; con i pulsanti freccia si possono 
spostare questi simboli extra in modo indipendente.

Creare un nuovo stile di testo per il simbolo
Questo concetto, importante ma piuttosto astratto, si spiega meglio con un esempio: si supponga 
che tutte le chiavi debbano usare un font musicale speciale proprio denominato Treble Font prel-
evato da qualche altra parte (per maggiori informazioni sui font musicali e sulle loro relazioni con 
i simboli, b Font musicali).

Non basta semplicemente cambiare il font degli stili di testo Common symbols, poiché ciò modi-
ficherebbe anche quello di note, alterazioni e così via; bisogna invece creare un nuovo stile di testo 
denominato (ad esempio) Clefs, impostarlo a TrebleFont e impostare tutti i simboli di chiave 
all’uso dello stile di testo Clefs, in modo che utilizzino tutti lo stesso stile: Per farlo:

* Cliccare su Font musicali nella finestra di dialogo House Style > Modifica simboli.
* Nella finestra Font musicali selezionare uno stile di testo esistente (per esempio, Common 

Symbols) sul quale basare il nuovo simbolo; cliccare su Nuovo, quindi su Sì.

* Nella finestra di dialogo che appare, digitare Clefs come nome del nuovo stile di testo e cambiare 
il font in TrebleFont.

* Cliccare su OK, quindi nuovamente su OK per chiudere la finestra di dialogo Font musicali.
* A questo punto, per ogni chiave nella finestra di dialogo House Style > Modifica simboli selez-

ionare la chiave, cliccare su Modifica, cambiare Font Musicali (cioè lo stile di testo che speci-
fica font e dimensione del simbolo) in Clefs e cliccare su OK.

Seguire la stessa procedura anche per cambiare un singolo simbolo a font o dimensione speciale.
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7.16 Pubblicazione

b SibeliusMusic.com, Esportare pagine web Scorch.

Questo capitolo spiega come realizzare una stampa a qualità elevata di partiture su piccola e larga 
scala per pubblicare la propria musica dall’inizio alla fine.

Diventare editori
Gran parte della musica non è mai pubblicata; perfino i compositori famosi in contatto con i più 
grandi editori a volte scoprono che molta della propria musica esiste solo in fotocopie dei loro 
manoscritti originali, che vedono la luce solo se qualcuno li prende a prestito per un’esecuzione. 
Sicuramente molta musica classica degli ultimi 50 anni circa è stata pubblicata senza un’adeguata 
promozione, nella speranza che la sua presenza su uno scaffale potesse attirare l’attenzione di 
potenziali esecutori. In alcuni casi lo stesso discorso vale per molte partiture commerciali (come i 
musical); la situazione per compositori e arrangiatori meno famosi può essere quindi molto triste!

Fortunatamente Sibelius rivede tutto questo discorso. Per distribuire la propria musica veloce-
mente e facilmente si può pubblicarla in Internet – per i dettagli b SibeliusMusic.com. Sibelius 
può anche portare una partitura dalla sua nascita nella testa dell’utente a un magazzino pieno di 
partiture e parti, stampate e rilegate (come farebbe un editore). Questo perchéperché anche i più 
grossi editori spesso non hanno molta più attrezzatura di voi; hanno un nome famoso, un logo e un 
fascino misterioso che li circonda; quello che serve è un pò di know-how e un amico tipografo a 
buon mercato.

Scrittura musicale e stile house
I grandi editori offrono standard elevati di scrittura musicale. Serve tempo ed esperienza per 
acquisire le capacità per produrre una scrittura musicale di alta qualità; per iniziare, tuttavia, ved-
ere b Scrittura musicale e Layout e formattazione.

Inoltre, gli editori istituiscono propri stili house. b House Style™ offre alcuni spunti al 
riguardo. La semplice scelta dei font di testo adatti e distintivi è di grande aiuto; b Font ade-
guati on page 222.

Stampa limitata
Per realizzare 100 copie di una partitura non c’è bisogno di avere una tipografia! Basta stampare 
con la propria stampante o realizzare una copia master da fotocopiare e poi rilegare le copie.

Attualmente le stampe limitate impiegano tecniche di stampa digitali non molto diverse da quelle 
usate da una comune stampante laser (ma in genere con una qualità superiore). A differenza della 
stampa litografata, che richiede la realizzazione di una serie di matrici prima che si possa stampare 
qualcosa (vedere in seguito), la stampa digitale utilizza direttamente un file (di solito in PDF) e il 
costo per una o 100 copie è uguale.

Con una buona stampante laser si possono ottenere risultati simili anche a casa, sebbene la “rifini-
tura” (rilegatura, graffettatura, ecc.) possano diventare talmente laboriose per cui vale la pena riv-
olgersi a una tipografia.
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Stampa su larga scala
Per pubblicare molta musica (centinaia di copie o più) è meglio affidarsi ad una tipografia che 
impiega processi di stampa digitali. In genere, si porta una stampa di buona qualità che poi è 
fotografata; attualmente, di norma si salva il lavoro in un file PDF (b Esportare file grafici) su 
CD-R o inviandolo via e-mail.

Stampa litografata
Per stampare quantità industriali (migliaia di copie) la tipografia può usare una stampante spe-
ciale ad alta risoluzione (2540 dpi o più) per trasferire la musica su una pellicola trasparente, che 
poi è riportata sulle matrici di stampa; in molti casi è possibile realizzare le matrici direttamente 
dal file, senza passare dalla pellicola.

Le matrici vanno poi nelle macchine di stampa. La stampa litografata è eseguita su grandi fogli di 
carta tagliati poi a misura. Molte tipografie preferiscono quindi se sul lavoro ci sono dei segni di 
taglio (piccole croci, denominate “crop marks”) agli angoli della pagina, i quali indicano dove deve 
avvenire il taglio della carta. I crop marks si attivano quando si salva la partitura in file EPS o PDF.

La tipografia deve essere in grado di incollare e rilegare tutte le copie desiderate; il costo per copia 
diminuisce drasticamente all’aumentare delle copie da stampare, perché gran parte dei costi 
riguardano il setup iniziale di stampa.

Fattori che influenzano la qualità di stampa
* Risoluzione: oltre i 600 dpi, le risoluzioni di stampa sono difficili da distinguere su righi di 

grandi dimensioni, mentre su righi più piccoli la differenza si nota; per esempio, c’è un differ-
enza appena percettibile tra 1200 dpi e 2540 dpi.

* Carta: la maggior parte di libri e musica sono stampati su carta bianca non rivestita (non lucida) 
in “lb/risma” (libbre per risma nel Nord America) e “g/m2” o “gsm” (grammi al metro quadrato 
in Europa) che ne indicano il peso (quindi lo spessore). Circa 21 lb/risma o 80 gsm si usa per la 
carta stampata, carta per fotocopie e libri piuttosto spessi. Circa 26 lb/risma o 100 gsm è prefer-
ibile per la musica (perché è carta meno trasparente e i singoli fogli sono più stabili sul leggio).

* Matrici: le matrici per la stampa litografica sono fatte di vari materiali (in genere è il tipografo a 
decidere quello migliore); le matrici metalliche offrono le qualità di stampa più elevate, quelle al 
poliestere sono più economiche ma abbastanza buone, mentre le matrici in carta sono di scarsa 
qualità e sono adatte solo per poster e altri documenti più grossolani.

Riassunto
Ricapitolando, per realizzare un lavoro di qualità adatto alla stampa su larga scala si deve:

* Investire in una stampante laser a 600 dpi o più e stampare in proprio; oppure:
* Creare un file PDF file della propria musica e consegnarlo su CD-R ad una tipografia (o inviarlo 

via e-mail) per farlo stampare in digitale o con il metodo litografico; se possibile, fornire anche 
un provino su carta della partitura. In generale, la stampa litografica è più costosa (tranne per 
grandi quantità) di quella digitale, ma il risultato è di altissima qualità.
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8.1 Lavorare con i file

Questo capitolo spiega come salvare le partiture in formato Sibelius e (per gli utenti esperti) come 
accedere ai file contenenti impostazioni personalizzate di Sibelius (es. stili house). Altri paragrafi 
di questo capitolo spiegano come condividere i file con altre persone (sia che abbiano o meno Sibe-
lius) e come importare ed esportare i file nei vari formati.

Creare una partitura
Per i dettagli su come iniziare una nuova partitura in Sibelius, vedere il Manuale Operativo.

Dimensione dei file
I file di Sibelius in generale occupano 20K più 1K per pagina (escluse le grafiche importate) anche 
per musica da banda e orchestrale; è possibile quindi salvare milioni di pagine sul disco rigido e 
anche le partiture più grandi si possono spedire via posta elettronica (persino J.S. Bach non 
avrebbe problemi di spazio sul disco rigido usando Sibelius!).

Salvataggio
Il salvataggio avviene come in qualsiasi altro programma, con i comandi File > Salva come
(Ctrl+Maius+S o xXS) e File > Salva (Ctrl+S o XS). Inoltre, per salvare le partiture di Sibelius, 
si può anche esportare in altri formati: MIDI, audio, grafici e tabulati ASCII. Per maggiori dettagli 
vedere i rispettivi capitoli in questo Manuale Operativo; per salvare le parole, b Plug-in.

Una posizione ideale per salvare è la cartella Scores creata da Sibelius. In Windows, la cartella 
Scores è creata nella cartella Documenti; su Mac è nella cartella Documenti dell’utente.

La cartella di default per il salvataggio delle partiture si può cambiare nella pagina File della 
finestra di dialogo File > Preferenze (menu Sibelius in Mac).

All’apertura successiva al salvataggio, la partitura si apre nel punto in cui si stava lavorando 
quando è stata salvata con lo stesso fattore di zoom. Se si preferisce che Sibelius apra le partiture al 
livello zoom di default invece che all’ultimo con il quale si stava lavorando, attivare l’opzione Apri a 
livello di zoom nella pagina File della finestra di dialogo File > Preferenze (menu Sibelius in 
Mac).

Salvataggio automatico
Sibelius può salvare automaticamente la partitura a intervalli specificati, in modo che se il com-
puter si blocca si perdono solo alcuni minuti di lavoro. Invece di salvare il file vero e proprio, Sibel-
ius esegue una copia della partitura e la salva in una cartella denominata AutoSave all’interno 
della cartella Backup Scores (vedere in seguito).

Se Sibelius non si chiude correttamente (in seguito a un blocco del computer o un’interruzione di 
alimentazione) all’avvio successivo verifica la cartella AutoSave e se ci trova delle partiture chiede 
se si desidera ripristinarle; chiudendolo normalmente, Sibelius cancella tutti i file presenti nella 
cartella AutoSave – è essenziale quindi non salvare i propri file in quella cartella! 

Il salvataggio automatico è attivo di default, me se per qualsiasi ragione si volesse disattivarlo 
andare nella pagina File della finestra di dialogo File > Preferenze (menu Sibelius in Mac).  
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Qui si può anche specificare la frequenza con la quale Sibelius salva automaticamente la partitura; 
il tempo di default è 10 minuti.

Backup
Ogni volta che si salva, la partitura (con un numero di versione aggiunto al nome) è salvata anche 
in Backup Scores nella cartella Scores. Se accidentalmente si cancella o si perde una partitura, 
cercare in questa cartella di backup l’ultima versione salvata (o versioni precedenti). Questa car-
tella contiene le ultime 40 partiture salvate; le copie più vecchie sono progressivamente cancellate 
per non riempire il disco rigido (non usare questa cartella per memorizzare i propri backup!).

Le partiture di backup sono create quando si salva manualmente, non ogni volta che Sibelius 
esegue un salvataggio automatico; tuttavia, come le partiture salvate automaticamente, le partiture 
di backup non sono cancellate quando si chiude Sibelius.

Finestra Score Info
La finestra di dialogo File > Info su partitura serve per inserire informazioni sulla partitura 
(titolo, compositore, arrangiatore, copyright e così via) usate automaticamente quando si pubblica 
la partitura in Internet (b Esportare pagine web Scorch). Queste informazioni si possono 
inserire anche nella pagina finale della finestra di dialogo File > Nuovo quando si crea una partit-
ura. La pagina File della finestra File > Info partitura mostra utili dettagli sulla partitura (data di 
creazione e dell’ultimo salvataggio, quantità di pagine, righi e misure contenute e così via); questa 
pagina appare solo dopo aver salvato la partitura almeno una volta.

I valori inseriti nei campi della finestra Score Info possono essere usati anche come jolly negli 
oggetti di testo da inizio a fine partitura; per i dettagli sui jolly e il loro uso in Sibelius, b Jolly.

File modificabili dall’utente
Sibelius consente di creare i seguenti file personalizzati:

* Idee (b Idee).
* Stili house (b House Style™).
* Plug-in (b Plug-in).
* Questionari (b Creatore Quaderni di Lavoro).
* Stili Arrange (b Modificare gli stili Arrange).
* Librerie di diagrammi accordo (b Diagrammi accordo).
* Equivalenti dei font di testo e musicali (b Lavorare con i testi, Font musicali).
* Fogli manoscritti (b Foglio manoscritto).
* Set di funzioni (b Menu e comandi rapidi).
* Menu scritte (b Lavorare con i testi).

Poiché Sibelius ha i propri set per ognuno di questi tipi di file, tutti quelli creati in più sono salvati 
su destinazioni diverse da quelle fornite dal programma. I file standard inclusi in Sibelius non si 
possono cancellare; non è possibile cambiare nulla nella cartella dell’applicazione vera e propria (o 
pacchetto applicativo – talvolta noto come “bundle” – in Mac) dove sono salvati i file.
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I file personalizzati (modificabili dall’utente) sono memorizzati in cartelle specifiche nella cartella 
dei dati d’applicazione nel computer, la cui destinazione è diversa in base al sistema operativo imp-
iegato:

* Windows Vista: C:\Users\nome utente\Application Data\Sibelius Software\Sibelius 5\.

* Windows XP: C:\Documents and Settings\nome utente\Application Data\. 
Sibelius Software\Sibelius 5.

* Mac: /Users/nome utente/Library/Application Support/Sibelius Software/Sibelius 5.

Si noti che in Windows, di default la cartella dati d’applicazione è nascosta e non è visibile in 
Esplora di Windows. Per accedere a essa selezionare Strumenti > Opzioni cartella da qualsiasi 
finestra di Esplora aperta; cliccare sulla pagina Visualizzazione e dall’elenco File e cartelle sceg-
liere Visualizza cartelle e file nascosti.

All’interno della cartella dati d’applicazione di Sibelius ci sono varie altre cartelle, i cui nomi ne 
indicano il contenuto; è possibile anche che non ci sia alcuna cartella, poiché sono inserite solo 
quando si crea o modifica un file salvato su quella destinazione.

Si può copiare ogni file appropriato nelle directory dell’area utente e Sibelius le userà all’avvio suc-
cessivo; inoltre, i file aggiunti o creati possono essere cancellati senza conseguenze spiacevoli.

Template Scorch e strutture
È possibile creare i propri template Scorch e strutture foglio/desk; collocarle nelle rispettive cartelle 
all’interno della cartella dati d’applicazione e Sibelius li riconoscerà. I template Scorch vanno nella 
cartella Scorch templates e le strutture nella cartella Textures.
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8.2 Condivisione file

Condividere la musica scritta in Sibelius con altre persone è semplice.

Condividere i file con altri utenti Sibelius
Se la persona con la quale si lavora ha Sibelius, è sufficiente inviargli il file tramite posta elettronica 
(vedere in seguito) o salvarlo su un supporto multimediale mobile come un CD-R.

Verificare la versione di Sibelius usata dalla persona alla quale si inviano i file. Se dispone della 
medesima versione di Sibelius, è sufficiente salvare il file normalmente e spedirlo; se invece ha una 
versione precedente di Sibelius oppure utilizza Sibelius Student o G7, occorre esportare la propria 
partitura in un formato file precedente – b Esportare su versioni precedenti.

Condividere i file con persone che non usano Sibelius
Se la persona con la quale si lavora non ha Sibelius, ci sono altri modi per condividere i file:

* Chiedere a questa persona di scaricare e installare la versione demo gratuita di Sibelius dal sito 
www.sibelius.com, quindi inviargli il file. Attenzione! La versione demo stampa solo una sin-
gola pagina filigranata, quindi per fare in modo che l’altra persona possa stampare la partitura 
questo non è il metodo migliore.

* Pubblicare la musica su SibeliusMusic.com, SibeliusEducation.com o sul proprio sito web – 
b SibeliusMusic.com, SibeliusEducation.com e Esportare pagine web Scorch.

* Creare un file PDF della partitura e inviarlo – vedere Creare file PDF a pagina 597.
* Esportare la musica in un file di grafica da Sibelius e spedirlo – b Esportare file grafici.

* Savare la musica in una pagina web Scorch e allegare entrambi i file a un messaggio di posta 
elettronica (vedere in seguito).

* Se l’altra persona ha un altro programma musicale dal quale ascoltare ed eventualmente modifi-
care la musica, inviare un file MIDI – b Esportare i file MIDI.

* Per inviare la musica a qualcuno che la possa sentire senza vedere la partitura, esportare un file 
audio da Sibelius, masterizzarlo su un CD audio (o comprimerlo in un file MP3) e spedirlo tra-
mite posta elettronica – b Esportare i file audio.

Spedire i file tramite posta elettronica
Spedire i file tramite posta elettronica è facilissimo, ma la procedura esatta varia in base al software 
di posta elettronica impiegato:

* Windows Mail, Outlook Express o Mozilla Thunderbird: scrivere un nuovo messaggio e cliccare 
sul pulsante Allega (l’icona graffetta), individuare il file, cliccare su Allega per allegarlo al mes-
saggio e spedirlo come di consueto.

* Apple Mail: scrivere un nuovo messaggio, quindi trascinare e rilasciare il file da allegare ad esso 
nella finestra messaggio e inviarlo come di consueto.

* Netscape Messenger: scrivere un nuovo messaggio, cliccare sul pulsante Allega e selezionare File
dall’elenco a tendina; individuare il file da allegare, fare doppio-clic sul nome per allegarlo al 
messaggio e spedirlo come di consueto.
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* Eudora: scrivere un nuovo messaggio, clic-destro (Windows) o Control-clic (Mac) del mouse sul 
corpo del messaggio e scegliere Allega file; individuare il file da allegare, fare doppio-clic sul 
nome per allegarlo al messaggio e inviarlo come di consueto.

Se non si usa uno di questi programmi consultare la documentazione del client di posta elettronica 
specifico per i dettagli sull’invio degli allegati.

Per spedire un file di Sibelius come pagina web Scorch tramite posta elettronica:

* Innanzitutto esportarlo (b Esportare pagine web Scorch).
* Ricordarsi di allegare entrambi i file .sib e .htm al messaggio di posta elettronica.
* Informare il ricevente che deve avere installato Scorch sul proprio computer; chiedergli di sal-

vare entrambi i file sul computer (per esempio, sul Desktop) e di eseguire un doppio-clic del 
mouse sul file .htm salvato per vedere la partitura sul proprio browser web.

File su Windows o Mac
Sibelius usa esattamente lo stesso formato file sia in Windows che su Mac; si può spostare una par-
titura di Sibelius da Mac a Windows (e viceversa) senza alcuna conversione – vedere sotto.

Entrambi i formati file sono in Unicode, un set di caratteri standard internazionale per cui i carat-
teri speciali (come le lettere accentate) sono tradotte automaticamente tra Mac e Windows. 
I font musicali e di testo sono sostituiti in modo intelligente – b Font equivalenti.

Sibelius ha estensione file .sib. Su Mac i file di Sibelius sono anche di tipo “Sibelius document” 
(internamente il Creatore è “SIBE” e il Tipo è “SIBL”).

Aprire partiture Mac in Windows
Se si tenta di aprire una partitura creata su Mac fornita su CD-R o altro drive, assicurarsi che il 
drive sia formattato per Windows – i computer Mac possono leggere i dischi Windows, ma Win-
dows non è in grado di leggere i dischi Mac.

Per aprire il file in Sibelius per Windows, occorre aggiungereal file l’estensione .sib. Sebbene Sibel-
ius l’aggiunga di default (sia in Windows che su Mac) alcuni utenti Mac preferiscono non usare le 
estensioni file; ciò è un problema in Windows, perché l’estensione file indica a Windows che si 
tratta di un file di Sibelius.

In Windows si può aggiungere l’estensione file con un clic-destro del mouse sull’icona del file e 
selezionando Rinomina; cambiare l’estensione e premere Invio (sulla tastiera principale). 
Un messaggio d’avviso informa che la modifica dell’estensione file potrebbe rendere il file inuti-
lizzabile (perché Windows presume che l’utente non sappia cosa sta facendo); quando chiede se si 
vuole continuare cliccare su Sì.

Una volta rinominato il file aprirlo come al solito con un doppio-clic del mouse.

Aprire le partiture Windows su Mac
Per aprire un file creato in Sibelius per Windows selezionare File > Apri e doppio-clic del mouse sul 
nome del file nella finestra di dialogo.
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8.3 Dividere e unire le partiture

Nello stesso file della partitura è possibile scrivere più movimenti, brani o pezzi (oppure scriverli in 
partiture separate da riunire in seguito); si può anche dividere una partitura contenente più pezzi 
in singole partiture.

Più movimenti, brani o pezzi
È preferibile collocare più sezioni (es. movimenti, brani o pezzi di musica) in un una partitura 
piuttosto di avere una partitura separata per ognuna; inoltre, poiché le nuove sezioni siano sulla 
stessa pagina delle altre (nella partitura o nelle parti) si deve inserirle nello stesso file.

Se ci sono sezioni diverse in due o più file da unire, vedere Funzione “Unire Partiture” 
(Append Score).

Per scrivere (ad esempio) un paio di esercizi su due sistemi nella stessa pagina:

* Inserire come al solito il primo esercizio.
* Selezionare la stanghetta alla fine del primo esercizio e premere Invio (sulla tastiera principale) 

per creare un break di sistema.
* Per avere anche nomi strumento completi e un rigo ordinato selezionare la misura alla fine del 

sistema precedente, aprire il pannello Misure della finestra Proprietà e attivare l’opzione Fine 
sezione.

* Se si desidera creare una stanghetta doppia o di finale alla fine del primo esercizio, (Crea >
Stanghetta > Finale o Doppia).

* Se all’inizio del secondo esercizio la tonalità è diversa, crearne una nuova al solito modo assicu-
randosi di attivare l’opzione Nascondi nella finestra di dialogo Crea > Alterazioni in chiave, 
per nascondere il cambio di tonalità alla fine del sistema precedente.

* Analogamente, se nell’esercizio successivo serve un nuovo tempo in chiave, crearlo al solito 
modo disattivando l’opzione Attiva avviso nella finestra di dialogo Indicazione tempo; ciò 
evita che sia scritto un tempo in chiave precauzionale alla fine del sistema precedente.

* Se si desidera reimpostare il numero misura all’inizio del secondo esercizio (Crea > Altro > Cam-
bio Numero Misura).

Inserire una partitura in più file
Per inserire una singola partitura in più file separati – nel caso più persone contemporaneamente 
lo stiano copiando o orchestrando, ad esempio – è bene regolare il numero sulla prima misura, 
della prima pagina e il primo segno di prova di ogni file, in modo che misure, pagine e segni di 
prova continuino da quelli precedenti.

Attenzione! Usando le parti, ogni sezione in cui l’intera partitura è stata divisa inizia su una nuova 
pagina in ogni parte (ciò può causare cambi di pagina scomodi); una volta terminata la partitura, 
quindi, è meglio unire tra loro i file con la funzione File > Unire partiture – vedere sotto. 

Funzione “Unire Partiture” (Append Score)
Può essere necessario unire tra loro due partiture (ad esempio, se si stanno realizzando canzonieri 
da file separati dei brani). Sibelius ha una funzione che aggiunge una partitura alla fine di una par-
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titura esistente, verificando automaticamente che abbiano righi corrispondenti e garantendo che la 
partitura aggiunta inizi su una nuova pagina.

Per usare questa funzione aprire la prima partitura e selezionare File > Unire partiture; si apre una 
finestra dalla quale scegliere un’altra partitura da aggiungere (il file da aggiungere che si sceglie 
non è modificato).

Se la partitura non ha lo stesso numero di righi, Sibelius genera un messaggio d’avviso (non 
aggiunge una partitura se i righi non corrispondono esattamente). Se il numero di righi è uguale 
ma alcuni nomi strumento sono diversi, Sibelius genera un altro messaggio d’avviso, ma consente 
di continuare (in tal caso, userà i nomi strumento presenti nella prima partitura).

Stili di testo, simboli, teste nota, ecc. dei due file sono miscelati; se due stili di testo hanno lo stesso 
nome ma sono configurati diversamente è usato quello nella prima partitura. Sibelius esegue varie 
operazioni per garantire un’unione ordinata delle partiture: se necessario, nel punto d’unione crea 
cambi di tempo in chiave, tonalità, chiave e strumento. Alla stanghetta finale nella prima partitura 
inserisce un break di pagina e un “fine sezione”, in modo che la partitura aggiunta inizi su una 
nuova pagina con (in generale) i nomi strumento completi; normalmente, quindi, il layout della 
partitura aggiunta rimane uguale a come era in origine.

È meglio nascondere cambi di chiave, tempo e le tonalità di precauzione dove si uniscono le due 
partiture, specialmente se il punto d’unione è in corrispondenza di un break tra due movimenti o 
pezzi – b Nascondere oggetti.
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8.4 Importare le grafiche

v Colore e import delle grafiche.

Questo capitolo spiega come inserire le grafiche nelle partiture importando in Sibelius immagini in 
formato TIFF.

Per trasformare un file grafico (es. un’immagine scansionata o un file PDF) di musica stampata in 
una partitura, b Scansione.

Per trasformare una partitura in un file grafico (es. un file EPS) da pubblicare o per aggiungere 
estratti di musica a un documento, b Esportare file grafici.

Importare una grafica
Per importare un file TIFF:

* Selezionare una nota, pausa, misura o altro oggetto nella partitura ove deve apparire la grafica.
* Scegliere Crea > Grafica. Appare una finestra di dialogo che chiede di trovare il file TIFF da 

importare; una volta trovato il file cliccare su Apri.
* La grafica è creata nella partitura e si può spostarla, copiarla, e così via.
* Se invece si vuole posizionare la grafica con il mouse o collocarla su una pagina vuota (b Break 

- Interruzioni), assicurarsi che non ci sia niente selezionato nella partitura prima di scegliere 
Crea > Grafica; il puntatore del mouse cambia colore, ad indicare che è “pronto” con un oggetto: 
cliccare nella partitura per inserire la grafica.

Le grafiche importate spesso appaiono più belle sullo schermo con la struttura carta in bianco nor-
male (plain white), poiché lo sfondo bianco intorno a forme non rettangolari s’amalgama meglio 
(b Impostazioni visive); tuttavia, le grafiche sono stampate bene con qualsiasi struttura della 
carta.

Sono forniti molti file grafici già pronti da usare se non si ha voglia di crearne di propri; essi sono 
nella cartella Graphics files all’interno della cartella Example Scores e comprendono:

* Figure di strumenti.
* Pulsanti della toolbar di Sibelius e layout del tastierino numerico per realizzare i propri ques-

tionari Sibelius.
* Anelli colorati manoscritti per segnare testi importati, ecc. A causa del modo in cui sono scritti 

devono essere posizionati con cura, per evitare di cancellare oggetti sotto di essi; non sono adatti 
ad essere disegnati attorno alle note, poiché cancellano il rigo.

* Varie grafiche multiuso e divertenti come speciali “attenzione!”, mani, anelli, facce sorridenti, 
ecc..

La cartella ha anche un file Sibelius Graphics examples che illustra molte delle grafiche.

Formati file
Sibelius può importare file grafici in formato TIFF a qualsiasi risoluzione colore (in altre parole, 
possono essere in bianco e nero, scala di grigi o a colori con qualsiasi numero di colori).
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Se la grafica non è in formato TIFF, si può convertirla in un file TIFF con un programma di grafica 
come Graphic Converter per Mac (scaricabile dal sito www.lemkesoft.com), Paint Shop Pro per 
Windows (scaricabile dal sito www.jasc.com) o Imaging per Windows (presente in molti PC nel 
menu Start > Programmi > Accessori).

Copiare, modificare e cancellare le grafiche
Una volta che la grafica appare nella partitura si può lavorarla praticamente come qualsiasi altro 
oggetto:

* Copiarla con un Alt+clic o z-clic
* Spostarla cliccandoci sopra in modo che si sfumi in blu e trascinandola con il mouse, oppure 

usare i tasti freccia (con Ctrl o X per step più grandi).
* Scalarla mantenendone le proporzioni, cliccando sulla piccola maniglia nell’angolo in basso a 

destra (in modo che si circondi di un box blu chiaro) e trascinarla con il mouse o usando i tasti 
3/2 (con Ctrl o X per step più grandi).

* Scalarla modificandone le proporzioni, tenendo premuto Ctrl o X prima di cliccare sull’angolo 
in basso a destra della grafica (ove appaiono le maniglie); rilasciare Ctrl o X e poi trascinarla 
con il mouse o usare i tasti 3/2 (con Ctrl o X per step più grandi).

* Cancellarla premendo Canc.

Per reimpostare una grafica dopo averla lavorata selezionare Layout > Ripristina aspetto
(comando rapido Ctrl+Maius+D o xXD): la grafica torna a posizione e dimensioni originali.

Dimensione file
Importando una graica nella partitura, la dimensione del file aumenta notevolmente; per manten-
erla il più piccola possibile Sibelius comprime il file TIFF quando lo importa e se si usa la stessa 
grafica più volte nella partitura, si può (e si deve) semplicemente copiarlo invece di importarlo 
nuovamente.

reference.book  Page 569  Wednesday, April 16, 2008  4:28 PM



8. File

570

8.5 Aprire i file MIDI

Se non si conosce il MIDI, vedere b Nozioni MIDI che spiega cosa sono i file MIDI. Per sapere 
dove trovare i file MIDI vedere Scaricare file MIDI.

Importare un file MIDI
Un file MIDI si apre come un normale file di Sibelius: selezionare File > Apri (Ctrl+O o XO), indi-
viduare il file (di solito in Windows i file MIDI hanno estensione .mid) e cliccare Apri.

Appare una finestra di dialogo con le opzioni da impostare (descritte in seguito). Normalmente, 
cliccando OK dopo pochi secondi si apre il file MIDI.

Alcuni file MIDI non contengono dati Program Change (sebbene contengano i nomi strumento); 
Lo strumento, quindi, deve essere “immaginato”. In tal caso, Sibelius avvisa che nomi strumento, 
suoni, chiavi e altri dettagli potrebbero essere scorretti; si deve regolare chiave dello strumento ecc. 
a mano o (preferibilmente) eseguire o procurarsi una copia del file MIDI che contiene il dato Pro-
gram Change necessario e importare quel file MIDI.

Se il file MIDI importato non è come quello previsto provare a modificare alcune impostazioni 
d’importazione – vedere Opzioni Import.

Una volta importato il file MIDI si può riprodurlo, modificarlo, salvarlo, stamparlo e ricavare parti 
da esso (come se fosse stata inserita la musica in Sibelius). Grazie alla funzione Live Playback di 
Sibelius (b Live Playback) i file MIDI importati sono riprodotti con tutti i particolari della 
sequenza originale – temporizzazione e velocity esatte di ogni nota.

Opzioni Import

Le opzioni nella pagina File MIDI della finestra di dialogo Apri file MIDI sono:

* File MIDI usa questo set di suoni: consente di specificare se i numeri Program e Bank utiliz-
zano lo standard General MIDI o un altro sound set; ciò aiuta Sibelius ad immaginare quali sono 
gli strumenti. Normalmente questa opzione si lascia in General MIDI (altrimenti disattivarla 
completamente per importare il file MIDI “così com’è”).
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* Solo un rigo per traccia: utile se si apre un file MIDI che scrive il piano (ad esempio) su due 
tracce separate (una per la mano sinistra e l’altra per la mano destra). Attivando questa opzione 
ogni mano è scritta su un rigo, non su due; si può quindi “pulirla” creando un nuovo piano, copi-
andoci le due mani e poi cancellando i due pianoforti originali.

* Mantieni ordine traccia; di default non è attiva (Sibelius sceglie l’ordine degli strumenti); atti-
vandola si mantengono gli strumenti nello stesso ordine delle tracce nel file MIDI.

* Mantieni nomi traccia: Sibelius usa il nome di ogni traccia come nome per lo strumento; dis-
attivarla per usare i nomi strumento di default degli strumenti che Sibelius immagina.

* Nascondi righi vuoti: di default è attiva; Sibelius nasconde i righi vuoti dall’inizio alla fine della 
partitura risultante; spesso è utile, poiché molti file MIDI hanno tracce che sono vuote (tranne 
per brevi passaggi); nascondendo i righi vuoti è più facile leggere la partitura.

* Importa marker come hit points: Sibelius converte tutti i marker nel file MIDI in hit point 
nella partitura che crea; disattvandola, Sibelius importa i marker come oggetti di testo standard.

* Usa frame rate da header SMPTE: Sibelius imposta i valori frame rate nella finestra Play >
Video e Tempo > Timecode e durata secondo le impostazioni presenti nel file MIDI – vedere 
Offset SMPTE.

* Usa intavolatura per chitarra: specifica se Sibelius deve importare le tracce di chitarra pre-
senti nel file MIDI su righi di tablatura; disattivandola, le chitarre sono importate su righi di 
notazione.

* Usa voci multiple: determina se Sibelius deve usare due voci (nel caso così facendo la notazi-
one sia più chiara); normalmente questa opzione si lascia attiva.

* Mostra segni di metronomo: mostra tutti i segni di metronomo; se ci sono molti cambi tempo 
(es. rit. e accel.) è meglio disattivare questa opzione, in modo da nascondere i segni di met-
ronomo nella partitura e renderla più leggibile (pur riproducendola allo stesso modo).

* Le opzioni Impostazioni documento permettono di scegliere Dimensioni pagina, House 
style e orientamento (Verticale o Orizzontale) della partitura risultante.

* Per i dettagli sulle opzioni nella pagina Notazione vedere Opzioni Flexi-time on page 21.

Opzioni di importazione raccomandate
L’esatta combinazione di opzioni da definire nella finestra di dialogo Apri file MIDI dipende da 
molti fattori; per esempio:

* Se s’importa un file MIDI per avere una notazione chiara disattivare le opzioni nella pagina 
Notazione per scrivere staccati e tenuti e sperimentare varie impostazioni Minimum note 
value fino a ottenere i risultati migliori.

* Importando un file MIDI solo per la riproduzione, le opzioni che si scelgono non sono impor-
tanti, poiché Sibelius riproduce sempre il file MIDI esattamente come suona con la funzione Live 
Playback.

* Se s’importa un file MIDI creato da qualcun altro (probabilmente su un dispositivo diverso, per 
esempio, un file MIDI scaricato da Internet) bisogna impostare l’opzione MIDI file uses this 
sound set al dispositivo per il quale è stato creato.

* Importando un file MIDI che utilizza il sound set General MIDI assicurarsi di aver scelto l’opzi-
one General MIDI in MIDI file uses this sound set.
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Nella maggior parte dei casi le impostazioni nella pagina Notazione vanno bene così: Regola 
ritmo attiva, Durata minima nota da 1/16, Staccato e Tenuto attive. Con un file MIDI nel quale 
i ritmi sono precisi (già quantizzati, ad esempio) disattivare l’opzione Regola ritmo.

Impostando il valore Durata minima il file MIDI contiene lunghe sequenze di note da 1/16 – 
ovviamente Sibelius non può riconoscere correttamente le sequenze usando note da 1/8 e potrebbe 
generare cose assurde (dovrà arrotondare le sequenze di note da 1/16 usando gruppi irregolari di 
note da 1/8, oppure unire tra loro alcune coppie di note da 1/16 per formare accordi a otto note).

Le opzioni per i gruppi irregolari (tuplet) sono a discrezione dell’utente: 

* Semplice: i gruppi irregolari sono scritti solo se contengono valori nota uguali.
* Moderato e Complesso: servono per ritmi più irregolari.

Si ricorda che se in un file MIDI c’è un gruppo irregolare particolare (una terzina, ad esempio) si 
deve lasciare questa opzione almeno a Semplice, altrimenti la terzina non sarà interpretata corret-
tamente! Inoltre, se (ad esempio) s’impostano tutti i gruppi irregolari in Complesso, Sibelius 
potrebbe elaborare ritmi irregolari complessi dove non sono previsti, quindi attenzione!

Conversione di massa (batch conversion)
Sibelius ha un plug-in che converte un’intera cartella piena di file MIDI; per usarlo selezionare 
Plug-in > Processo di massa > Converti cartella di file MIDI; un messaggio chiede d’individuare 
la cartella da convertire: trovarla e cliccare OK. Tutti i file MIDI nella cartella sono convertiti in file 
di Sibelius.

Pulizia dei file MIDI
Poiché i file MIDI non contengono alcun dato di notazione, potrebbero apparire confusi una volta 
aperti in Sibelius; ecco alcuni consigli per ottenere risultati migliori sia prima che dopo la conver-
sione:

* Se il file MIDI usa numeri Program Change non-standard (es. è configurato per suonare su un 
dispositivo MIDI insolito) Sibelius non riesce a identificare correttamente gli strumenti ed essi 
possono apparire con caratteristiche impreviste (es. chiavi sbagliate o in ordine sbagliato). 
Analogamente, se il file MIDI utilizza il canale 10 per gli strumenti intonati, questi sono impor-
tati come strumenti percussivi da Sibelius (dipende se aprendo il file MIDI si seleziona o meno 
un dispositivo MIDI adeguato).

* Se ciò avviene importare di nuovo il file cambiando l’opzione Il file MIDI usa questo set di 
suoni.

* Se il file MIDI non è quantizzatto opportunamente (o completamente) i ritmi sono scritti non 
così chiari come previsto. Se è possibile accedere al sequencer, si può provare a ri-quantizzare il 
file e aprirlo di nuovo in Sibelius. Altrimenti provare con il plug-in Plug-in > Semplifica 
notazione > Riscrivi esecuzione, il quale ri-quantizza la musica e ri-assegna le voci in modo 
intelligente (per maggiori dettagli vedere Riscrivi esecuzione on page 422).

L’operazione di “pulizia” più comune dopo l’apertura di un file MIDI è rendere più leggibili i righi 
di percussioni non intonate – per maggiori dettagli b Percussioni.
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Quando Sibelius importa percussioni non intonate in un file MIDI, ogni suono percussivo è con-
vertito a testa nota e posizione sul rigo (linea o spazio) definiti nello strumento 5 lines (drum 
set); se è usato un suono percussivo per cui la notazione non è definita in questo tipo di stru-
mento, Sibelius realizza una notazione usando teste nota normali a croce e rombo in posizioni 
vuote del rigo.

Talvolta si ottengono pause indesiderate tra le note o unisoni indesiderati (due teste nota che con-
dividono la stessa altezza); per rimediare a questa anomalia usare i plug-in Plug-in > Semplifica 
notazione > Rimuovi pause e Plug-in > Semplifica notazione > Rimuovi note all’unisono – 
b Plug-in.

Offset SMPTE
L’evento offset SMPTE MIDI è importato (se c’è) e definisce il valore Start Time nella finestra di 
dialogo Play > Video e Tempo > Timecode e durata (si usa anche per impostare il frame rate 
usato per il timecode nella partitura); tuttavia, poiché l’evento offset SMPTE MIDI non indica tutti 
i formati di frame rate usati da tutti i sequencer, se si conosce il frame rate da usare selezionare Set 
frame rate nella pagina MIDI File della finestra di dialogo Open MIDI File e scegliere il valore di 
frame rate desiderato dal menu (se non capite cosa significa non preoccupatevi – lasciate queste 
opzioni così come sono!).

Dettagli tecnici
Sibelius importa i file MIDI di tipo 0 e 1, cercando di trovare intelligentemente gli strumenti da 
usare (usando i nomi traccia se ci sono, altrimenti utilizzando i suoni) ed è in grado di distinguere 
(ad esempio) tra Violino e Viola, Clarinetto e Clarinetto Basso, oppure Soprano e Contralto 
dall’estensione musicale in ogni traccia. Sibelius “ripulisce” il ritmo usando l’algoritmo Flexi-time e 
conserva tanti o pochi dati di messaggi MIDI in base a quelli specificati (es. segni di metronomo, 
Program Change, e così via). Sibelius inoltre riduce automaticamente la dimensione del rigo se gli 
strumenti sono troppi per la dimensione della pagina.

Scaricare file MIDI
Per i file MIDI ci sono molte risorse on-line. Se serve un brano particolare provare a cercarlo in 
www.google.com (digitando il nome del brano seguito dalla scritta “file MIDI”, ad esempio). Alt-
rimenti è possibile provare con uno dei seguenti siti:

* www.prs.net: oltre 16.000 file di musica classica, tutti di pubblico dominio.
* www.musicrobot.com: motore di ricerca per i file MIDI di musica pop in rete.
* www.cpdl.org: ottimo sito con migliaia di file per musica corale di pubblico dominio.
* www.cyberhymnal.org: tutti gli inni principali (anche con parole scaricabili).

Non tutti i file di questi siti sono in formato MIDI – alcuni sono in formato Finale, PDF o altro. 
Altri possono essere anche in formato audio (es. MP3) che Sibelius non può aprire; verificare bene 
il formato del file prima di provarlo e scaricarlo. Sibelius, tuttavia, può aprire i file in vari formati – 
per i dettagli consultare gli altri argomenti in questo capitolo.

Una volta trovato il file MIDI desiderato nel browser web, identificare il link per scaricarlo; in 
genere i link sono sottolineati. Non cliccare direttamente sul link, poiché così facendo il file MIDI è 
riprodotto nel browser web: si vuole scaricarlo, non riprodurlo. Quindi:
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* Clic-destro (Windows) o Control-clic (Mac) sul link: appare un menu.
* Scegliere Save Link As, Save Target As o Download Link (il termine esatto dipende dal 

browser web impiegato).
* In base al browser web può apparire un messaggio che chiede dove salvare il file; in tal caso, 

scegliere una destinazione a portata di mano (il Desktop, ad esempio).
* A questo punto il file è scaricato; normalmente i file MIDI sono molto piccoli, quindi bastano 

pochi secondi.

Complimenti! Avete scaricato un file MIDI – la procedura descritta in precedenza si può usare per 
scaricare qualsiasi tipo di file da Internet.

Assicurarsi di sapere il nome del file MIDI e dove è stato salvato (normalmente sul Desktop), poi 
aprire Sibelius e seguire le istruzioni nel paragrafo Importare un file MIDI all’inizio di questo 
capitolo.

Attenzione! Scaricando o pubblicando file MIDI della musica di qualcuno senza il suo permesso si 
violano le leggi sul diritto d’autore (copyright); infrangerle è illegale e proibito in ogni caso dalla 
licenza d’uso di Sibelius.

La maggior parte della musica ha titolo e autore; se non si conosce il copyright di un file MIDI 
scaricato, si prega di consultare l’editore, il compositore o l’arrangiatore del brano.
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8.6 Aprire i file MusicXML

b Aprire i file Finale 98-2003.

Il convertitore file interno MusicXML 1.1 di Sibelius consente di aprire i file MusicXML creati in 
una serie di software musicali, inclusi Finale 2003 (e superiori) e SharpEye.

Con i file di Finale 2003 (solamente) può funzionare più o meno bene se si apre un file ETF 
(Enigma) – vedere b Aprire i file Finale 98-2003; si possono provare entrambi i metodi, ma i 
risultati ottenuti dipendono dal file che si sta importando.

Lo scopo del converitore file è risparmiare tempo, non convertendo ogni partitura in modo esatta-
mente identico all’originale; in particolare, MusicXML 1.1 non specifica la posizione precisa di ele-
menti o informazioni sulla configurazione del documento (come dimensione pagina e rigo).

Cosa significa MusicXML?
MusicXML è un formato di interscambio file tra software di notazione musicale. Offre un metodo 
migliore per trasferire la notazione tra programmi diversi di altri formati, come i file MIDI.

Creare i file MusicXML in Finale
Per avere un file in formato MusicXML in Finale si deve usare il plug-in Dolet (una versione “Lite” 
è fornita per Windows con Finale 2003). Se non si possiede Dolet Lite (o bisogna aggiornarsi a 
Dolet) si beneficerà di un supporto aggiuntivo di formato file per Finale (inclusi i file MuseData), 
più precisione nei passaggi dai file MusicXML salvati con Dolet per Sibelius e il supporto per 
esportare notazione percussiva, tablatura, stili di rigo, linee e parentesi personalizzate. 
Per maggiori informazioni visitare il sito www.recordare.com.

Aprire un file MusicXML
Un file MusicXML file si apre come un normale file di Sibelius: selezi-
onare File > Apri (comando rapido Ctrl+O o XO), individuare il file e 
cliccare Open. Sibelius mostra una finestra di dialogo nella quale 
definire dispositivo di riproduzione, dimensione e orientamento foglio 
e stile house da applicare alla partitura; se aprendo la partitura Sibelius 
non riesce a identificare i nomi strumento nel file, chiede se deve pro-
vare a riconoscere intelligentemente gli strumenti previsti.

In genere funziona, ma si può cliccare No e scegliere gli strumenti 
manualmente, se necessario:
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* L’elenco Strumenti nel file a sinistra mostra le singole parti nel file MusicXML.
* Nell’ordine in cui sono elencati i righi nell’elenco Strumenti nel file usare gli elenchi Ensem-

ble, Famiglia e Disponibili per scegliere gli strumenti di Sibelius da usare per ogni parte (un pò 
come nella finestra di dialogo Strumenti); doppio-clic del mouse sullo strumento o cliccare 
Aggiungi per aggiungerlo all’elenco Strumenti da creare a destra.

* Quando tutte le parti sono state mappate sugli strumenti di Sibelius si abilita il pulsante OK: 
cliccarci sopra per completare l’apertura del file.

In seguito si può verificare e modificare a piacere il file; in particolare, si possono cambiare le 
dimensioni di pagina e rigo nella finestra di dialogo Layout > Imposta documento.

Messaggi d’avviso
Alcuni file MusicXML contengono errori (indicati in una finestra di dialogo che elenca ogni errore 
e il punto in cui si è verificato nel file che si sta aprendo); gli errori possono essere di tre tipi:

* Errori fatali: il file non è di tipo XML; è un errore irreversibile e il file non può essere aperto.
* Errori di convalida: il file è di tipo XML, ma la sintassi specifica degli elementi MusicXML pre-

senta errori o incongruenze; Sibelius tenterà di aprire il file, ma la partitura risultante potrebbe 
presentare problemi inaspettati, quindi si dovrà procedere con cautela.

* Avvisi: talvolta il protocollo XML genera avvisi sui file XML quando sono aperti; normalmente 
ciò non impedisce una corretta apertura del file.

L’elenco con gli avvisi è utile per modificare il file dopo la sua conversione; si può anche usare il 
pulsante Salva Messaggi per salvare l’elenco degli errori in un file di testo, da stampare o spedire 
come prova di lettura.

Importare i file MusicXML salvati in un sequencer
Sibelius è ottimizzato per offrire i risultati migliori quando si aprono i file MusicXML creati con il 
plug-in Dolet di Finale; in casi estremi, però, alcuni file XML (specialmente quelli creati in 
sequencer privi di funzioni di notazione) possono generare una notazione illeggibile. 

Versioni supportate
Il convertitore MusicXML di Sibelius è basato su MusicXML 1.1. I file creati nei formati 
MusicXML più vecchi si aprono correttamente (sempre che siano validi); anche i file creati con 
versioni pù aggiornate del formato MusicXML si aprono, ma la maggior parte delle nuove funzioni 
non sono importate.

Sibelius apre solo i file MusicXML che impiegano il livello DTD (Document Type Definition) 
denominato “partwise.dtd”. Se un file usa il livello DTD “timewise.dtd” si deve usare XSLT per con-
vertirlo da MusicXML “timewise” a MusicXML “partwise”. Questo convertitore è disponibile on-
line sul sito: www2.freeweb.hu/mozartmusic/pttp/converter.html.

Conversione di massa (batch conversion)
Sibelius ha un plug-in che converte un’intera cartella piena di file MusicXML; per usarlo, selezion-
are Plug-in > Processo di massa > Converti cartella di file MusicXML. Un messaggio chiede 
d’individuare la cartella da convertire; trovarla e cliccare OK: tutti i file MusicXML nella cartella 
sono convertiti in file di Sibelius.
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Qualità dei risultati
La qualità dei risultati in genere è buona: la maggior parte degli elementi MusicXML sono impor-
tati da Sibelius; le limitazioni sono riassunte nella seguente tabella:

Elemento Limitazione

Articolazioni Segni di respirazione, cesure, scoop, plop, doit e falloff non sono importati.
Alcune articolazioni potrebbero essere collocate sul lato sbagliato di nota o accordo.
Gli elementi technical e ornaments non sono importati.

Misure Misure con gruppi irregolari potrebbero essere importate alla durata sbagliata.

Stanghette Se righi diversi hanno diversi tipi di stanghette simultaneamente, Sibelius usa il tipo di stanghetta 
della parte più in alto.
Stanghette Heavy, heavy-light e heavy-heavy non sono importate.

Tratti d’unione I sub-tratti d’unione non sono importati.
L’attributo “repeater” non è importato (per il tremolo).

Diagrammi accordo I diagrammi accordo non sono importati.

Simboli accordo Il plug-in Dolet di Finale esporta i simboli accordo solo quando la riproduzione dell’accordo è definita 
correttamente .
Alcuni simboli accordo potrebbero non essere importati (quando usano un elemento function).
Lo standard MusicXML specifca che tutti i simboli accordo vanno sopra il rigo superiore solo in una 
parte.
Le istanze Neapolitan, Italian, French, German, pedal (pedal-point bass) e Tristan sono tutte 
importate come accordi maggiori.
Se nell’elemento harmony non c’è l’elemento function il simbolo dell’accordo non è importato.
Se un accordo è specificato come un’inversione, quest’ultima è ignorata.

Chiavi Chiavi speciali per percussioni e tablature disponibili nei file MusicXML sono sostituite da quelle più 
simili disponibili in Sibelius.
Lo standard MusicXML non distingue le chiavi a inizio o fine di una misura.

Colori L’attributo color non è importato (gli oggetti colorati sono importati in nero).

Note attraverso il rigo I file MusicXML che usano una serie di voci attraverso i righi potrebbero importare alcune note sul 
rigo sbagliato.
I file contenenti accordi con note in righi diversi non sono importati correttamente.

Linee di fine ripetizione Sibelius potrebbe importare in modo non corretto linee di fine ripetizione complesse.
Sono importate solo le linee di fine ripetizione presenti nella parte più in alto del file XML.
Può essere necessario regolare manualmente la posizione delle linee di fine ripetizione.

Tablatura di chitarra L’elemento staff-type non è importato.
I righi di tablatura per chitarra con capotasto mobile non sono importati correttamente.
Hammer-on, pull-off e bending non sono importati.
Quasi tutti gli elementi “figli” di quello technical non sono importati.

Tonalità L’elemento cancel per i bequadri di precauzione non è importato.
Sono riconosciuti solo i modi major e minor dell’elemento mode.
Se manca l’elemento fifths è importata una tonalità atonale.
Gli elementi “figlio” diversi da key (es. key-step e key-alter) sono ignorati.
Se una parte ha più di un rigo, le tonalità potrebbero essere omesse da uno o più di questi righi.
Le tonalità che in altri programmi di notazione musicale si trovano dopo la stanghetta, in Sibelius 
potrebbero andare a finire prima della stanghetta.

Layout Sibelius può usare solo una dimensione pagina per l’intera partitura importata.
Oggetti spostati solo graficamente (offset) nel file potrebbero influenzare la riproduzione in Sibelius.

Parole Gli elementi laughing, humming, end-line, end-paragraph e editorial sono ignorati.
Gli attributi font dell’elemento text non sono convertiti, quindi i cambi font sono ignorati.
Gli attributi jusitfy, default-x, default-y, relative-x, relative-y e placement non sono convertiti.
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Segni di metronomo I segni di metronomo con note da 1/256, 1/128, 1/64 e lunghe (breve) non sono importate da Sibelius.
Tutti i segni di metronomo adottano le posizioni di default di Sibelius.
L’importatore XML legge solo i segni di metronomo nel rigo superiore della parte più in alto.
I segni di metronomo potrebbero essere duplicati se la parte più in alto nel file ha più di un rigo.

Ornamenti Alcuni ornamenti non sono importati; mordenti, trilli e turn sono importati.

Segni di prova I segni di prova sono importati ma solo quelli che appaiono sopra il rigo superiore nel file MusicXML.

Pause Le pause extra dovute a più voci sullo stesso rigo sono rimosse automaticamente, ma alcune pause 
extra potrebbero rimanere scritte (es. in passaggi attraverso il rigo).

Legature di portamento L’attributo continue non è importato.
Gli attributi d’identità position e bezier non sono importati.
Le legature tratteggiate e punteggiate non sono importate.
placement e orientation non sono importati.

Simboli I simboli non sono importati.

Righi Righi nascosti e ossia non sono importati.
Cambi del tipo di rigo non sono importati.

Gambi I valori del gambo none e double non sono importati.

Testi Il plug-in Dolet di Finale non supporta i testi allineati alla pagina; sono compresi gli stili di testo per 
scrivere titolo e compositore.
Gli attributi justify dell’elemento words non sono importati.
Alcuni elementi di testo sono importati grazie all’elemento dynamics, ma nessuno degli attributi 
dinamici è importato.
Elementi specifici del basso figurato, come parentheses, elision e extend non sono importati.
L’elemento directive non è importato.
Gli elementi font-family e font-size in genere sono ignorati.

Legature di valore L’elemento tie è completamente ignorato; sono importate solo le legature di valore specificate dall’ele-
mento tied.
L’attributo number è ignorato.
Tutte le legature di valore sono importate come legature solide.
Gli attributi position, placement, orientation, bezier-offset, bezier-x e bezier-y non sono importati.

Tempi in chiave Sibelius non importa tempi in chiave composti (es. 2/4 + 6/8), ma divisioni del movimento presenti 
solo nel numeratore (es. 2+3 / 4) sono importate.
Gli elementi Senza-misura non sono importati.
Il valore dell’attributo single-number del simbolo non è importato (se c’è s’importa in normal)
Se in righi diversi ci sono tempi in chiave diversi simultaneamente, Sibelius usa il tempo in chiave del 
rigo più in alto.

Gruppi irregolari I gruppi irregolari “annidati” (nested tuplet) non sono importati.
Alcune versioni del plug-in Dolet di Finale non collocano gli elementi d’inizio e fine del gruppo irrego-
lare alla giusta posizione (che quindi potrebbe non essere importato correttamente).
Gli attributi tuplet placement, position, show-type, show-number, bracket e line-shape non 
sono importati.

Elemento Limitazione
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8.7 Aprire i file Finale 98-2003

Il convertitore dei file Finale interno di Sibelius permette di aprire i file creati in Finale, Allegro, 
PrintMusic e Finale Guitar, inclusi i file ETF (Enigma) di Finale. Lo scopo del convertitore dei file è 
risparmiare tempo, non convertire ogni partitura in modo che sia identica all’originale. Come per 
qualsiasi convertitore di file ciò è poco realistico, poiché Finale/Allegro/PrintMusic/Finale Guitar e 
Sibelius lavorano in modo diverso e hanno funzioni diverse.

Se il file da aprire è di Finale 2004 o superiori esportare invece un file MusicXML da Finale e 
importarlo, poiché in questo modo funziona meglio – b Aprire i file MusicXML.

Versioni supportate
Sibelius può aprire i seguenti tipi di file:

* File .mus da Finale 98/2000, Allegro 98/2000, PrintMusic 1.0.
* File .etf da Finale 98/2000/2001/2002/2003/2004/2005, Finale Guitar.

Con file di versioni precedenti a Finale/Allegro 98, il convertitore chiede di salvare nuovamente il 
file da una versione più recente di Finale/Allegro per aggiornarlo; Sibelius lo può quindi aprire.

In Finale 2001–2005 e Finale Guitar si deve salvare il file in formato .etf (Enigma Transportable 
File), sebbene MusicXML sia preferibile (se disponibile); Sibelius non può aprire i file in formato 
.mus da Finale 2001 o successivi, né da Finale Notepad.

Se il file proviene da Finale 2003, possibilmente esportare il file in formato MusicXML; si potreb-
bero ottenere risultati migliori (dipende dal file). Se è salvato in Finale 2004 o Finale 2005 espor-
tarlo da Finale in formato MusicXML e importarlo così, poiché funzionerà meglio. Un file salvato 
in Finale 2006 o superiori, non può essere aperto da Sibelius; si deve usare il formato MusicXML. 
b Aprire i file MusicXML.

Convertire un file
In Sibelius, selezionare File > Apri (Ctrl+O o XO), individuare il file Finale, Allegro, PrintMusic o 
.etf e cliccare su Apri; appare una finestra di dialogo con alcune semplici opzioni: cliccare su OK e 
poco dopo il file si apre. Si può quindi verficarlo e modificarlo a seconda delle esigenze.

Messaggi d’avviso
Alcuni file contengono dati che il convertitore file non riesce a convertire correttamente. In tal 
caso, durante la conversione si apre una finestra di dialogo con un elenco di avvisi, i quali indicano 
la gravità di ciascun problema, oltre a rigo e misura nei quali si è verificato. I righi sono numerati 
in modo che quello più in alto è 1 (i righi nascosti sono comunque conteggiati – per un elenco di 
tutti i righi visibili nella finestra Crea > Strumenti e righi di Sibelius usare il comando rapido I).

L’elenco con gli avvisi è utile per modificare il file dopo la conversione (e usarlo come base per una 
prova di lettura della partitura, ad esempio).

La finestra d’avviso ha un pulsante Salva per salvare gli avvisi in file di testo da stampare o conseg-
nare a un correttore; gli avvisi si possono salvare in ogni momento – convertendo molti file gli 
avvisi si accumulano, quindi prima del salvataggio si può aspettare fino alla fine.
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Layout
Dopo la conversione Sibelius cerca di mantenere il layout del file originale, ma nei casi in cui 
l’informazione sul layout orginale non può essere determinata, Sibelius genera un avviso e procede 
configurando la partitura. Per assicurarsi che il layout in Sibelius corrisponda a quello del file orig-
inale, aprire il file originale in Finale, andare all’ultima pagina e selezionare Modifica > Aggiorna 
il layout, poi salvare nuovamente il file in formato .etf. Sibelius sarà quindi in grado di deter-
minare correttamente il layout del file.

Lingue supportate
I file creati in Finale Guitar e Finale 2003 o superiori possono contenere testi Unicode in qualsiasi 
lingua; sia in Windows che su Mac, Sibelius importa correttamente testi in Inglese, Tedesco e Giap-
ponese da questi file. 

Sibelius cerca anche di stabilire la lingua dei file di testo in Finale 2003 o superiori verificando il 
codice pagina usato per codificare il testo nel file. Il testo può non essere importato correttamente 
o non apparire affatto se il sistema operativo non supporta quella lingua. Se il file contiene testo in 
una lingua sconosciuta, scegliere l‘opzione Lingua predefinita del file che si sta aprendo nella 
finestra di opzioni che appare all’apertura di un file. Utilizza la lingua predefinita per tutti i 
testi impone a Sibelius di trattare tutto il testo (tranne quello che usa font musicali, come Petrucci) 
nel file di Finale come se fosse nel linguaggio di default selezionato; normalmente questa opzione 
non deve essere attiva.

Conversione di massa (batch conversion)
Sibelius ha un plug-in che converte un’intera cartella piena di file Finale; funziona allo stesso modo 
con i file di Allegro, PrintMusic e Finale Guitar.

Per usarlo selezionare Plug-in > Processo di massa > Converti cartella di file di Finale. Un mes-
saggio chiede di individuare la cartella da convertire; trovarla e cliccare su OK: tutti i rispettivi file 
nella cartella (inclusi i file Enigma .etf) sono convertiti in file di Sibelius.

Se i file sono stati creati in versioni di Finale o Allegro precedenti a Finale/Allegro 98 occorre 
aggiornarli, aprendoli e salvandoli nuovamente in versioni più recenti di Finale/Allegro prima di 
avviare il plug-in.

Qualità dei risultati
La qualità dei risultati in generale è buona: le notazioni standard normalmente si convertono bene 
e il convertitore riconosce persino vari “trucchi” usati comunemente in Finale trasformandoli in 
notazione corretta in Sibelius.

Le limitazioni dovute all’apertura dei file di Finale sono riassunte nella tabella che segue; la mag-
gior parte di esse non si verifica spesso, perché il più delle volte in Finale sono funzioni misteriose, 
usate raramente nella pratica quotidiana (ad esempio, le note speculari).
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Elemento Limitazioni

Alterazioni In situazioni strane di note legate in più voci (o note legate a niente) può darsi che un’alterazione non sia 
convertita correttamente.

Articolazioni Sono omesse le seguenti articolazioni di Finale (alcune non sono comunque normalmente scritte come 
articolazioni): estensione del trillo, trillo, accordo spezzato, doppio slash, abbellimento, rombo, paren-
tesi, tenuto + accento (come articolazione singola).
Articolazioni inserite con il tool Expression di Finale non sono importate.
Articolazioni che si convertono a quelle standard di Sibelius (accento, tenuto, staccato, ecc.) vanno alle 
posizioni di default di Sibelius.

Numeri misura Si può scegliere se convertirle ai numeri misura nativi di Sibelius o a testi di Sibelius nella finestra Opz-
ioni quando si apre un file; convertendole in testi, più opzioni di Finale funzionano correttamente, ma 
ciò può complicare la modifica della partitura e in alcuni casi persino far scomparire completamente i 
numeri misura.

Stanghette Regolazioni orizzontali manuali della stanghetta eseguite con il tool Measure di Finale sono ignorate.
Le stanghette grafiche sono omesse.
Le stanghette spesse sono importate come stanghette doppie.
I tick sono importati come stanghette regolari.
Le stanghette finali sono omesse (versione 2003 e successive).

Tratti d’unione I break dei tratti d’unione secondari sono convertiti in tratti d’unione secondari continui

Parentesi tonde 
e quadre

Le parentesi di linea sono importate come parentesi regolari.
Le parentesi riposizionate a mano in Finale sono importate alla spaziatura di Sibelius.
Collocazioni individuali secondarie di parentesi non sono convertite (ciò si definisce globalmente nella 
finestra di dialogo House Style > Regole tipografia di Sibelius).

Diagrammi accordo I diagrammi accordo fittizi che usano caratteri di font per chitarra digitati in testo (es. con il font 
Seville) sono importati correttamente.
I diagrammi accordo “nativi” di Finale sono convertiti con le seguenti limitazioni: se le voci dei suffissi 
accordo sono cambiate in Finale (quindi visualizzano un diagramma accordo diverso) Sibelius con-
vertirà sempre l’aspetto di default dei suffissi accordo standard; i nuovi suffissi accordo inseriti 
dall’utente non sono convertiti; inoltre, ci potrebbe essere qualche anomalia dovuta al numero limitato 
di cornici supportato da Finale. Per esempio, la cornice che appare in Finale per l’accordo D (no 3rd)
contiene una terza (a dispetto del nome); Sibelius mantiene l’aspetto originale del diagramma accordo 
(in questo caso visualizzando un diagramma accordo con una terza, proprio come fa Finale).

Simboli accordo I simboli accordi nelle parti trasportate non sono trasportati correttamente una volta importati (a meno 
che il file di Finale non sia stato salvato nella propria condizione trasportata).

Righi di batteria La mappatura di batteria dei righi percussivi potrebbe non essere corretta.

Abbellimenti I tratti d’unione degli abbellimenti non sempre sono convertiti con precisione.

Tablature per chitarra Le opzioni di regolazione gambo nelle tablature di Finale non si convertono; le opzioni di chiave per la 
tablatura in Finale non sono supportate.
Le nuove notazioni di tablatura per chitarra incluse in Finale 2003 e Finale Guitar sono importate, ma si 
noti che: le note assegnate automaticamente a una corda, in Sibelius potrebbero non essere sulla stessa 
corda (ma l’altezza sarà giusta); note su una corda specificata in Finale sono importate sulla stessa corda 
in Sibelius; se il file di Finale usa accordature di chitarra definite dall’utente, Sibelius importa i righi 
interessati come se usassero l’accordatura standard e genera un messaggio d’avviso “grave” – le altezze 
saranno giuste ma i numeri tasto saranno sbagliati, a causa di un bug nel formato file ETF di Finale; i 
file contenenti accordature di chitarra standard in Finale modificati dall’utente avranno le giuste altezze 
ma numeri tasto sbagliati in Sibelius – in questo caso non appare un messaggio d’avviso, perché il dato 
d’accordatura in Finale si perde salvandolo in un file ETF (quindi è impossibile sapere che è stato mod-
ificato); alcune accordature standard di chitarra sono sbagliate in Finale (le corde sono accordate sbagli-
ate in Finale): sono importate alle giuste altezze ma con numeri tasto errati.

Strumenti I nomi strumenti talvolta potrebbero essere sbagliati su Mac se durante l’import il codice pagina non è 
impostato correttamente.
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Tonalità Tonalità indipendenti su righi diversi sono importate come tonalità di default.
Tonalità anomale (es. 3 diesis + 2 bemolle) sono omesse; le partiture di Finale che utilizzano queste 
tonalità sono importate con spelling enarmonici errati.
Le tonalità nascoste in Finale basandosi sulla misura non sono convertite.

Layout e spaziatura I margini sono regolati per evitare che escano dalla pagina.
La spaziatura nota orizzontale in Finale è ignorata; sono usate invece le regole per la spaziatura di 
default di Sibelius (che spesso sono migliori).
I sistemi sovrapposti verticalmente in Finale sono importati come due sistemi distinti a separazione 0.

Linee Le linee tracciate con Shape Designer in Finale non sono importate.
La posizione delle estensioni di trillo non sempre è importata con precisione.
Le linee che iniziano e finiscono su righi diversi sono omesse.
Gambi capovolti possono provocare un posizionamento scorretto delle legature di portamento.
L’opzione di spessore per la legatura in Finale è ignorata.
I valori specificati dalla funzione Avoid Staff Line by at Least x amount di Finale sono ignorate.
Le legature Shape Expressions create in Finale non sono importate.
Le legature attaccate agli abbellimenti possono essere a posizioni imprecise.
Ripetizioni personalizzate non sono convertite.

Parole L’allineamento delle parole in Finale (sinistra, destra, centro) è importato con l’allineamento di default 
di Sibelius.
Le parole sono rispaziate secondo le regole di Sibelius.
Modificando lo stile di testo Lyrics la formattazione delle parole potrebbe non aggiornarsi automatica-
mente – scegliere quindi Modifica > Filtro > Parole e usare il comando Layout > Ripristina aspetto
dopo aver cambiato lo stile di testo.
Le sillabe di alcune parole talvolta sono scritte nell’ordine sbagliato.
A volte le parole possono diventare confuse.

Segni di metronomo Su Mac i segni di metronomo a volte possono essere sbagliati se durante l’import il codice pagina non è 
impostato correttamente.

Note e legature  
di valore

Si può definire la dimensione della testa nota (come percentuale delle dimensione normale in Sibelius) 
nella finestra di dialogo Options quando si apre un file.
Le direzioni dei gambi di default in Finale sono importate con quelle di default in Sibelius, quindi in 
alcuni casi i gambi potrebbero essere rivolti nella direzione opposta.
Le note attraverso il rigo sono implementate secondo le regole di Sibelius, quindi sono lasciate sul rigo 
originale le note in un accordo incrociate individualmente su un altro rigo e quelle incrociate su un rigo 
in un altro strumento (o in un rigo non adiacente).

Pagina Convertendo i numeri pagina in elementi di testo, talvolta scompaiono tutti i numeri pagina.

Estrazione parte Alcune opzioni di estrazione parte non sono importate (es. segni estratti in alcune parti e non da altre)

Riproduzione Le impostazioni di riproduzione MIDI sono importate dal layer 1 dei righi di Finale; le impostazioni in 
altri layer sono ignorate.

Segni di prova I segni di prova sono convertiti come testi nello stile di testo Rehearsal Marks; ciò significa che non sar-
anno rinumerati/riletterati automaticamente se modificati in futuro.
Le partiture contenenti segni di prova che usano numeri misura come testo non si aprono in Sibelius.

Pause La posizione verticale delle pause è convertita alle posizioni di default di Sibelius.

Simboli I simboli del tool Staff Expression sono omessi.

Testi Gli elementi di testo in Finale che contengono data e ora sono importati a data e ora della conversione.
Alcuni caratteri di testo (es. le lettere accentate) sono importate con più precisione se il file di Finale è 
importato nella stessa piattaforma (Mac o Windows) sulla quale è stato creato (il formato file di Finale, 
infatti, non è opportunamente indipendente dalla piattaforma).

Cambi di trasporto Nelle finestra di dialogo Staff Transpositions di Finale sono ignorate le seguenti funzioni: Simplify key; 
Chromatic transpositions; Set to clef

Elemento Limitazioni
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Gruppi La posizione verticale delle parentesi dei gruppi irregolari non è importata.
I gruppi irregolari di Finale senza parentesi, di default sono importati in parentesi.
I valori ratio di Finale sono importati con la seconda figura del ratio.
Le parentesi tonde in Finale sono importate come parentesi quadre.
Di default i gruppi irregolari non sono importati magneticamente.

Voci Le note speculari (usate raramente) non sono importate correttamente; si può rimediare convertendole 
tutte a note normali prima d’importare il file.
4 layer e 2 voci di Finale sono mappati a 4 voci in Sibelius; vale in tutte le situazioni pratiche, ma si pos-
sono avere strani casi nei quali questa mappatura non può essere eseguita e le note sono omesse 
(quando in Finale si usano contemporaneamente 5 o più combinazioni di layer/voce, ad esempio).

Elemento Limitazioni
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8.8 Aprire i file SCORE

Il convertitore di file SCORE interno di Sibelius permette di aprire i file creati nel programma di 
scrittura musicale SCORE.

Lo scopo del convertitore file è risparmiare tempo, non convertire ogni partitura in modo che sia 
identica all’originale. Come per qualsiasi convertitore file ciò non è molto realistico, poiché SCORE 
e Sibelius lavorano in modo diverso e hanno funzioni diverse. I file SCORE sono particolarmente 
difficili da convertire correttamente.

Convertire un file
Si può convertire una singola pagina (in genere con estensione file .mus) o un elenco di file SCORE 
con estensione .tmp (un elenco di pagine separate che contengono una partitura). Convertendo un 
elenco di file si deve collocare il file .tmp nella stessa cartella dei singoli file che rappresentano le 
pagine della partitura, altrimenti non possono essere trovati.

In Sibelius selezionare File > Apri (Ctrl+O o XO), individuare il file .tmp o .mus e cliccare su 
Apri; se in questa finestra non si vede il file, assicurarsi che il nome file abbia la giusta estensione.

Si apre una finestra di dialogo Opzioni con alcune opzioni auto-esplicative; modificare le opzioni 
in base alle necessità e cliccare su OK: poco dopo il file si apre. Durante la conversione del file 
appare una finestra che elenca gli errori rilevati se il convertitore trova funzioni che non è in grado 
di convertire (per un aiuto nella prova di lettura futura del file).

Una volta aperto il file si può controllarlo e modificarlo, se necessario.

Conversione in massa (batch conversion)
Sibelius ha un plug-in che converte un’intera cartella piena di file SCORE; per usarlo selezionare 
Plug-in > Processo di massa > Converti cartella di file SCORE. Un messaggio chiede di individ-
uare la cartella da convertire; trovarla e cliccare su OK: tutti i file SCORE nella cartella sono con-
vertiti in file di Sibelius.

Si noti che il plug-in SCORE converte elenchi di file (non singole pagine): per convertire più file 
SCORE, quindi, si devono collocare tutti i file in una singola cartella con un elenco di file per ogni 
partitura. Il plug-in convertirà gli elenchi dei file generando partiture di Sibelius.

Elenchi di file SCORE
Normalmente i file SCORE sono costituiti da una singola pagina. Se la partitura ha più di una pag-
ina, per convertirla si deve realizzare un elenco di file SCORE (un file con estensione .tmp conte-
nente un elenco di altri file SCORE). Molte partiture avranno già elenchi di file, poiché sono 
necessari per alcune operazioni in SCORE (come l’estrazione di parti).

Un elenco file si crea facilmente con l’utility FList di SCORE; altrimenti, si possono elencare le sin-
gole pagine in un editor di testo (es. Blocco note di Windows) e salvarle in un nome file con esten-
sione .tmp. Per esempio, avendo una partitura di 4 pagine costituita da file denominati 
page01a.mus, page02a.mus, page03a.mus e page04a.mus, l’elenco dei file sarà così:
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page01a.mus 1 
page02a.mus 1 
page03a.mus 1 
page04a.mus 1

Dopo il nome file è indicato il numero di file che compone la pagina (di solito 1); in alcuni casi può 
essere più di 1 (se la partitura contiene molti righi da distribuire tra i file).

I file elencati in un elenco di file SCORE possono avere qualsiasi estensione file (cioè non sono lim-
itati alle estensioni .mus, .pag e .pge, allo stesso modo dei file aperti direttamente).

Numeri strumento
Se la partitura è “ottimizzata” (cioè non tutti i sistemi hanno lo stesso numero di righi), Sibelius 
deve capire a quali corrispondono gli strumenti. Si può indicarlo aprendo i file in SCORE e impo-
stando il parametro 9 (numero strumento) per ogni rigo; in ogni caso, si deve farlo quando si 
estraggono le parti da SCORE.

Non impostando questo dato, il convertitore chiede se i numeri strumento devono essere inseriti 
automaticamente, oppure l’utente può specificare manualmente i numeri strumento persi.

Partiture trasportate
Se il file SCORE contiene strumenti trasportati bisogna assicurarsi che l’opzione Visualizza 
riquadro trasposizioni sia attiva nella finestra di dialogo Opzioni di conversione dell’arrangia-
mento, che appare quando si apre un file SCORE. Una volta cliccato su OK si apre la seguente 
finestra di dialogo:

Questa finestra consente di indicare a Sibelius quale strumento usare per ogni rigo nella partitura. 
Selezionare ogni strumento nell’elenco Strumenti nel file a sinistra, scegliere lo strumento appro-
priato dagli elenchi Famiglia e Disponibili e cliccare su Aggiungi; una volta assegnati gli stru-
menti a tutti gli elementi nell’elenco Strumenti nel file, cliccare su OK per convertire il file.

Tempi in chiave
Poiché SCORE non indica la durata delle misure, all’inzio della partitura serve un tempo in chiave, 
in modo che Sibelius conosca la durata delle misure da realizzare. Se non è presente un tempo in 
chiave, il convertitore visualizza una finestra di dialogo che consente di specificare qual è il tempo 
in chiave implicito; questo tempo in chiave non sarà inserito nella partitura convertita.
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Partiture a singola pagina
Il convertitore (oltre a leggere elenchi file) legge anche i file a singola pagina con estensioni .mus,
.pge e .pag; se il file non ha una di queste estensioni modificare il nome file per inserirle; tuttavia, 
i file ai quali fa riferimento un elenco di file SCORE possono avere un’estensione qualsiasi.

Ottimizzare la partitura prima della conversione
Sebbene la conversione file funzioni generalmente abbastanza bene senza regolare prima i file in 
SCORE, alcune modifiche migliorano notevolmente la qualità della partitura risultante in Sibelius:

* Assicurarsi che in ogni misura la somma dei movimenti corrisponda alla sua durata e che la 
durata di ogni misura corrisponda al tempo in chiave.

* Assicurarsi che le stanghette siano allineate verticalmente in ogni sistema; il metodo migliore 
per garantirlo è usare la routine “Line up and Justify” (L J) di SCORE.

* Inserire i numeri strumento su tutti i righi aggiungendo un valore al parametro 9. Ciò garantisce 
che Sibelius collochi la musica nei giusti strumenti.

* Per avere i risultati migliori usare la versione 3 o superiore di SCORE. Aprire e salvare nuova-
mente i file creati in versioni precedenti di SCORE usando almeno la versione 3. Il convertitore 
file non può aprire file dalla versione 1 di SCORE, mentre i file dalla versione 2 di SCORE non 
sono importati così fedelmente come quelli dalla versione 3.

Limitazioni
La tabella seguente mostra le limitazioni del convertitore dei file SCORE:

Elemento Limitazione

Tratti d’unione Talvolta i tratti d’unione non sono convertiti con prescisione; gruppi complessi di tratti d’unione parziali 
possono essere interpretati in modo diverso da Sibelius.

Diagrammi accordo Alcuni diagrammi sono convertiti in una griglia normale priva di una linea grossa (o “capotasto”) in alto.

Nomi strumento Nomi strumento multi-rigo o complessi (es. Corni I & II) non sono convertiti.

Tonalità I parametri 8, 9, 10, 11, 12, 13 delle tonalità estese di SCORE non sono convertiti; il loro impiego può provo-
care errori d’altezza nei rispettivi righi

Linee Le linee di Pedale sono convertite in testo Technique invece che in linee, quindi non influenzano la 
riproduzione; gli offset di linea nella versione 4 di SCORE non sono convertiti.

Parole In alcuni casi potrebbero non essere importate correttamente (quando una linea di parola termina sul 
sistema successivo a un’altezza verticale diversa da quella che ha nel sistema precedente).

Note e pause I quarti di tono non sono convertiti; righi in tre voci diverse possono avere i gambi rivolti nella direzione 
errata.

Riproduzione/MIDI Tutti i righi riproducono un suono di piano; usare la finestra Mixer (comando rapido Ctrl+Alt+M o
zXM) per impostare il suono di strumento corretto per ogni rigo dopo la conversione.

Legature di porta-
mento

Gli offset delle legature nella versione 4 di SCORE non sono convertiti.

Righi/sistemi Un Coda sullo stesso rigo ove c’è una misura D.S. potrebbe non essere convertito correttamente.

Simboli Alcuni simboli speciali (specialmente percussivi) potrebbero non essere convertiti correttamente.

Testi Il testo di sottotitolo di solito è convertito in stile di testo Titolo – usare il pannello Testo della finestra Pro-
prietà per cambiare lo stile di testo in Sottotitolo.

Legature di valore In gruppi irregolari legati, la legatura di valore talvolta oltrepassa le nota successiva.

Gruppi irregolari Il numero della terzina (es. 3) può urtare i tratti d’unione; gruppi irregolari complessi potrebbero non 
essere convertiti; si genera il messaggio d’errore: “La durata non è supportata”.
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Per aprire partiture create in versioni precedenti di Sibelius per Windows o Mac, b Aprire i file 
di versioni precedenti.

Il convertitore dei file Acorn interno di Sibelius consente di aprire file creati nei programmi origi-
nali Acorn Sibelius (Sibelius 7, Sibelius 7 Student, Sibelius 6 e Junior Sibelius), versioni 3.01 o 
superiori. Con i file precedenti la versione 3.01 il convertitore chiede di ri-salvare il file dalle ver-
sioni 3.01 o successive per aggiornarlo; ciò premette a Sibelius per Mac/Windows di aprirli.

Lo scopo del convertitore file è risparmiare tempo, non convertire ogni partitura in modo che sia 
identica a quella originale. Come per ogni convertitore ciò è poco realistico, poiché le versioni 
Acorn e Mac/Windows di Sibelius lavorano diversamente e hanno funzioni diverse.

Trasferire i file da Acorn a PC o Mac
Il metodo più semplice per trasferire i file è il seguente:

* Formattare un floppy-disk al formato DOS 1.44Mb (si può fare su Acorn o PC/Mac; i floppy-disk 
nuovi normalmente sono comunque formattati così); copiare i file Acorn nel floppy-disk, clic-
care sul pulsante Menu sull’icona del drive floppy-disk (segnata :0) sulla barra dell’icona e selez-
ionare Dismount, per assicurarsi che i file siano salvati completamente. 

* Estrarre il floppy-disk e inserirlo su PC o Mac.
* Copiare i file dal floppy-disk sull’hard-disk PC o Mac prima della conversione (saranno poi con-

vertiti più velocemente).
* Se si desidera aggiungere .s7 al nome file, ad indicare che si tratta di file Acorn Sibelius (usare 

.s7 anche per i file di Sibelius 6); altrimenti, si può rinominarli quando sono ancora su Acorn: 
aggiungere /s7 alla fine (lo slash diventerà un punto su PC/Mac). 

Convertire un file Acorn Sibelius
In Sibelius per Mac/Windows selezionare File > Apri (Ctrl+O o XO), individuare il file Acorn 
Sibelius (con la sua estensione .s7) e cliccare su Apri; si raccomanda di non aprire un file diretta-
mente da un floppy-disk (prima copiarlo su hard-disk). Poco dopo il file si apre ed è possibile 
quindi verificarlo e modificarlo secondo le necessità.

Se il file è precedente la versione 3.01 di Acorn Sibelius, un messaggio chiede di ri-salvare il file 
dalla versione 3.01 o superiore per aggiornarlo e riprovare.

Conversione di massa (batch conversion)
Sibelius ha un plug-in che converte un’intera cartella piena di file Acorn Sibelius. Per usarlo, in 
Sibelius per Mac/Windows selezionare Plug-in > Processo di massa > Converti cartella di file 
Sibelius 7 Acorn. Un messaggio chiede di individuare la cartella da convertire: trovarla e cliccare 
su OK. Tutti i file Acorn Sibelius nella cartella sono convertiti ai file di Sibelius per Mac/Windows.

Se i file Acorn Sibelius erano in un formato precedente la versione 3.01, caricarli in una versione 
3.01 o successiva di Acorn Sibelius e ri-salvarli prima di convertirli.
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Limitazioni
Le limitazioni principali sono riassunte nella tabella seguente – alcune limitazioni molto tecniche 
sono state omesse.

Elemento Limitazioni

Alterazioni In due voci, un’alterazione su una nota in una voce non è applicata implicitamente a note della stessa 
altezza nell’altra voce; deve apparire in entrambe le voci per essere convertita correttamente.
Alterazioni legate tra stanghette potrebbero essere convertite male sulla seconda nota (vedere Note e lega-
ture).

Articolazioni Alcune pause nelle misure di pausa non sono importate.

Cambi di numero 
misura

I cambi di numero della misura non sono importati.

Diagrammi accordo Al momento non sono importati (erano un’ultima aggiunta a Sibelius 7 ma sono poco usati).

Chiavi Può darsi che in alcuni casi ci siano problemi con le chiavi in ottava.

Gomme Non importate (non esiste equivalente diretto) – di solito in Sibelius per Mac/Windows sono sostituite da 
un sistema diviso, un ossia, un cambio strumento “nascosto” o un oggetto nascosto.

Abbellimenti Nella maggior parte dei casi sono importati.

Tablatura chitarra E’ convertita in modo elementare, convertendo il testo che costituisce la tablatura di chitarra in Sibelius 7 
(sebbene il risultato non è una tablatura di chitarra vera e propria di Sibelius per Mac/Windows).

Stili house In gran parte sono impostati ai default di Sibelius per Mac/Windows (per esempio, i numeri pagina sono 
resattati per iniziare da 1).

Layout / Spaziatura I break di sistema/pagina sono convertiti ma l’impaginazione potrebbe cambiare. Per correggere questa 
anomalia usare le funzioni Adatta in un’accollatura/Pagina di Sibelius per Mac/Windows; i vuoti tra i 
righi potrebbero non essere gli stessi. La spaziatura nota è quella standard di Sibelius per Mac/Windows 
(leggermente diversa da quella in Acorn).

Linee Non tutte le linee sono convertite ai rispettivi equivalenti; quelle che non lo sono si convertono invece a 
semplici linee continue.

Note e legature Legature di valore e portamento sono le stesse in Acorn Sibelius, quindi il convertitore immagina quali 
sono quelle da convertite in legature di valore in Sibelius per Mac/Windows; a volte il convertitore con-
verte erroneamente una legatura di portamento in una di valore, perché nel contesto si assomigliano – è 
abbastanza facile modificarle di nuovo, sebbene l’aspetto spesso è corretto anche lasciandole come lega-
ture di valore. 

Estrazione parte Se le parti sono estratte da un file Acorn Sibelius convertito alcuni strumenti trasportati potrebbero appa-
rire all’ottava sbagliata; ciò si corregge facilmente trasportando le rispettive parti di un’ottava. 

Riproduzione Le impostazioni di riproduzione MIDI non sono importate, quindi la maggior parte degli strumenti avrà il 
suono di default del piano; usare la finestra Finestra > Mixer di Sibelius per impostare correttamente i 
suoni.

Segni di prova Non sono importati.

Pause Misure di pausa a doppia nota intera (breve) sono importate come normali misure di pausa.

Righi Alcuni righi nascosti potrebbero riapparire dopo la conversione; si possono nascondere con il comando 
Layout > Nascondi righi vuoti.

Simboli Simboli (“Trasferibili”) non sono importati.

Testi Il testo di tempo duplicato è importato come singolo elemento di testo; le definizioni degli stili di testo non 
sono importate; i font di testo quindi sono riportati ai rispettivi default; il testo per il musicista non è 
importato (non ci sono diretti equivalenti in Sibelius per Mac/Windows); il testo di basso figurato non è 
importato; se sembra che il titolo scompaia dopo la conversione, potrebbe essere stato collocato fuori dalla 
cima della pagina; trascinare in basso il rigo finchè appare il titolo, trascinarlo in basso ad una distanza 
adeguata dal rigo e infine trascinare nuovamente in alto il rigo.

reference.book  Page 588  Wednesday, April 16, 2008  4:28 PM



8.10 Aprire i file di versioni precedenti

589

File
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Sibelius può aprire i file cresti in tutte le versioni precedenti di Sibelius per Windows o Mac; basta 
selezionare File > Apri e aprire la partitura come al solito.

Finestra Aggiorna Partitura
Poiché ogni nuova versione di Sibelius presenta un nuovo set 
di funzioni, aprendo una partitura esistente appare la finestra 
di dialogo Aggiorna Partitura per scegliere gli aspetti della 
partitura da aggiornare (se ce ne sono). Si possono scegliere 
solo opzioni che non erano disponibili nella versione di Sibel-
ius nella quale è stata salvata la partitura.

Di default, Sibelius non fa niente che possa influenzare 
l’aspetto della partitura, ma se è attiva l’opzione Crea parti 
dinamiche crea un set di default di parti dinamiche 
(b Lavorare con le parti).

Cliccando sul pulsante House Style è possibile scegliere nuove opzioni che possono migliorare 
l’aspetto della partitura:

* Legature magnetiche su note normali: rende magnetice le legature sopra o sotto le note nor-
mali, in modo che un’estremità di ogni legatura s’attacca alla nota o accordo più vicini 
(b Legature di portamento).

* Legature magnetiche su note che incrociano il rigo: funziona in modo simile, ma si applica 
solo a legature su note attraverso il rigo, come nella musica per tastiera (b Legature di por-
tamento).

* Regola lunghezza gambo versione 1.3: allunga di 0.25 spazi in più rispetto all’opzione non 
attiva i gambi a entrambi i lati delle note sulla linea centrale (molti editori e scrittori lo 
preferiscono).

* La regola di posizionamento voce è stata perfezionata in Sibelius 2, quindi per applicarla alle 
partiture più vecchie attivare l’opzione Regola posizionamento voce versione 2 (b Voci).

* Gruppi irregolari mangetici: garantisce che numeri e parentesi dei gruppi irregolari siano 
posizionati correttamente sopra o sotto le note del gruppo irregolare in base alla rispettiva posiz-
ione sul rigo (b Terzine e altri tuplet).

* Regola trascrizione note nella trasposizione di strumenti: garantisce che lo spelling delle 
note in strumenti trasportati sia enarmonicamente corretto (b Strumenti).

* Consenti spaziatura note e rigo contratta: trae vantaggio dai perfezionamenti eseguiti sugli 
algoritmi di spaziatura di Sibelius per compattare la spaziatura orizzontale e verticale della par-
titure più vecchie (b Spaziatura note).

* Posizioni tratti "Optical": applica le posizioni Optical ai tratti d’unione (b Tratti d’unione).
* Legature "Optical" applica le posizioni Optical alle legature di valore (b Legature di 

valore).
* Spaziatura note "Optical": sostituisce tutte le regolazioni manuali eseguite sulla spaziatura 

nota nella partitura e applica la regola Optical di Sibelius (b Spaziatura note).
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* Ignora oggetti nascosti per la direzione dei gambi e le pause: deve essere attiva (a meno 
che siano stati capovolti i gambi e cambiata la posizione verticale delle pause nella partitura e si 
desideri conservare queste modifiche).
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v Esportare file grafici.

Sibelius esporta (salva) un passaggio o pagina di musica in immagine nei formati standard dei file 
grafici. Si può anche copiare e incollare le grafiche da Sibelius direttamente in un’altra applicazione 
(es. Microsoft Word); ciò consente d’inserire facilmente la musica in altri documenti (articoli, 
questionari, temi, libri di musica, copertine, poster e annotazioni di programma).

Tutti gli esempi musicali in questo Manuale operativo sono stati esportati direttamente da 
Sibelius in Adobe FrameMaker – nessun bisogno di forbici e colla!

Se il documento finale è costituito prevalentemente da musica, si può usare invece Sibelius stesso 
come programma in cui assemblare musica e grafiche (per creare questionari di partiture con una 
pagina di copertina grafica, ad esempio) – b Importare le grafiche.

Copiare le grafiche sugli Appunti
Sibelius consente di copiare un’area della partitura sugli Appunti, da incollare quindi direttamente 
come grafica in un’altra applicazione.

* Per esportare un passaggio o misura specifici, occorre prima selezionarli.
* Scegliere Modifica > Seleziona > Seleziona grafica (comando rapido Alt+G o zG).
* Eseguendo una selezione, attorno ad essa appare un box tratteggiato; se non è stata fatta una 

selezione il cursore si trasforma in una croce e si può cliccare e trascinare il mouse attorno 
all’area della partitura da esportare.

* Regolare la dimensione del “marquee” (vedere sotto) in modo da includere esattamente ciò che 
si desidera copiare.

* Selezionare Modifica > Copia (comando rapido Ctrl+C o XC).
* Passare all’applicazione di destinazione e selezionare Modifica > Incolla (in generale il comando 

rapido è Ctrl+V o XV), oppure scegliere Modifica > Incolla speciale.

Nella pagina Altro della finestra File > Preferenze (menu Sibelius in Mac) definire la risoluzione 
grafica e scegliere se Sibelius esporterà in bianco e nero o a colori – b Preferenze.

Con l’esportazione copia e incolla delle grafiche Sibelius genera una grafica bitmap; per una grafica 
vettoriale usare invece la finestra di dialogo Esporta Grafiche – vedere Esportare le grafiche.

Regolare il marquee
Per regolare il marquee sono disponibili vari modi:

* Cliccare e trascinare una maniglia per estendere il marquee nella direzione desiderata.
* Tenere premuto Ctrl o X e trascinare la maniglie sinistra o destra per far scattare le estremità del 

marquee alle stanghette.
* Tenere premuto il tasto Maius e trascinare le maniglie per allargare il marquee proporzional-

mente in entrambe le direzioni (es. per alzarlo sia sopra che sotto il rigo, trascinare una delle 
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maniglie in alto e tenere premuto il tasto Maius mentre si trascina per estenderlo in alto e in 
basso).

Se prima di eseguire la procedura precedente nella partitura c’era una selezione di passaggio o 
sistema, Sibelius disegna automaticamente un box attorno a quell’area quando si seleziona 
Modifica > Seleziona > Seleziona grafica. Il box scatterà in cima e in basso ai righi, quindi prob-
abilmente non sarà necessario estendere la selezione in alto e in basso; per farlo, tenere premuto il 
tasto Maius e trascinare in alto la maniglia superiore del box.

Inserire le grafiche in Microsoft Word
Per collocare in un documento di Word la grafica creata in Sibelius e copiata sugli Appunti usando 
la procedura descritta in precedenza:

* Nel documento di Word posizionare il cursore alla posizione ove collocare la grafica.
* Selezionare Modifica > Incolla (Ctrl+V o XV); la grafica apparirà nel documento di Word.
* Aumentare o diminuire la dimensione della musica trascinando un angolo qualsiasi del box. 

Non trascinare un lato, altrimenti la musica si allunga e perde il rapporto di aspetto corretto. 
Premere Ctrl+Z o XZ per annullare (Undo) se ciò è stato fatto per sbaglio.

In alcune versioni di Microsoft Word, l’operazione incolla di una grafica da un’altra applicazione 
non funziona correttamente; in tal caso selezionare Modifica > Incolla speciale e, dall’elenco dei 
formati disponibili, scegliere Bitmap.

Attenzione a modificare la grafica in Word – i suoi editor grafici non gestiscono bene la musica e si 
potrebbero avere risultati imprevisti; usare invece un programma grafico dedicato.

Esportare le grafiche
Invece di usare gli Appunti, è possibile esportare le grafiche in un file sul disco rigido.

Poiché la maggior parte di utenti non è interessata ai dettagli tecnici, è Sibelius che si occupa dei 
dettagli per l’esportazione dei file grafici – generalmente non occorre nemmeno sapere quale tipo 
di file grafico esportare; è sufficiente conoscere il programma in cui lo si utilizza.
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Sibelius permette di esportare l’intera partitura, una singola pagina, uno o più sistemi o un’area 
specifica della partitura in modo semplice e rapido:

* Per esportare uno o più sistemi, selezionare anzitutto i sistemi desiderati come passaggio, quindi 
scegliere File > Esporta > Grafica; nella finestra Esporta Grafiche, cliccare su Sistemi selezi-
onati.

* Per esportare una o più pagine intere (o l’intera partitura) selezionare File > Esporta > Grafiche. 
Nella finestra Esporta Grafiche, cliccare su Tutte o Pagine e inserire i numeri pagina da espor-
tare.

* Per esportare un’area specifica della partitura eseguire una selezione di passaggio attorno 
all’area da esportare e scegliere Modifica > Seleziona > Grafica (Alt+G o zG). Il cursore si 
trasforma in una croce e a quel punto si può regolare con precisione l’area selezionata trasci-
nando una delle maniglie del marquee (vedere in precedenza); a questo punto selezionare File >
Esporta > Grafica e cliccare su Selezione grafica.

La finestra di dialogo Esporta Grafiche presenta le seguenti opzioni:

* Programma/Formato: elenca i programmi supportati direttamente da Sibelius, insieme ai vari 
formati di file grafici che può salvare; se il programma scelto non è elencato, si può scegliere il 
formato più adatto al proprio software.

* Nome del file: determina il nome del file assegnato al file di grafica esportato; salvando più 
pagine, il nome inserito qui forma la base del nome di ogni file (che sarà seguito dal numero 
pagina della partitura ed eventualmente anche dal nome della cartella).

* Salva nella cartella: consente di stabilire dove sarà salvato il(i) file di grafica esportato(i); clic-
care su Sfoglia e scegliere la cartella desiderata.

* Crea sottocartella: scegliendo d’esportare un intervallo di pagine dell’intera partitura e atti-
vando questa opzione, Sibelius crea una cartella nella quale colloca tutti i file di grafica; di 
default avrà il nome file specificato in precedenza associato al nome del formato; se, ad esempio, 
si specifica il nome file Concerto 1st movt e lo si esporta come file EPS, la cartella si chiamerà 
Concerto 1st movt EPS (sebbene si possa cambiare, se lo si desidera).

reference.book  Page 593  Wednesday, April 16, 2008  4:28 PM



8. File

594

* Grafiche EPS: queste opzioni (come suggerisce il nome) servono per esportare i file EPS:
% Includi anteprima TIFF: consente di includere un’anteprima TIFF monocromatica (com-

pressa con lo schema CCITT modificato Huffman RLE) nel file EPS, che permette alla mag-
gior parte dei programmi grafici di mostrare un’anteprima a bassa risoluzione del file EPS 
prima della stampa.

% Includi font: attivando questa opzione, Sibelius inserisce tutti i font utilizzati nel documento 
nel file EPS; sebbene l’aggiunta dei font aumenti la dimensione del file EPS creato, l’editore (o 
il tipografo) che desidera utilizzare i file EPS potrà stamparli correttamente senza bisogno di 
avere copie separate dei font veri e propri. Si raccomanda di attivare questa opzione (a meno 
che non vi sia una buona ragione per non farlo).

* Dimensioni: queste opzioni controllano la dimensione del file di grafiche salvato; sono dis-
ponibili varie opzioni per i diversi formati:
% Scala (solo EMF): è regolabile solo per l’esportazione nel formato (piuttosto inaffidabile) 

EMF; in teoria, EMF è un formato vettoriale e non dovrebbe esserci differenza esportando (ad 
esempio) al 100% o 400%; in pratica, però, il posizionamento di oggetti nei file EMF non è 
molto preciso a bassi valori di scala. Di default, i file EMF sono salvati al 400%, per migliorare 
l’allineamento di teste nota, gambi, ecc..
Per altri formati questa opzione non è modificabile, ma regolando l’opzione Punti per pollice essa 
s’aggiorna ad indicare come i dpi scelti influenzino il fattore di scala in uscita.

% Punti per pollice (solo TIFF, PNG, BMP, PICT): consente di controllare la risoluzione delle 
immagini bitmap esportate; più alto è il valore dpi, maggiore è la risoluzione del file espor-
tato. 
Il valore inserito qui indica la qualità bitmap rispetto a una stampante laser; scegliendo 
quindi 300 si ha la stessa qualità di una stampante laser a 300 dpi.

% Regola dimensione per ottimizzare righi (solo TIFF, PNG, BMP, PICT, EMF): questa opzi-
one consente a Sibelius di eseguire lievi regolazioni delle impostazioni Punti per pollice/
Scala, per garantire che la distanza tra tutte le linee del rigo nel file esportato siano a un 
numero pari di pixel (cosa che ne migliora l’aspetto).

% Dimensione minore riquadro: definisce le dimensioni del file grafico risultante. Se questa 
opzione non è attiva i file grafici utilizzano le dimensioni pagina della partitura (inclusi i mar-
gini) come limiti del box; con questa opzione attiva, il file è tagliato alla dimensione più pic-
cola possibile (cioè ai bordi della musica).

* Opzioni: altre opzioni (alcune delle quali disponibili solo per determinati formati):
% Monocromatico (solo TIFF, PNG, BMP): a meno che non occorra esportare una partitura 

contenente oggetti colorati (o grafiche importate a colori) è meglio lasciare attiva questa opz-
ione. Salvando i file grafici in bianco e nero la dimensione del file risultante è minima, ma la 
qualità non è compromessa (sempre che non servano i colori).

% Includi opzioni del menu Vista: specifica se le opzioni correnti del menu Vista (oggetti 
nascosti, evidenziazioni, colori nota e così via) saranno inclusi visibilmente nel file grafico. Di 
default questa opzione non è attiva.

% Includi oggetti colorati: disattivando questa opzione (o se è attiva quella Monocromatico) 
tutti gli oggetti colorati nella partitura sono colorati in nero nel file grafico esportato.
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% Sostituisci: queste opzioni fanno lo stesso per la stampa (b Stampa), cioè correggono i 
bug di alcuni programmi grafici che disegnano linee e parentesi sbagliate.

Una volta definite le opzioni, cliccare su OK per esportare il file grafico.

Conversione di massa (batch conversion)
Sibelius ha un plug-in che salva automaticamente i file grafici di tutte le partiture in una cartella – 
vedere Converti cartelle di spartiti in grafica in b Plug-in.

Formati grafici
I formati dei file grafici sono di due tipi: vettoriali e bitmap.

Le grafiche vettoriali sono scalabili – in altre parole, si possono ingrandire o ridurre senza una per-
dita di qualità – tendono anche a usare meno memoria dei file bitmap.

Le grafiche bitmap hanno una qualità inferiore rispetto a quelle vettoriali (a meno che non si usi 
una risoluzione molto elevata) e in generale occupano più memoria, ma sono supportati da molti 
più programmi.

I formati specifici disponibili in Sibelius sono:

* Vettoriali: EPS (Windows e Mac), EMF (Windows), PICT (Mac).
* Bitmap: TIFF, PNG, BMP (Windows e Mac).

Ogni formato è descritto nei dettagli in seguito; da Sibelius è possibile anche creare file PDF.  
Vedere Creare file PDF.

File Encapsulated PostScript (EPS)
La maggior parte di editori e tipografi preferisce ricevere la musica in formato EPS o PDF per la 
pubblicazione; Sibelius consente di esportare la musica direttamente in un file EPS.

I file EPS non stampano sulle stampanti non-PostScript da gran parte dei programmi; stampando 
un file EPS con una stampante non-PostScript si può ottenere una pagina bianca, un messaggio 
d’avviso che indica l’impossibilità di stampare file EPS su una stampante non-PostScript o una 
stampa a bassa risoluzione dell’immagine TIFF in anteprima contenuta nel file EPS.

Si raccomanda d’inserire i font nei file EPS; l’utente è autorizzato da Sibelius a fornire i font Opus, 
Helsinki, Reprise e Inkpen2 al proprio editore o tipografo per stampare i file EPS, ma deve avere il 
permesso di distribuire i font appartenenti ad altri.

In Sibelius si possono creare file EPS con i font TrueType o Type 1; i font TrueType sono installati 
di default (non è possibile avere installati contemporaneamente i font TrueType e PostScript Type 
1) – vedere Installare i font musicali Type 1 in b Font musicali. Tuttavia, vi sono alcune 
limitazioni sui font che possono essere inseriti nei file EPS da Sibelius:

* I font Type 42 non sono supportati. Il formato del font Type 42 è una versione PostScript dello 
standard TrueType. Tutti gli interpreti PostScript Level 3 (come le stampanti) possono visualiz-
zare i font TrueType a condizione che siano impacchettati nel formato font PS Type 42.

* I profili del font TrueType sono rappresentati in modo diverso dai profili del font PS, quindi 
quando sono convertiti da TrueType a Type 3 (per inserirli nel file EPS), alcuni dati potrebbero 
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andare persi. Ci potrebbero essere lievi differenze nell’aspetto tra il font contenuto nel EPS e il 
font originale TrueType (sebbene quasi sempre tali differenze siano impercettibili).

* Possono essere inseriti solo i font con set di caratteri Latin.
* I font OpenType con profili PostScript possono essere inseriti; i font OpenType con i profili True-

Type non possono essere inseriti.
* I font Multiple Master possono essere inseriti, ma l’aspetto del font inserito non sarà esattamente 

uguale alle istanze multiple del master usato.
* I font Macintosh PostScript Type 1 (SFNT) e Macintosh PostScript Type 1 CID (SFNT/CID) non 

possono essere inseriti.

Alcuni programmi grafici su Mac (es. Corel Draw 8) possono generare errori quando si aprono i 
file EPS da Sibelius; se appare un messaggio d’errore provare a salvare di nuovo il file EPS da Sibel-
ius con l’opzione anteprima TIFF disattivata.

Importando i file EPS nella versione 9.0 o successive di Adobe Illustrator si raccomanda di disatti-
vare l’opzione Type > Smart Punctuation, poiché essa cambia alcuni caratteri del font, facendo 
scomparire alcuni simboli musicali.

Importando i file EPS in Adobe PageMaker, quando si stampa il documento contenente il file EPS 
può apparire un messaggio indicante che il file EPS non è stato trovato; se nel file EPS sono stati 
insertiti i font, non importa: il documento sarà stampato correttamente nonostante questo mes-
saggio d’avviso.

File TIFF
TIFF (Tagged Image File Format) è un formato bitmap molto diffuso e particolarmente adatto per 
la musica, perché si può comprimere efficacemente; se non si possono usare le grafiche EPS 
(poiché non si dispone di una stampante PostScript, ad esempio) si raccomanda di usare il formato 
TIFF.

Il formato TIFF usa molta memoria durante l’esportazione dei file; tuttavia è possibile esportare le 
pagine fino a 1200 dpi senza problemi; a meno che nei file TIFF non servano i colori, lasciare attiva 
l’opzione Monocromatico, in modo da ridurre al minimo la dimensione del file salvato.

File PNG
PNG (Portable Network Graphics) è un altro formato bitmap ampiamente supportato e con 
un’eccellente compressione. Il formato PNG non è così diffuso come quello TIFF nelle applicazioni 
editoriali, ma è quello ideale per collocare le immagini della propria musica in Internet.

File EMF (solo Windows)
Il formato EMF (Enhanced MetaFile) è piuttosto standard nei programmi Windows, ma general-
mente non è supportato da Mac.

I file EMF si possono importare in programmi come Microsoft Word (versione 97 o superiori) e 
sono modificabili – fino a un certo punto – in programmi di disegno vettoriale come Adobe Illus-
trator e Corel Draw.

Inviando un file EMF a chi non ha Sibelius installato sul proprio computer, occorre inviare anche i 
font musicali di Sibelius usati nella grafica, poiché essi non possono essere inseriti nei file EMF.
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File PICT (solo Mac)
PICT è un formato di grafica vettoriale simile a EMF e l’immagine risultante è modificabile in pro-
grammi di disegno come Adobe Illustrator; i file PICT possono anche essere importati in pro-
grammi come Microsoft Word.

Come il formato EMF (vedere sopra) anche il formato file PICT ha alcune limitazioni (ad esempio, 
imprecisioni nel posizionamento dei gambi sulle teste nota); i file PICT funzionano meglio se sal-
vati in scala (Scale) del 100% (valore di default in Sibelius), non in Actual size (si scalano poi 
nel programma che li riceve).

A causa dei problemi inerenti al formato PICT è decisamente meglio usare i file EPS invece di 
quelli PICT.

File BMP
Il formato BMP è simile a TIFF e PNG (sebbene meno diffuso). La risoluzione colore del file BMP 
salvato sarà la stessa di quella definita per lo schermo del computer, a meno che non si attivi l’opz-
ione Monocromatico nella finestra di dialogo File > Esporta > Grafiche che riduce molto la 
dimensione del file; in generale, si raccomanda di usare il formato PNG invece di quello BMP, per-
ché i file risultanti saranno sempre più piccoli (anche a colori).

Creare file PDF
I file PDF (Portable Document Format) consentono di pubblicare elettronicamente i documenti 
generati da programmi di testo (conservandone l’aspetto originale) per la visualizzazione e la 
stampa su ogni sistema.

Su Mac, non serve alcun software aggiuntivo; per salvare una partitura in PDF selezionare File >
Stampa e cliccare sul pulsante Registra come PDF.

In Windows, Sibelius supporta la creazione dei file PDF se nel computer è installato un software 
PDF adeguato; quello ufficiale è Adobe Acrobat, un prodotto commerciale disponibile sul sito 
www.adobe.com per Mac e Windows, ma sono disponibili anche altre alternative: PDFCreator, 
ad esempio, si può scaricare dal sito:

http://pdfcreator.sourceforge.net

I file PDF sono generati da software che s’installano e funzionano come stampanti. Creare un file in 
PDF quindi è semplice come stampare un file da Sibelius; basta scegliere la “stampante” PDF. Per 
maggiori informazioni consultare la documentazione fornita con il software di creazione dei file 
PDF.

Per vedere i file PDF si deve installare sul computer il software gratuito Adobe Reader (su Mac 
invece si può usare l’applicazione Anteprima interna); scaricare l’ultima versione di Adobe Reader 
dal sito:

http://www.acrobat.com
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8.12 Esportare i file MIDI

È possibile esportare una partitura in un file MIDI, in modo da trasferire facilmente la musica in 
tutti gli altri programmi musicali. Per esportare un file MIDI non è necessario disporre di un’inter-
faccia MIDI o altri dispositivi MIDI.

Esportare un file MIDI
* Selezionare File > Esporta > File MIDI: appare la finestra di 

dialogo indicata a destra.
* Si può scegliere se esportare il file MDI per il dispositivo di 

riproduzione corrente (I dispositivi di riproduzione 
attuali) o uno diverso (Un differente dispositivo di 
riproduzione). Di default, Sibelius esporta un file MIDI 
adatto alla riproduzione su un dispositivo General MIDI
ideale, ad esempio, per inviare un file MIDI a qualcuno che 
lo ascolti; tuttavia, se si usa uno strumento virtuale e si 
desidera esportare un file MIDI da aprire (ad esempio) in 
un sequencer come Pro Tools per continuare a lavorare 
sull’esecuzione MIDI, scegliere il sound set più opportuno dall’elenco Un differente disposi-
tivo di riproduzione. Sibelius esporta il file MIDI con tutti i rispettivi messaggi Control Change 
MIDI, keyswitch e così via.

* Si può scegliere anche se esportare un file MIDI Tipo 0 o Tipo 1. Quasi sempre serve un file 
MIDI Tipo 1; tuttavia, alcuni dispositivi (es. certi tipi di pianoforti e tastiere) possono ripro-
durre solo i file MIDI di tipo 0. Consultare la documentazione del dispositivo per sapere se uti-
lizza file di tipo 0 o 1 (nel dubbio scegliere Tipo 1).

* Risoluzione in Tick è un’opzione abbastanza misteriosa; il default di 256 PPQN (“Pulses Per 
Quarter Note”) corrisponde alla risoluzione interna di Sibelius ed è il valore raccomandato. 
Anche qui, tuttavia, alcuni dispositivi possono riprodurre solo i file MIDI con specifiche 
impostazioni PPQN; vedere la documentazione del dispositivo per sapere se occorre un valore 
specifico (nel dubbio, lasciarlo a 256). Scegliendo un valore PPQN superiore il file MIDI non 
diventa più “preciso” (poiché la risoluzione interna di Sibelius è fissata a 256).

* Una volta definite le giuste opzioni cliccare su OK e digitare il nome del file desiderato nel 
campo Nome file – per evitare confusione usare un nome diverso da quello del file originale di 
Sibelius! Individuare un destinazione adeguata sulla quale salvarlo e cliccare su Salva.

Quando esporta i file MIDI, Sibelius include tutte le opzioni di riproduzione (come Espressivo, 
Rubato e feel ritmico). Si può quindi usare Sibelius anche come ingegnoso “perfezionatore di file 
MIDI” – aprire un file MIDI, attivare alcune interessanti opzioni di riproduzione e salvare una ver-
sione migliorata del file MIDI in un attimo!

Conversione di massa (batch conversion)
Sibelius dispone di un plug-in che salva i file MIDI di tutte le partiture di Sibelius in una cartella – 
vedere Converti cartelle di spartiti in MIDI a pagina 390.
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Rubato
Se nella finestra di dialogo Play > Prestazioni... è attivo il Rubato e la partitura è salvata in un file 
MIDI, i cambi di tempo dovuti al Rubato sono inclusi nel file, quindi le note appaiono “fuori 
allineamento” quando si apre il file in un sequencer MIDI.

Questo perché il Rubato altera direttamente le posizioni d’inizio delle note piuttosto di creare 
cambi tempo; per salvare un file MIDI da usare in altri programmi facendo in modo che sia corret-
tamente quantizzato, impostare il Rubato in Meccanico prima di salvare il file MIDI.

Ripetizioni
Di default, i file MIDI salvati da Sibelius includono tutte le ripetizioni presenti nella partitura orig-
inale. Se, per qualsiasi motivo, si preferisce non includere le ripetizioni disattivare l’opzione Ripro-
duci ripetizioni nella finestra di dialogo Play > Prestazioni... prima di salvare il file MIDI.

Partiture con più di 15 righi
Solo per utenti esperti! 

Poiché Sibelius usa la stessa codifica per esportare i file MIDI e riprodurre le partiture, è in grado 
d’inserire effetti come Espressivo nei file MIDI; in partiture con più di 15 righi, però, entra in gioco 
una differenza sostanziale.

Un file standard MIDI può avere solo 16 canali (ma un numero molto superiore di tracce); teorica-
mente, quindi, possono essere riprodotti simultaneamente solo 16 suoni diversi. Sibelius consente 
a più di uno strumento la condivisione dello stesso canale MIDI grazie a un complesso sistema che 
inserisce opportuni messaggi Program Change prima delle note per farle suonare con il giusto 
suono.

Tuttavia, esportando i file MIDI ogni rigo corrisponde a una traccia MIDI diversa in un file MIDI 
di tipo 1; in altre parole, due righi che condividono lo stesso canale in Sibelius occupano due tracce 
diverse nel file MIDI, entrambe assegnate allo stesso canale. Ciò significa che, riproducendo un file 
MIDI contenente più di 15 righi, uno o più righi potrebbero suonare col suono sbagliato.

L’unico modo per evitarlo è inserire messaggi Program Change prima di ogni nota nella partitura; 
non è la soluzione migliore, poiché alcuni dispositivi MIDI (es. la serie JV della Roland) rispon-
dono molto lentamente ai messaggi Program Change e il file MIDI non sarebbe riprodotto in 
modo omogeneo. Inoltre, inserendo messaggi Program Change prima di ogni nota, il file MIDI 
diventa molto complesso da modificare in un sequencer; Sibelius quindi esporta semplicemente il 
file con i canali condvisi. Si può aprire il file MIDI in un sequencer e riassegnare alcuni dei canali 
condivisi all’uso di altri dispositivi di riproduzione (poiché attualmente è abbastanza normale che i 
dispositivi MIDI abbiano 32 canali invece dei 16 tradizionali).

Non esiste una soluzione ideale a questo problema – il MIDI non è stato progettato per riprodurre 
partiture su larga scala, quindi qualsiasi soluzione è una sorta di compromesso. Il metodo di Sibel-
ius, tuttavia, è quello più utile per gli utenti che hanno bisogno di modificare la loro musica in un 
sequencer e offre la riproduzione migliore (sempre entro i limiti imposti dal MIDI).
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8.13 Esportare i file audio

b Sibelius Sounds Essentials.

v Kontakt Player.

Sibelius può salvare un file audio digitale della partitura da masterizzare su CD o trasformare in un 
file MP3 per Internet. Per salvare i file audio da Sibelius si deve impiegare una configurazione di 
riproduzione che usi uno o più strumenti virtuali, come la libreria Sounds Essentials di Sibelius 
che utilizza Kontakt Player 2 (b Sibelius Sounds Essentials).

Esportare l’audio
Per creare un file audio digitale in formato WAV (Windows) o AIFF (Mac):

* Se per la riproduzione si usano strumenti virtuali insieme ad altri dispositivi MIDI, solo i righi 
riprodotti dagli strumenti virtuali possono essere esportati in audio; prima d’iniziare quindi ass-
icurarsi che la configurazione di riproduzione corrente usi solo strumenti virtuali 
(b Dispositivi di riproduzione).

* Selezionare File > Esporta > Audio o cliccare sul pulsante nella barra degli strumenti 
indicato a destra.

* Si apre una finestra di dialogo che permette di stabilire nome e destinazione del file 
audio da salvare; Sibelius indica la dimensione del file audio e lo spazio approssimativo occupato 
sul disco rigido.

* Una volta configurate le opzioni desiderate, cliccare su Salva per iniziare l’esportazione. Sibelius 
esporta il file audio off-line (durante l’esportazione la partitura non si sente); inviando i dati 
audio direttamente sul disco rigido. In base a complessità della partitura e velocità del computer, 
l’esportazione può essere più o meno veloce che in tempo reale. Il vantaggio è che, se la partitura 
è troppo complessa perché il computer sia in grado di riprodurla in tempo reale senza difetti o 
interruzioni, si può comunque esportare una traccia audio priva di difetti (serve solo più tempo 
per esportare la partitura di quello che servirebbe a riprodurla direttamente).

* Per fermare l’operazione in qualsiasi momento, cliccare su Annulla nella finestra di progresso 
che appare. Il file audio parziale è salvato sulla destinazione specificata; si può usare (ad esem-
pio) per registrare l’apertura di una partitura più grande.

Masterizzare i file audio su CD
Il CD-R/RW (o “masterizzatore CD”) del computer, in generale ha un software per la creazione di 
CD dati e audio; il processo esatto per masterizzare i file audio salvati da Sibelius su un CD audio 
varia in base al programma fornito con il masterizzatore CD (per i dettagli vedere il rispettivo 
manuale).

Creare file MP3
Il formato MP3 (o MPEG Audio Layer 3 per l’esattezza) è quello più diffuso per condividere musica 
in Internet o tramite posta elettronica, poiché è molto più piccolo di un file WAV o AIFF. Una volta 
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salvato un file audio da Sibelius è possibile convertirlo facilmente in un file MP3 con un software 
gratuito. Ad esempio:

* Mac: mAC3dec (http://sourceforge.net/projects/mac3dec/) converte dal formato AIFF a 
MP3 con una semplice interfaccia “drag and drop”.

* Windows: dbPowerAmp Music Converter (http://www.dbpoweramp.com/dmc.htm) con-
verte in molti formati audio diversi con un semplice clic-destro del mouse sul file in Esplora di 
Windows.

Molti altri programmi convertono a/da MP3, compreso l’editor audio Audacity (http://audac-
ity.sourceforge.net/) e QuickTime Pro (http://www.apple.com/quicktime/pro/).
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8.14 Esportare pagine web Scorch

b SibeliusEducation.com, SibeliusMusic.com.

v Pubblicazioni in Internet.

Internet è il mezzo ideale per raggiungere con la propria musica il pubblico di tutto il mondo. Gra-
zie al plug-in Scorch, Sibelius consente a chiunque di vedere, riprodurre, trasportare e salvare le 
partiture dal proprio sito Web personale (b SibeliusMusic.com).

Impostazioni raccomandate
b SibeliusMusic.com per le varie impostazioni da eseguire sulle partiture in modo che altre 
persone le possano vedere, suonare e stampare con qualsiasi computer e stampante.

Preparando le partiture da pubblicare sul proprio sito Web considerare se cambiare le dimensoni 
di pagina e rigo della partitura per garantirne la massima leggibilità possibile sullo schermo. 
Per partiture in formato verticale di piccole ensemble, impostare la dimensione pagina in modo 
che ogni pagina sia occupata da un solo sistema; i visitatori del sito Web non dovranno così scor-
rere in alto e in basso la pagina per vedere ogni sistema della musica. Ci sono modelli web (tem-
plate) che visualizzano un solo sistema alla volta – vedere Template di pagine web.

Esportazione
* Innanzitutto selezionare File > Info su partitura, cliccare sulla pagina Compositore/Titolo e 

inserire alcune informazioni sul brano (se non è stato fatto nella finestra di dialogo Nuova par-
titura alla creazione della partitura stessa) – la pagina web che si sta generando presume che 
siano stati completati i campi Titolo e Compositore in modo che possano essere inclusi nella 
pagina web.

* Selezionare File > Esporta > Pagina Web Scorch.

* Inserire un nome file; Sibelius rimuove tutti gli spazi dal nome file sia nei file (.sib) che HTML 
(.htm) e accorcia il nome a 27 caratteri più l’estensione di 3 caratteri per compatibilità con i 
server.

* Se nella finestra di dialogo File > Info su partitura non è stato inserito nulla, appare un messag-
gio d’avviso indicante (ad esempio) che i campi Titolo e Compositore sono vuoti.

* Sibelius chiede di scegliere un template di pagina web nel quale inserire la partitura – vedere 
Template di pagine web. Si può anche regolare larghezza e altezza della partitura per come 
apparirà nella pagina web; se non si hanno esigenze particolari scegliere il template web Classic
lasciando invariate le altre impostazioni e cliccare su OK.
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Impostando un valore Larghezza più grande, pagina e musica diventano più grandi; non è nec-
essario inserire un valore Altezza per avere la stessa forma della pagina (consigliabile).
L’opzione Mantieni le proporzioni (attiva di default) regola automaticamente la dimensione 
della partitura in modo che le linee del rigo appaiano sempre equidistanti; lasciarla attiva.
Consenti salvataggio e stampa: come indica il nome, consente di scegliere se i visitatori del 
sito web possono stampare e salvare la musica o solo riprodurla – vedere Stampa e salvatag-
gio da Scorch.

* Sibelius salva quindi due file sulla destinazione scelta: un file HTML (con estensione .htm) e 
una partitura di Sibelius (con estensione .sib).

A questo punto è possibile inserire i due file sul proprio sito web; in base all’host del sito potrebbe 
essere necessario usare un client FTP o caricarli con il browser web.

Il file vero e proprio della partitura di Sibelius e la pagina web devono trovarsi entrambi nella stessa 
cartella sul proprio sito web, senza rinominare il file di Sibelius – l’HTML nella pagina web fa rifer-
imento al file di Sibelius.

Conversione di massa (batch conversion)
Sibelius dispone di un plug-in che salva le pagine web Scorch di tutte le partiture in una cartella e 
genera una pagina di indice con i link alle singole partiture – vedere Converti cartelle di spar-
titi in pagine web a pagina 390.

Stampa e salvataggio da Scorch
Attivando l’opzione Consenti salvataggio e stampa quando si salva la partitura in una pagina 
web di Scorch, i visitatori del sito potranno stampare la partitura sulle stampanti dei propri com-
puter e salvare la partitura in un file di Sibelius sul disco rigido per aprirla in Sibelius.

Ciò facilita la condivisione della musica tra più persone: gli insegnanti possono inserire i propri 
questionari sul sito web della scuola e gli studenti stamparli direttamente dal loro browser web, 
oppure (se hanno Sibelius) scaricarli sul proprio computer e completarli in Sibelius.

L’opzione Consenti salvataggio e stampa non ha alcuni vantaggi offerti dalla pubblicazione 
della musica sul sito SibeliusMusic.com:

* Non è permesso commercializzare Scorch sul proprio sito web senza una speciale licenza con-
cessa da Sibelius – non è ammesso richiedere alcun compenso in denaro per consentire ai visita-
tori del proprio sito di stampare e salvare musica.

* La musica sul proprio sito web non è criptata! Qualsiasi visitatore che possiede Sibelius può 
scaricare musica sul proprio computer cliccando semplicemente su Save in Scorch, quindi mod-
ificarla in Sibelius.

Attenzione! Anche se non si consente la stampa e il salvataggio, le partiture sono comunque scari-
cabili dai visitatori in forma non criptata; ogni volta che si vede qualcosa sul proprio browser web – 
testi, un’immagine o una partitura di Sibelius che usa il plug-in Scorch – significa che questa è stata 
scaricata nella cartella dei file temporanei di Internet sul disco rigido del proprio computer. Chi-
unque veda la musica sul proprio sito web personale, quindi, è potenzialmente in grado di modifi-
care il file originale (se possiede Sibelius). In altre parole, pubblicando musica sul proprio sito web 
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personale, la sicurezza non è garantita; pubblicandola invece su SibeliusMusic.com la musica è 
protetta.

SibeliusMusic.com usa un formato file criptato decifrabile solo dal plug-in Scorch – anche se qual-
cuno individuasse il file sul proprio disco rigido non sarebbe in grado di aprirlo con alcun altro 
programma diverso da Scorch (nemmeno in Sibelius); ciò garantisce inoltre che se qualcuno vede 
un file di Sibelius criptato in Scorch non può stamparlo, perché la stampa di questi file si basa su 
una comunicazione tra Scorch e il server di SibeliusMusic.com.

Per pubblicare musica in sicurezza sul proprio sito web contattare Sibelius Software per la licenza 
di Sibelius Internet Edition (versione speciale di Sibelius per le pubblicazioni in Internet).

Informazioni sulla partitura
Sul proprio sito web è possibile includere informazioni di catalogo (compositore, titolo, ecc.). 
Digitare i dettagli nella finestra di dialogo File > Nuovo quando si crea la partitura, oppure in 
seguito nella finestra File > Info su partitura; quando poi si salva una pagina web, Sibelius include 
automaticamente queste informazioni in etichette HTML (oltre che collocare l’informazione prin-
cipale in un testo nella pagina web).

Prima si deve realizzare una pagina web template che visualizzi il tipo d’informazione catalogo da 
includere (vedere Personalizzare il proprio sito web).

Chi è abile nella programmazione può scrivere un programma che crei automaticamente da queste 
etichette un catalogo on-line (o un motore di ricerca) delle partiture sul proprio sito.

Template di pagine web
È disponibile una serie di template di pagina web in varie combinazioni di stili e colori. Alcuni 
template usano una delle funzioni più utili di Scorch che è split playback, studiata per consentire di 
suonare con Scorch senza preoccuparsi dei cambi pagina – è come avere una persona accanto che 
gira la pagina!

Quando in riproduzione Scorch arriva alla fine di un sistema, sostituisce automaticamente il 
sistema appena riprodotto con un sistema più in basso nella pagina; l’occhio segue naturalmente la 
musica nella pagina e quando arriva in fondo vedrà che alcuni sistemi successivi sono già visibili in 
cima alla finestra Scorch.

La funzione split playback funziona meglio su musica per strumenti solisti o piccole ensemble 
(come strumento solista e tastiera). Per provare questa funzione scegliere dai template 2 system 
split playback, 3 system split playback o 4 system split playback.

I template 1 system playback e 1 system view mantengono solo un sistema visibile (utile per 
consentire ai visitatori del proprio sito di seguire la musica senza dover scorrere in alto e in basso la 
finestra del proprio browser web). 1 system playback mostra una pagina intera quando Scorch 
non è in riproduzione, ma solo un sistema durante la riproduzione.

Se sono stati abilitati stampa e salvataggio da Scorch, le partiture sono salvate e stampate esatta-
mente come appaiono in Sibelius – in altre parole, la funzione split playback non ha effetto sulle 
partiture vere e proprie; è solo un modo diverso di vedere le partiture in Scorch.
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Personalizzare il proprio sito web
Se non si desidera utilizzare i template di pagina web forniti da Sibelius (o si desidera migliorarli) 
serve una conoscenza di base della programmazione HTML (o un amico che la conosca).

La pagina web generata da Sibelius è molto semplice e si può modificare a piacere – si possono 
aggiungere sfondi o grafiche personalizzati, altre informazioni, link o altro.

È possibile realizzare template di pagine web personalizzati e salvarli con estensione .htm nella 
cartella Scorch Templates all’interno della cartella con i dati d’applicazione (vedere File modifi-
cabili dall’utente a pagina 562); essi appariranno nell’elenco dei template delle pagine web.

Un template di pagina è un file HTML standard con alcune etichette speciali ove sono inseriti 
nome file e dimensione dell’immagine quando si salva una pagina web Scorch; ci sono anche 
etichette opzionali sostituite dai campi Titolo, Compositore ecc. della finestra di dialogo File >
Info su partitura. L’elenco completo delle etichette (non tutte usate nei template campione) è il 
seguente:

Per gli esempi d’uso di queste etichette vedere i template delle pagine web forniti da Sibelius.

Gli unici elementi richiesti sono le etichette annidate <object> e <embed> che devono essere di 
questo tipo:

<object id="ScorchPlugin" 
classid="clsid:A8F2B9BD-A6A0-486A-9744-18920D898429" 
width="x" 
height="y" 
codebase="http://www.sibelius.com/download/software/win/ActiveXPlugin.cab”>

<param name="src" value="filename.sib">
<embed src=”filename.sib” 

width=”x” 
height=”y” 
type=”application/x-sibelius-score” 
pluginspage=”http://www.sibelius.com/cgi/plugin.pl”>

</object> 

ove filename.sib è il percorso del file di Sibelius, x è la larghezza della finestra Scorch (in pixel) e y
l’altezza della finestra Scorch in (pixel); queste scritte possono essere inserite automaticamente 
quando si usa il comando File > Esporta > Pagina Web Scorch in Sibelius se nel template della 
propria pagina web s’impostano rispettivamente a $FILENAME$, $WIDTH$ e $HEIGHT$.

Non cambiare gli attributi classid, codebase, type o pluginspage; essi informano il browser 
riguardo a Scorch indicando dove trovarlo se non è ancora stato installato.

Problemi e soluzioni
Alcuni server web potrebbero non visualizzare le pagine web Scorch; in tal caso, il browser avvisa 
che non trova un plug-in adatto (perché il server non riconosce l’estensione file .sib di Sibelius).

$FILENAME$ nome file + estensione del file di Sibelius

$PATHNAME$ Percorso del file di Sibelius

$WIDTH$, $HEIGHT$ Dalla finestra di dialogo Export Scorch Web Page

$TITLE$, $COMPOSER$, 
$ARRANGER$, $LYRICIST$, 
$ARTIST$, $MOREINFO$

Dalle finestre di dialogo File > Nuovo e File > Info partitura
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Se ciò avviene sul proprio sito web contattare l’ISP o amministratore di sistema del server chieden-
dogli di aggiungere Sibelius MIME-type alla configurazione del server per risolvere il problema.

Usare posta elettronica e CD-ROM
Per inviare a qualcuno un file di Sibelius tramite posta elettronica da vedere in Scorch, 
b Condivisione file.

Per promuovere la propria musica su CD-ROM si possono usare altrettanto efficacemente le funzi-
oni di Sibelius per le pubblicazioni in Internet; è sufficiente salvare il proprio sito web su un CD – 
altri potranno accedervi dal CD esattamente come da Internet.

Si noti, tuttavia, che occorre comunque scaricare Scorch da Internet seguendo il link in ogni pag-
ina web Scorch su disco; non è consentito distribuire personalmente Scorch (vedere Avvertenze 
legali).

Avvertenze legali
È illegale pubblicare in Internet musica protetta da copyright senza il permesso dell’autore. Ciò 
vale anche nel caso del proprio arrangiamento di un brano musicale protetto da copyright.

Le funzioni di Sibelius per le pubblicazioni musicali su Internet sono concesse in licenza solo per 
un utilizzo non a scopo di lucro (per i dettagli vedere il contratto di licenza di Sibelius).

Non è consentito distribuire Scorch (collocandolo sul proprio sito web, ad esempio) – chi visita il 
proprio sito deve seguire il link fornito per scaricare Scorch; le condizioni di licenza d’uso del plug-
in appaiono durante la sua installazione.
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8.15 Esportare su versioni precedenti

Sibelius è completamente compatibile retroattivamente. Sibelius 5 può aprire file di tutte le ver-
sioni precedenti di Sibelius, inclusi i file salvati in Sibelius Student e G7.

Le versioni meno recenti non possono aprire i file salvati in questa versione, ma si può usare il 
comando File > Esporta > Sibelius 2, 3, 4 o Student per salvare i file apribili in Sibelius 2, Sibelius 
3, Sibelius 4 e Sibelius Student (anche il programma per chitarra G7 usa lo stesso formato di Sibel-
ius 3 e Sibelius Student.) Si noti, però, che queste prime versioni non hanno tutte le funzioni di 
Sibelius 5, quindi le partiture potrebbero non apparire esattamente come in Sibelius 5. In partico-
lare, gli elementi descritti in seguito sono omessi o modificati (cioè non esportati nel file).

Differenze in Sibelius 2, 3, 4, G7 e Sibelius Student
Esportando i file su tutte le versioni precedenti di Sibelius sono omessi o modificati:

* Numeri misura:
% Se i numeri misura sono impostati per apparire ogni n misure il valore n è trasformato in una 

delle opzioni esistenti nelle versioni precedenti, quindi i numeri misura possono apparire su 
misure diverse.

% I cambi di numero misura che hanno nuovi formati di numero misura sono trasformati in 
cambi di numero misura normali.

% I cambi di numero misura con un testo prima o dopo il numero sono trasformati in cambi di 
numero misura normali.

% I numeri misura nascosti automaticamente alle stesse posizioni dei segni di prova non sono 
nascosti.

% La numerazione misura non tiene conto delle ripetizioni.
% I numeri misura appaiono sui righi definiti in House Style > Posizioni oggetti accollatura, 

non su quelli definiti in House Style > Regole tipografia.
* I break di pagina speciali sono convertiti in break di pagina normali e tutti gli oggetti di testo, 

simboli o grafiche impostati per apparire sulle pagine vuote sono cancellati dalla partitura, insi-
eme agli stili di testo delle pagine vuote.

* I cambi di numero pagina sono omessi; se aperte in versioni precedenti, le pagine sono numerate 
dalla prima pagina.

* I cambi di margine sono omessi (inclusi quelli generati dall’opzione Dopo prima pagina in 
Layout > Imposta documento e da break di pagina speciali); tutte le pagine nella partitura 
useranno i margini definiti nella prima pagina della partitura.

* Direzioni dei gambi e posizioni pausa potrebbero cambiare se è attiva l’opzione Ignora oggetti 
nascosti per la direzione dei gambi e le pause (pagina Note e Tremolo della finestra di dia-
logo House Style > Regole tipografia).

* Gli oggetti “cue-sized” diversi da note appaiono alla loro dimensione “normale”.
* Le Idee salvate nella partitura sono omesse.
* Le pause multiple nelle parti potrebbero separarsi in modo diverso in Sibelius 4 e precedenti, 

poiché in Sibelius 5 i testi di sistema attaccati alla pagina non separano le pause multiple.
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* I cambi strumento sono convertiti in opportuni cambi di tipo rigo e trasporto. Si noti, però, che il 
suono in riproduzione non cambia in corrispondenza del cambio strumento quando la partitura 
è riprodotta in versioni precedenti di Sibelius.

* Tutte le definizioni di nuovi strumenti, i tipi di rigo e i dati d’ensemble sono omessi 
(b Modifica strumenti).

Differenze in Sibelius 2, 3, G7 e Student
Gli elementi che seguono restano in Sibelius 4 ma sono omessi o cambiati in versioni precedenti:

* Parti dinamiche: tutte le parti esistenti nella partitura sono omesse (b Lavorare con le parti) 
sebbene sia possibile estrarle in Sibelius 5 e poi esportarle (come per la partitura).

* Opzioni Auto Layout: tutte le opzioni Auto Layout sono omesse (break di sistema automatici, 
separazione di pause multiple e pause multiple silenti, impostazioni avanzate dei break pagina).

* Posizioni Optical del tratto d’unione: i tratti d’unione cambiano leggermente posizione se aperti 
in versioni precedenti (b Tratti d’unione).

* Legature di valore Optical: le legature di valore cambiano leggermente posizione se aperte in ver-
sioni precedenti (b Legature di valore).

* Giustificazione: la giustificazione orizzontale e verticale di note e sistemi può cambiare se aperta 
in versioni precedenti (b Spaziatura rigo).

* Gli stili di testo con le dimensioni impostate a Keep absolute non sono scalate correttamente 
sui righi piccoli (b Modifica stili di testo).

Altre differenze in Sibelius 2
Gli elementi che seguono restano in Sibelius 4, Sibelius 3, G7 e Sibelius Student ma sono omesse o 
cambiate in Sibelius 2:

* Spaziatura nota: le opzioni di spaziatura più nuove (es. spazio minimo attorno a note, flag, ecc.) 
sono omesse; la spaziatura nota potrebbe regolarsi leggermente quando il file è aperto (special-
mente quando le distanze sono particolarmente ridotte o ampie) ma il layout complessivo 
(numero di misure per sistema e pagina) non cambia.

* Playback: tutti i dati Live Playback sono omessi (b Live Playback): opzioni Play on pass
(b Ripetizioni), termini in Play > Dictionary che usano ripetizioni o espressioni regolari, 
vuoti tra i movimenti nella stessa partitura (b Esecuzione), impostazioni di Kontakt Player 
nel Mixer (b Sibelius Sounds Essentials).

* Layout: la condizione Focus on Staves è omessa (b Evidenzia righi Selezionati).
* Regole tipografia: l’opzione Consenti tratti dopo pause è omessa (b Tratti d’unione), Cen-

ter staccatos on stem è convertita a Centra a metà agli staccati sul gambo
(b Articolazioni).

* Gli oggetti colorati (incluso il colore delle evidenziazioni) non appaiono colorati aprendo la parti-
tura in Sibelius 2, ma sono conservati e riappaiono a colori aprendo il file in Sibelius 3 o 4 (sem-
pre che non siano stati salvati di nuovo in Sibelius 2).

Utenti di Sibelius 1.4
Per condividere file con utenti di Sibelius 1.4 essi devono aggiornarsi alla versione corrente (non è 
possibile esportare un file di Sibelius 4 nel formato per la versione 1.4).
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8.16 File in tablatura ASCII

b Inserire una tablatura per chitarra, Notazione e tablatura per chitarra.

La tablatura ASCII è un formato diffuso per la condivisione delle tablature di chitarra in Internet. È 
possibile scaricare centinaia di migliaia di brani in formato di tablatura ASCII e Sibelius consente 
di aprire e salvare questi file per condividere i propri brani in Internet e via e-mail.

Come appare un file in tablatura ASCII?
Poiché i file in tabaltura ASCII sono scritti da centinaia di persone diverse (e di solito a mano) le 
informazioni che possono contenere variano tra i diversi file; alcuni file mostrano solo gli accordi 
di un determinato brano, mentre altri cercano di indicare tutte le tecniche usate nel brano origi-
nale, inclusi slide, bending, hammer-on e pull-off, armonici e così via. In ogni caso, tutti i file in 
tablatura ASCII utilizzano la stessa sintassi di base: i trattini rappresentano ogni corda del rigo, i 
numeri indicano i tasti e le barre verticali rappresentano le stanghette; ad esempio, la singola mis-
ura di una tablatura ASCII può apparire così:

                          P 
e |--0----------0---x-0-------| 
B |--0--2/3-----1---x-1--3-2--| 
G |--0-----1/2--2---x-2-------| 
D |--2----------0-------------| 
A |--2----------0-------------| 
E |--0------------------------| 

Importare i file di tablatura ASCII
I nomi file delle tablature ASCII normalmente terminano con l’estensione file .tab (sebbene pos-
sano avere la normale estensione file di testo .txt – in tal caso, occorre cambiare l’estensione del file 
in .tab in modo che Sibelius lo possa aprire – oppure possono essere destinati al basso (in tal caso 
avranno l’estensione file .btab).

Per aprire un file di tablatura in Sibelius selezionare File > Apri (Ctrl+O o XO), scegliere il file di 
tablatura da aprire e cliccare su Apri; si apre una finestra di dialogo con alcune opzioni:

* Importa sempre ritmiche: Sibelius cerca sempre di determinare il ritmo nel file di tablatura, 
anche se non è sicuro che siano indicati dei ritmi veri e propri.

* Importa ritmiche solo se specificate: Sibelius cerca di determinare il ritmo se ritiene che i 
ritmi siano in qualche modo indicati.

* Non importare mai le ritmiche: Sibelius ignora il ritmo del file di tablatura e importa ogni 
nota o accordo come una nota da 1/8 (sia che ritenga o meno che i ritmi siano indicati nel file).

Di default, Sibelius attiva l’opzione Importa ritmiche solo se specificate. Nel dubbio, usare 
questa opzione.

Sibelius cerca anche d’individuare nel file di tablatura simboli accordo ed etichette di testo (che 
indichino, ad esempio, dove iniziano strofe e ritornelli) ma non importa le parole (poiché general-
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mente non è chiaro dove debbano andare) o tecniche come bending, slide, hammer-on, pull-off e 
così via (poiché non esiste una convenzione su come debbano essere scritte nei file di tablatura 
ASCII).

Quando s’importa un file di tablatura ASCII, normalmente si ottiene una partitura che contiene 
tutte le giuste note e accordi, ma non i giusti ritmi. Questo perché la maggior parte dei file di tabla-
tura non ha i ritmi e, anche se presenti, non sono indicati in modo chiaro; i file di tablatura ASCII, 
quindi, sono molto utili per conoscere la progressione delle posizioni degli accordi sulle dita, ma 
suonandoli spesso non si riesce a riconoscere il brano originale!

I file di tablatura ASCII sono utili per imparare a suonare un determinato brano – qualcun altro ha 
trovato gli accordi e le diteggiature e ora è possibile sedere davanti a Sibelius con la chitarra e sen-
tire come suona ogni accordo.

Spesso i file di tablatura ASCII hanno in cima parecchio testo superfluo (es. commenti su chi ha 
realizzato la trascrizione); in generale, Sibelius ignora questi testi, tuttavia in caso di problemi, 
provare a rimuovere il testo supplementare in cima al file usando un programma di editing testuale 
(es. Notepad in Windows o TextEdit in Mac) e importare di nuovo il file.

Esportare i file in tablatura ASCII
Si può usare Sibelius anche per creare file in tablatura ASCII per i propri brani. Per farlo, selezion-
are File > Esporta > ASCII Tav, inserire un nome file e cliccare su Salva.

Sibelius apre immediatamente il file di tablatura in un editor testuale in modo da visualizzarlo; se 
ciò crea confusione, disattivare l’opzione Anteprima del file ASCII tab dopo l’esportazione
nella pagina File della finestra di dialogo File > Preferenze (menu Sibelius in Mac).

I file in tablatura ASCII salvati da Sibelius comprendono i ritmi indicati da lettere sopra ogni nota 
o accordo (ad esempio, E per una nota da 1/8, S per una da 1/16, ecc.), strutture ripetute (come 
stanghette d’inizio e fine ripetizione, linee di 1° e 2° finale, ecc.), simboli accordo e così via.

Se la partitura contiene un misto di righi di tablatura e notazione, vengono salvati solo i righi di 
tablatura (e se, ad esempio, nella partitura sono presenti due righi di tablatura, questi vengono sal-
vati entrambi).

Musica protetta da copyright
Scaricando o pubblicando file in tablatura ASCII della musica di altre persone senza permesso si 
violano le leggi sul diritto d’autore (copyright); ciò è illegale e proibito in ogni caso dal contratto di 
licenza di Sibelius.

La maggior parte della musica indica copyright e rispettivo autore; se non si è sicuri del copyright 
di un file in tablatura ASCII scaricato si è pregati di contattare l’editore, il compositore o l’arrangia-
tore.
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Glossario
Questo capitolo descrive i termini musicali e del computer poco comuni, tecnici o dal significato 
speciale in Sibelius usati in questo Manuale Operativo; i riferimenti incrociati sono 
in grassetto.

Abbellimento: piccola nota che non è sottratta alla durata della misura (a differenza di una cue 
note) – nell’esecuzione è “schiacciata” nella nota precedente o successiva. Gli abbellimenti con 
una linea diagonale sul gambo sono chiamate acciaccature; quelle senza linee appoggiature.

acciaccatura: breve abbellimento normalmente suonato prima del movimento e scritto con una 
linea che attraversa il gambo della nota.

Accordo: in questo Manuale operativo, accordo significa specificamente due o più teste nota su 
un singolo gambo (o nel caso di doppie note intere (brevi) e note intere (semibrevi) nella stessa 
voce). Le teste nota in voci o righi diversi sono considerate in accordi diversi.

Accordo - Simbolo: testo sopra un rigo che indica un accordo da suonare o sul quale improv-
visare (per esempio, Bbm cioè Si bemolle minore).

aftertouch: parametro MIDI che indica il grado di pressione esercitato premendo un tasto sulla 
tastiera MIDI; normalmente si usa per controllare la modulazione (vibrato).

alterazione: simbolo (es. bemolle, diesis) il quale indica che una nota deve essere alzata o 
abbassata di un piccolo intervallo – in generale mezzo step (semitono) e talvolta di uno step intero 
(tono) o un microtono.

Appoggiatura: lungo abbellimento normalmente suonato sul movimento; a differenza di 
un’acciaccatura è scritto senza una linea che attraversa il gambo della nota.

Articolazione: simbolo che appare sopra o sotto una nota o accordo; indica come deve essere 
suonata/o – es. staccato, tenuto, archetto in su, accento, fermata (pausa).

Audio Unit (o AU): nome di un formato per strumenti ed effetti virtuali inventato da Apple. I 
plug-in Audio Unit sono compatibili solo con i computer Mac.

Banco: set di un massimo di 128 numeri programma; i dispositivi MIDI con più di 128 suoni, 
raggruppano tali suoni in banchi.

BMP - File: formato grafico bitmap standard di Windows.

Break - Interruzione: vedere break di pagina, break di sistema.

Campionamento: registrazione digitale di un suono (solitamente un breve frammento come un 
loop di batteria o singola nota).

Canale: equivalente MIDI di un rigo (in generale specificato con un numero da 1 a 16). La mag-
gior parte dei dispositivi MIDI ha solo 16 canali; ogni canale può essere impostato solo a uno 
specifico numero programma, posizione pan, ecc. alla volta.
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Clipboard (Appunti): luogo (invisibile) ove la musica tagliata o copiata è collocata temporanea-
mente prima di essere incollata su un’altra destinazione nella partitura.

Coda: l’uncino curvo di una nota da 1/8 o più breve senza tratto d’unione (talvolta impropria-
mente chiamata gambo).

Codec: acronimo che significa compressore/decompressore o codificatore/decodificatore; è un soft-
ware che trasforma i dati video o audio in formati non compressi e compressi.

Configurazione (di riproduzione): raccolta d’impostazioni dei dispositivi di riproduzione a dis-
posizione di Sibelius che definiscono come saranno usati per la riproduzione.

Control Change: messaggio MIDI che controlla effetti come riverbero, posizione pan e sus-
tain.

Controller: dispositivo MIDI d’ingresso (tastiera, pedale sustain, rotellina di modulazione o 
pitch bend, ecc.).

Conversione: processo che cambia il formato di un file. 

Crop mark (“segno di taglio”): piccole croci usate nella stampa litografica per segnare gli angoli 
di una pagina che appaiono su grandi fogli di carta; la carta è poi tagliata lungo le linee indicate dai 
segni di taglio.

Cue note - Note guida: piccola nota guida (cue-size) così chiamata perché usata soprattutto per 
scrivere passaggi introduttivi in parti strumentali; a differenza degli abbellimenti le note cue-
size hanno una durata reale – cioè occupano spazio ritmico nella misura. Qualsiasi nota, pausa o 
misura di pausa può essere rimpicciolita, sia che si tratti di una nota normale, una testa nota 
speciale o un abbellimento; è possibile scrivere note cue-size anche su un rigo piccolo (cosa che le 
rimpicciolisce ulteriormente).

Cursore: linea verticale che indica dove ci si trova quando si creano le note o si digita un testo; 
talvolta chamato cursore o punto d’inserzione.

Cursore della timeline: cursore nella finestra Playback che consente di spostare la linea di 
riproduzione (e video) su una posizione qualsiasi nella partitura.

Default: valore al quale ogni opzione è impostata provvisoriamente fino a quando non la si cam-
bia. Sibelius ha valori di default “intelligenti”, quindi non capita spesso di dover cambiare le oper-
azioni che esegue automaticamente.

Dialogo - Finestra di (o box di dialogo): finestra che richiede informazioni e/o presenta varie 
opzioni e parametri con pulsanti (OK o Annulla) da premere al termine delle modifiche eseguite.

Diatonica: scala diatonica maggiore o minore; trasportare diatonicamente significa alzare o 
abbassare le note sulla scala; nella scala di DO maggiore trasportando una triade di SOL maggiore 
in alto di una 2a diatonica si ottiene un LA minore; in alto di una 3a diatonica si ha una triade di SI 
diminuito.

Dimensione punto: altezza di un font, misurata dalla cima delle lettere maiuscole alla base delle 
lettere minuscole discendenti (come la p); è specificata in punti (1 punto o pt = 1/72 pollici = circa 
0,353 mm).
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Dimensione rigo: altezza di un rigo a cinque linee misurata tra la metà delle linee in alto e in 
basso; in una partitura la dimensione di ogni oggetto – note, linee, la maggior parte di testi e tutti 
gli altri oggetti – è proporzionale alla dimensione del rigo. La dimensione del rigo per definizione 
equivale a 4 spazi.

Dinamiche: testi (es. mf) o forcine che specificano il volume o le variazioni di volume.

Dpi (punti per pollice): unità per la risoluzione di stampa e scansione; maggiore è il valore in
dpi di stampa o scansione, più alta è la risoluzione e più dettagliato il risultato ottenuto.

Nella stampa, 1200 dpi o superiori offrono una qualità professionale, nella quale i punti sono invis-
ibili. 600 dpi (risoluzione standard nella maggior parte delle stampanti laser) offre una qualità 
simile quindi spesso è sufficiente per una buona stampa musicale.

Per sottoporre a scansione la musica, un valore da 200 a 400 dpi è un intervallo normale di risoluz-
ione. Risoluzioni superiori (es. 600 dpi) sono usati per sottoporre a scansione foto e grafiche a 
qualità elevata.

Effetto: software che elabora un segnale modificando una o più caratteristiche del suono (ad 
esempio, per generare un riverbero).

Elemento: parte di un Sound ID tra due punti (.); ad esempio, gli elementi del sound ID 
strings.violin.ensemble sono: “strings”, “violin” ed “ensemble”.

EMF (Enhanced MetaFile): formato grafico vettoriale standard di Windows.

Engraving rules - Regole tipografia: regole usate per la scrittura musicale. Sibelius imp-
iega tutte le regole standard di scrittura che si possono scegliere grazie alle numerose opzioni pre-
senti nella finestra di dialogo House Style > Regole tipografia e in altre finestre.

Ensemble: set di strumenti raggruppati in una o più famiglie; ogni famiglia contiene a sua volta 
uno o più strumenti. La finestra Crea > Strumenti e righi presenta molte ensemble.

EPS (Encapsulated PostScript): formato file standard di grafiche vettoriali molto simile al for-
mato file PostScript; a differenza di un file PostScript, un file EPS si usa per collocare una singola 
pagina di testi o grafiche come immagine in programma di layout pagina (come Quark XPress); i 
file EPS sono usati principalmente per le edizioni professionali.

Esplodi: distribuisce le note di un accordo o passaggio d’accordi da uno o due righi a un numero 
superiore di righi (è l’opposto di Reduce).

Esporta: salva in un formato file usato da un altro programma (è l’opposto di Import).

Estrai: crea un file separato di un parte.

Fader: manopola scorrevole usata nei dispositivi audio come i mixer che controlla (ad esempio) il 
volume di un determinato canale audio; la finestra Mixer di Sibelius ha fader per il controllo di 
volume e pan dei singoli righi.

Famiglia: strumenti dello stesso tipo che appaiono insieme in una partitura (es. legni, ottoni, per-
cussioni e archi); è denominata anche “sezione” strumentale.

Filtro: funzione di Sibelius che seleziona oggetti di un certo tipo (es. forcine, testi) dalle caratteris-
tiche particolari (es. accordi a tre note).
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Flag: piccolo frammento di tratto d’unione che appare sulle note puntate (denominato anche 
tratto d’unione parziale).

Flexi-time™: funzione d’inserimento in tempo reale intelligente di Sibelius. b Inserimento 
step-time, Inserimento alfabetico, Inserimento con il mouse.

Foglio manoscritto: ogni volta che si crea una partitura essa è scritta su un tipo particolare di 
“foglio manoscritto” che si sceglie all’inizio; il foglio manoscritto specifica gli strumenti e altre opz-
ioni, come le impostazioni dello stile house.

Font di testo musicale: font speciale (come Opus Text) contenente simboli musicali espressi 
sotto forma di testo (per esempio, mf o q = 60.

Font Roman (o “Roman font”): qualsiasi font serif medio non in corsivo.

Font sans serif (o “sanserif ”): Si pronuncia san-serrif, ma senza accento Francese; un font senza 
serif, in generale è considerato adatto per brevi frammenti di testo (come i titoli).

Forcina: crescendo o diminuendo scritto con una forcina dalla doppia linea.

Formattazione: distribuzione della musica su sistemi e pagine. Sibelius riformatta istantanea-
mente l’intera partitura ogni volta che si esegue una modifica, per vederla sempre come sarà stam-
pata.

Gambo: linea verticale, talvolta chiamata impropriamente “coda” su note e accordi. b tail.

General MIDI (GM): nome del formato più diffuso dei sound set.

Giustificazione: espansione di una pagina in orizzontale e verticale fino ai margini; per esempio, 
in questo Manuale operativo il testo è giustificato orizzontalmente, in modo da toccare il mar-
gine destro; le misure di musica sono quaasi sempre giustificate in orizzontale allo stesso modo. 
I righi sono spesso giustificati in verticale, per arrivare fino al margine inferiore della pagina senza 
lasciare uno spazio vuoto in basso.

Graffa: segno { a sinistra di strumenti a tastiera e altri strumenti che utilizzano un rigo esteso 
(usato anche al posto di sottoquadre in vecchie partiture orchestrali per raggruppare i Corni).

Gruppo: elenco di strumenti nei quali Sibelius copia linee di note simili come parte della pro-
pria funzione Arrange.

Gruppo irregolare - V. Tuplet

Hit point: evento in un film (es. un colpo di pistola) da sincronizzare con un evento musicale 
nella partitura (es. un accordo forte o il punto cruciale di una frase); nella partitura gli hit point 
sono indicati da scritte in un box speciale.

House - Stile: “aspetto” complessivo di una partitura definito da un editore; in Sibelius, lo stile 
house è in gran parte determinato dalle opzioni nel menu House Style che includono regole di 
scrittura, stili di testo, tipi di linea e testa nota, ecc..

imagesetter: stampante ad alta risoluzione (di solito 2540 dpi o più) usata per matrici di stampa 
litografica. Le stampanti Imagesetters usano la scrittura PostScript, generalmente sono della 
Linotronic e possono generare pagine molto grandi.
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importa: per aprire o inglobare un file nel formato usato da programma diverso (è l’opposto di 
Esporta).

Inserimento alfabetico: metodo di scrittura musicale via tastiera del computer usando princi-
palmente le lettere A–G e il pad numerico; vedere Inserimento step-time, Inserimento con 
il mouse, Flexi-time™.

Inserimento con il mouse: metodo d’inserimento della musica con il mouse; in generale è il 
metodo più lento. b Inserimento alfabetico, Inserimento step-time, Flexi-time™.

Inserimento in tempo-reale: inserimento della musica da una tastiera MIDI a tempo con un 
clic per specificare ritmi e altezze. Flexi-time™ è il metodo in tempo reale usato da Sibelius.

Inserimento step-time: inserimento di note e accordi specificando le altezze su una tastiera 
MIDI e valori nota ecc. sul tastierino numerico. b Flexi-time™, inserimento alfabetico, 
inserimento con il mouse.

Interlinea: distanza tra linee successive di un testo; un’interlinea standard nei libri di testo è 
120% (la separazione tra le linee di testo è 1.2 volte la dimensione punto; in musica, spesso è 
preferibile un valore del 100% ).

Interruzione di pagina: termine forzato di una pagina a una particolare stanghetta, spesso ese-
guito alla fine di una sezione o per evitare scomodi cambi pagina nelle parti. b break di 
sistema.

Interruzione (Break) di sistema: terminazione di un sistema a una stanghetta particolare, 
spesso alla fine di una sezione musicale. b break di pagina.

Intestazione: testo che appare in cima a ogni pagina di un documento quando è stampato; 
spesso è chiamato “intestazione mobile” (vedere anche piè di pagina).

Jolly: codice usato in un oggetto di testo che inserisce un frammento speciale di testo prelevato da 
qualche altra parte (es. data, nome strumento, numero pagina).

Tastierino numerico: finestra dalla quale prelevare note, articolazioni, alterazioni, ecc. usando 
il mouse o i tasti numerici; cliccando sui cinque piccoli pulsanti in alto sotto i numeri (o digitando 
+ sul pad numerico, oppure F8–F12) è possibile scegliere fino a cinque diversi layout del tastierino 
numerico, denominati primo layout del tastierino numerico, secondo layout del tastierino numerico, 
ecc.

Keyswitch: tecnica usata da molti strumenti virtuali con la quale una nota molto grave che 
non genera suono indica invece allo strumento virtuale di usare un suono diverso per le note suc-
cessive suonate nella normale estensione dello strumento.

Kontakt Player 2: riproduttore campioni interno di Sibelius che consente la riproduzione di 
suoni strumentali a qualità elevata e generare file da masterizzare su CD.

Latenza: ritardo tra l’invio di un messaggio da Sibelius a un dispositivo sonoro per attivare una 
nota e il suono della stessa; in generale la latenza è maggiore (più ritardo) con i dispositivi software 
come Kontakt Player 2, rispetto a quelli hardware (come i moduli sonori).
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Layer - Livello: termine usato da alcuni programmi di notazione per indicare una voce; può 
indicare anche suoni diversi nello stesso programma in uno strumento virtuale ai quali si 
accede grazie a keyswitch e messaggi Control Change.

Lettura (scansione): rileva quali sono le note e gli altri oggetti della scansione.

Linea: forcina, legatura, 8va, glissando o qualsiasi altro oggetto nella finestra Crea > Linea. 

Linea di note: sequenza di note singole e pause prelevate dal passaggio sorgente come parte del 
processo della funzione Arrange (per esempio, una serie di accordi a tre note è trasformata in tre 
linee di note separate).

Linea di parola: linea orizzontale che segue ogni parola la cui sillaba finale è cantata su più di 
una nota.

Linea di riproduzione: linea verticale verde che indica dove nella partitura Sibelius è in 
riproduzione o la inizierà; questa linea è usata anche registrando in Flexi-time (è rossa).

Live Playback: particolare tipo di riproduzione che cattura ogni sfumatura dell’esecuzione origi-
nale, fino a velocity e temporizzazione di ogni nota.

Magnetico: indica il comportamento “intelligente” di legature di portamento, gruppi irregolari, 
alterazioni, articolazioni, legature di valore, slide, bending, ecc., che diventano adesivi alle note e si 
riposizionano se le note cambiano altezza.

Menu rapido: termine confuso con il menu che si apre con un clic-destro (Windows) o Control-
clic (Mac); non ha nulla a che fare con i comandi rapidi della tastiera del computer. Talvolta chiam-
ato “menu sensibile al contesto” perché il contenuto del menu dipende dall’elemento sul quale si 
clicca con il mouse.

Messaggi MIDI: comandi trasmessi ai dispositivi MIDI usati per ottenere particolari effetti di 
riproduzione come cambi di numero program e pitch bend; Sibelius li genera automatica-
mente durante la riproduzione e si può anche inserirne di espliciti sulla propria partitura usando 
oggetti di testo abbastanza misteriosi.

Microtono: frazione di mezzo step (semitono) usato nella musica d’avanguardia ed etnica. 
Il microtono più diffuso è il quarto di tono (metà di un semitono); i microtoni sono indicati da 
un’ampia gamma di strane alterazioni, generalmente costituite da diesis, bemolle e bequadri 
ridotti o con frammenti extra. Per generare i microtoni, alcuni strumenti devono essere ridotti o 
avere frammenti extra.

MIDI: acronimo di Musical Instrument Digital Interface – standard mondiale di comunicazione 
tra strumenti musicali elettronici e schede audio dei computer. b File MIDI (sotto).

MIDI File: file nel formato Standard MIDI File, riconosciuto praticamente da tutti i programmi 
musicali; i file MIDI sono destinati specificamente alla riproduzione (non sono ideali per il trasfer-
imento della notazione musicale tra i programmi).

Misura (o battuta): segmento di tempo definito da un certo numero di movimenti (battuta) di 
una determinata durata

Misura-H: linea orizzontale usata normalmente per la pause multiple.

Mixer: finestra di Sibelius che consente di regolare volume, posizione pan e silenziare i righi.
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Musicisti: diversi esecutori che condividono gli stessi righi ma di solito sono distinti da un 
numero (i Corni in genere condividono uno o più righi e spesso sono numerati 1, 2, 3 e 4).

MusicXML: formato file per il trasferimento della notazione musicale tra diversi programmi; è il 
metodo raccomandato per spostare la musica da Finale 2004 o successivi a Sibelius.

Navigatore: veduta in miniatura della partitura nell’angolo in basso a sinistra; trascinando con il 
mouse il rettangolo bianco ci si sposta lungo la partitura.

Nota: singola testa nota con un gambo, a meno che si tratti di una nota intera (semibreve) o 
intera doppia (breve). Le note possono avere alterazioni, articolazioni, punti ritmici, tratti 
d’unione, linee aggiuntive e tremolo (le singole altezze su un accordo sono opportunamente chia-
mate teste nota, non “note”).

Note d’attaccatura: si chiamano così note, linee di testo, simboli, ecc. che nella musica sono 
“attaccati” a righi e posizioni ritmiche particolari. Appartengono a quel rigo/posizione e si muo-
vono con esso riformattando la musica; quando si selezionano più oggetti, una freccia tratteggiata 
grigia mostra a cosa è attaccato l’oggetto.

Note guida - V. Cue Note

NoteOn / NoteOff: messaggi MIDI che avviano o fermano una nota.

Numero programma (o numero patch, o numero voce): numero che specifica il suono di uno 
strumento su un dispositivo MIDI. I numeri programma vanno da 0 a 127 o da 1 a 128; se ci sono 
più di 128 numeri programma, essi sono ragguppati in banchi extra.

OCR (scansione): riconoscimento ottico del carattere; in generale applicato per sottoporre a scan-
sione il testo, ma anche la musica.

Oggetti del rigo: oggetti attaccati (e riferiti) a un rigo particolare; sono inclusi note, accordi, 
pause, cambi di chiave e la maggior parte di stili di testo e simboli. b oggetti di sistema.

Oggetti di sistema: oggetti applicati a tutti gli strumenti invece che a un solo rigo; si tratta di 
tempi in chiave, tonalità, testi tempo e titolo, segni di prova e alcune linee e simboli. Gran parte 
degli oggetti di sistema è scritta appena sopra il sistema e talvolta anche nel mezzo. Gli oggetti di 
sistema non sono attaccati a un rigo particolare e appaiono in tutte le parti. b staff objects.

Oggetto: qualsiasi cosa si può mettere in una partitura – note, alterazioni, chiavi, testi, legature, 
ecc.. b oggetti del rigo, oggetti di sistema.

Optical™: funzione per varie regole di scrittura speciali peculiari di Sibelius che offrono una 
scrittura di elevata qualità (posizionamento di note, legature di valore e tratti d’unione).

Originale (scansione): pagina o partitura da sottoporre a scansione.

Ossia: piccola misura o simile di musica sopra un rigo di dimensioni normali che indica un modo 
alternativo di suonare qualcosa.

Pagina (a): facciata di un foglio musicale pronto per la pubblicazione; la dimensione della pagina 
non è necessariamente uguale a quella della carta, poiché si può stampare una pagina piccola su un 
grande foglio di carta.
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(b) un set completo di opzioni in una finestra di dialogo (es. House Style > Regole tipografia) 
accessibile cliccando su una pagina o un elemento in un elenco.

Parte: musica di uno o più strumenti estratta da una partitura completa, talvolta chiamata parte 
strumentale, orchestrale o bandistica. I musicisti leggono le proprie parti guardando solo la musica 
che suonano. Una parte dinamica è una parte salvata nello stesso file della partitura completa ed è 
aggiornata automaticamente ogni volta che si modifica la partitura. Una parte estratta è una parte 
in un file distinto dalla partitura e non è aggiornata automaticamente.

Parte dinamica: vedere parte.

Partitura: qualsiasi documento di notazione musicale; talvolta usato impropriamente per indi-
care una partitura completa. Vedere Partitura completa, parte, partitura trasportata.

Partitura completa: partitura nella quale ogni strumento suona un pezzo di musica (al contra-
tio di una parte).

Partitura trasportata: partitura nella quale la musica di strumenti trasportati non è 
scritta all’altezza alla quale suona; una partitura non trasportata è detta in DO, oppure scritta 
all’altezza suonata o altezza da concerto.

Passaggio: fraseggio musicale continuo lungo un rigo o più righi nello stesso momento, i quali 
possono essere o meno adiacenti in verticale (es. Flauto e Cello in una partitura orchestrale). Nella 
sua forma più semplice si può pensarlo come “rettangolo” di musica. Un passaggio si può estendere 
su più sistemi (perfino sull’intera partitura). In generale i passaggi sono racchiusi in un box di col-
ore blu chiaro; c’è anche un tipo di passaggio speciale denominato passaggio di sistema che 
contiene tutti gli strumenti ed è indicato da un doppio box color porpora.

Passaggio di sistema: passaggio selezionato che riguarda tutti i righi di una partitura, circon-
dato da un doppio box color porpora. Le differenze principali tra un passaggio di sistema e uno 
normale sono: copiando un passaggio di sistema lo si inserisce nella partitura invece di sostituire la 
musica esistente; copiando un passaggio di sistema si copiano gli oggetti di sistema e gli 
oggetti del rigo; cancellando un passaggio di sistema si eliminano le misure vere e proprie, 
invece che trasformarle in misure di pausa.

Pausa multipla: segno che indica più misure di pausa usato nelle parti; pause multiple più 
lunghe di solito sono indicate da un numero scritto sopra una misura-H.

PDF (Portable Document Format): formato file comune che consente di pubblicare 
elettronicamente per visione e stampa su ogni computer documenti realizzati da programmi di 
scrittura (es. Microsoft Word) mantenendone l’aspetto originale. Molto spesso usati da Adobe 
Acrobat e Adobe Reader.

PhotoScore: programma per la scansione della musica contenuto in Sibelius; ci sono due ver-
sioni – PhotoScore Lite è incluso in Sibelius, mentre PhotoScore Professional ha funzioni aggiun-
tive e si acquista separatamente.

PICT: formato file di grafica vettoriale standard per Mac.

Piè di pagina: testo che appare in fondo a ogni pagina di un documento; talvolta è chiamato “piè 
di pagina mobile”. Vedere anche intestazione.
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Pitch bend: nel MIDI è l’effetto “bending” di una nota in alto e in basso, ottenuto agendo su una 
levetta o rotellina (oppure trasmettendo un messaggio MIDI di pitch bend).

Plug-in: software che lavora all’interno di un ambiente software più grande. In Sibelius, un plug-
in è un piccolo programma che aggiunge una funzione extra a Sibelius, scritto in un linguaggio 
denominato ManuScript. Il termine “plug-in” spesso si usa anche per descrivere strumenti vir-
tuali che possono essere caricati nelle applicazioni host come Sibelius.

PNG (Portable Network Graphics): formato file standard di grafica bitmap.

Posizione pan (o pan): direzione da sinistra a destra di un suono nella riproduzione stereo.

PostScript: formato file di grafica vettoriale usato da alcune stampanti laser e dalla maggior 
parte di quelle imagesetters. Vedere anche EPS.

Program: suono (o raccolta di suoni in vari layer) accessibile da un singolo numero pro-
gramma.

Program Change: messaggio MIDI che cambia il numero programma di un canale 
MIDI.

Proprietà: caratteristiche degli oggetti nella partitura – posizione, modalità di riproduzione, font 
e dimensione e così via – accessibili dalla finestra Proprietà.

Quadra (a): segno verticale [ che raggruppa i righi di strumenti appartenenti alla stessa famiglia. 
Il segno verticale [ sottile che raggruppa strumenti separati è una sottoquadra.

(b): segno [ orizzontale che talvolta raggruppa le note in gruppi irregolari.

Questionario: foglio di carta con un esercizio per uno studente, da svolgere in classe o come 
compito a casa; in Sibelius il termine è usato in modo più generico per indicare qualsiasi cosa gen-
erata da Worksheet Creator (che può includere anche materiale di riferimento, poster, ecc.).

Riduzione (o implosione): sistema per collocare le note di più strumenti su uno o più righi (per 
creare un accompagnamento di tastiera o riduzione, ad esempio); è l’opposto di espansione.

Riformattazione: b formattazione.

Rigo: rigo musicale; il termine in inglese è “stave”.

Risoluzione: livello di dettaglio al quale una pagina è stampata o sottoposta a scansione, misu-
rato in dpi; oppure è il numero di pixel visualizzati sullo schermo di un computer (es. 1024 x 768).

Riverbero: effetto simile a un’eco confusa in un ambiente. Ambienti più grandi generano più 
riverbero. Talvolta la quantità di riverbero è specificata dal tempo di riverbero (cioè il tempo neces-
sario a un suono per smorzarsi di 60 decibel).

Scala di grigi (scansione): sfumature di grigio (al contrario di colore o bianco e nero).

Scanner - Driver: programma che indica al computer il tipo di scanner; analogo al driver stam-
pante.

Scansione (a): processo per ottenere una pagina di musica, testo o grafica in un programma nel 
computer usando uno scanner.
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(b) immagine generata quando una pagina è stata sottoposta a scansione. In PhotoScore Lite, le 
scansioni hanno sempre uno sfondo patinato per distinguere la musica letta da quella in Sibelius.

Scrittura musicale: arte di scrivere la notazione musicale; riguarda la forma dei simboli musi-
cali, posizionamento e spaziatura di note e altri oggetti, layout delle pagine e l’impiego di partico-
lari font e dimensioni di testo; gran parte (ma non tutta) della scrittura musicale è stata riassunta 
in regole di scrittura.

Segno di prova: grande lettera e/o numero (normalmente in un box) usata in lunghe partiture 
per aiutare il musicista durante le prove.

Selezionare: cliccando su un oggetto (o oggetti o passaggio) da modificare, copiare, spostare o 
cancellare esso si colora; il colore indica in quale voce si trova l’oggetto o se si tratta di un 
oggetto di sistema.

Selezione: qualsiasi cosa selezionata. Una selezione singola è costituita da un oggetto selezion-
ato; una selezione multipla è formata da due o più oggetti selezionati. Vedere passaggio.

Separatori di sistema: doppie linee diagonali spesse scritte tra i sistemi nelle partiture grandi 
per evidenziare la presenza di più di un sistema per pagina.

Sequencer: programma destinato principalmente a registrazione, modifica e riproduzione della 
musica con il MIDI; la maggior parte dei sequencer può anche stampare la notazione (entro certi 
limiti) ma poiché i sequencer sono progettati per il MIDI, non per la notazione, sono assai diversi 
dai programmi di notazione musicali. Molti sequencer, oltre al MIDI registrano e modificano 
anche l’audio (come un cantato).

Serif: punte su angoli e cime delle lettere in alcuni font, conosciuti come font serif. I font Serif 
sono considerati più leggibili di quelli sans serif per testi molto voluminosi (come i libri).

Sezione: suddivisione di una partitura (es. un brano da un album o un movimento da una sinfo-
nia); le nuove sezioni spesso iniziano con un nuovo titolo e i nomi strumenti completi. Talvolta i 
numeri misura ripartono da 1 e i segni di prova ripartono da A o 1.

Simbolo: oggetto di forma fissa collocabile ovunque nella partitura; si usa per vari oggetti come 
ornamenti e simboli percussivi. I simboli sono personalizzabili: possono essere di qualsiasi carat-
tere di ogni font o formati da un numero qualsiasi di simboli esistenti.

Sintesi: processo di generazione di un suono in base a calcoli matematici.

Sistema: gruppo di righi riprodotti simultaneamente e uniti di solito sul lato sinistro da una 
stanghetta iniziale. La musica per uno strumento solista spesso è scritta su un rigo; in tal caso 
i termini “sistema” e “rigo” indicano la stessa cosa.

Sound ID: nome strutturato che descrive il timbro particolare di un suono (wood-
wind.flutes.flute, woodwind.flutes.piccolo.flutter-tongue o strings.violin.ensemble.pizzi-
cato); una raccolta di sound ID è denominata SoundWorld.

Soundfont: raccolta di suoni campionati di solito in uno o due formati (SF2 e DLS). Inizialmente 
era un metodo per cambiare i suoni disponibili sulle schede audio di alcuni costruttori, ma ora è 
possibile usare i soundfont senza bisogno di una scheda audio specifica (normalmente caricandoli 
in uno strumento virtuale.
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Sound set: set completo di suoni disponibili su un dispositivo MIDI o strumento virtuale. 
Sibelius permette di scegliere tra sound set General MIDI, Garritan Personal Orchestra e così via.

SoundWorld: standard progettato da Sibelius Software per chiarire la confusione tra nomi pro-
gramma e numeri programma usati da dispositivi MIDI e strumenti virtuali; un Sound-
World è una raccolta di sound ID disposti in una struttura ad albero. 

Spaziatura: distanza tra due linee del rigo, usata come unità di misurazione principale nella 
scrittura musicale; ad esempio, i tratti d’unione normalmente sono spessi 0.5 spazi e una 
dimensione rigo è per definizione costituita da quattro spazi.

Spelling: modo in cui è scritta una nota alterata; la maggior parte di esse hanno spelling (per 
esempio, DO naturale può anche essere “scritto” come SI# o REbb).

Spreads: formato di stampa nel quale coppie di pagine consecutive sono stampate affiancate sullo 
stesso foglio di carta a indicare l’aspetto della partitura finita aperta in piano.

Stanghetta iniziale: stanghetta all’estremità sinistra di un sistema che unisce tra loro due righi; 
Sibelius li aggiunge automaticamente; normalmente la stanghetta inziale è omessa nei sistemi a 
singolo rigo. 

Stile di testo: stile di testo di ogni frammento di testo in una partitura che ne specifica font, 
dimensione, posizionamento, ecc.. Impieghi diversi dei testi hanno stili diversi; per esempio, i 
segni dinamici (es. mp) sono nello stile Expression.

Strumento: per Sibelius è qualsiasi cosa che ha un nome a sinistra di un sistema (cantanti, nastro 
magnetico, ecc.); gli strumenti possono avere più di un rigo (es. tastiere) e più di un musicista 
(es. i legni nella musica orchestrale/bandistica).

Strumento trasportato: strumento che suona a un’altezza diversa dalla musica in cui è scritto 
(es. clarinetto, corno o piccolo). Il trasporto (o “tonalità”) dello strumento è specificato dall’altezza 
generata quando il musicista legge un DO; per esempio, quando una tromba “in SIb” legge un DO 
in realtà suona un SIb.

Strumento virtuale: software che simula il suono di uno strumento reale, sia esso un sintetiz-
zatore o uno strumento analogico (in genere usando campioni o sintesi per generare il suono).

Sottoparentesi: b parentesi. 

Tab (a) guitar tab (abbreviazione per “tablatura”): notazione nella quale le linee del rigo rappre-
sentano le corde della chitarra e i numeri dei tasti indicano la diteggiatura.

(b) Uno o più pulsanti in cima a una finestra di dialogo che selezionano diverse pagine di opzioni; 
la finestra Tastierino numerico ha anche cinque pagine per la scelta di diversi layout del tast-
ierino numerico.

Testa nota: pallino o altra forma (es. croce o rombo) di una nota o accordo che ne specifica 
altezza, valore nota e talvolta la tecnica esecutiva.

Tick: è la più piccola unità di tempo in Sibelius; ci sono 256 tick per nota da 1/4.

TIFF (Tagged Image File Format): formato grafico standard bitmap.
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Timecode: numeri che indicano la posizione tempo in una partitura o video; in genere il time-
code indica ore, minuti, secondi e decimi di secondo o frame (fotogrammi).

Traccia: file MIDI equivalente a un rigo; i canali MIDI servivano a questo scopo nei file MIDI 
più vecchi (tipo 0), ma avevano lo svantaggio di essere limitati a 16, mentre il numero di tracce è 
illimitato nei file MIDI di tipo 1.

Tratti d’unione: linee spesse che uniscono gruppi di note da 1/8 e più brevi. Tratto d’unione 
frazionale è un altro termine per indicare un flag (bandierina).

Tuplet - Gruppo irregolare: ritmo suonato a una frazione della sua velocità normale (es. una 
terzina). È indicato da un singolo numero o ratio sopra o sotto le note, spesso con una parentesi
che mostra a quali note è applicato, talvolta con una piccola nota che indica l’unità ritmica alla 
quale fa riferimento il numero(i).

“Tuplet” in realtà è un gergo di software musicale – nel mondo della musica i tuplet in generale si 
chiamano ritmi irregolari, poliritmi o ritmi irrazionali.

TWAIN: standard di comunicazione usato tra programmi di computer e scanner; analogo al 
MIDI.

USB (Universal Serial Bus): i computer moderni hanno due o più porte USB che consentono la 
connessione di molte periferiche hardware, incluse stampanti e dispositivi MIDI.

Uscita (scansione): musica letta dalla scansione.

Valore nota: durata di una singola nota, accordo o pausa (es. nota da 1/8 o da 1/2).

Velocity: nel MIDI è la rapidità (quindi la forza) con la quale si preme un tasto su una tastiera 
MIDI: stabilisce il volume della nota; talvolta questo termine è usato anche per indicare la velocità 
con la quale si rilascia un tasto (che determina il tempo di decadimento della nota).

Voce: serie di note, accordi e pause in successione ritmica su un rigo (talvolta denominata “layer” 
o più impropriamente “parte” o “linea”). Normalmente c’è solo una voce su un rigo; in tal caso, i 
gambi possono essere rivolti in alto o in basso (dipende dall’altezza delle note).

Sono scritte due voci sullo stesso rigo quando occorre mostrare simultaneamente due ritmi 
indipendenti; le voci si distinguono dalla direzione del gambo – note e accordi della voce 1 hanno i 
gambi rivolti in alto, mentre nella voce 2 i gambi sono rivolti in basso.

Nella musica per chitarra e (talvolta) per tastiera si possono usare la quarta e quinta voce. 
Anche queste hanno i gambi rivolti in alto e in basso.

Selezionando una nota o altro oggetto il colore della selezione indica in quale voce ci si trova.

Volume: volume complessivo del canale MIDI diverso dalla velocity che determina il volume 
di singole note.

VST (Virtual Studio Technology): nome di un formato per strumenti virtuali ed effetti inven-
tato da Steinberg; strumenti virtuali ed effetti VST funzionano sia in Windows che su Mac.

Zither: strumento a corda popolare Ungherese a forma di scatola poco diffuso fuori dall’Unghe-
ria; in realtà non è menzionato in questo Manuale Operativo, ma inizia con la lettera Z...).
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Licenza d’uso

Installando o usando un elemento qualsiasi del Software o registrando il Prodotto l’acquirente 
(come singolo individuo o soggetto giuridico) concorda con il Licenziatario sui termini di questa 
Licenza che regolamenta l’uso del Prodotto; se non si accettano questi termini, entro 14 giorni 
dall’acquisto è possibile restituire il Prodotto e la relativa documentazione intatti nella confezione 
originale al proprio rivenditore di fiducia insieme a una prova d’acquisto per ottenere un rimborso 
completo.

Il Prodotto è protetto da copyright © Sibelius Software, una divisione di Avid Technology, Inc. e 
suoi affiliati 1987–2008.

Questa licenza d’uso non si applica alla Edizione Internet di Sibelius.

1. DEFINIZIONI

In questa Licenza parole e frasi che seguono hanno questi significati:

"Documentazione": Guida di Sibelius, Manuale Operativo di Sibelius, volantino Ultime Informazioni & Supporto Tecnico, video tutorial e ogni 
altra documentazione relativa al Software fornita all’acquirente in qualsiasi forma dal Licenziatario o contenuta nel Software.

"Licenza": Questo accordo tra l’acquirente e il Licenziatario e, se consentito dal contesto, la licenza condizionale garantita all’acquirente 
in questo accordo.

"Licenziatario": Sibelius Software Limited, azienda Inglese con sede presso The Old Toy Factory, 20-22 City North, Fonthill Road, Londra N4 
3HF, UK (N° di registrazione 3338819).

"Copia di Rete": Un Prodotto da usare su più terminali di computer collegati in una rete.

"Prodotto": Il Software e la Documentazione.

"Copia Singola": Un Prodotto da usare su un signolo terminale di computer.

"Software": Sibelius per Windows/Mac, Sibelius Scorch, le famiglie dei font Opus, Helsinki, Reprise e Inkpen2, video e file musicali 
d’esempio, PhotoScore Lite, Kontakt Player Silver, installativi, dimostrazioni di altro software e tutti gli altri programmi o file 
forniti all’acquirente dal DVD-ROM di Sibelius o tramite download.

"Licenza Sito Stand-Alone": Un Prodotto da usare su più terminali di computer non collegati in rete.

2. Licenza

2.1 (1) Il Licenziatario garantisce all’acquirente una licenza d’uso del Software non esclusiva e non trasferibile in accordo con la Documentazi-
one, soggetta ai termini di qualsiasi sconto educativo o altro, offerta o formula con la quale può essere ottenuto il Prodotto. Le copie educa-
tive, inoltre, non sono destinate all’uso commerciale. Per poter essere usati, alcuni elementi del Software possono essere soggetti a licenze 
d’uso separate da sottoscrivere.

(2) Se il Prodotto è una Copia Singola, il Software si può installare su un singolo computer; si può installare anche su un altro computer, sem-
pre che sia la stessa persona a usare il Software su uno dei computer e il Software non sia mai usato contemporanemente su entrambi i com-
puter.

(3) Se il Prodotto ha una Licenza Sito Stand-Alone, il Software si può usare solamente come applicazione non in rete e solo sul numero dei 
terminali di computer consentiti dalla licenza in un singolo luogo geografico.

(4) Se il Prodotto è una Copia di Rete, il Software si può installare solamente sui computer di una singola rete situata nello stesso luogo 
geografico (se non diversamente autorizzato per iscritto dal Licenziatario) e usare su non più del numero dei terminali di computer autoriz-
zati simultaneamente. Qualsiasi altro uso è proibito.

(5) La Titolarità del Prodotto non passa all’acquirente. La proprietà del Prodotto rimane al Licenziatario e ai suoi affiliati, pur essendo sog-
getta ai diritti garantiti all’acquirente previsti in questa Licenza. Tutti gli altri diritti sono riservati.

(6) Se il Software è fornito in seguito a promozione o aggiornamento da una versione precedente, la licenza utilizzata per la vecchia versione 
è da considerarsi scaduta.

2.2 Si può eseguire una stampa per uso personale di qualsiasi parte della Documentazione fornita in formato elettronico. È vietato eseguire o 
permettere a terzi di eseguire altre copie del Prodotto sia in forma visiva che leggibile da una macchina.

2.3 Non si può e non si deve consentire a terzi di tradurre, potenziare, modificare, alterare, adattare o realizzare lavori di altri basati sul Prodotto 
o su una parte di esso per qualsiasi motivo (compresa nessuna limitazione per la correzione di un errore), né integrare o incorporare qual-
siasi parte del Prodotto in un qualsiasi altro programma, file o prodotto per qualsiasi motivo, tranne nei casi espressamente indicati nella 
Documentazione.
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2.4 Non si può e non si deve consentire per nessun motivo a terzi di scomporre, decodificare, disassemblare o riprogettare il Software intera-
mente o in parte.

2.5 Non si può e non si deve consentire per nessun motivo a terzi di tradurre, convertire, decodificare o riprogettare interamente o parzialmente 
qualsiasi file in ogni versione dei formati Sibelius o Sibelius Scorch (creati o meno dalla propria copia di Software), né modificare tali file 
(tranne quando si usa il Software come indicato nella Documentazione).

2.6 Come indicato nella Documentazione e in conformità con la Sezione 2.1, la funzione "Save as Scorch Web Page" del Software e il plug-in 
browser web Scorch di Sibelius si possono usare per pubblicare partiture musicali in Internet, su DVD-ROM, CD-ROM, floppy disk o sup-
porti simili. 
È vietato da parte dell’acquirente e di terzi ricevere direttamente o indirettamente qualsiasi forma di pagamento o altra remunerazione per la 
visione, riproduzione, stampa o altro uso via Sibelius Scorch o via Internet di qualsiasi file creato dal Software (o basato su un file creato da 
esso) senza un consenso scritto espressamente rilasciato dal Licenziatario.

2.7 Il Prodotto (o qualsiasi parte di esso) non può essere usato per infrangere alcun diritto di copyright o il diritto alla privacy, pubblica o perso-
nale, né qualsiasi altro diritto simile di ogni altra persona o entità giuridica, inclusa nessuna limitazione ad infrangere i medesimi diritti 
usando il Prodotto insieme agli altri programmi di scansione PhotoScore Lite, PhotoScore MIDI o PhotoScore Ultimate, o usando le funzioni 
di pubblicazione in Internet del Prodotto.

2.8 Materiali didattici, contenuti di Idee, file e video musicali forniti con il Prodotto sono riservati all’uso personale dell’acquirente e/o dei suoi 
studenti o istituti scolastici. È vietata inoltre interamente o parzialmente la sua pubblicazione o uso commerciale.

3. Copyright

3.1 Si riconosce come da accordo tra l’acquirente e il Licenziatario che il copyright dell’intero Prodotto e degli elementi che lo costituiscono 
appartiene al Licenziatario o suoi affiliati ed è protetto dalle leggi nazionali, internazionali e da tutte le altre leggi applicabili sul copyright. 
Ulteriori dettagli sulla proprietà di tutti i copyright negli elementi del Prodotto sono descritti nel Prodotto stesso.

4. Responsabilità del Licenziatario

4.1 Il Licenziatario garantisce che il Prodotto è privo di difetti nei materiali e di lavorazione e sostanzialmente funziona normalmente come 
indicato nella Documentazione per un periodo di 90 giorni dalla data d’acquisto ("Periodo di Garanzia"). Se il Prodotto presenta un difetto 
durante il Periodo di Garanzia, può essere restituito insieme alla prova d’acquisto al Licenziatario il quale, a sua totale discrezione, rimbo-
rserà il prezzo pagato o riparerà il Prodotto senza alcun costo da parte dell’acquirente.

4.2 Il Licenziatario non si ritiene responsabile per qualsiasi reclamo dovuto a:

(1) Difetti o malfunzionamenti dovuti interamente o in parte a negligenza, errori dell’operatore, uso diverso da quello descritto nella Docu-
mentazione o qualsiasi altro uso improprio o abuso del Prodotto;

(2) Perdita o danneggiamento di dati, comunque provocati, evitabili, correggibili o sostanzialmente limitabili conservando in luogo sicuro le 
opportune copie di backup;

(3) Frammentazione o modifica del Software, fusione con qualsiasi altro programma, interventi di manutenzione destinati ad alterare o 
potenziare il Software da parte di qualcuno che non sia il Licenziatario o il personale autorizzato;

(4) L’inosservanza da parte dell’acquirente delle raccomandazioni fornite in precedenza dal Licenziatario per l’uso del Prodotto (o le soluzi-
oni agli eventuali difetti riscontrati);

(5) Perdite o danni comunque dovuti a omissioni o mancata osservanza d’informazioni o dati indicati nel Prodotto.

(6) Tranne ove diversamente indicato nella Sezione 4.1, tutte le condizioni, garanzie, indicazioni di scadenze e iniziative espresse o implicite, 
statutarie o altro che riguardano il Prodotto sono espressamente escluse.

(7) Tranne ove espressamente indicato nella Sezione 4.1, il Licenziatario non è responsabile in merito a perdite di profitti, entrate, benefici o 
qualsiasi perdita indiretta o consequenziale (inclusi perdite o danni subiti dall’acquirente a causa di un’azione eseguita da terzi) se tale perd-
ita è dovuta alla violazione degli obblighi contrattuali del Licenziatario in seguito a qualsiasi negligenza o altra azione illecita od omissione.

(8) La piena responsabilità del Licenziatario per la violazione di clausole e garanzie indicate in questa Licenza e per qualsiasi difetto o errori 
nel Prodotto si limita al prezzo pagato dall’acquirente per l’acquisto del Prodotto stesso (tranne ove espressamente indicato nella Sezione 
4.1).

5. Rescissione

5.1 Questa Licenza scade automaticamente in seguito alla distruzione del Prodotto da parte dell’acquirente. Il Licenziatario ha diritto di rescin-
dere questa Licenza in caso di violazione materiale da parte dell’acquirente di una qualsiasi condizione indicata in essa o di una qualsiasi 
delle istanze, garanzie, accordi od obblighi sottoscritti. In seguito alla notificazione di rescissione da parte del Licenziatario l’acquirente è 
tenuto a eliminare immediatamente tutte le copie del Software dal proprio(i) computer, distruggere tutte le altre copie del Prodotto o qual-
siasi elemento di esso e restituire il Prodotto al Licenziatario.
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6. Miscellanea

6.1 Nessuna mancanza di esercizio e ritardo d’esercizio da parte del Licenziatario di qualsiasi diritto, potere o privilegio può costituire una 
deroga, né alcun singolo o parziale esercizio di qualsiasi potere o privilegio preclude un altro o ulteriore diritto, potere o privilegio. Diritti e 
rimedi del Licenziatario connessi a questa Licenza non escludono alcun diritto o tutela previsti dalla legge.

6.2 È vietato distribuire, prestare, concedere in sottolicenza, noleggiare, (inclusa nessuna limitazione a prestito o noleggio di un computer sul 
quale è installato il Prodotto) o trasferire in altro modo il Prodotto a terzi senza prima avere un consenso scritto del Licenziatario che può 
essere concesso, condizonato o ritirato a esclusiva discrezione del Licenziatario stesso.

6.3 Si consente una comunicazione accurata dei dati personali durante la registrazione del Prodotto e un uso di questi dati in base alle norme 
sulla privacy applicate dal Licenziatario (si possono richiedere al Licenziatario o consultare sul sito www.sibelius.com) che possono cambi-
are periodicamente.

6.4 Questa Licenza è intesa dalle parti contraenti come espressione finale dell’accordo sulle clausole e completa ed esclusiva accettazione dei ter-
mini in essa contenuti. Questa Licenza sostituisce qualsiasi eventuale accordo precedente, sia scritto che orale, tra l’acquirente e il Licenzia-
tario riguardo alle clausole in essa contenute.

6.5 (Questa sezione vale solamente per i residenti nell’Unione Europea): questa Licenza è interpretata e regolamentata dalle leggi Inglesi ed 
entrambe le parti concordano di sottoporsi alla giurisdizione esclusiva dei tribunali Inglesi.

6.6 (Questa sezione vale solamente per i non residenti nell’Unione Europea): questa Licenza è interpretata e regolamentata dalle leggi della Cal-
ifornia. Qualsiasi causa, azione o procedimento legale inerente o collegato a questa Licenza può essere intentata e mantenuta solamente negli 
Stati Uniti presso la Corte Distrettuale nel Distretto Settentrionale della California, Città di San Francisco. Per qualsiasi causa, azione o pro-
cedimento legale le parti si sottomettono irrevocabilmente alla giurisdizione di tale Corte Federale. Le parti coscientemente, volontaria-
mente e irrevocabilmente si rimettono al giudizio del Tribunale per qualsiasi causa, azione o procedimento legale (inclusa qualsiasi 
controversia) sia di legge o equità derivanti o in ogni modo collegate a questa Licenza o ai termini in essa contenuti.

(Licenza versione 5, 10 Aprile 2007)

reference.book  Page 651  Wednesday, April 16, 2008  4:28 PM



Licenza d’uso

652

reference.book  Page 652  Wednesday, April 16, 2008  4:28 PM


	Presentazione
	Capitoli e argomenti
	Guida “on-screen”
	Riferimenti incrociati

	1. Inserire
	1.1 Inserimento note
	Inserimento alfabetico e step-time
	Tasti utili
	Inserimento con il mouse
	Reinserire le altezze
	Editing di valori nota, alterazioni, articolazioni, ecc.
	Opzioni d’inserimento nota
	Nascondere le note
	Trasformazione in pause
	Spostare le pause
	Nascondere le pause

	1.2 Tastierino numerico
	Layout del tastierino numerico
	Visualizzare e modificare le caratteristiche della nota
	Voci
	Comandi rapidi extra per le funzioni del tastierino numerico
	Accedere alle funzioni del pad numerico di un notebook (portatile)
	Uso del tastierino numerico in Mac OS X

	1.3 Flexi-time™
	Inserimento in tempo reale
	Registrare in Flexi-time
	Impostazioni di click
	Consigli
	Inserimento note per due strumenti
	Registrare altri dati MIDI
	Live Playback
	Opzioni Flexi-time
	Registrare note trasportate
	Spelling delle alterazioni
	Voci

	1.4 Scansione
	Introduzione
	PhotoScore Ultimate
	Scansione
	Installare e disinstallare PhotoScore Lite
	Originali supportati
	Musica protetta da copyright
	PER INIZIARE
	Le quattro fasi operative
	Avvio rapido
	1. SCANSIONE
	Riassunto della scansione
	Catalogare le pagine scansionate
	Consigli per la scansione
	2. LETTURA
	Avvio della lettura
	Cosa legge PhotoScore Lite
	Consigli sulla lettura
	3. EDITING
	Cosa correggere
	Verifica degli errori
	Riproduzione MIDI
	4. INVIO A SIBELIUS
	Correggere gli errori ritmici
	Formato
	Strumenti Multi-rigo
	Chiudere la partitura d’uscita
	Cancellare scansioni indesiderate
	Salvare i file MIDI
	PROBLEMI POSSIBILI
	Scansione molto lenta
	Non sono rilevati tutti i righi/sistemi
	La lettura è molto lunga
	Musica letta con poca precisione
	FUNZIONI AVANZATE
	Scegliere un buon scanner
	Regolare i righi/sistemi rilevati
	Opzioni della finestra Scan
	Elenco delle immagini scansionate
	Righi omessi
	Strumenti multi-rigo
	Strumenti/righi introdotti dopo l’inizio
	Righi piccoli
	Altre preferenze

	1.5 Inserire una tablatura per chitarra
	Creare uno strumento con tablatura
	Trasformare la notazione in tablatura o la tablatura in notazione
	Inserire la tablatura
	Note non suonabili
	Opzioni di diteggiatura della tablatura per chitarra
	Ripristinare la diteggiatura della tablatura
	Quando Sibelius ripristina automaticamente la diteggiatura della tablatura?
	Uso di una chitarra MIDI

	1.6 Selezioni e passaggi
	Selezione dei colori
	Selezioni singole
	Selezioni multiple
	Passaggi selezionati
	Situazioni veloci
	Cosa si può fare con selezioni multiple e passaggi selezionati?
	Copia multipla
	Copia multipla di un singolo oggetto
	Copia multipla di una selezione multipla
	Copia multipla di un passaggio
	Ripetizione delle selezioni

	1.7 Dispositivi d’ingresso MIDI
	Scelta dei dispositivi d’ingresso
	Problemi con l’ingresso MIDI
	Mappature d’ingresso
	Chitarre MIDI
	Consigli per un buon inserimento via chitarra MIDI


	2. Notazioni
	2.1 Acciaccature
	Comando Incolla come guida
	Plug in Trova posizioni note guida
	Verificare il plug-in delle acciaccature
	Preferenze del comando Incolla come guida
	Creare acciaccature, pause e altri oggetti
	Opzioni Regole tipografia
	Note grandi

	2.2 Alterazioni
	Creare un’alterazione su una nota
	Aggiungere le alterazioni alle note esistenti
	Rimuovere alterazioni particolari
	Rimuovere una serie di alterazioni
	Nascondere le alterazioni
	Alterazioni in parentesi
	Alterazioni piccole
	Doppie alterazioni e quarti di tono
	Altri microtoni
	“Spelling” delle alterazioni
	Semplificare le alterazioni
	Aggiungere le alterazioni alle note
	Unisoni alterati
	Digitare le alterazioni nel testo
	Spostare le alterazioni
	Riproduzione di alterazioni microtonali
	Opzioni Regole tipografia

	2.3 Articolazioni
	Creare la articolazioni per una nota
	Aggiungere le articolazioni a note esistenti
	Rimuovere alterazioni particolari
	Spostare le articolazioni
	Copia delle articolazioni
	Articolazioni sulle pause
	Articolazioni personalizzate
	Comandi rapidi dalla tastiera del computer
	Arresti (pause) sulle stanghette
	Articolazioni sopra il rigo
	Opzioni Regole tipografia

	2.4 Chiavi
	Modificare la chiave
	Spostare le chiavi
	Cancellare le chiavi
	Nascondere le chiavi all’inizio di un sistema
	Nascondere cambi di chiave d’avvertimento
	Chiavi d’ottava
	Opzioni Regole tipografia

	2.5 Colori
	Come colorare un oggetto
	Reimpostare il colore di un oggetto
	Visualizzare le note a colori
	Stampa a colori
	Quali oggetti si possono colorare?
	Quali oggetti non si possono colorare?
	Salvare i colori nel raccoglitore di Windows
	Salvare i colori nel raccoglitore di Mac

	2.6 Diagrammi accordo
	Creare i diagrammi accordo
	Stretch massimo
	Copiare, modificare e cancellare i diagrammi accordo
	Modificare e salvare i diagrammi accordo
	Aggiungere un testo di diteggiatura
	Aspetto del testo di diteggiatura
	Librerie di diagrammi accordo
	Simboli accordo
	Riproduzione dei diagrammi accordo
	Diagrammi accordi non riconosciuti
	Opzioni Regole tipografia

	2.7 Foglio manoscritto
	Tipi di foglio manoscritto
	Creare un foglio manoscritto personalizzato

	2.8 Gambi e linee aggiuntive
	Invertire la direzione del gambo
	Gambi sulla linea centrale
	Forzare la direzione del gambo
	Regolare la lunghezza dei gambi
	Note senza gambo
	Simboli per il gambo
	Nascondere le linee aggiuntive
	Opzioni Regole tipografia

	2.9 Legature di portamento
	Legature di portamento e segni di frase
	Legature di portamento magnetiche™
	Legature non magnetiche
	Legature su due o più sistemi
	Copiare le legature
	Legature multi-arco
	Legature tratteggiate e puntate
	Legature sulle parole
	Opzioni Regole tipografia

	2.10 Legature di valore
	Legature di valore e portamento
	Creare le legature di valore
	Legature di valore sui break
	Legature di valore “Laissez vibrer”
	Legature di valore nella musica arpeggiata
	Note legate in misure di 2˚ finale (2˚ volta)
	Opzioni Regole tipografia

	2.11 Linee
	Creare le linee
	Legature di portamento
	Forcine
	Ritardando e accelerando.
	Trilli
	Pedali
	1˚, 2˚ e 3˚ finale (misure 1˚/2˚/3˚ volta)
	Linee d’ottava (8/15)
	Glissato e portamento
	Linee d’arpeggio
	Parentesi per la musica di tastiera e doppi-stop
	Rettangolo
	Linee di tratti d’unione
	Linee tratteggiate
	Linee di chitarra
	Comando Reset Position
	Riformattare le linee
	Linee su due o più sistemi
	Nascondere le linee

	2.12 Misure e misure di pausa
	Aggiungere le misure alla fine della partitura
	Aggiungere le misure in mezzo alla partitura
	Modificare la durata delle misure
	Cancellare una misura intera
	Cancellare una misura in un rigo
	Creare una misura di pausa in una voce
	Cancellare il simbolo di una misura di pausa
	Creare misure irregolari
	Misure d’attacco (upbeat)
	Modificare la larghezza di una misura di pausa
	Misure di ripetizione e note intere doppie (breve)/misure di pausa vuote
	Spostare un simbolo di misura di pausa
	Misure divise

	2.13 Notazione e tablatura per chitarra
	Bending
	Intervalli di bending
	Bending & release
	Bending di ornamenti e pre-bending
	Pre-bending e release
	Bending all’unisono
	Slide
	Vibrato (whammy) con pressione e rilascio della leva
	Leva di vibrato scoop
	Leva di vibrato dip
	Altre tecniche
	Accordatura sui righi di tablatura
	Personalizzare tablature, accordature e strumenti a tasti
	Cambiare l’accordatura di uno strumento
	Note sulla tablatura con sfondo bianco
	La tablatura può essere divertente
	Opzioni Regole tipografia

	2.14 Ornamenti
	Creare gli ornamenti...
	...il metodo più rapido
	...il metodo più lento
	Modificare gli ornamenti
	Ornamenti alla fine delle misure
	Spaziatura degli ornamenti
	Opzioni Regole tipografia

	2.15 Parentesi quadre e graffe
	Spostare le parentesi quadre e graffe
	Aggiungere una parentesi, sottoparentesi quadra o graffa
	Nascondere una parentesi quadra o graffa
	Collocare le parentesi quadre a metà sistema
	Stile di parentesi quadre e graffe

	2.16 Pause multiple
	Usare le pause multiple
	Creare una pausa multipla
	Inserimento note in una pausa multipla
	Cambiare la durata di una pausa multipla
	Dividere una pausa multipla
	Evitare che una pausa multipla si divida in parti
	Stabilire perché si divide una pausa multipla
	Nascondere una pausa multipla
	Cancellare una pausa multipla
	Layout automatico di pause multiple
	Visualizzare i numeri misura sulle pause multiple
	Opzioni Regole tipografia
	Collocare i numeri per le pause multiple sotto la misura-H

	2.17 Percussioni
	Strumenti percussivi non intonati
	Notazione di batteria
	Inserimento nota per una percussione non intonata
	Righi diversi per strumenti diversi
	Creare una drum map personalizzata
	Rigo singolo per ogni musicista
	Simboli percussivi
	Rimuovere i bordi dai simboli di battente percussivo
	Rullate (Z sul gambo)

	2.18 Righi
	Creare i righi
	Strumenti con più righi
	Ossia
	Ordinare i sistemi sul lato sinistro
	Ordinare i sistemi sul lato destro
	Nascondere i righi
	Salvare gli alberi - nascondere i righi vuoti
	Mostrare i righi nascosti
	Cancellare permanentemente i righi
	Dimensione del rigo
	Righi piccoli
	Righi con spazi vuoti
	Confrontare due righi

	2.19 Ritmo libero
	Ritmo libero normale
	Ritmi liberi indipendenti
	Musica con più tempi in chiave simultanea
	Canto libero
	Recitativo
	Cadenze

	2.20 Simboli
	Creare un simbolo
	Spostare i simboli
	Modificare i simboli
	Riproduzione dei simboli
	Simboli scrivibili
	Ripetizioni
	Generici
	Ornamenti
	Tastiera
	Percussioni
	…battenti
	Chitarra
	Articolazioni
	Alterazioni
	Note
	Teste nota
	Pause
	Conduzione
	Chiavi
	Ottave
	Segni layout
	Tecniche
	Fisarmonica
	Campane
	Altri ornamenti
	Cluster
	Gambi speciali
	Prolatio
	Miscellanea
	Nomi nota

	2.21 Stanghette
	Stanghette alla fine delle misure
	Altre stanghette
	Doppia stanghetta finale
	Stanghette di ripetizione
	Stanghette introduttive
	Unioni delle stanghette
	Stanghette invisibili
	Nascondere solo le stanghette di alcuni righi
	Stanghette iniziali su sistemi a rigo singolo
	Misure separate
	Opzioni Regole tipografia

	2.22 Strumenti
	Strumenti o righi?
	Creare gli strumenti
	Cancellare gli strumenti
	Separatori di sistema
	Estensione dello strumento
	Transporto degli strumenti
	Alterazioni e tonalità per gli strumenti trasportati
	Esecutori multipli e archi divisi...
	...caso semplice
	...caso più complesso
	Strumenti doppi
	Cambi di strumento
	Modificare i cambi di strumento
	Cambi di strumento e parti dinamiche

	2.23 Tablatura per liuto
	Creare una tablatura per liuto
	Vari stili di tablatura per liuto
	Ritmi
	Diapason

	2.24 Tempi in chiave
	Creare i tempi in chiave
	Misure d’entrata (upbeat)
	Re-misurare la musica
	Tempi in chiave d’avvertimento
	Tempi in chiave complessi
	Gruppi di tratti d’unione e pause
	Misure irregolari e ritmo libero
	Tempi in chiave multipli
	Tempi in chiave alternati
	Modificare i tempi in chiave
	Tempi in chiave grandi, ecc.

	2.25 Terzine e altri tuplet
	Creare rapidamente i tuplet
	Creare lentamente i tuplet
	Modificare i tuplet
	Copiare i tuplet
	Cancellare i tuplet
	Impostare l’unità di durata
	Tuplet speciali
	Spostare i tuplet
	Tuplet annidati
	Tuplet nascosti
	Cambiare l’aspetto di tuplet già presenti nella partitura
	Parentesi orizzontali del tuplet
	Tuplet sopra le stanghette
	Motivi dei tuplet e opzioni Engraving Rules

	2.26 Teste nota
	Scegliere una testa nota
	Teste nota comuni
	Diverse dimensioni di teste nota
	Note in parentesi

	2.27 Tonalità
	Creare le tonalità
	Spostare e cancellare i cambi di tonalità
	Tonalità d’avvertimento
	Tonalità aperta/Atonale
	Strumenti senza tonalità
	Tonalità enarmoniche
	Tonalità multiple
	Opzioni Engraving Rules

	2.28 Tratti d’unione
	Gruppi dei tratti d’unione
	Tratti d’unione primari e secondari
	Reimpostare i gruppi dei tratti d’unione
	Riutilizzare i gruppi dei tratti d’unione
	Modifica dei tratti d’unione
	Tratti d’unione attraverso le pause
	Tratti d’unione attraverso stanghette, break di sistema e pagina
	Unire le duine
	Unire gli ottavi (crome) in 4
	Angolazione dei tratti d’unione
	Tratti d’unione orizzontali
	Invertire i tratti d’unione
	Invertire i tratti d’unione parziali
	Tratti d’unione tra i righi
	Tratti d’unione tra note sullo stesso rigo
	Dividere gli accordi tra i righi
	Tratti d’unione a ventaglio
	Nascondere tratti d’unione, bandierine e code
	Opzioni Regole tipografia
	Posizioni dei tratti d’unione
	Aspetto del tratto d’unione

	2.29 Tremolo
	Tremolo a una nota
	Tremolo a due note
	Rullate (Z sul gambo)
	Anomalie nella scrittura del tremolo

	2.30 Voci
	Cosa sono le voci?
	Uso delle voci
	Visualizzare il colore degli oggetti
	Iniziare una nuova voce di note
	Misure parzialmente in due voci
	Cancellare la Voce 2
	Unire le voci
	Unire i righi usando le voci
	Dividere le voci
	Voci 3 e 4
	Scambiare le voci
	Copiare le voci
	Copia da una voce a un’altra
	Pause
	Nascondere le voci
	Voci incrociate
	Opzioni Engraving Rules


	3. Testo
	3.1 Lavorare con i testi
	Creare rapidamente un testo
	Menu scritte
	Modificare il testo
	Selezionare una linea di testo
	Copiare linee di testo e testi tra programmi diversi
	Cambiare lo stile del testo esistente
	Nascondere il testo
	Comando Reset Position
	Resettare la forma
	Testo a sinistra del sistema
	Testo tra i righi
	Porzioni di testo multiple
	Creare oggetti speciali con il testo
	Creare e modificare i menu scritte
	Caratteri speciali

	3.2 Stili di testo comuni
	Cos’è uno stile di testo?
	Tre tipi di testo
	Stili di testo principali
	Expression
	Technique
	Metronome mark
	Modulazioni metriche
	Tempo
	Parole e simboli accordo
	Titolo, Sottotitolo, Compositore, Parolieri, Dediche
	Diteggiatura
	Testo piccolo e in box
	Copyright
	Piè di pagina (Footnote)
	Intestazione e Intestazione (dopo la prima pagina)
	Piè di pagina
	Testo normale

	3.3 Parole
	Digitare le parole
	Modificare le parole
	Strofe, ritornelli e traduzioni
	Copiare le parole in Sibelius
	Copiare una linea intera di parole
	Copiare le parole da una linea (o strofa) a un’altra
	Copiare le parole da Sibelius
	Creare le parole da un file di testo
	Dividere le parole in sillabe
	Verificare la sillabazione delle parole
	Parole condivise
	Parole su due voci
	Più parole per nota ed elisioni
	Legature e tratti d’unione
	Punteggiatura sospesa
	Posizione orizzontale
	Trattini della parola
	Poszione verticale
	Stile di testo
	Blocchi di parole
	Direzioni dei gambi
	Opzioni Engraving Rules

	3.4 Simboli accordo
	Creare automaticamente i simboli accordo
	Scrivere i simboli accordo
	Simboli accordo standard
	Font del simbolo accordo
	Numeri Nashville
	Riprodurre i simboli accordo
	Trasporto dei simboli accordo
	Allineare una fila di simboli accordo
	Frequenza dei simboli accordo
	Stile dei simboli accordo

	3.5 Basso figurato e numeri Romani
	Creare il basso figurato
	Creare i numeri Romani
	Simboli funzione

	3.6 Numeri misura
	Aspetto e frequenza
	Opzioni Mostra su Righi
	Opzioni Stile di testo
	Opzioni di posizione orizzontale
	Opzioni di posizione verticale
	Collocare i numeri misura sotto il rigo in basso
	Numeri misura in strutture di ripetizione
	Selezionare i numeri misura
	Spostare i numeri misura
	Nascondere i numeri misura
	Cambi di numero misura
	Comando Go to Bar
	Numero sulla prima misura
	Misure d’attacco (upbeat)
	Numeri misura nelle parti

	3.7 Numeri pagina
	Cambio di numero pagina
	Selezionare i numeri pagina
	Nascondere i numeri pagina
	Cancellare i numeri pagina
	Numeri pagina nelle parti
	Mostrare il numero di pagina sulla pagina 1
	Numero sulla prima pagina
	Posizionare i numeri pagina rispetto al margine
	Numeri pagina in partiture a una sola facciata
	Numeri pagina nei testi
	Comando Go to Page

	3.8 Segni di prova
	Creare i segni di prova
	Modificare i segni di prova
	Opzioni Engraving Rules

	3.9 Nomi strumento
	Modificare i nomi strumento
	Nascondere i nomi strumento
	Spostare i nomi strumento
	Formato e stile dei nomi
	Nomi strumento in nuove sezioni
	Nomi strumento nelle parti dinamiche
	Righi senza nome

	3.10 Modifica stili di testo
	Finestra Modifica tutti Font
	Finestra Modifica Stili Testo
	Pagina Generale
	Pagina Bordo
	Pagina Pos Orizzontale
	Pagina Pos Verticale
	Pagina Ripeti
	Cancellare gli stili di testo
	Font adeguati

	3.11 Jolly
	Come appaiono i jolly
	Jolly disponibili
	Nome parte e cambi strumento
	Uso dei jolly
	Aggiungere le modifiche formattate alla finestra Info su partitura

	3.12 Font equivalenti

	4. Riproduzione e video
	4.1 Riproduzione
	Finestra Playback
	Filosofia di progetto
	Cosa legge Sibelius?
	Regolare la riproduzione
	Dinamiche
	Forcine
	Trilli
	Tempo
	Rit. e accel.
	Glissando e portamento
	Armonici
	Strumenti con più righi
	Modulazioni metriche
	Note silenti e linee/testi ignorati
	Comando Tutte Note Off
	Altre opzioni di riproduzione

	4.2 Interpretazione della partitura
	Cosa legge Sibelius
	Dinamiche
	Forcine
	Trilli
	Tempo
	Modulazioni metriche
	Rit. e accel.
	Glissato e portamento
	Armonici
	Strumenti con più righi
	Note silenti e scritte ingnorate/linee

	4.3 Mixer
	Striscia pulsanti
	Strisce rigo
	Striscia traccia clic
	Strisce gruppo
	Strisce strumento virtuale
	Strisce bus effetti
	Striscia volume Master
	Mute e Solo
	Campo sonoro
	Migliorare la riproduzione con molti strumenti

	4.4 Sibelius Sounds Essentials
	Requisiti del computer
	Installare Sibelius Sounds Essentials
	Configurare Sibelius Sounds Essentials
	Come funziona Kontakt Player 2
	Finestra Kontakt Player 2
	Rack strumento
	Pannello di controllo principale
	Browser
	Uscite
	Tastiera virtuale
	MasterKontrol
	Opzioni
	Suoni interni

	4.5 Esecuzione
	Espressivo™
	Rubato™
	“Tocco” ritmico - Rhythmic feel™
	Riverbero
	Durata delle note
	Dinamiche tra i righi di tastiera
	Ripetizioni
	Messaggi MIDI

	4.6 Ripetizioni
	Riprodurre le ripetizioni
	Stanghette di ripetizione
	Linee di 1˚ e 2˚ finale
	Coda
	Dal Segno (D.S.) e Da Capo (D.C.)
	Creare un segno
	Fine e Al Coda
	Misure di ripetizione
	Finestra Properietà
	Quando riprodurre testi e linee
	Quando riprodurre le note
	Saltare le misure
	Finali opzionali & Repeat to fade
	Problemi in strutture ripetute complesse

	4.7 Live Playback
	Sentire Live Playback
	Visualizzare le velocity Live Playback
	Modificare i dati Live Playback
	Finestra Proprietà
	Modificare le velocity Live Playback
	Finestra Transform Live Playback
	Creare dati Live Playback
	Live Playback on e off per le sezioni di una partitura

	4.8 Dizionario di riproduzione
	Pagina Testo rigo
	Pagina Testo Accollatura
	Pagina Linee rigo
	Pagina Articolazioni
	Pagina Teste di nota
	Pagina Simboli
	Cambi ID suono
	Quando hanno effetto gli elementi nel dizionario
	Espressioni regolari
	Copiare gli elementi del dizionario di riproduzione in altre partiture

	4.9 Video
	Aggiungere un video
	Rimuovere un video
	Sincronizzazione
	Esempi video
	Formati file
	Salvare e aprire partiture con i file video
	Nascondere e mostrare la finestra Video
	Impostare il volume del video
	Impostare la dimensione della finestra Video
	Modalità A tutto schermo - Full screen
	Windows Media e QuickTime (solo Windows)
	Traslucenza della finestra Video
	Posizione d’inizio
	Aggiungere la musica ai file video

	4.10 Timecode e hit point
	Lettura Timecode
	Finestra Timecode e Durata
	Scrivere il timecode nella partitura
	Unità
	Punto d’inizio
	Opzione Durata alla fine della partitura
	Calcolo di timecode e durata
	Hit point
	Come inserire hit point nella partitura
	Modificare posizione tempo e nome degli hit point
	Cancellare gli hit point
	Adatta selezione a tempo
	Spostare tutti gli hit points
	Visualizzare gli hit point su un rigo
	Stili di testo

	4.11 Dispositivi di riproduzione
	Dispositivi compatibili
	Configurazioni di riproduzione
	Creare una nuova configurazione di riproduzione
	Cambiare la configurazione di riproduzione corrente
	Rinominare e cancellare le configurazioni di riproduzione
	Modificare una configurazione di riproduzione
	Pagina Dispositivi Attivi
	Pagina Set di Suoni Manuali
	Pagina Suoni Preferiti
	Pagina Effetti
	Finestra Audio Engine Options
	Set di Suoni - Sound set
	Soundfont

	4.12 Nozioni MIDI
	Domanda principale - cosa è il MIDI?
	Numeri programma e General MIDI
	Conteggio da 0
	Banchi: varianti dei suoni
	Canali
	Altri termini MIDI
	File MIDI

	4.13 Strumenti virtuali
	Cos’è uno strumento virtuale?
	Strumenti virtuali basati sul campione
	Strumenti virtuali basati sulla sintesi
	Tecnologie per gli strumenti virtuali
	Strumenti virtuali come “plug-in
	Effetti
	Come ottenere il meglio da strumenti virtuali ed effetti
	Ulteriori informazioni

	4.14 Lavorare con gli strumenti virtuali
	Sibelius Sounds Essentials
	Altre librerie Kontakt Player 2
	Combinare diverse librerie Kontakt Player 2
	Usare Kontakt Player 2 come altri strumenti virtuali
	Usare uno strumento virtuale multi-canale con un sound set
	Usare uno strumento virtuale multi-canale senza un sound set
	Usare uno strumento virtuale multi-canale con più programmi per canale
	Usare strumenti virtuali a singolo canale
	Usare i Soundfont con gli strumenti virtuali

	4.15 Messaggi MIDI
	Creare i messaggi MIDI in Sibelius
	È meglio usare il dizionario o i messaggi MIDI?
	Sintassi
	Messaggi di canale
	Program e Bank Change
	Numeri Banco
	Control Change
	Pitch Bend
	Aftertouch
	Modulation
	Breath
	Portamento
	Volume
	Pan
	Expression
	Sustain pedal
	Soft pedal
	Modalità canale
	NoteOn/NoteOff
	Messaggi di sistema
	Nascondere i messaggi MIDI
	Ulteriori informazioni

	4.16 SoundWorld™
	Sound ID, SoundWorld e sound set
	Dove appaiono in Sibelius i sound ID?
	Come sceglie Sibelius il sound ID da usare?
	Struttura ad albero del sound ID


	5. Funzioni efficaci
	5.1 Arrange™
	Riassunto
	Usare Arrange in modo musicale
	Come arrangia la funzione Arrange
	Stili Arrange
	Stili Block e Mixed
	Espandi
	Riduzione
	Arrangiare famiglie di strumenti
	Arrangiare l’orchestra
	Arrangiare una banda
	Arrangiare ensemble miste
	Arrangiare i cori
	Arrangiare le ensemble jazz
	Arrangiare ensemble rock e pop
	Arrangiare strumenti solisti
	Arrangiare altre ensemble
	Preparare la musica da arrangiare
	Dopo aver arrangiato la musica

	5.2 Modificare gli stili Arrange
	Come funziona
	Modificare gli stili di arrangiamento
	Linee che vanno nel primo gruppo

	5.3 Impostazioni visive
	Risoluzione dello schermo
	Numero di colori
	Sfondi
	Smoothing - Scorrevolezza
	Consigli rapidi
	Finestre trasparenti
	Monitor multipli

	5.4 Filtri e Trova
	Come usare i filtri
	Filtri rapidi
	Usare i filtri per copiare e cancellare
	Finestra Filtro avanzato
	Selezionare gli oggetti con caratteristiche x e y
	Selezionare gli oggetti con caratteristiche x o y
	Trovare gli oggetti
	Trovare e sostituire testi
	Trovare motivi (motif)

	5.5 Evidenzia righi Selezionati
	Scegliere i righi sui quali lavorare
	Riproduzione
	Selezioni e passaggi
	Pause multiple
	Confusioni possibili

	5.6 Nascondere oggetti
	Nascondere un oggetto
	Cosa può essere nascosto?
	Vedere gli oggetti nascosti
	Oggetti nascosti nella parti
	Riproduzione e stampa di oggetti nascosti

	5.7 Evidenzia
	Creare un’evidenziazione
	Selezionare oggetti evidenziati
	Spostare l’evidenziatura
	Cancellare un’evidenziazione
	Visualizzare le evidenziazioni
	Stampare le evidenziazioni

	5.8 Idee
	Cosa c’è in un’idea?
	Finestra Idee
	Ascolto delle idee
	Catturare un’idea
	Trovare un’idea
	Incollare un’idea
	Modificare un’idea
	Dove sono salvate le idee?
	Condividere le idee
	Importare le idee
	Accesso limitato alla libreria
	Idee interne
	Usare le idee per insegnare

	5.9 Menu e comandi rapidi
	Schemi dei comandi rapidi
	Differenze Windows/Mac
	Funzioni Scuola
	Funzioni computer portatile (solo Windows)
	Personalizzare i comandi rapidi
	Trovare comandi rapidi inutilizzati
	Abilitare e disabilitare le funzioni
	Condividere i set di funzioni
	Ri-memorizzare i comandi rapidi di default

	5.10 Panorama
	Attivare la veduta Panorama
	Muoversi nella veduta Panorama
	Inserimento e modifica nella veduta Panorama
	Spaziatura nota in Panorama
	Spaziatura rigo in Panorama
	Usare la veduta Panorama con Focus on Staves
	Aprire le partiture nella veduta Panorama

	5.11 Plug-in
	Plug-in aggiuntivi
	Installare nuovi plug-in
	Modificare i plug-in
	Creare i propri plug-in
	ALTERAZIONI
	Aggiungi alterazioni a tutte le note
	Aggiungi alterazioni a tutte le note con diesis e bemolle
	Aggiungi alterazioni precauzionali
	Aggiungi un simbolo di ficta sopra la nota
	Riscrivi bemolle come diesis/diesis come bemolle
	Semplifica alterazioni
	ANALISI
	Aggiungi scala gradi Schenker
	Confronta righi
	Trova motivo
	Trova estensione
	PROCESSO DI MASSA
	Calcola Statistiche
	Converti cartella di file Sibelius 7 Acorn
	Converti cartella di file di Finale
	Converti cartella di file MIDI
	Converti cartella di file MusicXML
	Converti cartella di file SCORE
	Converti cartelle di spartiti in grafica
	Converti cartelle di spartiti in MIDI
	Converti cartelle di spartiti in pagine web
	Importa House Style in una cartella di partiture
	Stampa copie multiple
	SIMBOLI ACCORDO
	Aggiungi accordo con capotasto
	Aggiungi simboli accordo
	Simboli accordo come frazione
	Realizza simboli e diagramma accordo
	TOOL DI COMPOSIZIONE
	Matrice a 12 toni
	Aggiungi pattern di batteria
	Aggiungi rigo Hit Point
	Aggiungi armonia semplice
	Explode
	Adatta selezione al tempo
	Inverti
	Mappatura Pitch
	Crea basso cifrato
	Reduce
	Retrocedi
	Visualizza Handbells richiesti
	Trasforma Scala
	NOTE E PAUSE
	Aggiungi teste di nota barrate per parti
	Applica Shape Notes
	Boomwhacker® Note Colors
	Color Pitches
	Converti tempo semplice in tempo composto
	Copia articolazioni e legature
	Valori delle note dimezzate/doppie
	Rendi i pitch costanti
	Rimuovi legature sospese
	Dividi pause di quarti puntati
	Straighten Written-Out Swing
	ALTRO
	Aggiungi pedali arpa
	Aggiungi nomi delle note alle teste delle note
	Groovy Music Mark-up
	Rendi layout uniforme
	Attiva layout per pianoforte a quattro mani
	Preferenze
	Rimuovi evidenziati
	Scale ed Arpeggi
	Imposta indicazione di metronomo
	Dividi Battuta
	Trova posizioni note guida
	RIPRODUZIONE
	Aggiungi Control Change continui
	Riproduzione Cresc./Dim.
	Riproduzione armonici
	Riproduzione ornamenti
	Riproduzione dei quarti di tono
	Strummer
	VERIFICA DI LETTURA
	Proof-read
	Controlla collegamenti
	Controlla battuta d’entrata
	Controlla quinte/ottave parallele
	Controlla trattini d’unione delle parole
	Controlla stop multipli
	Cosa è dove
	SEMPLIFICA NOTAZIONE
	Cambio punto di split
	Combina note legate e pause
	Duplicati In righi
	Sposta su altro rigo
	Rimuovi note sovrapposte
	Rimuovi pause
	Rimuovi note all’unisono
	Riscrivi esecuzione
	TESTO
	Aggiunge parentesi quadre al font Reprise Script
	Aggiungi diteggiature fiati
	Aggiungi nomi delle note
	Aggiungi legature alle parole
	Aggiungi diteggiatura per gli archi
	Aggiungi Tonica Sol-Fa
	Aggiungi numeri verso
	Allinea parole
	Cambia dinamiche
	Salva parole
	Trova e sostituisci testo
	Numera battute
	Numera battiti
	Riposiziona testo
	Virgolette intelligenti
	Beaming di parole tradizionale
	GRUPPI IRREGOLARI
	Aggiungi note in gruppi irregolari
	Cambia rapporto gruppo irregolare
	Allunga gruppo irregolare
	Inserisci in gruppo irregolare
	Rimuovi note dal gruppo irregolare
	Accorcia gruppo irregolare
	Dividi o unisci gruppi irregolari
	Preferenze Gruppo irregolare

	5.12 Preferenze
	Visualizza
	File
	Font Equivalenti
	Dispositivi ingresso
	Menu e scorciatoie
	Mouse
	Font musicali
	Inserimento nota
	Incolla come guida
	Posizione partitura
	Textures
	Menu contestuali
	Altro
	Messaggi di notifica

	5.13 Stampa
	Impostare la dimensione del foglio
	Stampa
	Intervallo di stampa
	Copie e Fasciola (Collate)
	Bordo
	Segni di ritaglio
	Visualizza opzioni menu
	Stampa a colori
	Data e ora a piè di pagina
	Adatta al foglio
	Scala
	Sostituisci - opzioni
	Stampa su due facciate
	Poster - Spreads
	2-Up
	Libretto
	Stampare più partiture o parti alla volta
	Scegliere carta di qualità
	Problemi con i margini
	Problemi con la stampa a doppia facciata

	5.14 Proprietà
	Vedere le proprietà
	Pannello Generale
	Pannello Testo
	Pannello Playback
	Pannello Linee
	Pannello Misure
	Pannello Note

	5.15 SibeliusEducation.com
	A chi serve?
	Caratteristiche
	Servizi SibeliusEducation.com
	Pubblicare gli esercizi in SibeliusEducation.com
	SibeliusMusic.com

	5.16 SibeliusMusic.com
	Scorch
	Impostazioni consigliate
	Pubblicazione su SibeliusMusic.com

	5.17 Trasporto intonazione
	Spostamento senza alterazioni
	Trasportare di una o più ottave
	Trasportare più di due ottave
	Trasportare di mezzo step (un semitono)
	Trasporti estremi
	Simboli e diagrammi accordo
	Spostare altri oggetti

	5.18 Undo e Redo
	Undo
	Redo
	Undo storia
	Redo storia
	Livello Undo

	5.19 Menu Vista
	Panorama
	Evidenza su righi
	Nomi rigo e Numeri battuta
	Marchi Layout
	Margini pagina
	Righelli
	Linee collegamento
	Oggetti nascosti
	Differenze nelle parti
	Highlights
	Colori note
	Live Playback Velocities
	Linea Playback
	Schermo intero (solo Windows)
	Barre scorrimento
	Toolbar
	Zoom

	5.20 Menu Finestra
	Nuova finestra
	Finestre tool
	Passa a parte/Partitura completa
	Prossima Parte
	Parte precedente
	Contrai (solo Mac)
	Ridimensiona (solo Mac)

	5.21 Creatore Quaderni di Lavoro
	Usare Worksheet Creator
	Rhythm levels (RL1-4) e scale levels (SL1-4)
	Template
	Categorie

	5.22 Inserire questionari personalizzati
	Inserire i propri questionari
	Dimensioni e margini pagina
	Foglio di risposte
	Domande casuali e fisse
	Usare le idee nei questionari
	Inserire un questionario in Creatore Quaderni di lavoro
	Modificare i questionari


	6. Parti Dinamiche™
	6.1 Lavorare con le parti
	Cosa sono le parti dinamiche?
	Vedere le parti dinamiche
	Vedere più parti
	Distinguere la partitura da una parte
	Finestra Parti
	Stampare più parti
	Creare nuove parti
	Aggiungere o rimuovere righi dalle parti
	Cancellare le parti
	Aspetto di parti e partitura

	6.2 Modificare le parti
	Spostare gli oggetti nelle parti
	Differenze nelle parti
	Ripristinare gli oggetti nelle parti
	Mostra e nascondi in parti e partitura
	Modificare i nomi delle parti
	Stili di testo nelle parti
	Cambi di chiave nelle parti
	Segni di Coda nelle parti
	Copiare il layout della parte
	Esportare stili house dalle parti
	Parti in trasporti diversi

	6.3 Finestra Aspetto parte multipla
	Pagina Impostazioni Documento
	Pagina Layout
	Pagina House Style

	6.4 Estrarre le parti
	Perché estrarre le parti?
	Finestra Estrarre le parti
	Più musicisti sullo stesso rigo
	Estrarre singoli musicisti


	7. Layout e tipografia
	7.1 Layout e formattazione
	Dimensione pagina e rigo
	Spaziatura verticale
	Spaziatura orizzontale
	Break di sistema e pagina
	Make Into System/Page
	Mantieni insieme battute
	Uniformare il layout
	Blocco formattazione
	Sblocco formattazione
	Auto Layout
	Ordinare i righi
	Ripristinare la posizione
	Ripristina su posizione partitura
	Ripristina aspetto
	Ripristina su aspetto partitura
	Allineamento degli oggetti
	Righelli e fogli grafici

	7.2 Scrittura musicale
	Premessa
	Cosa è la scrittura musicale?
	Regole di scrittura
	Regola n˚ 1: chiarezza
	Regola n˚ 2: evitare collisioni
	Unità
	Layout orizzontale: spaziatura note
	Layout verticale: spaziatura rigo
	Altre informazioni

	7.3 Layout automatico
	Configurare le parti
	Break di sistema automatici
	Break di pagina automatici
	Eliminare break di pagina e di sistema automatici
	Pause multiple

	7.4 Break - Interruzioni
	Inserire o togliere break di sistema o pagina manuali
	Dove collocare i break di sistema?
	Dove collocare i break di pagina?
	Break di pagina speciali
	Creare una pagina di titolo
	Creare testi e grafiche sulle pagine vuote
	Modificare i break di pagina speciali
	Cancellare break di pagina speciali
	Cambiare i margini di pagina e rigo con break di pagina speciali
	Break e parti dinamiche
	Rimuovere molti break
	Visualizzare i break

	7.5 Impostazioni documento
	Cambiare le impostazioni pagina
	Dimensioni del foglio
	Dimensione del rigo
	Margini pagina
	Margini del rigo
	Cambiare il setup del documento a metà partitura

	7.6 Attaccature
	Visualizzare le attaccature
	Visualizzare le attaccature nelle parti
	Attaccamento orizzontale
	Attaccamento verticale
	Attaccamento a un altro rigo
	Regolare le attaccature nelle parti
	Oggetti di sistema
	Collocare gli oggetti in posti insoliti

	7.7 House Style™
	Stili house predefiniti
	Stili house Reprise e Inkpen2
	Regole di scrittura
	Impostare gli stili house per tutte le partiture
	Esportare uno stile house
	Importare uno stile house

	7.8 Spaziatura note
	Regola di spaziatura nota
	Note non allineate
	Ottimizzare la spaziatura nota
	Ottimizzare la spaziatura delle parole

	7.9 Spaziatura rigo
	Spaziatura di rigo e sistema
	Spostare i righi
	Allineare i righi
	Ristabilire la spaziatura rigo di default

	7.10 Font musicali
	Cambiare font musicale
	Cambiare il font di un subset di simboli
	Font di testo musicale
	Usare font non forniti da Sibelius
	Installare i font musicali Type 1
	Realizzare i propri font musicali

	7.11 Posizioni di default
	Creare un Oggetto
	Spostare un oggetto
	Creare Linee
	Creare Testo
	Casi particolari
	Posizioni degli oggetti di sistema

	7.12 Modifica strumenti
	Finestra Edit Instruments
	Creare e cancellare un’ensemble
	Creare e cancellare una famiglia
	Aggiungere e rimuovere strumenti esistenti
	Creare, modificare e cancellare strumenti
	Modifica Tipo Rigo
	Pagina Generale
	Pagina Note e pause
	Pagina Percussione
	Pagina Tab

	7.13 Modifica linee
	Modificare una linea

	7.14 Modifica teste nota
	7.15 Modifica simboli
	Cambiare i simboli esistenti
	Nuovi simboli
	Simboli composti
	Modificare e creare nuovi simboli
	Creare un nuovo stile di testo per il simbolo

	7.16 Pubblicazione
	Diventare editori
	Scrittura musicale e stile house
	Stampa limitata
	Stampa su larga scala
	Stampa litografata
	Fattori che influenzano la qualità di stampa
	Riassunto


	8. File
	8.1 Lavorare con i file
	Creare una partitura
	Dimensione dei file
	Salvataggio
	Salvataggio automatico
	Backup
	Finestra Score Info
	File modificabili dall’utente
	Template Scorch e strutture

	8.2 Condivisione file
	Condividere i file con altri utenti Sibelius
	Condividere i file con persone che non usano Sibelius
	Spedire i file tramite posta elettronica
	File su Windows o Mac
	Aprire partiture Mac in Windows
	Aprire le partiture Windows su Mac

	8.3 Dividere e unire le partiture
	Più movimenti, brani o pezzi
	Inserire una partitura in più file
	Funzione “Unire Partiture” (Append Score)

	8.4 Importare le grafiche
	Importare una grafica
	Formati file
	Copiare, modificare e cancellare le grafiche
	Dimensione file

	8.5 Aprire i file MIDI
	Importare un file MIDI
	Opzioni Import
	Opzioni di importazione raccomandate
	Conversione di massa (batch conversion)
	Pulizia dei file MIDI
	Offset SMPTE
	Dettagli tecnici
	Scaricare file MIDI

	8.6 Aprire i file MusicXML
	Cosa significa MusicXML?
	Creare i file MusicXML in Finale
	Aprire un file MusicXML
	Messaggi d’avviso
	Importare i file MusicXML salvati in un sequencer
	Versioni supportate
	Conversione di massa (batch conversion)
	Qualità dei risultati

	8.7 Aprire i file Finale 98-2003
	Versioni supportate
	Convertire un file
	Messaggi d’avviso
	Layout
	Lingue supportate
	Conversione di massa (batch conversion)
	Qualità dei risultati

	8.8 Aprire i file SCORE
	Convertire un file
	Conversione in massa (batch conversion)
	Elenchi di file SCORE
	Numeri strumento
	Partiture trasportate
	Tempi in chiave
	Partiture a singola pagina
	Ottimizzare la partitura prima della conversione
	Limitazioni

	8.9 Aprire i file Acorn Sibelius
	Trasferire i file da Acorn a PC o Mac
	Convertire un file Acorn Sibelius
	Conversione di massa (batch conversion)
	Limitazioni

	8.10 Aprire i file di versioni precedenti
	Finestra Aggiorna Partitura

	8.11 Esportare file grafici
	Copiare le grafiche sugli Appunti
	Regolare il marquee
	Inserire le grafiche in Microsoft Word
	Esportare le grafiche
	Conversione di massa (batch conversion)
	Formati grafici
	File Encapsulated PostScript (EPS)
	File TIFF
	File PNG
	File EMF (solo Windows)
	File PICT (solo Mac)
	File BMP
	Creare file PDF

	8.12 Esportare i file MIDI
	Esportare un file MIDI
	Conversione di massa (batch conversion)
	Rubato
	Ripetizioni
	Partiture con più di 15 righi

	8.13 Esportare i file audio
	Esportare l’audio
	Masterizzare i file audio su CD
	Creare file MP3

	8.14 Esportare pagine web Scorch
	Impostazioni raccomandate
	Esportazione
	Conversione di massa (batch conversion)
	Stampa e salvataggio da Scorch
	Informazioni sulla partitura
	Template di pagine web
	Personalizzare il proprio sito web
	Problemi e soluzioni
	Usare posta elettronica e CD-ROM
	Avvertenze legali

	8.15 Esportare su versioni precedenti
	Differenze in Sibelius 2, 3, 4, G7 e Sibelius Student
	Differenze in Sibelius 2, 3, G7 e Student
	Altre differenze in Sibelius 2
	Utenti di Sibelius 1.4

	8.16 File in tablatura ASCII
	Come appare un file in tablatura ASCII?
	Importare i file di tablatura ASCII
	Esportare i file in tablatura ASCII
	Musica protetta da copyright


	Glossario
	Indice analitico
	Licenza d’uso


